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Chapitre 1 : Bienvenue dans Pro Tools

Bienvenue dans Pro Tools®. Pro Tools intègre de 
puissantes fonctions d'enregistrement 
audionumérique multipiste et de séquence 
MIDI, et fournit tous les outils pour 
l'enregistrement, l'arrangement, la composition, 
l'édition, le mixage et le mastering de données 
audio et MIDI de qualité professionnelle pour la 
musique, la vidéo, les films et le multimédia.

Guides Pro Tools
Les systèmes Pro Tools s'accompagnent des 
guides suivants :

Guide de démarrage : instructions d'installation 
du système Pro Tools et de connexion du
studio. Pour Pro Tools LE™ et M-Powered™, ces 
guides décrivent les méthodes spécifiques 
permettant d'effectuer les opérations courantes 
(enregistrement dans une session a Pro Tools, 
importation de données à partir d'un CD et 
création d'un CD audio à partir d'une session 
Pro Tools).

Guide de référence Pro Tools : description 
détaillée de toutes les fonctions et possibilités 
offertes par Pro Tools (les systèmes Pro Tools LE 
et M-Powered ne comportent qu'une version 
électronique du Guide de référence au format 
PDF).

Guide des menus Pro Tools : guide PDF 
électronique des menus de Pro Tools.

Guides des raccourcis clavier de Pro Tools : 
guides électroniques au format PDF pour 
Windows et Mac comportant la liste des 
raccourcis clavier et souris, y compris ceux 
apparaissant dans les menus de Pro Tools.

Guide des plug-in DigiRack : guide électronique 
au format PDF contenant les instructions 
d'utilisation des plug-in DigiRack™ (fournis 
avec Pro Tools) pour le traitement audio, en 
temps réel ou non, des fichiers dans Pro Tools.

Guide des plug-in Digidesign : guide électronique 
au format PDF contenant des instructions 
d'utilisation des plug-in Digidesign® optionnels 
pour le traitement audio, en temps réel ou non, 
des fichiers dans Pro Tools.

Guide des systèmes étendus (systèmes 
Pro Tools|HD uniquement) : instructions pour 
l'ajout de cartes Digidesign optionnelles ou d'un 
châssis d'extension sur un système 
Pro Tools|HD®.

Guide MachineControl™ (systèmes Pro Tools|HD 
uniquement) : guide électronique au format PDF 
qui contient des instructions d'installation et 
d'utilisation de l'option MachineControl pour 
Pro Tools permettant d'activer la 
communication série avec des transports audio 
et vidéo distants.
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Guides supplémentaires :

guides supplémentaires, notamment un 
glossaire, au format PDF installés avec Pro Tools. 
Reportez-vous au dossier de la documentation 
Pro Tools.

Digidesign fournit également des guides sur les 
interfaces audio, les surfaces de travail dédiées 
(comme D-Control™) et les contrôleurs (comme 
Command|8®) et sur bon nombre d'options 
Digidesign (MIDI I/O™, PRE et SYNC I/O™, par 
exemple). Consultez les documents fournis avec 
votre produit Digidesign spécifique.

Conventions utilisées dans ces 
guides

Les guides de Pro Tools utilisent les conventions 
suivantes pour indiquer les choix de menu, les 
commandes du clavier et de la souris :
:

Les symboles suivants sont utilisés pour mettre 
en évidence des informations importantes :

Pro Tools M-Powered et Academic 
Convention Action

File > Save Dans le menu File, 
sélectionnez Save.

Ctrl+N Maintenez la touche Ctrl 
enfoncée et appuyez sur 
la touche N.

Ctrl+clic Maintenez la touche Ctrl 
enfoncée tout en 
cliquant à l'aide du 
bouton de la souris.

Cliquez avec le bouton 
droit de la souris

Cliquez à l'aide du 
bouton droit de la souris.

Les conseils aux utilisateurs sont des 
astuces qui vous permettent d'optimiser 
l'utilisation de votre système Pro Tools.

Les avertissements importants contiennent 
des informations susceptibles de modifier 
les données d'une session ou les 
performances de votre système Pro Tools.

Les raccourcis indiquent des raccourcis 
clavier et souris utiles.

Les renvois dirigent l'utilisateur vers les 
sections correspondantes dans le présent 
guide et les autres guides de Digidesign.

Les références à Pro Tools LE™ dans ce 
guide s'appliquent également à Pro Tools 
M-Powered™ et à Pro Tools Academic™, 
sauf indication contraire dans les Guides de 
démarrage Pro Tools M-Powered et 
Academic.
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Informations sur la 
compatibilité
Digidesign peut assurer la compatibilité et 
fournir une assistance uniquement pour les 
matériels et les logiciels testés et approuvés par 
ses soins. 

Pour connaître la liste des ordinateurs, systèmes 
d'exploitation, disques durs et périphériques 
tiers agréés par Digidesign, visitez le site Web de 
Digidesign (www.digidesign.com).

A propos de 
www.digidesign.com
Le site Web de Digidesign 
(www.digidesign.com) est la meilleure source 
d'informations en ligne pour optimiser votre 
logiciel Pro Tools. Vous trouverez ci-après 
quelques exemples des services et fonctions 
disponibles.

Enregistrement : enregistrez votre produit en 
ligne. Pour des instructions précises, 
reportez-vous au formulaire d'enregistrement 
fourni avec votre système.

Assistance : contactez l'assistance technique ou 
le service clientèle de Digidesign, téléchargez des 
mises à jour logicielles et les dernières versions 
des manuels en ligne, consultez les documents 
sur la compatibilité avec les différents systèmes 
d'exploitation et la base de recherche en ligne 
(Answerbase) ou inscrivez-vous au forum de 
discussion pour les utilisateurs Pro Tools (en 
anglais) dans la section Digidesign User 
Conference. 

Formation : étudiez directement en ligne ou 
découvrez les méthodes de formation utilisées 
dans les centres de formation certifiés Pro Tools. 

Produits et développeurs : découvrez les 
produits Digidesign, nos partenaires de 
développement ainsi que leurs plug-in, 
applications et matériels et téléchargez des 
logiciels démo. 

Actualité et événements : accédez aux 
informations de dernière minute publiées par 
l'équipe de Digidesign et inscrivez-vous pour 
obtenir une démo de Pro Tools.
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Chapitre 2 : Concepts de Pro Tools

Ce chapitre explique les principes et les concepts 
de base du fonctionnement et des 
fonctionnalités de Pro Tools.

Enregistrement audio sur 
disque dur
L'enregistrement sur bande exploite un support 
linéaire : autrement dit, il faut rembobiner une 
bande, en retour arrière ou en avance rapide, 
pour pouvoir écouter l'endroit particulier d'un 
enregistrement. Pour modifier l'ordre ou répéter 
des données contenues sur un système linéaire, 
il faut les réenregistrer ou les couper, puis les 
joindre. 

L'enregistrement sur disque dur utilise un 
support non linéaire (ou à accès aléatoire) : on 
peut se rendre instantanément à n'importe quel 
endroit d'un enregistrement sans devoir 
rembobiner, comme avec une bande.

Les systèmes non-linéaires présentent plusieurs 
avantages. Vous pouvez facilement modifier la 
disposition des parties d'un enregistrement ou 
les répéter en les faisant lire par le disque dur 
dans un ordre différent ou à plusieurs reprises. 
De plus, cette réorganisation est non destructive, 
ce qui signifie que le matériel enregistré original 
reste intact.

Pro Tools est un système d'enregistrement non 
linéaire qui permet de réorganiser et de mixer 
des éléments enregistrés, de façon non 
destructive. 

Digidesign Audio Engine
DAE, abréviation de Digidesign Audio Engine 
(moteur audio Digidesign), est le système 
d'exploitation en temps réel de Digidesign pour 
le traitement, la lecture et l'enregistrement 
numériques. Lorsque vous installez Pro Tools, 
DAE s'installe automatiquement sur votre 
système.

Tout comme le système d'exploitation d'un 
ordinateur permet l'exécution des programmes 
sur celui-ci, DAE offre la plupart des 
fonctionnalités d'enregistrement sur disque dur, 
de traitement de signal numérique et 
d'automation de mixage nécessaires à Pro Tools 
et à d'autres produits de Digidesign et de ses 
partenaires de développement.

Le paramètre DAE Playback Buffer Size 
détermine la quantité de mémoire DAE allouée à 
la gestion des buffers de disque. La taille du 
buffer de lecture DAE peut être modifiée dans la 
boîte de dialogue Playback Engine.
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Boîte de dialogue Playback Engine

Pro Tools tire également parti du processeur 
hôte de votre ordinateur pour partager un 
certain nombre de tâches et de traitements DSP 
optionnels. 

Pro Tools LE utilise le processeur de l'ordinateur 
hôte (CPU) pour effectuer l'enregistrement, la 
lecture, le mixage et les calculs d'effets des pistes 
audio. Pro Tools HD utilise également le 
processeur de l'unité centrale pour le calcul des 
effets des plug-in RTAS®. Les performances sont 
déterminées par les caractéristiques de votre 
système et les réglages de son moteur de lecture. 

La boîte de dialogue Playback Engine permet de 
définir la taille du buffer matériel et d'allouer un 
pourcentage des ressources du processeur à ces 
tâches.

Sur les systèmes Pro Tools|HD, vous pouvez 
sélectionner le nombre de voix (et de pistes 
pouvant héberger les voix) pour votre système et 
ses sessions. Le choix du nombre de voix dépend 
des ressources DSP que vous souhaitez allouer 
aux voix. 

Sur les systèmes Pro Tools|HD, la boîte de 
dialogue Playback Engine permet également 
d'affecter les ressources DSP dédiées pour la 
compensation de retard.

Sessions Pro Tools
Lorsque vous démarrez un projet dans 
Pro Tools, vous créez une session. Cette section 
explique un certain nombre d'éléments de base 
concernant les sessions.

Fichier de session

Un fichier de session est le document créé par 
Pro Tools lorsque vous choisissez File > New 
Session et configurez une nouvelle session. 
Pro Tools ne peut ouvrir qu'une seule session à 
la fois. Le fichier de session porte l'extension .ptf 
(propre aux fichiers Pro Tools). Les fichiers de 
session contiennent des tables de tous les 
éléments associés à un projet, ce qui inclut les 
fichiers audio, les données MIDI, ainsi que 
toutes vos informations d'édition et de mixage. 
Rappelez-vous cependant qu'un fichier de 
session Pro Tools ne contient pas de fichier 
média (audio ou vidéo). En revanche, il fait 
référence aux fichiers audio, vidéo, MIDI et aux 
autres fichiers. Les modifications effectuées dans 

Pour plus d'informations sur la 
configuration de la taille du buffer de 
lecture DAE, reportez-vous à la section 
Taille du buffer de lecture DAE, page 46. 

Boîte de dialogue Playback Engine pour Pro Tools HD

Pour plus d'informations, reportez-vous à la 
section Configuration des paramètres du 
système Pro Tools (dans le moteur de 
lecture), page 40. Voir également 
Ressources système, page 14.
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une session seront enregistrées dans le nouveau 
fichier de session. Vous pouvez ainsi créer 
plusieurs versions d'une session ou sauvegarder 
votre travail d'édition et de mixage. 

Les icônes des fichiers de session sont différentes 
selon qu'il s'agit d'un système Pro Tools HD, 
Pro Tools LE ou Pro Tools M-Powered. 

Bien qu'il existe différentes icônes de fichiers de 
session, il est possible d'ouvrir ces fichiers à 
partir des trois applications (avec certaines 
restrictions). Pour plus d'informations, 
reportez-vous à la section Ouverture d'une 
session, page 101. 

Pistes

Les pistes de Pro Tools permettent d'enregistrer 
et d'éditer les données audio, MIDI, vidéo et 
d'automation. Les pistes Pro Tools fournissent 
également des canaux audio pour 
l'acheminement des bus internes, ainsi que des 
entrées et sorties physiques pour les données 
audio et MIDI.

Pro Tools propose sept types de pistes : pistes 
audio, d'entrée auxiliaire, de fader principal, de 
VCA principal, MIDI, d'instrument et vidéo.

Les données des pistes audio, des pistes MIDI et 
des pistes d'instrument peuvent être éditées en 
régions ou répétées à des emplacements 
différents, ce qui permet de créer des boucles, de 
réarranger des sections ou des chansons 
entières, ou d'assembler des pistes en utilisant 
des éléments de plusieurs prises. 

Les pistes d'entrée auxiliaire permettent 
d'acheminer des bus audio internes ou des 
entrées physiques vers des bus internes ou des 
sorties physiques. Les entrées auxiliaires sont 
généralement utilisées pour les bus d'effets 
audio, le débit audio (écoute) et le prémixage.

Icônes des fichiers de session

En cas de transfert d'une session dans un 
autre système Pro Tools, son icône de fichier 
adopte le type d'icône du système de 
destination.

Pro Tools HD

Pro Tools M-Powered Pro Tools Academic

Pro Tools LE

Piste audio dans la fenêtre Edit (piste stéréo affichée)

Piste MIDI dans la fenêtre Edit (Edition)
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Les pistes de fader principal fournissent des 
commandes pour les canaux de sortie audio 
physiques, y compris des réglages du niveau de 
volume pour le mixage, le panoramique et les 
inserts de plug-in.

Les pistes de VCA principal (Pro Tools HD 
uniquement) permettent de contrôler les pistes 
d'un groupe de mixage affecté au VCA principal.

Les pistes vidéo prennent en charge les formats 
QuickTime et Avid. Toutefois, il est impossible 
de mélanger ces deux types de données vidéo sur 
une même piste.

Les pistes audio, d'entrée auxiliaire, de fader 
principal, de VCA principal (Pro Tools HD 
uniquement) et d'instruments peuvent être 
mono, stéréo ou multicanaux (Pro Tools HD 
uniquement). Lors de la création d'une piste, 
sélectionnez son format dans la liste de formats 
pris en charge par votre système.

Fichier audio

Lorsque vous enregistrez du son dans une 
session Pro Tools, des fichiers audio sont créés. 

Les fichiers audio de chaque session sont stockés 
dans un dossier appelé « Audio Files » (fichiers 
audio). La liste des fichiers audio se trouve dans 
la liste des régions de Pro Tools et peut 
apparaître dans une piste audio. Il est possible de 
définir une section d'un fichier audio comme 
région. Pour plus d'informations, reportez-vous 
à la section Régions, page 10.

Régions

Une région correspond à un segment de données 
audio, MIDI ou vidéo. Une région peut 
correspondre à une boucle de batterie, un riff de 
guitare, un couplet de chanson, une prise, un 
effet sonore, un extrait de dialogue ou un fichier 
audio entier. Les régions permettent 
notamment d'organiser les données audio et 
MIDI. Il est possible également d'associer des 
données d'automation à une région. 
Dans Pro Tools, les régions sont créées à partir 
de fichiers audio ou de données MIDI, et 
peuvent être organisées en playlists de pistes 
audio et MIDI. Vous pouvez également 
regrouper des régions ou les lire en boucle.

Playlist

Une playlist est une suite de régions organisées 
sur une piste audio, MIDI ou vidéo. Les pistes 
possèdent des playlists d'édition et des playlists 
d'automation. 

Icône de fichier audio

Région audio

Menu déroulant du sélecteur de playlist
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Dans le cas des pistes audio, une playlist 
d'édition indique au disque dur quelles sont les 
régions audio à lire et dans quel ordre. 
Vous pouvez, par exemple, utiliser la même 
région audio pour accéder à la même partie de 
données audio à plusieurs reprises et en 
plusieurs emplacements sans utiliser d'espace 
disque supplémentaire. Plusieurs versions des 
mêmes données audio peuvent être utilisées à 
différents endroits et des effets variés peuvent 
leurs être appliqués. Dans le cas des pistes MIDI 
et des pistes d'instrument, les playlists d'édition 
permettent de stocker plusieurs séquences MIDI 
(ou performances) sur une piste. 

Une playlist peut être constituée d'une seule 
région ou de plusieurs régions séparées. Elle peut 
être constituée d'éléments de même origine, par 
exemple des régions provenant de plusieurs 
prises différentes d'un solo, ou d'éléments 
hétérogènes, plusieurs effets sonores différents 
par exemple. 

Vous pouvez créer autant de playlists d'édition 
que vous le souhaitez pour une piste. Vous 
pouvez ainsi assembler différentes versions 
d'interprétations ou d'éditions sur une même 
piste et choisir celles qui vous intéressent dans 
un menu déroulant apparaissant sur la piste.

Chaque piste possède, en outre, un seul 
ensemble de playlists d'automation, pour le 
volume, le panoramique, les coupures (mute) et 
pour chaque contrôle d'automation pour les 
affectations d'inserts et de départs de cette piste.

Canal

Le terme canal peut revêtir plusieurs sens 
différents, selon l'élément de système Pro Tools 
considéré. Dans son sens premier, le mot 
« canal » se réfère à une entrée ou à une sortie 
physique de votre système Pro Tools. 
Une interface audio 96 I/O offre, par exemple, 
16 canaux d'entrée et de sortie maximum à un 
système Pro Tools|HD, alors qu'une interface 
audio Mbox 2 ne fournit pas plus de 
quatre entrées et deux sorties.

La seconde utilisation du terme canal se réfère à 
une voie dans la fenêtre Mix de Pro Tools. 
Chaque piste d'une session Pro Tools possède 
une voie correspondante dans la fenêtre Mix.

Les voies audio et MIDI présentent des contrôles 
semblables, mais ces derniers ont des effets 
légèrement différents. Par exemple, les faders de 
voie audio, d'entrée auxiliaire et d'instrument 
contrôlent le gain de sortie de la console de 
mixage pour ce canal, alors que les faders de 
voies MIDI envoient des données de volume 
MIDI (de type contrôleur MIDI 7) à 
l'instrument MIDI. 
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Assignation du signal

Pro Tools offre des commandes logicielles de 
mixage et d'acheminement (assignation) du 
signal, accessibles à partir de la fenêtre Mix. 
Certaines de ces commandes sont également 
accessibles à partir de la fenêtre Edit.

Une tâche courante d'assignation du signal 
consiste à prémixer plusieurs pistes en une seule 
voie (par exemple, une entrée auxiliaire), afin de 
pouvoir partager le traitement et le contrôle de 
niveau. Dans l'exemple suivant, trois pistes 
audio sont prémixées dans une entrée stéréo 
auxiliaire.

Voie de console de la fenêtre Mix (piste audio)

Le terme canal MIDI s'applique également à 
un aspect distinct du fonctionnement MIDI. 
Pour plus d'informations, reportez-vous à la 
section « Piste », page 16.
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Options d'assignation du signal

Les options d'assignation du signal sont les 
suivantes : 

Sélecteurs d'entrées et de sorties (I/O) de 
pistes : l'assignation de signal la plus simple 
consiste à définir l'entrée et la sortie de la piste. 
Il est nécessaire d'affecter un chemin d'entrée à 
une piste pour qu'elle puisse enregistrer des 
données audio, ainsi qu'un chemin de sortie 
pour que ces données audio soient audibles via 

une sortie physique. Les signaux peuvent 
également être acheminés vers ou depuis 
d'autres pistes dans Pro Tools (ou entrées et 
sorties matérielles) à l'aide de bus internes.

Pistes d'entrée auxiliaire et de fader principal : 

les entrées auxiliaires peuvent servir de retours 
machine ou effets, de prémixeurs et de bus 
principaux. Les pistes de fader principal servent 
à contrôler les niveaux généraux de bus et de 
sortie. Les pistes d'entrée auxiliaire et de fader 
principal peuvent posséder des inserts plug-in et 
matériels. 

Pistes d'instrument : les pistes d'instrument 
permettent d'envoyer du son d'une entrée 
physique ou d'un plug-in vers des sorties, des 
départs et des bus ou d'autres inserts.

Départs : les départs envoient les données audio 
des pistes vers des sorties matérielles ou vers des 
bus internes acheminés à leur tour vers d'autres 
pistes au sein de Pro Tools. Les pistes de fader 
principal et de VCA principal ne gèrent pas les 
départs.

Inserts plug-in et matériels : le traitement des 
plug-in s'effectue entièrement dans le système 
Pro Tools. Les inserts matériels utilisent, en 
revanche, les entrées et les sorties de l'interface 
audio pour constituer une boucle d'insertion 
traditionnelle à destination et en provenance 
d'effets externes ou autres périphériques.

Chemins : les chemins correspondent à toute 
option d'assignation dans Pro Tools, y compris 
les entrées, sorties, bus et inserts internes ou 
externes. Pro Tools vous permet d'identifier ces 
chemins. Les noms des chemins seront affichés 
dans les sélecteurs d'entrée audio et de chemin 
de sortie ainsi que dans d'autres menus. 
Pour plus d'informations, reportez-vous au 
chapitre 6, Configuration des E/S.

Prémixage vers une entrée auxiliaire

Entrée 
provenant du 
chemin du bus 
stéréo

Plug-in
stéréo

Sortie vers un 
chemin de 
sortie stéréo

Sorties 
vers le 
chemin du 
bus stéréo

Inserts

Départs

Piste 

Pistes audio

d'entrée 
auxiliaire
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Formats de mixage : les sessions peuvent 
combiner des pistes, bus, entrées, sorties et 
inserts mono, stéréo et multicanaux (format 
supérieur). Les formats multicanaux sont pris en 
charge uniquement sur les systèmes 
Pro Tools|HD.

Ressources système
Le nombre de pistes, le traitement des plug-in, 
les options de chemin et d'assignation du signal 
ainsi que la disponibilité des voies sont en fin de 
compte limités par les ressources associées de 
l'ordinateur hôte et de votre matériel Pro Tools. 

Pro Tools offre plusieurs manières de gérer et de 
conserver des ressources pour optimiser les 
performances de votre système. Lorsque vous 
commencez à travailler avec des sessions et des 
pistes Pro Tools, les fonctions suivantes vous 
permettront d'augmenter le rendement du DSP 
et des autres ressources disponibles :

! Pro Tools vous permet d'ajuster le mode de 
fonctionnement de votre système en changeant 
des paramètres système concernant ses capacités 
de traitement, de lecture et d'enregistrement. 
Voir Configuration des paramètres du système 
Pro Tools (dans le moteur de lecture), page 40.

! Pro Tools permet de désactiver manuellement 
certains éléments de la session (tels que les pistes 
et les inserts), afin de libérer des ressources DSP. 
Les éléments inactives sont visibles, peuvent 
être édités et sont conservés dans la session. 
Pour plus d'informations, reportez-vous à la 
section Eléments actifs et inactifs, page 14.

! Tous les systèmes Pro Tools offrent des 
options souples de voix pour les pistes audio, 
afin d'optimiser l'utilisation des voix disponibles 
de votre système. Pour plus d'informations sur la 
gestion et les options de voix, reportez-vous à la 
section Emprunt des voix, page 162. 

Eléments actifs et inactifs

Pro Tools permet de définir certains éléments de 
la session (tels que les pistes et les inserts) 
comme étant inactifs, afin de libérer des 
ressources DSP et des connexions à la console. 

Les éléments de Pro Tools qui prennent en 
charge les modes d'activation et de désactivation 
sont les suivants :

• Pistes audio, d'entrée auxiliaire, de fader 
principal, de VCA principal et d'instrument

• Entrées et sorties de pistes

• Départs

• Entrées latérales (sidechain)

• Plug-in

• Inserts matériels

• Chemins (à l'échelle de la session)

Outre le réglage manuel des modes Active et 
Inactive, Pro Tools désactive automatiquement 
certains éléments en cas de ressources 
insuffisantes ou indisponibles. 

Lorsqu'ils sont actifs, les éléments sont 
entièrement engagés et opérationnels.

Lorsqu'ils sont inactifs, les éléments sont 
silencieux et hors service, bien que la plupart des 
contrôles qui leur sont associés demeurent 
réglables. Différents éléments inactifs ont une 
incidence particulière sur les ressources système 
disponibles.

Plug-in : lorsqu'un plug-in est inactif sur une 
piste, son DSP est disponible pour d'autres 
plug-in ou traitements. Les affectations des 
plug-in peuvent être désactivées soit 
manuellement, soit automatiquement (voir 
Mode inactif automatique et manuel, page 15). 

Les pistes MIDI ne peuvent être désactivées. 
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Chemin et affectation des chemins : lorsqu'un 
chemin ou l'affectation d'un chemin est 
désactivé(e), les ressources du chemin sont 
libérées au niveau de la console de mixage pour 
d'autres besoins d'assignation de signal de la 
session. La désactivation des chemins et des 
affectations peut s'effectuer soit manuellement, 
soit automatiquement (voir Mode inactif 
automatique et manuel, page 15).

Pistes : lorsqu'une piste est rendue inactive, ses 
voix sont utilisables par une autre piste. Les 
pistes mono inactives libèrent jusqu'à une voix, 
tandis que les pistes stéréo et multicanaux 
libèrent une voix par canal. De plus, lorsqu'une 
piste audio, d'entrée auxiliaire, d'instrument ou 
de fader principal est inactive, les plug-in, 
inserts, départs et affectations d'E/S 
correspondants le sont aussi, et le DSP associé 
est libéré et devient utilisable ailleurs dans la 
session.

Affichage des éléments inactifs

Lorsque des éléments sont inactifs, leurs noms 
apparaissent en italiques, sur un fond gris foncé. 
Lorsqu'une piste est inactive, la voie de console 
entière s'assombrit.

Mode inactif automatique et manuel

Les modes Active et Inactive constituent de 
puissantes options pour le transfert de session, 
et pour la gestion des ressources du système. 
Pro Tools permet de commuter 
automatiquement ou manuellement le mode 
inactif. Vous pouvez désactiver (ou activer) 
manuellement les éléments pour gérer de façon 
sélective les ressources du système au cours de 
l'édition et du mixage.

Eléments et pistes actifs et inactifs

Actif Plug-in inactif 

Piste inactive 
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Désactivation automatique des éléments

Lorsque vous ouvrez une session, il se peut que 
certains chemins de signaux, plug-in ou 
interfaces audio utilisés dans la session ne soient 
pas tous disponibles sous la forme définie sur le 
système. Lorsque vous ouvrez une session, il est 
possible qu'un nombre insuffisant de voix soit 
disponible si la session a été créée sur un type de 
système Pro Tools différent (par exemple, en 
créant une session sur un système Pro Tools HD, 
puis en l'ouvrant sur un système Pro Tools LE).

Lorsque ceci se produit, la session s'ouvre 
comme elle avait été enregistrée. Tous les 
éléments qui ne sont pas disponibles ou qui ne 
peuvent être chargés du fait de ressources 
insuffisantes, sont désactivés.

Commutation inactive manuelle

Vous pouvez faire appel manuellement aux 
modes Active ou Inactive pour gérer les 
ressources du système. Lorsque vous désactivez 
un élément, les ressources qui lui étaient 
associées sont à nouveau disponibles pour 
d'autres tâches de la session. 

Vous trouverez ci-après les instructions de base 
pour désactiver manuellement des éléments. 
Dans l'ensemble du Guide de référence Pro Tools, 
vous trouverez des instructions s’appliquant dès 
qu'un élément peut être désactivé. 

Pour activer ou désactiver un élément :

" Cliquez sur l'élément en maintenant les 
touches Pomme+Ctrl (Mac) ou Ctrl+Démarrer 
(Windows) enfoncées. 

Vous pouvez appliquer les modes Active ou 
Inactive à toutes les pistes ou à l'ensemble des 
pistes sélectionnées en utilisant les touches de 
modification standard de Pro Tools (Option et 
Option+Maj sur Mac, Alt et Alt+Maj sous 
Windows). 

Les entrées latérales prennent en charge la 
commutation active et inactive directe, mais ne 
suivent pas la commutation de toutes les pistes 
ou de l'ensemble des entrées latérales 
sélectionnées.

Piste
MIDI (Musical Instrument Digital Interface) est 
un protocole de communication destiné aux 
instruments de musique. Cette norme définie 
par les constructeurs permet de relier entre eux 
deux périphériques, quels qu'en soient la 
marque ou le modèle. Parmi les appareils 
pourvus de fonctions MIDI, citons les 
synthétiseurs, les modules sonores, les boîtes à 
rythmes, les patchs, les processeurs d'effets, les 
interfaces MIDI, les surfaces de contrôle MIDI et 
les séquenceurs. 

Les périphériques MIDI sont dotés de 
connecteurs DIN à 5 broches, repérés IN, OUT, 
ou THRU. Le port MIDI OUT émet les messages. 
Le port MIDI IN reçoit les messages. MIDI THRU 
transmet les données en provenance du port IN. 
Les périphériques MIDI se connectent à l'aide de 
câbles MIDI que l'on peut se procurer auprès de 
la plupart des revendeurs d'instruments de 
musique.

Flux de signaux MIDI

Tous les périphériques ne possèdent pas 
forcément les trois ports MIDI (IN, OUT et 
THRU).

transmission des données d'entrée
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Le protocole MIDI offre 16 canaux MIDI par 
port. Un même câble MIDI peut transmettre un 
ensemble de messages distincts concernant 
chacun des 16 canaux. Ces 16 canaux peuvent 
correspondre à différents périphériques MIDI ou 
à plusieurs canaux d'un même équipement (si 
celui-ci est multitimbral). Chaque canal peut 
contrôler un son d'instrument différent. 
Exemple : la basse sur le canal 1, le piano sur le 
canal 2 et la batterie sur le canal 10. 
Tout comme un magnétophone multipiste, un 
séquenceur MIDI peut enregistrer des 
arrangements complexes, même en n'utilisant 
qu'un seul clavier multitimbral.

Termes MIDI

Vous trouverez ci-après un certain nombre de 
termes MIDI courants :

Instrument MIDI : appareil ou logiciel 
instrumental MIDI (par exemple, un plug-in 
d'instrument).

Interface MIDI : dispositif permettant de relier 
des périphériques MIDI à un ordinateur. 

Appareil MIDI : tout clavier MIDI physique, 
générateur sonore, périphérique d'effets ou 
autre équipement capable d'envoyer ou de 
recevoir des informations MIDI.

Contrôleur MIDI : tout périphérique MIDI 
pouvant transmettre des données MIDI 
correspondant à une action, au jeu d'un 
instrumentiste... Il s'agit entre autres des claviers 
MIDI et des contrôleurs de guitare et 
d'instrument à vent MIDI. Les contrôleurs 
transmettent les informations MIDI depuis de 
leur port MIDI OUT.

Surface de contrôle MIDI : tout périphérique, tel 
que la MackieHUI (Human User Interface), 
utilisant une connexion MIDI pour envoyer des 
messages de contrôle vers un logiciel, mais qui 
n'est généralement pas utilisé pour enregistrer 
des informations MIDI. 

Générateur de signaux MIDI (Générateur sonore 
MIDI) : tout appareil MIDI pouvant lire un son 
MIDI. Les sources sonores reçoivent des données 
MIDI via les ports MIDI IN et transmettent des 
données audio via les sorties audio.

Multitimbral : capacité d'un périphérique MIDI à 
produire plusieurs sons d'instruments 
(par exemple piano, basse, et batterie) 
simultanément sur des canaux MIDI séparés. 
Un seul instrument MIDI multitimbral peut 
donc jouer des arrangements entiers.

Canal MIDI : il est possible de transmettre 
jusqu'à 16 canaux de données de performances 
MIDI sur un même câble MIDI. Le numéro du 
canal sépare les différents messages afin que vos 
sources sonores puissent recevoir celui qui leur 
est adressé.

Evénement de changement de programme : 
commande MIDI indiquant à une source sonore 
quel son ou programme prédéterminé utiliser. 
Le protocole MIDI permet de choisir dans un 
ensemble de 128 sons.

Message de sélection de banque : la plupart des 
dispositifs comportent plus de 128 sons disposés 
en banques. Le message de sélection de banque 
est une commande MIDI indiquant la banque 
de sons dans laquelle effectuer la sélection.

Contrôle local : paramètre du contrôleur présent 
sur la plupart des claviers MIDI, qui leur permet 
d'exécuter leur propre générateur sonore. 
La désactivation du contrôle total permet de 
contrôler la source sonore interne d'un 
périphérique uniquement par l'intermédiaire de 
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messages MIDI externes (par exemple, les 
messages envoyés par Pro Tools lorsque les 
données MIDI de Pro Tools sont acheminées 
vers le clavier MIDI). Lorsque vous utilisez 
Pro Tools, le « contrôle local » doit 
généralement être désactivé. Lorsque le 
« contrôle local » est désactivé, votre clavier 
continue de transmettre des données vers son 
port MIDI OUT.

Evénements de contrôleur continu : instructions 
MIDI permettent de modifier en temps réel les 
notes que l'on entend. Exemple : le Pitch Bend 
(variation de hauteur), la modulation, le 
volume, le panoramique, etc.

Données System Exclusive : données MIDI 
couramment utilisées pour l'envoi et la 
récupération des informations des paramètres 
de sons préprogrammés, afin de permettre leur 
archivage.

Erreurs courantes à propos 
du MIDI

L'appellation MIDI représente juste des 
informations de contrôle, et non des sons à 
proprement parler. C'est un peu comme le 
rouleau de piano pour un piano : il transmet des 
informations de contrôle sur la note à jouer, sur 
la durée d'émission et sur le niveau de volume. 
Lorsque vous appuyez sur une touche d'un 
clavier MIDI, par exemple, vous envoyez un 
message à un instrument MIDI ou à un 
générateur de signaux pour signaler qu'il faut 
jouer la note en question à la vitesse 
correspondante. Il peut s'agir de son générateur 
de signaux interne, d'un instrument MIDI 
externe ou d'un plug-in d'instrument, lequel 
peut être entièrement intégré à Pro Tools. Pour 
créer ou lire un enregistrement MIDI, vous 

devez disposer d'un instrument MIDI. L'audio 
provenant de votre instrument peut être envoyé 
vers une console de mixage externe ou contrôlé 
via l'interface audio Pro Tools.

Si vous utilisez un instrument MIDI externe, 
vous devez le connecter aux ports MIDI 
reconnus par votre ordinateur. Ces ports 
peuvent se trouver sur une interface Pro Tools 
dotée de ports MIDI (par exemple, une interface 
Mbox 2) ou une autre interface MIDI (par 
exemple, une interface Digidesign MIDI I/O).

Pour entendre un périphérique MIDI externe, 
vous devez connecter ses sorties audio à une 
console de mixage ou le relier à l'une des entrées 
audio de votre interface audio Pro Tools.

Comme pour tout système Pro Tools, chaque 
périphérique MIDI a ses propres fonctionnalités 
(et limitations) de gestion du nombre de voix et 
d'instruments susceptibles d'être reproduits à la 
fois. Pour plus d'informations concernant les 
fonctionnalités et limitations de chaque 
périphérique MIDI, consultez la documentation 
correspondante.

Chemins des signaux des instruments MIDI externes
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Nœuds MIDI virtuels

Lorsque vous utilisez la fonctionnalité MIDI 
avec des plug-in d'instrument dans Pro Tools, 
des nœuds MIDI virtuels sont créés. Ces nœuds 
fonctionnent comme des ports MIDI et offrent 
des connexions MIDI logicielles entre Pro Tools 
et d'autres logiciels MIDI, comme les plug-in 
d'instrument. Si vous insérez, par exemple, 
Reason de Propellerhead comme client ReWire 
sur une piste, ses diverses entrées MIDI vers 
Reason deviennent disponibles pour les sorties 
MIDI des pistes MIDI et d'instrument de 
Pro Tools. 

DigiBase
DigiBase est dédié à la gestion de base de 
données pour Pro Tools. Les outils puissants 
fournis par DigiBase étendent les capacités de 
recherche et d'importation de Pro Tools. Ils 
permettent de gérer les données internes et 
externes aux sessions, situées sur tout disque 
connecté au système.

Une base de données sert à organiser des données 
pour en faciliter la recherche, le tri, la gestion et 
l'utilisation. Par exemple, votre carnet de 
chèques peut être considéré comme un fichier 
de base de données. Chaque fois que vous faites 
un chèque, vous saisissez un nouvel 
enregistrement. Celle-ci contient des 
informations sur le chèque comme la date 
d'émission, le bénéficiaire et le montant. Elles 
sont enregistrées dans des colonnes spécifiques, 
c'est-à-dire des champs. Bien que le chèque ne se 
trouve pas lui-même dans ces colonnes, vous 
disposez de toutes les informations nécessaires 
s'y rapportant (les métadonnées du chèque).
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Chapitre 3 : Raccourcis clavier et 
menus contextuels

Ce chapitre vous donne un aperçu des 
principaux raccourcis clavier et souris utilisés 
dans Pro Tools. 

Raccourcis souris ou menus 
contextuels
Pro Tools permet d'accéder à de nombreuses 
commandes et menus du logiciel par 
l'intermédiaire du bouton droit de la souris. 

Touches de raccourci 
générales
Ce chapitre décrit des raccourcis clavier qui 
s'appliquent à de nombreuses fonctions de 
Pro Tools.

Fonctions des pistes

Pro Tools propose des raccourcis clavier pour les 
fonctions de piste suivantes :

• Changement de mode d'automation

• Activation des playlists

• Ajout de plug-in

• Préparation à l'enregistrement, la mise en 
solo et la coupure du son des pistes

• Protection des pistes en enregistrement et 
en mise en solo

• Affectation des entrées, des sorties et des 
départs

• Commutation volume/crête/retard de 
l'affichage

• Remise à zéro des afficheurs

• Modification de la hauteur des pistes

La liste de tous les raccourcis est disponible 
au format PDF dans Pro Tools. 
Sélectionnez Help > Keyboard Shortcuts.

Pour obtenir la liste complète des raccourcis 
souris, reportez-vous aux versions PDF des 
Guides des raccourcis clavier.

Commande Windows Mac

Pour appliquer 
l'action à toutes les 
voies ou pistes

Alt+ 
action

Option+
action

Pour appliquer 
l'action uniquement 
aux voies ou aux 
pistes sélectionnées

Alt+Maj+
action

Option+
Maj+ 
action
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Sélection des listes et des paramètres

Pro Tools propose des raccourcis clavier pour les 
éléments suivants :

• Sélection des pistes dans la liste des pistes

• Activation de groupes dans une liste de 
groupes

• Paramètres de la fenêtre Automation 
Enable

• Définition des paramètres d'emplacement 
mémoire

Commandes et outils d'édition

Pro Tools propose des raccourcis clavier pour 
déplacer les commandes de plug-in, les faders et 
les curseurs, l'outil Scrub et les données 
d'automation.

Focus clavier
Le focus clavier de Pro Tools détermine le 
fonctionnement des touches alphanumériques. 
Selon le focus clavier activé, les touches de votre 
clavier alphanumérique peuvent servir à 
sélectionner des régions de la liste des régions, à 
activer ou désactiver des groupes, ou à appeler 
une commande d'édition ou de lecture.

Vous ne pouvez activer qu'un seul des trois focus 
clavier à la fois. L'activation d'un focus clavier 
désactive le focus activé précédemment.

Pro Tools propose trois types de focus clavier :

Focus clavier sur les commandes : lorsque cette 
option est sélectionnée, elle donne accès à de 
nombreux raccourcis directs sur le clavier 
alphabétique pour l'édition et la lecture.

Lorsque le focus clavier sur les commandes est 
désactivé, vous avez toujours accès à n'importe 
lequel de ses raccourcis clavier en maintenant la 
touche Ctrlle (Mac) ou Démarrer (Windows) 
enfoncée pendant que vous appuyez sur la 
touche appropriée.

Focus clavier sur la liste des régions : lorsque 
cette option est sélectionnée, vous pouvez 
rechercher et sélectionner les régions audio, les 
régions MIDI et les groupes de régions dans la 
liste des régions en tapant les premières lettres 
de leur nom.

Commande Windows Mac

Pour basculer 
l'élément et régler 
tous les autres sur 
un même état 
nouveau

Alt+clic sur 
l'élément

Option+clic 
sur 
l'élément

Pour basculer 
l'élément et régler 
tous les autres sur 
l'état inverse

Ctrl+clic sur 
l'élément

Pomme+clic 
sur 
l'élément

Commande Windows Mac

Pour un réglage 
précis des 
curseurs, 
boutons et 
points 
d'inflexion

Ctrl+clic sur 
l'élément

Pomme+clic sur 
l'élément
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Focus clavier sur la liste des groupes : 
lorsque cette option est sélectionnée, vous 
pouvez activer ou désactiver les groupes 
d'édition et de mixage en tapant leur lettre 
d'identification (dans la fenêtre Mix ou Edit).

Pour définir le focus clavier, effectuez l'une des 
opérations suivantes :

" Cliquez sur le bouton a-z pour déterminer le 
focus que vous voulez activer.

– ou –

" Maintenez les touches Pomme+Alt (Mac) ou 
Ctrl+Alt (Windows) enfoncées pendant que 
vous appuyez sur l'une des touches suivantes : 
1 (Commandes), 2 (Liste des régions) ou 3 (Liste 
des groupes).

Modes du pavé numérique
Les préférences de fonctionnement du mode du 
pavé numérique en déterminent le 
comportement pour la fenêtre Transport.

Il y a deux modes Shuttle Lock (Shuttle 
verrouillé) « Classic » et « Transport » et un 
mode Shuttle.

Quel que soit le mode sélectionné, vous pouvez 
toujours utiliser le pavé numérique pour 
sélectionner et entrer des valeurs dans les 
champs de la zone d'édition des événements, 
des indicateurs de sélection d'édition, des 
compteurs principal et secondaire et du 
transport.

Pour définir le mode du pavé numérique :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation.

2  Dans la section Transport, sélectionnez le 
mode de pavé numérique (Classic, Transport ou 
Shuttle).

3  Cliquez sur OK. 

Modes Shuttle Lock

En mode Shuttle Lock (aussi bien Classic que 
Transport), vous pouvez utiliser le pavé 
numérique pour effectuer un shuttle avant ou 
arrière à la vitesse que vous désirez :

• La touche 5 correspond à la vitesse 
normale.

• Les touches de 6 à 9 permettent d'avancer à 
des vitesses progressivement plus rapides.

Bouton de focus clavier

Bien qu'il soit possible d'activer un focus 
clavier pour plusieurs fenêtres de plug-in, la 
saisie clavier s'applique uniquement à la 
fenêtre située au premier plan.

Focus clavier sur la 
liste des régions

Focus clavier sur la 
liste des groupes

Focus clavier sur les 
commandes (dans la barre 

de la fenêtre Edit)

Pour plus d'informations sur ces différents 
modes, consultez la section Mode Numeric 
Keypad, page 81.



Guide de référence Pro Tools24

• Les touches de 4 à 1 permettent de reculer 
de plus en plus vite (4 correspond à la 
vitesse Shuttle Lock la plus lente et 1 à la 
plus rapide).

• Appuyer sur 0 pour arrêter le mode Shuttle 
Lock, puis appuyez sur le chiffre voulu pour 
rétablir la vitesse Shuttle Lock 
correspondante.

• Appuyer sur la touche Echap ou sur la barre 
espace pour quitter le mode Shuttle Lock.

Vitesse Shuttle Lock personnalisée

(Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement)

Il est possible de personnaliser la vitesse Shuttle 
Lock d'avance rapide la plus élevée (touche 9).

Mode Classic

Ce mode reproduit le fonctionnement de 
Pro Tools dans ses versions antérieures à la 
version 5.0. Lorsque le mode du pavé 
numérique est défini sur Classic, vous pouvez :

• Lire jusqu'à deux pistes audio en mode 
Shuttle verrouillé. Appuyez sur Ctrl (Mac) 
ou Démarrer (Windows), puis sur un chiffre 
de1 à 9 pour sélectionner la vitesse de 
lecture. 

• Appuyer sur la touche plus ou moins pour 
inverser la direction.

• Appuyer sur 0 pour arrêter le mode Shuttle 
Lock, puis appuyez sur le chiffre voulu pour 
rétablir la vitesse Shuttle Lock 
correspondante.

• Appuyer sur la touche Echap ou sur la barre 
espace pour quitter le mode Shuttle Lock.

• Rappeler un emplacement mémoire en 
tapant son numéro, suivi d'un point(.).

Mode Transport

Ce mode permet de définir un ensemble de 
fonctions d'enregistrement et de lecture et de 
piloter les transports depuis le clavier 
numérique.
:

Lorsque le mode du pavé numérique est réglé sur 
Transport, vous pouvez également :

• Lire jusqu'à deux pistes audio en mode 
Shuttle verrouillé. Appuyez sur Ctrl (Mac) 
ou Démarrer (Windows), puis sur un chiffre 
de1 à 9 pour sélectionner la vitesse de 
lecture. 

• Appuyer sur la touche plus ou moins pour 
inverser la direction.

• Appuyer sur 0 pour arrêter le mode Shuttle 
Lock, puis appuyez sur le chiffre voulu pour 
rétablir la vitesse Shuttle Lock 
correspondante.

Pour plus d'informations, reportez-vous à la 
section Custom Shuttle Lock Speed :, 
page 450.

Fonction Touche

Activation/désactivation du clic 7

Activation/désactivation du 
décompte

8

Mode de fusion/remplacement 
MIDI

9

Activation/désactivation de la 
lecture en boucle

4

Activation/désactivation de 
l'enregistrement en boucle

5

Activation/désactivation du 
mode QuickPunch

6

Retour rapide 1

Avance rapide 2

Activation à l'enregistrement 3

Lecture/Arrêt 0
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• Appuyer sur la touche Echap ou sur la barre 
espace pour quitter le mode Shuttle Lock.

• Rappeler un emplacement mémoire en 
tapant un point (.), le numéro de 
l'emplacement mémoire, puis un autre 
point (.).

Mode Shuttle
(Pro Tools HD uniquement)

Pro Tools offre une autre forme de lecture en 
mode Shuttle, différente de celles des deux 
modes Shuttle Lock. Lorsque le mode du clavier 
numérique est réglé sur Shuttle, la lecture de la 
sélection d'édition actuelle commence lorsque 
vous appuyez sur les touches du clavier 
numérique et dure tant que vous les maintenez 
enfoncées ; la lecture s'arrête dès relâchement 
des touches. Vous pouvez définir plusieurs 
vitesses de lecture, en avant ou en arrière. Dans 
ce mode, les pré/post-roll sont ignorés.
:

Lorsque le mode du pavé numérique est défini 
sur Shuttle, vous pouvez également :

• Rappeler un emplacement mémoire en tapant 
un point (.), le numéro de l'emplacement 
mémoire, puis un autre point (.).

Vitesses de lecture Touche

1x Avance rapide 6

1x Retour arrière 4

4x Avance rapide 9

4x Retour arrière 7

1/4x Avance rapide 3

1/4x Retour arrière 1

1/2x Avance rapide 5+6

1/2x Retour arrière 5+4

2x Avance rapide 8+9

2x Retour arrière 8+7

1/16x Avance rapide 2+3

1/16x Retour arrière 2+1

Sélection de boucle (1x) 0

Les modes Shuttle Lock ne sont pas 
disponibles lorsque le mode du pavé 
numérique est réglé sur Shuttle.
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Chapitre 4 : Systèmes Pro Tools

Il existe quatre types de systèmes Pro Tools :

Pro Tools|HD : systèmes incluant le logiciel 
Pro Tools HD® pour le matériel système 
Pro Tools|HD.

Pro Tools LE : systèmes incluant le logiciel 
Pro Tools LE pour Digi 002®, Digi 002 Rack™, 
Mbox® 2, Mbox 2 Pro, Mbox 2 Mini, ou Mbox.

Pro Tools M-Powered : systèmes incluant le 
logiciel Pro Tools M-Powered pour les interfaces 
M-Audio® agréées Digidesign.

Pro Tools Academic : systèmes incluant le 
logiciel Pro Tools Academic pour les interfaces 
Mbox 2 et M-Audio® agréées Digidesign.

Systèmes optionnels

Pro Tools LE avec DV Toolkit 2 : systèmes 
Pro Tools LE mis à niveau avec l'option logicielle 
DV Toolkit™ 2.

Pro Tools LE ou M-Powered avec Music 
Production Toolkit : systèmes Pro Tools LE ou 
M-Powered mis à niveau avec l'option logicielle 
Music Production Toolkit.

Systèmes Pro Tools|HD
Les systèmes Pro Tools|HD sont disponibles 
dans les configurations indiquées à la page 30. 
Chaque système requiert au moins une interface 
audio Digidesign (vendue séparément). Il est 
possible d'ajouter des cartes Pro Tools|HD aux 
systèmes Pro Tools|HD, afin d'augmenter le 
nombre de pistes, le nombre de plug-in pris en 
charge, la capacité de traitement de la console de 
mixage et de connecter des interfaces audio 
supplémentaires.

Les références à Pro Tools LE dans ce guide 
s'appliquent également à Pro Tools 
M-Powered et à Pro Tools Academic, sauf 
indication contraire dans les Guides de 
démarrage Pro Tools M-Powered et 
Academic.

Les performances des systèmes Pro Tools 
dépendent de facteurs tels que la fréquence 
du processeur de l'ordinateur, la quantité de 
mémoire du système et les performances du 
disque dur. Vous pouvez obtenir les 
informations de configuration et de 
compatibilité les plus récentes auprès de 
votre revendeur Digidesign ou sur le site 
Web de Digidesign (www.digidesign.com).
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Systèmes Pro Tools|HD

Pro Tools|HD 1

Comprend les éléments suivants :

• Carte HD Core

• Logiciel Pro Tools HD

Pro Tools|HD 2 Accel

Comprend les éléments suivants :

• Carte HD Core

• Carte HD Accel

• Logiciel Pro Tools HD

Pro Tools|HD 3 Accel

Comprend les éléments suivants :

• Carte HD Core

• Deux cartes HD Accel

• Logiciel Pro Tools HD

Pro Tools|HD 2

Comprend les éléments suivants :

• Carte HD Core

• Carte HD Process

• Logiciel Pro Tools HD

Pro Tools|HD 3

Comprend les éléments suivants :

• Carte HD Core

• Deux cartes HD Process

• Logiciel Pro Tools HD

Systèmes Pro Tools|HD étendus

Tout système Pro Tools|HD peut être étendu en 
ajoutant des cartes HD Process ou HD Accel 
supplémentaires. Pour plus d'informations, 
consultez le Guide des systèmes étendus.

Interfaces audio prises en charge
(systèmes Pro Tools|HD uniquement)

Les interfaces audio suivantes sont compatibles 
avec les systèmes Pro Tools|HD :

• 192 I/O™

• 192 Digital I/O™

• 96 I/O™

• 96i I/O™

Les interfaces audio Digidesign Legacy suivantes 
sont prises en charge par les systèmes 
Pro Tools|HD :

• 888|24 I/O™ et 882|20 I/O™

• 1622 I/O™

• Interface ADAT Bridge I/O™ 24 bits

Les cartes HD Accel et HD Process peuvent 
être utilisées au sein du même système. 
Pour plus d'informations, reportez-vous au 
Guide de démarrage Pro Tools|HD.

Les systèmes Pro Tools|HD requièrent 
l'utilisation d'au moins une interface 
192 I/O, 192 digital I/O, 96 I/O ou 96i I/O.

Les interfaces Legacy I/O (par exemple, 
I/O 888|24) nécessitent l'utilisation d'au 
moins une interface I/O 192, I/O 
numérique 192, I/O 96, ou I/O 96i.
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Nombre maximal de voix en lecture ou en enregistrement sur les 
systèmes Pro Tools|HD

 Le tableau suivant indique le nombre maximal de voix en lecture et en enregistrement pour chaque 
type de système Pro Tools|HD. Les voix en lecture et en enregistrement se réfèrent au nombre de pistes 
de lecture et d'enregistrement simultanées sur votre système. Le nombre total de « pistes pouvant 
héberger des voix » renvoie au nombre maximal de pistes audio pouvant se partager les voix 
disponibles de votre système. (Une piste mono utilise une seule voix. Les pistes stéréo et multicanaux 
utilisent une voix par canal.) Les limites des voix dépendent de la fréquence d'échantillonnage de la 
session et du nombre de puces DSP dédiées au moteur de lecture du système. Les systèmes 
Pro Tools|HD peuvent ouvrir des sessions contenant un maximum de 256 pistes audio, mais les pistes 
audio dépassant les limites des pistes pouvant héberger les voix seront définies automatiquement sur 
Voice Off. 

Les systèmes Pro Tools|HD offrent jusqu'à 160 pistes (entrées) auxiliaires et un total de 128 bus de 
mixage interne. Ces systèmes offrent également jusqu'à 5 inserts et 10 départs par piste (en fonction 
de leur capacité DSP). Les systèmes Pro Tools|HD prennent également en charge jusqu'à 128 pistes 
d'instrument, 256 pistes MIDI, 128 pistes VCA et plusieurs pistes vidéo.

Tableau 1. Nombre maximal de voix en lecture ou en enregistrement simultanés sur les systèmes Pro ToolsTools|HD

Type de système de base

Fréquence 
d'échan-
tillonnage 
(kHz)

Voix en lecture 
(pistes mono en 
lecture simulta-
née)

Voix en enregis-
trement (pistes 
mono en lec-
ture simulta-
née)

Pistes 
totales 
héber-
geant des 
voix

Pro Tools|HD 1 : 44.1/48 96 96 112

88.2/96 48 48 48

176.4/192 12 12 12

Pro Tools|HD Accel 2,
Pro Tools|HD Accel 3

44.1/48 192 192 224

88.2/96 96 96 120

176.4/192 36 36 36

Pro Tools|HD 2,
Pro Tools|HD 3,
ou tout système Pro Tools|HD étendu

44.1/48 128 128 224

88.2/96 64 64 80

176.4/192 24 24 24
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Interfaces audio pour les systèmes Pro Tools|HD

Le tableau 2 récapitule les capacités d'entrée et de sortie des différentes interfaces audio des systèmes 
Pro Tools|HD.

Vous pouvez ajouter à votre système Pro Tools|HD plusieurs cartes d'extension Pro Tools|HD, soit 
directement à l'intérieur de l'ordinateur, soit en utilisant un châssis d'extension. En procédant de la 
sorte, vous augmentez le nombre de pistes et de plug-in ainsi que la capacité de traitement de la 
console de mixage et pouvez connecter des interfaces audio supplémentaires. Pour plus 
d'informations, consultez le Guide des systèmes étendus.

Tableau 2. Nombre de canaux des interfaces audio du système Pro Tools|HD

Type d'interface
Nombre de 
canaux I/O

Fréquences 
d'échantillon-
nage (kHz)

Conversion 
A/N

Conversion 
N/A

E/S 
numérique

192 I/O 16 entrées/16 
sorties

44.1, 48, 88.2, 
96, 176.4, 192

24 bits 24 bits 24 bits

192 Digital I/O 16 entrées/16 
sorties

44.1, 48, 88.2, 
96, 176.4, 192

Aucune Aucune 24 bits

96 I/O 16 entrées/16 
sorties

44.1, 48, 88.2, 
96

24 bits 24 bits 24 bits

96i I/O 16 entrées/2 
sorties

44.1, 48, 88.2, 
96

24 bits 24 bits 24 bits

888|24 I/O 20 entrées/8 
sorties

44.1, 48 24 bits 24 bits (ou 
20 bits, sur 
I/O 
anciennes)

24 bits

882|20 I/O 20 entrées/8 
sorties

44.1, 48 20 bits 20 bits 24 bits

1622 I/O 16 entrées/2 
sorties

44.1, 48 20 bits 24 bits 24 bits

E/S ADAT Bridge 
24 bits, interface

16 entrées/16 
sorties

44.1, 48 Aucune 24 bits 24 bits

Les interfaces Legacy I/O (par exemple, I/O 888|24) nécessitent l'utilisation d'au moins une interface 
I/O 192, I/O numérique 192, I/O 96, ou I/O 96i.
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Systèmes Pro Tools LE
Les systèmes Pro Tools LE sont disponibles dans 
les configurations suivantes :

Digi 002

Un système Digi 002 se compose des éléments 
suivants :

• Logiciel Pro Tools LE

• Interface audio et MIDI Digi 002 avec surface 
de contrôle

Digi 002 Rack

Un système Digi 002 Rack comprend les 
éléments suivants :

• Logiciel Pro Tools LE

• Interfaces audio et MIDI Digi 002

Mbox 2 Pro

Un système Mbox 2 se compose des éléments 
suivants :

• Logiciel Pro Tools LE

• Interfaces audio et MIDI Mbox 2 Pro

Mbox 2

Un système Mbox 2 se compose des éléments 
suivants :

• Logiciel Pro Tools LE

• Interfaces audio et MIDI Mbox 2

Mbox 2 Mini

Un système Mbox 2 se compose des éléments 
suivants :

• Logiciel Pro Tools LE

• Interface audio Mbox 2 Mini

Mbox

Un système Mbox se compose des éléments 
suivants :

• Logiciel Pro Tools LE

• Interface audio Mbox

Capacité de traitement

La capacité totale de traitement d'un 
système Pro Tools LE dépend de la 
puissance du processeur de votre ordinateur. 
Vous pouvez obtenir les informations les 
plus récentes concernant les exigences 
système et la compatibilité auprès de votre 
revendeur Digidesign ou sur le site Web de 
Digidesign (www.digidesign.com).
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Fonctionnalités des systèmes Pro Tools LE

Le tableau 3 indique les capacités en lecture, en enregistrement et en entrée/sortie de chaque système 
Pro Tools LE. Les pistes mono en lecture simultanée se réfèrent au nombre de pistes de lecture et 
d'enregistrement simultanées sur votre système. Le nombre total de « pistes pouvant héberger des 
voix » renvoie au nombre maximal de pistes audio pouvant se partager les voix disponibles de votre 
système. (Les pistes mono utilisent une seule piste audio, tandis que les pistes stéréo utilisent jusqu'à 
deux pistes.) Si vous ouvrez une session Pro Tools créée sur un système Pro Tools|HD avec plus de 
pistes que le système LE le permet, les pistes dépassant le nombre admis sont automatiquement 
réglées sur inactives.

Les systèmes Pro Tools LE offrent jusqu'à 128 pistes d'entrées auxiliaires, un total de 32 bus de mixage 
interne et jusqu'à 5 inserts et 10 départs par piste (suivant la capacité de traitement de votre 
ordinateur). De plus, les systèmes Pro Tools LE prennent en charge jusqu'à 32 pistes d'instrument et 
jusqu'à 256 pistes MIDI. Pro Tools LE prend également en charge une piste vidéo QuickTime.

Pour plus d'informations sur le transfert de données de session entre systèmes Pro Tools|HD et 
Pro Tools LE, reportez-vous à la section Partage de sessions créées sur des systèmes Pro Tools 
différents, page 291.

Tableau 3. Nombre de canaux en lecture ou en enregistrement sur les systèmes Pro Tools LE

Type de 
système

Pistes mono 
en lecture 
simultanée

Pistes tota-
les héber-
geant des 
voix

Nombre de 
canaux I/O

Conversion 
A/N

Conver-
sion N/A

E/S 
numéri-
que

Digi 002 
ou 
Digi 002 
Rack

32 128 jusqu'à 18 
entrées/18 sorties 
(à 48 kHz ou moins)

jusqu'à 10 
entrées/10 sorties 
(à 88,2 ou 96 kHz)

24 bits 24 bits 24 bits

Mbox 2 
Pro

32 128 jusqu'à 6 
entrées/8 sorties 
(à 48 kHz ou moins)

jusqu'à 4 
entrées/6 sorties 
(à 88,2 ou 96 kHz)

24 bits 24 bits 24 bits

Mbox 2 ou 
Mbox

32 128 jusqu'à 2 
entrées/2 sorties

24 bits 24 bits 24 bits

Mbox 2 
Mini

32 128 jusqu'à 2 
entrées/2 sorties

24 bits 24 bits n/d
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Pro Tools M-Powered
Un système Pro Tools M-Powered se compose 
des éléments suivants :

• Logiciel Pro Tools M-Powered

• Interface audio M-Audio agréée Digidesign 
(non fournie avec le logiciel M-Powered)

Pro Tools Academic
Un système Pro Tools Academic inclut :

• Logiciel Pro Tools Academic

• Un des éléments suivants :

• Interfaces audio et MIDI Mbox 2

– ou –

• Interface M-Audio agréée par Digidesign

DV Toolkit 2 et Music 
Production Toolkit
En plus des fonctionnalités habituelles fournies 
avec Pro Tools LE et Pro Tools M-Powered, les 
systèmes Pro Tools LE équipés du DV Toolkit 2 
et les systèmes Pro Tools LE et M-Powered 
équipés du Music Production Toolkit 
fournissent des fonctionnalités étendues.

Prise en charge de 48 pistes mono 
ou stéréo

Les systèmes Pro Tools LE avec l'option DV 
Toolkit 2 et les systèmes Pro Tools LE ou 
M-Powered avec l'option Music Production 
Toolkit vous permettent de lire ou d'enregistrer 
jusqu'à 48 pistes stéréo ou mono 
simultanément. Ces nombres élevés de pistes 
pourraient nécessiter des disques 
supplémentaires et des ordinateurs plus rapides 
agréés par Digidesign.

Prise en charge de 24 pistes 
QuickPunch

Avec DV Toolkit 2 ou Music Production Toolkit, 
vous pouvez enregistrer simultanément jusqu'à 
24 pistes mono ou stéréo avec QuickPunch.

Les références à Pro Tools LE dans ce guide 
s'appliquent également à Pro Tools 
M-Powered, sauf indication contraire dans 
le Guide de démarrage Pro Tools 
M-Powered.

Pour obtenir la liste la plus récente des 
interfaces M-Audio agréées par Digidesign, 
visitez le site web de Digidesign 
(www.digidesign.com).

Les références à Pro Tools LE dans ce 
guide s'appliquent également à Pro Tools 
Academic sauf indication contraire dans 
le Guide de démarrage Pro Tools 
Academic.

Pour obtenir la liste la plus récente des 
interfaces M-Audio agréées par Digidesign, 
visitez le site web de Digidesign 
(www.digidesign.com).

Pour plus d'informations, consultez le site 
Web Digidesign (www.digidesign.com).

Pour plus d'informations sur la priorité de 
pistes et l'assignation de voix, consultez la 
section Assignation des voix avec les 
options Toolkit, page 161.

Le nombre de pistes audio et 
QuickPunch total ne peut pas 
dépasser 48.
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Fonctions DV Toolkit 2
(Pro Tools LE uniquement)

Fonctions Pro Tools LE

DV Toolkit 2 active les fonctions suivantes pour 
les travaux sur film, vidéo ou vidéo numérique 
dans Pro Tools LE :

• Fonctions relatives aux sessions et aux pistes :

• Jusqu'à 48 pistes audio (stéréo ou mono) en 
lecture ou enregistrement simultané

• Pistes vidéo multiples, avec plusieurs 
playlists vidéo et films QuickTime par piste

• Possibilité d'utilisation de 24 pistes 
QuickPunch

• Options d'importation des données de 
session (Destination Track Names, Time 
Code Mapping, Find Matching Tracks, 
Session Data to Import, Track Playlist)

• Option d'exportation au format MP3 
(pour l'enregistrement en prémixage ou 
l'exportation d'une région en tant que 
fichier MP3)

• DigiBase Pro (avec prise en charge des 
navigateurs de catalogues et fonction de 
recherche simultanée selon plusieurs 
critères dans les navigateurs DigiBase)

• Fonctions d'édition :

• Fenêtre Universe

• Défilement continu

• Outil Scrub Trim

• Commande Replace Region

• Commande TCE Edit to Timeline Selection 

• Sélection de canaux audio alternatifs 
provenant d'un appareil d'enregistrement 
portable dans la timeline Pro Tools

• Expansion de canaux audio alternatifs 
provenant d'un appareil d'enregistrement 
portable vers de nouvelles pistes

• Fonctions de mixage et d'automation

• Automation instantanée pour l'écriture ou 
le rognage des données d'automation

• Commandes Glide Automation 

• Fonctions relatives au timecode et à la 
synchronisation :

• Règles temporelles (Time Code et 
Feet+Frames)

• Sélecteur de fréquence de timecode

• Sélecteur de fréquence Feet+Frames

• Commande Current Time Code Position

• Commande Current Feet+Frames Position 

• Option Use Subframes

• Accélération et ralentissement audio 
(Pull up et Pull down)

• Accélération et ralentissement vidéo 
(Pull up et Pull down)

Logiciels supplémentaires

DV Toolkit 2 inclut les logiciels supplémentaires 
suivants pour les travaux sur film, vidéo ou 
vidéo numérique dans Pro Tools LE :

Plug-in DINR™ (Digidesign Intelligent Noise 
Reduction™) LE : pour la réduction du bruit 
dans les données audio.

Option logicielle DigiTranslator™ : 
pour l'échange de fichiers audio/vidéo et de 
séquences avec d'autres applications 
compatibles AAF et OMFI.

TL Space Native™ Convolution Reverb Plug-in : 
pour l'application de la réverbération de 
convolution à vos données audio.

Plug-in VocALign Project du logiciel 
Synchro Arts : pour le réglage automatique de la 
synchronisation d'un signal audio par rapport à 
un autre signal.
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Présentation du Music Production 
Toolkit
(Pro Tools LE et M-Powered uniquement)

Fonctions Pro Tools

Music Production Toolkit active les fonctions 
suivantes dans Pro Tools LE et M-Powered :

• Fonctions relatives aux sessions et aux pistes :

• Jusqu'à 48 pistes audio (stéréo ou mono) en 
lecture ou enregistrement simultané

• Possibilité d'utilisation de 24 pistes 
QuickPunch

• Option d'exportation au format MP3 (pour 
l'enregistrement en prémixage ou 
l'exportation d'une région en tant que 
fichier MP3)

• Fonctions Beat Detective :

• Possibilité d'application de Beat Detective à 
plusieurs pistes

• Mode Collection

Logiciels supplémentaires

Music Production Toolkit inclut les logiciels 
supplémentaires suivants pour travailler avec 
Pro Tools LE et M-Powered :

Plug-in DINR™ (Digidesign Intelligent Noise 
Reduction™) LE : pour la réduction du bruit 
dans les données audio.

Plug-in Hybrid RTAS Synthesizer : 
pour l'utilisation d'un instrument virtuel dans 
vos sessions Pro Tools.

Plug-in Smack!™ LE Compressor : 
pour l'application de compression à vos 
données audio.

Plug-in SoundReplacer™ : pour le remplacement 
d'un son dans une piste par un autre son 
(par exemple, remplacement de la caisse claire 
dans votre piste batterie par un autre 
échantillon).

TL Space Native™ Convolution Reverb Plug-in : 
pour l'application de la réverbération de 
convolution à vos données audio.
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Chapitre 5 : Paramètres du système

Démarrage et arrêt du 
système
Pour que les différents composants de votre 
système Pro Tools puissent communiquer 
correctement entre eux, vous devez les mettre 
sous tension dans un ordre précis.

Lancez le système Pro Tools selon l'ordre suivant :

1  Dans le cas des systèmes Pro Tools|HD dotés 
d'un châssis d'extension, mettez ce dernier sous 
tension.

2  Mettez tous les disques durs externes sous 
tension. Patientez environ 10 secondes jusqu'à 
ce qu'ils aient atteint leur vitesse nominale.

3  Mettez sous tension les interfaces et 
périphériques MIDI ou les périphériques de 
synchronisation.

4  Diminuez le volume de tous les périphériques 
de sortie du système. 

5  En fonction de votre système Pro Tools, 
effectuez l'une des opérations suivantes :

• S'il s'agit d'un système Pro Tools|HD, 
mettez vos interfaces audio Pro Tools sous 
tension. Attendez au moins 15 secondes 
que le dispositif constituant le système soit 
initialisé.

• Pour les systèmes Pro Tools LE, M-Powered 
et Academic utilisant du matériel 
nécessitant une alimentation externe 
(comme Digi 002), mettez le matériel sous 
tension.

6  Mettez l'ordinateur sous tension. 

7  Lancez Pro Tools ou toute autre application 
tierce audio ou MIDI. 

Arrêtez votre système Pro Tools dans l'ordre 
suivant :

1  Quittez Pro Tools et toute autre application 
utilisée. 

2  Réduisez le volume de tous les périphériques 
de sortie du système. 

3  Mettez votre ordinateur hors tension.

4  En fonction de votre système Pro Tools, 
effectuez l'une des opérations suivantes :

• S'il s'agit d'un système Pro Tools|HD, 
éteignez vos interfaces audio Pro Tools.

• Pour les systèmes Pro Tools LE, M-Powered 
et Academic utilisant du matériel 
nécessitant une alimentation externe 
(comme Digi 002), éteignez le matériel.

5  Dans le cas des systèmes Pro Tools|HD dotés 
d'un châssis d'extension, mettez ce dernier hors 
tension.

Pour quitter Pro Tools, choisissez File > Exit 
(Windows) ou Pro Tools > Quit (Mac).
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6  Mettez hors tension les interfaces et 
périphériques MIDI ou les périphériques de 
synchronisation.

7  Mettez hors tension les disques durs externes.

Configuration des paramètres 
du système Pro Tools (dans le 
moteur de lecture)
Pro Tools vous permet d'ajuster le mode de 
fonctionnement de votre système en changeant 
des paramètres système concernant sa capacité de 
traitement, de lecture et d'enregistrement.

Ces paramètres système sont disponibles dans la 
boîte de dialogue Playback Engine (Setup > 
Playback Engine).

Dans la plupart des cas, les paramètres par 
défaut de votre système fournissent des 
performances optimales, mais vous pouvez 
souhaiter les régler afin que le système puisse 
prendre en charge de longues sessions et des 
sessions à traitement intensif de Pro Tools. 

Taille du buffer matériel

La taille du buffer matériel (H/W Buffer Size) 
contrôle la taille du cache matériel utilisé pour 
effectuer les tâches de traitement hôte, telles que 
le traitement des effets des plug-in temps réel 
(RTAS). 

! Des valeurs inférieures réduisent la latence 
d'écoute et sont particulièrement adaptées à 
l'enregistrement des entrées en direct. 

! Des valeurs supérieures permettent d'effectuer 
un traitement audio plus avancé et sont 
particulièrement adaptées au mixage de longues 
sessions et à l'utilisation d'un nombre supérieur 
de plug-in RTAS.

Pour modifier la taille du buffer matériel :

1  Sélectionnez Setup > Playback Engine. 

2  Dans le menu contextuel H/W Buffer Size, 
sélectionnez la taille du buffer audio, exprimée 
en échantillons. 

3  Cliquez sur OK. 

Processeurs RTAS

Le paramètre RTAS Processors permet de 
déterminer le nombre de processeurs de votre 
ordinateur alloués au traitement des plug-in 
RTAS (plug-in en temps réel).

Dans le cas d'ordinateurs équipés de plusieurs 
processeurs ou de la fonction de traitement 
multicœur ou Hyper-Threading, ce paramètre 
vous permet d'activer la prise en charge 
multiprocesseur pour les plug-in RTAS. Utilisé 
conjointement avec le paramètre CPU Usage 
Limit, il vous permet de contrôler le traitement 
RTAS et d'autres tâches Pro Tools gérées par le 
système. Par exemple : 

• Pour les sessions avec un nombre important 
de plug-in RTAS, vous pouvez allouer 
2 processeurs ou plus aux traitements RTAS et 
paramétrer une limite d'utilisation des 
processeurs élevée.

Un buffer de grande taille entraîne une 
réponse plus lente de l'écran et une certaine 
latence d'écoute, et risque d'affecter la 
précision de l'automation des plug-in, les 
données de Mute et les pistes MIDI.
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• Pour les sessions comptant un faible nombre 
de plug-in RTAS, limitez le nombre de 
processeurs alloués à ces plug-in et prévoyez 
une limite d'utilisation de processeur réduite 
pour éviter de monopoliser les ressources et 
optimiser la précision de l'automation, la 
réponse de l'écran et les performances vidéo. 

• Augmentez ces paramètres pour assurer la 
conversion de plug-in TDM/RTAS. 
Inversement, diminuez ces paramètres si vous 
n'utilisez que des plug-in TDM ou convertissez 
des plug-in RTAS en TDM. La conversion 
TDM/RTAS peut s'avérer nécessaire lors de 
l'enregistrement. Cela dépend de la latence, 
des besoins en matière d'assignation des voix 
et des possibilités d'écoute en enregistrement 
des plug-in TDM et RTAS. 

• Selon l'importance accordée à la réponse 
générale de l'écran et aux performances vidéo, 
et selon la densité des données d'automation 
utilisées, vous devrez parfois tenter différentes 
combinaisons (entre traitement RTAS et 
limite d'utilisation du processeur) pour 
obtenir un résultat optimal. Ainsi, pour 
améliorer la réponse de l'écran au cours d'une 
session de taille moyenne avec un nombre 
modéré de plug-in RTAS, il peut être 
préférable de réduire le nombre de plug-in 
RTAS alloués et de maintenir une limite 
d'utilisation maximale (99 %) sur un système 
doté d'un seul processeur.

Pour définir le nombre de processeurs RTAS :

1  Sélectionnez Setup > Playback Engine.

2  Dans le menu déroulant RTAS Processors, 
sélectionnez le nombre de processeurs 
disponibles que vous souhaitez allouer. 
Cela varie en fonction du nombre de 
processeurs disponibles sur votre ordinateur :

• Choisissez 1 Processor pour limiter le 
traitement RTAS à un processeur dans le 
système. 

• Choisissez 2 Processors pour permettre 
l'équilibrage de charge entre deux 
processeurs disponibles.

• Sur les systèmes de quatre processeurs ou 
plus, sélectionnez le nombre de 
processeurs RTAS voulu.

3  Cliquez sur OK.

Playback Engine, boîte de dialogue
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Fenêtre System Usage et traitement RTAS

La fenêtre System Usage affiche, au moyen d'un 
indicateur unique, le mode de traitement 
combiné RTAS appliqué sur tous les processeurs 
activés, quel que soit le nombre de processeurs 
dans le système. Si la fenêtre System Usage 
indique que vous êtes à la limite des ressources 
disponibles, augmentez le nombre de 
processeurs RTAS et ajustez le paramètre CPU 
Usage Limit. (pour en savoir plus, reportez-vous 
à la section Utilisation du système, page 51).

CPU Usage Limit

Le pourcentage d'utilisation du processeur 
(CPU Usage Limit) contrôle le pourcentage de 
ressources du processeur alloué aux tâches de 
traitement hôte de Pro Tools. Utilisé 
conjointement avec le paramètre RTAS 
Processors, il vous permet de contrôler les tâches 
Pro Tools réalisées par le système.

! En attribuant une valeur peu élevée au 
paramètre CPU Usage Limit, vous limitez 
l'impact du traitement de Pro Tools sur d'autres 
tâches requérant une utilisation intensive du 
processeur telles que le traçage d'écrans. Cela 
peut s'avérer utile lorsque la réponse de système 
est très lente ou lorsque d'autres applications 
sont en cours d'utilisation en même temps que 
Pro Tools.

! Un pourcentage d'utilisation du processeur 
élevé permet d'allouer davantage de puissance 
de traitement à Pro Tools et s'avère utile lorsque 
vous jouez des sessions de grande taille ou que 
vous utilisez davantage de plug-in RTAS. 

La valeur maximale du pourcentage d'utilisation 
du processeur est de 85 % pour les ordinateurs à 
processeur unique (sauf pour Digi 002, pour 
lequel la limite est de 99 %) et de 99 % pour les 
ordinateurs multi-processeurs (qui dédient un 
processeur complet à Pro Tools).

Sur les ordinateurs multi- processeurs, la valeur 
maximale du pourcentage d'utilisation du 
processeur est réduite lorsque vous utilisez tous 
vos processeurs (comme indiqué dans le menu 
contextuel RTAS Processing). Ainsi, avec des 
ordinateurs à deux processeurs, la limite est de 
90 %. Sur des ordinateurs à quatre processeurs, 
cette limite atteint 95 %.

Pour modifier le pourcentage d'utilisation du 
processeur :

1  Sélectionnez Setup > Playback Engine. 

2  Dans le menu contextuel CPU Usage Limit, 
sélectionnez le pourcentage de puissance du 
processeur à allouer à Pro Tools. 

3  Cliquez sur OK.

Options RTAS Engine

Pro Tools fournit deux options RTAS Engine 
dans la boîte de dialogue Playback Engine pour 
la suppression du rapport d'erreurs RTAS lors de 
la lecture et de l'enregistrement. Cela est 
particulièrement utile lors de l'utilisation de 
plug-in d'instrument.

Il est recommandé de n'activer la suppression 
d'erreurs RTAS que les rapports d'erreurs RTAS 
interrompent trop souvent votre processus 
créatif. L'activation de cette option peut 
entraîner une diminution de la qualité audio. 
Elle constitue néanmoins une solution 
envisageable dans la mesure où elle évite les 
interruptions de lecture et d'enregistrement 
lorsque vous travaillez avec des plug-in 

L'augmentation du pourcentage 
d'utilisation du processeur peut entraîner 
un ralentissement de l'affichage des écrans 
sur des ordinateurs lents.
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d'instrument. Désactivez l'option de 
suppression d'erreurs RTAS lorsque la plus haute 
qualité audio est requise, par exemple pour un 
mixage final.

Activation de la suppression 
d'erreurs RTAS

Pour activer la suppression d'erreurs RTAS :

1  Sélectionnez Setup > Playback Engine.

2  Sélectionnez Ignore Errors During 
Playback/Record.

3  Si l'option Minimize Additional I/O Latency 
est disponible, vous pouvez également la 
sélectionner.

4  Cliquez sur OK.

Options de suppression d'erreurs RTAS 

Ignore Errors During Playback/Record : lorsque 
cette option est activée, Pro Tools continue la 
lecture et l'enregistrement même si les exigences 
de traitements RTAS dépassent la limite 
d'utilisation du processeur sélectionnée. 
Cela peut entraîner des claquements et des clics 
dans l'audio, mais n'interrompt pas le transport.

Minimize Additional I/O Latency : l'activation de 
cette option réduit à 128 échantillons toute la-
tence supplémentaire entraînée par la suppres-
sion des erreurs RTAS lors de la lecture et de l'en-
registrement. La suppression d'erreurs RTAS 
nécessite au moins 128 échantillons de mise en 
mémoire tampon sur certains systèmes. Si cette 
option est désactivée, la taille du tampon est 
égale à la moitié de la valeur définie dans H/W 
Buffer ou égale à 128 échantillons minimum 
(la valeur la plus grande). Si votre ordinateur est 
un modèle moins récent et plus lent, nous vous 
recommandons de désactiver cette option pour 
éviter des performances médiocres.

Elle n'est disponible que si l'option Ignore Errors 
During Playback/Record est activée et si le 
système Pro Tools que vous utilisez nécessite de 
la mise en mémoire tampon supplémentaire 
pour la suppression d'erreurs RTAS, comme suit :

• Windows XP :

• Mbox 2 Pro

• Interfaces M-Audio agréées Digidesign avec 
Pro Tools M-Powered ou Academic

• Mac OS X :

• Mbox

• Mbox 2

• Mbox 2 Mini

• Mbox 2 Pro

• Digi 002 et 002 Rack

• Tous systèmes Pro Tools M-Powered

• Tous systèmes Pro Tools Academic

Boîte de dialogue Playback Engine, Mbox2
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Nombre de voix
(Pro Tools HD uniquement)

Sur les systèmes Pro Tools|HD, le paramètre 
Number of Voices vous permet de déterminer le 
nombre de voix disponibles et la façon dont ces 
voix sont affectées aux DSP dans votre système. 
Par exemple, le nombre de voix par défaut sur 
un système Pro Tools|HD 1 est de 48, avec un 
DSP (à des vitesses d'échantillonnage de 
44,1 kHz ou 48 kHz). 

Selon la fréquence d'échantillonnage de la 
session et le nombre de cartes Pro Tools|HD de 
votre système, vous disposez de plusieurs choix 
pour le nombre de voix. Pour connaître les 
limites de voix des différents systèmes 
Pro Tools|HD, reportez-vous à la section 
Nombre maximal de voix en lecture ou en 
enregistrement sur les systèmes Pro Tools|HD, 
page 31.

Pour modifier le nombre de voix et de ressources 
DSP à allouer :

1  Sélectionnez Setup > Playback Engine.

2  Sélectionnez le nombre de voix et de DSP à 
allouer pour l'assignation des voix en 
sélectionnant une valeur dans le menu 
contextuel Number of Voices, comme suit :

• Sélectionnez un nombre élevé de voix si les 
cartes Pro Tools|HD sont les seules cartes 
PCI installées sur votre ordinateur ou si 
vous utilisez un châssis d'extension pour 
augmenter le nombre de pistes prises en 
charge.

• Sélectionnez un nombre de voix 
intermédiaire, lorsque les cartes 
Pro Tools|HD sont installées dans un 
châssis d'extension, ou lorsque d'autres 
cartes PCI sont utilisées avec les cartes 
Pro Tools|HD.

La modification du nombre de voix affecte 
l'utilisation des ressources DSP, le nombre 
total de pistes pouvant héberger des voix et 
les performances générales de votre système. 

Option Playback Engine dialog, Ignore Errors During 
Playback/Record activée
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• Sélectionnez un nombre de voix restreint, 
si vous utilisez des cartes PCI dotées de 
bandes passantes étendues (cartes de 
capture vidéo, par exemple) avec vos cartes 
Pro Tools|HD. De plus, pour libérer des DSP 
pour les plug-in temps réel et le traitement, 
sélectionnez le nombre minimal de voix et 
de DSP nécessaires pour lire la session 
actuelle.

3  Cliquez sur OK. 

Fréquence d'échantillonnage par 
défaut

La fréquence d'échantillonnage (Sample Rate) 
s'affiche par défaut lorsque vous créez une 
session.

Pour modifier la fréquence d'échantillonnage par 
défaut :

1  Sélectionnez Setup > Playback Engine. 

2  Dans le menu contextuel Sample Rate, 
sélectionnez une fréquence d'échantillonnage.

3  Cliquez sur OK.

Moteur de compensation de retard
(Pro Tools HD uniquement)

Le moteur de compensation de retard (Delay 
Compensation Engine) permet de gérer les 
retards DSP dans la console de mixage Pro Tools. 

Il existe trois paramètres dans la boîte de 
dialogue Playback Engine permettant d'attribuer 
des ressources DSP à la fonction de 
compensation de retard : 

None : n'attribue aucune ressource DSP en vue 
de la compensation de retard.

Short : attribue un nombre réduit de ressources 
DSP pour la compensation de retard de chaque 
canal. Il s'agit du paramètre le plus efficace pour 
les systèmes Pro Tools|HD Accel.

Long : attribue un nombre maximum de 
ressources DSP pour la compensation de retard 
de chaque canal. Ce paramètre fait appel à la 
mémoire SRAM des DSP, utile aux plug-in 
requérant une grande quantité de DSP.

Pour configurer le moteur de compensation de 
retard, procédez comme suit :

1  Sélectionnez Setup > Playback Engine.

2  Dans le menu déroulant Delay Compensation 
Engine, sélectionnez un paramètre de 
compensation de retard.

3  Cliquez sur OK.

Le paramètre de compensation de retard choisi 
est enregistré en tant que préférence de session 
et préférence système.

Avec Pro Tools HD, le paramètre Sample 
Rate peut avoir un impact sur le nombre de 
voix disponibles.

La fréquence d'échantillonnage ne peut être 
modifiée que si aucune session n'est 
ouverte. Autrement, la fréquence 
d'échantillonnage est affichée, mais ne peut 
pas être modifiée.

Vous pouvez modifier la fréquence 
d'échantillonnage lors de la création d'une 
session Pro Tools en sélectionnant une 
fréquence différente dans la boîte de 
dialogue New Session. (Pour plus 
d’informations, reportez-vous à la section 
« Création d'une session », page 99.)

Pour plus d'informations, reportez-vous à la 
section Compensation de retard, page 757. 
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Taille du buffer de lecture DAE

Le paramètre DAE Playback Buffer Size 
détermine la quantité de mémoire DAE allouée 
aux buffers de disque. La taille du buffer de 
lecture DAE maximale pour les opérations de 
disque correspond au niveau 2.

! Une taille de buffer de lecture DAE inférieure 
au niveau 2 peut améliorer la vitesse d'amorce 
de lecture et d'enregistrement. En revanche, la 
lecture et l'enregistrement des pistes peuvent 
être plus difficiles si vos sessions contiennent un 
nombre élevé de pistes ou de points d'édition ou 
s'exécutent sur des disques durs lents ou très 
fragmentés.

! Une taille supérieure au niveau 2 permet une 
densité d'édition plus élevée au cours d'une 
session ou un nombre de pistes plus important 
lors de l'utilisation de disques durs plus lents. 
Cependant, un niveau élevé peut également être 
à l'origine d'un retard lors du démarrage de la 
lecture ou de l'enregistrement et produire un 
retard audible plus long lors de l'édition en cours 
de lecture.

Pour modifier la taille du buffer de lecture DAE :

1  Sélectionnez Setup > Playback Engine.

2  Dans le menu contextuel DAE Playback 
Buffer, sélectionnez une taille de buffer. 
La configuration de mémoire requise pour 
chaque paramètre est indiquée dans la partie 
inférieure de la boîte de dialogue Playback 
Engine.

3  Cliquez sur OK. 

4  Si Pro Tools nécessite davantage de mémoire 
système pour le buffer de lecture DAE, vous êtes 
invité à redémarrer l'ordinateur.

Une grande taille de buffer de lecture DAE 
réduit la mémoire système affectée aux 
autres tâches. Nous vous conseillons 
d'utiliser la valeur par défaut (niveau 2) à 
moins que vous ne rencontriez les erreurs 
-9073 de disques trop lents ou trop 
fragmentés. 

Boîte de dialogue Playback Engine
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Affectation de mémoire système
(Pro Tools HD uniquement)

Lors du démarrage de l'ordinateur, Pro Tools 
attribue automatiquement une partie de la 
mémoire système au buffer de lecture DAE. 
Cette portion de mémoire n'est plus disponible 
pour les autres applications, même si Pro Tools 
n'est pas en cours d'exécution.

Vous pouvez définir Pro Tools de sorte à ne 
réserver qu'une quantité minimale de la 
mémoire requise afin de conserver un 
maximum de mémoire système pour d'autres 
applications. 

Pour limiter l'allocation de mémoire système :

1  Sélectionnez Setup > Playback Engine.

2  Sélectionnez l'option Minimize System 
Memory Allocation. 

3  Cliquez sur OK. 

4  Effectuez l'une des opérations suivantes :

• Si vous travaillez sur un système Windows, 
redémarrez votre ordinateur. 

– ou –

• Sur un système Mac, saisissez votre mot de 
passe si vous y êtes invité, puis redémarrez 
votre ordinateur.

Configuration des paramètres 
matériels Pro Tools
Pro Tools vous permet de configurer 
l'acheminement des signaux, le format d'E/S 
numérique, la fréquence d'échantillonnage par 
défaut, ainsi que d'autres paramètres matériels 
variant selon votre système. 

La section suivante explique comment 
configurer un système Pro Tools|HD avec une 
ou plusieurs interfaces Pro Tools|HD (avec une 
connexion à une ou plusieurs interfaces Legacy).

Configuration du dispositif 
Pro Tools|HD

Sur les systèmes Pro Tools|HD, vous devez 
configurer les paramètres matériels de chaque 
interface audio connectée à votre système. 
Par exemple, les systèmes Pro Tools|HD 
prennent en charge des interfaces audio 92 I/O, 
192 Digital I/O, 96 I/O ou 96i I/O branchées à 
des cartes HD Core et HD Accel ou HD Process 
dans le système. Les interfaces 192 I/O, 
192 Digital I/O, and 96 I/O peuvent être 
associées à des interfaces supplémentaires 
(notamment les interfaces audio Digidesign plus 
anciennes ou les interfaces Legacy, comme les 
interfaces I/O 888|24, I/O 882|20 ou I/O 1622). 
Pour plus d'informations, consultez la section 
chapitre 4, Systèmes Pro Tools.

Pour configurer un autre système 
Pro Tools LE, consultez le Guide de 
démarrage fourni avec votre système.
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Configuration de la boîte de dialogue 
Hardware Setup

L'onglet Main de la boîte de dialogue Hardware 
Setup permet de définir les entrées et sorties 
physiques de votre interface audio assignées aux 
entrées et sorties Pro Tools.

Des pages supplémentaires sont disponibles afin 
de configurer d'autres paramètres pour chaque 
interface audio (tels que les niveaux de 
fonctionnement). Pour plus d'informations, 
reportez-vous au Guide de démarrage de votre 
système ou au guide de votre interface audio.

Pour configurer des interfaces audio sur un 
système Pro Tools|HD :

1  Sélectionnez Setup > Hardware.

2  Dans la liste Peripherals, sélectionnez 
l'interface audio Digidesign connectée à la 
première carte de votre système. Il s'agit de la 
première interface figurant dans la liste.

3  Cliquez sur l'onglet Main.

4  Dans le menu déroulant Clock Source, 
sélectionnez la source d'horloge appropriée pour 
le système. Vous utiliserez Internal dans de 
nombreux cas. Les autres choix permettent 
d'adapter Pro Tools à des sources d'horloge 
externes. Selon l'interface audio, vous avez le 
choix parmi les options Clock Source suivantes : 
AES/EBU [Encl], S/PDIF, Optical [Encl], AES/EBU 
1-8, TDIF, ADAT et Word Clock (des fréquences 
de signal Word Clock optionnelles sont 
disponibles si vous travaillez avec des fréquences 
d'échantillonnage plus élevées).

5  Dans le menu déroulant Ext. Clock Output, 
sélectionnez la sortie d'horloge appropriée à 
envoyer aux périphériques connectés à votre 
interface audio.

6  Sélectionnez le port d'E/S numérique actif sur 
le châssis de votre interface audio sous Digital 
Format. Vous avez le choix entre les options 
suivantes : AES/EBU, S/PDIF et Optical (S/PDIF). 
La sélection de l'option Optical (S/PDIF) 
redéfinit le port d'E/S optique (constitué, par 
défaut, de huit canaux d'E/SADAT) sur deux 
canaux d'E/S S/PDIF optiques.

7  Pour la compatibilité S/PDIF avec les 
enregistreurs DAT Tascam DA30, sélectionnez 
Tascam sous S/PDIF Format.

8  Pour les interfaces I/O 96 et 96i, cliquez sur le 
menu contextuel Meters et sélectionnez 
l'affichage des vumètres d'entrée ou de sortie.

9  Dans les menus déroulants Input et Output, 
sélectionnez les ports physiques (tels que Analog 
1-2 ou Optical 1-2) qui seront affectés aux 
canaux d'entrée et de sortie Pro Tools (comme 
Ch 1-2 ou Ch 3-4), affichés dans la partie gauche 
de la page Main.

Boîte de dialogue Hardware Setup pour l'interface 96 
I/O (onglet Main)

Identifiez les connexions de l'interface 
audio à tout moment en sélectionnant le 
nom de l'interface dans la liste des 
périphériques (Peripherals) puis en cliquant 
sur Identify. Tous les voyants situés sur le 
panneau avant de l'interface s'illuminent.



Chapitre 5 : Paramètres du système 49

Pour différencier les entrées et sorties d'un 
même format, celles-ci sont désignées 
différemment dans les menus contextuels des 
canaux d'entrée et de sortie. Par exemple, les 
entrées et sorties AES/EBU du châssis de 
l'interface 192 I/O sont répertoriées comme 
AES/EBU [Encl], tandis que les entrées et sorties 
AES/EBU de la carte d'E/S numérique installée en 
usine sont identifiées (par paires) comme 
AES/EBU 1-2, AES/EBU 3-4, AES/EBU 5-6 et 
AES/EBU 7-8. Pour les interfaces 192 I/O dotées 
de la carte optionnelle numérique d'E/S, les 
ports supplémentaires AES/EBU I/O de la carte 
optionnelle sont identifiés comme AES/EBU 
9-10, AES/EBU 11-12, AES/EBU 13-14 et 
AES/EBU 15-16.

10  Cliquez sur d'autres onglets (tels que Analog 
In et Analog Out) pour accéder à d'autres 
options de configuration propres à l'interface 
audio, à savoir :

• Dans l'interface 96 I/O, la configuration des 
niveaux de fonctionnement des entrées et 
sorties analogiques (+4 dBu ou -10 dBV).

• Dans l'interface 96i I/O, la configuration 
des niveaux de fonctionnement des entrées 
et sorties analogiques (+4 dBu ou -10 dBV).

• Dans l'entrée analogique 192 I/O, la 
définition du connecteur d'entrée et de 
l'option Soft Limit.

• Dans l'interface 192 I/O, la configuration 
de deux ensembles de réglages pour les 
entrées et les sorties analogiques.

• Dans les interfaces 192 I/O et 192 Digital 
I/O, la configuration de la conversion de 
fréquence d'échantillonnage en temps réel 
pour les entrées numériques.

• Dans les interfaces 192 I/O et 192 I/O 
Digital, la configuration des entrées et 
sorties de n'importe quelle carte 
optionnelle A/N, N/A ou E/S numérique 
installée dans l'appareil.

11  Répétez les étapes précédentes pour toute 
interface audio Pro Tools|HD supplémentaire.

12  Répétez les étapes précédentes pour toute 
interface Legacy I/O connectée aux interfaces 
audio Pro Tools|HD de votre système. Avant de 
pouvoir configurer une interface Legacy I/O, 
vous devez l'initialiser dans Hardware Setup.

13  Cliquez sur OK.

Initialisation des périphériques Legacy 
MIX (sur un système Pro Tools|HD)

Avant de pouvoir configurer une interface 
Legacy I/O, vous devez l'initialiser dans 
Hardware Setup. 

Pour initialiser une interface Legacy I/O sur un 
système Pro Tools|HD :

1  Démarrez votre système Pro Tools. Pour plus 
d’informations, reportez-vous à la section 
« Démarrage et arrêt du système », page 39.

2  Réduisez le volume de tous les composants de 
sortie du système. Un son numérique très 
puissant risque d'être émis avant l'initialisation 
de l'interface Legacy I/O.

3  Mettez l'interface Legacy I/O sous tension.

4  Dans la liste Peripherals, sélectionnez 
l'interface audio principale (l'interface 
Pro Tools|HD à laquelle votre interface Legacy 
I/O est connectée).

Pour plus d'informations sur les paramètres 
de configuration matérielle de chaque 
interface audio Pro Tools|HD, reportez-vous 
au Guide de démarrage Pro Tools|HD ou au 
manuel de votre interface audio.

Utilisez les flèches haut/bas pour faire 
défiler les périphériques dans la liste 
Peripherals.
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5  Dans la page Main de la boîte de dialogue 
Hardware Setup, sélectionnez l'option Legacy 
I/O dans Port Settings.

6  Dans la liste Peripherals, No Interface est 
indiqué deux fois, directement sous l'interface 
audio principale. Cliquez sur la première 
occurrence de No Interface. Un menu déroulant 
Interface s'affiche dans la boîte de dialogue 
Hardware Setup, répertoriant les options 
d'interfaces d'entrée/sortie prises en charge.

7  Dans le menu déroulant Interface, 
sélectionnez votre interface Legacy I/O. 

La page Main affiche les commandes pouvant 
être configurées.

8  Répétez les étapes précédentes pour chaque 
interface Legacy I/O.

Configuration de la boîte de dialogue 
I/O Setup

La boîte de dialogue I/O Setup offre une 
représentation graphique de l'acheminement 
des signaux pour chaque interface audio 
branchée, ainsi que des commandes 
d'affectation des ports physiques sur l'interface 
audio aux entrées et sorties Pro Tools. Les 
paramètres de ces commandes reflètent ceux des 
commandes d'acheminement de la boîte de 
dialogue Hardware Setup : les modifications 
apportées au routage dans une boîte de dialogue 
sont toujours reflétées dans l'autre boîte de 
dialogue. 

La boîte de dialogue I/O Setup permet 
d'identifier et d'affecter les chemins de signaux 
d'entrée, de départ, d'insert et de bus de 
Pro Tools. La boîte de dialogue I/O Setup 

comprend également des paramètres importants 
pour l'écoute, les vumètres et le son surround. 
Pour plus d'informations, consultez la section 
chapitre 6, Configuration des E/S.

Acheminement d'une paire de sorties 
Pro Tools vers des destinations 
multiples

Les paires de canaux Pro Tools peuvent être 
affectées à plusieurs sorties d'une interface audio 
à l'aide de la boîte de dialogue Hardware Setup. 
Si, par exemple, vous affectez les deux sorties 
d'interface Analog 1-2 et Analog 3-4 à la paire de 
sorties Pro Tools 1-2, un signal envoyé aux 
sorties Pro Tools 1-2 est acheminé 
simultanément aux deux paires de sorties de 
l'interface audio.

Ceci vous donne la possibilité d'envoyer le 
même signal (tel qu'une paire stéréo, un 
prémixage ou un mixage multicanal) vers de 
nombreuses destinations (telles que divers 
périphériques de mastering).

Pour sélectionner plusieurs ports de sortie pour 
une paire de canaux de sortie Pro Tools :

1  Sélectionnez Setup > Hardware.

2  Dans la liste Peripherals, sélectionnez 
l'interface souhaitée.

3  Cliquez sur l'onglet Main. 

4  Sélectionnez une paire de ports de sortie 
depuis un menu déroulant Output.

5  Tout en cliquant sur Démarrer (Windows) ou 
Ctrl (Mac), cliquez une deuxième fois sur ce 
même menu déroulant pour sélectionner une 
paire de ports de sortie supplémentaire.

Pour obtenir des informations sur les 
commandes Hardware Setup pour chaque 
interface audio Legacy, consultez le guide 
fourni avec l'interface.
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Le nom de sortie est alors précédé par un signe 
plus (« + ») pour signaler que plusieurs ports 
sont sélectionnés. Dans le menu contextuel, 
chaque paire de ports physiques affectée à la 
paire de sorties Pro Tools est signalée par une 
coche.

6  Répétez les étapes précédentes pour 
sélectionner des destinations de sortie 
supplémentaires. Le nombre de sorties 
disponibles sur votre système est la seule limite 
au choix des sorties.

Les paires de sorties Pro Tools peuvent 
également être acheminées vers plusieurs sorties 
depuis la boîte de dialogue I/O Setup. Pour plus 
d'informations, reportez-vous à la section 
Affectation d'E/S matérielles vers les E/S 
Pro Tools, page 59.

Utilisation du système

A propos de la bande passante de 
traitement

Les indicateurs de la fenêtre System Usage 
indiquent la quantité de puissance du système 
utilisée dans le traitement des sons et lors de 
l'écriture et de la lecture des données 
d'automation. 

Pro Tools HD, LE, M-Powered et Academic ont 
trois indicateurs en commun affichant le trafic 
du bus PCI, la la capacité de traitement du 
processeur et la capacité de traitement du 
disque.

Lorsque ces indicateurs approchent de leurs 
limites, le traitement natif, l'enregistrement ou 
la lecture des données d'automation peuvent se 
voir altérés. 

Pro Tools HD offre des indicateurs 
supplémentaires permettant de connaître 
l'utilisation du Time Slot TDM et l'utilisation des 
ressources DSP sur chaque carte système 
Pro Tools|HD.

Boîte de dialogue Hardware Setup pour l'interface 96 
I/O (onglet Main)

Fenêtre System Usage (correspondant ici à 
Pro Tools LE)

Indicateurs d'activité 
du système
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Des erreurs système peuvent se produire en 
raison d'une activité intense du processeur ou de 
l'interface PCI. Si l'activité sur le disque est 
élevée, Pro Tools risque de manquer la lecture de 
certaines données d'automation au cours de 
périodes d'activité particulièrement denses, 
notamment en cas de recours à la commande 
Bounce to Disk. 

Pour contrôler l'utilisation des ressources au 
cours d'une session Pro Tools :

" Sélectionnez Window > System Usage.

Pour réduire la charge de traitement, essayez 
l'une des actions suivantes :

" Réduisez la densité de l'automation aux points 
où elle semble la plus active. Pour en savoir plus, 
reportez-vous à Affinage de l'automation, 
page 819. 

" Désactivez les vumètres dans Sends View s'ils 
sont activés (en désactivant Show Meters dans 
Sends View dans la page Display Preferences). 
Pour en savoir plus, reportez-vous à Vues Send 
individuelles et vumètres de niveau de départ, 
page 741.

Vues de la fenêtre System Usage

(Pro Tools HD uniquement)

Pro Tools HD propose cinq vues différentes de la 
fenêtre System Usage : Small, Large, Detailed, 
Gas Gauge et Activity Only. Les formats Detailed 
et Gas Gauge indiquent le pourcentage 
d'utilisation pour chaque puce DSP.

Pour changer la vue de la fenêtre System Usage :

" Sélectionnez View > System Usage, puis l'un 
des formats d'affichage (Small, par exemple).

Fenêtre System Usage (correspondant ici à 
Pro Tools HD)

Pour plus d'informations, reportez-vous à la 
section Bounce to Disk :, page 858.

Utilisation 
des ressources DSP

Indicateurs d'activité 
du système

Utilisation du 
Time Slot TDM

Pour plus d'informations sur les différentes 
vues permettant de contrôler l'utilisation 
des ressources DSP, reportez-vous au Guide 
de démarrage Pro Tools|HD.



Chapitre 6 : Configuration des E/S 53

Chapitre 6 : Configuration des E/S

La boîte de dialogue I/O Setup contient des 
outils permettant d'identifier, de formater et 
d'affecter les chemins des signaux d'entrée, de 
sortie, d'insert et de bus de Pro Tools pour 
chaque session. 

Un chemin de signal est un regroupement 
logique de plusieurs entrées, sorties ou bus, qui 
possède un nom et un format (de canal) 
uniques. Dans Pro Tools, les chemins 
s'apparentent aux prémixages (stems) connus et 
appliqués dans le secteur du cinéma et de la 
vidéo (voir Stems et prémixages, page 56). 
La boîte de dialogue I/O Setup permet de 
nommer et de définir ces chemins selon les 
besoins de chaque projet.

Dans Pro Tools HD, la boîte de dialogue I/O 
Setup offre une représentation graphique de 
l'acheminement des signaux pour chaque 
interface audio branchée ainsi que des 
commandes d'assignation des ports physiques 
sur les entrées et sorties Pro Tools. Les 
paramètres de ces commandes reflètent ceux des 
commandes d'acheminement de la boîte de 
dialogue Hardware Setup : les modifications 
apportées au routage dans une boîte de dialogue 
sont toujours reflétées dans l'autre boîte de 
dialogue.

Chaque système Pro Tools peut posséder une 
configuration d'E/S différente, déterminée par 
les conditions suivantes :

• le type de système utilisé (Pro Tools|HD, 
Pro Tools LE, Pro Tools M-Powered ou 
Pro Tools Academic) ;

• le nombre et le type d'interfaces audio 
(sur les systèmes Pro Tools|HD) ;

• le plug-in de console, Stéréo ou Surround, 
installé (sur les systèmes Pro Tools|HD).

Chaque session Pro Tools conserve sa 
configuration de chemins sous forme de 
paramètres d'E/S. Les paramètres d'E/S 
enregistrés avec la session sont chargés 
automatiquement lors de l'ouverture de la 
session. Les éléments non disponibles (matériel, 
chemins ou ressources nécessaires) demeurent 
dans la session, mais sont inactifs (voir Chemins 
actifs et inactifs, page 66).

Lorsque vous créez des sessions, vous pouvez 
spécifier une configuration d'E/S par défaut, 
comportant des présélections pour les formats 
de mixage stéréo ou multicanal. Le mixage 
multicanal nécessite un système Pro Tools|HD.

La boîte de dialogue I/O Setup permet 
également de sauvegarder et d'importer les 
fichiers de paramètres d'E/S. 

Navigation dans la boîte de dialogue I/O Setup

Pour redimensionner la boîte de dialogue 
I/O Setup :

" Faites glisser l'angle inférieur droit de la 
fenêtre selon la procédure standard de votre 
système d'exploitation.
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Pour faire défiler le contenu de la boîte de dialogue 
I/O Setup vers la gauche ou vers la droite :

" Maintenez la touche Alt (Windows) ou 
Option (Mac) enfoncée et appuyez sur Page 
Up/Down.

Chemins dans les sessions

Au cours des sessions, le signal audio est envoyé 
vers plusieurs destinations à l'aide des sélecteurs 
d'entrée, de sortie, d'insert, de plug-in et de 
départ de la piste. Les sélecteurs permettent 
d'affecter les pistes à des entrées et des sorties 
matérielles, à des bus internes et à d'autres 
chemins de signaux dans Pro Tools.

Les chemins comportent les listes des 
acheminements de signaux disponibles via les 
sélecteurs d'entrée, de sortie, d'insert et de 
départ de la piste.

Sélecteur de chemin d'entrée et chemins

Sélecteur de chemin de sortie et chemins
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Chemins et configuration d'E/S

Les choix d'affectation du signal disponibles 
dans les sessions sont définis dans la boîte de 
dialogue I/O Setup. 

Chemins principaux et 
sous-chemins

La boîte de dialogue I/O Setup contient des 
chemins principaux et des sous-chemins.

Chemins principaux

Les chemins principaux sont des regroupements 
logiques d'entrées, d'inserts, de bus ou de sorties. 
Par exemple, un chemin de sortie stéréo 
générale pourrait porter le nom Main Out. 
Les noms de chemins stéréo se terminent 
souvent par les suffixes .L et .R (pour les canaux 
gauche et droit). 

Sous-chemins

Un sous-chemin représente le chemin d'un signal 
au sein d'un chemin principal. Un chemin de 
sortie stéréo par défaut, par exemple, est 
constitué de deux sous-chemins mono, gauche 
et droit. Des pistes ou départs mono peuvent 
être affectés vers l'un ou l'autre des sous-chemins 
mono d'un chemin de sortie stéréo. 

Paramètres d'E/S par défaut

Etant donné que Pro Tools installe 
automatiquement un fichier de paramètres d'E/S 
par défaut, vous disposez dès le départ d'un 
ensemble de chemins par défaut et n'avez pas 
besoin d'effectuer de réglages dans la boîte de 
dialogue I/O Setup. Vous pouvez personnaliser 
vos paramètres d'E/S à tout moment, selon les 
besoins spécifiques de chaque projet (voir Boîte 
de dialogue I/O Setup, page 57). 

Chemins de sortie dans la boîte de dialogue I/O Setup 
(Pro Tools HD)

Chemins principaux et sous-chemins dans la grille de 
configuration d'E/S du canal

Chemin stéréo principal

Sous-chemin mono

Sous-chemin mono

Cette option est surtout pratique pour 
définir et nommer des sous-chemins au sein 
de configurations de mixage complexes, 
telles qu'un mixage Surround 5.1. 



Guide de référence Pro Tools56

Fichiers des paramètres par défaut

Le fichier des paramètres par défaut stéréo est 
disponible sur tous les systèmes Pro Tools. 
Il propose des chemins principaux stéréo 
disposant chacun de leurs propres sous-chemins 
mono. 

Les fichiers de paramètres multicanaux sont 
disponibles pour les systèmes Pro Tools|HD. 
Ces paramètres correspondent à la définition de 
chemins spécifiques au mixage Surround. 
Pour plus d'informations, reportez-vous à la 
section Configuration de Pro Tools pour les 
sessions multicanaux, page 874.

Noms de chemins par défaut

L'attribution par défaut de noms de chemins 
d'entrées, de sorties et d'inserts est basée sur le 
type de système (par exemple, les systèmes 
Pro Tools LE spécifiques) ou le type et le nombre 
d'interfaces (pour les systèmes Pro Tools|HD) 
que vous utilisez.

Stems et prémixages

L'utilisation de stems et de prémixages provient 
du domaine de la post-production et permet 
d'organiser et de gérer les éléments d'un mixage 
par type ou par contenu. 

Par exemple, le mixage d'un film s'effectue le 
plus souvent après prémixage des effets sonores, 
des dialogues et de la musique. Le prémixage des 
dialogues, par exemple, contient tous les 
éléments du dialogue correctement équilibrés. 
Lors du mixage final de la scène ou de la bobine, 
ce prémixage des dialogues est mixé avec les 

autres prémixages. Cette procédure simplifie le 
mixage final : il suffit en effet de contrôler le 
niveau de chaque prémixage, plutôt que d'agir 
séparément sur le niveau des dizaines de pistes 
distinctes composant généralement la bande 
son d'un film.

Pro Tools permet de travailler avec des chemins 
principaux et des sous-chemins, comme avec 
des prémixages. Ceux-ci peuvent être affectés 
suivant les besoins et permettent notamment 
d'affecter plusieurs sorties à des pistes et des 
départs individuels. Pour plus d'informations, 
reportez-vous à la section Assignations de sorties 
multiples, page 735.
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Boîte de dialogue I/O Setup
La boîte de dialogue I/O Setup définit le chemin des signaux d'entrée, de sortie, d'insert et de bus de 
Pro Tools. L'assignation des ports d'E/S vers les entrées et sorties de Pro Tools peut également 
s'effectuer ici.

Pour ouvrir la boîte de dialogue I/O Setup :

1  Vérifiez que les interfaces audio sont actives et 
configurées correctement dans la boîte de 
dialogue Hardware Setup. Pour plus 
d'informations, reportez-vous à la section 
Configuration des paramètres matériels 
Pro Tools, page 47.

2  Choisissez Setup > I/O. 

Pour ouvrir la fenêtre Input, Output, Insert, Bus, 
Mic Preamps (Pro Tools HD uniquement) ou H/W 
Insert Delay (Pro Tools HD uniquement) à partir de 
la boîte de dialogue I/O Setup :

" Cliquez sur l'onglet approprié en haut de la 
boîte de dialogue I/O Setup. 

Figure 1.  Boîte de dialogue I/O Setup sur un système Pro Tools|HD avec une interface 96 I/O

Grille des canaux

Onglets des 
types de 
chemin

Développer/Réduire
les chemins

Etat actif/inactif

Options

Chemins principaux
et sous-chemins

Sélecteur de format de cheminColonne de nom du chemin

Outils du chemin

Sélecteurs d'entrées et
de sorties

Etiquette de l'interface
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Fermeture de la boîte de dialogue I/O Setup

Vous pouvez refermer la boîte de dialogue 
I/O Setup à tout moment en cliquant sur Cancel 
(les modifications ne sont pas enregistrées). 
Lorsque vous cliquez sur OK, Pro Tools vérifie la 
validité de plusieurs paramètres d'affectation 
(afin d'éviter les boucles de signaux). Si certains 
paramètres entrent en conflit ou ne sont pas 
valides, vous serez invité à les corriger avant que 
la boîte de dialogue I/O Setup ne se referme. 
Pour plus d'informations, reportez-vous à la 
section Configuration des E/S, page 66.

Commandes de la boîte de 
dialogue I/O Setup

Voici les différentes commandes de la boîte de 
dialogue I/O Setup.

Onglets des types de chemin : permettent de 
sélectionner le type de commande d'E/S à 
configurer (Input, Output, Insert, Bus, Mic 
Preamps (Pro Tools HD uniquement) ou H/W 
Insert Delay (Pro Tools HD uniquement)).

Sélecteurs d'entrées et de sorties :  permettent 
de sélectionner les ports physiques de votre 
interface audio à affecter aux entrées et sorties 
de Pro Tools. Les ports sont disponibles sous 
forme de paires de canaux. Les ports disponibles 
pour chaque interface affichée sont basés sur les 
paramètres de la configuration matérielle. Si, par 
exemple, les entrées et sorties AES/EBU d'une 
interface sont activées dans la fenêtre Hardware 
Setup, elles sont disponibles pour le routage 
dans la fenêtre I/O Setup. La fonctionnalité du 
sélecteur d'entrée et de sortie est identique à 
celle disponible dans la page Main de la boîte de 
dialogue Hardware Setup.

Colonne de nom du chemin : indique les chemins 
pouvant être sélectionnés, y compris le nom 
spécifié pour chaque chemin défini. Il est 
possible de renommer les noms de chemin.

Développer/Réduire : permet d'afficher ou de 
masquer les sous-chemins associés à un chemin 
principal.

Etat actif/inactif : indique et permet de modifier 
l'état, actif ou inactif, de chaque chemin.

Sélecteur de format de chemin : affiche et 
permet de sélectionner le type/format (mono, 
stéréo, Quad, 5.1, etc.) de chaque chemin défini. 
(Les formats multicanaux supérieurs au format 
stéréo sont pris en charge uniquement sur les 
systèmes Pro Tools|HD).

Grille des canaux : affecte les chemins à des 
interfaces et des canaux spécifiques. 

Compensation des retards d'entrée et de sortie 
(Pro Tools HD uniquement) : permet la 
compensation automatique des retards d'entrée 
et de sortie causés par le matériel Digidesign 
analogique-numérique et 
numérique-analogique.

Outils du chemin : personnalise la configuration 
de la boîte de dialogue I/O Setup. Les boutons 
comprennent : New Path, New Sub-Path, Delete 
Path et Default.

Bouton Show Last Saved Setup : s'affiche dans la 
boîte de dialogue I/O Setup dans certains cas de 
transfert de session. Pour plus de détails sur cette 
fonction, voir Affichage de la dernière 
configuration enregistrée et de la configuration 
en cours, page 69 

Options : les options permettent d'afficher des 
menus déroulants de définition des chemins ou 
des ordres pour Controller Meter Path, Audition 
Paths (aperçu de la liste des régions), New Track 
Default Output, Default Path Order, AFL/PFL 



Chapitre 6 : Configuration des E/S 59

Path (Pro Tools HD uniquement) et AFL/PFL 
Mutes (Pro Tools HD uniquement). Pour plus 
d'informations, reportez-vous à la section 
Options de configuration d'E/S, page 72.

Affectation d'E/S matérielles 
vers les E/S Pro Tools
La boîte de dialogue I/O Setup permet de définir 
les ports physiques du périphérique d'E/S 
affectés aux entrées et sorties disponibles dans 
Pro Tools. Les sélecteurs d'entrées et de sorties de 
la fenêtre I/O Setup servent de patch permettant 
d'affecter l'une des entrées ou des sorties 
physiques à la console de mixage Pro Tools.

Pour configurer l'acheminement d'E/S dans I/O 
Setup :

1  Choisissez Setup > I/O.

2  Cliquez sur l'onglet Input ou Output pour 
afficher le type de chemin correspondant. 

3  Cliquez sur le sélecteur d'entrée ou de sortie 
pour la première paire de canaux de l'interface, 
située sous l'icône de la première interface 
audio.

4  Dans le menu contextuel, sélectionnez une 
paire de ports physiques (tels que Analog 1–2), 
pour l'acheminer à une paire de canaux 
Pro Tools (tels que A 1–2) dans la colonne Path 
Name, située dans la partie gauche. 

5  Répétez les étapes précédentes pour toute 
paire de canaux supplémentaire.

6  Cliquez sur OK.

Assignation d'une paire de sorties 
Pro Tools à des destinations multiples

Les paires de canaux Pro Tools peuvent être 
affectées à plusieurs sorties d'une interface audio 
à l'aide de la boîte de dialogue I/O Setup. Si, par 
exemple, vous affectez les deux sorties 
d'interface Analog 1–2 et Analog 3–4 à la paire 
de sorties Pro Tools 1–2, un signal envoyé aux 
sorties Pro Tools 1–2 est acheminé 
simultanément aux deux paires de sorties de 
l'interface audio.

Ceci vous donne la possibilité d'envoyer le 
même signal (tel qu'une paire stéréo, un 
prémixage ou un mixage multicanal) vers de 
nombreuses destinations (telles que divers 
périphériques de mastering).

Le nombre de sorties disponibles sur votre 
système est la seule limite au choix des sorties.

Menu déroulant du sélecteur de canal d'E/S
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Les paires de sorties Pro Tools peuvent 
également être acheminées vers plusieurs sorties 
d'interface audio dans la boîte de dialogue 
Hardware Setup. Pour plus d’informations, 
consultez la section Acheminement d'une paire 
de sorties Pro Tools vers des destinations 
multiples, page 50.

Pour assigner une paire de canaux de sortie 
Pro Tools à plusieurs ports de sortie d'interface 
audio :

1  Choisissez Setup > I/O.

2  Cliquez sur l'onglet Output. 

3  Cliquez sur le sélecteur de sortie 
correspondant à une paire de canaux de 
l'interface, juste en dessous de l'icône de 
l'interface audio. 

4  Dans le menu contextuel, sélectionnez une 
paire de ports physiques (tels que Analog 1–2), 
pour l'acheminer à la paire de canaux Pro Tools 
correspondants (tels que A 1–2) dans la colonne 
Path Name, située dans la partie gauche.

5  Maintenez enfoncée la touche Démarrer 
(Windows) ou Ctrl (Mac) et cliquez sur le même 
sélecteur de sortie, puis choisissez une paire de 
sorties supplémentaires dans le même menu 
déroulant.

Le nom de sortie est alors précédé par un signe 
plus (+) pour signaler que plusieurs ports sont 
sélectionnés. Dans le menu contextuel, chaque 
paire de ports physiques affectée à la paire de 
sorties Pro Tools est signalée par une coche.

6  Répétez les étapes précédentes pour 
sélectionner des destinations de sortie 
supplémentaires. 

7  Cliquez sur OK.

Création et modification de 
chemins 
Vous pouvez créer et personnaliser les 
définitions des chemins des signaux en utilisant 
la boîte de dialogue I/O Setup. 

Les chemins peuvent être :

• renommés, pour faciliter l'identification 
après changement ou attribution d'un 
nouveau nom à des interfaces audio ;

• réaffectés, vers ou à partir de différentes 
sources ou destinations ;

• désactivés (ou réactivés) pour gérer des 
ressources d'E/S non disponibles ou 
inutiles ;

• supprimés.

Vous pouvez en outre importer et exporter les 
configurations d'E/S sous forme de fichiers de 
paramètres d'E/S et définir des paramètres de 
chemin par défaut.

Les affectations des chemins de sorties ne 
peuvent pas se chevaucher. Pour plus 
d'informations, consultez la section 
Chemins valides et conditions, page 66.
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Le tableau suivant dresse la liste des attributs 
disponibles pour chaque type de chemin.

Création d'un chemin ou d'un 
sous-chemin par défaut

Vous pouvez régler à tout moment le type de 
chemin de paramètres d'E/S sur sa configuration 
par défaut.

Pour restaurer les chemins et les noms de 
chemins par défaut :

1  Choisissez Setup > I/O.

2  Cliquez sur l'onglet Input, Output, Insert ou 
Bus pour afficher le type de chemin 
correspondant.

3  Cliquez sur Default. 

Pro Tools crée tous les chemins stéréo 
principaux possibles. Des sous-chemins mono 
sont également créés automatiquement pour 
chaque chemin stéréo principal. Ces noms de 
chemins par défaut s'affichent dans les 
sélecteurs de chemins d'entrées et de sorties 
audio de piste de la session. 

Création de chemins

Vous pouvez créer des chemins principaux et 
sous-chemins avec des noms, des affectations et 
de formats personnalisés. Les noms de chemins 
personnalisés apparaissent dans les sélecteurs 
d'entrées, de sorties, d'inserts et de bus de la piste 
de la session.

Pour créer un chemin :

1  Choisissez Setup > I/O.

2  Cliquez sur l'onglet Input, Output, Insert ou 
Bus pour afficher le type de chemin 
correspondant.

3  Effectuez l'une des opérations suivantes :

• Cliquez sur New Path, ou appuyez sur 
Ctrl+N (Windows) ou sur Pomme+N (Mac). 

– ou –

• Sélectionnez un chemin principal et 
cliquez sur New Sub-Path. 

4  Cliquez deux fois dans le champ Name et 
attribuez un nom au chemin. 

Options de chemin par type

Type de 
chemin

Options de chemin (attributs)

Entrée Noms, formats, et canal/voie 
source (interface audio 
analogique ou numérique)

Sortie Noms, formats et destination 
(canal de sortie de l'interface 
audio ou bus de départ interne)

Insert Noms, formats et destination 
(canaux de l'interface audio)

Bus Noms et formats

Chemins de sorties stéréo par défaut

Pour optimiser les ressources du DSP du 
système Pro Tools|HD, il est préférable de 
créer des sous-chemins mono pour les sorties 
et les bus, plutôt que de créer des chemins 
mono principaux.
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5  Appuyez sur la touche de tabulation pour 
valider le nouveau nom du champ et passer au 
champ Name du chemin suivant, ou appuyez 
sur Entrée (Windows) ou sur Retour (Mac) pour 
valider le nom du nouveau chemin. 

6  Choisissez un format dans le sélecteur de 
format de chemin (mono, stéréo ou multicanal). 

7  Configurez les autres types de chemins (Input, 
Output, Insert ou Bus) en répétant les étapes 
précédentes.

8  Cliquez sur OK pour fermer la boîte de 
dialogue I/O Setup. Si certains chemins se 
superposent ou portent le même nom, vous 
serez invité à les corriger avant que la boîte de 
dialogue I/O Setup ne se referme. Pour plus 
d'informations, reportez-vous à la section 
Configuration des E/S, page 66.

Modification des noms des chemins

Les noms des chemins peuvent être 
personnalisés dans la boîte de dialogue 
I/O Setup.

Pour renommer un chemin dans la boîte de 
dialogue I/O Setup :

1  Cliquez deux fois sur le nom du chemin.

2  Saisissez le nouveau du chemin.

3  Appuyez sur la touche Entrée (Windows) ou 
Retour (Mac). 

Modification des noms des interfaces

Les noms des interfaces audio peuvent être 
personnalisés dans la boîte de dialogue 
I/O Setup. Par la suite et sur les systèmes 
Pro Tools HD uniquement, la boîte de dialogue 
I/O Setup base les noms de chemins par défaut 
sur ces noms personnalisés.

Pour renommer une interface audio dans la boîte 
de dialogue I/O Setup :

1  Cliquez deux fois sur l'étiquette située 
au-dessus du nom d'une interface.

2  Attribuez un nouveau nom à l'interface.

3  Appuyez sur la touche Entrée (Windows) ou 
Retour (Mac). 

Sélecteur de format de chemin

Les chemins multicanaux et le mixage sont 
expliqués au chapitre 32, Configuration de 
Pro Tools pour le mixage en mode Surround 
(Pro Tools HD uniquement).

Vous pouvez également renommer les 
chemins d'E/S directement dans la fenêtre 
Edit ou Mix. Pour cela, cliquez avec le 
bouton droit de la souris sur le sélecteur 
d'entrée ou de sortie, puis choisissez la 
commande Rename.

Noms des interfaces

Nom de l'interface
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Sélection et agencement des chemins

La colonne Path Name de la boîte de dialogue 
I/O Setup permet de sélectionner un ou 
plusieurs chemins. Une fois sélectionnés, les 
chemins et sous-chemins peuvent être déplacés 
vers le haut ou vers le bas pour changer leur 
ordre d'affichage dans les sélecteurs d'entrées, de 
sorties, d'inserts et de bus de la piste. 
Vous pouvez également les supprimer. 
Un sous-chemin suit son chemin principal lors 
de leur déplacement dans la boîte de dialogue 
I/O Setup.

Pour sélectionner un chemin principal ou un 
sous-chemin :

" Cliquez sur le nom du chemin.

Pour sélectionner un ensemble continu de 
chemins :

1  Cliquez sur le nom du chemin.

2  Tout en maintenant la touche Maj enfoncée, 
cliquez sur un nom de chemin supplémentaire.

Tous les chemins compris entre le premier nom 
de chemin sélectionné et le nom de chemin 
supplémentaire sont automatiquement pris en 
compte.

Pour sélectionner ou désélectionner des chemins 
non contigus, procédez comme suit :

" Tout en maintenant la touche Pomme (Mac) 
ou Ctrl (Windows) enfoncée, cliquez sur les 
noms de chemins n'apparaissant pas en 
surbrillance pour les sélectionner.

– ou –

" Maintenez enfoncée la touche Ctrl (Windows) 
ou Pomme (Mac) et cliquez sur les noms de 
chemin qui sont en surbrillance pour les 
désélectionner.

Pour sélectionner tous les chemins et 
sous-chemins :

" Maintenez la touche Alt (Windows) ou 
Option (Mac) enfoncée pendant que vous 
cliquez sur un nom de chemin qui n'est pas en 
surbrillance.

Pour désélectionner tous les chemins et 
sous-chemins :

" Maintenez la touche Alt (Windows) ou 
Option (Mac) enfoncée pendant que vous 
cliquez sur un nom de chemin en surbrillance.

Pour réagencer les chemins :

" Faites glisser un ou plusieurs noms de chemin 
vers le haut ou vers le bas. 

Réinitialisation des chemins par 
défaut

Le bouton Default de la boîte de dialogue 
I/O Setup possède deux fonctions principales :

• Création de chemins par défaut jusqu'à la 
limite de la capacité des interfaces audio et 
ressources disponibles de votre système. Pour 
plus d'informations, reportez-vous à la section 
Création d'un chemin ou d'un sous-chemin 
par défaut, page 61.

Sélection des chemins dans la boîte de dialogue 
I/O Setup
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• Réinitialisation des noms des chemins 
sélectionnés conformément aux chemins 
correspondants de la configuration d'E/S en 
cours. Si vous remplacez, par exemple, une 
interface audio sur un système Pro Tools|HD, 
le bouton Default permet de mettre à jour vos 
définitions de paramètres d'E/S en fonction de 
la nouvelle configuration du matériel. 

Pour réinitialiser les noms des chemins :

" Cliquez sur Default.

Si des chemins correspondants sont disponibles 
dans la nouvelle configuration du système, les 
chemins existants seront mis à jour afin 
d'inclure les nouvelles interfaces audio 
(systèmes Pro Tools|HD).

Réinitialisation des bus de mixage

(Pro Tools HD uniquement)

Pro Tools HD prend en charge jusqu'à 128 bus 
de mixage (Pro Tools HD 7.x et Pro Tools 
TDM 6.9). En revanche, les versions précédentes 
de Pro Tools TDM et Pro Tools LE fournissent 
respectivement un maximum de 64 et de 32 bus 
de mixage. Lorsque vous ouvrez une session 
créée avec Pro Tools LE ou une version 
antérieure de Pro Tools TDM sur la version la 
plus récente de Pro Tools HD, le nombre de bus 
pris en charge correspond dans un premier 
temps à celui du système antérieur. Vous pouvez 
cependant redéfinir ce nombre de manière à 
exploiter les capacités de votre système 
Pro Tools HD.

Pour utiliser tous les bus disponibles dans des 
sessions prenant en charge un nombre de bus de 
mixage inférieur :

1  Ouvrez la boîte de dialogue I/O Setup.

2  Cliquez sur l'onglet Bus situé dans l'angle 
supérieur gauche.

3  Cliquez sur Default. 

Suppression de chemins

Les définitions de chemins inutiles ou 
indésirables peuvent être supprimées de la 
session courante pour refléter les modifications 
de votre configuration matérielle ou pour 
nettoyer les menus du sélecteur de piste. 
Après avoir supprimé un chemin, les 
affectations de pistes ou de signaux d'envoi 
vers celui-ci sont réinitialisées à No Output 
(pas de sortie).

Pour supprimer un chemin principal ou un 
sous-chemin :

1  Sélectionnez les chemins que vous voulez 
supprimer dans la boîte de dialogue I/O Setup. 

2  Cliquez sur Delete Path. 

Pour supprimer tous les chemins :

1  Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée pendant que vous cliquez sur un 
nom de chemin.

2  Cliquez sur Delete Path.

Il est possible de personnaliser les noms des 
interfaces. Pour plus d'informations, 
reportez-vous à la section Modification des 
noms des interfaces, page 62.

Le rétablissement des paramètres de bus par 
défaut a pour effet de redéfinir le nom de 
tous les bus en fonction de leurs noms par 
défaut.
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Affectation des canaux

Lorsque vous avez créé et formaté un chemin, il 
peut être affecté à des canaux de la grille 
spécifiques d'une interface audio ou d'un bus.

Pour affecter des canaux :

1  Sélectionnez un chemin principal ou un 
sous-chemin. 

2  Dans la rangée correspondant au chemin 
sélectionné, cliquez sur la colonne de la grille 
sous l'interface audio et le canal désirés. 
Les autres canaux pour ce type de chemin sont 
renseignés à droite, le cas échéant. 

Lorsque vous affectez, par exemple, un nouveau 
chemin stéréo et que vous cliquez sous le canal 
de sortie 1 dans la rangée correspondant au 
chemin, les canaux 1 et 2 se remplissent (à 
gauche sur 1, à droite sur 2). 

Affectation de canaux et console de mixage 
Surround

(Pro Tools HD uniquement)

Lors de l'affectation de chemins multicanaux, le 
canal de gauche (L) est affecté en premier sur la 
zone de grille sélectionnée et les canaux restants 
de droite sont renseignés immédiatement en 
respectant l'ordre des chemins par défaut. Du 
fait que certains formats de mixage multicanaux 
utilisent des dispositions de pistes propres, 
Pro Tools permet de définir le format par défaut 
dans la boîte de dialogue I/O Setup (voir 
Options de configuration d'E/S, page 72).

Réaffectation de canaux

Vous pouvez déplacer les affectations 
individuelles vers des canaux différents pour 
réorganiser la définition du chemin (en 
modifiant une affectation multicanal en 
L-R-C-LF-LS-RS, par exemple). 

Pour réaffecter des canaux dans un chemin :

" Faites glisser le canal vers le nouvel 
emplacement de la grille. Les autres affectations 
de canaux se décalent en conséquence.

Réorganisation des canaux

Le déplacement d'un signal de droite à gauche 
produit une réorganisation des autres signaux se 
retrouvant placés après le nouveau canal de 
destination. Le déplacement d'un signal de 
gauche à droite provoque une réorganisation 
(shuffling) de tous les signaux à la suite du 
nouveau canal de destination et laisse vide le 
canal précédemment utilisé. 

Affectation des canaux

Pour réaffecter des canaux dans un chemin, 
reportez-vous à la section Réaffectation de 
canaux, page 65.

Chemins de sorties personnalisés pour un mixage 5.1

Le changement de format d'un chemin 
efface toutes les affectations de canaux en 
cours. 
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Les sous-chemins suivent les chemins 
principaux

Lorsqu'un chemin principal est réaffecté, ses 
sous-chemins (s'il en existe) sont réaffectés 
automatiquement pour conserver la cohérence 
des affectations. Par exemple, la réaffectation 
d'un chemin stéréo vers d'autres sorties 
matérielles s'accompagne d'un déplacement 
identique de ses sous-chemins. 

Configuration des E/S

Pour définir la configuration d'E/S en cours :

" Cliquez sur OK dans la boîte de dialogue 
I/O Setup. 

Tous les chemins doivent être valides pour 
pouvoir appliquer la configuration d'E/S. 

Chemins valides et conditions

Lors de la configuration de la boîte de dialogue 
I/O Setup, un certain nombre de règles doivent 
être respectées pour définir les chemins et 
affecter les canaux. 

Bien qu'il soit possible de définir des affectations 
non valides dans la grille des canaux, Pro Tools 
n'acceptera une configuration d'E/S que si tous 
les chemins correspondent aux conditions de 
définition des chemins et d'affectation décrites 
ci-après.

Définitions minimales des chemins : tous les 
chemins doivent posséder un nom, un format 
spécifique et une affectation d'E/S valide. 

Canaux superposés et chemins valides : 

l'affectation des canaux respecte certaines règles 
concernant la superposition des chemins. 

• Il ne peut exister aucune superposition 
partielle ou complète entre deux chemins 
de sorties principaux, entre deux chemins 
d'inserts ni entre deux chemins de bus 
principaux. 

• Un chemin de type Output ou Bus créé doit 
être soit complètement indépendant des 
autres chemins (c'est-à-dire affecté à 
aucune autre interface d'E/S ou canal 
disponible) soit un sous-chemin 
totalement intégré à un chemin plus grand 
(par exemple un sous-chemin LCR dans un 
chemin 5.1).

• Les chemins de type Output et Insert 
peuvent se superposer dans la 
configuration d'E/S, mais un seul des deux 
peut être utilisé à un instant donné en 
cours de session. En revanche, les chemins 
de type Inputs peuvent être affectés à 
plusieurs pistes. 

Chemins actifs et inactifs

Les chemins de Pro Tools peuvent être actifs 
(on) ou inactifs (off, ou non disponibles). 
La commutation actif/inactif s'effectue 
manuellement, piste par piste ou session par 
session. En outre, Pro Tools définit 
automatiquement les chemins sur inactifs 
lorsque l'E/S n’est pas disponible. 

Affectation des chemins d'une piste : 
l'état inactif peut être attribué à l'affectation des 
chemins d'entrée, de sortie et de bus d'une piste 
à l'aide du sélecteur approprié. Les playlists des 
pistes restent ainsi intactes, mais la piste choisie 
est déconnectée du chemin de sortie ou de bus. 
Vous pouvez ainsi supprimer une piste d'un 
chemin de signal.
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Affectation de chemins à l'échelle de la session : 
vous pouvez activer ou désactiver globalement 
les chemins dans la boîte de dialogue I/O Setup. 
Vous pouvez ainsi désactiver un chemin de 
signal sur toutes les pistes qui lui sont 
actuellement affectées. Pro Tools désactive 
également les chemins non disponibles. 
Les chemins peuvent être non disponibles 
lorsque des dispositifs ou d'autres ressources du 
système ne sont pas disponibles, par exemple 
lors de l'ouverture d'une session enregistrée sur 
un autre système. 

Affectations des chemins d'une piste

(fenêtres Mix et Edit)

Pour activer ou désactiver l'affectation du chemin 
d'une piste :

" Dans la fenêtre Mix ou Edit, maintenez 
enfoncées les touches Ctrl+Démarrer (Windows) 
ou Pomme+Ctrl (Mac) pendant que vous cliquez 
sur le sélecteur d'entrée, de sortie, d'insert ou de 
départ de la piste. 

Les affectations de chemins de pistes inactives 
apparaissent en italique et sans surbrillance.

Inactivation ou activation de toutes les pistes 
ou de toutes les pistes sélectionnées

Les touches de modification Alt (Windows) ou 
Option (Mac) font basculer le chemin sur toutes 
les pistes. Les touches de modification Alt+Maj 
(Windows) ou Option+Maj (Mac) font basculer 
le chemin sur toutes les pistes sélectionnées. 
Cependant, Pro Tools n'appliquera la 
modification qu'à des affectations de chemins 
identiques, s'il en existe, dans la ou les pistes en 
cours. La bascule de plusieurs pistes n'affecte que 
celles qui possèdent la même affectation de 
chemin que celle que vous basculez de façon 
explicite. 

Bascule de plusieurs chemins

Si une piste ne possède qu'une affectation de 
sortie principale, maintenez enfoncées les 
touches Ctrl+Démarrer (Windows) ou 
Pomme+Ctrl (Mac) tout en cliquant sur son 
sélecteur de chemin de sortie pour désactiver la 
sortie principale. En cas d'affectations multiples, 
le sélecteur de piste s'affiche afin de vous 
permettre de spécifier le chemin d'entrée, de 
sortie, d'insert, ou de bus. 

Si un signal de départ (A - J) possède plusieurs 
affectations de sortie et si l'une d'entre elles a été 
basculée, toutes les affectations de sortie de ce 
signal de départ (A - J) seront basculées.

Chemins inactifs à l'échelle de la 
session

(boîte de dialogue I/O Setup)

Vous pouvez définir globalement le statut actif 
ou inactif des chemins dans la boîte de dialogue 
I/O Setup. 

Pour activer ou désactiver globalement un 
chemin :

1  Choisissez Setup > I/O.

2  Sélectionnez un type de chemin avec les 
onglets situés en haut de la fenêtre. 

3  Définissez le chemin comme actif ou inactif. 

Chemins actifs et inactifs dans la fenêtre I/O Setup

Inactif

Actif
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Les chemins inactifs apparaissent en italique 
dans les sélecteurs de chemin de la piste.

Affichage du statut actif ou inactif

Absence de surbrillance (italique) : indique que 
le chemin est inactif.

Surbrillance (sans italique) : indique que le 
chemin est actif.

Surbrillance (italique) : indique que le chemin 
est actif, mais qu'il n'y a pas suffisamment de 
ressources système disponibles. 

Configuration matérielle et 
transfert de session

Les sessions Pro Tools mémorisent le type et 
l'ordre des interfaces audio connectées et actives 
lors du dernier enregistrement de la session. 

E/S non disponibles

Lors de l'ouverture d'une session, Pro Tools 
vérifie si la configuration matérielle a changé 
depuis le dernier enregistrement de la session. 
Si la configuration matérielle est différente de 
celle de la dernière session enregistrée, les 
chemins associés aux E/S non disponibles sont 
rendus inactifs. 

Réaffectation

La réaffectation se produit lorsque la 
configuration d'origine d'une session ne 
correspond pas à celle du système courant et les 
chemins de la session sont réaffectés en fonction 
du matériel actuel. 

Les systèmes présentant des fonctions 
équivalentes en E/S sont réaffectés directement. 
Supposons, par exemple, qu'une session a été 
enregistrée sur un système Pro Tools|HD par 
l'intermédiaire de deux interfaces audio 
192 I/O : elle inclut 32 chemins d'entrée répartis 
sur les deux interfaces à 16 canaux. Cette session 
est chargée sur un système Pro Tools différent 
possédant une interface audio 96 I/O (16 canaux 
d'E/S) et une interface 1622 I/O (16 entrées 
analogiques) connecté à son port Legacy. 
Lors de l'ouverture initiale de la session dans le 
second système, Pro Tools affecte les 32 chemins 
d'entrée vers les entrées des deux interfaces. 

Lorsque le matériel n'est pas disponible à 
l'ouverture d'une session, les affectations 
peuvent être soit remplacées avec l'option de 
réaffectation, soit ouvertes comme inactives. 
Toute piste restant affectée à un chemin non 
disponible ne sera pas audible. Ceci peut 
toutefois être utile lorsque vous souhaitez 
réaffecter une par une des pistes dans le mixage 
de votre système.

Toute affectation du chemin peut 
également être désactivée piste par piste. 
Pour plus d'informations, reportez-vous à la 
section Affectations des chemins d'une 
piste, page 67.

Chemins actifs et inactifs dans un sélecteur de chemin 
de sortie de piste

Pour plus d'informations, reportez-vous à la 
section Chemins actifs et inactifs, page 66.
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Affichage de la dernière configuration 
enregistrée et de la configuration en cours

Lorsqu'une session ouverte contient des 
définitions de chemins pour des interfaces d'E/S 
non disponibles, la boîte de dialogue I/O Setup 
affiche la liste de ces chemins en italique. 

Le bouton Show Last Saved Setup affiche les 
interfaces audio utilisées dans la session 
d'origine. Cet affichage temporaire permet de 
consulter pour référence la dernière 
configuration des E/S enregistrée tandis que 
vous configurez la session de votre système. 

Lorsqu'une session a été ouverte en conservant 
des E/S non disponibles, vous pouvez réaffecter 
les pistes vers des chemins d'E/S disponibles. 

Fichiers des paramètres d'E/S
Vous aurez à gérer les paramètres d'E/S lors du 
transfert de sessions et lorsque vous développez 
des configurations d'E/S dans le cadre de 
sessions et de projets multiples. 

Paramètres par défaut, fichiers 
des paramètres et derniers 
paramètres utilisés pour les 
nouvelles sessions

Lorsque vous créez de nouvelles sessions, vous 
pouvez définir la configuration des E/S de la 
session en utilisant les options suivantes : 

Default I/O Setups : le programme d'installation 
de Pro Tools offre des présélections pour les 
configurations d'E/S stéréo et Surround 
(Pro Tools|HD uniquement). Pour plus 
d'informations, reportez-vous à la section 
Fichiers des paramètres d'E/S d'usine, page 71. 

Custom Presets : vous pouvez stocker et 
rappeler des présélections personnalisées à l'aide 
des fonctions d'exportation et d'importation de 
la boîte de dialogue I/O Setup. 

Last Used : la configuration d'E/S la plus récente 
(ou la dernière utilisée) est enregistrée dans un 
fichier de paramètres Last Used. Pour plus 
d'informations, reportez-vous à la section 
Paramètres d'E/S dernièrement utilisés, page 70. 

Paramètres d'E/S par défaut lors de la 
création d'une session

Lorsque vous créez une session, vous pouvez 
choisir les paramètres par défaut de mixage 
stéréo ou de mixage Surround, suivant votre 
système et votre configuration. Pour plus 
d'informations, reportez-vous à la section 
Fichiers des paramètres d'E/S d'usine, page 71. 

Importation et exportation des fichiers 
de paramètres d'E/S

Vous pouvez exporter et importer des 
configurations d'E/S sous forme de fichiers de 
paramètres d'E/S. Vous pouvez ainsi enregistrer 
les paramètres concernant différents projets, les 
importer pour une reconfiguration d'E/S, gérer 
des définitions de chemins et des paramètres de 
routage du signal. 

Pour redéfinir les chemins, consultez la 
section Création et modification de 
chemins, page 60. 



Guide de référence Pro Tools70

Exportation de paramètres d'E/S

Pour exporter et enregistrer une configuration 
d'E/S :

1  Cliquez sur Export Settings. 

2  Attribuez un nom au fichier des paramètres, 
puis enregistrez-le.

Importation des paramètres d'E/S

Vous pouvez importer les paramètres d'E/S 
avant d'ouvrir une session ou alors dans une 
session déjà ouverte (voir Paramètres d'E/S par 
défaut lors de la création d'une session, page 69). 

Lorsque vous importez des paramètres d'E/S 
dans une session existante, vous pouvez 
supprimer toutes les définitions de chemins 
inutilisées avant d'importer les nouveaux 
chemins ou laisser les définitions de chemins 
inchangées et ajouter les nouveaux chemins à la 
configuration des paramètres d'E/S actuelle.

Pour importer des paramètres d'E/S :

1  Cliquez sur Import Settings dans la boîte de 
dialogue I/O Setup.

2  Sélectionnez un fichier de paramètres d'E/S 
dans la boîte de dialogue Import Settings et 
cliquez sur Import. 

3  Une boîte de dialogue s'affiche, vous 
demandant si vous souhaitez ou non supprimer 
les chemins existants. Effectuez l'une des 
opérations suivantes :

• Cliquez sur Yes pour supprimer les chemins 
inutilisés et ajouter les chemins importés 
dans la configuration d'E/S actuelle. Cette 
opération efface toutes les affectations 
d'E/S et données d'automation liées aux 
chemins inutilisés. 

– ou –

• Cliquez sur No pour ajouter les chemins 
importés à votre configuration actuelle 
des I/O. 

Si l'importation produit des chevauchements 
des chemins, les nouveaux chemins 
apparaissent inactifs dans la boîte de dialogue 
I/O Setup Pour plus d'informations, 
reportez-vous à la section Chemins actifs et 
inactifs, page 66.

Après avoir importé les paramètres d'E/S, vous 
pouvez réassigner les définitions d'affectation de 
chemin dans la boîte de dialogue I/O Setup en 
modifiant l'affectation des chemins, en les 
renommant et en les supprimant. Pour plus 
d’informations, reportez-vous à la section 
« Création et modification de chemins », 
page 60.

Paramètres d'E/S dernièrement 
utilisés

Si vous effectuez des modifications dans la boîte 
de dialogue I/O Setup au cours d'une session, 
elles seront enregistrées dans le fichier de 
paramètres Last Used lorsque vous refermez la 
boîte de dialogue (en cliquant sur OK). 

Les modifications de configuration des I/O sont 
enregistrées lors de la sauvegarde de la session en 
cours. Les fichiers de présélections utilisateur ne 
contiendront pas les récentes modifications, 
sauf si vous exportez un fichier de paramètres 
mis à jour. 

Pour démarrer des sessions avec une boîte de 
dialogue I/O Setup vierge ou vide, il est 
possible de créer et d'exporter un fichier de 
paramètres d'E/S dans lequel toutes les 
définitions ont été supprimées. 
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Les derniers paramètres utilisés sont disponibles 
en tant que choix lors de la création ou de 
l'ouverture des sessions, en plus des 
présélections d'usine décrites ci-dessous.

Fichiers des paramètres d'E/S d'usine

Pro Tools contient des fichiers de paramètres 
d'E/S d'usine pour le mixage stéréo et Surround. 
Ces fichiers contiennent des définitions 
génériques de chemins principaux et de 
sous-chemins pour les deux formats de mixage. 

Fichier de paramètres pour le mixage stéréo

La présélection Stereo Mix (mixage stéréo) est 
constituée de tous les chemins stéréo et mono 
possibles dans votre session. 

La présélection Stereo Mix crée notamment le 
nombre maximal de chemins de chaque type, 
déterminé par la configuration des E/S 
disponibles du système et la configuration du 
matériel.

Fichiers de paramètres pour le mixage Surround 
(Pro Tools HD uniquement)

Le fichier Surround Mix offre d'autres 
présélections de sortie et de bus, spécifiques au 
Surround. Pour plus d'informations, 
reportez-vous à la section Fichiers de paramètres 
de mixage surround, page 875.

A propos du mode Direct Outputs

Le mode Direct Outputs (sorties directes), qui 
existait dans les versions précédentes de 
Pro Tools, a été remplacé par les sous-chemins 
mono par défaut, disponibles par l'intermédiaire 
de toutes les E/S valides dans la boîte de dialogue 
I/O Setup. 

Le bouton Default crée les chemins de sortie 
principaux avec les sous-chemins mono 
appropriés. Ces sous-chemins permettent 
l'affectation monophonique cas par cas. 

A l'ouverture d'une session enregistrée en mode 
Direct Outputs, Pro Tools affecte toutes les 
sorties vers des sous-chemins mono équivalents 
(en fonction des disponibilités). Consultez la 
section Configuration matérielle et transfert de 
session, page 68 pour plus d'informations sur la 
réaffectation. 

Pour convertir une session afin qu'elle émule le 
mode Direct Outputs, utilisez la fonction Auto 
Assign Ascending Outputs, comme expliqué 
ci-après.

Pour affecter automatiquement des sorties de 
piste en mode Direct Outputs :

1  Vérifiez que toutes les pistes que vous 
souhaitez assigner sont visibles (les pistes 
masquées n'étant pas assignées).

2  Choisissez les pistes à affecter.

3  Maintenez enfoncées les touches Ctrl+Alt 
(Windows) ou Pomme+Option (Mac), pendant 
que vous cliquez sur le sélecteur de sortie de la 
piste la plus à gauche et affectez-la au 
sous-chemin pour Output#1. Toutes les pistes 
visibles seront alors automatiquement affectées, 
une par une, à des sorties de sous-chemin mono, 
par ordre croissant.

Le choix de la présélection Stereo Mix 
équivaut à cliquer sur le bouton Default de 
chaque onglet de la boîte de dialogue 
I/O Setup. Pour plus d'informations, 
consultez la section Création et 
modification de chemins, page 60. 
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Options de configuration 
d'E/S
Les systèmes Pro Tools sont dotés de fonctions 
de paramétrage d' E/S supplémentaires. Il s'agit 
du routage des signaux par défaut pour 
l'affichage et l'écoute, et de la disposition des 
pistes par défaut pour les formats de mixage 
multicanaux.

Chemin du vumètre
(D-Control, D-Command et ProControl 
uniquement)

Le sélecteur de vumètre de chemin du 
contrôleur détermine le chemin affiché sur les 
vumètres de sortie des surfaces de contrôle 
D-Control, D-Command ou ProControl. 
Pour plus de détails, reportez-vous à la 
documentation de votre surface de contrôle.

Chemins d'écoute

Vous pouvez spécifier le chemin de sortie par 
lequel les fichiers et les régions sont écoutés 
dans la liste des régions ou dans les navigateurs 
DigiBase.

Utilisation du chemin d'écoute par 
défaut

Lorsque vous écoutez un fichier ou une région 
de la liste des régions, Pro Tools assure la sortie 
audio par envoi sur le chemin d'écoute. 
Pro Tools affecte un chemin d'écoute par défaut 
au premier chemin de sortie principal du format 
donné disponible. Vous pouvez également 
sélectionner un chemin d'écoute différent dans 
la boîte de dialogue I/O Setup.

Configuration des chemins d'écoute

Vous pouvez spécifier les sorties de contrôle 
souhaitées pour la liste des régions en utilisant le 
menu Audition paths. 

Menu principal Audition Paths : le menu 
principal est constitué de tous les choix de 
formats de chemin disponibles dans le système 
actuel (formats mono et stéréo sur tous les 
systèmes, formats LCR et au-delà sur les 
systèmes Pro Tools|HD). 

Sous-menus Audition Paths : Chaque choix de 
format du chemin dispose d'un sous-menu 
dressant la liste des chemins de sortie de ce 
format donné. Le sous-menu mono dresse la 
liste des chemins de sorties de n'importe quel 
format.

Pour configurer un chemin d'écoute :

" Sélectionnez le chemin désiré dans le menu 
ou les sous-menus Audition Paths.

Vous pouvez identifier les connexions de 
l'interface audio à tout moment en 
sélectionnant le nom de l'interface dans la 
liste des périphériques de la boîte de 
dialogue Hardware Setup, puis en cliquant 
sur Identify. Tous les voyants situés sur le 
panneau avant de l'interface s'illuminent.

Dans les systèmes Pro Tools|HD dotés de 
plusieurs interfaces audio, vous ne pouvez 
sélectionner que la première comme chemin 
d'écoute.
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Pour écouter les régions dans la liste des régions :

" Maintenez enfoncée la touche Alt (Windows) 
ou Option (Mac) pendant que vous cliquez sur la 
région de la liste.

Ecoute canal par canal de signaux multicanaux

Dans la liste des régions, les régions 
multicanaux sont écoutées via le chemin 
d'écoute en cours. Les signaux peuvent être 
écoutés tels quels (in-place) ou via toutes les 
sorties, comme décrit ci-dessous. 

Ecoute in-place

Lorsque vous écoutez un canal mono d'une 
région mono, cette région peut être lue à partir 
du canal correspondant de la région mono 
parente correspondante. Cette méthode de 
lecture s'appelle l'écoute « in-place ».

Pour écouter un canal « in-place » :

1  Dans la liste des régions, vérifiez que la région 
stéréo ou multicanal se trouve en vue 
développée (elle affiche .L, .R et les autres 
canaux la composant). 

2  Maintenez enfoncée la touche Option (Mac) 
ou Alt (Windows) pendant que vous cliquez sur 
la région du canal que vous souhaitez écouter. 

Ecoute sur toutes les sorties

Lorsque vous écoutez un canal mono d'une 
région mono, cette région peut être redirigée de 
manière uniforme vers toutes les sorties du 
chemin d'écoute de la région parente 
correspondante.

Pour écouter sur tous les canaux du chemin 
d'écoute principal :

" Maintenez enfoncée la touche Alt (Windows) 
ou Option (Mac) pendant que vous cliquez sur le 
signal dans la liste des régions. 

Chemin de sortie par défaut de la 
nouvelle piste

Vous pouvez définir l'affectation de chemin de 
sortie par défaut pour les nouvelles pistes, dans 
chaque format disponible. 

Pour spécifier une sortie par défaut pour les 
nouvelles pistes dans la boîte de dialogue 
I/O Setup :

" Cliquez sur le sélecteur de sortie par défaut de 
la nouvelle piste et sélectionnez un format et 
une sortie.

Chemin AFL/PFL
(Pro Tools HD uniquement)

Les pistes mises en solo en mode Solo AFL 
(After Fader Listen) ou PFL (Pre Fader Listen) 
sont acheminées vers le chemin AFL/PFL actuel, 
tel qu'il est défini par le sélecteur de chemin 
AFL/PFL.

Pour sélectionner la sortie AFL/PFL :

1  Choisissez Setup > I/O.

2  Cliquez sur l'onglet Output afin d'afficher la 
page Output.

Le paramètre New Track Default Output 
peut être défini aussi bien pour des chemins 
de bus que pour des chemins de sortie.

Pour plus d'informations sur l'utilisation 
des modes Solo AFL ou PFL, reportez-vous à 
la section Modes Solo, page 166.

Si le sélecteur de chemin AFL/PFL n'est pas 
visible, assurez-vous d'avoir installé le 
plug-in Surround Mixer.
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3  Sélectionnez un chemin à l'aide du sélecteur 
de chemin AFL/PFL.

4  Cliquez sur OK pour fermer la boîte de 
dialogue I/O Setup.

Définition des niveaux de chemin AFL ou PFL

Vous pouvez définir un niveau de chemin 
maître AFL/PFL indépendant pour tous les solos 
AFL et tous les solos PFL.

Pour configurer le niveau de chemin AFL/PFL pour 
tous les solos AFL ou PFL :

1  Choisissez Options > Solo Mode et 
sélectionnez un mode Solo en procédant de la 
façon suivante :

• Pour définir le niveau pour l'ensemble des 
solos AFL, sélectionnez AFL.

– ou –

• Pour définir le niveau pour les solos PFL, 
sélectionnez PFL.

2  Dans la fenêtre Mix ou Edit, maintenez 
enfoncée la touche Ctrl (Windows) ou Pomme 
(Mac) tout en cliquant sur un bouton Solo d'une 
piste.

3  Réglez le fader du chemin AFL/PFL.

4  Cliquez sur la nouvelle position du fader (ou 
appuyez sur Echap) pour fermer l'écran du fader.

Sélecteur de coupure AFL/PFL (chemin 
de sortie)

(Systèmes sans surface de contrôle D-Control 
ou D-Command)

Si vous n'utilisez pas une surface de contrôle 
D-Control ou D-Command, votre chemin de 
sortie Pro Tools normal peut être coupé lorsque 
vous envoyez un signal vers le chemin AFL/PFL. 
Pour ce faire, vous utiliserez le sélecteur de 
coupure AFL/PFL (chemin de sortie).

Pour désigner le chemin de sortie qui est coupé 
lors de l'écoute en solo des pistes en mode AFL 
ou PFL :

1  Choisissez Setup > I/O.

2  Cliquez sur l'onglet Output afin d'afficher la 
page Output.

3  Sélectionnez un chemin à l'aide du sélecteur 
de coupure AFL/PFL (chemin de sortie).

4  Cliquez sur OK pour fermer la boîte de 
dialogue I/O Setup.

Ordre des chemins par défaut
(Pro Tools HD uniquement)

Le sélecteur d'ordre des chemins par défaut 
permet de sélectionner la disposition de pistes 
par défaut qui sera suivie par Pro Tools lorsque 
vous créez et affectez des chemins principaux ou 
des sous-chemins au format 5.1 dans la boîte de 
dialogue I/O Setup. 

Ce paramètre n'affecte ni les définitions de 
chemin existantes, ni l'affichage des niveaux. 
Il ne fait que spécifier l'affectation des canaux 
dans le nouveau format 5.1. 

L'option None a pour effet de désactiver les 
modes Solo AFL et PFL. Dans ce cas, les 
modes AFL et PFL ne sont pas utilisables.

Il n'est pas nécessaire de mettre les pistes en 
solo pour que le niveau de chemin AFL/PFL 
maître soit réglé. 

Pour définir le niveau de chemin AFL/PFL 
sur 0 dB, cliquez sur un bouton Solo tout en 
maintenant les touches Ctrl+Démarrer 
(Windows) ou Ctrl+Pomme (Mac) 
enfoncées.

Pour plus d'informations sur la sélection et 
l'utilisation des modes Solo AFL ou PFL, 
reportez-vous à la section Modes Solo, 
page 166.
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Pour choisir un ordre de chemin par défaut :

" Sélectionnez l'affectation de canal dans le 
menu Default Path Order. 

Compensation H/W Insert 
Delay
(Pro Tools HD uniquement)

Pour compenser le retard (latence) des 
périphériques matériels externes (par exemple, 
une unité d'effets) utilisés dans la session, vous 
pouvez définir la valeur de compensation (en 
millisecondes) de chacun d'entre eux. Les 
valeurs entrées seront utilisées par le moteur de 
retardement pour synchroniser les chemins 
d'entrées lorsque l'insert matériel est en cours 
d'utilisation et que la compensation de retard est 
activée.

Pour régler le décalage de retard d'un insert :

" Entrez une valeur en millisecondes dans le 
champ correspondant à l'entrée à laquelle 
l'insert matériel est connecté.

Sélecteur d'ordre des chemins par défaut

Pour plus d'informations sur le mixage 
multicanal, consultez le chapitre 32, 
Configuration de Pro Tools pour le mixage 
en mode Surround (Pro Tools HD 
uniquement).

Champ de décalage de retard d'un insert

Les décalages de retard au niveau des 
inserts n'ont un effet que lorsque l'I/O est 
utilisée pour les inserts matériels.
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Chapitre 7 : Préferences

La zone de dialogue Preferences contient 
plusieurs pages d'onglets permettant de spécifier 
les préférences relatives à plusieurs paramètres 
de session. Chaque nouvelle session utilise 
ensuite ces paramètres.

Pour modifier les préférences de Pro Tools :

1  Choisissez Setup > Preferences.

2  Cliquez sur l'onglet correspondant à la page 
contenant les préférences à modifier. 

3  Cliquez sur OK une fois terminé.

Préférences d'affichage

Options Basics

Draw Grids in Edit Window : ajoute des 
graduations dans la fenêtre Edit. La résolution 
des graduations dépend du niveau de zoom de la 
fenêtre Edit.

Draw Waveforms Rectified : affiche les formes 
d'ondes audio dans une vue rectifiée. En d'autres 
termes, les formes d'ondes audio apparaissent de 
telle sorte que leurs excursions positive et 
négative (c'est-à-dire les parties situées au-dessus 
et en dessous de la ligne centrale) sont 
additionnées et présentées sous forme d'un 
signal positif unique. Cette vue permet 
d'afficher des formes d'onde plus détaillées, que 
la hauteur de piste soit normale ou réduite. 
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Elle sert notamment à modifier les données 
d'automation de volume, puisqu'elle représente 
le niveau des formes d'ondes à partir du bas de la 
piste.

Recompute Invalid Overviews : conduit 
Pro Tools à rechercher, à l'ouverture de la 
session, des données d'aperçu (données utilisées 
pour l'affichage des formes d'ondes) 
manquantes ou altérées. Si Pro Tools découvre 
des données d'aperçu manquantes ou altérées, le 
système recrée un ou plusieurs aperçus de la 
session. Cette opération peut durer un certain 
temps si la session contient de nombreuses 
pistes. Si vous avez des raisons de penser que les 
données d'aperçu d'une session sont altérées ou 
si vous importez des fichiers audio sans aperçu 
dans une session, assurez-vous que cette 
préférence est activée pour la session, enregistrez 
et fermez cette dernière, puis rouvrez-la. 
Pro Tools recrée alors les aperçus de la session à 
la réouverture.

Track Position Numbers Stay with Hidden 
Tracks : lorsque cette option est sélectionnée, 
les pistes masquées conservent leur numéro. 
Si elle ne l'est pas, des numéros sont affectés 
uniquement aux pistes affichées. Les pistes 
affichées sont alors numérotées 
séquentiellement et les pistes masquées ne sont 
pas numérotées.

Options d'affichage des info-bulles

Fonction : configure les info-bulles de façon à 
afficher la fonction de base de l'élément.

Details : configure les info-bulles de façon à 
afficher le nom complet d'un nom ou élément 
abrégé. La vue Details permet également 
d'afficher la valeur masquée ou abrégée des 
paramètres, ainsi que les assignations d'entrées 
et de sorties. 

Edit Window Default Length :

cette préférence permet de définir la longueur 
par défaut pour la fenêtre Edit en heures, 
minutes, secondes et images (Pro Tools HD ou 
Pro Tools LE avec DV Toolkit uniquement). 
Elle est notamment utile si vous souhaitez créer 
une session d'une durée spécifique ou conserver 
de l'espace en vue d'étendre l'espace de travail de 
la fenêtre Edit dans votre session. La longueur 
maximale est de 12 heures et 25 secondes à 
48 kHz (elle diminue de façon proportionnelle à 
des fréquences d'échantillonnage plus élevées).

Option Organize Plug-In Menus By

Cette option permet d'organiser librement les 
menus de plug-in dans le sélecteur d'insert ou le 
sélecteur de plug-in.

Flat List : permet de présenter les plug-in dans 
une liste simple triée par ordre alphabétique.

Category : affiche les plug-in par catégorie de 
processus (par exemple, EQ, Dynamics, Delay), 
chaque plug-in étant répertorié dans les 
sous-menus de catégorie. Les plug-in ne 
correspondant pas à une catégorie standard (par 
exemple, DigiRack Signal Generator) ou les 
plug-in- tiers n'appartenant pas à une catégorie 
définie par leurs développeurs, figurent dans la 
catégorie Other. Certains plug-in peuvent 
figurer dans plusieurs catégories. 

Manufacturer : permet de classer les plug-in par 
fabricant (tel que Digidesign, Eventide, Line 6 et 
McDSP), chaque plug-in étant répertorié dans 
les sous-menus de fabricant. Les plug-in dont le 
fabricant n'a pas été défini figurent dans le 
dossier fabricant Other. 

La plupart des plug-in tiers distribués par 
Digidesign sont regroupés sous Digidesign 
lorsque vous choisissez le mode d'affichage par 
fabricant.
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Category and Manufacturer : permet de classer 
les plug-in selon deux menus. Les menus de la 
partie supérieure de la fenêtre affichent les 
plug-in par catégorie de processus (par exemple, 
EQ, Dynamics, Delay), chaque plug-in étant 
répertorié dans les sous-menus de catégorie. 
Les menus de la partie inférieure de la fenêtre 
affichent les plug-in par fabricant (par exemple, 
Digidesign, Eventide, Line 6 ou McDSP), chaque 
plug-in étant répertorié dans les sous-menus de 
fabricant.

Section des vumètres

Options Peak Hold

Ces options permettent de régler la durée 
d'allumage des indicateurs d'écrêtage des 
vumètres de piste lorsqu'une crête est détectée. 

3-Second Peak Hold : lorsque cette option est 
sélectionnée, le vumètre de la piste affiche le 
dernier niveau de crête pendant trois secondes.

Infinite Peak Hold : lorsque cette option est 
sélectionnée, le vumètre de la piste affiche le 
dernier niveau de crête jusqu'à ce que vous 
l'effaciez en cliquant dessus.

No Peak Hold : lorsque cette option est 
sélectionnée, le vumètre de la piste ne « gèle » 
pas le niveau de crête.

Options Clip Indication

Ces options permettent de régler la durée 
d'allumage des indicateurs d'écrêtage des 
vumètres de piste, de plug-in et de départ 
lorsqu'une crête est détectée.

3-Second Clip Hold : lorsque cette option est 
sélectionnée, le vumètre affiche le dernier 
niveau d'écrêtage durant trois secondes.

Infinite Clip Hold : lorsque cette option est 
sélectionnée, le vumètre affiche le dernier 
niveau de crête jusqu'à ce que vous l'effaciez en 
cliquant dessus.

No Clip Hold : lorsque cette option est 
sélectionnée, le vumètre ne « gèle » pas le 
niveau d'écrêtage.

Show Meters in Sends View :

lorsque la vue Sends affiche des contrôles de 
départs distincts, sélectionnez cette option pour 
afficher les indicateurs de volume de départs. 
La désactivation de cette option permet 
d'accélérer la vitesse d'affichage et de traitement 
de l'écran.

Codage couleur

Always Display Marker Colors : permet d'afficher 
les couleurs des marqueurs dans la règle des 
marqueurs, quels que soient les paramètres 
choisis pour Default Region Color Coding. 

Options de codage couleur des pistes par 
défaut

Les options de codage couleur suivantes 
déterminent les codes de couleur utilisés par 
défaut pour les pistes dans les fenêtres Edit et 
Mix. Les choix possibles sont :

None : désactive l'affectation de couleurs pour 
les pistes.

Tracks and MIDI Channels : affecte une couleur à 
chaque piste de la fenêtre Edit ou Edit en 
fonction de l'assignation de sa voix ou de son 
canal MIDI.

Tracks and MIDI Devices : affecte une couleur à 
chaque piste de la fenêtre Edit ou Edit en 
fonction de l'assignation de sa voix ou de son 
périphérique MIDI.
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Groupes : affecte une couleur à chaque piste, 
conformément à son ID de groupe. En cas de 
suspension de groupes à l'aide de la commande 
Suspend Groups, les barres de couleurs des pistes 
ne sont pas affichées.

Track Type : affecte une couleur à chaque piste 
en fonction de leur type (audio, MIDI, 
Instrument, Auxiliaire ou Fader principal).

Options de codage couleur des régions 
par défaut

Les options de codage couleur suivantes 
déterminent les codes de couleur utilisés par 
défaut pour les régions dans la playlist de la 
piste. Les choix possibles sont :

None : désactive l'affectation de couleurs pour 
les régions. Les régions sont représentées par des 
formes d'ondes ou des notes MIDI noires sur un 
fond gris clair.

Tracks and MIDI Channels : affecte une couleur à 
chaque région de la fenêtre Edit en fonction de 
l'assignation de sa voix ou de son canal MIDI.

Tracks and MIDI Devices : affecte une couleur à 
chaque région de la fenêtre Edit en fonction de 
l'assignation de sa voix ou de son périphérique 
MIDI.

Groupes : affecte une couleur à chaque région, 
conformément à l'ID de groupe de sa piste. 
En cas de suspension de groupes à l'aide de la 
commande Suspend Groups, toutes les régions 
présentent des formes d'ondes ou des notes 
MIDI noires sur un fond gris clair.

Track Color : affecte une couleur de région basée 
sur la couleur attribuée à la piste.

Marker Locations : affecte une couleur aux 
données dans toutes les pistes en fonction du 
marqueur précédent le plus proche.

Region List Color : affecte une couleur à chaque 
région en fonction de sa couleur dans la liste des 
régions.

Préférences de 
fonctionnement

Section Transport

Timeline Insertion/Play Start Marker Follows 
Playback : lorsque cette option est sélectionnée, 
le point d'insertion de la timeline et le marqueur 
de démarrage de lecture se déplacent sur la 
timeline pour s'arrêter à l'emplacement 
correspondant à la fin de la lecture. Si cette 
option est désactivée, le point d'insertion de 
timeline et le marqueur de démarrage ne suivent 
pas la lecture.

Edit Insertion Follows Scrub/Shuttle : lorsque 
cette option est sélectionnée, le curseur 
d'édition repère automatiquement le point 
d'arrêt du scrubbing.

Audio During Fast Forward/Rewind : lorsque 
cette option est sélectionnée, le son est audible 
pendant l'avance ou le retour rapide.
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Play Start Marker Follows Timeline Selection : 
lorsque cette option est activée, le marqueur de 
démarrage de lecture s'aligne sur le marqueur de 
début de sélection de timeline lors des 
déplacements ou des créations de sélection de 
timeline ou lors des déplacements du point de 
début de sélection de timeline. Si cette option 
est désactivée, le marqueur de démarrage de 
lecture ne s'aligne pas sur la sélection de 
timeline.

Custom Shuttle Lock Speed : définit la vitesse 
Shuttle Lock d'avance rapide la plus élevée 
(touche 9) pour les modes Shuttle Lock (Classic 
ou Transport). La plage autorisée est comprise 
entre 50 et 800 %. 

Back/Forward Amount : définit la longueur par 
défaut des modes retour arrière, retour arrière et 
lecture, avance et avance et lecture. La base de 
temps des paramètres Back/Forward Amount est 
conforme à l'échelle temporelle principale par 
défaut. Il est possible de désélectionner l'option 
Follow Main Time Scale et de choisir un autre 
format de base de temps : Bars:Beats, Min:Sec, 
Time Code, Feet+Frames ou Samples.

Mode Numeric Keypad

Le mode Numeric Keypad détermine le 
fonctionnement du clavier numérique. Il est 
toujours possible d'utiliser le pavé numérique 
pour sélectionner et saisir des valeurs dans la 
zone d'édition des événements, des indicateurs 
de sélection d'édition, des compteurs principaux 
et secondaires et de la zone Transport.

Classic : le mode Shuttle Lock reproduit le 
fonctionnement de Pro Tools dans ses versions 
antérieures à la version 5.0. Lorsque le mode 
Classic Numeric Keypad est activé, vous pouvez 

lire un maximum de deux pistes audio en mode 
Shuttle Lock. Appuyez sur la touche Ctrl (Mac) 
ou Démarrer (Windows), puis sur un chiffre de 0 
à 9 pour sélectionner la vitesse de lecture. 
Appuyez sur la touche plus (+) ou moins (–) pour 
inverser la direction. Pour rappeler un 
emplacement mémoire, il suffit de saisir son 
numéro, suivi d'un point (.). 

Transport : sélectionne un mode Shuttle Lock 
permettant de définir un ensemble de fonctions 
d'enregistrement et de lecture et de piloter les 
transports depuis le clavier numérique. Lorsque 
le mode Transport Numeric Keypad est activé, 
vous pouvez lire un maximum de deux pistes 
audio en mode Shuttle Lock. Appuyez sur la 
touche Ctrl (Mac) ou Démarrer (Windows), puis 
sur un chiffre de 0 à 9 pour sélectionner la 
vitesse de lecture. Appuyez sur la touche plus (+) 
ou moins (–) pour inverser la direction. Rappeler 
un emplacement mémoire en tapant un point 
(.), le numéro de l'emplacement mémoire, puis 
un autre point (.). 

Shuttle (Pro Tools HD uniquement) : ce mode 
sélectionne un type de Shuttle différent du 
mode Shuttle Lock. En mode Shuttle, la lecture 
est déclenchée par une pression prolongée sur 
les touches du pavé numérique. Elle s'arrête 
lorsque vous relâchez les touches. Vous pouvez 
définir plusieurs vitesses de lecture, en avant ou 
en arrière. Vous pouvez également rappeler un 
emplacement mémoire en saisissant un point 
(.), son numéro, puis un autre point (.).

Pour plus d'informations, reportez-vous à la 
section Custom Shuttle Lock Speed :, 
page 450.

Pour personnaliser la vitesse Shuttle Lock 
d'avance rapide la plus élevée, reportez-vous 
à la section Custom Shuttle Lock Speed :, 
page 450.

Pour personnaliser la vitesse Shuttle Lock 
d'avance rapide la plus élevée, reportez-vous 
à la section Custom Shuttle Lock Speed :, 
page 450.
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Use Separate Play and Stop Keys :

lorsqu'elle est activée, cette option permet de 
démarrer la lecture à l'aide de la touche Entrée et 
de l'arrêter à l'aide de la touche 0 du pavé 
numérique. Cette option s'utilise notamment 
lors de l'écoute des transitions de boucle, pour 
démarrer et arrêter la lecture à des points 
rapprochés. L'option Use Separate Play and Stop 
Keys est disponible uniquement dans le mode 
Transport du pavé numérique.

Section Video

Options de priorité de lecture QuickTime

Normal : priorité de lecture par défaut d'une 
séquence QuickTime. Cette option n'attribue 
aucune priorité particulière à la lecture de la 
séquence par rapport à d'autres tâches de mise à 
jour d'écran telles que les vumètres, les 
déplacements de faders, etc. Dans la plupart des 
cas, vous pouvez utiliser ce paramètre.

Medium : ce paramètre attribue une priorité 
supérieure à la lecture d'une séquence 
QuickTime par rapport aux autres tâches de 
mise à jour d'écran de Pro Tools. Appliquez ce 
paramètre si le paramètre Normal ne permet pas 
une lecture cohérente de la séquence 
QuickTime.

Highest : ce paramètre accorde une priorité 
maximale à la lecture des séquences QuickTime. 
Dans ce mode, Pro Tools désactive les tâches à 
l'écran et exige que vous appuyiez sur la barre 
d'espace pour arrêter la lecture. Faites appel à ce 
paramètre si vous désirez une lecture 
ininterrompue de la séquence QuickTime.

High Quality QuickTime Image

Lorsque cette option est activée, Pro Tools 
décompresse les deux trames de chaque image 
entrelacée d'une séquence vidéo QuickTime. 
Lorsque vous visionnez une séquence 
QuickTime dans une fenêtre vidéo Pro Tools, 
cette option permet d'afficher la séquence dans 
la meilleure résolution possible. Si vous 
rencontrez des difficultés lors de la lecture d'une 
session contenant une séquence QuickTime, 
vous pouvez essayer d'améliorer les 
performances du système en désactivant cette 
option.

Avid Video Errors Stop Playback

(Pro Tools HD avec Avid Video Engine 
uniquement)

Lorsque cette option est sélectionnée, Pro Tools 
arrête automatiquement la lecture des données 
audio et vidéo si une seule image vidéo est 
omise.

Si elle ne l'est pas, Pro Tools continue la lecture 
des données audio même en cas d'omission 
d'images. Dans la plupart des cas, la lecture 
vidéo reprend après quelques images et les 
données audio et vidéo suivantes sont lues en 
synchronisation.

Lorsque cette option est sélectionnée, la 
touche Entrée ne permet plus d'ajouter des 
marqueurs d'emplacements mémoire. 
Pour effectuer cette opération, vous devez 
d'abord appuyer sur le point (.), puis sur la 
touche Entrée du pavé numérique.
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Avid Video NTSC Has Setup (NTSC-J)

(Pro Tools HD avec Avid Video Engine 
uniquement)

Cette préférence permet de régler le niveau de 
noir du signal vidéo NTSC sur 7,5 IRE (niveau 
standard) ou 0 IRE. Lorsque cette option est 
sélectionnée, le niveau de sortie est défini sur 
0 IRE.

Section Auto Backup

Enable Session File Auto Backup : lorsque cette 
option est sélectionnée, Pro Tools enregistre 
automatiquement des sauvegardes de votre 
fichier de session Pro Tools au cours de votre 
travail. Les sauvegardes sont placées dans le 
dossier Session Files Backup à l'intérieur de votre 
dossier de session. 

Keep : indique le nombre total de sauvegardes 
incrémentielles conservées.

Backup Every : indique la fréquence de 
sauvegarde de la session.

Record Section :

Latch Record Enable Buttons : sélectionnez cette 
option pour préparer plusieurs pistes à 
l'enregistrement. Sans cela, vous ne pourrez pas 
effectuer cette opération. La préparation d'une 
piste à l'enregistrement désactive alors la 
préparation de la piste audio précédente.

Link Record and Play Faders : lorsque cette 
option est sélectionnée, Pro Tools ne mémorise 
pas les différents niveaux de fondu des pistes 
lorsque celles-ci sont enregistrées. Vous pouvez 
dès lors uniformiser le niveau d'écoute pour 
toutes les pistes lors de l'enregistrement et de la 
lecture. 

Audio Track RecordLock (Pro Tools HD 
uniquement) : cette option permet de configurer 
Pro Tools de façon à émuler un défileur 
numérique ou à conserver le comportement 
hérité pour l'état d'enregistrement des pistes. 

• Si elle est sélectionnée, les pistes audio 
restent en mode d'enregistrement même en 
cas d'arrêt de la lecture ou de 
l'enregistrement. 

• Lorsque cette option est désactivée, les 
pistes audio cessent d'être en mode 
d'enregistrement lorsque Pro Tools est 
arrêté. Ceci permet d'éviter que les pistes ne 
restent activées d'une passe à l'autre, 
émulant le comportement 
d'enregistrement de piste d'un défileur 
numérique. 

Transport RecordLock (Pro Tools HD 
uniquement) : cette option permet de configurer 
l'enregistrement de transport (le bouton 
d'enregistrement dans les commandes de 
transport) de façon à émuler un défileur 
numérique ou à conserver le comportement 
hérité pour l'enregistrement principal dans la 
fenêtre Transport. 

• Si ce paramètre est sélectionné, l'option 
Transport Record reste activée même en cas 
d'arrêt de la lecture ou de l'enregistrement. 
Ceci évite de réactiver le transport entre 
chaque prise, ce qui émule le 
comportement d'un défileur numérique. 

• Si ce paramètre n'est pas sélectionné, 
l'option Transport Record est désactivée 
lorsque Pro Tools est arrêté manuellement 
ou lorsqu'il s'interrompt en raison d'une 
perte de timecode. Cela reproduit le 
comportement d'enregistrement Pro Tools 
standard. 
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Disable “Input” When Disarming Track (In “Stop”) 
(Pro Tools HD uniquement) : vous pouvez 
personnaliser l'écoute TrackInput pour 
maintenir sa sélection indépendamment de 
l'état d'enregistrement des pistes ou pour activer 
automatiquement le mode d'écoute Auto Input 
après une passe d'enregistrement. Ceci permet 
d'optimiser l'écoute lors d'une opération de 
doublage type (pour laquelle vous souhaitez 
conserver les pistes en mode Input Only jusqu'à 
l'activation explicite du mode Auto Input) ou 
lors d'une opération de contrôle musical type 
(pour laquelle le fait de laisser une piste en mode 
Input Only risquerait de provoquer une double 
écoute accidentelle après l'enregistrement).

• Si vous sélectionnez cette option, la 
désactivation de l'enregistrement pour une 
piste audio (tout mode) désactive le mode 
Input Only, quel que soit le mode d'écoute 
général, et lui applique uniquement une 
écoute audio à partir du disque. 

• Si vous ne la sélectionnez pas, les pistes 
audio restent en mode Input Only jusqu'à 
l'activation explicite de l'écoute Auto 
Input. 

Mute Record-Armed Tracks While Stopped 
(Pro Tools HD uniquement) : ce paramètre 
détermine l'état d'écoute des pistes préparées à 
l'enregistrement. 

• Si vous sélectionnez cette option, Pro Tools 
coupe les pistes en mode d'enregistrement 
avant l'arrêt du transport. L'écoute des 
entrées reste possible en cas d'arrêt au 
moyen du bouton TrackInput Monitor.

• Si vous sélectionnez cette option, Pro Tools 
les données audio des pistes en mode 
d'enregistrement restent audibles lors de 
l'arrêt du transport.

PEC/Direct Style Input Monitoring (Pro Tools HD 
uniquement) : cette option modifie le 
signalement du mode d'écoute TrackInput à 
l'écran (et sur les surfaces de contrôle prises en 
charge) de manière à émuler les indications PEC 
(lecture) et Direct (entrée/bus) des consoles de 
grand format. 

• Si elle n'est pas sélectionnée, la lettre I 
s'affiche sur le bouton TrackInput. Celui-ci 
est grisé lorsque le mode Auto Input est 
activé et clignote en vert pour indiquer le 
mode Input Only.

• Si elle est sélectionnée, le bouton 
TrackInput est grisé est indique la lettre D 
lorsque le mode Input Only est activé 
(Direct)-; il clignote en vert et affiche la 
lettre P pour indiquer le mode Auto Input 
(Pec ou lecture).

Options Online 

Record Online at Time Code (or ADAT) Lock : 

lorsque cette option est sélectionnée, 
l'enregistrement en ligne débute dès que 
Pro Tools reçoit un timecode entrant, puis le 
verrouille.

Record Online at Insertion/Selection : 
lorsque cette option est sélectionnée, 
l'enregistrement en ligne débute à 
l'emplacement du curseur d'édition. Il se 
poursuit jusqu'à ce que Pro Tools ne reçoive plus 
de timecode. Si vous définissez une sélection, 
Pro Tools enregistre en ligne uniquement 
pendant la durée de la sélection. 

Le paramètre Transport RecordLock est 
automatiquement désactivé et grisé lorsque 
le mode d'enregistrement Destructive est 
activé.
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Open Ended Record Allocation

Cette préférence détermine la quantité d'espace 
disque allouée à l'enregistrement.

Use All Available Space : lorsque cette option est 
sélectionnée, la totalité de l'espace disponible 
est allouée à l'enregistrement. Ce choix peut 
ralentir le processus d'enregistrement sur les 
disques durs utilisant certains systèmes de 
fichiers, tels HFS+ et NTFS.

Limit To : définit la durée d'enregistrement 
maximale autorisée. Cette option peut accélérer 
le lancement de l'enregistrement en attribuant 
uniquement une partie du disque dur au 
processus. Le nombre de minutes indiqué est 
alloué pour chaque piste préparée en 
enregistrement. Afin d'obtenir les performances 
d'enregistrement escomptées, il est conseillé de 
faire des essais avec ce paramètre. 

DestructivePunch File Length (Pro Tools HD 
uniquement)

Cette préférence définit la durée des fichiers 
audio consolidés lors de la préparation des pistes 
pour le mode DestructivePunch. La valeur par 
défaut est de 25 minutes. 

Section Misc (Miscellaneous)

(Pro Tools HD uniquement)

Auto Region Fade In/Out Length : cette option 
définit une durée par défaut pour les 
atténuations d'entrée et de sortie appliquées 
automatiquement aux frontières des régions. 
L'utilisation d'atténuations d'entrée et de sortie 
automatiques évite le montage des régions aux 
points de passage à zéro ou la création 
d'innombrables rendus d'atténuation afin 
d'éliminer les clics et autres parasites survenant 
au cours de la lecture. Les atténuations 
automatiques ne sont pas écrites sur le disque. 
La plage de valeurs de l'option Auto Region Fade 

In/Out Length s'étend de 0 à -10 ms. La valeur 
zéro indique l'absence d'atténuation 
automatique. La valeur de l'option Auto Fade est 
enregistrée avec la session et appliquée 
automatiquement à toutes les frontières de 
région autonomes jusqu'à ce que vous la 
modifiiez.

Calibration Reference Level : l'option 
Calibration Reference Level (niveau de 
calibration de référence) définit le niveau de 
calibration de référence par défaut en dB, 
lorsque Pro Tools fonctionne en mode 
Calibration. Pour les interfaces audio possédant 
des fonctions de rognage (telles que l'interface 
I/O 192), reportez-vous au guide de l'interface 
pour obtenir des instructions de calibrage.

Delay Compensation Time Mode : cette option 
vous permet de déterminer l'unité d'affichage 
des données dans le gestionnaire de retard : 
millième de seconde ou échantillon. Elle est 
disponible à condition d'avoir activé la 
compensation de retard (Options > Delay 
Compensation).

Préférences d'édition
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Section Regions

Region List Selection Follows Edit Selection : 
lorsque cette case est cochée, la sélection d'une 
région dans une piste est reflétée dans la liste des 
régions. 

Edit Selection Follows Region List Selection : 

lorsque cette case est cochée, la sélection d'une 
région dans la liste des régions affiche en 
surbrillance l'occurrence de cette région dans 
une piste.

Auto-Name Separated Regions : lorsque cette 
option est sélectionnée, Pro Tools nomme 
automatiquement les régions qui viennent 
d'être séparées en ajoutant un numéro à leur 
nom. Il peut être intéressant de désactiver cette 
option lors de l'importation de groupes de 
régions, de fichiers REX ou de fichiers ACID. 
En effet, comme ces types de fichiers 
contiennent parfois un grand nombre de 
régions distinctes, la liste des régions risque 
d'être difficile à consulter.

“Matching Start Time” Takes List

Lorsque vous cliquez sur avec le bouton droit de 
la souris ou que vous cliquez en maintenant la 
touche Ctrl (Windows) ou Pomme (Mac) 
enfoncée sur une région dans une piste, 
Pro Tools affiche une liste des régions (dans le 
sous menu contextuel Matches ou dans le menu 
déroulant Alternates) dont le marquage 
temporel correspond à l'emplacement actuel du 
curseur. Les préférences suivantes déterminent 
les régions ou prises qui apparaissent dans cette 
liste.

Includes Take Region Names That Match Track 
Names : lorsque cette option est sélectionnée, 
seules les régions dont le nom racine est 
identique à celui de la piste et de la playlist 
apparaissent dans le sous-menu contextuel 
Matches ou le menu déroulant Alternates. 

Includes Take Region Lengths That Match : 
lorsque cette option est sélectionnée, seules les 
régions dont la durée correspond à celle de la 
sélection en cours s'affichent dans le sous-menu 
contextuel Matches ou le menu déroulant 
Alternates. 

"Separate Region" Operates on All Related 
Takes : lorsque cette option est sélectionnée, 
l'édition d'une région avec la commande 
Separate Region concerne également toutes les 
prises associées (passes d'enregistrement) 
possédant le même marqueur temporel de 
l'utilisateur. Cette option aide à comparer 
différentes sections d'un groupe de prises 
associées.

Section Memory Locations

Auto-Name Memory Locations When Playing : 

lorsque cette option est sélectionnée, Pro Tools 
attribue un nom par défaut aux nouveaux 
emplacements mémoire, en fonction de leur 
emplacement temporel dans la session. 
Les unités temporelles sélectionnées dans le 
menu View déterminent les unités utilisées pour 
ces noms. 

Recall Memory Location Selection at Original 
Track : lorsque cette option est sélectionnée, les 
emplacements mémoire rappelant une sélection 
rappellent également la piste sur laquelle la 
sélection a été effectuée.

Section Tracks

New Tracks Default To Tick Timebase : lorsque 
cette option est sélectionnée, toutes les 
nouvelles pistes sont basées par défaut sur des 
références temporelles. Si elle n'est pas 
sélectionnée, les pistes audio, d'entrée auxiliaire, 
de fader principal et de VCA principal (Pro Tools 
HD uniquement) sont basées par défaut sur des 
échantillons.
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Section Fades

Crossfade Preview Pre-Roll : cette option spécifie 
la quantité de pré-roll ajoutée lors de l'écoute des 
crossfades dans la boîte de dialogue Fades.

Crossfade Preview Post-Roll : cette option 
spécifie la quantité de post-roll ajoutée lors de 
l'écoute des crossfades dans la zone de dialogue 
Fades.

QuickPunch/TrackPunch Crossfade Length : 

cette option spécifie la durée par défaut des 
crossfades créés par l'enregistrement en mode 
QuickPunch ou TrackPunch (Pro Tools HD 
uniquement). Ces crossfades se produisent 
avant le point d'entrée et après le point de sortie 
d'enregistrement. 

Preserve Fades when Editing : cette option 
permet de conserver les fondus d'entrée et de 
sortie et de convertir les crossfades séparés en 
fondus d'entrée et de sortie équivalents.

Réglages de fondu par défaut

Fade In : ce paramètre sélectionne la forme 
d'enveloppe par défaut des fade-in. 

Fade Out : ce paramètre sélectionne la forme 
d'enveloppe par défaut des fade-out. 

Crossfade : ce paramètre sélectionne la forme 
d'enveloppe par défaut des crossfades. 

REX/ACID : ce paramètre sélectionne la forme 
d'enveloppe par défaut des fondus et crossfades 
définis entre les régions (« sections ») dans les 
fichiers REX et ACID importés. 

Automatically Create Fades for Imported REX 
and ACID files :

cette option applique automatiquement des 
fondus entre les régions (ou sections de piste) 
dans les fichiers REX et ACID importés afin de 
minimiser les clics lors de la lecture. Si des 
sections se chevauchent, un crossfade est 
appliqué. Si des régions sont séparées par un 
espace vide, un fondu de sortie est appliqué à la 
fin de la première région. (Les formes de fondu 
appliquées aux fichiers REX/ACID dépendent 
des réglages de fondu par défaut définis pour ces 
fichiers.)

Zoom Toggle

Vertical Zoom : sélectionnez Selection ou Last 
Used dans la liste Vertical Zoom de la section 
Zoom Toggle.

Horizontal Zoom : sélectionnez Selection ou Last 
Used dans la liste Horizontal Zoom de la section 
Zoom Toggle.

Remove Range Selection After Zooming In : 
lorsque cette option est sélectionnée, la 
sélection d'édition actuelle prend la forme d'un 
point d'insertion après un zoom avant. Si vous 
effectuez ensuite un zoom arrière, la sélection 
précédente s'affiche à nouveau.

Track Height : sélectionnez Last Used, Medium, 
Large, Extreme ou Fit To Window dans le menu 
déroulant Track Height de la section Zoom 
Toggle.

Track View : sélectionnez Waveform/Notes, Last 
Used ou No Change dans le menu déroulant 
Track View de la section Zoom Toggle.
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Separate Grid Settings When Zoomed In : 

lorsqu'elle est sélectionnée, cette option 
conserve le paramètre de grille sélectionné 
lorsque vous effectuez un zoom avant ou un 
zoom arrière. Lorsque cette option est 
désélectionnée, le paramètre de grille 
correspondant au zoom s'applique lorsque vous 
effectuez un zoom avant. 

Levels of Undo

cette préférence permet de définir le nombre 
maximal d'actions qu'il est possible d'annuler 
avec la fonction Multiple Undo. Lorsque la 
valeur définie est faible, les ordinateurs lents 
peuvent voir leurs performances améliorées. 
Pro Tools prend en charge jusqu'à 32 opérations 
d'annulation.

Préférences de mixage

Section Setup

Sends Default to -INF : lorsqu'elle est 
sélectionnée, cette option règle le niveau de 
fader initial des nouveaux départs sur –∞ (pas de 
signal audible). Dans le cas contraire, le niveau 
de fader initial des nouveaux départs est défini 
sur 0 dB.

Send Pans Default to Follow Main Pan : lorsque
cette option est sélectionnée, l'option Follow
Main Pan est activée pour les nouveaux départs ;
dès lors les commandes de panoramique des
départs suivent les commandes de panoramique
de la piste. Lorsqu'elle n'est pas sélectionnée,
l'option Follow Main Pan est désactivée pour les
nouveaux départs.

Link Mix and Edit Group Enables : lorsqu'elle est 
sélectionnée, cette option associe l'activation et 
la désactivation des groupes Mix et Edit. 
L'activation du groupe A dans la fenêtre Mix 
active automatiquement ce groupe dans la 
fenêtre Edit, par exemple.

Use Absolute Pan Linking (Pro Tools HD Only) : 
cette option affecte le comportement des 
commandes de panoramique groupées.

• Lorsqu'elle est sélectionnée, le décalage 
relatif entre les commandes de 
panoramique groupées n'est pas conservé 
lorsque le réglage de l'une d'entre elles est 
modifié. Toutes les commandes de 
panoramique groupées s'alignent sur la 
valeur absolue de la commande modifiée. 

• Lorsqu'elle n'est pas sélectionnée, le 
décalage relatif entre les commandes 
groupées est conservé lorsque le réglage de 
l'une d'entre elles est modifié.
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Default EQ

cette préférence permet de sélectionner le 
plug-in d'égaliseur par défaut parmi les plug-in 
installés. Celui-ci peut ainsi être défini très 
rapidement, à la fois à l'écran et sur les surfaces 
de travail ICON. A l'écran, le plug-in s'affiche au 
début du menu déroulant du sélecteur d'insert. 
Sur les surfaces de travail ICON (Pro Tools HD 
uniquement), le plug-in s'affiche au début de la 
liste des choix de menu sur les codeurs rotatifs.

Default Dynamics

cette préférence permet de sélectionner le 
plug-in de dynamique par défaut parmi les 
plug-in installés. Celui-ci peut ainsi être défini 
très rapidement, à la fois à l'écran et sur les 
surfaces de travail ICON. A l'écran, le plug-in 
s'affiche au début du menu déroulant du 
sélecteur d'insert. Sur les surfaces de travail 
ICON (Pro Tools HD uniquement), le plug-in 
s'affiche au début de la liste des choix de menu 
sur les codeurs rotatifs.

Section Controllers

Edit Window Follows Bank Selection : si vous 
utilisez une surface de contrôle prise en charge 
par Pro Tools, cette option entraîne le 
défilement de la fenêtre Edit, permettant ainsi 
d'afficher la banque de pistes sélectionnée 
lorsque vous changez de banque sur la surface de 
contrôle. La banque en cours d'utilisation est 
ainsi toujours visible à l'écran.

Mix Window Follows Bank Selection : si vous 
utilisez une surface de contrôle prise en charge 
par Pro Tools, cette option entraîne le 
défilement de la fenêtre Mix, permettant ainsi 
d'afficher la banque de pistes sélectionnée 
lorsque vous changez de banque sur la surface de 
contrôle. La banque en cours d'utilisation est 
ainsi toujours visible à l'écran.

“Scroll to Track” Banks Controllers : lorsque 
vous utilisez une surface de contrôle (D-Control 
ou ProControl, par exemple), vous pouvez 
sélectionner cette option pour affecter les faders 
de la surface de contrôle à une piste numérotée 
lors de l'exécution de la commande Track > 
Scroll to Track.

Always Fill Channel Strips When Banking : 
si vous utilisez une surface de travail ICON 
(Pro Tools HD uniquement), ou toute autre 
surface de contrôle Digidesign prise en charge, 
cette option permet d'augmenter le nombre de 
canaux affichés lors de la création de banques : 
l'espace occupé par les commandes de banque 
sur la surface est optimisé afin de pouvoir 
afficher davantage de canaux.

Touch Timeout : lors de l'écriture de données 
d'automation en mode Touch, si vous arrêtez de 
déplacer un fader ou un codeur non tactile, 
Pro Tools poursuit l'écriture des données 
d'automation pendant la durée spécifiée par le 
paramètre Touch Timeout.

A l'expiration de ce « délai de contact », 
l'écriture de données d'automation s'arrête et ces 
données retrouvent leur valeur d'automation 
antérieure, à la vitesse spécifiée par le paramètre 
AutoMatch Time.

Section Automation

Smooth and Thin Data After Pass : lorsque cette 
option est sélectionnée, Pro Tools lisse 
automatiquement les données créées lors de la 
passe d'automation, puis les réduit selon la 
valeur spécifiée. 

Degree of Thinning : cette option spécifie 
l'importance de la « réduction » appliquée aux 
données d'automation à l'aide de la commande 
Thin Automation ou lorsque vous avez 
sélectionné l'option Smooth and Thin Data 
After Pass. 
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Plug-in Controls Default to Auto-Enabled : 
lorsque cette option est sélectionnée, toutes les 
commandes de nouveaux plug-in sont activées 
pour l'automation. Lorsqu'elle ne l'est pas, les 
commandes de nouveaux plug-in doivent être 
activées manuellement pour l'automation. 

Suppress Automation “Write To” Warnings 
(Pro Tools HD uniquement) : lorsque cette option 
est sélectionnée, Pro Tools supprime les 
avertissements affichés suite à l'appel des 
commandes Write Automation To Start, 
Selection, End ou Punch et à l'arrêt du transport.

Latching Behavior for Switch Controls in 
“Touch” : cette option détermine le 
comportement des commandes reliées à des 
touches (par exemple, la sourdine ou la 
désactivation du plug-in) lors de l'écriture de 
données d'automation en mode Touch.

• Lorsqu'elle est sélectionnée, les 
commandes du mode Touch sont 
verrouillées dans leur état actuel. Si un 
point d'inflexion est rencontré, l'écriture 
des données d'automation s'arrête. Si le 
transport est arrêté pendant l'écriture, la 
commande se fixe sur la valeur 
sous-jacente.

• Si elle n'est pas sélectionnée, les 
commandes du mode Touch ne sont pas 
verrouillées. 

Allow Latch Prime in Stop (Pro Tools HD 
uniquement) : lorsque cette option est 
sélectionnée et que des pistes sont en mode 
Latch, les valeurs des commandes activées pour 
l'automation sur ces pistes sont modifiables 
alors que le transport est arrêté. Pour cela, 
touchez ou déplacez les contrôles, en vue de la 
passe d'automation suivante. 

Coalesce when Removing Slaves from VCA Group 
(Pro Tools HD uniquement) : cette option 
détermine le comportement du système lors de 
la suppression de pistes esclaves d'un groupe 
contrôlé par VCA.

• Lorsqu'elle est sélectionnée, les données 
d'automation contenues sur la piste de 
VCA principal sont automatiquement 
fusionnées (sans confirmation) dans les 
pistes esclaves lors de la suppression.

• Lorsqu'elle n'est pas sélectionnée, une boîte 
de dialogue de confirmation vous invite à 
confirmer ou non la fusion des données 
d'automation de la piste de VCA principal 
dans les pistes esclaves.

Standard VCA Logic for Group Attributes 
(Pro Tools HD uniquement) : cette option 
détermine les attributs de groupe Mix 
susceptibles d'être sélectionnés dans la boîte de 
dialogue Group lorsque le groupe est assigné à 
un VCA principal. 

• Lorsqu'elle est sélectionnée, les 
commandes Main Volume, Mute, Solo, 
Record Enable et Input Monitoring des 
pistes esclaves sont liées uniquement au 
VCA principal ; elles ne peuvent pas être 
liées indépendamment. (Ce comportement 
émule le comportement des VCA 
principaux des consoles analogiques.)

• Lorsqu'elle n'est pas sélectionnée, les 
commandes Main Volume, Mute, Solo, 
Record Enable et Input Monitoring des 
pistes esclaves sont liées au VCA principal. 
Toutefois, elles peuvent également être 
liées aux groupes indépendamment.
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Include Sends in Trim Mode (Pro Tools HD 
uniquement) : cette option détermine l'état de 
rognage des faders de départ lorsqu'une piste est 
définie en mode Trim.

• Lorsqu'elle est sélectionnée, les faders de 
départ passent au mode Trim en même 
temps que le fader de volume principal. 

• Lorsqu'elle ne l'est pas, le fader de volume 
principal passe au mode Trim, mais le fader 
de départ reste dans le mode Automation 
standard correspondant.

Include Control Changes in Undo Queue : cette 
option indique si certaines modifications de 
commandes de mixage (par exemple, le 
déplacement d'un fader ou d'une commande 
panoramique) sont ajoutées ou non à la liste 
d'annulations.

• Lorsque cette option est sélectionnée, les 
modifications de commandes de mixage 
sont consignées dans la liste d'annulations 
et sont annulées en cas d'annulation d'une 
opération antérieure.

• Lorsqu'elle est désélectionnée, les 
modifications de commandes de mixage ne 
sont pas consignées dans la liste 
d'annulations. Vous pouvez ainsi annuler 
d'autres types d'opération tout en 
conservant les paramètres définis pour la 
console de mixage.

AutoMatch Time : lors de l'écriture de données 
d'automation en mode Touch, si vous relâchez 
un fader ou un contrôle, l'écriture s'arrête et les 
données retrouvent leur valeur antérieure. La 
vitesse de restauration de la valeur antérieure 
correspond à la durée AutoMatch. 

AutoGlide Time (Pro Tools HD uniquement) : 
ce paramètre définit la vitesse à laquelle 
Pro Tools passe (glisse) d'une valeur 
d'automation à une autre, en cas d'utilisation du 
mode AutoGlide.

After Write Pass, Switch To : sélectionne le 
mode d'automation sur lequel les pistes 
Pro Tools basculent automatiquement après une 
passe d'automation en mode Write (ou Write 
Trim). Vous pouvez choisir de basculer vers le 
mode Touch ou le mode Latch, ou de rester en 
mode Write en sélectionnant No Change. Après 
une passe d'automation en mode Write Trim, les 
pistes basculent automatiquement sur la version 
Trim du paramètre spécifié.

Options de la section Coalesce Trim 
Automation

(Pro Tools HD uniquement)

Ces options déterminent à quel moment les 
données d'automation de rognage sont 
reportées sur la playlist d'automation principale 
de la piste.

After Every Pass : les données d'automation de 
rognage sont fusionnées lorsque le transport est 
arrêté, à la fin de chaque passe d'automation de 
rognage. Aucune playlist composite n'est 
indiquée.

On Exiting Trim Mode : les données 
d'automation de rognage sont fusionnées dans 
une piste lorsque cette dernière n'est plus en 
mode Trim. Vous pouvez afficher les playlists 
composites avant de reporter les données de 
rognage.

Manually : les données d'automation de rognage 
sont fusionnées uniquement à l'aide de la 
commande Coalesce Trim Automation. Vous 
pouvez afficher les playlists composites avant de 
reporter les données de rognage.

Les opérations de réinitialisation des 
paramètres par défaut affectant les 
commandes de mixage sont consignées 
dans la liste d'annulations.
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Préférences de traitement

Section AudioSuite

Buffer Size

L'option AudioSuite Buffer Size (taille de buffer 
AudioSuite) définit la capacité du buffer de 
mémoire utilisé pour le traitement audio et 
l'aperçu à l'aide des plug-in AudioSuite. 
Si l'aperçu AudioSuite n'est pas fixe, définissez le 
buffer sur Mini ou Small.

Use AudioSuite Dither : lorsque cette option est 
sélectionnée, un plug-in Dither sélectionnable 
est appliqué aux tâches de traitement 
spécifiques d'AudioSuite, telles que Gain et 
Normalize.

Plug-in : cette option spécifie le plug-in à utiliser 
pour le traitement de dithering lorsque l'option 
Use AudioSuite Dither est sélectionnée.

Bit Depth : cette option permet de sélectionner 
une résolution pour les données audio après 
dithering (24 bits, 20 bits, 18 bits ou 16 bits).

Section TC/E (Time Compression/Expansion)

TC/E Plug-In : permet de sélectionner le plug-in 
utilisé par les fonctions de 
compression/extension temporelle (Time 
Compression et Expansion) lors de l'édition des 
données audio à l'aide de l'outil de trimming 
correspondant. L'outil de trimming utilise la 
fonction Time Compression/Expansion pour 
faire correspondre la durée d'une région audio à 
celle d'une autre région, à une grille de tempo, à 
une scène vidéo ou à tout autre point de 
référence. 

Default Settings : spécifie les paramètres par 
défaut du plug-in Time 
Compression/Expansion.

Section Import

Convert Imported “WAV” Files To 
AES31/BroadcastWave : lorsque cette option est 
sélectionnée, elle conforme tous les nouveaux 
fichiers .WAV importés à la norme de 
radiodiffusion AES31/EBU.

Automatically Copy Files on Import : lorsque 
cette option est sélectionnée, tous les fichiers 
audio importés par glisser-déposer sont copiés 
dans le dossier Audio Files de la session, qu'ils 
nécessitent ou non d'être convertis vers le type 
de fichier, la résolution ou la fréquence 
d'échantillonnage de la session actuelle. La boîte 
de dialogue Import Session Data est également 
définie par défaut sur Copy from Source Media. 
La préférence Automatically Copy Files on 
Import n'affecte pas la commande Import 
Audio.

Sample Rate Conversion Quality : cette option 
permet de sélectionner la qualité de la 
conversion de la fréquence d'échantillonnage 
par défaut. La conversion de la fréquence 
d'échantillonnage est utilisée dans un certain 
nombre de traitements dans Pro Tools, 
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notamment lors de la conversion et de 
l'importation de fichiers audio de différents 
formats dans une session, pour le prémixage et 
l'enregistrement de pistes avec une fréquence 
d'échantillonnage ou une résolution différentes. 
Plus la qualité de la conversion de la fréquence 
d'échantillonnage choisie est élevée, plus le 
traitement du fichier audio dans Pro Tools 
est lent.

Préférences MIDI

Options Basics

Play MIDI Notes When Editing : si cette option 
est sélectionnée, les notes MIDI sont audibles 
lors de leur insertion avec le crayon ou de leur 
déplacement à l'aide d'un outil Main.

Use MIDI to Tap Tempo : lorsque cette option est 
sélectionnée, vous pouvez battre le tempo sur 
un clavier MIDI afin d'entrer la nouvelle valeur 
de tempo dans le champ du tempo.

Display Events as Modified by Real-Time 
Properties : lorsque cette option est 
sélectionnée, Pro Tools affiche les effets des 
propriétés en temps réel à la fois dans la fenêtre 
Edit et dans la liste des événements MIDI.

Use F11 key for Wait for Note : lorsque cette 
option est sélectionnée, la touche de fonction 
F11 permet d'activer le mode d'attente de note 
(Wait for Note) pour l'enregistrement MIDI. 

Automatically Create Click Track in New 
Sessions : lorsque cette option est activée, 
Pro Tools crée automatiquement une piste de 
métronome dans les nouvelles sessions.

Default Note On Velocity : cette option définit la 
valeur de vélocité de Note On par défaut pour les 
notes MIDI insérées dans la fenêtre Edit et la liste 
MIDI Event.

Default Thru Instrument : définit l'instrument 
MIDI Thru par défaut. Sélectionnez un 
périphérique prédéfini à partir des instruments 
MIDI disponibles ou sélectionnez First Selected 
MIDI Track pour utiliser la sortie MIDI assignée 
de la première piste MIDI ou d'instrument 
sélectionnée. En cas de sélection de plusieurs 
pistes, l'instrument de la piste sélectionnée le 
plus proche du sommet de la fenêtre Edit (ou du 
bord gauche de la fenêtre Mix) est utilisé.

Pencil Tool Resolution When Drawing Controller 
Data : cette option définit la résolution par 
défaut des données de contrôleur MIDI créées 
avec le crayon. Le choix d'une valeur de 
résolution modérée évite la création de données 
de contrôleur inutilement denses. Ce paramètre 
est réglable entre 1 et 100 millièmes de seconde.

Global MIDI Playback Offset : permet de définir 
une valeur de décalage en échantillons afin de 
compenser la latence MIDI. La saisie d'une 
valeur dans cette zone conduit au même résultat 
que la définition d'un décalage à l'aide de la 
commande MIDI Track Offsets. Les valeurs de 
décalage peuvent être positives (plus tard) ou 
négatives (plus tôt). 
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Options de la section Note Display

Ces options définissent la référence du C moyen 
comme C3, C4 ou la note MIDI numéro 60.

Options de la section Delay 
Compensation for External Devices 

(Pro Tools HD uniquement)

Ces options permettent d'appliquer une 
compensation de retard aux signaux MIDI Time 
Code ou MIDI Beat Clock générés par Pro Tools. 
En général, il est préférable d'appliquer ce retard 
en cas de mixage externe de l'instrument MIDI 
externe et lorsque l'instrument MIDI externe est 
mixé à l'aide de la console de mixage Pro Tools. 

Ces options sont disponibles à condition d'avoir 
choisi un moteur de compensation de retard 
dans la boîte de dialogue Playback Engine et 
d'avoir activé l'option Delay Compensation 
dans Pro Tools. Elles agissent indépendamment 
des décalages disponibles pour les inserts 
matériels (dans la boîte de dialogue I/O Setup).

Préférences de 
synchronisation

Ces préférences déterminent le mode de réponse 
du transport d'une machine connectée à 
Pro Tools.

Section Machine Control

Machine Chases Memory Location : lorsque cette 
option est sélectionnée, le déplacement vers un 
emplacement donné dans une session à l'aide 
d'un emplacement mémoire fait suivre le 
transport connecté, qui se rend aussi à cet 
emplacement.

Machine Follows Edit Insertion/Scrub : lorsque 
cette option est sélectionnée, la recherche d'un 
emplacement spécifique dans une session par 
déplacement du point de sélection ou scrubbing 
d'une piste fait suivre le transport connecté, qui 
se rend aussi à cet emplacement.

Machine Cues Intelligently (Pro Tools HD 
uniquement) : lorsque cette option est 
sélectionnée, si vous désirez vous rendre en un 
point situé à plus de 10 secondes de la position 
actuelle, Pro Tools ordonne au transport 
connecté de se rendre à l'emplacement choisi à 
pleine vitesse jusqu'à 10 secondes avant le point 
demandé. L'avance rapide ralentit alors et la 
lecture se poursuit en vitesse normale jusqu'au 
point sélectionné. Ce processus accélère 
considérablement l'avance rapide sur les bandes 
avec certaines transports vidéo.

Stop at Shuttle Speed Zero (Pro Tools HD 
uniquement) : provoque l'envoi d'une 
commande Stop par Pro Tools, chaque fois que 
vous arrêtez le shuttle. Cette fonction s'avère 
utile si votre ordinateur requiert une commande 
d'arrêt explicite pour s'arrêter correctement. 
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Non-Linear Transport Error Suppression (Pro Tools 
HD uniquement) : lorsque Transport = Pro Tools, 
cette option empêche Pro Tools d'envoyer une 
commande d'arrêt lors de la mise hors ligne. 
Cela empêche également Pro Tools d'arrêter les 
autres périphériques 9 broches connectés au 
système.

Delay Before Locking to Time Code (Pro Tools HD 
uniquement) : définit le délai d'attente (en 
images) de Pro Tools avant les tentatives de 
verrouillage sur les machines envoyant des 
messages de verrouillage servo. Ce paramètre 
permet aux mécanismes de servo d'atteindre un 
niveau de verrouillage stable.

Section Remote Mode

(Pro Tools HD uniquement)

Ignore Track Arming : demande à Pro Tools 
d'ignorer les commandes d'activation de pistes 
(pour l'enregistrement) entrantes. Cette 
fonction est utile si vous utilisez un contrôleur 
principal pour préparer l'enregistrement des 
pistes sur d'autres ordinateurs, sans avoir à 
préparer de pistes dans Pro Tools.

Set Servo Lock Bit at Play (Tamura Support) : 
activez cette option lorsque vous utilisez un 
synchroniseur Tamura pour piloter Pro Tools en 
mode Remote afin de minimiser les temps de 
verrouillage lors de l'enregistrement.

Allow Track Arm Commands in Local Mode : 

permet à Pro Tools de répondre aux commandes 
d'activation de pistes (pour l'enregistrement) 
entrantes même lorsque le système n'est pas 
défini sur Remote Mode. Vous pouvez 
notamment sélectionner cette option lorsque 
vous utilisez une manette pour l'activation des 
pistes et le début de l'enregistrement dans 
Pro Tools. 

Punch In Frame Offset : cette option définit un 
décalage (exprimé en images) visant à 
compenser l'avance ou le retard du passage en 
mode enregistrement.

Punch Out Frame Offset : cette option définit un 
décalage (exprimé en images) visant à 
compenser l'avance ou le retard de l'arrêt du 
mode enregistrement.

Delay After Play Command : définit le délai 
d'attente (en images) de Pro Tools entre la 
réception d'une commande de lecture et le 
démarrage du moteur audio. Cette option 
permet d'éviter les démarrages non souhaités 
lors du verrouillage sur des synchroniseurs dont 
la prise en charge n'est pas entièrement assurée 
par Pro Tools.

Section Synchronization

Minimum Sync Delay : définit la durée (en 
images) nécessaire à la synchronisation des 
différentes machines composant votre système. 
Cette durée est différente pour chaque machine. 
Pour régler le temps de synchronisation dans 
Pro Tools, entrez la valeur dans le champ 
Minimum Sync Delay de la page 
Synchronization de la boîte de dialogue 
Preferences. La valeur minimale disponible est 
15 images. Déterminez la valeur minimale de 
temps de synchronisation pour votre système, 
puis entrez cette valeur dans la zone Minimum 
Sync Delay. Sur les systèmes utilisant 
MachineControl de Digidesign, activer le 
paramètre de timecode Use Serial accélérera 
considérablement la synchronisation. Pour que 
le timecode série soit utilisable, il faut que le 
périphérique de synchronisation agréé par 
Digidesign et les périphériques externes soient 
synchronisés au signal vidéo interne.
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Stable LTC Source (Pro Tools HD uniquement) : 

lorsqu'elle est sélectionnée, cette option 
supprime le délai d'attente d'une seconde avant 
la tentative de synchronisation de Pro Tools sur 
un timecode LTC entrant. Vous pouvez activer 
cette option lorsque la synchronisation de 
Pro Tools s'effectue sur une source de timecode 
stable (par exemple, un magnétophone à bande 
non linéaire ou un générateur LTC) et non sur 
un magnétophone à bande linéaire.



97

Partie III : Sessions et pistes
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Chapitre 8 : Sessions

Ce chapitre expose un certain nombre de 
notions de base concernant le démarrage d'un 
projet dans Pro Tools, notamment la création et 
la sauvegarde d'une session Pro Tools.

Création d'une session
Lorsque vous démarrez un projet dans 
Pro Tools, vous devez créer une session. 

Pour créer une session :

1  Choisissez File > New Session.

2  Sélectionnez le disque dur sur lequel vous 
voulez enregistrer la session. Il est préférable de 
sauvegarder la session sur un volume réservé aux 
données audio.

3  Sélectionnez le format de fichier audio de la 
session.

4  Sélectionnez la résolution (16 bits ou 24 bits) 
et la fréquence d'échantillonnage.

5  Sélectionnez les paramètres d'E/S à utiliser 
pour la session. Votre système est livré avec 
plusieurs configurations d'E/S préétablies, mais 
vous pouvez sélectionner une configuration 
d'E/S personnalisée. Pour plus d'informations, 
reportez-vous au chapitre 6, Configuration des 
E/S.

6  Nommez la session.

7  Cliquez sur Save.

Boîte de dialogue New Session

Pour une compatibilité optimale entre les 
environnements Windows et Mac, 
choisissez le type de fichier BWF (.WAV). 

Les fichiers Sound Designer II (SD II) ne 
sont pas pris en charge sur les systèmes 
Windows ou à des fréquences 
d'échantillonnage supérieures à 48 kHz.
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Sélection de la résolution et de la 
fréquence d'échantillonnage

Lorsque vous sélectionnez une résolution ou 
une fréquence d'échantillonnage pour votre 
session, prenez en compte les critères de fidélité, 
de compatibilité avec les autres systèmes et 
d'espace de stockage. 

La résolution et la fréquence d'échantillonnage 
affectent également la puissance de mixage 
disponible pour une session. Le travail en 24 bits 
ou avec des fréquences d'échantillonnage 
élevées réduit le nombre de canaux de console 
disponibles. Pour plus d'informations, reportez-
vous au guide de démarrage.

Il est impossible de combiner différentes 
résolutions au sein d'une session Pro Tools ; les 
fichiers de résolution différente doivent être 
convertis et importés dans la session. 

Fichiers et dossiers de 
session
Lorsque vous créez une session, Pro Tools génère 
automatiquement un dossier portant le nom de 
votre session. Ce dossier contient le fichier de 
session, un fichier WaveCache.wfm et plusieurs 
sous-dossiers, notamment ceux nommés Audio 
Files, Fade Files, Region Group.

Fichier de session

Le fichier de session est le document que crée 
Pro Tools lorsque vous démarrez un nouveau 
projet. Pro Tools ne peut ouvrir qu'une seule 
session à la fois. Le fichier de session porte 
l'extension .ptf (propre aux fichiers Pro Tools).

Dossier Audio Files

Le dossier Audio Files contient toutes les 
données audio enregistrées ou converties au 
cours de la session. 

Lorsque vous enregistrez une nouvelle piste 
audio, celle-ci est enregistrée dans un nouveau 
fichier audio dans le dossier Audio Files. Vous 
pouvez également importer d'autres fichiers 
audio dans la session et travailler avec. 

Dossier Fade Files

Le dossier Fade Files contient toutes les données 
de fondu enchaîné (crossfade) audio générées au 
cours de la session. 

Dossier Region Groups

Le dossier Region Groups est le répertoire par 
défaut réservé aux groupes de régions que vous 
exportez à partir de votre session Pro Tools.

Fichier WaveCache

Le fichier WaveCache.wfm stocke toutes les 
données d'affichage des formes d'ondes pour la 
session. Si vous supprimez le fichier 
WaveCache.wfm, Pro Tools en génère un 
nouveau la prochaine fois que vous ouvrez la 
session.

Contenu type d'un dossier de session

Pour plus de détails sur l'allocation des 
pistes audio à différents emplacements du 
disque dur, en particulier les volumes 
partagés, consultez la section Allocation de 
disque, page 311.
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Les sessions s'ouvrent plus rapidement lorsque 
vous stockez vos données de forme d'onde dans 
le fichier WaveCache. Ce fichier de session peut 
être inclus à chaque transfert de session vers un 
autre système Pro Tools 7.x. 

Pro Tools gère également un fichier WaveCache 
distinct dans le dossier local des bases de 
données Digidesign (C:\\Digidesign Databases). 
Ce fichier contient toutes les données de forme 
d'onde pour l'ensemble des fichiers utilisés sur le 
système. D'autres fichiers WaveCache sont créés 
et stockés dans le dossier Digidesign Databases 
de chaque disque dur relié à votre système. 

La suppression ou la mise à la Corbeille des 
fichiers WaveCache ne perturbe pas la session ni 
votre système. Cette opération implique 
néanmoins le recalcul des données de forme 
d'onde correspondant aux fichiers de données 
audio et leur stockage dans un nouveau fichier 
WaveCache ; elle se traduit par une ouverture de 
session plus lente. 

Dossier Session File Backups

Le dossier Session File Backups contient les 
sauvegardes automatiques de vos sessions 
Pro Tools. Ces fichiers sont créés à condition de 
travailler dans une session et d'activer l'option 
Enable Session File Auto Backup des préférences 
de fonctionnement. Voir Enable Session File 
Auto Backup :, page 83.

Dossier Renamed Audio Files

Ce dossier contient les noms des fichiers 
renommés lors de l'ouverture d'une session 
faisant référence à des noms de fichiers audio 
avec des caractères incompatibles ou, dans 

certaines situations, lors de l'enregistrement de 
la copie d'une session d'une version Pro Tools 
qui ne prend pas en charge les noms de fichier 
longs.

Ouverture d'une session
Lorsque vous ouvrez une session, Pro Tools 
recherche dans le dossier correspondant les 
fichiers audio et de fondu associés.

Pour ouvrir une session existante :

1  Choisissez File > Open Session.

2  Recherchez la session que vous voulez ouvrir, 
puis cliquez sur Open.

Pour plus d'informations, reportez-vous à la 
section Fichiers audio renommés et dossier 
Renamed Audio Files, page 285.

Pour plus d'informations sur l'ouverture de 
sessions créées sur différentes plates-formes, 
différents systèmes Pro Tools ou diverses 
versions logicielles Pro Tools, reportez-vous 
au chapitre 13, Gestion des fichiers et des 
sessions et compatibilité

Boîte de dialogue d'ouverture d'une session



Guide de référence Pro Tools102

Ouverture d'une session 
contenant des fichiers non 
disponibles

DigiBase vous informe si certains fichiers 
trouvés résident sur un volume de transfert (par 
exemple, un CD ou un DVD) ou si certains 
fichiers sont manquants. Pour plus 
d'informations, reportez-vous à la section 
Recherche des fichiers audio, page 283.

Ouverture d'une session à partir 
d'un volume de transfert

Lorsque vous ouvrez une session à partir d'un 
volume de transfert (tel qu'un CD ou un DVD), 
DigiBase vous demande d'enregistrer la session 
sur un volume Performance, puis de copier et de 
convertir les fichiers média référencés. Pour plus 
d'informations, reportez-vous à la section 
Recherche des fichiers audio, page 283.

Ouverture d'une session 
contenant des ressources non 
disponibles

Un message vous avertit si la session que vous 
ouvrez comporte des voix, des chemins d'I/O, 
des ressources DSP ou des plug-in non 
disponibles. Cela se produit fréquemment lors 
du transfert de sessions d'un système à un autre 
système constitué de matériel Digidesign 
différent.

La boîte de dialogue Unavailable Resources 
permet d'obtenir un premier rapport sur les 
composants manquants de la session. Pour 
sauvegarder un fichier texte (.txt) contenant un 
rapport Notes plus détaillé, ainsi que l'action 
résultante, cliquez sur Yes. Ce rapport Notes 
porte le nom de la session, suivi de Notes.txt. 
Vous êtes libre d'enregistrer ce fichier dans votre 
dossier Session ou à tout autre emplacement.

La section suivante décrit ce qui se produit lors 
de l'ouverture d'une session avec des éléments 
non disponibles.

Avec tous les systèmes Pro Tools :

! Les inserts affectés à des plug-in non 
disponibles sont désactivés.

! Les entrées, sorties et départs affectés à des 
chemins non disponibles sont désactivés.

Avec Pro Tools HD uniquement :

! Les pistes dont le nombre de voix est supérieur 
au maximum de voix disponibles sur le système 
actuel sont désactivées. 

Pro Tools LE uniquement :

! Les pistes dépassant le nombre maximal de 
voix disponibles du système actuel sont réglées 
sur Voice Off.

Vous pouvez également ouvrir une session à 
partir du navigateur DigiBase en cliquant 
deux fois dessus.
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Ouverture d'une session avec des 
noms de fichier audio contenant 
des caractères interdits

Pro Tools 7.x ne prend pas en charge les noms 
de fichier audio contenant les caractères ASCII 
suivants :

/ (barre oblique)

\ (barre oblique inverse)

: (deux points)

* (astérisque)

? (point d'interrogation)

« (guillemets)

< (symbole inférieur à)

> (symbole supérieur à)

| (ligne verticale)

Tout caractère ASCII créé avec une 
combinaison de touches désignant un bruit 
de haut niveau

Lorsque les noms des fichiers audio utilisés dans 
les sessions ouvertes contiennent de tels 
caractères, Pro Tools crée automatiquement une 
copie renommée de chaque fichier concerné (en 
remplaçant les caractères interdits par un trait 
de soulignement « _ »). Les fichiers renommés 
sont placés dans le dossier Renamed Audio Files. 
Les fichiers originaux restent inchangés dans le 
dossier Audio Files.

Avant l'ouverture de la session, vous êtes invité à 
enregistrer un rapport détaillé des fichiers 
renommés et de leurs noms d'origine dans un 
fichier texte de notes. Suivez les instructions à 
l'écran. Par défaut, le fichier de notes est 
sauvegardé dans le dossier Session.

Ouverture d'une session 
enregistrée avec un gain de fader 
de +6 dB

Toutes les sessions Pro Tools 7.x ont un niveau 
de gain de fader de +12 dB. Cependant, une 
session Pro Tools 7.x peut être enregistrée avec 
un gain de fader maximum de +6 dB ou de 
+12 dB dans une version antérieure de Pro Tools 
autorisant des gains de fader de +6 dB et +12 dB.

Lors de l'enregistrement d'une session à +12 dB 
ou +6 dB, Pro Tools vous informe que tout 
paramètre d'automation supérieur à +6 dB est 
maintenu à +6 dB. Pour plus d'informations, 
reportez-vous à la section Enregistrement d'une 
copie de la session, page 105.

Dans Pro Tools 7.x, si vous ouvrez une session 
enregistrée avec un niveau de gain maximum de 
+6 dB, la session applique une plage égale à 
+12 dB.

Ouverture d'une session 
récente
Dans le menu File, vous pouvez utiliser la 
commande Open Recent pour ouvrir l'une des 
dix dernières sessions ouvertes dans Pro Tools.

Pour ouvrir une session récente :

" Sélectionnez File > Open Recent et choisissez 
la session à ouvrir.

Si une session est déjà ouverte, Pro Tools vous 
invite à enregistrer la session en cours avant 
d'ouvrir la session récente sélectionnée.

Pour ouvrir une session récente, utilisez la 
combinaison de touches Ctrl+Maj+O 
(Windows) ou Pomme+Maj+O (Mac).
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Enregistrement d'une session
Il est recommandé d'enregistrer régulièrement 
votre travail au fil d'une session, afin de le 
conserver sur votre disque dur.

Enregistrement du fichier de la 
session

La commande Save enregistre les changements 
effectués au cours de la session par rapport à la 
version précédente du fichier. Elle ne peut pas 
être annulée.

Pour enregistrer une session :

" Choisissez File > Save.

Commande Revert to Saved

Si vous avez effectué des changements dans une 
session depuis la dernière sauvegarde, vous 
pouvez les annuler et revenir à l'état précédent.

Pour restaurer la dernière version enregistrée 
d'une session :

" Choisissez File > Revert to Saved.

Enregistrement du fichier de 
session sous un nouveau nom

La commande Save As permet d'enregistrer une 
copie de la session actuelle sous un nom 
différent ou vers un autre emplacement du 
disque. La commande Save As ferme la session 
en cours et permet de continuer à travailler sur 
la copie renommée. De ce fait, elle est utile pour 
faire des essais et enregistrer des versions 
successives de la session.

En travaillant de cette manière, vous pouvez 
rapidement revenir en arrière si vous souhaitez 
restituer une version précédente de votre 
session. La commande Save As vous permet 
d'enregistrer une nouvelle version du fichier de 
session uniquement, sans dupliquer les versions 
des fichiers audio ou de fondu.

Pour enregistrer une session sous un nouveau 
nom :

1  Choisissez File > Save As. 

2  Attribuez un nouveau nom à la session.

3  Cliquez sur Save.

Le fichier de session renommé est enregistré 
dans le dossier de la session avec la session 
d'origine (à moins que vous ayez spécifié une 
autre destination). Tout nouveau fichier audio 
que vous enregistrez dans votre session 
renommée sera placé dans le dossier Audio Files 
créé avec votre session d'origine. 

Vous pouvez également ouvrir une copie de 
sauvegarde de votre session si vous avez 
activé l'option Auto Backup des préférences 
de fonctionnement. Cette fonction permet 
de spécifier le nombre total de sauvegardes 
incrémentielles conservées et la fréquence 
d'enregistrement de la session. Pour plus 
d'informations, reportez-vous à la section 
Section Auto Backup, page 83.

Pro Tools 7.x permet de choisir des noms de 
fichier contenant autant de caractères que 
votre système d'exploitation l'autorise. 
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Enregistrement d'une copie de la 
session

La commande Save Copy In permet d'enregistrer 
une copie de la session actuelle avec ou sans ses 
fichiers audio et de fondu. En outre, vous 
pouvez préciser le format du fichier de session, 
le format du fichier audio, la résolution et la 
fréquence d'échantillonnage pour la copie de la 
session.

Contrairement à la commande Save As, la 
commande Save Copy In ne referme pas la 
session d'origine. C'est la raison pour laquelle 
toute nouvelle modification sera effectuée sur la 
session d'origine. Les copies de sessions servent à 
archiver des sessions importantes ou à préparer 
des sessions à des transferts vers d'autres 
systèmes Pro Tools.

La commande Save Copy In n'enregistre que les 
données audio utilisées dans la session. 
Les données audio enregistrées ou importées, 
puis supprimées de la session, mais pas du 
disque, ne seront pas incluses dans la nouvelle 
copie de la session.

L'utilisation de la commande Save Copy In est le 
seul moyen de modifier la fréquence 
d'échantillonnage d'une session. La fréquence 
d'échantillonnage de chaque fichier audio de 
session copié est remplacée par la fréquence 
d'échantillonnage sélectionnée. 

Lorsque vous enregistrez une copie de la session 
avec une résolution, des effets de dithering 
(Dither) et de mise en forme du bruit (Noise 
Shaping) sont appliqués. Voir le tableau 
suivant :

Le paramètre Dither utilisé lors d'une 
conversion est le plug-in Dither de Digidesign 
(avec le paramètre Noise Shaping activé).

Pour plus d'informations sur le partage de 
sessions entre différentes plates-formes, 
différents systèmes Pro Tools ou diverses 
versions logicielles Pro Tools, reportez-vous 
au chapitre 13, Gestion des fichiers et des 
sessions et compatibilité

Boîte de dialogue Save Copy In

Pour inclure toutes les données audio dans 
la copie de la session, tous les fichiers audio 
doivent être sélectionnés dans la section des 
éléments à copier.

Options Dither et Noise Shaping avec la commande 
Save Copy In

Résolution de la 
session

Dither
Noise 
Shaping

24 bits vers 24 bits Non Non

16 bits vers 24 bits Non Non

24 bits vers 16 bits Oui Oui

16 bits vers 16 bits Non Non

Pour en savoir plus sur le dithering, 
reportez-vous à Dithering, page 761.
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Pour enregistrer une copie de la session vers un 
nouvel emplacement :

1  Choisissez File > Save Copy In.

2  Dans la boîte de dialogue Save Copy In, 
sélectionnez une destination et entrez le nom 
du fichier de la nouvelle session.

3  Sélectionnez un format de fichier de session 
pour la session copiée.

4  Sélectionnez le type de fichier audio pour la 
session copiée. Si les fichiers audio sont 
compatibles avec Windows ou Mac, 
sélectionnez AIFF ou BWF (.WAV).

5  Définissez la résolution et la fréquence 
d'échantillonnage de la session copiée.

6  Le cas échéant, sélectionnez un niveau de gain 
de fader pour la session copiée.

7  Sélectionnez l'option Enforce Mac/PC 
Compatibility pour créer une session et des 
fichiers audio utilisables sur les systèmes 
Pro Tools installés aussi bien sous Windows que 
sur Mac (voir Enregistrement de copies de 
sessions Mac compatibles avec Windows, 
page 289).

8  Sélectionnez les éléments à copier associés à la 
session copiée.

9  Cliquez sur Save. 

Format de la session

Vous pouvez enregistrer la copie d'une session 
aux formats suivants, selon le type de plate-
forme utilisé :

Windows :

• Session Pro Tools (*.ptf) ; prise en charge de 
Pro Tools 7.x

• Session Pro Tools 5.1 -> 6.9 (.pts)

• Session Pro Tools 5.0 (.pt5)

• Session Pro Tools 4, 24 bits (.p24)

• Session Pro Tools 4, 16 bits (.pt4)

Mac :

• Dernière version ; prise en charge de 
Pro Tools 7.x

• Session Pro Tools 5.1 -> 6.9

• Session Pro Tools 5.0

• Session Pro Tools 4, 24 bits

• Session Pro Tools 4, 16 bits

• Session Pro Tools 3.2

Pour inclure toutes les données audio dans 
la copie de la session, tous les fichiers audio 
doivent être sélectionnés.

Lorsque vous enregistrez des sessions vers 
des versions antérieures à la version 
Pro Tools 5.1, les pistes comportant 
plusieurs canaux (y compris les pistes 
stéréo) et les plug-in multimono sont 
perdus. Pour éviter cette perte de données, 
enregistrez séparément les pistes et les plug-
in en mono.
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Paramètres de session

Type de fichier audio

Vous pouvez enregistrer la session pour 
référencer des fichiers audio BWF (.WAV) ou 
AIFF. Sous Mac, vous pouvez également 
enregistrer la session pour référencer les fichiers 
audio SD II (avec des fréquences 
d'échantillonnage allant jusqu'à 48 kHz).

Utilisation de types de fichiers mixtes

Une même session peut utiliser des fichiers 
audio de types différents. Si votre session 
d'origine contient plusieurs types de fichiers 
audio, ils ne sont pas convertis vers un type 
différent, à moins que vous n'indiquiez qu'ils 
doivent l'être. Toutefois, lorsque vous mélangez 
différents types de fichiers, les performances 
audio sont dégradées (du fait des manipulations 
supplémentaires sur les fichiers, nécessaires avec 
certains formats).

Bit Depth

Vous pouvez enregistrer la session avec une 
résolution de 16 ou 24 bits. Si la résolution de 
votre session est différente, les fichiers audio y 
sont convertis automatiquement avant d'être 
copiés vers l'emplacement spécifié.

Fréquence d'échantillonnage

Vous pouvez enregistrer la session à des 
fréquences d'échantillonnage de 44,1 kHz ou 
48 kHz (sur les systèmes Mbox 2, Mbox 2 Mini 
et Mbox) et à des fréquences d'échantillonnage 
allant jusqu'à 96 kHz (sur les systèmes 
Mbox 2 Pro, Digi 002, Digi 002 Rack et 
Pro Tools|HD avec interface 96 I/O ou 96i I/O) 
ou jusqu'à 192 kHz (sur les systèmes 
Pro Tools|HD avec interface 192 I/O ou 
192 Digital I/O). Si la fréquence 
d'échantillonnage de votre session est 
différente, les fichiers audio y sont convertis 
avant d'être copiés vers l'emplacement spécifié.

Gain de fader

Une session Pro Tools 7.x peut être enregistrée 
avec un gain de fader maximum de +6 dB ou de 
+12 dB dans une version antérieure de Pro Tools 
autorisant des gains de fader de +6 dB et +12 dB. 
Lors de l'enregistrement d'une session à +12 dB 
ou +6 dB, Pro Tools vous informe que tout 
paramètre d'automation supérieur à +6 dB est 
maintenu à +6 dB.

Option Enforce Mac/PC Compatibility

Lorsque vous enregistrez une session 
Pro Tools 7.x dans une version antérieure de 
Pro Tools, ce paramètre force les versions Mac 
ou Windows de Pro Tools à créer des sessions et 
des fichiers audio utilisables sur les deux plates-
formes. 

Les sessions SD II ne sont pas prises en 
charge dans Pro Tools pour Windows ni 
avec des fréquences d'échantillonnage 
supérieures à 48 kHz. Pour une 
compatibilité optimale, convertissez les 
sessions SD II au format BWF (.WAV).

Pour plus d'informations sur le prémixage 
sur disque et sur le dithering, reportez-vous 
à la section Dithering et prémixage sur 
disque (Bounce), page 856

Pour plus d'informations, reportez-vous à la 
section Enregistrement de copies de sessions 
Mac compatibles avec Windows, page 289.



Guide de référence Pro Tools108

Eléments à copier

All Audio Files

Lorsque cette option est sélectionnée, tous les 
fichiers audio sont copiés vers le nouvel 
emplacement.

Ce paramètre est automatiquement sélectionné 
si vous modifiez la résolution ou la fréquence 
d'échantillonnage de la session.

All (Non-Native) Audio Files

Le nom de cette option change en fonction du 
type de fichier audio sélectionné. Si vous 
modifiez le type de fichier audio de la session, 
cette option assure la conversion de tous les 
fichiers au type de fichier sélectionné. 
Lorsqu'elle est sélectionnée, cette option permet 
d'éviter un ralentissement des performances, qui 
survient souvent dans des sessions avec des 
types de fichiers mélangés.

Cette option est sélectionnée automatiquement 
dans l'un des cas suivants :

• Modification de la résolution ou de la 
fréquence d'échantillonnage

• Conversion au format AIFF ou BWF (.WAV) 
d'une session copiée au format SD II (sur 
Mac)

• Activation de l'option Enforce Mac/PC 
Compatibility

Don't Copy Fade Files

Lorsque cette option est sélectionnée, les 
fichiers de fondus ne sont pas copiés dans le 
dossier Fade Files de la nouvelle session. 

Pro Tools ouvre la session avec tous les médias 
disponibles, indique le nombre de fichiers 
manquants (le cas échéant) et vous demande 
comment continuer. Vous pouvez rechercher les 
fichiers de fondus existants à l'aide de l'option 

Manually Find Relink ou Automatically Find 
Relink ou choisir l'option Skip All pour laisser à 
Pro Tools le soin de recréer les fondus à partir du 
document de la session. Vous pouvez également 
sélectionner l'option Regenerate Missing Fades 
pour exclure les fichiers de fondus du processus 
de rétablissement de liens et les régénérer.

Session Plug-in Settings Folder

Lorsque cette option est sélectionnée, le dossier 
de paramètres de plug-in de la session (Plug-In 
Settings) est copié dans le nouvel emplacement. 
Les références à ces paramètres de plugin dans la 
session sont redirigées vers les fichiers de 
paramètres copiés.

Root Plug-In Settings Folder

Lorsque cette option est sélectionnée, le 
contenu du dossier de référence des paramètres 
de plug-in est copié dans un dossier nommé 
Place in Root Settings Folder, indiquant que ces 
fichiers devront être déplacés vers le dossier de 
référence des paramètres de plug-in dans le 
système de destination avant que vous ne les 
utilisiez. Les références à ces fichiers de 
paramètres de la session ne sont pas redirigées 
pour pointer vers les fichiers copiés.

Movie/Video Files

Lorsque cette option est sélectionnée, les 
fichiers vidéo de la session (QuickTime ou Avid) 
sont copiés vers le nouvel emplacement et les 
références de la session sont mises à jour pour 
pointer vers les fichiers vidéo copiés.
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Preserve Folder Hierarchy (Pro Tools HD 
uniquement) Lorsque cette option est 
sélectionnée, l'organisation relative des fichiers 
audio de la session résidant dans les différents 
lecteurs et dossiers est conservée. Le dossier 
principal de la session copiée inclut des sous-
dossiers correspondant aux sous-dossiers des 
disques ou dossiers de la session d'origine.

Lorsque l'option est désactivée, la commande 
Save Copy In copie dans un seul dossier de 
destination tous les fichiers de même type, 
indifféremment de leur emplacement. 

Création de modèles de 
session personnalisés
Vous pouvez créer des documents de session 
personnalisés pré-configurés conformément aux 
paramètres de pistes, aux paramètres de console 
de mixage, aux dispositions des fenêtres et aux 
emplacements mémoire du niveau de zoom que 
vous utilisez le plus souvent. Cela vous évite 
d'avoir à récréer toute la configuration de votre 
studio chaque fois que vous démarrez une 
nouvelle session.

Création de modèles Windows

Sous Windows, vous pouvez créer un modèle de 
session en faisant du fichier de session un 
document en lecture seule.

Pour créer un modèle de session personnalisé 
sous Windows :

1  Créez une session et organisez ses éléments 
selon vos préférences d'affichage dans le 
modèle. Vous pouvez également définir des 
éléments tels qu'une assignation de signal, des 
configurations d'inserts et de départs, des 
affichages de pistes, des paramètres de la règle et 
des paramètres par défaut.

2  Choisissez File > Save As.

3  Attribuez un nom à votre session et cliquez sur 
Save.

4  Fermez la session.

5  Recherchez le fichier de session que vous 
venez d'enregistrer dans l'Explorateur Windows.

6  Cliquez avec le bouton droit de la souris sur le 
fichier et choisissez Propriétés.

7  Dans la zone Attributs, sélectionnez Lecture 
seule.

8  Cliquez sur OK.

Vous pouvez également installer et utiliser 
les modèles de session Pro Tools par défaut, 
disponibles dans le répertoire Additional 
Files du disque d'installation de Pro Tools.

Transformation d'une session en fichier en lecture 
seule (Windows)
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Pour utiliser un modèle de session, effectuez l'une 
des opérations suivantes :

" Cliquez deux fois sur le modèle de session 
dans l'Explorateur Windows.

– ou –

" Dans Pro Tools, choisissez File > Open Session 
pour ouvrir le modèle de session. 

Pro Tools vous demande d'indiquer le nom de la 
nouvelle session. Le modèle de votre session 
d'origine reste inchangé.

Pour modifier le modèle de session :

1  Ouvrez les propriétés de la session dans 
l'Explorateur Windows.

2  Désactivez l'option de lecture seule et cliquez 
sur Appliquer.

3  Ouvrez la session dans Pro Tools et effectuez 
vos modifications.

4  Enregistrez la session et fermez Pro Tools.

5  Dans l'Explorateur Windows, réouvrez les 
propriétés de la session et réactivez l'option de 
lecture seule.

Création de modèles Mac

Pour créer un modèle de session sous Mac, 
enregistrez un fichier de session en tant que 
document Stationery Pad. Une fois la session 
enregistrée en tant que Stationery Pad, elle se 
comporte comme un modèle que vous pouvez 
ouvrir et enregistrer à nouveau en tant que 
session Pro Tools normale.

Pour créer un modèle de session personnalisé 
sous Mac :

1  Créez une session et organisez ses éléments 
selon vos préférences d'affichage dans le 
modèle. Outre la configuration des pistes, vous 
pouvez définir des éléments tels que 
l'assignation du signal, des configurations 
d'inserts et de départs, l'affichage des fenêtres 
Mix et Edit, les paramètres de règle et les 
paramètres par défaut.

2  Choisissez File > Save As.

3  Attribuez un nom à votre session et cliquez sur 
Save.

4  Fermez la session.

5  Recherchez le fichier de session que vous 
venez d'enregistrer dans le Finder Mac. 

6  Cliquez une fois sur le fichier pour le 
sélectionner.

7  Choisissez Fichier > Get Info.

Enregistrement d'une session au format Stationery 
Pad (Mac)
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8  Si besoin est, cliquez sur le triangle général 
Développer/Réduire pour afficher les 
informations et les options générales.

9  Sélectionnez l'option Stationery Pad.

10  Sélectionnez l'option Locked.

11  Fermez la fenêtre d'information.

Pour utiliser un modèle de session, effectuez l'une 
des opérations suivantes :

" Cliquez deux fois sur le modèle de session 
dans le Finder Mac.

– ou –

" Dans Pro Tools, choisissez File > Open Session 
pour ouvrir le modèle de session. 

Lorsque vous ouvrez une session enregistrée au 
format Stationery Pad, Pro Tools permet de 
modifier le modèle ou de démarrer une nouvelle 
session qui en reprend les paramètres. Si vous 
choisissez New Session, Pro Tools crée un 
dossier contenant une copie de votre modèle de 
session et des dossiers Audio et Fades.

Fermeture d'une session
Pro Tools ne peut ouvrir qu'une seule session à 
la fois. La commande Close Session ferme votre 
session actuelle de Pro Tools, sans arrêter 
l'application. Une invite d'enregistrement 
s'affiche lors de la fermeture de la session, mais il 
est recommandé d'utiliser la commande Save ou 
Save As de Pro Tools avant de fermer une 
session.

Pour fermer une session :

" Choisissez File > Close Session.

Fermeture de Pro Tools
Lors de la fermeture de l'application Pro Tools 
sous Windows ou Mac, une invite 
d'enregistrement s'affiche pour la session 
ouverte.

Pour quitter Pro Tools sous Windows :

" Choisissez File > Exit.

Pour quitter Pro Tools sous Mac :

" Choisissez Pro Tools > Quit Pro Tools.
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Chapitre 9 : Fenêtres principales de 
Pro Tools

Pro Tools offre deux façons complémentaires de 
visualiser un projet : la fenêtre Mix et la fenêtre 
Edit. Il permet également de contrôler le 
transport et les fonctions qui y sont liées via la 
fenêtre Transport. De plus, les navigateurs 
DigiBase permettent la gestion et l'importation 
de médias dans des sessions Pro Tools.

Fenêtre Mix
Dans la fenêtre Mix, les pistes s'affichent sous 
forme de voies disposant des commandes 
suivantes :

• Inserts

• Départs

• Assignation des entrées et sorties

• Volume

• Panoramique

• Activation à l'enregistrement

• Mode d'écoute d'entrée de piste

• Mode d'automation

• Solo et Mute

• Commandes d'instrument

• Préamplificateurs micro (Pro Tools HD 
uniquement)

Pour afficher la fenêtre Mix :

" Choisissez Window > Mix.

Pour afficher toutes les options d'affichage de la 
fenêtre Mix :

" Choisissez View > Mix Window > All.

Pour basculer de la fenêtre Edit à la fenêtre 
Mix, et inversement, appuyez sur la 
combinaison de touches Ctrl+touche égal (=) 
(Windows) ou Pomme+touche égal (=) 
(Mac).

Pour plus d'informations sur la sélection 
d'options d'affichage individuelles, 
reportez-vous à la section Vues dans les 
fenêtres Mix et Edit, page 731.
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Fenêtre Edit
La fenêtre Edit présente sur une timeline 
(timeline) des données audio et MIDI, ainsi que 
des données d'automation de la console de 
mixage, afin de faciliter l'enregistrement, 
l'édition et l'organisation des pistes. Tout 
comme dans la fenêtre Mix, chaque piste 
possède ses commandes de préparation à 
l'enregistrement, de mise en solo, de coupure du 
son (Mute) et d'automation.

Pour afficher la fenêtre Edit :

" Choisissez Window > Edit.

Pour afficher toutes les options d'affichage de la 
fenêtre Edit :

" Choisissez View > Edit Window > All. 

Pour plus d'informations sur la sélection 
d'options d'affichage individuelles, 
reportez-vous à la section Vues dans les 
fenêtres Mix et Edit, page 731.
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Figure 2.  Fenêtre Mix de Pro Tools
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Figure 3.  Fenêtre Edit de Pro Tools
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Sélecteurs de chemin de piste et 
commandes associées

Outils d'édition

Indicateurs de sélection et 
compteurs de la fenêtre Edit

Compteurs principaux et secondaires

Les compteurs principaux et secondaires 
peuvent être définis pour différents formats 
d'échelle temporelle (tels que Samples, 
Bars:Beats ou Minutes:Seconds). Pour plus 
d'informations, reportez-vous à la section 
Echelle temporelle principale, page 408. Ces 
compteurs figurent également dans la fenêtre 
Transport.

Indicateurs de sélection d'édition

Les indicateurs de sélection d'édition de début 
(Start), de fin (End) et de durée (Length) peuvent 
être définis pour différents formats d'échelle 
temporelle (tels que Samples, Bars:Beats ou 
Minutes:Seconds). Pour plus d'informations, 
reportez-vous à la section Echelle temporelle 
principale, page 408.

Commandes des pistes de la fenêtre Mix pour une piste 
audio mono (Vue large)

Commandes des pistes de la fenêtre Edit pour une piste 
audio stéréo (hauteur de piste moyenne)

Outils d'édition de la fenêtre Edit

Sélecteur du mode d'automation 
(page 796)
Bouton Record Enable (page 302)

Bouton d'écoute TrackInput (page 306) 
(Pro Tools HD seulement)

Bouton Solo (page 166)

Bouton de coupure (Mute) 
(page 169)

Sélecteur de chemin d'entrée audio 
(page 143)
Sélecteur de chemin de sortie audio 
(page 143)

Sélecteur du mode 
d'automation (page 796)

Bouton Mute (page 169)

Sélecteur de voix (page 160)

Sélecteur de hauteur de piste 
(page 397)

Sélecteur de playlist 
(page 413)

Nom de la piste (page 147)
Bouton Record Enable
(page 302)

Bouton Solo (page 166)

Bouton d'écoute TrackInput (page 306)

Sélecteur de base de temps (page 412)

Sélecteur de vue de la piste (page 393)

Zoom 
(page 429)

Outils de trimming 
(page 438) Sélecteur 

(page 453)

Outils 
d'accrochage 
(page 466)

Outil de scrubbing 
(page 447)

Outil Smart 
(page 445)

Bouton de personnalisation 
de la durée des notes 

(page 648)

Crayon 
(page 646)

Changement de 
zoom (page 429)

Compteurs affichés dans la fenêtre Edit

Indicateurs de sélection d'édition dans la fenêtre Edit

Compteurs principaux et secondaires (page 457)

Indicateurs de sélection d'édition (page 457)
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Zone d'édition des événements

La zone d'édition des événements indique le 
temps, la hauteur et autres informations 
relatives aux données audio ou MIDI 
sélectionnées. Elle permet également de définir 
des sélections à l'aide du clavier.

Barre de la fenêtre Edit

La barre de la fenêtre Edit contient divers 
sélecteurs, commandes, indicateurs et menus 
déroulants pour travailler dans la fenêtre Edit de 
Pro Tools.

Sélecteurs de vue

Commandes

Indicateurs de valeurs et menus 
déroulants Grid/Nudge

Indicateurs d'emplacement du curseur

Zone d'édition des événements affichant les 
informations concernant la piste MIDI

Sélecteurs de vue dans la barre de la fenêtre Edit

Attributs de note (page 655)
Pitch

Vélocité 
d'attaque

Vélocité de relâchement

Sélecteur de vue de la règle (page 731)

Sélecteur de vue de la fenêtre Edit (page 731)

Commandes dans la barre de la fenêtre Edit

Indicateurs de valeurs et menus déroulants Grid/Nudge 
dans la barre de la fenêtre Edit

Indicateurs d'emplacement du curseur dans la barre de 
la fenêtre Edit

Mode d'affichage de 
linéarité (page 580)

Tabulation vers 
transitoires (page 473)

Focus clavier sur les 
commandes (page 22)

Edition MIDI en 
miroir 

(page 645)

Liaison des sélections 
d'édition et de piste 

(page 463)

Liaison des sélections d'édition 
et de timeline (page 461)

Indicateur de valeur 
de grille (Grid) 

(page 502)
Menu déroulant des 

valeurs de grille (Grid) 
(page 502)

Indicateur de valeur d'incrément 
(Nudge) (page 505)

Menu 
déroulant des 

valeurs 
d'incrément 

(Nudge) 
(page 505)

Indicateur d'emplacement du curseur (page 453)

Indicateur de valeur d'emplacement du 
curseur (page 453)
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Fenêtre Transport :
La fenêtre Transport peut être paramétrée pour 
faire apparaître les commandes de transport, 
compteurs, contrôles MIDI et fonctions 
étendues de base. Les compteurs de la fenêtre 
Transport reflètent les commandes et compteurs 
situés en haut de la fenêtre Edit.

Pour afficher la fenêtre Transport :

" Choisissez Window > Transport.

Commandes et compteurs de 
transport principaux

En ligne : met Pro Tools « en ligne » afin que la 
lecture et l'enregistrement soient déclenchés par 
une source de timecode externe.

Retour à zéro : permet de revenir au début de la 
session.

Cliquez avec le bouton droit de la souris sur le 
bouton de retour à zéro afin d'accéder aux 
commandes d'automation Write to Start et 
Write to All.

Retour rapide : permet d'effectuer un retour en 
arrière rapide par rapport à l'emplacement de 
lecture actuel. Vous pouvez également cliquer 
plusieurs fois de suite, afin d'effectuer un retour 
arrière par incrément (d'une valeur basée sur 
l'échelle temporelle principale).

Fenêtre Transport affichant les principaux compteurs et 
commandes de transport (compteurs principaux et 
secondaires et MIDI non représentés)

Appuyez sur la touche Entrée (Windows) ou 
Retour (Mac) pour revenir au début de la 
session.

Indicateurs de sélection 
de début, fin et durée

En ligne

Retour rapide

Avance rapide

Arrêt

Lecture

Enregistre-
ment

Retour à zéro

Fin

Pré-roll

Transport maître

Post-roll

Indicateur d'activation à l'enregistrement de piste

Indicateur d'écoute 
TrackInput

Indicateur de pré-roll

Indicateur de post-roll

Incréments du retour rapide

Format de l'échelle 
temporelle principale

Valeur de 
l'incrément

Min:Sec 1 seconde

Timecode

(Pro Tools HD ou 
Pro Tools LE avec 
DV Toolkit 2)

1 image

Bars:Beats 1 mesure

Feet+Frame 

(Pro Tools HD ou 
Pro Tools LE avec 
DV Toolkit 2)

1 pied

Sample 1 seconde

Lorsque le mode du pavé numérique est 
réglé sur Transport, le retour rapide 
s'obtient en appuyant sur 1.
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Arrêt : arrête la lecture ou l'enregistrement.

Lecture : lance la lecture ou, si vous avez 
préalablement cliqué sur le bouton 
d'enregistrement, l'enregistrement à partir du 
point d'insertion de la timeline ou de 
l'emplacement du marqueur de début de lecture 
si le mode de transport dynamique est activé.

Cliquez avec le bouton droit de la souris sur le 
bouton de lecture pour sélectionner le mode de 
lecture qui convient dans le menu contextuel :

• Demi-vitesse

• Amorce pour lecture

• Boucle

• Transport dynamique

Lorsque le transport est arrêté, maintenez 
enfoncée la touche Démarrer (Windows) ou Ctrl 
(Mac) et cliquez sur le bouton de lecture pour 
passer en mode de lecture en boucle. Lorsque 
l'option est activée, un symbole de boucle 
s'inscrit dans le bouton Lecture et Pro Tools 
recommence la lecture du début à la fin de la 
sélection.

Avance rapide : permet d'effectuer une avance 
rapide par rapport au point d'insertion de la 
timeline. Vous pouvez également cliquer 
plusieurs fois de suite, afin d'effectuer une 
avance rapide par incréments (d'une valeur 
basée sur l'échelle temporelle principale).

Fin : permet d'aller directement à la fin de la 
session.

Vous pouvez aussi interrompre le transport 
en appuyant sur la barre d'espace ou en 
appuyant sur la touche 0 (zéro) du pavé 
numérique s'il est en mode Transport.

Vous pouvez également lancer la lecture en 
appuyant sur la barre d'espace ou en 
appuyant sur la touche 0 (zéro) du pavé 
numérique s'il est en mode Transport.

Pour lancer la lecture en demi-vitesse, vous 
pouvez également appuyer sur Maj+barre 
d'espace (Windows ou Mac) ou cliquer sur 
le bouton Lecture tout en maintenant 
enfoncée la touche Maj (Mac).

Pour plus d'informations sur la lecture en 
boucle et le mode de transport dynamique, 
reportez-vous à la section Lecture en boucle, 
page 475.

Incréments de l'avance rapide

Format de l'échelle 
temporelle principale

Valeur de l'incrément

Min:Sec 1 seconde

Timecode

(Pro Tools HD ou 
Pro Tools LE avec 
DV Toolkit 2)

1 image

Bars:Beats 1 mesure

Feet+Frame 

(Pro Tools HD ou 
Pro Tools LE avec 
DV Toolkit 2)

1 pied

Sample 1 seconde

Lorsque le mode du pavé numérique est 
réglé sur Transport, l'avance rapide 
s'obtient en appuyant sur la touche 2.

Vous pouvez aussi appuyer sur Ctrl+Entrée 
(Windows) ou Option+Retour (Mac) sur le 
clavier alphanumérique pour aller à la fin 
de la session.
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Enregistrement : prépare Pro Tools pour 
l'enregistrement (le bouton clignote). Cliquez 
ensuite sur Lecture pour lancer l'enregistrement 
sur les pistes en mode d'enregistrement 
uniquement.

Cliquez avec le bouton droit de la souris sur le 
bouton d'enregistrement pour sélectionner le 
mode d'enregistrement qui convient dans le 
menu contextuel :

• Normal

• Boucle

• Destructif

• QuickPunch

• TrackPunch (Pro Tools HD uniquement)

• DestructivePunch (Pro Tools HD 
uniquement)

Lorsque le transport est arrêté, vous pouvez 
également passer d'un mode d'enregistrement 
Pro Tools à l'autre en cliquant sur le bouton 
d'enregistrement tout en maintenant la touche 
Démarrer (Windows) ou Ctrl (Mac) enfoncée.

L'aspect du bouton d'enregistrement change 
alors pour indiquer le mode sélectionné : vide 
pour l'enregistrement non destructif ;« D » pour 
l'enregistrement destructif ; le symbole d'une 
boucle pour l'enregistrement en boucle ; « Q » 
pour l'enregistrement QuickPunch et « DP » 
pour l'enregistrement DestructivePunch.

Indicateur d'activation à l'enregistrement de 
piste : allumé (rouge), il indique qu'au moins 
une piste audio est actuellement en mode 
d'enregistrement. Lorsqu'il est éteint (gris), cela 
signifie qu'aucune piste audio n'est 
actuellement en mode d'enregistrement. 

Indicateur d'écoute TrackInput : allumé (vert), il 
indique qu'au moins une piste audio est 
actuellement réglée sur Input Only monitoring 
(quel que soit le statut d'activation de 
l'enregistrement). Lorsqu'il est éteint (gris), cela 
signifie que toutes les pistes sont réglées sur le 
mode d'écoute Auto Input.

Pré-roll : lors de la lecture ou de l'enregistrement, 
spécifie la quantité de données audio lues avant 
la position actuelle du curseur de lecture 
(timeline) ou l'emplacement du marqueur de 
démarrage de lecture, ou encore avant le début 
de la sélection de la timeline. Le pré-roll est 
particulièrement utile avec l'enregistrement de 
type correction (Punch), car il permet de 
« rentrer dans le rythme » avant d'atteindre le 
point d'entrée de l'enregistrement. Pour définir 
la durée de pré-roll désirée, entrez une nouvelle 
valeur dans ce champ ou faites glisser le drapeau 
de pré-roll dans la règle temporelle principale.

Vous pouvez également cliquer avec le 
bouton droit de la souris sur le bouton Fin 
pour accéder aux commandes d'automation 
Write to End et Write to All.

Vous pouvez aussi lancer immédiatement 
l'enregistrement en appuyant sur la touche 
F12, puis sur Ctrl+barre d'espace 
(Windows) ou Pomme+barre d'espace 
(Mac), ou encore en appuyant sur la touche 
3 du pavé numérique préalablement réglé 
sur le mode Transport.

Pour démarrer un enregistrement à 
demi-vitesse, appuyez sur Ctrl+Maj+barre 
d'espace (Windows) ou sur 
Pomme+Maj+barre d'espace (Mac).
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Pour activer le pre-roll :

" Cliquez sur le bouton pré-roll à gauche du 
champ pré-roll pour le mettre en surbrillance. 

Post-roll : lors de la lecture ou de 
l'enregistrement, spécifie la durée lue après la fin 
de la sélection de la timeline. Le post-roll est 
utile pour l'enregistrement à la volée, car la 
lecture se poursuit après le point de sortie de 
l'enregistrement, ce qui permet de vérifier que la 
transition avec les sons déjà enregistrés 
s'effectue en douceur. Pour définir la durée de 
post-roll désirée, entrez une nouvelle valeur 
dans ce champ ou faites glisser le drapeau de 
post-roll dans la règle temporelle principale.

Pour activer le post-roll :

" Cliquez sur le bouton post-roll à gauche du 
champ post-roll pour le mettre en surbrillance. 

Début : spécifie le début d'une plage de lecture 
ou d'enregistrement. Vous pouvez définir le 
point de départ en entrant un emplacement 
dans ce champ ou en faisant glisser le marqueur 
de sélection de timeline correspondant ou le 
marqueur de démarrage de lecture dans la règle 
temporelle principale. Pour plus d'informations, 
reportez-vous à la section Marqueurs de 
sélection de timeline, page 339.

Fin : spécifie la fin d'une plage de lecture ou 
d'enregistrement. Vous pouvez définir le point 
final en entrant un emplacement dans ce champ 
ou en faisant glisser le marqueur de sélection de 
timeline dans la règle temporelle principale. 
Pour plus d'informations, reportez-vous à la 
section Marqueurs de sélection de timeline, 
page 339.

Durée : spécifie la durée d'une plage de lecture 
ou d'enregistrement. Vous pouvez définir la 
durée en entrant un emplacement dans ce 
champ ou en sélectionnant une plage dans la 
règle temporelle principale.

Sélecteur du transport maître : spécifie l'unité 
principale pour les fonctions de transport et 
donne le moyen de mettre hors ligne les 
périphériques activés.

Pour configurer un transport maître :

" Cliquez sur le sélecteur du transport maître et 
sélectionnez l'un des transports maîtres suivants 
dans le sous-menu Transport : Pro Tools, 
Machine, MMC (MIDI Machine Control) ou 
Remote. 

Pour mettre un périphérique hors ligne :

" Cliquez sur le sélecteur de transport maître et 
désactivez le périphérique (MIDI ou Machine) 
dans le sous-menu Online. Les options des 
périphériques varient en fonction du transport 
maître actuel et des périphériques configurés 
dans Pro Tools. 

Pour remettre le périphérique en ligne, 
sélectionnez-le dans le sous-menu Online.

Lorsque les sélections d'édition et de 
timeline sont liées, vous pouvez effectuer 
une sélection d'édition dans la liste de 
diffusion d'une piste pour définir la plage de 
lecture et d'enregistrement. Voir Activation 
ou désactivation de la liaison des sélections 
d'édition et de timeline, page 461.

Si vous utilisez un périphérique MMC, 
reportez-vous au chapitre 35, tilisation de la 
synchronisation.

Si vous utilisez l'option Digidesign 
MachineControl, consultez le Guide 
MachineControl.
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Commandes MIDI

Pour faire apparaître les commandes MIDI dans la 
fenêtre Transport, procédez comme suit :

" Choisissez View > Transport > MIDI Controls.

– ou –

" Pour afficher les commandes MIDI, 
maintenez enfoncée la touche Ctrl (Windows) 
ou Pomme (Mac) pendant que vous cliquez sur 
le bouton Développer/Réduire (+) dans la 
fenêtre Transport.

Attendre la note : lorsque cette option est 
sélectionnée, l'enregistrement ne commence 
que lorsqu'un événement MIDI est reçu. Cela 
garantit que l'enregistrement ne commence que 
lorsque vous êtes prêt à jouer et que la première 
note, ou autre donnée MIDI, est enregistrée 
précisément au début de la plage 
d'enregistrement.

Métronome : lorsque cette fonction est 
sélectionnée, Pro Tools produit une impulsion 
de métronome qu'il est possible de configurer 
dans le but de déclencher des sons intégrés ou 
des instruments MIDI lors de la lecture et de 
l'enregistrement.

Le métronome Pro Tools est configuré dans la 
boîte de dialogue Click/Countoff Options. 
Cliquez deux fois sur le bouton Métronome 
pour ouvrir la boîte de dialogue Click/Countoff 
Options.

Décompte : lorsque cette option est 
sélectionnée, Pro Tools décompte le nombre 
spécifié de mesures (indiqué dans le bouton) 
avant le démarrage de la lecture ou de 
l'enregistrement.

Cliquez deux fois sur le bouton de décompte 
pour ouvrir la boîte de dialogue Click/Count 
Options.

Fusion MIDI : lorsque cette option est 
sélectionnée (mode Merge), les données MIDI 
enregistrées fusionnent avec celles qui se 
trouvaient sur la piste. Lorsque cette option est 
désélectionnée (mode Replace), les données 
MIDI enregistrées remplacent celles qui se 
trouvaient sur la piste.

Fenêtre Transport affichant les commandes MIDI

Fenêtre Transport affichant les commandes MIDI

Activation de 
la règle de 

tempo

Attendre la note

Décompte

Métrique 
actuelle

Métronome Fusion MIDI

Tempo actuel

Menu déroulant Tempo 
Resolution (valeur de 
temps)

Curseur de tempo

Bouton Développer/Réduire (+)

Appuyez sur la touche F11 pour activer la 
fonction d'attente de la note Wait for Note. 
Celle-ci n'est pas disponible lorsque l'option 
Disable F11 for Wait for Note est 
sélectionnée dans les préférences MIDI.

Lorsque le mode du pavé numérique est 
réglé sur Transport, appuyez sur la touche 7 
pour activer le métronome.

Lorsque le mode du pavé numérique est 
réglé sur Transport, appuyez sur la touche 8 
pour activer le décompte.
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Activation de la règle de tempo (Chef 
d'orchestre) : lorsque cette fonction est 
sélectionnée, Pro Tools utilise la table des 
tempos définie dans la règle de tempo. 
Lorsqu'elle est désélectionnée, Pro Tools passe 
en mode tempo manuel et ignore la règle de 
tempo.

En mode tempo manuel, vous pouvez entrer 
une valeur BPM dans le champ du tempo ou 
cliquer en rythme sur la touche T de votre 
clavier alphanumérique.

Curseur de tempo : lorsque la fonction Tempo 
Ruler Enable (Chef d'orchestre) est désactivée, 
Pro Tools ignore les événements de tempo dans 
la piste de tempo et joue un tempo manuel 
spécifié à la place. Vous définissez ce tempo au 
moyen du curseur de tempo.

Métrique actuelle : indique la métrique (type de 
mesure) utilisée à l'endroit de la session en cours 
de lecture. Cliquez deux fois sur le bouton de 
métrique actuelle pour ouvrir la fenêtre Change 
Meter.

Tempo actuel : affiche le tempo courant de la 
session basé sur l'emplacement de lecture en 
cours. En mode tempo manuel, vous pouvez 
saisir une valeur de BPM dans ce champ ou saisir 
manuellement un tempo avec le clavier de 
l'ordinateur ou un clavier MIDI externe.

Navigateurs DigiBase
Les bases de données DigiBase sont accessibles 
via les navigateurs DigiBase. Les navigateurs 
permettent d'explorer les bases de données 
DigiBase grâce à leur interface utilisateur 
intuitive dotée de nombreuses fonctions de 
gestion de fichiers (par exemple des fonctions de 
recherche et de tri).

Les navigateurs dans Pro Tools sont analogues 
aux fenêtres du système d'exploitation d'un 
ordinateur (comme l'Explorateur Windows ou le 
Finder Mac), mais ils sont conçus et optimisés 
pour les procédures Pro Tools. Vous pouvez 
afficher simultanément plusieurs navigateurs et 
personnaliser l'affichage de chaque navigateur.

Les navigateurs permettent de trier des sessions 
et fichiers audio et vidéo et d'y effectuer des 
recherches. Vous pouvez déplacer directement 
ces fichiers affichés par ces navigateurs (par 
glisser-déposer) dans la session Pro Tools en 
cours.

Lorsque des éléments hors ligne s'avèrent 
nécessaires, Pro Tools permet de rechercher les 
fichiers correspondants pour rétablir leur lien 
vers le média en ligne. 

Les principaux éléments d'un navigateur 
DigiBase (voir figure 4, page 125) sont les 
suivants : 

Barre de titre : indique le type de navigateur 
(espace de travail, volume, projet ou catalogue) 
et le nom du volume de la session ou du 
catalogue associé. 

Barre d'outils : contient le menu du navigateur, 
l'icône de recherche, des présélections de vues 
(numérotées de 1 à 5) et des outils de navigation. 

Lorsque le mode du pavé numérique est 
réglé sur Transport, appuyez sur la touche 9 
pour activer la fusion MIDI.
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En-têtes de colonnes : affichent le type de 
métadonnées qui figurent dans la liste des 
éléments. Les en-têtes de colonnes peuvent 
être :

• redimensionnés en faisant glisser le bord 
d'une colonne ou réorganisés en faisant 
glisser un en-tête ;

• déplacés par glisser-déposer à l'intérieur de 
l'un des deux volets du navigateur, le volet 
fixe et le volet de défilement.

Liste des éléments : affiche le contenu de la base 
de données d'un volume, d'un dossier, d'une 
session ou d'un catalogue. Les métadonnées des 
volumes, dossiers et fichiers (par exemple le 
nom du fichier et son format) s'affichent dans 
les colonnes de la liste des éléments. 

Il existe trois types de navigateurs Pro Tools, 
disponibles sur tous les systèmes pris en charge :

• Navigateur de l'espace de travail 
(Workspace)

• Navigateurs de volumes

• Navigateur de projet (Project)

DigiBase Pro (Pro Tools HD ou Pro Tools LE avec 
DV Toolkit 2 uniquement) fournit un 
navigateur supplémentaire :

• Catalogues

Navigateur de l'espace de travail

Le navigateur de l'espace de travail fournit 
l'accès à tous les volumes montés ainsi qu'aux 
dossiers et aux fichiers qu'ils contiennent. 

Il permet d'effectuer les opérations suivantes :

• Accès à tous les volumes montés

• Accès à tous les catalogues

• Recherche simultanée dans plusieurs 
volumes et catalogues

Figure 4.  Principaux éléments d'un navigateur DigiBase (navigateur du volume illustré)

Barre d'outils

Liste des 
éléments

Volet fixe Volet de défilement

Séparation

Afficher/Masquer

En-têtes de colonnes

Barre de titre
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• Sélection des volumes pour 
l'enregistrement et la lecture, la lecture 
seule ou le transfert

• Démontage des volumes

• Affichage, gestion, écoute et importation 
des éléments individuels dans tout 
catalogue ou volume monté

• Mise à jour des bases de données de 
volumes entiers

Navigateurs de volumes

Les navigateurs de volumes permettent de gérer 
des fichiers pour les volumes locaux et du réseau. 
Les volumes sont des partitions formatées sur un 
disque dur. Ouvrez un navigateur de volumes en 
cliquant deux fois sur un volume dans le 
navigateur de l'espace de travail. Tout 
changement effectué dans les navigateurs de 
volumes (tel que la copie, l'effacement ou le 
déplacement de fichiers et de dossiers) se reflète 
directement dans les volumes. Les volumes 
comprennent les disques durs montés, les 
volumes d'archivage de réseau et les 
CD/DVD-ROM.

Les navigateurs de volumes permettent 
d'effectuer les opérations suivantes :

• Affichage, gestion, écoute et importation 
d'éléments individuels dans le volume

• Mise à jour de la base de données pour le 
contenu du volume

Navigateur de projet

Le navigateur de projet fournit des outils de 
recherche et de gestion des fichiers référencés 
dans votre session en cours, quel que soit leur 
emplacement de stockage. Il permet d'effectuer 
les opérations suivantes :

• Affichage de tous les fichiers média liés à la 
session en cours, y compris tout fichier 
manquant

• Affichage, gestion, écoute et placement 
d'éléments individuels

Catalogues (DigiBase Pro uniquement)

Les catalogues permettent de gérer les fichiers 
Pro Tools de manière globale. Ils permettent 
d'organiser facilement des fichiers provenant de 
sources diverses dans des bibliothèques 
contenant vos fichiers préférés. Vous pouvez 
trier les catalogues et y effectuer des recherches, 
même lorsque les fichiers auxquels ils font 
référence sont hors ligne. Vous avez aussi la 
possibilité de les utiliser en mode partagé. 

Par ailleurs, les catalogues permettent d'effectuer 
les opérations suivantes :

• Collecte et organisation des fichiers de 
toute combinaison de volumes

• Création des catalogues de volumes 
complets permettant de visualiser et 
recherche de volumes en ligne ou non

• Affichage, gestion, écoute et importation 
des éléments individuels dans le catalogue

• Mise à jour la base de données pour le 
contenu du catalogue

Pour en savoir plus sur le navigateur de 
l'espace de travail, reportez-vous à la 
section Navigateur de l'espace de travail, 
page 228

Pour en savoir plus sur le navigateur de 
projet, reportez-vous à la section Navigateur 
de projet, page 231

Pour en savoir plus sur les catalogues, 
reportez-vous à la section Catalogues 
DigiBase Pro, page 233
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Fenêtre de tâches

La fenêtre de tâches est un utilitaire conçu pour 
visualiser et gérer toutes les tâches d'arrière-plan 
que vous effectuez avec Pro Tools. Elle permet 
de surveiller, d'interrompre momentanément et 
d'annuler les tâches d'arrière-plan (comme la 
copie de fichiers, les recherches, l'indexation et 
la création de fondus).

Fenêtre Relink

La fenêtre Relink propose des outils et des 
fonctions conçus pour rétablir les liens des 
sessions et des catalogues aux fichiers média. 
Les outils Relink permettent de rechercher et de 
récupérer des fichiers (hors ligne) destinés à la 
session en cours. 

Configuration de fenêtres
Pro Tools est un outil puissant permettant de 
gérer la configuration de fenêtres dans votre 
session, ainsi que la configuration interne des 
fenêtres Mix, Edit et Transport. Utilisez la liste 
des configurations de fenêtres pour créer, 
supprimer et gérer vos configurations de 
fenêtres stockées. Pro Tools permet de stocker 
jusqu'à 99 configurations de fenêtres. 
Les configurations de fenêtres sont enregistrées 
avec la session.

Une configuration de fenêtre peut stocker 
l'emplacement et la taille de toutes les fenêtres 
ouvertes, y compris les éléments suivants :

• Fenêtre Edit

• Fenêtre Mix

• Navigateur de l'espace de travail

• Navigateur de projet

• Navigateurs DigiBase

• Fenêtre Session Setup

• Fenêtres Time, Tempo et MIDI Operations

• Liste des événements MIDI

• Fenêtre Real-time MIDI Properties

• Fenêtre Beat Detective

• Fenêtre Plug-in

• Fenêtres panoramiques

• Fenêtres de préamplificateur micro

Pour en savoir plus sur la fenêtre de tâches, 
reportez-vous à la section Fenêtre de tâches, 
page 238.

Pour en savoir plus sur la fenêtre Relink, 
reportez-vous à la section Fenêtre Relink, 
page 224.

Créez un modèle de session avec votre 
configuration de fenêtre favorite. Vous 
pourrez ensuite utiliser ce modèle lors du 
démarrage d'une nouvelle session ou 
exécuter la commande Import Session Data 
pour importer les configurations de fenêtres 
dans votre session actuelle.
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• Toutes les fenêtres flottantes listées dans le 
menu des fenêtres

• Fenêtre Task Manager

• Fenêtre Transport

• Fenêtre Big Counter

• Fenêtre Automation

• Fenêtre Memory Locations

• Fenêtre d'activation des pistes

• Fenêtre Universe

• Fenêtre Vidéo

• Fenêtre de la palette de couleurs

• Fenêtre Undo History

• Fenêtre Disk Space

• Fenêtre System Usage

Une configuration de fenêtre peut également 
stocker les paramétrages d'affichage des fenêtres 
pour les fenêtres Edit, Mix et Transport.

Liste des configurations de 
fenêtres

La liste des configurations de fenêtres permet le 
rappel et la gestion des configurations de 
fenêtres stockées ainsi que la création de 
nouvelles configurations.

Pour ouvrir la liste des configuration de fenêtres :

" Sélectionnez Window > Configurations > 
Window Configuration List.

Propriétés des configurations de 
fenêtres

Vous pouvez stocker et rappeler les 
configurations de fenêtres avec la disposition 
des fenêtres dans votre session Pro Tools ou les 
paramètres des fenêtres Edit, Mix et Transport. 
Pour chaque configuration de fenêtre, vous 
pouvez déterminer les propriétés à stocker dans 
la boîte de dialogue New Window 
Configuration ou Edit Window Configuration.

Number : numéro de l'emplacement dans lequel 
la configuration de fenêtre est stockée (de 1 à 
99). Vous pouvez saisir un point (.), le numéro 
de la configuration de fenêtre, puis un astérisque 
(*) sur le pavé numérique de votre clavier pour 
rappeler la configuration de fenêtre stockée dans 
cet emplacement.

Name : nom de la configuration de fenêtre 
stockée.

L'emplacement et la taille de la liste de 
configurations de fenêtres ne sont pas 
stockés avec les configurations de fenêtres.

Liste des configurations de fenêtres

Appuyez sur Ctrl+Alt+J (Windows) ou 
Pomme+Option+J (Mac) pour afficher ou 
masquer la liste des configuration de 
fenêtres.

Boîte de dialogue Edit Window Configuration
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Window Layout : permet de stocker la taille et 
l'emplacement de toutes les fenêtres ouvertes.

Option Include Edit, Mix, and Transport Display 
Settings Lorsque cette option est activée, tous 
les paramètres d'affichage des fenêtres Edit, Mix 
et Transport sont stockés avec la configuration 
de fenêtre. Par exemple, cela permet d'afficher 
ou non la liste des régions dans la fenêtre Edit.

Edit Window Display Settings : stocke 
uniquement les paramètres d'affichage de la 
fenêtre Edit.

• Largeur des listes de pistes et de groupes

• Hauteur de la liste de pistes

• Largeur de la liste des régions

• Règles affichées (la règle principale l'est 
toujours)

• Les colonnes de pistes affichées (par 
exemple Inserts, Sends et Comments)

• Affichage de l'éditeur de tempo

• Affichage ou non des commandes de 
transport dans la fenêtre Edit

Mix Window Display Settings : stocke tous les 
paramètres d'affichage de la fenêtre Mix :

• Largeur des listes de pistes et de groupes

• Hauteur de la liste de pistes

• Les lignes de pistes affichées (par exemple 
Inserts, Sends et Comments)

• Vue réduite/agrandie de la fenêtre de 
mixage

Transport Window Display Settings : stocke tous 
les paramètres d'affichage de la fenêtre 
Transport :

• Affichage des compteurs

• Affichage des commandes MIDI

• Affichage étendu

Comments : permet la saisie de commentaires 
sur les configurations de fenêtres.

Commandes et options de 
configuration de fenêtres

Icônes des filtres d'affichage

A l'aide des icônes des filtres d'affichage, la liste 
de configurations des fenêtres vous permet 
d'afficher ou de masquer les configurations de 
fenêtres selon qu'elles sont stockées avec la 
disposition de fenêtre ou les paramètres de la 
fenêtre Edit, Mix ou Transport.

Vous pouvez filtrer les configurations de fenêtres 
dans la liste correspondante de l'une des manières 
suivantes :

" Cliquez sur l'icône d'affichage de filtre pour 
afficher ou masquer les configurations de 
fenêtres incluant cette propriété (disposition de 
fenêtres, paramètres de la fenêtre Edit, 
paramètres de la fenêtre Mix ou paramètres de la 
fenêtre Transport). 

– ou –

" Sélectionnez ou désélectionnez l'élément de 
filtre d'affichage dans le menu contextuel de la 
liste des configurations de fenêtres.

Icônes des filtres d'affichage de la liste des 
configurations de fenêtres

Disposition de fenêtre
Paramètres de la fenêtre Edit

Paramètres de la fenêtre Mix
Paramètres de la fenêtre Transport
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Menu contextuel de la liste des configurations 
de fenêtres

Vous pouvez sélectionner les options d'affichage 
et de tri, ainsi que les commandes pour créer et 
supprimer des configurations de fenêtres, à 
partir du menu déroulant de la liste des 
configurations de fenêtres.

View Filter : permet d'afficher ou de masquer les 
icônes de filtrage des configurations de fenêtres 
dans la liste, ou encore d'afficher ou de masquer 
les configurations de fenêtres avec disposition 
de fenêtre, paramètres des fenêtres Edit, 
paramètres des fenêtres Mix ou paramètres des 
fenêtres Transport. 

Show Comments : permet d'afficher ou de 
masquer les commentaires dans la liste des 
configurations de fenêtres.

New Configuration : permet de créer une 
configuration de fenêtre. Cette commande est 
également disponible à partir de Window > 
Configurations.

Update <Nom> : met à jour la configuration de 
fenêtre avec les modifications apportées à la 
disposition et aux paramètres de fenêtres en 
fonction des propriétés des configurations de 
fenêtres. Cette commande est également 
disponible à partir de Window > 
Configurations.

Edit <Nom> : ouvre la boîte de dialogue Edit 
Window Configuration qui permet de modifier 
les propriétés des configurations de fenêtres 
sélectionnées.

Clear <Nom> : efface la configuration de fenêtre 
sélectionnée sans supprimer l'emplacement 
(numéro).

Delete All : supprime toutes les configurations 
de fenêtres.

Insert Slot Before <Nom> : insère un nouvel 
emplacement avant la configuration de fenêtre 
sélectionnée, et, si nécessaire, incrémente le 
numéro de chacun des emplacements suivants.

Delete <Nom> Slot : supprime la configuration 
de fenêtre sélectionnée et son emplacement 
(numéro), et attribue un nouveau numéro aux 
emplacements suivants.

Auto-Update Active Configuration : met à jour 
automatiquement la configuration de fenêtre 
active après modification de la disposition et des 
paramètres des fenêtres. Cette commande est 
également disponible à partir de Window > 
Configurations.

Configuration de fenêtre active

La configuration de fenêtre active est signalée 
par un diamant situé à gauche du numéro de 
configuration dans la liste de configurations de 
fenêtres et dans le sous-menu Configurations 
(Window > Configuration). Si l'option 
Auto-Update Active Configuration est activée, le 
numéro de la configuration de fenêtre active 
s'affiche également dans le menu Window. 
Seules les configurations de fenêtres incluant 
une disposition de fenêtre peuvent être actives. 
Les autres configurations peuvent être 
sélectionnées et mettre à jour les paramètres 
d'affichage des fenêtres dans la disposition de 
fenêtre active.

Menu contextuel de la liste des configurations de 
fenêtres
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Création d'une configuration de fenêtre

Pour créer une configuration de fenêtre :

1  Ouvrez les fenêtres à inclure dans la 
configuration de fenêtre et positionnez-les à 
l'emplacement souhaité sur l'écran.

2  Effectuez l'une des opérations suivantes :

• Choisissez Window > Configurations > 
New Configuration. 

– ou –

• Sélectionnez New Configuration dans le 
menu contextuel de la liste des 
configurations de fenêtres.

3  Dans la boîte de dialogue New Window 
Configuration, effectuez l'une des opérations 
suivantes :

• Sélectionnez Window Layout et précisez si 
vous souhaitez inclure ou non les 
paramètres d'affichage des fenêtres Edit, 
Mix et Transport.

– ou –

• Sélectionnez l'une des options de 
paramètres d'affichage dans la liste 
déroulante (Edit Window Display Settings, 
Mix Window Display Settings ou Transport 
Window Display Settings).

4  Nommez la configuration de fenêtre.

5  Pro Tools choisit automatiquement le premier 
numéro disponible (de 1 à 99) pour la nouvelle 
configuration de fenêtre, mais vous pouvez en 
saisir un différent. Si le numéro saisi est déjà 
utilisé par une autre configuration, vous êtes 
invité à le remplacer ou à annuler l'opération. 

6  Tapez un commentaire pour la nouvelle 
configuration de fenêtre.

7  Cliquez sur OK pour stocker la nouvelle 
configuration de fenêtre ou annulez.

La nouvelle configuration de fenêtre est ajoutée 
à la liste de configuration de fenêtre.

Rappel de configuration de fenêtre

Vous pouvez utiliser la liste des configurations 
de fenêtres pour rappeler des configurations 
stockées. Vous pouvez également utiliser le pavé 
numérique de votre clavier pour rappeler une 
configuration de fenêtre spécifique.

Pour rappeler une configuration de fenêtre, 
effectuez l'une des opérations suivantes :

" Sélectionnez la configuration de fenêtre à 
partir de Window > Configurations.

Configuration de fenêtre active

Boîte de dialogue New Window Configuration

Configuration de 
fenêtre active

Pour ajouter une nouvelle configuration de 
fenêtre à cet emplacement de numéro, 
saisissez un point (.), un numéro (de 1 à 99) 
et appuyez sur la touche plus (+) du pavé 
numérique. Si une configuration de fenêtre 
existe déjà dans cet emplacement numéroté, 
la nouvelle configuration la remplace.
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" Cliquez sur la configuration de fenêtre 
souhaitée dans la liste des configurations de 
fenêtres pour la rappeler.

" Sur le pavé numérique, saisissez un point (.), le 
numéro de la configuration (de 1 à 99) puis 
appuyez sur la touche astérisque (*).

L'écran de la session Pro Tools affiche les mises à 
jour avec la configuration de fenêtre stockée.

Annulation d'une configuration de 
fenêtre

Pro Tools permet uniquement de revenir à la 
toute dernière configuration de fenêtre. 
Cette annulation est utile lors d'un rappel d'une 
configuration de fenêtre devant être suivi d'un 
retour à l'état précédent.

Pour annuler une configuration de fenêtre :

" Sur le pavé numérique, saisissez un point (.), 
le chiffre 0, puis appuyez sur la touche 
astérisque (*). 

Pour rétablir une configuration de fenêtre :

" Sur le pavé numérique, saisissez un point (.), 
le chiffre 0, puis appuyez sur la touche 
astérisque (*).

Si l'option Auto-Update Active Configuration 
est activée, l'annulation de la configuration de 
fenêtre rétablit la configuration stockée 
précédemment sans sauvegarder les 
modifications (voir Mise à jour des 
configurations de fenêtres, page 132).

Modification des configurations de 
fenêtres

Outre les propriétés stockées avec les 
configurations de fenêtres, vous pouvez 
modifier le numéro, le nom et les commentaires 
associés à une configuration de fenêtre. 

Pour modifier une configuration de fenêtre :

1  Sélectionnez la configuration à modifier dans 
la liste des configurations de fenêtres.

2  Dans le menu déroulant de cette liste, 
sélectionnez Edit <Nom>. 

3  Effectuez vos modifications dans la boîte de 
dialogue Edit Window Configuration, puis 
cliquez sur OK.

Mise à jour des configurations de 
fenêtres

Après avoir rappelé une configuration de fenêtre 
stockée, vous pouvez apporter des modifications 
à la disposition et aux paramètres des fenêtres, 
puis mettre à jour la configuration stockée avec 
vos modifications. Vous pouvez effectuer cette 
opération manuellement ou configurer 
Pro Tools de manière à ce que la mise à jour 
s'effectue automatiquement.

Pour effectuer une mise à jour manuelle d'une 
configuration de fenêtre, effectuez l'une des 
opérations suivantes :

" Choisissez Window > Configurations > 
Update Active Configuration.

La configuration de fenêtre active est mise à jour 
avec les modifications apportées à ses propriétés 
(disposition et paramètres d'affichage des 
fenêtres).

– ou –

" Dans le menu déroulant de cette liste, 
sélectionnez Update <Nom>.

La configuration sélectionnée est mise à jour 
avec les modifications apportées à ses propriétés.
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Pour que Pro Tools effectue une mise à jour 
automatique de la configuration de fenêtres 
active, effectuez l'une des opérations suivantes :

" Choisissez Window > Configurations > 
Auto-Update Active Configuration.

– ou –

" Dans le menu déroulant de cette liste, 
sélectionnez Auto-Update Active Configuration.

Lorsque l'option Auto-Update Active 
Configuration est activée, la configuration de 
fenêtre active est mise à jour avec toutes les 
modifications apportées à la disposition et aux 
paramètres d'affichage de fenêtres.

Seules les configurations de fenêtres avec 
disposition de fenêtre peuvent être actives. Elles 
sont, par conséquent, les seules à pouvoir être 
mises à jour automatiquement. Pour mettre à 
jour une configuration de fenêtre avec les 
modifications apportées aux paramètres 
d'affichage de fenêtres (comme par exemple la 
largeur de la liste de régions dans la fenêtre Edit), 
utilisez la commande Update dans la liste des 
configurations de fenêtres.

Réinitialisation d'une configuration de 
fenêtre

La réinitialisation d'une configuration de 
fenêtre supprime cette dernière ainsi que son 
numéro d'emplacement associé, sans modifier 
les numéros d'emplacement des autres 
configurations de fenêtres. La commande Clear 
est utile si vous souhaitez insérer une autre 
configuration dans le même emplacement. 

Pour réinitialiser une configuration de fenêtre :

1  Sélectionnez la configuration à réinitialiser 
dans la liste des configurations de fenêtres.

2  Dans le menu déroulant de cette liste, 
sélectionnez Clear <Nom>. 

Suppression d'une configuration de 
fenêtre

La suppression d'une configuration de fenêtre 
supprime cette dernière, ainsi que son numéro 
d'emplacement, et attribue de nouveaux 
numéros à toutes les configurations suivantes.

Pour supprimer une configuration de fenêtre :

1  Sélectionnez la configuration à supprimer 
dans la liste des configurations de fenêtres.

2  Effectuez l'une des opérations suivantes :

• Dans le menu déroulant de cette liste, 
sélectionnez Delete <Nom>. 

– ou –

• Supprimez toutes les configurations de 
fenêtres avec la commande Delete All.

Importation de configurations de 
fenêtres

Vous pouvez importer des configurations de 
fenêtres à partir d'une autre session grâce à la 
commande Import Session Data. 

Pour importer des configurations de fenêtres :

1  Choisissez File > Import  Session Data.

2  Sélectionnez l'option Window 
Configurations.

Importation des configurations de fenêtres



Guide de référence Pro Tools134

3  Si vous ne souhaitez importer que des 
configurations de fenêtres, cliquez sur le menu 
déroulant Session Data to Import et sélectionnez 
None.

4  Cliquez sur OK.

Masquage des fenêtres flottantes

La commande Hide All Floating Windows 
masque ou affiche toutes les fenêtres flottantes. 
Cette commande est utile pour masquer 
rapidement toutes les fenêtres flottantes de 
l'écran et travailler dans la fenêtre Edit ou Mix. 

Pour masquer ou afficher toutes les fenêtres 
flottantes :

" Sélectionnez ou désélectionnez Window > 
Hide All Floating Windows.

Menus
Les menus Pro Tools proposent différentes 
commandes pour configurer et utiliser 
Pro Tools, les sessions et les données des 
sessions.

Menus principaux Pro Tools

Pro Tools se compose des menus principaux 
suivants :

File : fournit des commandes pour la création et 
la gestion des sessions Pro Tools.

Edit : fournit des commandes pour la 
modification et la manipulation de la sélection 
actuelle ainsi que l'assignation des données dans 
la timeline ou le presse-papiers.

View : fournit des commandes pour la 
personnalisation du contenu des diverses 
fenêtres. 

Track : fournit des commandes pour la création, 
la gestion et l'édition des pistes.

Région : fournit des commandes pour la gestion 
et l'édition des régions.

Event : fournit des commandes pour l'édition 
d'événements audio et MIDI.

AudioSuite : fournit un ensemble de plug-in 
AudioSuite. 

Options : fournit des commandes pour la 
sélection de plusieurs options d'édition, 
d'écoute, de lecture et d'affichage.

Setup : fournit des commandes pour l'ouverture 
des boîtes de dialogue et des fenêtres ou la 
configuration des différents paramètres de 
matériel et de logiciels Pro Tools.

Window : fournit des commandes pour la 
navigation entre les différentes fenêtres 
Pro Tools.

Help : offre un accès aux documents PDF relatifs 
aux raccourcis Clavier, FAQ Digidesign, plug-in 
DigiRack, menus Pro Tools ainsi qu'au Guide de 
référence Pro Tools.

Appuyez sur Ctrl+Alt+J (Windows) ou 
Pomme+Option+J (Mac) pour afficher ou 
masquer toutes les fenêtres flottantes.

Pour plus d'informations sur les menus 
principaux et les menus contextuels de la 
liste des régions de Pro Tools, reportez-vous 
au manuel Pro Tools Menus Guide.
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Menus déroulants des listes de pistes, 
de régions et de groupes

Les listes de pistes, de régions et de groupes 
contiennent des menus déroulants permettant 
de gérer le contenu de chaque liste.

Menu déroulant de la liste des pistes : fournit 
des commandes pour l'affichage et le masquage 
des pistes dans les fenêtres Mix et Edit. Le menu 
déroulant de la liste des pistes sert également à 
trier le contenu de la liste des pistes. 

Menu déroulant de la liste des groupes (d'édition 
et de mixage) : fournit des commandes pour la 
création, l'affichage, l'interruption et la 
suppression des groupes d'édition et des groupes 
de mixage.

Menu déroulant de la liste des régions (fenêtre 
Edit seulement) : fournit des commandes pour 
la recherche, la sélection, le tri, la 
réinitialisation, le renommage, l'horodatage, le 
compactage, l'exportation et le recalcul des 
présentations sous forme d'onde des éléments 
dans la liste des régions. Ce menu déroulant sert 
également à définir l'ordre dans lequel les 
régions que vous faites glisser à partir de la liste 
des régions sont déposées dans la timeline. 

Menus contextuels des noms de pistes 
et de régions

En cliquant avec le bouton droit de la souris sur 
des noms de pistes et de régions, vous pouvez 
accéder à des menus contextuels offrant des 
commandes pour la gestion et le travail avec ces 
pistes et régions :

Menu contextuel des noms de pistes : s'ouvre 
avec un clic droit sur un nom de piste, dans la 
fenêtre Edit, Mix ou dans la liste de pistes, et 
fournit diverses commandes associées aux pistes 
(afficher/masquer, activer/désactiver, 
renommer, dupliquer ou supprimer, etc.). 

Menu contextuel des noms de régions (fenêtre 
Edit uniquement) : s'ouvre avec un clic droit sur 
un nom de région dans la liste des régions et 
fournit diverses commandes pour la 
réinitialisation, le renommage, l'horodatage ou 
le remplacement de régions. Ce menu 
contextuel permet également d'exporter des 
définitions de régions ou des régions 
sélectionnées en tant que fichiers, de recalculer 
les présentations de forme d'onde, de 
sélectionner le fichier parent ou les régions 
sélectionnées dans le navigateur de l'espace de 
travail DigiBase ou de sélectionner une région 
en tant qu'objet dans la fenêtre Edit.

Pour plus d'informations, reportez-vous à la 
section Liste de pistes, page 152.

Pour plus d'informations, consultez la 
section Liste de groupes, page 176.

Pour plus d'informations, reportez-vous à la 
section Liste des régions, page 419.

Pour plus d'informations, reportez-vous à la 
section Menu contextuel relatif aux noms 
des pistes-, page 155.

Pour plus d'informations, reportez-vous à la 
section Liste des régions, page 419.
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Menus contextuels des indicateurs de 
groupes de pistes et noms de groupes

Lorsque vous effectuez un clic long sur un nom 
de groupe dans la liste des groupes ou cliquez sur 
un indicateur de groupe, un menu contextuel 
s'affiche, vous donnant accès à des commandes 
associées aux groupes (pour la sélection de pistes 
dans un groupe, par exemple).

Info-bulles
Pro Tools affiche des info-bulles dans toutes les 
fenêtres principales. Il suffit de placer le curseur 
quelques secondes sur un nom abrégé ou une 
icône ou un outil sans nom pour connaître la 
fonction ou les détails de l'élément (en fonction 
des préférences choisies pour les info-bulles).

Pour configurer les info-bulles pour Pro Tools :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Display.

2  Dans la section Basics, activez les options 
d'info-bulles à afficher. 

Function : affiche le nom fonctionnel des 
différents éléments Pro Tools (boutons, 
indicateurs, modes, sélecteurs et outils d'édition, 
par exemple).

Details : affiche les noms ou valeurs abrégés ou 
masqués dans Pro Tools pour différents 
éléments Pro Tools (noms d'insert, niveaux de 
gain, paramètres et affectations de routage, par 
exemple).

3  Cliquez sur OK. 

Pour plus d'informations, reportez-vous à la 
section Menus contextuels pour le nom de 
groupe et l'indicateur d'ID de groupe d'une 
piste, page 178.

Pour désactiver les info-bulles, 
désélectionnez ces options.
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Chapitre 10 : Pistes

Ce chapitre aborde les tâches principales de 
gestion des pistes telles que la création et la 
suppression de pistes, l'assignation de voix et de 
canaux de sortie, et le regroupement de pistes. 

Types de pistes
Une session Pro Tools peut contenir différents 
types de pistes : audio, entrée auxiliaire, fader 
principal, VCA principal (Pro Tools HD 
uniquement), MIDI, Instrument et vidéo.

Pistes audio, d'entrée auxiliaire, de 
fader principal et de VCA principal

Les pistes audio, d'entrée auxiliaire, de fader 
principal et de VCA principal de Pro Tools 
peuvent être aux formats mono, stéréo et 
multicanal.

Pistes audio

Les pistes audio permettent l'enregistrement et 
la lecture de fichiers audio enregistrés ou 
importés sur disque.

Pistes d'entrée auxiliaire

Les pistes d'entrée auxiliaire peuvent servir de 
signaux de départs d'effets, accueillir une autre 
version de mixage, faire office de destination de 
prémixage ou d'entrées pour le contrôle ou le 
traitement de l'audio (tel que l'audio des 
instruments MIDI externes) et convenir à 
diverses autres tâches d'assignation audio.

Pistes de fader principal

Les pistes de fader principal contrôlent le niveau 
global des pistes audio envoyées vers les sorties 
physiques. Vous pouvez avoir, par exemple, 
24 pistes dans une session avec les canaux 
ProTools 1 à 8 assignés à Analog Output 1–2, les 
canaux 9 à 16 assignés à Analog Output 3–4 et 
les canaux 17 à 24 assignés à Analog 
Output 5–6. Il suffit ensuite de créer trois faders 
principaux afin de contrôler chaque paire de 
canaux.

Les pistes de fader principal permettent de 
réaliser encore davantage d'opérations (telles 
que le contrôle des niveaux de prémixage). 
Pour plus d'informations, reportez-vous à la 
section Pistes de fader principal, page 724.

Les fonctions des pistes vidéo sont décrites 
au chapitre 36, Traitement vidéo dans 
Pro Tools
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Pistes de VCA principal

(Pro Tools HD uniquement)

Les pistes de VCA principal ont pour but 
d'émuler le fonctionnement des canaux 
d'amplification commandés par tension sur les 
consoles analogiques. Un fader de canal VCA 
permet dans ce cas de contrôler, regrouper ou 
décaler les niveaux des signaux des autres 
canaux de la console.

Les pistes de VCA principal ne transmettent pas 
de données audio. Elles n'ont par conséquent 
pas d'entrées, de sorties, d'inserts ou d'envois. 
Les pistes de VCA principal sont associées à un 
groupe de mixage, qui apparaît dans le sélecteur 
d'assignation de la piste de VCA.

Les commandes des pistes de ce groupe de 
mixage (appelées pistes esclaves) sont modifiées 
par celles de la piste de VCA principal. 

Pistes MIDI

Les pistes MIDI stockent les données des notes, 
des instruments et des contrôleurs MIDI. Il est 
impossible de sélectionner le format de piste 
lorsque vous créez une piste MIDI, car elle ne 
gère pas les données audio.

Pistes d'instrument

Les pistes d'instrument sont un type particulier 
de piste qui associe les fonctionnalités MIDI et 
audio dans une seule voie de console. Les pistes 
d'instrument simplifient l'utilisation des 
instruments logiciels et matériels pour 
enregistrer et écouter des instruments MIDI.

Format des pistes

Pistes mono

Une piste audio mono, d'entrée auxiliaire, de 
fader principal ou d'instrument contrôle le 
volume et, dans certains cas, le panoramique 
d'un canal audio unique. Une piste mono audio 
utilise une seule voix. Il est possible, en outre, de 
l'affecter à une sortie multicanal.

Pistes stéréo

Une piste audio mono, d'entrée auxiliaire, de 
fader principal ou d'instrument correspond à 
une voie de console unique, mais lit deux 
canaux audio sous forme d'une paire stéréo. 
Les pistes audio stéréo utilisent deux voix. 

Pistes multicanaux (Pro Tools HD uniquement)

Une piste multicanal correspond à une voie de 
console unique, lisant plusieurs canaux audio 
(3 à 8 canaux simultanément). Ceci permet à 
Pro Tools de prendre en charge les formats de 
mixage multicanaux, tels que LCRS, 5.1, 6.1, etc. 
Les pistes audio, d'entrée auxiliaire, de fader 
principal ou d'instrument sont compatibles avec 
tout format multicanal pris en charge.

Pour plus d'informations sur le mixage Surround 
avec Pro Tools, reportez-vous aux chapitres 
suivants :

• chapitre 32, Configuration de Pro Tools pour 
le mixage en mode Surround (Pro Tools HD 
uniquement)

• chapitre 33, Pistes multicanaux et assignation 
des signaux (Pro Tools HD uniquement)

• chapitre 34, Panoramique et mixage en mode 
Surround (Pro Tools HD uniquement)

Pour plus d'informations, reportez-vous à la 
section Pistes de VCA principal, page 727.
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Voies de piste

Voies de piste audio

Chaque piste audio possède son propre jeu de 
commandes de voies pour le volume, le 
panoramique, la préparation à l'enregistrement, 
l'écoute des signaux d'entrée (Pro Tools HD 
uniquement), le mode d'automation, la mise en 
solo/coupure de son et l'assignation de voix. Les 
pistes audio possèdent également une vue 
Comments dans laquelle s'affichent les 
commentaires saisis.

Voies de piste d'entrée auxiliaire

Chaque piste d'entrée auxiliaire dispose de son 
propre jeu de commandes de voies pour le 
volume, le panoramique, le mode d'automation, 
la mise en solo et la coupure de son. Les pistes 
d'entrée auxiliaire offrent également une vue 
Comments dans laquelle s'affichent les 
commentaires saisis.

Voies de piste audio de format mono

Inserts

Départs (illustration des départs A–E)

Sélecteurs de chemin d'entrée/de 
sortie audio

Boutons de mise en solo et de coupure du son

Sélecteur de mode d'automation

Bouton du nom de piste

Curseur de panoramique

Vumètre de niveau

Fader de volume

Identification du groupe

Bouton de la fenêtre Output

Commentaires de la piste

Indicateur du type de piste

Sélecteur de voix

Bouton de préparation à 
l'enregistrement de piste

Indicateur de volume/crête/retard

Indicateur de panoramique

Vue de compensation de retard 
(Pro Tools HD uniquement)

Bouton d'écoute TrackInput 
(Pro Tools HD uniquement)

Codage couleur de la piste
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Voies de pistes de fader principal

Chaque piste de fader principal dispose de son 
propre jeu de commandes de voies pour le 
volume et le mode d'automation. Les pistes de 
fader principal possèdent également une vue 
Comments dans laquelle s'affichent les 
commentaires saisis.

Voies de pistes de VCA principal

(Pro Tools HD uniquement)

Chaque piste de VCA principal dispose de son 
propre jeu de commandes de voies pour le 
volume, la préparation à l'enregistrement, 
l'écoute des signaux d'entrée, le mode 

Voie de piste d'entrée auxiliaire stéréo

Inserts

Départs (illustration des départs A–E)

Sélecteurs de chemin d'entrée/de 
sortie audio

Boutons de mise en solo et de 
coupure du son

Sélecteur de mode d'automation

Bouton du nom de piste

Curseurs de panoramique

Vumètres de niveau

Fader de volume

Identification du groupe

Commentaires de la piste

Indicateur du type de piste

Indicateur de volume/crête/retard

Indicateurs de panoramique

Vue de compensation de retard 
(Pro Tools HD uniquement)

Codage couleur de la piste

Bouton de la fenêtre Output

Voie de piste de fader principal stéréo

Inserts

Sélecteurs de chemin de sortie audio

Sélecteur de mode d'automation

Bouton du nom de piste

Vumètres de niveau

Fader de volume

Identification du groupe

Commentaires de la piste

Indicateur du type de piste

Indicateur de volume/crête/retard
Vue de compensation de retard 
(Pro Tools HD uniquement)

Codage couleur de la piste

Bouton de la fenêtre Output
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d'automation, la mise en solo et la coupure de 
son. Les pistes de VCA principal possèdent 
également une vue Comments dans laquelle 
s'affichent les commentaires saisis.

Voies de pistes MIDI

Chaque piste MIDI dispose de son propre jeu de 
commandes de voies pour le volume MIDI, le 
panoramique, la préparation à l'enregistrement, 
le mode d'automation, la mise en solo, la 
coupure de son, l'affectation de patch et 
l'affectation de canal. Les pistes MIDI possèdent 
également une vue Comments dans laquelle 
s'affichent les commentaires saisis.

Pour plus d'informations, reportez-vous à la 
section Pistes de VCA principal, page 727.

Piste de VCA principal

Sélecteur d'assignation 

Indicateurs du type de 
piste VCA

Identification de groupe VCA

Mute

TrackInput 

Volume

Mise en 
solo

Activa-
tion de 
l'enregis-
trement

Vumètre de niveau

de groupe

Voie MIDI

Sélecteur d'entrée MIDI

Fader de volume MIDI

Curseur de panoramique MIDI

Bouton du nom de piste

Vumètre de vitesse MIDI

Sélecteur de mode d'automation

Sélecteur de sortie MIDI

Activation de l'enregistrement

Sélection de patch

Indicateur de panoramique MIDI

Indicateur de volume MIDI

Indicateur du type de piste

Identification du groupe

Commentaires de la piste

Boutons de mise en solo et de 
coupure du son

Codage couleur de la piste
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Voies de pistes d'instrument

Chaque piste d'instrument dispose de son 
propre jeu de commandes de voies pour l'audio 
(piste d'entrée auxiliaire, par exemple), le 
volume, le panoramique, le mode d'automation, 
la mise en solo, la coupure de son et la 
préparation à l'enregistrement MIDI (piste 
MIDI, par exemple). Les pistes d'instrument 
offrent une vue supplémentaire, la vue 
Instruments, qui contient les commandes MIDI 
d'entrée et de sortie, de coupure de son, de 
volume et de panoramique (comme sur une 
piste MIDI). Les pistes d'instrument possèdent 
également une vue Comments dans laquelle 
s'affichent les commentaires saisis. 

Voie de la piste d'instrument stéréo

Inserts

Départs

Sélecteurs de chemin d'entrée/de 
sortie audio

Boutons de mise en solo et de coupure du son

Sélecteur de mode d'automation

Nom de la piste

Curseurs de panoramique

Vumètres de niveau

Fader de volume

Identification du groupe

Bouton de la fenêtre Output

Commentaires de la piste

Indicateur du type de piste

Indicateur de volume/crête/retard

Indicateurs de panoramique

Vue de compensation de retard 
(Pro Tools HD uniquement)

Activation de l'enregistrement

Sélection de patch

Sélecteur d'entrée MIDI

Sélecteur de sortie MIDI

Vumètre de vitesse MIDI

Volume MIDI

Curseur de 

Bouton de coupure de son MIDI

Codage couleur de la piste
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Commandes et indicateurs 
des pistes

Sélecteurs d'entrée/sortie

La vue I/O affiche les sélecteurs d'entrée et de 
sortie sur les pistes audio, d'entrée auxiliaire, de 
fader principal (sortie seulement), MIDI et 
d'instrument.

Pour afficher la vue I/O dans la fenêtre Edit :

" Choisissez View > Edit Window > I/O.

Indicateur de 
volume/crête/retard du canal

L'indicateur de volume d'une piste audio 
possède trois modes : volume, crête et retard du 
canal.

Pour changer le mode d'affichage de l'indicateur 
de volume :

" Pour basculer d'un mode à l'autre, maintenez 
la touche Pomme (Mac) ou Ctrl (Windows) 
enfoncée pendant que vous cliquez sur ce 
bouton.

Indicateur de volume (et fader contextuel) : 
affiche le niveau du volume actuel ou d'entrée 
d'une piste, défini par le fader de volume de la 
piste. Dans la vue I/O (fenêtre Edit), cliquez sur 
l'indicateur de volume pour afficher le fader 
contextuel qui permet de régler le volume.

Indicateur de crête : fonctionne comme 
indicateur de la marge de sécurité, référencé au 
dernier niveau de crête rencontré en cours de 
lecture. Pour réinitialiser le compteur de crête, 
cliquez n'importe où sur l'afficheur. Les valeurs 
sont comprises entre –∞ (aucun signal) et 0 dB. 

Indicateur de retard du canal : affiche le retard 
total, en échantillons, subi sur la piste, dû à 
l'utilisation de plug-in TDM sur ce canal. 

Fenêtre Edit – vue I/O (piste audio)

Pour plus d'informations sur les autres vues 
de pistes, reportez-vous à la section Vues 
dans les fenêtres Mix et Edit, page 731.

Les voies de la fenêtre Mix affichent 
toujours les sélecteurs d'entrée et de sortie, 
ainsi que les valeurs de volumes et de 
panoramiques ; la fenêtre Mix ne contient 
par conséquent pas d'option d'affichage de 
la vue I/O.

Pour plus d'informations sur les sélecteurs 
d'entrée et de sortie, reportez-vous à la 
section Assignation d'entrées et de sorties à 
des pistes, page 156.

Sélecteur de chemin 
d'entrée
Sélecteur de chemin 
de sortie
Indicateur de volume
Indicateur de 
panoramique

Bouton de la fenêtre 
Output

Fader contextuel du volume (piste audio) de la vue I/O 
(fenêtre Edit)
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Indicateur de panoramique

L'indicateur de panoramique affiche le 
paramètre actuel de panoramique d'une piste. 
Les valeurs de panoramique s'étendent de <100 
(à l'extrême gauche) à 100> (à l'extrême droite). 
Les commandes de panoramique ne sont 
disponibles que pour les pistes stéréo ou les 
pistes mono assignées à une sortie stéréo.

Dans la vue I/O (fenêtre Edit), cliquez sur 
l'indicateur de panoramique pour afficher le 
curseur contextuel qui permet de régler le 
panoramique.

Curseur de panoramique

Le curseur de panoramique contrôle la balance 
d'une piste sur la paire de sorties qui lui est 
affectée. Il n'apparaît que si vous utilisez des 
pistes stéréo ou des pistes mono envoyées vers 
une sortie stéréo.

Le curseur de panoramique d'une piste MIDI ne 
fonctionne que si vous contrôlez un générateur 
de sons qui prend en charge le panoramique 
MIDI.

Fader de volume

Le fader de volume de la piste contrôle le 
volume d'une piste lorsqu'elle est en lecture, et 
son niveau d'écoute lorsqu'elle est en 
enregistrement. Vous pouvez relier les niveaux 
de retour et de lecture en activant la préférence 
de fonctionnement « Link Record and Play 
Faders ».

Le gain de fader maximum pour un fader de 
volume est de +12 dB.

Fader de volume MIDI

Si votre générateur de sons MIDI prend en 
charge le volume, le fader de volume sur une 
piste MIDI ou une piste d'instrument peut 
transmettre une valeur comprise entre 0 et 127 
au contrôleur de volume MIDI.

Vumètre de piste

Sur les pistes audio, les afficheurs de niveau 
(vumètres) indiquent le niveau du signal en 
cours d'enregistrement ou de lecture sur le 
disque dur. Sur les pistes d'entrée auxiliaire, de 
fader principal et d'instrument, les afficheurs de 
niveau (vumètres) indiquent le niveau du signal 
en cours de lecture sur la sortie du canal. Le vert 
indique les niveaux nominaux ; le jaune indique 
le pré-écrêtage (–6 dB en dessous du signal 
pleine échelle) ; le rouge indique le signal pleine 
échelle/écrêtage. Lorsqu'une piste audio est 
préparée en enregistrement, son vumètre 
indique les niveaux d'enregistrement.

Sur les pistes MIDI, le vumètre indique la 
vélocité MIDI de l'événement MIDI le plus 
récent.

Curseur contextuel du panoramique (piste audio) de la 
vue I/O (fenêtre Edit)

Les commandes de panoramique de départ 
peuvent être liées aux commandes de 
panoramique principales d'une piste en 
activant le bouton Follow Main Pan dans la 
fenêtre Send.
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Visualisation des niveaux pré ou post-fader

Vous pouvez définir globalement les vumètres 
des pistes audio pour qu'ils indiquent les 
niveaux pré- ou post-fader. Lorsque l'option 
Pre-Fader Metering est sélectionnée, les 
afficheurs de niveau indiquent les niveaux avant 
fader (c'est-à-dire indépendamment de la 
position du fader). Avec l'option Post-Fader 
Metering, les niveaux des vumètres suivent les 
évolutions du fader.

Pour basculer entre les modes pré et post-fader 
des vumètres :

" Choisissez Options > Pre-Fader Metering.

Gel de crêtes

Les vumètres de Pro Tools disposent d'une 
fonction de gel de crêtes, dotée de trois options : 
3 secondes, infini, ou aucun.

Pour choisir un réglage de gel de crête :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Display.

2  Sélectionnez une option de gel de crête 
(Peak Hold).

3  Cliquez sur OK.

Pour réinitialiser un vumètre :

" Cliquez n'importe où sur le vumètre. 

Pour réinitialiser tous les vumètres, effectuez 
l'une des opérations suivantes :

" Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée pendant que vous cliquez 
sur un vumètre.

" Sélectionnez Track > Clear All Clip Indicators.

" Appuyez sur Option+C (Mac) ou sur Alt+C 
(Windows).

Indication d'écrêtage

Les vumètres de Pro Tools disposent d'une 
indication d'écrêtage dotée de trois options. 
3 secondes, infini, ou aucune. Si un écrêtage 
survient, le voyant supérieur du vumètre reste 
allumé (en rouge).

Pour choisir un paramètre d'indication 
d'écrêtage :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Display.

2  Sélectionnez une option d'indication 
d'écrêtage (Clip Indication).

3  Cliquez sur OK.

Pour supprimer un indicateur d'écrêtage :

" Cliquez n'importe où sur le vumètre. 

Pour supprimer tous les indicateurs d'écrêtage, 
effectuez l'une des opérations suivantes :

" Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée pendant que vous cliquez 
sur un vumètre.

" Sélectionnez Track > Clear All Clip Indicators.

" Appuyez sur Option+C (Mac) ou sur Alt+C 
(Windows).

Vue large des vumètres

L'option Wide Meters View permet de 
sélectionner un affichage plus large des 
vumètres de pistes dans les fenêtres Mix et Edit, 
les niveaux indiqués par les vumètres étant ainsi 
plus faciles à lire. Cet affichage est également 
possible dans la vue « réduite » de la fenêtre Mix.

Des indicateurs d'écrêtage apparaissent 
dans les fenêtres de plug-in, de départ et de 
piste.
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Pour activer ou désactiver la vue large des 
vumètres :

" Maintenez enfoncées les touches 
Pomme+Option+Ctrl (Mac) ou 
Ctrl+Démarrer+Alt (Windows) pendant que 
vous cliquez sur les vumètres de la piste dans la 
fenêtre Edit ou Mix.

Réglage de la largeur des 
pistes
Fenêtre Mix

La commande Narrow Mix permet d'afficher 
l'ensemble des pistes ou des canaux de la fenêtre 
Mix en largeur réduite afin de conserver de 
l'espace à l'écran dans une session de grande 
taille. Pour savoir comment régler la hauteur des 
pistes dans la fenêtre Edit, reportez-vous à la 
section Hauteur de la piste, page 397.

Pour réduire la largeur des pistes dans la 
fenêtre Mix :

" Choisissez View > Narrow Mix.

Pour afficher les pistes à leur largeur normale :

" Désélectionnez View > Narrow Mix.

Création de pistes
Sur tous les systèmes, vous pouvez créer des 
pistes mono et stéréo. Avec Pro Tools HD, vous 
êtes également libre de créer des pistes 
multicanaux (pistes LCR à 7.1).

Lorsque de nouvelles pistes sont définies, elles 
reçoivent un nom par défaut, qui peut 
cependant être modifié à tout moment.

! Pour insérer de nouvelles pistes à côté d'une 
piste donnée dans une session, sélectionnez 
cette piste en cliquant sur son nom dans la 
fenêtre Mix ou Edit avant d'ouvrir la boîte de 
dialogue New Tracks. Les nouvelles pistes 
viennent s'ajouter immédiatement après la piste 
sélectionnée. 

! Pour insérer de nouvelles pistes après la 
dernière piste d'une session, assurez-vous 
qu'aucun nom de piste n'est sélectionné à 
l'écran avant d'ouvrir la boîte de dialogue 
New Tracks

Vue large des vumètres dans les fenêtres Mix et Edit

Vous pouvez changer la largeur des pistes en 
appuyant sur la touche Ctrl+Alt+M 
(Windows) ou Pomme+Option+M (Mac).

Vous pouvez également ajouter des pistes à 
votre session en les important à partir de 
sessions qui existent déjà. Pour plus 
d'informations, consultez la section 
Importation de pistes et de leurs attributs, 
page 255.
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Pour créer des pistes :

1  Choisissez Track > New.

2  Dans le menu contextuel Track Type, 
sélectionnez le type de piste que vous souhaitez 
ajouter. 

3  Sélectionnez le format de piste (mono, stéréo 
ou l'un des formats Surround multicanaux) dans 
le menu contextuel Track Format. Les formats 
Surround ne sont disponibles que pour les 
systèmes Pro Tools|HD.

4  Sélectionnez la règle temporelle (échantillons 
ou tics) dans le menu contextuel Track 
Timebase.

5  Entrez le nombre de nouvelles pistes.

6  Si vous le souhaitez, procédez de la manière 
suivante :

• Pour ajouter d'autres pistes, cliquez sur le 
bouton Add Row.

– ou –

• Pour supprimer la piste précédente, il suffit 
de cliquer sur le bouton Remove Row.

7  Pour réorganiser les pistes, cliquez sur l'icône 
Move Row et faites la glisser vers le haut ou vers 
le bas.

8  Cliquez sur Create.

Attribution de noms aux pistes

Les noms des pistes servent aussi à nommer 
automatiquement des fichiers audio et des 
régions (voir Nom des pistes par défaut, 
page 310).

Boîte de dialogue New Tracks

Pour faire défiler automatiquement le menu 
contextuel Track Type de la boîte de 
dialogue New Tracks, appuyez sur Pomme 
(Mac) ou sur Ctrl (Windows), puis utilisez 
les touches fléchées Haut/Bas.

Pour faire défiler automatiquement le menu 
contextuel Track Format, appuyez sur la 
touche Pomme (Mac) ou Ctrl (Windows) et 
utilisez les touches fléchées Gauche/Droite.

Pour faire défiler automatiquement le menu 
contextuel Track Timebase, appuyez sur la 
combinaison de touches Pomme+Option 
(Mac) ou Ctrl+Alt (Windows) et utilisez les 
touches fléchées Haut/Bas.

Nombre de nouvelles pistes

Format des pistes

Type de piste

Timeline de la piste

Ajouter/supprimer une ligne

Vous pouvez également ajouter une 
nouvelle piste en appuyant sur Ctrl+N 
(Windows) ou Pomme+N (Mac). 
Pour supprimer une piste dans la boîte de 
dialogue New Tracks, appuyez sur 
Ctrl+moins (–) (Windows) ou 
Pomme+moins (–) (Mac).

Icône Move Row dans la boîte de dialogue New Tracks

Boîte de dialogue Track Name/Comments

Icône Move Row
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Pour renommer une piste :

1  Effectuez l'une des opérations suivantes :

• Dans les fenêtres Mix ou Edit, cliquez deux 
fois sur le bouton du nom de la piste que 
vous voulez renommer.

– ou –

• Dans la liste des pistes ou dans la fenêtre 
Mix ou Edit, cliquez avec le bouton droit de 
la souris sur le nom de la piste à renommer.

2  Dans la boîte de dialogue Track 
Name/Comments, tapez un nouveau nom.

3  Cliquez sur Previous ou sur Next pour 
renommer d'autres pistes affichées.

4  Cliquez sur OK.

Ajout de commentaires à des pistes

Pour entrer des commentaires pour une piste, 
effectuez l'une des opérations suivantes :

" Depuis la voie de piste, cliquez directement 
sur la zone Comments, entrez le commentaire et 
appuyez sur Entrée (Windows) ou Retour (Mac). 

– ou –

" Dans les fenêtres Edit ou Mix, cliquez deux 
fois sur le bouton du nom de la piste souhaitée. 
Cliquez ensuite directement dans la zone 
Comments, entrez le commentaire pour la 
piste et appuyez sur Entrée (Windows) ou 
Retour (Mac). 

Numérotation des pistes

Avec l'option Track Numbers View activée, 
chaque piste reçoit un numéro correspondant à 
sa position dans les fenêtres Mix et Edit. 
Lorsque l'ordre des pistes change, celles-ci sont 
renumérotées pour que le nouvel ordre puisse 
être conservé.

Pour activer l'option d'affichage des numéros 
de piste :

" Choisissez View > Track Number.

Pour accéder directement au numéro de piste de 
votre choix :

1  Effectuez l'une des opérations suivantes :

• Choisissez Track > Scroll to Track.

– ou –

• Appuyez sur Pomme+Option+G (Mac) ou 
sur Ctrl+Alt+G (Windows).

2  Dans la boîte de dialogue Scroll To Track, 
entrez le numéro de position de la piste

3  Cliquez sur OK.

Pour passer à la piste précédente ou 
suivante dans la boîte de dialogue Track 
Name/Comments, appuyez sur la touche 
Pomme (Mac) ou Ctrl (Windows) et utilisez 
les touches fléchées Haut et Bas ou Gauche 
et Droite.

Pour entrer un retour chariot dans la zone 
Comments, appuyez sur les touches 
Maj+Retour (Mac) ou Maj+Entrée 
(Windows) du clavier AZERTY.

Boîte de dialogue Scroll To Track
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La piste est sélectionnée et les fenêtres défilent 
comme suit :

• Les pistes de la fenêtre Mix défilent pour 
afficher la piste sélectionnée le plus 
possible à gauche. 

• Les pistes de la fenêtre Edit défilent pour 
afficher la piste sélectionnée le plus près 
possible du haut. 

Sélection des pistes

Pour réaliser certaines opérations, comme la 
duplication de pistes ou l'ajout de pistes à un 
groupe, il est indispensable de sélectionner des 
pistes. Il est possible de sélectionner une ou 
plusieurs pistes à la fois.

Pour sélectionner une piste :

" Cliquez sur le nom d'une piste qui n'est pas en 
surbrillance dans la voie de la piste.

Pour sélectionner un ensemble de pistes :

1  Cliquez sur le nom d'une piste qui n'est pas en 
surbrillance dans la voie de la piste.

2  Tout en maintenant la touche Maj enfoncée, 
cliquez sur un bouton de nom de piste 
supplémentaire.

Toutes les pistes comprises entre la première 
piste et la piste supplémentaire seront 
également sélectionnées.

Pour sélectionner ou désélectionner des pistes 
non contiguës, effectuez l'une des opérations 
suivantes :

" Maintenez enfoncée la touche Ctrl (Windows) 
ou Pomme (Mac) et cliquez sur les boutons de 
nom de piste qui ne sont pas en surbrillance 
pour les sélectionner.

– ou –

" Maintenez enfoncée la touche Ctrl (Windows) 
ou Pomme (Mac) et cliquez sur les boutons de 
nom de piste qui sont en surbrillance pour les 
désélectionner.

Pour sélectionner toutes les pistes :

" Maintenez la touche Alt (Windows) ou 
Option (Mac) enfoncée pendant que vous 
cliquez sur un bouton de nom de piste qui n'est 
pas en surbrillance.

Pour désélectionner toutes les pistes :

" Maintenez la touche Alt (Windows) ou 
Option (Mac) enfoncée pendant que vous 
cliquez sur un bouton de nom de piste qui est en 
surbrillance.

Sélection des pistes lors d'une sélection 
d'édition

Pro Tools permet de lier les sélections d'éditions 
et les sélections de pistes. Lorsque les sélections 
d'édition et de piste sont liées, vous pouvez 
effectuer une sélection dans une ou plusieurs 
pistes à des fins d'édition ; chaque piste est 
sélectionnée (les noms des pistes s'affichent 
automatiquement en surbrillance). 

Pour lier la sélection d'édition et la sélection 
de piste :

" Choisissez Options > Link Track and Edit 
Selection.
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Affichage d'une piste par défilement

(Pro Tools HD uniquement)

Pour afficher une piste en la faisant défiler :

" Dans la liste des pistes ou dans la fenêtre Mix 
ou Edit, cliquez avec le bouton droit de la souris 
sur le nom de la piste à afficher.

La piste est sélectionnée et les fenêtres défilent 
comme suit :

• Les pistes de la fenêtre Mix défilent pour 
afficher la piste sélectionnée le plus 
possible à gauche. 

• Les pistes de la fenêtre Edit défilent pour 
afficher la piste sélectionnée le plus près 
possible du haut. 

Suppression de pistes

Lorsque vous supprimez des pistes, les données 
de vos régions audio ou MIDI restent dans la 
liste des régions, mais la disposition des régions 
de la piste supprimée (autrement dit, la playlist 
de la piste) est perdue. 

Si la piste contient des playlists qui ne sont 
affectées à aucune piste, vous êtes invité à les 
supprimer ou à les conserver.

Pour supprimer une piste :

1  Cliquez sur le nom de la piste souhaitée (dans 
sa voie de piste) pour la sélectionner. 

2  Effectuez l'une des opérations suivantes :

• Choisissez Track > Delete.

– ou –

• Dans la liste des pistes ou dans la fenêtre 
Mix ou Edit, cliquez avec le bouton droit de 
la souris sur le nom de la piste et choisissez 
Delete.

3  Cliquez sur OK pour supprimer les pistes 
sélectionnées de la session.

Duplication de pistes

La commande Duplicate Track permet de 
dupliquer une ou plusieurs pistes, y compris 
leurs données audio ou MIDI, les playlists, les 
automations et autres attributs.

Pour dupliquer une ou plusieurs pistes :

1  Sélectionnez les pistes qui vous intéressent.

2  Effectuez l'une des opérations suivantes :

• Choisissez Track > Duplicate. 

• Appuyez sur les touches Alt+Maj+D 
(Windows) ou Option+Maj+D (Mac).

• Dans la liste des pistes ou dans la fenêtre 
Mix ou Edit, cliquez avec le bouton droit de 
la souris sur le nom de la piste et choisissez 
Duplicate.

La commande Delete Track ne peut pas être 
annulée.

Pour sélectionner plusieurs pistes, 
maintenez la touche Pomme (Mac) ou Ctrl 
(Windows) enfoncée tout en cliquant sur les 
noms des pistes.

Pour sélectionner une série de pistes, cliquez 
sur les noms des pistes en maintenant la 
touche Maj enfoncée.

Pour plus d’informations, consultez la 
section Sélection des pistes, page 149.
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3  Dans la boîte de dialogue Duplicate Tracks, 
configurez les options suivantes selon vos 
besoins :

• Entrez le nombre de copies à créer dans le 
champ Number of Duplicates. 

• Pour copier la playlist d'édition active 
(visible) à partir de la piste source, activez 
Active Playlist. 

• Pour copier les playlists d'édition sur la 
piste source, activez Alternate Playlists.

• Pour copier toutes les automations à partir 
de la piste source, activez Automation. 

• Pour copier toutes les affectations de 
plug-in et d'insert, activez Inserts. 

• Pour copier l'ensemble des départs et des 
affectations de départ, activez Sends.

• Pour conserver toutes les affectations de 
groupes de mixage et d'édition, activez 
Group Assignments. 

4  Pour dupliquer plusieurs pistes, procédez 
comme suit :

• Si vous voulez que toutes les pistes 
récemment créées suivent la dernière piste 
source sélectionnée (à l'extrême droite de la 
fenêtre Mix et en bas de la fenêtre Edit), 
activez l'option Insert after Last Selected 
Track.

– ou –

• Si vous souhaitez que chaque piste 
récemment créée soit insérée directement 
après sa piste source, désactivez l'option.

5  Cliquez sur OK pour dupliquer les pistes 
conformément aux paramètres de la boîte de 
dialogue Duplicate Tracks. Cliquez sur Cancel 
pour fermer la boîte de dialogue et éviter de 
créer des doubles des pistes. 

Dans la fenêtre Mix, chaque piste dupliquée est 
créée à droite de la piste d'origine. Dans la 
fenêtre Edit, chaque piste dupliquée est créée 
sous la piste d'origine. Lors de la duplication de 
plusieurs pistes, vous pouvez également décider 
que les nouvelles pistes soient conformes à la 
dernière piste sélectionnée (ou que toute 
nouvelle piste soit conforme à la piste source).

Duplication des pistes esclaves VCA

(Pro Tools HD uniquement)

Le fait de dupliquer une piste esclave VCA (sans 
dupliquer ses affectations de groupe) a pour effet 
de fusionner les éventuelles automations sur la 
piste dupliquée. La lecture de la piste dupliquée 
fusionnée se déroule comme si elle faisait partie 
du groupe VCA. 

Boîte de dialogue Duplicate Tracks
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Liste de pistes
La liste des pistes, dans la partie gauche des 
fenêtres Mix et Edit, présente toutes les pistes de 
la session. Elle permet d'afficher ou de masquer 
une piste en sélectionnant ou désélectionnant 
son nom dans les fenêtres Mix et Edit. Même 
lorsqu'une piste est masquée, les données qu'elle 
contient sont lues dans le cadre de la session. 
Les pistes inactives apparaissent en italiques 
dans la liste des pistes.

Bouton Show/Hide Track List/Group 
List View

Pour afficher (ou masquer) la liste des pistes (et la 
liste des groupes) :

" Cliquez sur le bouton Show/Hide Track 
List/Group List View dans la fenêtre Mix ou Edit.

Menu déroulant de la liste des pistes

Le menu contextuel situé en haut de la liste des 
pistes contient des commandes permettant 
d'afficher ou de masquer toutes les pistes, les 
pistes actuellement sélectionnées à l'écran ou 
des types de pistes particuliers (audio, entrée 
auxiliaire, fader principal, MIDI ou instrument).

La liste des pistes peut également servir à 
créer des pistes lors de l'importation de 
médias à partir de DigiBase. Pour plus 
d'informations, consultez la section 
Importation d'éléments avec la fonction 
glisser-déposer, page 263. 

Liste des pistes

Menu contextuel de la liste des pistes

Nom de la 
piste

Icône du 
type de piste

Code 
couleur de la 

piste

Numéro de la piste

Liste des pistes affichée dans la fenêtre Edit

Option Show Only

Bouton Show/Hide Track List/Group List View
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La commande de tri des pistes (Sort Tracks By) 
permet de classer les pistes en fonction de 
différents critères (nom, type, groupe d'édition, 
groupe de mixage ou voix). L'ordre de tri choisi 
est répercuté dans la liste des pistes de la fenêtre 
Mix ou Edit.

Lorsqu'une piste appartenant à un groupe actif 
est masquée, elle n'est pas affectée par les 
opérations d'édition effectuées sur les autres 
membres du groupe dans la fenêtre Edit. Dans la 
fenêtre Mix, en revanche, une piste masquée 
appartenant à un groupe actif est concernée par 
toutes les opérations autres que la préparation à 
l'enregistrement.

Pour masquer une piste, effectuez l'une des 
opérations suivantes :

" Cliquez sur le nom d'une piste en surbrillance 
dans la liste des pistes.

– ou –

" Dans la liste des pistes ou dans la fenêtre Mix 
ou Edit, cliquez avec le bouton droit de la souris 
sur le nom de la piste et choisissez Hide (ou Hide 
and Make Inactive si la piste est active et que 
vous souhaitez également la rendre inactive).

Pour afficher une piste actuellement masquée, 
effectuez l'une des opérations suivantes :

" Cliquez sur le nom d'une piste qui n'est pas en 
surbrillance dans la liste des pistes.

– ou –

" Dans la liste des pistes ou dans la fenêtre Mix 
ou Edit, cliquez avec le bouton droit de la souris 
sur le nom de la piste et choisissez Show (ou 
Show and Make Active si la piste est inactive et 
que vous souhaitez également la rendre active).

Pour afficher toutes les pistes :

" Cliquez sur le menu contextuel de la liste des 
pistes et choisissez Show All Tracks.

Pour masquer toutes les pistes :

" Cliquez sur le menu contextuel de la liste des 
pistes et choisissez Hide All Tracks.

Option Sort Tracks By

Sur les systèmes Pro Tools HD, même si une 
piste est masquée, sa position par rapport 
aux autres pistes affecte la priorité de sa 
lecture en tant que piste pouvant héberger 
des voix (voir Emprunt des voix, page 162 
pour plus de détails).

Vous pouvez également afficher toutes les 
pistes en maintenant la touche Alt 
(Windows) ou Option (Mac) enfoncée 
pendant que vous cliquez sur le nom d'une 
piste sans surbrillance.

Vous pouvez également masquer toutes les 
pistes en maintenant la touche Alt 
(Windows) ou Option (Mac) enfoncée 
pendant que vous cliquez sur le nom d'une 
piste en surbrillance ou en cliquant sur un 
symbole de piste à gauche d'un nom de piste 
en surbrillance.

Pour réorganiser les pistes à l'écran, faites 
glisser les noms des pistes vers leurs 
nouvelles positions dans la liste des pistes 
ou dans la fenêtre Mix ou Edit.
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Pour afficher une série de pistes :

1  Cliquez sur le nom d'une piste sans 
surbrillance dans la liste des pistes.

2  Cliquez sur un autre nom de piste tout en 
appuyant sur la touche Maj.

Tous les noms compris entre le premier nom de 
piste sélectionné et le nom de piste 
supplémentaire sont automatiquement pris en 
compte.

Pour afficher ou masquer une série de pistes dans 
la liste des pistes à l'aide du rectangle de 
sélection :

1  Appuyez sur la touche Pomme (Mac) ou Ctrl 
(Windows) et maintenez-la enfoncée.

2  Déplacez le curseur à gauche du nom d'une 
piste jusqu'à ce que le rectangle de sélection avec 
le symbole + s'affiche.

• Pour afficher les pistes, le rectangle de 
sélection doit se trouver à gauche d'un nom 
d'une piste sans surbrillance.

• Pour masquer les pistes, le rectangle de 
sélection doit se trouver à gauche du nom 
d'une piste en surbrillance.

3  Cliquez sur un nom de piste et faites-le glisser 
vers le haut ou vers le bas (pour masquer ou 
afficher la piste et les pistes placées 
imédiatement au-dessus ou au-dessous d'elle).

Pour afficher ou masquer des pistes non 
contiguës, effectuez l'une des opérations 
suivantes :

" Cliquez sur les noms de piste (qui ne sont pas 
en surbrillance) pour les sélectionner.

– ou –

" Cliquez sur les noms de piste (qui sont en 
surbrillance) pour les désélectionner.

A propos des groupes d'édition et de 
mixage et des pistes masquées

Si elles appartiennent à un groupe activé, les 
pistes masquées seront concernées par toutes les 
opérations de la fenêtre Mix effectuées sur 
d'autres membres du groupe (à l'exception des 
opérations de préparation à l'enregistrement 
audio ou MIDI). Si vous appliquez des 
commandes de mise en solo, de coupure de son 
ou d'activation en enregistrement de 
l'automation à une piste groupée, tous les 
membres masqués du groupe seront également 
concernés par ces commandes. 

Dans la fenêtre Edit, cependant, les opérations 
d'édition effectuées sur les membres d'un groupe 
activé n'affectent pas les pistes masquées de ce 
groupe. 

A propos de l'écrêtage et de la liste des 
pistes

(Pro Tools HD uniquement)

En cas d'écrêtage de piste, plug-in ou départ, le 
nom de la piste figure en rouge dans la liste des 
pistes. Les pistes affichées et masquées affichent 
toutes des indications d'écrêtage. 

Vous pouvez également sélectionner une 
série de pistes en déplaçant le curseur à 
gauche des noms de pistes (le rectangle de 
sélection apparaît) et en entourant les 
régions que vous voulez sélectionner.
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A propos des numéros de pistes et des 
pistes cachées

Dans les fenêtres Mix et Edit, les numéros de 
position des pistes peuvent prendre en compte 
les pistes masquées dans leur séquence de 
numérotation, ou au contraire, les ignorer :

• Les numéros sont assignés uniquement aux 
pistes affichées (lorsque l'option Track 
Position Numbers Stay With Hidden Tracks 
est désactivée dans la page Display 
Preferences). Dans ce cas, les pistes actives 
sont numérotées dans l'ordre croissant. 
Les pistes masquées ne sont pas numérotées.

– ou –

• Le numéro de position des pistes masquées est 
conservé (lorsque l'option Track Position 
Numbers Stay With Hidden Tracks est activée 
dans la page Display Preferences).

Menu contextuel relatif aux 
noms des pistes-
(fenêtre Edit, fenêtre Mix ou liste des pistes)

Lorsque vous cliquez à l'aide du bouton droit de 
la souris sur le nom d'une piste dans la fenêtre 
Edit, dans la fenêtre Mix ou dans la liste des 
pistes, un menu contextuel donne accès aux 
commandes suivantes :

Hide/Show : masque (ou affiche) la piste (ou les 
pistes sélectionnées le cas échéant).

Hide and Make Inactive : masque la piste (ou les 
pistes sélectionnées le cas échéant) et la rend 
inactive.

Make Active/Inactive : inverse ou non l'état 
actif de la piste (ou de toutes les pistes 
sélectionnées dans la fenêtre Mix ou Edit 
uniquement).

Scroll Into View : fait défiler la piste vers le haut 
de la fenêtre Edit ou vers la gauche de la 
fenêtre Mix.

Send to Sibelius (pistes MIDI et d'instrument 
uniquement) : exporte les données MIDI d'une 
ou plusieurs pistes MIDI ou d'instrument et 
importe automatiquement ces données MIDI 
dans Sibelius (ou G7). Pour plus d'informations, 
reportez-vous à la section Envoi vers Sibelius, 
page 278.

Export MIDI (pistes MIDI et d'instrument 
uniquement) : exporte les données MIDI d'une 
ou plusieurs pistes MIDI ou d'instrument vers un 
fichier MIDI standard. Pour plus d'informations, 
reportez-vous à la section Exportation de 
fichiers MIDI, page 276.

Coalesce VCA Master Automation (Pro Tools HD 
uniquement) : fusionne l'automation VCA aux 
pistes esclaves de la piste VCA.

Coalesce Trim Automation (Pro Tools HD 
uniquement) : fusionne les données 
d'automation en mode Trim sur la piste (ou les 
pistes sélectionnées le cas échéant).

Clear Trim Automation (Pro Tools HD 
uniquement) : supprime les données 
d'automation en mode Trim sur la piste (ou les 
pistes sélectionnées le cas échéant).

Locked (piste vidéo uniquement) : inverse ou 
non l'état verrouillé/déverrouillé de la piste 
vidéo (ou des pistes sélectionnées le cas 
échéant).

Rename : ouvre la boîte de dialogue Track 
Name.

Duplicate : duplique la piste (ou les pistes 
sélectionnées le cas échéant).
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Split Into Mono (pistes multicanaux 
uniquement) : divise une piste multicanal (ou les 
pistes multicanaux sélectionnées le cas échéant) 
en plusieurs pistes mono.

Delete : supprime la piste (ou les pistes 
sélectionnées le cas échéant).

Expand to New Tracks : répartit sur de nouvelles 
pistes des fichiers audio multicanaux importés à 
partir d'un appareil d'enregistrement portable, 
de telle sorte que chaque canal réside sur sa 
propre piste audio mono. Pro Tools conforme 
également automatiquement toutes les pistes 
étendues aux éditions dans la piste (étendue) 
guide. Vous pouvez répartir des fichiers 
multicanaux sur de nouvelles pistes triées par 
nom de canal, par numéro de canal ou par nom 
et numéro de canal.

Assignation d'entrées et de 
sorties à des pistes
Les entrées des pistes audio, d'entrée auxiliaire et 
d'instrument peuvent être assignées à des 
canaux de l'interface audio ou à des bus. Il en est 
de même pour les sorties des pistes audio, 
d'entrée auxiliaire, de fader principal et 
d'instrument.

Pour les pistes stéréo et Surround multicanaux, 
les entrées et les sorties apparaissent par paires 
stéréo et en tant que groupes multicanaux. 
Les entrées, sorties et bus disponibles sont 
définis comme des chemins dans la boîte de 
dialogue I/O Setup (voir chapitre 6, 
Configuration des E/S). 

Assignation automatique des entrées 
et des sorties

Lorsque vous ajoutez des pistes à une nouvelle 
session, les entrées sont automatiquement 
assignées par ordre croissant. Si vous possédez, 
par exemple, une interface audio dotée de huit 
entrées, la création de quatre pistes audio mono 
ajoute automatiquement quatre pistes audio 
avec des entrées assignées aux quatre premiers 
chemins définis dans la boîte de dialogue I/O 
Setup. Lors de la création de pistes stéreo, les 
entrées sont automatiquement assignées aux 
paires d'entrées suivantes.

Les sorties assignées automatiquement aux 
nouvelles pistes sont déterminées par la sortie 
par défaut de la nouvelle piste spécifiée dans la 
boîte de dialogue I/O Setup.

Assignation des entrées vers les 
pistes audio
(pistes audio, entrées auxiliaires et pistes 
d'instrument)

Pour assigner une entrée à une piste audio :

1  Afin d'assigner des entrées de pistes audio 
dans la fenêtre Edit, choisissez View > Edit 
Window > I/O.

Assignation des entrées/sorties de trois pistes 
audio mono

Piste envoyée sur 
l'entrée audio 2

Piste envoyée sur 
le bus 2

Piste envoyée sur 
aucune d'entrée

L'entrée des pistes d'instrument est 
automatiquement acheminée vers tout 
plug-in d'instrument inséré.
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2  Dans les fenêtres Mix ou Edit, cliquez sur le 
sélecteur de chemin d'entrée de la piste et faites 
votre choix parmi les canaux de l'interface audio 
et les bus disponibles. Pour les pistes Surround 
stéréo et multicanaux, les entrées apparaissent 
par paires et dans des groupes multicanaux.

Le sélecteur de chemin d'entrée permet 
d'envoyer n'importe quelle entrée audio ou 
n'importe quel bus interne de Pro Tools vers une 
piste audio ou une piste d'entrée auxiliaire. 
Les choix disponibles dans ce menu contextuel 
sont déterminés par la configuration 
d'installation des I/O. Les entrées utilisées par 
une autre piste s'affichent en gras dans le 
sélecteur. 

Pour supprimer une assignation d'entrée :

" Sélectionnez l'option No Input dans le 
sélecteur de chemin d'entrée.

Assignation des sorties des pistes 
audio
(pistes audio, entrées auxiliaires, faders 
principaux et pistes d'instrument)

Pour assigner la sortie d'une piste audio :

1  Afin d'assigner des sorties de pistes audio dans 
la fenêtre Edit, choisissez View > Edit Window > 
I/O.

2  Dans les fenêtres Mix ou Edit, cliquez sur le 
sélecteur de chemin de sortie de la piste et 
choisissez parmi les canaux de l'interface audio 
et les bus disponibles. Pour les pistes Surround 
stéréo et multicanaux, les sorties s'affichent par 
paires et dans des chemins multicanaux.

'

Sélecteur de chemin d'entrée
Sélecteur de chemin de sortie
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Le sélecteur de chemin de sortie permet 
d'envoyer une piste vers n'importe quelle sortie 
audio ou bus interne configuré(e). Les choix 
disponibles dans ce menu contextuel sont 
déterminés par la configuration d'installation 
des I/O. Les sorties utilisées par une autre piste 
s'affichent en gras dans le sélecteur.

Pour affecter automatiquement toutes les pistes 
visibles, une par une, à des sorties de sous-chemin 
mono, par ordre croissant :

1  Assurez-vous qu'un nombre suffisant de 
sous-chemins mono est défini dans la boîte de 
dialogue I/O Setup (voir chapitre 6, 
Configuration des E/S).

2  Maintenez enfoncées les touches Ctrl+Alt 
(Windows) ou Pomme+Option (Mac), pendant 
que vous cliquez sur le sélecteur de chemin de 
sortie de la piste la plus à gauche et affectez-la au 
sous-chemin pour Output#1. Toutes les pistes 
visibles seront alors automatiquement affectées, 
une par une, à des sorties de sous-chemin mono, 
par ordre croissant.

Pour supprimer une assignation de sortie :

" Sélectionnez l'option No Input dans le 
sélecteur de chemin de sortie. Les playlists des 
pistes dépourvues d'assignation de sortie 
s'estompent.

Modification du nom des entrées 
et des sorties de pistes à partir de 
la fenêtre Edit ou Mix

Il est possible de changer le nom des chemins 
d'E/S depuis les fenêtres Edit ou Mix ou dans la 
boîte de dialogue I/O Setup.

Pour renommer un chemin d'E/S à partir de la 
fenêtre Edit ou Mix :

1  Dans la fenêtre Edit ou Mix, cliquez à l'aide du 
bouton droit de la souris sur le sélecteur d'entrée 
ou le sélecteur de sortie d'une piste et choisissez 
Rename dans le menu contextuel.

2  Dans la boîte de dialogue Rename I/O, donnez 
un nom au chemin d'E/S et cliquez sur OK.

Méthodes pour rendre les entrées 
et les sorties de pistes inactives à 
partir de la fenêtre Edit ou Mix

Il est possible de rendre les entrées et les sorties 
inactives. La désactivation d'une entrée ou d'une 
sortie de piste la coupe, tout en conservant 
toutes les données de playlist et d'automation. 
Les entrées et les sorties inactives n'utilisent pas 
de ressources pour les connexions à la console 
de mixage TDM, toutefois les plug-in assignés à 
la piste continuent d'exploiter les ressources DSP 
requises. Les plug-in RTAS utilisent les 
ressources de l'unité centrale tandis que les 
plug-in TDM utilisent les ressources DSP 
disponibles sur les cartes Pro Tools|HD. 

Lorsque vous assignez une piste audio, une 
entrée auxiliaire, un fader principal ou une 
piste d'instrument sur « No Output », ses 
données d'automation de panoramique 
ainsi que ses contrôles de plug-in sont 
perdus. 

'

Boîte de dialogue Rename I/O
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Vous pouvez rendre des entrées et des sorties de 
piste inactives (ou actives) directement depuis la 
fenêtre Edit ou Mix. Les chemins d'E/S inactifs 
sont grisés.

Pour rendre une entrée ou une sortie de piste 
inactive (ou active) à partir du menu contextuel du 
sélecteur d'E/S :

" Dans la fenêtre Edit ou Mix, cliquez à l'aide du 
bouton droit de la souris sur le sélecteur d'entrée 
ou le sélecteur de sortie d'une piste et choisissez 
Make Inactive (ou Make Active) dans le menu 
contextuel.

Pour activer/désactiver une entrée ou une sortie :

" Maintenez enfoncées les touches Pomme+Ctrl 
(Mac) ou Ctrl+Démarrer (Windows) pendant 
que vous cliquez sur le sélecteur d'entrée ou de 
sortie dans la fenêtre Mix ou Edit.

Priorité des pistes et 
assignation de voix
En fonction de la configuration de votre 
système, les systèmes Pro Tools LE fournissent 
jusqu'à 32 voix pour la lecture et 
l'enregistrement audio. Reportez-vous au 
tableau 3, page 34 pour obtenir des 
informations sur les fonctionnalités du 
système LE.

Le nombre de voix (canaux simultanés de 
lecture et d'enregistrement audio) des systèmes 
Pro Tools|HD varie en fonction de la 
configuration du système. Le système 
Pro Tools|HD 1, par exemple, peut offrir jusqu'à 
96 voix de lecture et d'enregistrement audio, 
à 44,1 ou 48 kHz. Reportez-vous au tableau 1, 
page 31 pour obtenir des informations sur les 
fonctionnalités du système Pro Tools.

Les systèmes Pro Tools LE équipés de l'option 
DV Toolkit 2 ou de l'option Music Production 
Toolkit permettent de lire ou d'enregistrer 
jusqu'à 48 pistes stéréo ou mono en simultané. 
Pour plus d'informations sur les fonctionnalités 
des systèmes avec ces options, reportez-vous à la 
section DV Toolkit 2 et Music Production 
Toolkit, page 35.

Priorité des pistes

Bien que votre dispositif Pro Tools autorise un 
nombre fixe de voix, le logiciel Pro Tools permet 
de travailler avec plus de pistes audio qu'il n'y a 
de voix. Toutes ces pistes peuvent être 
enregistrées ou importées, arrangées et 
transférées pour la lecture, mais elles ne peuvent 
pas toutes être lues simultanément. 

Lorsque les pistes de la session sont plus 
nombreuses que les voix disponibles, celles 
ayant la plus faible priorité risquent de ne pas 
être entendues. Dans de telles situations, 
Pro Tools affecte des priorités aux pistes qui 
recherchent des voix disponibles. Les pistes 
pouvant être plus nombreuses que les voix 
disponibles, Pro Tools permet de régler la 
priorité de lecture des pistes audio de plusieurs 
façons. Voir et .

Les systèmes Pro Tools|HD permettent 
également d'affecter des voix spécifiques à 
plusieurs pistes pour faire en sorte que ces voix 
soient partagées par plusieurs pistes. 
Cette fonction est désignée sous l'appellation 
d'emprunt des voix. La combinaison des pistes de 
lecture/enregistrement et des pistes de voix 
partagées constitue le nombre total de pistes 
pouvant héberger des voix sur un système 
Pro Tools|HD. 
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Pour assigner plusieurs pistes à une même voix, 
reportez-vous à la section Définition de 
l'assignation des voix, page 160. Pour plus 
d'informations sur l'emprunt de voix, 
reportez-vous à la section Emprunt des voix, 
page 162.

Changement de la priorité de lecture 
d'une piste

Les pistes avec des positions plus élevées 
(à gauche dans la fenêtre Mix, en haut de la 
fenêtre Edit) ont toujours priorité sur les pistes 
inférieures d'une session. 

Pour augmenter la priorité d'une piste, vous 
pouvez au choix :

" Dans la fenêtre Mix, faire glisser le bouton de 
nom de piste à gauche des autres pistes de la 
session. Les pistes situées à gauche de la fenêtre 
Mix possèdent une priorité plus élevée que celles 
situées à droite.

" Dans la fenêtre Edit, faire glisser le bouton de 
nom de piste au-dessus d'autres pistes de la 
session. Les pistes situées en haut de la fenêtre 
Edit ont une priorité plus élevée que celles 
situées au-dessous.

" Dans la liste des pistes, faire glisser le bouton 
de nom de piste vers une position plus élevée. 
Les pistes situées en haut de cette liste possèdent 
une priorité plus élevée que celles situées vers 
le bas.

Libération des voix sur une piste

Vous pouvez également modifier la priorité 
relative d'une piste en libérant sa voix, la 
rendant ainsi disponible pour d'autres pistes au 
sein de la session. 

Pour libérer la voix d'une piste, procédez comme 
suit :

" Cliquez sur le sélecteur de voix de la piste et 
définissez-le sur Off. Pour plus d'informations, 
consultez la section Définition de l'assignation 
des voix, page 160.

" Désactivez la piste en cliquant sur 
Ctrl+Démarrer (Windows) ou Pomme+Ctrl 
(Mac) et en cliquant sur l'icône du type de piste, 
dans la fenêtre Mix.

" Assurez-vous que la piste ne comporte pas 
d'affectation de sortie ou de départ. 

" Avec Pro Tools HD, vous pouvez libérer 
temporairement la voix d'une piste en la 
coupant au cours de la lecture (voir Option Mute 
Frees Assigned Voice, page 170).

Définition de l'assignation 
des voix

L'assignation de voix d'une piste peut être 
désactivée ou configurée en mode dynamique. 
Pro Tools HD permet en outre d'assigner un 
numéro de voix donné.

Sur tous les systèmes Pro Tools, vous pouvez 
utiliser l'option d'assignation dynamique des 
voix pour la gestion des voix en tâche de fond, 
en affectant celles qui ne sont pas utilisées par 
d'autres pistes.

Le système Pro Tools LE ne prend en charge 
que l'assignation de voix dynamique (et 
non pas l'assignation de voix individuelle).
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Avec Pro Tools HD, les pistes assignées à un 
numéro de voix donné ont la priorité sur les 
pistes en mode d'assignation dynamique de voix 
et prennent en charge l'emprunt de voix (voir 
Emprunt des voix, page 162). Pour s'assurer 
qu'une piste sera entendue ou qu'elle est 
disponible pour l'enregistrement QuickPunch, 
TrackPunch (à la volée) ou DestructivePunch, 
assignez-lui un numéro de voix spécifique.

Les voix des pistes stéréo et multicanaux 
s'affichent par paires et dans des groupes 
multicanaux. Les voix déjà assignées à une autre 
piste apparaissent en gras dans le menu 
contextuel du sélecteur de voix.

Pour définir l'assignation d'une voix à une piste :

" Cliquez sur le sélecteur de voix et définissez la 
piste sur Dyn, Off ou sélectionnez un numéro de 
voix (dans Pro Tools HD uniquement).

Assignation des voix avec les options Toolkit

(Pro Tools LE avec DV Toolkit 2 ou Music 
Production Toolkit)

Les systèmes Pro Tools LE équipés de l'option 
DV Toolkit 2 ou de l'option Music Production 
Toolkit permettent de lire ou d'enregistrer 
jusqu'à 48 pistes stéréo ou mono en simultané. 
Pour traiter un plus grand nombre de pistes, 
vous devez disposer de plusieurs disques durs et 
de systèmes agréés par Digidesign plus rapides. 

Les 48 premières pistes audio actives et 
correspond à l'assignation de voix DYN 
(Dynamically Allocated Voicing) sont lues. 
Les pistes venant après ces 48 pistes ne peuvent 
ni être lues, ni enregistrées. Leur bouton 
Dynamically Allocated Voicing vire au bleu 
pour indiquer qu'elles ne sont pas disponibles 
en lecture ou en enregistrement.

Avec Pro Tools HD, les modes QuickPunch, 
TrackPunch et DestructivePunch exigent 
des voix supplémentaires. Pour plus 
d'informations, consultez la section 
chapitre 17, Techniques d'enregistrement 
fractionné avancées.

Avec Pro Tools HD, l'insert initial d'un 
plug-in RTAS utilise des voix 
supplémentaires dans certains cas. 
Reportez-vous à la section Utilisation des 
voix et latence totale pour les plug-in RTAS, 
page 767.

Sélecteur de voix pour une piste audio stéréo 
(Pro Tools HD illustré)

Il est impossible de lire les pistes lorsqu'elles 
sont inactives ou lorsque leur assignation de 
voix est configurée sur Off.
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Lorsque vous travaillez avec plus de 48 pistes 
audio, vous pouvez lire les données audio de la 
piste 49 et des pistes suivantes en changeant la 
priorité de la piste supérieure, de la manière 
suivante :

• Rendez une piste de niveau inférieur 
inactive (cliquez sur le nom de la piste et 
choisissez Track > Make Inactive).

• Configurez l'assignation de voix d'une piste 
de niveau inférieur sur Off (cliquez sur le 
sélecteur de voix et choisissez Off).

• Faites glisser le bouton du nom de la piste 
supérieure vers la gauche (fenêtre Mix) ou 
vers le haut (dans la fenêtre Edit ou dans la 
liste des tâches) jusqu'à ce qu'elle prenne la 
place de l'une des 48 premières pistes 
audio. La 48ème piste audio deviendra 
alors la 49ème piste audio et son 
assignation de voix sera désactivée (Off).

Si l'assignation de voix de la piste 49 d'origine 
(ou d'une piste supérieure) était désactivée (Off), 
elle reprend automatiquement l'assignation 
DYN dès que vous effectuez l'une des étapes 
ci-dessus.

Assignation automatique des voix par ordre 
croissant

(Pro Tools HD uniquement)

Vous pouvez assigner automatiquement toutes 
les pistes (ou toutes les pistes sélectionnées) à 
des voix consécutives. Vous pourrez ainsi, par 
exemple, sélectionner huit pistes audio et les 
réassigner aux voix 9 à 16.

Pour assigner toutes les pistes audio à des voix 
consécutives :

" Tout en appuyant sur Pomme+Option (Mac) 
ou sur Ctrl+Alt (Windows), sélectionnez le 
numéro de voix désiré pour la première piste 
dans le sélecteur de voix à l'extrême gauche de la 
fenêtre Mix ou en haut de la fenêtre Edit.

La voix est alors assignée à la première piste, les 
voix étant assignées consécutivement aux pistes 
(de même format) de priorité inférieure. 

Pour assigner toutes les pistes audio 
sélectionnées à des voix consécutives :

1  Sélectionnez les pistes audio en appuyant sur 
la touche Ctrl (Windows) ou Option (Mac) et en 
cliquant sur leur nom.

2  Maintenez les touches Ctrl+Alt+Maj 
(Windows) ou Pomme+Option+Maj (Mac) 
enfoncées pendant que vous sélectionnez le 
numéro de voix désiré pour la première piste 
sélectionnée dans le sélecteur de voix situé à 
gauche de la fenêtre Mix ou en haut de la 
fenêtre Edit.

La voix est assignée à la piste de départ, les 
suivantes étant assignées consécutivement aux 
pistes actuellement sélectionnées (de même 
format) de priorité inférieure. 

Emprunt des voix

(Pro Tools HD uniquement)

Pro Tools HD présente une fonction d'emprunt 
des voix qui vous permet d'affecter plusieurs 
pistes à une même voix. La piste de priorité la 
plus élevée adopte cette voix. Toutefois, lors 
d'un « trou » dans une piste de priorité élevée, la 
voix ainsi libérée redevient provisoirement 
disponible : elle est alors attribuée à la piste de 
priorité la plus proche, qui « s'intercale » et est 

Pour sélectionner plusieurs pistes, 
maintenez la touche Pomme (Mac) ou Ctrl 
(Windows) enfoncée tout en cliquant 
dessus.

Pour sélectionner une série de pistes, cliquez 
sur les noms des pistes en maintenant la 
touche Maj enfoncée.
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donc lue. À la fin du « trou » dans la piste 
originale de priorité la plus élevée, la piste de 
priorité la plus proche qui avait provisoirement 
pris sa place lui restitue sa voix. 

L'exemple qui suit démontre le concept 
d'emprunt des voix :

Dans l'illustration ci-dessus, les deux pistes 
visibles sont assignées à une même voix. La piste 
du haut contient une zone ouverte, un « trou » 
dans lequel aucune région n'apparaît. La voix 
inutilisée est alors disponible et la piste de 
priorité la plus proche assignée à cette voix 
(celle du bas) s'intercale dans la zone ouverte 
pour être lue.

En permutant la priorité des pistes, l'assignation 
des voix et en disposant les régions de façon à 
bénéficier des transferts de priorité entre pistes 
lors des « trous », vous découvrirez de 
nombreuses applications utiles des pistes 
hébergeant des voix sur votre système 
Pro Tools HD.

Configuration de l'entrée et 
de la sortie MIDI
L'enregistrement et la lecture MIDI sont 
possibles sur les pistes MIDI et les pistes 
d'instrument.

Assignation d'une entrée de 
piste MIDI

Pro Tools permet d'affecter des ports et des 
canaux MIDI donnés à une entrée de piste MIDI. 
La sélection par défaut All reçoit toutes les 
données MIDI entrantes de l'ensemble des ports 
sur l'intégralité des canaux. Servez-vous du 
sélecteur d'entrée MIDI pour spécifier le port et 
le canal MIDI d'entrée.

Pour assigner une entrée de piste MIDI :

" Cliquez sur le sélecteur d'entrée MIDI de la 
piste et affectez un port et un canal à l'entrée 
MIDI. Les canaux déjà affectés à une autre piste 
s'affichent en caractères gras.

Les régions « Rhythm » sont reproduites en l'absence 
de régions « Lead »

Pour plus d'informations sur l'affectation 
d'entrées MIDI aux pistes d'instrument, 
reportez-vous à la section Affectation 
d'entrée et de sortie MIDI aux pistes 
d'instrument, page 165.

Dans la fenêtre Edit, choisissez View > Edit 
Window > I/O pour accéder au sélecteur 
d'entrée d'une piste.
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Assignation d'une sortie de 
piste MIDI

Pro Tools permet d'affecter des ports et des 
canaux MIDI donnés à une sortie de piste MIDI. 
Aucune sélection par défaut n'envoie de 
données MIDI à un port sur un canal donné. 
Servez-vous du sélecteur de sortie MIDI pour 
spécifier le port et le canal MIDI de sortie.

Pour assigner une piste MIDI (et toutes ses 
régions) à un canal de périphérique MIDI donné :

" Cliquez sur le sélecteur de sortie MIDI de la 
piste et affectez un port et un canal à la sortie 
MIDI. Les canaux déjà affectés à une autre piste 
s'affichent en caractères gras.

Pour assigner plusieurs destinations à une piste 
MIDI unique :

" Maintenez la touche Pomme (Mac) enfoncée 
et cliquez sur le sélecteur de sortie MIDI ou 
utilisez le bouton droit de la souris (Windows) et 
sélectionnez d'autres canaux de périphériques.

Sélecteur d'entrée MIDI (piste MIDI illustrée)

Les pistes MIDI de Pro Tools ne peuvent pas 
contenir plusieurs canaux de données MIDI.

Pour plus d'informations sur l'affectation 
de sorties MIDI aux pistes d'instrument, 
reportez-vous à la section Affectation 
d'entrée et de sortie MIDI aux pistes 
d'instrument, page 165.

Dans la fenêtre Edit, choisissez View > Edit 
Window > I/O pour accéder au sélecteur de 
sortie d'une piste.

Sélecteur de sortie MIDI (piste MIDI illustrée)

Pour plus d'informations sur 
l'enregistrement et l'importation de données 
MIDI, reportez-vous au chapitre 16, 
Enregistrement MIDI



Chapitre 10 : Pistes 165

Affectation d'entrée et de sortie 
MIDI aux pistes d'instrument

Les pistes d'instrument bénéficient d'une vue 
spécifique pour les commandes MIDI, 
notamment les sélecteurs d'entrée et de sortie 
MIDI.

Pour afficher les commandes MIDI de piste 
d'instrument, effectuez l'une des opérations 
suivantes :

" Choisissez View > Mix Window > 
Instruments.

– ou –

" Choisissez View > Edit Window > 
Instruments.

Entrée MIDI de la piste d'instrument

Pro Tools permet d'affecter des ports et des 
canaux MIDI donnés à une entrée MIDI de piste 
d'instrument. La sélection par défaut All reçoit 
toutes les données MIDI entrantes de l'ensemble 
des ports sur l'intégralité des canaux. 
Servez-vous du sélecteur d'entrée MIDI pour 
spécifier le port et le canal MIDI d'entrée.

Les canaux déjà utilisés par une autre entrée de 
la piste s'affichent en gras dans le menu 
contextuel du sélecteur d'entrée MIDI.

Pour affecter l'entrée MIDI d'une piste 
d'instrument :

" Cliquez sur le sélecteur d'entrée MIDI de la 
piste et affectez un port et un canal à l'entrée 
MIDI. Les canaux déjà affectés à une autre piste 
s'affichent en caractères gras.

Sortie MIDI de la piste d'instrument

Pro Tools permet d'affecter des ports et des 
canaux MIDI donnés à une sortie MIDI de piste 
d'instrument. Aucune sélection par défaut 
n'envoie de données MIDI à un périphérique, un 
port ou un nœud sur un canal donné. 
Servez-vous du sélecteur de sortie MIDI pour 
spécifier le port et le canal MIDI de sortie.

Les canaux déjà utilisés par une autre entrée de 
la piste s'affichent en gras dans le menu 
contextuel du sélecteur d'entrée MIDI.

Pour affecter la sortie MIDI d'une piste 
d'instrument :

" Cliquez sur le sélecteur de sortie MIDI de la 
piste et affectez un port et un canal à la sortie 
MIDI. Les canaux déjà affectés à une autre piste 
s'affichent en caractères gras.

Insertion de plug-in d'instrument 
sur les pistes d'instrument

Pour insérer un plug-in d'instrument sur une piste 
d'instrument :

" Cliquez sur le sélecteur d'insert sur la piste 
d'instrument, puis sélectionnez le plug-in 
d'instrument. 

Vue Instrument

Sélecteur d'entrée MIDI

Sélecteur de sortie MIDI
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Un nœud MIDI (port MIDI virtuel) est 
automatiquement créé et attribué à la sortie 
MIDI de la piste.

Lecture en solo et coupure du 
son des pistes
Vous pouvez activer les boutons de mise en solo 
(Solo) et de coupure du son (Mute) à tout 
moment en cours de lecture. Ces boutons ont 
une incidence sur les pistes MIDI et audio. Vous 
pouvez écouter en solo ou couper le son de 
plusieurs pistes en même temps dans une 
session.

Le regroupement par piste a également une 
incidence sur les fonctions de lecture en solo et 
de coupure du son. Lorsque vous coupez ou 
écoutez en solo une piste appartenant à un 
groupe de mixage actif, toutes les autres pistes 
de ce groupe sont également coupées ou 
écoutées en solo.

Bouton Solo

Le bouton Solo coupe généralement le son de 
toutes les autres pistes de façon à écouter 
uniquement la piste choisie.

Avec Pro Tools HD, ce comportement est 
sélectionné comme mode Solo désigné sous 
l'appellation Solo In Place. Des modes Solo 
supplémentaires sont fournis afin de modifier le 
fonctionnement du bouton Solo. Pour plus 
d'informations, consultez la section Modes 
Solo, page 166.

Pour lire des pistes en solo :

1  Cliquez sur le bouton Solo de la piste. 
Le bouton est mis en surbrillance et le son de 
toutes les autres pistes est coupé.

2  Cliquez sur le bouton Solo d'une autre piste. 
Les boutons de ces deux pistes sont mis en 
surbrillance et le son de toutes les autres pistes 
est coupé.

Pour désactiver la mise en solo des pistes :

" Cliquez sur le bouton Solo de la piste lue 
en solo.

Modes Solo

(Pro Tools HD uniquement)

Avec Pro Tools HD, le bouton Solo permet de :

• Couper le son des autres pistes pour écouter 
seulement la piste choisie.

– ou –

• Envoyer une piste donnée vers une sortie 
différente.

Piste d'instrument avec plug-in d'instrument 
(Digidesign Synchronic illustré)

Les pistes d'instrument possèdent des jeux 
différents de boutons de mise en solo et de 
coupure du son pour l'écoute audio et le 
système MIDI.

Pour plus d'informations sur la création et 
la modification de groupes en vue de 
procéder à la lecture en solo ou à la coupure 
de son des pistes, reportez-vous à la section 
Regroupement des pistes, page 174.

Insert avec plug-in d'instrument
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Le comportement du bouton Solo est défini par 
le mode Solo de la manière suivante :

SIP (Solo In Place) : le bouton Solo coupe le son 
des autres pistes. Lorsque ce mode est activé, les 
pistes peuvent être mises en solo (voir Mode 
Solo Safe, page 169).

AFL (After Fader Listen) : le bouton Solo 
achemine le signal 
post-fader/post-panoramique vers la sortie de 
chemin AFL/PFL. Le chemin AFL/PFL est 
configuré dans la page de l'onglet Output de la 
boîte de dialogue I/O Setup (voir Chemin 
AFL/PFL, page 73). 

Avec AFL, le niveau que vous entendez dépend 
du niveau du fader pour la piste considérée. 
De plus, un paramètre de niveau maître 
individuel pour AFL affecte la sortie d'une piste 
ou de toutes les pistes mises en solo en mode 
AFL (voir Chemin AFL/PFL, page 73). 
Ce paramètre de niveau est indépendant du 
paramètre de niveau PFL.

PFL (Pre Fader Listen) : le bouton Solo 
achemine le signal pré-fader/pré-panoramique 
vers la sortie de chemin AFL/PFL. Le chemin 
AFL/PFL est configuré dans la page de l'onglet 
Output de la boîte de dialogue I/O Setup (voir 
Chemin AFL/PFL, page 73). 

Avec PFL, le niveau de fader et de panoramique 
sont ignorés ; le niveau que vous entendez 
dépend du niveau d'enregistrement du signal. 
De plus, un paramètre de niveau maître 
individuel pour PFL affecte la sortie d'une piste 

ou de toutes les pistes mises en solo en mode PFL 
(voir Chemin AFL/PFL, page 73). Ce paramètre 
de niveau est indépendant du paramètre de 
niveau AFL.

Pour sélectionner un mode Solo :

1  Choisissez Options > Solo Mode.

2  Sélectionnez SIP, AFL ou PFL.

Utilisation de DSP avec le mode AFL ou PFL

Les modes AFL et PFL sont exécutés par 
Pro Tools qui crée un mixage en arrière-plan 
pour envoyer le signal vers le chemin AFL/PFL 
choisi. Selon la taille de votre mixage principal, 
Pro Tools consacre une partie importante de ses 
ressources DSP disponibles lors de l'utilisation 
du mode AFL/PFL.

L'annulation de la déclaration du chemin 
AFL/PFL libère toutes les ressources DSP 
précédemment utilisées pour le mode AFL/PFL.

Les modes Solo AFL et PFL requièrent le 
plug-in Surround Mixer (voir le guide de 
démarrage Pro Tools|HD).

Les modes Solo AFL et PFL requièrent le 
plug-in Surround Mixer. 

Si l'option Mutes Frees Assigned Voice est 
activée, toutes les pistes dont le son est 
coupé ne seront pas audibles en mode PFL.

Le mode Solo de toutes les pistes écoutées en 
Solo peut être librement modifié et ainsi 
passer en mode SIP ou AFL. Les pistes 
précédemment écoutées en solo adapteront 
leur mise en solo au nouveau mode.

Le fait de passer du mode Solo au mode PFL 
à la volée pour toutes les pistes écoutées en 
solo a pour effet d'effacer toutes les pistes 
précédemment en solo avant d'activer le 
mode PFL. Cette opération permet d'éviter 
un accroissement considérable des niveaux.
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Utilisation du mode AFL/PFL sur les systèmes 
Pro Tools avec une surface de contrôle 
D-Control ou D-Command

AFL/PFL est optimisé pour les systèmes 
Pro Tools à l'aide de la surface de contrôle 
D-Command ou D-Control. XMON permute 
automatiquement la source d'écoute de la sortie 
principale à la sortie AFL/PFL de Pro Tools.

Utilisation du mode AFL/PFL sur les systèmes 
Pro Tools sans surface de contrôle D-Control ou 
D-Command

Si vous n'utilisez pas une surface de contrôle 
D-Control ou D-Command, votre chemin de 
sortie Pro Tools normal n'est pas nécessairement 
coupé lorsque vous envoyez un signal vers le 
chemin AFL/PFL. S'il s'avère nécessaire de 
couper automatiquement le signal principal 
lorsqu'un signal AFL/PFL est appelé, procédez 
comme suit : 

1  Configurez le chemin de sortie pour les pistes 
AFL ou PFL mises en solo.

2  Sélectionnez le chemin de sortie principal 
dont le son est coupé lorsque vous mettez en 
solo une piste en mode AFL ou PFL (voir 
Sélecteur de coupure AFL/PFL (chemin de 
sortie), page 74).

3  Configurez votre matériel pour écouter 
simultanément le chemin principal et les 
chemins AFL/PFL.

Lorsque le mode AFL ou PFL est sélectionné en 
tant que mode Solo et qu'une piste est mise en 
solo, le chemin de la sortie principale est coupé 
et le signal AFL/PFL apparaît au niveau du 
chemin AFL/PFL pour écoute.

Options Solo Latch

Les solos peuvent être verrouillés (les boutons 
Solo sur lesquels vous appuyez par la suite 
s'ajoutent à l'ensemble de pistes en solo), 
déverrouillés ou verrouillés temporairement 
(Pro Tools HD uniquement).

Pour sélectionner un mode Solo Latch :

" Choisissez Options > Solo Mode et 
sélectionnez l'une des options suivantes :

Latch : lorsque cette option est sélectionnée, les 
boutons Solo sur lesquels vous appuyez par la 
suite s'ajoutent à l'ensemble de pistes en solo.

X–OR (annulation des solos précédents) : 

lorsque cette option est sélectionnée, le fait 
d'appuyer sur des boutons Solo annule les solos 
précédents.

Momentary (Pro Tools HD uniquement) : lorsque 
cette option est sélectionnée, les boutons Solo 
ne restent pas bloqués. Une piste est mise en 
solo à condition de maintenir enfoncée sa 
touche Solo.

Avec une surface de contrôle approuvée par 
Digidesign, pour mettre d'autres pistes en solo, 
il suffit d'appuyer sur leurs touches Solo 
(à condition de maintenir au moins un bouton 
Solo enfoncé). Toutes les pistes en solo 
arrêteront de l'être si aucune touche Solo n'est 
maintenue enfoncée.

Pour plus d'informations sur l'utilisation de 
XMON et AFL/PFL, reportez-vous au Guide 
de votre surface de contrôle.

Pour annuler le mode X-OR et mettre en solo 
plusieurs pistes à la fois, maintenez enfoncé 
le bouton Solo sur la première piste. Les 
boutons Solo sur lesquels vous appuierez 
ensuite seront verrouillés.
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Verrouillage temporaire des solos en mode 
Momentary Solo Latch

(Pro Tools HD uniquement)

Pour verrouiller provisoirement les solos :

1  Choisissez Options > Solo Mode > 
Momentary.

2  Maintenez enfoncé le bouton Solo de la 
première piste à mettre en solo.

3  Tout en continuant à maintenir enfoncé le 
premier bouton Solo, appuyez sur des boutons 
Solo supplémentaires. Les boutons Solo restent 
activés tant qu'un bouton Solo est maintenu 
enfoncé.

Mode Solo Safe

Pro Tools permet de protéger contre le solo une 
piste. Ceci évite de couper le son d'une piste, 
même lorsque vous voulez écouter d'autres 
pistes en solo. Cette fonction est utile pour les 
pistes, telles que les entrées auxiliaires utilisées 
comme prémixage de pistes audio, ou de retours 
d'effets, car elle permet à la piste d'effets ou 
audio de rester dans un mixage, même lorsque 
les autres pistes sont placées en solo. Il est 
également utile de protéger des pistes MIDI 
contre le solo pour que leur lecture ne soit pas 
affectée lorsque vous placez des pistes audio en 
solo.

Pour protéger une piste contre le solo :

" Maintenez enfoncée la touche Pomme (Mac) 
ou Ctrl (Windows) pendant que vous cliquez sur 
le bouton Solo de la piste désirée. Ceci évite de 
couper le son d'une piste, même lorsque vous 
voulez écouter d'autres pistes en solo. Le bouton 
Solo devient transparent en mode Solo Safe.

Pour déprotéger une piste contre le solo :

" Maintenez enfoncée la touche Pomme (Mac) 
ou Ctrl (Windows) pendant que vous cliquez à 
nouveau sur le bouton Solo de la piste désirée.

Bouton de coupure du son

Le bouton de coupure du son (Mute) coupe le 
son de la piste sélectionnée. Il est possible de 
couper le son de plusieurs pistes en même 
temps. Si l'option Options > Mute Frees 
Assigned Voice (systèmes Pro Tools HD 
uniquement) est active, la coupure du son d'une 
piste assigne sa voix à la piste virtuelle de 
priorité la plus élevée suivante (assignée à la 
même voix).

Pour couper le son d'une piste :

" Cliquez sur le bouton de coupure du son de la 
piste. La piste est inactive et le son est coupé.

Pour désactiver la coupure du son d'une piste :

" Cliquez de nouveau sur le bouton de coupure 
du son.

Tant qu'au moins un bouton Solo est 
maintenu enfoncé, tous les solos restent 
verrouillés.

Les pistes AFL ou PFL écoutées en solo 
(Pro Tools HD uniquement) ne peuvent pas 
être protégées contre le solo.
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Option Mute Frees Assigned Voice

(Pro Tools HD uniquement)

Lorsque vous sélectionnez Options > Mute Frees 
Assigned Voice et que vous coupez le son d'une 
piste, la lecture de celle-ci est désactivée, et sa 
voix est « récupérée » par la piste de priorité la 
plus élevée suivante assignée à la même voix.

Lorsque cette option est active, un retard peut se 
produire (d'une à plusieurs secondes suivant la 
puissance du processeur) entre le moment ou 
vous coupez ou désactivez la coupure de son 
d'une piste et celui où vous en constatez l'effet 
sur la lecture. 

Inactivation des pistes
Les pistes audio, d'entrées auxiliaires, de faders 
principaux, de VCA principal (Pro Tools HD 
uniquement) et d'instrument peuvent être 
désactivées. Les pistes inactives n'utilisent ni 
DSP ni voix. Sur les pistes inactives, les plug-in, 
départs, voix et automation sont tous 
désactivés. Il est également possible de 
désactiver automatiquement les pistes 
lorsqu'une session est ouverte sur un système 
possédant moins de puissance DSP que celui sur 
lequel elle a été créée.

Pour activer ou désactiver une piste :

" Maintenez enfoncées les touches Pomme+Ctrl 
(Mac) ou Ctrl+Démarrer (Windows) pendant 
que vous cliquez sur l'indicateur du type de piste 
dans la fenêtre Mix.

Les playlists des pistes inactives sont estompées 
et les commandes des pistes sont grisées.

Lorsque vous coupez le son d'une piste en 
activant l'option Mute Frees Assigned 
Voice, la voix n'est pas libérée pour 
l'enregistrement QuickPunch, TrackPunch 
(à la volée) ou DestructivePunch.

De grandes tailles de buffer de lecture DAE 
peuvent également augmenter le retard 
potentiel entre le moment où vous cliquez 
sur le bouton de coupure du son et la 
coupure de son effective. Pour plus 
d'informations, consultez la section Taille 
du buffer de lecture DAE, page 46.

Les pistes MIDI ne peuvent être désactivées.

Activation/désactivation d'une piste

Indicateur du type de piste
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Pour désactiver une ou plusieurs pistes :

1  Cliquez sur le nom de la piste souhaitée (dans 
sa voie de console de piste) et choisissez Make 
Inactive. 

Codage couleur des pistes, 
des régions, des marqueurs et 
des groupes
Des couleurs différentes peuvent être affectées à 
des régions, des pistes, des marqueurs et des 
groupes audio et MIDI. 

Les régions illustrées dans les vues Waveform et 
Block de la fenêtre Edit sont en couleur. 
Les pistes présentées dans la liste des pistes, la 
liste de groupes et les fenêtres Mix et Edit sont 
associées à des barres de couleurs.

Barres de couleur

Le codage couleur au niveau de la piste est 
représenté par les barres de couleur de la 
manière suivante :

Fenêtre Mix : les couleurs de la piste s'affichent 
sous forme de barres de couleur horizontales 
figurant au-dessus de chaque voie et en dessous 
du nom de la piste. 

Fenêtre Edit : les couleurs de la piste s'affichent 
sous forme de barres de couleur verticales à 
gauche de chaque piste.

Liste des pistes : les couleurs de la piste 
s'affichent sous forme de barres de couleur 
verticales à gauche de chaque nom de piste.

Liste de groupes : les couleurs de la piste 
s'affichent sous forme de barres de couleur 
verticales à gauche de chaque nom de groupe.

Les couleurs par défaut sont automatiquement 
affectées aux pistes, mais il est possible de 
remplacer ces couleurs par celles de la palette qui 
offre un choix de 96 couleurs. Pour plus 
d'informations, reportez-vous à la section 
Palette de couleurs, page 173.

Affichage des préférences de 
page pour le codage couleur

Les options de codage couleur déterminent la 
manière dont les couleurs sont affectées à 
l'affichage des pistes et des régions.

Pour modifier les options de codage couleur :

1  Sélectionnez Setup > Preferences.

2  Cliquez sur l'option Display.

3  Sélectionnez une option de codage couleur de 
piste par défaut.

4  Sélectionnez une option de codage couleur de 
région par défaut.

5  Sélectionnez ou désélectionnez l'option 
Always Display Marker Colors.

6  Cliquez sur OK.

Always Display Marker Colors

Cette option permet d'afficher les couleurs des 
marqueurs dans la règle des marqueurs, quels 
que soient les paramètres choisis pour Default 
Region Color Coding. 

Pour sélectionner plusieurs pistes, 
maintenez la touche Pomme (Mac) ou Ctrl 
(Windows) enfoncée tout en cliquant 
dessus.

Pour sélectionner une série de pistes, cliquez 
sur les noms des pistes en maintenant la 
touche Maj enfoncée.
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Options Default Track Color Coding

Ces options déterminent la façon dont les 
couleurs sont affectées à l'affichage des pistes. 

None : désactive l'affectation de couleurs par 
défaut pour les pistes.

Tracks and MIDI Channels : affecte une couleur à 
chaque piste de la fenêtre Edit ou Edit en 
fonction de l'assignation de sa voix ou de son 
canal MIDI.

Tracks and MIDI Devices : affecte une couleur à 
chaque piste de la fenêtre Edit ou Edit en 
fonction de l'assignation de sa voix ou de son 
périphérique MIDI.

Groupes : affecte une couleur à chaque piste, 
conformément à son ID de groupe Mix ou Edit. 
En cas de suspension de groupes à l'aide de la 
commande Suspend Groups, les barres de 
couleur des pistes ne sont pas affichées.

Track Type : affecte une couleur à chaque piste 
en fonction de leur type (audio, Entrée 
auxiliaire, Instrument, MIDI ou Fader principal).

Options Default Region Color Coding

Ces options déterminent la façon dont les 
couleurs sont affectées à l'affichage des régions. 

None : désactive l'affectation de couleurs par 
défaut pour les régions. Les régions sont 
représentées par des formes d'ondes ou des notes 
MIDI noires sur un fond gris clair.

Tracks and MIDI Channels : affecte une couleur à 
chaque région de la fenêtre Edit en fonction de 
l'assignation de sa voix ou de son canal MIDI.

Tracks and MIDI Devices : affecte une couleur à 
chaque région de la fenêtre Edit en fonction de 
l'assignation de sa voix ou de son périphérique 
MIDI.

Groupes : affecte une couleur à chaque région, 
conformément à l'ID de groupe de sa piste. 
En cas de suspension de groupes à l'aide de la 
commande Suspend Groups, toutes les régions 
présentent des formes d'ondes ou des notes 
MIDI noires sur un fond gris clair.

Track Color : affecte une couleur de région basée 
sur la couleur attribuée à la piste. (Pour plus 
d’informations, reportez-vous à la section 
« Palette de couleurs », page 173.)

Marker Locations : affecte une couleur aux 
données dans toutes les pistes en fonction du 
marqueur précédent le plus proche.

Options des codes couleur par défaut des pistes

Options des codes couleur par défaut des régions
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Region List Color : affecte une couleur à chaque 
région en fonction de sa couleur dans la liste des 
régions. Lorsque cette option est activée, la 
couleur de région attribuée est conservée même 
si la région est placée dans un ensemble de pistes 
d'un code couleur différent. 

Palette de couleurs

La palette de couleurs permet de sélectionner 
des couleurs pour les pistes, les régions, les 
groupes et les marqueurs. 

La palette de couleurs prend en charge des 
codages couleur de région distincts dans la liste 
des régions et dans les pistes.

Pour appliquer une couleur à partir de la palette :

1  Choisissez Window > Color Palette.

2  Effectuez l'une des opérations suivantes :

• Dans le menu contextuel Apply to Selected, 
sélectionnez la destination du codage 
couleur : Tracks (pistes), Marker 
(marqueur), Group (Groupe), Regions in 
Tracks (Régions dans les pistes) ou Regions 
in Region List (Régions dans la listes de 
régions).

– ou –

• Sélectionnez une piste, un marqueur, un 
groupe, une région de piste ou une région 
de la liste de régions dans la fenêtre 
Pro Tools qui convient. Le menu Apply to 
Selected affiche le type d'élément que vous 
avez sélectionné.

3  Sélectionnez une couleur dans la palette ou 
sélectionnez une des options suivantes :

Default : supprime toute couleur personnalisée 
et rétablit la couleur selon l'orientation de la 
couleur par défaut. Pour plus d'informations, 
reportez-vous à la section Affichage des 
préférences de page pour le codage couleur, 
page 171.

None : désactive l'affectation de couleurs. les 
régions affectées sont représentées par une 
forme d'onde noire ou des notes MIDI noires sur 
fond gris clair. Les barres de couleur des pistes et 
des groupes concernés ne s'affichent plus.

L'activation d'une option de la liste Default 
Region Color Coding autre que l'option 
Region List Color annule la couleur de la 
liste de régions correspondante et réaffecte la 
couleur de la piste parente aux copies de la 
région placées dans les pistes. Les copies de 
la région dans la liste des régions conservent 
leur couleur unique, le cas échéant. 

Fenêtre de la palette de couleurs

Option Apply to Selected

Bouton Hold

Option Default
Option None

Dernière couleur affectée

Option Default

Si la sélection d'un marqueur ne permet pas 
de présenter l'option Marker dans le menu 
contextuel Apply to Selected, cela signifie 
que l'option Always Display Marker Colors 
dans la page Display Preferences est 
désactivée. Pour plus d'informations, 
reportez-vous à la section Always Display 
Marker Colors, page 171.
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Utilisation du bouton Hold

La palette de couleurs présente un bouton Hold 
dont le but est de simplifier le processus 
d'affectation de mêmes couleurs à de nombreux 
éléments (comme les pistes et les régions).

Par défaut, ce bouton est désactivé. Dans ce cas, 
la palette de couleurs met automatiquement en 
surbrillance la couleur affectée (s'il y en a une) 
des éléments au fur et à mesure que vous les 
sélectionnez. 

Par défaut, ce bouton est désactivé. Dans ce cas, 
la palette de couleurs met automatiquement en 
surbrillance la couleur affectée (s'il y en a une) 
des éléments au fur et à mesure que vous les 
sélectionnez. 

Lorsque le bouton Hold est activé, la couleur 
affectée sélectionnée dans la palette de couleurs 
reste inchangée lorsqu'une piste ou une région 
différente est sélectionnée. 

Pour utiliser le bouton Hold afin d'affecter une 
même couleur à plusieurs éléments : 

1  Cliquez sur le bouton Hold pour l'activer. 
Le bouton Hold vire au blanc et la couleur 
actuellement sélectionnée est mise en 
surbrillance (elle est entourée d'un cadre blanc). 

2  Sélectionnez des pistes ou des régions 
supplémentaires auxquelles vous voulez affecter 
la couleur choisie. Etant donné que le bouton 
Hold est activé, la palette des couleurs ne se 
conforme pas à la sélection de l'élément ; elle 
conserve la dernière couleur actuellement 
affectée. 

3  Cliquez à nouveau sur la couleur affectée pour 
l'appliquer à la nouvelle sélection de pistes ou de 
régions. Utilisez le menu contextuel Apply to 
Selected pour déterminer les éléments 
sélectionnés concernés. 

4  Pour désactiver le bouton Hold et rétablir le 
mode par défaut de la palette de couleurs, 
cliquez sur le bouton Hold jusqu'à ce qu'il soit 
désactivé. 

Regroupement des pistes
Pro Tools offre une fonction de regroupement 
relatif qui permet de relier des pistes et leurs 
commandes. 

Les groupes sont pratiques pour éditer plusieurs 
pistes exactement de la même manière ou pour 
mixer plusieurs pistes (par exemple, une paire de 
pistes stéréo ou un prémixage) tout en 
préservant leurs niveaux relatifs. 

Pro Tools offre les fonctions de regroupement 
suivantes :

• Jusqu'à 104 groupes disponibles, répartis 
dans 4 banques de 26 ID de groupe.

• Possibilité d'imbrication afin d'inclure des 
sous-groupes dans des groupes plus 
importants.

• Les faders ou contrôleurs regroupés 
préservent leurs niveaux relatifs.

• Les groupes peuvent être assignés à une 
piste de VCA principal disponible 
(Pro Tools HD uniquement).

Vous pouvez également répartir les régions 
dans des groupes de régions. Pour plus 
d'informations, consultez la section 
Groupes de régions, page 525.
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Groupes de mixage, groupes 
d'édition et groupes de 
mixage/édition

Les groupes de mixage ont une incidence 
uniquement sur les fonctions de mixage alors 
que les groupes d'édition concernent les 
fonctions d'édition. Les groupes de 
mixage/édition permettent d'établir un lien 
entre le groupe de mixage et le groupe d'édition.

Groupes d'édition

Les groupes d'édition se rapportent aux 
éléments suivants dans la fenêtre Edit :

• Vue de la piste

• Hauteur de la piste

• Timeline de la piste

• Fonctions d'édition audio et MIDI

• Fonctions d'édition d'automation

Groupes de mixage dans Pro Tools HD

Les groupes de mixage dans Pro Tools HD 
peuvent se rapporter aux éléments suivants :

• Coupure de son principale

• Mise en solo

• Niveau de départ

• Coupure du départ

• Volume principal

• Panoramique principal

• Niveau LFE principal

• Activation de l'enregistrement

• Ecoute des entrées

• Mode d'automation

• Panoramique de départ

• Niveau LFE de départ

• Commandes de plug-in

• Commande de désactivation de plug-in 
(Bypass)

Groupes de mixage dans Pro Tools LE

Les groupes de mixage dans Pro Tools LE ont 
toujours une incidence sur les éléments 
suivants :

• Volume principal

• Mode d'automation

Les groupes de mixage dans Pro Tools LE 
peuvent aussi se rapporter aux éléments 
suivants :

• Coupure de son principale

• Mise en solo

• Niveau de départ

• Coupure du départ

Limitations liées au regroupement

Le regroupement n'a pas d'effet sur les 
paramètres suivants :

• Assignation des voix

• Assignation des sorties

• Insertion de plug-in

Attributs de groupe 
sélectionnable

Vous pouvez déterminer les paramètres ou les 
attributs liés dans les groupes au moyen des 
méthodes suivantes :

• En faisant du groupe un groupe d'édition, un 
groupe de mixage ou une combinaison des 
deux (groupe de mixage/édition)

Dans Pro Tools HD, lorsque l'attribut de 
panoramique principal est activé pour les 
groupes, le comportement de groupe 
s'applique aux commandes de liaison, de 
couplage inversé avant, de couplage inversé 
arrière et de couplage inversé avant/arrière 
dans les fenêtres de panoramiques 
multicanaux et stéréo.
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• En faisant votre choix dans la liste des 
attributs du groupe (dans le cas d'un groupe 
de mixage ou d'un groupe de mixage/édition)

• En indiquant si les attributs sélectionnés 
s'appliquent de façon globale à tous les 
groupes ou à des groupes individuels (dans le 
cas de groupes de mixage dans Pro Tools HD 
uniquement)

Liaison de groupes de mixage et 
d'édition

L'option Link Mix and Edit Group Enables relie 
l'activation de groupe entre les fenêtres Mix et 
Edit. 

Pro Tools permet de créer des groupes qui sont à 
la fois de mixage et d'édition, même si vous 
préféreriez dans certains cas ne pas relier ces 
groupes. Par exemple, lorsque vous utilisez la 
fenêtre Mix pour le mixage, vous pouvez 
préférer travailler avec des groupes imbriqués 
plus grands. En revanche, dans la fenêtre Edit, 
vous préférerez peut-être effectuer vos tâches 
d'édition à l'intérieur d'un groupe plus petit. 
Dans ce cas, désactiver l'option Link Mix and 
Edit Group Enables permet de travailler avec des 
groupes différents dans les deux fenêtres.

Pour supprimer le lien entre les groupes de mixage 
et d'édition :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Mixing. 

2  Désactivez l'option Link Mix and Edit Group 
Enables et cliquez sur OK.

Groupes de mixage et pistes de 
VCA principal
(Pro Tools HD uniquement)

Il est possible d'affecter un groupe de mixage 
existant à une piste de VCA principal ou un 
nouveau groupe de mixage à une piste de VCA 
principal pendant sa création. Vous ne pouvez 
assigner qu'un groupe à la fois à une piste de 
VCA principal. Une piste de VCA principal ne 
peut pas contrôler un groupe qui s'inclut 
lui-même.

Commandes de regroupement
Les menus et les commandes nécessaires à la 
création et à la modification de groupes sont 
accessibles à partir des éléments suivants :

• Liste de groupes

• Nom de groupe dans la liste de groupes

• Indicateur d'ID de groupe sur une piste

• Menu Track > Group

Liste de groupes

Les fonctions de regroupement de piste de 
Pro Tools se trouvent à gauche de la fenêtre Mix 
ou Edit dans la liste des groupes. La fenêtre 
déroulante contient les noms de tous les groupes 
de votre session, ainsi qu'un menu contextuel 
qui donne accès aux commandes de 
regroupement. Depuis ce menu, vous pouvez 
sélectionner et activer des groupes.

Pour plus d'informations sur l'affectation 
des groupes aux pistes de VCA principal, 
reportez-vous à la section Attribution de 
groupes aux pistes de VCA principal, 
page 730.
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Par défaut, chaque session possède un groupe 
nommé All, qui inclut toutes les pistes de la 
session. Vous ne pouvez ni éditer ni supprimer 
le groupe All.

Bouton Show/Hide Track List/Group 
List View

Pour afficher la liste des groupes (et la liste des 
pistes) :

" Cliquez sur le bouton Show/Hide Track 
List/Group List View dans la fenêtre Mix ou Edit.

Identification du groupe

A gauche de chaque nom dans la liste des 
groupes se trouve la lettre d'identification de 
chaque groupe (de « a » à « z »).

Symboles de groupes

A gauche de chaque identification de groupe (de 
« a » à « z ») se trouve un symbole indiquant si 
ce groupe est sélectionné dans la fenêtre actuelle 
(la fenêtre Edit ou Mix). Il existe trois types de 
symboles de groupes, tels qu'illustrés dans la 
figure suivante :

Les significations de ces symboles de groupes 
sont les suivantes :

Cercle plein : indique que tous les membres du 
groupe sont actuellement sélectionnés, et 
qu'aucun membre en dehors du groupe n'est 
sélectionné.

Cercle vide : indique que seuls certains membres 
du groupe sont actuellement sélectionnés.

Cercle contenant un point : indique que tous les 
membres du groupe sont actuellement 
sélectionnés, ainsi que des membres en dehors du 
groupe.

Liste de groupes

Liste de groupes d'édition dans la fenêtre Edit

Menu contextuel de la liste des groupes
Cliquez ici pour 
sélectionner un 
groupe en 
tapant sa lettre

Cliquez ici pour 
activer un 
groupe 

Cliquez ici 
pour 
sélectionner 
les membres 
du groupe à 
l'écran

Cliquez ici pour masquer 
la liste des groupesID de groupe

Couleurs

Bouton Show/Hide Track List/Group List View

Symboles de groupes

Cercle vide

Cercle plein

Cercle contenant un point
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Menu contextuel de la liste des 
groupes

Le menu contextuel en haut de la liste des 
groupes contient les commandes suivantes :

New Group : exécute la commande Track > 
Group.

Display : commandes permettant d'afficher 
uniquement les groupes d'édition, uniquement 
les groupes de mixage ou tous les groupes 
(édition, mixage et mixage/édition).

Suspend All Groups : suspend le comportement 
de groupe pour tous les groupes de mixage et 
d'édition.

Modify Groups : ouvre la boîte de dialogue 
Group permettant de modifier uniquement les 
groupes existants.

Delete Active Groups : supprime uniquement les 
groupes actifs actuels.

Menus contextuels pour le nom de 
groupe et l'indicateur d'ID de 
groupe d'une piste

Lorsque vous cliquez sur un nom de groupe dans 
la liste de groupes et maintenez le bouton de la 
souris enfoncé ou cliquez sur un indicateur d'ID 
de groupe d'une piste, un menu contextuel 
présente les commandes suivantes :

Tracks : indique le groupe auquel appartient la 
piste.

Attributes : affiche les attributs du groupe

Modify : ouvre la boîte de dialogue Group 
permettant de modifier uniquement les groupes 
existants.

Duplicate : ouvre la boîte de dialogue Group 
pour le groupe dupliqué.

Delete : supprime un simple groupe.

Select Tracks in Group : sélectionne des pistes 
dans le groupe.

Show/Hide Tracks in Group : affiche ou masque 
des pistes dans le groupe actuel.

Show Only Tracks in Group : affiche uniquement 
les pistes dans le groupe et masque toutes les 
autres pistes.

Show All Tracks : affiche toutes les pistes dans la 
session.

Menu contextuel de la liste des groupes

Menu contextuel des noms de groupes
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Boîte de dialogue Group

Quelle que soit la tâche effectuée (création ou 
modification de groupes au moyen de la groupe 
de listes, de l'indicateur d'ID de groupe d'une 
piste ou de la commande Track > Group), vous 
ferez appel à la boîte de dialogue Group.

La boîte de dialogue Group permet de créer des 
groupes et d'attribuer des attributs aux groupes.

Boîte de dialogue Groupe dans 
Pro Tools HD

Dans Pro Tools HD, la boîte de dialogue Group 
se compose de trois pages :

Tracks : permet d'ajouter et de retirer des pistes 
dans le groupe actuel.

Attributes : permet de sélectionner les 
paramètres se rapportant au groupe de mixage 
ou au groupe de mixage/édition actuel.

Globals : permet de sélectionner les paramètres 
applicables sous forme de modèle à des groupes 
individuels en activant l'option Follow Globals.

Menu contextuel des indicateurs d'ID de groupe

Boîte de dialogue Group (Pro Tools HD)
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Boîte de dialogue Groupe dans 
Pro Tools LE

Dans Pro Tools LE, la boîte de dialogue Group 
est constituée d'une seule page.

Utilisation des groupes

Création de groupes

Vous pouvez sélectionner les pistes que vous 
souhaitez ajouter à un groupe avant de le créer, 
ou ajouter et retirer des pistes d'un groupe après 
sa création.

Création de groupes dans Pro Tools HD

Pour créer un groupe dans Pro Tools HD :

1  Sélectionnez les pistes que vous souhaitez 
inclure dans le groupe. Si vous omettez de le 
faire pour l'instant, il sera possible de les ajouter 
par la suite.

2  Effectuez l'une des opérations suivantes :

• Choisissez Track > Group.

– ou –

• Choisissez New Group dans le menu 
contextuel Group List.

3  Donnez un nom au groupe.

4  Sélectionnez le type de groupe à créer : groupe 
d'édition (Edit), groupe de mixage (Mix) ou 
groupe de mixage/édition (Mix/Edit).

Boîte de dialogue Group (Pro Tools LE)

Sélection d'un type de groupe
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5  Sélectionnez un ID de groupe dans le menu 
contextuel ID. Quatre banques de 26 ID sont 
disponibles : a–z, 2a–z, 3a–z, 4a–z. Si vous 
omettez de choisir un ID de groupe, Pro Tools 
attribue automatiquement l'ID disponible le 
plus proche au nouveau groupe. 

6  Cliquez sur Tracks dans la boîte de dialogue 
Group et effectuez l'une des opérations 
suivantes :

• Pour ajouter les pistes actuellement 
sélectionnées dans la session au groupe, 
cliquez sur le bouton Add en bas de la boîte 
de dialogue Group.

• Pour ajouter des pistes au groupe, 
sélectionnez les noms des pistes dans la 
liste Available et cliquez sur Add ou 
appuyez sur la touche A du clavier de 
l'ordinateur.

• Pour retirer des pistes du groupe, 
sélectionnez les noms des pistes dans la 
liste Currently In Group et cliquez sur 
Remove ou appuyez sur la touche R du 
clavier de l'ordinateur.

• Cliquez deux fois sur les noms des pistes 
dans l'une ou l'autre des listes pour les 
transférer dans la colonne opposée.

• Pour remplacer toutes les pistes dans le 
groupe par les pistes actuellement 
sélectionnées dans la session, cliquez sur le 
bouton Replace en bas de la boîte de 
dialogue Group.

7  Si le groupe est un groupe de mixage ou un 
groupe de mixage/édition, effectuez l'une des 
opérations suivantes :

• Définissez les attributs du groupe (voir 
Définition des attributs de groupes, 
page 186).

Sélection d'un ID de groupe

Sélection des noms de pistes en vue de les ajouter à un 
groupe

Dans l'une ou l'autre des listes, cliquez sur 
les noms des pistes en maintenant la touche 
Maj enfoncée pour sélectionner une série de 
noms de pistes. Maintenez enfoncée la 
touche Pomme (Mac) ou Ctrl (Windows) 
pendant que vous cliquez pour sélectionner 
des noms de pistes non contigus.
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• Si vous souhaitez affecter le groupe à un 
VCA disponible, sélectionnez la piste VCA 
à partir du menu contextuel VCA.

8  Cliquez sur OK.

Création de groupes dans Pro Tools LE

Pour créer un groupe dans Pro Tools LE :

1  Sélectionnez les pistes que vous souhaitez 
inclure dans le groupe. Si vous omettez de le 
faire pour l'instant, il sera possible de les ajouter 
par la suite.

2  Effectuez l'une des opérations suivantes :

• Choisissez Track > Group.

– ou –

• Choisissez New Group dans le menu 
contextuel Group List.

3  Donnez un nom au groupe.

4  Sélectionnez le type de groupe à créer : groupe 
d'édition (Edit), groupe de mixage (Mix) ou 
groupe de mixage/édition (Mix/Edit).

5  Sélectionnez un ID de groupe dans le menu 
contextuel ID. Quatre banques de 26 ID sont 
disponibles : a–z, 2a–z, 3a–z, 4a–z. Si vous 
omettez de choisir un ID de groupe, Pro Tools 
attribue automatiquement l'ID disponible le 
plus proche au nouveau groupe. 

6  Effectuez l'une des opérations suivantes :

• Pour ajouter les pistes actuellement 
sélectionnées dans la session au groupe, 
cliquez sur le bouton Add en bas de la boîte 
de dialogue Group.

• Pour ajouter des pistes au groupe, 
sélectionnez les noms des pistes dans la 
liste Available et cliquez sur Add ou 
appuyez sur la touche A du clavier de 
l'ordinateur.

• Pour retirer des pistes du groupe, 
sélectionnez les noms des pistes dans la 
liste Currently In Group et cliquez sur 
Remove ou appuyez sur la touche R du 
clavier de l'ordinateur.

• Cliquez deux fois sur les noms des pistes 
dans l'une ou l'autre des listes pour les 
transférer dans la colonne opposée.

• Pour remplacer toutes les pistes dans le 
groupe par les pistes actuellement 
sélectionnées dans la session, cliquez sur le 
bouton Replace en bas de la boîte de 
dialogue Group.

Sélection d'une piste VCA en vue de contrôler un 
groupe

Sélection d'un type de groupe
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7  Sélectionnez les éléments à lier au sein des 
groupes : coupures de son (Mutes), mises en solo 
(Solos), coupures de départ (Send Mutes), 
niveaux de départ (Send Levels).

8  Cliquez sur OK.

Modification des groupes

Pour modifier un groupe :

1  Effectuez l'une des opérations suivantes :

• Choisissez Modify Groups dans le menu 
contextuel Group List. 

• Dans la fenêtre Mix, cliquez sur l'indicateur 
d'ID de groupe d'une piste et choisissez 
Modify dans le menu contextuel. 

• Cliquez à l'aide du bouton droit de la souris 
sur le nom du groupe dans la liste des 
groupes et choisissez Modify dans le menu 
contextuel.

2  Dans la boîte de dialogue Groups, 
sélectionnez le groupe que vous souhaitez 
modifier à partir du menu contextuel ID.

3  Changez les éléments de votre choix pour le 
groupe actuel :

• Nom de groupe

• Type de groupe (Edition, Mixage ou 
Mixage/Edition)

• Etat VCA (Pro Tools HD uniquement)

• Etat de l'option Follows Global (Pro Tools 
HD uniquement)

• Groupe d'appartenance de la piste

• Attributs (Pro Tools HD uniquement)

• Options de liaison au sein des groupes 
(Pro Tools LE uniquement)

4  Cliquez sur OK.

Sélection des noms de pistes en vue de les ajouter à un 
groupe

Dans l'une ou l'autre des listes, cliquez sur 
les noms des pistes en maintenant la touche 
Maj enfoncée pour sélectionner une série de 
noms de pistes. Maintenez enfoncée la 
touche Pomme (Mac) ou Ctrl (Windows) 
pendant que vous cliquez pour sélectionner 
des noms de pistes non contigus.

Options de liaison au sein des groupes (Pro Tools LE)

Menu contextuel de la liste des groupes
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Pour changer les paramètres du groupe « All » 
dans Pro Tools HD :

1  Cliquez à l'aide du bouton droit de la souris 
sur le nom du groupe « All » dans la liste des 
groupes et choisissez Modify dans le menu 
contextuel.

2  Dans la boîte de dialogue Group, sélectionnez 
Edit, Mix ou Mix/Edit pour redéfinir les 
paramètres du groupe ALL. Si vous sélectionnez 
Edit ou Mix, le groupe ALL s'appliquera 
uniquement à ce type de groupe. 

3  Pour les groupes de mixage ou de 
mixage/édition, vous avez la possibilité de 
changer les paramètres suivants :

• Etat de l'option Follows Global

• Attributs

4  Cliquez sur OK. 

Pour changer les paramètres du groupe « All » 
dans Pro Tools LE :

1  Cliquez à l'aide du bouton droit de la souris 
sur le nom du groupe « All » dans la liste des 
groupes et choisissez Modify dans le menu 
contextuel.

2  Dans la boîte de dialogue Group, sélectionnez 
Edit, Mix ou Mix/Edit pour redéfinir les 
paramètres du groupe ALL. Si vous sélectionnez 
Edit ou Mix, le groupe ALL s'appliquera 
uniquement à ce type de groupe. 

3  Pour les groupes de mixage ou de 
mixage/édition, vous avez la possibilité de 
changer les options suivantes de liaison au sein 
des groupes :

• Coupures de son (Mutes)

• Mises en solo (Solos)

• Coupures de départ (Send Mutes)

• Niveaux de départ (Send Levels)

4  Cliquez sur OK. 

Menu contextuel du groupe All

Boîte de dialogue Modify ALL Group

Boîte de dialogue Modify ALL Group
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Suppression des groupes

Il est possible de supprimer un groupe ou tous 
les groupes à la fois.

Pour supprimer un simple groupe, effectuez l'une 
des opérations suivantes :

" Dans la fenêtre Mix, cliquez sur l'indicateur 
d'ID de groupe d'une piste et choisissez Delete 
dans le menu contextuel. 

– ou –

" Cliquez à l'aide du bouton droit de la souris 
sur le nom du groupe dans la liste des groupes et 
choisissez Delete dans le menu contextuel.

Pour supprimer tous les groupes actuellement 
actifs :

" Choisissez Delete Active Groups dans le menu 
contextuel de la liste des groupes. 

Duplication des groupes

Vous pouvez dupliquer un groupe et modifier 
ses paramètres de façon à préparer rapidement 
un mixage. 

Pour dupliquer un groupe :

1  Effectuez l'une des opérations suivantes :

• Cliquez sur l'indicateur d'ID de groupe 
d'une piste et choisissez Duplicate dans le 
menu contextuel. 

– ou –

• Cliquez à l'aide du bouton droit de la souris 
sur le nom du groupe dans la liste des 
groupes et choisissez Duplicate dans le 
menu contextuel.

2  Changez les éléments de votre choix pour le 
groupe actuel :

• Nom du groupe

• Type de groupe (Edition, Mixage ou 
Mixage/Edition)

• Etat VCA (Pro Tools HD uniquement)

• Etat de l'option Follows Global (Pro Tools 
HD uniquement)

• Groupe d'appartenance de la piste

• Attributs (Pro Tools HD uniquement)

• Options de liaison au sein des groupes 
(Pro Tools LE uniquement)

3  Cliquez sur OK. 

La suppression d'un groupe est irréversible.

Menu contextuel de la liste des groupes

Il est impossible de supprimer le groupe 
ALL.
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Définition des attributs de 
groupes
(Pro Tools HD uniquement)

Lorsque vous créez un groupe de mixage ou un 
groupe de mixage/édition, vous avez la 
possibilité de sélectionner les paramètres de la 
fenêtre Mix qui seront liés à ce groupe. 
Ces paramètres liés correspondent aux attributs 
du groupe.

Vous pouvez sélectionner des attributs dans la 
page Globals et définir des groupes individuels 
conformes aux paramètres globaux ou appliquer 
des attributs à des groupes de façon 
indépendante. 

Pour sélectionner des attributs dans la page 
Global :

1  Lors de la création ou de la modification d'un 
groupe, cliquez sur Globals dans la boîte de 
dialogue Group.

2  Sélectionnez le jeu de base d'attributs pour les 
groupes de votre session. 

3  Cliquez sur OK pour enregistrer le groupe et 
les nouveaux paramètres globaux.

Pour sélectionner des attributs pour un groupe 
indépendant :

1  Lors de la création ou de la modification d'un 
groupe de mixage ou d'un groupe de 
mixage/édition, effectuez l'une des opérations 
suivantes :

• Cliquez sur Attributes dans la boîte de 
dialogue Group et sélectionnez les attributs 
à associer au groupe. 

– ou –

• Cliquez sur Follow Globals pour vous 
conformer au jeu de base des attributs. 
La page Attributes s'estompe pour signaler 
que le groupe est conforme aux sélections 
de la page Globals.

Page Globals de la boîte de dialogue Group

Pour plus d'informations sur la sélection 
d'attributs, reportez-vous à la section 
Sélection des attributs de groupes, 
page 187.

Pour plus d'informations sur la sélection 
d'attributs, reportez-vous à la section 
Sélection des attributs de groupes, 
page 187.
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2  Cliquez sur OK pour enregistrer les 
paramètres.

Sélection des attributs de groupes

Vous pouvez sélectionner les attributs suivants à 
titre de paramètres globaux ou pour des groupes 
individuels.

Commandes des pistes :

• Volume principal (Main Volume)

• Coupure de son principale (Main Mute)

• Panoramique principal (Main Pan)

• Niveau LFE principal (Main LFE)

• Activation de l'enregistrement

• Ecoute des entrées (Input Monitoring)

• Mise en solo

• Mode d'automation (Automation Mode)

Commandes de départ (Départs A–J) :

• Niveau de départ (Send Level)

• Coupure du départ (Send Mute)

• Panoramique de départ (Send Pan)

• Niveau LFE de départ (Send LFE)

Commandes d'insert (Inserts A–E) :

• Commandes de plug-in (Insert Controls)

• Désactivation de l'insert (Insert Bypass)

Pour sélectionner les attributs d'un groupe, 
effectuez l'une des opérations suivantes :

" Sélectionnez des attributs individuels en 
cliquant sur leurs cases à cocher.

" Pour sélectionner ou désélectionner tous les 
attributs, maintenez enfoncées les touches 
Alt+Maj (Windows) ou Option+Maj (Mac) 
pendant que vous cliquez sur un attribut.

" Pour sélectionner ou désélectionner tous les 
attributs pour un départ ou un insert unique (au 
niveau d'une rangée), maintenez enfoncées les 
touches Démarrer (Windows) ou Pomme (Mac) 
pendant que vous cliquez sur un attribut de 
cette rangée. 

" Pour sélectionner ou désélectionner les 
attributs d'une commande unique au niveau de 
tous les départs, de tous les inserts ou pour les 
quatre commandes de piste (au niveau d'une 
colonne), maintenez enfoncées les touches Alt 
(Windows) ou Option (Mac) pendant que vous 
cliquez sur un attribut de cette colonne. 

Page Attributes de la boîte de dialogue Group
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Enregistrement des présélections 
d'attributs de groupes

Il est possible de définir six présélections 
d'attributs de groupes que vous pouvez charger à 
partir de la page Attributes ou Globals chaque 
fois que vous créez ou modifiez un groupe de 
mixage ou un groupe de mixage/édition. 

Pour enregistrer les paramètres d'attributs 
actuels sous forme de présélection :

1  Dans la boîte de dialogue Group, cliquez sur 
Save. Pour enregistrer un paramètre à partir de la 
page Attibutes, assurez-vous que l'option Follow 
Globals est désélectionnée.

2  Sélectionnez l'un des six emplacements de 
présélection à partir du menu contextuel 
Location et cliquez sur Save.

Pour charger une présélection de groupe :

" Cliquez sur le bouton de présélection 
correspondant (1–6) dans la boîte de dialogue 
Groups. Pour charger un paramètre à partir de la 
page Attibutes, assurez-vous que l'option Follow 
Globals est désélectionnée.

Activation de groupes
Les opérations d'édition ne s'appliquent pas aux 
membres d'un groupe qui sont cachés dans la 
liste de pistes. Les opérations de mixage 
(exception faite de la préparation en 
enregistrement) s'appliquent aux pistes 
masquées.

Pro Tools permet de créer des groupes distincts 
pour l'édition et le mixage. Cette option est 
définie à l'aide de la commande New Group. 
Les groupes concernés à la fois par l'édition et le 
mixage peuvent être découplés.

Pour activer un groupe :

" Dans la liste des groupes, sélectionnez le nom 
du groupe que vous voulez activer. Le nom du 
groupe s'affiche en surbrillance pour indiquer 
qu'il est activé.

Pour activer d'autres groupes, cliquez sur leurs 
noms dans la liste des groupes. 

Le déplacement du fader d'un membre du 
groupe provoque le déplacement des autres 
membres relativement à celui-ci. Si des groupes 
sont en conflit lorsque vous déplacez des faders 
et si un fader appartient à plusieurs groupes, il 
suivra le groupe le plus élevé ou le groupe 
« parent » auquel il appartient.

Pour désactiver un groupe :

" Dans la liste des groupes, sélectionnez le nom 
du groupe que vous voulez désactiver. Le nom 
du groupe cesse de s'afficher en surbrillance 
pour indiquer qu'il est désactivé.

Enregistrement d'une présélection de groupe

Pour enregistrer les paramètres d'attributs 
actuels directement vers un emplacement 
de présélection, maintenez enfoncée la 
touche Pomme (Mac) ou Ctrl (Windows) 
pendant que vous cliquez sur le bouton de 
présélection.

Chargement d'une présélection de groupe
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Sélection de groupes au clavier

Le focus sur le clavier de la liste des groupes 
permet de saisir une lettre identifiant un groupe 
de sorte à activer automatiquement le statut de 
ce groupe.

! Dans la fenêtre Mix, le focus sur le clavier de la 
liste des groupes est toujours actif. 

! Dans la fenêtre Edit, vous devez activer le 
focus pour pouvoir l'utiliser.

Pour activer le focus sur le clavier de la liste des 
groupes, effectuez l'une des opérations 
suivantes :

" Cliquez sur le bouton de focus clavier en haut 
et à droite de la liste des groupes.

– ou –

" Appuyez sur Pomme+Option+3 (Mac) ou sur 
Ctrl+Alt+3 (Windows).

Pour activer ou désactiver des groupes en utilisant 
le focus sur le clavier de la liste des groupes Edit 
et Mix :

" Lorsque le focus est activé, tapez la lettre 
d'identification du groupe (a–z) pour activer ou 
désactiver automatiquement le groupe en 
question.

Isolation temporaire d'une 
commande d'un élément dans le 
cadre d'une opération de groupe

Il est possible d'isoler temporairement la 
commande d'un élément de groupe lors d'une 
opération de groupe en cliquant à l'aide du 
bouton droit de la souris sur l'élément.

Voici les éléments qu'il est possible d'isoler lors 
d'une opération de groupe :

• Curseur de panoramique (Pro Tools HD 
uniquement)

• Préparation à l'enregistrement du canal 
(Pro Tools HD uniquement)

• Fonction TrackInput du canal (Pro Tools 
HD uniquement)

• Curseur de panoramique du départ

• Fader de volume du canal

• Curseur de panoramique du canal

• Bouton de coupure du son d'un canal

• Bouton de mise en solo du canal

• Bouton de préparation à l'enregistrement 
du canal

• Bouton TrackInput du canal

• Fader de départ

• Curseur de panoramique du départ

Focus sur le clavier de la liste des groupes activé

Vous pouvez également suspendre 
temporairement le comportement de groupe 
d'une piste en maintenant enfoncée la 
touche Ctrl (Mac) ou Démarrer (Windows) 
et en cliquant sur la fonction de groupe 
souhaitée.



Guide de référence Pro Tools190

Commandes regroupées avec 
des décalages
Si les commandes suivantes sont regroupées en 
présentant des décalages et déplacées vers leurs 
positions extrêmes, les décalages relatifs sont 
préservés lorsque vous changez à nouveau leur 
position :

• Volume principal

• Panoramique principal (Pro Tools HD 
uniquement)

• Niveau de départ

• Panoramique de départ

Si un fader de volume regroupé est déplacé, par 
exemple, jusqu'à sa valeur maximale, tout autre 
fader de ce groupe possédant une valeur 
supérieure mémorisera leur décalage relatif dès 
que vous abaisserez le premier fader.

Dans les vues d'automation, ce phénomène est 
matérialisé dans la playlist d'automation par des 
points d'inflexion bleus aux niveaux extrêmes 
de la playlist d'automation.

Définition des commandes de 
panoramique groupées afin 
d'ignorer les décalages

Par défaut, les décalages sont préservés pour les 
commandes de panoramique groupées. Dans 
certaines procédures, il est préférable de faire 
correspondre les commandes de panoramique 
groupées aux valeurs absolues plutôt que de 
maintenir les décalages.

Pour définir des commandes de panoramique 
groupées afin d'ignorer les décalages :

1  Choisissez Setup > Preferences et cliquez sur 
Mixing.

2  Sélectionnez l'option « Use Absolute Pan 
Linking ».

Lorsque cette option est activée, les commandes 
de panoramique groupées s'alignent par rapport 
à la valeur absolue de la commande 
panoramique en cours d'ajustement.
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Chapitre 11 : DigiBase

DigiBase et DigiBase Pro (Pro Tools HD et 
Pro Tools LE avec DV Toolkit 2 uniquement) 
allient une interface intuitive de type navigateur 
et un moteur d'utilisation de bases de données 
intégré, optimisé pour la gestion des données et 
supports Pro Tools.

Les navigateurs DigiBase proposent une palette 
complète d'outils de base de données pour les 
opérations de recherche, de tri, d'écoute et 
d'importation de fichiers audio, MIDI et vidéo, 
et de fichiers de paramètres de plug-in (.txf) et de 
session. Il est possible d'afficher et d'organiser 
plusieurs navigateurs en appliquant des 
paramètres d'affichage personnalisé, ceci afin 
d'optimiser votre environnement de travail. 

Eléments DigiBase
La figure 5 présente les différents éléments de 
DigiBase. Les flèches indiquent les déplacements 
possibles des fichiers entre les éléments.

Pour plus d'informations sur les opérations 
de glisser-déposer des fichiers à partir de 
navigateurs DigiBase dans votre session 
Pro Tools, reportez-vous à la section 
Importation d'éléments avec la fonction 
glisser-déposer, page 263.



Guide de référence Pro Tools192

Navigateurs DigiBase

Vous pouvez accéder aux bases de données 
DigiBase par le biais des navigateurs DigiBase 
(voir la figure 6). Les navigateurs permettent 
d'explorer les bases de données DigiBase grâce à 
leur interface utilisateur intuitive dotée de 
nombreuses fonctions de gestion de fichiers (par 
exemple des fonctions de recherche et de tri).

Les navigateurs de Pro Tools sont semblables 
aux fenêtres Windows standard et sont conçus 
spécifiquement pour travailler dans Pro Tools. 
Vous pouvez afficher simultanément plusieurs 
navigateurs et personnaliser l'affichage de 
chaque navigateur.

Les navigateurs permettent de trier des sessions 
et fichiers audio et vidéo et d'y effectuer des 
recherches. Vous pouvez déposer les fichiers 
audio, vidéo et de session affichés dans les 
navigateurs directement dans la session 
Pro Tools active.

Lorsque des éléments hors ligne s'avèrent 
nécessaires, Pro Tools permet de rechercher les 
fichiers correspondants pour rétablir leur lien 
vers le média en ligne. 

Les principaux éléments d'un navigateur 
DigiBase (voir figure 6) sont les suivants : 

Barre de titre : indique le type de navigateur 
(espace de travail, volume, projet ou catalogue) 
et le nom du volume de la session ou du 
catalogue associé. 

Barre d'outils : contient le menu du navigateur, 
l'icône de recherche, des présélections de vues 
(numérotées de 1 à 5) et des outils de navigation. 

Figure 5.  Flux de données entre une session Pro Tools et des navigateurs DigiBase

Navigateur de l'espace de travail

Navigateurs
Catalogues

Navigateur 

Fenêtre Relink
Fenêtre de 

Session 

(DigiBase 
de volumes Pro uniquement)
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Liste des éléments : affiche le contenu de la base 
de données d'un volume, d'un dossier, d'une 
session ou d'un catalogue. 

Colonnes : identifient le type des métadonnées 
des volumes, dossiers et fichiers (par exemple le 
nom du fichier et son format) affichées dans les 
colonnes de la liste des éléments.

• Pour redimensionner une colonne, faites 
glisser le bord de celle-ci. Pour modifier son 
emplacement, faites glisser son en-tête.

• Vous pouvez faire glisser les colonnes vers 
l'un ou l'autre des deux volets disponibles : 
le volet fixe ou le volet de défilement.

Il existe trois types de navigateurs Pro Tools, 
disponibles sur tous les systèmes pris en charge :

• Navigateur de l'espace de travail 
(Workspace)

• Navigateurs de volumes

• Navigateur de projet (Project)

DigiBase Pro (Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 seulement) fournit un navigateur 
supplémentaire :

• Catalogues

Navigateur de l'espace de travail

Le navigateur de l'espace de travail fournit 
l'accès à tous les volumes montés ainsi qu'aux 
dossiers et aux fichiers qu'ils contiennent. 

L'espace de travail permet d'effectuer les 
opérations suivantes :

• Accès à tous les volumes montés

• Accès à tous les catalogues

• Recherche simultanée dans plusieurs 
volumes et catalogues

Figure 6.  Principaux éléments d'un navigateur DigiBase (navigateur de volume illustré)

Barre d'outils

Liste des éléments
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• Sélection des volumes pour 
l'enregistrement et la lecture, la lecture 
seule ou le transfert

• Démontage des volumes

• Affichage, gestion, écoute et importation 
des éléments individuels dans tout 
catalogue ou volume monté

• Mise à jour des bases de données de 
volumes entiers

Navigateurs de volumes

Les navigateurs de volumes permettent de gérer 
des fichiers pour les volumes locaux et du réseau. 
Les volumes sont des partitions formatées sur un 
disque dur. Ouvrez un navigateur de volumes en 
cliquant deux fois sur un volume dans le 
navigateur de l'espace de travail. Tout 
changement effectué dans les navigateurs de 
volumes (tel que la copie, l'effacement ou le 
déplacement de fichiers et de dossiers) se reflète 
directement dans les volumes. Les volumes 
comprennent les disques durs montés, les 
volumes d'archivage de réseau et les CD-ROM.

Les navigateurs de volumes permettent 
d'effectuer les opérations suivantes :

• Affichage, gestion, écoute et importation 
d'éléments individuels dans le volume

• Mise à jour de la base de données pour le 
contenu du volume

Navigateur de projet

Le navigateur de projet fournit des outils de 
recherche et de gestion des fichiers référencés 
dans votre session en cours, quel que soit leur 
emplacement de stockage. Il permet d'effectuer 
les opérations suivantes :

• l'affichage de tous les fichiers média liés à la 
session en cours, y compris tout fichier 
manquant ;

• Affichage, gestion, écoute et placement 
d'éléments individuels

Catalogues 

(DigiBase Pro uniquement)

Les catalogues permettent de gérer les fichiers 
Pro Tools de manière globale. Ils permettent 
d'organiser facilement des fichiers provenant de 
sources diverses dans des bibliothèques 
contenant vos fichiers préférés. Vous pouvez 
trier les catalogues et y effectuer des recherches, 
même lorsque les fichiers auxquels ils font 
référence sont hors ligne. Vous avez aussi la 
possibilité de les utiliser en mode partagé. 

Par ailleurs, les catalogues permettent d'effectuer 
les opérations suivantes :

• Collecte et organisation des fichiers de 
toute combinaison de volumes

• Création des catalogues de volumes 
complets permettant de visualiser et 
recherche de volumes en ligne ou non

• Affichage, gestion, écoute et importation 
des éléments individuels dans le catalogue

• Mise à jour la base de données pour le 
contenu du catalogue

Pour en savoir plus sur le navigateur de 
l'espace de travail, reportez-vous à la 
section Navigateur de l'espace de travail, 
page 228

Pour en savoir plus sur le navigateur de 
projet, reportez-vous à la section Navigateur 
de projet, page 231

Pour en savoir plus sur les catalogues, 
reportez-vous à la section Catalogues 
DigiBase Pro, page 233.
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Fenêtre de tâches

La fenêtre de tâches est un utilitaire conçu pour 
visualiser et gérer toutes les tâches d'arrière-plan 
que vous effectuez avec Pro Tools. Elle permet 
de surveiller, d'interrompre momentanément et 
d'annuler les tâches d'arrière-plan (comme la 
copie de fichiers, les recherches, l'indexation et 
la création de fondus).

Fenêtre Relink

La fenêtre Relink propose des outils et des 
fonctions conçus pour rétablir les liens des 
sessions et des catalogues aux fichiers média. 
Les outils Relink permettent de rechercher et de 
récupérer des fichiers (hors ligne) destinés à la 
session en cours. 

Volumes Performance et 
Transfer
DigiBase permet de visualiser, de gérer et 
d'importer des sessions et du média à la fois 
depuis le volume Performance et le volume 
Transfer.

Volumes Performance : volumes de stockage 
(disques durs) adaptés à la lecture et sélectionnés 
à partir du navigateur de l'espace de travail pour 
l'enregistrement et la lecture (R) ou la lecture 
uniquement (P) de fichiers médias dans une 
session Pro Tools.

Volumes Transfer : volumes non pris en charge 
pour la lecture de médias dans Pro Tools (tels 
que les volumes de réseau partagés ou les 
CD-ROM) ou volumes de stockage (disques durs) 
choisis dans le navigateur de l'espace de travail 
comme volumes Transfer (T). Ceux-ci ne peuvent 
pas être utilisés pour enregistrer ou lire des 
fichiers médias dans une session Pro Tools. 
Les volumes Transfer (T) peuvent être utiles 
pour transférer une session et des fichiers médias 
entre différents systèmes Pro Tools.

Pour en savoir plus sur la fenêtre de tâches, 
reportez-vous à la section Fenêtre de tâches, 
page 238.

Pour en savoir plus sur la fenêtre Relink, 
reportez-vous à la section Fenêtre Relink, 
page 224

Pour plus d'informations sur le choix des 
volumes, consultez Indicateurs de volumes 
audio et vidéo, page 229.
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Base de données Digidesign
Les informations affichées dans les navigateurs 
sont sauvegardées dans des bases de données 
individuelles. Pro Tools crée ces bases de 
données automatiquement pour tous les 
volumes montés, notamment les volumes 
Transfer.

Les bases de données Digidesign utilisent trois 
types de fichiers :

volume.ddb : stocke des métadonnées de fichiers 
média et de session dans un volume particulier.

catalog.ddb (DigiBase Pro uniquement): 
stocke des métadonnées de fichiers média et de 
session pour un catalogue défini par l'utilisateur. 
Les fichiers de session et médias catalogués 
peuvent résider sur plusieurs volumes, 
notamment les volumes Transfer.

Wavecache.wfm : contient des aperçus de forme 
d'onde pour les fichiers référencés par chaque 
session.

Bases de données de volumes de 
lecture/écriture (disques durs) :

pour chaque volume, un fichier de base de 
données distinct est généré dans un dossier 
intitulé Digidesign Databases, à la racine du 
volume. La base de données est sauvegardée 
avec le volume qu'elle décrit, de sorte que si vous 
déplacez ultérieurement le volume dans un 
autre système, vous n'aurez pas besoin de recréer 
la base de données.

Volumes de bases de données en lecture seule

(CD/DVD-ROM et volumes protégés contre 
l'écriture)

Comme les données ne peuvent pas être écrites 
sur des volumes en lecture seule, les bases de 
données de ces volumes sont stockées 
localement sur votre disque dur. 

Sous Windows, elles sont stockées dans le 
dossier Program Files\Digidesign\Pro Tools\
Databases\Volumes. 

Sous Mac, elles sont stockées dans le dossier 
Library/Application Support/Digidesign/ 
Databases/Volumes. 

Bases de données de volumes partagés sur le 
réseau

Bien qu'un volume partagé permette la lecture et 
l'écriture de données, Pro Tools le considère 
comme un volume réservé uniquement à la 
lecture et aucune base de données n'est stockée 
sur le volume partagé. Par conséquent, les bases 
de données pour les volumes partagés sont 
stockées localement sur le disque dur. 

Sous Windows, elles sont stockées dans le 
dossier Program Files\Digidesign\Pro Tools\
Databases\Volumes.

Sous Mac, les bases de données de volumes sont 
stockées dans le dossier Library/Application 
Support/Digidesign/Databases/Volumes.

La suppression du dossier Digidesign 
Database entraîne la perte de toutes les 
informations des bases de données 
existantes. Pour recréer un dossier de bases 
de données Digidesign que vous avez effacé, 
vous devez réindexer le volume (voir 
Indexation des bases de données DigiBase, 
page 202).
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Partage de fichiers de base de données

Les utilisateurs peuvent partager des fichiers de 
bases de données. Cela s'avère particulièrement 
utile pour les volumes Transfer car cela évite 
d'avoir à copier (indexer) les données.

Ainsi, la taille des volumes partagés (comme les 
volumes d'archivage de réseau) est souvent 
importante et leur indexation peut prendre un 
temps considérable. Pour éviter de perdre du 
temps en effectuant une copie, vous pouvez 
indexer une seule fois manuellement une partie 
(ou la totalité) du volume partagé et envoyer les 
fichiers de bases de données à d'autres 
utilisateurs par courrier électronique. 
Ces derniers pourront ajouter les fichiers de base 
de données en les faisant glisser dans leur dossier 
Volumes. Une indexation manuelle et 
périodique permet par la suite de maintenir à 
jour toutes les bases de données.

Partage de catalogues 

(DigiBase Pro uniquement)

Il est possible de créer des catalogues pour un 
projet particulier et de les partager entre 
plusieurs systèmes afin d'optimiser votre travail. 
Les catalogues DigiBase Pro sont stockés sous 
forme de fichiers de bases de données sur votre 
disque dur. 

Sous Windows, ils sont stockés dans le dossier 
Program Files\Digidesign\Pro Tools\
Databases\Catalogs. 

Sous Mac, ils sont stockés dans le dossier 
Library/Application Support/Digidesign/ 
Databases/Catalogs.

Fenêtres et outils des 
navigateurs
Les navigateurs affichent tous les fichiers 
contenus dans leur base de données (consultez 
figure 7, page 198), y compris les fichiers 
Pro Tools et autres que Pro Tools. Ils peuvent 
aussi afficher les types de fichiers inconnus ainsi 
que les alias et les dossiers du bureau. 

DigiBase n'affiche pas tous les fichiers, ceci afin 
d'optimiser la vitesse de traitement et de 
protéger des éléments vitaux. Par exemple, sous 
Windows, les navigateurs DigiBase n'affichent 
pas les dossiers Program Files, Windows, 
Digidesign Databases, WU Temp et System 
Volume Information ; sous Mac, ils n'affichent 
pas les dossiers System, Applications, Library ou 
Digidesign Databases. Par conséquent, ces 
dossiers ne sont pas concernés par les fonctions 
d'indexation, de recherche, de tri et ne sont 
nullement affectés par toute autre tâche 
entreprise dans DigiBase. Nous vous conseillons 
de ne sauvegarder aucune session Pro Tools ou 
fichier média dans ces dossiers.

Les principaux éléments d'un navigateur 
DigiBase (voir figure 6, page 193) sont les 
suivants :

Barre de titre : elle spécifie le type de navigateur 
(espace de travail, volume ou projet) et le nom 
du volume ou du catalogue associé. 

Barre d'outils : elle propose un menu de 
navigation, une icône de recherche, des 
présélections d'affichage et des outils de 
navigation.

Liste des éléments : elle affiche le contenu de la 
base de données d'un volume, d'un dossier, 
d'une session ou d'un catalogue. 
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Colonnes : elles affichent les métadonnées 
(telles que le nom et le format de fichier) pour 
les volumes, les dossiers et les fichiers de la Liste 
des éléments.

Chaque ligne de données du navigateur 
représente un élément (par exemple un fichier 
ou un dossier). Les données disponibles pour 
chaque élément sont affichées dans des 
colonnes. Vous pouvez organiser et placer les 
colonnes dans le volet fixe ou le volet de 
défilement. 

Figure 7.  Outils, volets et colonnes de base du navigateur (navigateur de l'espace de travail illustré)
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Ouverture des navigateurs

Vous disposez de plusieurs méthodes pour 
ouvrir, fermer et vous déplacer dans les 
navigateurs.

Pour ouvrir le navigateur de l'espace de travail :

" Choisissez Window > Workspace. 

Pour ouvrir un navigateur de volumes :

1  Ouvrez le navigateur de l'espace de travail 
(Windows > Workspace). 

2  Cliquez deux fois sur un volume ou dossier 
dans la liste des éléments. Un nouveau 
navigateur de volume s'affiche.

Pour ouvrir le navigateur de projet : 

1  Ouvrez une session de Pro Tools.

2  Choisissez Window > Project.

Pour ouvrir un navigateur de catalogue 
(DigiBase Pro uniquement) :

1  Ouvrez le navigateur de l'espace de travail 
(Windows > Workspace). 

2  Cliquez sur l'icône Développer/Réduire située 
en regard de l'icône Catalogs pour afficher tous 
les catalogues si ceux-ci ne sont pas déjà visibles. 

3  Cliquez deux fois sur un catalogue. 

Pour ouvrir un autre volume ou un catalogue dans 
une nouvelle fenêtre de navigateur tout en laissant 
le navigateur de volumes ou de catalogues actuel 
ouvert :

" Tout en maintenant la touche Ctrl (Windows) 
ou Pomme (Mac) enfoncée, cliquez deux fois sur 
le volume ou sur le catalogue. 

Affichage du contenu d'un volume, 
dossier ou catalogue

Pour développer ou réduire le dossier sélectionné, 
effectuez une des actions suivantes :

" Cliquez sur l'icône Développer/Réduire en 
regard du dossier.

– ou –

" Sélectionnez un volume, un dossier ou un 
catalogue et cliquez sur la touche fléchée Droite 
pour développer l'arborescence ou sur la touche 
fléchée Gauche pour la réduire.

Pour vous déplacer d'un niveau vers le haut dans le 
navigateur : 

" Cliquez sur la flèche de retour de la barre 
d'outils du navigateur. 

Placement des navigateurs au premier 
plan ou en arrière-plan

Pour placer tous les navigateurs ouverts au 
premier plan :

" Choisissez Window > Browsers > Bring to 
Front. 

Pour remonter d'un niveau dans le 
navigateur, maintenez la touche Ctrl 
(Windows) ou Pomme (Mac) enfoncée et 
appuyez sur la touche fléchée Haut.

Icône de fonction de navigation

Pour déplacer les navigateurs situés au 
premier plan à l'arrière-plan, appuyez sur 
les touches Alt+J (Windows) ou Option+J 
(Mac).

Flèche de retour du navigateur
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Pour faire passer tous les navigateurs en 
arrière-plan :

" Sélectionnez Windows > Browsers > 
Send to Back. 

Tous les navigateurs ouverts passent alors en 
arrière-plan, les autres fenêtres se plaçant au 
premier plan. Les navigateurs restent actifs et 
accessibles. 

Pour ramener un navigateur ouvert au 
premier plan :

" Choisissez Windows > Browsers et 
sélectionnez un navigateur ouvert dans le 
sous-menu.

Pour passer au navigateur suivant ou précédent :

" Appuyez sur la touche Ctrl (Windows) ou 
Pomme (Mac) et utilisez les touches fléchées 
Gauche/Droite.

Fermeture des navigateurs

Pour fermer tous les navigateurs :

" Cliquez sur la case de fermeture du navigateur 
tout en maintenant enfoncée la touche Alt 
(Windows) ou Option (Mac). 

Utilisation des éléments des 
navigateurs

Ouverture d'une session

Pour ouvrir une session Pro Tools répertoriée dans 
un navigateur :

" Cliquez deux fois sur un fichier de session 
Pro Tools, lorsque aucune session n'est ouverte. 

Ouverture de séquences AAF et OMF

(DigiTranslator uniquement)

Sur des systèmes dotés de l'option 
DigiTranslator 2.0, il est possible d'ouvrir des 
séquences AAF et OMF depuis les navigateurs 
DigiBase.

Vous pouvez aussi faire glisser les séquences AAF 
et OMF des navigateurs pour les déposer dans la 
session en cours.

Pour ouvrir une séquence AAF ou OMF depuis un 
navigateur DigiBase :

1  Effectuez l'une des opérations suivantes :

• Cliquez deux fois sur une séquence AAF ou 
OMF dans un navigateur, lorsque aucune 
session Pro Tools n'est ouverte

– ou –

• Déposez la séquence AAF ou OMF depuis le 
navigateur vers la timeline dans une 
session ouverte.

2  Configurez la boîte de dialogue Import Session 
Data.

3  Cliquez sur OK.

Pour placer tous les navigateurs en 
arrière-plan, appuyez sur les touches 
Alt+Maj+J (Windows) ou Option+Maj+J 
(Mac).

Etant donné que la fenêtre de tâches est un 
utilitaire et non un navigateur, elle reste 
ouverte.

Pour plus d'informations sur l'importation 
de séquences AAF et OMF, reportez-vous au 
manuel DigiTranslator Integrated Option 
Guide.
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Création et ouverture de dossiers

Les navigateurs permettent de créer et de 
manipuler des dossiers (sous-répertoires du 
système de fichiers). Tous les dossiers 
comportent une icône Développer/Réduire 
destinée à afficher leur contenu. Lorsque vous 
faites glisser des éléments vers l'icône d'un 
dossier, cela revient à les faire glisser vers un 
navigateur ouvert. 

Pour créer un dossier dans un navigateur de 
volumes ou un catalogue :

1  Choisissez New Folder dans le menu de 
navigation. 

2  Donnez un nom au dossier, puis cliquez 
sur OK (cliquez sur Cancel pour annuler la 
création).

Dans les navigateurs de volumes, le dossier est 
créé sur le disque. En ce qui concerne les 
catalogues, le dossier est uniquement généré 
dans le catalogue. La liste d'éléments est mise à 
jour quand vous ajoutez de nouveaux éléments. 

Pour ouvrir un dossier dans le navigateur en 
cours :

" Cliquez deux fois sur le dossier ou cliquez sur 
l'icône Développer/Réduire correspondant à 
l'élément souhaité. 

Pour créer et ouvrir un nouveau dossier dans son 
propre navigateur :

" Tout en maintenant la touche Ctrl (Windows) 
ou Pomme (Mac) enfoncée, cliquez deux fois sur 
le dossier. La fenêtre du navigateur précédent 
(parent) reste ouverte. 

Défilement et déplacement de 
sélections

Pour faire défiler le volet actif vers le haut ou 
le bas :

" Appuyez sur la touche du clavier Page préc. ou 
Page suiv.

Pour atteindre le haut ou le bas du volet actif :

" Appuyez sur la touche Origine (pour aller en 
haut) ou Fin (pour aller en bas).

Pour déplacer les éléments vers le haut ou vers le 
bas dans le navigateur en cours :

1  Sélectionnez les éléments souhaités dans le 
navigateur, en vérifiant que la fenêtre en 
question se trouve au premier plan. 

2  Appuyez sur la touche fléchée Haut ou Bas.

Entrée de texte dans les navigateurs

Vous pouvez éditer de nombreuses zones 
d'entrée de texte pour remplacer ou mettre à 
jour les données d'un élément. 

Une fois le navigateur mis au premier plan 
et le dossier sélectionné, appuyez sur la 
touche fléchée Bas tout en maintenant la 
touche Ctrl (Windows) ou Pomme (Mac) 
pour ouvrir un dossier dans le navigateur 
actif.

Une fois le navigateur mis au premier plan 
et le dossier sélectionné, appuyez sur les 
touches Ctrl+Alt+touche fléchée Bas 
(Windows) ou Pomme+Option+touche 
fléchée Bas (Mac) pour ouvrir un dossier 
dans le nouveau navigateur lui 
correspondant.
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Pour éditer une zone d'entrée de texte et en sortir 
en restaurant le statut d'affichage précédent :

" Appuyez sur Entrée.

Pour restaurer le texte précédent en annulant 
l'édition de texte :

" Appuyez sur la touche Echap.

Sélection des volumes pour 
l'enregistrement, la lecture et le 
transfert

Pour mener à bien la gestion des volumes et des 
données, le navigateur de l'espace de travail 
permet de désigner des volumes R 
(enregistrement et lecture), P (lecture 
seulement) ou T (transfert). Le navigateur 
comporte aussi des colonnes distinctes pour les 
libellés audio (« A ») et vidéo (« V »). 

Pour plus de détails sur le choix des volumes, 
consultez la section Indicateurs de volumes 
audio et vidéo, page 229. 

Indexation des bases de 
données DigiBase
L'indexation désigne le procédé de lecture des 
fichiers média, d'extraction des métadonnées 
pour chaque fichier et de sauvegarde de ces 
données dans une base de données associée, en 
vue d'afficher ces données dans les colonnes 
d'un navigateur. Une fois un volume ou un 
dossier entièrement indexé, vous pouvez y 
effectuer des recherches rapides, car toutes les 
métadonnées sont déjà triées et organisées.

Un volume ou un dossier qui n'a pas été indexé 
le sera automatiquement lors de sa première 
ouverture dans un navigateur DigiBase. Pour les 
volumes ou dossiers comprenant une quantité 
importante de fichiers média, l'indexation peut 
prendre un certain temps. Vous pouvez par 
conséquent souhaiter indexer manuellement 
des volumes ou des fichiers spécifiques avant de 
démarrer un projet, ceci afin d'accélérer le 
processus.

Indexation pendant la navigation

La première fois que vous ouvrez un navigateur 
de volumes pour un volume ou un dossier qui 
n'a jamais été indexé, Pro Tools remplit 
automatiquement la base de données pour le 
niveau en question du volume. Le navigateur 
affiche des fichiers et des dossiers dans la liste 
d'éléments, ainsi que des métadonnées dans les 
colonnes de chaque élément. L'indexation se 
poursuit jusqu'à ce que vous refermiez le 
navigateur ou que le dossier soit entièrement 
indexé. 

La prochaine fois que vous ouvrirez le 
navigateur en question, il affichera 
immédiatement les métadonnées des éléments 
déjà indexés. Si vous avez refermé le navigateur 
ou le dossier avant la fin de l'indexation ou que 
le contenu du dossier a changé depuis votre 
dernière navigation, Pro Tools effectuera 
automatiquement la mise à jour de la base de 
données lors de la prochaine ouverture. La base 
de données est donc toujours parfaitement à 
jour pour le dossier où vous naviguez. Affichez le 
Gestionnaire des tâches pour vérifier l'activité 
en cours.

L'indexation pendant la navigation permet de 
gagner du temps, car elle complète seulement la 
base de données pour les éléments du volume 
actuellement parcouru. Par exemple, si vous 
naviguez dans la racine du volume, l'indexation 

Pour plus de détails sur l'édition des 
colonnes, consultez la section Données des 
colonnes, page 207.
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porte seulement sur les dossiers et fichiers au 
niveau de la racine. Si vous ouvrez un dossier, 
Pro Tools indexe uniquement les éléments dans 
ce dossier. Une base de données est donc 
uniquement indexée pour les parties du volume 
dans lesquelles vous avez navigué. Cependant, 
les recherches sont plus rapides et complètes si 
un volume a déjà été entièrement indexé. 

Indexation manuelle

L'indexation manuelle fournit toutes les 
données manquantes et met à jour les données 
modifiées pour les dossiers sélectionnés et tous 
leurs sous-dossiers. 

Pour mettre à jour l'index d'un dossier et de tous 
ses sous-dossiers :

1  Choisissez l'élément souhaité dans la liste 
d'éléments d'un navigateur. 

2  Choisissez l'option Update Database for 
Selected dans le menu de navigation. 

Pour mettre à jour l'index d'un volume entier :

1  Choisissez le volume à mettre à jour dans le 
navigateur de l'espace de travail. 

2  Choisissez l'option Update Database for 
Selected dans le menu de navigation. 

Affichage de la date de la dernière indexation

La colonne Last Indexed indique la date à 
laquelle l'index du dossier et de tous ses 
sous-dossiers a été mis à jour. Notez qu'il est 
possible que certains sous-dossiers aient été mis 
à jour plus récemment.

Mise à jour automatique des actions de 
Pro Tools

Dès que Pro Tools ajoute, efface ou modifie un 
fichier d'un volume ou d'une session, la base de 
données appropriée est immédiatement mise à 
jour pour refléter le changement opéré. 

Menu de navigation 
Toutes les fenêtres de navigateur proposent un 
menu de navigation dans le coin supérieur 
gauche de leur barre d'outils. Ce menu offre des 
commandes propres à chaque type de 
navigateur, comme décrit ci-dessous. 

Toutes les commandes de navigation ne sont 
pas disponibles dans les différents navigateurs, 
comme expliqué ci-après.

New Folder : crée un dossier dans le volume ou 
le catalogue actuel. Dans les navigateurs de 
volumes, cette commande crée un dossier sur le 
disque. Pour plus d'informations, reportez-vous 
à la section Création et ouverture de dossiers, 
page 201.

Update Database for Selected : met à jour la 
base de données des volumes ou dossiers 
sélectionnés.

Les changements effectués avec 
l'Explorateur Windows ou le Finder Mac 
(par exemple la copie ou le déplacement de 
fichiers) ne sont pas pris en compte par 
Pro Tools et ne sont donc indexés que si 
vous parcourez le dossier correspondant ou 
que vous effectuez une indexation 
manuelle.

Icône du menu de navigation

Menu de 
navigation
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New Catalog : crée un catalogue. Cette 
opération doit s'effectuer avec DigiBase Pro. 

Create Catalog from Selection : crée un 
catalogue entièrement indexé pour les éléments 
sélectionnés. Cette opération doit s'effectuer 
avec DigiBase Pro. 

Calculate Waveform : calcule l'affichage de 
forme d'onde pour les fichiers audio 
sélectionnés ou tous les fichiers des dossiers 
choisis. 

Reveal in Finder/Explorer : ouvre la fenêtre 
parente correspondant au fichier sélectionné 
dans le Finder (Mac) ou dans l'Explorateur 
(Windows). 

Reveal in Browser : ouvre le navigateur parent 
pour l'élément sélectionné. L'élément choisi 
apparaît en surbrillance dans son navigateur 
parent.

Select Offline Files : sélectionne tous les fichiers 
hors ligne (« offline »).

Select Transfer Files : sélectionne tous les 
fichiers identifiés comme des fichiers de 
transfert (résidant sur des supports ne 
permettant pas la lecture). 

Select Online Files : sélectionne tous les fichiers 
en ligne (« online »). 

Invert Selection : inverse la sélection.

Copy and Relink : copie les éléments 
sélectionnés dans le navigateur de projet vers un 
emplacement donné et établit le lien entre la 
session et les copies plutôt que vers les fichiers 
originaux. Utilisez cette commande pour 
déplacer facilement des fichiers d'un volume 
Transfer vers un volume Performance. 
Cette commande est aussi disponible dans les 
catalogues de DigiBase Pro pour copier des 
éléments et relier le catalogue actuel aux copies. 

Relink Offline : ouvre la fenêtre Relink 
(commande uniquement disponible dans les 
navigateurs de projets).

Relink Selected : ouvre la fenêtre Relink avec 
tous les fichiers sélectionnés du navigateur actuel 
affichés et définis comme fichiers à aligner (Files 
to Match). Uniquement disponible dans les 
catalogues et les navigateurs de projets.

Duplicate Selected : effectue une copie des 
éléments sélectionnés au même emplacement. 

Lock Selected : verrouille tous les éléments 
sélectionnés. Tous les fichiers déjà verrouillés le 
restent. En verrouillant un dossier, vous 
verrouillez tous ses fichiers et sous-dossiers. 

Unlock Selected : déverrouille les éléments 
sélectionnés. 

Delete Selected :  efface tout élément 
sélectionné. Dans les navigateurs de l'espace de 
travail, de projets et de volumes, l'effacement 
d'un élément le supprime sur le disque. Pour les 
catalogues, un message vous demande si vous 
voulez effacer les éléments du catalogue (en 
conservant vos disques intacts) ou effacer les 
fichiers référencés par les éléments du catalogue. 

Unmount : permet de démonter tout volume en 
ligne (commande uniquement disponible dans 
le navigateur de l'espace de travail). 

Spacebar Toggles File Preview : active ou 
désactive la barre d'espace pour afficher ou 
annuler l'affichage de l'aperçu. Lorsque cette 
option est désactivée, utilisez le bouton Preview 
pour afficher ou annuler l'affichage de l'aperçu. 

Tant que Pro Tools s'exécute, utilisez 
toujours la commande Unmount du menu 
Workspace pour démonter un volume. Vous 
pouvez aussi quitter Pro Tools et démonter 
le volume. 
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Auto-Preview : active ou désactive l'aperçu 
automatique des fichiers. La sélection d'un 
fichier dans le navigateur lance l'affichage de 
l'aperçu lorsque cette option est activée. 
Le bouton Preview est mis à jour et indique 
l'activation de l'aperçu automatique.

Loop Preview : affiche l'aperçu le fichier 
sélectionné en effectuant une lecture en boucle 
du fichier. Si plusieurs fichiers sont sélectionnés, 
seul l'aperçu du premier fichier s'affiche. 
Le bouton Preview est mis à jour et indique 
l'activation de l'aperçu en boucle.

Commandes DigiBase Pro 
supplémentaires

(Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement)

Les catalogues proposent les fonctions 
complémentaires suivantes pour la gestion des 
commentaires dans les éléments sélectionnés. 

Copy Database Comments to Clip Names : copie 
les commentaires de la base de données d'une 
entrée vers son nom de clip. 

Copy File Comments to Clip Names (Mac 
uniquement) : copie les commentaires de fichier 
d'un élément vers le nom de clip. 

Volets et options d'affichage 
des navigateurs
Les fenêtres de navigateur affichent une liste 
d'éléments divisée en plusieurs colonnes (telles 
que nom, taille, date de création et fréquence 
d'échantillonnage du fichier). La liste des 
éléments est scindée en deux volets. 
Vous pouvez placer les colonnes dans chacun de 
ces deux volets ; chaque colonne peut en outre 
être masquée et réaffichée, redimensionnée ou 
réordonnée. 

Déplacement de colonnes dans 
les volets

Vous pouvez placer les colonnes du navigateur 
dans le volet de votre choix. Déplacez les 
colonnes qui vous servent le plus dans le volet 
de gauche. Si certaines colonnes vous servent 
moins fréquemment, vous pouvez les déplacer 
dans le volet de droite. 

Pour déplacer les colonnes dans les volets :

" Cliquez sur l'en-tête de colonne et faites la 
glisser dans un autre volet. 

Pour afficher ou masquer le volet de droite :

" Cliquez sur l'icône Afficher/Masquer dans 
l'angle inférieur droit du volet de gauche. 

Pour afficher ou annuler l'affichage de 
l'aperçu avec un navigateur « frontmost », 
utilisez les combinaisons de touches Ctrl+P 
(Windows) ou Pomme+P (Mac). La touche 
Echap permet également d'interrompre 
l'aperçu.

Pour plus d'informations sur les 
commentaires, consultez la section Zones 
de commentaires, page 210.

Icône Afficher/Masquer le volet

Afficher/Masquer
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Organisation et redimensionnement 
des colonnes

Pour réorganiser les colonnes d'un volet :

" Faites glisser l'en-tête de la colonne à 
l'emplacement souhaité.

Pour redimensionner une colonne :

" Faites glisser la limite de l'en-tête de colonne 
jusqu'à la largeur souhaitée. 

Affichage et masquage des colonnes

Vous pouvez masquer ou afficher des colonnes 
dans les navigateurs DigiBase en fonction de 
votre rythme de travail. L'affichage par défaut 
des colonnes inclut les éléments utilisés dans la 
plupart des sessions.

Pour afficher ou masquer une colonne :

" Cliquez sur l'étiquette de la colonne en 
maintenant la touche Démarrage (Windows) ou 
Ctrl (Mac) enfoncée ou cliquez avec le bouton 
droit de la souris sur l'étiquette, puis 
sélectionnez ou désélectionnez le nom de la 
colonne dans le menu contextuel. 

Pour afficher ou masquer toutes les colonnes :

" Cliquez sur l'en tête d'une colonne en 
maintenant la touche Démarrage (Windows) ou 
Ctrl (Mac) enfoncée ou cliquez avec le bouton 
droit de la souris sur l'en-tête et sélectionnez ALL 
ou NONE dans le menu contextuel. Lorsque 
vous sélectionnez NONE, seules les colonnes 
Name et Clip Name s'affichent.

Pour afficher le jeu de colonnes par défaut :

" Cliquez sur l'en-tête d'une colonne en 
maintenant la touche Démarrage (Windows) ou 
Ctrl (Mac) enfoncée ou cliquez avec le bouton 
droit de la souris sur l'en-tête et sélectionnez 
DEFAULT dans le menu contextuel. 

Présélections d'affichage

Pro Tools permet de sauvegarder jusqu'à 
5 présélections d'affichage pour chaque type de 
navigateur et la fenêtre Relink. Vous pouvez 
charger ces présélections en cliquant sur le 
bouton de présélection d'affichage (View Preset) 
souhaité. Vous disposez de présélections 
d'affichage pour chaque type de navigateur.

Pour sauvegarder une présélection d'affichage :

1  Ouvrez un navigateur ou la fenêtre Relink. 

2  Organisez les colonnes et les vues. 

3  Cliquez sur un des cinq boutons de 
présélection d'affichage (View Preset) en 
maintenant enfoncée la touche Pomme (Mac) 
ou Ctrl (Windows). 

Affichage et masquage des colonnes

Boutons de présélection d'affichage

Présélections d'affichage du navigateur
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Pour charger une présélection sauvegardée :

" Cliquez sur le bouton de présélection 
d'affichage approprié.

A propos de la présélection d'affichage 1

La présélection 1 devient la présentation par 
défaut pour les navigateurs du même type 
quand vous les ouvrez pour la première fois. 

Tri des colonnes

Vous pouvez trier les colonnes par ordre 
croissant ou décroissant ; vous disposez 
également d'options de tris multiples (jusqu'à 
quatre niveaux).

Pour effectuer un tri par colonnes :

" Cliquez sur l'en-tête de la colonne souhaitée. 

Un tri secondaire s'avère souvent très utile (vous 
pouvez par exemple effectuer un tri par bande 
ou par marquage temporel). 

Pour effectuer un tri secondaire :

" Cliquez sur le titre de colonne correspondant 
au critère de recherche du tri secondaire en 
maintenant enfoncée la touche Alt (Windows) 
ou Option (Mac). 

Pour passer du tri par ordre croissant au tri par 
ordre décroissant :

" Cliquez sur la flèche de tri en haut de la barre 
de défilement verticale. 

Données des colonnes
Dans les navigateurs, chaque rangée de données 
représente un élément d'une base de données 
(par exemple, un fichier, une session ou un 
volume). Chaque colonne affiche des données 
spécifiques à un élément, comme décrit 
ci-dessous.

Status : première colonne du navigateur 
indiquant l'état de chaque élément, comme 
décrit ci-dessous.

Name : affiche le nom du fichier, du dossier, du 
volume, du catalogue ou de la session. Cette 
zone de texte peut être éditée dans tous les 
navigateurs sauf les catalogues. 

A : désigne les volumes pour l'enregistrement et 
la lecture (R), la lecture seule (P) ou le transfert 
(T) audio (commande uniquement disponible 
dans le navigateur de l’espace de travail).

V : désigne les volumes pour l'enregistrement et 
la lecture (R), la lecture seule (P) ou le transfert 
(T) audio (commande uniquement disponible 
dans le navigateur de l'espace de travail). 

Tri secondaire

Icônes et affichage de l'état

Icône Texte Etat

Aucune En noir En ligne

Aucune En caractères 
italiques bleus

Hors ligne

T En caractères 
italiques bleus

Transfert

Pour plus d'informations, reportez-vous à la 
section Indicateurs de volumes audio 
et vidéo, page 229.
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Kind : spécifie s'il s'agit d'un volume, d'un 
dossier, d'un catalogue ou d'un fichier. Pour les 
fichiers, cette colonne affiche le type : fichier de 
session, audio, vidéo ou autre. Cette zone ne 
peut pas être éditée. 

Size : affiche la taille d'un fichier, exprimée en 
Ko. Pour les dossiers, affiche la taille totale de 
tous les fichiers contenus dans ce dossier. Cette 
zone ne peut pas être éditée.

Date Indexed : affiche la date de la dernière 
indexation de l'élément. Cette zone ne peut pas 
être éditée.

Capacity : affiche la capacité totale d'un volume. 
Cette zone ne peut pas être éditée. 

Free : affiche la capacité disponible des 
volumes. Cette zone ne peut pas être éditée. 

Waveform : affiche une représentation 
graphique du fichier audio. Pour plus 
d'informations, reportez-vous à la section 
Formes d'onde et écoute, page 210.

Duration : affiche la durée d'un fichier en temps 
absolu (horloge murale), quel que soit le format 
du code temporel. Pour les groupes de régions, 
les mesures et temps s'affichent dans la colonne 
Duration. Cette zone ne peut pas être éditée.

File Comment : affiche tout commentaire associé 
au fichier. Les commentaires sur un fichier sont 
pris en charge avec les fichiers BWF et SD II, 
mais ne le sont pas avec les fichiers AIFF. Les 
commentaires restent associés à leurs fichiers 
quand vous les copiez, les convertissez ou les 
transférez. Pour plus d'informations, 
reportez-vous à la section Zones de 
commentaires, page 210.

Database Comment : affiche des commentaires 
de l'utilisateur sauvegardés dans la base de 
données, tout en prenant en charge les 
commentaires du Finder (commande 

uniquement disponible pour le navigateur 
Project et les catalogues). Pour plus 
d'informations, reportez-vous à la section Zones 
de commentaires, page 210.

Date Modified : affiche la date de la dernière 
modification de l'élément. Cette zone ne peut 
pas être éditée.

Date Created : affiche la date de création d'un 
élément. Cette zone ne peut pas être éditée. 

Number of Channels : affiche le nombre de 
canaux dans un fichier audio : mono, stéréo ou 
3-8 appropriés pour les fichiers multicanaux 
compatibles. Cette zone ne peut pas être éditée.

Format : affiche le format d'un fichier audio (tel 
que BWF (.WAV) ou AIFF). Cette zone ne peut 
pas être éditée. 

Sample Rate : affiche la fréquence 
d'échantillonnage d'un fichier audio. Ce champ 
ne peut être édité dans des navigateurs que pour 
les fichiers WAV et SDII. Cette colonne peut 
s'avérer utile lors du travail avec des données 
audio qui ont été accélérées ou ralenties ou pour 
forcer la conversion de fréquence 
d'échantillonnage avant l'importation d'un 
fichier qui à l'origine ne nécessitait aucune 
conversion. 

Bit Depth : affiche la résolution d'un fichier 
audio. Cette zone ne peut pas être éditée.

Tempo : affiche le tempo associé aux fichiers 
MIDI, REX, ACID, de groupe de régions et de 
session. Cette zone ne peut pas être éditée.

Original Time Stamp : affiche le marquage 
temporel d'origine (emplacement du timecode) 
des fichiers audio ou vidéo.

User Time Stamp : affiche, le cas échéant, le 
marquage temporel défini par l'utilisateur pour 
les fichiers audio.
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Path : affiche le chemin d'accès à l'élément. 

Unique ID : affiche l'identifiant (ID) unique d'un 
fichier Pro Tools. 

Tape (DigiTranslator 2.0 uniquement) : Cette 
colonne affiche le nom original de la bande Avid 
si l'élément est un fichier OMF (audio ou vidéo). 
Si, à l'origine, le fichier audio a été enregistré 
dans une session Pro Tools, cette zone affiche le 
nom de la session d'origine. Les fichiers vidéo 
qui à l'origine ont été enregistrés dans Pro Tools 
avec AVoption|XL n'affichent pas de nom de 
bande.

TC Rate : Si DigiTranslator 2.0 est installé, cette 
colonne affiche la fréquence d'échantillonnage 
de l'élément s'il s'agit d'une séquence AAF ou 
d'une séquence ou d'un fichier OMF : 24, 25, 
29.97, 30, drop ou non-drop. Pour les 
séquences, la fréquence d'échantillonnage au 
début de la séquence sera affichée.

Video Compression : affiche le taux de 
compression des fichiers vidéo.

Frame Rate : affiche la fréquence d'images des 
fichiers vidéo.

Channel Names : affiche le nom de canal et le 
nombre de données intégrés dans les fichiers 
audio multicanaux. Cette zone ne peut pas être 
éditée.

Scene : affiche les données de numéro de scène 
intégrées dans des fichiers audio. 

Take : affiche les données de numéro de prise 
intégrées dans des fichiers audio.

Shoot Date : affiche les informations 
concernant la date et l'heure de génération 
insérées dans les fichiers audio. Cette zone ne 
peut pas être éditée.

Sound Roll : affiche les données de nombre de 
bande son (en général, elles sont nommées 
« Tape » dans les fichiers BWF, mais sont 
distinctes de la date affichée dans la colonne 
DigiBase Tape). Cette zone ne peut pas être 
éditée.

Sound Roll TC : affiche le timecode de départ de 
fichiers audio. Cette zone ne peut pas être 
éditée.

Sound Roll TC Rate : affiche les informations sur 
la fréquence d'images insérées dans les fichiers 
audio : 24, 25, 29.97, 30, drop ou non-drop. 
Cette zone ne peut pas être éditée.

User Bits : affiche des informations texte 
insérées dans les fichiers audio. Vous pouvez 
utiliser ce champ pour les commentaires 
utilisateur ou les informations auto-générées 
avec certains enregistreurs portables.

Tape ID : affiche des informations d'identifiant 
de bande insérées dans les fichiers audio. Cette 
zone ne peut pas être éditée.

Project : affiche les données de nom de projet 
intégrées dans des fichiers audio.

Circled : indique si l'état d'une prise est 
paramétré sur « circled » (No ou Yes) dans les 
fichiers audio. Cette option sert en général à 
indiquer la prise à utiliser.

Plug-In Name : affiche le nom du plug-in pour 
les fichiers Plug-in Settings (.txf).

Plug-in Manufacturer Name : affiche le nom du 
plug-in fabricant pour les fichiers Plugin 
Settings (.txf).

Link Path : affiche le chemin d'accès au fichier 
utilisé pour rétablir le lien (commande 
uniquement disponible dans la fenêtre Relink). 
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Clip Name : affiche le nom du fichier ou du clip 
Avid si l'élément est un fichier AAF ou OMF. 
Quand vous importez un fichier dans une 
session, le nom du clip apparaît dans la timeline 
et dans la liste de régions. Cette zone peut 
uniquement être éditée dans les catalogues ; 
vous pouvez la générer avec n'importe quelle 
commande « Copy Comments to Clip Name » 
du menu de navigation (voir Commandes 
DigiBase Pro supplémentaires, page 205). 

Zones de commentaires

Les commentaires liés aux fichiers individuels 
peuvent être sauvegardés dans la base de 
données et intégrés à l'ensemble de 
métadonnées du fichier. 

Il existe deux types de zones de commentaires : 
les commentaires de fichier et les commentaires 
de base de données.

Commentaires de fichier

Les commentaires de fichier sont sauvegardés 
avec les métadonnées du fichier même. Tous les 
types de fichiers ne proposent pas ces 
commentaires. L'indexation sauvegarde les 
commentaires de fichier dans la base de 
données, ce qui permet de rechercher et de 
visualiser les commentaires même si le fichier en 
question est hors ligne. Les navigateurs 
permettent d'éditer les commentaires de fichier, 
à condition que les fichiers ou que leurs médias 
parents ne soient pas uniquement réservés à la 
lecture. 

Vous pouvez également ajouter et éditer des 
commentaires de fichier dans les fichiers Session 
Pro Tools depuis le navigateur de projet. Les 
catalogues ne permettent pas d'éditer les 
commentaires de fichier.

Commentaires de base de données

(Navigateurs de projets et de catalogues 
uniquement)

Les commentaires de la base de données au sein 
d'un catalogue sont sauvegardés dans la base de 
données du catalogue. Les commentaires de 
base de données dans le navigateur de projet 
sont sauvegardés dans la session. Les remarques 
peuvent contenir jusqu'à 256 caractères, 
peuvent faire l'objet de recherche, s'appliquent à 
toutes les plates-formes et peuvent être éditées. 
Pour plus d'informations, reportez-vous à la 
section Commentaires et catalogues, page 235. 

Ajout et modification de commentaires

Pour ajouter, visualiser ou éditer un commentaire :

1  Cliquez sur la zone Comments. Si nécessaire, 
cette zone s'agrandit pour afficher le 
commentaire entier. 

2  Entrez ou éditez un commentaire. 

3  Appuyez sur Entrée ou cliquez en dehors de la 
zone de texte pour la refermer. 

Formes d'onde et écoute
La colonne Waveform affiche les formes d'onde 
calculées pour les éléments correspondant à des 
fichiers audio. L'affichage des formes d'onde 
dépend des facteurs suivants :

• Les formes d'onde s'affichent si elles ont déjà 
été calculées et sauvegardées avec les 
métadonnées du fichier ou dans le cache 
global des formes d'onde.
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• Quand vous importez un fichier dans une 
session, une forme d'onde est 
automatiquement calculée pour ce fichier 
(s'il y a lieu). 

• Les formes d'onde sont grisées si elles n'ont 
pas déjà été sauvegardées avec les 
métadonnées du fichier ou dans le cache 
global des formes d'onde. 

L'aperçu de la forme d'onde est sauvegardé dans 
le fichier ou le dossier Digidesign Databases 
approprié. Pour plus d'informations, 
reportez-vous à la section WaveCache, 
page 213.

Somme des formes d'onde de fichiers 
multicanaux

Pour les fichiers stéréo et multicanaux, les 
formes d'onde affichées représentent la somme 
des canaux. 

Calcul des formes d'onde pour 
l'affichage

Si un élément correspondant à un fichier audio 
ne possède pas de forme d'onde, il est nécessaire 
de calculer cette dernière avant qu'elle puisse 
être affichée dans la colonne Waveform du 
navigateur. 

Pour calculer les formes d'onde dans un 
navigateur :

1  Choisissez des fichiers audio en ligne ou des 
dossiers contenant des fichiers audio, dans un 
navigateur.

2  Choisissez Calculate Waveform dans le menu 
de navigation. 

Ecoute de fichiers audio

Vous pouvez écouter les éléments audio depuis 
les navigateurs DigiBase avant de les importer, 
de les copier ou de les effacer. 

La fonction utilise le chemin d'écoute principal 
sélectionné dans le volet Output de la boîte de 
dialogue I/O Setup de Pro Tools. Le niveau est 
défini par le niveau Master Fader (ou Auxiliary 
Input) en vigueur pour le chemin d'écoute. 

Lors d'une écoute depuis DigiBase, les fichiers 
audio entrelacés comportant plus de deux 
canaux sont « transformés » en fichiers mono 
pour l'écoute. Lorsque vous écoutez les fichiers 
multimono, vous devez traiter un fichier à la 
fois.

Affichage de formes d'onde dans un navigateur

Formes d'onde d'éléments avant le calcul

Les fichiers MIDI peuvent être écoutés à 
partir de la liste des régions de la session, 
mais non pas à partir des navigateurs 
DigiBase. 

Certaines opérations effectuées dans 
Pro Tools peuvent interrompre 
provisoirement l'écoute dans DigiBase. 
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Pour lancer ou interrompre l'écoute d'un fichier 
audio dans un navigateur :

1  Choisissez un fichier audio dans la liste 
d'éléments d'un navigateur. Vérifiez que la 
fenêtre du navigateur est au premier plan 
(active). 

2  Effectuez l'une des opérations suivantes :

• Cliquez sur le bouton Waveform Preview 
(l'icône haut-parleur à gauche de l'affichage 
de forme d'onde). Cliquez de nouveau pour 
mettre fin à l'écoute.

• Si l'option Spacebar Toggles File Preview est 
sélectionnée dans le menu du navigateur, 
appuyez sur la barre d'espace. Appuyez à 
nouveau sur la barre d'espace pour 
interrompre l'écoute.

• Appuyez sur Pomme+P (Mac) ou sur Ctrl+P 
(Windows) pour démarrer ou interrompre 
l'écoute. 

• Appuyez sur la touche Echap pour 
interrompre l'écoute. 

Pour écouter en boucle :

1  Dans le menu de navigateur, sélectionnez 
Loop Preview Mode. Le bouton Browser Preview 
se met à jour pour afficher l'icône Loop Preview.

2  Choisissez un fichier audio dans la liste 
d'éléments d'un navigateur. Vérifiez que la 
fenêtre du navigateur est au premier plan 
(active). 

3  Effectuez l'une des opérations suivantes :

• Cliquez sur le bouton Browser Preview.

• Cliquez sur le bouton Waveform Preview.

• Si l'option Spacebar Toggles File Preview est 
sélectionnée dans le menu du navigateur, 
appuyez sur la barre d'espace.

Pour interrompre l'écoute en boucle, effectuez 
l'une des actions suivantes :

" Cliquez de nouveau sur le bouton Browser 
Preview.

" Si l'option Spacebar Toggles File Preview est 
sélectionnée dans le menu du navigateur, 
réappuyez sur la barre d'espace.

Pour écouter un fichier audio à partir d'un endroit 
spécifique du fichier :

" Cliquez à l'emplacement souhaité de la forme 
d'onde affichée. Appuyez sur la barre d'espace 
pour interrompre la lecture. 

Pour écouter des fichiers automatiquement lors de 
leur sélection :

" Dans le menu de navigation, sélectionnez 
Auto-Preview. Le bouton Preview est mis à jour 
et indique l'activation de l'aperçu automatique.

L'écoute démarre après la sélection du 
fichier dans un navigateur si l'option 
Auto-Preview est activée.

Bouton DigiBase Preview, mode Loop Preview

Ecoute d'un fichier audio

Bouton DigiBase Preview, Auto-Preview activé
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WaveCache

Un fichier WaveCache global mémorise les 
formes d'onde qui ne peuvent pas être 
sauvegardées dans le fichier audio, comme dans 
le cas de fichiers uniquement destinés à la 
lecture, de fichiers situés sur le réseau et d'autres 
volumes réservés à la lecture, ainsi que pour les 
fichiers entrelacés. Le fichier WaveCache global 
est sauvegardé dans le dossier Digidesign 
Databases, sur votre volume de démarrage 
Pro Tools. Pour les volumes autorisant la 
sauvegarde, le cache est sauvegardé avec les 
fichiers Digidesign Database du volume en 
question. 

Sélection d'éléments

Pour sélectionner un élément dans un navigateur :

" Cliquez sur l'icône d'un élément. Son nom 
s'affiche alors en surbrillance. 

Pour sélectionner plusieurs éléments :

" Sélectionnez un groupe d'éléments avec le 
rectangle de sélection ou appuyez sur Maj en 
cliquant sur les éléments souhaités. Pour choisir 
plusieurs éléments non consécutifs, cliquez 
dessus en maintenant la touche Pomme (Mac) 
ou Ctrl (Windows) enfoncée. 

Pour sélectionner tous les éléments affichés :

" Appuyez sur Pomme+A (Mac) ou sur Ctrl+A 
(Windows).

Pour sélectionner tous les fichiers Transfer dans la 
fenêtre active :

" Choisissez Select Transfer Files dans le menu 
du navigateur. 

Pour sélectionner tous les fichiers hors ligne :

" Choisissez l'option « Select Offline Files » 
dans le menu de navigation.

Pour sélectionner tous les fichiers en ligne :

" Choisissez l'option « Select Online Files » dans 
le menu de navigation. 

Pour inverser la sélection actuelle :

" Choisissez l'option « Invert Selected » dans le 
menu de navigation. 

Déplacement, copie, 
duplication et effacement des 
éléments
Les opérations de déplacement, de copie, de 
duplication et d'effacement des éléments dans 
les navigateurs s'effectuent selon les mêmes 
règles que dans votre système d'exploitation. 
Ainsi, le déplacement d'un fichier dans un autre 
volume produit une copie de ce fichier ; 
Pro Tools vous avertit dès qu'un élément risque 
d'être remplacé ou écrasé suite à l'opération 
effectuée. Quand vous faites glisser l'élément 
d'un catalogue vers un navigateur de volumes, 
une copie de cet élément est créée. 
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Déplacement d'éléments

Pour déplacer des éléments :

" Choisissez un ou plusieurs éléments et 
faites-les glisser. Si la destination se trouve à un 
autre endroit sur le même volume, l'élément est 
déplacé ; en revanche, si vous le déplacez vers un 
autre volume, l'élément est copié. 

Copie d'éléments

Pour copier et déplacer des éléments :

" Choisissez un ou plusieurs éléments et 
faites-les glisser vers un nouvel emplacement en 
appuyant sur la touche Option. 

Duplication d'éléments

Pour dupliquer un ou plusieurs éléments :

1  Choisissez un ou plusieurs éléments. 

2  Choisissez l'option « Duplicate Selected » dans 
le menu de navigation.

Effacement d'éléments et de dossiers

Tous les navigateurs permettent de choisir et 
d'effacer des fichiers ainsi que des dossiers. Si un 
élément choisi réside sur un volume 
uniquement destiné à la lecture, vous ne pouvez 
pas l'effacer. 

Consultez la section Effacement d'éléments de 
catalogue, page 214 pour plus d'informations. 

Pour effacer un ou plusieurs éléments :

1  Choisissez un ou plusieurs éléments.

2  Appuyez sur la touche de suppression ou 
choisissez Delete Selected dans le menu de 
navigation. 

3  Pro Tools vous demande de confirmer la 
suppression définitive des fichiers choisis sur le 
disque. Cliquez sur Delete pour effacer les 
éléments ou sur Cancel pour conserver intacts 
vos fichiers et disques. 

Pour effacer des fichiers verrouillés :

1  Choisissez un ou plusieurs éléments. 

2  Appuyez sur Ctrl+Suppr (Windows) ou sur 
Pomme+Suppr (Mac).

Effacement d'éléments de catalogue

(DigiBase Pro uniquement)

Lorsque vous effacez un dossier ou un élément 
d'un catalogue DigiBase Pro, Pro Tools vous 
permet de spécifier si l'effacement porte 
uniquement sur l'alias (renvoi) du catalogue ou 
s'il élimine aussi l'élément du disque ou 
également les fichiers d'origine du disque. 

Vous pouvez faire glisser directement des 
éléments vers la timeline ou la liste des 
régions de la session en cours. Pour plus 
d'informations, reportez-vous à la section 
Importation d'éléments avec la fonction 
glisser-déposer, page 263.

Pour dupliquer des éléments sélectionnés 
dans le navigateur, appuyez sur Ctrl+D 
(Windows) ou Pomme+D (Mac).

Pour effacer directement les éléments sans 
afficher cette boîte de dialogue 
d'avertissement, appuyez sur la touche 
Option tout en enfonçant la touche de 
suppression (ou en choisissant Delete 
Selected). 
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Pour effacer un élément d'un catalogue : 

1  Ouvrez un catalogue et choisissez un ou 
plusieurs éléments. 

2  Appuyez sur la touche de suppression ou 
choisissez Delete Selected dans le menu de 
navigation. 

3  Lorsque le système vous y invite, effectuez 
l'une des actions suivantes : 

• Pour supprimer les alias des éléments 
choisis du catalogue, cliquez sur Aliases. 

– ou –

• Pour supprimer les éléments choisis du 
disque (ainsi que leurs alias du catalogue), 
cliquez sur Files. 

Effacement de dossiers dans les catalogues

L'effacement d'un dossier dans le catalogue ne 
supprime pas le dossier en question du disque 
(même si vous choisissez d'effacer tous les 
fichiers du disque). En effet, étant donné que les 
catalogues sont des « clichés » d'éléments, leurs 
alias renvoient seulement aux fichiers présents 
dans le dossier correspondant au moment de la 
création du catalogue. Pour éviter les pertes de 
données, les dossiers ne sont jamais effacés du 
disque, même lorsque vous choisissez d'effacer 
les fichiers (Files) au lieu des alias (Aliases). 

Recherche d'éléments
DigiBase bénéficie de puissantes fonctions de 
recherche permettant de trouver rapidement les 
fichiers souhaités. 

Le navigateur Workspace permet d'effectuer des 
recherches dans plusieurs volumes et catalogues 
(quand cette fonction est disponible). Tous les 
autres navigateurs vous permettent d'effectuer 
des recherches dans leur propre contenu. 

Les recherches portent sur les éléments du volet 
Items List ou Search Results ; seuls les éléments 
trouvés et répondant aux critères de recherche 
sont affichés. 

DigiBase Pro permet d'effectuer des recherches à 
partir de plusieurs critères et de rechercher les 
éléments dans les catalogues.

La fenêtre Relink propose des fonctions de 
recherche spécialement conçues pour localiser 
les fichiers manquants et rétablir leurs liens. 
Pour plus d'informations, reportez-vous à la 
section Création et rétablissement de liens de 
fichiers, page 220. 

Fonctions de recherche communes à tous les 
systèmes

Tous les systèmes proposent les fonctions de 
recherche suivantes :

• Recherche d'éléments par nom (Name), type 
(Kind) et date de modification (Date 
Modified).

• Les résultats de la recherche s'affichent dans la 
liste d'éléments, où vous pouvez les 
sélectionner directement pour les écouter, les 
copier ou effectuer d'autres opérations. Dans 
le navigateur de l'espace de travail, un volet 
Search Results (résultats de la recherche) 
distinct affiche les éléments trouvés. 
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• Servez-vous des modificateurs de syntaxe de 
recherche comme OR, les caractères 
génériques et les signes plus grand que/plus 
petit que. Pour plus d'informations, 
reportez-vous à la section Restriction de la 
recherche, page 217. 

• Recherche en mode Quick ou Advanced. 
Le mode Quick utilise automatiquement des 
caractères génériques pour accélérer l'entrée 
des données pendant la recherche. Le mode 
de recherche Advanced permet de définir des 
caractères génériques pour affiner la 
recherche. Pour plus d'informations, 
reportez-vous à la section Modes de recherche, 
page 218.

Fonctions de recherche supplémentaires dans 
DigiBase Pro seulement

Avec DigiBase Pro, vous pouvez également 
effectuer les opérations suivantes : 

• Rechercher sur toute colonne de données 
comme les zones de commentaires, de 
fréquence d'échantillonnage, de format et de 
tempo.

• Enregistrer les résultats d'une recherche en 
tant que nouveau catalogue.

Lancement d'une recherche

Pour effectuer une recherche dans le navigateur 
en cours :

1  Cliquez sur l'icône Search pour afficher le 
volet correspondant. 

2  Effectuez l'une des opérations suivantes :

• Quel que soit le système, entrez le texte 
dans la zone File Name pour effectuer une 
recherche par nom, entrez la date ou 
choisissez un type de fichier dans le menu 
contextuel Kind. Pour plus d'informations, 
reportez-vous à la section Saisie de données 
lors des recherches, page 217.

– ou –

• Si vous utilisez DigiBase  Pro (Pro Tools HD 
et Pro Tools LE avec DV Toolkit 2), 
sélectionnez vos critères de recherche en 
fonction de vos besoins. Appuyez sur la 
touche de tabulation pour déplacer le 
curseur dans le champ suivant. Maintenez 
la touche Maj en foncée lors de cette 
opération pour revenir au champ 
précédent.

3  Cliquez sur le bouton Search ou appuyez sur 
Entrée (Windows) ou Retour (Mac).

Lorsque la recherche démarre, les flèches de la 
barre d'outils tournent sur elles-mêmes et le 
bouton Search devient le bouton Stop. La liste 
des résultats (en bas du navigateur) affiche les 
éléments correspondant aux critères de 
recherche. Vous pouvez les sélectionner et les 
écouter. 

Icône de recherche et volet de recherche

Icône de recherche

Panneau de
recherche

Pour lancer une recherche, appuyez sur 
Ctrl+F (Windows) ou Pomme+F (Mac).
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Pour arrêter une recherche :

" Cliquez sur le bouton Stop pendant la 
recherche en cours. 

La recherche est interrompue et le bouton Stop 
se transforme en bouton Search. Tous les 
résultats de la recherche restent affichés et 
toutes les entrées de la zone de recherche sont 
conservées. 

Pour réinitialiser les paramètres de recherche :

" Cliquez sur Reset pour effacer tous les critères 
des zones de recherche et activer l'affichage 
principal du navigateur (avec tous les éléments). 
La fenêtre de recherche reste ouverte.

Pour refermer le volet de recherche et retourner à 
l'affichage complet du navigateur :

" Cliquez sur l'icône de recherche du navigateur 
pour ouvrir ou fermer le volet de recherche.

La recherche est interrompue, le volet de 
recherche (ainsi que le volet de résultats de 
recherche) se referme et vous retournez à 
l'affichage principal du navigateur. 

Saisie de données lors des 
recherches

Formats de champs et recherche

Cette section décrit les types de formats de 
données disponibles (toutes les zones d'entrée 
ne sont pas disponibles sur tous les systèmes). 

Zones de texte : permettent de saisir 
directement du texte. La zone est vide par 
défaut. 

Menus déroulants : proposent des options pour 
certaines zones. Ainsi, le menu déroulant Bit 
Depth offre des options pour « Any », « 16-bit » 
ou « 24-bit ».

Date et heure : permet d'entrer la date et l'heure 
dans divers formats.

Timecode : utilise les raccourcis d'entrée de 
timecode standard Pro Tools : 
hh:min:sec:frames.

Restriction de la recherche

Certaines zones comportent de petits menus 
déroulants permettant de délimiter les critères de 
recherche sélectionnés. 

Il s'agit des modificateurs suivants :

• Egal à (=)

• Différent de (!=) 

• Inférieur à (<)

• Supérieur à (>)

• Inférieur ou égal à (<=)

• Supérieur ou égal à (>=)

• Plage (<…>)

Recherches limitées sur une plage : quand cette 
fonction est active, une deuxième zone de 
recherche s'ajoute ; elle permet de délimiter une 
plage avec deux valeurs (deux dates, par 
exemple). Pro Tools trouve tous les éléments 
compris entre ces deux valeurs (incluses).

Caractères génériques (* et ?)

Vous pouvez ajouter un astérisque (*) au début 
ou à la fin d'une entrée de texte pour effectuer 
une recherche avec des caractères génériques. 
Par exemple, pour trouver tous les fichiers dont 
le nom se termine par début, vous pouvez taper 
*début dans la zone de recherche. Vous trouverez 
ainsi des fichiers portant le nom vocalise.début et 
dialogue2.début. 
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Vous pouvez entrer un point d'interrogation (?) 
si le caractère générique remplace un seul 
caractère. Par exemple, une recherche portant 
sur f?ire permet de trouver faire et foire. Par 
contre, si la recherche porte sur f*ire, vous 
trouverez faire, foire, funiculaire, fractionnaire, etc. 

Recherches avec l'opérateur OR

Les boutons plus (+) et moins (–) ajoutent et 
suppriment respectivement des rangées OR 
permettant de trouver des résultats répondant 
aux critères de la rangée supérieure ou (« or ») 
des rangées supplémentaires.

Pour ajouter et utiliser des rangées OR dans une 
recherche :

1  Cliquez sur le bouton plus (+) pour ajouter 
une rangée OR identique à la rangée supérieure 
mais ne comportant aucune entrée dans ses 
zones de recherche. 

2  Pour ajouter une rangée OR, cliquez à 
nouveau sur le bouton Plus (+). Tant qu'une 
rangée OR est vide, elle n'a aucun impact sur la 
recherche.

3  Saisissez les critères de recherche.

Par exemple, pour faire une recherche sur tous 
les fichiers intitulés Chien ou Aboiement :

• Saisissez Chien dans le premier champ File 
Name.

• Ajouter une rangée OR.

• Saisissez Aboiement dans le deuxième 
champ File Name.

4  Cliquez sur Search. 

Pour supprimer des rangées OR :

" Cliquez sur le moins (–) pour effacer la rangée 
OR du bas. 

Recherches sur plusieurs mots

Si vous entrez plusieurs mots dans une zone de 
texte, Pro Tools recherche les fichiers qui 
contiennent tous ces mots. Si vous tapez 
Aboiement chien par exemple, seuls les fichiers 
dont le nom contient les mots Chien et 
Aboiement sont trouvés.

Chaînes de texte délimitées par des 
guillemets

Quand le texte est placé entre guillemets, la 
recherche porte sur la chaîne de texte entre les 
guillemets. Par exemple, si vous tapez Aboiement 
chien (avec des guillemets), seuls les éléments 
comportant les termes Aboiement chien, quel que 
soit l'endroit dans le nom de fichier, s'affichent 
comme résultats de la recherche.

Modes de recherche

DigiBase fournit deux types d'environnement de 
recherche de texte :

Mode Quick Search : applique des caractères 
génériques avant et après chaque chaîne de 
texte. Par exemple, une recherche rapide (Quick 
search) sur Chien donne les résultats suivants : 
Chiens, aboiement_chien et hurlements_chiens.

Mode de recherche Advanced : n'applique pas 
automatiquement de caractères génériques. 
Ainsi, les résultats d'une recherche avancée sur 
Chien sont : Gros chien, mais pas Chiens (à moins 
que vous n'ayez ajouté manuellement un 
caractère générique, tel que décrit dans la 
section Caractères génériques (* et ?), page 217). 
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De plus, la recherche avancée reconnaît les 
coupures de mots tels que les traits de 
soulignement et les majuscules. Par exemple, les 
résultats d'une recherche avancée sur Chien 
incluent également Gros_Chien (Gros-trait de 
soulignement-Chien) et GrosChien, mais 
n'incluent pas GrosChiens.

Pour activer le mode de recherche avancée :

" cliquez sur l'option Advanced pour activer ce 
mode. 

Pour retourner en mode Quick Search :

" cliquez sur l'option Advanced pour désactiver 
le mode de recherche avancée.

A propos de la procédure de 
recherche

Les recherches sont conduites en deux étapes, 
indiquées chacune par le statut Search affiché 
dans le volet de recherche (et la fenêtre de 
tâches). 

Recherche dans des bases de données : la 
recherche porte d'abord sur les bases de données 
existantes. Cette étape de recherche est la plus 
rapide ; notez que la précision de recherche 
dépend de celle de la base de données (en 
d'autres termes, si la base de données n'est pas 
parfaitement à jour, vous risquez de ne pas 
trouver les fichiers recherchés). 

Recherche du système de fichiers : il s'agit de la 
deuxième étape de recherche. Cette recherche, 
bien qu'elle ne soit pas aussi rapide que celle des 
bases de données, est plus fiable car elle ne 
repose pas sur la base de données (qui n'est pas 
nécessairement à jour).

Sauvegarde des résultats de la 
recherche sous forme de 
catalogue
(DigiBase Pro uniquement)

Pour sauvegarder les résultats de votre recherche 
sous forme de catalogue :

1  Sélectionnez Edit > Select All ou appuyez sur 
Ctrl+A (Windows) ou sur Pomme+A (Mac), pour 
sélectionner tous les éléments de la liste des 
éléments.

2  Dans le menu de navigation, sélectionnez 
Create Catalog.

Volet de recherche

Le changement de mode Search affecte tous 
les navigateurs de DigiBase. 

Recherche avancée 

La première étape de recherche doit être 
complètement terminée afin que la 
deuxième étape puisse démarrer.

Pour plus d'informations, reportez-vous à la 
section Catalogues DigiBase Pro, page 233.
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Création et rétablissement de 
liens de fichiers
Une session Pro Tools contient des renvois ou 
des liens vers des fichiers audio et d'autres 
supports d'une session. Seuls les fichiers audio et 
vidéo se trouvant sur des volumes Performance 
et comprenant des renvois valides peuvent être 
lus dans la session.

Les types de fichiers suivants ne peuvent pas être 
lus :

Fichiers de transfert : fichiers résidant sur des 
volumes ne convenant pas pour la lecture, tels 
qu'un CD-ROM et des volumes de réseau.

Fichiers manquants : fichiers ne se trouvant pas 
à l'endroit où la session les cherche parce qu'ils 
ont été déplacés ou qu'ils se trouvent sur un 
volume inaccessible (hors ligne).

Le processus de rétablissement du transfert et 
des fichiers manquants s'appelle Rétablissement 
de liens. Dans certains cas, ce rétablissement du 
lien peut comporter plusieurs tâches auxiliaires.

• Les fichiers de transfert doivent d'abord être 
copiés vers un volume Performance 
approprié. Dans ce cas, la session rétablit un 
lien avec ces copies des volumes Performance 
plutôt qu'avec les fichiers de transfert 
originaux.

• Il existe des fonctions permettant de 
rechercher dans les volumes des fichiers 
manquants. Dès que Pro Tools les localise, il 
établit un nouveau lien entre la session et les 
fichiers retrouvés.

• Les liens des fichiers se trouvant sur des 
volumes inaccessibles ne pourront être 
rétablis qu'après le remontage (remise en 
ligne) des volumes en question.

Quand faut-il rétablir un lien ?

A l'ouverture d'une session ou ultérieurement, 
Pro Tools vous invite à rétablir le lien avec les 
fichiers introuvables.

! Le rétablissement des liens à l'ouverture d'une 
session garantit que tous les médias de cette 
session seront disponibles. Le rétablissement des 
liens peut être effectué manuellement ou 
automatiquement. Pour plus d'informations, 
reportez-vous à la section Ouverture d'une 
session contenant des fichiers manquants, 
page 222. 

! Le rétablissement des liens ultérieurement 
(après l'ouverture d'une session) constitue la 
façon la plus rapide d'ouvrir une session. Dans 
ce cas, les entrées manquantes restent hors ligne 
et ne peuvent pas être lues. Si certains de ces 
éléments vous sont nécessaires, vous pouvez 
rétablir les liens correspondants à partir du 
navigateur de projet. Pour plus d'informations, 
reportez-vous à la section Fichiers manquants 
dans une session ouverte, page 223.

Rétablissement de lien forcé

Si vous ne parvenez pas à rétablir le lien vers le 
fichier original, vous pouvez forcer un 
rétablissement de lien vers un autre fichier. Pour 
plus d'informations, reportez-vous à la section 
Rétablissement forcé des liens des fichiers, 
page 227. 

Les catalogues de DigiBase Pro proposent 
des caractéristiques de liaison uniques. Pour 
plus d'informations, reportez-vous à la 
section Rétablissement de liens et d'alias 
dans les catalogues, page 228. 
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Fichiers de transfert

Contrairement aux fichiers manquants, les 
fichiers de transfert peuvent être localisés, mais 
ils résident sur des volumes ne pouvant être lus 
(CD-ROM ou lecteurs de réseau). Ce genre de 
volume apparaît comme volume Transfer dans 
le navigateur de l'espace de travail. 

Ouverture d'une session avec des 
fichiers de transfert

Si une session trouve des fichiers résidant sur des 
volumes qui ne peuvent pas être lus, une boîte 
de dialogue apparaît, vous invitant à copier ces 
fichiers vers un volume approprié. Effectuez 
l'une des opérations suivantes : 

! Cliquez sur Yes pour ouvrir la boîte de 
dialogue Copy and Relink.

– ou –

! Cliquez sur No pour ouvrir la session en 
conservant les fichiers de transfert hors ligne. 
Une fois la session ouverte, le navigateur Project 
signale les fichiers de transfert au moyen d'un 
« T » dans la colonne Status.

Fichiers de transfert dans une session 
ouverte

Pour que les fichiers de transfert puissent être 
joués dans la session actuelle :

1  Choisissez Window > Project.

2  Cliquez deux fois sur le dossier Audio Files 
pour afficher tous les fichiers audio.

3  Choisissez Select Transfer Files dans le menu 
du navigateur. 

4  Choisissez Copy and Relink dans le menu du 
navigateur. 

5  Choisissez une destination sur un volume 
Performance valide où copier les fichiers et 
cliquez sur OK. 

6  En cas de besoin, répétez cette procédure pour 
les fichiers vidéo et les fichiers de fade. 

Copy and Relink

La commande Copy and Relink est une option 
pour la gestion de fichiers disponible dans le 
navigateur de projet et les catalogues 
DigiBase Pro. 

La commande Copy and Relink permet de 
copier facilement des fichiers et d'établir un lien 
entre une session ou un catalogue et les copies 
plutôt qu'avec les originaux. 

Pour copier des fichiers ailleurs et rétablir un lien 
avec les copies :

1  Effectuez l'une des opérations suivantes :

• Choisissez Window > Project. 

– ou –

• Ouvrez le catalogue approprié. 

2  Choisissez les entrées que vous souhaitez 
copier et relier. Vous pouvez choisir n'importe 
quel type de fichier média (en ligne, hors ligne, 
fichiers de transfert). 

3  Choisissez l'option Copy and Relink Selected 
dans le menu du navigateur. 

4  Si le dossier d'arrivée choisi par défaut 
(le dossier Audio Files de la session) ne convient 
pas, choisissez-en un autre et cliquez sur 
Choose. 

5  Les fichiers sont copiés vers l'endroit choisi et 
les liens entre la session ou le catalogue et les 
copies sont établis en arrière-plan. 
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Fichiers manquants

Si un fichier ne se trouve plus à l'endroit où il 
résidait lors du dernier enregistrement de la 
session, ce fichier est considéré comme étant 
manquant. Cela se produit lorsque vous 
déplacez des fichiers ou le dossier de la session, 
ou encore si les fichiers se trouvent sur un 
volume non disponible. 

Ouverture d'une session contenant des 
fichiers manquants

Pour ouvrir une session ProTools avec des fichiers 
manquants :

1  Lors de l'ouverture d'une session, Pro Tools 
tente d'accéder à tous les supports requis. 
Il affiche ensuite une liste des fichiers 
manquants (le cas échéant) et vous demande 
quelle opération vous souhaitez à présent 
effectuer. Si vous apprenez que certains fichiers 
ne peuvent pas être lus, consultez la section 
Fichiers de transfert, page 221.

2  Sélectionnez l'une des options suivantes :

• Skip All. Vous pouvez également 
sélectionner Skip All en appuyant sur 
Ctrl+A (Windows) ou Pomme+A (Mac).

• Manually Find Relink. Vous pouvez 
également sélectionner Manually Find 
Relink en appuyant sur Ctrl+M (Windows) 
ou Pomme+M (Mac)

• Automatically Find Relink. Vous pouvez 
également sélectionner Automatically Find 
Relink en appuyant sur Ctrl+A (Windows) 
ou Pomme+A (Mac)

3  Sélectionnez Regenerate Missing Fade Files si 
vous préférez générer à nouveau les liens des 
fondus plutôt que de les rétablir.

4  Cliquez sur OK.

Skip All

L'option Skip All permet d'ignorer tous les 
fichiers et fondus manquants. Il s'agit de la 
méthode la plus rapide pour ouvrir une session 
en utilisant tous les supports disponibles. 
Les fichiers manquants sont hors ligne dans la 
session et s'affichent en italique dans la liste des 
régions et dans le navigateur de projet. 
Les fondus (fade) manquants sont recréés dès 
que les fichiers associés reviennent en ligne. 

Manually Find and Relink

Cette option ouvre la fenêtre Relink. Utilisez la 
fenêtre Relink pour rechercher, comparer, 
vérifier et relier des fichiers manquants. 
Les fichiers peuvent être liés un à un ou par 
groupe (batch). Pour plus d'informations, voir 
Fenêtre Relink, page 224. 

Automatically Find and Relink

La fonction Automatically Find and Relink est la 
méthode la plus simple pour la liaison d'une 
session aux fichiers requis. Elle ne permet 
cependant pas de comparer des fichiers, ni de 
vérifier les liens. Cette option ne peut pas être 
annulée. L'option Automatically Find and 
Relink fonctionne comme suit : 

Avertissement concernant les fichiers manquants à 
l'ouverture d'une session

Vous pouvez également sélectionner 
Regenerate Missing Fades en appuyant sur 
Ctrl+R (Windows) ou Pomme+R (Mac).
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• Elle cherche les fichiers (nom, ID, format et 
taille) sur tous les volumes Performance 
disponibles.

• Elle établit un lien avec les premiers fichiers 
correspondant aux critères de la recherche.

• Elle confirme les liens avec tous les fichiers 
trouvés en arrière-plan

• Si certains fichiers n'ont pu être liés, la fenêtre 
de tâches apparaît et affiche une indication de 
tâche échouée dans le volet Paused Tasks. 
Cliquez deux fois sur l'icône de tâche pour 
ouvrir la fenêtre Relink et rétablissez les liens 
manuellement.

Regenerate Missing Fades

Activez cette option si vous souhaitez exclure les 
fondus du processus de rétablissement des liens 
(les fondus sont alors recalculés). Cette option 
est disponible si vous avez sélectionné les 
options Automatically Find and Relink ou 
Manually Find and Relink. 

Fichiers manquants dans une session 
ouverte

Vous pouvez ouvrir le navigateur Project pour 
sélectionner et relier plusieurs (ou tous les) 
fichiers manquants. 

Pour rétablir les liens de fichiers manquants ou 
hors ligne dans la session ouverte :

1  Choisissez Window > Project.

2  Choisissez Relink Offline dans le menu de 
navigation pour ouvrir la fenêtre Relink. 

3  Configurez la fenêtre Relink comme souhaité. 
Pour plus d'informations, reportez-vous à la 
section Fenêtre Relink, page 224. 

Pour rétablir les liens de fichiers sélectionnés 
dans une session ouverte :

1  Choisissez Window > Project. 

2  Sélectionnez les fichiers pour lesquels vous 
souhaitez rétablir des liens. Vous pouvez rétablir 
les liens de tout fichier (même ceux qui ne sont 
pas hors ligne). 

3  Choisissez Relink Selected dans le menu de 
navigation. 

4  Configurez la fenêtre Relink comme souhaité. 
Pour plus d'informations, reportez-vous à la 
section Fenêtre Relink, page 224. 

Les liens, une fois attribués, ne pourront pas 
être défaits une fois la session sauvegardée. 
La seule manière de rétablir les liens 
précédents consiste à fermer la session sans 
la sauvegarder. 

L'affichage d'échec ne disparaît même pas 
de la fenêtre de tâches, même si les fichiers 
ont été par la suite retrouvés et reliés. 
Comme toutes les tâches ayant échoué, de 
telles entrées doivent être supprimées 
manuellement. Pour plus d'informations, 
reportez-vous à la section A propos des 
tâches ayant échoué, page 241. 
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Fenêtre Relink
La fenêtre Relink propose des outils permettant 
d'effectuer toutes les tâches de rétablissement de 
liens (voir figure 8, page 224). 

La fenêtre Relink comporte les éléments 
suivants :

Menu et barre d'outils : vous y trouverez le 
menu Relink, les présélections d'affichage et les 
boutons permettant de rétablir les liens. L'état 
est affiché à l'extrême droite.

Zones de recherche : permet de sélectionner les 
volumes sur lesquels porte la recherche des 
éléments manquants. 

Fichiers à relier : affiche les fichiers manquants.

Fichiers candidats : répertorie les fichiers 
correspondant aux « critères de rétablissement 
de lien » définis pour un fichier manquant 
donné. Vous pouvez activer/désactiver l'icône 
de lien en regard du candidat pour rétablir le 
lien du candidat proposé (ou supprimer son 
lien) au fichier manquant sélectionné. 

La fenêtre Relink permet de contrôler chaque 
phase du rétablissement de lien. 

Les sections ci-dessous expliquent comment 
effectuer les opérations suivantes : 

• Ouverture de la fenêtre Relink 

• Sélection des volumes et des dossiers à 
rechercher (et à ne pas rechercher)

• Recherche, comparaison et rétablissement de 
liens entre les fichiers individuels et un ou 
plusieurs candidats 

• Localisation et rétablissement de liens rapides 
des fichiers manquants par groupe, avec la 
possibilité de définir les critères de recherche 
des fichiers

• Activation et désactivation des liens de tout 
candidat

• Comparaison et vérification des liens avant de 
les appliquer 

Figure 8.  Principaux éléments de la fenêtre Relink

Fichiers à relier

Fichiers candidats

Zones de recherche

Menu et barre d'outils
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Ouverture de la fenêtre Relink

Quand vous ouvrez une session comportant des 
fichiers manquants, utilisez l'option Manually 
Find and Relink pour ouvrir la fenêtre Relink. 

Vous pouvez également afficher la fenêtre 
Relink après l'ouverture de la session. 

Pour ouvrir la fenêtre Relink dans une session 
ouverte :

1  Choisissez Window > Project. 

2  Choisissez Relink Offline dans le menu de 
navigation. 

Sélection des zones de recherche

Le volet Areas to Search permet de sélectionner 
les volumes et dossiers dans lesquels vous 
souhaitez effectuer la recherche des fichiers 
manquants. Cela permet d'accélérer la 
procédure de rétablissement de lien en limitant 
le nombre de volumes ou de dossiers à 
rechercher. De plus, le fait d'exclure des dossiers 
d'une recherche permet également de rediriger 
une session ou un catalogue vers une copie plus 
appropriée d'une entrée.

Pour sélectionner des volumes ou des dossiers à 
inclure ou exclure d'une recherche :

1  Configurez le volet Areas to Search de sorte à 
afficher le volume, catalogue ou dossier 
adéquat. 

2  Cliquez dans la colonne Search de chaque 
élément pour l'inclure ou l'exclure de la 
recherche. Lorsqu'une entrée est cochée, elle est 
incluse dans la recherche. Tous les dossiers au 
sein de l'entrée sont également cochés.

Rétablissement de liens entre un 
ou plusieurs fichiers

La fenêtre Relink permet de rétablir les liens 
entre un fichier ou plusieurs fichiers manquants 
à la fois, en groupes. 

Rétablissement de liens entre des 
fichiers manquants individuels

Il est parfois préférable de rétablir les liens entre 
des fichiers individuels un par un afin de relier la 
session au fichier adéquat. C'est notamment le 
cas si plusieurs copies d'un fichier média sont en 
ligne ou lorsque vous voulez garder un contrôle 
maximum sur le processus de rétablissement du 
lien. 

Pour relier un fichier manquant :

1  Configurez le volet Areas to Search. 

2  Sélectionnez une entrée dans la liste Files to 
Relink. 

Volumes sélectionnés à inclure dans la recherche
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3  Cliquez sur Find All Candidates. 

Pro Tools parcourt les volumes sélectionnés et 
affiche tous les fichiers correspondant à File 
Name ou Unique ID dans la liste des candidats. 
Des icônes de lien indiquent si un candidat est 
déjà lié.

4  Cliquez sur l'icône du lien à côté du candidat 
que vous souhaitez relier. Une icône de lien en 
regard d'un élément indique qu'il sera relié à 
l'élément actuellement sélectionné dans la liste 
Files to Relink.

5  Cliquez sur l'icône de lien en regard des autres 
candidats si vous souhaitez relier des fichiers 
manquants supplémentaires.

6  Cliquez sur le bouton Commit Links.

Relier plusieurs fichiers manquants

En vous servant du bouton Find Links, vous 
pouvez relier plusieurs fichiers en une fois. 

Pour relier plusieurs fichiers manquants :

1  Configurez Areas to Search Reportez-vous à la 
section Sélection des zones de recherche, 
page 225.)

2  Sélectionnez un ou plusieurs éléments dans la 
liste Files to Relink. Le bouton Find Links 
devient disponible. 

3  Cliquez sur Find Links. 

Rétablissement du lien d'un fichier manquant 
sélectionné

Les clips vidéo OMF peuvent être reliés à 
une session s'ils correspondent à des ID 
uniques.

Les clips vidéo QuickTime peuvent être 
reliés à une session par un nom et un format 
de fichier uniquement (QuickTime).

Pour contrôler les critères de correspondance 
et de lien lorsque vous rétablissez le lien 
d'un fichier manquant individuel, 
servez-vous du bouton Find Links. 
Le bouton Find Links est décrit dans la 
section Relier plusieurs fichiers manquants, 
page 226.

Find All Candidates

Indication de l'état du lien 

Icône 
de lien
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4  Si nécessaire, configurez les critères de 
rétablissement de liens dans la fenêtre Linking 
Options.

• Par défaut, l'option Find by Name and ID 
est activée.

• Pour ajouter des critères de recherche 
supplémentaires, sélectionnez une option 
dans la boîte de dialogue Linking Options. 
(L'option Modification Date n'est 
disponible que pour les catalogues.)

• Si vous activez Match Duration, Pro Tools 
ne sélectionne que des fichiers de longueur 
équivalente ou plus grande. 

5  Cliquez sur OK pour continuer (ou sur Cancel 
pour revenir à la fenêtre Relink). 

Pro Tools recherche un candidat acceptable 
pour le premier fichier manquant (la première 
entrée de la liste Files to Relink). Une icône de 
lien apparaît à côté de chaque fichier quand 
Pro Tools trouve et relie le premier candidat 
acceptable au fichier manquant. La colonne 
Link Path affiche l'emplacement du candidat 
sélectionné. Pro Tools continue à faire des 
recherches, établir des correspondances et des 
liens pour chaque fichier manquant de la liste 
Files to Relink. 

6  Pour visualiser le candidat sélectionné pour 
un fichier manquant donné, mettez en 
surbrillance le fichier manquant. Le candidat 
pour ce fichier apparaît dans le volet Candidates 
où vous pouvez visualiser les informations 
concernant le fichier et la forme d'onde.

7  Si, à la fin du processus Find Links, vous n'êtes 
pas satisfait du candidat sélectionné pour un des 
fichiers manquants, vous pouvez cliquer sur 
Find All Candidates pour le fichier sélectionné 
(consultez la section Rétablissement de liens 
entre des fichiers manquants individuels, 
page 225). 

Rétablissement forcé des liens 
des fichiers

Si vous souhaitez établir un lien vers un fichier 
de substitution (contenant par exemple les 
mêmes données audio ou vidéo, mais pas le 
même nom ou identifiant unique), vous pouvez 
forcer un rétablissement de lien.

! Pour forcer un rétablissemnt de lien à un 
fichier audio, son format (WAV, SD2, AIFF ou 
MXF), sa fréquence d'échantillonnage et sa 
résolution doivent correspondre à ceux du 
fichier original.

! Pour forcer un rétablissemnt de lien à un 
fichier vidéo, son format (QuickTime, Avid, 
MXF ou OMF) et sa fréquence d'images doivent 
correspondre à ceux du fichier original.

Pour forcer un rétablissement de lien :

1  Choisissez Window > Project. 

2  Choisissez Relink Offline dans le menu de 
navigation. 

3  Dans la fenêtre Relink, sélectionnez un 
élément dans la liste Files to Relink. 

4  Naviguez dans le volet Areas to Search pour 
localiser le fichier à relier.

Options de couplage
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5  Déposez le fichier dans le volet Candidates de 
la fenêtre Relink.

6  Cliquez sur l'icône Link à côté du fichier que 
vous avez déposé dans le volet Candidates. 

7  Cliquez sur le bouton Commit Links.

Confirmation des liens

Il est impossible d'annuler un lien. Une fois que 
vous avez relié un fichier et sauvegardé la 
session, celle-ci conserve le nouveau lien en 
mémoire (le lien d'origine est ignoré). C'est 
pourquoi vous devez confirmer le lien avec 
l'option Commit Links. 

Pour confirmer des liens :

1  Etablissez des liens entre les fichiers en 
utilisant la fenêtre Relink, comme décrit dans la 
section Rétablissement de liens entre un ou 
plusieurs fichiers, page 225. 

2  Cliquez sur Commit. Une demande de 
confirmation apparaît. 

3  Effectuez l'une des opérations suivantes :

• Cliquez sur Yes pour confirmer les liens 

– ou –

• Cliquez sur No pour annuler l'opération 
sans modifier les fichiers. 

Rétablissement de liens et d'alias 
dans les catalogues

Les catalogues DigiBase Pro sont des 
compilations d'alias ou de raccourcis vers les 
fichiers réels. Si vous déplacez les fichiers, un 
élément d'un catalogue peut être séparé de son 
fichier de référence. 

Pour rétablir le lien dans un catalogue :

1  Ouvrez le catalogue. 

2  Sélectionnez des éléments à relier. 

3  Choisissez Relink Selected dans le menu de 
navigation de cette fenêtre de catalogue. 

Navigateur de l'espace de 
travail
Le navigateur de l'espace de travail constitue le 
point de départ pour la gestion des supports 
(voir figure 9, page 229). Ce navigateur est 
disponible tant que Pro Tools est actif, même si 
aucune session n'est ouverte.

Le navigateur de l'espace de travail permet 
d'effectuer les opérations suivantes :

• Désignation de volumes en tant que 
volumes Performance (volumes de lecture 
et d'enregistrement) ou volumes de 
transfert. 

• Affichage et accès à tous les volumes 
disponibles.

• Démontage de volumes.

L'option Automatically Find and Relink est 
le seul processus de liaison qui ne vous 
demande pas de vérifier les liens avant de 
les enregistrer. Si vous utilisez cette option 
mais que le résultat ne vous satisfait pas, 
refermez la session sans la sauvegarder afin 
d'éviter que les nouveaux liens ne soient 
confirmés. 

Boîte de dialogue Commit Links
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• Création, affichage et accès aux catalogues.

• Recherche simultanée dans plusieurs 
volumes et catalogues. 

Le navigateur de l'espace de travail ressemble au 
bureau de votre ordinateur puisqu'il affiche tous 
les volumes locaux et de réseau disponibles. Ce 
navigateur de l'espace de travail propose tous les 
éléments typiques d'un navigateur, y compris 

une liste d'éléments, des présélections 
d'affichage et l'accès à tous les fichiers. De plus, 
ce navigateur contient les paramètres 
d'allocation de lecteurs, l'accès aux catalogues et 
offre la possibilité de chercher dans plusieurs 
volumes et catalogues à la fois.

Ouverture du navigateur de l'espace 
de travail

Pour ouvrir le navigateur de l'espace de travail : 

1  Lancez Pro Tools.

2  Choisissez Window > Workspace.

Indicateurs de volumes audio 
et vidéo

L'espace de travail contient des colonnes pour 
les indicateurs de volumes audio et vidéo. 
Ces deux colonnes affichent les volumes et 
permettent de désigner le volume utilisé pour 
l'enregistrement (R), la lecture (P) ou le 
transfert (T). 

R (Enregistrement et Lecture) : permet de lire 
des fichiers audio et vidéo résidant déjà sur ce 
volume et d'en enregistrer de nouveaux. 

Figure 9.  Navigateur de l'espace de travail avec volet de recherche

Nom du navigateur

Menu et barre 
d'outils

Liste des éléments

Résultats de la 
recherche

Indicateurs de volume

Volet fixe Volet de défilement

Séparation

Afficher/Masquer

Volet de recherche

Appuyez sur Alt+point-virgule (;) 
(Windows) ou sur Option+point-virgule (;) 
(Mac) pour ouvrir le navigateur de l'espace 
de travail.
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P (Lecture uniquement) : permet de lire des 
fichiers audio et vidéo résidant sur ce volume 
mais ne permet pas d'en enregistrer de 
nouveaux. 

T (Transfert) : peut uniquement être utilisé pour 
la sauvegarde, le transfert ou l'écoute de fichiers 
et n'est donc pas disponible pour 
l'enregistrement ou la lecture. 

Pour redéfinir un indicateur de volume :

1  Ouvrez le navigateur de l'espace de travail.

2  Cliquez sur l'indicateur audio ou vidéo 
approprié au volume pour le sélectionner. 

Montage et démontage des 
volumes

Le navigateur de l'espace de travail permet de 
démonter des volumes lorsque Pro Tools est en 
cours d'exécution. Il affiche les volumes au fur et 
à mesure qu'ils sont montés. 

Pour démonter un volume dans le navigateur de 
l'espace de travail :

1  Choisissez un volume dans le navigateur de 
l'espace de travail. 

2  Sélectionnez l'option Unmount Volumes dans 
le menu de navigation. 

Le navigateur de l'espace de travail ferme le 
fichier de la base de données du volume en ligne 
sélectionné et le supprime du navigateur ; le 
volume est également démonté du système. S'il 
s'agit d'un support amovible (un CD-ROM, par 
exemple), il est éjecté. 

Pro Tools vous avertira si le volume que vous 
démontez contient des fichiers référencés dans 
la timeline.

Catalogues dans le navigateur de 
l'espace de travail
(DigiBase Pro uniquement)

Sous DigiBase Pro, le navigateur de l'espace de 
travail propose des outils pour la création et 
l'accès aux catalogues. Tout catalogue que vous 
créez apparaît dans le dossier Catalogs du 
navigateur de l'espace de travail. 

Pour afficher tous les catalogues : 

1  Ouvrez le navigateur de l'espace de travail. 

2  Cliquez sur l'icône Développer/Réduire en 
regard du dossier Catalogs.

Pour ouvrir un seul catalogue :

" En cliquant deux fois sur un catalogue, vous 
ouvrez une fenêtre de navigation pour ce 
catalogue. 

Désignation d'un volume de l'espace de travail

Utilisez toujours la commande Unmount du 
menu de navigation de l'espace de travail 
pour démonter un volume. Vous pouvez 
également quitter Pro Tools, puis démonter 
le volume. Tant que Pro Tools est en cours 
d'exécution, toute autre méthode de 
démontage est proscrite. 

Visualisation de catalogues dans l'espace de travail 

Pour obtenir des informations complètes à 
propos de l'utilisation des catalogues, 
consultez la section Catalogues DigiBase 
Pro, page 233
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Recherche dans le navigateur de 
l'espace de travail

Le navigateur de l'espace de travail propose les 
fonctions de recherche les plus complètes de vo-
tre DigiBase. Vous pouvez en effet limiter vos re-
cherches à un volume, l'étendre à plusieurs vo-
lumes, voire même à des ensembles comprenant 
des volumes, des dossiers et des fichiers. Vous 
pouvez sélectionner les volumes sur lesquels la 
recherche doit porter et les volumes à ignorer. 
L'espace de travail comporte un volet Search Re-
sults distinct pour la visualisation, la sélection et 
la gestion des résultats de vos recherches. 

Le volet de résultats de la recherche permet de 
visualiser les résultats de vos recherches tout en 
vous laissant la possibilité de visualiser et de 
régler les options pour des recherches 
supplémentaires. 

Pour lancer une recherche à partir de l'espace de 
travail :

1  Choisissez Windows > Workspace pour ouvrir 
le navigateur de l'espace de travail. 

2  Cliquez sur l'icône de recherche pour afficher 
le volet de recherche de l'espace de travail. 

3  Spécifiez les critères de la recherche. 

4  Cliquez à côté des éléments de la liste Areas to 
Search pour inclure ou exclure des volumes dans 
la recherche. Les éléments marqués d'une coche 
et leurs sous-dossiers sont inclus dans la recher-
che. Ces paramètres s'appliquent la prochaine 
fois que vous ouvrez un volet de recherche dans 
l'espace de travail.

5  Cliquez sur Search. 

6  Les résultats de la recherche apparaissent dans 
le volet de résultats de la recherche. 

Navigateur de projet
Le navigateur de projet (Project) affiche et gère 
tous les fichiers liés à la session actuelle, quel 
que soit leur emplacement (voir figure 10, 
page 232). 

Le navigateur de projet est comparable à la liste 
des régions, car il regroupe tous les fichiers liés à 
une session, y compris les données 
complémentaires et les fonctions de recherche 
et de tri des navigateurs Pro Tools. 

Contrairement à la liste de régions, le navigateur 
de projet n'affiche cependant pas de régions 
séparées (il n'affiche en effet que des fichiers 
complets). 

Le navigateur de projet et ses commandes de 
menu permettent d'effectuer les opérations 
suivantes :

• Visionner tous les fichiers média associés à 
une session

• Identifier, sélectionner et établir des liens 
avec des fichiers hors ligne

• Identifier, sélectionner, copier et établir des 
liens avec des fichiers de transfert

Volets Search et Search Results de l'espace de travail

Volet de 
recherche

Zones de 
recherche

Résultats 
de la 
recherche

Pour plus d'informations sur la recherche, 
consultez la section Recherche d'éléments, 
page 215. 
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Ouverture du navigateur de projet

Pour ouvrir le navigateur de projet :

1  Lancez Pro Tools et ouvrez une session.

2  Choisissez Window > Project.

Le navigateur de projet affiche les informations 
suivantes :

Dossier Audio Files : contient tous les fichiers 
audio référencés par la session en cours, quel 
que soit leur emplacement. 

Dossier Fade Files : contient tous les fichiers de 
fondu référencés par la session en cours, quel 
que soit leur emplacement. 

Dossier Render Sources : contient tous les 
fichiers importés dans la session mais devant 
encore être convertis, copiés ou traités. 

Dossier Video files : contient tous les fichiers 
vidéo référencés par la session en cours.

Chaque dossier du navigateur de projet 
comprend une icône Développer/Réduire. 
En cliquant sur cette icône, vous affichez la liste 
des fichiers dans le sous-groupe. Notez que les 
dossiers affichés dans le navigateur de projet se 
présentent sous forme de groupement de 
fichiers de session, plutôt que de dossiers 
physiques de disque. 

Localisation de fichiers parents de 
régions

Vous pouvez paramétrer le navigateur de projet 
pour qu'il mette automatiquement en 
surbrillance le fichier parent de toute région 
sélectionnée dans la liste de régions Pro Tools.

Pour mettre en surbrillance le fichier parent d'une 
région sélectionnée :

1  Sélectionnez une région dans la liste des 
régions. Si la préférence Region List Selection 
Follows Track Selection est activée, vous pouvez 
sélectionner une région sur une piste.

2  A partir du menu contextuel Region List, 
sélectionnez Select Parent in Project Browser.

Appuyez sur Alt+O (Windows) ou sur 
Option+O (Mac) pour ouvrir le navigateur 
de l'espace de travail.

Figure 10.  Navigateur de projet

Dossiers et 
fichiers

Menu de 
navigation et 
barre d'outils

Lorsque l'option Select Parent in Project 
Browser est activée, le navigateur de projet 
met automatiquement en surbrillance le 
ficher parent de tout fichier ou région 
sélectionné(e) dans la liste des régions. 
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A propos du navigateur de projet

Opérations de glisser-déposer 
impossibles dans le navigateur 
de projet

Pour importer un fichier d'un autre navigateur 
dans la session actuelle, vous devez faire glisser 
les fichiers vers la timeline ou la liste de régions. 
Vous ne pouvez pas importer de fichier dans une 
session en le faisant glisser vers le navigateur de 
projet. Par contre, vous pouvez placer des 
fichiers du navigateur de projet dans la session 
actuelle en les faisant glisser.

Suppression d'éléments du navigateur 
de projet

Les fichiers que vous supprimez du navigateur 
de l'espace de travail ou d'un navigateur de 
volumes sont effacés du disque dur. Les fichiers 
vidéo et de sessions ne peuvent pas être 
supprimés dans le navigateur de projet. 

En supprimant un élément du navigateur de 
projet, vous le supprimez également de la 
session actuelle, voire du disque dur (via la boîte 
de dialogue Clear Regions de Pro Tools). 

Restrictions pour la copie et le 
rétablissement des liens

Dans le navigateur de projet, la commande 
Copy and Relink (menu de navigation) n'est pas 
disponible pour des fichiers de session ou des 
fichiers audio hors ligne. Utilisez la fenêtre 
Relink pour remettre les éléments en question 
en ligne. La commande Relink Selected n'est pas 
disponible pour des fichiers de session. 

Mise à jour du navigateur de projets

Le navigateur de projet est automatiquement 
mis à jour lorsque vous ajoutez ou supprimez un 
fichier de la session. Il est donc toujours indexé 
et « à la page ». 

Catalogues DigiBase Pro 
(Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement)

Les catalogues sont disponibles avec DigiBase 
Pro, qui est inclus avec Pro Tools HD et 
Pro Tools LE avec DV Toolkit 2 (voir figure 11).

Si les navigateurs de volumes sont conçus pour 
refléter de manière précise la structure des 
fichiers d'un volume donné, les catalogues 
quant à eux ressemblent à un dossier de fichiers 
favoris ; ils permettent de rassembler et 
d'organiser les éléments souvent utilisés, quel 
que soit leur emplacement. 

Un catalogue n'est autre qu'un dossier ne 
contenant que des alias (renvois) ou des 
raccourcis. Lorsque vous placez un fichier dans 
un catalogue, vous n'effectuez pas de copie ni ne 
modifiez l'emplacement de stockage de ce 
fichier. Il s'agit plutôt d'un renvoi (« alias ») à ce 
fichier vous permettant de manipuler ce dernier 
sans avoir besoin de connaître son emplacement 
physique. 

Pour plus d'informations sur la recherche, le 
tri et le travail avec le navigateur de projet, 
reportez-vous à la section Navigateur de 
projet, page 231.
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Ouverture d'un navigateur de 
catalogues

Les catalogues apparaissent dans le navigateur 
de l'espace de travail.

Pour ouvrir un navigateur de catalogues :

1  Ouvrez le navigateur de l'espace de travail.

2  Cliquez sur l'icône Développer/Réduire des 
catalogues. 

3  Effectuez l'une des opérations suivantes :

• Cliquez sur l'icône Développer/Réduire du 
catalogue souhaité pour afficher son 
contenu dans l'espace de travail 

– ou –

• Cliquez deux fois sur le nom du catalogue 
si vous souhaitez le visionner dans son 
propre navigateur. 

Noms de clips dans les catalogues

Les noms de clips sont les noms qui apparaissent 
dans la timeline et la liste des régions lorsqu'un 
fichier est importé dans une session. 

Dans la plupart des cas, le nom de clip est 
identique au nom de fichier. Le nom de clip de 
fichiers OMF est celui qui apparaît dans le 
chutier Avid. 

Figure 11.  Navigateur du catalogue
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Les noms de clips peuvent être édités 
uniquement au sein d'un catalogue. Lorsque 
vous éditez le nom du clip, cela n'a aucune 
incidence sur le fichier en cours ; cependant, 
lorsque vous ajoutez ce fichier à un nouveau 
catalogue, il s'affiche sous son nom de clip 
original. Si vous faites glisser un fichier d'un 
catalogue dans une session, c'est cependant son 
nom de clip édité qui apparaîtra dans la timeline 
et la liste des régions. 

Si le nom de clip comporte plus de 32 caractères, 
Pro Tools le tronque lors de l'importation dans 
une session. 

Commentaires et catalogues

Les catalogues proposent des commandes 
permettant de gérer des commentaires du Finder 
Mac OS 9, de la base de données ainsi que les 
noms de clips. 

Les commentaires de la base de données au sein 
d'un catalogue sont sauvegardés dans la base de 
données du catalogue. Les remarques peuvent 
contenir jusqu'à 256 caractères, peuvent faire 
l'objet de recherche, s'appliquent à toutes les 
plates-formes et peuvent être éditées. 

Copy OS 9 Finder Comment to Database 
Comments : copie les commentaires Finder 
Mac OS 9 d'un élément sélectionné vers la base 
de données.

Copy Database Comments to Clip Names : 
copie les commentaires de la base de données 
d'une entrée vers le nom de clip. 

Copy File Comments to Clip Names : copie les 
commentaires de fichier d'un élément vers le 
nom de clip. 

Création de catalogues

Vous pouvez ajouter de nouveaux catalogues 
(qui peuvent être vides) à l'espace de travail ou 
sélectionner des fichiers au préalable et créer un 
catalogue basé sur votre sélection. 

Pour créer un catalogue vide :

1  Ouvrez le navigateur de l'espace de travail. 

2  Choisissez New Catalog dans le menu de 
navigation. 

3  Entrez un nouveau nom et cliquez sur OK. 

Pour créer un catalogue à partir de plusieurs 
fichiers : 

1  Ouvrez un navigateur au choix (voire un 
catalogue existant). 

2  Choisissez les éléments que vous souhaitez 
inclure dans le nouveau catalogue. 

3  Sélectionnez Create Catalog dans le menu de 
navigation. 

Une nouvelle base de données de catalogue déjà 
indexée est créée à partir des éléments 
sélectionnés. 

Création de catalogues à partir de 
dossiers

Pour créer un catalogue à partir du contenu d'un 
dossier : 

1  Ouvrez le navigateur de l'espace de travail s'il 
n'est pas ouvert. 

2  Faites glisser un dossier sur l'icône de 
catalogue dans le navigateur de l'espace de 
travail. 

Les commentaires du Finder Mac OS 9 
(accessibles via la fenêtre Infos d'OS 9) 
n'apparaissent pas dans les fenêtres Lire les 
informations de Mac OS X. Utilisez la 
commande Copy OS 9 Finder Comment to 
Database Comments pour récupérer des 
commentaires stockés sur votre support. 
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Pro Tools indexe le dossier et crée ensuite un 
catalogue indexé qui prend le nom du dossier 
sélectionné.

Attribution d'un nouveau nom à un 
catalogue

Vous pouvez renommer un catalogue à 
n'importe quel moment. 

Pour renommer un catalogue :

1  Cliquez sur l'icône du catalogue dans l'espace 
de travail jusqu'à ce que son nom apparaisse en 
surbrillance. 

2  Entrez le nouveau nom du catalogue. 

Modification des catalogues

Pour ajouter des éléments à un catalogue, 
effectuez l'une des actions suivantes :

" Ouvrez le catalogue et faites glisser les fichiers 
souhaités d'un autre navigateur 

– ou –

" Cliquez sur l'icône principale Catalogs dans 
l'espace de travail pour pouvoir visionner tous 
les catalogues disponibles, puis faites glisser les 
fichiers voulus. 

Pour ajouter un dossier à un catalogue :

1  Ouvrez le catalogue.

2  Choisissez Create Folder dans le menu de 
navigation. 

Pour supprimer des éléments d'un catalogue :

1  Sélectionnez les éléments. 

2  Appuyez sur la touche Supprimer ou 
choisissez Delete Selected dans le menu de 
navigation. Une boîte de dialogue 
d'avertissement s'affiche.

3  Dans la boîte de dialogue d'avertissement, 
cliquez sur les éléments suivants :

• Cliquez sur Cancel pour annuler 
l'opération de suppression.

• Cliquez sur Delete Files pour supprimer les 
alias et les fichiers associés du disque.

• Cliquez sur Delete Aliases pour supprimer 
uniquement les alias et non pas les fichiers 
associés.

Une fois effectuée, cette suppression ne peut être 
annulée.

Rassemblement de fichiers dans un catalogue

Les catalogues constituent un outil de choix 
pour rassembler des fichiers provenant de 
plusieurs supports. 

Par exemple, créez un catalogue intitulé 
« Bruits » et placez-y des fichiers provenant de 
trois volumes différents. En faisant glisser le 
catalogue du navigateur de l'espace de travail 
vers un volume, vous créez un dossier « Bruits ». 
Tous les fichiers référencés par le catalogue sont 
automatiquement copiés dans le volume. 
Les dossiers et sous-dossiers (le cas échéant) 
ainsi que leur contenu sont également copiés. 

Boîte de dialogue d'avertissement Delete Catalog
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Mise à jour de catalogues

Une base de données de catalogue n'étant liée à 
un aucun volume spécifique, la commande 
Update Index est moins performante. Si vous 
sélectionnez Update Database for Selected dans 
le menu de navigation, Pro Tools cherche les 
fichiers référencés dans le catalogue et met à 
jour les données suivantes :

Métadonnées les métadonnées de tous les 
fichiers trouvés en ligne, y compris les 
commentaires de fichier, sont mis à jour.

Commentaires de la base de données : 
les commentaires de la base de données ne sont 
pas mis à jour puisqu'ils ne s'appliquent qu'au 
catalogue et n'appartiennent donc pas aux 
métadonnées des fichiers.

Rétablissement des liens des 
éléments d'un catalogue

Si un catalogue renvoie à des fichiers devenus 
introuvables, utilisez Relink pour retrouver, 
copier et relier les fichiers manquants. Pour plus 
d'informations, reportez-vous à la section 
Création et rétablissement de liens de fichiers, 
page 220. 

Suppression de catalogues

Pour supprimer un catalogue :

1  Sélectionnez un ou plusieurs catalogues dans 
le navigateur de l'espace de travail. 

2  Appuyez sur la touche Supprimer ou 
choisissez Delete Selected dans le menu de 
navigation. Une boîte de dialogue 
d'avertissement s'affiche.

3  Dans la boîte de dialogue d'avertissement, 
cliquez sur les éléments suivants :

• Cliquez sur Cancel pour annuler 
l'opération de suppression.

• Cliquez sur Delete Files pour supprimer les 
alias et les fichiers associés du disque.

• Cliquez sur Delete Aliases pour supprimer 
uniquement les alias et non pas les fichiers 
associés.

Une fois effectuée, cette suppression ne peut être 
annulée. 

Importation d'éléments de 
catalogue

Il est possible d'importer des éléments en ligne 
ou hors ligne d'un catalogue dans la session en 
cours. 

Importation des éléments en ligne d'un 
catalogue

L'opération de glisser-déposer des fichiers audio 
sur la liste des régions ou sur la timeline de 
Pro Tools se déroule de la même manière que 
dans un navigateur de volume. 

Boîte de dialogue d'avertissement Delete Catalog

Pour plus d'informations, reportez-vous à la 
section Importation d'éléments avec la 
fonction glisser-déposer, page 263. 
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Importation d'éléments hors ligne d'un 
catalogue

Les catalogues permettent également de 
chercher et d'importer des fichiers hors ligne. 
Si, par exemple, vous disposez d'un extrait 
musical stocké sur un CD-ROM ou sur un 
volume non disponible, vous pouvez faire 
glisser le fichier en question du catalogue vers la 
timeline d'une session. Le fichier est 
automatiquement importé dans la session lors 
du montage du volume. 

La première étape consiste à ajouter des fichiers 
à un catalogue (les fichiers doivent être en 
ligne). Une fois l'ajout à un catalogue effectué, 
les éléments sont affichés en italique s'ils sont 
mis hors ligne. 

Les fichiers hors ligne peuvent être déposés 
depuis un catalogue sur la timeline d'une session 
comme des fichiers en ligne. Une boîte de 
dialogue s'affiche, vous demandant si vous 
souhaitez ou non rétablir un lien avec le fichier. 
Cliquez sur Skip All pour charger tous les 
éléments en tant que fichiers hors ligne (les 
régions correspondantes apparaissent en bleu 
dans la timeline). Le navigateur de projet 
répertorie ces éléments dans le dossier Render 
Sources pour signaler à Pro Tools qu'il est 
nécessaire de rétablir les liens manquants. 

Dès que vous montez un volume contenant les 
fichiers hors ligne référencés, Pro Tools importe 
automatiquement les données en arrière-plan. 
Ceci est le cas même si vous avez enregistré la 
session, quitter ou relancer Pro Tools. 

Dès que les données ont été importées, elles 
apparaissent comme des éléments en ligne dans 
la timeline, la liste des régions et le navigateur 
de projet. 

Si les éléments hors ligne utilisent la même 
fréquence d'échantillonnage, la même 
résolution (nombre de bits) et le même format 
que la session, aucune conversion n'est 
nécessaire. Tant que le volume est disponible 
pour la lecture, les éléments peuvent être lus 
dans la session dès que le volume est monté. 

Si le volume n'est pas disponible pour la lecture, 
vous êtes invité à copier les fichiers requis vers 
des volumes appropriés. 

Fenêtre de tâches
Afin d'accroître la flexibilité et les performances 
des tâches de gestion de fichiers, Pro Tools 
propose une fenêtre de tâches (voir figure 12, 
page 239). La gestion de fichiers dans Pro Tools 
implique la création, la copie, la conversion, la 
recherche et l'indexation de fichiers de façon 
quasi permanente. Ces tâches sont exécutées en 
arrière-plan et ne retardent pas les processus 
d'enregistrement, de montage et de mixage en 
cours. 

La fenêtre de tâches permet de surveiller, 
d'interrompre ou d'annuler les tâches en cours 
(telle que la copie, la création de fondus et 
l'indexation). 

Pour plus d'informations sur le transfert de 
fichiers, les fichiers manquants et le 
rétablissement de liens, consultez la section 
Fenêtre Relink, page 224.

Vous ne pouvez pas effectuer d'opérations 
de glisser/déposer vers ou depuis la fenêtre 
de tâches.
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Ouverture de la fenêtre de tâches

Pour ouvrir la fenêtre de tâches :

" Dans Pro Tools, choisissez Window > Task 
Manager.

Messages de la fenêtre de tâches

Lorsqu'une tâche ne peut pas être exécutée en 
arrière-plan, la fenêtre de tâches passe au 
premier plan et vous informe de l'erreur. La 
tâche incomplète apparaît alors dans le volet 
Paused Tasks (tâches suspendues) de la fenêtre 
de tâches. 

La fenêtre de tâches étant une fenêtre flottante, 
elle n'entravera en aucun cas l'opération 
actuellement en cours. Vous pouvez donc 
poursuivre l'enregistrement et l'édition, et 
repousser la gestion des fichiers à un moment 
plus approprié.

Appuyez sur Alt+' (Windows) ou sur 
Option+' (Mac) pour ouvrir le navigateur de 
l'espace de travail.

Figure 12.  Fenêtre de tâches, vues maximale (haut) et minimale (bas)
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Affichage de la fenêtre de tâches

La fenêtre de tâches propose un affichage 
maximum et minimum. 

Pour alterner entre les deux types d'affichage :

" Cliquez sur l'icône de basculement de vue, 
située en haut de la fenêtre de tâches. 

Outils, colonnes et vues de la 
fenêtre de tâches

La fenêtre de tâches fournit des commandes 
pour les opérations de la fenêtre de tâches.

Les données suivantes sont toujours visibles 
dans la fenêtre de tâches (pour les deux types de 
vues) :

Name : renvoie à l'élément concerné, qu'il 
s'agisse d'un fichier, d'une base de données ou de 
tout autre élément pris en charge.

Etat : il s'agit de l'action en cours (copie, 
traitement, indexation, etc.).

Progress : spécifie l'état d'avancement de la 
tâche ou de ses tâches secondaires, ce qui inclut 
l'analyse de la taille des entrées et la durée 
approximative requise pour compléter la tâche. 

Barre de progression : indique que le traitement 
est en cours. 

Quantification : indique, en pourcentage, l'état 
d'avancement de la tâche en cours.

Fenêtre des tâches actives

La partie supérieure de la fenêtre de tâches 
affiche les tâches en cours et celles en attente de 
traitement. La tâche en cours d'exécution se 
trouve tout en haut de la liste. Toutes les tâches 
apparaissant dans ce volet seront exécutées. 

Les tâches exécutées disparaissent de la file 
d'attente.

Les tâches ne pouvant pas être exécutées sont 
transférées dans le volet Paused tasks (voir plus 
loin). La colonne Status contient une 
description de l'erreur.

Volet Paused tasks

Le volet Paused tasks se trouve sous le volet des 
tâches actives, sous une barre de séparation 
amovible. Les tâches répertoriées dans ce volet 
ne seront exécutées qu'une fois déplacées dans le 
volet de tâches actives. 

Interruption et annulation des 
tâches

La fenêtre de tâches permet d'interrompre 
(mettre en pause), de reprendre et d'annuler des 
tâches. 

Pour interrompre une tâche :

" Faites glisser la tâche du volet Active Tasks 
dans le volet Paused Tasks. 

Cette tâche se trouve alors en haut de la liste de 
tâches suspendues. 

Pour interrompre toutes les tâches :

" Choisissez Pause All dans le menu de la 
fenêtre de tâches.

Pour reprendre une tâche :

" Faites glisser la tâche depuis le volet Paused 
Tasks dans le volet des tâches actives. La tâche 
retrouve alors sa place originale dans la liste 
d'attente. 
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Pour reprendre toutes les tâches :

" Sélectionnez Resume All dans le menu de la 
fenêtre de tâches. Toutes les tâches de la fenêtre 
Paused Tasks (sauf celles n'ayant pas pu être 
complétées) apparaissent dans le volet des 
tâches actives. 

Pour annuler une tâche :

1  Sélectionnez la tâche dans l'un des deux volets 
de la fenêtre de tâches.

2  Appuyez sur Supprimer pour la supprimer de 
la fenêtre de tâches. 

Pour annuler toutes les tâches :

1  Sélectionnez n'importe quelle tâche dans l'un 
des deux volets de la fenêtre. 

2  Appuyez sur Ctrl+A (Windows) ou sur 
Pomme+A (Mac) pour sélectionner toutes les 
tâches de ce volet.

3  Appuyez sur Supprimer.

Cette commande ne peut pas être annulée.

A propos de l'interruption d'une tâche

Certaines tâches se composent en fait de 
plusieurs sous-tâches. Lorsque vous supprimez 
une tâche, les sous-tâches déjà exécutées ne sont 
pas annulées. Par exemple, même si 
l'importation et la conversion de plusieurs 
fichiers apparaissent comme une tâche unique, 
la suppression de cette tâche avant qu'elle ne 
soit complétée interrompt le processus 
d'importation et de conversion. Les fichiers déjà 
convertis et importés restent cependant sur le 
disque dur. Si vous souhaitez interrompre une 
tâche comprenant plusieurs sous-tâches, il vaut 
mieux attendre la fin de l'opération et vous 
servir d'Undo pour annuler toutes les 
sous-tâches, si possible. 

Fermeture de sessions avec des 
tâches en attente

Si vous fermez une session ou si vous quittez 
Pro Tools alors qu'il reste encore des tâches à 
exécuter (dans le volet des tâches actives ou 
Paused tasks), Pro Tools vous demande si vous 
souhaitez annuler les tâches restantes ou les 
exécuter. Vous pouvez alors ouvrir la fenêtre de 
tâches et attendre la fin des opérations, annuler 
les tâches en attente ou quitter la fenêtre. Si vous 
fermez la session, certaines tâches sont 
annulées. Les tâches comportant la copie de 
fichiers sont cependant mémorisées et relancées 
au prochain lancement de Pro Tools. 

A propos des tâches ayant échoué

Le volet Paused tasks contient une liste de toutes 
les tâches qui n'ont pas pu être exécutées. 
La raison de cet échec apparaît dans la colonne 
Status. 

Une tâche ayant échoué ne peut pas être reprise 
et doit être supprimée manuellement du volet 
Paused tasks. 

Si la commande Automatically Find and Relink 
n'a pas pu trouver tous les fichiers d'une session, 
la tâche apparaît dans la partie Paused tasks avec 
un message d'échec. Elle reste dans ce volet 
jusqu'au moment où vous la supprimez de la 
fenêtre de tâches (même si vous êtes parvenu à 
retrouver les fichiers ultérieurement au cours 
d'une nouvelle opération de recherche et de 
connexion). 
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Priorité des tâches

Une tâche en cours peut être interrompue par 
une autre tâche ayant priorité sur la première. 
Dans ce cas, la tâche interrompue est exécutée 
plus tard et une barre de progression dans le 
volet des tâches actives indique à quel moment 
la tâche a été interrompue. Une fois la tâche 
prioritaire terminée, la première tâche 
inachevée est reprise.

Conseils pour l'utilisation de la 
fenêtre de tâches

Interrompre les tâches durant la lecture

Le menu de navigation de la fenêtre de tâches 
propose une préférence globale intitulée Pause 
during Playback. Lorsque cette option est 
activée, les tâches actives sont suspendues 
durant la lecture (ou l'enregistrement) de 
Pro Tools. Ce paramètre est surtout conseillé 
pour des processeurs plutôt lents ou pour éviter 
qu'une surcharge du système ne ralentisse les 
opérations d'enregistrement ou de lecture. 
Cette préférence garde son statut jusqu'au 
moment où vous le modifiez. 

Tâches sauvegardées

Une tâche qui importe des fichiers dans une 
session est sauvegardée avec la session lors de sa 
fermeture. Elle reprend dès que vous ouvrez à 
nouveau cette session. 

Si, par exemple, vous importez des pistes 
(Import Track) avec l'option Copy Media 
activée, enregistrez et quittez la session avant 
que cette tâche ne soit achevée, les tâches de 
copie reprennent automatiquement la 
prochaine fois que vous ouvrez cette session. 

Tâches groupées

Certaines tâches englobent plusieurs tâches 
auxiliaires. Ainsi, Copy and Relink peut 
nécessiter la copie de plusieurs centaines de 
fichiers. Afin de faciliter la gestion de ce type de 
tâches, celles-ci sont regroupées selon l'action 
qu'elles effectuent. Ainsi, une commande Copy 
and Relink apparaît comme une seule tâche de 
copie dans la fenêtre de tâches, avec cependant 
une icône Développement/Réduction dans la 
fenêtre de tâches. En cliquant sur cette icône, 
vous affichez la liste des sous-tâches impliquées.

Si la liste contient plusieurs tâches groupées, les 
sous-tâches du deuxième groupe ne sont traitées 
qu'une fois toutes les sous-tâches du groupe 
précédent exécutées.

Si vous enregistrez et fermez une session dont 
plusieurs tâches groupées se trouvent dans la file 
d'attente, et s'il s'agit de tâches pouvant être 
reportées à l'ouverture ultérieure, elles sont 
affichées comme membres d'un unique groupe 
la prochaine fois que vous ouvrez la session. 

Exemple pratique
Cet exemple montre comment exploiter les 
fonctions des navigateurs DigiBase, notamment 
ses catalogues, au sein d'un projet classique de 
postproduction. 

Supposons pour cet exemple que vous deviez 
produire les données audio d'un spot 
publicitaire télévisé pour une gamme de 
produits de la firme Aviary Fish & Chips. 
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Démarrage de Pro Tools et contrôle de l'espace de 
travail

1  Lancez Pro Tools. Le navigateur de l'espace de 
travail s'affiche sur tous les volumes montés. 
L'icône Catalogs s'affiche également. 

2  Cliquez sur l'icône Développer/Réduire située 
en regard de l'icône Catalogs pour afficher tous 
les catalogues du dossier Catalogs. Il vous faut 
avant tout créer un catalogue, car ce projet n'en 
contient encore aucun. 

Création d'un catalogue (Pro Tools HD et 
Pro Tools LE avec DV Toolkit uniquement)

3  Dans le menu de navigation, sélectionnez 
New Catalog.

4  Nommez le catalogue Aviary.

5  Cliquez sur OK. 

Un nouveau dossier appelé Aviary s'affiche sous 
l'icône Catalog dans le navigateur de l'espace de 
travail.

Recherche et sélection de fichiers audio pour le 
projet

6  Des sons de pas sont nécessaires pour ce 
projet. Vous pouvez utiliser les sons de pas 
enregistrés dans la session sur un disque dur 
local. Pour les visualiser, retournez dans le 
navigateur de l'espace de travail et ouvrez le 
navigateur de volumes du disque en question.

7  Pour rechercher tous les enregistrements de 
sons de pas, cliquez sur l'icône de recherche 
dans le navigateur de volumes afin d'activer les 
outils de recherche. 

8  Dans la zone d'entrée de texte en dessous de 
File Name, tapez foot (pas) et appuyez sur la 
touche Entrée (ou cliquez sur le bouton Search). 

Eléments dans le navigateur de l'espace de travail

Choisissez New Catalog dans le menu de navigation.

Menu de 
navigation

Nouveau catalogue affiché dans le navigateur l'espace 
de travail

Icône de recherche dans la barre d'outils du navigateur

Icône de recherche
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Les fichiers trouvés par le navigateur et 
correspondant à la recherche s'affichent les uns 
après les autres. 

9  Choisissez tous les fichiers résidant sur ce 
volume et faites-les glisser vers l'icône de 
catalogue Aviary (que vous trouverez dans le 
navigateur de l'espace de travail). 

10  Refermez le navigateur de volumes et cliquez 
deux fois sur le catalogue Aviary : le navigateur 
du catalogue Aviary s'ouvre alors. Il affiche les 
fichiers footstep (de sons de pas) entièrement 
indexés.

11  Vous allez à présent rechercher des cris de 
souris (provenant d'un nouveau CD d'effets 
sonores, par exemple). Montez le CD : il 
apparaît sous forme de nouveau volume dans le 
navigateur de l'espace de travail. 

12  Pour éviter de devoir indexer et rechercher 
tous les fichiers du CD, cliquez deux fois sur 
l'icône de CD dans le navigateur de l'espace de 
travail afin d'ouvrir le navigateur de volumes du 
CD. Le navigateur affiche vingt dossiers ou plus 
(c'est souvent le cas des bibliothèques d'effets 
sonores, car les sons y sont organisés par thème).

13  Cliquez sur le dossier Animals (Animaux) 
afin de l'afficher en surbrillance et choisissez 
Update Database for Selected dans le menu de 
navigation. Cette opération permet d'indexer 
uniquement le dossier choisi plutôt que le 
disque entier.

14  Quand le dossier est indexé, effectuez une 
recherche en tapant « Mouse » (souris). 
Le navigateur localise et affiche plusieurs 
fichiers. 

15  Ecoutez chaque entrée en cliquant sur le 
haut-parleur à gauche de la forme d'onde. 

16  Choisissez les trois fichiers qui vous semblent 
les plus appropriés et faites-les glisser vers le 
navigateur du catalogue Aviary. Ces fichiers 
s'affichent à présent en regard des fichiers de pas 
sélectionnés précédemment. 

17  Refermez le navigateur du CD.

Recherche sur plusieurs critères

18  Vous avez ensuite besoin d'un bruit 
d'accident de voitures durant entre 5 à 
6 secondes. Un catalogue d'une bibliothèque 
d'effets sonores composée de cinq disques est 
disponible ; bien que les CD ne soient pas 
montés, vous pouvez y effectuer des recherches. 

Résultats de la recherche dans le navigateur de 
l'espace de travail

Eléments figurant dans le catalogue
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19  Cliquez sur l'icône de recherche du 
navigateur Workspace, choisissez les cinq 
catalogues sur lesquels votre recherche doit 
porter, tapez « car crash » (accident de voiture) 
dans la zone File Name et configurez la plage 
Duration pour rechercher les fichiers d'une 
durée de 5 à 6 secondes. Bien que les CD soient 
hors ligne (pas montés), le système trouve des 
résultats. 

20  Le navigateur a trouvé quatre fichiers 
répondant aux critères de la recherche. Faites-les 
glisser vers le navigateur du catalogue Aviary 
pour les ajouter au catalogue (ils apparaissent 
sous forme d'éléments hors ligne). 

Repérage de fichiers à partir du catalogue 
(Pro Tools HD et Pro Tools LE avec DV Toolkit 
uniquement)

21  Refermez tous les navigateurs à l'exception 
du catalogue Aviary. 

22  Faites glisser les fichiers depuis le navigateur 
du catalogue Aviary vers la timeline de la session 
actuelle afin de les placer aux emplacements 
souhaités.

• Les sons de pas sont disponibles et peuvent 
être reproduits, car ils sont déjà liés au 
dossier Audio Files.

• Quand vous ajoutez les cris de souris, les 
fichiers sont automatiquement copiés du 
CD monté vers le dossier Audio Files de la 
session. La copie et la conversion 
éventuellement requise sont effectuées en 
arrière-plan.

• Placez le bruit d'accident de voiture 
souhaité en le sélectionnant dans le 
catalogue (il se trouve sur un des CD hors 
ligne). Bien que le disque ne soit pas 
monté, le fichier d'accident apparaît dans 
la timeline et la liste de régions audio sous 
forme d'un fichier audio hors ligne. Quand 
vous souhaiterez écouter et utiliser les 
bruits d'accidents (hors ligne), vous 
monterez le CD contenant les effets en 
question. Etant donné que le CD n'est pas 
un lecteur disponible pour la lecture, le 
fichier est toujours affiché hors ligne dans 
la timeline. Recherche de fichiers audio durant entre 5 et 

6 secondes

Placement de données audio d'un catalogue dans la 
session



Guide de référence Pro Tools246

23  Mettez le fichier souhaité en surbrillance 
dans le navigateur de projet et choisissez Copy 
and Relink dans le menu de navigation. 
Sélectionnez ensuite un volume Performance 
disponible pour ce fichier. Sélectionnez ensuite 
un volume de lecture disponible pour le fichier. 
Une fois la copie terminée, le fichier est affiché 
en ligne dans la session, indiquant qu'il est prêt 
pour la lecture. 

Pour plus d'informations sur la création de 
liens, reportez-vous à la section Fenêtre 
Relink, page 224.
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Chapitre 12 : Importation et 
exportation de données de session

Pro Tools permet d'importer un grand nombre 
de données dans une session, notamment des 
fichiers audio et MIDI, des groupes de régions, 
des fichiers vidéo, des playlists de pistes, des 
configurations d'E/S et des configurations 
d'assignations de signaux.

Vous pouvez importer des fichiers audio et MIDI 
dans une session ou transférer l'intégralité de 
pistes audio ou MIDI, ainsi que leurs attributs, 
depuis une autre session. De plus, avec les 
systèmes Pro Tools HD, vous avez la possibilité 
d'importer toute combinaison d'attributs de 
pistes depuis une autre session, comme les 
playlists audio ou MIDI, l'assignation des 
signaux, les plug-in ou l'automation d'une piste. 
Voir Importation de données audio, page 247 et 
Importation de pistes et de leurs attributs, 
page 255. 

Importation de données audio
Les fichiers et les régions audio peuvent être 
importés vers de nouvelles pistes ou dans la liste 
des régions, d'où on peut les faire glisser sur des 
pistes existantes.

Pro Tools peut convertir automatiquement tout 
fichier ne correspondant pas au type de fichier 
audio, à la fréquence d'échantillonnage ou à la 
résolution de la session. Le cas échéant, ces 
fichiers audio doivent être convertis lors de 
l'importation. Pro Tools divise également les 
fichiers audio entrelacés en plusieurs fichiers 
mono.

Vous pouvez écouter les fichiers et les régions 
avant de les importer.

Si des définitions de régions sont présentes dans 
un fichier audio, vous pouvez convertir et 
importer l'audio pour une région sans importer 
l'ensemble du fichier audio parent.

Pour importer ou exporter des fichiers vidéo, 
reportez-vous au chapitre 36, Traitement 
vidéo dans Pro Tools

Pro Tools 7.x ne prend pas en charge les 
noms de fichier audio composés de certains 
caractères ASCII (voir Ouverture d'une 
session contenant des noms de fichier audio 
avec des caractères interdits, page 285).
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Les fichiers audio de type suivant peuvent être 
importés dans des sessions Pro Tools :

• AIFF

• WAV ou BWF (.WAV)

• SD II

• SD I

• MP3

• MXF audio

• Sound Resource (AIFL — Mac seulement)

• WMA (Windows Media — Windows 
seulement)

• QuickTime (Mac uniquement)

• AAC audio (y compris les données audio 
avec les extensions de fichier AAC, Mp4 et 
M4a)

• Fichiers ReCycle (REX 1 et 2)

• Fichiers ACID

Importation de fichiers ACID et REX

Lorsque vous travaillez avec des fichiers ACID 
ou REX 1 et 2, prenez les éléments suivants en 
considération :

! Les fichiers ACID sans données temporelles 
sont importés sous forme de régions audio.

! Les fichiers ACID avec données temporelles et 
les fichiers REX 1 et 2 sont importés sous forme 
de groupes de régions (voir Importation et 
exportation de fichiers de groupe de régions, 
page 279).

! Après avoir importé des fichiers ACID et des 
fichiers REX 1 et 2, il est possible de réduire la 
liste des régions en masquant les régions créées 
automatiquement (désélectionnez Show > Auto-
Created dans le menu déroulant de la liste des 
régions).

! Pro Tools peut automatiquement appliquer 
des crossfades temps réel à des fichiers REX et 
ACID importés (voir Fondus automatiques pour 
fichiers REX et ACID importés, page 249).

Copie, ajout et conversion de données 
audio

Suivant les propriétés des fichiers audio que 
vous importez, vous pouvez les ajouter, les 
copier ou les convertir. Les options suivantes 
s'affichent dans la boîte de dialogue Import 
Audio lorsqu'elles s'appliquent au fichier audio 
sélectionné.

Ajout

Les fichiers audio de même résolution et de 
même type qu'une session peuvent y être 
ajoutés directement. Lorsque vous ajoutez un 
fichier audio, la session référence le fichier audio 
d'origine dans son emplacement d'origine. 
Utilisez cette option si vous ne voulez pas 
consommer d'espace supplémentaire sur le 
disque dur pour des fichiers audio dont la 
résolution et le type correspondent déjà à votre 
session.

Pro Tools permet d'ajouter à une session des 
fichiers audio qui ne sont pas de son type natif. 
Par exemple, vous pouvez ajouter des fichiers 
SD II, AIFF ou WAV à n'importe quelle session 
Mac ou des fichiers AIFF ou WAV à n'importe 
quelle session Windows. Toutefois, cette 
opération réduit les performances des sessions 
mélangeant les types de fichiers. 

Pro Tools n'est pas en mesure d'importer 
des fichiers AAC ou MP4 protégés avec 
l'extension .M4p. Ces fichiers sont protégés 
par des droits en matière de propriété 
numérique.
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Les fichiers audio dont la résolution est 
différente de celle de la session doivent être 
convertis avant d'être importés. 

Copie

Dès que vous pouvez ajouter un fichier à votre 
session, vous avez également la possibilité de le 
copier. Cette option crée une copie du fichier 
audio et la place dans le dossier de votre choix. 
Lorsque vous copiez un fichier audio, la session 
référence le fichier copié dans son nouvel 
emplacement. 

L'option Copy peut en outre servir à déplacer 
des données audio d'un lecteur non pris en 
charge ou extractible vers un lecteur audio, ou 
pour archiver des fichiers audio d'une session 
vers un emplacement spécifique.

Conversion

Les fichiers audio dont la résolution et la 
fréquence d'échantillonnage sont différentes de 
celles de la session, ou dont le type de fichier est 
incompatible (tels que les fichiers SD II dans 
Windows) doivent être convertis pour être 
utilisés dans la session. Lorsqu'un fichier audio 
est converti, un nouveau fichier avec la 
résolution, le type et la fréquence 
d'échantillonnage corrects est créé et placé dans 
le dossier de votre choix.

La qualité de conversion de la fréquence 
d'échantillonnage utilisée par Pro Tools est 
déterminée par l'option Conversion Quality 
dans les préférences. Pour en savoir plus, 
reportez-vous à Qualité de conversion de 
fréquence d'échantillonnage, page 250.

Importation de fichiers stéréo

Lorsque vous utilisez la commande Import 
Audio, les fichiers stéréo entrelacés sont 
automatiquement importés dans des pistes 
stéréo.

Les fichiers audio stéréo non entrelacés (double 
mono) peuvent être importés automatiquement 
vers des pistes stéréo. Les fichiers de ce type 
doivent inclure dans leurs noms les 
identificateurs de canal « .L » et « .R » 
(par exemple, nomfichier.L et nomfichier.R) et les 
fichiers doivent être de même longueur. 
Sous Windows ou en mode de compatibilité 
Mac/PC, ces fichiers portent une extension de 
trois lettres ajoutée après l'identificateur de 
canal « .L » ou « .R ».

Pro Tools permet également d'importer des 
fichiers multicanaux entrelacés pour chaque 
type de fichier reconnu. 

Fondus automatiques pour fichiers REX 
et ACID importés

Pro Tools peut automatiquement appliquer des 
crossfades temps réel aux régions ou « sections » 
des fichiers REX et ACID importés. 

Pour appliquer de crossfades temps réel à des 
fichiers REX et ACID :

1  Choisissez Setup > Preferences, puis cliquez 
sur Editing. 

2  Sélectionnez l'option Automatically Create 
Fades For Imported REX and ACID files.

Pro Tools permet d'ajouter à une session des 
fichiers de fréquence d'échantillonnage 
différente. Dans le champ des 
commentaires de la boîte de dialogue 
Import Audio, un avertissement indique que 
ces fichiers ne seront pas lus à la bonne 
vitesse et à la bonne hauteur si vous ne les 
convertissez pas.
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3  Cliquez sur REX/ACID, choisissez les formes 
souhaitées pour les crossfades et cliquez sur OK. 

4  Cliquez sur OK pour refermer la boîte de 
dialogue Preferences.

Qualité de conversion de 
fréquence d'échantillonnage
Ce paramètre détermine la qualité de la 
conversion de la fréquence d'échantillonnage 
utilisée lors de la conversion et de l'importation 
de données audio dans une session. Cinq 
qualités de conversion sont possibles, classées 
par ordre croissant : de Low à Tweak Head. Plus la 
qualité est élevée et la conversion importante, 
plus le temps nécessaire à la conversion sera 
important.

Pour définir la qualité de conversion de la 
fréquence d'échantillonnage :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Processing.

2  Dans le menu déroulant Sample Rate 
Conversion Quality, sélectionnez la qualité. 
Dans la plupart des applications, les qualités 
Good (bon) ou Better (meilleur) donneront de 
très bons résultats.

3  Cliquez sur OK.

Importation des fichiers audio 
et des régions
Pro Tools propose plusieurs méthodes pour 
importer des fichiers audio et des régions dans 
une session ouverte.

• Importation de fichiers et de régions audio 
à l'aide des commandes de menu Pro Tools, 
page 250

• Importation de fichiers audio à l'aide de 
l'icône de l'application Pro Tools ou de son 
alias, page 253

• Importation de fichiers audio par 
glisser-déposer, page 253

• Importation de données audio depuis des 
CD audio, page 253

Importation de fichiers et de 
régions audio à l'aide des 
commandes de menu Pro Tools

Pro Tools offre plusieurs commandes de menu 
pour importer des fichiers ou des régions audio.

Selon vos éditions ou vos modifications de 
tempo après importation de fichiers REX ou 
ACID, il est possible que les fondus soient 
supprimés et vous deviez les recréer.

Préférence de qualité de la conversion de la fréquence 
d'échantillonnage

Pour importer des pistes entières depuis 
d'autres sessions, reportez-vous à 
Importation de pistes et de leurs attributs, 
page 255.
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Pour importer des fichiers ou des régions audio 
dans une session (depuis le menu File de 
Pro Tools) :

1  Choisissez File > Import > Audio. 

2  Dans la boîte de dialogue Import Audio, 
sélectionnez un fichier audio pour afficher ses 
propriétés et ses régions associées.

Vous pouvez choisir de ne faire apparaître qu'un 
seul type de fichier (AIFF, par exemple) en le 
sélectionnant dans le menu déroulant Show. 
Pour afficher tous les types de fichiers pris en 
charge, sélectionnez All Documents dans le 
menu déroulant Show.

Dans la liste d'importation, les fichiers audio se 
distinguent des régions par leurs icônes.

3  Pour écouter un fichier ou une région 
sélectionnés avant importation, cliquez sur les 
boutons de lecture et d'arrêt de la boîte de 
dialogue d'importation audio.

Pour régler le volume de lecture, déplacez le 
curseur vertical. Pour aller à un endroit 
particulier du fichier, déplacez le curseur 
horizontal qui se trouve juste au-dessous des 
boutons de lecture et d'arrêt. 

Les canaux 1–2 constituent la sortie d'écoute par 
défaut. Sur les systèmes Pro Tools HD, la sortie 
d'écoute peut être modifiée dans I/O Setup ou 
Hardware Setup.

4  Effectuez l'une des opérations suivantes :

• Pour placer un fichier ou une région dans la 
liste d'importation, sélectionnez le fichier 
puis cliquez sur Add ou Convert. 

• Pour importer tous les fichiers et régions 
dans le répertoire actuel, cliquez sur Add 
All ou Convert All. 

• Pour supprimer un fichier ou une région de 
la liste d'importation, sélectionnez-le (ou 
la) et cliquez sur Remove. 

• Pour supprimer toutes les régions ou les 
fichiers, cliquez sur Remove All.

5  Lorsque vous avez ajouté tous les fichiers 
audio et toutes les régions à la liste 
d'importation, vous pouvez appliquer la 
conversion de la fréquence d'échantillonnage en 
effectuant les actions suivantes :

• Activez Apply SRC.

Figure 13.  Boîte de dialogue Import Audio

Icônes des fichiers et des régions dans la boîte de 
dialogue Import Audio

Icône de fichier audio

Icône de région audio

Sur Mac, les fichiers de ressources son 
(Sound Resource) doivent porter l'extension 
.SFIL pour que Pro Tools puisse les 
importer. 
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• Spécifiez la fréquence d'échantillonnage 
source soit en saisissant un numéro, soit en 
sélectionnant une fréquence dans le menu 
contextuel.

• Dans le menu contextuel Quality, 
sélectionnez une conversion de fréquence 
d'échantillonnage. Ce paramètre de qualité 
de la conversion de la fréquence 
d'échantillonnage annule celui de la page 
des préférences de traitement.

6  Cliquez sur Done (Terminé).

7  Si vous copiez ou convertissez des fichiers, 
sélectionnez un emplacement pour les 
nouveaux fichiers. Sélectionnez un dossier dans 
un lecteur audio valide, tel que le dossier Audio 
Files pour la session actuelle. 

8  Dans la boîte de dialogue Audio Import 
Options, sélectionnez l'endroit de la session où 
iront les fichiers importés.

New Track : chaque fichier audio est importé 
dans sa propre piste individuelle et dans la liste 
de régions. 

Lorsque vous importez de l'audio dans une piste, 
vous pouvez également sélectionner 
l'emplacement de la piste où le fichier audio doit 
démarrer (en début de session par exemple).

Region List : les fichiers audio sont importés 
dans la liste de régions sans créer de piste. Les 
fichiers audio importés apparaissent dans la liste 
de régions et vous pouvez les faire glisser vers 
une piste audio.

9  Si vous créez une piste, choisissez 
l'emplacement pour le fichier importé dans la 
piste :

Session Start : place le fichier ou la région au 
début de la session. 

Song Start : aligne le début du fichier ou de la 
région avec le début du morceau. 

Selection : aligne le début du fichier ou de la 
région avec le curseur d'édition ou le début 
d'une sélection dans la timeline.

Spot : affiche la boîte de dialogue Spot qui 
permet de placer le fichier ou la région dans un 
emplacement spécifique basé sur toute échelle 
temporelle.

10  Cliquez sur OK.

Boîte de dialogue Audio Import Options



Chapitre 12 : Importation et exportation de données de session 253

Importation de fichiers audio à 
l'aide de l'icône de l'application 
Pro Tools ou de son alias

Il est possible d'importer des fichiers audio dans 
une session en utilisant l'icône de l'application 
Pro Tools ou son alias.

Pour importer des fichiers audio dans une session 
en utilisant l'icône de l'application Pro Tools ou 
son alias :

1  Ouvrez ou créez une session.

2  Depuis l'Explorateur Windows ou le Finder 
Mac, recherchez les fichiers audio que vous 
souhaitez importer.

Les fichiers audio doivent être au format WAV, 
SD II ou AIFF/AIFC pour pouvoir être déposés 
dans Pro Tools. 

Les fichiers audio seront convertis s'ils ne sont 
pas de résolution correcte ou s'ils n'ont pas le 
nombre correct de canaux. Ils seront convertis 
en fichiers mono en utilisant le format de fichier 
audio par défaut, avec la résolution et la 
fréquence d'échantillonnage de la session. 

3  Faites glisser les fichiers audio sur l'icône de 
l'application Pro Tools ou son alias.

Importation de fichiers audio par 
glisser-déposer

Vous pouvez faire glisser des fichiers audio à 
partir d'un navigateur DigiBase ou depuis 
l'Explorateur Windows ou le Finder Mac et les 
déposer dans la timeline, une piste, la liste des 
pistes ou la liste des régions.

Pour importer de l'audio dans la liste des régions :

1  Sélectionnez des fichiers audio dans un 
navigateur DigiBase, dans l'Explorateur 
Windows ou dans le Finder Mac. 

2  Déposez les fichiers dans la liste des régions de 
la session actuelle. 

Pour importer de l'audio dans une piste existante :

1  Sélectionnez des fichiers audio dans un 
navigateur DigiBase, dans l'Explorateur 
Windows ou dans le Finder Mac. 

2  Déposez les fichiers dans une piste existante 
de la fenêtre Edit de la session actuelle. 

Pour importer de l'audio dans de nouvelles pistes :

1  Sélectionnez des fichiers audio dans un 
navigateur DigiBase, dans l'Explorateur 
Windows ou dans le Finder Mac. 

2  Effectuez l'une des opérations suivantes :

• Maintenant la touche Maj enfoncée et 
cliquez sur les pistes et déposez les fichiers 
dans la fenêtre Edit de la session actuelle. 

• Déposez les fichiers dans un emplacement 
vide de la fenêtre Edit de la session actuelle.

• Déposez les fichiers dans la liste des pistes.

Importation de données audio 
depuis des CD audio

Pro Tools permet d'importer des pistes depuis 
des CD audio en appliquant les mêmes 
méthodes que pour des fichiers audio :

• en faisant glisser les données audio du CD à 
partir du dossier du CD ;

• en faisant glisser des fichiers depuis le 
navigateur DigiBase ;

• en utilisant la commande Import Audio.

Pour en savoir plus sur l'utilisation des 
navigateurs DigiBase, reportez-vous au 
chapitre 11, DigiBase.
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Le transfert s'effectuant dans le domaine 
numérique, il n'y a aucune dégradation de 
signal.

La fréquence d'échantillonnage des CD audio 
est de 44,1 kHz. C'est pourquoi, si la fréquence 
d'échantillonnage de la session est de 48 kHz ou 
plus, Pro Tools convertit celle des données audio 
importées. Avant d'importer des données audio 
d'un CD, réglez la qualité de conversion désirée. 
Pour plus d'informations, reportez-vous à la 
section Qualité de conversion de fréquence 
d'échantillonnage, page 250.

Avant d'importer des données audio d'un CD, 
assurez-vous que l'espace libre sur le disque dur 
est suffisant pour accueillir les fichiers audio 
convertis.

Pour importer des données audio d'un CD à l'aide 
du navigateur DigiBase :

1  Insérez le CD audio dans le lecteur de CD-
ROM.

2  Choisissez Window > Workspace.

3  Dans le navigateur DigiBase, cliquez sur le CD 
et sélectionnez la piste audio. 

4  Effectuez l'une des opérations suivantes :

• Faites glisser le fichier et déposez-le dans la 
liste des régions pour l'ajouter à la session.

• Faites glisser le fichier et déposez-le sur une 
piste pour le placer dans la piste.

• Faites glisser le fichier et déposez-le dans la 
liste des pistes pour ajouter et créer une 
piste.

Pro Tools convertit la piste audio du CD en 
fichier ayant un format, une résolution et une 
fréquence d'échantillonnage identiques à ceux 
de la session, et l'enregistre sur votre disque dur. 

Le fichier audio importé s'affiche dans la liste 
des régions. Vous pouvez ensuite faire glisser la 
région sur une piste de votre session.

Importation de fichier audio 
multicanaux à partir d'un appareil 
d'enregistrement portable

Pro Tools vous permet d'utiliser la méthode de 
votre choix pour importer des fichier audio 
monophoniques et polyphoniques enregistrés 
par un appareil d'enregistrement portable. 
Lorsque vous importez ces types de fichiers, 
vous devez les convertir en format audio 
compatible avec Pro Tools.

L'importation de données audio provenant 
d'un CD à l'aide d'une méthode glisser-
déposer vous permet de continuer à 
travailler dans la session au premier-plan 
(dans la fenêtre Mix ou Edit, par exemple) 
pendant que le Gestionnaire de tâches 
(Window > Task Manager) se charge 
d'importer et de convertir les données audio 
en arrière-plan.

Pour plus d'informations sur le 
Gestionnaire de tâches, reportez-vous à la 
section Fenêtre de tâches, page 238.

Si la fonction de lecture automatique est 
activée, arrêtez la lecture et fermez 
l'application configurée à cet effet.

Pour obtenir des informations à propos de 
l'importation de fichiers à partir d'un 
appareil d'enregistrement portable, 
consultez le manuel Field Recorder 
Workflow Guide.
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Importation de fichiers audio 
monophoniques

Un fichier audio monophonique contient un 
canal mono et des métadonnées appropriées 
provenant d'un enregistrement multicanal 
unique. 

Lorsque vous importez des fichiers audio 
monophoniques enregistrés simultanément, ils 
sont convertis en régions multicanaux et 
affichés ensemble dans la liste de régions. 
Les métadonnées correspondantes sont 
également importées avec les fichiers.

Importation de fichiers audio 
polyphoniques

Un fichier audio polyphonique contient 
plusieurs canaux mono et des métadonnées 
appropriées enregistrées simultanément dans un 
enregistrement multicanal.

Lors de son importation dans Pro Tools, un 
fichier audio polyphonique est divisé en fichiers 
audio monophoniques écrits sur le disque (un 
fichier par canal). Les régions de chaque canal 
apparaissent dans la playlist, et une région 
multicanal apparaît dans la liste des régions avec 
ses canaux en dessous. Les métadonnées 
correspondantes sont également importées avec 
les fichiers. 

Importation de pistes et de 
leurs attributs
Vous pouvez importer dans la session actuelle de 
Pro Tools des pistes entières provenant d'une 
autre session, à l'aide de la commande Import 
Session Data ou en les déposant dans la session. 

Vous pouvez sélectionner des données de 
session spécifiques à importer (par exemple 
l'automation et les acheminements) avec 
Pro Tools HD ou Pro Tools LE avec 
DV Toolkit 2. Vous pouvez aussi importer les 
options principales de playlist, soit en 
remplaçant les options existantes, soit en 
écrasant des éléments sur les pistes existantes.

Par exemple, avec Pro Tools HD ou Pro Tools LE 
avec DV Toolkit 2, vous pouvez décider 
d'importer uniquement les données audio de la 
piste dans votre session Pro Tools actuelle. 
Cela revient à « changer la bobine d'une 
cassette » dans une configuration de studio 
traditionnelle avec un magnétophone à bande 
et une console de mixage. Vous pouvez 
également choisir d'importer tous les paramètres 
de mixage d'une piste sans en importer l'audio, 
ce qui importera une voie qui sera utilisée sur 
une piste dans la session actuelle. En important 
les paramètres de mixage pour toutes les pistes 
d'une session ou d'un modèle de session, vous 
pouvez réutiliser une console Pro Tools sur 
toutes les sessions d'un projet. 
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Pour importer des pistes ou des attributs :

1  Ouvrez ou créez une session.

2  Effectuez l'une des opérations suivantes :

• Choisissez File > Import > Session Data, 
puis sélectionnez la session dont vous 
souhaitez importer les données et cliquez 
sur Open. 

– ou –

• Faites glisser le fichier de session dont vous 
souhaitez importer les pistes ou les attributs 
depuis un navigateur DigiBase, l'Explorateur 
Windows ou le Finder Mac et déposez-le dans 
la zone de playlist des pistes (dans la fenêtre 
Edit de la session actuelle) ou dans la liste des 
pistes.

3  Si les sessions ont des gains de fader (Fader 
Gain) différents, vous serez invité à garder ou 
changer le gain de fader avant que la boîte de 
dialogue Session Data ne s'ouvre.

4  Dans la section Source Tracks, sélectionnez les 
pistes à importer en cliquant sur le menu 
contextuel à droite de chaque nom de piste et en 
choisissant Import As New Track. 

5  Avec Pro Tools HD ou Pro Tools LE avec 
DV Toolkit 2, pour chaque piste que vous 
sélectionnez, vous pouvez décider de l'importer 
en tant que nouvelle piste ou choisir une piste 
de destination dans le menu déroulant 
correspondant. Cliquez sur Match Tracks pour 
faire correspondre automatiquement les pistes 
source aux pistes de destination ayant des noms 
identiques. 

6  Avec Pro Tools HD ou Pro Tools LE avec 
DV Toolkit 2, sélectionnez l'une des options de 
Track Playlist pour choisir le mode 
d'importation des pistes source. 

7  Si cela est nécessaire, sélectionnez les options 
d'importation des fichiers médias depuis les 
menus contextuels Audio Media Options et 
Video Media Options. 

8  Choisissez l'option de correspondance du 
timecode à appliquer aux données importées. 

9  Si les fréquences d'échantillonnage des 
sessions sont différentes, choisissez celle de la 
session source à partir du menu déroulant 
Source Sample Rate. 

10  Sélectionnez l'option Import Tempo/Meter 
Map pour importer les pistes de tempo et de 
mesure à partir de la session source.

11  Sélectionnez l'option Import Key Signature 
Map pour importer des signatures de tonalité à 
partir de la session source.

12  Pour importer des marqueurs et des 
emplacements mémoire à partir de la session 
source, sélectionnez l'option Import 
Marker/Memory Locations.

13  Avec Pro Tools HD ou Pro Tools LE avec 
DV Toolkit 2, sélectionnez l'option Import 
Mix/Edit Groups pour importer tout groupe Mix 
ou Edit de votre choix à partir de la session 
source.

Pour sélectionner plusieurs pistes, cliquez 
sur le menu contextuel d'une piste tout en 
maintenant enfoncée la touche Alt 
(Windows) ou la touche Option (Mac) et 
sélectionnez Import As New Track.

Si le système Pro Tools actuel ne prend pas 
en charge le mixage Surround, les pistes 
Surround n'apparaissent pas dans la liste 
Source Tracks.
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14  Avec Pro Tools HD, sélectionnez l'option 
Import Mic Pre Settings pour importer tout 
paramètre de préamplificateur de micro depuis 
la session source.

15  Cliquez sur OK une fois terminé.

16  Si vous choisissez de copier ou de consolider 
un support, choisissez un emplacement pour 
placer ses fichiers.

Importation de playlists groupées 
depuis d'autres sessions

Vous pouvez importer des pistes qui utilisent 
des playlists groupées depuis une autre session 
Pro Tools ; la fonction de regroupement de 
playlist reste inchangée pour ces pistes 
importées. L'importation à partir de sessions 
antérieures à Pro Tools 6.1 est néanmoins 
soumise à restriction : Après l'importation d'un 
ensemble partiel de playlists groupées, par 
exemple les pistes 1 à 7 d'un groupe de 10 pistes, 
vous ne pourrez plus importer les pistes 8 à 10 
sans les « rejoindre » au groupe de playlists pour 
les pistes 1 à 7.

Boîte de dialogue Import Session 
Data

La boîte de dialogue Import Session Data permet 
d'afficher les propriétés de la session source, de 
sélectionner les pistes à importer et, avec 
Pro Tools HD, de choisir les attributs de ces 
pistes que vous souhaitez importer dans la 
session actuelle.

Les pistes importées sont désactivées si leur 
support source n'est pas disponible ou si la 
session en cours ne contient pas de chemin 
de sortie équivalent.

Boîte de dialogue Import Session Data (Pro Tools HD)

Boîte de dialogue Import Session Data (Pro Tools LE)
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Propriétés de la session source

La boîte de dialogue Import Session Data affiche 
les propriétés de la session source. Ces propriétés 
comprennent le nom de la session source, le 
type de session, l'heure de début de la session, la 
résolution audio et la fréquence 
d'échantillonnage. Pour les sessions Pro Tools 
version 5.1 ou ultérieure, le programme dans 
lequel la session a été créée et le type de fichier 
audio s'affichent également.

Options des médias audio

Refer to Source Media (Where Possible) : 
cette option permet d'éviter de dupliquer les 
fichiers audio, en se référant aux fichiers 
d'origine quand cela est possible. Si les fichiers 
source ne résident pas sur un support 
directement pris en charge (tel qu'un CD ou un 
DVD) ou s'ils nécessitent une conversion de 
résolution ou de fréquence d'échantillonnage, 
ils sont quand même copiés. Lorsque cette 
option est activée, la session actuelle se réfère 
aux fichiers qui ne correspondent pas au format 
de fichier audio de la session actuelle. 

Copy from Source Media : cette option permet 
de copier tout les fichiers audio liés aux pistes 
importées depuis le support source vers un 
nouvel emplacement spécifique et de convertir 
les fichiers au format, à la résolution et à la 
fréquence d'échantillonnage des fichiers audio 
de la session actuelle si nécessaire. Elle est 
pratique si vous importez des pistes à partir 
d'une source telle qu'un CD ou un DVD ou d'un 
stockage partagé et que vous souhaitez placer les 
fichiers audio sur un disque dur différent.

Consolidate from Source Media : cette option 
permet de consolider l'audio lors de sa copie. 
Elle est pratique si vous souhaitez ne copier que 
les régions des fichiers audio utilisés dans les 
pistes source, sans copier l'audio non utilisé. 

Cette option permet de copier et de convertir 
l'audio consolidé au format, à la résolution et à 
la fréquence d'échantillonnage des fichiers 
audio de la session actuelle si nécessaire. 

La sélection de cette option vous permet de 
choisir la taille de la marge (en millisecondes) 
appliquée pour consolider l'audio. Le terme 
marge désigne la partie du fichier audio d'origine 
conservée avant et après chaque région, dans le 
cas où vous devriez modifier après coup les 
nouvelles régions.

Force to Target Session Format : cette option 
permet de copier et de convertir tout fichier 
dont le format, la résolution et la fréquence 
d'échantillonnage ne correspondent pas au 
fichier de la session actuelle. En revanche, les 
fichiers dont le type, la résolution et la 
fréquence d'échantillonnage correspondent au 
fichier de la session actuelle sont directement 
référencés et ne sont pas copiés.

Options des médias vidéo

Vous pouvez choisir de laisser les fichiers médias 
vidéo dans leur emplacement d'origine ou de les 
copier vers un nouvel emplacement. Cette 
option est utile si vous importez des pistes à 
partir d'une source telle qu'un CD ou un DVD ou 
d'un stockage partagé et que vous souhaitez 
placer les fichiers vidéo sur un disque différent.

Options de mappage du timecode

Vous pouvez spécifier l'emplacement des pistes 
importées dans la session actuelle. Les temps 
sont exprimés en timecode pour Pro Tools|HD 
et Pro Tools LE avec DV Toolkit 2, et en 
minutes:secondes pour les autres systèmes 
Pro Tools LE.

Dans la boîte de dialogue Import Session Data, 
les options d'importation disponibles sont les 
suivantes :
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Maintain Absolute Time Code Values : 
cette option place les pistes aux emplacements 
qu'elles occupaient dans la session source. Ainsi, 
si la session actuelle démarre à 00:01:00:00 et 
que la session à partir de laquelle vous importez 
démarre à 10:00:00:00, les premières pistes 
importées démarreront 9 heures et 59 minutes 
après le début de votre session.

Maintain Relative Time Code Values : 
cette option place les pistes en préservant leur 
décalage par rapport au début de la session dans 
la session source. Par exemple, si la session 
source démarre à 01:00:00:00 et contient une 
piste qui démarre à 01:01:00:00 et que la session 
actuelle démarre à 02:00:00:00, la piste est 
placée à 02:01:00:00 dans la session actuelle. 

Map Start Time Code To : cette option « force » 
les pistes à démarrer à un timecode précis, tout 
en respectant leurs positions d'origine. Sur les 
systèmes Pro Tools|HD ou Pro Tools LE avec 
DV Toolkit 2, ces informations sont exprimées 
en hh:mm:ss:ff, alors que sur les systèmes 
Pro Tools LE, elles sont exprimées en hh:mm:ss. 
En d'autres termes, si la session en cours démarre 
à 00:01:00:00 et si la session à partir de laquelle 
vous importez démarre à 10:00:00:00, vous 
pouvez réinitialiser le timecode de démarrage 
sur 00:01:00:00 pour éviter que les fichiers 
soient placés 9 heures et 59 minutes après le 
démarrage de la session.

Options de décalage des pistes

Vous pouvez spécifier un décalage de piste en 
plus de tout décalage résultant des options Time 
Code Mapping. Tout matériel audio importé est 
décalé de la valeur spécifiée dans la timeline de 
la session actuelle. Les entrées peuvent être 
saisies en Minutes:Seconds, Bars|Beats, Samples, 
Time Code ou Feet/Frames. 

Options de fréquence 
d'échantillonnage

Vous pouvez définir les options qui contrôlent 
la façon dont la fréquence d'échantillonnage est 
appliquée aux fichiers audio importés. Si la 
session source et la session actuelle ont la même 
fréquence d'échantillonnage, cette partie de la 
boîte de dialogue est désactivée.

Source Sample Rate : pour les fichiers audio 
créés dans n'importe quelle session, quelle que 
soit la fréquence d'échantillonnage, le processus 
de conversion de la fréquence d'échantillonnage 
peut traiter les fichiers de différentes manières 
pour compenser les modes pull-up et pull-down, 
ainsi que les fréquences d'images NTSC ou PAL. 
Ce paramètre permet également de choisir la 
fréquence d'échantillonnage à partir de laquelle 
lancer la procédure de conversion. 

Destination Sample Rate : la valeur de la 
fréquence d'échantillonnage de destination est 
toujours celle de la session actuelle.

Conversion Quality : cette option permet de 
déterminer la qualité de la procédure de 
conversion de la fréquence d'échantillonnage. 
Pour plus d'informations, reportez-vous à la 
section « Qualité de conversion de fréquence 
d'échantillonnage », page 250.

Zone Source Tracks

Cette zone de la boîte de dialogue répertorie les 
pistes de la session source qui peuvent être 
importées, chacune ayant un menu déroulant 
lui correspondant. 
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Menus déroulants 
Operation/Destination Track

A chaque piste source correspond un menu 
contextuel qui répertorie les options 
d'importation des pistes et, sur les systèmes 
Pro Tools HD et Pro Tools LE avec DV Toolkit 2, 
les pistes de destination possibles dans la session 
actuelle. Les menus déroulants affichent les 
éléments suivants : 

Do Not Import : ni la piste source ni ses attributs 
ne sont importés. 

Import as New Track : la piste source et tous les 
attributs sélectionnés dans le menu Session Data 
to Import sont importés dans une nouvelle 
piste, au sein de la session actuelle. 

Destination Track Names (Pro Tools HD et 
Pro Tools LE avec DV Toolkit 2 uniquement) : 
les noms des pistes de destination possibles dans 
la session actuelle sont répertoriés dans la partie 
inférieure du menu déroulant. Les playlists 
importées et tous les attributs sélectionnés dans 
Data to Import sont placés dans la piste de 
destination sélectionnée. 

Seules les pistes de destination qui 
correspondent au type de piste (audio, 
instrument, MIDI, entrée auxiliaire ou de fader 
principal) et le format de canal (mono, stéréo ou 
tout format multicanal pris en charge) de la piste 
source s'affichent dans le menu déroulant. 

Option Find Matching Tracks

(Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement)

Si vous importez des playlists depuis des pistes 
source ayant le même nom que certaines pistes 
de destination dans la session actuelle (par 
exemple une nouvelle coupure dans une scène), 
cliquez sur l'option Find Matching Tracks pour 
faire correspondre automatiquement les noms 

de pistes. Les pistes doivent avoir le même nom, 
le même format de canal et être du même type 
pour pouvoir être automatiquement mises en 
correspondance. 

Menu Session Data to Import

(Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement)

Le menu Session Data to Import vous permet de 
sélectionner les attributs des pistes sélectionnées 
que vous souhaitez importer dans la session 
actuelle. 

Les attributs sélectionnés sont appliqués à toutes 
les pistes que vous avez choisies d'importer dans 
la session actuelle.

Remplacement d'attributs de pistes

Lorsque vous importez un attribut de la piste 
source dans une piste existante de la session 
actuelle, celui-ci écrase l'attribut correspondant 
dans la piste de destination. Si vous choisissez de 
ne pas importer d'attribut de la piste source, 
l'attribut correspondant dans la piste de 
destination est conservé. 

Options du menu Session Data de la boîte de dialogue 
Import Session Data
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Remplacement des noms des chemins 
de pistes

Lorsque vous importez une entrée, une sortie, 
une sortie de départ ou des affectations d'inserts 
matériels d'une piste, les noms de chemin et 
configurations d'E/S personnalisés de la session 
source ne sont pas importés. Vous pouvez 
importer des noms de chemin et des 
configurations d'E/S en important les 
paramètres I/O Setup. Pour plus d'informations, 
reportez-vous à la section Fichiers des 
paramètres d'E/S, page 69. 

Sélection d'attributs de pistes à importer

Vous pouvez sélectionner les options All, None 
ou toute autre combinaison parmi les attributs 
répertoriés. Les attributs suivants sont 
disponibles pour l'importation :

All : importe toutes les playlists de la piste 
source, selon le paramètres Track Playlist Option 
et tous les attributs de la liste Session Data to 
Import.

None : importe uniquement la playlist 
principale de la piste source (selon le paramètre 
Track Playlist Option) et aucun autre attribut de 
la piste source. 

Alternate Playlists : importe toutes les playlists 
secondaires de la piste source. Les playlists 
secondaires s'affichent dans le menu déroulant 
de la playlist de la piste de destination. 

Regions and Media : importe tous les fichiers et 
les régions audio de la piste source et les place 
dans la liste des régions. 

Volume Automation and Setting : importe le 
paramètre de fader du volume de la piste source 
et toute donnée d'automation dans la playlist 
Volume Automation de la piste. Le paramètre de 
fader du volume et toutes les données Volume 
automation de la piste de destination sont 
remplacées par les nouvelles données. 

Pan Automation and Setting : importe le 
paramètre Pan Slider de la piste source et toute 
donnée d'automation dans la playlist Pan 
Automation de la piste. Le paramètre Pan Slider 
et toutes les données Pan automation de la piste 
de destination sont remplacées avec les 
nouvelles données.

Mute Automation and Setting : importe le 
paramètre Mute de la piste source et toute 
donnée d'automation dans la playlist Mute 
Automation de la piste. Le paramètre Mute et 
toutes les données Mute automation de la piste 
de destination sont remplacées avec les 
nouvelles données.

Main Output Assignments : importe les 
affectations de sortie de la piste source, y 
compris les affectations de sorties multiples qui 
viennent remplacer les affectations de sorties de 
canal dans la piste de destination.

Send Output Assignments : importe les 
affectations de sorties de départs de la piste 
source qui viennent remplacer les affectations 
de sorties de départs dans la piste de destination.

Plug-In Assignments : importe les affectations de 
plug-in de la piste source. Tout plug-in de la 
piste de destination est supprimé et les 
paramètres qui y sont associés ainsi que 
l'automation sont perdus. 

Si la piste source utilise un plug-in qui n'est pas 
disponible dans le système de destination, il 
apparaît dans la piste de destination et est 
désactivé. 
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Plug-In Settings and Automation : lorsque les 
affectations de plug-in de la piste source sont 
importées, cette option importe les paramètres 
de plug-in de la piste et toute donnée 
d'automation associée aux plug-in. Si aucune 
affectation de plug-in n'est importée, cette 
option n'a aucun effet.

Hardware Insert Assignments-: importe les 
affectations d'inserts matériels de la piste source. 
Ces affectations d'insert viennent remplacer les 
affectations d'inserts dans la piste de 
destination.

Voice Assignments : importe l'assignation des 
voix de la piste source depuis la session source 
qui remplace les assignations de voix dans la 
piste de destination. 

Input Assignments : importe les affectations 
d'entrées de canal de la piste source qui 
remplacent les assignations d'entrée dans la 
piste de destination. 

Side-Chain Assignments : lorsque les affectations 
de plug-in de la piste source sont importées, 
cette option importe toutes les affectations par 
déclenchement externe associées aux plug-in. Si 
aucune affectation de plug-in n'est importée, 
cette option n'a aucun effet.

I/O Labels (Path Names) : importe les noms de 
chemins de la piste source.

Track Active State : importe l'état actif/inactif 
de la piste source depuis la session source. 

Track Comments : importe les commentaires 
sur la piste associés à la piste source. Ces 
commentaires viennent remplacer ceux de la 
piste de destination. 

Record Safe/solo Safe Settings : importe les 
paramètres de protection en enregistrement et 
de protection contre le solo de la piste source 
depuis la session source. Tous les paramètres de 
protection en enregistrement et de protection 
contre le solo dans la piste de destination sont 
remplacés. 

Track View Settings : importe la vue de hauteur 
d'une piste et d'une playlist de la piste source 
depuis la session source. 

Mix/Edit Groups : importe les groupes de pistes à 
partir de la session source.

Options d'importation

Import Tempo/Meter Map : Importe les tables 
des mesures et des tempos, telles qu'elles 
apparaissent dans les règles du chef d'orchestre 
(Tempo, Métrique), depuis la session source. 
Tout événement métrique ou de tempo de la 
session de destination est remplacé. 

Import Key Signature Map : importe toutes les 
signatures de tonalité (si présentes) dans 
Pro Tools avec les données de session importées. 
Ces signatures viennent remplacer celles de la 
session de destination.

Import Marker/Memory Locations : importe les 
marqueurs et les emplacements mémoire tels 
qu'ils apparaissent dans la règle des marqueurs, à 
partir de la session source. Ceux qui figurent 
dans la session de destination sont conservés. 
Les numéros disponibles suivants sont attribués 
aux marqueurs et aux emplacements mémoire 
importés.

Import Window Configurations : importe les 
configurations de fenêtres à partir de la session 
source.
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Importation des paramètres PRE

(Pro Tools HD uniquement)

importe tous les paramètres de préamplificateur 
de micro (Mic Pre ou PRE) Pro Tools à partir de la 
session source. Tous les paramètres PRE dans la 
session de destination sont remplacés. 

Options de playlist

(Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement)

Vous pouvez sélectionner l'une des options 
suivantes pour contrôler la façon dont la playlist 
principale est importée sur la piste de 
destination dans la session actuelle. 

Import Main Playlists — Replacing Destination 
Main Playlists : importe la playlist principale 
depuis la piste source. Lorsque vous importez la 
playlist dans une piste existante, la playlist 
principale dans la piste de destination est 
supprimée et remplacée par la playlist importée. 

! Si vous sélectionnez cette option et importez 
tous les attributs de la piste source, cela revient à 
importer la piste entière. 

! Si vous sélectionnez cette option et que vous 
n'importez aucun attribut de la piste source, les 
playlists audio sont remplacées tant que vous 
conservez les paramètres de mixage actuels.

Import Main Playlists—Overlaying New with 
Existing, Trimming Existing Regions : importe la 
playlist principale depuis la piste source. 
Lorsque vous importez la playlist dans une piste 
existante, toutes les données de playlist 
existante qui recouvrent les données importées 
depuis la piste source sont rognées et remplacées 
par les données importées. Toutes les données 
de la playlist dans la piste de destination qui ne 
recouvrent pas d'autres données sont conservées 
dans la piste de destination. 

Do Not Import Main Playlists—Leaving 
Destination Playlists Intact : n'importe pas la 
playlist principale depuis la piste source. Aucune 
donnée audio n'est importée, seuls les attributs 
sélectionnés dans la liste Session Data to Import 
sont importés dans les pistes sélectionnées. 
Lorsque cette option est sélectionnée, 
l'importation de la totalité des entrées, sorties, 
départs, inserts, et attributs de plug-in de la piste 
source équivaut à importer une voie.

Importation d'éléments avec 
la fonction glisser-déposer
La figure 14 présente certaines options 
disponibles pour l'importation de média à l'aide 
de DigiBase. 

Importation de fichiers média

L'importation ne convertit ou ne copie pas 
toujours les fichiers audio. Pour en savoir 
plus, reportez-vous aux sections File 
Conversion on Import, page 266 et Copie 
au cours de l'importation, page 267.

L'importation via la méthode 
glisser-déposer ne place pas nécessairement 
la fenêtre Edit au premier plan. Par 
exemple, lorsque vous faites glisser un 
fichier depuis un navigateur vers une piste, 
le navigateur source reste en premier plan 
(mais pas la fenêtre Edit). Vérifiez toujours 
la fenêtre active, de premier plan ou de 
navigateur avant de continuer.
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Pour importer des éléments dans la liste des 
régions :

1  Sélectionnez les fichiers audio, vidéo, MIDI, 
REX, ACID ou de groupe de régions dans le 
navigateur. 

2  Faites glisser l'élément sélectionné, puis 
déposez-le dans la liste des régions. 

Pour importer des éléments sur une piste 
existante :

1  Sélectionnez un élément dans un navigateur. 

2  Faites glisser le fichier sélectionné, puis 
déposez-le à l'emplacement souhaité sur une 
piste compatible existante. Le fichier est importé 
et placé à l'endroit où il a été déposé. 

Pour importer des éléments en tant que nouvelles 
pistes :

1  Sélectionnez des éléments dans un navigateur. 

2  Effectuez l'une des opérations suivantes :

• Maintenez la touche Maj enfoncée et faites 
glisser les vers n'importe quel emplacement 
de la fenêtre Edit. 

• Déposez les éléments dans la liste des 
pistes.

• Déposez les éléments dans un espace vide 
de la fenêtre Edit, en dessous ou au-dessus 
des pistes. 

Pour importer et déplacer de l'audio dans 
une piste :

1  Activez le mode Spot. 

2  Choisissez un fichier audio dans un 
navigateur DigiBase. 

Figure 14.  Importation depuis les navigateurs par opération de glisser-déposer 

Volumes

Catalogues

Espace de travail

Déposer des éléments dans la 
liste des régions à importer

Déposer des éléments ou des fichiers de session
dans des pistes existantes ou dans la liste de
pistes pour les ajouter en tant que nouvelles pistes
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3  Faites glisser les éléments et déposez-les dans 
une playlist de la timeline Pro Tools. La boîte de 
dialogue Spot apparaît.

4  Saisissez l'emplacement du timecode 
approprié (l'endroit où vous souhaitez placer 
l'élément importé). 

Pour importer et déplacer un fichier audio selon sa 
forme d'onde : 

1  Tout en maintenant enfoncée la touche Ctrl 
(Windows) ou Pomme (Mac), cliquez sur 
l'affichage de la forme d'onde d'un élément au 
point de référence approximatif sur lequel vous 
souhaitez placer l'élément dans une piste. 

2  Tout en maintenant enfoncée la touche Ctrl 
(Windows) ou Pomme (Mac), faites glisser la 
forme d'onde vers une piste audio existante (le 
fichier audio source et la piste audio de 
destination doivent posséder le même nombre 
de canaux).

Placement au début et à la fin

Pour importer un élément et le placer au début :

" Tout en cliquant sur Démarrer (Windows) ou 
Ctrl (Mac), faites glisser un élément, puis 
déposez-le sur une piste. 

Pour placer l'élément au début et le copier dans le 
dossier Audio files de la session :

" Maintenez les touches Alt+Démarrer 
(Windows) ou Pomme+Ctrl (Mac) enfoncées et 
faites glisser un élément vers une piste. 

Pour placer l'élément à la fin :

" Tout en maintenant les touches 
Ctrl+Démarrer (Windows) ou Pomme+Ctrl 
(Mac) enfoncées, faites glisser un élément, puis 
déposez-le sur une piste. 

Pour placer l'élément à la fin et le copier dans le 
dossier Audio files de la session : 

" Tout en maintenant les touches 
Ctrl+Alt+Démarrer (Windows) ou 
Pomme+Option+Ctrl (Mac) enfoncées, faites 
glisser un élément, puis déposez-le sur une piste. 

Importation de séquences AAF 
et OMF
(DigiTranslator 2.0 requis)

Pour importer des séquences AAF et OMF à 
partir des navigateurs, suivez la procédure ci-
dessous.

Pour importer des séquences dans une piste 
existante :

1  Sélectionnez une séquence AAF ou OMF dans 
un navigateur. 

2  Faites glisser l'élément et déposez-le à 
l'emplacement souhaité de la session en cours. 
Le fichier est importé et placé à l'endroit où il a 
été déposé. Si la séquence contient de la vidéo, la 
piste vidéo est également importée.

Le mode Auto Spot n'est pas pris en charge 
lors de l'importation depuis des navigateurs 
DigiBase. Importez tout d'abord l'élément 
dans la liste des régions, puis déplacez-le 
depuis cet endroit pour utiliser le mode Auto 
Spot. Reportez-vous au Guide de référence 
Pro Tools pour de plus amples 
informations.
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Importation de sessions et de 
pistes

Vous pouvez déposer les fichiers de session dans 
la session en cours pour importer (et placer) des 
fichiers audio, vidéo, MIDI, REX, ACID et de 
groupe de régions, ainsi que des pistes et des 
données de session. 

• Lorsque vous déposez une session dans la liste 
des régions, toutes les régions de cette session 
sont importées (mais pas les pistes). 

• Lorsque vous déposez une session dans une 
piste de Pro Tools LE, vous pouvez importer 
des pistes.

• Sur les systèmes Pro Tools HD, lorsque vous 
déposez une session dans une playlist, la boîte 
de dialogue Import Session Data s'ouvre. 
Vous pouvez y sélectionner des pistes et des 
attributs à importer. Les données de la session 
importée commencent à l'endroit où vous 
avez déposé la session dans la timeline.

Pour importer des pistes et autres données de 
session par une opération de glisser-déposer :

1  Ouvrez le navigateur de votre choix. 

2  Faites glisser un fichier de session Pro Tools ou 
une séquence AAF ou OMF (nécessite 
DigiTranslator 2.0), puis déposez-le (ou la) dans 
la session en cours, en procédant de la façon 
suivante : 

• Faites glisser cet élément, puis déposez-le 
sur une piste pour recouvrir et écraser les 
données sur les pistes cible. Maintenez la 
touche Maj enfoncée tout en effectuant 
une opération de glisser-déposer si vous 
souhaitez remplacer les playlists de pistes 
en cours par celles en cours d’importation 
(la touche Maj pré-configure les paramètres 
de la boîte de dialogue Import Session 
Data).

• Faites glisser les éléments, puis déposez-les 
dans un espace vide (autre qu’une piste) de 
la timeline de la fenêtre Edit pour créer des 
pistes pour les données de session 
importées. 

• Configurez la boîte de dialogue Import 
Session Data comme souhaité. Reportez-
vous au Guide de référence Pro Tools pour en 
savoir plus sur l'utilisation de la boîte 
Import Session Data. 

File Conversion on Import

Par défaut, les fichiers ajoutés à la session par 
opération de glisser-déposer font référence aux 
médias originaux, à moins qu'il ne résident pas 
sur un volume Performance valide ou dans l'un 
des cas suivants :

• La fréquence d'échantillonnage est différente.

• La résolution est différente.

• Le fichier est compressé.

• Le fichier est un fichier multicanaux 
entrelacés.

• Le fichier est au format WAV, mais l'option de 
Pro Tools Preference Convert all 
imported.WAV files to AES31/Broadcast Wave 
est activée.

La qualité de conversion de la fréquence 
d'échantillonnage est fonction des préférences 
Pro Tools définies. 

Si le fichier réside sur un volume Performance 
approprié et que la résolution est identique, la 
conversion de la fréquence d'échantillonnage 
peut être supprimée (notamment pour accélérer 
l'importation pour l'écoute d'état provisoire ou 
lorsque la vitesse de lecture n'est pas essentielle). 
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Copie au cours de l'importation

Si aucune conversion n'est nécessaire et que les 
fichiers résident sur un volume Performance 
approprié, Pro Tools référence la version 
originale du média. Vous pouvez également 
copier des médias lors de l'importation en 
utilisant les commandes de touches ou en 
activant l'option Automatically Copy Files on 
Import. Les fichiers sont créés dans le dossier 
Audio Files de la session. 

Pour copier manuellement lors de 
l'importation :

" Faites glisser les fichiers en maintenant 
enfoncée la touche Option (Mac) ou Alt 
(Windows). Une copie des fichiers est créée dans 
le dossier Audio Files de la session. 

Lors de l'importation de sessions ou de pistes, 
vous devez spécifier dans la boîte de dialogue 
Import Session Data si vous souhaitez référencer 
ou copier le média source.

Pour copier manuellement des fichiers lors de 
l'importation :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operations.

2  Sélectionnez Automatically Copy Files on 
Import. 

3  Cliquez sur OK pour refermer la boîte de 
dialogue Preferences.

Utilisation de l'option Undo after 
Importing 

L'option Undo after importing supprime tout 
fichier affecté de la timeline. Cependant, les 
éléments importés sont conservés dans la 
session (dans le navigateur de projet et la liste 
des régions) et sont hors ligne. Si vous ne 
supprimez pas manuellement les fichiers de la 
session, Pro Tools les considère comme 
manquants lors de la prochaine ouverture de 
session. 

Exportation de données audio
Pro Tools prend en charge l'exportation des 
régions sous forme de fichiers audio, 
l'exportation des fichiers de données audio 
droite et gauche sous forme de fichier stéréo 
entrelacés et l'exportation des informations 
propres aux régions.

Vous pouvez également exporter des données 
audio à partir de Pro Tools en prémixant ou en 
consolidant des pistes audio. Pour plus 
d'informations, reportez-vous aux sections 
Commande de consolidation, page 563 et 
Bounce to Disk :, page 858.

Exportation d'une région sous 
forme de nouveau fichier audio

Vous pouvez exporter des régions sous forme de 
fichiers audio, grâce à la commande Export 
Regions as Files. Cette commande est utile si 
vous envisagez d'utiliser une région dans 
d'autres sessions (ou dans d'autres applications 
audio) sans utiliser son fichier source parent. 

Cette commande permet également de convertir 
des régions dans un format audio, une 
fréquence d'échantillonnage ou une résolution 
différents.
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Pour exporter des régions sous forme de nouveaux 
fichiers audio :

1  Dans la liste des régions, sélectionnez les 
régions que vous voulez exporter.

2  Dans le menu déroulant de la liste des régions, 
choisissez Export Regions as Files. La boîte de 
dialogue Export Selected s'affiche.

3  Dans la boîte de dialogue Export Selected, 
définissez le type de fichier, le format, la 
résolution numérique et la fréquence 
d'échantillonnage. Par ailleurs, indiquez la 
qualité de la conversion et choisissez le 
répertoire de destination.

Lorsque vous exportez des régions dans une 
résolution inférieure, la fonction de dithering 
avec ou sans mise en forme du bruit (Noise 
Shaping) est appliquée comme indiqué dans le 
tableau 13.

Le paramètre Dither utilisé lors d'une 
conversion est le plug-in Dither de Digidesign 
(avec ou sans le paramètre Noise Shaping 
activé), comme indiqué au tableau 13.

4  Sélectionnez une option de résolution des 
noms de fichier en double par Pro Tools. 

Boîte de dialogue Export Selected

Tableau 13. Options Dither et Noise Shaping avec la 
boîte de dialogue Export Selected

Résolution Dither
Noise 
Shaping

24 bits vers 
24 bits

Non Non

16 bits vers 
24 bits

Non Non

24 bits vers 
16 bits

Oui Oui

16 bits vers 
16 bits

Non Non

24 bits vers 8 bits Oui Non

16 bits vers 8 bits Oui Non

Pour en savoir plus sur le dithering, 
reportez-vous à Dithering, page 761.
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Prompting for Each Duplicate : cette option vous 
invite à entrer un nom pour tout fichier portant 
le même nom qu'un fichier de votre répertoire 
de destination. 

Auto Renaming : cette option modifie 
automatiquement le nom de tout fichier 
dupliqué en lui ajoutant un nombre à la fin (tel 
que le fichier_01). 

Replacing with New Files : les fichiers ayant le 
même nom sont remplacés par les nouveaux 
fichiers.

5  Une fois la configuration des options 
d'exportation terminée, cliquez sur Export pour 
exporter les nouveaux fichiers audio.

Exportation de fichiers stéréo ou 
multicanaux entrelacés

La commande Export Regions as Files permet 
d'exporter des régions audio sous forme de 
fichiers stéréo ou multicanaux entrelacés, 
utilisables dans d'autres applications. Pro Tools 
n'est pas capable d'utiliser directement des 
fichiers entrelacés dans la timeline. Il faut 
d'abord les convertir en fichiers multimono. 
Par exemple, dans le cas d'un fichier stéréo, les 
régions sélectionnées doivent posséder des 
noms identiques, munis des suffixes « .L » et 
« .R » (par exemple voix_01.L et voix_01.R). 
Ces régions apparaissent sous forme d'une 
région stéréo dans la liste des régions.

Pro Tools HD permet également de prémixer des 
fichiers multicanaux entrelacés pour chaque 
type de fichier reconnu. 

Pour exporter des régions sous forme de fichier 
stéréo ou multicanal entrelacé :

1  Sélectionnez la région audio stéréo ou 
multicanal dans la liste des régions ou dans la 
playlist de la piste. Si les régions apparaissent sur 
des pistes mono de la session, sélectionnez les 
deux régions mono.

2  Dans le menu déroulant de la liste des régions, 
choisissez Export Regions as Files.

3  Dans la boîte de dialogue Export Selected, 
sélectionnez « Stereo Interleaved » dans le menu 
déroulant Format. Dans le cas de régions 
multicanaux, l'option Stereo Interleaved produit 
un fichier multicanal entrelacé.

4  Une fois la configuration de toutes les options 
d'exportation terminée, cliquez sur Export pour 
exporter le nouveau fichier stéréo entrelacé.

Exportation des définitions des 
régions

Pro Tools enregistre les définitions des régions 
des fichiers audio au sein de chaque session. Si 
vous souhaitez utiliser les régions d'un fichier 
audio dans une autre session ou avec une autre 
application qui les prend en charge, vous 
pouvez exporter les informations des régions. 

La commande Export Region Definitions 
n'exporte pas les régions sous forme de fichiers 
audio (contrairement à la commande Export 
Regions as Files). En revanche, elle mémorise des 
pointeurs vers les régions au sein du fichier 
source parent.

Si vous avez l'intention de transférer des 
données de session Pro Tools vers une autre 
session, vous devez exporter les définitions 
des régions pour les sessions contenant 
plusieurs prises créées avec Loop Record.
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Pour exporter les définitions des régions d'un 
fichier audio :

1  Dans la liste des régions, sélectionnez les 
régions ou les groupes de régions pour lesquels 
vous voulez exporter les définitions. Il n'est pas 
nécessaire de sélectionner la région audio du 
fichier parent.

2  Choisissez Export Region Definitions dans le 
menu déroulant de la liste des régions.

3  Cliquez sur Export.

Exportation de pistes 
Pro Tools en tant que 
séquences AAF ou OMFI
Lorsque l'option DigiTranslator Integrated 
(DigiTranslator 2.0 ou ultérieur) est 
sélectionnée, Pro Tools vous permet d'exporter 
des pistes individuelles au format AAF ou OMFI. 
Utilisez la commande Export Selected Tracks as 
AAF/OMF.

Exportation de sessions en 
tant que texte
(Pro Tools HD uniquement)

La commande Export Session Info as Text 
permet de créer un fichier texte contenant des 
informations complètes concernant votre 
session. 

Ce fichier texte contient la liste des fichiers 
audio, des régions audio, l'EDL de la piste audio, 
des informations détaillées de marquage 
temporel et des informations concernant les 
crossfades.

Les listes EDL des pistes sont exportées sous 
forme de texte délimité par des tabulations, 
c'est-à-dire contenant des tabulations entre 
chaque en-tête de colonne et des tabulations 
entre chaque paramètre d'événement. Vous 
pouvez utiliser ces données dans un programme 
permettant de lire des listes EDL ou formater ces 
données EDL sous forme de tableaux en utilisant 
un traitement de texte ou un tableur.

Pro Tools avec DigiTranslator ne prend pas 
en charge les fichiers AAF avec des médias 
intégrés.

Pour plus d'informations sur l'installation, 
l'utilisation ou la désinstallation de 
DigiTranslator avec Pro Tools, reportez-
vous au guide DigiTranslator. 
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Options de la boîte de dialogue 
Export Session Text

Include File List/Region List

Cette option permet d'exporter une liste des 
fichiers audio et des régions de la session. La liste 
File répertorie tous les fichiers audio et les fades 
de la session, ainsi que leur emplacement sur le 
disque dur. La liste des régions affiche toutes les 
régions audio de la session, ainsi que le fichier 
audio source de chaque région.

Include Track EDLs (Playlists)

Cette option permet d'exporter les listes EDL des 
pistes (playlists). Ces listes peuvent servir à 
vérifier avec précision le placement des régions 
et des modifications ou être utilisées par un 
programme de conformation pour des 
applications de post-production. Dans des 
circonstances extrêmes, l'EDL peut permettre de 
recréer une session entière.

Lors de l'exportation des listes EDL des pistes, les 
options suivantes sont disponibles :

Show Subframes : cette option d'affichage des 
sous-trames permet d'exporter des informations 
temporelles de subframes (subdivisions 
d'images) avec les listes EDL des pistes, si elles 
sont utilisées dans votre session.

Include User Timestamps : vous pouvez inclure 
des marquages temporels définis par l'utilisateur 
avec les listes EDL des pistes. Ces marquages 
temporels indiquent un emplacement défini par 
l'utilisateur de la session pour la région ou 
l'emplacement d'origine de la région lors de son 
enregistrement.

Fade Handling : pour les listes EDL des pistes, 
vous pouvez choisir d'afficher les crossfades 
(Show Crossfades), de ne pas les afficher (Don't 
Show Crossfades) ou de combiner les régions en 
crossfade (Combine Crossfaded Regions). 
Lorsque des régions sont combinées, leurs durée 
et emplacement sont calculés jusqu'au centre du 
crossfade (pour la première région) et à partir du 
centre du crossfade (pour la région qui suit).

Time Format : vous pouvez sélectionner le 
format temporel approprié sur lequel sont 
basées les informations des listes EDL. En post-
production, par exemple, vous choisirez un 
timecode SMPTE, mais en musique où la 
référence est généralement la grille rythmique, 
vous préférerez sans doute un format temporel 
en mesures et temps (Bars & Beats). 

Format de fichier

Vous pouvez choisir d'exporter dans l'un des 
formats de texte proposés. Ils incluent des 
formats de texte standard, ainsi que les formats 
Microsoft Word et Excel. 

Boîte de dialogue Export Session Text

Les listes EDL des pistes MIDI ne sont pas 
exportées.
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Boîte de dialogue Export Session 
Text

Informations sur la session

Le fichier texte de la session débute avec des 
informations de base relatives à la session. Ces 
informations incluent le nom de la session, la 
fréquence d'échantillonnage, la résolution, le 
format temporel, le nombre de pistes audio, de 
régions audio et de fichiers audio de la session, 
comme dans l'exemple ci-dessous.

Liste des fichiers et liste des régions

Ensuite, si vous choisissez de les inclure, 
apparaissent les listes des fichiers audio et des 
régions.

Liste EDL de la piste

L'élément final, s'il est exporté, est la liste EDL de 
la piste. Une liste EDL indique le nom de la piste, 
et tous les points de montage, avec le numéro de 
l'événement, le nom de la région, les heures de 
début et de fin de la région, ainsi que la durée de 
la région. Le marquage temporel de la région est 
également exporté, si vous choisissez cette 
option. Les subframes sont affichées dans 
chaque champ de temps si vous sélectionnez 
cette option.

Pour exporter une session sous forme de texte :

1  Choisissez File > Export > Session Info as Text.

2  Choisissez d'inclure ou non la liste File, 
Region et les listes EDL de la piste.

3  Si vous choisissez d'inclure les listes EDL de la 
piste, sélectionnez si vous voulez faire apparaître 
les subframes et s'il faut inclure des marquages 
temporels définis par l'utilisateur. Sélectionnez 
également une option de gestion de crossfade.

4  Si vous choisissez d'inclure les listes EDL de la 
piste, sélectionnez le format temporel du texte 
de la session exportée dans le menu déroulant.

5  Sélectionnez dans le menu déroulant le format 
de fichier du texte exporté.

6  Lorsque vous avez défini ces options, cliquez 
sur OK. 

7  Sélectionnez un emplacement et entrez un 
nom de fichier pour le fichier texte exporté. 
Dans Windows, Pro Tools ajoute la bonne 
extension de 3 lettres, tandis que sur le Mac, 
c'est l'extension « .txt » qui est ajoutée.

Exemple d'informations d'une session

NOM DE LA SESSION : Ripleys II-092700

FREQUENCE 
D'ECHANTILLONNAGE :

48000.000000

RESOLUTION : 24 bits

FORMAT TEMPOREL : 30 image

NOMBRE DE PISTES 
AUDIO :

19

NOMBRE DE REGIONS 
AUDIO :

203

NOMBRE DE FICHIERS 
AUDIO :

54
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Envoi de fichiers via 
DigiDelivery
DigiDelivery® de Digidesign est un système de 
transfert efficace et fiable de fichiers média 
numériques sur Internet. La commande Send 
via DigiDelivery vous permet d'envoyer une 
session Pro Tools et tous les fichiers associés au 
moyen de DigiDelivery, directement à partir de 
Pro Tools.

Tout comme la commande Save Copy In, 
DigiDelivery copie dans un seul dossier de 
destination tous les fichiers de même type, 
indifféremment de leur emplacement.

Toute personne est libre d'envoyer et de recevoir 
des fichiers à partir d'un système DigiDelivery, 
même si elle ne possède pas de serveur réseau 
DigiDelivery.

! Pour effectuer un transfert, l'expéditeur doit 
disposer d'une connexion Internet, d'un compte 
sur un serveur réseau DigiDelivery et de 
l'application client DigiDelivery. 

! Pour recevoir les fichiers, les destinataires ont 
besoin uniquement d'une connexion Internet et 
de l'application client DigiDelivery. Il n'est pas 
nécessaire de disposer d'un compte sur le serveur 
réseau.

Pour envoyer une session à partir de Pro Tools à 
l'aide de DigiDelivery :

1  Choisissez File > Send via DigiDelivery.

2  Effectuez l'une des opérations suivantes :

• Si le client DigiDelivery n'est pas installé 
sur votre système, Pro Tools lance votre 
navigateur Web et se connecte au site 
DigiDelivery pour que vous puissiez 
télécharger le client DigiDelivery actuel.

– ou –

• Si le client DigiDelivery est installé sur 
votre système, la boîte de dialogue Send to 
DigiDelivery s'affiche.

3  Sélectionnez les fichiers à inclure dans la boîte 
de dialogue Send to DigiDelivery.

Voici les différents choix possibles :

• Fichiers audio

• Fichiers de fondu

• Fichiers vidéo

• Fichiers de paramètres de plug-in

• Fichier de timeline uniquement (fichiers 
référencés dans la timeline de session 
actuelle)

4  Cliquez sur OK. Cela a pour effet de lancer le 
client DigiDelivery et d'ouvrir l'assistant 
DigiDelivery Send (Page 1). C'est à partir de cette 
page que vous donnez un nom à votre livraison 
et ajoutez ou retirez des fichiers.

5  Complétez les autres pages de l'assistant 
DigiDelivery Send et envoyez le fichier, en 
suivant les instructions fournies avec le logiciel 
client DigiDelivery.

Pour plus d'informations, rendez-vous sur 
le site Web de DigiDelivery 
(www.digidesign.com/digidelivery).

Boîte de dialogue Include in Delivery
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Importation de fichiers MIDI
Vous pouvez importer des fichiers MIDI 
standard (SMF) dans vos sessions Pro Tools.

Pro Tools propose plusieurs méthodes pour 
importer des fichiers MIDI dans une session 
ouverte.

• Importation de fichiers MIDI à l'aide des 
commandes de menu Pro Tools, page 274

• Importation de fichiers MIDI par 
glisser-déposer, page 275

Pro Tools n'importe pas les fichiers de séquence 
externes. Pour utiliser des séquences provenant 
d'autres applications MIDI dans une session 
Pro Tools, vous devrez d'abord les enregistrer 
sous forme de fichiers MIDI standard (SMF). 
Consultez la documentation du logiciel de 
séquence pour plus de détails sur 
l'enregistrement de fichiers MIDI standard.

Il existe deux types de fichiers MIDI standard, 
tous deux pris en charge par Pro Tools :

! Les fichiers MIDI de type 0 enregistrent les 
données de tous les canaux MIDI sur une seule 
piste. Lors de l'importation de ces fichiers, 
Pro Tools trie et sépare les données par canal et 
place les informations de chaque piste dans des 
régions et des pistes distinctes.

! Les fichiers MIDI de type 1, parfois nommés 
fichiers MIDI multipistes, comportent plusieurs 
pistes de données MIDI. Lorsque vous importez 
ces fichiers, les données de chaque piste sont 
placées dans leur propre piste MIDI de la session 
Pro Tools.

Importation de fichiers MIDI à 
l'aide des commandes de menu 
Pro Tools

Pro Tools offre plusieurs commandes de menu 
pour importer des fichiers MIDI.

Pour importer des fichiers MIDI dans une session 
(depuis le menu File de Pro Tools) :

1  Choisissez File > Import > MIDI et 
sélectionnez le fichier MIDI que vous souhaitez 
importer.

2  Dans la boîte de dialogue MIDI Import 
Options, sélectionnez la destination du fichier 
importé.

New Track : crée une piste de destination du 
fichier importé.

Region List : importe le fichier dans la liste des 
régions, à partir de laquelle il devient accessible.

3  Si vous créez une piste, choisissez 
l'emplacement pour le fichier importé dans la 
piste :

Session Start : place le fichier ou la région au 
début de la session. 

Boîte de dialogue MIDI Import Options
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Song Start : aligne le début du fichier avec le 
début du morceau. 

Selection : aligne le début du fichier avec le 
curseur d'édition ou le début d'une sélection 
dans la timeline.

Spot : affiche la boîte de dialogue Spot qui 
permet de placer le fichier dans un 
emplacement spécifique basé sur toute échelle 
temporelle.

4  Choisissez l'une des options suivantes :

Import Tempo Map From MIDI File : remplace 
toute table des tempos et des mesures existante 
par les informations de tempo et de mesure 
provenant du fichier MIDI. 

Importation des signatures de tonalité à partir 
d'un fichier MIDI : écrase toute signature 
existante avec les informations de signature de 
tonalité provenant du fichier MIDI. 

Remove Existing Instrument Tracks : supprime 
toute piste d'instrument existante. La sélection 
de cette option n'aucun effet sur les pistes MIDI 
actuelles. Toutes les régions MIDI existantes 
seront conservées dans la liste des régions.

Remove Existing MIDI Tracks : supprime toute 
piste MIDI existante. La sélection de cette 
option n'a aucun effet sur les pistes d'instrument 
actuelles. Toutes les régions MIDI existantes 
seront conservées dans le chutier des régions.

Remove Existing MIDI Regions : supprime les 
régions MIDI existantes (c'est-à-dire toutes les 
données figurant sur l'ensemble des pistes MIDI 
et d'instrument), mais laisse les pistes MIDI et 
d'instrument en place. 

5  Cliquez sur OK.

Le fichier MIDI sera importé conformément aux 
paramètres choisis dans la boîte de dialogue 
Import MIDI Settings.

6  Dans la fenêtre Mix, cliquez sur le sélecteur de 
sortie MIDI pour chaque nouvelle piste et 
affectez un instrument MIDI et un canal.

Importation de fichiers MIDI par 
glisser-déposer

Vous pouvez faire glisser des fichiers MIDI à 
partir d'un navigateur DigiBase, de l'Explorateur 
Windows ou du Finder Mac et les déposer dans 
la timeline, une piste, la liste des pistes ou la liste 
des régions.

Pour importer des données MIDI dans la liste des 
régions :

1  Sélectionnez des fichiers MIDI dans un 
navigateur DigiBase, dans l'Explorateur 
Windows ou dans le Finder Mac. 

2  Déposez les fichiers dans la liste des régions de 
la session actuelle. 

Pour importer des données MIDI sur une piste 
existante :

1  Sélectionnez des fichiers MIDI dans un 
navigateur DigiBase, dans l'Explorateur 
Windows ou dans le Finder Mac. 

2  Déposez les fichiers dans une piste existante 
de la fenêtre Edit de la session actuelle. 

Si le fichier MIDI standard contient des 
marqueurs, ceux-ci ne sont importés que si 
la session en cours ne contient aucun 
marqueur.
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Pour importer des données MIDI dans de nouvelles 
pistes :

1  Sélectionnez des fichiers MIDI dans un 
navigateur DigiBase, dans l'Explorateur 
Windows ou dans le Finder Mac. 

2  Effectuez l'une des opérations suivantes :

• A partir du navigateur DigiBase, maintenez 
la touche Maj enfoncée et faites glisser les 
fichiers vers n'importe quel emplacement 
de la fenêtre Edit de la session actuelle.

• Déposez les fichiers dans un emplacement 
vide de la fenêtre Edit de la session actuelle.

• Déposez les fichiers dans la liste des pistes.

Exportation de fichiers MIDI
Pour exporter les pistes MIDI d'une session afin 
de les utiliser dans une autre application MIDI, 
ou les lire avec un séquenceur MIDI externe 
(matériel), vous pouvez exporter les pistes 
Pro Tools MIDI et Instrument sous forme de 
fichier MIDI standard. 

Les données MIDI peuvent être exportées depuis 
Pro Tools sous forme d'une piste unique 
multicanal fusionnée (Type 0) ou de plusieurs 
pistes (Type 1).

Si votre session Pro Tools utilise des signatures 
de tonalité et des mesures, elles sont exportées 
avec le fichier MIDI.

Pour exporter toutes les pistes MIDI et 
d'instrument de la session en cours :

1  Veillez à désactiver la coupure des pistes MIDI 
de la session que vous voulez inclure dans le 
fichier MIDI exporté. Ou inversement, coupez le 
son des pistes MIDI que vous ne désirez pas 
inclure dans le fichier MIDI exporté. Dans le cas 
des pistes d'instrument, activez ou désactivez le 
bouton de coupure de son MIDI (vue 
Instruments).

2  Choisissez > Export > MIDI. La boîte de 
dialogue Export MIDI Settings s'affiche.

3  Dans le menu déroulant MIDI File Format, 
sélectionnez 1 (plusieurs pistes) ou 0 (une seule 
piste).

4  Si l'heure de début du morceau est différente 
de l'heure de début de la session, choisissez 
Session Start ou Song Start dans le menu 
contextuel Location Reference.

5  Activez ou désactivez l'option Apply Real-
Time Properties, selon ce qui convient.

6  Cliquez sur OK. Cela a pour effet d'afficher 
une boîte de dialogue d'enregistrement.

7  Choisissez la destination du fichier MIDI et 
donnez-lui un nom.

8  Cliquez sur Save. 

Pour obtenir des informations détaillées sur 
l'utilisation des navigateurs DigiBase, 
reportez-vous au Guide DigiBase.

Boîte de dialogue Export MIDI Settings
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Pro Tools exporte toutes les pistes MIDI et 
d'instrument non coupées de la session en cours 
sous forme de fichier MIDI standard et l'écrit sur 
votre disque dur. Les informations MIDI 
exportées incluent les notes, les événements du 
contrôleur, les changements du programme, les 
données System Exclusive, ainsi que les 
événements concernant le tempo, la mesure et 
les marqueurs.

L'heure de début SMPTE pour la session ou le 
morceau (selon la sélection effectuée dans le 
menu déroulant Location Reference) est 
également exportée. Ainsi, les pistes exportées, 
lorsqu'elles sont lues à partir d'une autre 
application MIDI, démarrent au même code 
SMPTE, et sont donc synchrones avec les sons 
enregistrés sur bande ou les images provenant 
de magnétoscope externe, ou encore à 
Pro Tools.

Consultez la documentation de votre 
séquenceur MIDI pour savoir s'il prend en 
charge l'importation des points de début SMPTE 
à partir des fichiers MIDI.

Eléments non exportés avec les 
fichiers MIDI

Les coupures (Mute) d'automation et de régions 
n'ont pas d'incidence sur les données MIDI 
exportées. Tant qu'une piste MIDI ou qu'une 
piste d'instrument n'est pas coupée en cliquant 
sur son bouton Mute respectif, toutes ses 
données MIDI sont exportées.

Lors de l'exportation de fichiers MIDI à partir de 
Pro Tools, l'assignation des périphériques aux 
pistes n'est pas conservée (même si l'affectation 
des canaux est maintenue). Par conséquent, si 
vous exportez des pistes MIDI ou d'instrument à 
partir de Pro Tools et que vous les réimportez 
plus tard, vous devrez réassigner les pistes aux 
périphériques de votre studio.

Toutes les informations de playlist des pistes 
MIDI et d'instrument sont perdues lors de 
l'exportation. Par exemple, les pistes qui 
contenaient préalablement des douzaines de 
régions MIDI seront « mises à plat » et ne 
contiendront qu'une seule région après 
exportation et réimportation.

Exportation de pistes 
individuelles MIDI et d'instrument

Vous pouvez aussi exporter des pistes MIDI 
individuelles et d'instrument en tant que 
fichiers MIDI. Cela peut s'avérer utile pour le 
stockage de bibliothèques de vos séquences 
MIDI favorites ou de données Sysex (comme par 
exemple les transferts de patch individuels ou 
d'un groupe de patchs à partir de vos appareils 
MIDI externes) ou pour l'importation de MIDI 
dans des applications de notation autres que 
Sibelius ou G7.

Pour exporter une piste MIDI ou d'instrument en 
tant que fichier MIDI :

1  Effectuez l'une des opérations suivantes :

• Cliquez avec le bouton droit de la souris sur 
le nom d'une piste non sélectionnée de la 
fenêtre Edit ou Mix, ou dans la liste de 
pistes.

– ou –

• Maintenez la touche Ctrl (Mac) ou 
Démarrer (Windows) enfoncée et cliquez 
avec le bouton droit de la souris sur le nom 
d'une piste dans liste de pistes ou dans la 
fenêtre Edit. 

2  Sélectionnez Export MIDI dans le menu 
contextuel.

3  Définissez les paramètres d'export MIDI dans 
la boîte de dialogue Export MIDI Settings.

4  Cliquez sur OK.
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5  Dans la boîte de dialogue Save, saisissez le 
nom du fichier MIDI, spécifiez l'emplacement 
où vous souhaitez l'enregistrer et cliquez sur 
Save.

Pour exporter toutes les pistes d'instrument ou 
MIDI de Pro Tools en tant que fichier MIDI :

1  Sélectionnez les pistes à exporter en tant que 
fichier MIDI.

2  Cliquez avec le bouton droit de la souris sur le 
nom de la piste sélectionnée de la fenêtre Edit ou 
Mix, ou dans la liste de pistes.

3  Sélectionnez Export MIDI dans le menu 
contextuel.

4  Définissez les paramètres d'exportation MIDI 
qui conviennent.

5  Cliquez sur OK. 

6  Dans la boîte de dialogue Save, saisissez le 
nom du fichier MIDI, spécifiez l'emplacement 
où vous souhaitez l'enregistrer et cliquez sur 
Save.

Envoi vers Sibelius
Pro Tools vous permet d'envoyer toutes les 
pistes d'instrument ou MIDI (ou seulement les 
pistes sélectionnées) aux logiciels de notation 
Sibelius ou G7 afin d'imprimer les morceaux et 
partitions issus de votre session Pro Tools. 
Par exemple, si vous travaillez dans Pro Tools 
avec une partition de trompette samplée mais 
souhaitez qu'un trompettiste joue la partition, 
vous pouvez envoyer la piste de la trompette à 
Sibelius et imprimer la partition pour le 
trompettiste. Vous pouvez ensuite enregistrer le 
trompettiste lorsqu'il jouera la partition.

Pour envoyer toutes les pistes d'instrument et 
MIDI Pro Tools à Sibelius :

" Choisissez File > Send To Sibelius.

Pro Tools exporte toutes les pistes d'instrument 
et MIDI à Sibelius en tant que fichier MIDI. 
Sibelius démarre s'il est installé sur votre 
ordinateur. Si le seul logiciel installé est G7, c'est 
celui-ci qui s'ouvre. Sibelius (ou G7) vous invite 
à importer le fichier MIDI exporté à partir de 
Pro Tools avec la boîte de dialogue Open MIDI 
File. Vous pouvez apporter des modifications 
supplémentaires à la notation dans Sibelius et 
imprimer la musique de votre session.

Si votre session Pro Tools utilise des signatures 
de tonalité et des mesures, elles sont exportées 
avec le fichier MIDI et importées dans Sibelius.

Les fichiers MIDI exportés à partir de Pro Tools 
avec la commande Send to Sibelius sont 
enregistrés dans un dossier MIDI Files 
automatiquement créé dans le dossier de session 
Pro Tools. Les fichiers MIDI portent le même 
nom que la session ou que la piste, si une seule 
piste est exportée.

Cliquez avec le bouton droit de la souris 
tout en maintenant la touche Alt 
(Windows) ou Option (Mac) pour exporter 
toutes les pistes dans un fichier MIDI 
unique.

Cliquez avec le bouton droit de la souris 
tout en maintenant les touches Alt+Maj 
(Windows) ou Option+Maj (Mac) pour 
exporter toutes les pistes sélectionnées dans 
un fichier MIDI unique.
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Pour envoyer une seule piste d'instrument ou MIDI 
Pro Tools à Sibelius :

1  Effectuez l'une des opérations suivantes :

• Cliquez avec le bouton droit de la souris sur 
le nom d'une piste non sélectionnée de la 
fenêtre Edit ou Mix, ou dans la liste de 
pistes.

– ou –

• Maintenez la touche Ctrl (Mac) ou 
Démarrer (Windows) enfoncée et cliquez 
avec le bouton droit de la souris sur le nom 
d'une piste dans liste de pistes ou dans la 
fenêtre Edit. 

2  Sélectionnez Send To Sibelius dans le menu 
contextuel.

La piste est sélectionnée et envoyée à Sibelius.

Pour envoyer une sélection de pistes d'instrument 
et MIDI Pro Tools à Sibelius :

1  Choisissez les pistes à envoyer à Sibelius.

2  Cliquez avec le bouton droit de la souris sur le 
nom de la piste sélectionnée de la fenêtre Edit ou 
Mix, ou dans la liste de pistes.

3  Sélectionnez Send To Sibelius dans le menu 
contextuel.

Toutes les pistes sélectionnées sont envoyées à 
Sibelius.

Importation et exportation de 
fichiers de groupe de régions
Avec Pro Tools, vous pouvez exporter et 
importer les fichiers de groupe de régions au 
format .rgrp. Cela vous permet d'effectuer les 
opérations suivantes :

• séparer les métadonnées des groupes de 
régions des fichiers audio pour éviter les 
opérations de copie de fichiers inutiles lors 
de l'exportation de groupes de régions 
audio composés de plusieurs fichiers 
source ;

• exporter des données MIDI en tant que 
groupe de régions ;

• créer des boucles multipistes.

Les fichiers de groupe de régions stockent les 
métadonnées suivantes :

• Références à tous les fichiers audio au sein 
du groupe de régions

• Noms des régions et emplacements relatifs 
dans les pistes

• Fondus et crossfades

• Noms et formats (monopiste ou multipiste) 
des groupes de régions

• Toutes les données MIDI présentes dans le 
groupe de régions (notes, contrôleurs et 
Sysex, par exemple)

• Noms des pistes

Les fichiers de groupe de régions ne contiennent 
pas les données suivantes :

• Audio

• Automation

• Plug-in

• Assignation des pistes

• Table des tempos et des mesures

• Informations sur la liste des régions

Cliquez avec le bouton droit de la souris 
tout en maintenant la touche Alt 
(Windows) ou Option (Mac) pour envoyer 
toutes les pistes à Sibelius.

Cliquez avec le bouton droit de la souris 
tout en maintenant les touches Alt+Maj 
(Windows) ou Option+Maj (Mac) pour 
envoyer toutes les pistes à Sibelius.
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Pro Tools propose plusieurs méthodes pour 
importer des groupes de régions dans une 
session ouverte :

• Importation de groupes de régions à l'aide 
des commandes de menu Pro Tools, 
page 280

• Importation des groupes de régions par 
glisser-déposer, page 280

Importation de groupes de régions 
à l'aide des commandes de menu 
Pro Tools

Pour importer un groupe de régions avec les 
commandes de menu Pro Tools :

1  Choisissez File > Import > Region Groups et 
sélectionnez le groupe de régions à importer.

2  Dans la boîte de dialogue Region Group 
Import Options, sélectionnez la destination du 
groupe de régions.

New Track : crée une piste de destination du 
groupe de régions importé.

Region List : importe le groupe de régions dans 
la liste des régions, à partir de laquelle il devient 
accessible. 

3  Si vous créez une piste, choisissez 
l'emplacement pour le groupe importé dans la 
piste :

Session Start : place le groupe au début de la 
session. 

Song Start : aligne le début du groupe avec le 
début du morceau. 

Selection : aligne le début du groupe avec le 
curseur d'édition ou le début d'une sélection 
dans la timeline.

Spot : affiche la boîte de dialogue Spot qui 
permet de placer le groupe dans un 
emplacement spécifique basé sur toute échelle 
temporelle.

4  Choisissez l'une des options d'importation 
suivantes :

Import Tempo Map from Region Group File : 
remplace la table des tempos de la session par 
celle du groupe de région. Cette option n'est 
disponible que pour l'importation du groupe de 
régions dans le début de la session.

5  Cliquez sur OK. 

Importation des groupes de 
régions par glisser-déposer

Vous pouvez faire glisser des groupes de régions 
à partir d'un navigateur DigiBase ou depuis 
l'Explorateur Windows ou le Finder Mac et les 
déposer dans la timeline, une piste, la liste des 
pistes ou la liste des régions.

Pour importer des groupes de régions dans la liste 
de régions :

1  Sélectionnez un ou plusieurs groupes de 
régions dans un navigateur DigiBase, dans 
l'Explorateur Windows ou dans le Finder Mac. 

2  Déposez les fichiers dans la liste des régions de 
la session actuelle. 

Boîte de dialogue Region Group Import Options
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Pour importer des groupes de régions dans une 
piste existante :

1  Sélectionnez un ou plusieurs groupes de 
régions dans un navigateur DigiBase, dans 
l'Explorateur Windows ou dans le Finder Mac. 

2  Déposez les fichiers dans une piste existante 
de la fenêtre Edit de la session actuelle. 

Pour importer des groupes de régions dans de 
nouvelles pistes :

1  Sélectionnez un ou plusieurs groupes de 
régions dans un navigateur DigiBase, dans 
l'Explorateur Windows ou dans le Finder Mac. 

2  Effectuez l'une des opérations suivantes :

• A partir du navigateur DigiBase, maintenez 
la touche Maj enfoncée et faites glisser les 
fichiers vers n'importe quel emplacement 
de la fenêtre Edit de la session actuelle.

• Déposez les fichiers dans un emplacement 
vide de la fenêtre Edit de la session actuelle.

• Déposez les fichiers dans la liste des pistes.

Exportation de groupes de régions

Pour exporter un groupe de régions :

1  Sélectionnez un ou plusieurs groupes de 
régions dans la liste des régions.

2  Dans le menu contextuel de la liste des 
régions, choisissez Export Region Groups. 
La boîte de dialogue correspondante s'affiche.

3  Par défaut, le répertoire de destination 
correspond au dossier Region Groups créé 
automatiquement dans le dossier de la session. 
Vous pouvez en changer en cliquant sur le 
bouton Choose, en accédant à l'emplacement 
désiré, puis en cliquant sur Choose. Cliquez sur 
Reset pour rétablir le répertoire de destination 
par défaut.

4  Activez l'une des options suivantes pour 
résoudre les noms de fichiers de groupe de 
régions en double :

• Prompting for Each Duplicate (option par 
défaut)

• Auto Renaming

• Replacing with New Files

5  Cliquez sur OK. 

Pour obtenir des informations détaillées sur 
l'utilisation des navigateurs DigiBase, 
reportez-vous au Guide DigiBase.

Boîte de dialogue Export Region Groups
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Exportation de groupes de régions vers un autre 
disque dur

En règle générale, si vous exportez des groupes 
de régions vers un autre disque dur, il est 
recommandé de copier tous les fichiers audio 
éventuellement référencés. Vous pourrez ainsi 
transférer des groupes de régions non seulement 
d'une session à une autre, mais aussi d'un 
système à un autre.

Pour exporter un groupe de régions vers un autre 
disque dur en prenant en compte ses fichiers 
audio :

1  Exportez un ou plusieurs groupes de régions 
vers le disque dur de votre choix.

2  Créez une nouvelle session sur le nouveau 
disque.

3  Sélectionnez Setup > Preferences.

4  Dans la boîte de dialogue Preferences, cliquez 
sur l'onglet Processing et sélectionnez 
Automatically Copy Files on Import.

5  Cliquez sur OK pour refermer la boîte de 
dialogue Preferences.

6  Importez tous les groupes de région 
précédemment exportés en les déposant dans la 
session. 

Le dossier des fichiers audio de la nouvelle 
session contient à présent tous les fichiers 
référencés par les groupes de régions.
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Chapitre 13 : Gestion des fichiers et 
des sessions et compatibilité

Avec Pro Tools, vous travaillez avec plusieurs 
types de fichiers informatiques. Pour que les 
systèmes Pro Tools fonctionnent correctement, 
certains fichiers doivent être conservés dans des 
emplacements spécifiques du disque dur.

! Les fichiers logiciels Pro Tools (comme les 
applications et les fichiers de plug-in) doivent 
être placés dans votre lecteur de démarrage 
(celui qui contient le système d'exploitation et 
autres fichiers système).

! Dans les systèmes Pro Tools|HD, vous pourrez 
trouver les fichiers de données (comme les 
fichiers audio, de session et de fondus) dans tout 
disque compatible connecté aux bus internes ou 
externes ATA/IDE, FireWire ou SCSI (SCSI HBA 
inclus) de votre ordinateur. Pour optimiser les 
performances des systèmes Pro Tools|HD, il est 
recommandé d'utiliser des pilotes SCSI. Les 
pilotes FireWire et ATA/IDE sont également pris 
en charge. Pour plus d'informations, visitez le 
site Web de Digidesign (www.digidesign.com).

! Dans les systèmes Pro Tools LE, vous pourrez 
trouver les fichiers de données (comme les 
fichiers de session, audio et de fondus) dans tout 
disque compatible drive connecté au bus 
internes ou externes ATA/IDE, FireWire ou SCSI 
de votre ordinateur.

Gestion des fichiers audio

Identifications uniques de fichiers

Pro Tools attribue un identificateur unique à 
chaque fichier audio d'une session, il peut ainsi 
retrouver un fichier dont le nom ou 
l'emplacement a été modifié.

Recherche des fichiers audio

Pro Tools travaille en fait avec des renvois à des 
fichiers audio et média via la fenêtre Relink. 

Pro Tools classe les volumes de stockage en 
fonction de leurs capacités en matière de 
performances (d'enregistrement ou de lecture) ou 
de transfert (stockage ou copie) des fichiers audio 

Bien que Pro Tools vous permette d'effectuer 
les enregistrements sur votre lecteur 
système, cela est généralement déconseillé. 
Vous ne devez enregistrer sur des lecteurs 
système qu'en cas de besoin : par exemple, 
si votre ordinateur ne comporte qu'un seul 
disque dur ou si vos autres lecteurs sont déjà 
saturés.
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et autres fichiers médias. Les fichiers audio 
doivent être placés sur des volumes Performance 
appropriés et comprendre des renvois valides 
pouvant être lus dans une session Pro Tools.

Lors de l'ouverture d'une session, si Pro Tools 
signale que des fichiers audio sont absents d'un 
volume Performance, ou si le système ne 
parvient pas à localiser les fichiers audio 
contenus dans la session, vous pouvez localiser 
et copier les fichiers afin de lire la session. 
Ce processus est appelé rétablissement des liens. 

Fichiers de transfert

Les fichiers de transfert résident sur des volumes 
non destinés à la lecture comme les CD-ROM, 
les DVD et les lecteurs en réseau.

Pour ouvrir une session comprenant des fichiers 
de transfert :

" Ouvrez la session de Pro Tools. Si des fichiers 
se trouvent sur un volume non destiné à la 
lecture, Pro Tools vous fournit les instructions 
suivantes :

• Cliquez sur Yes pour ouvrir la fenêtre Copy 
and Relink.

– ou –

• Cliquez sur No pour ouvrir la session en 
conservant les fichiers de transfert hors 
ligne. 

Pour que les fichiers de transfert puissent être 
joués dans la session actuelle :

1  Choisissez Window > Project.

2  Cliquez deux fois sur le dossier Audio Files 
pour afficher tous les fichiers audio.

3  Choisissez Select Transfer Files dans le menu 
du navigateur. 

4  Choisissez Copy and Relink dans le menu du 
navigateur. 

5  Choisissez une destination sur un volume 
Performance valide où copier les fichiers.

6  Cliquez sur OK. 

Fichiers manquants

Si un fichier ne se trouve plus à l'endroit où il 
résidait lors du dernier enregistrement de la 
session, ce fichier est considéré comme étant 
manquant. 

Pour ouvrir une session ProTools avec des fichiers 
manquants :

1  Ouvrez la session de Pro Tools. Si des fichiers 
sont manquants, Pro Tools envoie un 
avertissement pour vous en informer 
(avertissement Missing Files).

2  Choisissez l'une des options suivantes :

Skip All : ignore tous les fichiers manquants de 
fondus. Les fichiers manquants sont mis hors 
ligne dans la session.

Pour plus d'informations sur les 
classifications des volumes de stockage, 
reportez-vous à la section Volumes 
Performance et Transfer, page 195.

Pour obtenir des informations complètes sur 
le rétablissement de lien des fichiers de 
transfert, consultez la section Création et 
rétablissement de liens de fichiers, 
page 220.

Avertissement concernant les fichiers manquants à 
l'ouverture d'une session
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Manually Find and Relink : ouvre la fenêtre 
Relink, dans laquelle vous pouvez rechercher, 
comparer, vérifier et relier des fichiers 
manquants.

Automatically Find and Relink : lance une 
recherche dans tous les volumes Performance 
pour localiser tous les fichiers dont le nom, l'ID 
de fichier unique, le format et la longueur 
correspondent aux fichiers manquants et les 
associe aux fichiers manquants si possible. 

3  Pour exclure les fichiers de fondus du 
processus de rétablissement de liens, et les 
recalculer, sélectionnez l'option Regenerate 
Missing Fades.

4  Cliquez sur OK. 

Fichiers audio renommés et dossier 
Renamed Audio Files

Les fichiers audio renommés se trouvent dans le 
dossier Renames Audio Files créé 
automatiquement dans le dossier de la session 
Pro Tools. Vous pouvez renommer les fichiers 
lorsque vous ouvrez une session faisant 
référence à des noms de fichier audio contenant 
des caractères incompatibles. Il est possible de le 
faire également dans certaines situations, 
notamment lors de l'enregistrement de la copie 
d'une session d'une version Pro Tools qui ne 
gère pas les noms de fichier longs.

Ouverture d'une session contenant des noms 
de fichier audio avec des caractères interdits

Pro Tools 7.x ne prend pas en charge les noms 
de fichier audio contenant les caractères ASCII 
suivants :

/ (barre oblique)

\ (barre oblique inverse)

: (deux points)

* (astérisque)

? (point d'interrogation)

« (guillemets)

< (symbole inférieur à)

> (symbole supérieur à)

| (ligne verticale)

Tout caractère ASCII créé avec une 
combinaison de touches désignant un bruit 
de haut niveau

Lorsque les noms des fichiers audio utilisés dans 
les sessions ouvertes contiennent de tels 
caractères, Pro Tools crée automatiquement une 
copie renommée de chaque fichier concerné (en 
remplaçant les caractères interdits par un trait 
de soulignement « _ »). Les fichiers renommés 
sont placés dans le dossier Renamed Audio Files. 
Les fichiers originaux restent inchangés dans le 
dossier Audio Files.

Avant l'ouverture de la session, vous êtes invité à 
enregistrer un rapport détaillé des fichiers 
renommés et de leurs noms d'origine dans un 
fichier texte de notes. Par défaut, le fichier de 
notes est sauvegardé dans le dossier Session.

Pour en savoir plus sur le rétablissement de 
liens des fichiers manquants, consultez la 
section Création et rétablissement de liens 
de fichiers, page 220.
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Enregistrement d'une copie d'une session 
contenant des noms de fichier audio longs

Lors de l'enregistrement de fichiers dans 
Pro Tools 6.9.x ou une version antérieure 
(à l'aide de la commande Save Copy In), les 
fichiers audio dont le nom dépasse la limite du 
format de destination sont tronqués et placés 
dans le dossier Session, conformément aux 
règles suivantes :

• Si la nouvelle session est enregistrée dans le 
même répertoire que le répertoire d'origine, 
un dossier Renamed Audio Files est créé dans 
le répertoire d'origine de la session pour les 
fichiers audio renommés.

• Si la nouvelle session est enregistrée dans un 
répertoire différent du répertoire d'origine et 
si l'option All Audio Files n'est pas cochée, un 
nouveau dossier Session (composé d'un 
sous-dossier Audio Files et d'un sous-dossier 
Renamed Audio Files) est créé. Les fichiers 
audio renommés sont inclus dans le dossier 
Audio Files.

• Si la nouvelle session est enregistrée dans un 
répertoire différent du répertoire d'origine et 
si l'option All Audio Files est cochée, un 
nouveau dossier Session (composé d'un 
sous-dossier Audio Files) est créé. Les fichiers 
audio renommés seront alors placés dans le 
dossier Audio Files.

Compatibilité avec les 
fichiers WAV
Conversion de fichiers WAV importés au format 
AES31/BroadcastWave

Pro Tools crée toujours des fichiers BWF (WAV) 
compatibles AES31/Broadcast lorsqu'ils 
proviennent de Pro Tools. Cette option crée des 
fichiers WAV importés compatibles avec la 
norme AES31/EBU Broadcast.

AES31/Broadcast Wave est une variante du type 
de fichier audio standard WAV. Le format AES31 
contient des marquages temporels SMPTE et 
d'autres informations complémentaires aux 
données PCM audio brutes. 

Cette variante est conforme aux normes définies 
par l'AES (Audio Engineering Society) et l'EBU 
(European Broadcasters Union). Choisissez cette 
option pour garantir la compatibilité avec 
d'autres stations de travail reconnaissant ce type 
de fichier. 

Cette option crée des fichiers WAV importés 
compatibles avec la norme AES31/EBU 
Broadcast :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Processing.

2  Sélectionnez l'option Convert imported WAV 
files to AES31/BroadcastWave, puis cliquez 
sur OK.

Il est possible néanmoins de travailler dans 
une session Pro Tools 7.x ayant des fichiers 
audio avec des noms comprenant des 
caractères interdits. Si vous choisissez la 
commande Save Session Copy In dans 
Pro Tools 6.9.x ou une version antérieure 
avec l'option Enforce Mac/PC Compatibility 
activée, les pistes sont renommées avec des 
caractères autorisés. Si l'option Enforce 
Mac/PC Compatibility est désactivée, les 
caractères restent les mêmes.
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Partage des sessions créées 
sur différentes plates-formes
Cette session inclut les éléments suivants :

• Travail avec des disques HFS+ basés sur Mac 
sur des ordinateurs Windows, page 287.

• Enregistrement de copies de sessions Mac 
compatibles avec Windows, page 289.

Travail avec des disques HFS+ 
basés sur Mac sur des ordinateurs 
Windows

Pour monter des disques HFS+ sur un système 
NTFS en vue de leur utilisation avec Pro Tools, 
l'option Digidesign HFS+ Disk Support ou 
l'utilitaire MacDrive Utility est nécessaire.

Option Digidesign HFS+ Drive Support

(Pro Tools HD et Pro Tools LE sur Windows 
uniquement)

Pro Tools HD et Pro Tools LE pour Windows XP 
prennent en charge l'enregistrement et la lecture 
de sessions directement à partir de disques 
formatés Mac (HFS+) utilisant l'option 
Digidesign HFS+ Disk Support. L'option HFS+ 
Disk Support est automatiquement installée 
avec les logiciels Pro Tools HD et Pro Tools LE 
par défaut.

Lors de l'utilisation de l'option Digidesign HFS+ 
Disk Support pour l'enregistrement et la lecture 
sur un système Windows, le fichier de session et 
tous les fichiers associés (par exemple les fichiers 
audio et MIDI) doivent être stockés sur des 

disques formatés Mac (HFS+). L'enregistrement 
et la lecture d'une session à partir d'un mélange 
de disques formatés Mac et Windows ne sont 
pas pris en charge.

Déplacement de sessions d'un système 
Windows vers des disques HFS+ Mac

(A partir de disques NTFS Windows 
uniquement)

Il existe une procédure spécifique pour 
transférer des fichiers de session à partir de 
disques NTFS de type Windows vers des disques 
HFS+ de type Mac.

Pour transférer des sessions Pro Tools Windows 
depuis des disques NTFS vers des disques HFS+ :

1  Paramétrez les options Digidesign HFS+ Disk 
Support ouMacDrive sur Backup/File Transfer.

2  Effectuez l'une des opérations suivantes :

• Faites glisser le dossier de session du disque 
NTFS vers le disque HFS+.

– ou –

• Ouvrez la session Windows sur le disque 
NTFS, choisissez Save Copy In, puis 
enregistrez une copie de la session sur le 
disque HFS+.

Pour plus d'informations, consultez le 
manuel Mac HFS+ Disk Support Option 
Guide.

Les systèmes Mac sont capables de lire 
(mais pas d'écrire) des sessions situées sur 
des disques durs Windows formatés 
FAT 32.
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Déplacement de sessions Mac sur des 
disques HFS+ vers un système 
Windows

(Sur disques NTFS Windows uniquement)

Plusieurs étapes sont nécessaires pour transférer 
des fichiers à partir de disques HFS+ de type Mac 
vers des disques NTFS de type Windows.

Pour transférer des sessions Pro Tools Mac depuis 
des disques HFS+ vers des disques NTFS :

1  Paramétrez l'option Digidesign HFS+ Disk 
Support ouMacDrive sur Normal Use.

2  Effectuez l'une des opérations suivantes :

• Faites glisser le dossier de session du disque 
HFS+ vers le disque NTFS.

– ou –

• Ouvrez la session Mac sur le disque HFS+ et, 
lorsque vous y êtes invité, choisissez Save 
Copy In et enregistrez une copie de la 
session sur le disque HFS+. 

Si la session utilisait précédemment des fichiers 
SD II, ceux-ci sont convertis au nouveau format 
de fichier audio.

Pour enregistrer (ou créer) des sessions Mac 
destinées à être utilisées sur des systèmes 
Windows, reportez-vous à la section 
Enregistrement de copies de sessions Mac 
compatibles avec Windows, page 289.

Lors du transfert de sessions Pro Tools 
depuis des disques HFS+ vers des disques 
NTFS, les sessions Pro Tools sont 
incapables de rétablir les liens avec les 
fichiers audio et de fondu dont les noms 
sont composés de caractères Mac interdits 
dans Windows. Ces caractères sont 
automatiquement convertis en traits de 
soulignement («_»). Les fichiers en question 
sont placés dans le dossier Renamed Audio 
Files. Il vous faut alors rétablir 
manuellement les liens de chaque fichier 
par ID de fichier (voir Fichiers manquants, 
page 284).

Pour enregistrer une session ne comportant 
aucun caractère interdit, reportez-vous à la 
section Enregistrement de copies de sessions 
Mac compatibles avec Windows, page 289.

Boîte de dialogue Save Copy In
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Enregistrement et lecture à partir de 
disques HFS+ sur Windows

Windows XP prend en charge l'enregistrement 
et la lecture de sessions directement à partir de 
disques formatés Mac (HFS+) à l'aide de l'option 
Digidesign HFS+ Disk Support ou de 
l'application logicielle MacDrive.

Lors de l'utilisation de l'option Digidesign HFS+ 
Disk Support ou de MacDrive pour 
l'enregistrement et la lecture sur un système 
Windows, le fichier de session et tous les fichiers 
audio doivent être stockés sur des disques 
fomatés Mac (HFS+). L'enregistrement et la 
lecture d'une session à partir d'un mélange de 
disques formatés Mac et Windows ne sont pas 
pris en charge.

Pour enregistrer ou lire à partir de disques HFS+ 
avec Windows à l'aide de MacDrive :

1  Sous Windows, allez dans Panel.

2  Choisissez Options > File Names et 
sélectionnez l'option International Use.

3  Supprimez toutes les options répertoriées sous 
File Name Maps.

4  Dans Pro Tools, choisissez Window > 
Workspace et assurez-vous que tous les volumes 
formatés Mac sont paramétrés sur R 
(enregistrement) ou P (lecture) dans les colonnes 
A (Audio) et V (Vidéo). 

Enregistrement de copies de 
sessions Mac compatibles avec 
Windows
(Commande Save Copy In dans Pro Tools 6.9.x 
et les versions antérieures uniquement)

Les sessions créées et enregistrées dans 
ProTools7.x sont toujours compatibles sur des 
systèmes Windows et Mac.

Si vous créez une session dans Pro Tools 6.9.x 
(ou une version antérieure) sur un système Mac, 
elle sera compatible avec les systèmes Windows 
à condition d'avoir activé l'option Enforce 
Mac/PC Compatibility lors de la sélection de la 
commande Save Copy In. Il faut également 
prendre en compte certaines limites multi 
plate-formes.

Limites des sessions 
multiplates-formes

Lorsque vous enregistrez (ou créez) une copie 
d'une session Pro Tools compatible Mac et 
Windows, tenez compte des restrictions 
suivantes et de la façon dont elles sont gérées 
dans Pro Tools :

Types de fichiers audio

Le format de fichier recommandé pour une 
parfaite interopérabilité entre les plates-formes 
est le format BWF (.WAV). Pour favoriser les 
échanges de sessions, Pro Tools adopte par 
défaut le format BWF pour les nouvelles 
sessions.

Dans les versions précédentes de 
Pro Tools, les disques formatés Mac HFS+ 
ne pouvaient être utilisés qu'en tant que 
volumes Transfer lorsqu'ils étaient 
connectés aux systèmes Windows XP avec 
MacDrive.

Pour plus d'informations sur l'utilisation de 
l'option Digidesign HFS+ Disk Support, 
consultez le manuel Mac HFS+ Disk 
Support Option Guide.
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Pro Tools propose différents formats de fichier 
pour l'enregistrement, le prémixage et 
l'exportation. Cependant, si vous créez une 
session en utilisant le format SD II, une boîte de 
dialogue d'avertissement s'affiche pour vous 
rappeler les conditions d'utilisation suivantes :

• Les sessions SD II ne sont pas prises en 
charge sous Windows XP.

• La fréquence d'échantillonnage maximale 
autorisée pour des fichiers SD II est de 
48 kHz. 

Extensions des noms de fichiers

Pour assurer la compatibilité 
multiplates-formes, tous les fichiers d'une 
session doivent se terminer par une extension de 
trois lettres. Les fichiers de session 
Pro Tools version 5.1 à 6.9.x portent l'extension 
« .pts » et les fichiers de session Pro Tools 5 
portent l'extension « .pt5 ». Les fichiers WAV 
portent l'extension « .wav » et les fichiers AIFF 
portent l'extension « .aif ».

Caractères ASCII incompatibles

Les noms des régions, des pistes et des fichiers et 
les paramètres de plug-in ne peuvent pas 
contenir de caractères ASCII incompatibles avec 
l'un ou l'autre des systèmes. 

Lorsque vous importez des fichiers dans une 
session, les caractères incompatibles sont 
convertis en traits de soulignement («_») et les 
fichiers renommés sont placés dans le dossier 
Renamed Files.

Les caractères suivants sont interdits dans des 
sessions Windows :

/ (barre oblique)

\ (barre oblique inverse)

: (deux points)

* (astérisque)

? (point d'interrogation)

« (guillemets)

< (symbole inférieur à)

> (symbole supérieur à)

| (ligne verticale)

Tout caractère ASCII créé avec une 
combinaison de touches désignant un bruit 
de haut niveau

Enregistrement de sessions 
multiplates-formes

Pour sauvegarder une session existante dans 
Pro Tools 6.9.x ou une version antérieure et 
garantir la compatibilité Mac et Windows :

1  Choisissez File > Save Copy In.

2  Dans la boîte de dialogue Save Copy In, 
sélectionnez une destination et entrez le nom 
du fichier de la nouvelle session.

3  Sélectionnez AIFF, BWF (WAV) comme option 
Audio File Type. Ces formats de fichiers sont 
compatibles avec les deux plates-formes.

4  Définissez la résolution et la fréquence 
d'échantillonnage de la session.

5  Activation de l'option Enforce Mac/PC 
Compatibility. Cette option doit être 
sélectionnée pour que votre session soit 
compatible sur les deux plates-formes.

6  Sélectionnez les éléments à copier vers la 
nouvelle session.

7  Cliquez sur Save. 
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Si la session utilisait précédemment des fichiers 
SD II, ceux-ci sont convertis au nouveau format 
de fichier audio.

Partage de sessions créées 
sur des systèmes Pro Tools 
différents
Pro Tools facilite le partage de sessions entre les 
systèmes Pro Tools|HD et les systèmes 
Pro Tools LE. Il existe entre les trois types de 
systèmes des différences importantes qui 
peuvent avoir une incidence sur le transfert des 
informations d'une session. 

Le tableau suivant inclut également les systèmes 
Pro Tools LE avec l'option DV Toolkit 2, ainsi 
que les systèmes Pro Tools LE avec l'option 
Music Production Toolkit.

Pro Tools permet de convertir en fichier 
compatible Windows un fichier créé sur 
Mac et enregistré sans l'option Enforce 
Mac/PC compatibility. Pour plus 
d'informations, reportez-vous à la section 
Partage des sessions créées sur différentes 
plates-formes, page 287.

Pour plus d'information sur le transfert de 
sessions entre Windows et Mac, consultez 
la section Partage des sessions créées sur 
différentes plates-formes, page 287.

Différences entre les systèmes Pro Tools

Fonction
Systèmes 
Pro Tools|HD

Systèmes 
Pro Tools LE

Systèmes 
Pro Tools LE avec 
DV Toolkit 2

Systèmes 
Pro Tools LE avec 
Music Production 
Toolkit

Nombre maximal 
de pistes audio

jusqu'à 256 jusqu'à 128 (32 
pouvant héberger 
des voix)

jusqu'à 128 (48 
pouvant héberger 
des voix)

jusqu'à 128 (48 
pouvant héberger 
des voix)

Nombre maximal 
de pistes 
d'instrument

128 32 32 32

Nombre maximal 
de bus de mixage

128 bus 
(Pro Tools 6.9 et 
versions 
ultérieures)

64 bus 
(Pro Tools 6.7 et 
versions 
antérieures)

32 bus (Pro Tools 
7.x)

16 bus (Pro Tools 
6.9.x et versions 
antérieures)

32 32
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Ouverture de sessions Pro Tools HD 
dans Pro Tools LE

Une session Pro Tools HD 7.2 ou ultérieure ne 
contenant pas de pistes vidéo ou de pistes de 
VCA principal peut être ouverte avec 
Pro Tools LE 7.x, mais il est possible que certains 
éléments de session s'ouvrent différemment, 
voire pas du tout.

Lors de l'ouverture d'une session Pro Tools HD 
7.x dans Pro Tools LE 7.x, les événements 
suivants se produisent :

Pistes

• Toutes les pistes au-delà des 32 premières 
pistes, ainsi que les pistes inactives, sont 
définies sur voice off.

• Toute affectation à des bus au-delà de 32 est 
inactive.

• Les pistes d'instrument au-delà de la piste 32 
sont désactivées.

• Les plug-in TDM ayant des équivalents RTAS 
sont convertis ; les autres sont désactivés.

• Les pistes multicanaux surround sont 
supprimées de la session.

• Les chemins d'entrée et de sortie non 
disponibles deviennent inactifs.

• Tout paramètre de compensation de retard est 
supprimé.

• Les pistes de VCA principal sont supprimées et 
toute automation VCA non fusionnée est 
abandonnée.

Groupes

• Dans Pro Tools LE 7.1 ou une version 
antérieure, tous les groupes au-delà des 26 
premiers (Banque 1, Groupes a-z) sont 
abandonnés.

• Les groupes Mix ne conservent que les 
informations du volume principal.

• Les groupes Mix/Edit ne gardent que les 
informations du volume principal et du mode 
d'automation.

• Les informations du processus d'automation 
pour les commandes groupées sont 
conservées.

Inserts par piste jusqu'à 5 jusqu'à 5 jusqu'à 5 jusqu'à 5

Départs par piste jusqu'à 10
(Pro Tools 7.x)

jusqu'à 5 
(Pro Tools 6.9.x 
et versions 
antérieures)

jusqu'à 10 
(Pro Tools 7.x)

jusqu'à 5 
(Pro Tools 6.9.x 
et versions 
antérieures)

jusqu'à 10 jusqu'à 10

Différences entre les systèmes Pro Tools

Fonction
Systèmes 
Pro Tools|HD

Systèmes 
Pro Tools LE

Systèmes 
Pro Tools LE avec 
DV Toolkit 2

Systèmes 
Pro Tools LE avec 
Music Production 
Toolkit

Les sessions Pro Tools HD 7.2 contenant 
des pistes vidéo ou des pistes de VCA 
principal ne s'ouvrent qu'avec Pro Tools LE 
7.0cs3 et versions ultérieures.
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• Les comportements groupés des paramètres 
Solo, Mute, Send Level et Send Mute sont 
conservés.

• Les paramètres Solo Mode et Solo Latch sont 
abandonnés.

Vidéo

• Seule la piste vidéo principale est affichée.

• Seule la première séquence QuickTime de la 
session est affichée ou lue.

• Si la session contient des films QuickTime 
dans la liste des régions mais pas de piste 
vidéo, la session s'ouvre avec une nouvelle 
piste QuickTime contenant la première 
séquence QuickTime de la liste des régions.

• La timeline affiche et lit uniquement la 
dernière playlist vidéo active. Aucune autre 
playlist vidéo n'est disponible.

• Dans Pro Tools LE 7.1 ou une version 
antérieure, les régions vidéo et les groupes de 
régions vidéo ne sont ni affichés ni 
sauvegardés.

Partage de sessions créées 
sur des versions logicielles 
différentes de Pro Tools
Pro Tools facilite le partage de sessions entre 
différentes versions logicielles d'un système 
Pro Tools particulier (par exemple, partage de 
sessions entre Pro Tools HD 7.x et Pro Tools 
HD 6.x).

Partage de sessions Pro Tools HD 
7.2 ou plus récentes avec des 
versions antérieures de 
Pro Tools HD

Ouverture de sessions Pro Tools HD 7.2 
ou plus récentes avec Pro Tools HD 7.1 
ou 7.0

Une session Pro Tools HD 7.2 ou ultérieure ne 
contenant pas de pistes vidéo ni de pistes de 
VCA principal peut être ouverte avec 
Pro Tools HD 7.1 ou 7.0, mais certains éléments 
de session risquent de s'ouvrir différemment, 
voire pas du tout.

Lors de l'ouverture d'une session Pro Tools HD 
7.2 avec une version antérieure de Pro Tools 
HD 7.1 ou 7.0, les événements suivants se 
produisent : 

Pistes

• Les pistes de VCA principal sont enlevées et 
toute automation VCA non fusionnée est 
abandonnée.

• Toute automation de rognage non fusionnée 
est abandonnée.

Les sessions Pro Tools HD 7.2 ou plus 
récentes contenant des pistes vidéo ou des 
pistes de VCA principal ne s'ouvrent 
qu'avec Pro Tools LE 7.1cs3 et ses versions 
ultérieures.
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Groupes

• Tous les groupes au-delà des 26 premiers 
(Banque 1, groupes a-z) sont abandonnés.

• Les groupes Mix ne conservent que les 
informations du volume principal.

• Les groupes Mix/Edit ne gardent que les 
informations du volume principal et du mode 
d'automation.

• Les informations du processus d'automation 
pour les commandes groupées ne sont pas 
conservées.

• Les comportements groupés des paramètres 
Solo, Mute, Send Level et Send Mute ne sont 
pas conservés.

• Les paramètres Solo Mode et Solo Latch sont 
abandonnés.

Vidéo

• Seule la piste vidéo principale est affichée.

• Seule la première séquence QuickTime de la 
session est affichée ou lue.

• Si la session contient des films QuickTime 
dans la liste des régions mais pas de piste 
vidéo, la session s'ouvre avec une nouvelle 
piste QuickTime contenant la première 
séquence QuickTime de la liste des régions.

• La timeline affiche et lit uniquement la 
dernière playlist vidéo active. Aucune autre 
playlist vidéo n'est disponible.

• Les régions vidéo et les groupes de régions 
vidéo ne sont ni affichés ni enregistrés.

Enregistrement de sessions 
Pro Tools HD 7.2 ou plus récentes au 
format Pro Tools 5.1 - 6.9

L'ouverture d'une session Pro Tools 7.2 ou plus 
récente avec Pro Tools 6.9.x - 5.1 est impossible. 

Pour enregistrer une session Pro Tools 7.x de 
manière à ce qu'elle soit compatible avec les 
versions 6.9.x - 5.1 de Pro Tools, utilisez la 
commande File > Save Copy In et choisissez le 
format de session « Pro Tools 5.1 -> 6.9 ».

Lors de l'enregistrement d'une session 
Pro Tools HD 7.2 ou plus récente au format 
Pro Tools HD 5.1 -> 6.9, les événements 
suivants se produisent :

Pistes

• Les pistes d'instrument sont divisées en pistes 
d'entrée auxiliaire et pistes MIDI distinctes.

• Les pistes de VCA principal sont supprimées et 
l'automation VCA est fusionnée dans les 
pistes esclaves correspondantes.

• Les playlists Trim automation sont fusionnées 
dans leurs playlists d'automation respectives.

• Les niveaux de gain de fader et les points 
d'inflexion d'automation supérieurs à +6 dB 
passent à +6 dB.

• Les noms longs sont abrégés à 31caractères.

• Les attributs suivant sont abandonnés :

• Groupes de régions

• Répétitions des régions

• Régions MIDI basées sur les échantillons

• Pistes MIDI basées sur les échantillons

• Départs F-J et toutes les données 
d'automation associées

• Emplacements marqueur/mémoire 201 
à 999
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Groupes

• Tous les groupes au-delà des 26 premiers 
(Banque 1, groupes a-z) sont abandonnés.

• Les groupes Mix ne conservent que les 
informations du volume principal.

• Les groupes Mix/Edit ne gardent que les 
informations du volume principal et du mode 
d'automation.

• Les informations du processus d'automation 
pour les commandes groupées ne sont pas 
conservées.

• Les comportements groupés des paramètres 
Solo, Mute, Send Level et Send Mute ne sont 
pas conservés.

• Les paramètres Solo Mode et Solo Latch sont 
abandonnés.

Vidéo

• Seule la piste vidéo principale est affichée.

• Seule la première séquence QuickTime de la 
session est affichée ou lue.

• Si la session contient des films QuickTime 
dans la liste des régions mais pas de piste 
vidéo, la session s'ouvre avec une nouvelle 
piste QuickTime contenant la première 
séquence QuickTime de la liste des régions.

• La timeline affiche et lit uniquement la 
dernière playlist vidéo active. Aucune autre 
playlist vidéo n'est disponible.

• Les régions vidéo et les groupes de régions 
vidéo ne sont ni affichés ni enregistrés.

Enregistrement de sessions 
Pro Tools HD 7.2 ou plus récentes au 
format Pro Tools 5.0

L'ouverture d'une session Pro Tools 7.2 ou plus 
récente avec Pro Tools versions 5.0 est 
impossible.

Pour enregistrer une session Pro Tools 7.x de 
manière à ce qu'elle soit compatible avec la 
versions 5.0 de Pro Tools, utilisez la commande 
File > Save Copy In et choisissez le format de 
session « Pro Tools 5.0 ».

L'enregistrement d'une session Pro Tools HD 
7.2 ou plus récente au format Pro Tools 5.0 
produit les mêmes événements que 
l'enregistrement d'une session Pro Tools HD 
7.2 au format Pro Tools HD 5.1 ->6.9, 
accompagnés des événements suivants :

• Les pistes multicanaux surround sont 
supprimées de la session.

• Les pistes inactives sont supprimées de la 
session.

• Les pistes affectées à aucune sortie (No 
Output) sont acheminées vers les bus 31 et 32.

• Les pistes ou départs affectés aux bus 33 à 64 
sont acheminés vers les bus 31 et 32.

• Les pistes affectées à des chemins multicanaux 
ou à des sous-chemins de chemins 
multicanaux sont acheminées vers les bus 31 
et 32.

• Les départs affectés à des chemins 
multicanaux ou à des sous-chemins de 
chemins multicanaux sont abandonnés.

• Les pistes ou départs affectés aux chemins 
stéréo faisant référence à des canaux 
pairs/impairs (2-3, par exemple) sont 
acheminés vers les bus 31 et 32.

• Les instances de plug-in multimono sont 
abandonnées.
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Partage de sessions Pro Tools LE 
7.3 avec des versions antérieures 
de Pro Tools LE

Ouverture de sessions Pro Tools LE 7.3 
avec Pro Tools LE 7.1 ou 7.0

Une session Pro Tools LE 7.3 ne contenant pas 
de pistes vidéo peut être ouverte avec 
Pro Tools LE 7.1 ou 7.0, mais certains éléments 
de session risquent de s'ouvrir différemment, 
voire pas du tout.

Lors de l'ouverture d'une session Pro Tools LE 
7.3 avec une version de Pro Tools LE 7.1 ou 
7.0, les événements suivants se produisent : 

Groupes

• Tous les groupes au-delà des 26 premiers 
(Banque 1, groupes a-z) sont abandonnés.

• Les groupes Mix ne conservent que les 
informations du volume principal.

• Les groupes Mix/Edit ne gardent que les 
informations du volume principal et du mode 
d'automation.

Vidéo

• Seule la piste vidéo principale est affichée.

• Seule la première séquence QuickTime de la 
session est affichée ou lue.

• Si la session contient des films QuickTime 
dans la liste des régions mais pas de piste 
vidéo, la session s'ouvre avec une nouvelle 
piste QuickTime contenant la première 
séquence QuickTime de la liste des régions.

• La timeline affiche et lit uniquement la 
dernière playlist vidéo active. Aucune autre 
playlist vidéo n'est disponible.

• Les régions vidéo et les groupes de régions 
vidéo ne sont ni affichés ni enregistrés.

Partage de sessions 
Pro Tools LE 7.3 avec Pro Tools LE 
6.9 ou versions antérieures

L'ouverture d'une session au format Pro Tools LE 
7.3 avec les versions 6.9.x ou antérieures de 
Pro Tools LE est impossible. En revanche, vous 
pouvez l'enregistrer sous une version antérieure 
compatible. Certains composants de session 
dans la nouvelle copie s'ouvrent différemment, 
voire pas du tout.

Enregistrement de sessions 
Pro Tools LE 7.x au format Pro Tools LE 
5.1 - 6.9

Pour enregistrer une session Pro Tools 7.x de 
manière à ce qu'elle soit compatible avec les 
versions 6.9.x - 5.1 de Pro Tools, utilisez la 
commande File > Save Copy In et choisissez le 
format de session « Pro Tools 5.1 -> 6.9 ».

Lors de l'enregistrement d'une session 
Pro Tools LE au format Pro Tools 5.1 > 6.9, les 
événements suivants se produisent :

• Tous les groupes au-delà des 26 premiers 
(Banque 1, groupes a-z) sont abandonnés.

• Les groupes Mix ne conservent que les 
informations du volume principal.

• Les groupes Mix/Edit ne gardent que les 
informations du volume principal et du mode 
d'automation.

• Seule la piste vidéo principale est affichée.

• Seule la première séquence QuickTime de la 
session est affichée ou lue.

• Si la session contient des films QuickTime 
dans la liste des régions mais pas de piste 
vidéo, la session s'ouvre avec une nouvelle 
piste QuickTime contenant la première 
séquence QuickTime de la liste des régions.
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• La timeline affiche et lit uniquement la 
dernière playlist vidéo active. Aucune autre 
playlist vidéo n'est disponible.

• Les régions vidéo et les groupes de régions 
vidéo ne sont ni affichés ni enregistrés.

• Les niveaux de gain de fader et les points 
d'inflexion d'automation supérieurs à +6 dB 
passent à +6 dB.

• Les noms longs sont abrégés à 31caractères.

• Les pistes d'instrument sont divisées en pistes 
d'entrée auxiliaire et pistes MIDI distinctes.

• Les attributs suivants sont abandonnés :

• Groupes de régions

• Répétitions des régions

• Régions MIDI basées sur les échantillons

• Pistes MIDI basées sur les échantillons

• Départs F-J et toutes les données 
d'automation associées

• Emplacements marqueur/mémoire 201 à 
999

• Bus 17 à 32 (Pro Tools LE)

Enregistrement de sessions 
Pro Tools LE 7.x au format Pro Tools 
LE 5.0

Pour sauvegarder une session Pro Tools 7.x pour 
qu'elle soit compatible avec la version 5.0 de 
Pro Tools, utilisez la commande File > Save 
Copy In pour choisir le format de session 
« Pro Tools 5.0 »

L'enregistrement d'une session Pro Tools LE 
7.x au format Pro Tools 5.0 produit les mêmes 
événements que l'enregistrement d'une 
session Pro Tools LE 7.3 au format 5.1 ->6.9, 
accompagnés des événements suivants :

• Les niveaux de gain de fader et les points 
d'inflexion d'automation supérieurs à +6 dB 
passent à +6 dB.

• Les instances de plug-in multimono sont 
abandonnées.

• Les départs affectés à des chemins 
multicanaux ou à des sous-chemins de 
chemins multicanaux sont abandonnés.

• Les pistes affectées à aucune sortie (No 
Output) sont acheminées vers les bus 31 et 32.

• Les pistes ou départs affectés aux bus 33 à 64 
sont acheminés vers les bus 31 et 32.

• Les pistes affectées à des chemins multicanaux 
ou à des sous-chemins de chemins 
multicanaux sont acheminées vers les bus 31 
et 32.

• Les pistes/départs affectés aux chemins stéréo 
faisant référence à des canaux pairs/impairs 
(2-3, par exemple) sont acheminés vers les bus 
31 et 32.

Prise en charge des 
applications multilingues pour 
les systèmes Pro Tools
(SE localisé sur Mac OS X uniquement)

Il est possible à présent d'ouvrir une version 
anglaise et localisée de Pro Tools (Pro Tools 
Coréen, Chinois simplifié ou Japonais) sur un 
Mac agréé par Digidesign capable d'exécuter les 
versions anglaise et localisées de Mac OS X. Une 
seule version localisée de Pro Tools peut être 
ouverte à la fois.

Pour changer de version localisée Pro Tools :

1  Fermez d'abord Pro Tools.

2  Lancez Préférences Système (menu Pomme).

3  Cliquez sur International (l'icône 
« drapeau »).

4  Cliquez sur l'onglet Langue si la page Langue 
n'est pas la page actuelle.
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5  Dans la colonne Langues, cliquez sur la langue 
de votre choix et faites-la glisser vers le haut de 
la liste.

6  Fermez la fenêtre International.

7  Effectuez l'une des opérations suivantes :

• Si vous passez d'une version localisée à la 
version anglaise, lancez Pro Tools.

– ou –

• Si vous passez d'une version localisée à une 
autre (ou de l'anglais à une version 
localisée), fermez puis ouvrez la session à 
partir du menu Pomme, puis lancez 
Pro Tools.

Si vous souhaitez réafficher la langue 
précédemment sélectionnée au démarrage 
de l'ordinateur (après avoir travaillé dans 
une autre version localisée), suivez les 
étapes ci-dessus et rétablissez la langue 
précédente comme préférence 
internationale.
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Chapitre 14 : Configuration de 
l'enregistrement

Avant d'enregistrer, vérifiez que votre système 
Pro Tools est correctement connecté et 
configuré. Pour plus d'informations concernant 
la connexion de Pro Tools à votre studio, 
consultez le Guide de démarrage fourni avec votre 
système. 

Certaines informations de ce chapitre 
concernent l'enregistrement MIDI, mais vous 
trouverez davantage de précisions sur ce sujet 
dans le chapitre 16, Enregistrement MIDI

Connexions d'entrée et 
niveaux audio
La plupart des interfaces audio Pro Tools|HD 
fonctionnent comme des périphériques de 
niveau ligne et n'offrent pas de 
pré-amplification. Les sources de faible niveau 
(micros, guitares électriques) doivent être 
pré-amplifiées. Pour cela, il vous faut une 
console de mixage haut de gamme ou un 
préampli dédié, comme le Digidesign PRE.

Digi 002 et Digi 002 Rack sont dotés de quatre 
entrées pré-amplifiées auxquelles vous pouvez 
connecter des signaux de faible niveau et de 
quatre entrées supplémentaires avec gain 
commutable. 

Mbox 2, Mbox 2 Pro, Mbox 2 Mini et Mbox sont 
dotés de deux entrées pré-amplifiées auxquelles 
vous pouvez connecter des signaux de faible 
niveau.

Pour plus d'informations sur les unités M-Audio 
agréées Digidesign, reportez-vous à la 
documentation de l'interface M-Audio.

Quel que soit le système, les commandes de 
volume et de panoramique des pistes dans 
Pro Tools modifient uniquement les niveaux 
d'écoute, sans affecter le gain d'entrée des 
niveaux d'enregistrement. Les vumètres à DEL 
des interfaces audio Digidesign indiquent aussi 
bien l'utilisation de la pleine échelle numérique 
(niveau le plus élevé avant écrêtage) que 
l'écrêtage réel des signaux de sortie de Pro Tools. 
Les vumètres à l'écran de l'application Pro Tools 
n'indiquent que l'écrêtage réel.

Le Digidesign PRE peut être utilisé comme 
pré-ampli autonome avec tous les systèmes 
Pro Tools ou contrôlé à distance lors d'une 
session Pro Tools sur un système 
Pro Tools|HD.
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Ecrêtage numérique

L'écrêtage se produit lorsqu'un enregistreur ou 
une console de mixage reçoit un signal supérieur 
à la limite autorisée par l'appareil. Sur de 
nombreux magnétophones analogiques, un 
léger écrêtage ajoute une chaleur perceptible au 
son, du fait de la compression magnétique sur la 
bande. Dans le cas d'un enregistrement 
numérique, en revanche, l'écrêtage provoque 
une distorsion numérique indésirable qui doit 
être impérativement évitée. 

Réglage des niveaux d'entrée 
suffisamment haut tout en évitant 
l'écrêtage

Lorsque vous envoyez un signal vers n'importe 
quel système d'enregistrement audio, Pro Tools 
compris, vérifiez le niveau d'entrée afin 
d'optimiser la plage dynamique et le rapport 
signal-bruit du fichier enregistré. Si le niveau 
d'entrée est trop faible, vous ne bénéficierez pas 
pleinement de la plage dynamique de votre 
système Pro Tools. Si le niveau d'entrée est trop 
élevé, le signal écrête et provoque des 
distorsions dans l'enregistrement. 

Veillez à définir des niveaux légèrement 
supérieurs à 6 dB (cette valeur s'affiche dans le 
vumètre d'entrée) sans déclencher l'indicateur 
d'écrêtage de l'interface audio.

Mode Calibration

(Pro Tools HD uniquement)

Le mode Calibration de Pro Tools permet de 
régler les niveaux d'entrée et de sortie des 
interfaces audio de manière à ce qu'ils 
correspondent à ceux de votre console de 
mixage et des autres périphériques de votre 
studio.

L'interface 192 I/O est équipée de deux séries de 
potentiomètres de rognage en entrée et deux 
séries de potentiomètres de rognage en sortie. 
De plus, le niveau de référence de l'entrée peut 
être réglé sur +4 dBu ou sur -10 dBV. L'interface 
888|24 I/O est équipée de potentiomètres de 
rognage en entrée et en sortie, contrairement

aux interfaces audio suivantes : 192 Digital I/O, 
96 I/O, 96i I/O, 882|20 I/O, 1622 I/O et ADAT 
Bridge I/O 24 bits. Certaines interfaces d'E/S de 
Digidesign non équipées de potentiomètres de 
rognage en sortie (par exemple, E/S 96i I/O) 
fournissent des commandes logicielles de 
réglage des niveaux d'entrée. Pour les modifier, 
sélectionnez Setup > Hardware (pour plus 
d'informations relatives à votre interface d'E/S, 
reportez-vous au guide correspondant).

Activation des pistes à 
l'enregistrement
Pour enregistrer des données sur une piste, vous 
devez d'abord activer le bouton Record Enable. 
Pour enregistrer des données simultanément sur 
plusieurs pistes, préparez à l'enregistrement 
plusieurs pistes de type audio, instrument ou 
MIDI. 

Pour en savoir plus sur le calibrage de votre 
interface audio ou sur l'utilisation du mode 
Calibration, reportez-vous au Guide 
192 I/O (ou aux instructions d'utilisation 
du mode de calibrage incluses dans les 
livraisons antérieures de l'interface 
192 I/O) ou au Guide 888|24 I/O.
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Lorsqu'une ou plusieurs pistes sont activées pour 
l'enregistrement, cliquez sur le bouton Record 
(dans la fenêtre Transport ou Edit) pour armer 
l'enregistrement, puis cliquez sur le bouton Play 
(dans la fenêtre Transport ou Edit) pour lancer 
l'enregistrement.

Pour préparer une piste audio, MIDI ou une piste 
d'instrument à l'enregistrement :

" Depuis la fenêtre Mix ou Edit, cliquez sur le 
bouton Record Enable de la piste pour activer ou 
désactiver le mode de préparation à 
l'enregistrement de la piste. Le bouton est 
allumé lorsqu'il est activé et le fader de la piste 
apparaît en surbrillance dans la fenêtre Mix.

Pour préparer plusieurs pistes audio à 
l'enregistrement :

" Depuis la fenêtre Mix ou Edit, cliquez sur le 
bouton Record Enable de la piste pour activer ou 
désactiver le mode de préparation à 
l'enregistrement de chaque piste.

Seules les pistes MIDI et les pistes 
d'instrument peuvent être préparées à 
l'enregistrement pendant la lecture ou 
l'enregistrement. Pour préparer les pistes 
audio à l'enregistrement, vous devez arrêter 
les commandes de transport ou encore 
activer le mode d'enregistrement 
QuickPunch, TrackPunch ou 
DestructivePunch. Pour plus d'informations 
sur QuickPunch, TrackPunch et 
DestructivePunch, consultez Modes 
d'enregistrement, page 314.

Pour plus d'informations à propos de la 
numérisation (enregistrement) vidéo dans 
Pro Tools, consultez le chapitre 36, 
Traitement vidéo dans Pro Tools ou le guide 
des périphériques vidéo Avid. Piste audio préparée à l'enregistrement dans les 

fenêtres Mix et Edit

Si le mode de verrouillage des pistes pour 
l'enregistrement (Latch Record) n'est pas 
activé, appuyez sur la touche Maj tout en 
cliquant sur le bouton Record Enable de la 
piste pour activer ou désactiver le mode de 
préparation à l'enregistrement de chaque 
piste. Pour plus d'informations, 
reportez-vous à la section Préférence Latch 
Record Enable Buttons, page 304.

Fenêtre Edit

Mix, fenêtre
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Pour préparer plusieurs pistes MIDI ou pistes 
d'instrument à l'enregistrement :

" Depuis la fenêtre Mix ou Edit, appuyez sur la 
touche Maj tout en cliquant sur le bouton 
Record Enable de la piste pour activer ou 
désactiver le mode de préparation à 
l'enregistrement de chaque piste.

Pour préparer les pistes MIDI ou les pistes 
d'instrument à l'enregistrement à l'aide des 
touches fléchées Haut/Bas :

" Pour préparer la piste MIDI ou la piste 
d'instrument précédente ou suivante à 
l'enregistrement, maintenez enfoncée la touche 
Ctrl (Windows) ou Pomme (Mac), pendant que 
vous appuyez sur les flèches Haut/Bas. La piste 
précédente (ou suivante) quitte le mode de 
préparation à l'enregistrement.

Pour préparer toutes les pistes audio ou toutes les 
pistes MIDI ou d'instrument à l'enregistrement :

" Pour activer ou désactiver la préparation de 
toutes les pistes audio, MIDI ou les pistes 
d'instrument à l'enregistrement, maintenez 
enfoncée la touche Alt (Windows) ou Option 
(Mac) pendant que vous cliquez sur le bouton 
Record Enable. 

Pour l'activation de la préparation des pistes, 
Pro Tools traite de la même manière les pistes 
MIDI et les pistes d'instrument. Par conséquent, 
maintenir les touches Alt (Windows) ou Option 
(Mac) enfoncées tout en cliquant sur le bouton 
Record Enable d'une piste MIDI ou d'une piste 
d'instrument prépare l'ensemble des pistes MIDI 
et des pistes d'instrument à l'enregistrement.

Pour préparer toutes les pistes audio, ou toutes 
les pistes MIDI et d'instrument sélectionnées à 
l'enregistrement :

" Pour activer ou désactiver la préparation de 
toutes les pistes audio, MIDI ou les pistes 
d'instrument sélectionnées à l'enregistrement, 
maintenez enfoncées les touches Alt+Maj 
(Windows) ou Option+Maj (Mac) et cliquez sur 
le bouton Record Enable.

Préférence Latch Record Enable 
Buttons

Lorsque la préférence Latch Record Enable 
Buttons est sélectionnée, vous pouvez préparer 
des pistes supplémentaires à l'enregistrement en 
cliquant sur les boutons Record Enable 
correspondants. Les pistes précédemment 
préparées le demeurent. La préférence Latch 
Record Enable Buttons ne concerne que les 
pistes audio.

Lorsque la préférence Latch Record Enable 
Buttons est désélectionnée, l'activation pour 
l'enregistrement d'une piste audio désactive 
l'enregistrement pour la piste audio précédente.

Pour que la piste précédente reste activée 
pour l'enregistrement lors de l'activation de 
nouvelles pistes, utilisez la combinaison de 
touches Control+Maj+Haut/Bas (Windows) 
ou Pomme+Maj+Haut/Bas (Mac).

L'activation pour l'enregistrement d'une 
piste faisant partie d'un groupe de mixage 
ne s'étend pas aux autres pistes du groupe. 
Pour activer toutes les pistes d'un groupe 
pour l'enregistrement, cliquez directement 
sur la gauche du nom du groupe dans la liste 
pour sélectionner toutes les pistes du groupe, 
puis cliquez sur le bouton Record Enable 
d'une des pistes en maintenant les touches 
Alt+Maj (Windows) ou Option+Maj (Mac).
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Pour activer la préférence Latch Record Enable 
Buttons :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation.

2  Sélectionnez l'option Latch Record Enable 
Buttons.

Mode de protection contre 
l'enregistrement

Le mode Record Safe de Pro Tools permet 
d'interdire individuellement la préparation de 
plusieurs pistes à l'enregistrement. Utilisez le 
mode de protection contre l'enregistrement 
pour protéger les pistes importantes.

Pour protéger une piste audio ou MIDI contre 
l'enregistrement :

" Maintenez enfoncée la touche Ctrl (Windows) 
ou Pomme (Mac) pendant que vous cliquez sur 
le bouton Record Enable correspondant à la 
piste. Ce bouton apparaît alors en grisé.

Pour désactiver la protection contre 
l'enregistrement de la piste, maintenez enfoncée 
la touche Ctrl (Windows) ou Pomme (Mac) 
pendant que vous cliquez sur le bouton Record 
Enable.

Pour protéger toutes les pistes contre 
l'enregistrement :

" Maintenez enfoncées les touches Ctrl+Alt 
(Windows) ou Pomme+Option (Mac) et cliquez 
sur le bouton Record Enable des pistes.

Pour sortir toutes les pistes du mode de 
protection contre l'enregistrement, maintenez 
les touches Ctrl+Alt (Windows) enfoncées ou 
Pomme+Option (Mac) et cliquez à nouveau sur 
ce bouton.

Pour protéger toutes les pistes sélectionnées 
contre l'enregistrement :

" Pour activer/désactiver la protection contre 
l'enregistrement des pistes, maintenez 
enfoncées les touches Ctrl+Alt+Maj (Windows) 
ou Pomme+Option+Maj (Mac) pendant que 
vous cliquez sur le bouton Record Enable de 
n'importe quelle piste sélectionnée.

Modes d'écoute en 
enregistrement
Pro Tools propose deux modes d'écoute des 
signaux d'entrée : Auto Input et Input Only. 
Ces modes déterminent de quelle manière les 
signaux d'entrée sont écoutés au cours de la 
lecture, de l'enregistrement ou lorsque le 
transport est arrêté.

Mode d'écoute Auto Input

En mode Auto Input, dès que la lecture de la 
session s'arrête, Pro Tools bascule sur l'écoute 
des signaux d'entrée audio. Lorsque la lecture est 
lancée en vue d'une entrée d'enregistrement à la 
volée (punch-in), Pro Tools lit les données déjà 
enregistrées sur la piste jusqu'au point d'entrée. 
En mode réenregistrement, vous écoutez le 
signal d'entrée. A la fin du réenregistrement, 
Pro Tools lit à nouveau les données enregistrées 
sur la piste. Cette fonction est semblable au 
mode Auto Input (commutation automatique 
lecture/entrées) des magnétophones multipistes 
numériques ou analogiques.

Lorsque vous êtes en mode Auto Input, le 
retour à l'écoute des données de la piste à la 
fin du réenregistrement n'est pas 
instantané.
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Mode Input Only Monitoring

En mode Input Only, dès qu'une piste est 
préparée à l'enregistrement, Pro Tools ne permet 
d'écouter que l'entrée audio, quelle que soit la 
sélection en enregistrement effectuée ou l'état.

Dans Pro Tools LE, l'indicateur d'état Input 
Monitor Enabled (dans la fenêtre Transport) de 
couleur verte indique que le mode Input Only 
est activé.

Dans Pro Tools HD, l'indicateur s'affiche en vert 
lorsque la fonction TrackInput est activée pour 
une ou plusieurs pistes.

Sélection du mode d'écoute 
de l'enregistrement dans 
Pro Tools LE

Pour que les pistes activées en enregistrement 
utilisent le mode d'écoute Auto Input :

" Sélectionnez Track > Auto Input Monitoring.

Pour que les pistes activées en enregistrement 
utilisent le mode d'écoute Input Only :

" Sélectionnez Tracks > Input Only Monitoring.

Sélection du mode d'écoute de 
l'enregistrement avec la fonction 
TrackInput
(Pro Tools HD uniquement)

La fonction TrackInput permet à tout moment 
d'activer et de désactiver les modes d'écoute 
Auto Input au mode Input Only pour chaque 
piste audio, y compris pendant la lecture, 
l'enregistrement ou l'arrêt et ce, même si une 
piste n'est pas préparée à l'enregistrement. 
La fonction TrackInput offre la souplesse 
d'écoute nécessaire au doublage et à 
l'enregistrement fractionné, et est similaire à la 
commutation d'entrée des enregistreurs 
multipistes numériques ou appareils de même 
type.

Lorsque le bouton TrackInput d'une piste est 
activé (vert), la piste gère les données audio en 
mode Input Only. 

Lorsque le bouton TrackInput d'une piste est 
désactivé, la piste est en mode Auto Input.

Avec Pro Tools HD, les pistes sont réglées 
sur Auto Input par défaut et un contrôle 
d'écoute (bouton TrackInput) est proposé 
pour chaque piste. Pour plus 
d'informations, reportez-vous à la section 
Sélection du mode d'écoute de 
l'enregistrement avec la fonction 
TrackInput, page 306.

Fenêtre Transport

Indicateur d'état Input Monitor Enabled

Pour passer du mode d'écoute Auto Input 
au mode Input Only et inversement, 
appuyez sur les touches Alt+K (Windows) 
ou Option+K (Mac).

Boutons d'écoute TrackInput dans la fenêtre Edit

Bouton TrackInput

Bouton TrackInput

 Fonction désactivée (Auto Input)

Fonction activée (Input Only)
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Pour définir le mode d'écoute de pistes audio, 
effectuez l'une des opérations suivantes :

" Cliquez sur le bouton TrackInput Monitor de 
chaque piste concernée.

" Tout en maintenant la touche Alt (Windows) 
ou Option (Mac) enfoncée, cliquez sur un 
bouton TrackInput Monitor.

" Tout en maintenant les touches Alt+Maj 
(Windows) ou Option+Maj (Mac) enfoncées, 
cliquez sur le bouton TrackInput Monitor d'une 
piste sélectionnée.

Pour activer/désactiver le bouton TrackInput de 
toutes les pistes activées pour l'enregistrement, 
effectuez l'une des opérations suivantes :

" Pour activer le mode d'écoute Auto Input, 
sélectionnez Track > Set Record Tracks to Auto 
Input.

" Pour activer le mode d'écoute Input Only, 
sélectionnez Track > Set Record Tracks to Input 
Only.

Préférence Disable « Input » When 
Disarming Track

Lorsque la préférence Operation est cochée, 
l'écoute d'entrée de piste (TrackInput) est 
désactivée à chaque fois qu'une piste est 
désactivée pour l'enregistrement. Ceci s'avère 
particulièrement utile pour certaines 
procédures, telles que l'enregistrement d'une 
série de pistes, une par une.

La désactivation de cette option a pour effet de 
laisser les boutons TrackInput activés lorsque le 
bouton Record Enable de la piste est désactivé.

Niveaux d'écoute en 
enregistrement et en lecture
Pro Tools mémorise deux niveaux de fader 
différents pour l'écoute de chaque piste audio : 
l'un est utilisé lorsque la piste est préparée à 
l'enregistrement, l'autre lorsqu'elle ne l'est pas. 

Pro Tools garde automatiquement la trace de ces 
deux valeurs de niveaux de fader. Si vous réglez 
un fader lorsqu'une piste est préparée à 
l'enregistrement et que vous désactivez la 
préparation à l'enregistrement, le fader reprend 
son niveau de lecture.

Lorsque des pistes audio sont préparées à 
l'enregistrement, leurs faders de volume 
deviennent rouges dans la fenêtre Mix pour 
indiquer que le niveau d'écoute de 
l'enregistrement est actif.

Link Record and Play Faders :

Lorsque l'option Link Record and Play Faders est 
sélectionnée dans les préférences de 
fonctionnement, Pro Tools ne mémorise pas les 
différents niveaux d'écoute en enregistrement et 
en lecture des pistes audio. Dans ce cas, le fait de 
préparer une piste audio à l'enregistrement n'a 
aucun effet sur le niveau du fader de la piste. 
Vous pouvez ainsi conserver un mixage 
cohérent, que ce soit pendant l'enregistrement 
ou la lecture.

Pour permuter les pistes activées à 
l'enregistrement entre les modes Auto 
Input et Input Only, appuyez sur les 
touches Alt+K (Windows) ou Option+K 
(Mac).
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Latence d'écoute
(Pro Tools LE)

Pro Tools LE utilisant le processeur hôte de votre 
ordinateur pour le traitement, la lecture et 
l'enregistrement des données audio, le signal 
audio subit un léger retard, ou latence, lors de 
son parcours dans le système. La valeur de cette 
latence est liée à la taille du buffer matériel : plus 
la capacité du buffer est volumineuse, plus la 
latence sera importante.

Sur les systèmes Pro Tools LE, vous pouvez 
réduire le temps de latence d'écoute en 
diminuant la taille du buffer de l'appareil. Il est 
toutefois impossible d'éliminer complètement la 
latence, même pour une taille de buffer réduite 
au minimum. De plus, le fait de réduire la taille 
du buffer limite le nombre de pistes audio que 
vous pouvez enregistrer simultanément sans 
risque d'erreur.

Dans certaines circonstances, une taille de buffer 
plus importante peut s'avérer nécessaire, par 
exemple lorsque vous avez de nombreuses pistes 
et davantage de plug-in ; mais en général une 
taille de buffer inférieure est souhaitable lors de 
l'enregistrement de données audio que vous 
écoutez via Pro Tools LE.

Si vous écoutez la source enregistrée via une 
console de mixage externe avant que les 
données soient acheminées vers Pro Tools, vous 
n'entendrez aucune latence.

Pour régler la taille du buffer matériel :

1  Sélectionnez Setup > Playback Engine.

2  Choisissez le nombre d'échantillons dans la 
liste déroulante H/W Buffer Size.

3  Cliquez sur OK.

Ecoute avec une latence zéro
(Mbox 2, Mbox 2 Mini et Mbox uniquement)

Mbox 2, Mbox Mini et Mbox permettent de 
contrôler les signaux d'entrée analogique lors de 
l'enregistrement, en éliminant la latence. 
Cette écoute analogique à latence zéro est 
contrôlée par le bouton Mix du panneau avant 
du dispositif, que vous pouvez utiliser pour 
mélanger et régler l'entrée analogique entre 
l'interface et la lecture Pro Tools. Pour plus 
d'informations, reportez-vous au guide de 
démarragede votre système.

Ecoute à faible latence
(Digi 002, Digi 002 Rack et Mbox 2 Pro 
uniquement)

Les systèmes Digi 002, Digi 002 Rack et Mbox 2 
Pro peuvent utiliser l'option Low Latency 
Monitoring pour enregistrer avec une latence 
d'écoute extrêmement réduite, sur autant de 
pistes que chaque système peut gérer. Seules les 
pistes dont les entrées sont assignées à une 
interface audio (et non à un bus) autorisent 
l'écoute à faible latence.

Les ordinateurs dotés de processeurs plus 
lents ne pourront peut-être pas utiliser une 
taille de buffer de 128 sans que cela 
n'entraîne des erreurs de fonctionnement.
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Pour activer l'écoute à faible latence :

1  Préparez les pistes audio à l'enregistrement en 
cliquant sur les boutons Record Enable.

2  A partir du sélecteur de chemins de sortie, 
assignez chaque piste soit à Output 1 soit à 
Output 2 (mono) ou aux deux (stéréo). Seules les 
pistes assignées à ces sorties utilisent l'écoute à 
faible latence.

3  Sélectionnez Options > Low Latency 
Monitoring. 

Lorsque l'écoute à faible latence est activée, les 
plug-in et les envois affectés aux pistes préparées 
à l'enregistrement (acheminés vers les sorties 1 
et 2) sont automatiquement désactivés et 
doivent le rester. De plus, ces pistes 
n'apparaissent pas sur les vumètres des faders 
principaux.

Ecoute à faible latence et 
prémixage sur disque

Lorsque l'option Low Latency Monitoring est 
activée, seules les pistes audio sont incluses via 
la commande Bounce To Disk (prémixage sur 
disque). Les pistes d'entrées et d'instrument 
auxiliaires sont ignorées. Pour inclure les pistes 
d'entrée auxiliaire et d'instrument, désactivez 
l'option Low Latency Monitoring avant 
l'utilisation de la commande Bounce to Disk. 

Ecoute à faible latence avec 
compensation de retard
(Pro Tools HD uniquement)

Si vous choisissez d'effectuer un enregistrement 
en activant la compensation de retard, Pro Tools 
interrompt automatiquement la compensation 
de retard pour les pistes dans lesquelles vous 
souhaitez insérer un point d'entrée ou en mode 
d'écoute des signaux d'entrée. En pareils cas, 
aucune compensation de retard n'est ajoutée à la 
piste et l'indicateur de compensation de retard 
affiche zéro. 

La compensation de retard doit être activée dès 
que possible au cours du mixage et de la lecture. 
Dans certains cas, il est préférable de désactiver 
la fonction de compensation de retard lors de 
l'enregistrement.

L'interruption automatique de la compensation 
de retard ou des pistes préparées à 
l'enregistrement au cours de l'enregistrement 
peut être annulée pour la piste de votre choix, 
quel que soit le statut d'enregistrement ou le 
mode d'entrée.

L'entrée externe ne peut pas être enregistrée 
au cours du prémixage sur disque. 
Pour inclure l'entrée externe dans votre 
prémixage, celle-ci doit être enregistrée au 
préalable sur de nouvelles pistes audio (voir 
Enregistrement sur des pistes, page 857).

Pour plus d'informations sur l'annulation 
de la suspension de la compensation de 
retard, reportez-vous à la section Ecoute à 
latence réduite lors de l'enregistrement, 
page 760.
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Nom des pistes par défaut
Lorsque vous créez des pistes audio, des pistes 
d'entrée auxiliaire, de fader principal, de VCA 
principal, MIDI et des pistes d'instrument, 
Pro Tools les nomme « Audio », « Aux », 
« Master », « VCA »« MIDI » ou « Inst » et les 
numérote de façon séquentielle. Lorsque vous 
créez, par exemple, deux pistes audio, leur nom 
par défaut est « Audio 1 » et « Audio 2 ». 
Vous pouvez renommer les pistes et leur ajouter 
des commentaires.

Les noms de pistes définissent les noms des 
nouveaux fichiers et des nouvelles régions lors 
de l'enregistrement sur une piste. Reportez-vous 
à Attribution de noms aux pistes, page 147.

Noms par défaut des fichiers et des 
régions audio

Lorsque vous enregistrez sur une piste audio, les 
noms de fichiers et de régions résultants sont 
basés sur le nom de la piste. Par exemple, après 
avoir enregistré pour la première fois sur une 
piste nommée « Guit électr », le fichier audio 
écrit sur le disque dur porte le nom « Guit 
électr_01 ». De plus, une région portant le nom 
« Guit électr_01 » apparaît dans la liste des 
régions. Cette région est une région de fichier 
complet.

Les prises suivantes sur la même piste portent le 
même nom, mais le numéro de la prise est 
incrémenté (par exemple, « Guit électr_02 »). 
La seconde série de chiffres (par exemple, « Guit 
électr_01-01 ») désigne une région créée 
automatiquement à partir d'une édition. 

Lorsque vous enregistrez des pistes MIDI, un 
principe d'identification similaire est utilisé, à la 
seule différence qu'il ne comporte qu'une série 
de chiffres. Après avoir enregistré, par exemple, 
sur une piste nommée « Synth 1 », la région 
créée s'appelle « Synth 1-01 ». Les régions 
suivantes de cette piste, créées soit à partir de 
prises supplémentaires, soit à partir d'éditions de 
régions, sont numérotées de façon séquentielle 
(par exemple, « Synth 1-02 »).

Noms des pistes audio stéréo

Lors de l'enregistrement sur des pistes audio 
stéréo, les noms des fichiers audio et des régions 
des canaux gauche et droit sont respectivement 
accompagnés des suffixes « .L » et « .R ».

Noms des pistes multicanaux

(Pro Tools HD uniquement)

Lors de l'enregistrement sur des pistes Surround 
multicanaux, les noms des fichiers audio et des 
régions de chaque canal se voient 
respectivement accompagnés des suffixes 
suivants.

Les modes TrackPunch, QuickPunch et 
Destructive Punch utilisent une méthode 
différente pour numéroter les régions. Pour 
en savoir plus, reportez-vous à 
Numérotation des régions et des prises avec 
QuickPunch, page 371.

Format 
multicanal

Suffixes des fichiers et des 
régions

LCR L, C, R

Quad L, R, Ls, Rs

LCRS L, C, R, S

5.0 L, C, R, Ls, Rs
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Allocation de disque
Par défaut, Pro Tools enregistre les fichiers audio 
dans le dossier Audio Files qui se trouve dans le 
dossier de la session. La fenêtre Disk Allocation 
permet d'indiquer d'autres emplacements pour 
les fichiers audio de chaque piste audio.

Les disques durs pleins n'apparaissent pas dans 
la fenêtre Disk Allocation.

Pour accroître les performances du système, 
Pro Tools peut enregistrer et lire chaque piste à 
partir d'un disque dur différent. Vous pouvez 
aussi distribuer automatiquement les pistes qui 
viennent d'être créées vers plusieurs disques 
audio grâce à l'option Round Robin Allocation.

Navigation dans la fenêtre Disk Allocation

Pour redimensionner la fenêtre Disk Allocation :

" Faites glisser l'angle inférieur droit de la 
fenêtre selon la procédure standard de votre 
système d'exploitation (Windows ou Mac).

Pour faire défiler la fenêtre Disk Allocation vers le 
haut ou le bas :

" Appuyez sur Page Up ou Page Down.

Allocation de lecteurs audio dans votre 
système

Pour allouer les pistes aux disques audio de votre 
système :

1  Choisissez Setup > Disk Allocation.

2  Dans la fenêtre Disk Allocation, allouez un 
disque dur à chaque piste en cliquant dans la 
colonne Root Media Folder, puis en 
sélectionnant un volume dans la liste 
déroulante Disk Allocation.

Seuls les disques portant le suffixe R (lecture et 
enregistrement) peuvent être sélectionnés dans 
la fenêtre Disk Allocation. Pour plus 
d'informations, reportez-vous à la section 
Volumes Performance et Transfer, page 195.

Un dossier portant le nom de la session est créé 
sur chaque disque dur ; il contient des 
sous-dossiers pour les fichiers audio et les 
fichiers de fondu.

• Pour affecter une piste à un autre disque 
dur, cliquez sur la piste et sélectionnez le 
nom d'un disque.

5.1 L, C, R, Ls, Rs, LFE

6.0 L, C, R, Ls, Cs, Rs, LFE

6.1 L, C, R, Ls, Cs, Rs

7.0 L, Lc, C, R, Rc, Ls, Rs

7.1 L, Lc, C, R, Rc, Ls, Rs, LFE

Format 
multicanal

Suffixes des fichiers et des 
régions

Fenêtre Disk Allocation

Liste déroulante Disk Allocation
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• Pour allouer toutes les pistes à un même 
disque dur, maintenez enfoncée la touche 
Alt (Windows) ou Option (Mac) pendant 
que vous sélectionnez le nom d'un disque.

• Pour sélectionner plusieurs éléments, 
maintenez enfoncée la touche Maj pendant 
que vous cliquez sur le nom d'une piste 
(dans la colonne des pistes). Vous 
sélectionnez ainsi les pistes déjà 
sélectionnées et toutes les pistes 
intermédiaires.

• Pour sélectionner plusieurs éléments non 
consécutifs, maintenez la touche Ctrl 
(Windows) ou Pomme (Mac) enfoncée tout 
en cliquant sur le nom d'une piste dans la 
colonne des pistes.

3  Pour sauvegarder les fichiers audio enregistrés 
dans un dossier existant (sans créer un autre 
dossier pour la session), cochez la case 
Customize Allocation Options, puis cliquez sur 
le bouton Change et choisissez un dossier. Pour 
créer des sous-dossiers, cochez la case Create 
Subfolders for audio, video, and fade files.

4  Pour répartir automatiquement toutes les 
pistes créées sur les différents disques connectés 
à votre système, cochez la case Use Round Robin 
Allocation for New Tracks.

Si vous utilisez l'allocation à distribution 
automatique (Round Robin Allocation) et 
souhaitez que l'enregistrement audio s'effectue 
sur le disque de démarrage du système :

• Lancez le navigateur de l'espace de travail 
(Window > Workspace) et réglez 
l'indicateur de volume de votre système sur 
R (Enregistrement et lecture) Pour plus 
d'informations, reportez-vous à la section 
Désignation du volume de l'espace de 
travail, page 313.

5  Lorsque vous avez terminé, cliquez sur OK.

Enregistrement des paramètres 
d'allocation de disque

Pour enregistrer les paramètres d'allocation de 
disque et les utiliser dans de futures sessions, 
enregistrez la session sous forme de modèle. 
Pour en savoir plus, reportez-vous à Création de 
modèles de session personnalisés, page 109.

Allocation de disque et sessions 
multiplateforme

Pour assurer un fonctionnement multi 
plates-formes, il est nécessaire que les sessions 
Pro Tools sur Mac et leurs fichiers audio associés 
se trouvent sur des disques formatés Mac (HFS or 
HFS+). Les sessions Pro Tools sous Windows et 
leurs fichiers audio associés doivent se trouver 
sur des disques formatés Windows (NTFS ou 
FAT32). 

L'allocation à distribution automatique 
(Round Robin Allocation) n'est pas possible 
si vous utilisez des disques durs 
partitionnés.

Si vous souhaitez exclure des volumes 
montés individuels valides des passages 
d'allocation à distribution automatique, 
ouvrez le navigateur de l'espace de travail et 
protégez le volume en sélectionnant P 
(lecture seulement) ou T (transfert). Pour 
plus d'informations, reportez-vous à la 
section Indicateurs de volumes audio 
et vidéo, page 229.

Voir Enregistrement de copies de sessions 
Mac compatibles avec Windows, page 289 
et Partage des sessions créées sur différentes 
plates-formes, page 287.
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Réallocation des pistes

Lorsque vous ouvrez une session dans laquelle 
certains disques durs préalablement alloués ne 
sont plus disponibles (ou ne correspondent pas à 
la plate-forme de la session en cours), Pro Tools 
réalloue automatiquement les pistes au volume 
sur lequel le fichier de session est stocké. Le cas 
échéant, utilisez l'allocation de disques pour 
réallouer des pistes à d'autres disques.

Désignation du volume de l'espace de 
travail

La désignation du volume de l'espace de travail 
peut altérer la disponibilité du disque, ainsi que 
l'allocation de disque. Depuis le navigateur de 
l'espace de travail, sélectionnez Record 
(enregistrement), Playback (lecture) ou Transfer 
(transfert) pour les volumes. Si vous configurez 
un disque pour qu'il soit en lecture seule (Play 
Only ou Transfer), vous devez vérifier les pistes 
anciennement allouées à ce disque dans la 
fenêtre Disk Allocation. Pour plus 
d'informations, reportez-vous à la section 
Indicateurs de volumes audio et vidéo, 
page 229.

Enregistrement sur le volume 
système

Bien que Pro Tools autorise l'enregistrement sur 
le volume système, cette opération est en 
principe déconseillée. Les performances 
d'enregistrement et de lecture audio sur les 
disques durs système ne sont pas aussi bonnes 
que sur les disques durs non-système.

Enregistrez sur les disques système uniquement 
en cas de nécessité absolue, par exemple si votre 
système informatique n'a qu'un disque dur, ou si 
les autres disques sont saturés.

Par défaut, le volume système n'est pas compris 
dans l'allocation à distribution automatique 
(quel que soit la désignation du volume dans le 
navigateur de l'espace de travail). Pour inclure le 
volume système dans les allocations à 
distribution automatique, reportez-vous à 
Allocation de lecteurs audio dans votre système, 
page 311.

Allocation de l'espace de 
disque dur pour 
l'enregistrement
La préférence de fonctionnement Open Ended 
Record Allocation détermine l'espace disque dur 
alloué à l'enregistrement sur une ou plusieurs 
pistes dans Pro Tools.

Lorsque cette préférence d'allocation est réglée 
sur Use All Available Space, la totalité de l'espace 
disponible du disque est allouée à 
l'enregistrement. En réglant ce paramètre, vous 
pouvez enregistrer des prises ou des sessions plus 
longues. 

Sous Windows, vous pouvez effectuer des 
enregistrements et des écoutes à partir de 
disques HFS+ formatés Mac si l'option 
Digidesign HFS+ Disk Support est installée. 
Pour plus d'informations, consultez le 
manuel Mac HFS+ Disk Support Option 
Guide.

La réallocation de piste n'a aucune 
conséquence sur les données audio 
précédemment enregistrées. Elle n'affecte 
que l'emplacement de sauvegarde des 
nouvelles données audio.
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Cependant, lors de l'allocation de tout l'espace 
disponible, Pro Tools ut avoir besoin de plus de 
temps pour commencer l'enregistrement. Dans 
ce cas, essayez de réduire ce retard en allouant 
une durée spécifique à l'enregistrement. 

En général, la préférence Use All Available Space 
sollicite plus les disques durs. En plus de pouvoir 
enregistrer et réduire les retards, de nombreux 
systèmes voient leurs performances 
d'enregistrement globales s'améliorer lorsque 
l'option Open Ended Record Allocation est 
limitée.

Pour allouer une durée spécifique à 
l'enregistrement :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation.

2  Sous l'option Open Ended Record Allocation, 
sélectionnez Limit To et entrez un nombre de 
minutes à allouer.

Le nombre de minutes indiqué est alloué pour 
chaque piste préparée en enregistrement. 

3  Lorsque vous avez terminé, cliquez sur OK.

Contrôle de l'espace 
disponible

Pour gérer l'espace disponible de votre disque dur 
au cours d'une session Pro Tools :

" Choisissez Window > Disk Space.

Pour afficher l'espace disque disponible sous 
différents formats d'affichage :

" Choisissez View > Disk Space et sélectionnez 
un format (Text View ou Gas Gauge).

Modes d'enregistrement
Pro Tools dispose des quatre modes 
d'enregistrement audio suivants :

• Normal (Non destructif)

• Destructive

• Boucle

• QuickPunch :

• TrackPunch (Pro Tools HD uniquement)

• DestructivePunch (Pro Tools HD 
uniquement) :

Pour sélectionner le mode Record, procédez 
comme suit :

" Sélectionnez le mode Record dans le menu 
Options. Si le mode Record est sélectionné; 
Pro Tools est en mode d'enregistrement normal 
(Non destructif).

" Cliquez avec le bouton droit de la souris sur le 
bouton d'enregistrement de la fenêtre 
Transport, puis sélectionnez le mode Record du 
menu contextuel.

Vous pouvez également éviter ce retard en 
configurant Pro Tools en mode Record 
Pause (enregistrement en attente) avant de 
commencer à enregistrer. Pour plus 
d'informations, reportez-vous à la section 
Mode Record Pause, page 329.

Préférence de fonctionnement Option Open Ended 
Record Allocation
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L'aspect du bouton d'enregistrement change 
alors pour indiquer le mode Record comme 
suit : 

• Vide pour Normal (Non destructif) 

• D pour destructif

• Symbole de boucle pour l'enregistrement 
en boucle (Loop Record)

• P pour QuickPunch

• T pour TrackPunch (Pro Tools HD 
uniquement)

• DP pour DestructivePunch (Pro Tools HD 
uniquement)

Mode d'enregistrement normal 
(non destructif)

En mode d'enregistrement normal non 
destructif, Pro Tools effectue un enregistrement 
audio non-destructif, ce qui signifie que si vous 
enregistrez sur des régions existantes d'une piste, 
les données ne sont pas effacées de votre disque 
dur. Le nouvel et l'ancien enregistrement audio 
sont conservés sur votre disque dur et figurent 
sous forme de régions dans la liste des régions.

En mode d'enregistrement normal, la plage 
d'enregistrement se définit en sélectionnant une 
plage dans la règle ou dans la playlist d'une 
piste, ou en indiquant les points de début et de 
fin dans la fenêtre Transport. En l'absence de 
sélection, l'enregistrement commence au point 
où se trouve le curseur et se poursuit jusqu'à ce 
que vous cliquiez sur le bouton Stop dans la 
fenêtre Transport.

Les paramètres pré/post-roll permettent 
d'écouter les données audio jusque et au-delà 
des points de début et de fin, ce qui est utile pour 
le réenregistrement (voir Enregistrement audio 
fractionné, page 332).

Vous pouvez également parcourir les modes 
d'enregistrement Pro Tools si le Transport 
est interrompu, en cliquant sur le bouton 
d'enregistrement tout en maintenant la 
touche Démarrer (Windows) ou Ctrl (Mac) 
enfoncée.

Activation du mode d'enregistrement destructif

Pendant l'enregistrement, vous pouvez 
économiser l'espace disque en supprimant 
les prises inutiles (voir Suppression des 
régions inutiles, page 567) et en compactant 
les fichiers audio (voir Compactage d'un 
fichier audio, page 564).

Pour définir une plage d'enregistrement en 
la sélectionnant dans la playlist d'une piste, 
les sélections Timeline et Edit doivent être 
liées. Pour plus d'informations, 
reportez-vous à la section Activation ou 
désactivation de la liaison des sélections 
d'édition et de timeline, page 461.
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Mode d'enregistrement destructif

En mode d'enregistrement destructif, les 
données enregistrées sur des régions existantes 
remplacent définitivement les données audio 
qui s'y trouvaient déjà, ce qui permet de gagner 
de l'espace sur le disque dur. Toutefois, si vous 
disposez d'un espace suffisant sur le disque dur, 
il est généralement préférable d'utiliser le mode 
d'enregistrement non destructif de Pro Tools 
pour éviter d'effacer des enregistrements 
précédents.

Au niveau de la définition de la plage 
d'enregistrement et les paramètres pré- et 
post-roll, le mode destructif fonctionne comme 
le mode normal non destructif.

Contrairement aux autres modes 
d'enregistrement, il n'est pas possible d'annuler 
des prises en mode d'enregistrement destructif 
(voir Annulation d'une prise d'enregistrement, 
page 328).

Mode d'enregistrement en boucle

Le mode d'enregistrement en boucle permet 
d'enregistrer prise par prise (de façon non 
destructive) tandis que la même section audio se 
répète. Cette technique est pratique pour 
enregistrer rapidement plusieurs prises d'une 
partie sans perdre la spontanéité.

La partie mise en boucle et enregistrée (qui doit 
durer au minimum une seconde) est 
sélectionnée dans la règle ou dans la liste de 
diffusion d'une piste, ou en indiquant les points 
de début et de fin dans la fenêtre Transport. 
Le paramètre de pré-roll, s'il est activé, est utilisé 
pendant la première passe d'enregistrement, 

mais ensuite, à chaque passage de la boucle, les 
temps de pré/post-roll sont ignorés.

Lorsque vous utilisez le mode d'enregistrement 
en boucle, chaque prise successive apparaît 
comme une région dans la liste des régions et sa 
numérotation s'effectue de façon séquentielle. 
Les différentes prises, identiques en longueur et 
en heure de début, sont écoutées et se placent 
aisément dans la piste à l'emplacement correct, à 
l'aide du menu déroulant Matches (voir Ecoute 
des prises enregistrées dans la timeline, 
page 335).

QuickPunch :

QuickPunch permet l'enregistrement « à la 
volée », ce qui vous donne la possibilité, 
pendant la lecture, de passer instantanément et 
manuellement en mode enregistrement sur une 
piste audio déjà prête à l'enregistrement, puis de 
sortir du mode enregistrement en cliquant 
simplement sur le bouton d'enregistrement de la 
fenêtre Transport. L'enregistrement 
QuickPunch est non destructif.

En mode QuickPunch, Pro Tools commence 
l'enregistrement d'un nouveau fichier dès que la 
lecture commence et crée automatiquement des 
régions au sein de ce fichier à chaque point 
d'entrée et de sortie de l'enregistrement. Ces 
régions apparaissent dans la playlist de la piste. 

En mode d'enregistrement destructif, la 
présentation sous forme d'ondes n'est 
redessinée qu'après avoir interrompu 
l'enregistrement.

Pour définir une plage d'enregistrement en 
la sélectionnant dans la playlist d'une piste, 
les sélections Timeline et Edit doivent être 
liées. Pour plus d'informations, 
reportez-vous à la section Activation ou 
désactivation de la liaison des sélections 
d'édition et de timeline, page 461.

En mode d'enregistrement en boucle, la 
présentation sous forme d'ondes n'est 
redessinée qu'après avoir interrompu 
l'enregistrement.
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Le fichier audio complet apparaît dans la liste 
des régions avec les régions créées en mode 
QuickPunch. Vous pouvez ainsi, dans une 
même passe, effectuer jusqu'à 200 points 
d'entrée et de sortie d'enregistrement.

Bien qu'il soit possible d'enregistrer à la volée 
dans les autres modes en indiquant 
manuellement la plage d'enregistrement, seul le 
mode QuickPunch permet de sortir 
instantanément de l'enregistrement.

TrackPunch

(Pro Tools HD uniquement)

TrackPunch permet d'appliquer un punch-in ou 
un punch-out aux pistes ou de les sortir du mode 
de préparation à l'enregistrement sans 
interrompre l'enregistrement et la lecture 
en ligne. 

TrackPunch est un mode d'enregistrement non 
destructif. Lorsqu'une piste est en mode 
TrackPunch, Pro Tools commence à enregistrer 
un nouveau fichier lorsque la lecture démarre. 
Pendant la lecture, certaines ou la totalité des 
pistes en mode TrackPunch peuvent être 
activées ou désactivées en vue de 
l'enregistrement ou subir un punch-in ou un 
punch-out. 

TrackPunch crée automatiquement des régions 
dans ce fichier qui correspondent à chaque 
point d'entrée ou de sortie d'enregistrement. Ces 
régions apparaissent dans la playlist de la piste. 
Le fichier audio complet apparaît dans la liste 
des régions avec les régions créées en mode 
QuickPunch. Vous pouvez ainsi, dans une 
même passe, effectuer jusqu'à 200 points 
d'entrée et de sortie d'enregistrement. 

DestructivePunch

(Pro Tools HD uniquement)

Destructive Punch est un mode 
d'enregistrement destructif qui permet de lancer 
et d'arrêter instantanément l'enregistrement sur 
des pistes audio individuelles pendant la lecture, 
tout en conservant un fichier audio contigu 
pour chaque piste enregistrée. 

Modes d'enregistrement et MIDI

Outre les différents modes d'enregistrement, il 
existe également un bouton MIDI Merge dans la 
fenêtre Transport, qui détermine comment sont 
enregistrées les données MIDI. Lorsque le mode 
fusion (Merge) est activé, les nouvelles données 
MIDI viennent s'ajouter aux anciennes. Lorsque 
le bouton MIDI Merge est désactivé (mode 
Replace), les nouvelles données MIDI remplacent 
les anciennes.

L'enregistrement MIDI fonctionne de la même 
manière, que vous utilisiez un mode non 
destructif ou destructif. De plus, il n'est pas 
nécessaire que le mode QuickPunch ou le mode 
TrackPunch soit activé pour réaliser un 

Pour plus d'informations sur QuickPunch, 
consultez la section Enregistrement audio 
QuickPunch, page 367.

Pour plus d'informations sur TrackPunch, 
consultez la section Enregistrement audio 
TrackPunch, page 371.

Pour plus d'informations sur 
DestructivePunch, consultez la section 
Enregistrement audio DestructivePunch, 
page 381.

Fusion MIDI activée

Bouton MIDI Merge
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enregistrement à la volée en MIDI ; cette 
possibilité existe dans les modes non destructif 
et destructif.

Contrairement au mode d'enregistrement en 
boucle, l'activation/désactivation du mode 
MIDI Merge détermine si les données existantes 
sont remplacées ou fusionnées.

A moins que le mode MIDI Merge ne soit activé, 
l'enregistrement MIDI est destructif (bien qu'il 
soit possible d'annuler une passe 
d'enregistrement MIDI), soit par remplacement, 
soit par ajout d'une région. Il existe une 
exception à cette règle : lorsque le mode 
d'enregistrement en boucle est actif, les régions 
existantes de la piste sont remplacées par de 
nouvelles lorsque vous enregistrez de nouvelles 
données. Les anciennes régions demeurent 
intactes et restent disponibles dans la liste des 
régions, ainsi que dans la liste déroulante 
Matches. Dans le mode d'enregistrement en 
boucle, la fusion MIDI n'a aucun effet ; c'est 
pourquoi le bouton de fusion MIDI est estompé.

Enregistrement avec le 
métronome
Si vous envisagez de travailler avec des pistes 
MIDI ou des pistes d'instrument dans votre 
session ou si vous travaillez sur des données 
audio référencées en mesures et en temps, vous 
pouvez enregistrer vos pistes tout en écoutant le 
métronome Ceci garantit que les données 
enregistrées, MIDI et audio, seront bien en 
mesure tout au long de la session.

Lorsque les données de votre piste tombent bien 
en face des temps, vous pouvez bénéficier de 
certaines fonctions d'édition pratiques de 
Pro Tools, telles que la quantification des 
régions MIDI et audio, la quantification de notes 
MIDI individuelles, et le copier-coller de 
mesures et de parties de morceaux en 
mode Grid.

Création d'une piste de métronome 
(Click Track)

Pro Tools permet de créer une piste de 
métronome à l'aide du plug-inClick de DigiRack. 
Vous pouvez également effectuer cette 
opération à l'aide d'un périphérique MIDI.

Pour créer une piste de métronome avec le plug-in 
Click DigiRack :

" Choisissez Track > Create Click Track.

Les données enregistrées sans référence au 
métronome peuvent néanmoins être 
alignées sur une grille mesure/temps dans 
Pro Tools à l'aide de la commande Beat 
Detective (voir chapitre 24, Beat Detective). 
Sinon, utilisez la commande Identify Beat 
pour spécifier le tempo (voir Commande 
Identify Beat, page 588).

Vous pouvez enregistrer des données MIDI 
avec ou sans métronome et cliquer sur les 
marqueurs Bar|Beat ou encore générer une 
table des tempos et mesures à partir de 
celui-ci en utilisant la commande Beat 
Detective. Voir chapitre 24, Beat Detective.

Pour plus d'informations sur le plug-in 
Click, consultez le Guide des plug-in 
DigiRack. 
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Pro Tools crée une nouvelle piste d'entrée 
auxiliaire nommée Click (métronome) ; le 
plug-in Click est déjà inséré. Dans la fenêtre 
Edit, la hauteur de la piste de métronome est 
définie sur Mini. Vous pouvez créer plusieurs 
pistes de métronome. Chaque piste suivante est 
nommée de façon séquentielle. Par exemple, 
Click 1, Click 2 et Click 3.

Pour écouter le métronome lors de la lecture et 
de l'enregistrement, configurez les options de 
métronome (voir Options de métronome, 
page 319) et vérifiez que le celui-ci est activé 
(voir Activation du métronome, page 320).

Pour créer une piste de métronome en utilisant un 
périphérique MIDI :

1  Créez une piste d'entrée auxiliaire mono ou 
une piste d'instrument.

2  Effectuez l'une des opérations suivantes :

• Dans le sélecteur d'entrée de la piste, 
sélectionnez le chemin auquel le 
périphérique MIDI est connecté. 

– ou –

• Insérez un plug-in d'instrument dans la 
piste (par exemple, Xpand! de Digidesign).

3  Configurez les options de la boîte de dialogue 
Click/Countoff et veillez à sélectionner le port 
du périphérique MIDI ou du plug-in 
d'instrument dans le menu déroulant Output 
(voir Options de métronome, page 319).

4  Activez le métronome (consultez Activation 
du métronome, page 320).

Options de métronome

Pro Tools propose des options et des 
commandes permettant l'utilisation d'un 
métronome. Les étapes suivantes décrivent les 
procédures de configuration et d'activation d'un 
métronome avec le plug-in ou un appareil MIDI.

Pour configurer les options du métronome :

1  Accédez à la boîte de dialogue Click/Countoff 
Options en effectuant l'une des procédures 
suivantes :

• Sélectionnez Setup > Click.

– ou –

• Cliquez deux fois sur le bouton du 
métronome ou du décompte dans la 
fenêtre Transport.

2  Effectuez une des opérations suivantes dans la 
boîte de dialogue Click/Countoff Options :

• Si vous utilisez le pIug-in DigiRack Click, 
sélectionnez None dans la liste déroulante 
Output.

– ou –

• Si vous utilisez un métronome avec des 
données MIDI, choisissez dans le menu 
déroulant Output le numéro du port 
(périphérique) et le canal sur lequel jouera 
le métronome. 

3  Spécifiez la note, la vélocité et la durée des 
notes accentuées et non accentuées. 

Boîte de dialogue Click/Countoff Options

Le cas échéant, vous pouvez également jouer 
les nouvelles notes sur un contrôleur de 
clavier MIDI.
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Lorsque vous entendez le métronome dans vos 
sessions Pro Tools, la note accentuée correspond 
au premier temps de chaque mesure ; aux autres 
temps correspondent des notes non accentuées.

4  Indiquez si le métronome doit être entendu 
pendant la lecture et l'enregistrement (During 
play and record), seulement pendant 
l'enregistrement (Only during record) ou 
seulement pendant le décompte (Only during 
countoff).

5  Si vous utilisez un décompte, indiquez le 
nombre de mesures devant être décomptées. 
Si vous souhaitez entendre le décompte 
seulement pendant l'enregistrement, cochez 
l'option Countoff only when recording.

6  Cliquez sur OK.

Activation du métronome

Les pistes de métronome doivent être activées 
pour être entendues lors de la lecture ou de 
l'enregistrement.

Pour activer un métronome à partir du menu MIDI :

" Sélectionnez Options > Click.

Pour activer le métronome dans la fenêtre 
Transport :

1  Affichez les commandes MIDI dans la fenêtre 
Transport en procédant comme suit :

• Choisissez View > Transport > MIDI 
Controls.

• Pour afficher les commandes MIDI, 
maintenez enfoncée la touche Ctrl 
(Windows) ou Pomme (Mac) pendant que 
vous cliquez sur le bouton Développer/ 
réduire (+) dans la fenêtre Transport.

• Pour afficher les commandes MIDI et les 
compteurs, maintenez enfoncée la touche 
Alt (Windows) ou Pomme (Mac) pendant 
que vous cliquez sur le bouton 

Développer/réduire (+) dans la fenêtre 
Transport.

2  Dans la fenêtre Transport, cliquez sur le 
bouton du métronome pour le mettre en 
surbrillance.

3  Pour utiliser le décompte pendant 
l'enregistrement ou la lecture, cliquez sur le 
bouton de décompte dans la fenêtre Transport 
pour le mettre en surbrillance.

Entendre le décompte avant l'enregistrement 
aide les musiciens à commencer à jouer au bon 
moment et en rythme. Le bouton de décompte 
de la fenêtre Transport indique le nombre de 
mesures décomptées.

Fenêtre Transport affichant les contrôles MIDI

Bouton du métronome activé

Décompte activé

Le décompte est ignoré lorsque Pro Tools est 
en ligne et synchronisé avec un timecode 
SMPTE.

Bouton Développer/réduire (+)

Bouton du métronome

Bouton de décompte
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Réglage du tempo et de la 
métrique par défaut

Réglage de la métrique par défaut

Lorsque vous ouvrez une nouvelle session de 
Pro Tools, la métrique (type de mesure) par 
défaut est 4/4. Si vous envisagez d'enregistrer 
avec le métronome et que vous travaillez avec 
une métrique différente, modifiez-la en 
conséquence.

Si la métrique d'une session ne correspond pas à 
celle de la musique que vous enregistrez, les 
notes accentuées du métronome ne seront pas 
en mesure avec ce que vous jouez ; par 
conséquent, les données enregistrées risquent 
de ne pas s'aligner en termes de mesures/temps 
dans la fenêtre Edit.

Les changements de métrique, qui peuvent 
intervenir à tout moment dans une session 
Pro Tools, sont mémorisés dans la piste de 
métrique et apparaissent dans la règle de 
métrique. Pour plus d'informations sur 
l'insertion et l'édition des événements de 
métrique, consultez la section Evénements de 
métrique, page 592.

Pour définir la métrique par défaut d'une session :

1  Cliquez deux fois sur le bouton Current Meter 
dans la fenêtre Transport.

2  Entrez la métrique utilisée dans la session et 
entrez 1|1|000 comme emplacement (Location), 
de façon à ce que l'événement de métrique ainsi 
inséré remplace la métrique par défaut.

3  Sélectionnez une valeur de note pour le temps 
à partir du menu déroulant Click.

4  Cliquez sur OK pour insérer le nouvel 
événement de métrique.

Réglage du tempo par défaut

Lorsque vous ouvrez une session dans Pro Tools, 
le tempo par défaut est de 120 BPM. Si vous 
envisagez d'enregistrer avec le métronome et 
que vous travaillez avec un tempo différent de 
120 bpm, réglez-le en conséquence.

Bouton Current Meter

Fenêtre Meter Change

Les changements de tempo, qui peuvent 
intervenir à tout moment dans une session 
Pro Tools, sont mémorisés dans la piste de 
tempo et apparaissent dans la règle de 
tempo. Pour plus d'informations sur 
l'insertion et l'édition des événements de 
tempo, consultez la section Tempo, 
page 570.



Guide de référence Pro Tools322

Pour insérer un événement de tempo par défaut :

1  Cliquez deux fois sur le marqueur de début de 
morceau dans la fenêtre Edit (voir Marqueur de 
début de morceau, page 569).

2  Saisissez la valeur de BPM à utiliser pour la 
session. 

3  Définissez l'emplacement (Location) sur 
1|1|000, de façon à ce que la valeur de tempo 
ainsi insérée remplace celle par défaut.

4  Sélectionnez une valeur de note pour la 
mesure à partir du menu contextuel Resolution.

5  Cliquez sur OK.

Utilisation du mode tempo manuel

En mode Manual Tempo, Pro Tools ignore les 
événements de tempo enregistrés sur la piste de 
tempo et joue un tempo manuel à la place. 
Vous pouvez définir le tempo avec le curseur de 
tempo ou, si vous n'êtes pas certain du tempo, 
en battant le tempo grâce au bouton Tap.

Vous pouvez régler le tempo manuel en cours de 
lecture, mais celle-ci sera alors momentanément 
interrompue.

Pour régler le tempo manuel à l'aide du curseur de 
tempo :

1  Pour faire apparaître les commandes MIDI 
dans la fenêtre Transport, sélectionnez View > 
Transport > MIDI Controls.

2  Dans la fenêtre Transport, cliquez sur le 
bouton Tempo Ruler Enable (chef d'orchestre) 
pour qu'il n'apparaisse plus en surbrillance. 
Pro Tools passe en mode Manual Tempo. Dans 
ce mode, tous les événements de tempo 
enregistrés sur la piste de tempo sont ignorés.

3  Pour baser la valeur BPM sur un élément autre 
que la noire par défaut, cliquez sur le sélecteur 
de résolution du tempo et sélectionnez une 
autre valeur.

4  Pour entrer un nouveau tempo, faites glisser le 
curseur horizontal de tempo dans la fenêtre 
Transport.

Pour affiner la résolution du curseur de tempo, 
appuyez sur la touche Ctrl (Windows) ou 
Pomme (Mac) pendant que vous le faites glisser.

Pour quitter le mode Manual Tempo et activer la 
piste tempo :

" Dans la fenêtre Transport, cliquez sur le 
bouton Tempo Ruler Enable (chef d'orchestre) 
(il ne s'affiche plus en surbrillance).

Fenêtre Tempo Change

Mode de tempo manuel activé

Curseur de tempo

Bouton d'activation
de la règle de tempo

Sélecteur de résolution

Curseur de tempo
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Pour régler le tempo manuel à l'aide du 
battement :

1  Pour faire apparaître les commandes MIDI 
dans la fenêtre Transport, sélectionnez View > 
Transport > MIDI Controls.

2  Dans la fenêtre Transport, cliquez sur le 
bouton Tempo Ruler Enable (chef d'orchestre) 
pour qu'il n'apparaisse plus en surbrillance. 
Pro Tools passe en mode Manual Tempo. Dans 
ce mode, tous les événements de tempo 
enregistrés sur la piste de tempo sont ignorés.

3  Effectuez l'une des opérations suivantes :

• Cliquez dans le champ du tempo pour le 
faire apparaître en surbrillance et appuyez 
sur la touche T de votre clavier de façon 
répétée au rythme du nouveau tempo.

– ou –

• Cliquez dans le champ Tempo pour le faire 
apparaître en surbrillance et battez le 
tempo en jouant une note de façon répétée 
sur le clavier de votre contrôleur MIDI.

Pour calculer le nouveau tempo, Pro Tools fait la 
moyenne des huit derniers battements (ou 
moins) afin de déterminer le tempo. La valeur 
BPM calculée apparaît dans le champ Tempo de 
la fenêtre Transport.

Pour verrouiller le nouveau tempo :

" Désactivez le mode Manual Tempo de 
Pro Tools en cliquant sur le bouton Tempo Ruler 
Enable (chef d'orchestre), puis insérez le 
nouveau tempo comme tempo par défaut pour 
le marqueur de début de morceau.
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Chapitre 15 : Enregistrement audio

Enregistrement d'une piste 
audio
Dans Pro Tools, vous enregistrez de l'audio sur 
des pistes audio. Ces pistes peuvent être mono, 
stéréo ou multicanal selon les spécificités de la 
source d'enregistrement. 

Lorsque vous enregistrez une source mono, 
faites-le sur une seule piste audio mono dans 
Pro Tools. Un seul fichier audio mono est écrit 
sur le disque ; il apparaît en tant que région dans 
la playlist et dans la liste des régions.

Lorsque vous enregistrez une source stéréo, 
faites-le sur une seule piste audio stéréo dans 
Pro Tools. Un fichier audio mono est inscrit sur 
le disque pour chaque canal d'une piste stéréo : 
un pour le canal gauche et un pour le canal 
droit. Ces fichiers apparaissent en tant que 
région stéréo dans la playlist de la piste et dans la 
liste des régions.

L'enregistrement d'une source multicanal sur 
une piste de même type (Pro Tools HD 
uniquement) est similaire à l'enregistrement de 
pistes audio stéréo. Un seul fichier audio mono 
est écrit pour chaque canal de la piste ; il 
apparaît en tant que région multicanal dans la 
playlist et dans la liste des régions.

Pour configurer une piste audio en 
enregistrement :

1  Connectez vos sources de son mono ou stéréo 
aux sorties de votre interface audio Pro Tools.

2  Choisissez Setup > Hardware et procédez 
comme suit :

• Sélectionnez l'interface audio à utiliser 
pour l'enregistrement de votre source.

• Sélectionnez le format de canal 
correspondant au nombre de canaux de 
votre source.

3  Créez une piste audio mono ou stéréo 
(voir Création de pistes, page 146).

4  Renommez la piste avec un nom descriptif 
pour votre source (par exemple « Guitare » ou 
« Voix ») ou utilisez le nom de piste par défaut.

Pour plus d'informations sur les pistes 
multicanaux, reportez-vous à la section 
Pistes audio multicanaux, page 882.

Certaines interfaces audio Pro Tools 
(comme Mbox 2) ne possèdent que deux 
canaux à paramétrer sur analogue ou 
numérique uniquement.
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5  Assignez une entrée de matériel (source 
d'enregistrement) en effectuant l'une des 
opérations suivantes :

• Dans la fenêtre Mix, sélectionnez l'entrée 
de matériel correspondant à votre source à 
partir du sélecteur de chemin d'entrée de 
la piste.

– ou –

• Dans la fenêtre Edit avec vue I/O, 
sélectionnez l'entrée de matériel 
correspondant à votre source à partir du 
sélecteur de chemin d'entrée de la piste.

6  Assignez une sortie matériel en effectuant 
l'une des opérations suivantes :

• Dans la fenêtre Mix, sélectionnez la sortie 
de matériel pour l'écoute (par exemple A 
1-2) à partir du sélecteur de chemin de 
sortie de la piste.

– ou –

• Dans la fenêtre Edit avec vue I/O, 
sélectionnez la sortie de matériel pour 
l'écoute (par exemple A 1-2) à partir du 
sélecteur de chemin de sortie de la piste.

7  Activez la piste pour enregistrement en 
procédant comme suit :

• Dans la fenêtre Mix, cliquez sur le bouton 
Record Enable de la piste.

– ou –

Sélecteur de chemin d'entrée (fenêtre Mix)

Sélecteur de chemin d'entrée (fenêtre Edit)

Sélecteur de chemin de sortie (fenêtre Mix)

Sélecteur de chemin de sortie (fenêtre Edit)

Bouton d'activation en enregistrement de la piste 
(fenêtre Mix)

 
Activa-
tion de 
l'enregis-
trement
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• Dans la fenêtre Edit, cliquez sur le bouton 
Record Enable de la piste.

Le bouton Record Enable clignote en rouge, le 
fader est allumé en rouge et l'indicateur 
d'activation de la fenêtre Transport vire au rouge 
(indiquant que le mode d'enregistrement est 
activé pour au moins une piste).

8  Réglez le niveau de sortie de votre source 
sonore (instrument, console de mixage ou 
préamplificateur). Surveillez les niveaux des 
afficheurs de la piste dans Pro Tools pour vérifier 
que vous obtenez le signal le plus élevé possible 
sans écrêtage.

9  Effectuez l'une des opérations suivantes :

• Dans la fenêtre Mix, réglez le niveau de la 
piste et les faders de panoramique. Ces 
paramètres affectent l'écoute et non les 
données enregistrées.

– ou –

• Dans la fenêtre Output de la piste, réglez le 
niveau et le panoramique de la piste. Ces 
paramètres affectent l'écoute et non les 
données enregistrées. Voir Fenêtres Output 
pour les pistes et les départs, page 744.

Pour enregistrer une piste audio :

1  Avec Pro Tools HD, assurez-vous que l'option 
Delay Compensation est désactivée dans le 
menu Options.

2  Assurez-vous que les éléments suivants sont 
désélectionnés dans le menu Options : 
Destructive Record, Loop Record, QuickPunch, 
TrackPunch et DestructivePunch.

3  Activez le métronome et le décompte dans la 
fenêtre Transport pour enregistrer avec ces 
fonctions (voir Enregistrement avec le 
métronome, page 318).

4  Indiquez la métrique et le tempo par défaut de 
la session si vous utilisez ce type d'informations 
(voir Réglage du tempo et de la métrique par 
défaut, page 321).

5  Dans la fenêtre Transport, cliquez sur le 
bouton de retour à zéro pour vous assurer que 
l'enregistrement commencera au début de la 
session.

6  Dans la fenêtre Transport, cliquez sur le 
bouton d'enregistrement pour préparer 
Pro Tools à l'enregistrement (mode de 
préparation pour l'enregistrement). Le bouton 
d'enregistrement clignote.

7  Pour commencer l'enregistrement, cliquez sur 
le bouton de lecture de la fenêtre Transport. 
Avec l'option Countoff, Pro Tools décompte le 
nombre de mesures spécifié avant de 
commencer l'enregistrement.

8  Pour interrompre l'enregistrement, cliquez sur 
le bouton d'arrêt de la fenêtre Transport.

Les nouvelles données audio enregistrées sont 
écrites sur le disque et apparaissent sous la forme 
d'une région audio dans la playlist de la piste et 
dans la liste de régions.

Bouton d'activation en enregistrement de la piste 
(fenêtre Edit)

Activation de 
l'enregistre-
ment

Dans la plupart des cas, Digidesign 
recommande l'enregistrement sans 
compensation de retard. Pour plus 
d'informations, reportez-vous à la section 
Compensation de retard, page 757.
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Pour lire la piste audio :

1  Cliquez sur le bouton Record Enable de la 
piste audio pour annuler la préparation en 
enregistrement. Le fader de volume de la piste 
fonctionne à présent comme contrôle du niveau 
de lecture.

2  Dans la fenêtre Transport, cliquez sur le 
bouton de retour à zéro pour vous assurer que la 
lecture commencera au début de la session.

3  Cliquez sur le bouton de lecture de la fenêtre 
Transport pour commencer la lecture. Réglez le 
volume de la piste et les faders de panoramique.

Annulation ou arrêt de l'enregistrement 
audio

Après avoir enregistré une piste audio et lorsque 
le Transport est arrêté, vous pouvez annuler la 
prise d'enregistrement.

Pour annuler un enregistrement audio :

" Après avoir arrêté le Transport, choisissez Edit 
> Undo Record Audio. 

La playlist des pistes revient à son état précédent 
et les matériaux sont supprimés comme suit :

• En mode d'enregistrement normal, seule la 
prise la plus récente est annulée.

• En mode d'enregistrement en boucle, 
toutes les prises enregistrées passe après 
passe sont annulées.

• En mode TrackPunch, DestructivePunch 
ou QuickPunch, tous les enregistrements 
fractionnés de la dernière passe 
d'enregistrement sont annulés.

Si l'opération est irréversible, l'outil 
d'annulation correspondant s'affiche en grisé 
dans le menu.

Annulation d'une prise d'enregistrement

Il est possible d'annuler la prise en cours 
d'enregistrement. Les données audio 
enregistrées jusqu'à ce point sur votre disque dur 
sont alors supprimées, de même que les régions 
correspondantes dans la playlist de la piste et la 
liste de régions. En mode d'enregistrement en 
boucle, toutes les prises enregistrées passe après 
passe sont annulées. Il est impossible d'annuler 
un enregistrement en mode Destructive. 

Pour annuler une prise en cours d'enregistrement :

" Appuyez sur Ctrl+point (.) (Windows) ou 
Pomme+point (.) (Mac) avant l'arrêt du 
transport.

Enregistrement de plusieurs 
pistes audio

Pro Tools peut enregistrer simultanément plu-
sieurs pistes audio, dans les limites du nombre 
de pistes imposées par votre système. Pour enre-
gistrer sur plusieurs pistes, préparez en enregis-
trement les pistes, puis lancez l'enregistrement. 
Procédez comme décrit dans la section Enregis-
trement d'une piste audio, page 325.

Si une piste préparée à l'enregistrement est 
en mode d'écoute Auto Input, vous 
entendrez l'entrée si le transport est arrêté. 
La piste passe automatiquement en mode de 
lecture lorsque vous appuyez sur Play, puis 
retourne en mode Input à l'arrêt ou à 
l'enregistrement à la volée. Pour plus 
d'informations, reportez-vous à la section 
Mode d'écoute Auto Input, page 305.

Si vous annulez une passe d'enregistrement 
lors d'un enregistrement, Pro Tools supprime 
de la session toutes les passes 
d'enregistrement annulées précédemment et 
vous offre la possibilité de supprimer la passe 
d'enregistrement précédente de votre 
dispositif.
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Pour chaque piste en mode d'enregistrement, un 
nouveau fichier audio est écrit sur le disque et 
une nouvelle région créée. Celle-ci apparaît dans 
la playlist et dans la liste de régions.

Raccourcis pour 
l'enregistrement
Avec Pro Tools, pour préparer une piste à 
l'enregistrement, vous pouvez cliquez sur le 
bouton d'enregistrement de la fenêtre Transport 
ou Edit ou démarrer l'enregistrement avec les 
raccourcis clavier suivants :

• Appuyez sur F12 pour lancer immédiatement 
l'enregistrement.

• Appuyez sur Ctrl+Barre d'espace (Windows) 
ou sur Pomme+Barre d'espace (Mac) pour 
lancer l'enregistrement.

• Appuyez sur la touche 3 du pavé numérique 
(lorsque le mode du pavé numérique est réglé 
sur Transport).

Mode Record Pause
Lorsque vous enregistrez un grand nombre de 
pistes ou de canaux, ou lorsque vous lisez un 
grand nombre de pistes pendant 
l'enregistrement, Pro Tools peut prendre un peu 
plus de temps à commencer effectivement 
l'enregistrement. Pour éviter ce retard, placez 
Pro Tools en mode Record Pause (attente en 
enregistrement) avant de commencer à 
enregistrer.

Pour enregistrer à partir du mode Record Pause :

1  Cliquez sur le bouton d'enregistrement de la 
fenêtre Transport. Le bouton d'enregistrement 
clignote.

2  Pour placer Pro Tools en mode d'attente en 
enregistrement (Record Pause), maintenez 
enfoncée la touche Alt (Windows) ou Option 
(Mac) dans la fenêtre Transport pendant que 
vous cliquez sur le bouton de lecture. Les 
boutons de lecture et d'enregistrement 
clignotent.

3  Pour commencer l'enregistrement 
instantanément, cliquez sur le bouton de 
lecture. 

4  Cliquez sur le bouton d'arrêt pour arrêter 
l'enregistrement.

Sous Mac, la touche F12 ne permet 
l'enregistrement que si la fonction 
Dashboard est désactivée ou réaffectée. 
Pour obtenir plus d'informations, 
reportez-vous au Guide de démarrage.

Sous Mac, la combinaison de touches 
Pomme+Barre d'espace ne permet 
l'enregistrement que si la fonction 
Dashboard est désactivée ou réaffectée. 
Pour obtenir plus d'informations, 
reportez-vous au Guide de démarrage.

Pour démarrer un enregistrement à 
demi-vitesse, appuyez sur Ctrl+Maj+Barre 
d'espace (Windows) ou sur Pomme+Maj+ 
Barre d'espace (Mac). Pour en savoir plus, 
reportez-vous à la section Enregistrement et 
lecture à demi-vitesse, page 345.

Lors de la synchronisation avec le timecode, 
utilisez le mode Record Pause pour 
enregistrer ou lire un grand nombre de 
pistes. Cela accélère la synchronisation avec 
le timecode.
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Enregistrement de prises 
supplémentaires
Après avoir enregistré sur une piste audio, vous 
pouvez enregistrer d'autres prises sur cette 
même piste. Cependant, si vous enregistrez ces 
prises supplémentaires en mode destructif, les 
données audio des prises précédentes 
enregistrées sur le disque dur seront 
définitivement détruites.

Pour conserver les données audio des prises 
précédentes, enregistrez en mode normal (non 
destructif).

Pour enregistrer de façon non destructive une 
nouvelle prise sur la même piste :

1  Assurez-vous que les éléments suivants sont 
désélectionnés : Destructive Record, Loop 
Record, QuickPunch, TrackPunch et 
DestructivePunch.

2  Activez la piste pour l'enregistrement.

3  Effectuez l'une des opérations suivantes :

• Dans la fenêtre Transport, cliquez sur le 
bouton de retour à zéro pour vous assurer 
que l'enregistrement commencera au début 
de la session.

– ou –

• Si Options > Link Timeline and Edit 
Selection est actif, cliquez n'importe où 
dans la playlist de la piste pour pouvoir 
enregistrer à partir de cet endroit.

4  Dans la fenêtre Transport, cliquez sur le 
bouton d'enregistrement pour préparer 
Pro Tools à l'enregistrement.

5  Cliquez ensuite sur Lecture pour lancer 
l'enregistrement.

6  Cliquez sur le bouton d'arrêt pour arrêter 
l'enregistrement.

Un nouveau fichier audio enregistré est écrit sur 
le disque ; il apparaît sous forme d'une région 
audio dans la playlist de la piste et dans la liste 
de régions.

L'ancienne prise est conservée sur votre disque 
dur, et figure toujours sous forme de région dans 
la liste des régions.

Pour enregistrer de façon destructive sur une prise 
précédente :

1  Sélectionnez Options > Destructive Record. 
Lorsque vous travaillez en mode 
d'enregistrement destructif, un « D » s'inscrit 
dans le bouton Record.

2  Activez la piste pour l'enregistrement.

3  Effectuez l'une des opérations suivantes :

• Dans la fenêtre Transport, cliquez sur le 
bouton de retour à zéro pour vous assurer 
que l'enregistrement commencera au début 
de la piste.

– ou –

Pour plus d'informations sur les noms 
attribués aux fichiers audio et aux régions 
dans le cadre de nouvelles prises, consultez 
la section Nom des pistes par défaut, 
page 310.

Pour enregistrer une partie spécifique de la 
piste, avec des points de début et de fin 
précis, consultez la section Enregistrement 
audio fractionné, page 332.

Mode d'enregistrement destructif actif

Destructive 

Record
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• Si Options > Link Timeline and Edit 
Selection est actif, cliquez n'importe où 
dans la playlist de la piste pour pouvoir 
enregistrer à partir de cet endroit.

4  Dans la fenêtre Transport, cliquez sur le 
bouton d'enregistrement pour préparer 
Pro Tools à l'enregistrement.

5  Cliquez ensuite sur Lecture pour lancer 
l'enregistrement.

6  Une fois terminé, cliquez sur le bouton d'arrêt 
pour arrêter l'enregistrement.

Les données audio de la nouvelle prise sont 
écrites sur le disque, remplaçant de façon 
définitive les données précédentes. Les 
nouvelles données viennent remplacer les 
données d'origine dans la région existante. 
La région n'est pas renommée.

Ajout de nouvelles données à la fin 
d'une piste

Vous pouvez également ajouter de nouvelles 
données à la fin d'une piste. 

Pour ajouter des éléments à la fin de la piste :

1  Effectuez l'une des opérations suivantes :

• Cliquez sur le bouton Fin de la fenêtre 
Transport pour localiser la fin de la piste 
(cela permet de localiser la fin de la 
session).

– ou –

• Placez le curseur à la fin de la dernière 
région de la piste à l'aide de la touche de 
tabulation.

2  Commencez l'enregistrement à partir de cet 
emplacement. 

Pro Tools ajoute les nouveaux éléments à la fin 
de la piste. Si vous travaillez en mode 
d'enregistrement destructif, les nouvelles 
données audio s'ajoutent au fichier audio et à la 
région à partir de la première prise. Si vous 
travaillez en mode d'enregistrement non 
destructif, un nouveau fichier et une nouvelle 
région sont créés.

Enregistrement vers une nouvelle 
playlist

Plutôt que d'écraser des régions audio existantes, 
il existe une autre manière d'enregistrer de 
nouvelles prises sur la même piste de façon non 
destructive. Pour ce faire, il suffit de créer une 
playlist pour la piste, puis d'effectuer 
l'enregistrement comme précédemment.

Les pistes peuvent posséder plusieurs playlists 
d'édition, chacune mémorisant une liste des 
régions et l'ordre dans lequel les lire. Comme les 
playlists suivent les groupes, le fait de dupliquer 
ou de sélectionner une autre playlist pour une 
piste du groupe activé portera sur toutes les 
pistes du groupe.

Pour enregistrer vers une nouvelle playlist de 
piste :

1  Cliquez sur le sélecteur de playlist de la piste et 
sélectionnez New dans le menu contextuel.

2  Entrez le nouveau nom de la playlist. 

Pour enregistrer une partie spécifique de la 
piste, avec des points de début et de fin 
précis, consultez la section Enregistrement 
audio fractionné, page 332.

Sélecteur de playlist
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3  Cliquez sur OK.

Lorsqu'une playlist est créée, son nom remplace 
celui de la piste. Les noms des nouveaux fichiers 
audio et des nouvelles régions sont basés sur le 
nom de la piste.

4  Activez la piste pour l'enregistrement.

5  Dans la fenêtre Transport, cliquez sur le 
bouton de retour à zéro pour vous assurer que 
l'enregistrement commencera au début de la 
session.

6  Dans la fenêtre Transport, cliquez sur le 
bouton d'enregistrement pour préparer 
Pro Tools à l'enregistrement.

7  Cliquez ensuite sur Lecture pour lancer 
l'enregistrement.

8  Cliquez sur le bouton d'arrêt pour arrêter 
l'enregistrement.

Un nouveau fichier audio enregistré est écrit sur 
le disque ; il apparaît sous forme d'une région 
audio dans la nouvelle playlist de la piste et dans 
la liste de régions.

La sélection d'une playlist précédente à partir du 
sélecteur de playlist de la piste rappelle ses 
régions tel qu'elles apparaissaient auparavant 
dans la piste. A tout moment, toutes les régions 
de toutes les playlists sont disponibles dans la 
liste des régions et peuvent être 
mélangées/combinées entre playlists et pistes.

Enregistrement audio 
fractionné
Pour définir une région d'enregistrement sur 
une playlist ou remplacer une partie de piste 
enregistrée, vous pouvez définir un point d'entrée 
d'enregistrement en spécifiant la région à 
enregistrer avant de commencer 
l'enregistrement.

Bien qu'il existe plusieurs manières de définir les 
plages d'enregistrement et de lecture (voir 
Définition des points d'enregistrement 
fractionné et de boucle, page 338), la plus 
simple est peut-être de sélectionner au sein de la 
playlist la région à enregistrer.

Lors de l'enregistrement, la lecture commence 
dès le point déterminé par la durée de pré-roll (si 
la fonction correspondante est activée) et se 
poursuit jusqu'au point de début (point d'entrée 
de l'enregistrement), là où démarre 
effectivement l'enregistrement. Lorsque le point 
de fin est atteint (point de sortie de 
l'enregistrement), Pro Tools sort 
automatiquement du mode d'enregistrement et 
continue la lecture pendant la durée de post-roll 
définie. Cette fonction automatisée de point 
d'entrée et de sortie de l'enregistrement 
constitue un moyen puissant et précis 
d'enregistrer ou de réenregistrer sur une piste.

Pour plus d'informations sur les playlists et 
leur édition, consultez la section Playlists, 
page 413.

Pour entrer et sortir manuellement des 
pistes audio préparées en enregistrement 
pendant la lecture, reportez-vous au 
chapitre 17, Techniques d'enregistrement 
fractionné avancées.

Pour définir une plage d'enregistrement par 
sélection dans une playlist, les sélections 
d'édition et de timeline doivent être liées 
(sélectionnez Options > Link Timeline and 
Edit Selection).
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Pour effectuer un enregistrement fractionné sur 
une piste audio :

1  Effectuez l'une des opérations suivantes :

• Pour effectuer un enregistrement non 
destructif, assurez-vous de ne pas activer 
Options > Destructive Record.

– ou –

• Si vous avez décidé de remplacer les 
données de la région spécifiée, activez 
Options > Destructive Record.

2  Activez la piste pour l'enregistrement.

3  Sélectionnez Options > Link Timeline and 
Edit Selection.

4  A l'aide du sélecteur, faites glisser la playlist de 
la piste jusqu'à ce que la sélection englobe la 
plage souhaitée (voir Définition des points 
d'enregistrement fractionné et de boucle, 
page 338).

5  Pour écouter ce qui se trouve déjà sur la piste 
jusqu'au point d'entrée, ou après le point de 
sortie de l'enregistrement, activez les pré et 
post-roll et entrez leurs durées (voir Définition 
des paramètres de pré et post-roll, page 341).

6  Dans la fenêtre Transport, cliquez sur le 
bouton d'enregistrement pour préparer 
Pro Tools à l'enregistrement.

7  Cliquez ensuite sur Lecture pour lancer 
l'enregistrement.

Pro Tools commence l'enregistrement à partir 
du point d'entrée. En cas de pré-roll, 
l'enregistrement commence lorsque le point 
d'entrée est atteint. Celui-ci se poursuit jusqu'à 
ce que le point de sortie de l'enregistrement soit 
atteint, sauf si vous interrompez manuellement 
l'enregistrement. Si le post-roll est activé, la 
lecture se poursuit pendant le temps spécifié.

Si vous travaillez en mode non destructif, un 
nouveau fichier audio est écrit sur le disque et 
une nouvelle région apparaît dans la piste et 
dans la liste des régions.

Si vous travaillez en mode destructif, les 
nouvelles données audio remplacent les 
précédentes dans le fichier audio et la région 
existants.

Ecoute pendant les enregistrements 
fractionnés

Pro Tools propose deux modes d'écoute pour 
l'enregistrement : Auto Input et Input Only. 

Enregistrement audio en 
boucle
Pro Tools offre un mode d'enregistrement en 
boucle qui permet d'enregistrer prise après prise 
tandis que la même section audio se répète sans 
cesse. Cette technique est pratique pour 
enregistrer rapidement plusieurs prises d'une 
partie sans perdre la spontanéité.

Lorsque vous effectuez un enregistrement en 
boucle, il faut commencer par indiquer les 
points de début et de fin de la boucle. Bien qu'il 
existe plusieurs façons de paramétrer les plages 
d'enregistrement et de lecture (voir Définition 

Si vous enregistrez en n'importe quel mode 
autre que le mode destructif, les 
enregistrements fractionnés ne remplacent 
pas définitivement les données enregistrées. 
Si vous avez décidé de remplacer les données 
de la région spécifiée (et de ne conserver que 
la prise la plus récente), activez Options > 
Destructive Record.

Pour plus d'informations, reportez-vous à la 
section Mode d'écoute Auto Input, 
page 305.
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des points d'enregistrement fractionné et de 
boucle, page 338), le plus simple consiste à 
sélectionner la portée pour qu'elle passe en 
boucle dans la playlist de la piste (veillez à 
activer les options > Link Timeline et Edit 
Selection).

Le paramètre de pré-roll, s'il est activé, est utilisé 
lors de la première passe d'enregistrement 
uniquement. Le paramètre de post-roll, s'il est 
activé, est utilisé uniquement pour la dernière 
passe. Les temps de pré- et post-roll sont ignorés 
lors de chaque boucle successive. 
Pour compenser cela, vous pouvez rallonger 
provisoirement la boucle, quitte à rétablir par la 
suite la durée appropriée en appliquant l'outil de 
trimming sur les prises enregistrées (voir 
Utilisation des outils de trimming, page 438).

Lorsque vous effectuez un enregistrement audio 
en boucle, Pro Tools crée un seul fichier audio 
regroupant toutes les prises. Les prises 
apparaissent sous forme de régions distinctes 
dans la liste des régions et sont numérotées de 
façon séquentielle. Après avoir arrêté 
l'enregistrement, vous pouvez écouter n'importe 
quelle prise d'enregistrement.

Pour effectuer un enregistrement en boucle sur 
une piste audio :

1  Sélectionnez Options > Loop Record. Lorsque 
le mode Loop Record est actif, le symbole d'une 
boucle apparaît dans le bouton 
d'enregistrement.

2  Préparez en enregistrement la piste audio en 
cliquant sur son bouton Record Enable.

3  Sélectionnez Options > Link Timeline and 
Edit Selection.

4  A l'aide du sélecteur, sélectionnez la plage de 
boucle dans la piste. Pour connaître d'autres 
méthodes permettant de définir la plage 
d'enregistrement, consultez la section 
Définition des points d'enregistrement 
fractionné et de boucle, page 338.

5  Pour écouter jusqu'au début de la boucle, 
activez le pré-roll et définissez sa durée (voir 
Définition des paramètres de pré et post-roll, 
page 341).

6  Dans la fenêtre Transport, cliquez sur le 
bouton d'enregistrement pour préparer 
Pro Tools à l'enregistrement.

7  Cliquez ensuite sur Lecture pour lancer 
l'enregistrement.

Le bouton d'enregistrement clignote pendant le 
pré-roll. Lorsque le point de début est atteint, 
Pro Tools commence l'enregistrement. Une fois 
le point de fin atteint, Pro Tools retourne au 
début et poursuit l'enregistrement.

8  Pour annuler toutes les prises enregistrées 
pendant un enregistrement en boucle, appuyez 
sur Ctrl+point (.) (Windows) ou sur 
Pomme+point (.) (Mac).

Pour utiliser d'autres prises créées avec Loop 
Record au cours de sessions différentes (en 
utilisant, par exemple, la boîte de dialogue 
Import Session Data), exportez les 
définitions des régions (voir Exportation des 
définitions des régions, page 269). Si les 
définitions des régions ne sont pas 
exportées, les autres prises créées avec Loop 
Record ne seront pas accessibles lorsqu'elles 
seront importées dans une autre session. 

Mode d'enregistrement en boucle activé
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9  Une fois terminé, cliquez sur le bouton d'arrêt 
pour arrêter l'enregistrement.

Si vous arrêtez l'enregistrement avant d'avoir 
atteint le milieu de la boucle, Pro Tools élimine 
cette prise. Si vous enregistrez sur plus de la 
moitié de la boucle, Pro Tools laisse la prise sur 
la piste lorsque vous arrêtez l'enregistrement.

Les prises enregistrées apparaissent sous forme 
de régions dans la liste des régions et sont 
numérotées de façon séquentielle. La dernière 
prise enregistrée apparaît dans la playlist active 
sur la piste. Pour plus de détails sur l'écoute de 
plusieurs prises, reportez-vous à la section 
Ecoute des prises enregistrées dans la timeline, 
page 335.

Lecture en boucle et enregistrement 
audio

Pro Tools ignore la lecture en boucle lors de 
l'enregistrement. La seule manière de définir 
une boucle pendant l'enregistrement est 
d'activer le mode Loop Record.

Ecoute des prises 
enregistrées dans la timeline
Après avoir enregistré plusieurs prises, en 
enregistrement en boucle ou fractionné, vous 
pouvez remplacer la prise se trouvant sur la piste 
par des prises précédentes. Les prises doivent 
avoir la même heure de début pour être 
disponibles. Pour écouter les différentes prises 
(régions) à partir de la liste des régions, cliquez 
sur chacune d'elles tout en maintenant la 
touche Option (Mac) ou Alt (Windows) 
enfoncée.

Toutes les prises sont numérotées de façon 
séquentielle.

Sélection d'une prise différente 
dans la liste des régions

Pour sélectionner une prise dans la liste des 
régions :

1  Dans la fenêtre Edit, sélectionnez la prise en 
cours avec l'outil d'accrochage de temps.

2  Faites glisser une autre prise en maintenant 
enfoncée la touche Ctrl (Windows) ou sur 
Pomme (Mac) dans la liste de régions.

La région remplace la prise précédente et se 
positionne précisément à l'endroit correct.

3  Répétez les étapes précédentes pour écouter 
d'autres prises.

Sélection d'une prise différente 
sur une piste

Chaque région résultant d'une passe 
d'enregistrement fractionné ou en boucle 
possède un temps de début identique (le 
marqueur de temps de l'utilisateur). Vous pouvez 
sélectionner et écouter d'autres prises à partir du 
sous-menu contextuel Matches ou du menu 
contextuel Alternate Takes, et ce même durant 
la lecture.
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Pour sélectionner une autre prise, procédez 
comme suit :

" Cliquez avec le bouton droit de la souris sur la 
région et sélectionnez une autre prise dans le 
menu contextuel des pistes identiques.

" Maintenez enfoncée la touche Ctrl (Windows) 
ou Pomme (Mac) et cliquez avec le sélecteur sur 
le début de la plage d'enregistrement en boucle 
ou fractionné. Sélectionnez ensuite une prise 
différente dans le menu contextuel qui s'affiche.

" Si la prise se trouvant sur la piste est 
sélectionnée, maintenez enfoncée la touche Ctrl 
(Windows) ou Pomme (Mac) et cliquez 
n'importe où dans la prise avec le sélecteur afin 
de sélectionner une prise différente dans le 
menu contextuel qui s'affiche.

La prise (région) sélectionnée remplace la prise 
précédente et se positionne précisément à 
l'endroit correct.

Une façon de vous assurer que les futures prises 
utilisent le même marqueur de temps utilisateur 
(et apparaissent dans le menu déroulant 
Matches) consiste à sauvegarder les sélections 
d'enregistrement en boucle ou fractionné sous 
forme de mémoire d'emplacement. Si, par la 
suite, vous devez enregistrer d'autres prises, il 
vous suffit de rappeler la mémoire 
d'emplacement. Pour plus d'informations, 
reportez-vous à la section Emplacements 
mémoire, page 340.

Pour changer le marqueur de temps utilisateur 
d'autres régions afin qu'elles apparaissent dans 
le menu déroulant Matches correspondant à un 
endroit précis, utilisez la commande du menu 
déroulant de la liste des régions. Pour plus 
d'informations, reportez-vous à la section 
Marquage temporel, page 938.

Pistes identiques et pistes multiples

Si vous avez effectué des enregistrements en 
mode Loop Record sur plusieurs pistes et si 
chacune contient plusieurs pistes avec des 
marqueurs de temps utilisateur identiques, vous 
pouvez modifier les pistes simultanément.

Pour modifier les prises de plusieurs pistes :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Editing.

2  Dans la liste de prises, activez les options 
suivantes sous Matching Start Time :

• Includes Take Region Name(s) that Match 
Track Names

– et –

• Includes Take Regions Lengths That Match

3  Cliquez sur OK pour refermer la boîte de 
dialogue Preferences.

4  A l'aide du sélecteur, sélectionnez la région de 
la prise de chaque piste audio à remplacer.

Sous-menu contextuel Matches

Menu contextuel Alternate Takes
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5  Effectuez l'une des opérations suivantes :

• Cliquez avec le bouton droit de la souris sur 
une des prises sélectionnées et sélectionnez 
une prise différente à partir du sous-menu 
Matches.

– ou –

• Cliquez sur une des prises sélectionnées en 
maintenant enfoncée la touche Ctrl 
(Windows) ou Pomme (Mac) et 
sélectionnez une prise différente à partir du 
menu contextuel Alternate Takes.

La prise sélectionnée remplace la prise 
précédente et se positionne à l'endroit précis sur 
chaque piste.

Préférences d'édition des prises

Outre le partage du même marqueur de temps 
utilisateur, les régions apparaissant dans le 
sous-menu Matches et le menu contextuel 
Alternate Takes dépendent des options définies 
dans la boîte de dialogue Preferences.

Pour définir les préférences d'édition des prises :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Editing.

2  Dans la liste des prises, activez ou désactivez 
les options suivantes de la section Matching 
Start Time :

Includes Take Region Name(s) That Match Track 
Names : lorsque cette option est sélectionnée, 
seules les régions partageant le même nom 
racine avec la piste ou la playlist apparaissent 
dans le sous-menu Matches et dans le menu 
contextuel Alternate Takes. Par exemple, les 
pistes identiques d'une piste nommée « Gtr.L » 
indiquent les régions « Gtr.L_01 » et 
« Gtr.L_02-01 », mais pas « Guit.L_01 ». 

Includes Take Region Lengths That Match : 

lorsque cette option est sélectionnée, seules les 
régions qui correspondent à la durée de la 
sélection en cours (même s'il ne s'agit pas d'une 
région entière) apparaissent dans le sous-menu 
Matches et le menu contextuel Alternate Takes. 
S'il n'y a aucune sélection, toutes les prises ayant 
le même marqueur de temps utilisateur 
s'affichent.

“Separate Region” Operates On All Related 
Takes : lorsque cette option est sélectionnée, 
l'édition d'une région avec la commande 
Separate Region concerne également toutes les 
prises associées possédant le même marqueur de 
temps de l'utilisateur.

Cette option aide à comparer différentes 
sections d'un groupe de prises associées. 
Par exemple, vous pouvez rapidement séparer 
en sections tout un groupe de prises de voix 
associées, puis écouter et sélectionner 
indépendamment les meilleurs moments de 
chaque section.

Lorsque cette option est sélectionnée, vérifiez 
que les options Include Take Region Names That 
Match Track Name(s) et Include Take Region 
Lengths that Match le sont également. Si ce n'est 
pas le cas, toutes les régions de la session 
possédant le même marqueur de temps 
utilisateur seront concernées.

Dans la plupart des cas, il sera préférable de 
désélectionner l'option Separate Region 
Operates On All Related Takes pour éviter de 
créer un grand nombre de régions lorsque vous 
utiliserez la commande Separate Region.
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Définition des points 
d'enregistrement fractionné 
et de boucle
Les points de début et de fin d'une plage 
d'enregistrement fractionné et en boucle 
peuvent être définis à l'aide des méthodes 
suivantes :

• Sélectionnez une plage dans la playlist 
d'une piste (avec les options > Link 
Timeline et Edit Selection activées).

• Sélectionnez une plage dans une règle 
temporelle.

• Faites glisser les marqueurs de sélection de 
timeline dans la règle.

• Entrez les temps de début et de fin dans la 
fenêtre Transport.

• Rappelez un emplacement mémoire 
incluant une sélection Edit (avec les 
options > Link Timeline et Edit Selection 
activées).

Pour définir la région à enregistrer dans la playlist 
d'une piste :

1  Pour restreindre la sélection en fonction du 
pas de grille actuel, réglez le mode d'édition sur 
Grid. 

2  Sélectionnez Options > Link Timeline and 
Edit Selection.

3  Effectuez l'une des opérations suivantes :

• A l'aide du sélecteur, sélectionnez la plage 
d'enregistrement dans la playlist de la piste.

– ou –

• Si la plage d'enregistrement est définie par 
les points de début et de fin d'une région, 
sélectionnez la totalité de la région.

Pour définir la région à enregistrer dans une règle 
temporelle :

1  Pour restreindre la sélection en fonction du 
pas de grille actuel, réglez le mode d'édition 
sur Grid. 

2  Sélectionnez la plage d'enregistrement dans la 
règle temporelle de votre choix.

Sélection de la playlist

Vous pouvez également entrer des points de 
départ et de fin au cours de la lecture. 
Appuyez sur la flèche vers le haut pour 
définir le point de début et sur la flèche vers 
le bas pour définir les points de fin. Si vous 
utilisez cette approche en mode Grid, 
l'alignement sur la grille n'est pas respecté.

Sélection dans la règle temporelle

Si le sélecteur est désactivé, vous n'avez pas 
besoin de le sélectionner manuellement. 
D'autres outils d'édition (tels que l'outil 
d'accrochage de temps) se transforment 
automatiquement en sélecteur dans les 
règles temporelles.
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Marqueurs de sélection de timeline

Lorsque des pistes sont en mode 
d'enregistrement, des marqueurs de sélection de 
timeline correspondant aux temps de début et 
de fin apparaissent sous forme de flèches rouges 
vers le haut et vers le bas dans la règle temporelle 
principale. Si aucune piste n'est activée en 
enregistrement, les marqueurs de sélection de 
timeline sont bleus.

Vous pouvez faire glisser les marqueurs de 
sélection de timeline, séparément ou ensemble, 
pour définir les plages de lecture et 
d'enregistrement.

Pour définir la plage d'enregistrement en 
déplaçant les marqueurs de sélection de timeline :

1  Si vous le souhaitez, réglez le mode d'édition 
sur Grid jusqu'à ce que les marqueurs de 
sélection de timeline s'alignent sur la valeur de 
grille en cours.

2  Faites glisser le premier marqueur de sélection 
de timeline (flèche vers le bas) vers le début de la 
plage.

3  Faites glisser le second marqueur de sélection 
de timeline (flèche en haut) vers la fin de la 
plage.

Champ de début, de fin et de durée

En affichage étendu, la fenêtre Transport peut 
afficher les temps de début (start), de fin (end) et 
de durée (length), ainsi que les valeurs des 
paramètres de pré et de post-roll. Lorsque vous 
définissez une plage d'enregistrement ou de 
lecture, ces champs en indiquent les paramètres.

Vous pouvez entrer des valeurs dans les champs 
de début et de fin pour définir la région à lire ou 
à enregistrer. Les marqueurs de sélection de 
timeline sont mis à jour en conséquence dans la 
règle temporelle principale.

Marqueurs de sélection de timeline dans la règle 
temporelle principale

Déplacement d'un marqueur de sélection de timeline 
(début) dans la règle temporelle principale

Si la plage d'enregistrement en cours est déjà 
de la bonne durée et qu'il suffise de la 
déplacer, faites glisser l'un des marqueurs de 
sélection de timeline en maintenant 
appuyée la touche Alt (Windows) ou Option 
(Mac) pour déplacer l'ensemble vers un 
nouvel emplacement (tout en conservant la 
même durée).

Fenêtre Transport avec affichage des champs de début, 
de fin et de durée
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Pour définir la plage d'enregistrement en entrant 
les temps de début et de fin dans la fenêtre 
Transport :

1  Pour consulter les temps de début, de fin ainsi 
que la durée, effectuez l'une des opérations 
suivantes :

• Sélectionnez View > Transport > Expanded.

– ou –

• Dans la fenêtre Transport, cliquez sur le 
bouton Développer/Réduire (icône +), en 
appuyant sur la touche Maj.

2  Effectuez l'une des opérations suivantes :

• Dans la fenêtre Transport, cliquez sur le 
champ Start.

– ou –

• Appuyez sur Alt+barre oblique (/) 
(Windows) ou sur Option+barre oblique (/) 
(Mac) sur le pavé numérique pour 
sélectionner le champ Start de la fenêtre 
Transport.

3  Tapez l'emplacement de début, puis appuyez 
sur Alt+barre oblique (/) (Windows) ou sur 
Option+barre oblique (/) (Mac) du pavé 
numérique pour valider la valeur et passer 
automatiquement au champ de fin.

4  Tapez l'emplacement de fin, puis appuyez sur 
Entrée pour valider la valeur.

Emplacements mémoire

Vous pouvez stocker des sélections d'édition 
avec emplacements de mémoire, qui peuvent 
inclure les valeurs actuelles de pré- et post-roll.

Pour sauvegarder une sélection d'édition à l'aide 
d'un emplacement mémoire :

1  Assurez-vous que les options > Link Timeline 
et Edit Selection sont sélectionnées.

2  Définissez la plage d'enregistrement en 
effectuant une sélection d'édition ou de 
timeline, ou en entrant les temps de début et de 
fin dans la fenêtre Transport.

3  Pour enregistrer les valeurs de pré- et de 
post-roll, activez et définissez les durées de pré- 
et de post-roll en les saisissant dans la fenêtre 
Transport ou en faisant glisser les drapeaux leur 
correspondant dans la règle représentant 
l'échelle temporelle principale (voir Définition 
des paramètres de pré et post-roll, page 341).

4  Appuyez sur la touche Entrée du pavé 
numérique ou cliquez sur le bouton Add 
Marker/Memory Location dans la fenêtre Edit.

5  Dans la boîte de dialogue New Memory 
Location, cochez l'option Selection de la zone 
Time Properties et, si vous le souhaitez, dans la 
zone General Properties, cochez l'option 
Pre/Post Roll Times.

Utilisez la touche point (.) ou les flèches 
droite et gauche pour vous déplacer dans les 
champs Start et End. Utilisez les flèches 
haut et bas pour augmenter ou réduire les 
valeurs numériques.

Pour plus d'informations sur les 
emplacements mémoire, reportez-vous à la 
section Emplacements mémoire et 
marqueurs, page 605.
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6  Entrez le nouveau nom de l'emplacement de 
mémoire.

7  Cliquez sur OK.

Pour rappeler une sélection d'édition à l'aide d'un 
emplacement mémoire :

1  Sélectionnez Options > Link Timeline and 
Edit Selection.

2  Sélectionnez Windows> Memory Locations.

3  Effectuez l'une des opérations suivantes :

• Dans la fenêtre Memory Locations, cliquez 
sur le nom ou le numéro de l'emplacement 
mémoire.

– ou –

• Rappelez l'emplacement de mémoire en 
entrant un point (.), le numéro de la 
mémoire et un autre point (.) sur le pavé 
numérique. (Voir Modes du pavé 
numérique, page 23).

Les temps de début et de fin, ainsi que les 
paramètres de pré et de post-roll stockés dans la 
mémoire d'emplacement, sont rappelés.

Définition des paramètres de pré 
et post-roll

Le début de pré-roll et la fin de post-roll 
apparaissent sous forme de drapeaux dans la 
règle qui représente l'échelle temporelle 
principale. Lorsque les pré et post-roll sont 
activés, les drapeaux sont verts, sinon ils sont 
gris.

Vous pouvez entrer les durées de pré et de 
post-roll dans la fenêtre Transport, les définir à 
partir de la playlist d'une piste ou d'une règle 
temporelle, ou en rappelant une mémoire 
d'emplacement.

Réglage des paramètres de Pré- et de 
Post-Roll dans la fenêtre Transport

 Vous pouvez activer et définir les paramètres de 
pré et de post-roll dans la fenêtre Transport.

Pour définir et activer les paramètres de pré- et de 
post-roll dans les champs de la fenêtre Transport :

1  Sélectionnez View > Transport > Expanded.

2  Dans la fenêtre Transport, cliquez sur le 
champ pré-roll.

Boîte de dialogue New Memory Location

Fenêtre des emplacements mémoire

Drapeaux de pré/post-roll verts (activés) dans la règle 
temporelle principale
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3  Tapez la durée de pré-roll désirée, puis 
appuyez sur la barre oblique (/) du pavé 
numérique pour valider la valeur et passer 
automatiquement au champ Post-roll.

4  Tapez la durée de post-roll désirée puis 
appuyez sur Entrée pour valider la nouvelle 
valeur.

5  Pour activer le pré- ou le post-roll, cliquez sur 
le bouton correspondant pour le mettre en 
surbrillance.

Réglage des paramètres de Pré- et de 
Post-Roll dans une playlist

Le sélecteur permet d'activer et de désactiver le 
pré et le post-roll en cliquant dans la playlist 
d'une piste.

Pour définir et activer les paramètres de pré- et de 
post-roll en cliquant dans une playlist :

1  Sélectionnez Options > Link Timeline and 
Edit Selection.

2  A l'aide du sélecteur, sélectionnez la plage 
d'enregistrement dans la playlist de la piste.

3  A l'aide du sélecteur, maintenez enfoncée la 
touche Alt (Windows) ou Option (Mac) avant la 
sélection pour activer le pré-roll à cet endroit 
pendant que vous cliquez sur la playlist de la 
piste.

4  A l'aide du sélecteur, maintenez enfoncée la 
touche Alt (Windows) ou Option (Mac) après la 
sélection pour activer le post-roll à cet endroit 
pendant que vous cliquez sur la liste de diffusion 
de la piste.

Pour désactiver les paramètres de pré et de 
post-roll en cliquant dans une playlist :

1  A l'aide du sélecteur, maintenez enfoncée la 
touche Alt (Windows) ou Option (Mac) pour 
désactiver le pré-roll pendant que vous cliquez 
sur la sélection d'édition près du début.

2  A l'aide du sélecteur, maintenez enfoncée la 
touche Alt (Windows) ou Option (Mac) pour 
désactiver le prost-roll pendant que vous cliquez 
sur la sélection d'édition près de la fin.

3  Déposez le drapeau Pre-Roll sur le marqueur 
de début de sélection de timeline.

4  Déposez le drapeau Post-Roll sur le marqueur 
de fin de sélection de timeline.

Activation des paramètres de pré et de 
post-roll dans le menu Options

Vous pouvez activer et désactiver les paramètres 
de pré et de post-roll (ensemble) dans le menu 
Options.

Pour activer à la fois le pré et le post-roll à partir du 
menu Options :

" Sélectionnez Options > Pre/Post-Roll.

Déplacement des drapeaux de pré- et 
post-roll dans la règle temporelle

Vous pouvez faire glisser (séparément ou 
ensemble) les drapeaux de pré- et de post-roll 
dans la règle temporelle principale pour définir 
leur emplacement.

Utilisez la touche point (.) ou les flèches 
droite et gauche pour vous déplacer dans les 
champs Pre-roll et Post-roll. Utilisez les 
flèches haut et bas pour augmenter ou 
réduire les valeurs numériques.

Dans la timeline, vous pouvez régler le pré- 
et le post-roll sur zéro. Tout d'abord, 
déposez le drapeau de Pre-Roll sur le 
marqueur de début de sélection de timeline, 
puis déposez le drapeau Post-Roll sur le 
marqueur de fin de sélection de timeline.
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Pour définir les paramètres de pré et de post-roll 
en se déplaçant sur la règle temporelle principale :

1  Si vous le souhaitez, réglez le mode d'édition 
sur Grid jusqu'à ce que les drapeaux Pré et 
Post-Roll s'alignent sur la valeur de grille en 
cours.

2  Faites glisser le drapeau de pré-roll vers un 
nouvel emplacement dans la règle.

3  Faites glisser le drapeau de post-roll vers un 
nouvel emplacement dans la règle temporelle.

Enregistrement à partir d'une 
source numérique
Si vous envisagez d'utiliser un lecteur DAT ou un 
enregistreur de CD à sortie numérique ou tout 
autre dispositif numérique avec votre système 
Pro Tools, vérifiez qu'il est compatible avec son 
format numérique. Par exemple, les entrées et 
les sorties AES/EBU de votre interface audio 
Pro Tools doivent uniquement être connectées à 
un appareil AES/EBU.

Options numériques Pro Tools|HD

Les interfaces 192 I/O, 192 Digital I/O et 96 I/O 
sont dotées d'options numériques AES/EBU, 
S/PDIF et ADAT. Les interfaces 192 I/O et 
192 Digital I/O incluent également des options 
d'E/S numériques TDIF. L'interface 96i I/O ne 
comprend que l'option numérique S/PDIF.

Sur les interfaces 192 I/O, 192 Digital I/O ou 
96 I/O, Pro Tools peut recevoir à tout moment 
des données audionumériques à partir de 
l'interface d'I/O Optical (ADAT) pré-installée (si 
le réglage est autre que S/PDIF). Toutefois, 
Pro Tools peut recevoir des données 
audionumériques uniquement à partir de l'une 
des sources [Encl] numériques situées sur son 
châssis (AES/EBU, Optical (S/PDIF) ou S/PDIF).

Toutes les interfaces d'E/S Pro Tools|HD 
comportent des sources numériques situées sur 
le châssis qui s'affichent sous forme de versions 
[Encl] pour les différencier des entrées et sorties 
numériques disponibles sur la carte 
192 Digital I/O. C'est le cas, par exemple, des 
entrées et sorties AES/EBU incluses dans toutes 
les interfaces 192 I/O (AES/EBU [Encl]).

Les ports numériques supplémentaires de 
l'interface 192 I/O et 192 Digital I/O sont les 
suivants : AES/EBU et ADAT. Pro Tools ne peut 
recevoir des données audio numériques que de 
l'un de ces ports à la fois.

Toutefois, les entrées de la carte numérique et du 
châssis de l'interface audio 192 I/O peuvent être 
utilisées simultanément. Sur une interface 
192 I/O, par exemple, il est possible de 

Déplacement d'un drapeau de pré-roll dans la règle 
temporelle

Pour définir des durées de pré et de post-roll 
identiques, faites glisser le drapeau de 
pré-roll ou celui de post-roll dans la règle, 
tout en appuyant sur la touche Alt 
(Windows) ou Option (Mac). Le drapeau 
désélectionné reprendra immédiatement la 
même valeur et s'adaptera lorsque vous 
faites glisser le drapeau sélectionné.

Pour plus d'informations sur la 
configuration de votre système Pro Tools 
pour l'enregistrement depuis une source 
numérique, reportez-vous au guide de 
démarrage s'y rapportant.
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désactiver une source provenant de l'une des 
entrées situées sur le châssis et de faire effectuer 
à une autre entrée au niveau des ports 
numériques une conversion de fréquence 
d'échantillonnage, pour bénéficier ainsi de deux 
sources numériques.

Options numériques Pro Tools LE

Les systèmes Digi 002 et Digi 002 Rack incluent 
les options numériques S/PDIF et ADAT I/O. 

Mbox 2, Mbox 2 Pro et Mbox ne comprennent 
que l'option numérique S/PDIF.

Toutes les sorties numériques sont actives en 
permanence. Vous pouvez ainsi envoyer 
simultanément des données audionumériques 
vers plusieurs périphériques numériques. 

Enregistrement à partir de 
sources numériques

Pour enregistrer à partir d'une source numérique 
avec Pro Tools :

1  Connectez la sortie numérique de votre source 
d'enregistrement à l'entrée appropriée de votre 
dispositif audio.

2  Si vous souhaitez démarrer une nouvelle 
session avec une fréquence d'échantillonnage 
différente, procédez comme suit :

• Choisissez File > New Session.

• Sélectionnez la fréquence 
d'échantillonnage.

• Configurez le reste de la boîte de dialogue 
New Session en conséquence.

• Cliquez sur Save.

3  Spécifiez le format (numérique) des entrées de 
l'interface audio à laquelle la source 
d'enregistrement numérique est connectée. 

• Sélectionnez Setup > Hardware.

• Sélectionnez l'interface audio.

• Sélectionnez le format numérique pour la 
paire de canaux appropriée (AES/EBU ou 
S/PDIF, par exemple). 

4  Pour les systèmes Pro Tools|HD seulement, 
procédez comme suit :

• Dans la fenêtre Session Setup, sélectionnez 
la source d'horloge appropriée. 

– ou –

• Sélectionnez Setup > Hardware.

• Sélectionnez la source d'horloge appropriée 
connectée à l'interface audio adéquate.

• Cliquez sur OK pour refermer la boîte de 
dialogue Hardware Setup.

5  Créez une piste audio stéréo.

6  Assignez les sélecteurs de chemin d'entrée de 
la piste à l'entrée appropriée. Puisqu'il s'agit d'un 
transfert numérique, vous n'avez pas à vous 
soucier des niveaux d'entrée.

7  Attribuez le sélecteur de chemin de sortie à la 
piste à la sortie appropriée pour l'écoute (A 1-2 
par exemple). 

Certaines unités d'I/O Digidesign ne 
disposent que de deux canaux pouvant être 
réglés en mode analogique ou numérique. 
Par exemple, Mbox 2 dispose des entrées 
numériques S/PDIF L–R (stéréo) et des 
entrées analogique In 1–2. Mbox 2 peut 
enregistrer simultanément à partir des 
entrées analogiques et numériques. 
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8  Assurez-vous que les éléments suivants sont 
désélectionnés dans le menu Options : 
Destructive Record, Loop Record, QuickPunch, 
TrackPunch et DestructivePunch.

9  Dans la fenêtre Transport, cliquez sur le 
bouton de retour à zéro pour vous assurer que 
l'enregistrement commencera au début de la 
session.

10  Activez la nouvelle piste audio pour 
l'enregistrement.

11  Dans la fenêtre Transport, cliquez sur le 
bouton d'enregistrement pour préparer 
Pro Tools à l'enregistrement.

12  Cliquez ensuite sur Lecture pour lancer 
l'enregistrement.

13  Démarrez la lecture sur les nouvelles sources 
d'enregistrement.

14  Lorsque les données source sont passées, 
cliquez sur le bouton d'arrêt de la fenêtre 
Transport.

15  Arrêtez la lecture sur les sources 
d'enregistrement.

Après un transfert numérique

Lorsque vous avez terminé un enregistrement 
numérique, rétablissez sur Internal le menu 
déroulant Clock Source de la fenêtre de 
configuration de la session (Session Setup). Dans 
le cas contraire, Pro Tools ne repassera pas sur 
son horloge interne et ne pourra ni enregistrer 
ni lire correctement les données audio. Le 
non-rétablissement de la synchronisation 
interne pose en général des problèmes de 
hauteur (lecture trop rapide ou trop lente)de 
clics et autres parasites, ou crée des erreurs DAE, 
car un enregistreur DAT ou de CD en veille peut 
revenir à une fréquence d'échantillonnage 
différente par défaut ou s'arrêter complètement 
de fournir un signal d'horloge.

Enregistrement et lecture à 
demi-vitesse
Pro Tools autorise la lecture et l'enregistrement à 
demi-vitesse. Cette fonction, similaire à celle 
d'un magnétophone, permet d'enregistrer des 
éléments en demi-vitesse puis de les lire à vitesse 
normale (plus vite et une octave plus haut) ou 
d'enregistrer à vitesse normale puis de lire à 
demi-vitesse (plus lentement et une octave plus 
bas). Elle est utile à la réalisation d'effets 
spéciaux.

Enregistrement à demi-vitesse

Pour enregistrer des pistes MIDI dont la lecture 
est difficile ou des mouvements d'automation 
complexes, utilisez l'enregistrement à 
demi-vitesse. 

Pour enregistrer à demi-vitesse :

1  Préparez à l'enregistrement les pistes que vous 
souhaitez enregistrer à demi-vitesse.

2  Dans la fenêtre Transport, cliquez sur le 
bouton d'enregistrement pour activer Pro Tools 
à l'enregistrement.

3  Appuyez sur Pomme+Maj+barre d'espace 
(Mac) ou sur Ctrl+Maj+barre d'espace 
(Windows). L'enregistrement commence et la 
lecture de toutes les données existantes 
s'effectue à demi-vitesse.

4  A la fin de l'enregistrement, cliquez sur le 
bouton d'arrêt.
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Lecture à demi-vitesse

Utilisez la lecture à demi-vitesse pour apprendre 
ou transcrire des passages difficiles des pistes 
enregistrées.

Pour lire à demi-vitesse :

1  Cliquez sur le bouton de lecture dans la fenêtre 
de Transport tout en maintenant la touche Maj 
enfoncée. 

2  Pour interrompre la lecture, cliquez sur le 
bouton d'arrêt de la fenêtre Transport.

Vous pouvez également lire à demi-vitesse 
en utilisant la combinaison de touches 
Maj+barre d'espace.
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Chapitre 16 : Enregistrement MIDI

Dans Pro Tools, l'enregistrement MIDI 
ressemble beaucoup à l'enregistrement audio. 
Il existe toutefois quelques différences 
importantes :

! Contrairement à l'enregistrement audio, 
l'enregistrement MIDI est presque toujours 
destructif. Pour plus d'informations, consultez 
la section Modes d'enregistrement et MIDI, 
page 317.

! Contrairement aux pistes audio, les pistes 
MIDI et les pistes d'instrument peuvent être 
activées en enregistrement à la volée, en cours 
de lecture ou d'enregistrement.

! Les pistes MIDI et les pistes d'instrument 
disposent d'un sélecteur d'entrée permettant de 
déterminer le port de votre interface 
(périphériques) et le canal qui sont envoyés et 
enregistrés sur la piste. Si le sélecteur d'entrée 
MIDI est réglé sur All, tous les canaux de tous les 
périphériques sont envoyés à la piste. 

! A l'instar des entrées auxiliaires, les pistes 
d'instrument possèdent des sélecteurs d'E/S 
audio. A la différence des sélecteurs de pistes 
d'instrument pour les E/S MIDI, ils servent 
principalement au contrôle audio des 
instruments ou plug-in d'instrument MIDI. 

! Il n'est pas nécessaire d'activer l'option 
QuickPunch TrackPunch ou DestructivePunch 
pour effectuer des entrées d'enregistrement à la 
volée sur des pistes MIDI ou des pistes 
d'instrument. Cette possibilité existe dans le 
mode d'enregistrement normal non destructif et 
dans le mode d'enregistrement destructif.

Enregistrement à partir de 
périphériques MIDI
Les entrées MIDI des pistes MIDI et des pistes 
d'instrument en mode d'enregistrement 
déterminent les données MIDI qui seront 
enregistrées dans Pro Tools. Les entrées MIDI 
peuvent être réglées sur un périphérique (port) 
ou un canal donné, ou sur All pour que les 
données provenant de tous les périphériques 
soient fusionnées vers la piste.

Les pistes MIDI et d'instrument de Pro Tools ne 
contiennent pas plusieurs canaux et effectuent 
toujours la lecture par l'intermédiaire des 
périphériques et des canaux affectés à la piste 
(sortie MIDI). Il est possible d'enregistrer 
simultanément plusieurs canaux MIDI sur 
plusieurs pistes.

Les options suivantes de Pro Tools déterminent 
les modalités d'enregistrement à partir d'un 
contrôleur MIDI (clavier ou boîte à rythme 
MIDI) :
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! Les périphériques définis en tant que 
contrôleurs MIDI dans la boîte de dialogue 
Peripherals (sous Setup > Peripherals) sont 
ignorés lors de l'enregistrement de pistes MIDI. 
Cela évite l'enregistrement de données 
provenant de surfaces de contrôle MIDI telles 
que Digidesign Command|8.

! Pour enregistrer et lire des pistes MIDI, le 
dispositif doit être activé dans la boîte de 
dialogue Input Devices. Pour plus 
d'informations, reportez-vous à la section 
Activation des périphériques d'entrée, page 348.

En outre, les options suivantes ont une 
incidence sur la façon dont les données MIDI 
sont enregistrées dans Pro Tools :

! Le filtre d'entrée MIDI peut filtrer les messages 
MIDI que vous ne souhaitez pas enregistrer, tels 
que des données Polyphonic Aftertouch ou 
System Exclusive. Pour plus d'informations, 
reportez-vous à la section Filtre d'entrée MIDI, 
page 350.

! Lorsqu'elle est active, l'option Input Quantize 
quantifie automatiquement toutes les notes 
MIDI enregistrées, c'est-à-dire, en corrige 
automatiquement le timing. Pour plus 
d'informations, reportez-vous à la section Input 
Quantize, page 350.

Activation des périphériques 
d'entrée
Pour enregistrer à partir d'un contrôleur MIDI 
(un clavier MIDI, par exemple) dans Pro Tools, 
celui-ci doit être activé dans la boîte de dialogue 
Input Devices. Cette boîte de dialogue permet de 
s'assurer que les notes indésirables provenant de 
certains périphériques, tels que les boîtes à 
rythmes ou les arpégiateurs, ne sont pas 
enregistrées.

Surfaces de contrôle MIDI : pour utiliser une 
quelconque surface de contrôle MIDI (telle que 
Digidesign Command|8), celle-ci doit être 
activée dans la boîte de dialogue Input Devices.

MMC : pour que Pro Tools puisse être 
commandé via MMC (MIDI Machine Control), 
le MMC doit être activé comme source dans la 
boîte de dialogue Input Devices.

Pour activer les périphériques d'entrée :

1  Choisissez Setup > MIDI > Input Devices.

2  Dans la boîte de dialogue MIDI Input Enable, 
procédez comme suit :

• Sélectionnez les périphériques MIDI à 
enregistrer. Sélectionnez également les 
périphériques à utiliser en tant que surface 
de contrôle.

• Désélectionnez tous les périphériques 
d'entrée que vous souhaitez ignorer 
pendant l'enregistrement MIDI.
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3  Cliquez sur OK.

MIDI Thru
Pour pouvoir écouter les pistes MIDI pendant 
l'enregistrement, activez MIDI Thru. Lorsque 
cette option est activée, Pro Tools renvoie les 
données MIDI provenant des contrôleurs vers 
les périphériques et canaux affectés à la piste 
MIDI actuellement en mode d'enregistrement.

Pour activer MIDI Thru :

" Sélectionnez Options > MIDI Thru.

Instrument Thru par défaut

En plus des pistes MIDI en mode 
d'enregistrement, vous pouvez également 
envoyer les données MIDI vers l'instrument 
Thru par défaut. Cela vous évite de créer une 
piste MIDI et de la préparer à l'enregistrement 
pour écouter un périphérique et un canal MIDI 
particuliers.

Contrairement aux pistes MIDI, qui ne 
reçoivent que les données MIDI du périphérique 
et du canal affectés à leur sélecteur d'entrée 
MIDI, toutes les données MIDI entrantes sont 
routées vers l'instrument Thru par défaut.

Si l'instrument Thru par défaut est affecté à une 
piste MIDI en mode d'enregistrement, Pro Tools 
n'envoie que vers cette piste les données MIDI 
entrantes.

Zone de dialogue MIDI Input Enable

Il n'est pas nécessaire de sélectionner les 
périphériques pour que ceux-ci reçoivent des 
données MIDI de Pro Tools. Par exemple, il 
est inutile de sélectionner un périphérique 
utilisé exclusivement comme générateur de 
sons dans la boîte de dialogue MIDI Input 
Enable.

L'option Global MIDI Playback Offset de la 
préférence MIDI et les décalages individuels 
de piste MIDI n'ont pas d'incidence sur les 
données MIDI envoyées via MIDI Thru.

Lorsque l'option MIDI Thru est activée, les 
données System Exclusive (Sysex) sont 
renvoyées vers le périphérique MIDI affecté à 
la piste en mode d'enregistrement si la taille 
des événements Sysex est inférieure à 
256 octets.

Lorsque vous utilisez l'option MIDI Thru, il 
est préférable de désactiver le contrôle local 
sur vos périphériques MIDI. S'il reste activé, 
votre périphérique MIDI risque de recevoir 
les notes MIDI en double, ce qui peut causer 
divers problèmes. Si vous ne savez pas 
comment désactiver le contrôle local de 
votre instrument, consultez la 
documentation du fabricant.
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Pour configurer un instrument Thru par défaut :

1  Sélectionnez Setup > Preferences. 

2  Cliquez sur l'icône MIDI. 

3  Effectuez l'une des opérations suivantes :

• Sélectionnez un périphérique spécifique 
dans le menu déroulant Default Thru 
Instrument pour lire par défaut ses données 
MIDI. 

• Sélectionnez Follows First Selected MIDI 
Track pour que l'affectation d'aperçu MIDI 
suive la sélection de piste MIDI. Lorsque 
plusieurs pistes MIDI sont sélectionnées, 
l'aperçu s'affiche dans la piste du haut ou 
celle de gauche dans les fenêtres Edit et 
Mix. 

• Pour désactiver l'instrument Thru par 
défaut, sélectionnez None.

Filtre d'entrée MIDI
Le filtre d'entrée MIDI permet d'éliminer par 
filtrage certains types de messages MIDI de vos 
enregistrements. Le filtre d'entrée MIDI peut 
être configuré pour enregistrer tous les messages 
(All), seulement les messages spécifiés (Only) ou 
tous les messages sauf ceux spécifiés (All except).

Par exemple, pour filtrer un changement de 
programme :

1  Choisissez Setup > MIDI > Input Filter.

2  Dans la boîte de dialogue MIDI Input Filter, 
sélectionnez l'option All Except.

3  Sélectionnez l'option Program Changes. Ne 
cochez pas les autres cases d'option.

4  Cliquez sur OK.

Lorsque vous utilisez l'option All Except, les 
types de messages MIDI sélectionnés ne sont pas 
enregistrés. Inversement, lorsque vous utilisez 
l'option Only, seuls les messages MIDI 
sélectionnés sont enregistrés.

Input Quantize
Lorsque l'option Input Quantize est activée, 
toutes les notes MIDI enregistrées sont 
automatiquement quantifiées. L'option Input 
Quantize est utile à l'enregistrement de données 
MIDI avec une rythmique précise. Désactivez 
cette option si vous souhaitez préserver la 
nuance originale de vos pistes MIDI enregistrées 
(un phrasé rubato, par exemple).

L'option Default Thru Follows First Selected 
MIDI Track Selection vous permet 
également d'écouter un instrument sans 
créer ni activer l'enregistrement de la piste 
MIDI ou la piste d'instrument.

Boîte de dialogue MIDI Input Filter

Pour plus d'informations sur l'option Input 
Quantize, consultez la section Input 
Quantize, page 696. 
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Attendre la note
Le bouton Wait for Note de la fenêtre Transport 
détermine de quelle manière Pro Tools 
commence l'enregistrement. Lorsque cette 
option est sélectionnée, Pro Tools ne démarre 
l'enregistrement qu'à la réception d'un 
événement MIDI. Cela permet de s'assurer que 
l'enregistrement ne commence qu'à la première 
note de l'instrument et que les données 
correspondantes, MIDI ou non, sont 
enregistrées précisément au début de la plage 
d'enregistrement (temps de début).

L'option Wait for Note s'utilise pour 
l'enregistrement normal, à la volée ou en boucle. 
Si le pré-roll est actif, il intervient après la 
réception de l'événement MIDI et avant le début 
de l'enregistrement.

Pour activer l'option Wait for Note :

1  Pour faire apparaître les commandes MIDI 
dans la fenêtre Transport, sélectionnez View > 
Transport > MIDI Controls.

2  Dans la fenêtre Transport, cliquez sur le 
bouton Wait for Note pour qu'il passe en 
surbrillance.

Mode de fusion/ 
remplacement MIDI
Le bouton de fusion MIDI de la fenêtre 
Transport détermine de quelle manière les 
données MIDI sont enregistrées lors d'overdubs 
ou d'enregistrements en punch-in. Lorsque la 
fusion MIDI est activée (mode Merge), les 
données MIDI enregistrées viennent s'ajouter à 
celles se trouvant déjà sur la piste. Lorsque le 
bouton de fusion MIDI est désactivé (mode 
Replace), les données qui se trouvaient dans la 
région enregistrée sont remplacées par les 
nouvelles.

Le bouton de fusion MIDI peut être activé et 
désactivé en cours de lecture ou 
d'enregistrement. Dans le mode 
d'enregistrement en boucle, la fusion MIDI n'a 
aucun effet ; c'est pourquoi le bouton de fusion 
MIDI est estompé.

Ces boutons s'excluent mutuellement et ne 
peuvent être activés simultanément. Par 
exemple, si vous activez le décompte et 
cliquez sur le bouton Wait for Note, le 
décompte est désactivé.

Fenêtre Transport affichant les commandes MIDI

Bouton Wait for Note activé

Lorsque l'option Use F11 for Wait for Note 
des préférences de fonctionnement est 
sélectionnée, vous pouvez appuyer sur F11 
pour activer le bouton Wait for Note. 
(Sur les systèmes Mac, le raccourci clavier 
Desktop doit être désactivé ou réaffecté.)

Bouton Wait for Note
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Pour activer la fusion MIDI :

1  Pour faire apparaître les commandes MIDI 
dans la fenêtre Transport, sélectionnez View > 
Transport > MIDI Controls.

2  Dans la fenêtre Transport, cliquez sur le 
bouton de fusion MIDI pour qu'il soit mis en 
surbrillance.

Configuration de pistes MIDI 
ou de pistes d'instrument 
pour l'enregistrement

Pour configurer une ou plusieurs pistes MIDI ou de 
pistes d'instrument pour l'enregistrement :

1  Utilisez une piste MIDI ou d'instrument 
existante ou créez-en une.

2  Pour les pistes d'instrument, choisissez View > 
Mix Window > Instruments ou View > Edit 
Window > Instruments.

3  Dans le sélecteur d'entrée MIDI de la piste, 
sélectionnez le périphérique et le canal à 
enregistrer. (Pour les pistes d'instrument, le 
sélecteur d'entrée MIDI est disponible dans la 
vue Instruments.)

Pour activer la fusion MIDI par un raccourci 
clavier, réglez le mode du pavé numérique 
sur Transport et appuyez sur la touche 9 du 
pavé numérique. 

Vous pouvez également copier et fusionner 
les notes MIDI à l'aide de la fonction de 
collage spécial. Pour plus d'informations, 
reportez-vous à la section Fonction de 
collage spécial pour les données 
d'automation, page 830.

Fusion MIDI activée

Bouton MIDI Merge

Sélecteur d'entrée de la piste MIDI (fenêtre Mix)

Sélecteur d'entrée MIDI de la piste d'instrument 
(fenêtre Mix)

Sélecteur d'entrée MIDI de la piste MIDI (fenêtre Edit)

Sélecteur d'entrée MIDI de la piste d'instrument 
(fenêtre Edit)

Sélecteur d'entrée MIDI

Sélecteur d'entrée MIDI

Sélecteur d'entrée MIDI

Sélecteur d'entrée MIDI
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4  Dans le sélecteur de sortie MIDI, sélectionnez 
le périphérique et le canal à lire.

5  Pour affecter plusieurs destinations à une 
même piste MIDI ou d'instrument, cliquez sur le 
sélecteur de sortie MIDI, appuyez sur la touche 
Démarrer (Windows) ou Ctrl (Mac) et cliquez 
sur des canaux d'autres périphériques. Lorsque 
plusieurs destinations sont sélectionnées pour 
une seule piste MIDI, un astérisque (*) s'affiche à 
côté du nom de la première destination dans le 
sélecteur de sortie MIDI.

6  Pour affecter à la piste un changement de 
programme par défaut, effectuez l'une des 
opérations suivantes :

• Cliquez sur le bouton de sélection des 
patchs.

• Effectuez vos sélections de programme et 
de banque.

• Cliquez sur Done (Terminé).

7  Si vous enregistrez vers plusieurs pistes MIDI 
ou d'instrument, répétez les étapes précédentes 
pour chaque piste, puis passez à l'étape suivante.

8  Si vous souhaitez utiliser un clic, activez et 
configurez le métronome, puis définissez un 
tempo et une mesure par défaut pour la session 
(voir Enregistrement avec le métronome, 
page 318).

9  Activez au choix l'option Wait for Note ou 
Countoff dans la fenêtre Transport. 

10  Pour remplacer des données de la piste, 
désactivez la fusion MIDI dans la fenêtre 
Transport (voir Mode de fusion/ remplacement 
MIDI, page 351).

Sélecteur de sortie MIDI de la piste MIDI (fenêtre Mix)

Sélecteur de sortie MIDI de la piste d'instrument 
(fenêtre Mix)

Sélecteur de sortie MIDI de la piste MIDI (fenêtre Edit)

Sélecteur de sortie MIDI de la piste d'instrument 
(fenêtre Edit)

Sélecteur de sortie MIDI

Sélecteur de sortie MIDI

Sélecteur de sortie MIDI

Sélecteur de sortie MIDI

Les messages de changement de programme 
(changement de son) par défaut sont 
transmis à chaque lecture de la piste. 
Pour plus d'informations, reportez-vous à 
la section Sélection de patch (changements 
de programme et de banque), page 661.
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11  Pour quantifier automatiquement des 
données enregistrées, activez l'option Input 
Quantize (voir Input Quantize, page 350).

12  Dans la fenêtre Transport, cliquez sur le 
bouton de retour à zéro pour vous assurer que 
l'enregistrement commencera au début de la 
session.

13  Préparez la piste MIDI ou la piste 
d'instrument à l'enregistrement en cliquant sur 
son bouton Record Enable.

14  Assurez-vous que Options > MIDI Thru est 
sélectionné, puis commencez à jouer sur votre 
contrôleur MIDI. Le périphérique ou le plug-in 
d'instrument MIDI affecté à la sortie MIDI de la 
piste doit émettre un son et les vumètres de la 
piste doivent témoigner d'une activité MIDI.

Vous êtes maintenant prêt à enregistrer des 
données MIDI vers les pistes MIDI ou 
d'instruments en mode d'enregistrement.

Enregistrement de pistes MIDI 
et d'instrument
Dans Pro Tools, vous pouvez enregistrer vers 
une ou plusieurs pistes MIDI ou d'instrument. 
L'enregistrement simultané vers plusieurs pistes 
permet :

• d'enregistrer simultanément plusieurs 
musiciens à partir de plusieurs contrôleurs 
MIDI ;

• d'enregistrer un clavier splitté en plusieurs 
canaux ;

• de transférer des pistes MIDI provenant d'un 
séquenceur MIDI externe.

Pour enregistrer vers une ou plusieurs pistes MIDI 
ou pistes d'instrument :

1  Avec Pro Tools HD, assurez-vous que l'option 
Delay Compensation est désactivée dans le 
menu Options.

2  Configurez une piste MIDI ou d'instrument 
pour l'enregistrement (voir Configuration de 
pistes MIDI ou de pistes d'instrument pour 
l'enregistrement, page 352).

3  Activez le mode d'enregistrement pour la piste 
que vous souhaitez enregistrer en cliquant sur le 
bouton Record Enable correspondant.

Pour tirer parti des fonctions d'édition de 
Pro Tools, effectuez les enregistrements en 
activant le métronome pour les pistes basées 
sur des références temporelles. Cela garantit 
que les données enregistrées s'aligneront 
correctement sur la grille de mesure/temps 
de la session. Vous pouvez également 
enregistrer sans métronome vers des pistes 
MIDI basées sur des échantillons et déduire 
le tempo et la mesure à partir des notes.

Pour enregistrer les données audio d'un 
instrument ou d'un plug-in d'instrument 
MIDI, acheminez la sortie audio de la piste 
d'instrument, ou de la piste d'entrée 
auxiliaire, qui écoute l'instrument vers une 
piste audio. Préparez la piste audio à 
l'enregistrement et lancez l'enregistrement. 
Pour plus d'informations, reportez-vous à la 
section Enregistrement de données audio à 
partir d'un instrument MIDI, page 364.

Dans la plupart des cas, Digidesign 
recommande l'enregistrement sans 
compensation de retard. Pour plus 
d'informations, reportez-vous à la section 
Compensation de retard, page 757.
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4  Placez Pro Tools en mode d'enregistrement 
normal non destructif. Dans le menu Options, 
désélectionnez au besoin les options Destructive 
Record, Loop Record, QuickPunch, TrackPunch 
(Pro Tools HD uniquement) et 
DestructivePunch (Pro Tools HD uniquement).

5  Vérifiez les paramètres de fusion MIDI. 

6  Vérifiez les paramètres de pré-roll et de 
décompte (Countoff). 

7  Dans la fenêtre Transport, cliquez sur le 
bouton de retour à zéro pour vous assurer que 
l'enregistrement commencera au début de la 
session.

8  Dans la fenêtre Transport, cliquez sur le 
bouton d'enregistrement pour préparer 
Pro Tools à l'enregistrement (mode de 
préparation pour l'enregistrement). L'indicateur 
d'état du mode d'enregistrement de la piste 
devient rouge.

9  Cliquez ensuite sur Lecture pour lancer 
l'enregistrement. Avec l'option Countoff, 
Pro Tools décompte le nombre de mesures 
spécifié avant de commencer l'enregistrement. 
Avec l'option Wait for Note, l'enregistrement 
commence dès la première note (c'est-à-dire, à la 
réception d'un événement MIDI).

10  Tapez sur les touches du contrôleur MIDI.

11  Pour interrompre l'enregistrement, cliquez 
sur le bouton d'arrêt dans la fenêtre Transport.

A chaque piste activée en enregistrement 
correspond une région MIDI dans la playlist et 
dans la liste des régions.

Création de régions MIDI sur des barres 
de mesure

Lors de l'enregistrement ou de la saisie de notes 
MIDI, les marques de début et de fin des régions 
MIDI sont créées dans les limites des barres de 
mesure. Cela permet de placer les régions MIDI 
en fonction de la musique sur toute la longueur 
des barres.

Le début d'une région MIDI enregistrée sur la 
barre de mesure précède immédiatement la 
première note MIDI de la région. De même, la 
fin d'une région MIDI enregistrée sur la barre de 
mesure suit immédiatement la dernière note 
MIDI de la région. 

Ecrasement de régions MIDI existantes

A la différence des régions audio, les régions 
MIDI existantes ne sont pas écrasables, mais les 
données MIDI qui les composent le sont. Si le 
mode de fusion MIDI est désactivé lors de 
l'enregistrement de données MIDI sur une piste 
qui contient déjà des régions, les données MIDI 
enregistrées écrasent celles des régions 
existantes. Cependant, les limites des régions 
restent les mêmes. D'autres régions MIDI 
peuvent être créées pour combler les espaces 

Pour préparer des pistes supplémentaires à 
l'enregistrement, cliquez sur le bouton 
Record Enable tout en appuyant sur la 
touche Maj.

Bouton d'enregistrement en mode de préparation à 
l'enregistrement

Appuyez sur F12 pour lancer 
immédiatement l'enregistrement. 
Vous pouvez également utiliser la 
combinaison de touches Ctrl+barre d'espace 
(Windows) ou Pomme+barre d'espace 
(Mac). Pour plus d'informations, 
reportez-vous à la section Raccourcis pour 
l'enregistrement, page 329.
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vides compris dans les limites d'une région MIDI 
existante. Cette création s'effectue généralement 
sur les barres de mesure. Si les limites de la 
région n'y figurent pas, les régions créées sont 
délimitées par les autres régions existantes.

Lecture de données MIDI 
enregistrées

Pour lire une piste MIDI ou une piste d'instrument 
enregistrée :

1  Dans la fenêtre Transport, cliquez sur le 
bouton de retour à zéro pour vous assurer que 
l'enregistrement commencera au début de la 
session.

2  Pour commencer la lecture, cliquez sur le 
bouton de lecture de la fenêtre Transport.

Les données MIDI enregistrées sont lues sur 
chaque canal et périphérique de sortie (port) 
affectés à la piste.

Annulation d'un enregistrement 
MIDI

Vous pouvez annuler des prises MIDI déjà 
enregistrées.

Pour annuler un enregistrement MIDI :

" Après avoir arrêté le Transport, choisissez Edit 
> Undo MIDI Recording. 

La playlist de la piste revient à son état antérieur. 
L'annulation est sujette aux conditions 
suivantes :

• Si vous avez appliqué plusieurs 
entrées/sorties d'enregistrement avant 
l'arrêt du Transport, seule la dernière partie 
enregistrée est annulée.

• En mode d'enregistrement en boucle, 
toutes les prises enregistrées passe après 
passe sont annulées.

Annulation d'une prise 
d'enregistrement

Il est également possible d'annuler la prise en 
cours avant l'arrêt du Transport.

Pour annuler une prise en cours d'enregistrement :

" Appuyez sur Ctrl+point (.) (Windows) ou 
Pomme+point (.) (Mac) avant l'arrêt du 
transport.

En mode d'enregistrement en boucle, toutes les 
prises enregistrées passe après passe sont 
annulées.

Enregistrement MIDI 
fractionné
Pour remplacer une partie de la piste MIDI ou de 
la piste d'instrument, vous pouvez définir un 
point d'entrée en spécifiant la région à réenregis-
trer avant l'enregistrement proprement dit.

Pour définir des points d'entrée sur une piste MIDI 
ou une piste d'instrument :

1  Configurez une piste MIDI ou d'instrument 
pour l'enregistrement (voir Configuration de 
pistes MIDI ou de pistes d'instrument pour 
l'enregistrement, page 352).

La première note MIDI peut appartenir à 
une région MIDI et la dernière note à la 
région MIDI suivante. La fin de la région 
peut également se situer avant la dernière 
note et étendre ainsi les notes au-delà de la 
limite de la région. Toutefois, le début d'une 
région ne peut pas être précédé par une 
première note. 
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2  Placez Pro Tools en mode d'enregistrement 
normal non destructif. Dans le menu Options, 
désélectionnez au besoin les options Destructive 
Record, Loop Record, QuickPunch, TrackPunch 
(Pro Tools HD uniquement) et 
DestructivePunch (Pro Tools HD uniquement).

3  Dans la fenêtre Transport, désactivez Attendre 
la note et Décompte.

4  Sélectionnez Options > Link Timeline and 
Edit Selection.

5  A l'aide du sélecteur, sélectionnez la plage 
d'insertion dans la playlist de la piste.

6  Pour écouter ce qui se trouve déjà sur la piste 
jusqu'au point d'entrée, ou après le point de 
sortie de l'enregistrement, activez les pré et 
post-roll et spécifiez leurs durées (voir Définition 
des paramètres de pré et post-roll, page 341).

7  Activez pour l'enregistrement la piste 
contenant la prise précédente.

8  Dans la fenêtre Transport, cliquez sur le 
bouton d'enregistrement pour préparer 
Pro Tools à l'enregistrement. Le bouton 
d'enregistrement clignote.

9  Cliquez ensuite sur Lecture pour lancer 
l'enregistrement.

Si le pré-roll est activé, les données se trouvant 
sur la piste sont lues jusqu'au point d'entrée de 
l'enregistrement. Vous pouvez commencer à 
jouer pendant le pré-roll pour vous mettre dans 
l'ambiance. Les données MIDI ne sont pas 
enregistrées tant que le point d'entrée de 
l'enregistrement n'est pas atteint.

Lorsque le point de début est atteint, Pro Tools 
commence l'enregistrement. L'enregistrement 
se poursuit jusqu'au point final. Si le post-roll est 
activé, la lecture se poursuit pendant le temps 
spécifié.

10  Pour interrompre l'enregistrement, cliquez 
sur le bouton d'arrêt de la fenêtre Transport.

Les dernières données MIDI enregistrées 
apparaissent dans la piste.

Enregistrement fractionné en cours de 
lecture en MIDI

Il n'est pas obligatoire de définir au préalable 
une région d'enregistrement pour définir un 
point d'entrée sur une piste MIDI ou une piste 
d'instrument. En fait, vous pouvez appliquer des 
entrées/sorties d'enregistrement à tout moment 
en cours de lecture. Contrairement aux pistes 
audio, il n'est pas nécessaire d'activer 
l'enregistrement QuickPunch pour réaliser un 
enregistrement à la volée.

Pour enregistrer à la volée en MIDI :

1  Configurez une piste MIDI ou d'instrument 
pour l'enregistrement (voir Configuration de 
pistes MIDI ou de pistes d'instrument pour 
l'enregistrement, page 352).

2  Placez Pro Tools en mode d'enregistrement 
normal non destructif. Dans le menu Options, 
désélectionnez au besoin les options Destructive 
Record, Loop Record, QuickPunch, TrackPunch 
(Pro Tools HD uniquement) et 
DestructivePunch (Pro Tools HD uniquement).

3  Dans la fenêtre Transport, désactivez Attendre 
la note et Décompte.

4  Activez pour l'enregistrement la piste 
contenant la prise précédente.

5  Pour commencer la lecture, cliquez sur le 
bouton de lecture de la fenêtre Transport. 

Pour connaître d'autres méthodes 
permettant de définir la plage 
d'enregistrement, reportez-vous à la section 
Définition des points d'enregistrement 
fractionné et de boucle, page 338.



Guide de référence Pro Tools358

6  Une fois le point d'entrée d'enregistrement 
atteint, effectuez l'une des opérations suivantes :

• Cliquez sur le bouton d'enregistrement de 
la fenêtre Transport.

– ou –

• Sur les systèmes Pro Tools compatibles avec 
les surfaces de contrôle Digidesign ou les 
systèmes Digi 001 et Digi 002 Rack 
disposant d'une pédale, appuyez sur celle-ci 
au point d'entrée d'enregistrement désiré.

Lors de l'enregistrement, le bouton 
d'enregistrement de la fenêtre Transport et celui 
de la préparation à l'enregistrement de la piste 
cessent de clignoter et restent allumés.

7  Pour arrêter l'enregistrement, cliquez de 
nouveau sur Record (ou appuyez sur la pédale).

Pro Tools quitte alors le mode d'enregistrement 
et continue la lecture. Vous pouvez appliquer 
d'autres entrées/sorties d'enregistrement au 
cours de la même passe.

Régions et enregistrement 
fractionné

Selon la plage d'enregistrement, de nouvelles 
régions peuvent être créées à l'issue de 
l'enregistrement fractionné. Par exemple, la 
figure 15 montre les deux régions existant avant 
l'enregistrement. Si le mode de fusion MIDI est 
désactivé, l'enregistrement remplace toutes les 
données MIDI contenues dans la plage 
d'enregistrement. Lorsque le début et la fin 
d'enregistrement se situent entre deux limites de 
régions, les notes sont enregistrées dans 
chacune des régions ainsi que dans une nouvelle 
région créée afin de combler l'espace vide entre 
les deux régions.

Lorsque vous sélectionnez avant 
l'enregistrement fractionné une région entière 
ou une partie de région, aucune région n'est 
créée. Dans ce cas, seules les données se trouvant 
dans la région existante sont modifiées, aucune 
donnée nouvelle n'étant enregistrée hors de la 
région.

Dans ce cas de figure, contrairement à 
l'enregistrement audio, l'enregistrement MIDI 
est destructif. Les données MIDI venant d'être 
enregistrées remplacent les données MIDI de la 
région, sans modifier les limites de celle-ci.

Si les données MIDI d'une région sont modifiées 
suite à une prise d'enregistrement, les données 
d'origine sont perdues (sauf si vous choisissez 
Edit > Undo MIDI Recording) ou associées aux 
nouvelles données (si l'option MIDI Merge était 
activée pendant l'enregistrement). Si vous 
souhaitez conserver les données de la région, 
vous pouvez utiliser l'option Duplicate pour 
copier la région (Commande Duplicate, 
page 521) ou la playlist de la piste, ou encore 
sauvegarder les données à conserver dans une 
nouvelle playlist (voir Utilisation des playlists, 
page 414).

Figure 15.  Région ajoutée après l'enregistrement 
fractionné

avant l'enregistrement fractionné

après l'enregistrement fractionné

nouvelle région
données venant

d'être enregistrées
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Enregistrement MIDI en 
boucle
L'enregistrement MIDI en boucle peut 
s'effectuer selon deux méthodes : 

• En mode normal non destructif, activez le 
mode de lecture en boucle et la fusion MIDI 
pour l'enregistrement en boucle de type boîte 
à rythme.

– ou –

• Utilisez le mode d'enregistrement en boucle 
pour enregistrer plusieurs prises successives à 
chaque passe d'enregistrement. Cette 
méthode est semblable à l'enregistrement 
audio en boucle.

Enregistrement en boucle et mode 
de fusion MIDI

Pour l'enregistrement en boucle de données 
MIDI, utilisez le mode normal non destructif en 
activant le mode de lecture en boucle (Loop 
Playback) et la fusion MIDI (MIDI Merge). Cette 
méthode permet d'enregistrer et de fusionner les 
données MIDI sur une même région passe après 
passe d'enregistrement. De cette façon, vous 
pouvez par exemple enregistrer une charley lors 
d'une première passe, la grosse caisse/caisse 
claire lors d'une seconde, etc.

Vérifiez que la fusion MIDI est active dans la 
fenêtre Transport. Dans le cas contraire 
(en mode Replace), chaque prise remplacera la 
précédente de façon destructive.

Pour enregistrer en boucle en mode de 
fusion MIDI :

1  Configurez une piste MIDI ou d'instrument 
pour l'enregistrement (voir Configuration de 
pistes MIDI ou de pistes d'instrument pour 
l'enregistrement, page 352).

2  Placez Pro Tools en mode d'enregistrement 
normal non destructif. Dans le menu Options, 
désélectionnez au besoin les options Destructive 
Record, Loop Record, QuickPunch, TrackPunch 
(Pro Tools HD uniquement) et 
DestructivePunch (Pro Tools HD uniquement).

3  Sélectionnez Options > Loop Playback. 
Lorsque l'option de lecture en boucle est active, 
le symbole d'une boucle s'affiche dans le bouton 
Play.

4  Activez la piste MIDI ou d'instrument pour 
l'enregistrement. Vérifiez qu'aucune piste audio 
n'est en mode d'enregistrement.

5  Dans la fenêtre Transport, cliquez sur le 
bouton de fusion MIDI pour qu'il soit mis en 
surbrillance.

Pour les enregistrements de type boîte à 
rythme, utilisez la fonction Step Input (voir 
Step Input, page 697).

Vous pouvez activer à la volée une autre 
piste MIDI ou d'instrument en 
enregistrement pendant un enregistrement 
en boucle. Maintenez enfoncée la touche 
Pomme (Mac) ou Ctrl (Windows) et 
appuyez sur les flèches haut/bas pour 
préparer la piste MIDI ou d'instrument 
précédente ou suivante à l'enregistrement.

Mode de lecture en boucle activé
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6  Désactivez Attendre la note et Décompte dans 
la fenêtre Transport.

7  Sélectionnez Options > Link Timeline and 
Edit Selection.

8  A l'aide du sélecteur, sélectionnez la plage de 
boucle dans la playlist de la piste.

9  Pour écouter jusqu'au début de la boucle, 
activez le pré-roll et définissez sa durée (voir 
Définition des paramètres de pré et post-roll, 
page 341).

10  Dans la fenêtre Transport, cliquez sur le 
bouton d'enregistrement pour préparer 
Pro Tools à l'enregistrement. Le bouton 
d'enregistrement clignote.

11  Cliquez ensuite sur Lecture pour lancer 
l'enregistrement.

Le bouton d'enregistrement clignote pendant le 
pré-roll. Lorsque le point de début est atteint, 
Pro Tools commence l'enregistrement. Lorsque 
le point de fin est atteint, Pro Tools retourne au 
point de début et continue la lecture et 
l'enregistrement.

12  Tapez sur les touches du contrôleur MIDI. 
Les nouvelles données MIDI enregistrées 
apparaissent sous forme de région dans la piste 
d'enregistrement. Prise après prise, les données 
enregistrées apparaissent dans la région sans 
remplacer les données des prises précédentes.

13  Pour passer à une nouvelle piste, appuyez sur 
la touche Ctrl (Windows) ou Pomme (Mac), puis 
sur les touches Haut/Bas pour activer 
l'enregistrement de la piste MIDI ou 
d'instrument suivante ou précédente.

14  Pour interrompre l'enregistrement, cliquez 
sur le bouton d'arrêt de la fenêtre Transport.

Les nouvelles données MIDI enregistrées 
apparaissent sous la forme d'une région MIDI 
dans la playlist de la piste et dans la liste des 
régions.

Enregistrement en boucle de 
plusieurs prises

Lorsque vous enregistrez des données MIDI en 
mode d'enregistrement en boucle, des régions 
sont créées chaque fois que de nouvelles 
données sont reçues pendant une passe 
d'enregistrement. Cela est quelque peu différent 
de l'enregistrement audio en boucle, dans lequel 
un fichier audio unique comprenant toutes les 
prises est créé. Ces prises apparaissent en tant 
que régions individuelles dans la liste des 
régions.

Cette méthode d'enregistrement MIDI en boucle 
permet d'enregistrer prise après prise sans 
interrompre l'enregistrement, afin de préserver 
la spontanéité du processus de création. 
Cette méthode d'enregistrement MIDI possède 
un autre avantage : comme elle est non 
destructive, les régions existantes et les régions 
créées demeurent intactes (et s'affichent dans la 
liste des régions).

Pour enregistrer des données MIDI en mode 
d'enregistrement en boucle :

1  Configurez une piste MIDI ou d'instrument 
pour l'enregistrement (voir Configuration de 
pistes MIDI ou de pistes d'instrument pour 
l'enregistrement, page 352).

2  Sélectionnez Options > Loop Record. Lorsque 
le mode Loop Record est actif, le symbole d'une 
boucle apparaît dans le bouton 
d'enregistrement.

Pour connaître d'autres méthodes 
permettant de définir la plage 
d'enregistrement, reportez-vous à la section 
Définition des points d'enregistrement 
fractionné et de boucle, page 338.
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3  Si vous ne l'avez pas déjà fait, activez le mode 
d'enregistrement pour la piste MIDI ou la piste 
d'instrument en cliquant sur le bouton Record 
Enable correspondant. Vérifiez qu'aucune piste 
audio n'est en mode d'enregistrement.

4  Désactivez Attendre la note et Décompte dans 
la fenêtre Transport.

5  Sélectionnez Options > Link Timeline and 
Edit Selection.

6  A l'aide du sélecteur, sélectionnez la plage de 
boucle dans la playlist de la piste.

7  Pour écouter jusqu'au début de la boucle, 
activez le pré-roll et définissez sa durée (voir 
Définition des paramètres de pré et post-roll, 
page 341).

8  Dans la fenêtre Transport, cliquez sur le 
bouton d'enregistrement pour préparer 
Pro Tools à l'enregistrement. Le bouton 
d'enregistrement clignote.

9  Cliquez ensuite sur Lecture pour lancer 
l'enregistrement.

Le bouton d'enregistrement clignote pendant le 
pré-roll. Lorsque le point de début est atteint, 
Pro Tools commence l'enregistrement. Lorsque 
le point de fin est atteint, Pro Tools retourne au 
point de début et continue la lecture et 
l'enregistrement.

10  Tapez sur les touches du contrôleur MIDI. 
Une région MIDI contenant les nouvelles 
données enregistrées est créée automatiquement 
et apparaît dans la playlist de la piste, 
remplaçant la région précédente.

Les régions sont remplacées (de façon non 
destructive) passe après passe d'enregistrement 
lorsque de nouvelles données MIDI sont reçues.

11  Pour interrompre l'enregistrement, cliquez 
sur le bouton d'arrêt de la fenêtre Transport.

Les prises enregistrées apparaissent sous forme 
de régions dans la liste des régions et sont 
numérotées de façon séquentielle. Vous pouvez 
ainsi écouter les prises, de même durée et 
facilement interchangeables, à partir du menu 
contextuel des prises identiques, même lorsque 
la session est en lecture ou en boucle.

Pour écouter des prises d'enregistrement 
différentes :

" Cliquez avec le bouton droit de la souris sur la 
région et sélectionnez la prise de votre choix 
dans le menu contextuel des pistes identiques. 

" Maintenez enfoncée la touche Ctrl (Windows) 
ou Pomme (Mac) et cliquez avec le sélecteur sur 
le début de la plage d'enregistrement en boucle 
ou fractionné. Sélectionnez ensuite une prise 
différente dans le menu contextuel qui s'affiche.

" Si la prise se trouvant sur la piste est 
sélectionnée, maintenez enfoncée la touche Ctrl 
(Windows) ou Pomme (Mac) et cliquez 
n'importe où dans la prise avec le sélecteur afin 
de sélectionner une prise différente dans le 
menu contextuel qui s'affiche.

Mode d'enregistrement en boucle activé

Pour connaître d'autres méthodes 
permettant de définir la plage 
d'enregistrement, reportez-vous à la section 
Définition des points d'enregistrement 
fractionné et de boucle, page 338.
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La prise (région) sélectionnée remplace la prise 
précédente et se positionne précisément à 
l'endroit correct.

Option MIDI Step Input
L'option Step Input permet d'utiliser un clavier 
MIDI (ou tout autre contrôleur capable 
d'envoyer des notes MIDI) pour entrer des notes 
individuellement, l'une après l'autre. Vous 
bénéficiez ainsi du contrôle précis de la position, 
de la durée et de la vélocité de la note. MIDI Step 
Input vous donne également la possibilité de 
créer des passages musicaux difficiles à 
interpréter fidèlement ou joués à un tempo plus 
rapide. 

Enregistrement de données 
System Exclusive
Pro Tools permet l'enregistrement et la lecture 
de données System Exclusive (Sysex) sur des 
pistes MIDI. Cela permet d'utiliser des pistes 
MIDI dans Pro Tools pour stocker des données 
de patches (programmes) et de configuration 
des appareils MIDI, ou d'enregistrer en temps 
réel des changements de valeurs Sysex 
correspondant à un paramètre particulier d'un 
périphérique MIDI qui ne peut pas être contrôlé 
par un contrôleur MIDI standard.

Pour enregistrer un « dump » (transfert de 
données) Sysex au début d'une piste MIDI :

1  Vérifiez que la prise MIDI OUT du 
périphérique émettant les données Sysex est 
connectée à la prise MIDI IN de votre interface 
MIDI.

2  Dans la boîte de dialogue MIDI Input Filter, 
activez les cases Only et System Exclusive.

3  Configurez une piste MIDI pour 
l'enregistrement (voir Configuration de pistes 
MIDI ou de pistes d'instrument pour 
l'enregistrement, page 352).

4  Placez Pro Tools en mode d'enregistrement 
normal non destructif. Dans le menu Options, 
désélectionnez au besoin les options Destructive 
Record, Loop Record, QuickPunch, TrackPunch 
(Pro Tools HD uniquement) et 
DestructivePunch (Pro Tools HD uniquement).

5  Activez une piste MIDI pour l'enregistrement.

6  Activez l'option Wait for Note dans la fenêtre 
Transport.

7  Dans la fenêtre Transport, cliquez sur le 
bouton de retour à zéro pour vous assurer que 
l'enregistrement commencera au début de la 
session.

Sélection d'une prise MIDI différente

Pour plus d'informations sur l'audition et la 
gestion des prises, consultez Ecoute des 
prises enregistrées dans la timeline, 
page 335.

Pour plus d'informations sur l'option Step 
Input, consultez la section Step Input, 
page 697.
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8  Lorsque vous êtes prêt à enregistrer, cliquez 
sur Record dans la fenêtre Transport. 

Les boutons d'enregistrement, de lecture et 
d'attente de note clignotent pour indiquer que 
Pro Tools attend des données MIDI.

9  Lancez le transfert des données Sysex depuis le 
périphérique MIDI en suivant les instructions 
du fabricant. Pro Tools démarre 
automatiquement l'enregistrement à la 
réception des données Sysex.

10  Après le transfert des données Sysex, cliquez 
sur le bouton d'arrêt de la fenêtre Transport.

Les nouvelles données MIDI enregistrées 
apparaissent sous la forme d'une région MIDI 
dans la playlist de la piste et dans la liste des 
régions. Les régions MIDI contenant des 
données System Exclusive apparaissent vides 
lorsque l'affichage de la piste MIDI est réglé sur 
Regions.

Pour que les blocs d'événements Sysex 
indiquant l'emplacement des données 
s'affichent, réglez la vue de la piste MIDI en 
affichage Sysex (voir Vue Regions pour les pistes 
MIDI et les pistes d'instrument, page 404). 

Pour envoyer des données Sysex d'un système 
Pro Tools vers un périphérique MIDI externe :

1  Vérifiez que la prise MIDI IN du périphérique 
recevant les données System Exclusive est 
connectée à la prise MIDI OUT de votre interface 
MIDI. Vérifiez également que le périphérique est 
configuré pour recevoir des données Sysex. 
Certains périphériques obligent à désactiver la 
protection de la mémoire. Pour de plus amples 
informations, reportez-vous aux instructions du 
fabricant.

2  Vérifiez que la piste MIDI contenant les 
données Sysex n'est pas en mode 
d'enregistrement.

3  Cliquez sur le sélecteur de sortie MIDI de la 
piste et assignez le périphérique à partir du 
menu déroulant.

4  Configurez le périphérique MIDI externe pour 
la réception des données Sysex en suivant les 
instructions du fabricant.

5  Pour commencer la lecture, cliquez sur le 
bouton de lecture de la fenêtre Transport. 
Pro Tools commence à lire et à transmettre les 
données Sysex précédemment enregistrées au 
périphérique MIDI désigné.

Pour plus d'informations sur le 
déplacement et la copie de données Sysex, 
consultez la section Evénements System 
Exclusive, page 666.
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Enregistrement de données 
audio à partir d'un instrument 
MIDI
Pour contrôler l'audio d'un instrument MIDI 
(plug-in ou non), vous pouvez généralement 
utiliser les pistes d'entrée auxiliaire et 
d'instrument. Lors du mixage final, les données 
audio des pistes d'instrument et d'entrée 
auxiliaire peuvent être incluses avec l'option 
Bounce to Disk. Si l'enregistrement s'effectue sur 
une nouvelle piste, vous pouvez également avoir 
recours au transfert d'un chemin 
d'enregistrement. 

Enregistrement de données audio d'un 
plug-in d'instrument

Pour enregistrer des données audio d'un plug-in 
d'instrument :

1  Créez une piste d'instrument.

2  Insérez un plug-in d'instrument sur la piste 
créée.

3  Effectuez l'une des opérations suivantes :

• Enregistrez le morceau MIDI sur la piste 
d'instrument.

• Saisissez les données MIDI dans la piste 
d'instrument.

4  Créez une piste audio composée du même 
nombre de canaux que la piste d'instrument.

5  Définissez le sélecteur de sortie audio de la 
piste d'instrument sur un bus (Bus 1–2, par 
exemple).

6  Définissez le sélecteur d'entrée audio de la 
piste audio sur le même bus.

7  Définissez le sélecteur de sortie audio de la 
piste audio sur le chemin d'écoute principale 
(A 1–2, par exemple).

8  Activez la piste audio pour l'enregistrement.

9  Effectuez l'une des opérations suivantes :

• Dans la fenêtre Transport, cliquez sur le 
bouton de retour à zéro pour vous assurer 
que l'enregistrement commencera au début 
de la session.

– ou –

• Sélectionnez la plage d'enregistrement 
dans la timeline.

10  Dans la fenêtre Transport, cliquez sur le 
bouton d'enregistrement pour préparer 
Pro Tools à l'enregistrement.

11  Pour commencer l'enregistrement, cliquez 
sur le bouton de lecture de la fenêtre Transport.

Avec des plug-in d'instrument, vous pouvez 
enregistrer les données audio d'un 
instrument MIDI vers une nouvelle piste 
avant le mixage afin de libérer des 
ressources DSP.

Vous pouvez également enregistrer 
simultanément les données MIDI et audio 
du morceau.
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12  Pour interrompre la lecture du morceau MIDI 
enregistré précédemment, cliquez sur le bouton 
d'arrêt dans la fenêtre Transport.

Enregistrement de données audio à 
partir d'un instrument MIDI externe

Vous pouvez enregistrer les données audio d'un 
instrument MIDI externe de deux façons :

• En acheminant vers une piste audio en mode 
d'enregistrement les données audio à partir de 
la sortie de la piste d'instrument (ou d'entrée 
auxiliaire) qui écoute l'instrument MIDI. 

• En définissant le sélecteur du chemin d'entrée 
audio de la piste audio sur le même chemin 
d'entrée audio que celui de la piste 
d'instrument (ou d'entrée auxiliaire) qui 
écoute l'instrument MIDI. 

Cette seconde méthode limite l'effet de latence 
associé au transfert. Avant de procéder à 
l'enregistrement du même chemin audio, 
vérifiez néanmoins que le son de la piste 
d'instrument (ou d'entrée auxiliaire) qui sert à 
l'écoute est coupé.

Enregistrement de données audio d'un plug-in 
d'instrument
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Chapitre 17 : Techniques 
d'enregistrement fractionné avancées

Il existe trois méthodes d'enregistrement 
avancées : QuickPunch, TrackPunch et 
DestructivePunch. 

QuickPunch : mode d'enregistrement non 
destructif permettant d'appliquer des entrées et 
des sorties d'enregistrement dans les pistes en 
mode d'enregistrement pendant la lecture, par le 
biais du bouton d'enregistrement de la fenêtre 
Transport.

TrackPunch (Pro Tools HD uniquement) : 
mode d'enregistrement non destructif 
permettant d'appliquer des entrées et des sorties 
d'enregistrement dans les pistes ou de les sortir 
du mode d'enregistrement sans interrompre 
l'enregistrement et la lecture en ligne.

DestructivePunch (Pro Tools HD uniquement) : 

mode d'enregistrement non destructif avec un 
seul fichier audio continu, permettant 
d'appliquer des entrées et des sorties 
d'enregistrement dans les pistes ou de les sortir 
du mode d'enregistrement sans interrompre 
l'enregistrement et la lecture en ligne.

Enregistrement audio 
QuickPunch
Pro Tools offre une fonction d'enregistrement à 
la volée, intitulée QuickPunch. QuickPunch 
permet pendant la lecture d'appliquer 
instantanément des entrées et des sorties 
d'enregistrement sur les pistes audio en mode 
d'enregistrement en cliquant sur le bouton 
d'enregistrement de la fenêtre Transport.

En mode QuickPunch, Pro Tools commence 
l'enregistrement d'un nouveau fichier dès que la 
lecture débute et crée automatiquement des 
régions au sein de ce fichier à chaque point 
d'entrée et de sortie de l'enregistrement. 
Ces régions apparaissent dans la playlist de la 
piste. Le fichier audio complet apparaît dans la 
liste des régions avec les régions créées en mode 
QuickPunch. Vous pouvez ainsi, dans une 
même passe, effectuer jusqu'à 200 points 
d'entrée et de sortie d'enregistrement. 
Contrairement à l'enregistrement fractionné 
normal (voir Enregistrement audio fractionné, 
page 332), QuickPunch gère la commutation 

Sur les systèmes Pro Tools compatibles avec 
les surfaces de contrôle ainsi que sur les 
systèmes Digi 002 et Digi 002 Rack, vous 
pouvez utiliser une pédale pour entrer et 
sortir à tout moment de l'enregistrement 
avec QuickPunch.
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d'écoute (passage des données enregistrées aux 
données antérieures au point de sortie de 
l'enregistrement). Tous les enregistrements 
QuickPunch sont non destructifs.

QuickPunch/TrackPunch Crossfade 
Length (Longueur des crossfades crées 
par enregistrement QuickPunch et 
TrackPunch)

Pro Tools peut écrire automatiquement un 
crossfade à chaque point d'entrée ou de sortie 
d'enregistrement lorsque vous utilisez 
QuickPunch. La durée de ces crossfades se 
définit via l'option QuickPunch 
Crossfade/TrackPunch Length dans la page 
Editing Preferences.

Pour définir la durée des crossfades en mode 
QuickPunch :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Editing.

2  Entrez une valeur (en ms) pour la longueur de 
crossfade QuickPunch /TrackPunch.

Une durée de crossfade de 10 est une valeur 
assez commune. Si vous définissez cette 
préférence sur une valeur nulle, Pro Tools ne 
crée aucun crossfade aux points d'entrée et de 
sortie de l'enregistrement.

3  Cliquez sur OK.

Si vous avez spécifié une valeur de crossfade 
QuickPunch/TrackPunch non nulle, Pro Tools 
crée un crossfade au point d'entrée (ce crossfade 
commence avant ce point et s'étend jusqu'à 
celui-ci) et un autre crossfade au point de sortie 
(qui s'étend après la région d'enregistrement).

Même si la durée du crossfade 
QuickPunch/TrackPunch est nulle, Pro Tools 
exécute toujours un crossfade d'écoute (qui ne 
s'écrit pas sur le disque) d'une durée de 
4 millisecondes pour éviter les clics parasites qui 
risquent de se produire lorsque vous entrez et 
sortez du mode d'enregistrement.

Vous pouvez modifier les crossfades 
QuickPunch de la même façon que les crossfades 
standard (voir Utilisation des fondus, page 539).

Instructions d'enregistrement 
pour Pro Tools HD

Lorsque vous utilisez l'enregistrement 
QuickPunch (à la volée) sur un système 
Pro Tools HD, deux voix sont nécessaires pour 
chaque piste mono en mode d'enregistrement. 
Vous pouvez ainsi enregistrer jusqu'à la moitié 
du nombre total de voix disponibles sur votre 
système. Par exemple, un système Pro Tools|HD 
Accel avec 192 voix peut enregistrer en 
QuickPunch sur 96 pistes mono (ou 48 pistes 
stéréo) au maximum simultanément.

Si le nombre de voix nécessaire pour les pistes 
activées en enregistrement n'est pas disponible 
lorsque vous passez en mode QuickPunch, vous 
êtes invité à libérer des voix.

Il n'est pas nécessaire d'activer l'option 
QuickPunch pour effectuer des 
enregistrements à la volée avec les pistes 
MIDI. Cette possibilité existe dans le mode 
d'enregistrement normal (non destructif) et 
dans le mode d'enregistrement destructif.
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Pour libérer des voix sur des pistes qui ne sont pas 
activées en enregistrement et qu'il n'est pas 
nécessaire d'écouter pendant l'enregistrement, 
effectuez l'une des opérations suivantes :

" Définissez l'assignation des voix des pistes sur 
Off.

" Désactivez des pistes.

" Rassemblez tous les plug-in RTAS avant les 
plug-in TDM.

En fonction des besoins, des voix utilisées par 
d'autres pistes désactivées en enregistrement 
peuvent être « volées » pendant 
l'enregistrement avec QuickPunch. L'ordre de 
priorité des pistes lors d'un enregistrement 
QuickPunch est le suivant :

• Les pistes dont les voix sont assignées, mais 
qui ne sont pas en mode d'enregistrement.

• Les pistes dont les voix sont assignées qui 
sont en mode d'enregistrement.

• Les pistes à assignation dynamique des 
voix qui ne sont pas en mode 
d'enregistrement.

• Les pistes à assignation dynamique des 
voix qui sont en mode d'enregistrement.

Si la session comprend un grand nombre de voix 
disponibles, vous ne devriez pas rencontrer de 
problème en utilisant QuickPunch avec des 
pistes à assignation dynamique des voix. 
Toutefois, si les voix viennent à manquer et que 
vous voulez être sûr qu'une piste restera audible 
pendant l'enregistrement QuickPunch, 
assignez-lui une voix.

QuickPunch et assignation dynamique 
des voix

(Pro Tools HD uniquement)

Lorsque vous utilisez QuickPunch avec un 
système Pro Tools|HD configuré pour 
l'utilisation d'un maximum de voix, veillez à 
régler l'assignation des voix pour chaque piste 
audio sur Dyn (ce qui correspond à Dynamically 
Allocated Voicing). Ceci permet à Pro Tools de 
gérer la distribution des voix entre les deux 
ensembles de voix. Ainsi, pour un système 
Pro Tools|HD Accel à 192 voix, l'option 
d'assignation dynamique des voix répartit les 
voix de façon égale entre les quatre ensembles 
de voix (1 à 48, 49 à 96, 97–144 et 145 à 192).

Si vous n'utilisez pas l'option d'assignation 
dynamique des voix, ces dernières doivent être 
réparties de façon égale entre tous les moteurs 
DSP. Pour utiliser, par exemple, QuickPunch sur 
32 pistes sans l'option d'assignation dynamique 
des voix, les pistes 1 à 16 doivent être affectées 
aux voix 1 à 16 et les pistes 17 à 32 aux voix 33 
à 48.

Instructions d'enregistrement 
pour Pro Tools LE

Sur les systèmes Pro Tools LE, vous pouvez 
enregistrer simultanément jusqu'à 16 pistes 
mono et 8 pistes stéréo avec QuickPunch (voir 
Fonctionnalités des systèmes Pro Tools LE, 
page 34).

Sur les systèmes Pro Tools LE avec DV Toolkit 2 
ou Music Production Toolkit, vous pouvez 
enregistrer simultanément jusqu'à 24 pistes 
mono ou stéreo avec QuickPunch. Néanmoins, 
le nombre de pistes audio et QuickPunch ne 
peut dépasser 48.
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Enregistrement avec QuickPunch

Pour enregistrer à la volée avec QuickPunch :

1  Avec Pro Tools HD, assurez-vous que l'option 
Delay Compensation est désactivée dans le 
menu Options.

2  Sélectionnez Options > QuickPunch. Lorsque 
l'option QuickPunch est activée, la lettre P 
s'affiche sur le bouton d'enregistrement. 

3  Pour modifier l'option de crossfade 
automatique utilisé par QuickPunch, configurez 
l'option QuickPunch Crossfade Length dans la 
page Editing Preferences (voir 
QuickPunch/TrackPunch Crossfade Length 
(Longueur des crossfades crées par 
enregistrement QuickPunch et TrackPunch), 
page 368).

4  Préparez les pistes auxquelles vous souhaitez 
appliquer l'enregistrement. Vérifiez que le 
système dispose d'un nombre de voix suffisant.

5  Préparez-vous à enregistrer en positionnant 
Pro Tools à l'endroit désiré. Si vous le souhaitez, 
activez une valeur de pré-roll dans la fenêtre 
Transport.

6  Démarrez la lecture en cliquant sur Play dans 
la fenêtre Transport.

7  Effectuez l’une des opérations suivantes :

• A l'endroit du début de l'enregistrement, 
cliquez sur Record dans la fenêtre 
Transport.

– ou –

• Sur les systèmes Pro Tools compatibles avec 
les surfaces de contrôle Digidesign ou un 
système Digi 001 ou Digi 002 Rack 
disposant d’une pédale, appuyez sur celle-
ci au point d’entrée d’enregistrement 
désiré.

Le bouton d'enregistrement cesse de clignoter et 
reste allumé pendant l'enregistrement.

8  Pour arrêter l'enregistrement, cliquez de 
nouveau sur Record (ou appuyez sur la pédale).

Tandis que Pro Tools continue la lecture, vous 
pouvez effectuer d'autres entrées/sorties 
d'enregistrement (jusqu'à 100). Dans ce cas de 
figure, un seul fichier audio est enregistré, à 
partir duquel Pro Tools crée les régions 
appropriées.

QuickPunch avec une sélection 
d'édition

Si vous effectuez une sélection d'édition et 
utilisez QuickPunch, les règles suivantes 
s'appliquent :

! Si le Transport n’est pas activé, 
l'enregistrement commence et s'arrête chaque 
fois que vous cliquez sur le bouton 
d'enregistrement, quels que soient les points de 
début et de fin de la sélection. 

! Si le Transport est activé, le comportement en 
entrée/sortie de l'enregistrement est contrôlé par 
le paramètre Online Options de la page 
Operation Preferences. Si vous sélectionnez 
Record Online at Insertion/Selection, 

QuickPunch utilise la puissance du 
processeur, ce qui risque de réduire le 
nombre de pistes et de plug-in que vous 
pouvez utiliser.

Digidesign recommande l'enregistrement 
sans compensation de retard. Pour plus 
d'informations, reportez-vous à la section 
Compensation de retard, page 757. 

QuickPunch activé

QuickPunch activé
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QuickPunch ne permet d'entrer/sortir de 
l'enregistrement qu'au sein de la sélection (ou 
dans le cas d'un point d'insertion, seulement 
après celui-ci). Si vous sélectionnez Record 
Online at Time Code Lock, QuickPunch ne tient 
pas compte de la sélection et entre/sort de 
l'enregistrement quand vous le souhaitez (une 
fois Pro Tools synchronisé sur le timecode).

Numérotation des régions et des prises 
avec QuickPunch

Après un enregistrement avec QuickPunch, les 
nouvelles régions audio apparaissent dans la 
liste des régions. Ceci comprend la région audio 
correspondant au fichier englobant tous les 
points d'entrée/sortie effectués au cours de la 
passe d'enregistrement, ainsi que les régions 
« dérivées » de chaque point d'entrée et de 
sortie.

Les noms des régions QuickPunch sont 
numérotés de façon séquentielle, en 
commençant par 01. Par exemple, si vous entrez 
deux fois en enregistrement QuickPunch sur 
une piste nommée Lead Gtr, une région du 
fichier audio parent apparaît, nommée Lead 
Gtr_01, ainsi que deux régions correspondant 
aux entrées d'enregistrement QuickPunch, 
intitulées Lead Gtr_01_01 et Lead Gtr_01_02. 

Si vous arrêtez la lecture puis effectuez d'autres 
enregistrements en QuickPunch, les régions 
suivantes seront nommées de manière 
incrémentielle, en augmentant à chaque fois 
d'une unité les deux premiers chiffres du nom. 
Par exemple, lors de la seconde passe, les régions 
QuickPunch sont nommées Lead Gtr_02_01, 
Lead Gtr_02_02, et ainsi de suite.

Enregistrement audio 
TrackPunch
(Pro Tools HD uniquement)

TrackPunch est un défileur numérique 
particulièrement utile pour le réenregistrement 
de films (doublage) et le mixage. Des raccourcis 
clavier et des paramètres par défaut pour 
l'enregistrement et l'écoute des signaux d'entrée 
offrent un certain niveau de flexibilité qui fait de 
TrackPunch un mode également utile pour les 
chargements d'épreuves et l'enregistrement de 
bruitages, ainsi que pour l'enregistrement 
fractionné et le suivi dans les sessions musicales. 

Instructions d'utilisation de la fonction 
TrackPunch

TrackPunch et assignation dynamique des voix

Si vous utilisez le mode TrackPunch sur un 
système Pro Tools|HD configuré pour 
l'utilisation d'un maximum de voix, veillez à 
régler l'assignation des voix pour chaque piste 
audio sur dyn (ce qui correspond à Dynamically 
Allocated Voicing, précédemment appelé Auto 
Voice). Pro Tools peut ainsi gérer 
automatiquement les voix plus efficacement. 

Fichiers audio et TrackPunch

Après une passe d'enregistrement TrackPunch, 
la playlist de la piste concernée dans la fenêtre 
Edit affiche les régions créées à la suite de 
l'insertion des points d'entrée d'enregistrement. 
Vous pouvez utiliser tout outil de trimming 
après l'enregistrement fractionné pour ouvrir le 
début ou la fin des régions enregistrées en mode 
TrackPunch (et QuickPunch) ou pour révéler le 
fichier audio parent qui a été enregistré à 
l'arrière-plan. Vous pouvez ainsi compenser 
pour tout point d'enregistrement manqué ou 
tardif. 
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Nombre de voix nécessaires pour 
l'enregistrement TrackPunch

TrackPunch nécessite deux voix pour chaque 
piste mono en mode d'enregistrement. 
Vous pouvez ainsi enregistrer jusqu'à la moitié 
du nombre total de voix disponibles sur votre 
système. 

Lorsque vous activez le mode TrackPunch, vous 
êtes invité à libérer des voix supplémentaires si 
le nombre de voix disponibles n'est pas 
suffisant. 

Pour libérer des voix sur des pistes qui ne sont pas 
activées en enregistrement et qu'il n'est pas 
nécessaire d'écouter pendant l'enregistrement, 
effectuez l'une des opérations suivantes :

" Définissez l'assignation des voix des pistes 
sur Off.

" Désactivez des pistes.

" Rassemblez tous les plug-in RTAS avant les 
plug-in TDM.

En fonction des besoins, des voix utilisées par 
d'autres pistes peuvent être « volées » pendant 
l'enregistrement avec TrackPunch (certaines 
pistes sont alors coupées).

La priorité de lecture des voix en mode 
TrackPunch est la même qu'avec QuickPunch, 
c'est-à-dire la suivante, par ordre décroissant :

• Les pistes dont les voix sont assignées, mais 
qui ne sont pas en mode d'enregistrement.

• Les pistes dont les voix sont assignées qui 
sont en mode d'enregistrement.

• Les pistes à assignation dynamique des 
voix qui ne sont pas en mode 
d'enregistrement.

• Les pistes à assignation dynamique des 
voix qui sont en mode d'enregistrement.

Si la session comprend un grand nombre de voix 
disponibles, vous ne devriez pas rencontrer de 
problème en utilisant TrackPunch avec des 
pistes à assignation dynamique des voix. 
Toutefois, si les voix viennent à manquer et si 
vous voulez être sûr qu'une piste restera audible 
pendant l'enregistrement TrackPunch, assignez-
lui une voix. 

Enregistrement TrackPunch

Avant d'utiliser TrackPunch, configurez 
Pro Tools et TrackPunch comme suit : 

Pour configurer Pro Tools et TrackPunch : 

1  Configurez les préférences TrackPunch 
(voir Préférences TrackPunch, page 373). 

2  Si nécessaire, configurez les paramètres de 
synchronisation Pro Tools pour 
l'enregistrement en ligne et la préparation des 
pistes (voir Configuration de la synchronisation 
et de l'activation des pistes, page 375).

Pour utiliser TrackPunch :

1  Vérifiez que Pro Tools n'est pas en mode 
d'enregistrement ni de lecture (le transport est 
arrêté). 

2  Assurez-vous que l'option Delay 
Compensation est désactivée dans le menu 
Options.

3  Activez le mode TrackPunch (voir Activation 
du mode TrackPunch, page 375). 

Digidesign recommande l'enregistrement 
sans compensation de retard. Pour en savoir 
plus sur la compensation de retard, 
reportez-vous à Compensation de retard, 
page 757.
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4  Activez en mode TrackPunch toutes les pistes 
audio que vous souhaitez enregistrer de manière 
fractionnée pendant la passe d'enregistrement 
(voir Activation des pistes en mode TrackPunch, 
page 376). 

5  Configurer l'écoute des pistes en mode 
d'enregistrement en sélectionnant le mode 
correspondant dans le menu Track. Vous avez le 
choix entre les options suivantes :

• Set Record Tracks to Auto Input

• Set Rec Enabled Tracks to Input Only

Le choix d'un mode d'écoute affecte 
uniquement les pistes en mode 
d'enregistrement. 

6  Démarrez la lecture. 

7  Pour comparer les niveaux de la source 
d'entrée avec l'audio sur disque, cliquez sur le 
bouton TrackInput. La couleur verte 
(illumination) indique que la piste effectue 
l'écoute de l'entrée. La couleur grise (sans 
illumination) indique que la piste effectue 
l'écoute à partir du disque (voir Sélection du 
mode d'écoute de l'enregistrement avec la 
fonction TrackInput, page 306). 

8  Pour enregistrer de manière fractionnée des 
pistes les unes après les autres, cliquez sur le 
bouton d'enregistrement de la fenêtre 
Transport, puis utilisez les boutons d'activation 
des pistes à l'enregistrement pour appliquer des 
entrées et des sorties d'enregistrement dans 
chaque piste à la volée. 

9  Pour enregistrer de manière fractionnée 
plusieurs pistes simultanément, effectuez l'une 
des actions suivantes : 

• Préparez 16 pistes audio à l'enregistrement 
TrackPunch, puis cliquez sur le bouton 
d'enregistrement de la fenêtre Transport 
pour appliquer simultanément des entrées 
et sorties d'enregistrement dans chaque 
piste en mode d'enregistrement. 

– ou –

• Commencez par cliquer sur le bouton 
d'enregistrement de la fenêtre Transport, 
puis effectuez la combinaison de touches 
Alt+Maj (Windows) ou Option+Maj (Mac) 
et cliquez sur le bouton Record Enable afin 
d'appliquer des entrées et sorties 
d'enregistrement dans les pistes 
sélectionnées pour l'enregistrement 
TrackPunch.

10  Tout en continuant la lecture locale ou 
distante, effectuez l'une des actions suivantes :

• Appliquez des entrées d'enregistrement 
dans d'autres pistes TrackPunch 
séparément :

• Après avoir appliqué une sortie 
d'enregistrement, désactivez les pistes en 
enregistrement et activez d'autres pistes en 
mode d'enregistrement TrackPunch. 

• Répétez cette action pour appliquer des 
sorties d'enregistrement à d'autres stems, 
pistes ou prises. 

Préférences TrackPunch

Les préférences suivantes permettent de 
personnaliser les performances de la fonction 
TrackPunch. 

Vous pouvez également utiliser les boutons 
TrackInput pour changer la source d'écoute 
pour les pistes en mode d'enregistrement. 

Utilisez des groupes pour les sélections de 
plusieurs pistes en un seul clic (cliquez à 
gauche de Group Name dans Group List). 



Guide de référence Pro Tools374

TrackPunch Crossfade Length

Pro Tools peut écrire automatiquement un 
crossfade à chaque point d'entrée ou de sortie 
d'enregistrement lorsque vous utilisez 
TrackPunch. La durée de ces crossfades se définit 
via l'option QuickPunch Crossfade/TrackPunch 
Length dans la page Editing Preferences. Pour 
plus d'informations, reportez-vous à la section 
QuickPunch/TrackPunch Crossfade Length 
(Longueur des crossfades crées par 
enregistrement QuickPunch et TrackPunch), 
page 368.

Paramètres de transport et 
d'enregistrement des pistes

Les préférences TrackPunch s'affichent dans la 
page Operation Preferences. Ces préférences 
permettent de spécifier la façon dont l'état 
d'enregistrement des pistes et du transport doit 
réagir lors de l'arrêt du transport (pendant la 
lecture et l'enregistrement) et d'optimiser 
Pro Tools dans le cadre d'opérations de 
production musicale, vidéo ou 
cinématographique.

Transport RecordLock

Ce paramètre permet de configurer l'option 
Transport Record de façon à émuler un défileur 
numérique ou à conserver le comportement 
hérité pour l'enregistrement principal dans la 
fenêtre Transport. 

! Si ce paramètre n'est pas sélectionné, l'option 
Transport Record est désactivée lorsque 
Pro Tools est arrêté manuellement ou lorsqu'il 
s'interrompt en raison d'une perte de timecode. 
Cela reproduit le comportement 
d'enregistrement Pro Tools hérité. 

! Si ce paramètre est sélectionné, l'option 
Transport Record reste activée même en cas 
d'arrêt de la lecture ou de l'enregistrement. 
Ceci évite de réactiver le transport entre chaque 
prise, ce qui émule le comportement d'un 
défileur numérique. 

Destructive Recording et Transport RecordLock

Afin d'empêcher tout enregistrement accidentel 
sur des données précédemment enregistrées, la 
préférence Transport RecordLock est 
automatiquement désactivée et grisée lorsque le 
mode d'enregistrement Destructive est activé. 

Audio Track RecordLock

Ce paramètre permet aux pistes Pro Tools 
d'émuler un défileur numérique ou de conserver 
le comportement hérité pour l'état 
d'enregistrement des pistes. 

! Lorsque la préférence Audio RecordLock est 
activée, les pistes audio en mode 
d'enregistrement restent activées même en cas 
d'arrêt de la lecture ou de l'enregistrement. 

Préférences TrackPunch

Si vous sortez de l'enregistrement en 
cliquant sur le bouton d'enregistrement 
dans la fenêtre Transport, vous sortez 
également du mode prêt à l'enregistrement.
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! Lorsque la préférence Audio RecordLock n'est 
pas activée, les pistes audio quittent le mode 
d'enregistrement en cas d'arrêt de Pro Tools. 
Ceci permet d'éviter que les pistes ne restent 
activées d'une passe à l'autre, émulant le 
comportement d'enregistrement de piste d'un 
défileur numérique.

Destructive Recording et Transport RecordLock

Afin d'empêcher tout enregistrement accidentel 
sur des données précédemment enregistrées, la 
préférence Transport RecordLock est 
automatiquement désactivée et grisée lorsque le 
mode d'enregistrement Destructive est activé. 

Configuration de la 
synchronisation et de 
l'activation des pistes

Dans le cadre de l'enregistrement en ligne et de 
l'enregistrement fractionné, configurez les 
paramètres Peripheral et Session Setup en 
procédant comme suit : Pour obtenir des temps 
de verrouillage optimaux lors de la 
synchronisation, il est déconseillé d'appliquer le 
mode TrackPunch à plus de 16 pistes à la fois.

Pour procéder à un enregistrement en ligne à 
l'aide de la permutation TrackPunch :

1  Sélectionnez Setup > Peripherals. Vérifiez que 
le périphérique de synchronisation sélectionné 
est Digidesign SYNC et qu'il communique avec 
Pro Tools. 

2  Choisissez Setup > Session et procédez ainsi :

• Sélectionnez une référence de position et 
d'horloge. 

• Si vous voulez que Pro Tools serve de 
périphérique de timecode principal, activez 
l'option Using SYNC. Cette option fait 
partie des commandes Generator situées 
dans la zone Time Code Settings de la 
fenêtre Session Setup. 

3  Si vous contrôlez Pro Tools à l'aide d'un 
protocole 9 broches, procédez comme suit :

• Cliquez sur l'onglet Machine Control pour 
afficher la page Machine Control dans la 
boîte de dialogue Peripherals (sous Setup > 
Peripherals). 

• Configurez les paramètres du mode Remote 
9-pin Deck Emulation (voir le guide 
MachineControl).

• Cliquez sur OK pour refermer la boîte de 
dialogue Peripherals.

Activation du mode TrackPunch

Avant de pouvoir activer des pistes audio 
individuelles pour effectuer un enregistrement 
en mode TrackPunch, ce dernier doit avoir été 
activé au niveau du transport Pro Tools.

Pour activer le mode TrackPunch :

1  Vérifiez que Pro Tools n'est pas en mode 
d'enregistrement ni de lecture (le transport est 
arrêté).

2  Effectuez l’une des opérations suivantes :

• Sélectionnez Options > TrackPunch.

• Cliquez avec le bouton droit de la souris sur 
le bouton d'enregistrement de la fenêtre 
Transport, puis sélectionnez la commande 
TrackPunch du menu contextuel.

• Tout en maintenant la touche Démarrer 
(Windows) ou Ctrl (Mac) enfoncée, cliquez 
sur le bouton d'enregistrement de la fenêtre 
Transport pour faire défiler les modes 
d'enregistrement disponibles jusqu'à ce que 
le mode TrackPunch soit sélectionné (un T 
majuscule indique le mode TrackPunch). 

Contactez le fabricant de votre contrôleur 
pour obtenir les profils les plus récents et les 
mises à jour disponibles pour la prise en 
charge de Pro Tools. 
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• Appuyez sur Pomme+Maj+T (Mac) ou sur 
Ctrl+Maj+T (Windows).

Affichage de l'état du mode 
TrackPunch dans la fenêtre 
Transport

Bouton Transport Record

Le bouton Transport Record indique le statut 
TrackPunch et Record comme suit :

Lorsque le mode TrackPunch est activé :

! Un T majuscule s'affiche sur le bouton 
d'enregistrement de la fenêtre Transport. 

! Si au moins une piste est en mode 
TrackPunch, le bouton d'enregistrement reste 
allumé en bleu. 

Lorsque le mode TrackPunch est activé et que 
le transport est prêt à l'enregistrement :

! Si aucune piste n'est en mode TrackPunch, le 
bouton d'enregistrement clignote en gris et 
rouge. 

! Si au moins une piste est en mode 
TrackPunch, le bouton d'enregistrement 
clignote en bleu et rouge.

! Si au moins une piste est en mode TrackPunch 
et en mode d'enregistrement, le bouton 
d'enregistrement clignote en rouge et bleu et le 
voyant d'enregistrement s'allume.

! Dès qu'au moins une piste est en mode 
d'enregistrement, le bouton Transport Record 
reste allumé en rouge.

Activation des pistes en mode 
TrackPunch

Vous pouvez activer des pistes en mode 
TrackPunch sans les activer en enregistrement 
afin d'appliquer des entrées et sorties sur des 
pistes spécifiques après le lancement de la 
lecture. 

Pour activer ou désactiver une piste en mode 
TrackPunch :

" Maintenez enfoncée la touche Ctrl (Windows) 
ou Ctrl (Mac) et cliquez sur le bouton Record 
Enable de la piste. Il s'allume en bleu pour 
indiquer que le modeTrackPunch est activé. 

Pour activer ou désactiver toutes les pistes audio 
en mode TrackPunch : 

" Maintenez enfoncées les touches 
Alt+Démarrer (Windows) ou Option+Ctrl (Mac) 
et cliquez sur le bouton Record Enable de la 
piste. Le bouton de la piste s'allume en bleu pour 
indiquer que le modeTrackPunch est activé.

Pour activer ou désactiver toutes les pistes audio 
sélectionnées en mode TrackPunch :

" Maintenez enfoncées les touches 
Alt+Démarrer+Maj (Windows) ou 
Option+Ctrl+Maj (Mac) et cliquez sur le bouton 
Record Enable de la piste. Les boutons des pistes 
sélectionnées s'allument en bleu pour indiquer 
que le modeTrackPunch est activé.

Bouton Transport Record avec mode TrackPunch activé

Indicateurs d'état des modes TrackPunch et TrackInput 
dans la fenêtre Transport

TrackPunch activé
Indicateur d'état 
de l'activation en 
enregistrement

Indicateur 
d'état de 
l'entrée
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Affichage de l'état d'enregistrement 
des pistes

Le bouton Record Enable de chaque piste 
indique son état d'activation en mode 
TrackPunch et en mode d'enregistrement 
comme suit :

• Si les deux modes sont activés pour une piste, 
son bouton Record Enable clignote en bleu et 
rouge. 

• Si le mode TrackPunch est activé pour une 
piste mais pas le mode enregistrement, son 
bouton Record Enable reste allumé en bleu. 

• Si seul le mode enregistrement est activé pour 
une piste, son bouton Record Enable clignote 
en rouge. 

• Si une piste se trouve en cours 
d'enregistrement (quel que soit le mode), son 
bouton Record Enable reste allumé en rouge.

Enregistrement TrackPunch

Après avoir activé le mode TrackPunch de 
Pro Tools et activé ce type d'enregistrement 
pour des pistes, vous pouvez procéder à 
l'enregistrement de différentes manières.

Entrées d'enregistrement sur 
différentes pistes

Pour effectuer des entrées d'enregistrement sur 
des pistes :

1  Activez le mode TrackPunch de Pro Tools.

2  Tout en maintenant enfoncée la touche 
Démarrer (Windows) ou Ctrl (Mac), cliquez sur 
le bouton Record Enable de chaque piste 
concernée afin de n'activer pour celle-ci que le 
mode TrackPunch. Le bouton Record Enable de 
la piste doit rester allumé en bleu. 

3  Cliquez sur Record dans la fenêtre Transport 
pour activer le mode d'enregistrement 
TrackPunch. Le bouton d'enregistrement 
clignote en bleu et rouge.

4  Pour commencer la lecture, cliquez sur le 
bouton de lecture de la fenêtre Transport.

5  Pendant la lecture, effectuez des entrées ou 
sorties d'enregistrement sur des pistes en mode 
TrackPunch en cliquant sur leurs boutons 
Record Enable respectifs.

6  Arrêtez la lecture. Une fois la passe d'enregis-
trement terminée, les états du mode d'enregis-
trement et de la préparation à l'enregistrement 
correspondent à la configuration par défaut 
TrackPunch actuelle. 

Créez des groupes de pistes pour chaque 
stem ou ensemble de pistes sur lesquelles 
vous prévoyez d'effectuer une entrée. La liste 
des groupes permet de sélectionner 
rapidement toutes les pistes du groupe. 
Il s'avère ainsi plus facile d'activer ou de 
désactiver simultanément plusieurs pistes 
en mode TrackPunch. 

Indication de l'état du mode TrackPunch d'une piste 
audio dans la fenêtre Mix

Bouton d'enregistrement

Etat d'enregistrement d'une piste dans la fenêtre Edit

Un allumage en rouge permanent 
indique l'enregistrement (tous les 
modes)
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Application simultanée d'entrées 
d'enregistrement sur plusieurs pistes

Pour appliquer simultanément des entrées 
d'enregistrement sur plusieurs pistes :

1  Activez le mode TrackPunch (voir Activation 
du mode TrackPunch, page 375).

2  Cliquez sur le bouton Record Enable de 
chaque piste concernée afin d'activer pour celle-
ci les modes TrackPunch et enregistrement. 
Le bouton Record Enable de la piste clignote en 
bleu et rouge. 

3  Pour commencer la lecture, cliquez sur le 
bouton de lecture de la fenêtre Transport.

4  Pendant la lecture, cliquez sur le bouton 
d'enregistrement de la fenêtre Transport pour 
effectuer simultanément des entrées ou sorties 
d'enregistrement sur toutes les pistes en mode 
TrackPunch. 

5  Arrêtez la lecture. Une fois la passe 
d'enregistrement terminée, les états du mode 
enregistrement et de la préparation à 
l'enregistrement correspondent à la 
configuration par défaut TrackPunch actuelle. 

Lancement de l'enregistrement sur 
toutes les pistes

Pour effectuer des entrées d'enregistrement sur 
toutes les pistes :

1  Activez le mode TrackPunch (voir Activation 
du mode TrackPunch, page 375).

2  Cliquez sur le bouton Record Enable de 
chaque piste concernée afin d'activer pour celle-
ci les modes TrackPunch et enregistrement. 
Le bouton Record Enable de la piste clignote en 
bleu et rouge. 

3  Cliquez sur Record dans la fenêtre Transport 
pour activer le mode d'enregistrement 
TrackPunch. Le bouton d'enregistrement 
clignote en bleu et rouge.

4  Pour commencer la lecture, cliquez sur le 
bouton de lecture de la fenêtre Transport.

5  Pendant la lecture, effectuez des entrées ou 
sorties d'enregistrement sur des pistes en mode 
TrackPunch en cliquant sur leurs boutons 
Record Enable respectifs.

6  Arrêtez la lecture. Une fois la passe 
d'enregistrement terminée, les états du mode 
enregistrement et de la préparation à 
l'enregistrement correspondent à la 
configuration par défaut TrackPunch actuelle. 

Procédures TrackPunch

Pro Tools émule et améliore les quatre 
procédures suivantes, souvent appliquées en 
production cinématographique, vidéo et 
musicale :

• Doublage et mixage de films (voir Doublage et 
mixage de films avec TrackPunch, page 379)

• Chargement d'épreuves (voir Chargement 
d'épreuves à l'aide de la préférence 
RecordLock, page 380)

• Enregistrement de bruitages (voir 
Enregistrement de bruitages avec TrackPunch, 
page 380)

• Suivi et enregistrement fractionné pour la 
production musicale et tout autre 
environnement d'enregistrement (voir Suivi 
et enregistrement fractionné de musique en 
mode TrackPunch, page 381)

Chacune de ces procédures tire parti des 
fonctionnalités et options du mode TrackPunch. 
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Les exemples pratiques ci-dessous partent du 
principe que vous connaissez déjà les 
techniques d'acheminement, de sélection et de 
groupement des pistes Pro Tools. Si ce n'est pas 
le cas, reportez-vous au chapitre 10, Pistes et au 
chapitre 28, Mixage : principes de base.

Doublage et mixage de films avec 
TrackPunch

En offrant toutes les capacités d'enregistrement 
fractionné en ligne et de permutation d'écoute 
d'un défileur numérique, TrackPunch optimise 
Pro Tools pour le réenregistrement et le mixage 
des films. 

Les fonctionnalités de doublage et de mixage de 
films de TrackPunch offrent les possibilités 
suivantes :

• Activation et enregistrement fractionné de 
pistes audio Pro Tools à distance, à partir d'un 
synchroniseur principal (comme les 
commandes SoundMaster through P2), à tout 
moment, sans interruption de la lecture et 
tout en maintenant la synchronisation avec le 
timecode (requiert Digidesign 
MachineControl)

• Bascule des pistes audio Pro Tools entre 
l'écoute d'entrée et de disque 

• Utilisation de TrackPunch lorsque Pro Tools 
sert de périphérique principal de timecode 
(génération) ou lors de l'asservissement. 

• Comme Pro Tools peut être utilisé en réseau, 
les fichiers audio TrackPunch (et tous les 
autres) et les sessions entières peuvent être 
utilisés pour un transfert sécurisé vers d'autres 
systèmes à des fins de vérification, de 
modification et d'archivage. 

Les sessions de pré-doublage types utilisant 
TrackPunch impliquent les étapes suivantes :

1  Configurez la synchronisation entre Pro Tools 
et les autres dispositifs. 

2  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation.

3  Sélectionnez (activez) Transport RecordLock. 
Cela permet au bouton d'enregistrement de 
rester activé après la fin du transport.

4  Désactivez Audio Track RecordLock. Cela 
permet de désactiver l'enregistrement de la piste 
audio à la fin du transport.

5  Choisissez Options > TrackPunch pour activer 
le mode TrackPunch. 

6  Créez 32 pistes, puis effectuez les actions 
suivantes : 

• Affectez leurs entrées.

• Groupez-les par huit. 

7  Cliquez sur les boutons d'activation de 
l'enregistrement dans les huit premières pistes 
pour les faire passer en mode TrackPunch (ou le 
groupe pour la première passe de pré-doublage).

8  Affectez les commandes de la console au 
premier groupe de huit pistes dans la session. 

En mode Remote, Transport RecordLock n'a 
aucun effet. Le synchroniseur détermine le 
comportement.

En mode Remote, Audio Track RecordLock 
n'a aucun effet. Le synchroniseur détermine 
le comportement.

Utilisez la liste de groupes pour sélectionner 
rapidement toutes les pistes du groupe, puis 
cliquez en maintenant les touches Alt+Maj 
(Windows) ou Option+Maj (Mac) enfoncées 
pour activer en enregistrement toutes les 
pistes du groupe.
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9  Commencez la passe de pré-doublage. Utilisez 
les commandes de la console pour activer 
Pro Tools et pour appliquer des entrées et sorties 
d'enregistrement au premier groupe. 

10  Lorsque le premier pré-doublage est terminé 
et que toutes les pistes sont désactivées pour 
l'enregistrement, supprimez toutes les pistes en 
mode TrackPunch.

11  Sélectionnez le groupe de pistes suivant et 
activez-les pour le mode TrackPunch.

12  Appliquez des entrées et sorties 
d'enregistrement au deuxième groupe de pistes. 

13  Au besoin, répétez les étapes précédentes.

Chargement d'épreuves à l'aide 
de la préférence RecordLock

Outre le doublage et le mixage, Pro Tools facilite 
le chargement d'épreuves. Les épreuves et les 
types de transferts comparables sont composés 
de plusieurs prises ou scènes, chacune étant 
enregistrée tout en étant synchronisée avec un 
timecode horaire unique. Entre les prises, le 
timecode ne continue pas ; il s'arrête 
complètement. C'est pourquoi le timecode des 
épreuves et des données source comparables est 
qualifié de discontinu. 

Lorsqu'une session est mise hors ligne pendant 
l'enregistrement en raison de la discontinuité du 
timecode, Pro Tools reste activé et attend la 
reprise du timecode. Pro Tools recommence 
l'enregistrement lorsque la synchronisation est 
rétablie avec le timecode pour la prise suivante. 
Chaque piste est enregistrée dans son propre 
fichier audio. 

Pour configurer RecordLock pour le chargement :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation. 

2  Activez Transport RecordLock. 

3  Activez Audio Track RecordLock. 

4  Configurez la synchronisation et les autres 
paramètres. 

5  Mettez Pro Tools en ligne et démarrez le 
lecteur source externe. 

6  Chaque fois que le timecode s'interrompt ou 
s'arrête, Pro Tools reste en ligne et attend de 
recevoir un nouveau timecode. Les pistes 
activées pour le transport et l'enregistrement 
restent activées pour l'enregistrement (ou en 
mode TrackPunch). Lorsque le timecode 
reprend, Pro Tools commence l'enregistrement 
dans un nouveau fichier (avec un marquage 
temporel correct basé sur le code entrant). 

Enregistrement de bruitages avec 
TrackPunch

L'enregistrement des bruitages est un type 
d'enregistrement dont les conditions de 
contrôle sont spécifiques. Entre les entrées ou 
sorties d'enregistrement et les prises, les entrées 
doivent être coupées lorsque les artistes de 
bruitage se déplacent avec leur matériel pendant 
les scènes. 

L'écoute TrackInput peut être configurée pour la 
prise en charge de l'enregistrement TrackPunch 
des bruitages avec la préférence Mute Record-
Armed Tracks While Stopped.

Pour configurer Pro Tools pour le contrôle 
d'enregistrement TrackPunch des bruitages : 

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation.

2  Activez Mute Record-Armed Tracks While 
Stopped.

Comme Pro Tools dispose d'une limite de 
timeline de 13 heures, vous devez utiliser 
plusieurs sessions pour charger les épreuves 
si l'écart est supérieur à 13 heures.



Chapitre 17 : Techniques d'enregistrement fractionné avancées 381

3  Configurez la synchronisation et les autres 
paramètres de Pro Tools et des différents 
périphériques, puis activez le mode TrackPunch 
et procédez à l'enregistrement TrackPunch 
(reportez-vous à Enregistrement TrackPunch, 
page 372 pour connaître les différentes étapes 
impliquées).

Si l'option Mute Record-Armed Tracks While 
Stopped est activée lors d'un enregistrement en 
ligne, les pistes activées en enregistrement sont 
coupées si le transport est arrêté. L'écoute des 
entrées reste possible, à tout moment, au moyen 
du commutateur TrackInput. 

Suivi et enregistrement fractionné 
de musique en mode TrackPunch

L'enregistrement multipiste moderne requiert la 
possibilité de « capturer l'instant » en 
permettant l'enregistrement à la volée et 
TrackPunch. Les fonctions de TrackPunch pour 
les situations de suivi et enregistrement 
fractionné sont notamment les suivantes :

• Activez les pistes pour l'enregistrement à la 
volée. 

• Appliquez des entrées et sorties 
d'enregistrement à l'aide des boutons Record 
Enable à l'écran, à distance à partir d'un 
synchroniseur, à l'aide d'une surface de 
contrôle ou au moyen d'une pédale. 

• Comparez les niveaux à l'aide du 
commutateur TrackInput. 

Enregistrement audio 
DestructivePunch
(Pro Tools HD uniquement)

DestructivePunch est un mode d'enregistrement 
destructif qui permet de lancer et d'arrêter instan-
tanément l'enregistrement sur des pistes audio 
individuelles pendant la lecture, tout en conser-
vant un fichier audio contigu pour chaque piste 
enregistrée. Ce mode d'enregistrement ne crée 
aucune région supplémentaire. 

DestructivePunch garantit des procédures de 
mixage et de pré-doublage efficaces des fichiers 
contigus uniques sans points de montage.

DestructivePunch est en fait une version des-
tructive du mode TrackPunch. A la différence du 
mode TrackPunch qui utilise un fichier en ar-
rière-plan, le mode destructif DestructivePunch 
permet d'enregistrer l'audio directement dans le 
fichier d'origine par le biais d'un crossfade li-
néaire fixé à 10 ms. Vous pouvez ainsi, dans une 
même passe DestructivePunch, effectuer jusqu'à 
200 points d'entrée et de sortie d'enregistre-
ment.

DestructivePunch et MachineControl

Si vous utilisez le logiciel Digidesign 
MachineControl en mode Remote 9-Pin Deck 
Emulation, il est possible de contrôler la 
fonction DestructivePunch par l'intermédiaire 
du protocole P2. 

DestructivePunch et allocation des voix

A l'instar des modes TrackPunch et QuickPunch, 
le mode DestructivePunch nécessite 2 voix par 
piste mono. Lorsque vous utilisez Destructive-
Punch avec un système Pro Tools|HD configuré 
pour l'utilisation d'un maximum de voix, veillez 
à régler l'assignation des voix pour chaque piste 
audio sur Dyn ( Dynamically Allocated Voicing). 
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Pro Tools peut ainsi gérer automatiquement les 
voix plus efficacement. 

Configuration de Pro Tools pour 
l'enregistrement en mode 
DestructivePunch

Avant d'utiliser le mode DestructivePunch, 
configurez ses préférences ainsi que les 
paramètres Pro Tools qui lui sont associés 
comme indiqué dans les paragraphes suivants.

Paramètres de transport et 
d'enregistrement des pistes

Les préférences des fonctions Transport 
RecordLock et Audio RecordLock spécifient le 
comportement des pistes et des boutons Record 
Enable de la fenêtre Transport après l'arrêt de la 
lecture ou de l'enregistrement. Leur 
fonctionnement en mode DestructivePunch est 
le même qu'en mode TrackPunch. Pour plus 
d'informations, reportez-vous à la section 
Préférences TrackPunch, page 373.

Paramètres de compensation de retard

En mode DestructivePunch, vérifiez, après avoir 
appliqué une entrée à un enregistrement 
existant, que les paramètres de compensation de 
retard sont identiques à ceux définis pour le 
fichier d'origine.

! Si la compensation du retard était active lors 
de l'enregistrement du fichier d'origine, elle doit 
également l'être lors de l'insertion du point 
d'entrée en mode DestructivePunch. 

! Si la compensation du retard était désactivée 
lors de l'enregistrement du fichier d'origine, elle 
doit également l'être lors de l'insertion du point 
d'entrée en mode DestructivePunch.

Pour maintenir la cohérence du chemin de la 
fonction de compensation du retard au cours de 
l'enregistrement en mode DestructivePunch, 
vous devez empêcher Pro Tools d'utiliser le 
chemin d'écoute à faible latence lorsque les 
pistes d'enregistrement passent en mode 
d'écoute des signaux d'entrée.

Pour vérifier que l'écoute à faible latence est 
désactivée pour une piste d'enregistrement :

" Maintenez enfoncées les touches 
Démarrer+Ctrl (Windows) ou Pomme+Ctrl 
(Mac) et cliquez sur l'indicateur de 
compensation de la piste.

Pour vérifier que l'écoute à faible latence est 
désactivée pour toutes les pistes 
d'enregistrement :

" Maintenez enfoncées les touches 
Démarrer+Ctrl+Maj (Windows) ou 
Pomme+Ctrl+Maj (Mac) et cliquez sur 
l'indicateur de compensation de la piste.

Pour vérifier que l'écoute à faible latence est 
désactivée pour les pistes d'enregistrement 
sélectionnées :

" Maintenez enfoncées les touches 
Démarrer+Ctrl+Alt+Maj (Windows) ou 
Pomme+Ctrl+Option+Maj (Mac) et cliquez sur 
l'indicateur de compensation de la piste.

Activation du mode 
DestructivePunch

Pour enregistrer des pistes audio avec la fonction 
DestructivePunch, vous devez avoir activé au 
préalable le mode DestructivePunch dans 
Pro Tools.
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Pour activer le mode DestructivePunch :

1  Vérifiez que Pro Tools n'est pas en mode 
d'enregistrement ni de lecture (le transport est 
arrêté). 

2  Effectuez l’une des opérations suivantes :

• Sélectionnez Options > DestructivePunch.

• Cliquez avec le bouton droit de la souris sur 
le bouton d'enregistrement de la fenêtre 
Transport, puis sélectionnez la commande 
DestructivePunch du menu contextuel.

• Tout en maintenant la touche Démarrer 
(Windows) ou Ctrl (Mac) enfoncée, cliquez 
sur le bouton d'enregistrement de la fenêtre 
Transport pour faire défiler les modes 
d'enregistrement disponibles jusqu'à ce que 
le mode DestructivePunch soit sélectionné 
(« dp » s'affiche sur le bouton Record 
Enable de la fenêtre Transport). 

Préparation des pistes à 
l'enregistrement 
DestructivePunch

Préparation des pistes à 
l'enregistrement DestructivePunch 
sans le bouton Record Enable

Vous pouvez préparer les pistes à 
l'enregistrement DestructivePunch sans avoir à 
les activer en enregistrement. Cela vous permet, 
après le lancement de la lecture, d'insérer des 
points d'entrée sur des pistes spécifiques en 
cliquant sur leurs boutons Record Enable 
respectifs. 

Pour préparer une piste audio à l'enregistrement 
DestructivePunch :

" Tout en maintenant la touche Démarrer 
(Windows) ou Ctrl (Mac) enfoncée, cliquez sur 
le bouton Record Enable de la piste pour 
l'allumer en bleu.

Pour préparer toutes les pistes audio à 
l'enregistrement DestructivePunch : 

" Tout en maintenant les touches Alt+ 
Démarrer (Windows) ou Option+Ctrl (Mac) 
enfoncées, cliquez sur les boutons Record 
Enable de toutes les pistes pour les allumer en 
bleu.

Pour préparer les pistes audio sélectionnées à 
l'enregistrement DestructivePunch :

" Tout en maintenant les touches 
Démarrer+Alt+Maj (Windows) ou 
Option+Ctrl+Maj (Mac) enfoncées, cliquez sur 
les boutons Record Enable des pistes 
sélectionnées pour les allumer en bleu.

Préparation simultanée des pistes à 
l'enregistrement et au mode 
DestructivePunch

Vous pouvez activer simultanément 
l'enregistrement et le mode DestructivePunch 
pour les pistes audio. Le mode DestructivePunch 
démarre alors dès que l'enregistrement est activé 
dans la fenêtre Transport et que la lecture 
commence.

Pour activer simultanément une piste audio en 
mode DestructivePunch et en mode 
enregistrement :

" Cliquez sur le bouton d'enregistrement de la 
piste. Le bouton Record Enable de la piste 
clignote en bleu et rouge. 

Vous pouvez créer un groupe de VCA pour 
chaque prémixage ou ensemble de pistes à 
enregistrer et utiliser le bouton VCA Record 
Enable pour préparer toutes les pistes du 
groupe à l'enregistrement DestructivePunch. 
Pour plus d'informations, reportez-vous à la 
section Pistes de VCA principal, page 727.
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Pour activer simultanément toutes les pistes 
audio en mode DestructivePunch et en mode 
enregistrement :

" Maintenez la touche Alt (Windows) ou 
Option (Mac) enfoncée et cliquez sur le bouton 
Record Enable de la piste. Le bouton Record 
Enable de toutes les pistes clignote en bleu et 
rouge.

Pour activer simultanément les pistes audio 
sélectionnées en mode DestructivePunch et en 
mode enregistrement :

" Maintenez enfoncées les touches Alt+Maj 
(Windows) ou Option+Maj (Mac) et cliquez sur 
le bouton Record Enable de la piste. Le bouton 
Record Enable des pistes sélectionnées clignote 
en bleu et rouge.

Affichage de l'état 
DestructivePunch

Bouton Transport Record Enable

Le bouton Transport Record Enable indique 
l'état DestructivePunch et le mode 
d'enregistrement comme suit :

Lorsque le mode DestructivePunch est activé :

! Les lettres « dp » s'affichent sur le bouton 
d'enregistrement de la fenêtre Transport. 

! Si au moins une piste est en mode 
DestructivePunch, le bouton d'enregistrement 
de la fenêtre Transport reste allumé en bleu.

Lorsque le mode DestructivePunch est activé et 
que le transport est prêt à l'enregistrement :

! Si aucune piste n'est en mode 
DestructivePunch, le bouton d'enregistrement 
clignote en gris et rouge. 

! Si au moins une piste est en mode 
DestructivePunch, le bouton d'enregistrement 
clignote en bleu et rouge.

! Si au moins une piste est en mode 
DestructivePunch et en mode d'enregistrement, 
le bouton d'enregistrement clignote en rouge et 
bleu et le voyant d'enregistrement s'allume.

! Dès qu'au moins une piste est en mode 
d'enregistrement, le bouton d'enregistrement 
reste allumé en rouge.

Bouton d'enregistrement de la fenêtre Transport en 
mode DestructivePunch

Etat DestructivePunch dans la fenêtre Transport

Voyant 

Mode DestructivePunch actif

Voyant de 
statut de 
l'entrée

d'enregistrement
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Affichage de l'état d'enregistrement 
des pistes

Lorsque Pro Tools est en mode 
DestructivePunch, l'état du mode 
d'enregistrement et du mode DestructivePunch 
des pistes est indiqué comme suit sur leurs 
boutons Record Enable respectifs :

• Si les deux modes sont activés pour une piste, 
son bouton Record Enable clignote en bleu et 
rouge. 

• Si le mode DestructivePunch est activé pour 
une piste mais pas le mode d'enregistrement, 
son bouton Record Enable reste allumé en 
bleu. 

• Si seul le mode enregistrement est activé pour 
une piste, son bouton Record Enable clignote 
en rouge.

• Si une piste se trouve en cours 
d'enregistrement (quel que soit le mode), son 
bouton Record Enable reste allumé en rouge.

Voyants de statut de l'enregistrement 
et de l'entrée

Les voyants d'enregistrement et d'entrée situés 
en regard du bouton d'enregistrement de la 
fenêtre Transport indiquent l'état de 
l'enregistrement et de l'entrée des pistes comme 
suit, quel que soit le mode d'enregistrement 
choisi :

Voyant de statut de l'enregistrement Lorsqu'il 
est allumé (rouge), cela signifie qu'au moins une 
piste audio est actuellement activée pour 
l'enregistrement. Lorsqu'il est éteint (gris), cela 
signifie qu'aucune piste audio n'est 
actuellement activée pour l'enregistrement. 

Voyant de statut de l'entrée Lorsqu'il est allumé 
(vert), cela signifie qu'au moins une piste audio 
est actuellement réglée sur Input Only 
monitoring (quel que soit le statut d'activation 
de l'enregistrement). Lorsqu'il est éteint (gris), 
cela signifie que toutes les pistes sont réglées sur 
le mode d'écoute Auto Input.
.

Préparation des pistes à 
l'enregistrement 
DestructivePunch

Pour être préparée à l'enregistrement 
DestructivePunch, la piste doit contenir un 
fichier audio contigu remplissant les conditions 
suivantes :

• Le fichier démarre au début de la session 
(échantillon 0). 

– et –

• La longueur du fichier est supérieure ou 
égale à celle du fichier DestructivePunch 
(voir Longueur du fichier 
DestructivePunch, page 386). 

Indication de l'état du mode DestructivePunch d'une 
piste audio dans la fenêtre Mix 

Etat d'enregistrement d'une piste dans la fenêtre Edit

Bouton d'enregistrement

Un allumage en rouge permanent 
indique l'enregistrement (tous les 
modes)

Les boutons Record Enable des pistes 
s'allument également en bleu pour indiquer 
qu'une piste est en mode DestructivePunch.
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Si la piste ne contient pas de fichier remplissant 
ces conditions, vous pouvez effectuer l'une des 
opérations suivantes pour définir le fichier selon 
la configuration requise :

• Déplacez le fichier actuel dans la timeline 
de la piste en le faisant démarrer au début 
de la session.

• Sélectionnez les données de la piste et 
exécutez la commande Consolidate pour 
créer un fichier continu de la longueur 
requise.

• Définissez la longueur du fichier 
DestructivePunch de manière à ce que la 
longueur du fichier actuel soit supérieure 
ou égale à la longueur requise.

• Exécutez la commande Prepare DPE Tracks 
pour consolider les données audio sur 
toutes les pistes préparées à 
l'enregistrement DestructivePunch. Voir 
Utilisation de la commande Prepare DPE 
Tracks, page 386.

Longueur du fichier DestructivePunch

Pour enregistrer une piste audio avec la fonction 
DestructivePunch, la piste doit contenir un 
fichier audio contigu dont la longueur minimale 
doit être spécifiée dans la page des préférences 
de fonctionnement de Pro Tools.

Pour définir la longueur du fichier 
DestructivePunch :

1  Choisissez Setup > Preferences et cliquez sur 
Operations. 

2  Saisissez une valeur pour DestructivePunch 
File Length. 

3  Cliquez sur OK.

Utilisation de la commande Prepare 
DPE Tracks

Pour préparer une piste à l'enregistrement 
DestructivePunch :

1  Activez le mode DestructivePunch (voir 
Activation du mode DestructivePunch, 
page 382). 

2  Vérifiez que les pistes à préparer sont en mode 
DestructivePunch (voir Préparation des pistes à 
l'enregistrement DestructivePunch sans le 
bouton Record Enable, page 383).

3  Sélectionnez Options > Prepare DPE Tracks. 

Pro Tools consolide les données audio sur toutes 
les pistes en mode DestructivePunch du début 
de la session à la valeur spécifiée dans la 
préférence DestructivePunch File Length. 

Enregistrement DestructivePunch

Une fois en mode DestructivePunch, Pro Tools 
permet plusieurs types d'enregistrement des 
pistes préparées au mode DestructivePunch.

Entrées d'enregistrement sur des 
pistes uniques

Pour effectuer des entrées d'enregistrement sur 
des pistes uniques :

1  Activez le mode DestructivePunch 
(voir Activation du mode DestructivePunch, 
page 382). 

2  Tout en maintenant la touche Démarrer 
(Windows) ou Ctrl (Mac) enfoncée, cliquez sur 
le bouton Record Enable de chaque piste 
concernée afin de n'activer pour celle-ci que le 
mode DestructivePunch. Le bouton Record 
Enable de la piste reste allumé en bleu. 
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3  Cliquez sur Record dans la fenêtre Transport 
pour activer le mode d'enregistrement. Le 
bouton Record Enable clignote en bleu et rouge.

4  Pour commencer la lecture, cliquez sur le 
bouton de lecture de la fenêtre Transport.

5  Pendant la lecture, appliquez des entrées ou 
sorties d'enregistrement sur des pistes en mode 
DestructivePunch en cliquant sur leurs boutons 
Record Enable respectifs.

6  Arrêtez la lecture. Une fois la passe 
d'enregistrement terminée, les états du mode 
d'enregistrement et de la préparation de 
l'enregistrement correspondent à la 
configuration actuelle des préférences Audio 
Track RecordLock et Transport RecordLock. 

Application simultanée d'entrées 
d'enregistrement sur plusieurs pistes

Pour appliquer simultanément des entrées 
d'enregistrement sur plusieurs pistes :

1  Activez le mode DestructivePunch (voir 
Activation du mode DestructivePunch, 
page 382). 

2  Cliquez sur le bouton Record Enable de 
chaque piste concernée afin d'activer pour celle-
ci les modes DestructivePunch et 
enregistrement. Le bouton Record Enable de 
chaque piste clignote en bleu et rouge. 

3  Pour commencer la lecture, cliquez sur le 
bouton de lecture de la fenêtre Transport.

4  Pendant la lecture, cliquez sur le bouton 
d'enregistrement de la fenêtre Transport pour 
effectuer simultanément des entrées ou sorties 
d'enregistrement sur toutes les pistes en mode 
DestructivePunch. 

5  Arrêtez la lecture. Une fois la passe 
d'enregistrement terminée, les états d'activation 
en mode enregistrement et de préparation de 
l'enregistrement correspondent à la 
configuration actuelle des préférences Audio 
Track RecordLock et Transport RecordLock.

Démarrage de l'enregistrement 
immédiat sur plusieurs pistes

Pour appliquer des entrées d'enregistrement sur 
plusieurs pistes :

1  Activez le mode DestructivePunch (voir 
Activation du mode DestructivePunch, 
page 382). 

2  Cliquez sur le bouton Record Enable de 
chaque piste concernée afin d'activer pour 
celle-ci les modes DestructivePunch et 
enregistrement. Le bouton Record Enable de 
chaque piste clignote en bleu et rouge. 

3  Cliquez sur Record dans la fenêtre Transport 
pour activer le mode d'enregistrement. 
Le bouton d'enregistrement clignote en bleu et 
rouge.

4  Pour commencer la lecture, cliquez sur le 
bouton de lecture de la fenêtre Transport.

5  Pendant la lecture, effectuez des entrées ou 
sorties d'enregistrement sur des pistes en mode 
DestructivePunch en cliquant sur leurs boutons 
Record Enable respectifs.

6  Arrêtez la lecture. Une fois la passe 
d'enregistrement terminée, les états d'activation 
en mode enregistrement et de préparation de 
l'enregistrement correspondent à la 
configuration actuelle des préférences Audio 
Track RecordLock et Transport RecordLock. 
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Chapitre 18 : Notions de base d'édition

Edition dans Pro Tools
La fenêtre Edit de Pro Tools offre un puissant 
ensemble d'outils d'édition et d'assemblage de 
pistes audio, vidéo et MIDI. Les données des 
pistes peuvent être éditées de façon non 
destructive et en temps réel pendant la lecture. 
La fenêtre Edit vous permet également d'éditer 
graphiquement l'automation des pistes. 

Edition non destructive

La grande majorité des opérations d'édition 
audio dans Pro Tools est non destructive. Qu'il 
s'agisse de couper, de coller, de « rogner », de 
séparer ou de supprimer des régions, vous 
n'effectuez ces opérations que sur une carte des 
données audio réelles. Les fichiers audio sources 
demeurent intacts. Cependant, certains 

processus ou outils indiqués dans ce guide 
fonctionnent de façon destructive (ce qui 
signifie qu'ils modifient définitivement les 
fichiers audio de votre disque dur).

Si l'édition de pistes MIDI peut être destructive 
dans certains cas, le respect de quelques 
précautions vous permettra de préserver vos 
pistes et vos régions MIDI importantes lorsque 
vous effectuerez des opérations d'édition (voir 
Edition MIDI non destructive, page 406).

Edition en cours de lecture

Pro Tools permet d'effectuer de nombreuses 
tâches d'édition pendant la lecture de la session. 
Cette particularité permet de modifier et d'éditer 
une session de façon interactive, puisque vous 
entendez immédiatement les modifications 
apportées. Il existe de nombreux cas dans 
lesquels vous pourrez utiliser cette particularité 
pour augmenter votre productivité lorsque vous 
travaillez dans une session. 

Vous trouverez ci-après quelques exemples 
d'édition que vous pouvez réaliser au cours 
d'une boucle ou pendant la lecture de vos 
pistes :

• Capture, séparation et rognage de régions

• Placement, repérage ou réorganisation de 
régions

• Ajout de fondus ou de crossfades à des 
régions audio

Pour en savoir plus sur l'édition de données 
MIDI, reportez–vous à la section 
chapitre 25, Édition MIDI. 

Pour en savoir plus sur l'édition de données 
vidéo, reportez–vous à la section 
chapitre 36, Traitement vidéo dans 
Pro Tools.

Pour plus d'informations sur l'option 
Automation de la fenêtre Edit, consultez le 
chapitre 30, Automation
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• Transposition, quantification (y compris 
Groove Quantize) et autres modifications 
des pistes MIDI 

• Déplacement par décalage de régions audio 
ou MIDI

• Ecoute de différentes playlists

• Réglage ou mise à l'échelle de données 
d'automation

• Insertion d'un plug-in temps réel

• Traitement de l'audio avec un plug-in 
AudioSuite

• Edition d'un point d'inflexion 
d'automation

Lorsque Pro Tools est en lecture, certains aspects 
ne peuvent être modifiés. Ce guide s'y rapporte 
au fur et à mesure de la présentation des 
fonctions.

Données de la piste
Chaque fois que vous enregistrez ou importez 
des données audio, vidéo et MIDI, Pro Tools crée 
des régions pour les nouvelles données de la 
piste, qui indiquent où elles commencent et où 
elles se terminent, mais qui offrent également 
un aperçu de leur forme d'onde générale et de 
leur contenu. Lorsque vous enregistrez des prises 
supplémentaires ou que vous entrez à un 
emplacement donné d'une piste, Pro Tools crée 
des régions.

On peut également créer des régions en coupant 
et collant, en redimensionnant, en séparant et 
en re-capturant des régions existantes. Les 
régions d'une session s'affichent dans la liste des 
régions, d'où l'on peut les faire glisser vers des 
pistes existantes. Une piste peut contenir un 

nombre indifférent de régions, dans n'importe 
quelle disposition. La playlist d'une piste définit 
l'ordre de lecture et l'emplacement des régions 
composant une piste. 

Types de régions

Il existe différents types de régions audio et 
MIDI en fonction de leur mode de création :

Régions audio de fichiers complets : ces régions 
audio sont créées pendant l'enregistrement ou 
l'importation de données audio, le regroupe-
ment de régions existantes et le traitement non 
destructif par un plug-in AudioSuite. Les régions 
audio de fichiers complets font référence à un fi-
chier audio complet qui se trouve sur votre dis-
que dur. Les régions audio de fichiers complets 
s'affichent en gras dans la liste des régions 
(voir Liste des régions, page 419). Les régions 
normales ne font souvent référence qu'à une 
partie du fichier audio parent et sont créées en 
cours d'édition et, dans certains cas, en cours 
d'enregistrement fractionné.

Régions définies par l'utilisateur : il s'agit des ré-
gions définies de façon explicite par l'utilisateur, 
par exemple lors de l'enregistrement ou de l'im-
portation de données audio ou MIDI ; quand 
vous capturez, séparez ou regroupez une 
sélection ; quand vous « rognez » une région 
audio d'un fichier complet ou encore quand 
vous renommez une région existante.

En plus des régions audio et MIDI, les pistes 
offrent des playlists d'automation de toute 
donnée d'automation (notamment de 
volume). L'automation peut être enregistrée 
et éditée dans les fenêtres Edit ou Mix. Pour 
plus d'informations, reportez-vous à la 
section chapitre 30, Automation.

Pour plus d'informations sur les régions 
vidéo, consultez la section chapitre 36, 
Traitement vidéo dans Pro Tools.
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Régions créées automatiquement : ces régions 
sont créées automatiquement en cours d'édition 
et, dans certains cas, en cours d'enregistrement 
fractionné dans des régions existantes. Dans la 
mesure où ces régions peuvent rapidement 
s'accumuler au cours d'une session, vous pouvez 
les masquer dans la liste des régions (voir 
Attribution de noms et affichage des régions, 
page 564). les régions créées automatiquement 
peuvent être transformées en régions définies 
par l'utilisateur en les renommant.

Régions Offline : Les régions sont offline lorsque 
leurs fichiers parents sont introuvables ou non 
disponibles à l'ouverture d'une session ou lors de 
l'importation d'une piste. Les régions offline 
apparaissent estompées et en italiques dans la 
liste des régions ; elles apparaissent en bleu clair 
avec leur nom en italiques dans les playlists. 
Les régions offline peuvent être éditées au même 
titre que les autres régions, mais elles ne peuvent 
être traitées par des plug-in AudioSuite. 

Régions multicanaux : ces régions, qui 
s'affichent en tant que région unique dans la 
liste des régions, font référence à plusieurs 
régions et fichiers audio pour les pistes stéréo et 
Surround. Les régions multicanaux peuvent être 
agrandies (en cliquant sur le triangle qui se 
trouve à côté de leur nom) pour faire apparaître 
les différents canaux, que vous pouvez alors faire 
glisser sur les pistes indépendamment les unes 
des autres.

Groupes de régions ensemble formé de plusieurs 
régions audio et MIDI, un groupe de régions 
s'affiche et agit comme une région unique. 
Les groupes de régions servent essentiellement 
de conteneur à une ou plusieurs régions. 
Les groupes de régions peuvent être créés sur 
une seule piste ou sur plusieurs pistes adjacentes 
audio, MIDI et d'instrument. Ils permettent de 
rassembler plusieurs régions en une 
macrorégion et facilitent ainsi la manipulation, 

l'édition et l'organisation des ambiances et du 
tempo.

Vue de piste

La vue de la piste détermine quelles données 
sont affichées et éditées dans la zone de la 
playlist de la piste. Les données de la vue de la 
piste peuvent être définies sur Blocks, 
Waveform, Volume, Pan, Mute, ou sur un 
paramètre automatisé ou un contrôleur continu, 
suivant le type de piste.

Pistes audio : Les pistes peuvent être réglées sur 
Blocks, Waveform, Volume, Volume Trim, Pan, 
Mute, ou sur n'importe quel paramètre dont 
l'automation est activée. Les pistes audio sont 
définies par défaut sur la vue Waveform et leurs 
données sont donc représentées graphiquement 
sous la forme d'ondes d'amplitude 
(représentation temps-domaine du son). Cette 
vue de la piste présente suffisamment de détails 
pour permettre des éditions importantes de la 
région.

Pistes d'entrée auxiliaire : Les pistes peuvent 
être réglées sur Volume, Volume Trim, Pan, Mute, 
ou sur n'importe quel paramètre dont 
l'automation est activée. 

Pistes de fader principal Les pistes peuvent être 
réglées sur Volume, Volume Trim, ou sur 
n'importe quel paramètre dont l'automation est 
activée.

Pour plus d'informations sur les groupes de 
régions, voir Groupes de régions, page 525.

Visualisation d'une piste audio en mode Waveform
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Pistes de VCA principal (Pro Tools HD 
uniquement) Les pistes peuvent être réglées sur 
Volume, Volume Trim ou Mute.

Pistes MIDI : Ces pistes peuvent être réglées sur 
Blocks, Regions, Notes, Volume, Pan, Mute, 
Velocity, Pitch Bend, After Touch, Program, Sysex, 
et sur n'importe quel type de contrôleur 
continu. Les pistes MIDI sont en général réglées 
sur les vues Notes ou Regions dont les notes 
s'affichent sous la forme d'une bande perforée 
pour piano mécanique. Utilisez la vue Notes 
pour insérer, modifier et, copier et coller des 
notes MIDI. Utilisez la vue Regions pour 
organiser, acquérir ou regrouper des régions. 
D'autres vues de pistes MIDI s'avèrent 
particulièrement utiles pour l'édition des 
données de contrôleur, des changements du 
programme et des événements Sysex.

Pistes d'instrument Ces pistes peuvent être 
définies sur Blocks, Regions, Notes, Volume, Pan, 
Mute, Velocity, Pitch Bend, After Touch, Program, 
Sysex, et sur tout type de contrôleur continu 
pour pistes MIDI, ainsi que sur Volume, Volume 
Trim, Pan, Mute ou tout contrôle de plug-in dont 
l'automatisation est activée. Les pistes 
d'instrument sont en général réglées sur les vues 
Notes ou Regions dont les notes s'affichent sous 
la forme d'une bande perforée pour piano 
mécanique. Utilisez la vue Notes pour insérer, 
modifier et, copier et coller des notes MIDI. 
Utilisez la vue Regions pour organiser, acquérir 
ou regrouper des régions. D'autres vues de pistes 
d'instrument s'avèrent particulièrement utiles 
pour l'édition de l'automation, des données de 
contrôleur, des changements du programme et 
des événements Sysex.

Lorsque la vue de la piste est définie sur Blocks, 
les régions audio et MIDI s'affichent sous forme 
de blocs vides portant le nom de la région. 
Ce mode est particulièrement utile lorsque, 
après avoir capturé et édité des régions au niveau 
de la forme d'onde ou de l'événement MIDI, 
vous désirez les déplacer et les réorganiser. 
Les rafraîchissements d'écran sont plus rapides 
dans ce format d'affichage.

Lorsque l'affichage d'une piste audio ou 
d'instrument est défini sur Volume, Pan ou un 
autre contrôle automatisé, ou lorsqu'une piste 
MIDI ou d'instrument est paramétrée sur l'un 
des types de contrôleurs continus (Volume, 
Pitch Bend, After Touch), les données de cette 
piste s'affichent sous la forme de segments de 
droite reliés par des points d'inflexion 
modifiables. Pour modifier les données 
d'automation, déplacez ces points d'inflexion ou 
ajoutez-en à l'aide du crayon ou de la main.

Vue de la piste MIDI en mode Notes

Vue de la piste audio définie sur Pan

Pour plus d'informations sur l'édition des 
données d'automation des pistes audio, 
reportez–vous à la section chapitre 30, 
Automation. 

Pour plus d'informations sur l'insertion et 
l'édition des données de contrôleurs des 
pistes MIDI, reportez–vous à la section 
Evénements de contrôleur continu, 
page 659.
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Pour définir le mode de visualisation de la piste :

" Cliquez sur le sélecteur de vue de piste et 
sélectionnez le format désiré dans le menu 
contextuel.

La piste est alors visualisée dans le nouveau 
format. Si elle fait partie d'un groupe d'édition 
actif, toutes les pistes du groupe passent aussi sur 
ce nouveau format de visualisation.

Changement de vue de piste

Avec les pistes audio, MIDI, d'entrée auxiliaire et 
d'instrument, vous pouvez passer d'une vue à la 
suivante ou à la précédente, ou basculer entre 
plusieurs vues courantes prédéfinies.

Sélecteur de vue de piste audio

Sélecteur de vue de piste auxiliaire

Sélecteur de vue de piste de fader principal

Sélecteur de piste de VCA principal (Pro Tools HD 
uniquement)

Cliquez pour afficher le menu 
déroulant Track View

Cliquez pour afficher le menu 
déroulant Track View

Cliquez pour afficher le menu 
déroulant Track View

Cliquez pour afficher le menu 
déroulant Track View

Sélecteur de vue de piste MIDI

Sélecteur de vue de piste d'instrument

Pour plus d'informations sur les vues de 
piste vidéo, reportez–vous à la section Vue 
de la piste vidéo, page 947.

Cliquez pour afficher le menu 
déroulant Track View

Cliquez pour afficher le menu 
déroulant Track View
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Navigation entre plusieurs vues

Lorsque vous passez à la vue suivante ou que 
vous revenez à la vue précédente, l'ordre de la 
liste n'est pas modifié dans le sélecteur de vue de 
piste.

Pour passer à la vue suivante ou précédente :

1  Cliquez sur la piste dont vous souhaitez 
modifier la vue. Pour changer la vue de plusieurs 
pistes, maintenez la touche Maj enfoncée et 
cliquez sur les pistes souhaitées ou faites glisser 
le sélecteur, ou bien sélectionnez un groupe.

2  Effectuez l'une des opérations suivantes :

• Pour passer à la vue précédente ou suivante 
de toutes les pistes sélectionnées, appuyez 
sur les touches fléchées à gauche ou à droite 
tout en maintenant les touches 
Ctrl+Démarrer (Windows) ou Ctrl+Pomme 
(Mac) enfoncées.

– ou –

• Pour passer à la vue précédente ou à la vue 
suivante de toutes les pistes, maintenez les 
touches Ctrl+Alt+Démarrer (Windows) ou 
Ctrl+Option+Pomme (Mac) enfoncées et 
appuyez sur les flèches gauche ou droite, 
indiquant respectivement la vue 
précédente et la vue suivante.

Basculement d'une vue de piste courante à 
une autre

Les vues de piste les plus couramment utilisées 
pour l'édition de pistes audio sont les vues 
Waveform et Volume. Pour l'édition de pistes 
MIDI et d'instrument, il s'agit des vues Notes et 
Regions. Pro Tools offre la possibilité de basculer 
simplement d'une vue à l'autre.

Pour changer la vue de pistes sélectionnées :

1  Cliquez sur la piste pour laquelle vous voulez 
changer la visualisation. Pour changer la vue de 
plusieurs pistes, maintenez la touche Maj 
enfoncée et sélectionnez les pistes souhaitées 
ou, cliquez et faites glisser le sélecteur.

2  Effectuez l'une des opérations suivantes :

• Appuyez sur les touches Ctrl+moins (-) 
(Mac) ou sur Démarrer+moins (-) 
(Windows) du clavier alphanumérique.

– ou –

• Après avoir activé le focus clavier sur les 
commandes (reportez–vous à la section 
Focus clavier, page 22), appuyez sur la 
touche moins (-) du clavier 
alphanumérique.

Les pistes audio passent de la vue Waveform à la 
vue Volume et inversement. Les pistes MIDI et 
les pistes d'instrument passent de la vue Notes à 
la vue Regions, et inversement.

Les vues en tête de liste (notamment, la vue 
Blocks pour les pistes audio ou MIDI) ne 
peuvent pas être remplacées par une vue 
précédente. De même, les vues en fin de liste 
(notamment, la vue des contrôleurs MIDI) 
ne peuvent pas être remplacées par la vue 
suivante.

Pour basculer la vue de toutes les pistes, 
appuyez sur les touches Option+Ctrl+moins 
(-) (Mac) ou sur Alt+Démarrer+moins (-) 
(Windows) du clavier alphanumérique.

Lorsque le focus clavier est activé, vous 
pouvez basculer la vue de toutes les pistes en 
appuyant simplement sur les touches 
Option+moins (-) (Mac) ou sur Alt+moins (-
) (Windows) du clavier alphanumérique.
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Vues principales des pistes

Les pistes audio, MIDI et d'instrument 
possèdent des vues dites principales. Lorsqu'une 
piste est affichée dans une vue principale, toutes 
les modifications effectuées s'appliquent à 
l'ensemble des données de la piste. Par exemple, 
lorsqu'une piste audio est définie sur Waveform, 
l'opération de copier/coller ne concerne pas 
seulement les informations de la forme d'onde, 
mais également toutes les données 
d'automation associées. 

La vue principale dépend du type de piste :

• Pistes audio : Waveform et Blocks

• Pistes MIDI et d'instrument : Regions, 
Blocks et Notes (avec le sélecteur)

La vue Volume est la vue principale des pistes 
d'entrée auxiliaire, des pistes de fader principal 
et des pistes de VCA principal. Lorsqu'une piste 
d'entrée auxiliaire ou de fader principal est 
affichée dans une vue principale, toutes les 
modifications effectuées s'appliquent à 
l'ensemble des données d'automation de la 
piste.

Hauteur de la piste

Vous pouvez visualiser les pistes dans la fenêtre 
Edit selon huit hauteurs : Micro, Mini, Small, 
Medium, Large, Jumbo, Extreme et Fit To Window. 
Plus les hauteurs de pistes sont grandes, plus 
l'édition est précise. Cette condition s'applique 
particulièrement aux pistes MIDI. Les hauteurs 
de pistes plus petites sont utiles pour 
économiser l'espace d'écran dans une session de 
grande taille.

Vous pouvez régler la hauteur des pistes 
individuellement ou définir la même hauteur 
pour toutes les pistes. La hauteur des pistes est 
réglable en cours de lecture.

Pour définir la hauteur des pistes, effectuez l'une 
des opérations suivantes :

" Cliquez sur la petite flèche située à côté du 
sélecteur de vue de piste pour faire apparaître le 
menu déroulant de hauteur de piste.

– ou –

" Cliquez à l'aide du bouton droit de la souris 
sur la zone située à droite des commandes de la 
piste et choisissez la hauteur dans le menu 
contextuel.

La piste est redimensionnée à la nouvelle 
hauteur. Si la piste fait partie d'un groupe 
d'édition, toutes les pistes de ce groupe adoptent 
la nouvelle hauteur.

Menu déroulant de hauteur de la piste 

Pour augmenter/réduire la hauteur d'une 
piste contenant une sélection ou dans 
laquelle le curseur d'édition se trouve 
actuellement, maintenez enfoncée la touche 
Démarrer (Windows) ou Ctrl (Mac) 
pendant que vous cliquez sur la touche 
fléchée Haut/Bas.
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Affichage étendu de piste

Les pistes stéréo et multicanaux partagent la 
même playlist pour le volume et la coupure. 
Cette playlist partagée occupe normalement 
toute la hauteur de la piste, en s'étendant sur 
tous les canaux.

Avec l'affichage étendu de la piste, vous pouvez 
afficher séparément la playlist de chaque canal, 
ce qui permet une édition plus précise des points 
d'inflexion. Ceci est également pratique pour 
éditer des données de panoramique ou de plug-
in multimono, ces deux types de données 
pouvant être différents sur chaque canal.

L'affichage étendu de la piste permet également 
d'obtenir une forme d'onde plus grande 
(équivalente à celle des pistes mono), ainsi 
qu'un sélecteur de vue de piste et un vumètre 
pour chaque voie.

Pour activer l'affichage étendu de la piste :

" Dans le sélecteur de hauteur de piste, cliquez 
sur Expanded Track Display.

Commandes de piste et hauteur 
de piste

La hauteur de la piste influe sur l'affichage des 
différentes commandes dans la fenêtre Edit. 
Lorsqu'une hauteur de piste est réglée sur Small, 
par exemple, la plupart des boutons s'affichent 
en taille réduite.

Lorsque la hauteur d'une piste est réglée sur 
Mini ou Micro, seules les commandes Record, 
Mute et Solo s'affichent et les menus de playlist, 
de règle temporelle, de hauteur de piste et de vue 
de piste sont accessibles à partir du même 
sélecteur.

Playlist de volume pour une piste stéréo

Piste stéréo en affichage étendu de la piste

Menu déroulant de hauteur de la piste

Hauteur de la piste définie sur Small

Hauteur de la piste définie sur Mini
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Lorsque la hauteur d'une piste est définie sur 
Large, Jumbo ou Extreme, tous les contrôles de 
la piste s'affichent à leur taille maximale.

Hauteur de piste continue et variable

La fenêtre Edit vous permet de redimensionner 
la hauteur des pistes de façon continue en 
cliquant et en faisant glisser la limite inférieure 
de la colonne Track Controls. 

Pour redimensionner la hauteur d'une piste dans la 
fenêtre Edit :

" Cliquez et faites glisser (vers le haut ou le bas) 
la ligne inférieure de la colonne Track Controls 
de la piste en question. Le curseur change de 
forme pour signaler que la piste peut être 
redimensionnée.

La hauteur de la piste est modifiée par 
incrément.

Affichage dans les playlists 
des noms et positions 
temporelles des régions et 
d'autres données
Les noms et positions temporelles des régions 
gênent parfois l'édition des formes d'onde audio 
ou des données MIDI. Lorsque cela se produit, 
vous pouvez en désactiver l'affichage. Dans 
d'autres cas, par exemple pour organiser ou 
positionner des effets sonores, il peut s'avérer 
utile d'afficher les noms et positions temporelles 
des régions. 

Pour activer ou désactiver l'affichage des noms 
des régions dans les playlists :

" Sélectionnez ou désélectionnez View > 
Region > Name.

Pour afficher les positions temporelles des 
régions :

" Dans View > Region, sélectionnez l'une des 
options suivantes :

No Time : désactive l'affichage des positions 
temporelles des régions.

Current Time : affiche les positions temporelles 
de début et de fin des régions

Hauteur de la piste définie sur Large

Réglage de la hauteur d'une piste audio

Appuyez sur la touche Ctrl (Windows) ou la 
touche Pomme (Mac), puis maintenez-la 
enfoncée tout en réglant la taille de piste de 
manière continue ou non incrémentielle.

Pour redimensionner toutes les pistes de 
manière continue, maintenez la touche 
Option (Mac) ou Alt (Windows) enfoncée 
pendant que vous faites glisser le curseur.

Pour redimensionner toutes les pistes 
sélectionnées de manière continue, 
maintenez les touches Option+Maj (Mac) 
ou Alt+Maj (Windows) enfoncées pendant 
que vous faites glisser le curseur.
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Original Time Stamp : affiche le marqueur de 
temps d'origine de chaque région. Le marqueur 
de temps d'origine est le timecode d'origine de la 
région, lors de son premier enregistrement ou de 
sa création.

User Time Stamp affiche le marqueur de temps 
utilisateur pour chaque région. Le marqueur de 
temps utilisateur, par défaut identique au 
marqueur de temps d'origine, peut être redéfini 
grâce à la commande Time Stamp.

Il est possible d'afficher les points de 
synchronisation des régions et des groupes de 
régions dans les playlists (reportez–vous à la 
section Points de synchronisation, page 504). 
Cette fonctionnalité facilite le positionnement 
par rapport au timecode et l'organisation en 
mode Grid.

Les chevauchements de régions peuvent être 
affichés pour les régions contenues dans les 
playlists. Cette fonctionnalité s'avère utile pour 
l'organisation et l'utilisation des pistes audio 
basées sur une référence temporelle (voir 
Chevauchements de régions, page 488).

Les informations sur les noms de canal ainsi que 
sur les scènes et les prises peuvent être affichées 
pour les régions contenues dans les playlists et 
dans la liste des régions. Cette fonctionnalité 

peut s'avérer utile pour travailler avec des 
enregistrements multicanaux et des 
métadonnées réalisées avec des enregistreurs 
portables. 

Régions audio et formes 
d'onde
Lorsque la vue des pistes audio est en mode 
Waveform, Pro Tools représente les données 
audio sous forme d'un diagramme appelé forme 
d'onde audio. Les formes d'onde audio donnent 
de nombreuses informations sur le son 
enregistré.

Dans la figure 16, les « crêtes » représentent les 
emplacements de l'enregistrement où l'attaque 
du son provoque une augmentation 
momentanée du volume. Ils sont suivis de 
« vallées » où le volume diminue.

A chaque type de son correspond un type de 
forme d'onde différent. La batterie, par exemple, 
produit en général des formes d'onde avec des 
transitoires marqués (des crêtes de courte durée), 
clairement visibles. Un coup de grosse caisse ou 
de caisse claire, par exemple, possède une 
attaque puissante et franche suivie d'une 
décroissance rapide du son.

Affichage activé des noms et positions temporelles des 
régions et des chevauchements

Reportez–vous au guide « Field Recorder 
Workflow Guide » pour plus 
d'informations sur l'utilisation des 
enregistreurs portables.

Figure 16.  Forme d'onde audio d'une piste de batterie
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D'autres sons, tels que les voix ou les entrées 
soutenues de synthétiseur, produisent des 
formes d'ondes très différentes. Ces sons ont des 
crêtes et des vallées moins prononcées parce 
qu'ils disposent de façon générale d'attaques 
plus douces et de temps de rétablissement plus 
longs.

Préférence Draw Waveforms Rectified

Lorsque l'option Draw Waveforms Rectified des 
préférences d'affichage est sélectionnée (dans la 
page Display Preferences), les formes d'onde 
audio s'affichent sous forme d'un signal unique 
de valeur positive, obtenu en additionnant leurs 
excursions positives et négatives. Toutefois, 
même lorsque cette préférence est activée, le 
zoom avant allant au-delà d'un certain point 
provoquera l'affichage normal des formes 
d'onde.

Le mode rectifié affiche des formes d'onde plus 
détaillées avec les hauteurs Medium ou Small, et 
peut se révéler particulièrement efficace pour 
l'édition des données d'automation du volume, 
car il représente les « niveaux » de la forme 
d'onde en partant du bas de la piste.

Instructions d'édition des formes 
d'onde

A l'aide du sélecteur de la fenêtre Edit, vous 
pouvez sélectionner des parties de formes 
d'onde audio et les diviser en segments nommés 
régions, de manière à pouvoir les réorganiser et à 
les manipuler dans les pistes.

Pendant l'édition, essayez de créer des régions 
qui permettent de maintenir un tempo 
cohérent. Si vous définissez des régions qui 
contiennent toujours un nombre entier de 
temps, vous pourrez enchaîner les régions et 
conserver un rythme régulier et continu.

Il est parfois utile d'avoir une forme d'onde 
régulière et bien définie, une piste de batterie 
par exemple, qui peut servir de guide lorsque 
vous sélectionnez et définissez d'autres régions. 
Si vous avez bien joué dans le rythme, il devrait 
être plus facile de créer des régions 
rythmiquement précises en vous référant à la 
forme d'onde de la batterie.

Lorsque vous définissez des régions, respectez les 
règles suivantes :

! Chaque fois que c'est possible, faites 
commencer la région exactement avant une 
crête de niveau et terminez-la immédiatement 
avant un autre crête de niveau.

! Chaque fois que c'est possible, vérifiez qu'une 
région commence et se termine exactement au 
même endroit dans un temps.

! Les fonctions Pro Tools suivantes vous 
aideront à modifier les données rythmiques ou 
les sources audio avec des transitoires claires 
dans des régions précises :

• Tabulation vers transitoires (voir 
Tabulation vers transitoires, page 473.) ;

• édition sur grille (voir Grid, page 427).

• Beat Detective (voir chapitre 24, Beat 
Detective) ;

Données audio affichées en mode rectifié

Données audio affichées en mode normal
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Eviter les clics et autres parasites

Si une région éditée commence ou se termine 
sur un point d'amplitude élevée, vous risquez 
d'entendre un clic lorsque Pro Tools passe en 
lecture d'une région à l'autre. Pour éviter 
les clics :

! Vérifiez que les points de début et de fin de 
votre sélection se trouvent aussi près que 
possible du point où l'amplitude de la forme 
d'onde diminue et coupe la ligne de passage par 
zéro (l'axe horizontal central dans l'affichage de 
la forme d'onde de la piste). Si nécessaire, utilisez 
les outils de zoom de la fenêtre Edit (voir 
Utilisation des outils de zoom, page 429) pour 
afficher les formes d'onde avec davantage de 
détails.

! Appliquez un crossfade entre des régions où se 
produit un clic. Consultez la section Création 
d'un crossfade, page 548 pour plus 
d'informations.

! Sur Pro Tools HD, utilisez la fonction 
AutoFade afin d'appliquer des fondus d'entrée 
ou de sortie en temps réel à toutes les limites des 
régions qui ne touchent, ni ne chevauchent 
d'autres régions. Pour plus d'informations, 
consultez la section Utilisation des fondus 
automatiques, page 550.

Edition audio non destructive

Lorsque vous éditez la playlist d'une piste audio 
dans Pro Tools, vous ne coupez ni ne déplacez 
réellement des parties de son comme vous le 
feriez avec une bande analogique. Au lieu de 
cela, Pro Tools crée une carte du fichier audio 
sur votre disque dur, qui décrit l'ordre dans 
lequel les différentes portions de la piste doivent 
être lues.

Lorsque vous rognez des régions audio à l'aide 
de l'un des outils de trimming ou lorsque vous 
modifiez le placement ou l'ordre des régions sur 
une piste, utilisez plusieurs playlists, afin de 
pouvoir rétablir facilement l'état précédent 
d'une piste. Pour plus d'informations, 
reportez-vous à la section Playlists, page 413.

Régions audio et données 
d'automation

Les données d'automation audio font partie des 
pistes et non de la liste des régions. Ainsi, lorsque 
vous déplacez une région audio de la liste des 
régions vers une nouvelle piste, aucune donnée 
d'automation n'est placée dans la piste. En 
revanche, si vous déplacez une région audio 
d'une piste existante (contenant des données 
d'automation) vers une autre piste, les données 
d'automation de la piste source sont placées 
dans la piste de destination.

Sélection qui commence et se termine sur un point de 
passage par zéro
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Régions MIDI et données MIDI
Les deux modes de visualisation les plus 
couramment utilisés pour les pistes MIDI et les 
pistes d'instrument sont les modes Notes et 
Regions.

Utilisez la vue Notes pour insérer et éditer des 
notes MIDI individuelles ou travailler avec des 
groupes de notes et les modifier.

Utilisez la vue Regions pour organiser les 
régions.

Vue Notes pour les pistes MIDI et 
les pistes d'instrument

Lorsque la vue d'une piste MIDI ou d'une piste 
d'instrument est définie sur Notes, les notes 
MIDI s'affichent sous la forme d'une bande 
perforée pour piano mécanique. Chaque note 
apparaît sous forme de petit rectangle, sa 
position verticale indiquant sa hauteur et sa 
position horizontale indiquant son 
emplacement temporel (et sa durée).

A gauche de la playlist de la piste MIDI ou de la 
piste d'instrument se trouve, pour référence de 
hauteur, un mini-clavier vertical, avec le 
numéro de l'octave. Vous pouvez cliquer sur le 
mini-clavier pour écouter les hauteurs de notes. 
Les flèches situées en haut et en bas du mini-
clavier (non disponibles dans les plus petites 
hauteurs de piste) permettent de faire défiler 
l'affichage des notes vers le haut ou vers le bas.

Dans la vue Notes, la plage de hauteurs de notes 
MIDI affichable dépend de la hauteur de la piste 
et de la valeur du zoom. Chaque fois que les 
notes d'une piste ne tiennent pas dans sa 
hauteur courante, les notes au-dessus ou au-
dessous de la zone affichée s'affichent sous 
forme de lignes d'un pixel d'épaisseur tout en 
haut ou tout en bas de la région affichée (voir 
figure 17 ci-dessus).

Pour plus d'informations sur la définition 
de Track View, consultez la section Vue de 
piste, page 393.

Pour changer de vue de piste, cliquez sur la 
piste de votre choix et appuyez sur la 
combinaison de touches Démarrer+moins
(-) sous Windows ou Ctrl+moins (-) sous 
Mac du clavier alphanumérique.

Figure 17.  Piste MIDI affichant les notes

Flèche vers le haut

Flèche vers le 

Note MIDI au-dessus 
de l'affichage

Référence clavier
Note MIDI
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Pour faire défiler l'affichage des notes d'une piste 
MIDI ou d'une piste d'instrument vers le haut ou 
vers le bas, procédez d'une des manières 
suivantes :

" Cliquez sur la flèche vers le haut ou vers le bas 
du mini-clavier.

– ou –

" Sélectionnez l'un des outils de la fenêtre Edit 
(l'outil d'accrochage de temps par exemple), 
appuyez sur Pomme+Option+Ctrl (Mac) ou sur 
Ctrl+Alt+Démarrer (Windows), puis cliquez et 
faites glisser la note vers le haut ou le bas sur le 
mini-clavier.

A l'aide des outils de la fenêtre Edit, vous pouvez 
insérer, transposer, rogner et déplacer des notes. 
Pour plus d'informations, reportez-vous à la 
section Edition manuelle des notes MIDI, 
page 651.

Vue Regions pour les pistes MIDI 
et les pistes d'instrument

Les pistes MIDI et les pistes d'instrument 
peuvent aussi être visualisées sous forme de 
régions. Cette vue est très similaire à la vue 
Waveform pour les pistes audio. Bien que les 
notes d'une piste soient visibles dans la vue 
Regions, l'édition de notes individuelles n'est 
pas possible dans cette vue. En revanche, toutes 
les opérations d'édition concernent une plage de 
temps englobant toutes les données de la piste, 
en particulier les événements de contrôleur 
continu, de changements de programme et de 
type Système Exclusif.

Utilisez la vue Regions pour définir des régions 
qui représentent des sections et des clips d'un 
morceau ou pour réorganiser ou regrouper des 
éléments d'une piste.

Dans la vue Regions, l'échelle de zoom vertical 
est définie automatiquement de manière à 
afficher toute la plage de hauteurs de notes MIDI 
sur la piste.

Défilement de notes avec la flèche vers le haut du mini-
clavier

Défilement de l'affichage des notes par glissement

Si votre souris possède une molette de 
défilement, vous pouvez l'utiliser pour faire 
défiler l'affichage des notes d'une piste 
MIDI ou d'une piste d'instrument. Placez le 
curseur de la souris sur une piste MIDI ou 
une piste d'instrument dans la fenêtre Edit 
et maintenez les touches Ctrl+Alt+Démarrer 
(Windows) ou Pomme+Option+Ctrl (Mac) 
enfoncées pendant que vous utilisez la 
molette pour faire défiler l'affichage des 
notes de la piste MIDI ou de la piste 
d'instrument.

Pour plus d'informations sur la définition 
de Track View, consultez la section Vue de 
piste, page 393.
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Toutefois, vous devez respecter un certain 
nombre de principes lorsque vous sélectionnez, 
coupez, copiez et rognez des régions MIDI :

! Lorsque vous coupez ou supprimez une 
sélection de région ou de groupe de régions 
incluant le point de début d'une note, toute la 
note est supprimée. C'est le cas même si vous 
n'avez sélectionné qu'une partie de la note (du 
moment qu'elle inclut son point de début).

! Lorsque vous coupez ou supprimez une 
sélection de région ou de groupe de régions 
contenant le point de fin d'une note (mais pas 
son point de début), la note est conservée et 
déborde de la région.

! Des règles similaires s'appliquent également 
lorsque les régions MIDI ou des groupes de 
régions contenant des régions MIDI sont 
rognées avec l'un des outils de rognage. Si le 
point de début de la région MIDI est déplacé au-
delà du point de début de la note, cette dernière 
est supprimée. Si le point de fin de la région est 
rogné de telle manière que le point de début de 
la note se trouve dans la région mais que son 
point de fin ne s'y trouve pas, la note est 
conservée et dépasse du bord de la région.

Lorsque vous déplacez et positionnez des 
régions MIDI comportant des notes qui 
dépassent, les notes se déplacent toujours avec 
les régions. Lorsque vous positionnez des 
régions MIDI comportant des notes qui 
dépassent à côté ou près d'une autre région, les 
notes superposées viennent se positionner à 
l'intérieur de la région suivante de la piste.

Création de régions MIDI sur des barres 
de mesure

Lorsque vous enregistrez des données MIDI ou 
entrez manuellement des notes MIDI, le début 
et la fin des régions MIDI obtenues sont compris 
dans les limites de la mesure. Cela permet de 
placer les régions MIDI en fonction de la 
musique sur toute la longueur des barres.

Le début d'une région MIDI enregistrée sur la 
barre de mesure précède immédiatement la 
première note MIDI de la région. De même, la 
fin d'une région MIDI enregistrée sur la barre de 
mesure suit immédiatement la dernière note 
MIDI de la région. 

Pour basculer la vue de la piste entre les 
notes et les régions, cliquez dans la piste de 
votre choix et appuyez sur la combinaison 
des touches du clavier alphanumérique 
Démarrer+moins (-) (Windows) ou 
Ctrl+moins (-) (Mac), ou appuyez sur 
Ctrl+Alt (Windows) ou Pomme+Option 
(Mac) et utilisez les flèches gauche et droite 
pour changer la vue de la piste.

Section d'une région MIDI avec dépassement de note
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Edition MIDI non destructive

Si l'édition de régions audio est en général non 
destructive, ce n'est en général pas le cas des 
régions MIDI. Par exemple, si une région MIDI 
se trouve à un seul endroit dans une seule piste, 
l'édition de cette région est destructive. Cela 
signifie que la modification de la hauteur, de la 
durée ou du positionnement de notes en vue 
Notes modifie définitivement la région.

Cependant, lorsque vous éditez une région MIDI 
qui apparaît ailleurs sur la même piste (à un 
autre emplacement ou dans une playlist 
différente) ou dans une autre piste, l'édition est 
non destructive et crée automatiquement une 
région. Pour retrouver les données précédentes, 
faites glisser la région d'origine depuis la liste des 
régions ou retournez dans une playlist 
préalablement sauvegardée.

Régions MIDI et événements de 
type Contrôleur Continu

Les événements de Contrôleur Continu font 
partie des régions MIDI et non des pistes. Ainsi, 
lorsque vous déplacez une région contenant des 
données de Contrôleur depuis une piste ou 
depuis la liste des régions, ces données sont 
écrites dans la piste de destination.

Contrairement aux événements de type 
Contrôleur Continu, qui représentent des 
nuances au sein d'une prestation MIDI, l'option 
Mute de Pro Tools est une playlist d'automation 
qui coupe effectivement le moteur MIDI. 
L'automation de Mute ne correspond pas aux 
événements MIDI réels et n'est donc pas 
exportée lors de la sauvegarde sous forme de 
fichier MIDI standard.

Règles temporelles et règles 
de chef d'orchestre

Vous pouvez afficher les règles temporelles 
suivantes en haut de la fenêtre Edit :

• Bars:Beats 

• Minutes:Secondes

• Time Code (Pro Tools HD et Pro Tools LE 
avec DV Toolkit 2 uniquement)

• Feet+Frames (Pro Tools HD et Pro Tools LE 
avec DV Toolkit 2 uniquement)

• Samples

• Time Code 2 (Pro Tools HD et Pro Tools LE 
avec DV Toolkit 2 uniquement)

Les playlists permettent de restaurer en 
toute sécurité l'état précédent d'une piste. 
Avant d'éditer des notes ou bien de rogner 
ou de réorganiser des régions, faites une 
copie de la playlist de la piste, puis éditez 
cette copie (voir Playlists, page 413).

Pour appliquer les modifications à toutes les 
instances d'une région MIDI, activez le 
mode Mirrored MIDI Editing (voir Mirrored 
MIDI Editing, page 645).

Affichage de toutes les règles 
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Outre le fait qu'elles référencent 
temporellement les données de la piste, les 
règles temporelles servent à définir les sélections 
d'édition des données de la piste et les sélections 
de graduation des régions d'enregistrement et de 
lecture.

Vous pouvez afficher les règles de chef 
d'orchestre suivantes :

• Tempo (et Tempo Editor)

• Meter

• Key Signature

• Markers

Les règles Meter et Tempo indiquent les 
modifications apportées aux données de tempo 
et de mesure au cours de la session. La règle Key 
Signature indique les changements de clé. La 
règle Markers affiche des marqueurs aux 
emplacements importants de la piste.

Pour afficher toutes les règles :

" Sélectionnez View > Rulers > All.

Pour supprimer une règle de l'affichage, effectuez 
l'une des opérations suivantes :

" Cliquez sur le nom de la règle en appuyant sur 
Option (à gauche de la règle).

– ou –

" Choisissez View > Rulers et sélectionnez une 
option de règle.

Pour afficher uniquement l'échelle temporelle 
principale dans la règle temporelle :

" Sélectionnez View > Rulers > None (Echelle 
temporelle principale, page 408.)

Pour ajouter une règle particulière à l'affichage, la 
règle Markers, par exemple :

" Sélectionnez View > Rulers > Marker.

Pour modifier l'ordre d'affichage des règles :

" Cliquez sur le nom d'une règle et faites-le 
glisser vers le haut ou vers le bas.

Sélecteur de la vue des règles

Vous pouvez également configurer les règles 
temporelles et les règles de chef d'orchestre à 
l'aide du sélecteur de la vue des règles.

Faites glisser le sélecteur dans une règle 
temporelle pour sélectionner des données sur 
toutes les pistes affichées dans la fenêtre 
Edit. Pour inclure les pistes du chef 
d'orchestre dans la sélection, faites glisser 
ces pistes en maintenant enfoncée la touche 
Option (Mac) ou Alt (Windows).

Pour plus d'informations sur les marqueurs 
Memory Location et les règles Meter, Tempo 
et Key Signature, reportez–vous au 
chapitre 23, Pistes du chef d'orchestre et 
emplacements mémoire

Sélecteur de la vue des règles dans la fenêtre Edit

Sélecteur de la vue des règles 
sélectionné
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Règle de timecode secondaire

(Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement)

Une règle de timecode secondaire, intitulée 
Time Code 2, vous permet de référencer les 
fréquences d'échantillonnage vidéo de la 
timeline qui diffèrent de la fréquence de 
timecode de la session. Il est toutefois 
impossible d'effectuer des placements sur la 
règle Time Code 2 qui ne peut par ailleurs pas 
être définie en tant qu'échelle temporelle 
principale.

La règle de timecode secondaire peut être définie 
de façon à afficher les fréquences suivantes :

• 23.976 FPS

• 24 FPS

• 25 FPS

• 29.97 FPS

• 29.97 FPS Drop

• 30 FPS

• 30 FPS Drop

• 50 FPS

• 59.94 FPS

• 59.94 FPS Drop

• 60 FPS

• 60 FPS Drop

Echelle temporelle principale
Vous pouvez afficher simultanément toutes les 
règles temporelles dans la fenêtre Edit, mais une 
seule d'entre elles représente l'échelle temporelle 
principale, également appelée règle temporelle 
principale. 

L'échelle temporelle détermine le format utilisé 
pour :

• le compteur principal de la fenêtre 
Transport ;

• le compteur principal en haut de la fenêtre 
Edit ;

• les valeurs de début (start), de fin (end) et 
de durée (length) ;

• les valeurs de pré et de post-roll ;

• les valeurs de grille et d'incrément.

L'échelle temporelle principale peut être définie 
dans les formats suivants :

Bars:Beats : affiche l'échelle temporelle en 
nombre de mesures et de temps. Utilisez cette 
échelle si vous travaillez avec des éléments 
musicaux qu'il faut placer en fonction de 
mesures et de temps.

Pour que vos pistes s'alignent correctement 
sur les mesures et les temps de votre session, 
effectuez l'enregistrement avec le 
métronome (voir Enregistrement avec le 
métronome, page 318). Toutefois, dans 
Pro Tools, les données enregistrées sans 
métronome peuvent être alignées plus tard 
sur la grille de mesure/temps à l'aide de la 
commande Identify Beat (voir Commande 
Identify Beat, page 588) ou de Beat 
Detective (voir chapitre 24, Beat Detective).
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Minutes:Seconds : affiche l'échelle temporelle 
en minutes et secondes. A mesure que vous 
zoomez vers l'avant à l'aide du zoom, l'échelle 
temporelle est graduée en dixièmes, puis en 
centièmes et en millièmes de seconde.

Time Code (Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement) : affiche l'échelle 
temporelle en timecodes SMPTE. La fréquence 
d'images et l'heure du début de la session sont 
définies dans la fenêtre Session Setup.

Pro Tools prend en charge les fréquences 
d'images suivantes : 23.976, 24, 25, 29,97 et 
Non-Drop ; 29,97 Drop ; 30 Non-Drop et 
30 images par seconde Drop. 

Feet+Frames (Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement) : affiche l'échelle 
temporelle en pieds et images afin de constituer 
une référence pour les projets audio destinés au 
cinéma. L'affichage horaire en Pieds.Images 
repose sur le format de film 35 mm. 

Samples : affiche l'échelle temporelle en 
échantillons. Ce format est très pratique pour 
l'édition d'échantillons avec une précision 
élevée. 

Définition de l'échelle temporelle 
principale

Pour définir l'échelle temporelle principale, 
effectuez l'une des opérations suivantes :

" Cliquez sur le sélecteur de compteur principal 
(situé en haut dans la fenêtre Edit, ainsi que 
dans la fenêtre Transport, lorsque l'affichage des 
compteurs est activé) et sélectionnez une échelle 
temporelle.

" Si une règle temporelle est déjà affichée, 
cliquez sur son nom. Il s'affiche alors en 
surbrillance.

Navigation à l'aide des compteurs principaux

Les compteurs principaux (en haut de la fenêtre 
Edit et dans la fenêtre Transport) facilitent la 
navigation vers un emplacement temporel 
spécifique. 

Sélecteur de compteur principal (dans la fenêtre Edit)

Lorsque vous définissez l'échelle temporelle 
principale sur la base de temps affichée 
dans le compteur secondaire, les deux 
échelles temporelles sont modifiées. 
En d'autres termes, l'échelle temporelle 
secondaire prend l'ancienne valeur de base 
de temps de l'échelle temporelle principale.

Changement d'échelle temporelle principale

L'indicateur de compteur principal de la 
fenêtre Transport ne s'affiche que lorsque 
l'affichage des compteurs est activé pour 
cette fenêtre.
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Pour naviguer à l'aide d'un compteur principal :

1  Cliquez sur un compteur principal.

2  Entrez une position.

3  Appuyez sur la touche Entrée (Windows) ou 
Retour (Mac) pour rechercher automatiquement 
une nouvelle position.

Définition de l'échelle temporelle des 
compteurs secondaires

Sous chaque compteur principal, un compteur 
secondaire fournit une référence temporelle 
supplémentaire.

Pour définir l'échelle de temps du compteur 
secondaire :

" Cliquez sur un sélecteur de compteur 
secondaire et sélectionnez une échelle 
temporelle.

Résolution temporelle
Pro Tools est un programme travaillant à 
l'échantillon près, doté d'une résolution MIDI 
interne de 960000 impulsions par noire (ppn). 
Toutefois, lorsque l'échelle temporelle est réglée 
sur Bars|Beats, la résolution d'affichage dans 
Pro Tools est de 960 ppn. 

Avec l'échelle de temps Bars|Beats, Pro Tools 
travaille selon une référence temporelle (1 tic = 
1/960e de noire). Ainsi, il peut se produire un 
léger arrondi à l'échantillon le plus proche selon 
l'emplacement des événements choisi (voir 
Arrondi de l'échantillon et opérations d'édition, 
page 413).

Lorsque vous travaillez en Bars|Beats, vous 
devrez souvent indiquer des valeurs de tic pour 
un certain nombre d'opérations, en particulier :

• le placement et le positionnement de 
régions ;

• la définition des durées des régions ou des 
notes MIDI ;

• la recherche et la définition des plages de 
lecture et d'enregistrement (avec pré/post-
roll) ;

• la spécification des paramètres dans les 
pages Grid/Groove Quantize et Change 
Duration de la fenêtre MIDI Operations ;

• la définition des valeurs de pas de grille et 
d'incrément.

L'indicateur de compteur secondaire de la 
fenêtre Transport ne s'affiche que lorsque 
l'affichage des compteurs est activé pour 
cette fenêtre.

Sélecteur de compteur secondaire (dans la 
fenêtre Edit)
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Le tableau ci-dessous répertorie les nombres de 
tics pour chaque valeur de note :

Bases de temps définies par 
échantillons et par référence 
temporelle

Dans Pro Tools, vous pouvez définir les bases de 
temps des pistes par échantillons ou par 
référence temporelle.

Par défaut, les données audio de Pro Tools sont 
basées sur les échantillons. Ainsi, si une région 
audio se trouve à une position donnée, 
exprimée en échantillons, elle ne bougera pas si 
le tempo de la session est modifié. Par contre, 
l'expression de sa position en mesures et temps 
est modifiée.

Les données MIDI de Pro Tools sont basées sur 
une référence temporelle. Ainsi, si une région 
MIDI se trouve à une position précise, exprimée 
en mesures et temps, elle ne quittera pas cet 
emplacement si le tempo change au cours de la 
session. Par contre, l'expression de sa position 
en échantillons est modifiée.

Piste audio et piste MIDI basées sur les 
échantillons

Dans le cas d'une piste audio, toutes les régions 
audio de la piste occupent une position absolue 
sur la timeline. La source audio ne bouge pas par 
rapport à l'échantillon, que le tempo et la 
mesure soient modifiés ou non au cours de la 
session.

Si vous définissez une piste MIDI comme étant 
basée sur les échantillons, tous les événements 
MIDI de la piste ont un emplacement absolu sur 
la timeline. Les événements MIDI ne bougent 
pas par rapport à l'échantillon, que le tempo et 
la mesure soient modifiés ou non au cours de la 
session.

Piste audio et piste MIDI basées sur une 
référence temporelle

Une piste audio basée sur une référence 
temporelle est fixée sur Bars|Beats et se déplace 
relativement à la timeline de l'échantillon 
lorsque le tempo et la mesure sont modifiés. 
Cependant, les événements MIDI et la piste 
audio basée sur une référence temporelle se 
comportent différemment en cas de 
modification du tempo, en termes de durée. 
La longueur des événements de note est 
modifiée en fonction des changements de 
tempo ou de mesure, alors que ce n'est pas le cas 
des régions audio. Les changements de mesure 
et de tempo affectent uniquement le point de 
début (point de synchronisation) de chaque 
région d'une piste basée sur une référence 
temporelle.

Vous pouvez décider si une piste doit être basée 
sur l'échantillon ou sur le métronome, lors de sa 
création ou de la modification ultérieure de la 
base de temps. 

Valeur de 
note

Normal Pointillé Triplet

1/2 note 1920 2880 1280

1/4 note 960 1440 640

1/8 note 480 720 320

1/16 note 240 360 160

1/32 note 120 180 80

1/64 note 60 90 40
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Changement de règle temporelle

Il est possible d'intervertir les règles temporelles 
de toutes les pistes Pro Tools.

La hauteur de la piste influe sur l'affichage des 
différentes commandes dans la fenêtre Edit. Le 
sélecteur de timeline, utilisé pour changer la 
timeline d'une piste, n'est visible que pour les 
hauteurs de pistes supérieures ou égales à Small.

Pour appliquer une autre règle temporelle à une 
piste, procédez comme suit :

" Si la hauteur de la piste est définie sur Small ou 
sur une valeur plus élevée, cliquez sur le 
sélecteur de règle temporelle et sélectionnez la 
règle souhaitée. L'icône du sélecteur de règle 
temporelle est modifiée afin de prendre votre 
modification en compte. 
.

– ou –

" Si la hauteur de la piste est définie sur Mini, 
cliquez sur la petite flèche à droite du sélecteur 
de vue de piste pour faire apparaître la liste 
déroulante de sélection de hauteur de piste, puis 
choisissez la règle temporelle souhaitée dans le 
sous-menu correspondant.

Règles temporelles des playlists secondaires

Après avoir modifié la règle temporelle d'une 
piste, vous pouvez décider d'appliquer cette 
modification à la playlist active de la piste 
uniquement ou à la piste et à l'ensemble de ses 
playlists secondaires. 

Pour que toutes les nouvelles pistes soient 
basées par défaut sur le métronome, activez 
l'option New Tracks Default to Tick 
Timebase dans les préférences d'édition.

Sélecteur de règle temporelle sur une piste dont la 
hauteur est définie sur Medium

Sélecteur de règle
temporelle (tics)

Sélecteur de règle 
temporelle (échantillons)

Sélecteur de règle temporelle sur une piste dont la 
hauteur est définie sur Small 

Menu déroulant de hauteur de la piste

Sélecteur de règle
temporelle (tics)

Sélecteur de règle 
temporelle (échantillons)
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Pour configurer un changement de règle 
temporelle s'appliquant à l'ensemble des playlists 
d'une piste :

" Cliquez sur le sélecteur de règle temporelle et 
activez l'option Selection Changes Alternate 
Playlists. 

Groupes

Lorsque vous modifiez la règle temporelle d'une 
piste audio appartenant à un groupe actif, le 
changement de règle temporelle est appliqué à 
l'ensemble des pistes du groupe.

Emplacement d'une région audio

Dans les pistes audio basées sur une référence 
temporelle, l'emplacement d'une région audio 
est déterminé par le point de début de la région, 
à moins que celle-ci ne comporte un point de 
synchronisation.

Si tel est le cas, celui-ci détermine l'emplacement 
de fixation de la région sur la grille. 

Emplacement du marqueur

Lorsque vous créez des marqueurs et des 
emplacements mémoire de sélection, vous 
pouvez leur attribuer une référence absolue 
(basée sur les échantillons) ou relative, en 
mesures et temps (basée une référence 
temporelle). Pour plus d'informations, 
reportez-vous à la section Références Bar|Beat et 
absolue, page 606.

Arrondi de l'échantillon et opérations 
d'édition

Lorsque les données audio de Pro Tools sont 
basées sur les échantillons, il peut se produire un 
léger arrondi au niveau des échantillons lorsque 
l'échelle temporelle principale est définie sur 
Bars|Beats. Ceci est particulièrement évident 
lorsque vos régions audio doivent tomber 
parfaitement sur le temps (cas d'une boucle par 
exemple) : vous constaterez parfois un léger 
décalage, d'un tic ou deux. Pour éviter ce 
phénomène, il suffit de prendre quelques 
précautions simples.

Lorsque vous sélectionnez des régions audio 
pour les copier, les dupliquer ou les répéter, 
vérifiez que vous sélectionnez les données à 
l'aide du sélecteur (activez le mode Grid pour 
plus de précision), ou définissez la plage de 
sélection en entrant ses points de début et de fin 
dans la zone Event Edit. Ne sélectionnez pas les 
données avec la main (ou en cliquant deux fois 
avec le sélecteur). Ceci garantit que la sélection 
sera précise en termes de mesures et de 
battements (et qu'elle ne sera pas basée sur la 
longueur des données en échantillons).

Playlists
La possibilité de créer des playlists est une 
fonction extrêmement utile de Pro Tools. 
Chaque piste est associée à une playlist 
principale et à un certain nombre de playlists 
secondaires.

Les playlists d'édition prennent un « cliché » de la 
disposition actuelle des régions d'une piste, ce 
qui permet d'essayer librement d'autres 
dispositions, puisque vous pouvez toujours 
rétablir, si nécessaire, les playlists préalablement 
sauvegardées.

Sélecteur de règle temporelle et menu contextuel
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Une playlist, qui peut être constituée d'une seule 
ou de plusieurs régions, ne peut être affectée à 
une piste que si elle n'est pas déjà utilisée par 
une autre piste. Si vous pouvez créer un nombre 
pratiquement illimité de playlists d'édition, 
partagées entre toutes les pistes, chaque piste 
possède son propre ensemble de playlists 
d'automation dédiées.

Les playlists d'automation des pistes audio 
stockent les données correspondant au volume, 
au panoramique, aux coupures (Mute) et aux 
plug-in. Les playlists d'automation des pistes 
MIDI, en revanche, ne mémorisent que des 
informations de coupure ; les événements de 
contrôleur continu, de changements de 
programmes et Sysex sont stockés dans les 
régions MIDI et, à ce titre, font partie des 
playlists d'édition.

Utilisation des playlists

Lors de la création d'une piste, celle-ci ne 
contient qu'une seule et unique playlist, vide 
jusqu'à ce que vous y enregistriez, importiez ou 
y fassiez glisser des éléments.

De nouvelles playlists, vides ou dupliquées à 
partir de la playlist actuelle, peuvent être créées. 
Une fois une playlist créée, vous pouvez la 
rappeler, la renommer et la supprimer comme 
vous le souhaitez, à l'aide du sélecteur de 
playlists.

Duplication d'une playlist

Lorsque vous éditez une piste, vous pouvez 
travailler sur une copie de la playlist de la piste et 
conserver l'originale intacte.

Pour dupliquer la playlist actuelle d'une piste :

1  Cliquez sur le sélecteur de playlists de la piste 
et choisissez Duplicate dans le menu déroulant.

2  Donnez un nom à la nouvelle playlist, puis 
cliquez sur OK. 

La playlist dupliquée apparaît dans la piste, dont 
le nom change pour prendre celui de la nouvelle 
playlist.

Les playlists nouvelles ou dupliquées sont 
nommées automatiquement selon le modèle 
suivant : nom de la piste, suivi d'un point (.) et 
du numéro de playlist. Par exemple, la première 
playlist dupliquée d'une piste intitulée « Kick » 
est automatiquement nommée « Kick.01 », et 
les playlists dupliquées par la suite seront 
nommées «Kick.02», « Kick.03 », etc.

Pour plus d'informations sur les playlists 
d'automation, consultez la section 
chapitre 30, Automation.

Vous pouvez faire glisser des données audio 
sur une piste à partir de la liste des régions, 
des navigateurs de DigiBase, de 
l'Explorateur Windows ou du Finder de 
Mac.

Sélecteur de playlist
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Création d'une playlist

Vous pouvez créer des playlists vierges pour y 
enregistrer ou y importer des données audio et 
MIDI. Cela peut être utile notamment pour 
effectuer des prises supplémentaires de données 
audio ou MIDI ou pour essayer d'autres 
dispositions.

Pour créer une playlist (vide) :

1  Cliquez sur le sélecteur de playlist de la piste et 
choisissez New.

2  Donnez un nom à la nouvelle playlist, puis 
cliquez sur OK. Une playlist vide, portant le 
nom spécifié, apparaît alors dans la piste.

Affectation d'une playlist à une 
autre piste

Par défaut, une playlist est disponible 
uniquement pour la piste sur laquelle elle a été 
créée. Toutefois, lorsque la playlist devient 
obsolète sur sa piste d'origine ou toute autre 
piste, elle peut être réaffectée à une autre piste à 
l'aide de la fonction Other Playlists. Lorsqu'une 
playlist a été réassignée à une autre piste (quelle 
que soit la piste), elle n'est plus disponible pour 
les autres pistes, y compris sa piste d'origine.

La règle temporelle d'une playlist audio est 
enregistrée avec la playlist. Lorsque vous 
assignez une playlist non assignée à une piste, la 
piste prend en considération la règle temporelle 
enregistrée pour la playlist.

Pour assigner une playlist de piste :

" Cliquez sur le sélecteur de playlist et procédez 
comme suit :

• Sélectionnez l'une des playlists de la piste.

– ou –

• Sélectionnez une playlist à partir d'une 
autre piste en cliquant sur le sous-menu 
Other Playlists, puis en sélectionnant la 
playlist de votre choix.

La playlist sélectionnée apparaît dans la piste, 
dont le nom est mis à jour et devient celui de la 
playlist sélectionnée.

Changement du nom d'une playlist

Vous pouvez renommer une playlist en 
renommant la piste à laquelle elle est affectée. 

Pour renommer la playlist affectée à une piste :

1  Cliquez deux fois sur le nom de la piste.

2  Entrez un nouveau nom et cliquez sur OK. Les 
noms de la piste et de la playlist sont tous deux 
mis à jour.

Suppression d'une playlist

Vous pouvez supprimer complètement une 
playlist d'une session. Cependant, les playlists 
n'occupant que très peu d'espace sur le disque, il 
n'est pas nécessaire de les supprimer pour des 
raisons d'économie d'espace.

Sélection d'une playlist d'une autre piste
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Pour supprimer une ou plusieurs playlists d'une 
piste :

1  Cliquez sur le sélecteur de playlist et 
sélectionnez Delete Unused.

2  Sélectionnez les playlists non assignées que 
vous souhaitez supprimer. Cliquez tout en 
maintenant la touche Maj (Windows ou Mac), la 
touche Ctrl (Windows) ou la touche Pomme 
(Mac) enfoncée pour sélectionner plusieurs 
playlists simultanément.

3  Cliquez sur OK pour supprimer les playlists 
sélectionnées. Une fois effectuée, cette 
suppression ne peut être annulée.

Playlists et groupes

Lorsque vous créez des playlists avec des pistes 
groupées, le suffixe ajouté au nom de playlist est 
automatiquement incrémenté pour chaque 
piste du groupe actif. Cela vous permet de 
revenir à une prise précédente en sélectionnant 
les prises de playlist par groupes. 

Cette méthode vous permet d'ajouter des pistes 
au groupe existant ; les suffixes de leur nom de 
playlist sont synchronisés avec les pistes 
d'origine. 

Des playlists vides sont automatiquement créées 
afin de conserver la synchronisation des prises 
de playlist lors d'un retour à des prises plus 
récentes du groupe.

Pour conserver les noms et les performances de 
playlists synchronisées (exemple de procédure) :

1  Créez des pistes et regroupez-les.

2  Assurez-vous que le groupe est activé.

3  Créez une playlist (cliquez sur le sélecteur de 
playlist dans l'une des pistes du groupe, puis 
sélectionnez New). Le suffixe par défaut sera 
« .01 », ce qui signifie qu'il s'agit de la prise 1.

4  Enregistrez la piste 1, puis créez une playlist. 
Les playlists de toutes les pistes du groupe sont 
incrémentées et prennent la valeur « .02 ».

5  Créez des pistes (par exemple, pour un 
musicien ou un micro supplémentaire), puis 
ajoutez ces pistes au groupe (ou créez un groupe 
avec toutes les pistes).

6  Incrémentez toutes les playlists en cliquant 
sur le sélecteur de playlist dans l'une des pistes 
du groupe, puis en choisissant New.

Le même suffixe est désormais ajouté à toutes les 
playlists. Si vous créez des playlists 
supplémentaires dans l'une des pistes du groupe, 
les playlists correspondantes sont incrémentées 
afin d'assurer leur synchronisation.

7  Si vous souhaitez écouter la prise .01 du 
premier groupe de pistes, vous pouvez revenir à 
la playlist .01 à partir de n'importe quelle 
playlist du groupe.

Les playlists de toutes les pistes du groupe sont 
numérotées à l'aide de suffixes .01 (y compris les 
pistes ajoutées au groupe d'origine après les 
prises initiales). Des playlists vides sont 
automatiquement créées sur les membres 
nouvellement ajoutés, afin que les numéros de 
playlists correspondent sur l'ensemble des 
membres du groupe 

Lorsque vous supprimez une piste d'une 
session, vous avez la possibilité de 
supprimer ou de conserver ses playlists pour 
les utiliser sur d'autres pistes.

Pour plus d'informations sur le 
regroupement de pistes, consultez la section 
Regroupement des pistes, page 174.
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Multiples niveaux 
d'annulation
Pro Tools peut conserver la trace des 32 
dernières opérations pouvant être annulées et 
permet ainsi de revenir à un état d'édition 
précédent. 

Les opérations d'annulation dans Pro Tools sont 
stockées à la file, dans l'ordre où elles ont été 
appelées. Lorsque vous choisissez Edit > Undo, 
c'est l'opération la plus récente qui est annulée. 
Si vous choisissez Undo de nouveau, l'opération 
suivante dans la file sera annulée. Vous pouvez 
également choisir Edit > Redo pour rétablir une 
opération annulée, ce qui permet de remonter 
une opération après l'autre dans la file 
d'annulation.

Lorsque le nombre d'opérations de la file 
d'annulation atteint cette limite, toute autre 
opération susceptible d'être annulée remplacera 
l'opération la plus ancienne dans la file 
d'annulation.

Pour annuler la dernière opération, effectuez une 
des opérations suivantes :

" Choisissez Edit > Undo.

– ou –

" Appuyez sur Ctrl+Z (Windows) ou sur 
Pomme+Z (Mac).

Pour répéter la dernière opération annulée, 
effectuez une des opérations suivantes :

" Choisissez Edit > Redo.

– ou –

" Appuyez Maj+Ctrl+Z (Windows) ou sur 
Maj+Pomme+Z (Mac).

Fenêtre Undo History

La fenêtre Undo History permet de voir 
l'historique des opérations qu'il vous est possible 
d'annuler ou de rétablir, afin de revenir à une 
étape précédente. Cet historique affiche l'heure 
de chaque modification, ce qui vous permet de 
revenir à l'état dans lequel se trouvait la session 
à une heure précise. 

Pour afficher ou masquer la fenêtre Undo History :

" Choisissez Window > Undo History.

Pour annuler des opérations dans la fenêtre Undo 
History :

" Cliquez sur l'opération de la liste (en gras) à 
annuler. 

Toutes les opérations de la file d'attente qui ont 
été réalisées après l'opération que vous 
sélectionnez sont également annulées. Dans la 
fenêtre Undo History, les opérations qu'il est 
possible d'annuler s'affichent en gras et les 
opérations que vous pouvez rétablir (celles ayant 
déjà été annulées) s'affichent en italique.

Si aucune action ne peut être annulée, le 
menu affiche Can't Undo.

Si aucune action ne peut être répétée, le 
menu affiche Can't Redo.

Fenêtre Undo History

Opérations
impossible
à annuler

Opérations
pouvant 
être répétées

Heures de création

Sélecteur d'options
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Pour rétablir des opérations dans la fenêtre Undo 
History :

" Cliquez sur l'opération (en italique) de la liste 
à répéter.

L'opération que vous avez choisie est rétablie, 
ainsi que toutes les opérations antérieures à 
celle-ci dans la liste.

Pour activer ou désactiver l'affichage des heures 
de création dans la fenêtre Undo History :

" Cliquez dans le menu déroulant Options et 
choisissez Show Creation Times. 

Pour annuler toutes les opérations de la fenêtre 
Undo History :

" Cliquez dans le menu déroulant Options et 
choisissez Undo All.

Pour rétablir toutes les opérations de la fenêtre 
Undo History :

" Cliquez dans le menu déroulant Options et 
choisissez Redo All.

Pour effacer le contenu de la File d'annulation

" Cliquez dans le menu déroulant Options et 
choisissez Clear Undo Queue.

D'autres opérations permettent également de 
supprimer la file d'attente d'annulations, parmi 
lesquelles figurent les suivantes :

• Suppression d'une piste ou d'une région 
dans la liste des régions

• Choix de Select > Unused ou Select > 
Unused Audio Except Whole Files dans le 
menu déroulant de la liste des régions

Lorsque le nombre d'opérations de la fenêtre 
Undo History atteint cette limite, toute autre 
opération susceptible d'être annulée remplace 
l'opération la plus ancienne en haut de la file 

d'attente d'annulations. Lorsque l'opération la 
plus ancienne arrive en avant-dernière position 
et qu'elle est sur le point de disparaître de la file 
d'attente, elle s'affiche en rouge.

Niveaux d'annulation et RAM

Pro Tools devant conserver la trace des playlists 
de toutes les pistes éditées, l'utilisation de 
plusieurs niveaux d'annulation risque de 
solliciter la mémoire de façon intensive. 
Pour réduire la quantité de mémoire système 
(RAM) utilisée par la file d'annulation, il suffit de 
réduire le nombre de niveaux d'annulation dans 
Pro Tools. Si vous avez alloué une grande 
quantité de RAM à Pro Tools, vous pouvez 
utiliser un plus grand nombre de niveaux 
d'annulation.

Pour définir le nombre de niveaux d'annulation 
dans Pro Tools :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Editing.

2  Cliquez dans le champ Levels of Undo et 
entrez une valeur comprise entre 1 et 32.

3  Cliquez sur OK.

La fenêtre Undo History vous permet 
d'afficher la liste des opérations pouvant 
être annulées et de revenir à un état 
précédent.

Niveaux d'annulation
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Liste des régions
La fenêtre Edit affiche dans une liste des régions 
complète la totalité des régions audio et MIDI, 
ainsi que les groupes de régions. 

Toutes les régions enregistrées, importées ou 
créées lors de l'édition apparaissent dans la liste 
des régions. Les éléments peuvent être déplacés 
d'une liste vers des pistes et disposés dans un 
ordre quelconque. Les régions de tous types 
peuvent également être écoutées depuis la liste 
des régions en cliquant dessus tout en 
maintenant la touche Option (Mac) ou Alt 
(Windows) enfoncée.

Le menu déroulant Region List accessible à 
partir du haut de la fenêtre Region List propose 
des outils et des commandes permettant de gérer 
le contenu de la liste.

Menu déroulant de la liste des 
régions :

Le menu déroulant de la liste des régions 
propose des outils permettant de rechercher, 
sélectionner, trier, exporter, supprimer et gérer 
les différents éléments de la liste. 

Pour accéder au menu déroulant Region List :

" Dans la fenêtre Edit, cliquez sur le menu 
déroulant de la liste des régions.

Affichage des régions dans la liste des 
régions

Dans la liste des régions, les régions audio de 
fichiers complets apparaissent en gras et les 
régions stéréo et multicanaux peuvent être 
agrandies pour afficher des canaux particuliers.

Les noms de régions pouvant être longs, vous 
pouvez faire défiler ou redimensionner la liste 
des régions si nécessaire (voir figure 18, 
page 419). 

Si l'option Region List Selection Follows Track 
Selection des préférences d'édition est active, 
une région ou un groupe de régions sur lesquels 
vous cliquez dans la liste des régions passent en Figure 18.  Liste des régions

Cliquez sur le bouton Show/Hide Region List 
pour masquer la liste des régions

Faites glisser la 
largeur de la 

liste des régions pour 
la redimensionner

Cliquez pour faire apparaître le menu 
contextuel

Focus sur le clavier

Menu Region List

Menu Region List
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surbrillance dans la piste à laquelle ils 
appartiennent. De même, la sélection d'une 
région ou d'un groupe de régions dans une piste 
est reflétée dans la liste des régions.

Affichage des informations du fichier 
pour les régions audio

Outre les noms des régions, la liste des régions 
peut également afficher des informations 
concernant le codage couleur, le type (audio, 
MIDI et groupe de régions), la règle temporelle 
et le fichier audio parent de la région :

Color : affiche le codage couleur des régions.

Icon : affiche l'icône pour les régions audio et 
MIDI, ainsi que les groupes de régions.

Timebase : affiche la règle temporelle pour les 
régions audio et MIDI, ainsi que pour les 
groupes de régions.

File Name : affiche le nom du fichier parent.

Disk Name : affiche le nom du disque dur sur 
lequel sont situés les fichiers référencés.

Full Path : affiche le chemin de répertoire 
complet du fichier parent de la région.

Channel Name : affiche le nom du canal des 
fichiers audio importés à partir d'enregistreurs 
portables.

Scene and Take : affiche la scène et la prise des 
fichiers audio importés à partir d'enregistreurs 
portables.

Par défaut, Pro Tools n'affiche que le nom de 
région dans la liste des régions. 

Tri et recherche dans la liste des 
régions

La plupart des sessions contiennent de 
nombreuses régions, ce qui peut rendre difficile 
la recherche d'une région particulière dans la 
liste des régions. Pro Tools vous permet de trier 
et de rechercher les régions dans la liste de 
régions afin de localiser rapidement les régions 
recherchées.

Utilisez la liste des régions comme un 
chutier permettant de stocker vos boucles 
audio et clips MIDI favoris. Si vous 
enregistrez une session sous forme de 
modèle (voir Création de modèles de session 
personnalisés, page 109), les régions seront 
directement disponibles pour de futures 
sessions.

Régions et informations de fichier affichées dans la 
liste des régions

Lorsque vous effectuez des modifications, la 
liste des régions peut se remplir rapidement 
de régions créées automatiquement. 
Vous pouvez masquer les régions créées 
automatiquement en choisissant l'option 
Show dans le menu déroulant Region List, 
puis en désélectionnant l'option Auto-
Created.
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Pour trier les régions dans la liste des régions :

1  Cliquez dans le menu déroulant de la liste des 
régions (en haut de la liste), puis choisissez 
Sort By. 

2  Sélectionnez une base de tri dans le sous-
menu :

• Region Type (régions audio, groupes de 
régions, régions midi)

• Name

• Length

• Original Time Stamp

• User Time Stamp

• Timebase

• Start in Parent

• End in Parent

• File Name

• File Length

• File Creation Date

• File Modification Date

• Disk Name (groupes de régions et audio 
uniquement)

• Track Format/Width

• By Channel Name

• By Scene and Take

3  Cliquez sur le menu déroulant Region List, 
choisissez Sort By, puis sélectionnez l'une des 
options suivantes pour appliquer des critères de 
tri supplémentaires :

• Ascending

• Descending

Recherche de régions

Utilisez la commande Find pour afficher toutes 
les régions d'une liste dont les noms 
contiennent un mot ou une phrase donnés.

Pour rechercher et afficher les régions dans la 
liste des régions :

1  Effectuez l'une des opérations suivantes :

• Dans le menu déroulant de la liste des 
régions, choisissez Find. 

– ou –

• Appuyez sur Pomme+Maj+F (Mac) ou sur 
Ctrl+Maj+F (Windows).

2  Dans la boîte de dialogue Find Regions, 
effectuez l'une des opérations suivantes : 

• Sélectionnez By name puis tapez le nom ou 
une partie du nom des régions que vous 
recherchez. La chaîne de recherche 
s'affiche en haut de la liste des régions.

• Sélectionnez Include subsequently added 
regions pour limiter l'affichage aux régions 
qui viennent d'être ajoutées. Un signe plus 
(+) s'affiche en haut de la liste des régions 
pour indiquer que cette option est 
sélectionnée.

• Sélectionnez les deux options pour 
commencer la recherche avec la liste de 
régions spécifiée et autoriser l'affichage des 
régions ajoutées. 

Boîte de dialogue Find Regions
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3  Cliquez sur OK.

Tous les types de régions dont les noms 
correspondent au mot ou à l'expression que 
vous recherchez s'affichent dans la liste des 
régions. La chaîne de recherche s'affiche en haut 
de la liste des régions entre parenthèses. 

Le texte saisi dans la boîte de dialogue Find est 
enregistré dans un historique, ce qui vous 
permet de trouver rapidement des expressions 
déjà recherchées, sans avoir à en taper de 
nouveau la totalité. 

Pour effectuer de nouveau une recherche sur un 
élément déjà recherché :

1  Dans le menu déroulant de la liste des régions, 
choisissez Find.

2  Cliquez sur la petite flèche à droite du champ 
de texte de la boîte de dialogue Find, puis 
sélectionnez une chaîne de texte dans le menu 
déroulant de l'historique de recherche. 

L'historique est enregistré avec la session. 

L'historique permet non seulement d'enregistrer 
toute chaîne de texte recherchée préalablement, 
mais également d'insérer manuellement 
plusieurs entrées dans l'historique de recherche 
(sans qu'il soit nécessaire d'effectuer chaque 
recherche pour stocker des mots ou des 
expressions). 

Pour compiler un historique de recherche sans 
devoir effectuer chaque recherche :

1  Dans le menu déroulant de la liste des régions, 
choisissez Find. 

2  Tapez le nom ou une partie du nom des 
régions que vous recherchez. 

3  Cliquez sur la double flèche à droite du champ 
de texte de la boîte de dialogue Find et 
maintenez-la enfoncée, puis sélectionnez Insert 
Entry dans le menu déroulant. 

4  Saisissez une autre entrée, puis choisissez de 
nouveau Insert Entry pour ajouter des chaînes 
de recherche supplémentaires à l'historique. 

Pour supprimer une entrée de l'historique :

1  Sélectionnez-la dans le menu déroulant Find 
History de sorte qu'elle s'affiche dans le champ 
de texte. 

2  Dans le menu déroulant de l'historique de 
recherche, choisissez Remove Entry. 

Pour effacer le contenu de l'historique de 
recherche :

" Dans le menu déroulant Find History, 
choisissez Remove All Entries. 

Régions trouvées dans la liste des régions

Exemple d'historique de recherche

Liste des régions au cours d'une recherche
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Sélection des régions dans la liste 
des régions

Dans les listes des régions vous pouvez 
sélectionner plusieurs régions pour les faire 
glisser vers des pistes, les traiter avec des plug-in 
AudioSuite ou les exporter.

Pour sélectionner ou désélectionner une région 
dans la liste des régions, effectuez une des 
opérations suivantes :

" Cliquez sur un nom de région qui n'est pas en 
surbrillance pour le sélectionner

– ou –

" Cliquez sur un nom de région en surbrillance 
pour le désélectionner.

Pour sélectionner un ensemble de régions, 
effectuez l'une des opérations suivantes :

" Placez le curseur sur la gauche des noms des 
régions pour faire apparaître le rectangle de 
sélection et entourez-en les régions que vous 
voulez sélectionner.

– ou –

" Cliquez sur le nom de la région dans la liste 
des régions, puis cliquez en maintenant la 
touche Maj enfoncée sur un nom de région 
supplémentaire.

Toutes les régions comprises entre la première 
région sélectionnée et la région supplémentaire 
sont automatiquement prises en compte.

Pour sélectionner ou désélectionner un ensemble 
de régions à l'aide du rectangle de sélection :

1  Placez le curseur à gauche d'un nom de région 
jusqu'à ce que l'icône du rectangle de sélection 
et un petit symbole « + » apparaissent :

• Pour pouvoir sélectionner des régions, le 
rectangle de sélection doit être placé à 
gauche d'un nom de région qui n'est pas en 
surbrillance.

• Pour désélectionner des régions, le 
rectangle de sélection doit être placé à 
gauche d'un nom de région en surbrillance.

2  Cliquez sur le nom d'une région, puis faites-le 
glisser vers le haut ou vers le bas (pour 
sélectionner ou désélectionner les régions 
situées immédiatement au-dessus ou au-dessous 
du nom de région.

Pour sélectionner ou désélectionner des régions 
non consécutives, procédez comme suit :

" Tout en maintenant la touche Pomme (Mac) 
ou la touche Ctrl (Windows) enfoncée, cliquez 
sur des noms de régions n'apparaissant pas en 
surbrillance pour les sélectionner.

– ou –

" Maintenez enfoncée la touche Ctrl (Windows) 
ou la touche Pomme (Mac) et cliquez sur des 
noms de régions surbrillance pour les 
désélectionner.

Régions entourées par le rectangle de sélection

Pour sélectionner plusieurs régions non 
consécutives dans la liste des régions, 
appuyez et maintenez enfoncée la touche 
Ctrl (Windows) ou la touche Pomme (Mac) 
tout en effectuant les sélections.
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Sélection de régions au clavier

Si le focus clavier de la liste des régions est 
activé, vous pouvez taper les premières lettres du 
nom d'une région pour que Pro Tools recherche 
et sélectionne automatiquement la région dans 
la liste correspondante.

Pour activer et utiliser le focus clavier sur la liste 
des régions :

1  Cliquez sur le bouton de focus clavier en haut 
et à droite de la liste des régions.

2  Tapez les premières lettres de la région pour 
que Pro Tools la recherche et la sélectionne 
automatiquement. Lorsqu'une région a été 
trouvée et sélectionnée, vous pouvez la faire 
glisser sur une piste.

La sélection au clavier de régions audio 
recherche les régions d'après leur nom et non 
d'après celui de leurs fichiers parents ou des 
volumes sur lesquels ils résident.

Ecoute des régions dans la liste des 
régions

Pour écouter une région de la liste des régions :

" Maintenez la touche Alt (Windows) ou la 
touche Option (Mac) enfoncée tout en cliquant 
sur le nom de la région.

Pistes stéréo et multicanaux dans 
la liste des régions

Les régions stéréo et multicanaux, qu'elles soient 
importées ou enregistrées dans Pro Tools, 
s'affichent sous forme d'éléments uniques dans 
la liste des régions. Par exemple, deux régions 
sources mono nommées « Main Piano.L » et 
« Main Piano.R » apparaissent dans la liste sous 
la forme « Main Piano (Stereo) ». Un triangle de 
réduction et d'agrandissement indique les 
régions stéréo et multicanaux. 

Les régions stéréo et multicanaux apparaissent 
par défaut dans la liste des régions en vue 
réduite. Vous pouvez afficher leurs régions 
individuelles en cliquant sur la flèche située à 
gauche de la région pour la développer.

Pour agrandir ou réduire toutes les régions stéréo 
et multicanaux :

" Appuyez sur Option (Mac) ou sur Alt 
(Windows) tout en cliquant sur le triangle.

Chaque élément d'une région stéréo et 
multicanal en vue agrandie peut être sélectionné 
indépendamment des autres régions associées 
dans la liste des régions.

Focus clavier de la liste des régions activé

Cliquez pour 
activer ou 
désactiver le 
focus clavier

Régions stéréo réduites (haut) et développées (bas).

Triangles de 
développement/ 
réduction 
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Règles pour les régions stéréo et 
multicanaux

Pour afficher les régions stéréo et multicanaux 
sous forme de régions collectives, les régions du 
composant doivent être de même durée. Si une 
région stéréo ou multicanal existante a été 
déplacée sur plusieurs pistes mono, puis éditée 
de sorte qu'un ou plusieurs composants ne sont 
plus de la même longueur, l'affichage stéréo 
disparaît et les régions apparaissent sous forme 
de régions individuelles dans la liste des régions.

Menus contextuels des noms 
de régions affichés avec le 
bouton droit de la souris
(liste des régions)

Lorsque vous cliquez avec le bouton droit de la 
souris sur un nom dans la liste des régions, un 
menu contextuel permet d'accéder aux 
commandes suivantes :

Clear : supprime les régions sélectionnées de la 
session.

Rename : renomme les régions sélectionnées.

Time Stamp : redéfinit le marquage temporel des 
régions sélectionnées.

Replace Region (Pro Tools LE avec DV Toolkit 2 
uniquement) : remplace plusieurs instances d'un 
région par une autre région.

Compact : compacte les régions sélectionnées.

Export Region Definitions : exporte les 
définitions des régions sélectionnées.

Export Regions as Files : exporte les régions 
sélectionnées sous forme de fichiers.

Recalculate Waveform Overviews : retrace les 
formes d'onde des régions sélectionnées.

Select Parent in Workspace : met en 
surbrillance le fichier parent de la région 
sélectionnée dans le navigateur de l'espace de 
travail DigiBase.

Object Select in Edit Window : sélectionne une 
région sous forme d'objet dans la fenêtre Edit.

Modes d'édition
Pro Tools propose quatre modes d'édition : Slip, 
Shuffle, Spot et Grid. Le mode Grid offre 
également deux modes de fonctionnement : 
absolu et relatif. Pour sélectionner le mode 
d'édition, cliquez sur le bouton correspondant 
dans la partie supérieure gauche de la 
fenêtre Edit.

Le mode d'édition a une incidence sur le 
déplacement et le positionnement des régions 
audio et MIDI (et des notes MIDI), sur le 
fonctionnement des commandes Copier et 
Coller, ainsi que sur le fonctionnement des 
différents outils d'édition (outil de trimming, 
sélecteur, main et crayon).

Boutons de mode d'édition

Pour définir le mode d'édition, vous pouvez 
également utiliser les touches F1 (Shuffle), 
F2 (Slip), F3 (Spot) et F4 (Grid). 

Utilisez la touche d'accent ( ` ) pour 
basculer d'un mode d'édition à un autre.
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Shuffle

Le mode Shuffle (le terme signifie « mélanger » 
en anglais) permet de déplacer, rogner, couper 
ou coller librement les régions dans une piste ou 
vers d'autres pistes, mais leur mouvement est 
restreint par les autres régions. Autrement dit, si 
vous placez plusieurs régions dans une piste, 
elles s'alignent automatiquement l'une avec 
l'autre. Vous pouvez ensuite modifier l'ordre 
dans lequel elles se succèdent, mais vous ne 
pouvez pas les séparer, ni les superposer comme 
en mode Slip. Cependant, s'il existe un silence 
entre des régions existantes et que ces régions 
sont modifiées, le silence est maintenu et n'est 
pas supprimé.

En mode Shuffle, l'ajout d'une autre région au 
début d'une piste décale les régions suivantes 
vers la droite, de la durée de la région ajoutée. 

Lorsque vous utilisez l'outil de trimming en 
mode Shuffle, le fait de modifier le point de 
début ou de fin d'une région décale 
automatiquement les régions suivantes en 
conséquence. Le mode Shuffle n'a pas 
d'incidence sur le placement et l'insertion de 
notes MIDI.

Verrouillage du mode Shuffle

Il est important d'exclure le mode Shuffle de 
certaines procédures afin de s'assurer que les 
régions restent synchronisées pendant l'édition. 
Le verrouillage du mode Shuffle entraîne la 
désactivation de toutes les touches de raccourci 
et de surface de contrôle correspondant à ce 
mode. Le mode Shuffle ne peut plus être 
sélectionné, même par inadvertance. Le 
verrouillage du mode Shuffle ne peut être 
effectué lorsque le mode Shuffle est en cours 
d'utilisation. 

Pour verrouiller le mode Shuffle :

" En mode d'édition quelconque excepté le 
mode Shuffle, cliquez sur le bouton Shuffle de 
l'écran tout en maintenant la touche Ctrl 
(Windows) ou la touche Pomme (Mac) 
enfoncée. Une icône représentant un cadenas 
apparaît sur le bouton Shuffle. 

Pour déverrouiller le mode Shuffle :

" Cliquez sur le cadenas du bouton Shuffle tout 
en maintenant la touche Pomme (Mac) ou la 
touche Ctrl (Windows) enfoncée.

Slip

En mode Slip (le terme signifie glisser en 
anglais), vous pouvez déplacer les régions 
librement à l'intérieur d'une même piste ou vers 
d'autres pistes. Dans ce mode, il est possible de 
placer une région dans une piste en laissant un 
espace entre elle et les autres régions. Lors de la 
lecture de la piste, cet espace est silencieux. Vous 
pouvez également déplacer une région pour 
qu'elle recouvre partiellement ou complètement 
une autre région.

Utilisez le mode Slip lorsque vous voulez que 
l'outil de trimming, le sélecteur, la main et le 
crayon fonctionnent sans aucune restriction de 
placement temporel.

Icône cadenas indiquant le verrouillage du mode 
Shuffle

Verrouillage 
du mode Shuffle
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Spot

 Utilisez le mode Spot (le terme signifie « point 
précis » en anglais) pour placer des régions à des 
endroits précis. Ce mode permet de préciser un 
point précis (exprimé en timecode SMPTE ou 
tout autre format temporel), capturer une 
adresse de timecode entrant ou utiliser les 
marqueurs temporels d'une région comme 
points de référence pour le placement. Ceci peut 
être particulièrement utile lorsque vous 
effectuez des tâches de post-production d'après 
des timecodes SMPTE correspondant à une 
image précise. 

Lorsque le mode Spot est activé, Pro Tools vous 
demande d'indiquer un emplacement de 
destination lorsqu'une région est déplacée à 
partir de la liste des régions, d'un navigateur 
DigiBase, de l'Explorateur Windows ou du 
Finder de Mac.

Grid

En mode Grid, les régions et les notes MIDI 
déplacées, rognées ou insérées s'alignent sur la 
valeur de grille sélectionnée ou sur les 
incréments précis d'une grille temporelle définie 
par l'utilisateur. 

Grid absolu et relatif

Le mode Grid peut être appliqué en mode absolu 
ou relatif : 

! En mode Grid absolu, le déplacement d'une 
région entraîne le déplacement du début de la 
région sur le pas de la limite de la grille. Si le 
point de départ d'une région se trouve entre 

deux temps et que la grille est définie sur 1/4 de 
note, le déplacement de la région déplace l'heure 
de début lui correspondant sur le 1/4 de note le 
plus proche (la valeur actuelle de grille absolue). 

! En mode Grid relatif, les régions peuvent être 
déplacées par unités de pas (ou d'incréments). 
Si le point de départ d'une région se trouve entre 
deux temps et que la grille est définie sur des 
1/4 de note, le déplacement de la région est 
contraint à 1/4 de note et conserve la position 
relative de la région sur la mesure la plus proche.

Pour sélectionner le mode Grid absolu ou relatif :

" Cliquez sur le sélecteur de mode Grid, puis 
choisissez Absolute ou Relative. 

Configuration de la grille

Le pas réel de la grille, défini dans le menu 
déroulant Grid Value, peut être basé sur une 
valeur temporelle en utilisant l'échelle 
principale de temps (option Main Time Scale) ; 
si cette option n'est pas sélectionnée, vous 
pouvez utiliser un autre format temporel pour le 
pas de la grille. 

Pour suspendre temporairement le mode 
Grid et basculer en mode Slip tout en 
déplaçant une région, cliquez et maintenez 
enfoncée la touche Ctrl (Windows) ou la 
touche Pomme (Mac).

Pour plus d'informations sur le mode Grid 
relatif, reportez–vous à la section 
Déplacement des régions par glissement en 
mode Grid, page 502. 
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L'indicateur de valeur de grille et le menu 
déroulant sont situés dans la fenêtre Edit.

Regions/Markers est une autre option disponible 
du menu déroulant Grid Value. Lorsque cette 
option est sélectionnée, les événements peuvent 
être placés librement (comme en mode Slip) 
mais ils viennent s'aligner sur les emplacements 

de la région (points de début, de fin et de 
synchronisation), sur les marqueurs et les 
sélections d'édition lorsque vous les placez à 
proximité.

Pour afficher les lignes de la grille dans la fenêtre 
Edit, procédez comme suit :

" Choisissez Setup > Preferences, puis cliquez 
sur l'onglet Display et activez Draw Grids in Edit 
Window.

– ou –

" Activez (et désactivez) les graduations en 
cliquant sur n'importe quel nom de la règle de 
base de temps.

Indicateur de valeur de grille et menu déroulant

La valeur de grille actuelle est également 
utilisée pour la commande de quantification 
de grille Quantize to Grid (voir 
Quantification des régions sur la grille, 
page 509) et la commande Separated 
Region At Grid (voir Commandes Separate 
Region, page 486).

Les notes MIDI insérées avec le crayon 
ignorent l'option Regions/Markers et 
s'alignent sur la valeur temporelle 
sélectionnée dans le menu déroulant Grid 
Value.

Lignes de la grille affichées dans la fenêtre Edit

Activation des lignes de la grille à partir de la règle 
temporelle

Cliquez pour activer ou désactiver les lignes de la grille
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Outils d'édition
Pro Tools propose plusieurs outils d'édition : 
Zoom, outil de trimming, sélecteur, Main, outil 
de scrubbing, crayon et outil multifonction 
Smart. Sélectionnez l'outil de votre choix en 
cliquant dessus dans la fenêtre Edit. Le Zoom, 
l'outil de trimming, la main et le crayon 
comportent des modes différents, qui peuvent 
être sélectionnés depuis un menu contextuel 
multiple lorsque vous cliquez sur l'outil.

Boutons de zoom Utilisez les boutons de zoom 
pour effectuer des zooms avant ou arrière, 
verticalement ou horizontalement sur les 
données MIDI et les données de piste audio. 
En outre, vous pouvez enregistrer et rappeler 
cinq présélections de zoom.

Zoom : permet de sélectionner une vue de zoom 
sur une piste.

Changement de zoom : permet de passer de la 
valeur de zoom en cours à un facteur de zoom 
défini, et inversement.

Outils de trimming : permet d'appliquer un 
rognage aux régions et groupes de régions.

Sélecteur : permet d'effectuer des sélections sur 
les pistes.

Main : permet de sélectionner, séparer ou 
déplacer des régions sur des pistes.

Outil Smart  permet de rogner, sélectionner ou 
saisir des régions sur des pistes.

Outil de scrubbing : permet de lire en mode 
scrubbing les éléments d'une piste.

Crayon : permet de dessiner une automation ou 
des données MIDI.

Utilisation des outils de zoom
Les options de zoom de Pro Tools sont les 
suivantes : les boutons de zoom horizontal et 
vertical, le Zoom, les boutons de présélection de 
zoom et la commande de changement de zoom.

Boutons de zoom

Pro Tools propose différents boutons 
permettant d'effectuer un zoom sur les données 
de pistes.

Boutons de zoom avant/arrière horizontal

Les boutons de zoom avant/arrière horizontal 
permettent de zoomer horizontalement sur les 
données d'une piste.

Boutons de zoom et outils d'édition

Vous pouvez utiliser les touches F5 (Zoom), 
F6 (Trimming), F7 (Sélecteur), F8 (Main), 
F9 (Scrubbing) et F10 (Crayon) pour 
sélectionner l'outil d'édition correspondant 
et parcourir son sous-ensemble d'outils. 

Appuyez sur la touche Echap pour basculer 
entre les différents outils d'édition.

Changement de zoom Outil Smart

Crayon

Zoom
Outils de 

Sélecteur

Main

Outil de scrubbing
Boutons de zoom

trimming

Bouton de zoom avant horizontal 

Bouton de zoom 
arrière horizontal

Bouton de zoom
avant horizontal
(sélectionné)
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Pour effectuer un zoom avant horizontal sur 
l'ensemble des pistes, procédez comme suit :

" Cliquez sur la commande de zoom avant 
horizontal.

" Appuyez sur les touches Pomme+] (Mac) ou 
Ctrl+] (Windows).

" Cliquez sur la commande de zoom avant 
horizontal et faites-la glisser pour effectuer un 
zoom continu.

Pour effectuer un zoom arrière horizontal sur 
l'ensemble des pistes, procédez comme suit :

" Cliquez sur la commande de zoom arrière 
horizontal.

" Appuyez sur les touches Pomme+[ (Mac) ou 
Ctrl+[ (Windows).

" Cliquez sur la commande de zoom arrière 
horizontal et faites-la glisser pour effectuer un 
zoom continu.

Boutons de zoom avant et arrière pour les 
éléments audio et MIDI

Les boutons de zoom audio et MIDI vous 
permettent respectivement d'effectuer un zoom 
avant ou arrière verticalement sur les éléments 
audio et MIDI.

Pour effectuer un zoom avant vertical sur 
l'ensemble des pistes audio, procédez comme 
suit :

" Cliquez sur la commande de zoom avant 
audio. 

" Appuyez sur Pomme+Option+] (Mac) ou sur 
Ctrl+Alt+] (Windows).

" Cliquez sur la commande de zoom audio et 
faites-la glisser pour effectuer un zoom continu.

Pour effectuer un zoom arrière vertical sur 
l'ensemble des pistes audio, procédez comme 
suit :

" Cliquez sur la commande de zoom arrière 
audio. 

" Appuyez sur Pomme+Option+[ (Mac) ou sur 
Ctrl+Alt+[ (Windows).

" Cliquez sur la commande de zoom arrière 
audio et faites-la glisser pour effectuer un zoom 
continu.

Pour effectuer un zoom avant vertical sur 
l'ensemble des pistes d'instruments et MIDI, 
procédez comme suit :

" Cliquez sur la commande de zoom avant 
MIDI.

– ou –

" Appuyez sur Pomme+Maj+] (Mac) ou sur 
Ctrl+Maj+] (Windows).

Pour effectuer un zoom arrière vertical sur 
l'ensemble des pistes d'instruments et MIDI, 
procédez comme suit :

" Cliquez sur la commande de zoom arrière 
MIDI.

– ou –

" Appuyez sur Pomme+Maj+[ (Mac) ou sur 
Ctrl+Maj+[ (Windows).

Boutons de zoom vertical audio et MIDI

Boutons de zoom
vertical audio

Bouton de zoom 
vertical MIDI
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Pour effectuer un zoom vertical vers l'avant ou 
vers l'arrière sur une piste d'instrument ou MIDI :

1  Vérifiez que la vue de piste n'est pas définie sur 
Régions.

2  Sélectionnez le zoom. 

3  Maintenez la touche Démarrer (Windows) ou 
Ctrl (Mac) enfoncée, puis cliquez et faites glisser 
la souris vers le haut pour effectuer un zoom 
avant ou vers le bas pour effectuer un zoom 
arrière.

Autres fonctions du bouton de zoom

Pour revenir au niveau de zoom précédent, 
procédez comme suit :

" Maintenez la touche Option (Mac) ou la 
touche Alt (Windows) enfoncée, pendant que 
vous cliquez sur l'un des boutons de zoom 
horizontal audio ou MIDI.

– ou –

" Appuyez sur Pomme+Option+E (Mac) ou sur 
Ctrl+Alt+E (Windows).

Pour effectuer un zoom avant dans une sélection :

" Appuyez sur Option+F (Mac) ou sur Alt+F 
(Windows).

Pour effectuer un zoom de manière à ce que toutes 
les régions soient visibles dans la fenêtre Edit, 
procédez comme suit :

" Cliquez deux fois sur le Zoom dans la barre 
d'outils.

– ou –

" Appuyez sur Option+A (Mac) ou sur Alt+A 
(Windows).

Zoom

Le Zoom permet d'effectuer un zoom avant et 
arrière dans une zone particulière de la piste. 
Il comporte deux modes : le mode Normal et le 
mode Single Zoom. 

! En mode zoom normal, le Zoom reste 
sélectionné après l'action de zoom. 

! En mode Single Zoom, l'outil d'édition 
sélectionné précédemment est resélectionné 
automatiquement après le zoom.

Zoom normal

Pour effectuer un zoom autour d'un point 
particulier de la piste :

1  Procédez comme suit pour activer le mode 
Normal Zoom :

• Cliquez dans le menu déroulant du Zoom 
et sélectionnez le mode Normal Zoom.

– ou –

• Pour passer en mode Normal Zoom, 
appuyez sur la touche F5.

2  Cliquez une fois avec l'outil de zoom sur un 
point de la piste. Toutes les pistes sont agrandies 
d'un niveau et la fenêtre Edit est centrée autour 
du point cible.

3  Pour revenir au niveau de zoom précédent, 
maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée et cliquez sur l'outil de 
zoom.

Zoom
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Pour effectuer un zoom avant sur une zone 
particulière de la piste :

1  Procédez comme suit pour activer le mode 
Normal Zoom :

• Cliquez dans le menu déroulant du Zoom 
et sélectionnez le mode Normal Zoom.

– ou –

• Pour passer en mode Normal Zoom, 
appuyez sur la touche F5.

2  Effectuez l'une des opérations suivantes :

• Pour effectuer un zoom horizontal, faites 
glisser le Zoom dans la playlist de la piste.

– ou –

• Pour effectuer un zoom horizontal et 
vertical, appuyez sur la touche Pomme 
(Mac) ou la touche Ctrl (Windows) tout en 
vous déplaçant dans la playlist de la piste.

La zone agrandie remplit toute la fenêtre Edit.

Mode zoom simple 

Le mode Single Zoom (zoom simple) qui vous 
ramène à l'outil précédent lorsqu'un zoom a été 
effectué.

Par exemple, lorsque vous utilisez l'outil Smart, 
si vous cliquez sur le mode Single Zoomer, 
chaque fois qu'un zoom aura été effectué 
Pro Tools reviendra automatiquement à l'outil 
Smart.

Pour utiliser le mode Single Zoom, procédez 
comme suit :

" Cliquez sur le menu déroulant du Zoom et 
sélectionnez le mode Single Zoom.

– ou –

" Appuyez sur la touche F5 pour basculer en 
mode Single Zoom.

Le mode Single Zoom est identifié par une flèche 
vers la droite dans l'icône du Zoom. 

Cette flèche est absente dans le mode de zoom 
normal.

Zoom dans une règle

Pour effectuer un zoom horizontal dans une règle :

1  Appuyez sur Pomme+Ctrl (Mac) ou sur 
Ctrl+Alt (Windows) et déplacez le curseur dans 
la zone de la règle pour afficher l'outil de zoom.

2  Effectuez l'une des opérations suivantes :

• Cliquez une fois pour effectuer un zoom 
avant d'un niveau autour d'un certain 
point.

– ou –

• Déplacez le Zoom autour d'une zone 
particulière de la règle.

Zoom horizontal avec le Zoom

Mode zoom simple

Mode zoom normal

Zoom dans une règle
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Zoom en continu à l'aide du zoom

Utilisez l'outil Zoom pour effectuer un zoom 
avant ou arrière en continu. 

Pour effectuer un zoom en continu sur une piste ou 
un groupe de pistes donné :

1  Sélectionnez le zoom. 

2  Maintenez la touche Ctrl (Mac) ou Démarrer 
(Windows) enfoncée, puis faites glisser le zoom 
sur une piste, comme suit :

• Vers le haut, pour un zoom avant vertical

• Vers le bas, pour un zoom arrière vertical

• Vers la droite, pour un zoom avant 
horizontal

• Vers la gauche, pour un zoom arrière 
horizontal

Avec le zoom horizontal, le zoom est effectué 
simultanément sur toutes les pistes. Le 
déplacement du zoom sur les pistes s'effectue 
horizontalement vers l'avant ou vers l'arrière à 
partir de l'emplacement sur lequel vous avez 
cliqué. 

Zoom vertical vers l'avant ou vers l'arrière en 
continu sur l'ensemble des pistes audio

La fonction de zoom continu affecte 
normalement uniquement la piste ou le groupe 
de pistes dans lesquels vous cliquez. Vous 
pouvez toutefois choisir d'effectuer un zoom sur 
l'ensemble des pistes audio affichées 
simultanément. 

Pour effectuer un zoom vertical continu vers 
l'avant ou vers l'arrière sur l'ensemble des pistes 
audio :

1  Sélectionnez le zoom. 

2  Appuyez sur les touches Ctrl+Maj (Mac) ou 
Démarrer+Maj (Windows), puis faites glisser la 
souris vers le haut ou vers le bas. Lorsque vous 
relâchez la souris, le zoom s'effectue sur toutes 
les pistes audio affichées au même niveau de 
zoom. 

Boutons de présélection de zoom

Pro Tools permet de conserver 5 présélections de 
zoom horizontal dans la fenêtre Edit, que vous 
pouvez rappeler en tapant leur chiffre ou en 
cliquant sur le bouton de présélection 
correspondant. 

Pour enregistrer une vue comme présélection 
de zoom :

1  Utilisez le zoom pour configurer la vue de 
piste selon vos préférences. 

2  Cliquez sur un bouton de présélection de 
zoom (de 1 à 5) et maintenez le bouton de la 
souris enfoncé, puis sélectionnez Save Zoom 
Preset dans le menu contextuel de présélection 
de zoom. Le bouton de présélection clignote 
momentanément, puis la présélection de zoom 
existante enregistrée à ce numéro est remplacée. 

Menu contextuel de présélection de zoom
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Pour rappeler une présélection de zoom 
enregistrée, effectuez l'une des actions 
suivantes :

" Cliquez sur le bouton de présélection de zoom 
correspondant (de 1 à 5). 

– ou –

" Cliquez sur le bouton Zoom Preset et 
maintenez le bouton de la souris enfoncé, puis 
sélectionnez Recall Zoom Preset dans le menu 
contextuel de présélection de zoom.

Changement de zoom

Le bouton de changement de zoom vous permet 
de définir et de basculer d'un état de zoom à un 
autre directement depuis la fenêtre Edit.

Paramètres de changement de zoom

La boîte de dialogue Zoom Toggle permet 
d'enregistrer et de rappeler les paramètres 
suivants :

• Vertical Zoom

• Horizontal Zoom

• Track Height

• Track View

• Paramètre de grille

Préférences du changement de zoom 

Les préférences du changement de zoom 
déterminent le fonctionnement du changement 
de zoom. Réglez les préférences du changement 
de zoom de façon à les adapter à vos procédures 
de travail. 

Vertical Zoom

Selection : lorsque cette valeur est sélectionnée, 
le changement de zoom vers l'avant effectue un 
zoom vertical sur la sélection actuelle à éditer.

Last Used : lorsque cette valeur est sélectionnée, 
le changement de zoom vers l'avant effectue un 
zoom vertical sur le dernier état du changement 
de zoom stocké des notes MIDI dans la vue 
Notes uniquement. 

Préférences du changement de zoom

Pour l'édition MIDI, définissez les 
préférences du changement de zoom comme 
suit : Vertical Zoom sur Last Used, 
Horizontal Zoom sur Last Used, Track View 
sur Waveform/Notes et Track Height sur Fit 
to Window.

Pour l'édition audio, définissez les 
préférences du changement de zoom comme 
suit : Vertical Zoom sur Selection, 
Horizontal Zoom sur Selection, Track 
Height sur Fit to Window et Track View sur 
No Change.
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Horizontal Zoom

Selection : lorsque cette valeur est sélectionnée, 
le changement de zoom vers l'avant effectue un 
zoom horizontal sur la sélection actuelle. Ceci 
s'avère particulièrement utile lors de l'édition de 
données audio.

Last Used : lorsque cette valeur est sélectionnée, 
le changement de zoom vers l'avant effectue un 
zoom horizontal sur le dernier état enregistré du 
changement de zoom. Cette option peut émuler 
une autre fenêtre d'édition. Ceci est très utile 
pour l'édition des notes MIDI.

Remove Range Selection After Zooming In 

Lorsque l'option Remove Range Selection After 
Zooming In est sélectionnée, la sélection à éditer 
est réduite en un point d'insertion après le 
changement de zoom vers l'avant.

Track Height

Last Used : lorsque cette valeur est sélectionnée, 
le changement de zoom vers l'avant remplace la 
hauteur de toutes les pistes contenant une 
sélection à éditer par la hauteur de piste utilisée 
en dernier.

Medium : lorsque cette valeur est sélectionnée, le 
changement de zoom vers l'avant remplace la 
hauteur de toutes les pistes contenant une 
sélection à éditer par la hauteur de piste 
moyenne.

Large : lorsque cette valeur est sélectionnée, le 
changement de zoom vers l'avant remplace la 
hauteur de toutes les pistes contenant une 
sélection à éditer par la taille élevée de la 
hauteur de piste.

Jumbo : lorsque cette valeur est sélectionnée, le 
changement de zoom vers l'avant remplace la 
hauteur de toutes les pistes contenant une 
sélection à éditer par la taille géante de la 
hauteur de piste.

Extreme : lorsque cette valeur est sélectionnée, 
le changement de zoom vers l'avant remplace la 
hauteur de toutes les pistes contenant une 
sélection à éditer par la taille optimale de la 
hauteur de piste.

Fit To Window : lorsque cette valeur est 
sélectionnée, le changement de zoom vers 
l'avant remplace la hauteur de toutes les pistes 
contenant une sélection à éditer par la hauteur 
de piste ajustée à la fenêtre.

Track View

Waveform/Notes : lorsque cette valeur est 
sélectionnée, le changement de zoom vers 
l'avant remplace la vue des pistes audio par la 
vue Waveform et celle des pistes d'instrument et 
MIDI par la vue Notes.

Last Used : lorsque cette valeur est sélectionnée, 
le changement de zoom vers l'avant remplace la 
vue des pistes par la dernière vue de pistes 
utilisée et enregistrée avec le bouton Zoom 
Toggle.

No Change : lorsque cette valeur est 
sélectionnée, la vue des pistes n'est pas modifiée 
lors d'un changement de zoom vers l'avant ou 
l'arrière.

Separate Grid Settings When Zoomed In : 

lorsqu'elle est sélectionnée, cette option 
conserve le paramètre de grille sélectionné 
lorsque vous effectuez un zoom avant ou un 
zoom arrière. lorsque cette option est 
désélectionnée, le paramètre de grille 
correspondant au zoom s'applique lorsque vous 
effectuez un zoom avant. 
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Utilisation du changement de zoom 

Selon les préférences de changement de zoom 
définies, le bouton de changement de zoom de 
la fenêtre Edit vous permet de définir un état de 
zoom puis de basculer de cet état à l'état actuel et 
vice versa, ou de faire un zoom sur les 
paramètres des préférences du changement de 
zoom. Lorsque ce bouton est sélectionné, la 
fenêtre Edit affiche le zoom enregistré. En outre, 
toute modification apportée à la vue pendant 
que la commande de changement de zoom est 
activée sera enregistrée dans l'état du zoom.

Lorsque ce bouton est désactivé, la fenêtre Edit 
rétablit l'affichage en fonction du dernier zoom 
effectué.

Pour enregistrer un zoom à l'aide du bouton de 
changement de zoom :

1  Définissez les préférences du changement de 
zoom

2  Effectuez une sélection d'édition.

3  Cliquez sur le bouton de changement de 
zoom. Le bouton s'allume pour indiquer que le 
changement de zoom est activé et Pro Tools 
effectue un changement de zoom avant en 
fonction des paramètres définis dans les 
préférences du changement de zoom.

Lorsque la valeur Last Used est sélectionnée 
pour un ou plusieurs des paramètres suivants, 
vous pouvez régler le zoom, la hauteur ou la vue 
correspondant(e) dans la fenêtre Edit afin de 
mettre à jour l'état de zoom enregistré :

• Vertical Zoom

• Horizontal Zoom

• Track Height

• Track View

Pour modifier l'état du changement de zoom 
enregistré, procédez comme suit :

" Modifiez les préférences du changement de 
zoom

– ou –

" Si la valeur Last Used est sélectionnée pour 
une ou plusieurs des préférences (Vertical Zoom, 
Horizontal Zoom, Track Height ou Track View), 
procédez comme suit :

• Vérifiez que le bouton de changement de 
zoom est allumé (activé). 

– et –

• Réglez la hauteur de piste, le zoom vertical, 
la vue des pistes ou la grille si le champ 
correspondant est défini sur Last Used. 
Les changements sont enregistrés en tant 
que nouvel état de changement de zoom.

Pour supprimer le zoom enregistré en mode de 
changement de zoom :

1  Vérifiez que le bouton de changement de 
zoom est allumé (activé). 

2  Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée tout en cliquant sur le 
bouton de changement de zoom.

Bouton de changement de zoom dans la fenêtre Edit

Bouton de changement de zoom

Lorsque le mode de focus clavier sur les 
commandes est activé (reportez–vous à la 
section Focus clavier, page 22), appuyez sur 
la touche E pour activer ou désactiver la 
commande de changement de zoom.
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Pour utiliser le changement de zoom sans modifier 
les vues de playlists :

1  Effectuez une sélection sur une ou plusieurs 
pistes.

2  Effectuez l'une des opérations suivantes :

• Appuyez sur Option+Ctrl+E (Mac) ou sur 
Alt+Démarrer+E (Windows).

– ou –

• Lorsque le focus clavier sur les commandes 
est activé (reportez–vous à la section Focus 
clavier, page 22), appuyez sur Option+E 
(Mac) ou sur Alt+E (Windows).

Basculement automatique lors d'un 
changement de sélection

Lorsque le changement de zoom est activé, la 
sélection d'une plage de données différente ou la 
sélection de données sur une piste différente 
affecte le changement de zoom de la manière 
suivante : 

• Une sélection plus longue ne change pas le 
zoom de la fenêtre ; le niveau de zoom 
actuel est conservé. 

• Remplacer la sélection par celle d'une piste 
différente définit l'état de changement de 
zoom avant pour la hauteur et la vue des 
pistes. Le zoom horizontal reste cependant 
inchangé. Lorsque la sélection est déplacée 
à partir d'une piste agrandie (zoom avant), 
la hauteur réduite des pistes (zoom arrière) 
est rétablie.

Zoom avec la molette de 
défilement

Si votre souris possède une molette, vous pouvez 
l'utiliser pour effectuer un zoom avant et arrière 
sur les pistes, verticalement et horizontalement.

Pour effectuer un zoom continu dans la fenêtre 
Edit (zoom horizontal) :

" Maintenez la touche Alt (Windows) ou la 
touche Option (Mac) enfoncée tout en faisant 
défiler la molette de la souris.

Pour effectuer un zoom continu sur les données 
audio dans la fenêtre Edit (zoom vertical) :

" Maintenez les touches Alt+Maj (Windows) ou 
les touches Option+Maj (Mac) enfoncées tout en 
faisant défiler la molette de la souris.

Pour effectuer un zoom continu sur les données 
MIDI dans la fenêtre Edit (zoom vertical) :

" Maintenez les touches Alt+Démarrer 
(Windows) ou les touches Option+Ctrl (Mac) 
enfoncées tout en faisant défiler la molette de la 
souris.

Utilisation du changement de zoom

La fonction de basculement automatique ne 
fonctionne pas avec les sélections d'édition 
réparties sur plusieurs pistes dont le zoom a 
été ajusté à la fenêtre.
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Pour faire défiler le contenu de la fenêtre Edit ou 
de la fenêtre Mix horizontalement :

1  Activez la fenêtre dont vous voulez faire 
défiler le contenu en cliquant dessus ou en la 
plaçant au premier plan.

2  Maintenez la touche Maj enfoncée tout en 
faisant défiler la molette de la souris. 

Utilisation des outils de 
trimming
Les outils de trimming offrent des fonctions de 
rognage des régions, des notes et des données. 
Les fonctions de trimming suivantes sont 
disponibles :

• Outil de trimming standard

• Outil de trimming de 
compression/extension temporelle, 
également appelé TC/E

• Outil Scrub Trim (Pro Tools HD 
uniquement)

• Outil de trimming de boucle

Les outils de trimming sont contraints par des 
limites de régions, quel que soit le mode Edit, de 
la façon suivante : 

• Le rognage vers la gauche est contraint par 
la limite la plus à gauche de la région 
suivante (début de la région).

• Le rognage vers la droite est contraint par la 
limite la plus à droite de la région (fin de la 
région).

• L'outil de trimming propose des fonctions 
spéciales lorsqu'il est utilisé sur des régions 
et des groupes de régions mis en boucle. 
Pour plus d'informations, reportez-vous 
aux sections Groupes de régions, page 525 
et Mise en boucle de régions, page 534.

Outil de trimming

L'outil de trimming permet de raccourcir ou 
d'allonger rapidement une région (jusqu'à 
rétablir la durée totale du fichier audio source). 
La première fois que vous rognez une région, 
Pro Tools l'ajoute automatiquement à la liste des 
régions, en tant que nouvelle région (en lui 
attribuant un nom dérivé du nom d'origine) 
pour la différencier de l'originale.

L'outil de trimming standard est non destructif 
et ne modifie pas les données audio ou MIDI 
d'origine (lorsque vous travaillez sur des 
régions). Pour rétablir la durée de la région 
d'origine, faites-la glisser depuis la liste des 
régions ou rétablissez la durée originale de la 
région éditée à l'aide de l'outil de trimming.

L'utilisation de l'outil de trimming dépend du 
mode d'édition : Shuffle, Slip, Spot ou Grid 
(reportez–vous à la section Modes d'édition, 
page 425).

Pour rogner une région avec l'outil de trimming 
standard :

1  Sélectionnez l'outil de trimming. 

2  Dans Pro Tools HD, cliquez sur le menu 
contextuel de l'outil de trimming, puis 
sélectionnez Standard.

L'outil de trimming standard sert également 
à rallonger ou raccourcir des notes MIDI 
(voir Rognage des temps de début et de fin 
d'une note, page 653), ainsi qu'à mettre à 
l'échelle des données d'automation et de 
contrôleur Dessin d'automation, page 820.

Outil de trimming
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3  Placez le curseur près du début ou de la fin 
d'une région, de façon à afficher le curseur de 
l'outil de trimming.

Pour inverser la direction de l'outil de trimming 
standard, appuyez sur Option (Mac) ou sur Alt 
(Windows).

4  Effectuez l'une des opérations suivantes :

• Si vous « rognez » la fin, faites glisser le 
curseur vers la gauche pour raccourcir la 
région ou vers la droite pour la rallonger.

– ou –

• Si vous « rognez » le début, faites glisser le 
curseur vers la droite pour raccourcir la 
région ou vers la gauche pour la rallonger.

Lorsque vous rognez des régions sur une piste 
stéréo ou multicanal, tous les canaux sont 
rognés.

En mode Shuffle, les régions suivantes se 
décalent autant que nécessaire pour laisser la 
place à la région éditée. En mode Grid, les temps 
de début et de fin déplacés s'alignent sur le point 
le plus proche de la grille. En mode Spot, la boîte 
de dialogue Spot s'ouvre et vous invite à entrer le 
nouvel emplacement des points de début et de 
fin de la région.

Outil de trimming 
compression/extension 
temporelle (Time 
Compression/Expansion)

Cet outil de trimming temporel est pratique 
pour ajuster une région audio à la durée d'une 
autre région, d'une grille de tempo, d'une scène 
vidéo ou à pratiquement tout autre point de 
référence désiré.

L'outil de trimming temporel fonctionne en 
utilisant le plug-in AudioSuite Time 
Compression/Expansion (ou un plug-in tiers) 
pour créer un fichier audio. L'outil de trimming 
temporel s'utilise en faisant glisser le point de 
début ou de fin de la région pour étendre ou 
compresser la région.

Préférences du plug-in de 
compression/expansion

Vous pouvez sélectionner le plug-in AudioSuite 
à utiliser pour le rognage à l'aide de l'outil de 
trimming TCE. 

Outil de trimming

Lorsque vous travaillez avec des données 
audio, vous ne pouvez rogner au-delà des 
limites des régions adjacentes.

Outil de trimming compression/extension temporelle 
sur une région

L'outil de trimming TCE annule la mise en 
boucle et consolide la région.

Avec Pro Tools HD ou LE avec DV Toolkit 
2, vous pouvez faire correspondre une 
sélection d'édition à la longueur d'une 
sélection de timeline en sélectionnant Edit > 
TCE Edit to Timeline Selection 
(reportez–vous à la section Edition TCE 
(Time Compression and Expansion, 
compression/expansion temporelle) et 
sélection de timeline, page 478.
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Pour définir le plug-in AudioSuite à utiliser avec 
l'outil de trimming compression/expansion 
temporelle :

1  Sélectionnez Setup > Preferences.

2  Cliquez sur l'onglet Processing.

3  Dans le menu contextuel du plug-in TC/E, 
sélectionnez le plug-in AudioSuite à utiliser avec 
l'outil de trimming compression/expansion 
temporelle.

4  Dans la liste déroulante Default Settings, 
sélectionnez le paramètre du plug-in requis.

5  Cliquez sur OK.

Utilisation de l'outil de trimming 
compression/expansion temporelle en 
mode Grid

L'outil de trimming temporel peut être utilisé en 
mode Grid pour ajuster une région au tempo 
d'une session ou d'une section d'une session. 
Par exemple, vous pouvez importer une boucle 
de batterie d'une mesure au tempo de 90 BPM 
dans une session dont le tempo est de 120 BPM. 
En mode Grid, l'outil de trimming temporel 
permet de compresser facilement et rapidement 
la boucle de batterie à la longueur d'une mesure, 
avec une perte minime de la qualité audio. 

Pour utiliser l'outil de compression/extension 
temporelle en mode Grid :

1  Réglez le mode d'édition sur Grid.

2  Cliquez sur le menu déroulant de l'outil de 
trimming et sélectionnez TCE.

3  Avec l'outil de trimming TC/E, faites glisser le 
point de début ou de fin de la région audio pour 
étendre ou compresser la région à la taille de la 
grille (par exemple par noires). La région est 
traitée automatiquement par le plug-in 
AudioSuite de compression/expansion 
temporelle. La nouvelle région apparaît dans la 
playlist et dans la liste des régions.

Utilisation de l'outil de compression/expansion 
temporelle en mode Slip

Pour utiliser l'outil de trimming Time 
Compression/Expansion en mode Slip :

1  Définissez le mode d'édition sur Slip.

2  Cliquez sur le menu déroulant de l'outil de 
trimming et sélectionnez TCE.

3  Avec l'outil de trimming 
Compression/Expansion, faites glisser le point 
de début ou de fin de la région pour étendre ou 
compresser la région. Une nouvelle région est 
traitée automatiquement par le plug-in 
AudioSuite de compression/expansion 
temporelle. La nouvelle région apparaît dans la 
playlist et dans la liste des régions.

 Préférences TC/E

Pour plus d'informations sur les plug-in 
AudioSuite, consultez le Guide des plug-in 
DigiRack.

Le rognage des régions en mode Relative 
Grid s'effectue par incrément tout en 
conservant un décalage relatif (le cas 
échéant) par rapport à la grille.

Outil de trimming compression/extension temporelle 
(Time Compression/Expansion)
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Utilisation de l'outil de trimming 
compression/expansion temporelle en 
mode Spot

En mode Spot, lorsque vous cliquez sur l'outil de 
compression/extension temporelle dans une 
région, la boîte de dialogue Spot s'ouvre. Vous 
pouvez préciser l'emplacement sur lequel vous 
voulez que la région débute ou se termine, ou la 
durée de la région pour que celle-ci s'ajuste 
automatiquement.

Pour utiliser l'outil de compression/extension 
temporelle en mode Spot :

1  Définissez le mode d'édition sur Spot.

2  Cliquez sur le menu déroulant de l'outil de 
trimming et sélectionnez TCE.

3  Cliquez sur la région à côté de son point de 
début ou de fin. La boîte de dialogue Spot 
s'ouvre. A l'aide de n'importe quelle échelle de 
temps, entrez une nouvelle valeur de début ou 
de fin (ou une durée) de la région, et cliquez sur 
OK. Une nouvelle région est traitée 
automatiquement par le plug-in AudioSuite de 
compression/expansion temporelle. La nouvelle 
région apparaît dans la playlist et dans la liste 
des régions.

Outil de trimming Scrub
(Pro Tools HD uniquement)

L'outil Scrub Trim est pratique pour écouter des 
données (sur deux pistes au maximum) afin de 
rechercher un point de Rognage. Vous pouvez 
vous déplacer dans une piste pour écouter les 
données audio, puis rogner à un endroit précis 
en relâchant le bouton de la souris.

Cette action crée une région. Remarquez que le 
curseur de l'outil Scrub Trim se transforme en un 
« rognage à droite » ou « rognage à gauche » 
selon qu'il se trouve du côté droit ou du côté 

gauche d'une région. Pour inverser la direction 
de l'outil Scrub Trim, appuyez sur Option (Mac) 
ou sur Alt (Windows) avant de cliquer sur la 
région.

Le sens et la vitesse de lecture en Scrub varient 
selon le mouvement du contrôleur. Les données 
audio d'une piste lue en scrubbing empruntent 
le chemin du signal de la piste, y compris les 
éventuels effets qui y sont disposés.

Pour effectuer un Scrub Trim sur une piste :

1  Cliquez sur le menu déroulant de l'outil de 
trimming et sélectionnez Scrub. Le curseur se 
transforme en haut-parleur avec un crochet.

2  Faites glisser le curseur dans la piste, vers la 
gauche ou la droite. Les données audio de la 
piste lue en scrubbing empruntent le chemin du 
signal de la piste, y compris les effets TDM. 
Lorsque vous avez repéré le point de rognage 
désiré, relâchez le bouton de la souris pour 
« rogner » la région.

Pour effectuer un Scrub Trim sur deux pistes, 
cliquez avec l'outil Scrub Trim entre deux pistes 
adjacentes et déplacez le curseur.

Pour affiner la résolution (sans effectuer de 
zoom), appuyez sur la touche Pomme (Mac) ou 
Ctrl (Windows) pendant le scrubbing.

Outil Scrub Trim sur une région
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Outil de trimming de boucle

Utilisez l'outil de trimming de boucle pour créer 
ou rogner des régions en boucle.

Création de boucles avec l'outil de 
trimming de boucle

Pour créer des régions en boucle à l'aide de l'outil 
de trimming de boucle :

1  Cliquez sur l'icône de l'outil de trimming dans 
la fenêtre Edit pour accéder au menu déroulant 
de sélection des outils de trimming.

2  Sélectionnez Loop.

3  Placez le curseur sur la moitié supérieure d'une 
région ou d'un groupe de régions audio ou MIDI 
sans boucle. Le curseur change de forme pour 
signaler que le trimming de boucle peut être 
utilisé sur la région. (Placer le curseur sur la 
moitié inférieure de la région affiche le curseur 
de trimming standard.)

4  Effectuez l'une des opérations suivantes :

• Cliquez à la fin d'une région, puis faites 
glisser le curseur vers la gauche ou la droite 
jusqu'à l'endroit où la boucle doit se 
terminer.

– ou –

• Cliquez au début d'une région, puis faites 
glisser le curseur vers la gauche ou la droite 
jusqu'à l'endroit où la boucle doit 
commencer.

Rognage de régions mises en boucle

Vous pouvez rogner des régions mises en boucle 
de deux manières :

• Utilisez l'outil de trimming de boucle sur une 
région mise en boucle pour modifier la 
longueur de sa mise en boucle. Par exemple, 
utilisez l'outil de trimming de boucle sur une 
région mise en boucle pour l'allonger de 2 à 
4 mesures. Pour une région d'une mesure, le 
nombre de boucles passe de 2 à 4. Chaque 
itération de boucle ne change pas de 
longueur ; toutefois, la longueur de 
l'intégralité de la région mise en boucle est 
modifiée.

Outil de trimming de boucle

Pour plus d'informations sur la mise en 
boucle de régions, reportez–vous à la section 
Mise en boucle de régions, page 534.

Curseur de trimming de boucle

Région mise en boucle

Outil de trimming de boucle

Icône de boucle
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• Rognez la région source (itération de boucle) 
tout en conservant la longueur globale de la 
boucle d'origine. Le nombre d'itérations de 
boucle contenues dans la région mise en 
boucle est modifié en conséquence. Rognez 
par exemple une itération de boucle de 2 
mesures d'une région mise en boucle de 4 
mesures en une itération de boucle d'une 
mesure. La région mise en boucle de 4 mesures 
reste inchangée alors que le nombre 
d'itérations de boucle passe de 2 à 4. La 
longueur de chaque itération de boucle est 
modifiée mais la longueur de la mise en 
boucle de la région ne l'est pas.

Pour utiliser l'outil de trimming de boucle sur une 
région mise en boucle :

1  Sélectionnez l'outil de trimming de boucle.

2  Déplacez le curseur sur la moitié supérieure de 
la région mise en boucle (pas sur une icône de 
boucle). Le curseur représente l'outil de 
trimming de boucle.

3  Rognez la région mise en boucle.

Le nombre de boucles varie de sorte à combler la 
nouvelle longueur de l'ensemble de la région 
mise en boucle.

Pour rogner la région source (itération de boucle) 
d'une région mise en boucle :

1  Sélectionnez l'outil de trimming de boucle.

2  Placez le curseur sur l'icône de boucle dans la 
région mise en boucle ou à tout endroit le long 
du bas de la région. Le curseur est remplacé par 
l'icône de l'outil de trimming.

3  Effectuez le rognage du début ou de la fin de 
l'itération de boucle.

Le nombre d'itérations de boucles rognées varie 
de sorte à combler la longueur d'origine de 
l'ensemble de la région mise en boucle.

Région mise en boucle

Rognage en boucle d'une région mise en boucle

Outil de trimming de boucle

Icône de boucle

Pour un rognage d'itérations de boucle par 
incrément, maintenez la touche Démarrer 
(Windows) ou Ctrl (Mac) enfoncée.

Le rognage d'une région mise en boucle 
n'affecte pas les fondus sous-jacents.

Région mise en boucle

Rognage d'une région mise en boucle

Région mise en boucle rognée

Outil de trimming Icône de boucle
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Utilisation du sélecteur
Utilisez le sélecteur pour placer le curseur 
d'édition sur une piste ou une règle temporelle 
ou pour effectuer des sélections de timeline ou 
des sélections d'édition sur des pistes. Pour plus 
d'informations sur la sélection, voir Sélection 
des données de la piste, page 463.

Positionnement du curseur d'édition

Pour positionner le curseur à l'aide du sélecteur :

1  Sélectionnez le sélecteur dans la fenêtre Edit

2  Cliquez sur l'emplacement de votre choix sur 
une piste ou une règle temporelle.

Sélection d'édition à l'aide du 
sélecteur

Pour effectuer une sélection d'édition avec le 
sélecteur :

1  Sélectionnez le sélecteur dans la fenêtre Edit.

2  Cliquez dessus, puis faites-le glisser sur une 
piste, sur plusieurs pistes ou sur une règle 
temporelle (si l'option Link Timeline and Edit 
Selection est activée).

Pour sélectionner une région entière avec le 
sélecteur :

1  Sélectionnez le sélecteur dans la fenêtre Edit.

2  Cliquez deux fois sur la région souhaitée de la 
piste.

Pour sélectionner une piste entière avec le 
sélecteur :

1  Sélectionnez le sélecteur dans la fenêtre Edit.

2  Cliquez trois fois sur la piste souhaitée.

Réalisation d'une sélection de la 
timeline avec le sélecteur

Pour effectuer une sélection de la timeline avec le 
sélecteur :

1  Sélectionnez le sélecteur dans la fenêtre Edit.

2  Cliquez dessus, puis faites-le glisser sur une 
piste ou sur une règle temporelle (si l'option 
Link Timeline and Edit Selection est activée).

Positionnement du curseur à l'aide du sélecteur

Sélection à l'aide du sélecteur :
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Utilisation de l'outil Main
Utilisez les outils Main afin de sélectionner, 
séparer ou déplacer des régions sur des pistes. Il 
existe trois modes différents pour l'outil Main : 
Accrochage de temps/Séparation/Saisie d'objet

Outil d'accrochage de temps Sélectionne une 
région entière sur une piste à l'aide d'un clic de 
souris. Pour plus d'informations sur la sélection, 
voir Sélection des données de la piste, page 463.

Outil de séparation (Separation Grabber) Permet 
de copier et de coller une sélection d'édition 
d'un emplacement à un autre en cliquant dessus 
et en la faisant glisser. Pour plus d'informations, 
reportez-vous à la section Outil de séparation, 
page 488.

Outil de saisie d'objet Vous permet de 
sélectionner plusieurs régions non adjacentes. 
Pour plus d'informations, reportez-vous à la 
section Sélection d'objets, page 466.

Pour sélectionner l'un des outils de saisie :

1  Cliquez sur le bouton de l'outil de saisie et 
maintenez le bouton de la souris enfoncé dans la 
fenêtre Edit.

2  Dans le menu contextuel de la main, 
sélectionnez l'outil de saisie de votre choix.

Utilisation de l'outil Smart
L'outil Smart permet d'utiliser instantanément 
le sélecteur, la main et l'outil de trimming, ainsi 
que de créer des fades et des crossfades. La 
position du curseur par rapport à une région, 
une note, ou au sein d'une playlist 
d'automation, détermine le fonctionnement de 
l'outil Smart.

Pour sélectionner l'outil Smart, cliquez sur son 
icône en haut à gauche de la fenêtre Edit, ou 
appuyez simultanément sur F6+F7 (ou F7+F8).

Outil Smart en vue Waveform (ou en 
vue Regions pour les pistes MIDI)

Outil d'accrochage de temps

Outil de séparation

Outil de saisie d'objet

Sélection d'un outil de saisie

Outil Smart dans la fenêtre Edit

Outil Smart dans la vue Waveform

Fondu d'entrée 
(Fade-in)

Fondu de sortie 
(Fade-out)Sélecteur

Main, outil

Outil de 
trimming 
(début)

Outil de 
trimming 

(fin)

Crossfade :
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Les fonctions suivantes sont utilisables avec 
l'outil Smart lorsque vous travaillez avec des 
pistes audio en vue Waveform ou Blocks, ou 
avec des pistes MIDI ou d'instrument en vue 
Regions :

! Pour le sélecteur, placez le curseur au milieu 
de la région, dans la moitié supérieure.

! Pour l'outil d'accrochage, placez le curseur au 
milieu de la région, dans la moitié inférieure.

! Pour l'outil de trimming, placez le curseur à 
proximité du point de début ou de fin de la 
région. 

! Pour un fondu d'entrée ou de sortie, placez le 
curseur à proximité du point de début ou de fin 
de la région, près du haut. Lorsque le curseur de 
fondu apparaît, faites glisser dans la région pour 
définir la durée du fondu. Le fondu est créé 
automatiquement selon les réglages par défaut 
(Default Fade Settings, dans les préférences 
d'édition).

! Pour créer un crossfade (fondu enchaîné), 
placez le curseur entre deux régions audio 
adjacentes, près du bas. Lorsque le curseur de 
Crossfade apparaît, faites glisser vers la gauche 
ou la droite pour définir la durée du crossfade. Le 
crossfade est créé automatiquement selon les 
réglages de fondu par défaut (Default Fade 
Settings dans les préférences d'édition).

Outil Smart dans la vue Notes

L'outil Smart permet, lorsque vous travaillez 
avec des pistes MIDI et des pistes d'instrument 
en vue Notes, d'accéder aux fonctions 
suivantes :

! Pour le sélecteur, placez le curseur de sorte 
qu'il ne recouvre aucune note.

! Pour obtenir le sélecteur tout en positionnant 
le curseur sur des notes, appuyez sur la touche 
Pomme (Mac) ou la touche Ctrl (Windows).

! Pour l'outil d'accrochage, placez le curseur sur 
la note, vers le milieu. 

! Pour obtenir le rectangle de sélection 
permettant de sélectionner un groupe de notes, 
positionnez le curseur de façon à ce qu'il ne 
recouvre pas les notes, puis appuyez sur la 
touche Pomme (Mac) ou la touche Ctrl 
(Windows).

! Pour l'outil de trimming, placez le curseur à 
proximité du point de début ou de fin de la note.Pour passer provisoirement de l'outil Smart 

à l'outil de scrubbing, placez le curseur sur 
la région afin d'activer le sélecteur, puis 
appuyez sur la touche Ctrl (Mac) ou la 
touche Démarrer (Windows).

Outil Smart dans la vue Notes

Pour passer provisoirement de l'outil Smart 
à la gomme, placez le curseur sur la région 
afin d'activer le sélecteur, puis appuyez sur 
les touches Option+Ctrl (Mac) ou 
Alt+Démarrer (Windows).

Sélecteur

Main, outilDébut du rognage 
des notes

Fin du rognage 
des notes
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Outil Smart dans les vues Automation 
et Controller

Les fonctions suivantes sont utilisables avec 
l'outil Smart lorsque vous travaillez dans les vues 
Automation et Contrôleur :

! Pour le sélecteur, placez le curseur n'importe 
où dans les trois quarts inférieurs de la liste de 
diffusion. Faites glisser le sélecteur pour 
sélectionner des points d'inflexion. 

! Pour l'outil de trimming, placez le curseur 
n'importe où dans le quart inférieur de la 
playlist. Pour rogner des points d'inflexion, 
déplacez l'outil de trimming. Pour plus de 
précision, appuyez sur la touche Pomme (Mac) 
ou la touche Ctrl (Windows) tout en effectuant 
le rognage.

! Pour les outils Main, sélectionnez l'outil 
requis en maintenant la touche Ctrl (Windows) 
ou la touche Pomme (Mac) enfoncée, puis 
cliquez sur la ligne d'automation pour créer des 
points d'inflexion.

Pour modifier des points d'inflexion existants, 
placez le curseur à proximité d'un point 
d'inflexion, ce qui fait apparaître l'outil 
d'accrochage.

Pour plus de précision avec l'outil Main, 
appuyez sur la touche Pomme (Mac) ou la 
touche Ctrl (Windows), ou maintenez-la 
enfoncée si vous créez un point d'inflexion. 

Appuyez sur Maj pour restreindre le mouvement 
de l'outil Main dans le sens vertical.

Pour restreindre le mouvement de l'outil Main 
dans le sens vertical avec précision, appuyez sur 
Ctrl+Maj (Windows) ou sur Pomme+Maj (Mac). 

Outil Smart avec les pistes stéréo et 
multicanaux

Si vous utilisez l'outil Smart sur des pistes stéréo 
et multicanaux, il est impossible d'éditer 
indépendamment les canaux séparés. Toutes les 
modifications apportées affecteront l'ensemble 
des canaux. 

Le passage d'un outil à un autre via l'outil Smart 
dans les pistes stéréo et multicanaux est 
déterminé par la position au sein de la piste dans 
sa globalité, et non par rapport à chacun des 
canaux.

Utilisation de l'outil de 
scrubbing
L'outil de scrubbing permet d'effectuer un 
scrubbing sur deux pistes audio maximum dans 
la fenêtre Edit. L'outil de scrubbing est une 
technique qui provient du montage sur bande 
magnétique et consiste à faire défiler la bande 
d'avant en arrière sur la tête de lecture, à une 
vitesse inférieure à la vitesse normale, afin de 
mieux repérer un endroit particulier 
(généralement pour réaliser des 
coupes/assemblages).

Si la consultation d'une forme d'onde audio 
dans Pro Tools est utile pour rechercher 
visuellement un point d'édition, il peut arriver 
que cette forme d'onde ne permette pas de 
repérer le point de montage désiré dans les 
données audio. En effectuant une lecture 
d'avant en arrière dans Pro Tools, vous pouvez 
écouter et localiser un point précis d'édition. 

Lorsque l'option Edit Insertion Follows 
Scrub/Shuttle des préférences de 
fonctionnement est activée, le curseur d'édition 
saute automatiquement à l'endroit où vous vous 
êtes arrêté en mode Scrubbing.
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Lorsque l'option de défilement est réglée sur 
Continuous (Pro Tools HD et LE avec DV Toolkit 
2 uniquement) ou Center Playhead (Pro Tools 
HD uniquement), un clic avec l'outil de 
scrubbing dans la playlist d'une piste centre la 
fenêtre Edit autour de ce point et y place la tête 
de lecture. Avec ces options de défilement, les 
données soumises au scrubbing se déplacent au-
delà de la tête de lecture, qui ne bouge pas et 
reste au centre.

Pour effectuer un scrubbing sur une seule 
piste audio

1  Sélectionnez l'outil de scrubbing.

2  Faites glisser l'outil sur la piste : vers la gauche 
pour revenir en arrière ou la droite pour avancer.

La distance et la vitesse du déplacement (via la 
souris ou la molette de lecture d'une surface de 
contrôle) détermine la durée et la vitesse de 
lecture des données audio. Les données audio de 
la piste ainsi lue sont assignées vers sa sortie, 
avec tous les effets affectés à la piste.

La résolution de l'outil de scrubbing dépend du 
facteur de zoom sur la piste lue.

Pour lire plusieurs pistes audio, procédez 
comme suit :

" Après avoir sélectionné l'outil de scrubbing, 
faites-le glisser entre deux pistes adjacentes.

– ou –

" Effectuez un scrubbing dans une sélection 
contenant plusieurs pistes.

Lorsque vous lisez plusieurs pistes, vous 
n'entendez que les deux premières.

Le scrubbing ne concerne que les pistes 
audio. Il ne concerne pas les pistes MIDI et 
les pistes d'instrument.

Scrubbing d'une piste audio avec l'outil de scrubbing

Pour remplacer temporairement le sélecteur 
par l'outil de scrubbing, cliquez sur l'outil 
tout en maintenant la touche Démarrer 
(Windows) ou la touche Ctrl (Mac) 
enfoncée. Pour affiner la résolution, 
maintenez enfoncées les touches 
Pomme+Ctrl (Mac) ou les touches Ctrl-
Démarrer (Windows) tout en cliquant.

Scrubbing entre deux pistes audio

Vous ne pouvez effectuer une lecture que sur 
un maximum de huit canaux dans 
Pro Tools, ce qui permet de lire une piste 
7.1, deux pistes stéréo (quatre canaux), 
mais pas deux pistes 5.1 Surround 
(12 canaux).
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Mode Scrub/Shuttle

En scrubbing normal, la lecture s'effectue à 
vitesse normale ou plus lente. Le mode 
Scrub/Shuttle, en revanche, vous permet 
d'effectuer un scrubbing à plusieurs fois la 
vitesse normale, ce qui peut être utile pour lire 
des plages étendues et repérer des données.

Pour effectuer un scrubbing en mode Shuttle 
(plusieurs fois la vitesse normale) :

1  Sélectionnez l'outil de scrubbing.

2  Tout en appuyant sur Option (Mac) ou sur Alt 
(Windows), déplacez l'outil de scrubbing vers la 
gauche pour retourner en arrière ou vers la 
droite pour avancer. Les boutons Avance rapide 
et Retour arrière de la fenêtre Transport 
s'activent. 

La distance et la vitesse du déplacement 
déterminent la vitesse des données audio lues en 
scrubbing.

Mode Shuttle Lock (shuttle verrouillé)

Le mode shuttle verrouillé vous permet d'utiliser 
le clavier numérique pour effectuer, à la vitesse 
que vous désirez, un shuttle avant ou arrière 
allant jusqu'à deux pistes : 5 correspond à la 
vitesse normale, les touches de 6 à 9 permettent 
d'avancer à des vitesses progressivement plus 
accélérées et les touches de 4 à 1 permettent de 
reculer de plus en plus vite (4 correspond à la 
vitesse de Shuttle Lock la plus lente et 1 à la plus 
rapide). Si plusieurs pistes sont sélectionnées, 
seules les deux premières passent en mode 
Shuttle Lock.

Pour lire une ou deux pistes en mode Shuttle 
Lock : 

1  Dans Pro Tools HD, vérifiez que l'option 
Numeric Keypad Mode des préférences de 
fonctionnement n'est pas réglée sur Shuttle (voir 
Préférences de fonctionnement, page 80).

2  A l'aide du sélecteur, cliquez dans la piste à 
l'endroit où vous souhaitez que commence la 
lecture. Pour que le shuttle s'effectue sur deux 
pistes, cliquez sur une seconde piste en 
appuyant sur Maj.

3  Appuyez sur Ctrl (Mac) ou sur Démarrer 
(Windows) et sur un chiffre du clavier 
numérique : 0–9 (9 est le plus rapide, 5 est la 
vitesse normale, 0 arrête le shuttle).

Dès que le mode Shuttle Lock est actif, les 
boutons Avance rapide et Retour rapide sont mis 
en surbrillance dans la fenêtre Transport.

4  Appuyez sur d'autres touches pour changer la 
vitesse de lecture ou appuyez sur plus (+) ou 
moins (-) pour changer la direction de lecture 
(plus pour aller en avant, moins pour aller en 
arrière).

5  Pour arrêter la lecture, appuyez sur Ctrl+0 
(Mac) ou sur Démarrer+0 (Windows).

Pour quitter le mode Shuttle Lock, effectuez l'une 
des opérations suivantes :

" Appuyez sur Stop dans la fenêtre Transport.

– ou –

" Appuyez sur la barre d'espace.
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Custom Shuttle Lock Speed :

Utilisez l'option Custom Shuttle Lock Speed 
pour adapter la vitesse Shuttle Lock d'avance 
rapide la plus élevée (touche 9) à vos besoins 
d'édition et d'audition.

Pour configurer la vitesse de Shuttle verrouillé 
personnalisée :

1  Dans Pro Tools, choisissez Setup > Preferences 
et cliquez sur l'onglet Operation. 

2  Assurez-vous que le mode du clavier 
numérique (Numeric Keypad) est réglé sur 
Transport ou Classic (voir Préférences de 
fonctionnement, page 80).

3  Entrez le pourcentage que vous désirez dans 
les paramètres de Custom Shuttle Lock Speed. La 
plage autorisée est comprise entre 50 et 800 %. 
Utilisez les flèches Haut et Bas pour augmenter 
ou réduire le paramètre. 

4  Cliquez sur OK. 

La vitesse que vous avez choisi dans le Custom 
Shuttle Lock Speed est enregistrée avec vos 
préférences Pro Tools (et non pas avec la 
session).

Pour activer la vitesse de Shuttle verrouillé 
personnalisée :

" Appuyez sur Démarrer+9 (Windows) ou 
Ctrl+9 (Mac) sur le pavé numérique.

Clavier numérique réglé sur 
Shuttle
(Pro Tools HD uniquement)

Pro Tools offre une autre forme de lecture en 
mode Shuttle, différente de celle du mode 
Shuttle verrouillé. Lorsque le mode du clavier 
numérique est réglé sur Shuttle, la lecture de la 
sélection d'édition actuelle commence lorsque 
vous appuyez sur les touches du clavier 

numérique et dure tant que vous les maintenez 
enfoncées ; la lecture s'arrête dès relâchement 
des touches. Vous pouvez définir plusieurs 
vitesses de lecture, en avant ou en arrière. 
Dans ce mode, les pré/post-roll sont ignorés.

Pour effectuer un shuttle lorsque le mode du 
clavier numérique est réglé sur Shuttle :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation.

2  Réglez le mode du clavier numérique sur 
Shuttle, puis cliquez sur OK.

3  A l'aide du sélecteur, cliquez dans la piste à 
l'endroit où vous souhaitez que commence la 
lecture. Pour que le shuttle s'effectue sur deux 
pistes, cliquez sur une seconde piste en 
appuyant sur Maj.

4  Appuyez et maintenez enfoncée l'une des 
touches suivantes (ou l'une des combinaisons de 
touches) sur le clavier numérique pour 
déclencher la lecture.

5  Appuyez sur une autre touche pour changer de 
direction ou de vitesse. Relâchez pour arrêter.

Vitesse de 
Shuttle

Touche de 
retour 
arrière

Touche 
d'avance 

rapide

Vitesse 1 x 4 6

Vitesse 4 x 7 9

Vitesse 1/4 x 1 3

Vitesse 1/2 x 4+5 5+6

Vitesse 2 x 7+8 8+9
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Utilisation du crayon
Le crayon vous permet de dessiner des formes 
d'ondes audio (à l'échelle de l'échantillon), des 
modifications de tempo, des données MIDI et 
une automation. 

La fenêtre Universe
(Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement)

La fenêtre Universe affiche une vue générale de 
la session, représentant les données audio et 
MIDI de toutes les pistes non masquées (y 
compris les pistes inactives ou contenant des 
régions hors ligne). L'ordre d'affichage des 
éléments dans la fenêtre Universe correspond à 
l'ordre de la piste dans la fenêtre Edit.

Pour ouvrir la fenêtre Universe :

" Choisissez Window > Universe.

Les données audio se trouvant dans les pistes 
audio sont représentées par de simples lignes 
horizontales dans la fenêtre Universe. Chaque 
canal d'une piste stéréo ou multicanal est 
représenté individuellement.

Les pistes d'entrée auxiliaire, les pistes de fader 
principal et les pistes de VCA principal ne 
contenant pas de données audio, elles 
s'affichent sous forme de zone vides dans la 
fenêtre Universe.

Les pistes MIDI et d'instrument contenant des 
données MIDI sont représentées par de simples 
lignes horizontales.

Pour plus d'informations sur le dessin des 
formes d'onde audio, consultez la section 
Réparation de la forme d'onde avec le 
crayon, page 524.

Pour plus d'informations, consultez la 
section Edition des événements de tempo 
dans l'éditeur de tempo, page 575.

Pour plus d'informations, consultez la 
section Crayon, page 646.

Pour plus d'informations, consultez la 
section Dessin d'automation, page 820. Fenêtre Universe

La zone ombrée indique ce qui est 
visible dans la fenêtre Edit
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Changement de taille de la fenêtre 
Univers

Bien que vous puissiez la redimensionner 
horizontalement et verticalement, la fenêtre 
Universe affiche toujours la durée de la session 
entière. Si vous redimensionnez la fenêtre 
Universe et qu'une partie des pistes de la session 
n'est pas affichée, une barre de défilement 
verticale apparaît.

Zone ombrée dans la fenêtre Universe

La zone ombrée de la fenêtre Universe 
représente les éléments visibles dans la fenêtre 
Edit. Si vous modifiez ce qui apparaît dans la 
fenêtre Edit (par un zoom, un défilement 
horizontal ou vertical, en masquant/affichant 
des pistes ou en changeant leur hauteur), la zone 
en surbrillance de la fenêtre Universe est mise à 
jour en conséquence.

Pendant la lecture, si vous faites défiler la fenêtre 
Edit, la zone en surbrillance de la fenêtre 
Univers défile également.

Défilement dans la fenêtre Univers

En cliquant dans la fenêtre Univers, vous pouvez 
faire défiler automatiquement, horizontalement 
ou verticalement, les éléments affichés dans la 
fenêtre Edit. Une méthode pratique pour aller 
n'importe où dans la session ou pour redéfinir 
les pistes visibles dans la fenêtre Edit.

Pour déplacer la zone en surbrillance dans la 
fenêtre Univers :

1  Choisissez Window > Universe.

2  Faites glisser la zone en surbrillance à un 
emplacement différent dans la fenêtre Universe 
pour changer les pistes affichées dans la fenêtre 
Edit.

Si toutes les pistes sont visibles dans la fenêtre 
Edit et que la session est en zoom arrière 
complet avec toutes les régions visibles, c'est 
toute la fenêtre Univers qui est ombrée.

Fenêtre Video Universe

La fenêtre Universe propose également un menu 
contextuel affiché en cliquant avec le bouton 
droit de la souris qui permet d'ouvrir la fenêtre 
Video Universe dans laquelle vous pouvez 
afficher, parcourir, agrandir/réduire et 
sélectionner des régions vidéo de la piste vidéo 
principale.

Pour plus d'informations sur la fenêtre 
Video Universe, reportez–vous à la section 
Défilement d'une vidéo dans la fenêtre 
Video Universe, page 962.
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Chapitre 19 : Lecture et sélection des 
données des pistes

Lecture des pistes
Après avoir enregistré ou importé des données 
audio ou MIDI vers des pistes, vous les écouterez 
en vue de leur édition ou de leur mixage.

Pour définir le début de la lecture, vous pouvez 
cliquer n'importe où dans une piste avec le 
sélecteur (si les sélections d'édition et de 
timeline sont liées). Voir Activation ou 
désactivation de la liaison des sélections 
d'édition et de timeline, page 461.

Curseur de lecture

Le curseur de lecture prend la forme d'une ligne 
continue non clignotante qui se déplace dans la 
fenêtre Edit pour indiquer la position de lecture 
actuelle.

L'option de défilement sélectionnée détermine 
le défilement de la fenêtre Edit pendant la 
lecture et le fonctionnement du curseur de 
lecture. Pour plus d'informations, consultez la 
section Options de défilement, page 460.

Emplacement de la lecture

L'emplacement correspondant à la lecture 
apparaît dans les compteurs situés en haut de la 
fenêtre Edit et dans les fenêtres Transport et Big 
Counter.

Pour afficher les compteurs dans la fenêtre 
Transport :

" Choisissez View > Transport > Counters.

Définition d'un point de lecture à l'aide du sélecteur

Fenêtre Transport avec compteurs

Pour afficher ou masquer les compteurs, 
maintenez enfoncée la touche Démarrer 
(Windows) ou Ctrl (Mac) pendant que vous 
cliquez sur le bouton Développer/réduire de 
la fenêtre Transport.

Pour afficher ou masquer les commandes 
MIDI, maintenez enfoncée la touche Ctrl 
(Windows) ou Pomme (Mac) pendant que 
vous cliquez sur le bouton Développer/ 
réduire de la fenêtre Transport.
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Pour afficher la fenêtre Big Counter :

" Choisissez Window > Big Counter.

Curseur d'édition

Le curseur d'édition est une ligne clignotante qui 
apparaît lorsque vous cliquez avec le sélecteur 
dans la playlist d'une piste. Le curseur d'édition 
clignotant indique le point de début de 
n'importe quelle tâche d'édition effectuée. 
Si vous effectuez une sélection et réalisez une 
édition, c'est la sélection qui constitue la cible de 
l'édition.

Lecture de base à partir d'un point 
spécifique

Pour commencer la lecture depuis un point 
spécifique d'une piste :

1  Choisissez Options > Link Timeline and Edit 
Selection.

2  A l'aide du sélecteur, cliquez dans la piste à 
l'endroit où vous souhaitez que commence la 
lecture.

3  Pour commencer la lecture, cliquez sur le 
bouton de lecture de la fenêtre Transport.

4  Pour arrêter la lecture, cliquez sur le bouton 
Stop de la fenêtre Transport.

Pour positionner le curseur à un autre 
emplacement et lancer la lecture à partir de ce 
point, effectuez l'une des opérations suivantes :

" Après l'arrêt de la lecture, cliquez sur le point 
souhaité à l'aide du sélecteur, puis cliquez sur 
Play dans la fenêtre Transport.

– ou –

" Cliquez sur l'emplacement correspondant 
dans une règle temporelle au cours de la lecture.

Lorsque les sélections d'édition et de timeline 
sont liées, vous pouvez cliquer sur une région ou 
une note MIDI à l'aide de l'outil d'accrochage de 
temps pour mettre à jour automatiquement la 
timeline en fonction du début de la sélection, ce 
qui permet de lancer la lecture à partir ce point.

Défilement de la page pendant la 
lecture

Vous pouvez paramétrer Pro Tools de façon à 
faire défiler l'affichage de la piste pendant la 
lecture et à ce que le curseur d'édition apparaisse 
là où la lecture s'arrête.

Si vous souhaitez que l'affichage de la piste et le 
curseur d'édition suivent la lecture :

1  Choisissez Options > Scrolling > Page.

2  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation.

3  Sélectionnez l'option Timeline Insertion/Play 
Start Marker Follows Playback, puis cliquez 
sur OK.

4  Choisissez Options > Link Timeline and Edit 
Selection.

Pour afficher ou masquer les compteurs et 
les commandes MIDI, maintenez enfoncée 
la touche Alt (Windows) ou Option (Mac) 
pendant que vous cliquez sur le bouton 
Développer/réduire de la fenêtre Transport.

Fenêtre Big Counter

Pour activer ou désactiver l'option Timeline 
Insertion/Play Start Marker Follows 
Playback, appuyez sur Ctrl+N (Mac) ou sur 
Démarrer+N (Windows).
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5  A l'aide du sélecteur, cliquez dans la piste à 
l'endroit où vous souhaitez que commence la 
lecture.

6  Pour commencer la lecture, cliquez sur le 
bouton de lecture de la fenêtre Transport. Le 
curseur de lecture défile dans la fenêtre Edit et 
indique l'emplacement actuel de la lecture.

7  Pour arrêter la lecture, cliquez sur le bouton 
Stop de la fenêtre Transport. Le curseur d'édition 
apparaît à l'endroit où la lecture s'est arrêtée.

Recherche et écoute avec Avance 
rapide/Retour rapide

Les boutons d'avance rapide et de retour rapide 
de la fenêtre Transport permettent de rechercher 
des données dans les pistes. Si l'option Audio 
During Fast Forward/Rewind des préférences de 
fonctionnement est sélectionnée, vous entendez 
les données audio balayées dès que vous cliquez 
sur l'un de ces boutons (comme avec un lecteur 
de CD).

Vous pouvez également effectuer une avance 
rapide ou un retour rapide par incréments en 
cliquant plusieurs fois sur le bouton 
correspondant. La taille de ces incréments est 
déterminée par l'échelle temporelle principale :

Bars:Beats : déplacement jusqu'au début de la 
mesure précédente ou suivante.

Min:Sec : déplacement vers l'arrière ou l'avant 
par incrément d'une seconde.

Timecode : déplacement vers l'arrière ou l'avant 
par incrément d'une seconde (avec ajustement 
au format SMPTE courant).

Feet+Frames : déplacement vers l'arrière ou 
l'avant par incrément d'un pied.

Samples : déplacement vers l'arrière ou l'avant 
par incrément d'une seconde.

Recherche à l'aide des 
commandes Back et Forward
(Pro Tools HD uniquement)

Pro Tools fournit quatre commandes de type 
Retour/Avance (appelées parfois « rollback ») 
destinées à déplacer l'emplacement 
correspondant à la lecture dans la fenêtre Edit. 

Vous pouvez également déplacer l'emplacement 
de la lecture de plusieurs incréments en 
exécutant à plusieurs reprises la commande 
(voir la section Répétition des commandes 
Back/Forward, page 456).

Back : déplacement de la lecture vers l'arrière, 
de la valeur du paramètre Back/Forward 
Amount.

Back and Play : déplacement de la lecture vers 
l'arrière de la valeur Back/Forward Amount et 
lancement automatique de la lecture.

Forward : déplacement de la lecture vers l'avant 
de la valeur Back/Forward Amount.

Forward and Play : déplacement de la lecture 
vers l'avant de la valeur Back/Forward Amount et 
lancement automatique de la lecture.

Définition de la valeur Back/Forward

L'intervalle du déplacement Back/Forward est 
déterminé par la préférence Back/Forward 
Amount située dans la page Operation de la 
fenêtre Setup > Preferences.

Les commandes Back/Forward fonctionnent 
également lorsque vous contrôlez un 
périphérique à 9 broches. Reportez-vous au 
Guide MachineControl pour plus 
d'informations.
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Pour configurer le paramètre Back/Forward 
Amount :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation.

La référence temporelle des paramètres 
Back/Forward Amount est conforme à l'échelle 
temporelle principale par défaut. Il est possible 
de désélectionner l'option Follow Main Time et 
de choisir un autre format temporel :

• Bars:Beats

• Min:Sec

• Timecode

• Feet+Frames

• Samples

2  Effectuez l'une des opérations suivantes :

• Sélectionnez un intervalle prédéfini dans le 
menu déroulant Back/Forward Amount.

– ou –

• Dans le champ Back/Forward Amount, 
entrez un intervalle personnalisé.

Utilisation des commandes Back ou Forward

Pour déplacer l'emplacement de la lecture, vers 
l'arrière, de la valeur Back/Forward Amount :

" Appuyez sur Pomme (Mac) ou sur Ctrl 
(Windows) et cliquez sur Rewind dans la fenêtre 
Transport.

Pour déplacer l'emplacement de la lecture, vers 
l'avant, de la valeur Back/Forward Amount :

" Tout en maintenant la touche Ctrl (Windows) 
ou Pomme (Mac) enfoncée, cliquez sur Avance 
rapide dans la fenêtre Transport.

Pour déplacer l'emplacement de la lecture, vers 
l'arrière, de la valeur Back/Forward Amount et 
lancer automatiquement la lecture :

" Appuyez sur Pomme+Option (Mac) ou sur 
Ctrl+Alt (Windows) et cliquez sur Retour rapide 
dans la fenêtre Transport.

Pour déplacer l'emplacement de la lecture, vers 
l'avant, de la valeur Back/Forward Amount et 
lancer automatiquement la lecture :

" Appuyez sur Pomme+Option (Mac) ou sur 
Ctrl+Alt (Windows) et cliquez sur Avance rapide 
dans la fenêtre Transport.

Répétition des commandes Back/Forward

Toutes les commandes Back/Forward peuvent 
être répétées de manière à augmenter 
l'amplitude du déplacement total vers l'avant ou 
l'arrière.

Pour répéter les déplacements vers l'avant ou 
l'arrière :

1  Appuyez sur la touche Pomme (Mac) ou Ctrl 
(Windows) et maintenez-la enfoncée.

2  Cliquez sur Rewind ou Fast Forward le nombre 
de fois nécessaire pour déplacer l'emplacement 
de lecture vers l'avant ou vers l'arrière. La valeur 
Back/Forward Amount spécifie l'intervalle du 
déplacement.

Extension des sélections avec les commandes 
Back ou Back and Play

Les commandes Back ou Back and Play peuvent 
servir à étendre une sélection vers l'arrière et ce, 
de la valeur du paramètre Back/Forward 
Amount. 
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Pour étendre une sélection avec les commandes 
Back ou Back and Play :

1  Définissez la valeur du paramètre 
Back/Forward Amount Voir Définition de la 
valeur Back/Forward, page 455.

2  Faites glisser le sélecteur dans la piste pour 
faire une sélection.

3  Effectuez l'une des opérations suivantes :

• Pour étendre la sélection vers l'arrière de la 
valeur Back/Forward Amount, appuyez sur 
Maj+Ctrl (Windows) ou Maj+Pomme (Mac) 
et cliquez sur Retour rapide dans la fenêtre 
Transport.

– ou –

• Pour étendre la sélection vers l'arrière de la 
valeur Back/Forward Amount, puis lancez 
la lecture, maintenez les touches 
Maj+Ctrl+Alt (Windows) ou Maj+Pomme+ 
Option (Mac) et cliquez sur Retour rapide 
dans la fenêtre Transport.

Indicateurs et compteurs de la 
fenêtre Edit

Les compteurs et les indicateurs situés en haut 
de la fenêtre Edit présentent l'emplacement de 
lecture actuel et la sélection d'édition. Ils 
incluent les compteurs principaux et 
secondaires et les indicateurs de sélection 
d'édition de début (Start), de fin (End) et de 
durée (Length).

Tous les compteurs et indicateurs (excepté le 
compteur secondaire) de la fenêtre Edit vous 
permettent d'entrer un emplacement dans 
l'écran de leur compteur pour accéder à un 
emplacement temporel donné.

Le compteur principal indique l'emplacement 
de lecture, exprimé dans le format temporel de 
l'échelle temporelle principale. Le compteur 
secondaire peut être réglé sur n'importe quel 
autre format d'échelle temporelle, afin de 
fournir une autre référence temporelle.

Les indicateurs de sélection d'édition (à droite 
des compteurs principaux et secondaires) 
affichent les temps de début et de fin et la durée 
de la sélection d'édition actuelle selon l'échelle 
temporelle principale.

Les compteurs principaux et secondaires, ainsi 
que les indicateurs de sélection d'édition, 
apparaissent également dans la fenêtre 
Transport avec l'affichage des compteurs activé.

Pour naviguer à l'aide du compteur principal de la 
fenêtre Edit (ou à l'aide d'un indicateur de 
sélection d'édition) :

1  Effectuez l'une des opérations suivantes :

• Cliquez sur un des compteurs.

– ou –

• Appuyez sur la touche représentant un 
astérisque (*) du pavé numérique pour 
mettre en surbrillance le compteur 
principal dans la fenêtre Edit (ou celui de la 
fenêtre Transport ou Big Counter, si l'une 
ou l'autre est à l'écran).

Bien que vous ne puissiez pas étendre une 
sélection vers l'avant à l'aide des 
commandes Forward ou Forward and Play, 
il est possible d'utiliser les procédures 
suivantes avec Forward ou Forward and 
Play pour déplacer le point de début de la 
sélection actuelle.

Compteurs principaux et secondaires, indicateurs de 
sélection d'édition
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2  Entrez la nouvelle position. Appuyez sur le 
point (.) pour passer d'un champ de valeur à 
l'autre.

3  Appuyez sur Entrée pour valider la nouvelle 
valeur et vous y rendre automatiquement.

Défilement dans une règle 
temporelle

Vous pouvez faire défiler le contenu de la fenêtre 
Edit en cliquant sur la règle et en la faisant 
glisser. Ceci ne met pas réellement à jour la 
valeur de position de la session, mais permet de 
décaler facilement l'affichage vers la gauche ou 
la droite afin de mieux repérer des données pour 
les éditer.

Cette méthode s'utilise notamment avec 
l'option de défilement continu (Pro Tools HD et 
Pro Tools LE avec DV Toolkit 2 uniquement), 
qui n'entraîne pas de mise à jour et ne suit pas 
les sélections de timeline.

Pour faire défiler le contenu complet de la fenêtre 
Edit à partir de la règle :

" Tout en appuyant sur Pomme+Option +Ctrl 
(Mac) ou sur Ctrl+Alt+Démarrer (Windows), 
faites glisser l'une des règles temporelles vers la 
gauche ou la droite.

Défilement avec la molette

Si votre souris possède une molette, vous pouvez 
l'utiliser pour effectuer un défilement vertical ou 
horizontal dans n'importe quelle fenêtre 
Pro Tools dotée d'une barre de défilement (telle 
que la liste des événements MIDI).

Pour faire défiler une fenêtre Pro Tools 
verticalement :

1  Placez la souris sur la fenêtre que vous voulez 
faire défiler (par exemple vous pouvez faire 
défiler l'affichage des pistes ou la liste des 
régions dans la fenêtre Edit).

2  Faites rouler la molette vers le haut ou vers le 
bas pour faire défiler la fenêtre vers le haut ou 
le bas.

Pour faire défiler une fenêtre Pro Tools 
horizontalement :

1  Placez la souris sur la fenêtre que vous voulez 
faire défiler (par exemple vous pouvez faire 
défiler l'affichage des pistes ou la liste des 
régions dans la fenêtre Edit).

2  Faites rouler la molette vers le haut ou vers le 
bas tout en appuyant sur la touche Maj pour 
faire défiler la fenêtre vers la gauche ou la droite.

Recherche du curseur de lecture

Utilisez le localisateur de curseur de lecture pour 
rechercher le curseur de lecture lorsqu'il 
n'apparaît pas à l'écran. Le localisateur de 
curseur de lecture apparaît à droite dans la règle 
temporelle principale une fois que le curseur de 
lecture s'est déplacé au-delà de la partie visible 
de la fenêtre Edit. Si le curseur de lecture se 
trouve en amont de la partie visible de la fenêtre 
Edit, le localisateur de curseur de lecture 
apparaît à gauche dans la règle temporelle 
principale.Défilement via une règle

Localisateur de curseur de lecture, enregistrement 
activé (curseur de lecture situé après les données 
audio visibles)

Localisateur de curseur de lecture
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Si par exemple l'option de défilement est définie 
sur None, le curseur de lecture se déplace hors de 
l'écran une fois que la région visible dans la 
fenêtre Edit a été lue. Le localisateur de curseur 
de lecture apparaît à droite dans la règle 
temporelle principale une fois que le curseur de 
lecture s'est déplacé au-delà de la partie visible 
de la fenêtre Edit.

Le localisateur de curseur de lecture est rouge 
lorsqu'une piste est en cours d'enregistrement et 
bleue lorsqu'aucun enregistrement n'est activé.

Pour rechercher le curseur de lecture lorsqu'il se 
trouve en dehors de l'écran :

" Cliquez sur la fonction de recherche du 
curseur de lecture dans la règle temporelle 
principale.

La fenêtre Edit change pour centrer le curseur de 
lecture à l'écran.

Défilement automatique des 
pistes dans les fenêtres Mix 
et Edit
(Pro Tools HD uniquement)

Si vous travaillez avec de nombreuses pistes et 
que les fenêtres Edit ou Mix ne peuvent pas 
toutes les afficher à la fois, vous pouvez 
sélectionner une piste dans une fenêtre et 
Pro Tools défilera automatiquement jusqu'à 
cette piste dans l'autre fenêtre.

Pour faire défiler automatiquement la fenêtre 
Mix et afficher une piste sélectionnée dans la 
fenêtre Edit :

" Maintenez la touche Ctrl (Mac) ou Démarrer 
(Windows) enfoncée pendant que vous cliquez 
sur le nom d'une piste dans la fenêtre Edit.

La sélection de la piste entraîne le défilement de 
la fenêtre Mix où s'affiche la piste sélectionnée.

Pour faire défiler automatiquement la fenêtre Edit 
et afficher une piste sélectionnée dans la 
fenêtre Mix :

" Maintenez la touche Ctrl (Mac) ou Démarrer 
(Windows) enfoncée pendant que vous cliquez 
sur le nom d'une piste dans la fenêtre Mix.

La sélection de la piste entraîne le défilement de 
la fenêtre Edit où s'affiche la piste sélectionnée.

Navigation dans les pistes à l'aide 
des numéros de position des 
pistes

Avec l'option Track Numbers View activée, 
chaque piste reçoit un numéro correspondant à 
sa position dans les fenêtres Mix et Edit. 
Vous pouvez défiler directement jusqu'à 
n'importe quelle piste à partir de son numéro de 
position.

Pour accéder directement à la piste de votre choix 
en utilisant son numéro de position :

1  Choisissez View > Track Number.

2  Effectuez l'une des opérations suivantes :

• Choisissez Track > Scroll to Track.

– ou –

• Appuyez sur Pomme+Option+F (Mac) ou 
sur Ctrl+Alt+F (Windows).

Lorsque l'ordre des pistes change, les 
numéros de position des pistes sont 
réattribués de manière à les conserver en 
séquences numériques.
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3  Dans la boîte de dialogue Scroll To Track, 
entrez le numéro de position de la piste

4  Cliquez sur OK.

La piste est sélectionnée et les fenêtres défilent 
comme suit :

• Les pistes de la fenêtre Edit défilent pour 
afficher la piste sélectionnée le plus près 
possible du haut. 

• Les pistes de la fenêtre Mix défilent pour 
afficher la piste sélectionnée le plus possible à 
gauche. 

Options de défilement
Il est possible de configurer le défilement du 
contenu de la fenêtre Edit en cours de lecture et 
d'enregistrement. 

Pour configurer les options de défilement :

" Choisissez Options > Scrolling et sélectionnez 
l'une des options suivantes :

None : la fenêtre Edit ne défile ni pendant ni 
après la lecture. le curseur de lecture se déplace 
dans la fenêtre Edit, indiquant la position du 
point de lecture.

After Playback : le curseur de lecture se déplace 
dans la fenêtre Edit, indiquant la position du 
point de lecture. La fenêtre Edit défile jusqu'au 
dernier point lu après l'arrêt de la lecture.

Page : le curseur de lecture se déplace dans la 
fenêtre Edit, indiquant la position du point de 
lecture. Lorsque le bord droit de la fenêtre Edit 
est atteint, son contenu tout entier défile et le 
curseur de lecture reprend son déplacement 
depuis le bord gauche de la fenêtre.

Continuous (Pro Tools HD et Pro Tools LE avec DV 
Toolkit 2 uniquement) : voir Défilement continu 
pendant la lecture, page 460.

Center Playhead (Pro Tools HD uniquement) : 

voir Défilement utilisant la tête de lecture, 
page 461.

Défilement continu pendant la lecture

(Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement)

L'option de défilement Continuous Scroll 
During Playback provoque le défilement 
continu de la fenêtre Edit au-delà du curseur de 
lecture, qui reste au centre de la fenêtre. 
Avec cette option, la lecture repose toujours sur 
la sélection de la timeline (contrairement à ce 
qui se produit avec l'option Center Playhead 
Scrolling). L'option Continuous Scrolling 
During Playback utilise les capacités de 
traitement de l'hôte et doit par conséquent 
s'utiliser uniquement en cas de nécessité absolue 
avec Pro Tools LE avec DV Toolkit 2.

Boîte de dialogue Scroll To Track

Si vous sélectionnez un élément dans la 
timeline ou une playlist ou si vous faites 
défiler la timeline à la main en mode Page 
Scroll ou Continuous Scroll, le défilement 
est suspendu. Pour reprendre le défilement 
de la page et se positionner sur 
l'emplacement de lecture, cliquez sur le 
localisateur de curseur de lecture dans la 
règle temporelle principale (voir Recherche 
du curseur de lecture, page 458).
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Défilement utilisant la tête de lecture

(Pro Tools HD uniquement)

Cette option de défilement provoque le 
défilement continu du contenu de la fenêtre 
Edit au-delà de la tête de lecture, matérialisée par 
une ligne bleue située au centre de la fenêtre 
(rouge pendant l'enregistrement).

La tête de lecture indique où commence la 
lecture lorsque vous cliquez sur Play dans la 
fenêtre Transport.

Pour déplacer la tête de lecture jusqu'à un 
endroit déterminé, vous pouvez faire défiler la 
règle (voir Défilement dans une règle 
temporelle, page 458), utiliser la barre de 
défilement horizontale de la fenêtre Edit ou 
taper la position désirée dans l'un des 
indicateurs de sélection d'édition ou l'un des 
compteurs.

Le déplacement de la tête de lecture par ces 
méthodes ne met pas à jour la sélection de 
timeline. En revanche, la mise à jour de la 
sélection de timeline déplace automatiquement 
la tête de lecture vers le point d'insertion de la 
timeline.

Lorsque la tête de lecture est activée, vous 
pouvez atteindre la sélection d'édition ou de 
timeline et passer en lecture. Pour en savoir plus, 
reportez-vous à la section Lecture des sélections 
d'édition et de timeline avec la tête de lecture, 
page 479.

Demi-écran de la fenêtre Edit

Lorsque l'option de défilement Continuous ou 
Center Playhead est activée, un demi-écran 
apparaît à l'extrême gauche de la fenêtre Edit 
(avant le début de la session).

Activation ou désactivation 
de la liaison des sélections 
d'édition et de timeline
Pro Tools vous permet d'activer ou de désactiver 
la liaison des sélections d'édition et de timeline. 

Lorsque les sélections d'édition et de timeline 
sont liées, la sélection dans une playlist de piste 
(une sélection d'édition) définit également la 
plage de lecture et d'enregistrement (la sélection 
de timeline).

Lorsque vous désolidarisez les sélections 
d'édition et de timeline, vous pouvez 
sélectionner une partie de piste à modifier, 
distincte de la sélection de timeline (qui définit 
la plage de lecture et d'enregistrement).

Option de défilement utilisant la tête de lecture 

Demi-écran pour l'option de défilement Center 
Playhead
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Pour activer ou désactiver la liaison des sélections 
d'édition et de timeline, effectuez l'une des 
opérations suivantes :

" Sélectionnez ou désélectionnez Options > 
Link Timeline and Edit Selection.

– ou –

" En haut et à gauche de la fenêtre Edit, cliquez 
sur le bouton Link Timeline and Edit Selection 
de manière à le mettre en surbrillance (il est 
sélectionné) ou à supprimer la mise en 
surbrillance (il n'est pas sélectionné).

Si vous travaillez sur une scène de film ou en 
vidéo, vous pouvez avoir besoin de séparer les 
sélections d'édition et de timeline pour 
rechercher ou lire des données se trouvant à des 
emplacements différents de la sélection de 
timeline actuelle. Vous pouvez lire des 
sélections d'édition (choisissez Edit > Selection > 
Play Edit) sans interrompre la sélection de 
timeline actuelle. Lorsque vous avez repéré les 
données, vous pouvez revenir à la sélection de 
timeline et les placer dans le contexte de la 
scène.

La figure 19 illustre une autre application 
possible de la séparation des sélections d'édition 
et de timeline. Dans cet exemple, la sélection de 
timeline définit une plage à boucler en lecture, 
tandis qu'une région MIDI (se trouvant dans la 
boucle) est sélectionnée pour des besoins 
d'édition. Pendant la lecture, la sélection 

d'édition peut être déplacée, quantifiée ou 
transposée pendant que la boucle est lue de 
façon complètement indépendante et sans 
interruption.

Si vous pouvez théoriquement le faire alors que 
les sélections d'édition et de timeline sont liées, 
dès que la lecture est arrêtée, la plage de lecture 
sera mise à jour en fonction de la plage d'édition 
la plus récente ou selon une note lorsque vous 
éditez des données MIDI.

Marqueurs de sélections d'édition et de 
timeline

Les sélections de timeline sont représentées dans 
la règle temporelle principale par des marqueurs 
de sélection de timeline, qui prennent la forme de 
flèches bleues (rouges en cours d'enregistre-
ment). De plus, des drapeaux de pré et de post-roll 
(verts lorsqu'ils sont actifs) indiquent l'emplace-
ment du pré/post-roll.

Lorsque les sélections d'édition et de timeline 
sont séparées, les sélections d'édition s'affichent 
dans la règle avec les marqueurs d'édition, qui 
apparaissent sous forme de crochets noirs.

Liaison des sélections d'édition et timeline activée

Appuyez sur Maj + / (barre oblique) pour 
activer ou désactiver l'option Link Timeline 
and Edit Selection.

Figure 19.  Sélections d'édition et de timeline séparées

Marqueurs de sélection de timeline avec drapeaux de 
pré/post-roll

Figure 20.  Marqueurs d'édition
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Lorsque les sélections d'édition et de timeline 
sont liées, les sélections d'édition sont 
représentées par les marqueurs de sélection de 
timeline.

Pour plus d'informations concernant 
l'utilisation des sélections d'édition et de 
timeline, reportez-vous aux sections suivantes :

• Sélection des données de la piste, page 463

• Sélections de timeline, page 476

• Définition des points d'enregistrement 
fractionné et de boucle, page 338

• Définition des paramètres de pré et 
post-roll, page 341

Activation ou désactivation 
de la liaison des sélections 
d'édition et de piste
Pro permet d'activer ou de désactiver la liaison 
des sélections d'édition et de pistes.

Lorsque les sélections d'édition et de piste sont 
liées, vous pouvez effectuer une sélection dans 
une ou plusieurs pistes à des fins d'édition ; 
chaque piste est sélectionnée (les noms des 
pistes s'affichent automatiquement en 
surbrillance). Cela vous permet d'exécuter des 
commandes à l'échelle de la piste (pour changer 
la vue de pistes ou les hauteurs de pistes, par 
exemple) et d'appliquer la commande à toutes 
les pistes avec lesquelles vous travaillez. 

Lorsque les sélections d'édition et de pistes sont 
dissociées, définir une sélection d'édition ne 
sélectionne pas automatiquement les pistes 
associées. 

Pour activer ou désactiver la liaison des sélections 
d'édition et de pistes, effectuez l'une des 
opérations suivantes :

" Sélectionnez ou désélectionnez Options > 
Link Track and Edit Selection.

– ou –

" En haut et à gauche de la fenêtre Edit, cliquez 
sur le bouton Link Track and Edit Selection de 
manière à le mettre en surbrillance (il est 
sélectionné) ou à supprimer la mise en 
surbrillance (il n'est pas sélectionné).

Sélection des données de 
la piste
Avant de pouvoir éditer des données audio et 
MIDI, vous devez les sélectionner. La vue de la 
piste détermine la manière dont le matériel 
s'affiche et est sélectionné. 

Lorsque vous effectuez une sélection, elle 
apparaît en surbrillance sur la piste. Le début et 
la fin de la sélection sont également représentés 
par des flèches bleues (marqueurs de sélection de 
timeline) dans la règle temporelle principale. 
Si une piste quelconque (audio ou MIDI) de la 
session est préparée en enregistrement, même si 
elle est masquée, ces marqueurs s'affichent en 
rouge. 

Liaison des sélections d'édition et de piste activée

Marqueurs de sélection de timeline indiquant une 
sélection d'édition
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Lorsque les sélections d'édition et de timeline 
sont séparées, la plage de sélection d'édition est 
indiquée par des marqueurs d'édition dans la 
règle temporelle principale. Pour plus 
d'informations, consultez la section Activation 
ou désactivation de la liaison des sélections 
d'édition et de timeline, page 461.

Sélections et groupes d'édition

Lorsque vous effectuez des sélections sur des 
pistes appartenant à un groupe d'édition, toutes 
les pistes de ce dernier sont sélectionnées.

Sélections et pistes masquées

Lorsque vous éditez des pistes appartenant à un 
groupe d'édition, aucune piste masquée de ce 
dernier n'est concernée par l'édition. Pour éditer 
tous les membres d'un groupe, vérifiez s'ils sont 
visibles en mettant en surbrillance leurs noms 
dans la liste des pistes. 

Sélection sur plusieurs pistes

Pour effectuer une sélection sur plusieurs pistes :

" A l'aide du sélecteur, cliquez et faites glisser 
horizontalement pour inclure des pistes 
adjacentes d'une sélection (faites glisser 
verticalement pour définir la plage temporelle). 

Sélection de régions

Pour sélectionner une partie d'une région :

" Déplacez le sélecteur dans une région, 
(à gauche ou à droite) pour sélectionner les 
données d'une seule piste. (Vous pouvez 
également utiliser le sélecteur sur plusieurs 
pistes adjacentes pour effectuer des sélections 
s'étendant sur plusieurs pistes).

Pour sélectionner une région entière, procédez 
comme suit :

" Cliquez sur la région à l'aide de l'outil 
d'accrochage de temps.

– ou –

" Cliquez deux fois sur la région avec le 
sélecteur.

Pour sélectionner deux régions et la plage de 
temps qui les sépare :

1  Avec l'outil d'accrochage de temps, cliquez sur 
la première région.

2  Cliquez sur la seconde région en appuyant sur 
la touche Maj. Les deux régions sont 
sélectionnées, ainsi que la plage de temps qui les 
sépare (y compris, éventuellement, d'autres 
régions).

Pour sélectionner une piste entière, procédez 
comme suit :

" Cliquez dans la piste avec le sélecteur et 
choisissez Edit > Select All.

– ou –

" Cliquez trois fois sur n'importe quelle piste 
avec le sélecteur.

Pour sélectionner toutes les régions de toutes les 
pistes :

1  Sélectionnez le groupe d'édition All dans le 
menu déroulant de la liste des groupes.

2  Effectuez l'une des opérations suivantes :

Sélection d'une partie d'une région
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• Cliquez sur n'importe quelle piste avec le 
sélecteur et choisissez Edit >Select All.

– ou –

• Cliquez trois fois sur n'importe quelle piste 
avec le sélecteur.

Option Region List Selection Follows 
Edit Selection

Lorsque l'option « Region List Selection Follows 
Track Selection » des préférences d'édition est 
activée, la sélection d'une région dans une piste 
sélectionne également la région dans la liste des 
régions.

Inversement, lorsque l'option Edit Selection 
Follows Region List Selection des préférences 
d'édition est activée, la sélection d'une région 
dans la liste des régions entraîne la sélection la 
première occurrence de cette région dans la 
piste.

Tout sélectionner à partir des règles 
temporelles

Pour sélectionner toutes les données de toutes les 
pistes audio et MIDI affichées :

1  Activez l'option Link Timeline and Edit 
Selection (Options > Link Timeline and Edit 
Selection).

2  Cliquez deux fois sur n'importe quelle règle 
temporelle. Toutes les régions de toutes les pistes 
audio et MIDI affichées sont sélectionnées. Les 
pistes masquées ne sont pas sélectionnées.

Pour sélectionner toutes les données de toutes les 
pistes, y compris les événements du chef 
d'orchestre :

1  Activez l'option Link Timeline and Edit 
Selection (Options > Link Timeline and Edit 
Selection).

2  Cliquez deux fois sur n'importe quelle règle 
temporelle en maintenant enfoncée la touche 
Option (Mac) ou Ctrl (Windows). Toutes les 
régions de toutes les pistes audio et MIDI 
affichées sont sélectionnées, y compris les 
événements dans chaque piste du chef 
d'orchestre.

Réalisation de sélections pendant la 
lecture

Pro Tools permet d'effectuer des sélections à la 
volée à l'aide des touches fléchées Haut et Bas.

Pour réaliser une sélection pendant la lecture :

1  Activez l'option Link Timeline and Edit 
Selection (Options > Link Timeline and Edit 
Selection).

2  A l'aide du sélecteur, cliquez au début de la 
piste dans laquelle vous voulez effectuer la 
sélection.

3  Pour commencer la lecture, cliquez sur le 
bouton de lecture de la fenêtre Transport.

4  Lorsque la lecture atteint le point où vous 
souhaitez que la sélection commence, appuyez 
sur la touche flèche en bas.

5  Appuyez sur la flèche vers le haut au point où 
vous voulez définir la fin de la sélection. 
La plage sélectionnée s'affiche en surbrillance.

6  Pour arrêter la lecture, cliquez sur Stop dans la 
fenêtre Transport.

Pour sélectionner toutes les régions de toutes 
les pistes sans sélectionner le groupe 
d'édition All, appuyez sur Entrée 
(Windows) ou sur Retour (Mac), puis 
simultanément sur Ctrl+A (Windows) ou 
sur Pomme+A (Mac). L'option Link 
Timeline and Edit Selection doit être 
activée.
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Pour remonter automatiquement au début de la 
sélection (ou à l'emplacement du curseur à 
l'écran), appuyez sur la touche flèche à gauche. 
Appuyez sur la flèche à droite pour aller à la fin 
de la sélection.

En mode de défilement par page ou continu, le 
défilement est suspendu en cas de sélection sur 
la timeline ou dans la playlist pendant la lecture 
lorsque le curseur de lecture sort de l'image. Pour 
reprendre le défilement de la page et se 
positionner sur l'emplacement de lecture, 
cliquez sur le localisateur de curseur de lecture 
dans la règle temporelle principale (voir 
Recherche du curseur de lecture, page 458).

Sélection d'objets

L'outil de saisie d'objet permet de sélectionner 
des régions non contiguës sur une ou plusieurs 
pistes. Les sélections non contiguës doivent 
recouvrir des régions entières. Si vous souhaitez 
que des sélections non contiguës incluent une 
partie de région, commencez par transformer 
cette portion en région à part entière, à l'aide de 
la commande Separate Region (voir 
Commandes Separate Region, page 486).

Pour sélectionner des régions non contiguës :

1  Réglez le mode d'édition sur Slip ou Grid.

2  Cliquez sur le menu déroulant Grabber et 
sélectionnez Objet.

3  Cliquez sur chaque région que vous voulez 
inclure dans la sélection en appuyant sur Maj. 
Les régions peuvent même se trouver sur des 
pistes différentes.

Chaque région sur laquelle vous cliquez est 
entourée d'une bordure foncée, qui indique 
qu'elle est sélectionnée.

L'outil de saisie d'objet ignore les groupes 
d'édition lorsque vous réalisez des sélections. 
Par exemple, sélectionner une région sur une 
piste groupée ne sélectionne pas les régions des 
autres pistes du groupe.

Sélections de temps et d'objet

Vous pouvez convertir des sélections de temps et 
d'objet. Les sélections de temps s'effectuent avec 
le sélecteur et l'outil d'accrochage de temps. Les 
sélections d'objet s'effectuent avec l'outil de 
saisie d'objet.

La conversion en sélection d'objet est utile 
lorsque vous travaillez avec des sélections 
importantes, en particulier avec plusieurs pistes 
et que vous souhaitez supprimer certaines 
régions de la sélection.

La conversion en sélection de temps s'utilise 
lorsque vous souhaitez sélectionner toutes les 
régions entre deux sélections d'objet non 
contiguës.

L'outil de saisie d'objet n'est pas disponible 
lorsque le mode d'édition est réglé sur 
Shuffle ou sur Spot.

Outil de saisie d'objet

Sélection non contiguë
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Pour convertir une sélection de temps en sélection 
d'objet :

1  Faites glisser le sélecteur dans n'importe quelle 
piste pour définir une sélection ou sélectionnez 
une règle temporelle pour sélectionner dans 
toutes les pistes.

2  Une fois l'outil de saisie d'objet sélectionné, 
cliquez deux fois sur l'icône d'accrochage dans la 
barre d'outils. Les régions comprises dans la 
plage de sélection sont alors sélectionnées en 
tant qu'objets. Les régions partiellement 
sélectionnées sont désélectionnées.

Pour sélectionner des régions partiellement 
sélectionnées, appuyez sur la touche Démarrer 
(Windows) ou Ctrl (Mac) tout en cliquant deux 
fois sur l'icône d'accrochage.

Pour convertir une sélection d'objet en sélection 
de temps :

1  Sélectionnez le nombre de régions désiré avec 
l'outil de saisie d'objet.

2  Cliquez deux fois sur le sélecteur dans la barre 
d'outils. La plage de temps qui sépare la 
première et la seconde région est sélectionnée.

Si vous utilisez l'outil de saisie d'objet pour des 
pistes appartenant à un groupe d'édition, les 
régions des autres pistes du groupe sont 
sélectionnées si elles se trouvent dans la plage de 
la région sélectionnée.

Modification de la durée d'une 
sélection

La plage de sélection peut être raccourcie ou 
prolongée ; ce type d'opération n'affecte pas les 
données de la sélection.

Pour changer la durée d'une sélection, effectuez 
l'une des opérations suivantes :

" A l'aide du sélecteur, placez le curseur à l'une 
des extrémités de la sélection actuelle et cliquez 
en appuyant sur Maj ou cliquez en appuyant sur 
Maj et déplacez le curseur vers la gauche ou la 
droite.

" Dans la règle temporelle principale, faites 
glisser le marqueur de sélection de timeline 
correspondant au début ou à la fin de la 
sélection.

" Si l'option Link Timeline and Edit Selection et 
désactivée, faites glisser les marqueurs d'édition 
(voir figure 20, page 462) pour modifier la durée 
de la sélection.

Pour effectuer une sélection longue :

1  A l'aide du sélecteur, cliquez à l'endroit où 
vous souhaitez que commence la sélection.

2  Déplacez le curseur jusqu'au point de fin et 
cliquez à l'endroit où vous souhaitez que finisse 
la sélection. 

Régions sélectionnées

Régions sélectionnées en tant qu'objets

Déplacement d'un marqueur de sélection de timeline



Guide de référence Pro Tools468

Pour vérifier les points de début et de fin d'une 
sélection longue, appuyez sur la touche flèche à 
gauche pour retourner au début de la sélection 
ou sur la touche flèche à droite pour aller à la fin 
de la sélection.

Déplacement par incrément d'une plage 
de sélection

La plage de sélection (mais pas les données de la 
sélection) peut être déplacée d'une valeur de 
déplacement par incréments.

Pour déplacer une plage de sélection par 
incrément :

1  Configurez la valeur de déplacement par 
incrément. Pour en savoir plus, reportez-vous à 
la section Définition de la valeur de 
déplacement par incrément, page 506.

2  Effectuez la sélection initiale avec le sélecteur.

3  Tout en appuyant sur Maj, appuyez sur plus 
(+) ou moins (–) sur le clavier numérique pour 
déplacer la plage de sélection de la valeur de 
l'incrément.

Déplacement par incréments des points 
de début et de fin de la sélection

Vous pouvez déplacer par incrément les points 
de début et de fin des sélections.

Pour déplacer le point de début ou de fin de la 
valeur de déplacement par incrément :

1  Configurez la valeur de déplacement par 
incrément. Pour en savoir plus, reportez-vous à 
la section Définition de la valeur de 
déplacement par incrément, page 506.

2  Effectuez la sélection initiale avec le sélecteur.

3  Effectuez l'une des opérations suivantes :

• Maintenez enfoncées les touches 
Option+Maj (Mac) ou Alt+Maj (Windows) 
et appuyez sur plus (+) ou moins (–) sur le 
pavé numérique pour déplacer le début de 
la sélection de la valeur de l'incrément.

– ou –

• Maintenez enfoncées les touches 
Pomme+Maj (Mac) ou Ctrl+Maj (Windows) 
et appuyez sur plus (+) ou moins (–) sur le 
pavé numérique pour déplacer la fin de la 
sélection de la valeur de l'incrément.

Extension des sélections

Vous pouvez étendre des sélections aux points 
de début et de fin de la région pour inclure une 
région adjacente ou aux marqueurs et aux 
emplacements mémoire.

Pour étendre une sélection jusqu'au point de 
début ou de fin d'une région :

1  A l'aide du sélecteur, sélectionnez une partie 
d'une région ou cliquez n'importe où dans la 
région.

2  Effectuez l'une des opérations suivantes :

• Appuyez sur Maj + Tab pour étendre la 
sélection au point de fin de la région.

– ou –

• Appuyez sur Option+Maj+Tab (Mac) ou sur 
Ctrl+Maj+Tab (Windows) pour étendre la 
sélection au point de début de la région.

Pour étendre une sélection et inclure une région 
adjacente :

1  Sélectionnez la première région à l'aide de 
l'outil d'accrochage de temps.

2  Effectuez l'une des opérations suivantes :
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• L'option Tab to Transients étant désactivée, 
appuyez sur Démarrer+Maj+Tab 
(Windows) ou Ctrl+Maj+Tab (Mac) pour 
étendre la sélection à la limite de la région 
suivante.

– ou –

• Pour étendre la sélection et inclure la limite 
de la région précédente, appuyez sur 
Ctrl+Démarrer+Maj+Tab (Windows) or 
Option+Ctrl+Maj+Tab (Mac).

Pour étendre une sélection à un marqueur ou à un 
emplacement mémoire :

1  Effectuez l'une des opérations suivantes :

• Cliquez dans une piste avec le sélecteur sur 
le point de début ou de fin souhaité.

– ou –

• Effectuez une sélection avec le sélecteur ou 
l'outil d'accrochage de temps.

2  Effectuez l'une des opérations suivantes :

• Cliquez sur un marqueur dans la règle des 
marqueurs tout en appuyant sur Maj.

– ou –

• Cliquez sur un emplacement mémoire 
dans la fenêtre Memory Locations tout en 
appuyant sur Maj.

La sélection est étendue depuis le point 
d'insertion d'origine jusqu'au marqueur ou à 
l'emplacement mémoire.

Utilisation des indicateurs de 
sélection (Start, End et Length)

Les indicateurs de sélection d'édition situés en 
haut de la fenêtre Edit peuvent définir des 
sélections d'édition précises. Les valeurs de 
temps des indicateurs de sélection d'édition 
utilisent le format temporel de l'échelle 
temporelle principale.

Pour effectuer une sélection avec les indicateurs 
de sélection d'édition :

1  Avec le sélecteur, cliquez sur la piste que vous 
voulez sélectionner.

2  Cliquez dans le champ Start en haut de la 
fenêtre Edit.

3  Saisissez le point de début de la sélection et 
appuyez sur la barre oblique (/) pour entrer la 
valeur et passer automatiquement au champ 
de fin.

4  Saisissez le point de fin de la sélection et 
appuyez sur Entrée pour accepter la valeur.

Raccourcis de saisie numérique pour les 
indicateurs de sélection

Les raccourcis suivants sont à votre disposition 
pour entrer les valeurs dans les indicateurs de 
sélection d'édition :

• Appuyez sur la touche / (barre oblique) pour 
naviguer dans les trois indicateurs de sélection 
d'édition.

• Utilisez la touche point (.) ou les flèches droite 
et gauche pour vous déplacer dans les champs 
temporels de chaque indicateur de sélection 
d'édition.

Modifier les indicateurs de sélection
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• Utilisez les flèches haut et bas pour augmenter 
ou réduire les valeurs numériques.

• Faites glisser le curseur dans un champ en 
maintenant enfoncée la touche Pomme (Mac) 
ou Ctrl (Windows) pour faire défiler les 
valeurs.

• Appuyez sur plus (+) ou moins (–) avec un 
nombre à ajouter ou à soustraire de la valeur 
du champ. Par exemple, pour ajouter 10 à la 
valeur courante d'un champ, naviguez dans le 
champ, appuyez sur la touche plus (+), tapez 
10 et appuyez sur Entrée.

" Appuyez sur esc ou Echap pour quitter les 
indicateurs de sélection d'édition sans entrer de 
nouvelle valeur.

Mode calculatrice

Vous pouvez éditer les valeurs de style 
calculatrice dans les indicateurs de sélection 
d'édition.

Pour soustraire des valeurs temporelles :

1  Dans l'indicateur de sélection d'édition, placez 
en surbrillance le champ que vous voulez 
modifier.

2  Appuyez sur moins (–) sur le pavé numérique.

3  Tapez la quantité à soustraire de la valeur de 
temps courante et appuyez sur Entrée.

4  Appuyez de nouveau sur Entrée pour 
appliquer la modification.

Pour ajouter des valeurs temporelles :

1  Dans l'indicateur de sélection d'édition, placez 
en surbrillance le champ que vous voulez 
modifier.

2  Appuyez sur plus (+) sur le pavé numérique.

3  Tapez la quantité à ajouter à la valeur de temps 
courante et appuyez sur Entrée.

4  Appuyez de nouveau sur Entrée pour 
appliquer la modification.

Sélection sur plusieurs pistes

Pour effectuer des éditions sur plusieurs pistes 
ou sur toutes les pistes, vous devez d'abord les 
sélectionner. Pour ce faire, il suffit d'inclure 
d'autres pistes à la sélection ou d'effectuer une 
sélection dans une règle temporelle (pour toutes 
les pistes).

Pour effectuer une sélection sur plusieurs pistes :

" A l'aide du sélecteur, cliquez et déplacez le 
curseur verticalement pour inclure les pistes 
adjacentes d'une sélection (déplacez le curseur 
horizontalement pour définir la plage 
temporelle). 

Pour étendre une sélection à une autre piste :

1  A l'aide du sélecteur ou de l'outil d'accrochage 
de temps, effectuez une sélection dans la 
première piste ou dans les pistes.

2  Cliquez sur d'autres pistes avec le sélecteur en 
appuyant sur Maj. Une plage identique est 
sélectionnée sur chaque piste supplémentaire.

Pour raccourcir ou allonger la sélection sur 
chacune des pistes, appuyez sur Maj tout en 
déplaçant le sélecteur pour modifier l'étendue de 
la sélection.

Ces raccourcis servent également à entrer les 
valeurs de début et de fin dans la fenêtre 
Transport.
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Pour effectuer une sélection sur toutes les pistes, 
procédez comme suit :

" Activez All Edit Group et effectuez une 
sélection dans n'importe quelle piste.

– ou –

" A l'aide du sélecteur, faites défiler une règle 
temporelle (vérifiez que les sélections d'édition 
et de timeline sont liées).

Ces sélections incluent toutes les pistes de la 
fenêtre Edit, mais n'incluent pas les pistes du 
chef d'orchestre (tempo, métrique et 
marqueurs).

Pour effectuer une sélection sur toutes les pistes, 
y compris les pistes du chef d'orchestre (pour 
tempo, métrique et marqueurs) :

" Déplacez le sélecteur dans n'importe quelle 
règle temporelle en maintenant enfoncée la 
touche Option (Mac) ou Alt (Windows).

Déplacement et extension de 
sélections entre pistes

Lorsque le focus clavier sur les commandes est 
actif, les sélections d'édition peuvent être 
déplacées ou étendues vers les pistes adjacentes.

Pour déplacer une sélection vers une piste 
adjacente :

1  Activez le focus clavier sur les commandes 
(voir Focus clavier, page 22).

2  A l'aide du sélecteur ou de l'outil d'accrochage 
de temps, effectuez une sélection.

3  Effectuez l'une des opérations suivantes :

• Appuyez sur P sur le clavier de votre 
ordinateur pour déplacer la sélection vers la 
piste précédente.

– ou –

• Appuyez sur le point-virgule (;) pour 
déplacer la sélection vers la piste suivante.

Dans les deux cas, la sélection d'édition d'origine 
est désélectionnée.

Pour étendre une sélection à une piste adjacente :

1  Activez le focus clavier sur les commandes 
(voir Focus clavier, page 22).

2  A l'aide du sélecteur ou de l'outil d'accrochage 
de temps, effectuez une sélection.

3  Effectuez l'une des opérations suivantes :

• Appuyez sur Maj + P pour étendre la 
sélection à la piste précédente.

– ou –

• Appuyez sur Maj+point-virgule (;) pour 
étendre la sélection à la piste suivante.

Dans les deux cas, la sélection d'édition d'origine 
reste sélectionnée.

Bouton de focus clavier sur les commandes activé

Pour déplacer la sélection vers la piste 
précédente, appuyez sur Ctrl+P (Mac) ou sur 
Démarrer+P (Windows) avec le focus 
clavier sur les commandes activé ; pour 
déplacer la sélection vers la piste suivante, 
appuyez sur Ctrl+point-virgule (;) (Mac) ou 
sur Démarrer+point-virgule (;) (Windows).
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Pour supprimer la piste du bas d'une sélection :

" Appuyez sur Option+Ctrl+point-virgule (;) 
(Mac) ou sur Alt+Démarrer+point-virgule (;) 
(Windows) pour supprimer la piste du bas.

Autres techniques de sélection 
utiles

La section suivante présente d'autres techniques 
de sélection.

Pour placer le curseur d'édition précisément au 
point de début, de fin ou de synchronisation d'une 
région :

1  Vérifiez que le bouton de tabulation vers 
transitoire n'est pas activé. Voir Tabulation vers 
transitoires, page 473.

2  Cliquez avec le sélecteur dans la piste.

3  Effectuez l'une des opérations suivantes :

• Appuyez sur la touche de tabulation (Tab) 
pour déplacer le curseur sur le point de 
début, de fin ou de synchronisation de la 
région suivante ou du groupe de régions 
suivant.

– ou –

• Appuyez sur Option+Tab (Mac) ou sur 
Ctrl+Tab (Windows) pour déplacer le 
curseur sur le point de début, de fin ou de 
synchronisation de la région précédente ou 
du groupe de régions précédent. 

Pour effectuer une sélection avec l'outil de 
scrubbing :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation.

2  Sélectionnez l'option Edit Insertion Follows 
Scrub/Shuttle, puis cliquez sur OK.

3  Déplacez l'outil de scrubbing pour repérer un 
point de début approprié de la sélection, puis 
relâchez-le.

4  Tout en appuyant sur Maj, déplacez l'outil de 
scrubbing pour repérer un point de fin approprié 
de la sélection, puis relâchez-le. La plage qui 
sépare le scrub initial et final est sélectionnée.

Pour déplacer une sélection vers une région 
adjacente de la même piste :

1  Sélectionnez une région avec l'outil 
d'accrochage de temps

2  Effectuez l'une des opérations suivantes :

• Pour déplacer la sélection vers la région 
suivante, appuyez sur Ctrl+Tab (Mac) ou 
sur Démarrer+Tab (Windows). 

– ou –

• Pour déplacer la sélection vers la région 
précédente, appuyez sur Option+Ctrl+Tab 
(Mac) ou sur Ctrl+Démarrer+Tab 
(Windows).

Dans les deux cas, la région d'origine est 
désélectionnée.

Pour faire glisser une sélection d'édition dans la 
règle temporelle principale :

1  A l'aide du sélecteur ou de l'outil d'accrochage 
de temps, effectuez une sélection.

2  Tout en appuyant sur Option (Mac) ou sur Alt 
(Windows), déplacez le curseur sur l'un des 
marqueurs de sélection de timeline de la règle 
(l'outil d'accrochage de temps apparaît).

Pour déplacer la sélection vers la piste 
précédente, appuyez sur Ctrl+Maj+P (Mac) 
ou sur Démarrer+Maj+P (Windows) avec le 
focus clavier sur les commandes activé ; 
pour déplacer la sélection vers la piste 
suivante, appuyez sur 
Ctrl+Maj+point-virgule (;) (Mac) ou sur 
Démarrer+Maj+point-virgule (;) 
(Windows).
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3  Faites glisser le curseur vers la gauche ou la 
droite pour avancer ou reculer temporellement 
la sélection d'édition tout en conservant sa 
durée.

Si l'option Link Timeline and Edit Selection est 
désactivée (Options > Link Timeline and Edit 
Selection), faites glisser les marqueurs d'édition 
en appuyant sur Option (Mac) ou sur Alt 
(Windows).

Commandes contextuelles et 
conservation des sélections

Les commandes contextuelles, associées aux 
combinaisons de touches, permettent 
d'effectuer certaines opérations sur des objets 
tout en conservant les sélections affichées dans 
les fenêtres Edit et Mix. Par exemple, vous 
pouvez conserver les sélections affichées dans 
les zones suivantes tout en effectuant certaines 
opérations :

• sélections de régions dans la timeline ;

• sélections de noms de région dans la liste 
des régions ;

• sélections de pistes.

Pour appliquer une commande à un objet tout en 
conservant la sélection actuelle :

" Appuyez sur la touche Ctrl (Windows) ou 
Pomme (Mac) et cliquez avec le bouton droit de 
la souris sur un objet, puis sélectionnez la 
commande souhaitée dans le menu contextuel.

Tabulation vers transitoires

L'option Tab to Transients permet de naviguer 
automatiquement vers les transitoires dans les 
formes d'onde audio, en plaçant le curseur juste 
avant le pic de transitoire détecté. Vous pouvez 
ainsi définir des sélections et des plages de 
lecture, ainsi que des points de début et de fin 
pour de nouvelles régions, sans devoir effectuer 
de zoom avant sur la forme d'onde.

Lorsque l'option de tabulation vers transitoires 
est active, la fonction de tabulation repère 
également les points de début, de fin mais pas de 
synchronisation de la région.

Pour définir les points de début et de fin d'une 
sélection avec l'option de tabulation vers 
transitoires :

1  En haut et à gauche de la fenêtre Edit, cliquez 
sur le bouton de tabulation vers transitoires 
pour le sélectionner.

2  Si vous comptez définir la plage de lecture 
avec cette sélection, sélectionnez Options > Link 
Timeline and Edit Selection.

3  Cliquez sur la piste audio juste avant le début 
des données que vous voulez sélectionner.

4  Appuyez plusieurs fois sur la touche de 
tabulation jusqu'à ce que le curseur se 
positionne sur le transitoire correspondant au 
début de la sélection.

Si nécessaire, vous pouvez accéder au transitoire 
précédent en appuyant sur Option+Tab (Mac) 
ou sur Ctrl+Tab (Windows).

Glissement d'une sélection d'édition dans la règle 
temporelle principale

Bouton de tabulation vers transitoires activé
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5  Appuyez sur Maj + Tab jusqu'à ce que le 
curseur se positionne à la fin des données à 
sélectionner.

Pour déplacer le point de fin de la sélection sur le 
transitoire précédent, appuyez sur 
Option+Maj+Tab (Mac) ou sur Ctrl+Maj+Tab 
(Windows).

Une fois sélectionnées, les données peuvent être 
mises en boucle pour l'enregistrement ou la 
lecture, ou transformées en nouvelle région avec 
les commandes Separate ou Capture.

Lecture des sélections
Après avoir effectué une sélection d'édition, 
vous pouvez l'écouter en cliquant sur Play dans 
la fenêtre Transport. S'ils sont activés, les pré et 
post-roll sont lus également.

Pour lire une sélection :

1  Activez l'option Link Timeline and Edit 
Selection (Options > Link Timeline and Edit 
Selection).

2  A l'aide du sélecteur ou de l'outil d'accrochage 
de temps, effectuez une sélection de piste.

3  Si vous souhaitez utiliser les pré-roll ou les 
post-roll, activez-les et définissez leurs 
paramètres. Pour en savoir plus, reportez-vous à 
la section Définition des paramètres de pré et 
post-roll, page 341.

4  Cliquez sur le bouton de lecture dans la 
fenêtre Transport ou appuyez sur la barre 
d'espace.

La plage de sélection est lue sur toutes les pistes, 
y compris les pré-roll et post-roll (le cas 
échéant).

Pour lire une sélection d'édition lorsque l'option 
Link Timeline and Edit Selection est désactivée, 
effectuez l'une des opérations suivantes :

" Choisissez Edit > Selection > Play Edit.

Pour lire une sélection de timeline lorsque l'option 
Link Timeline and Edit Selection est désactivée :

" Choisissez Edit > Selection > Play Timeline.

Ecoute des pré-roll et des post-roll

Vous pouvez écouter et lire uniquement les 
données correspondant au pré-roll ou au 
post-roll d'une sélection.

Pour lire à partir du point de pré-roll jusqu'au début 
de la sélection ou jusqu'à l'emplacement actuel 
du curseur :

" Appuyez sur Option+flèche gauche (Mac) ou 
sur Alt+flèche gauche (Windows).

Pour lire jusqu'au point de post-roll depuis la fin de 
la sélection ou depuis l'emplacement actuel du 
curseur :

" Appuyez sur Pomme+flèche droite (Mac) ou 
sur Ctrl+flèche droite (Windows).

Ecoute des points de début et de fin 
des sélections

Il peut arriver que vous souhaitiez écouter le 
début ou la fin d'une sélection audio sans pour 
autant entendre la sélection complète. 
Par exemple, pour vérifier si le début ou la fin 
d'une sélection inclut des clics indésirables.

Les crêtes des transitoires sont généralement 
visibles dans la forme d'onde. Cependant, 
certains transitoires basse fréquence peuvent 
ne pas apparaître sous forme de crêtes 
visibles dans la forme d'onde.
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Pour écouter le point de début d'une sélection :

" Appuyez sur Pomme+flèche gauche (Mac) ou 
sur Ctrl+flèche gauche (Windows).

Lors de l'écoute du début d'une sélection, celle-ci 
est lue depuis le point de début pendant une 
durée égale à la quantité de post-roll.

Pour écouter le point de début d'une sélection 
avec le pré-roll :

" Appuyez sur Pomme+Option+flèche gauche 
(Mac) ou sur Ctrl+Alt+flèche gauche (Windows).

Pour écouter le point de fin d'une sélection :

" Appuyez sur Option+flèche droite (Mac) ou 
sur Alt+flèche droite (Windows).

Lorsque vous écoutez la fin d'une sélection, la 
lecture commence avant le point de fin, de la 
durée de pré-roll.

Pour écouter le point de fin d'une sélection avec le 
post-roll :

" Appuyez sur Pomme+Option+flèche droite 
(Mac) ou sur Ctrl+Alt+flèche droite (Windows).

Lecture en boucle

Lorsque l'option Loop Playback est active, la 
région sélectionnée sur la piste est lue en boucle. 
S'il n'y a aucune sélection, la lecture se déroule 
normalement à partir de l'emplacement actuel 
du curseur. 

La lecture en boucle permet notamment de 
vérifier la continuité rythmique d'une sélection 
de données musicales. Si vous travaillez avec des 
sélections d'une mesure, une lecture en boucle 
permet de vérifier si le bouclage n'est pas 
perceptible. Si vous avez l'impression d'une 
discontinuité rythmique, ajustez la durée de la 
sélection jusqu'à obtenir la « musicalité » 
recherchée dans le contexte de la playlist et des 
autres pistes.

Pour lire une sélection en boucle :

1  Activez l'option Link Timeline and Edit 
Selection (Options > Link Timeline and Edit 
Selection).

2  A l'aide du sélecteur, sélectionnez la plage de 
la piste à lire en boucle.

3  Activez l'option Loop Playback en procédant 
comme suit :

• Sélectionnez Options > Loop Playback. 

• Cliquez avec le bouton droit de la souris sur 
le bouton de lecture de la fenêtre Transport, 
puis sélectionnez la commande Loop du 
menu contextuel.

• Cliquez sur le bouton Lecture en 
maintenant enfoncée la touche Ctrl (Mac) 
ou Démarrer (Windows). 

• Appuyez sur Pomme+Maj+L (Mac) ou sur 
Ctrl+Maj+L (Windows).

Plages de lecture pour l'audition des points de début et 
de fin

joue le début
(pendant la durée de post-roll)

lit le pré-roll + le début

joue la fin
(pendant la durée de pré-roll)

lit la fin + le post-roll

Une sélection doit durer au moins 500 ms 
pour pouvoir être lue en boucle.
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• Lorsque le mode du pavé numérique est 
réglé sur Transport, appuyez sur 4 sur le 
pavé numérique.

Lorsque l'option est activée, un symbole de 
boucle s'inscrit dans le bouton Lecture de la 
fenêtre Transport.

4  Dans la fenêtre Transport, cliquez sur le 
bouton Play.

La lecture commence à partir du point de 
pré-roll (si le pré-roll est activé) et se poursuit 
jusqu'au point de fin de la sélection, où la 
lecture revient au point de départ.

5  Pour arrêter la lecture, cliquez sur le bouton 
Stop de la fenêtre Transport.

Lecture en boucle et enregistrement 
audio

Même si l'option Loop Playback est active, 
Pro Tools ne fonctionne pas en boucle lorsqu'on 
tente d'enregistrer des pistes audio en modes 
QuickPunch, Destructive Record ou 
Nondestructive Record.

Pour enregistrer en boucle des pistes audio dans 
Pro Tools, vous devez activer le mode Loop 
Record (voir Enregistrement audio en boucle, 
page 333).

Sélections de timeline
Lorsque l'option des sélections d'édition et de 
timeline est désactivée, vous pouvez effectuer 
dans la timeline des sélections distinctes des 
sélections d'édition.

Lorsque les sélections d'édition et de timeline 
sont liées, les sélections d'édition effectuées sont 
reflétées dans la timeline et celles de timeline 
sous forme de sélection d'édition sur toutes les 
pistes.

Que les sélections d'édition et de timeline soient 
liées ou non, la plage indiquée par les marqueurs 
de sélection de timeline détermine toujours la 
plage de lecture et d'enregistrement (sauf en 
mode de transport dynamique ; voir Mode 
Dynamic Transport, page 480).

Avec Pro Tools HD, lorsque l'option de 
défilement est définie sur Center Playhead, elle 
détermine où commence la lecture (voir Lecture 
des sélections d'édition et de timeline avec la 
tête de lecture, page 479).

Pour effectuer une sélection de timeline avec le 
sélecteur :

1  Pour restreindre la sélection en fonction du 
pas de grille actuel, réglez le mode d'édition sur 
Grid. 

2  Cliquez et déplacez le sélecteur dans n'importe 
quelle règle temporelle.

Lecture en boucle activée

Réalisation d'une sélection de timeline avec le 
sélecteur
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La sélection de timeline est indiquée dans la 
règle temporelle principale par les marqueurs de 
sélection de timeline bleus (ou rouges si la piste 
est en mode d'enregistrement). Le début, la fin 
et la durée correspondant à la sélection de 
timeline apparaissent dans les champs 
correspondants de la fenêtre Transport.

Pour définir la sélection de timeline en déplaçant 
les marqueurs de sélection de timeline :

1  Si vous le souhaitez, réglez le mode d'édition 
sur Grid pour restreindre le mouvement en 
fonction du pas de grille actuel. 

2  A l'aide de l'outil d'accrochage de temps, 
déplacez le premier marqueur de sélection de 
timeline (flèche orientée vers le bas) sur le point 
de début.

3  Déplacez le second marqueur de sélection de 
timeline (flèche orientée vers le haut) sur le 
point de fin.

Pour définir la sélection de timeline dans la fenêtre 
Transport :

1  Si nécessaire, développez l'affichage de la 
fenêtre Transport de manière à afficher les 
temps de début et de fin (View > Transport > 
Expanded).

2  Effectuez l'une des opérations suivantes :

• Dans la fenêtre Transport, cliquez sur le 
champ Start.

– ou –

• Appuyez sur Alt+barre oblique (/) 
(Windows) ou sur Option+barre oblique (/) 
(Mac) sur le pavé numérique pour 
sélectionner le champ Start de la fenêtre 
Transport.

3  Tapez le nouvel emplacement de début et 
appuyez sur la barre oblique (/) pour entrer la 
valeur et passer automatiquement au champ 
End.

4  Tapez le nouvel emplacement de fin et 
appuyez sur Entrée pour accepter la valeur.

Déplacement d'une sélection de 
timeline

De même que les sélections d'édition, les 
sélections de timeline peuvent être déplacées 
dans la règle temporelle principale.

Pour déplacer une sélection de timeline dans la 
règle temporelle principale :

1  Tout en appuyant sur Option (Mac) ou sur Alt 
(Windows), déplacez le curseur sur l'un des 
marqueurs de sélection de timeline (l'outil 
d'accrochage de temps apparaît).

2  Faites glisser le curseur vers la gauche ou la 
droite pour avancer ou reculer dans le temps la 
sélection de timeline, tout en conservant sa 
durée.

Pour sélectionner toutes les pistes, y compris 
celles du chef d'orchestre, appuyez sur 
Option (Mac) ou sur Alt (Windows) tout en 
cliquant et en déplaçant le sélecteur dans la 
règle temporelle.

Déplacement d'un marqueur de sélection de timeline

Les raccourcis pour entrer les valeurs de 
début et de fin dans la fenêtre Transport 
sont répertoriés dans la section Raccourcis 
de saisie numérique pour les indicateurs de 
sélection, page 469.
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Copie des sélections de timeline vers 
ou à partir de sélections d'édition

Lorsque les sélections d'édition et de timeline ne 
sont pas liées, vous pouvez copier des sélections 
entre elles.

Pour copier une sélection d'édition vers la 
timeline :

" Choisissez Edit > Selection > Change Edit to 
Match Timeline.

Pour copier une sélection de timeline vers une 
sélection d'édition :

" Choisissez Edit > Selection > Change Timeline 
to Match Edit.

Edition TCE (Time 
Compression and Expansion, 
compression/expansion 
temporelle) et sélection de 
timeline
(Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement)

Lorsque les sélections d'édition et de timeline 
sont séparées, vous pouvez rétrécir ou étendre 
temporellement une sélection audio pour 
qu'elle corresponde à une sélection de timeline. 
Cette fonction est assurée par un plug-in Time 
Compression/Expansion, qui permet d'étendre 
ou de compresser les données audio 
sélectionnées.

Pour faire correspondre une sélection d'édition à 
la timeline :

1  Désélectionnez > Link Timeline and Edit 
Selection.

2  A l'aide du sélecteur, sélectionnez les données 
audio à compresser ou à étendre.

3  Dans n'importe quelle règle temporelle, 
sélectionnez la plage de temps dans laquelle 
vous voulez inscrire les données audio.

4  Choisissez Edit > TCE Edit to Timeline 
Selection. La sélection d'édition est compressée 
ou étendue à la durée de la sélection de timeline.

Compression ou extension de la 
sélection d'édition selon la sélection 
de timeline pour plusieurs pistes et 
canaux

La commande TCE Edit to Timeline est 
applicable à des sélections multicanaux et à des 
sélections sur plusieurs pistes. Toutes les régions 
sont compressées ou étendues de façon égale 
avec la même valeur en pourcentage, basée sur la 
plage de sélection d'édition. Ceci garantit que la 
relation rythmique entre les différents canaux 
ou les différentes pistes est conservée.

Correspondance d'une région 
audio avec une sélection d'édition

Les régions peuvent être déplacées de la liste des 
régions pour s'inscrire dans une sélection 
d'édition. La région déplacée est compressée ou 
étendue à la durée de la sélection. Cette fonction 
est mise en œuvre par le plug-in Time 
Compression/Expansion pour étendre ou 
compresser la région audio.

Pour plus d'informations sur les préférences 
de traitement TCE, reportez-vous à la 
section Préférences de traitement, page 92.
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Pour faire correspondre une région audio à une 
sélection d'édition :

1  A l'aide du sélecteur, sélectionnez la plage de 
temps désirée dans une piste audio.

2  Faites glisser la région depuis la liste des 
régions vers la piste où vous avez effectué la 
sélection, en maintenant enfoncées les touches 
Pomme-Option (Mac) ou Ctrl-Alt (Windows). 
Le début de la région est placé au début de la 
sélection, et la région voit sa durée compressée 
ou étendue pour correspondre à celle de la 
sélection.

Correspondance à la sélection sur 
plusieurs pistes et canaux

La commande Fit to Selection permet de faire 
glisser plusieurs régions de la liste des régions 
vers plusieurs pistes ou vers des pistes 
multicanaux.

Cependant, toutes les régions déplacées sont 
alors compressées ou étendues de façon 
identique, du même pourcentage, basé sur la 
durée de la dernière région sur laquelle vous 
avez cliqué avant d'effectuer le déplacement.

Lecture des sélections 
d'édition et de timeline avec 
la tête de lecture
(Pro Tools HD uniquement)

Lorsque l'option de défilement est réglée sur 
Center Playhead, les sélections dans la timeline 
ne déterminent pas où commence la lecture. 
La tête de lecture, par elle-même, indique où 
commence la lecture lorsque vous cliquez sur 
Play dans la fenêtre Transport.

Les sélections de timeline et d'édition peuvent 
encore être lues lorsque la tête de lecture est 
activée.

Pour lire une sélection d'édition avec la tête de 
lecture

1  Désélectionnez Options > Linked Timeline 
and Edit Selections.

2  Sélectionnez Options > Scrolling > Center 
Playhead.

3  A l'aide du sélecteur ou de l'outil d'accrochage 
de temps, effectuez une sélection de piste.

4  Choisissez Edit > Selection > Play Edit.

La tête de lecture passe à la sélection d'édition, 
qu'elle lit du début à la fin, puis s'arrête.

Pour lire une sélection de timeline avec la tête de 
lecture

1  Désélectionnez Options > Linked Timeline 
and Edit Selections.

2  Sélectionnez Options > Scrolling > Center 
Playhead.

3  Faites glisser le sélecteur dans n'importe quelle 
règle temporelle pour définir la plage de lecture.

4  Choisissez Edit > Selection > Play Timeline.

La tête de lecture passe à la sélection de timeline, 
qu'elle lit du début à la fin, puis s'arrête.

Déplacement de la tête de lecture

Lorsque l'option de défilement Center Playhead 
est activée, la tête de lecture peut être déplacée 
en avant ou en arrière, vers la limite suivante de 
la région dans la piste sélectionnée.

Pour déplacer la tête de lecture vers les limites 
d'une région :

1  Vérifiez que le bouton de tabulation vers 
transitoire n'est pas activé (voir Tabulation vers 
transitoires, page 473).

2  Cliquez avec le sélecteur dans la piste.
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3  Effectuez l'une des opérations suivantes :

• Appuyez sur la touche de tabulation pour 
déplacer la tête de lecture en avant vers la 
limite de la région suivante.

– ou –

• Pour déplacer la tête de lecture en arrière à 
la limite de la région précédente, appuyez 
sur Option+Tab (Mac) ou sur Ctrl+Tab 
(Windows).

Mode Dynamic Transport
Le mode Dynamic Transport permet de séparer 
l'emplacement du point de lecture de la 
sélection de Timeline. Lorsque vous 
sélectionnez ce mode, vous pouvez démarrer la 
lecture à l'emplacement souhaité de la timeline 
sans perdre les sélections de timeline ou 
d'édition. Par exemple, vous pouvez utiliser 
simultanément les modes Dynamic Transport et 
Loop Playback pour écouter uniquement les 
transitions entre les cycles de boucle.

Lorsque le mode Dynamic Transport est activé, 
la fenêtre de la règle temporelle principale se 
développe de manière à afficher le nouveau 
marqueur de démarrage de lecture. Ce marqueur 
détermine l'emplacement du point de 
démarrage de la lecture lors de l'activation du 
transport. L'emplacement choisi est entièrement 
indépendant de la sélection de timeline. Vous 
pouvez le modifier pendant la lecture ; la lecture 
se poursuit alors à partir du nouvel 
emplacement.

Pour activer ou désactiver le mode Dynamic 
Transport :

" Sélectionnez ou désélectionnez la commande 
Options > Dynamic Transport.

Pour déplacer le marqueur de démarrage de 
lecture, effectuez l'une des opérations suivantes :

" Sélectionnez un outil d'édition, puis cliquez 
sur la ligne du marqueur de démarrage de lecture 
dans la règle temporelle principale.

" Sélectionnez un outil d'édition, cliquez sur le 
marqueur de démarrage de lecture, puis 
déplacez le à l'emplacement souhaité.

Appuyez sur Ctrl+Démarrer+P (Windows) 
ou Pomme+Ctrl+P (Mac) pour sélectionner 
ou désélectionner le mode Dynamic 
Transport.

L'activation du mode Dynamic Transport 
désactive automatiquement l'option Link 
Timeline and Edit Selection et active 
automatiquement le mode Loop Playback.

Mode Dynamic Transport avec affichage du marqueur 
de démarrage de lecture dans la règle temporelle 
principale développée

Marqueur de Sélection dans la 

Ligne du marqueur de démarrage de lecture

de lecture
démarrage règle temporelle
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" Cliquez sur les commandes d'avance rapide 
ou de retour rapide de la fenêtre Transport pour 
déplacer le marqueur de démarrage de lecture en 
fonction de la valeur d'incrément standard 
définie pour ces commandes.

Pour modifier les marqueurs de début ou de fin de 
sélection de timeline :

1  Définissez une sélection de timeline en 
cliquant et en déplaçant le sélecteur dans la règle 
temporelle principale. Si l'option Link Timeline 
and Edit Selection est activée (Options > Link 
Timeline and Edit Selection), vous pouvez créer 
une sélection d'édition à l'aide du sélecteur ou 
d'un autre outil d'accrochage.

2  Sélectionnez un outil d'édition, cliquez sur le 
marqueur de début ou de fin de sélection de 
timeline, puis déplacez le vers la gauche ou vers 
la droite afin d'étendre ou de réduire la 
sélection.

Pour déplacer la sélection de timeline :

" Sélectionnez un outil d'édition, cliquez sur la 
sélection dans la règle temporelle principale, 
puis déplacez la à l'emplacement souhaité.

Play Start Marker Follows Timeline 
Selection

Lorsque cette option est activée, le marqueur de 
démarrage de lecture s'aligne sur le marqueur de 
début de sélection de timeline lors des 
déplacements ou des créations de sélection de 
timeline ou lors des déplacements du point de 
début de sélection de timeline. Si cette option 
est désactivée, le marqueur de démarrage de 
lecture ne s'aligne pas sur la sélection de 
timeline.

Cliquez deux fois dans la ligne du marqueur 
de démarrage de lecture de la règle 
temporelle principale pour indiquer le 
nouvel emplacement du marqueur et 
démarrer la lecture.

Les modifications de sélection de timeline 
effectuées en cours de lecture entraînent 
l'interruption momentanée de l'opération. 
Pour minimiser la durée de cette 
interruption, réduisez la taille du buffer de 
lecture DAE dans la boîte de dialogue 
Playback Engine.

Déplacement de sélection d'édition en mode Dynamic 
Transport

Lorsque l'option Link Timeline and Edit 
Selection est désactivée, cliquez sur la 
sélection de timeline en appuyant sur la 
touche Alt (Windows) ou Option (Mac), 
puis alignez la de manière sur la sélection 
d'édition pour déplacer les deux sélections 
simultanément.



Guide de référence Pro Tools482

Pour aligner en permanence le marqueur de 
démarrage de lecture sur le marqueur de début de 
sélection de timeline :

1  Sélectionnez Setup > Preferences.

2  Cliquez sur l'onglet Operation.

3  Sélectionnez l'option Play Start Marker 
Follows Timeline Selection.

4  Cliquez sur OK.

Timeline Insertion/Play Start Marker 
Follows Playback

Lorsque cette option est activée, le marqueur de 
démarrage de lecture se déplace sur la timeline 
pour s'arrêter à l'emplacement correspondant à 
la fin de la lecture. Si cette option est désactivée, 
le marqueur de démarrage ne suit pas la lecture. 

Lorsque le mode Dynamic Transport n'est pas 
sélectionné, le point d'insertion de la timeline 
suit la lecture.

Pour que le point d'insertion de timeline ou le 
marqueur de démarrage de lecture suive la 
progression de l'opération :

1  Sélectionnez Setup > Preferences.

2  Cliquez sur l'onglet Operation.

3  Sélectionnez Timeline Insertion/Play Start 
Marker Follows Playback.

4  Cliquez sur OK.

Utilisation du mode Dynamic 
Transport Mode avec l'option Loop 
Playback

L'utilisation du mode Dynamic Transport et de 
l'option Loop Playback permet de spécifier les 
points de début et de fin de boucle avec la 
sélection de timeline et de positionner le 
marqueur de démarrage de lecture. 

La combinaison de ces fonctionnalités permet 
notamment d'écouter les transitions de boucle.

L'activation du mode Dynamic Transport active 
automatiquement l'option Loop Playback.

Pour écouter une transition de boucle :

1  Activez le mode Dynamic Transport (Options 
> Dynamic Transport).

2  Vérifiez que le mode Loop Playback est activé 
(Options > Loop Playback).

3  Créez la sélection de timeline à lire en boucle. 
Si l'option Link Timeline and Edit Selection est 
activée sous Options, vous pouvez créer une 
sélection d'édition.

4  Positionnez le marqueur de démarrage de 
lecture devant le marqueur de fin de sélection de 
timeline.

5  Démarrez la lecture.

La lecture débute avant le point de fin de boucle 
et se poursuit jusqu'au point de départ de la 
boucle. Vous pouvez modifier l'emplacement 
des marqueurs de début et de fin de sélection de 
timeline en les déplaçant vers la gauche ou vers 
la droite, même pendant la lecture. 

Ecoute de la transition de boucle en mode Dynamic 
Transport
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Utilisation de touches différentes pour 
le démarrage et l'arrêt de la lecture

Lorsqu'elle est activée, l'option Use Separate Play 
and Stop Keys permet de démarrer la lecture à 
l'aide de la touche Entrée et de l'arrêter à l'aide de 
la touche 0 du pavé numérique. Cette option 
s'utilise notamment lors de l'écoute des 
transitions de boucle, pour démarrer et arrêter la 
lecture à des points rapprochés.

Pour utiliser des touches du pavé numérique 
différentes pour le démarrage et l'arrêt de la 
lecture :

1  Sélectionnez Setup > Preferences.

2  Cliquez sur l'onglet Operation.

3  Définissez le mode du pavé numérique sur 
l'option Transport.

4  Sélectionnez l'option Use Separate Play and 
Stop Keys.

5  Cliquez sur OK.

La touche Entrée permet de démarrer la lecture. 
La touche zéro permet d'arrêter la lecture. 
Si vous appuyez deux fois sur la touche zéro, le 
marqueur de démarrage de lecture se positionne 
au début de la sélection de timeline.

Raccourcis clavier permettant de 
déplacer le marqueur de démarrage de 
lecture

En mode Dynamic Transport, vous pouvez 
utiliser des raccourcis clavier pour déplacer le 
marqueur de démarrage de lecture pendant la 
lecture ou lorsque le transport est arrêté. 

Pour déplacer le marqueur de démarrage de 
lecture au début de sélection de timeline :

" Appuyez sur le point (.) du pavé numérique, 
puis sur la flèche orientée vers la gauche.

Pour déplacer le marqueur de démarrage de 
lecture à la fin de sélection de timeline :

" Appuyez sur le point (.) du pavé numérique, 
puis sur la flèche orientée vers la droite.

Pour déplacer le marqueur de démarrage de 
lecture au début de sélection d'édition :

" Appuyez sur le point (.) du pavé numérique, 
puis sur la flèche orientée vers le bas.

Pour déplacer le marqueur de démarrage de 
lecture au niveau de la tête de lecture :

" Appuyez sur le point (.) du pavé numérique, 
puis sur la flèche orientée vers le haut.

Pour déplacer le marqueur de démarrage de 
lecture vers l'arrière (retour rapide) :

" Appuyez sur la touche 1 du pavé numérique.

Pour déplacer le marqueur de démarrage de 
lecture vers l'avant (avance rapide) :

" Appuyez sur la touche 2 du pavé numérique.

Lorsque cette option est sélectionnée, la 
touche Entrée ne permet plus d'ajouter des 
marqueurs d'emplacements mémoire. Pour 
effectuer cette opération, vous devez d'abord 
appuyer sur le point (.), puis sur la touche 
Entrée du pavé numérique. Le nouveau 
marqueur apparaît lorsque vous appuyez 
sur la touche Entrée.
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Pour déplacer le marqueur de démarrage de 
lecture vers une mesure spécifique :

" Sélectionnez l'option Bars:Beats en tant que 
règle temporelle principale, puis effectuez la 
procédure suivante sur le pavé numérique :

• Appuyez sur la touche astérisque (*).

• Saisissez le numéro de mesure.

• Appuyez sur Entrée.

Enregistrement en mode Dynamic 
Transport

L'enregistrement en mode Dynamic Transport 
permet de démarrer la lecture indépendamment 
de la sélection de timeline. Les points d'entrée et 
de sortie de l'enregistrement sont définis en 
fonction de la sélection de timeline.
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Chapitre 20 : Utilisation des régions et 
des sélections

Les régions constituent les composants 
élémentaires permettant d'organiser les sources 
audio et MIDI dans Pro Tools. Pour profiter 
pleinement des fonctions d'édition offertes par 
Pro Tools, il est essentiel de bien comprendre les 
processus de création, de modification et 
d'organisation des régions.

Ce chapitre aborde les fonctions d'édition 
fondamentales qui s'appliquent aux régions et 
groupes de régions, ainsi que les sélections qui 
concernent, dans la majorité des cas, les 
données audio et/ou MIDI.

Création de régions
Pro Tools offre plusieurs commandes pour créer 
des régions et des groupes de régions, chacune 
ayant un effet légèrement différent sur la 
sélection. Lorsque vous créez une région ou un 
groupe de régions, il ou elle s'affiche dans la liste 
des régions et dans la playlist de la piste. 
Pour plus de détails sur l'attribution 
automatique de nom à ces nouvelles régions, 
reportez-vous à la section Options de 
désignation automatique, page 565.

Lors de la création d'une région à partir d'une 
région existante, la région d'origine reste dans la 
liste des régions.

Commande Capture Region

La commande Capture Region définit une 
sélection en tant que nouvelle région et l'ajoute 
à la liste des régions. A partir de là, vous pouvez 
faire glisser la nouvelle région vers des pistes 
existantes.

Pour plus d'informations sur les procédures 
d'édition spécifiques aux données MIDI, 
reportez-vous au chapitre 25, Édition MIDI.

Pour plus d'informations sur les procédures 
d'édition spécifiques aux données vidéo, 
reportez-vous à la section Régions vidéo, 
page 956.
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Pour capturer une nouvelle région :

1  A l'aide du sélecteur, cliquez dans une région 
existante et sélectionnez les données de la 
nouvelle région.

2  Choisissez Region > Capture.

3  Donnez un nom à la nouvelle région et 
cliquez sur OK.

La nouvelle région apparaît dans la liste des 
régions. La région d'origine n'est pas modifiée.

Commandes Separate Region

Les commandes Separate Region définissent une 
sélection, à l'intérieur d'une région existante ou 
d'une région partiellement sélectionnée, en tant 
que nouvelle région et la séparent des données 
environnantes. 

Les nouvelles régions s'affichent dans les pistes 
dans lesquelles elles ont été créées, isolées des 
données qui les entourent. Elles apparaissent 
également dans la liste des régions. 

Il existe trois commandes Separate Region :

At Selection (or Edit Cursor) : crée de nouvelles 
limites de région aux points de début et de fin de 
la sélection. S'il n'existe aucune sélection et que 
le curseur d'édition est placé dans la région, cette 
dernière est divisée en deux nouvelles régions au 
point d'insertion. 

On Grid : crée des régions en fonction de la 
résolution de grille actuelle.

At Transients : crée automatiquement des 
limites de région en fonction des transitoires 
détectés dans une sélection. Cette commande et 
l'option de tabulation vers transitoires utilisent 
le même algorithme.

Pour séparer une ou plusieurs régions au niveau de 
la sélection (ou du curseur d'édition) :

1  Effectuez l'une des opérations suivantes :

• Créez une sélection d'édition à l'aide du 
sélecteur.

• Cliquez avec le sélecteur sur le point où 
vous souhaitez créer une séparation.

2  Effectuez l'une des opérations suivantes :

• Choisissez Edit > Separate Region > At 
Selection.

• Appuyez sur Pomme+E (Mac) ou sur Ctrl+E 
(Windows).

• Effectuez une sélection d'édition, puis 
cliquez avec le bouton droit de la souris 
près de la position du curseur ou de la 
sélection et sélectionnez la commande 
Separate dans le menu contextuel.

3  Si l'option Auto-Name Separated Regions des 
préférences d'édition n'est pas active, entrez le 
nom de la nouvelle région à l'invite, puis cliquez 
sur OK.

Pour séparer des régions en fonction de la 
résolution de grille actuelle.

1  Effectuez une sélection d'édition.

2  Choisissez Edit > Separate Region > On Grid.

Pour séparer des régions aux transitoires :

1  Effectuez une sélection d'édition.

2  Choisissez Edit > Separate Region > At 
Transients.

Sélection d'une partie de région
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Auto-Name Separated Regions Option

Lorsque l'option Auto-Name Separated Regions 
de la page des préférences d'édition est 
sélectionnée, Pro Tools attribue 
automatiquement des noms aux régions 
séparées. Le nom est une variation chiffrée du 
nom de la région d'origine.

Lorsque vous séparez une région, d'autres 
régions sont créées automatiquement à partir 
des données situées de part et d'autre de la 
séparation ; les noms de ces régions reçoivent 
chacun un numéro. La région d'origine n'est pas 
modifiée dans la liste des régions.

Séparation sur plusieurs pistes

La figure 21 illustre une séparation sur trois 
pistes audio mono et une piste stéréo. 
Pour certaines pistes, la sélection se trouve dans 
une région, tandis que d'autres se trouvent au 
début ou à la fin d'une région.

Une fois séparées, ces données peuvent être 
déplacées ou copiées vers un autre 
emplacement.

Si vous éditez une région faisant partie des 
prises associées utilisant le même marqueur 
de temps utilisateur (créée lors d'un 
enregistrement en boucle, par exemple) 
alors que l'option Separate Region Operates 
On All Related Takes des préférences 
d'édition est activée, la commande Separate 
Region a une incidence sur chaque prise. 
Pour plus d'informations, reportez-vous à la 
section Préférences d'édition des prises, 
page 337.

La liste des régions peut se remplir 
rapidement de régions créées 
automatiquement. Pour faciliter la gestion 
des régions, dans le menu contextuel Region 
List, désélectionnez Show > Auto-Created 
pour masquer toutes les régions créées 
automatiquement dans la liste des régions.

Figure 21.  Séparation sur plusieurs pistes
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Outil de séparation

L'outil de séparation permet de séparer 
automatiquement une sélection d'édition et de 
la déplacer vers un autre emplacement ou une 
autre piste.

Pour séparer une sélection avec l'outil de 
séparation :

1  Créez une sélection d'édition à l'aide du 
sélecteur. La sélection peut se trouver à 
l'intérieur d'une même région, sur des régions 
adjacentes de la même piste ou englober 
plusieurs pistes.

2  Dans le menu contextuel de la main, 
sélectionnez l'outil de séparation.

3  Sélectionnez la sélection à l'aide du curseur et 
faites-la glisser vers le nouvel emplacement ou 
vers une autre piste.

Une région (ou plusieurs) est créée, contenant la 
sélection précédente, séparément de la sélection 
d'origine. De nouvelles régions sont également 
créées à partir des données se trouvant hors de la 
sélection d'origine.

Pour séparer une sélection sans affecter les 
régions d'origine :

1  Créez une sélection d'édition à l'aide du 
sélecteur. La sélection peut se trouver à 
l'intérieur d'une même région, sur des régions 
adjacentes de la même piste ou englober 
plusieurs pistes.

2  Dans le menu contextuel de la main, 
sélectionnez l'outil de séparation.

3  Tout en appuyant sur Option (Mac) ou sur Alt 
(Windows), faites glisser la sélection vers le 
nouvel emplacement ou vers une autre piste.

De nouvelles régions contenant la sélection 
précédente sont créées et placées au nouvel 
emplacement. La sélection et les régions 
d'origine demeurent intactes.

Chevauchements de régions

Lorsqu'une piste audio basée sur le métronome 
comporte plusieurs régions, l'accélération du 
tempo peut provoquer un chevauchement de 
régions adjacentes. Vous pouvez définir les 
régions audio de sorte à afficher un coin écorné 
à leurs limites en cas de chevauchement. 

Outil de séparation

Déplacement d'une sélection plus loin dans la piste 
avec l'outil de séparation

avant
après

Déplacement d'une sélection vers une autre piste avec 
l'outil de séparation
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Pour basculer entre l'affichage des limites des 
régions chevauchées et celui des régions 
chevauchantes :

" Sélectionnez View > Region > Overlap.

Modifier le chevauchement des régions

Le chevauchement de régions provoqué par la 
modification de certains paramètres, comme le 
tempo basé sur le métronome, peut ne pas vous 
convenir. Le cas échéant, vous avez la possibilité 
de modifier le chevauchement en affichant la 
région de votre choix en premier plan ou en 
arrière-plan.

Pour modifier le chevauchement de régions :

1  Dans la fenêtre Edit, choisissez la ou les 
régions à réorganiser.

2  Effectuez l'une des opérations suivantes :

• Choisissez Region > Bring to Front pour 
que la région sélectionnée chevauche les 
régions adjacentes.

– ou –

• Choisissez Region > Send to Back pour que 
la région sélectionnée soit chevauchée par 
les régions adjacentes. 

Si la sélection est constituée de plusieurs régions 
qui se chevauchent, Pro Tools applique la 
commande à toutes les régions ainsi qu'aux 
régions de droite adjacentes. 

Rognage de régions
En plus des outils de trimming, Pro Tools intègre 
plusieurs options d'édition de limites de région 
et de groupe de régions. 

Commande Trim Region to 
Selection

La commande Trim Region to Selection 
supprime les données situées avant et après une 
région ou une note MIDI sélectionnée, pour que 
seule la sélection ne s'affiche à l'écran. 
Vous pouvez ainsi supprimer rapidement toutes 
les données d'une région (et, dans certains cas, 
l'intégralité de la piste), à l'exception de celles 
contenues dans la sélection active.

Pour « rogner » les données indésirables d'une 
région ou d'une note :

1  A l'aide du sélecteur, sélectionnez une partie 
d'une région ou d'une note (ou d'une plage de 
notes).

2  Choisissez Edit > Trim Region > To Selection 
pour supprimer les données situées hors de la 
sélection.

Commandes Trim Region to 
Insertion 

Vous pouvez rogner une région ou une note 
MIDI en supprimant automatiquement les 
données qui se trouvent entre le point 
d'insertion d'édition et le point de début ou de 
fin de la région.

Chevauchements de régions

Région chevauchante

Région chevauchée
Pour plus d'informations sur l'utilisation 
des outils de trimming, consultez la section 
Utilisation des outils de trimming, 
page 438.
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Pour rogner depuis un point de début jusqu'au 
point d'insertion :

1  A l'aide du sélecteur, cliquez dans la région ou 
dans la note, à l'endroit où vous souhaitez placer 
le nouveau point de début.

2  Choisissez Edit > Trim Region > Start To 
Insertion. Le point de début de la région est 
rogné automatiquement jusqu'au point 
d'insertion.

Pour rogner depuis un point de fin jusqu'au point 
d'insertion :

1  A l'aide du sélecteur, cliquez dans la région ou 
dans la note, à l'endroit où vous souhaitez placer 
le nouveau point de fin.

2  Choisissez Edit > Trim Region > End To 
Insertion. Le point de fin de la région est rogné 
automatiquement jusqu'au point d'insertion.

Commandes Trim to Fill Selection

La commande Trim to Fill Selection permet 
d'insérer automatiquement des données 
sous-jacentes dans les espaces entre régions.

Pour combler des espaces depuis un point de 
début de région :

1  Faites glisser le sélecteur pour sélectionner au 
moins un espace entre les régions.

2  Choisissez Edit > Trim Region > Start to Fill 
Selection.

Le point de début de la région situé derrière 
l'espace est étendu à la région précédente, le plus 
loin possible en fonction de la quantité de 
données sous-jacentes pouvant combler 
l'espace.

Pour combler des espaces depuis un point de fin 
de région :

1  Faites glisser le sélecteur pour sélectionner au 
moins un espace entre les régions.

2  Choisissez Edit > Trim Region > End to Fill 
Selection. 

Fin de la région rognée jusqu'au point d'insertion

Remplissage d'un espace avec le début d'une région
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Le point de fin de la région situé devant l'espace 
est étendu automatiquement jusqu'à la région 
suivante, le plus loin possible en fonction de la 
quantité de données sous-jacentes pouvant 
combler l'espace.

Pour combler des espaces avec les points de 
début et de fin d'une région :

1  Faites glisser le sélecteur pour sélectionner au 
moins un espace entre les régions.

2  Choisissez Edit > Trim Region > To Fill 
Selection.

Le point de début de la région se trouvant 
derrière l'espace est étendu automatiquement 
jusqu'à la région précédente, le plus loin 
possible en fonction de la quantité de données 
sous-jacentes pouvant combler l'espace. En 
parallèle, le point de fin de la région se trouvant 
devant l'espace est étendu automatiquement 
jusqu'à la région suivante, le plus loin possible 
en fonction de la quantité de données 
sous-jacentes pouvant combler l'espace.

Rognage par incrément

Vous pouvez rogner les points de début et de fin 
d'une région en les déplaçant par incrément.

Pour rogner le point de début ou de fin d'une région 
de la valeur de déplacement par incréments :

1  Configurez la valeur de déplacement par 
incrément (voir Définition de la valeur de 
déplacement par incrément, page 506).

2  A l'aide de l'outil d'accrochage de temps, 
sélectionnez la région à rogner.

3  Effectuez l'une des opérations suivantes :

• Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée et appuyez sur le 
signe plus (+) ou moins (-) du pavé 
numérique pour rogner le point de début 
de la région de la valeur de déplacement 
par incrément.

– ou –

• Maintenez la touche Pomme (Mac) ou Ctrl 
(Windows) enfoncée et appuyez sur le 
signe plus (+) ou moins (-) du clavier 
numérique pour rogner le point de fin de la 
région de la valeur de déplacement par 
incrément.

Réunion de divisions de 
région
La commande Heal Separation rétablit l'état 
d'origine de régions séparées, à la condition que 
les régions se trouvent encore l'une à côté de 
l'autre et que leurs points de début et de fin 
relatifs n'aient pas été modifiés depuis la 
séparation.

Si vous avez « rogné » ou modifié d'une manière 
ou d'une autre les points de début et de fin des 
deux régions, ou si vous les avez éloignées l'une 
de l'autre, vous ne pourrez pas les rétablir telles 

Remplissage d'un espace avec la fin d'une région
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qu'elles étaient à l'aide de la commande Heal 
Separation. Il n'est pas possible de réunir deux 
régions créées à partir de fichiers audio 
différents.

Pour rétablir une séparation entre deux régions :

1  Faites glisser le sélecteur pour sélectionner une 
partie de la première région et une partie de la 
seconde région ainsi que l'espace qui les sépare.

2  Choisissez Edit > Heal Separation.

Si la commande Heal Separation ne parvient pas à 
reconstituer une région divisée, effectuez l'une 
des opérations suivantes :

" Supprimez l'une des deux régions (vérifiez que 
le mode Slip est sélectionné pour que l'espace 
ainsi créé ne se referme pas), puis, à l'aide de 
l'outil de trimming, étendez la région restante de 
sa longueur originale (voir Utilisation des outils 
de trimming, page 438).

– ou –

" Supprimez les deux divisions de région et 
faites glisser la région d'origine de la liste des 
régions vers l'emplacement d'origine (voir 
Placement des régions dans les pistes, page 492).

Placement des régions dans 
les pistes
Une fois créée, la région s'inscrit dans la liste des 
régions. Vous pouvez la faire glisser de la liste 
vers une piste pour l'ajouter à une disposition de 
régions existante ou bien l'ajouter à une piste 
créée de toute pièce. Le placement exact des 
régions dans une piste dépend du mode 
d'édition choisi (Shuffle, Slip, Spot ou Grid) 
(voir Modes d'édition, page 425).

Pour placer une région dans une piste :

1  Dans la liste des régions, sélectionnez la ou les 
régions à placer.

2  Faites glisser les régions sélectionnées de la 
liste des régions vers le point souhaité sur 
la piste. 

Si vous faites glisser plusieurs régions, celles-ci 
seront déposées sur des pistes adjacentes, de 
gauche à droite, ou sur plusieurs pistes de haut 
en bas en fonction de l'ordre de placement sur la 
timeline (voir Ordre de placement sur la 
timeline, page 493). Si vous faites glisser une 
région stéréo, elle doit être placée dans une piste 
stéréo ou dans deux pistes mono.

Les régions sont placées en fonction du mode 
d'édition courant :

• En mode Shuffle, les régions existantes de la 
piste se décalent de façon à libérer assez de 
place pour la nouvelle région.

• En mode Spot, vous êtes invité par la boîte de 
dialogue Spot à entrer l'emplacement désiré 
pour la région déplacée (voir Placement de 
régions (Spot), page 500). 

• En mode Grid, la région déplacée s'aligne sur 
le pas le plus proche de la grille.

• En mode Slip, les régions se placent 
exactement à l'endroit où elles sont déposées 
sur la piste de destination.

Pour plus d'informations sur la recherche 
par initiale dans la liste des régions, 
consultez la section Sélection de régions au 
clavier, page 424.

Pour suspendre temporairement le mode 
Grid lorsque vous déplacez une région, 
maintenez la touche Pomme (Mac) ou Ctrl 
(Windows) enfoncée après avoir cliqué sur 
le bouton de la souris.
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Ordre de placement sur la timeline

La commande Timeline Drop Order du menu 
contextuel Region List permet de déterminer si 
les régions sélectionnées de la liste des régions 
sont déposées les unes derrière les autres sur une 
seule piste ou si elles sont réparties sur plusieurs 
pistes :

Top to Bottom : lorsque cette option est activée, 
les régions sont réparties sur plusieurs pistes de 
destination ou sur de nouvelles pistes (lorsque 
vous les faites glisser en dessous de la dernière 
piste ou vers la liste de pistes). 

Left to Right : lorsque cette option est activée, 
les régions sont placées les unes derrière les 
autres sur une seule piste de destination ou sur 
une nouvelle piste (lorsque vous les faites glisser 
en dessous de la dernière piste ou vers la liste de 
pistes).

Pour définir l'ordre de placement des régions :

" Sélectionnez Region List > Timeline Drop 
Order, puis Top to Bottom ou Left to Right. 

Pour faire glisser, puis déposer plusieurs éléments 
de la liste des régions sur de nouvelles pistes :

1  Dans le menu déroulant de la liste des régions, 
choisissez Timeline Drop Order > Top to 
Bottom.

2  Triez la liste des régions pour configurer, au 
besoin, l'ordre de positionnement des éléments. 

3  Sélectionnez plusieurs régions, puis effectuez 
l'une des opérations suivantes :

• Pour placer les régions à l'endroit voulu sur 
de nouvelles pistes, déposez-les en dessous 
de la dernière piste. 

• Pour placer les régions en début de session 
sur de nouvelles pistes, déposez-les dans la 
liste des pistes. 

Pour placer plusieurs régions sur plusieurs pistes 
existantes :

1  Dans le menu déroulant de la liste des régions, 
choisissez Timeline Drop Order > Top to 
Bottom.

2  Sélectionnez plusieurs éléments de la liste des 
régions, puis déposez-les à l'endroit voulu dans 
la playlist d'une piste compatible. Lorsque le 
curseur détecte une destination compatible, les 
contours de la région s'y affichent. 

Pour faire glisser, puis déposer plusieurs éléments 
de la liste des régions sur une seule piste : 

1  Dans le menu déroulant de la liste des régions, 
choisissez Timeline Drop Order > Left to Right.

2  Triez la liste des régions pour configurer, au 
besoin, l'ordre de positionnement des éléments. 

3  Sélectionnez plusieurs régions, puis effectuez 
l'une des opérations suivantes :

• Pour placer le premier élément à l'endroit 
voulu sur une nouvelle piste, déposez-le 
dans la zone située en dessous de la 
dernière piste, indiquée dans la 
fenêtre Edit. 

Nouvelles pistes après dépose de plusieurs régions, 
l'ordre de placement sur la timeline étant défini sur le 
mode Top to Bottom
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• Pour placer le premier élément en début de 
session sur une nouvelle piste, déposez-le 
dans la liste de pistes. 

• Pour placer des éléments sur une piste 
existante, déposez-les dans la playlist 
d'édition de la piste souhaitée. 

Si la sélection contient des régions de types 
différents (audio et MIDI ou groupes de régions 
et MIDI, par exemple), les pistes adéquates sont 
créées et les régions intègrent celles qui leur 
correspondent. De même, si la sélection 
contient plusieurs formats (mono, stéréo ou 
autres), de nouvelles pistes sont créées pour 
chaque format et les régions intègrent les pistes 
qui leur correspondent. 

Placement des régions au point 
d'insertion d'édition

Vous pouvez faire glisser une piste de la liste des 
régions, d'une piste à l'autre ou à l'intérieur 
d'une piste, puis aligner son point de début, de 
fin ou de synchronisation sur le point 
d'insertion d'édition. Cette technique s'utilise 
notamment au stade de la post-production. En 
effet, elle permet de définir un point de sélection 
d'édition lors de la lecture ou à l'arrêt et de placer 
facilement des effets sonores au point 
d'insertion d'édition.

Pour placer le début d'une région sur le point 
d'insertion d'édition :

1  Avec le sélecteur, cliquez dans la piste, sur 
l'emplacement temporel où vous souhaitez 
placer le début de la région. 

2  Effectuez l'une des opérations suivantes :

• Maintenez la touche Ctrl (Mac) ou 
Démarrer (Windows) enfoncée et faites 
glisser la région de la liste des régions, ou 
d'une autre piste, vers la piste de 
destination.

– ou –

• Si la piste contient déjà cette région, 
maintenez la touche Ctrl (Mac) ou 
Démarrer (Windows) enfoncée et cliquez 
sur la région avec l'outil d'accrochage de 
temps.

Pour placer la fin d'une région sur le d'insertion 
d'édition :

1  Avec le sélecteur, cliquez dans la piste, sur 
l'emplacement temporel où vous souhaitez 
placer la fin de la région. 

2  Effectuez l'une des opérations suivantes :

• Maintenez les touches Pomme+Ctrl (Mac) 
ou Ctrl+Démarrer (Windows) enfoncées et 
faites glisser la région de la liste des régions, 
ou d'une autre piste, vers la piste de 
destination.

– ou –

• Si la piste contient déjà cette région, 
maintenez enfoncées les touches 
Pomme+Ctrl (Mac) ou Ctrl+Démarrer 
(Windows) et cliquez sur la région avec 
l'outil d'accrochage de temps.

Nouvelles pistes après dépose de plusieurs régions, 
l'ordre de placement sur la timeline étant défini sur le 
mode Left to Right

Avec Pro Tools HD, lorsque l'option 
Scrolling est définie sur Center Playhead, les 
régions s'alignent sur la tête de lecture et 
non sur le point d'insertion d'édition.
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Pour placer le point de synchronisation d'une 
région sur le point d'insertion d'édition :

1  Avec le sélecteur, cliquez dans la piste, sur 
l'emplacement temporel où vous souhaitez 
placer le point de synchronisation de la région. 

2  Effectuez l'une des opérations suivantes :

• Maintenez les touches Ctrl+Maj (Mac) ou 
Démarrer+Maj (Windows) enfoncées et 
faites glisser la région de la liste des régions, 
ou d'une autre piste, vers la piste de 
destination.

– ou –

• Si la piste contient déjà cette région, 
maintenez les touches Maj+Ctrl (Mac) ou 
Maj+Démarrer (Windows) enfoncées et 
cliquez sur la région avec l'outil 
d'accrochage de temps.

Alignement sur les points de 
début de la région

Vous pouvez aligner le point de début, de fin et 
de synchronisation d'une région sur le début 
d'une autre région sur une autre piste.

Pour aligner les points de début des régions sur 
des pistes différentes :

1  A l'aide de l'outil d'accrochage de temps, 
sélectionnez la région sur laquelle vous voulez 
effectuer l'alignement en cliquant dessus.

2  Si l'option Scrolling est définie sur Center 
Playhead (Pro Tools HD uniquement), placez la 
tête de lecture sur le point de début de la région 
sélectionnée. Pour en savoir plus, reportez-vous 
à la section Déplacement de la tête de lecture, 
page 479.

3  Effectuez l'une des opérations suivantes :

• Maintenez enfoncée la touche Ctrl (Mac) 
ou Démarrer (Windows) et faites glisser une 
région de la liste des régions vers une autre 
piste.

– ou –

• Si la piste contient déjà cette région, 
maintenez la touche Ctrl (Mac) ou 
Démarrer (Windows) enfoncée et cliquez 
sur la région à déplacer avec l'outil 
d'accrochage de temps.

Le point de début de la seconde région est aligné 
avec celui de début de la première région.

Pour aligner le point de fin d'une région avec le 
point de début d'une autre région (sur une piste 
différente) :

1  A l'aide de l'outil d'accrochage de temps, 
sélectionnez la région sur laquelle vous voulez 
effectuer l'alignement en cliquant dessus.

2  Si l'option Scrolling est définie sur Center 
Playhead (Pro Tools HD uniquement), placez la 
tête de lecture sur le point de début de la région 
sélectionnée (voir Déplacement de la tête de 
lecture, page 479).

3  Effectuez l'une des opérations suivantes :

• Maintenez enfoncées les touches 
Pomme+Ctrl (Mac) ou Ctrl+Démarrer 
(Windows) et faites glisser une région de la 
liste des régions vers une autre piste.

– ou –

• Si la piste contient déjà cette région, 
maintenez enfoncées les touches 
Pomme+Ctrl (Mac) ou Ctrl+Démarrer 
(Windows) et cliquez sur la région à 
déplacer avec l'outil d'accrochage de temps.

Le point de fin de la seconde région est aligné 
sur celui de début de la première région.

Avec Pro Tools HD, lorsque l'option 
Scrolling est définie sur Center Playhead, les 
points de début, de fin et de synchronisation 
des régions s'alignent sur la tête de lecture.
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Pour aligner le point de synchronisation d'une 
région sur le point de début d'une autre région (sur 
une piste différente) :

1  A l'aide de l'outil d'accrochage de temps, 
sélectionnez la région à aligner.

2  Si l'option Scrolling est définie sur Center 
Playhead (Pro Tools HD uniquement), placez la 
tête de lecture sur le point de début de la région 
sélectionnée (voir Déplacement de la tête de 
lecture, page 479).

3  Effectuez l'une des opérations suivantes :

• Maintenez enfoncées les touches Ctrl+Maj 
(Mac) ou Démarrer+Maj (Windows) et 
faites glisser une région de la liste des 
régions vers une autre piste.

– ou –

• Si la piste contient déjà cette région, 
maintenez les touches Ctrl+Maj (Mac) ou 
Démarrer+Maj (Windows) enfoncées et 
cliquez sur la région à déplacer avec l'outil 
d'accrochage de temps.

Le point de synchronisation de la seconde 
région est aligné sur celui de début de la 
première région.

Déplacement des régions par 
glissement

L'outil d'accrochage de temps permet aussi de 
faire glisser une région ou un groupe de régions 
sélectionnées (sur la même piste ou sur plusieurs 
pistes) vers de nouveaux emplacements ou vers 
d'autres pistes. En post-production, cette 
fonction s'avère utile pour la synchronisation 
des événements audio, notamment pour repérer 
les effets sonores et les dialogues sur une 
musique, un film ou une vidéo.

Le déplacement des régions en les faisant glisser 
dépend du mode d'édition (Shuffle, Slip, Spot ou 
Grid). Pour plus d'informations, reportez-vous à 
la section Modes d'édition, page 425.

Déplacement des régions 
(Shuffling)

En mode Shuffle, vous pouvez déplacer 
librement les régions dans une piste ou vers une 
autre piste, mais leur mouvement est contraint 
par les autres régions. Cela signifie que si vous 
placez plusieurs régions dans une piste, leurs 
points de début et de fin s'alignent 
automatiquement les uns sur les autres. Vous 
pouvez ensuite modifier l'ordre dans lequel elles 
se succèdent, mais vous ne pouvez pas les 
séparer, ni les superposer comme en mode Slip. 
En mode Shuffle, l'ajout d'une autre région au 
début d'une piste décale les régions suivantes 
vers la droite, de la durée de la région ajoutée.

Pour déplacer des régions en mode Shuffle :

1  Réglez le mode d'édition sur Shuffle en 
cliquant sur le bouton en haut et à gauche de la 
fenêtre Edit.

2  Faites glisser une région mono de la liste des 
régions vers une piste vide. La région s'aligne sur 
le début de la piste

Vous pouvez faire glisser une copie d'une 
région vers un autre emplacement ou une 
autre piste en appuyant sur Option (Mac) ou 
sur Alt (Windows).

Pour conserver l'emplacement temporel 
d'une région lorsque vous la déplacez vers 
une autre piste, appuyez sur la touche Ctrl 
(Mac) ou Démarrer (Windows).
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3  Vers cette même piste, faites glisser une 
seconde région de la liste des régions, aux 
environs du centre de la piste. Le point de début 
de la seconde région est aligné sur la fin de la 
première région.

4  Avec l'outil d'accrochage de temps, faites 
glisser la seconde région vers le début de la piste.

Pro Tools « réorganise » la position des deux 
régions. La seconde est devenue la première, 
mais les deux régions restent collées l'une à 
l'autre.

5  Faites d'autres essais en mode Shuffle en 
faisant glisser d'autres régions vers la piste et en 
les réorganisant.

Les régions verrouillées (voir Verrouillage de 
régions, page 509), ainsi que toutes les régions 
situées après elles, ne bougent pas lorsque 
d'autres régions voisines sont déplacées en mode 
Shuffle. S'il n'y a pas assez d'espace pour placer 
ou dupliquer une région devant une région 
verrouillée, la zone d'insertion est désactivée.

Si vous placez une région alors que vous vous 
trouvez en mode Slip, puis que vous passez en 
mode Shuffle, Pro Tools conserve le timing et la 
position relatifs de la région déplacée en 
glissant, ainsi que tout espace vide entre elle et 
les autres régions.

Déplacement en mode Shuffle de 
plusieurs pistes et de régions 
multicanaux

Il est possible de déplacer en mode Shuffle des 
sélections sur plusieurs pistes ou sur des pistes 
multicanaux. Dans ce cas, toute région 
partiellement sélectionnée est coupée et 
déplacée avec la région que l'on fait glisser. 
Ceci permet de ne conserver que les données qui 
correspondent à la région déplacée.

Déplacement de régions à l'aide 
des outils d'accrochage

Les outils d'accrochage permettent de déplacer 
une ou plusieurs régions, ou la sélection 
d'édition. La sélection est alors coupée et collée 
au nouvel emplacement. 

Pour certaines procédures, il est important 
d'exclure le mode Shuffle afin de garantir 
l'alignement temporel des régions lors de 
l'édition. Le verrouillage du mode Shuffle 
entraîne la désactivation de toutes les 
touches de raccourci et de surface de contrôle 
correspondant à ce mode. Le mode Shuffle 
ne peut plus être sélectionné, même par 
inadvertance. Pour plus d'informations, 
reportez-vous à la section Verrouillage du 
mode Shuffle, page 426.

Déplacement de régions multicanaux en mode Shuffle

Pour copier la sélection sans la couper, 
maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée tout en cliquant et en 
déplaçant la sélection.

Le déplacement de cette région par shuffling coupe ce canal
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Pour déplacer une ou plusieurs régions ou la 
sélection d'édition à l'aide des outils 
d'accrochage :

1  Effectuez une sélection.

2  A l'aide de l'un des outils d'accrochage (temps, 
séparation ou saisie d'objet), faites glisser la 
sélection vers le nouvel emplacement.

Accrochage de temps et saisie d'objet

Si vous déplacez des données audio, les outils 
d'accrochage de temps et de saisie d'objet 
superposent uniquement les données audio sur 
la piste de destination.

Outil de séparation (Separation Grabber)

L'outil de séparation entraîne le remplacement 
de l'ensemble de la plage sélectionnée sur la 
timeline de la piste de destination. 

Alignement à la région précédente 
ou suivante sur une piste

Les commandes Snap To Next et Snap To 
Previous permettent d'aligner une région (ou 
une sélection d'édition comprenant une ou 
plusieurs régions sur une ou plusieurs pistes) à la 
fin de la région précédente ou au début de la 
région suivante. Ces commandes s'utilisent pour 
raccorder bout à bout les régions adjacentes 
d'une piste.

Déplacement d'une sélection à l'aide de l'outil 
d'accrochage de temps

Déplacement d'une sélection à l'aide de l'outil de 
séparation
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Pour aligner une région à la région précédente 
d'une piste :

1  Effectuez l'une des opérations suivantes :

• Avec l'outil d'accrochage de temps, 
sélectionnez une région.

– ou –

• Sélectionnez une zone de piste contenant 
des régions entières à l'aide du sélecteur. 
Ces régions doivent être adjacentes.

2  Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Snap To > Previous. 

– ou –

• Cliquez avec le bouton droit de la souris sur 
la région ou la sélection d'édition, puis 
sélectionnez la commande Snap to 
Previous dans le menu contextuel.

La région sélectionnée s'aligne sur la région 
précédente sur la piste. Les deux régions sont 
alors raccordées bout à bout.

Pour aligner une région à la région suivante 
d'une piste :

1  Effectuez l'une des opérations suivantes :

• Avec l'outil d'accrochage de temps, 
sélectionnez une région.

– ou –

• Sélectionnez une zone de piste contenant 
des régions entières à l'aide du sélecteur. 
Ces régions doivent être adjacentes.

2  Effectuez l'une des opérations suivantes :

• Sélectionnez Edit > Snap To > Next. 

– ou –

• Cliquez avec le bouton droit de la souris sur 
la région ou la sélection d'édition, puis 
sélectionnez la commande Snap to Next 
dans le menu contextuel.

La région sélectionnée s'aligne sur la région 
suivante sur la piste. Les deux régions sont alors 
raccordées bout à bout.

Alignement d'une région à la région suivante 
d'une piste

Vous pouvez également utiliser les 
commandes d'alignement Snap To avec une 
sélection d'édition comprenant plusieurs 
régions sur une ou plusieurs pistes.
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Déplacement de régions en 
mode Slip

En mode Slip, l'outil d'accrochage de temps 
permet de déplacer à volonté les régions à 
l'intérieur d'une piste ou vers d'autres pistes. 
Dans ce mode, il est possible de placer une 
région dans une piste en laissant un espace entre 
elle et les autres régions. Lors de la lecture de la 
piste, cet espace est silencieux. Vous pouvez 
également déplacer une région pour qu'elle 
recouvre partiellement ou complètement une 
autre région.

Pour déplacer des régions en mode Slip :

1  Activez le mode Slip (voir Modes d'édition, 
page 425).

2  Faites glisser une région de la liste des régions 
vers une piste vide.

3  Vers cette même piste, faites glisser une 
seconde région de la liste des régions, aux 
environs du centre de la piste. La seconde région 
se place à l'endroit où vous la relâchez. 
Contrairement au mode Shuffle, ce mode ne 
permet pas d'aligner la seconde région pas sur la 
première.

4  Faites glisser les régions vers différents 
endroits dans la piste pour « sentir » le 
déplacement en mode Slip. Essayez de placer la 
seconde région pour qu'elle recouvre légèrement 
la première. Lisez le résultat.

Placement de régions (Spot)

Le mode Spot est utile dans le cadre de sessions 
dans lesquelles vous souhaitez placer des régions 
sur des emplacements précis quelle que soit 
l'échelle de temps. Il s'utilise notamment pour 
les tâches de post-production. Le mode Spot 
permet de placer une région en précisant un 
emplacement SMPTE (Pro Tools HD et 
Pro Tools LE avec DV Toolkit 2 uniquement) ou 
un nombre de mesures et de temps, en capturant 
une adresse de timecode entrante, ou en 
utilisant les marqueurs temporels de la région.

Pour placer une région en mode Spot :

1  Réglez le mode d'édition sur Spot en cliquant 
sur le bouton correspondant, en haut et à 
gauche de la fenêtre Edit.

2  Effectuez l'une des opérations suivantes :

• Faites glisser une région à partir de la liste 
des régions ou faites glisser des fichiers 
audio ou des sessions à partir d'un 
navigateur DigiBase vers une piste 
existante. 

– ou –

• Cliquez avec l'outil d'accrochage de temps 
sur une région se trouvant déjà dans la 
piste.

Pour un repérage encore plus rapide, si vous 
utilisez le VITC, utilisez la commande 
Auto-Spot Regions pour placer une région à 
l'emplacement SMPTE actuel avec l'outil 
d'accrochage de temps. Pour plus 
d'informations, reportez-vous à la section 
Placement automatique de régions, 
page 937.
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3  Dans la boîte de dialogue Spot, sélectionnez le 
format temporel désiré dans le menu déroulant 
Time Scale.

Chaque champ de la boîte de dialogue Spot 
apparaît dans le format temporel choisi.

4  Dans les systèmes Pro Tools HD ou 
Pro Tools LE avec DV Toolkit 2, si vous avez 
défini le format temporel (Time Scale) sur Time 
Code, sélectionnez l'option Use Subframes pour 
afficher les subdivisions d'images dans les 
champs, afin d'améliorer la précision.

5  Effectuez l'une des opérations suivantes :

• Cliquez dans le champ Start, Sync Point ou 
End et tapez un nouvel emplacement. 
La modification de l'un de ces points de 
repère met à jour automatiquement les 
autres points de repère.

• Cliquez sur la flèche verticale du champ 
Original Time Stamp ou sur celle du champ 
User Time Stamp pour entrer la valeur du 
marqueur de temps d'origine ou du 
marqueur de temps utilisateur.

• Si vous utilisez une source de timecode 
SMPTE externe, cliquez sur la flèche du bas, 
située à côté du champ Current Time Code 
(ou appuyez sur la touche égal (=) du 
clavier numérique) pour capturer une 
adresse de timecode entrant.

6  Cliquez sur OK. La région est déplacée vers le 
nouvel emplacement indiqué par ses points de 
début, de fin ou de synchronisation.

Si une région ne possède pas de point de 
synchronisation défini, le champ Sync Point de 
la boîte de dialogue Spot fonctionne comme le 
champ Start.

Placement des régions à l'aide de commandes 
contextuelles

Vous pouvez définir le placement des régions 
dans une piste à l'aide de combinaisons de 
touches et de commandes contextuelles.

Pour placer une région sur une sélection :

1  Positionnez le curseur ou créez une sélection à 
l'emplacement de la piste où vous souhaitez 
placer la région à l'aide du sélecteur.

2  Appuyez sur la touche Ctrl (Windows) ou 
Pomme (Mac) et cliquez avec le bouton droit de 
la souris sur la région, puis sélectionnez l'une des 
commandes suivantes dans le menu 
contextuel :

• Move Region Start to Selection Start

• Move Region Sync to Selection Start

• Move Region End to Selection Start

Boîte de dialogue Spot

Pour plus d'informations sur l'utilisation 
du timecode SMPTE dans Pro Tools, 
reportez-vous à la section chapitre 35, 
tilisation de la synchronisation.

Dans les versions précédentes de Pro Tools, 
vous pouviez définir le placement d'une 
région sur une sélection en cliquant dessus à 
l'aide de l'outil Main.
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Marqueurs de temps de la région

Lorsqu'une région est créée, elle subit un 
marquage temporel relatif au temps de début 
SMPTE spécifié pour la session. Ce marquage 
temporel d'origine est lié de façon permanente à 
la région et ne peut être modifié. Si jamais une 
région est déplacée, elle peut facilement être 
replacée à sa position d'origine depuis la boîte de 
dialogue Spot.

Lors de la définition initiale du marquage de 
temps original, c'est ce même emplacement qui 
sert également à définir le marqueur de temps 
utilisateur de la région.

Contrairement au marqueur temporel original, 
le marqueur temporel utilisateur peut être 
redéfini via la commande Time Stamp dans le 
menu contextuel de la liste des régions (voir 
Marquage temporel, page 938). 

Time Stamps dans DigiBase

Les navigateurs DigiBase contiennent des 
colonnes pour le marquage temporel original et 
le marquage temporel utilisateur. 

Marquage temporel et correspondances

Les régions possédant des marqueurs de temps 
utilisateur identiques sont regroupées dans le 
sous-menu Matches du menu contextuel lors de 
l'écoute des prises (voir Sélection d'une prise 
différente sur une piste, page 335). 

Déplacement des régions par 
glissement en mode Grid

Le mode Grid offre plusieurs fonctions utiles 
pour faire glisser et déplacer des régions dans les 
playlists de la piste. Ce mode est 
particulièrement utile pour disposer des régions 
à intervalles précis, lorsque vous travaillez avec 
une session basée sur les mesures et les temps. 

Les pas de la grille, en fonction de l'échelle de 
temps principale, peuvent être exprimés en 
trames, en nombre de mesures et de temps, en 
minutes/secondes ou en nombre d'échantillons. 

Le mode Grid offre également deux modes de 
fonctionnement : absolu et relatif. Ces modes 
régissent l'application de la grille (voir Mode 
Grid absolu et relatif, page 503).

Configuration de la grille

Lorsque l'option Draw Grid in Edit Window est 
activée dans la page des préférences d'affichage, 
des graduations verticales s'affichent dans la 
fenêtre Edit.

Vous pouvez également activer et désactiver ces 
graduations de la fenêtre Edit en cliquant sur le 
nom de la règle temporelle en surbrillance.

Définition de la valeur de la grille

Outre son influence sur le placement des 
régions, la valeur de la grille restreint les 
sélections d'édition et de timeline, et détermine 
le fonctionnement de la commande Region > 
Quantize to Grid.

Pour définir la valeur de la grille :

1  Effectuez l'une des opérations suivantes :

• Dans le menu View > Main Counter, 
sélectionnez l'échelle temporelle de la 
valeur de grille.

– ou –

• Pour conserver l'échelle temporelle 
principale et utiliser un format temporel 
différent pour la grille, désélectionnez 
l'option Follow Main Timebase dans le 

Pour suspendre temporairement le mode 
Grid et basculer en mode Slip tout en 
déplaçant une région, appuyez sur Ctrl 
(Windows) ou Pomme (Mac).
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menu déroulant de valeur de grille de la 
fenêtre Edit.

2  Effectuez l'une des opérations suivantes :

• Dans le menu déroulant de la valeur de 
grille de la fenêtre Edit, sélectionnez la 
valeur temporelle permettant de définir les 
limites de la grille.

– ou –

• Pour définir une grille d'après les 
marqueurs, sélections et limites des régions 
d'une session, sélectionnez 
Regions/Markers dans le menu déroulant 
de la valeur de grille.

Mode Grid absolu et relatif

Le mode Grid peut être absolu ou relatif. 

! En mode Grid absolu, le déplacement d'une 
région entraîne le déplacement du début de la 
région sur les limites de la grille. Si le point de 
départ d'une région se trouve entre deux temps 
et que la grille est définie sur 1/4 de note, le 
déplacement de la région déplace l'heure de 

début lui correspondant sur le 1/4 de note le 
plus proche (la valeur actuelle de grille absolue). 

! En mode Grid relatif, vous pouvez déplacer les 
régions par unités (ou incréments). Si le point de 
départ d'une région se trouve entre deux temps 
et que la grille est définie sur des 1/4 de note, le 
déplacement de la région est contraint à 1/4 de 
note et conserve la position relative de la région 
sur la mesure la plus proche.

Pour sélectionner le mode Grid absolu ou relatif :

" Cliquez sur le sélecteur de mode Grid, puis 
choisissez Absolute ou Relative. 

Pour placer ou déplacer une région en mode Grid :

1  Configurez la valeur de grille (voir Définition 
de la valeur de la grille, page 502).

2  Effectuez l'une des opérations suivantes :

• Faites glisser une région de la liste des 
régions vers une piste existante. 

– ou –

• Avec l'outil d'accrochage de temps, faites 
glisser une région se trouvant déjà dans une 
piste vers un nouvel emplacement.

Le point de début de la région s'aligne sur le pas 
le plus proche de la grille. Si un point de 
synchronisation a été défini pour la région, il 
s'aligne sur le pas de la grille.

Menu déroulant de valeur de grille, indiquant les 
mesures et les temps (Bars:Beats)

Pour suspendre temporairement le mode 
Grid et basculer en mode Slip tout en 
déplaçant une région, appuyez sur Ctrl 
(Windows) ou Pomme (Mac).
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Points de synchronisation
Le placement des régions dans les modes Grid et 
Spot peut être basé sur la définition d'un point 
de synchronisation de la région. Les points de 
synchronisation sont utiles pour aligner un 
point donné d'une région sur la grille ou sur un 
emplacement particulier (exprimé en code 
SMPTE ou en mesures/temps). Cette fonction est 
importante pour placer des musiques et effets 
sonores sur des films et de la vidéo.

Supposons par exemple que la région audio 
d'une fermeture de porte contienne à la fois le 
grincement de la porte en train de se fermer, le 
claquement de la porte et la réverbération du 
claquement. L'utilisation d'un point de 
synchronisation pour le claquement permet de 
placer ce dernier à un endroit précis de la 
session.

Pour définir le point de synchronisation d'une 
région :

1  Activez le mode Slip (voir Modes d'édition, 
page 425).

2  Effectuez l'une des opérations suivantes :

• Cliquez avec le sélecteur sur le point d'une 
région où vous souhaitez définir le point de 
synchronisation.

– ou –

• Appuyez sur la touche fléchée vers le bas au 
cours de la lecture. 

3  Choisissez Region > Identify Sync Point. Une 
petite flèche orientée vers le bas s'affiche en bas 
de la région, avec une fine ligne grise verticale, 
pour indiquer l'emplacement du point de 
synchronisation.

Pour changer l'emplacement d'un point de 
synchronisation :

" Cliquez avec le sélecteur sur un point de la 
région, puis choisissez Region > Identify Sync 
Point. Le nouvel emplacement est identifié 
comme le point de synchronisation de la région.

Suppression des points de 
synchronisation

Pour supprimer un point de synchronisation, 
effectuez l'une des opérations suivantes :

" Sélectionnez toute la région et choisissez 
Region > Remove Sync Point.

– ou –

" A l'aide de l'outil d'accrochage de temps, 
cliquez sur le point de synchronisation à 
supprimer tout en maintenant la touche Alt 
(Windows) ou Option (Mac) enfoncée.

Affichage des points de 
synchronisation

Vous avez la possibilité d'afficher ou de masquer 
les points de synchronisation dans les régions 
audio.

Points de synchronisation

Vous pouvez également faire glisser un 
point de synchronisation. Pour plus 
d'informations, reportez-vous à la section 
Déplacement des points de synchronisation, 
page 505.

Points de synchronisation
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Pour désactiver l'affichage des points de 
synchronisation dans les régions audio :

" Désélectionnez View > Region > Sync Point.

Pour activer l'affichage des points de 
synchronisation dans les régions audio :

" Sélectionnez View > Region > Sync Point. 

Déplacement des points de 
synchronisation

Vous pouvez faire glisser un point de 
synchronisation à l'emplacement de votre choix 
dans la région audio. 

Pour définir un point de synchronisation par 
glisser-déposer :

1  Si vous souhaitez aligner le point de 
synchronisation sur la valeur de grille en cours, 
activez le mode Grid (voir Modes d'édition, 
page 425).

2  Sélectionnez l'outil d'accrochage de temps.

3  Cliquez sur le point de synchronisation et 
faites-le glisser vers un nouvel emplacement.

Scrubbing des points de 
synchronisation

Si l'affichage d'une forme d'onde audio aide à 
définir un point de synchronisation, il ne 
permet pas toujours de repérer le point de 
montage souhaité dans les données audio. 
La technique de scrubbing permet justement de 
détecter précisément l'endroit où placer le point 
de synchronisation lorsque vous le déplacez sur 
une forme d'onde audio.

Pour procéder au scrubbing tout en faisant glisser 
le point de synchronisation :

1  Si vous souhaitez aligner le point de 
synchronisation sur la valeur de grille en cours à 
la fin du scrubbing, réglez le mode d'édition sur 
Grid (voir Modes d'édition, page 425).

2  Sélectionnez l'outil de scrubbing.

3  Cliquez sur le point de synchronisation et 
faites-le glisser vers un nouvel emplacement. 
Lors de son déplacement, le point de 
synchronisation réalise un scrubbing de la 
source audio.

Déplacement par incrément 
(Nudging)
Pro Tools permet de déplacer des régions (ou des 
notes MIDI) par incrément précis à l'aide des 
touches plus (+) et moins (-) du clavier 
numérique. L'amplitude de ce déplacement est 
déterminée par la valeur spécifiée dans le menu 
déroulant Nudge Value. La fonction Nudge est 
utilisable dans n'importe quel mode d'édition.

Le déplacement par incréments peut être 
remarquablement efficace pour ajuster le 
"groove" d'une phrase musicale ou le placement 
d'un effet sonore par rapport aux autres 
éléments de la session. Pro Tools pouvant 

Scrubbing d'un point de synchronisation

Curseur de scrubbing des points de synchronisation
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déplacer des données par incrément en cours de 
lecture, vous pouvez utiliser cette fonction de 
façon continue et en temps réel pour ajuster le 
timing entre les pistes.

Le déplacement par incrément sert également à 
ajuster le placement des points d'inflexion des 
courbes d'automation. Pour plus 
d'informations, reportez-vous à la section 
Modification de l'automation, page 822.

Définition de la valeur de déplacement 
par incrément

La valeur de déplacement par incréments 
détermine l'amplitude du déplacement par 
incréments des régions et des sélections. 

Vous pouvez également déplacer par incréments 
les points de début et de fin des sélections 
(voir Déplacement par incréments des points de 
début et de fin de la sélection, page 468). 
De plus, vous pouvez rogner des régions de la 
valeur de déplacement par incréments (voir 
Rognage par incrément, page 491).

Pour définir la valeur de déplacement par 
incrément :

1  Effectuez l'une des opérations suivantes :

• Dans le menu View > Main Counter, 
sélectionnez l'échelle temporelle de la 
valeur de déplacement par incrément.

– ou –

• Pour conserver l'échelle temporelle 
principale et utiliser un format temporel 
différent pour la valeur de déplacement par 
incrément, désélectionnez l'option Follow 
Main Timebase dans le menu déroulant 
Nudge Value.

2  Spécifiez une valeur de déplacement par 
incrément en effectuant l'une des opérations 
suivantes :

• Dans le menu déroulant Nudge Value de la 
fenêtre Edit, sélectionnez la valeur de 
déplacement par incrément.

– ou –

• Pour spécifier une valeur de déplacement 
par incrément ne figurant pas dans le menu 
déroulant Nudge Value, cliquez sur 
l'indicateur correspondant, puis tapez la 
valeur.

Déplacement de régions par 
incrément (Nudging)

Pour déplacer une ou plusieurs régions par 
incrément :

1  Configurez la valeur de déplacement par 
incrément. Pour en savoir plus, reportez-vous à 
la section Définition de la valeur de 
déplacement par incrément, page 506.

2  A l'aide de l'outil d'accrochage de temps ou du 
sélecteur, sélectionnez la ou les régions, ou 
groupes de régions, que vous voulez déplacer par 
incrément. Les régions peuvent se trouver sur 
des pistes différentes. Seules les régions 
entièrement sélectionnées sont déplacées par 
incrément.

Menu déroulant Nudge Value affichant le timecode
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3  Effectuez l'une des opérations suivantes :

• Appuyez sur plus (+) sur le clavier 
numérique pour déplacer la sélection vers 
l'avant de la valeur de déplacement par 
incrément.

– ou –

• Appuyez sur la touche moins (–) du pavé 
numérique pour reculer la sélection de la 
valeur de déplacement par incrément.

La commande Nudge fonctionne de la même 
manière, quel que soit le mode d'édition. Les 
régions adjacentes sont superposées en mode 
Shuffle, la boîte de dialogue Spot ne s'ouvre pas 
en mode Spot et les données décalées ne 
s'alignent pas sur la grille en mode Grid.

Déplacement de régions par incrément 
sur plusieurs pistes et dans des pistes 
multicanaux

Lorsque vous déplacez par incrément une 
sélection de plusieurs régions, dans une seule ou 
dans plusieurs pistes contenant également des 
silences, les données d'automation résidant 
dans les silences sont également déplacées par 
incrément.

Déplacement par incrément de la valeur 
plus grande suivante

Outre le déplacement par la valeur d'incrément 
courante, vous pouvez également sélectionner 
la valeur d'incrément suivante, plus grande, 
entrée dans le menu déroulant Nudge. 

Par exemple, si la valeur de déplacement par 
incrément est réglée sur 1 image et que vous 
souhaitez une valeur plus grande, vous pouvez 
choisir comme valeur d'incrément suivante, 
plus grande, 10 images.

Pour vous déplacer par incrément vers l'avant ou 
l'arrière de la valeur plus grande suivante :

1  Activez le focus clavier sur les commandes 
(voir Focus clavier, page 22).

2  A l'aide du sélecteur ou de l'outil d'accrochage 
de temps, sélectionnez les régions ou les notes à 
déplacer par incrément.

3  Appuyez sur la barre oblique (/) pour avancer 
les données sélectionnées de la valeur 
d'incrément suivante. Appuyez sur M pour 
reculer par incrément la sélection.

Déplacement par incrément du 
contenu d'une région

Il est fréquent que le point de début d'une région 
se trouve à l'emplacement correct (valeur précise 
de timecode ou nombre de mesures), mais que 
les données de la région commencent trop tard 
ou trop tôt. Vous pouvez, en fait, déplacer par 
incrément la forme d'onde audio ou les notes 
MIDI d'une région sans en déplacer les points de 
début et de fin.

Vous pouvez également déplacer les régions 
de la valeur d'incrément suivante, sans 
activer le focus clavier sur les commandes. 
Pour ce faire, maintenez la touche Ctrl 
(Mac) ou Démarrer (Windows) enfoncée et 
appuyez sur la barre oblique (/) ou sur M.
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Ce « glissement » du contenu de la région n'est 
possible que si des données se trouvent en 
dehors des points de début et de fin de la région, 
à partir de la région rognée ou éventuellement 
capturées depuis une région plus grande.

Pour déplacer par incrément le contenu d'une 
région sans en changer les points de début et de 
fin :

1  Configurez la valeur de déplacement par 
incrément (voir Définition de la valeur de 
déplacement par incrément, page 506).

2  A l'aide de l'outil d'accrochage de temps, 
sélectionnez la région dont vous voulez déplacer 
le contenu par incrément.

3  Tout en appuyant sur Ctrl (Mac) ou sur 
Démarrer (Windows), appuyez sur plus (+) ou 
moins (–) sur le pavé numérique pour déplacer 
les données de la valeur Nudge spécifiée.

Commande Shift
La commande Shift vous permet d'avancer ou 
reculer temporellement les données de la piste, 
d'une quantité définie. La commande Shift est 
utilisable sur les sélections, les régions, les notes 
MIDI, les données de contrôleurs MIDI, et les 
points d'inflexion de l'automation.

Pour décaler une sélection ou une région :

1  A l'aide du sélecteur ou de l'outil d'accrochage 
de temps, sélectionnez les données de piste à 
décaler. Les données sélectionnées peuvent se 
trouver sur plusieurs pistes différentes.

2  Choisissez Edit > Shift. Dans la boîte de 
dialogue Shift, sélectionnez si les données 
doivent être avancées (Earlier) ou reculées 
(Later).

3  Cliquez dans l'un des champs de la base de 
temps pour spécifier la valeur de décalage 
souhaitée. Lorsque vous entrez une valeur dans 
l'un des champs de la base de temps, les autres 
sont mis à jour automatiquement.

4  Si vous voulez décaler des données avec une 
meilleure précision, vous pouvez sélectionner 
l'option Use Subframes.

5  Cliquez sur OK. Les données sont décalées, 
avant ou après, de la valeur indiquée. 

Déplacement par incrément du contenu d'une région

Le contenu de la région est déplacé, les données de 
la forme d'onde glissant à l'intérieur et hors des 
limites de la région active

avant

après

Boîte de dialogue Shift
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Si une partie d'une région était sélectionnée, de 
nouvelles régions sont créées à partir de la 
sélection et des données se trouvant hors de 
celle-ci. 

La commande Shift fonctionne de la même 
manière, quel que soit le mode d'édition. 
Par exemple, les régions adjacentes sont 
superposées en mode Shuffle, la boîte de 
dialogue Spot ne s'ouvre pas en mode Spot et les 
données décalées ne s'alignent pas sur la grille 
en mode Grid.

Quantification des régions sur 
la grille
La commande Quantize to Grid permet de régler 
le positionnement des régions MIDI et audio 
sélectionnées de sorte à aligner avec précision 
leur point de début (ou de synchronisation, le 
cas échéant) sur le pas de grille le plus proche.

Pour quantifier une ou plusieurs régions :

1  Configurez la valeur de grille (voir Définition 
de la valeur de la grille, page 502).

2  A l'aide du sélecteur ou de l'outil d'accrochage 
de temps, sélectionnez la ou les régions à 
quantifier. Les régions peuvent se trouver sur 
des pistes différentes. Seules les régions 
entièrement sélectionnées seront quantifiées.

3  Choisissez Region > Quantize to Grid. Les 
temps de début (ou les points de 
synchronisation) des régions sont alignés sur les 
pas les plus proches de la grille définie. 

Pour les régions MIDI, la quantification 
s'effectue uniquement au niveau des régions et 
toutes les données MIDI contenues dans ces 
régions (telles que les notes) sont déplacées de 
façon égale. Ces données conservent par 
conséquent leur relation rythmique. Pour 

quantifier des notes MIDI individuelles, 
sélectionnez la commande Event > MIDI 
Grid/Groove Quantize (voir Grid/Groove 
Quantize, page 675).

Verrouillage de régions
Si vous voulez associer de façon permanente une 
région ou un groupe de régions à un 
emplacement particulier d'une piste (temps, 
adresse SMPTE, ou position exprimée en 
échantillons), vous pouvez la verrouiller pour 
éviter qu'elle ne soit déplacée par accident. 
Vous ne pouvez ni déplacer, ni supprimer des 
régions verrouillées. 

Pour verrouiller (ou déverrouiller) une région :

1  A l'aide de l'outil d'accrochage de temps, 
sélectionnez la ou les régions à verrouiller (ou à 
déverrouiller). Les régions peuvent se trouver sur 
des pistes différentes.

2  Choisissez Region > Lock (ou Region > 
Unlock).

Lorsque la fonction de verrouillage est activée, 
un cadenas miniature s'affiche dans la région 
pour indiquer que celle-ci ne peut être ni 
déplacée ni supprimée. Si vous tentez d'effectuer 
des éditions qui déplaceraient une région 
verrouillée, Pro Tools vous en avertit.

En mode Shuffle, les régions verrouillées, ainsi 
que toutes les régions situées après la région 
verrouillée, ne sont pas déplacées lorsque 
d'autres régions voisines sont déplacées.

Région audio verrouillée
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Coupure/rétablissement 
des régions
Le choix de la commande Mute/Unmute Region 
coupe la lecture de la région sélectionnée. 
Si vous sélectionnez cette commande une 
deuxième fois, le son de la région est rétabli. 
Les régions coupées sont estompées pour 
indiquer leur statut.

Pour couper ou rétablir le son d'une ou de 
plusieurs régions :

1  A l'aide de l'outil d'accrochage de temps, 
sélectionnez la ou les régions dont vous 
souhaitez couper ou rétablir le son. Les régions 
peuvent se trouver sur des pistes différentes.

2  Choisissez Region > Mute/Unmute. Lorsque le 
son est coupé, les régions correspondantes sont 
estompées.

Remplacement des régions 
audio
(Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement)

La fonction Replace Region permet de remplacer 
plusieurs occurrences d'une région audio par 
une autre région dans la playlist. Cette fonction 
est utile en post-production si vous utilisez un 
effet sonore, un bruit d'ambiance ou une région 
d'atmosphère plusieurs fois au cours d'une 
session et que vous décidez ensuite de remplacer 
une ou toutes les régions d'origine par une 
région différente.

Elle est également utile dans la production 
musicale, lorsque vous voulez remplacer une 
boucle ou un échantillon donnés (par exemple 
un son de batterie) par un nouveau. Vous 
pouvez l'utiliser en composition, si vous 
connaissez le tempo d'une section ou d'une 
session, pour créer un morceau en partant de 
zéro avec des régions « brutes » de la bonne 
longueur et les remplacer plus tard par les 
régions « finales » de même longueur.

Boîte de dialogue Replace Region

Les options suivantes sont disponibles dans la 
boîte de dialogue Replace Region :

Replace: Original Region Only : remplace la 
région sélectionnée par la région de 
remplacement que vous avez fait glisser depuis 
la liste des régions.

Région audio coupée (celle du milieu)

Boîte de dialogue Replace Region
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Replace: All Instances of the Original Region : 

remplace toutes les occurrences de la région 
sélectionnée correspondant aux critères de la 
zone On par la région de remplacement de la 
liste des régions.

• On This Track : remplace les régions 
correspondant aux critères de la zone 
Match et se trouvant sur la même piste que 
la région d'origine.

• On All Tracks : remplace les régions 
correspondant aux critères de la zone 
Match pour toutes les pistes de la session.

• On Within the Selection : remplace les 
régions correspondant aux critères de la 
zone Match au sein de la sélection active.

Replace: All Regions That Match Original 
Region's : remplace toutes les régions 
correspondant aux critères des zones Match et 
On par la région de remplacement que vous avez 
fait glisser depuis la liste des régions. 

• Start Position : remplace toutes les régions 
possédant le même temps de début que la 
région sélectionnée. Ceci inclut les régions 
ayant été créées automatiquement lors du 
rognage des points de fin.

• End Position : remplace toutes les régions 
possédant le même temps de fin que la 
région sélectionnée. Ceci inclut les régions 
ayant été créées automatiquement lors du 
rognage des points de début.

• Name : remplace toutes les régions 
provenant du même fichier audio et 
renommées de la même manière.

• On This Track : remplace les régions 
correspondant aux critères de la zone 
Match et se trouvant sur la même piste que 
la région d'origine.

• On All Tracks : remplace les régions 
correspondant aux critères de la zone 
Match pour toutes les pistes de la session.

• On Within the Selection : remplace les 
régions correspondant aux critères de la 
zone Match au sein de la sélection active.

La correspondance des régions utilise tous les 
critères de la zone Match spécifiés. Par exemple, 
si vous sélectionnez Start Position et End 
Position, toutes les régions issues du même 
fichier audio d'origine que votre sélection et 
possédant les mêmes temps de début et de fin 
seront remplacées.

Fit Region Using The: Original Region Length : 
si la région de remplacement est plus petite que 
la région d'origine, elle est placée dans la playlist 
et toute donnée audio restante de la région 
d'origine est supprimée. 

Si la région de remplacement est plus grande que 
la sélection, elle est placée dans la playlist et 
rognée pour correspondre à la longueur de la 
région d'origine.

Fit Region Using The: Original Selection Length : 
si la région de remplacement s'étend au-delà de 
la région d'origine, elle est rognée (si elle est plus 
grande que la région d'origine) pour 
correspondre à la sélection.

Fit Region Using The: Replacement Region 
Length : la région de remplacement est placée 
dans son intégralité, quelle que soit la durée de 
la région ou de la sélection d'origine.

Pour remplacer des régions :

1  Sélectionnez dans la playlist de la piste une 
région que vous voulez remplacer. La sélection 
peut s'étendre au-delà du point de fin de la 
région et inclure des données provenant d'une 
région de remplacement plus longue que la 
région d'origine.
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2  Faites glisser la région de remplacement de la 
liste des régions vers la région sélectionnée en 
maintenant enfoncées les touches Pomme+Maj 
(Mac) ou Ctrl+Maj (Windows). La boîte de 
dialogue Replace Region s'ouvre.

3  Configurez la boîte de dialogue Replace 
Region (voir Boîte de dialogue Replace Region, 
page 510).

4  Cliquez sur OK.

Remplacement de régions de la liste 
des régions

La commande Replace Region est également 
disponible dans le menu contextuel Region List. 
Avant de l'utiliser, assurez-vous d'avoir 
sélectionné une région sur une piste ainsi 
qu'une région de remplacement dans la liste des 
régions. 

Pour remplacer des régions à l'aide du menu 
déroulant de la liste des régions :

1  Sélectionnez la région à remplacer sur une 
piste. 

2  A l'aide de la souris, sélectionnez la région de 
remplacement souhaitée dans la liste des régions 
tout en maintenant la touche Pomme (Mac) ou 
Ctrl (Windows) enfoncée. (Maintenez la touche 
Ctrl enfoncée uniquement si l'option Region 
List Selection Follows Edit Selection est activée 
dans la page des préférences d'édition.) 

3  Choisissez Replace Region dans le menu 
déroulant de la liste des régions. 

4  Configurez la boîte de dialogue Replace 
Region (voir Boîte de dialogue Replace Region, 
page 510).

5  Cliquez sur OK.

Remplacement des régions et pistes 
multicanaux

La commande Replace Region permet de faire 
glisser des régions multicanaux à partir de la 
liste des régions vers des pistes multicanaux, à 
condition que le format des canaux soit 
identique. Par exemple, vous pouvez remplacer 
une région stéréo sélectionnée dans une piste 
audio stéréo par une autre région stéréo de la 
liste des régions. En revanche, vous ne pouvez 
pas la remplacer par deux régions audio mono. 
De même, vous ne pouvez pas remplacer des 
régions de plusieurs pistes mono par des régions 
multicanaux.

Régions audio des appareils 
d'enregistrement portables
Pro Tools contient des outils de remplacement 
de région spécialement conçus pour les travaux 
d'enregistrement effectués hors studio. Vous 
pouvez ainsi remplacer les régions d'une piste 
audio dont les données sont importées d'un 
appareil d'enregistrement portable par d'autres 
canaux et développer plusieurs canaux sur de 
nouvelles pistes.

Pour ouvrir la boîte de dialogue Replace 
Region sans créer de sélection au préalable, 
maintenez enfoncées les touches 
Pomme+Maj (Mac) ou Ctrl+Maj 
(Windows) et faites glisser une région de la 
liste des régions vers une région de piste non 
sélectionnée.
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Remplacement d'une région par 
un autre canal
(Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement)

Pro Tools contient des outils de remplacement 
de région spécialement conçus pour les travaux 
d'enregistrement effectués hors studio. 
Vous pouvez remplacer une région mono (ou 
une partie d'une région mono) par un segment 
équivalent d'un autre canal enregistré en 
simultané. Les fondus appliqués à la région 
d'origine sont automatiquement recalculés par 
rapport à la région de remplacement et les 
automations définies sur la piste sont 
conservées.

Pour remplacer une région par un autre canal 
équivalent :

1  Dans la timeline, créez une sélection incluant 
ou chevauchant la région ou la fraction de 
région à remplacer.

2  Effectuez l'une des opérations suivantes :

• Sélectionnez un outil d'édition, cliquez 
avec le bouton droit de la souris (Windows 
ou Mac) ou cliquez en maintenant la 
touche Ctrl enfoncée (Mac) sur la sélection 
à remplacer, puis sélectionnez la 
commande Matches dans le menu 
contextuel.

– ou –

• Avec le sélecteur, cliquez sur la sélection à 
remplacer en maintenant enfoncée la 
touche Ctrl (Windows) ou Pomme (Mac).

Le sous-menu Matches s'affiche et répertorie les 
canaux de remplacement équivalents sous 
l'en-tête Channels. (L'en-tête Alternates de ce 
sous-menu affiche également les prises de 
remplacement disponibles.)

3  Dans le sous-menu Matches, sélectionnez le 
nom de la région de remplacement de la région 
d'origine.

4  Répétez cette procédure pour chacune des 
régions à remplacer sur la piste.

Conditions de disponibilité des canaux 
de remplacement

Pour qu'un canal puisse remplacer un canal 
d'origine (représenté par une région ou une 
fraction de région sélectionnée sur la timeline), 
toutes les conditions suivantes doivent être 
remplies :

• Les deux canaux font partie du même 
groupe multicanaux correspondant à un 
enregistrement effectué en simultané sur 
un ou plusieurs appareils portables.

• Certaines métadonnées du canal d'origine 
correspondent à celles du canal de 
remplacement.

Pour plus d'informations sur l'utilisation 
d'enregistrements multicanaux effectués 
avec des appareils portables, reportez-vous 
au manuel Field Recorder Workflow Guide.

Sélection d'un autre canal d'un groupe de canaux pour 
le remplacement d'une région
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• Les métadonnées imbriquées lors du 
tournage ou de l'enregistrement ont été 
conservées avant l'importation dans 
Pro Tools.

Si les enregistrements multicanaux proviennent 
d'un ou de plusieurs appareils portables, les deux 
canaux doivent se chevaucher au moins une fois 
entre les positions de timecode de début et de 
fin, et doivent remplir l'une des conditions 
suivantes :

• scène et prise identiques ;

• date de tournage identique (uniquement si 
la scène et la prise contiennent des 
informations concernant les deux 
canaux) ;

• nom de bande identique ;

• nom de bande son identique ;

• nom de bande son du canal de 
remplacement identique au nom de bande 
du canal actuel ;

• nom de bande du canal de remplacement 
identique au nom de bande son du canal 
actuel.

Développement de canaux de 
remplacement vers de nouvelles 
pistes
(Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement)

Lorsque vous travaillez sur une région mono 
appartenant à un enregistrement multicanaux, 
vous pouvez développer cette région (ou une 
fraction de cette région) sur de nouvelles pistes 
reflétant les canaux de remplacement 
correspondants tout en conservant les 
modifications et les fondus. 

Cette fonction permet par exemple de créer 
facilement différentes versions d'une piste 
modifiée correspondant à plusieurs entrées de 
canal (microphones) enregistrées en simultané.

Pour développer des canaux de remplacement sur 
de nouvelles pistes :

1  Dans la timeline, effectuez l'une des 
opérations suivantes :

• Pour développer uniquement une partie 
des régions de la piste, créez une sélection 
comprenant ou chevauchant le nombre de 
régions souhaité, puis cliquez sur la 
sélection à l'aide du bouton droit de la 
souris (Windows ou Mac) ou en 
maintenant la touche Ctrl enfoncée (Mac).

– ou –

• Pour développer toutes les régions d'une 
piste, cliquez sur le nom de la piste à l'aide 
du bouton droit de la souris (Windows ou 
Mac) ou en maintenant la touche Ctrl 
enfoncée (Mac).

2  Dans le menu contextuel qui s'affiche, 
sélectionnez la commande Expand to New 
Tracks, puis choisissez la méthode de 
développement des canaux de remplacement de 
la sélection sur les nouvelles pistes :

• By Channel Name

• By Channel Number

• By Channel Name and Number

Les canaux de remplacement 
correspondants sont des canaux mono 
enregistrés en même temps que la région 
d'origine (par exemple, des enregistrements 
multicanaux effectués à partir d'un ou de 
plusieurs appareils portables). Pour plus 
d'informations sur les critères auxquels 
doivent répondre les canaux de 
remplacement, reportez-vous au manuel 
Field Recorder Workflow Guide.
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Si des canaux de remplacement sont 
disponibles, Pro Tools les développe sur de 
nouvelles pistes (y compris le canal représenté 
dans la piste d'origine) en fonction des 
paramètres sélectionnés.

Commandes d'édition
Pro Tools contient de nombreuses commandes 
d'édition standard (par exemple, couper, copier 
et coller). Pro Tools offre également des 
commandes d'édition spécialisées optimisées 
pour la production audio et MIDI (par exemple, 
la commande de répétition du collage 
permettant de remplir une sélection).

Couper, copier, coller et 
supprimer

Les commandes couper, copier, coller et 
supprimer permettent de réorganiser et d'éditer 
les données des pistes. Les éditions peuvent 
s'appliquer à des régions entières sélectionnées à 
l'aide de l'outil d'accrochage de temps ou sur des 
plages d'une piste sélectionnées à l'aide du 
sélecteur. Les éditions peuvent également 
s'appliquer à plusieurs pistes (voir Edition sur 
plusieurs pistes, page 520).

Vue de la piste et contenu d'édition

Lorsque vous coupez ou copiez les données 
d'une piste, la vue de la piste détermine le type 
de données placées dans le presse-papiers. 
Lorsque vous affichez des formes d'onde pour les 
pistes audio ou bien des pistes MIDI ou 
d'instrument en vue Notes ou Regions, les 
sélections incluent toutes les données 
sous-jacentes d'automation et de contrôleur. 
Ainsi, lorsque vous coupez une région audio, les 
données d'automation de niveau, de 
panoramique, de coupure, de signal de départ 
ou de plug-in de la piste sont également 
coupées. Ceci vous évite de couper 
individuellement dans chaque playlist 
d'automation de la piste.

Développement d'une sélection sur de nouvelles pistes

Pour plus d'informations concernant le 
fonctionnement de ces différentes options 
lors du développement sur de nouvelles 
pistes, reportez-vous au manuel Field 
Recorder Workflow Guide.

Résultat du développement d'une sélection sur de 
nouvelles pistes

Vous pouvez couper, copier et coller des 
régions non contiguës à l'aide de l'outil de 
saisie d'objet.
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Cependant, lorsque vous sélectionnez des 
groupes de notes MIDI avec la main 
(en dessinant un rectangle autour), seules les 
données correspondant aux notes sont placées 
dans le presse-papiers. Lorsque vous 
sélectionnez une plage temporelle de notes 
MIDI avec le sélecteur, toutes les données de 
contrôleur contenues dans la piste sont 
sélectionnées (comme pour la sélection de pistes 
audio avec le sélecteur dans la vue Waveform).

Lorsqu'une piste affiche des données 
d'automation ou de contrôleur, seules ces 
données sont placées dans le presse-papiers. De 
plus, chaque fois que vous coupez ou copiez des 
données d'automation, des points d'inflexion 
limites sont créés à chaque extrémité de la zone 
sélectionnée, afin de conserver la pente de 
l'automation à la fois à l'intérieur et hors de la 
sélection.

Si des pistes sont groupées, le copier-coller sur 
n'importe quelle piste a une incidence sur les 
autres pistes du groupe. Les pistes masquées, 
même si elles appartiennent à un groupe en 
cours d'édition, ne sont pas concernées par 
l'édition.

Le mode d'édition a une influence sur la 
sélection, la copie et le collage des données :

• En mode Slip, la commande Couper laisse un 
espace vide correspondant aux données 
supprimées de la piste. 

• En mode Slip, les données collées peuvent se 
superposer à une région adjacente.

• En mode Shuffle, la commande Couper ne 
laisse pas d'espace vide, les régions situées à 
droite de celle coupée se décalant pour remplir 
le trou. 

• En mode Shuffle, toutes les régions se décalent 
de la distance nécessaire pour laisser la place 
aux régions collées.

Les régions sont souvent créées 
automatiquement lors des éditions. Lorsque 
vous supprimez, par exemple, une sélection 
d'une région, de nouvelles régions sont créées 
automatiquement à partir des données résidant 
hors de la sélection.

Commandes Cut et Copy

La commande Cut permet de supprimer une 
sélection d'une piste et de la placer dans le 
presse-papiers.

La commande Copy place une copie de la 
sélection dans le presse-papiers pour pouvoir la 
coller dans une autre piste ou dans la même 
piste à un emplacement différent, sans que la 
sélection d'origine ne soit modifiée ou déplacée.

Pour couper ou copier une sélection ou une 
région :

1  Pour restreindre la sélection en fonction du 
pas de grille actuel, réglez le mode d'édition sur 
Grid. 

2  Définissez la vue des pistes que vous voulez 
éditer.

Données d'une forme d'onde audio

Données d'automation (données de type point 
d'inflexion) avec région audio coupée et collée
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Lorsque vous affichez des formes d'onde pour les 
pistes audio ou des notes ou des régions pour les 
pistes MIDI, les sélections incluent les données 
sous-jacentes d'automation et de contrôleur. 
Lorsqu'une piste affiche des données 
d'automation, seules ces données sont 
concernées par les éditions.

3  Créez une sélection d'édition des données à 
couper ou à copier.

4  Effectuez l'une des opérations suivantes :

• Choisissez Edit > Cut pour supprimer la 
sélection et la placer dans le presse-papiers.

– ou –

• Choisissez Edit > Copy pour placer la 
sélection dans le presse-papiers sans la 
supprimer.

Si une partie d'une région a été coupée ou 
copiée, les données du presse-papiers 
s'inscrivent dans la liste des régions, en tant que 
nouvelle région. Si une partie d'une région a été 
coupée, de nouvelles régions sont créées 
automatiquement à partir des données se 
trouvant hors de la sélection. 

Lorsque le mode Shuffle est activé, les régions 
suivantes sont déplacées de manière à remplir 
l'espace vide.

Suppression des données sous-jacentes de la 
région

Lorsque vous supprimez une région ou une 
sélection, vous pouvez également supprimer ou 
conserver les données sous-jacentes de la région.

Pour supprimer une région ou une sélection et les 
données sous-jacentes de la région :

" Choisissez Edit > Cut.

Pour supprimer une région ou une sélection sans 
supprimer les données sous-jacentes de la région :

" Choisissez Edit > Clear.

Commande Paste

La commande Paste place le contenu du 
presse-papiers au point d'insertion de l'édition, 
en remplaçant les données déjà présentes.

Pour coller une sélection ou une région :

1  Pour restreindre le point d'insertion ou la 
sélection en fonction du pas de grille actuel, 
réglez le mode d'édition sur Grid. 

2  Effectuez l'une des opérations suivantes :

• A l'aide du sélecteur, cliquez dans la piste, à 
l'endroit où vous souhaitez coller les 
données.

– ou –

• A l'aide du sélecteur ou de l'outil 
d'accrochage de temps, effectuez une 
sélection à l'endroit où les données seront 
placées.

3  Choisissez Edit > Paste.

Si vous effectuez le collage à un point d'insertion 
en mode Shuffle, les données situées à droite du 
point se décalent vers la droite. En mode Slip, les 
données sont remplacées.

Si vous effectuez le collage dans une sélection en 
mode Shuffle, la sélection est remplacée par le 
contenu du presse-papiers et les données 
adjacentes se décalent à gauche ou à droite de la 
durée nécessaire. En mode Slip, la sélection est 
également remplacée mais les données 
adjacentes demeurent inchangées.
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Commande Clear

La commande Clear permet de supprimer une 
sélection d'une piste sans la placer dans le 
presse-papiers.

Pour supprimer une sélection d'une région :

1  Pour restreindre la sélection en fonction du 
pas de grille actuel, réglez le mode d'édition sur 
Grid. 

2  Définissez la vue des pistes que vous voulez 
éditer.

Lorsque vous affichez des formes d'onde pour les 
pistes audio ou des notes ou des régions pour les 
pistes MIDI, les sélections incluent les données 
sous-jacentes d'automation et de contrôleur. 
Lorsqu'une piste affiche des données 
d'automation, seules ces données sont 
concernées par les éditions.

3  Effectuez une sélection d'édition.

4  Choisissez Edit > Clear pour supprimer la 
sélection.

Si une partie d'une région a été supprimée, de 
nouvelles régions sont créées automatiquement 
à partir des données se trouvant hors de la 
sélection. Lorsque le mode Shuffle est activé, les 
régions suivantes sont déplacées de manière à 
remplir l'espace vide.

Commandes spéciales couper, 
copier, coller et supprimer

Les commandes « spéciales » du menu Edit 
(Cut Special, Copy Special, Paste Special et Clear 
Special) permettent de couper, de copier, de 
coller et de supprimer des automations 
(automation du volume, du panoramique, de la 
coupure de son et des plug-in) de pistes audio, 
du VCA principal, d'entrée auxiliaire, 
d'instrument et de fader principal. Vous pouvez 
utiliser également ces commandes pour les 
données du contrôleur MIDI sur des pistes MIDI 
et d'instrument.

Cut Special

Les commandes Cut Special permettent de 
couper uniquement les données d'automation 
de la sélection actuelle (sans les notes audio, 
vidéo ou MIDI associées) et de les placer en 
mémoire pour les coller à un autre emplacement 
de l'une des manières suivantes :

All Automation : coupe toutes les données 
d'automation ou du contrôleur MIDI, affichées 
ou non.

Pan Automation : coupe uniquement les 
données de panoramique MIDI ou 
d'automation de panoramique, affichées ou 
non.

Plug-In Automation : coupe uniquement les 
données d'automation de plug-in affichées.

Lorsque vous travaillez avec des données 
MIDI, vous pouvez fusionner le contenu du 
presse-papiers avec les données de la piste 
de destination. Pour plus d'informations, 
reportez-vous à la section Merge :, 
page 519.

Vous ne pouvez pas coller des données du 
contrôleur MIDI sur des données 
d'automation, et inversement.
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Copy Special

Les commandes Copy Special vous permettent 
de copier uniquement les données d'automation 
de la sélection actuelle (sans les notes audio, 
vidéo ou MIDI associées) et d'en placer une 
copie en mémoire pour les coller à un autre 
emplacement.

All Automation : copie toutes les données 
d'automation ou du contrôleur MIDI, affichées 
ou non. 

Pan Automation : copie uniquement les données 
de panoramique MIDI ou d'automation de 
panoramique, affichées ou non.

Plug-In Automation : copie uniquement les 
données d'automation de plug-in affichées.

Paste Special

Les commandes Paste Special vous permettent 
de coller des données d'automation dans une 
autre région (sans que cela affecte les notes 
audio, vidéo ou MIDI) d'une des manières 
suivantes : 

Merge : colle les données du contrôleur MIDI 
depuis le presse-papiers vers la sélection et les 
fusionne avec les données du contrôleur MIDI 
actif ou au point d'insertion. Cette fonction 
permet de regrouper dans une piste MIDI 
unique des données MIDI provenant de 
plusieurs pistes.

Repeat to Fill Selection : copie plusieurs 
itérations de données audio, vidéo ou MIDI à 
partir du presse-papiers de manière à remplir la 
sélection. Si vous sélectionnez une zone dont la 
taille n'est pas un multiple exact de celle de la 
région copiée, la partie restante de la sélection 
est remplie par une version rognée de la 
sélection d'origine. Cette fonction permet de 

créer facilement des boucles de batterie et autres 
effets répétitifs. Avant de coller les données, 
Pro Tools vous invite à spécifier un crossfade 
pour lisser les transitions entre les régions. 

To Current Automation Type : colle les données 
d'automation ou de contrôleur MIDI du 
presse-papiers sur la sélection, ou au point 
d'insertion, en tant que données de type 
d'automation actuel ou de contrôleur MIDI 
continues. Cette fonctionnalité permet de 
copier un type de données d'automation sur un 
autre ou un type de données MIDI continues sur 
un autre type de données MIDI contiguës.

Clear Special

Les commandes Clear Special permettent 
d'effacer uniquement les données d'automation 
de la région actuelle. Les choix possibles sont :

All Automation : supprime toutes les données 
d'automation ou du contrôleur MIDI, affichées 
ou non.

Pan Automation : efface uniquement les 
données d'automation de panoramique ou les 
données de panoramique MIDI, affichées ou 
non.

Plug-In Automation : supprime uniquement les 
données d'automation de plug-in affichées.

Pour plus d'informations sur l'utilisation 
des données d'automation, reportez-vous au 
chapitre 30, Automation.
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Repeat to Fill Selection

La commande Repeat to Fill Selection permet de 
remplir automatiquement une sélection avec 
des régions ou des données audio ou MIDI sans 
vous obliger à dupliquer manuellement les 
régions. Pour utiliser cette fonctionnalité, 
coupez ou copiez une région, créez une 
sélection, puis sélectionnez la commande pour 
remplir la sélection. Lorsque vous collez des 
régions audio, vous êtes invité à paramétrer le 
crossfade à utiliser. 

Si vous remplissez une zone dont la taille est un 
multiple exact de celle de la région copiée (si, 
par exemple, vous remplissez 16 mesures avec 
une région de 4 mesures), la sélection copiée est 
collée autant de fois que nécessaire pour remplir 
la sélection. Si vous remplissez une zone qui 
n'est pas un multiple exact de la taille de la 
région copiée (si, par exemple, vous remplissez 
15 secondes avec une région de 2 secondes de 
bruit d'ambiance), la zone de sélection restante 
est remplie par une version automatiquement 
rognée de la sélection d'origine.

Pour remplir une sélection à l'aide de la 
commande Repeat to Fill Selection :

1  Sélectionnez la région à copier.

2  Choisissez Edit > Copy.

3  Sélectionnez la zone à remplir à l'aide du 
sélecteur, puis choisissez Edit > Paste Special > 
Repeat to Fill Selection.

4  Effectuez l'une des opérations suivantes :

• Si vous collez des régions audio dans des 
zones plus grandes, la boîte de dialogue 
Batch Fades s'ouvre. Configurez la boîte de 
dialogue pour créer des crossfades entre 
chaque région collée, puis cliquez sur OK.

– ou –

• Si vous ne voulez pas de crossfades pour les 
données audio collées, cliquez sur Cancel 
dans la boîte de dialogue Batch Fades.

Edition sur plusieurs pistes

Lorsque vous travaillez avec des données de 
plusieurs pistes, vous devez prendre en 
considération un certain nombre de points 
importants. Par exemple, si des pistes 
sélectionnées sont réglées sur leur vue principale 
(voir Vues principales des pistes, page 397), les 
éditions concernent non seulement les données 
MIDI et audio des pistes sélectionnées, mais 
également toutes les données d'automation et de 
contrôleur.

Si toutes les pistes sélectionnées s'affichent sous 
forme de données d'automation, les éditions ne 
concernent que le type de données 
d'automation affiché dans chaque piste. 
De plus, si la piste 1 affiche l'automation du 
panoramique, la piste 2 affiche l'automation du 
niveau et la piste 3 affiche l'automation de 
coupure, la commande Cut coupe uniquement 
les données de panoramique de la piste 1, les 
données de volume de la piste 2 et les données 
de coupure de la piste 3.

Pour copier tous les types d'automation sur toutes 
les pistes sélectionnées lors de la copie des 
données d'automation ou de contrôleur :

" Maintenez enfoncée la touche Démarrer 
(Windows) ou Ctrl (Mac) et sélectionnez Edit > 
Copy Special > All Automation.

Pour plus d'informations sur la sélection de 
données sur plusieurs pistes, reportez-vous à 
la section Sélection sur plusieurs pistes, 
page 470
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Pour coller plusieurs pistes :

1  Effectuez l'une des opérations suivantes :

• Positionnez le point d'insertion dans 
chaque piste de destination. Pour ce faire, 
maintenez la touche Maj enfoncée, puis 
cliquez sur les différents points d'insertion.

• Cliquez dans une piste en maintenant 
enfoncées les touches Alt+Maj (Windows) 
ou Option+Maj (Mac) pour sélectionner 
toutes les pistes.

• Créez une sélection dans l'une des règles 
temporelles.

2  Choisissez Edit > Paste.

Lorsque vous collez plusieurs types de données, 
toute donnée copiée est collée dans le type de 
playlist qui lui correspond. Les données 
d'automation sont collées dans la playlist 
d'automation correspondante. Les données 
audio ou MIDI sont collées dans la playlist audio 
ou MIDI. Il n'est pas nécessaire de définir les 
pistes de destination en fonction du type de 
données à coller.

Si toutes les pistes de destination d'un collage 
multipiste sont affichées sous forme 
d'automation, le collage remplace les données 
précédentes de la piste cible sans shuffling, que 
vous soyez en mode Slip ou Shuffle.

Commande Duplicate
La commande Duplicate copie une sélection et 
la place immédiatement après la fin de la 
sélection. Bien qu'elle soit similaire aux 
commandes Copy et Paste, la commande 
Duplicate est plus pratique et plus rapide, en 
particulier lorsque vous travaillez avec des 
données réparties sur plusieurs pistes. 

Pour effectuer plusieurs copies d'une sélection, 
utilisez la commande Repeat (voir Commande 
Repeat, page 522). Vous pouvez également 
activer la lecture en boucle des régions (voir 
Mise en boucle de régions, page 534).

Comme avec les commandes Copy et Paste, un 
certain nombre de règles s'appliquent lorsque 
vous dupliquez des données sur plusieurs pistes 
(voir Edition sur plusieurs pistes, page 520).

Pour dupliquer une sélection ou une région :

1  Si vous travaillez avec des données basées sur 
les mesures:temps, telles que des boucles, 
définissez l'échelle temporelle principale sur 
Bars:Beats.

2  Pour restreindre la sélection en fonction du 
pas de grille actuel, réglez le mode d'édition sur 
Grid. 

3  Effectuez une sélection d'édition.

4  Choisissez Edit > Duplicate. Les données sont 
placées immédiatement après le point de fin de 
la sélection.

En mode Shuffle, les données dupliquées sont 
placées directement après la fin de la sélection. 
Les régions qui se trouvent après sont décalées 
pour laisser la place aux données dupliquées. 
En mode Slip, les données dupliquées se 
superposent aux données adjacentes.
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Lorsque vous utilisez les commandes Duplicate 
(ou Repeat) avec des notes MIDI sélectionnées 
via l'outil d'accrochage de temps, les données 
sont toujours dupliquées une mesure plus tard 
et fusionnées avec les données existantes de la 
piste (au lieu de les remplacer).

Duplication de données audio

Lorsque vous utilisez les commandes Duplicate 
(ou Repeat) avec des données audio qui doivent 
tomber parfaitement sur le temps (comme les 
boucles rythmiques), il est important de 
sélectionner les données audio à l'aide du 
sélecteur ou en tapant les points de début et de 
fin dans la zone Event Edit. Si vous sélectionnez 
une région audio à l'aide de l'outil d'accrochage 
de temps (ou en cliquant deux fois sur la région 
avec le sélecteur), les données peuvent être 
décalées de plusieurs tics du fait de l'arrondi à 
l'échantillon le plus proche.

Par ailleurs, si vous souhaitez dupliquer (ou 
répéter) des données audio qui ne sont pas 
basées sur les mesures:temps, réglez l'échelle 
temporelle sur un autre format que Bars:Beats. 
Cela permet d'attribuer aux données audio 
dupliquées le nombre correct d'échantillons et 
de les placer précisément.

Commande Repeat
Similaire à la commande Duplicate, la 
commande Repeat permet en outre de préciser le 
nombre de duplications des données.

Comme avec les commandes Copy et Paste, un 
certain nombre de règles s'appliquent lorsque 
vous répétez des données sur plusieurs pistes 
(voir Edition sur plusieurs pistes, page 520).

Vous pouvez coller plusieurs fois des données 
afin de remplir toute une sélection (voir Repeat 
to Fill Selection, page 520).

Vous pouvez également activer la lecture en 
boucle des régions (voir Mise en boucle de 
régions, page 534).

Pour répéter une sélection ou une région :

1  Si vous travaillez avec des données basées sur 
les mesures:temps, telles que des boucles, 
définissez l'échelle temporelle principale sur 
Bars:Beats.

2  Pour restreindre la sélection en fonction du 
pas de grille actuel, réglez le mode d'édition 
sur Grid. 

3  Effectuez une sélection d'édition.

4  Choisissez Edit > Repeat. Dans la boîte de 
dialogue Repeat, entrez le nombre de répétitions 
des données et cliquez sur OK.

Les données sont placées immédiatement après 
le point de fin de la sélection et dupliquées 
autant de fois que vous l'avez indiqué.

En mode Shuffle, les données répétées sont 
placées directement après la fin de la sélection. 
Les régions qui se trouvent après sont décalées 
pour laisser la place aux données répétées. En 
mode Slip, les données répétées se superposent 
aux données suivantes.

Boîte de dialogue Repeat
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Edition de pistes stéréo et 
multicanaux
Les régions se trouvant sur des canaux 
individuels au sein de pistes stéréo et 
multicanaux ne peuvent être sélectionnées de 
façon indépendante. Toutes les sélections sur 
ces pistes sont basées sur le temps, ce qui signifie 
que les régions sélectionnées avec le sélecteur ou 
l'outil d'accrochage de temps s'étendent à 
chaque canal de la piste.

Lorsque des régions de pistes multicanaux sont 
éditées avec l'outil de trimming ou déplacées 
avec l'outil d'accrochage de temps, les données 
de chaque canal sont affectées de la même 
manière.

Division des pistes sélectionnées

Pour éditer un canal spécifique d'une piste 
stéréo ou multicanal sans intervenir sur les 
autres canaux, vous pouvez la diviser en 
plusieurs pistes mono. Lorsque vous avez 
effectué vos éditions sur les données séparées, 
vous pouvez les déplacer ou les copier vers la 
piste multicanal d'origine.

Pour diviser une piste stéréo ou multicanal :

1  Sélectionnez une ou plusieurs pistes stéréo ou 
multicanaux (voir Sélection des pistes, 
page 149). 

2  Choisissez Track > Split Into Mono. 
Les régions provenant des canaux sur les pistes 
sélectionnées sont placées sur de nouvelles 
pistes audio mono.

Les noms des nouvelles pistes sont basés sur 
celui de la piste source et sur le suffixe du canal. 
Par exemple, après division d'une piste stéréo 
nommée « Funkit », deux nouvelles pistes 
baptisées « Funkit.L » et « Funkit.R » sont créées.

Les affectations de sortie et des signaux de 
départs ainsi que les paramètres de volume et de 
panoramique sont conservés dans les nouvelles 
pistes. Des équivalents mono des affectations de 
plug-in stéréo et multimono sont attribués aux 
nouvelles pistes. Cependant, les plug-in 
multicanaux ne sont pas affectés aux nouvelles 
pistes.

Déplacement de régions vers et à partir 
des pistes stéréo et multicanaux

Lors du déplacement de régions vers et à partir 
des pistes stéréo ou multicanaux, les règles 
suivantes s'appliquent :

! Si le nombre de pistes et de canaux sont 
identiques pour la source et la destination, vous 
pouvez déplacer des régions entre des pistes 
multicanaux et des pistes mono.

! La source et la destination des régions 
déplacées peuvent être mélangées. Par exemple, 
vous pouvez déplacer des régions d'une piste 5.0 
(contenant cinq canaux) vers une piste stéréo et 
trois pistes audio mono.

! Lorsque vous déplacez des régions 
multicanaux vers des pistes mono, les pistes de 
destination doivent être adjacentes.

! Lorsque vous déplacez des régions depuis des 
pistes mono vers une piste multicanal, les pistes 
source peuvent ne pas être adjacentes.

Déplacement d'une région stéréo vers deux pistes 
audio mono
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Les régions multicanaux peuvent également être 
déplacées de la liste des régions vers des pistes 
multicanaux de même format, des groupes de 
pistes audio mono ou une combinaison 
des deux. 

Inversement, un ensemble de régions mono 
uniques peut être déplacé de la liste des régions 
vers des pistes multicanaux, à condition que le 
nombre de régions déplacées corresponde au 
nombre de canaux de la piste de destination.

Traitement audio avec les 
plug-in AudioSuite
Les plug-in AudioSuite qui accompagnent votre 
système Pro Tools permettent de traiter et de 
modifier des régions audio ainsi que des fichiers 
audio complets. Ce type d'opération permet 
d'appliquer un traitement AudioSuite particulier 
aux régions audio de votre session, tel que la 
normalisation ou la suppression de composante 
continue.

Réparation de la forme d'onde 
avec le crayon
Le crayon permet de « redessiner » de façon 
destructive les données de la forme d'onde. Cet 
outil est couramment utilisé pour réparer un 
bruit ou un clic dans un fichier audio. Un clic 
apparaît sous la forme d'une pointe soudaine et 
franche dans une forme d'onde. Cet outil n'est 
actif que lorsque la fenêtre Edit effectue un 
zoom au niveau de l'échantillon.

Bien que vous puissiez annuler la modification 
du crayon, il est conseillé de créer une copie de 
sauvegarde de l'audio cible avant d'utiliser le 
crayon. Vous pouvez le faire en utilisant le 
plug-in AudioSuite Duplicate.

Pour éditer de façon destructive une forme d'onde 
audio avec le crayon :

1  Recherchez la zone que vous souhaitez éditer.

2  A l'aide du Zoom ou des boutons de zoom, 
faites un zoom à l'échelle de l'échantillon de 
façon à afficher la forme d'onde comme une 
ligne continue fine. Réglez la hauteur de la piste 
pour éditer la forme d'onde avec la précision 
voulue. Pour augmenter la résolution visuelle, 
vous pouvez également effectuer un zoom 
vertical.

3  Sélectionnez le crayon.

4  Dessinez avec précaution la zone désirée de la 
forme d'onde à l'aide du crayon.

Pour plus d'informations sur les plug-in 
AudioSuite, consultez le Guide des plug-in 
DigiRack.

Le crayon est un outil d'édition destructif 
qui modifie définitivement le fichier audio 
sur le disque et doit être utilisé avec 
beaucoup de précautions.

Pour plus d'informations sur le plug-in 
Duplicate d'AudioSuite, consultez le Guide 
des plug-in DigiRack.

Vous pouvez rappeler des niveaux de zoom à 
l'aide de boutons de présélection de zoom 
(voir Utilisation des outils de zoom, 
page 429) ou d'emplacements mémoire 
(voir Emplacements mémoire et marqueurs, 
page 605).

Crayon
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Pour des résultats satisfaisants, prenez soin de ne 
pas déborder. Vous avez toutefois la possibilité 
d'annuler votre dernière édition à l'aide de la 
commande Undo.

Essayez de limiter l'édition à une toute petite 
zone, et veillez à ce que vos "corrections" soient 
adaptées à la forme de la forme d'onde 
environnante. 

Groupes de régions
Un groupe de régions est un ensemble formé de 
plusieurs régions audio et MIDI qui s'affiche et 
agit comme une région unique. Les groupes de 
régions servent essentiellement de conteneur à 
une ou plusieurs régions. Les groupes de régions 
peuvent être créés sur une ou plusieurs pistes 
adjacentes audio, MIDI et d'instrument. 
Ils permettent de rassembler plusieurs régions 
en une macrorégion et facilitent ainsi la 
manipulation, l'édition et l'organisation des 
ambiances et du tempo. 

Sur les pistes, vous pouvez les placer à côté de 
régions standard et les modifier à l'aide des 
mêmes techniques d'édition de Pro Tools. 
Certaines modifications effectuées sur un 
groupe, telles que la coupure ou la suppression, 

s'appliquent à toutes les régions qu'il englobe. 
D'autres, telles que le rognage, ne s'appliquent 
qu'aux limites du groupe et n'ont aucune 
incidence sur les régions sous-jacentes.

Chaque groupe de régions est enregistré en 
même temps que la session dans un fichier .rgrp. 
Les fichiers de groupes de régions peuvent être 
exportés et importés entre plusieurs sessions 
Pro Tools.

Les groupes de régions s'utilisent notamment 
dans le cadre des opérations suivantes :

• Groupement d'une région audio basée sur des 
références temporelles, ayant été divisée en 
une multitude de petites régions à l'aide de 
percussions individuelles ou d'un modèle à 
percussions. Vous pouvez facilement créer ces 
petites régions avec la commande Beat 
Detective ou Separate Region At Transients, 
ou les exporter en tant que fichiers REX ou 
ACID.

• Groupement de parties ou de sections de la 
session afin de faciliter la composition ou 
l'organisation (par exemple, groupement des 
régions de la section de cuivres jouées 
pendant un refrain afin de les copier sur le 
refrain suivant).

Création de groupes de régions

Pour créer un groupe de régions :

1  Sélectionnez une ou plusieurs régions sur une 
ou plusieurs pistes. Pour plus d'informations sur 
les groupes de régions multipistes, reportez-vous 
à la section Groupes de régions multipistes, 
page 527.

Réparation d'un "pop" avec le crayon

Si vous ne parvenez pas à réaliser un zoom 
avant plus important pour effectuer vos 
corrections au crayon, vérifiez la longueur 
de la fenêtre Edit (session). Réduisez la 
longueur globale de la fenêtre Edit (session), 
si possible, jusqu'à ce que le crayon soit 
utilisable. 

Les groupes de régions sont entièrement 
indépendants des groupes de mixage et 
d'édition.
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La longueur de la sélection détermine la durée 
du groupe de régions. Vous pouvez définir le 
début et la fin d'une sélection sur les limites 
d'une région, sur un espace vide ou même sur la 
partie centrale d'une région. Lors de la création 
d'un groupe de régions, si votre sélection 
démarre ou s'achève à l'intérieur d'une région, 
celle-ci est scindée à la limite de la sélection. Les 
groupes de régions créés à partir de sélections 
d'objets incluent toutes les régions, 
sélectionnées ou non, situées entre la première 
et la dernière région sélectionnées sur la piste.

2  Choisissez Region > Group.

Le groupe de régions est représenté sous la forme 
d'une seule région associée à une icône de 
groupe de régions affichée dans le coin inférieur 
gauche. Les groupes de régions s'inscrivent 
également dans la liste des régions.

Format temporel des groupes de régions

Les groupes de régions sont associés au format 
temporel (basé sur des références temporelles ou 
des échantillons) des pistes sur lesquelles ils sont 
créés. Les groupes de régions multipistes 
peuvent inclurent à la fois des pistes basées sur 
des échantillons et des pistes basées sur des 
références temporelles.

Sélection de régions à grouper sur une seule 
piste audio

Groupe de régions sur une piste audio et dans la liste 
des régions

cône de groupe de régions

Groupe de régions sur une piste audio

Groupe de régions sur une piste MIDI

Vous pouvez créer des groupes de régions à 
partir de sélections vides. Cela s'avère 
particulièrement utile en mode Shuffle pour 
conserver les espaces entre les régions.

Les commandes de menu Group et Ungroup 
Region s'appliquent à toute sélection 
d'édition, quelle que soit la vue de piste 
active.

Icône de groupes de régions audio

Icône de groupe de régions MIDI
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Annulation du groupement de régions

Pour annuler le groupement de régions :

1  Sélectionnez un groupe de régions. 

2  Choisissez Region > Ungroup.

Le groupe de régions est supprimé et toutes les 
régions sous-jacentes et groupes de régions 
emboîtés s'affichent. S'il existe plusieurs groupes 
de régions emboîtés, la commande Ungroup 
annule le groupement de la région de la couche 
supérieure, sans toucher aux groupes de régions 
sous-jacents.

Pour annuler le groupement d'un groupe de 
régions (et inclure tous les groupes de régions 
emboîtés qui s'y rapportent) :

1  Sélectionnez un groupe de régions.

2  Choisissez Region > Ungroup All.

Reconstitution de groupes de régions

La commande de menu Regroup annule la 
dernière commande Ungroup et restaure le 
groupe de régions individuelles. Ainsi, vous 
pouvez annuler le regroupement de régions, 
modifier les régions sous-jacentes comme vous 
le souhaitez, puis les regrouper de nouveau pour 
poursuivre vos opérations globales de 
composition et d'organisation.

Pour reconstituer un groupe de régions :

1  Sélectionnez une région appartenant à 
l'ancien groupe de régions à reconstituer.

2  Choisissez Region > Regroup.

Si vous avez utilisé la commande Ungroup All, la 
commande Regroup recrée tous les anciens 
groupes de régions emboîtés.

3  Pour reconstituer un groupe de régions utilisé 
plusieurs fois au cours de la session, effectuez 
l'une des opérations suivantes dans la boîte de 
dialogue Change All qui s'affiche.

• Choisissez Modify pour appliquer les 
modifications à toutes les autres instances 
du groupe de régions. 

– ou –

• Choisissez Copy pour créer une copie et 
appliquer uniquement les modifications au 
groupe de régions copié. 

Groupes de régions multipistes

Les groupes de régions multipistes (groupes 
créés sur plusieurs pistes) facilitent le 
groupement de parties (pistes de percussions 
enregistrées à partir de plusieurs micro, par 
exemple) ainsi que la composition et 
l'organisation. Pour créer des groupes de régions 
multipistes, vous pouvez utiliser une 
combinaison quelconque de pistes audio, MIDI 
et d'instrument, basées sur des échantillons 
et/ou des références temporelles.

Les groupes de régions multipistes et 
monopistes fonctionnent de manière similaire. 
Les groupes de régions multipistes s'affichent sur 
plusieurs pistes adjacentes sous la forme d'un 
seul objet.
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Pour créer un groupe de régions multipistes :

1  Sélectionnez plusieurs régions de pistes 
adjacentes.

2  Choisissez Region > Group.

Division de groupes de régions 
multipistes

L'insertion, le déplacement, le masquage et la 
suppression de pistes dans un groupe de régions 
multipistes, bien que possibles, peuvent 
provoquer la division du groupe. Lorsqu'un 
groupe de régions est divisé, une rupture 
apparaît dans l'icône de groupe de régions. 
Le groupe de régions divisé fonctionne toujours 
en tant que groupe unique, mais l'icône rompue 
indique un groupe inachevé ou divisé sur 
plusieurs pistes séparées.

Sélection de régions à grouper sur plusieurs pistes

Groupe de régions multipiste

Icône de groupe de régions

Groupe de régions multipistes mixte (données audio 
basées sur des échantillons et des références 
temporelles, et données MIDI basées sur des 
références temporelles)

Les groupes de régions multipistes créent des 
groupes de régions emboîtés par piste avant 
de les grouper sur plusieurs pistes.

La commande Regroup prend en charge les 
groupes de régions multipistes.

cône de groupe de régions mixte
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L'une des opérations suivantes peut être à 
l'origine d'une division d'un groupe de régions :

• insertion d'une piste dans un groupe de 
régions multipistes ;

• déplacement d'une piste d'un groupe de 
régions multipistes occasionnant sa 
séparation d'avec les autres pistes du groupe ;

• masquage d'une piste faisant partie d'un 
groupe de régions multipistes ;

• suppression d'une piste faisant partie d'un 
groupe de régions multipistes ;

• modification du tempo d'un groupe mixte de 
régions basées sur des références temporelles 
et des échantillons ;

• enregistrement dans un groupe de régions ;

• modification d'une playlist sur une piste 
faisant partie d'un groupe de régions 
multipistes.

La division de groupes de régions peut s'avérer 
utile dans certains cas. Par exemple, si vous 
appliquez un accompagnement aux deux 
premiers vers d'une chanson, vous pouvez 
grouper les parties constituantes du premier vers 

et les copier en tant que groupe de régions pour 
le deuxième vers, tout en conservant une piste 
vocale continue entre les deux groupes de 
régions.

Groupes de régions sur des pistes 
basées sur des références 
temporelles

Lorsque vous modifiez le tempo, les groupes de 
régions sur les pistes basées sur des références 
temporelles règlent leur longueur en ajustant en 
conséquence la position de toutes leurs régions. 
Ce réglage s'avère particulièrement utile dans le 
cadre de l'organisation de données rythmiques 
et de la lecture de groupes de régions importés à 
partir de fichiers REX et ACID. 

Groupe de régions divisé après la suppression 
d'une piste

Icône de groupe de régions divisé

Pour supprimer une piste et conserver intact 
un groupe de régions, annulez d'abord le 
groupe de régions, puis supprimez la piste en 
question, et enfin reconstituez le groupe de 
régions. Le groupe de régions est recréé sans 
altération, à l'exception de la suppression de 
la piste.

Groupe de régions sur une piste basée sur des 
références temporelles de 120 BPM et de 160 BPM
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Modification de la base de temps d'un 
groupe de régions

Vous pouvez modifier le format temporel d'un 
groupe de régions en effectuant les opérations 
suivantes :

• modification de la base de temps de la 
piste ;

• glisser-déposer du groupe de régions sur 
une piste dont la base de temps est 
différente.

La modification de la base de temps crée une 
copie du groupe de régions d'origine. L'original 
et la copie s'affichent dans la liste des régions 
avec une base de temps différente.

Conversion d'échantillons en références 
temporelles

Le déplacement d'un groupe de régions d'une 
piste basée sur des échantillons vers une piste 
basée sur des références temporelles ne modifie 
en rien sa longueur. En effet, les échantillons 
sont convertis en références temporelles après le 
déplacement du groupe sur la piste basée sur des 
références temporelles. La longueur du groupe 
varie uniquement si le tempo est modifié par la 
suite. Si nécessaire, ajustez le tempo local de la 
piste basée sur des références temporelles sur le 
tempo du groupe de régions basé sur des 
échantillons avant le déplacement du groupe.

Conversion de références temporelles en 
échantillons

Le déplacement d'un groupe de régions d'une 
piste basée sur des références temporelles vers 
une piste basée sur des échantillons ne modifie 
pas la longueur du groupe à moins qu'il ne soit 
déplacé vers un autre emplacement temporel 
pour lequel un tempo différent a été défini. En 
effet, les références temporelles sont converties 
en échantillons après le déplacement du groupe 
sur la piste basée sur des échantillons. 

Groupes de régions multipistes incluant des 
pistes basées sur des échantillons et des pistes 
basées sur des références temporelles

Les groupes de régions multipistes peuvent 
inclurent à la fois des pistes basées sur des 
échantillons et des pistes basées sur des 
références temporelles. Toutefois, la 
modification du tempo sépare les pistes basées 
sur des échantillons des pistes basées sur des 
références temporelles.

Edition des groupes de régions

L'édition des groupes de régions est similaire à 
celle des régions normales. Vous pouvez 
nommer, déplacer, couper, copier, coller, 
rogner, verrouiller les groupes de régions, en 
couper le son, etc. Il existe néanmoins quelques 
différences importantes. 

Edition des groupes de régions MIDI

Toute modification d'une région MIDI au sein 
d'un groupe de régions crée une copie de la 
région, qui est ensuite superposée au groupe de 
régions. Par exemple, une nouvelle région est 
créée sur le groupe de régions si vous effectuez 
un enregistrement, insérez une note, éditez les 
données du contrôleur MIDI ou quantifiez une 
sélection de timeline.

Groupe de régions multipiste dont les pistes basées sur 
des échantillons et les pistes basées sur des 
références temporelles ont été séparées après 
modification du tempo
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Edition des groupes de régions audio

Certaines commandes d'édition audio créent de 
nouvelles régions sur les groupes de régions. 
Pour les utiliser tout en conservant le groupe de 
régions, annulez le groupement des régions, 
effectuez les modifications, puis reconstituez le 
groupe.

Les commandes d'édition suivantes créent de 
nouvelles régions sur les groupes de régions :

• Le traitement AudioSuite d'une région 
groupée entraîne la création d'une région sur 
le groupe de régions.

• Le regroupement d'une sélection d'une région 
groupée crée un fichier audio et une région sur 
le groupe de régions.

• Un enregistrement dans un groupe de régions 
crée un fichier audio et une région sur un 
groupe de régions.

• Si vous redessinez une forme d'onde avec le 
crayon, une nouvelle région est créée sur le 
groupe de régions.

Tabulation vers transitoires et limites de 
régions

Si l'option Tab to Transients est activée, la 
touche Tab permet de déplacer le curseur vers les 
transitoires et les limites de région internes à un 
groupe de régions. 

Si l'option est désactivée, la touche de tabulation 
déplace le curseur vers les limites du groupe de 
régions uniquement (et le point de 
synchronisation, le cas échéant).

Rognage de groupes de régions

Le rognage de groupes de régions à l'aide de 
l'outil de trimming standard est identique à 
celui des régions classiques, qu'il concerne un 
groupe de régions monopistes ou multipistes.

Le rognage d'un groupe de régions n'inclut pas 
les régions sous-jacentes ; il s'applique aux 
limites du groupe de régions. Les régions 
sous-jacentes conservent leur longueur et leur 
emplacement d'origine. Cette règle s'applique à 
toutes les régions MIDI et audio sous-jacentes, 
ainsi qu'aux groupes de régions emboîtés. Si les 
régions sous-jacentes d'un groupe de régions se 
retrouvent en dehors des limites du groupe après 
une opération de trimming, elles seront 
peut-être inaudibles à la lecture. 

Lorsque vous rognez des groupes de régions à 
l'aide de l'outil TC/E Trim, le rognage s'applique 
uniquement aux régions audio et crée une 
nouvelle région sur les groupes de régions.

Après avoir rogné un groupe, si vous annulez le 
groupement, les régions audio se retrouvant en 
dehors des limites du groupe actif sont rognées 
de manière à respecter les limites du groupe de 
régions ou supprimées.

Enregistrement

Lors d'enregistrements audio ou MIDI, de 
nouvelles régions sont superposées, et non 
incluses, aux groupes de régions. Pour 
enregistrer dans un groupe de régions, annulez 
d'abord le groupement des régions, effectuez 
l'enregistrement, puis regroupez les régions. 
Le groupe de régions est recréé sans altération, à 
l'exception des nouvelles données de 
l'enregistrement.

Pour plus d'informations, reportez-vous à la 
section Tabulation vers transitoires, 
page 473.
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Fondus et crossfades sur les 
groupes de régions

Tout comme les régions normales, les groupes 
de régions peuvent comporter des fondus et des 
crossfades. Toutefois, les fondus s'appliquent 
uniquement aux régions audio. Vous pouvez 
effectuer un crossfade entre groupes de régions, 
mais aussi entre groupes de régions et régions 
audio normales.

Importation et exportation de 
fichiers de groupe de régions

Pro Tools permet d'exporter et d'importer des 
groupes de régions sous forme de fichiers .rgrp 
afin d'autoriser les opérations suivantes :

• Séparation des métadonnées des groupes 
de régions des fichiers audio pour éviter les 
opérations de copie de fichiers inutiles lors 
de l'exportation de groupes de régions 
audio composés de plusieurs fichiers 
source.

• Exportation des données MIDI sous forme 
de groupe de régions.

• Création de boucles multipistes.

Les fichiers de groupe de régions stockent les 
métadonnées suivantes :

• Références à tous les fichiers audio au sein 
du groupe de régions.

• Noms des régions et emplacements relatifs 
dans les pistes.

• Fondus et crossfades.

• Noms et formats (monopiste ou multipiste) 
des groupes de régions.

• Toutes les données MIDI du groupe de 
régions (notes, contrôleurs, données Sysex, 
etc.).

• Nom des pistes.

Les fichiers de groupe de régions ne contiennent 
pas les données suivantes :

• Automation.

• Plug-in.

• Assignation des pistes.

• Table des tempos et mesures.

• Informations sur la liste des régions.

Deux groupes de régions multipistes avec crossfades 
sur les pistes audio et sans crossfades sur les 
pistes MIDI

L'annulation du groupement de régions 
supprime les fondus et crossfades au niveau 
du groupe. Ils sont restaurés dès que le 
groupe est reconstitué.

Lorsque vous modifiez le tempo avec des 
groupes de régions appartenant à des pistes 
basées sur des références temporelles, vous 
devrez peut-être annuler le groupement, 
rétablir ou créer des fondus, puis regrouper 
les régions afin de conserver les fondus 
souhaités.

Pour plus d'informations sur l'utilisation 
des fondus et des crossfades dans Pro Tools, 
reportez-vous au chapitre 21, Fondus et 
crossfades



Chapitre 20 : Utilisation des régions et des sélections 533

Importation de groupes de régions

Pour importer un groupe de régions :

" Faites glisser le fichier de groupe de régions à 
partir d'un navigateur DigiBase ou depuis 
l'Explorateur Windows ou le Finder Mac et 
déposez-le dans la timeline, sur une piste, dans 
la liste des pistes ou dans la liste des régions.

Le placement d'un groupe de régions a des 
conséquences différentes selon la destination 
choisie :

• Lorsque vous déposez un groupe de régions 
sur une piste, Pro Tools recherche un format 
de piste correspondant, vérifie le nombre de 
canaux et s'assure (dans le cas de groupes de 
régions multipistes) qu'il y a suffisamment de 
pistes adjacentes correspondantes pour 
importer le fichier de groupe de régions. 
S'il répond à ces critères, le groupe de régions 
est importé et placé à l'endroit choisi sur la ou 
les pistes.

• Lorsque vous déposez un groupe de régions 
sur la timeline ou la liste des pistes, le 
programme crée de nouvelles pistes pour le 
groupe de régions importé. 

• Lorsque vous déposez un groupe de régions 
dans la liste des régions, le programme y 
ajoute un nouveau groupe de régions. Toutes 
les régions audio et MIDI et même les autres 
groupes de régions contenus dans le groupe de 
régions déposé apparaissent également dans 
la liste des régions. 

Exportation de groupes de régions

Pour exporter un groupe de régions sans ses 
fichiers audio :

1  Sélectionnez un ou plusieurs groupes de 
régions dans la liste des régions.

2  Dans le menu déroulant de la liste des régions, 
choisissez Export Region Groups. La boîte de 
dialogue correspondante s'affiche.

3  Pour modifier l'emplacement du répertoire de 
destination par défaut créé automatiquement 
pour les groupes de régions, effectuez la 
procédure suivante :

• Cliquez sur le bouton Choose.

• Accédez à l'emplacement souhaité.

• Cliquez sur Choose. 

4  Pour rétablir le répertoire de destination par 
défaut, cliquez sur Reset.

5  Activez l'une des options suivantes pour 
résoudre les noms de fichiers de groupe de 
régions en double :

• Prompting for Each Duplicate

• Auto Renaming

• Replacing with New Files

6  Cliquez sur OK. 

Boîte de dialogue Export Region Groups
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En règle générale, avant d'exporter un groupe de 
régions vers un autre disque dur, il est conseillé 
de copier ses fichiers audio référencés. 
Vous pourrez ainsi transférer des groupes de 
régions non seulement d'une session à une 
autre, mais aussi d'un système à un autre.

Pour exporter un groupe de régions avec ses 
fichiers audio :

1  Exportez un ou plusieurs groupes de régions 
vers le disque dur de votre choix.

2  Créez une nouvelle session sur le nouveau 
disque.

3  Sélectionnez Setup > Preferences.

4  Dans la boîte de dialogue Preferences, cliquez 
sur l'onglet Processing et sélectionnez 
Automatically Copy Files on Import.

5  Cliquez sur OK pour refermer la boîte de 
dialogue Preferences.

6  Importez tous les groupes de région 
précédemment exportés en les déposant dans la 
session. 

Le dossier des fichiers audio de la nouvelle 
session contient à présent tous les fichiers 
référencés par les groupes de régions.

Mise en boucle de régions
Pro Tools permet de lire en boucle les régions 
audio, MIDI et les groupes de régions. Dans le 
cadre de la composition et de l'organisation des 
données audio, la mise en boucle de régions est 
un moyen simple et efficace de répéter une 
région sur une piste ou plusieurs régions sur 
plusieurs pistes. La mise en boucle des régions 
offre plus de souplesse que les commandes 
Repeat et Duplicate.

La mise en boucle de régions consiste à répéter la 
région source autant de fois que le spécifie la 
boîte de dialogue Region Looping ou de manière 
à combler la longueur de boucle indiquée 
(30 secondes ou jusqu'à la région suivante sur la 
piste, par exemple). La région source correspond à 
la région d'origine sélectionnée pour la mise en 
boucle. Les itérations de boucle correspondent 
aux régions mises en boucle qui suivent la 
région source. Si vous n'avez pas défini le 
nombre de répétitions, la dernière itération de 
boucle est tronquée de sorte à combler la 
sélection jusqu'au point de fin ou jusqu'à la 
longueur de boucle spécifiée.

Une fois mise en boucle, une région s'édite de la 
même manière qu'un groupe de régions. 
Par exemple, lorsque vous déplacez une région 
mise en boucle, vous déplacez la région source 
en même temps que toutes ses itérations de 
boucle.

Les régions mises en boucle (toutes les 
itérations) sont signalées par une icône de 
boucle située dans l'angle inférieur droit de 
chaque itération. 

Région mise en boucle

Icônes de boucle

Région source Itérations de boucle

Région mise en boucle
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Création de boucles de régions

Pour créer des régions mises en boucle, vous 
pouvez utiliser la commande Loop ou l'outil de 
trimming de boucle. 

Pour mettre en boucle une région :

1  Sélectionnez une région audio ou MIDI, ou un 
groupe de régions. 

2  Choisissez Region > Loop. La boîte de dialogue 
Region Looping s'affiche.

3  Effectuez l'une des opérations suivantes :

• Sélectionnez l'option Number of Loops et 
entrez le nombre de fois que vous souhaitez 
répéter la région.

• Sélectionnez l'option Loop Length et 
entrez la durée selon la base de temps 
principale. S'il ne s'agit pas d'un multiple 
exact de la durée de la boucle source, la 
dernière itération de boucle est tronquée.

• Sélectionnez l'option Loop Until End of 
Session or Next Region. La région mise en 
boucle est répétée jusqu'à la région 
suivante sur la piste ou jusqu'à la fin de la 
session. Si nécessaire, la dernière itération 
de boucle est ajustée par troncation.

4  Si vous le souhaitez, vous pouvez sélectionner 
l'option Enable Crossfade pour créer un 
crossfade au point de boucle. Pour modifier le 
crossfade de boucle, effectuez la procédure 
suivante :

• Cliquez sur le bouton Settings.

• Configurez les crossfades de boucle.

La mise en boucle d'une région ne 
s'applique pas à l'automation associée à la 
région source. Pour copier l'automation 
définie pour la boucle source sur les 
itérations de boucle, utilisez les commandes 
Copy Special et Paste Special Repeat To Fill 
Selection (voir la section Automation et 
régions mises en boucle, page 538).

Pour plus d'informations sur l'utilisation de 
l'outil de trimming de boucle, consultez la 
section Outil de trimming de boucle, 
page 442.

Vous pouvez aussi sélectionner des régions 
sur plusieurs pistes.

Si vous sélectionnez plusieurs régions sur 
une même piste, seule la première région de 
votre sélection est mise en boucle.

Boîte de dialogue Region Looping
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• Cliquez sur OK.

5  Dans la boîte de dialogue Region Looping, 
cliquez sur OK.

Pour renommer la région mise en boucle 
uniquement (ou la région et le fichier de disque) :

1  Cliquez deux fois sur l'icône de boucle à l'aide 
de la main.

2  Entrez un nouveau nom.

3  Indiquez si vous souhaitez renommer la 
région uniquement ou la région et le fichier du 
disque.

4  Cliquez sur OK.

Pour annuler la mise en boucle une région :

1  Sélectionnez la région mise en boucle.

2  Choisissez Region > Unloop. La boîte de 
dialogue Unloop Regions s'affiche.

3  Effectuez l'une des opérations suivantes :

• Cliquez sur Remove pour annuler la mise 
en boucle et supprimer toutes les itérations, 
exception faite de la première boucle 
complète (région source).

– ou –

• Cliquez sur Flatten pour annuler la mise en 
boucle et créer une région pour chaque 
itération de boucle.

Pour annuler la mise en boucle et le groupement 
d'une sélection de régions :

1  Sélectionnez une région mise en boucle 
contenant un ou plusieurs groupes de régions.

2  Choisissez Region > Ungroup All.

Annulation de boucle et mise à plat de régions 
à l'aide des commandes de menu Separate 
Regions

Les commandes Separate Regions (At Selection, 
On Grid et At Transients) annulent 
automatiquement la mise en boucle de régions 
et les aplanit avant la séparation.

Boîte de dialogue Loop Crossfade

Pour plus d'informations sur l'utilisation 
des crossfades dans Pro Tools, 
reportez-vous au chapitre 21, Fondus et 
crossfades

Boîte de dialogue Unloop Regions

La commande Region Ungroup a le même 
effet sur les boucles que le bouton Flatten de 
la commande Unloop.
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Modification de régions mises en 
boucle

Les régions mises en boucle peuvent être 
modifiées en tant que régions individuelles 
(chaque itération séparément) ou groupes de 
régions (toutes les itérations). Par exemple, 
lorsque vous utilisez la main pour sélectionner 
une région mise en boucle, vous sélectionnez la 
boucle dans son intégralité (région source et 
itérations de boucle). En revanche, un clic sur 
l'icône de boucle d'une itération sélectionne 
uniquement l'itération correspondante.

Le déplacement d'une région en boucle déplace 
à la fois la région source et toutes les itérations 
de boucle qui s'y rapportent. Les itérations de 
boucle ne peuvent pas être déplacées sans leur 
région source. Si vous déplacez ou collez une 
région plus courte sur une région mise en 
boucle, la boucle ne s'arrête pas après la nouvelle 
région. Les parties constituantes d'une région 
mise en boucle ne peuvent pas être ajustées 
séparément.

Pour sélectionner une région mise en boucle dans 
son ensemble (toutes les itérations de groupe), 
effectuez l'une des opérations suivantes :

" Cliquez une fois sur la région mise en boucle à 
l'aide de la main ou de l'outil Smart. 

– ou –

" Cliquez deux fois sur la région mise en boucle 
à l'aide du sélecteur.

La région source et toutes ses itérations de 
boucle sont sélectionnées.

Pour sélectionner une région source ou une 
itération de boucle individuellement, effectuez 
l'une des opérations suivantes :

" Cliquez une fois sur l'icône de boucle de la 
région source ou d'une itération de boucle à 
l'aide de la main ou de l'outil Smart.

– ou –

" A l'aide du sélecteur, cliquez une fois sur 
l'icône de région en boucle et sélectionnez la 
région en déplaçant le curseur vers la gauche.

Tabulation vers transitoires et limites de 
régions

L'option Tab to Transients déplace le curseur 
vers les transitoires et les limites internes d'une 
région mise en boucle. La tabulation normale 
(option Tab to Transients désactivée) déplace le 
curseur vers les limites de début et de fin de la 
région mise en boucle.

Rognage de régions mises en boucle

Pour rogner les régions en boucle, vous disposez 
de l'outil de trimming, de l'outil de trimming de 
boucle et des commandes Trim Region. L'outil 
de trimming en boucle rogne la région mise en 
boucle dans son ensemble. L'outil de trimming 
rogne uniquement l'itération de boucle et 
augmente ou diminue le nombre d'itérations de 
manière à remplir la totalité de la longueur de la 
région mise en boucle.

Si vous étendez vers la gauche la région source 
avec l'outil de trimming pour modifier la 
longueur totale de la région mise en boucle, la 
région source se déplace en amont de la timeline 
et des itérations de boucle comblent l'espace 
jusqu'au point de fin de la dernière itération de 

Pour plus d'informations sur le rognage de 
régions mises en boucle à l'aide de l'outil de 
trimming en boucle, consultez la section 
Outil de trimming de boucle, page 442.
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la boucle d'origine. Si le rognage vers la gauche 
ne concerne qu'une partie de la durée de la 
région source, celle-ci n'est pas déplacée et une 
itération de boucle partielle est créée sur sa 
gauche. Cette fonction vous permet d'effectuer 
de rapides changements de vos compositions. 
En effet, vous pouvez utiliser des boucles 
partielles en tant que levés ou étendre des effets 
sonores mis en boucle et une ambiance en 
amont d'une musique de film.

Pour rogner une région mise en boucle au niveau 
de la sélection :

1  A l'aide du sélecteur, effectuez une sélection 
d'édition portant sur la totalité ou une partie 
d'une région mise en boucle.

2  Choisissez Edit > Trim Region, puis l'une des 
commandes de rognage de région (To Selection, 
To Fill Selection, Start to Fill Selection, End to 
Fill Selection).

Automation et régions mises en 
boucle

La mise en boucle d'une région audio ne 
s'applique pas à l'automation associée à la région 
source. Cette opération permet d'appliquer une 
automation à l'échelle de la totalité de la région 
mise en boucle. Par exemple, vous pouvez 
insérer un fondu sur une partie ou la totalité 
d'une région mise en boucle fonctionnant 
indépendamment des itérations de boucle. 

Vous pouvez aussi répéter l'automation sur 
chaque itération de boucle. En ce qui concerne 
les régions audio mises en boucle, utilisez les 
commandes Copy Special et Paste Special Repeat 
to Fill Selection afin de copier et coller tout ou 
partie des données d'automation de la région 
source vers tout ou partie des itérations de 
boucle qui lui sont associées. 

Pour copier et coller les données d'automation 
depuis une région source vers des itérations de 
boucle :

1  Sélectionnez la région source.

2  Choisissez Edit > Copy Special, puis l'une des 
commandes Copy Special (All Automation, Pan 
Automation, Plug-In Automation) en fonction 
du type des données d'automation à copier.

3  Sélectionnez l'intégralité de la région mise en 
boucle.

4  Choisissez Edit > Paste Special > Repeat to Fill 
Selection.

Automation de panoramique sélectionnée pour la 
commande Special Copy

Automation de panoramique sélectionnée pour la 
commande Special Paste to Fill Selection
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Chapitre 21 : Fondus et crossfades

Utilisation des fondus
Vous pouvez créer des fondus d'entrée et de 
sortie sur une région ou encore des crossfades 
entre des régions audio adjacentes. 
Le crossfading (fondu enchaîné) consiste à 
fondre deux régions audio pour éviter les clics 
ou les changements de niveau soudains. 
Les crossfades trouvent de nombreuses 
applications, du « lissage » des transitions entre 
régions à la création d'effets spéciaux. Vous 
pouvez définir la durée, la position et la forme 
des crossfades.

Les fondus sont calculés, puis écrits sur le 
disque. Les crossfades écrits sur le disque sont 
stockés dans un dossier nommé Fade Files, 
contenu dans le dossier de la session. Lorsque 
vous lisez votre piste, Pro Tools lit et joue le 
fichier de fondu à partir du disque.

Pro Tools ne permet pas de remplacer des 
fondus d'entrée et des fondus de sortie par des 
crossfades. Pour ajouter un crossfade entre des 
régions, tous les fondus d'entrée et fondus de 
sortie existants entre les régions doivent 
préalablement être supprimés. 

A propos des crossfades et des 
courbes

Pour créer un crossfade (fondu enchaîné) entre 
deux régions, utilisez le sélecteur pour 
sélectionner à la fois le point de fin de la 
première région et le point de début de la 
seconde. C'est la longueur de cette sélection qui 
détermine la longueur du crossfade. Bien que les 
fondus puissent apparaître comme des régions à 
part entière, ils ne peuvent en fait être séparés 
des régions dans lesquels ils ont été créés. Vous 
pouvez toutefois créer des fondus d'entrée 
(fade-in) et de sortie (fade-out) pour des régions 
individuelles (voir Création de fondus aux 
débuts et aux fins des régions, page 546).

La boîte de dialogue Fades permet de 
sélectionner, de visualiser et de manipuler les 
courbes utilisées pour les fondus et les 
crossfades. Vous pouvez affecter différentes 
courbes de niveau aux portions de fondu 
d'entrée et de sortie d'un crossfade. La boîte de 
dialogue Fades offre également un aperçu du 
fondu.

Les exemples suivants illustrent des types de 
crossfade courants et décrivent l'influence des 
types de sélection sur le caractère du crossfade.

Pro Tools HD inclut une fonction Auto Fade 
qui permet de réaliser des fondus en temps 
réel, sans besoin de les enregistrer au 
préalable sur le disque (voir Utilisation des 
fondus automatiques, page 550).

 Les crossfades étant créés par fondu 
enchaîné entre des données audio 
superposées, il n'est pas possible de les 
réaliser sur des régions ne contenant pas de 
données au-delà de leurs limites.
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Crossfade standard (centré)

Ce type de sélection crée un crossfade des deux 
côtés du point de jonction, qui a une incidence 
sur le niveau de la région 1 et de la région 2. 
C'est le type de crossfade le plus courant.

Ce type de crossfade implique que la région 1 
contienne des données audio au-delà de son 
point de fin et que la région 2 contienne des 
données audio avant son point de début.

Pré crossfade

Ce type de sélection crée un crossfade avant le 
point de jonction. Ceci permet de conserver le 
niveau nominal du tout début de la région 2 au 
lieu de lui faire subir un fondu, ce qui est utile 
lorsque vous souhaitez conserver une attaque 
forte au début de cette région. Lorsque vous 
effectuez des sélections de crossfades 
intervenant sur le bord de deux régions, vous 
pouvez utiliser la touche de tabulation pour 
déplacer le curseur exactement au début ou à la 
fin d'une région.

Ce type de crossfade implique que la région 2 
contienne des données audio avant son point de 
début.

Post crossfade

Ce type de sélection crée un crossfade après le 
point de jonction. Il est utile lorsque vous 
souhaitez conserver l'amplitude de la région 1 
jusqu'au bout. Lorsque vous effectuez des 
sélections de crossfades intervenant sur le bord 
de deux régions, vous pouvez utiliser la touche 
de tabulation pour déplacer le curseur 
exactement au début ou à la fin d'une région.

Ce type de crossfade nécessite que la région 1 
contienne des données audio au-delà de son 
point de fin.

Crossfade centré

Pré crossfade

region 1

fade out
curve

fade in
curve

region 2

splice point

crossfade selection

region 1 region 2

border of region 1 and 2

selection range extends just up to beginning of region 2

Post crossfade

region 1 region 2

border of region 1 and 2

selection range begins just after end of region 1
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Boîte de dialogue Fades
La boîte de dialogue Fades ouverte avec la 
commande Edit > Fades permet de sélectionner, 
de visualiser et de manipuler les fondus et les 
crossfades et de modifier les courbes 
correspondantes. Les fondus d'entrée sont 
caractérisés par les paramètres In Shape et les 
fondus de sortie par les paramètres Out Shape. 
Ils n'affichent que leurs propres paramètres.

Les contrôles de la boîte de dialogue Fades sont 
les suivants :

Audition 

Cliquez sur ce bouton pour écouter les fondus. 
Pro Tools prend en charge l'écoute des fondus 
directement depuis les sorties de l'interface 
audio.

Vue de la première piste (crossfades uniquement) 

Si vous réalisez un crossfade entre plusieurs 
pistes, ce bouton permet de voir et d'obtenir un 
aperçu des données audio de la première des 
deux pistes adjacentes.

Vue de la seconde piste (crossfades uniquement) 

Si vous réalisez un crossfade entre plusieurs 
pistes, ce bouton permet de voir et d'obtenir un 
aperçu des données audio de la seconde des 
deux pistes adjacentes.

Vue des deux pistes (crossfades uniquement) 

Ce bouton permet d'afficher les formes d'onde 
des deux premières pistes adjacentes dans un 
crossfade entre plusieurs pistes. 

Fondu des courbes seulement : 

cliquez sur ce bouton pour afficher les courbes 
de fondu spécifiées sans visualisation des formes 
d'onde audio. C'est l'option par défaut lorsque 
vous ouvrez la boîte de dialogue Fades.

Boîte de dialogue Fades, fondu de sortie

Boîte de dialogue Fades, crossfade
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Courbes de fondus et formes d'onde séparées 

Cliquez sur ce bouton pour afficher les courbes 
de fondu spécifiées ainsi que des vues séparées 
des formes d'onde du fondu d'entrée (fade-in) et 
de sortie (fade-out).

Courbes de fondus et formes d'onde superposées 

cliquez sur ce bouton pour afficher les courbes 
de fondu spécifiées ainsi que des vues 
superposées des formes d'onde en entrée et en 
sortie de fondu. 

Courbes fondues et somme des formes d'onde 

Ce bouton permet d'afficher les courbes de 
fondu spécifiées ainsi qu'une seule forme d'onde 
représentant la somme des données audio du 
crossfade.

Zoom avant 

cliquez sur ce bouton pour agrandir l'échelle de 
la vue de l'amplitude de la forme d'onde. 
Cliquez sur l'échelle de la vue par défaut en 
maintenant enfoncée la touche Pomme (Mac) 
ou Ctrl (Windows).

Zoom arrière 

Cliquez sur ce bouton pour réduire l'échelle de la 
vue de l'amplitude de la forme d'onde. Cliquez 
sur l'échelle de la vue par défaut en maintenant 
enfoncée la touche Pomme (Mac) ou Ctrl 
(Windows).

Paramètres de la forme du fondu en 
sortie

Le paramètre Out Shape permet de définir la 
forme du fondu de sortie à partir d'une région 
(fondu) ou à partir de la région 1 (crossfade). 

Standard : sélectionne une courbe de fondu 
unique et continue. Ceci crée un fondu 
universel, susceptible d'être édité en déplaçant la 
courbe elle-même.

S-Curve : sélectionne une courbe en S, dont les 
caractéristiques s'inversent au début et à la fin. 
Ceci permet, par exemple, d'obtenir un fondu de 
sortie plus rapide au début de la courbe et plus 
lent en sortie. Les courbes en S sont utiles avec 
les données sur lesquelles les crossfades sont 
difficiles à réaliser. Les courbes en S peuvent être 
éditées en faisant glisser la courbe dans l'éditeur 
de courbes.

Courbes présélectionnées : sept courbes 
présélectionnées sont à votre disposition pour 
faciliter la création rapide de crossfades. 
Ces présélections peuvent être éditées en faisant 
glisser le point de fin de la courbe dans l'éditeur 
de courbe de cette boîte de dialogue. Ces sept 
présélections sont les suivantes :

! La présélection de courbe 1 maintient le 
volume au maximum pendant toute la durée du 
fondu, puis le réduit immédiatement une fois le 
fondu terminé.

Forme du fondu en sortie
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! La présélection de courbe 2 effectue un fondu 
de sortie relativement lent, en conservant un 
niveau de volume assez élevé pendant toute la 
durée du fondu.

! La présélection de courbe 3 effectue un fondu 
de sortie légèrement plus rapide, en conservant 
un niveau de volume un peu moins élevé 
pendant le fondu.

! La présélection de courbe 4 effectue un fondu 
de sortie de façon linéaire. C'est la courbe par 
défaut.

! La présélection de courbe 5 effectue un fondu 
de sortie rapide au début du crossfade.

! La présélection de courbe 6 fait chuter le 
niveau du volume encore plus rapidement au 
début du fondu.

! La présélection de courbe 7 désactive toutes 
les données audio au début du fondu.

Réglage des liens

(crossfades uniquement)

Le paramètre Link (liaison) relie les courbes 
sélectionnées de fondu en entrée et en sortie 
d'un crossfade. Si vous modifiez l'une des 
courbes, l'autre est également modifiée. 
Ce fonctionnement garantit que le résultat 
obtenu définit un crossfade maintenant une 
puissance constante ou un gain constant, suivant 
le type sélectionné.

Puissance égale (Equal Power) : l'option Equal 
Power est recommandée pour les données dont 
la phase n'est pas cohérente, comme dans le cas 
d'un crossfade entre deux types d'éléments 
complètement différents. Utilisez cette option 
pour éviter la chute de niveau qui peut se 
produire avec un crossfade de gain égal. Avec ce 
type de fondu, cliquer sur la courbe tout en 
appuyant sur la touche Option (Mac) ou Alt 
(Windows) la réinitialise à sa forme par défaut.

Equal Gain : cette option est recommandée pour 
les données qui sont cohérentes en phase ou 
presque, comme dans le cas d'un crossfade entre 
deux régions ou instruments identiques (une 
boucle de batterie répétée, par exemple). Utilisez 
cette option pour éviter l'écrêtage qui peut se 

Présélection de courbe 1

Présélection de courbe 2

Présélection de courbe 3

Présélection de courbe 4

Présélection de courbe 5

Présélection de courbe 6

Présélection de courbe 7

Liaison de fondu
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produire avec un crossfade de puissance égale. 
Avec ce type de fondu, cliquer sur la courbe tout 
en appuyant sur la touche Option (Mac) ou Alt 
(Windows) la réinitialise à sa forme par défaut.

None : cette option désactive la liaison entre les 
courbes de fondu d'entrée et de sortie, ce qui 
permet de les régler séparément, notamment 
leurs points de début et de fin. Elle permet de 
créer des formes de crossfade personnalisées. 

Lorsque le paramètre Link est défini sur Equal 
Power ou Equal Gain, vous pouvez éditer 
uniquement le fondu d'entrée de la courbe ; 
pour cela, appuyez sur Option (Mac) ou sur Alt 
(Windows) tout en déplaçant le curseur. Pour 
n'éditer que le fondu de sortie de la courbe, 
appuyez sur Pomme (Mac) ou sur Ctrl 
(Windows) tout en vous déplaçant.

Paramètres de pente

(Fondu d'entrée et de sortie uniquement)

Les paramètres de la fenêtre Slope permettent de 
définir la pente des fondus d'entrée et de sortie. 
Sélectionnez Equal Power ou Equal Gain. 
Pour plus d'informations sur les fondus 
maintenant une puissance ou un gain 
constant(e), reportez-vous à la section Réglage 
des liens, page 543.

Option Use Dither

L'option Use Dither active une fonction 
présélectionnée de dithering avec mise en forme 
du bruit (noise shaping) qui améliore les 
performances audio lors du fondu au silence 
entrée ou en sortie, ou du crossfade entre deux 
régions de faible niveau. Le dithering n'est 
généralement pas utile lorsque vous réalisez un 
fondu entre deux régions d'amplitude audio 
élevée. Vous pouvez désactiver le dithering 
lorsque vous éditez vos fondus dans la boîte de 
dialogue Fades pour accélérer les aperçus et le 
recalcul du fondu, puis réactiver le dithering 
pour créer le fondu ou le crossfade définitif.

Réglage de la forme du fondu d'entrée

Le paramètre In Shape permet de définir la 
forme du fondu d'entrée d'une région (fondu) 
ou d'une région 2 (crossfade). 

Réglage du point de fin d'une courbe de fondu

Liaison de fondu

Option de dithering pour les fondus

Forme du fondu d'entrée
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Standard : sélectionne une courbe de fondu 
unique et continue. Ceci crée un fondu 
universel, susceptible d'être édité en déplaçant la 
courbe elle-même.

S Curve : sélectionne une courbe en S, dont les 
caractéristiques s'inversent au début et à la fin. 
On peut ainsi avoir un fondu d'entrée rapide en 
début de courbe et plus lent en fin. Les courbes 
en S sont utiles avec les données sur lesquelles 
les fondus sont difficiles à réaliser. Les courbes 
en S peuvent être éditées en faisant glisser la 
courbe dans l'éditeur de courbes.

Courbes présélectionnées : sept courbes 
présélectionnées sont à votre disposition pour 
accélérer le processus de création. Ces 
présélections peuvent être éditées en faisant 
glisser le point de fin de la courbe dans l'éditeur 
de courbe de cette boîte de dialogue. Ces sept 
présélections sont les suivantes :

! La présélection de courbe 1 maintient le 
volume au maximum pendant toute la durée du 
fondu dès le début du fondu d'entrée.

! La présélection de courbe 2 effectue un fondu 
d'entrée rapide, pour atteindre l'amplitude 
maximale relativement tôt dans la courbe de 
fondu.

! La présélection de courbe 3 effectue un fondu 
d'entrée relativement rapide.

! La présélection de courbe 4 effectue un fondu 
d'entrée de façon linéaire. C'est la courbe par 
défaut.

! La présélection de courbe 5 effectue un fondu 
d'entrée lent au début du fondu.

! La présélection de courbe 6 effectue un fondu 
d'entrée encore plus lent que la courbe 
précédente.

! La présélection de courbe 7 désactive toutes 
les données audio jusqu'à la fin du fondu.

Combinaisons classiques de courbes

Vous trouverez ci-après les combinaisons 
possibles de courbes de fondu d'entrée et de 
sortie.

Crossfade linéaire : il s'agit d'un crossfade (fondu 
enchaîné) polyvalent, créant une transition 
douce et progressive entre la région 1 et la 
région 2.

Présélection de courbe 1

Présélection de courbe 2

Présélection de courbe 3

Présélection de courbe 4

Présélection de courbe 5

Présélection de courbe 6

Présélection de courbe 7

Crossfade linéaire

1-out 2-in
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Crossfade à puissance constante : il s'agit d'un 
crossfade polyvalent qui est utile lorsqu'un 
crossfade linéaire semble créer une chute 
notable de niveau au point de jonction.

Fondu avec recouvrement : cette combinaison 
de courbes maintient les deux régions à niveau 
nominal pendant toute la durée du crossfade : la 
région 2 « monte en marche » au début, et la 
région 1 « descend en marche » à la fin.

Préférences de fondus et de 
crossfades

Vous pouvez définir des paramètres de fondu et 
de crossfade par défaut. Ces paramètres se 
chargent comme paramètres « de base » lorsque 
vous utilisez la commande Create Fades, ainsi 
que les commandes Fade to Start et Fade to End.

Pour définir les préférences de fondu et de 
crossfade :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Editing.

2  Définissez les durées de pré-roll et de post-roll 
pour les aperçus de fondu.

3  Cliquez sur Fade In et définissez la forme par 
défaut des fondus d'entrée, puis cliquez sur OK.

4  Cliquez sur Fade Out et définissez la forme par 
défaut des fondus de sortie, puis cliquez sur OK.

5  Cliquez sur Crossfade et définissez la forme 
par défaut des crossfades, puis cliquez sur OK.

6  Cliquez sur OK.

Création de fondus aux 
débuts et aux fins des régions
Pro Tools permet de créer des fondus d'entrée et 
de sortie en début et fin de régions. 

Avec Pro Tools HD, vous pouvez également 
utiliser une option de fondu automatique 
d'entrée et de sortie, qui permet d'appliquer des 
fondus d'entrée ou de sortie en temps réel à toutes 
les régions pendant la lecture. Ces fondus ne 
sont pas écrits sur le disque mais ils sont 
appliqués automatiquement lors de la lecture. 
Pour plus d'informations, reportez-vous à la 
section Utilisation des fondus automatiques, 
page 550.

Crossfade à puissance constante

Crossfade avec recouvrement

1-out 2-in

1-out

2-in

Préférences de fondu
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Création de fondus d'entrée et 
de sortie

Suivant la manière dont vous effectuez la 
sélection, vous pouvez placer un fondu d'entrée 
ou de sortie exactement au début ou à la fin 
d'une région, ou le placer de façon à ce qu'il 
déborde dans une zone vierge de la piste. La 
longueur de la sélection dans la région 
détermine la durée du fondu d'entrée ou de 
sortie.

Vous pouvez également effectuer un fondu vers 
le début ou la fin d'une région à partir d'un point 
d'insertion.

Bien que les fondus apparaissent comme des 
régions à part entière, ils ne peuvent pas être 
séparés des régions dans lesquelles ils ont été 
créés. 

Lors de changements de tempo sur une piste 
audio basée sur le métronome, les fondus 
d'entrée et de sortie demeurent avec leurs 
régions parentes. Les fondus conservent leur 
durée absolue et sont recalculés après les 
changements de tempo.

Pour créer un fondu d'entrée :

1  Sélectionnez le début de la région où vous 
voulez placer le fondu d'entrée. La sélection doit 
aller jusqu'au début exact de la région ou sur une 
zone vierge précédant la région sur la piste.

2  Effectuez l'une des opérations suivantes :

• Choisissez Edit > Fades > Create. 

– ou –

• Appuyez sur Pomme+F (Mac) ou sur Ctrl+F 
(Windows).

3  Sélectionnez la courbe de fondu d'entrée et 
configurez les paramètres du fondu.

4  Cliquez sur le bouton Audition pour écouter 
les fondus.

5  Réglez la courbe en la déplaçant ou en 
choisissant une forme différente dans le menu 
déroulant des formes de fondu d'entrée 
(In Shape).

6  Cliquez sur OK. 

Pro Tools calcule alors le fondu puis l'écrit sur le 
disque. La courbe de fondu sélectionnée 
apparaît dans la région.

Pour créer un fondu de sortie :

1  Sélectionnez la fin de la région sur laquelle 
vous voulez effectuer un fondu de sortie. La 
sélection doit aller jusqu'à la fin exacte de la 
région ou jusqu'à une zone vierge après la région 
dans la piste.

Région avec un fondu d'entrée Sélection du début d'une région pour un fondu d'entrée

Sélection de la fin d'une région pour un fondu de sortie
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2  Effectuez l'une des opérations suivantes :

• Choisissez Edit > Fades > Create. 

– ou –

• Appuyez sur Pomme+F (Mac) ou sur Ctrl+F 
(Windows).

3  Sélectionnez la courbe de fondu de sortie et 
configurez les paramètres du fondu.

4  Cliquez sur le bouton Audition pour écouter 
les fondus.

5  Réglez la courbe en la déplaçant ou en 
choisissant une forme différente dans le menu 
déroulant des formes de fondu de sortie 
(Out Shape).

6  Cliquez sur OK. 

Pro Tools calcule alors le fondu puis l'écrit sur le 
disque. Votre courbe de fondu apparaît dans la 
région.

Pour réaliser un fondu depuis le point d'insertion 
jusqu'au point de début d'une région :

1  Placez le curseur à l'emplacement désiré dans 
la région.

2  Effectuez l'une des opérations suivantes :

• Choisissez Edit > Fades > Fade To Start.

– ou –

• Appuyez sur Alt+D (Windows) ou sur 
Ctrl+D (Mac).

Le fondu est alors appliqué conformément aux 
préférences du fondu d'entrée (voir Préférences 
de fondus et de crossfades, page 546).

Pour réaliser un fondu depuis le point d'insertion 
jusqu'au point de fin d'une région :

1  Placez le curseur à l'emplacement désiré dans 
la région.

2  Effectuez l'une des opérations suivantes :

• Choisissez Edit > Fades > Fade To End.

– ou –

• Appuyez sur Alt+G (Windows) ou sur 
Ctrl+G (Mac).

Le fondu est alors appliqué conformément aux 
préférences du fondu de sortie (voir Préférences 
de fondus et de crossfades, page 546).

Création d'un crossfade

Pour créer un crossfade entre deux régions :

1  Cliquez avec le sélecteur sur le point où vous 
souhaitez faire commencer le crossfade dans la 
première région et faites-le glisser jusqu'au point 
de la seconde région où vous souhaitez qu'il se 
termine. Les sélections de crossfade peuvent 
commencer et se terminer n'importe où dans 
leurs régions respectives.

2  Effectuez l'une des opérations suivantes :

• Choisissez Edit > Fades > Create.

– ou –

• Appuyez sur Pomme+F (Mac) ou sur Ctrl+F 
(Windows).

3  Utilisez les boutons de vue pour régler la vue 
du crossfade. Le calcul de l'affichage de la forme 
d'onde peut demander quelques instants 
lorsque les sélections sont longues.

4  Sélectionnez une forme de sortie et une forme 
d'entrée.

5  Sélectionnez une option de liaison.

Par la suite, vous pouvez redimensionner la 
longueur des fondus à l'aide d'un outil de 
trimming.
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6  Cliquez sur le bouton Audition pour écouter le 
crossfade. Pour les longs crossfades, Pro Tools 
peut prendre quelques instants pour calculer et 
charger les données audio dans la RAM de 
lecture. 

7  Effectuez l'une des opérations suivantes :

• Réglez les courbes en sélectionnant des 
formes présélectionnées différentes dans 
les menus Out Shape et In Shape.

– ou –

• Déplacez les courbes de fondu d'entrée et 
de sortie pour personnaliser la forme 
affichée. Si vous choisissez None comme 
option de liaison, vous pouvez déplacer et 
régler les points de début ou de fin d'une 
courbe de fondu.

8  Cliquez sur le bouton Audition pour réécouter 
le crossfade.

9  Lorsque le crossfade vous convient, cliquez sur 
OK. Le fondu est calculé et écrit sur le disque, 
mais les fichiers audio et les régions demeurent 
inchangés. Les crossfades sont stockés dans le 
dossier Fade Files du dossier de la session.

Pour supprimer un crossfade, effectuez l'une des 
opérations suivantes :

" Sélectionnez la partie de la piste contenant les 
crossfades à supprimer, puis choisissez Edit > 
Fades > Delete. 

" Sélectionnez le crossfade avec l'outil 
d'accrochage de temps, puis appuyez sur Suppr 
(Mac) ou sur la touche de retour arrière 
(Windows). 

" Sélectionnez un outil d'édition, cliquez avec le 
bouton droit de la souris sur le crossfade à 
supprimer, puis sélectionnez la commande 
Delete Fades dans le menu contextuel qui 
s'affiche. 

Pour rogner un crossfade :

1  Sélectionnez le crossfade avec l'outil 
d'accrochage de temps ou en cliquant deux fois 
dessus avec le sélecteur.

2  A l'aide d'un des outils de trimming, agissez 
sur l'une ou l'autre extrémité du crossfade. Le 
crossfade est recalculé pour refléter la nouvelle 
durée après Rognage.

Crossfades sur des pistes audio basées 
sur des tics

Un nouveau rendu des crossfades est effectué en 
cas de modification du tempo dans une piste 
audio basée sur des tics. Le nouveau crossfade a 
une durée identique à celle qu'il avait avant le 
changement de tempo. 

S'il n'y pas suffisamment de données audio pour 
réaliser le crossfade, ou si la partie du nouveau 
crossfade sort des limites de régions valides, le 
crossfade est supprimé.

Sélections de pré/post crossfade

En effectuant une sélection qui commence ou se 
termine précisément au bord séparant deux 
régions, vous pouvez créer des « pré » ou des 
« positionnement » crossfades. Utilisez la 
touche de tabulation pour placer le point 
d'insertion exactement au début ou à la fin 
d'une région.

Par la suite, vous pouvez redimensionner la 
longueur des crossfades à l'aide d'un outil 
de trimming.
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Pour créer un pré- ou post-crossfade :

1  A l'aide du sélecteur, cliquez sur la piste 
contenant les régions entre lesquelles vous 
désirez créer le crossfade.

2  Effectuez l'une des opérations suivantes :

• Appuyez sur la touche de tabulation pour 
avancer à la limite de région suivante. 

– ou –

• Pour revenir à la limite de la région 
précédente, maintenez la touche Pomme 
(Mac) ou Ctrl (Windows) enfoncée et 
appuyez sur la touche de tabulation.

3  Développez la sélection comme suit :

• Pour ajuster votre sélection, déplacez-vous 
en appuyant sur Maj, ou appuyez sur Maj et 
la touche de tabulation (Tab) pour avancer 
la sélection vers la limite de la région 
suivante. 

– ou –

• Pour faire reculer la sélection vers la limite 
de la région précédente, appuyez sur 
Option+Maj+Tab (Mac) ou sur 
Ctrl+Maj+Tab (Windows).

4  Effectuez l'une des opérations suivantes :

• Choisissez Edit > Fades > Create.

– ou –

• Appuyez sur Pomme+F (Mac) ou sur Ctrl+F 
(Windows).

5  Sélectionnez un type de fondu et cliquez 
sur OK.

Utilisation des fondus 
automatiques
(Pro Tools HD uniquement)

Pro Tools HD permet d'appliquer 
automatiquement des fondus d'entrée et de 
sortie en temps réel à toutes les limites des 
régions composant une session. Indiquez la 
durée (de 0 à 10 ms) des fondus automatiques en 
temps réel à l'aide de la préférence Auto Region 
Fade In/Out Length de la page Operation 
Preferences). Ces fondus d'entrée et de sortie 
sont réalisés pendant la lecture. 
Ils n'apparaissent pas dans la fenêtre Edit et ne 
sont pas écrits sur le disque.

L'option de fondu automatique a également un 
effet sur l'emprunt des voix d'une session. 
Chaque fois que, dans une même voix, une piste 
virtuelle de priorité inférieure se manifeste dans 
un moment de silence d'une piste virtuelle de 
priorité supérieure, un fondu d'entrée et un 
fondu de sortie sont appliqués à la transition.

Cette fonction est particulièrement utile dans 
les situations de post production tels que le 
prémixage de dialogues. Par exemple, vous 
pouvez affecter à une même voix de Pro Tools 
une piste de dialogue et une piste 
d'« ambiance ». Vous pouvez ensuite définir 
l'option AutoFade sur une longueur modérée 
(4 ms environ) de manière à ce que chaque fois 
qu'un silence se produit dans le dialogue, la 
lecture bascule doucement sur la piste 
d'ambiance, puis revienne doucement au 
dialogue sans clics.

L'utilisation des fondus automatiques en entrée 
et en sortie vous épargne les côtés fastidieux de 
l'édition aux points de passages à zéro ou les 
nombreuses écritures (rendus) de fondus pour 
éliminer les clics en lecture. Toutefois, comme 
ces fondus automatiques ne sont pas écrits sur le 
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disque, ces clics existent toujours dans le fichier 
de son. Il en résulte que ces anomalies 
apparaîtront encore si vous utilisez les 
commandes Duplicate AudioSuite Plug-In ou 
Export Selected as Sound Files (à partir de la liste 
des régions) pour dupliquer plusieurs régions 
sous forme d'un fichier continu. Pour effectuer 
le rendu de ces fondus automatiques en temps 
réel, choisissez File > Bounce to > Disk.

Pour définir la durée des fondus automatiques 
d'entrée et de sortie :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation. 

2  Entrez une valeur entre 0 et 10 ms dans le 
champ Auto Region Fade In/Out Length. 
La valeur zéro (par défaut) indique l'absence 
d'atténuation automatique.

3  Cliquez sur OK. La valeur de l'option AutoFade 
est enregistrée avec la session et appliquée 
automatiquement à toutes les limites de région 
autonomes jusqu'à ce que vous la modifiiez.

Création de fondus et de 
crossfades groupés
Les fondus groupés permettent de créer 
plusieurs fondus simultanément. Effectuez des 
sélections dans plusieurs régions, puis utilisez la 
commande Create Fades pour créer des 
crossfades à chaque transition entre régions. 
Si votre sélection inclut des régions dans 
lesquelles se trouvent déjà des crossfades, cette 
fonction permet de les modifier.

Pour appliquer des crossfades entre plusieurs 
régions :

1  A l'aide du sélecteur, cliquez sur la première 
région dans laquelle vous voulez créer un 
crossfade. Vérifiez que la sélection inclut la 
région entière.

2  Déplacez le sélecteur pour étendre la sélection 
de manière à inclure la dernière la région dans 
laquelle vous voulez créer le crossfade. Vérifiez 
que la sélection inclut la région entière.

3  Effectuez l'une des opérations suivantes :

• Choisissez Edit > Fades > Create.

– ou –

• Appuyez sur Pomme+F (Mac) ou sur Ctrl+F 
(Windows).

4  La boîte de dialogue Batch Fades vous permet 
de créer des fondus, de créer des fondus en 
entrée et en sortie, d'ajuster des fondus existants 
ou d'effectuer plusieurs de ces opérations à la 
fois. 

Si vous choisissez de créer des fondus et des 
fondus d'entrée et de sortie, de nouveaux 
crossfades sont créés à chaque limite de région 
bordée par une autre région sélectionnée, un 
fondu d'entrée est créé au début de la première 
région et un fondu de sortie est créé à la fin de la 
dernière région.

Régions sélectionnées pour les fondus groupés



Guide de référence Pro Tools552

5  Sélectionnez le placement des fondus : 
Pre-Splice (avant la jonction), Centered (centré) 
ou Post-Splice (après la jonction) (voir A propos 
des crossfades et des courbes, page 539). 

6  Entrez une durée de crossfade en 
millisecondes.

7  Cliquez sur OK. 

Pro Tools crée alors les fondus dans toutes les 
régions sélectionnées.

Déplacement et déplacement 
par incrément des fondus et 
des crossfades
Les fondus et les crossfades peuvent être 
déplacés de manière classique ou par incrément 
dans les pistes, indépendamment des régions 
correspondantes. Lors des déplacements des 
fondus d'entrée et de sortie, les données audio 
sont masquées, puis réaffichées, suivant la 
position du fondu dans la région concernée. 
Le point de chevauchement entre deux régions 
varie également avec le déplacement des fondus. 
Par ailleurs, cette opération est contrainte aux 
limites sous-jacentes des régions.

Déplacement classique ou par 
incrément des fondus ou des 
crossfades dans des régions

Pour déplacer un fondu ou un crossfade dans des 
régions :

1  Sélectionnez le fondu ou le crossfade à 
déplacer en procédant comme suit :

• Sélectionnez l'outil d'accrochage de temps 
pour sélectionner le fondu.

– ou –

• Sélectionnez une plage de données 
incluant le fondu à l'aide du sélecteur.

Boîte de dialogue Batch Fades

Par la suite, vous pouvez redimensionner la 
longueur des fondus à l'aide d'un outil de 
trimming.

Sélection d'un fondu à l'aide de l'outil d'accrochage de 
temps
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2  Déplacez le fondu en effectuant l'une des 
opérations suivantes :

• Faites glisser le fondu vers un nouvel 
emplacement sur la piste à l'aide de l'outil 
d'accrochage de temps.

– ou –

• Déplacez le fondu par incrément sur la 
piste en appuyant sur les touches plus (+) 
ou moins (–) du pavé numérique.

Déplacement de régions 
contenant des fondus ou des 
crossfades

Déplacement de régions contenant des 
fondus ou des crossfades

Lorsque vous déplacez une sélection de région 
contenant un fondu d'entrée, un fondu de sortie 
ou un crossfade, le fondu est déplacé en même 
temps que la sélection.

Pour déplacer une sélection de région contenant 
des fondus ou des crossfades :

1  Effectuez l'une des opérations suivantes :

• A l'aide de l'outil d'accrochage de temps, 
cliquez sur une région (ou cliquez deux fois 
sur une région à l'aide du sélecteur) pour 
sélectionner la région ainsi que le fondu 
(d'entrée ou de sortie) correspondant.

– ou –

• Sélectionnez plusieurs régions contenant 
les fondus et crossfades à déplacer. 

2  Déplacez la sélection de région en effectuant 
l'une des opérations suivantes :

• Faites glisser la sélection de région vers un 
nouvel emplacement sur la piste à l'aide de 
la main.

– ou –

• Déplacez la sélection de région par 
incrément sur la piste en appuyant sur les 
touches plus (+) ou moins (–) du pavé 
numérique.

Déplacement par incrément des régions 
adjacentes aux fondus d'entrée ou 
de sortie

Lorsque vous déplacez une sélection de région 
adjacente à un fondu d'entrée ou de sortie sans 
sélectionner le fondu, la durée du fondu 
augmente ou diminue de manière à conserver le 
point de début ou de fin de fondu. L'étendu du 
changement dépend de la quantité de données 
audio situées en dehors du point de début ou de 
fin du fondu.

Déplacement d'un fondu à l'aide de l'outil d'accrochage 
de temps

Résultat du déplacement du fondu

Déplacement d'une région et du fondu correspondant
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Pour déplacer une région sans son fondu :

1  Sélectionnez la région sans sélectionner le 
fondu.

2  Déplacez la région par incrément en appuyant 
sur les touches plus (+) ou moins (–) du pavé 
numérique.

Déplacement de régions adjacentes à 
des crossfades

Lorsque vous déplacez l'une des deux régions 
adjacentes à un crossfade, les régions se 
séparent. L'état du fondu dépend de la 
définition de l'option Preserve Fades when 
Editing dans la page des préférences d'édition. 

Pour séparer des régions adjacentes à un 
crossfade et conserver le fondu correspondant :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Editing.

2  Sélectionnez l'option Preserve Fades when 
Editing.

3  Cliquez sur OK pour refermer la boîte de 
dialogue Preferences.

4  Utilisez l'outil d'accrochage de temps ou l'outil 
de séparation pour sélectionner l'une des deux 
régions adjacentes au crossfade.

5  Déplacez la région sélectionnée avec la main.

Pour séparer des régions adjacentes à un 
crossfade et supprimer le fondu :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Editing.

2  Désélectionnez l'option Preserve Fades when 
Editing.

3  Cliquez sur OK pour refermer la boîte de 
dialogue Preferences.

4  Utilisez l'outil d'accrochage de temps ou l'outil 
de séparation pour sélectionner l'une des deux 
régions adjacentes au crossfade.

Sélection d'une région sans le fondu correspondant

Déplacement par incrément d'une région sans le fondu 
correspondant

Sélection d'une région adjacente à un crossfade

Séparation de régions et préservation des fondus

Sélection d'une région adjacente à un crossfade
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5  Déplacez la région sélectionnée avec la main.

Déplacement par incrément de régions 
adjacentes à des crossfades

Lorsque vous déplacez par incrément l'une des 
deux régions adjacentes à un crossfade, le fondu 
s'étend de manière à préserver la position 
relative des points de début et de fin du 
crossfade. Sa longueur dépend de l'amplitude du 
chevauchement entre les deux régions. 

Si le déplacement par incrément de la région 
s'étend au-delà des limites des données audio 
disponibles pour le crossfade, le fondu est 
supprimé.

Pour déplacer une région par incrément et étendre 
le crossfade correspondant :

1  Utilisez l'outil d'accrochage de temps pour 
sélectionner l'une des deux régions adjacentes 
au crossfade.

2  Déplacez la région par incrément en appuyant 
sur les touches plus (+) ou moins (–) du pavé 
numérique.

Séparation de régions 
incluant des fondus ou des 
crossfades
Vous pouvez créer des régions à partir de 
données de piste se chevauchant à l'aide de 
fondus ou de crossfades. Les fondus de la région 
source sont ajustés à la nouvelle région.

Pour séparer une région contenant un fondu ou un 
crossfade :

1  Faites glisser le sélecteur pour sélectionner les 
données de la nouvelle région.

2  Effectuez l'une des opérations suivantes :

• Choisissez Edit > Separate Region > At 
Selection. 

– ou –

• Appuyez sur Pomme+E (Mac) ou sur Ctrl+E 
(Windows). 

Séparation de régions et suppression des fondus

Sélection d'une région adjacente à un crossfade

Extension du crossfade par déplacement par incrément
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A l'emplacement du chevauchement de la 
région et du fondu d'entrée ou de sortie, le 
fondu est rogné de manière à correspondre aux 
limites de la sélection.

A l'emplacement de chevauchement de la 
sélection et du crossfade, le crossfade est séparé 
en un fondu de sortie et un fondu d'entrée au 
niveau de la limite de la sélection.

Rognage de régions incluant 
des fondus ou des crossfades

Rognage d'une région au niveau d'une 
limite de fondu

Vous pouvez rogner des régions adjacentes aux 
limites de fondu et de crossfade. 

Pour rogner une région au niveau d'une limite de 
fondu :

" A l'aide de l'outil de trimming, cliquez sur la 
limite de région, puis déplacez-la de manière à 
rogner la région. Le fondu reste constant et 
respecte la nouvelle limite de région.

Rognage au niveau d'une sélection sur 
plusieurs fondus ou crossfades

Vous pouvez rogner des régions au niveau de 
sélections contenant des fondus ou des 
crossfades.

Pour rogner une région au niveau d'une sélection 
contenant des fondus, effectuez l'une des 
opérations suivantes :

" Effectuez une sélection dans la piste, puis 
choisissez Edit > Trim Region > To Selection. 
Le rognage peut s'appliquer sur plusieurs régions 
et sur plusieurs fondus. Les fondus affectés sont 
ajustés aux nouvelles limites de région.

Sélection de données chevauchant un fondu

Résultat de la commande Separate Region sur un 
fondu d'entrée

Sélection de données chevauchant un crossfade

Résultat de la commande Separate Region sur un 
crossfade

Déplacement d'une limite de région à l'aide de l'outil de 
trimming
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" A l'aide du sélecteur, cliquez dans la région, 
puis choisissez Edit > Trim Regions > Start to 
Insertion ou End to Insertion. Vous pouvez 
rogner la région jusqu'à sa limite dans la piste ou 
jusqu'à celle du fondu de la piste.

Formes et limites de fondu 
dans une vue d'automation
Vous pouvez afficher et modifier les formes et les 
limites de fondu dans les vues d'automation. Les 
données d'automation s'affichent alors de 
manière plus précise et sont plus facilement 
modifiables. Pour plus d'informations sur 
l'automation et les vues d'automation, consultez 
le chapitre 30, Automation.

Rognage au niveau d'une sélection sur plusieurs fondus

Informations de fondu dans une vue d'automation
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Chapitre 22 : Gestion des régions

La gestion des régions d'une session vous permet 
de limiter la configuration du système et du 
stockage au minimum, et simplifie les besoins 
d'archivage. Ce chapitre décrit plusieurs outils 
permettant de gérer les fichiers et les régions des 
sessions Pro Tools. 

Suppression du silence des 
régions
Les commandes Strip Silence analysent les 
sélections audio sur plusieurs pistes et 
suppriment (ou extraient) toutes les zones de 
silence en divisant la sélection en régions plus 
petites.

Les commandes Strip Silence permettent de 
supprimer les silences d'une région ou d'extraire 
les données audio tout en conservant les 
silences. La suppression des zones de silence 
s'utilise notamment lors de la préparation à la 
compression des données audio (voir 
Compactage d'un fichier audio, page 564). La 
commande Strip Silence permet de diviser 
automatiquement une sélection en plusieurs 
régions, afin de quantifier des données audio en 
une valeur de note ou de placer des effets 
sonores à des emplacements SMPTE précis.

Fenêtre Strip Silence

La fenêtre Strip Silence contient les commandes 
suivantes pour régler les paramètres pris en 
compte lors de la définition des zones de silence 
à l'aide de la commande Strip Silence. Le réglage 
de ces curseurs entraîne l'apparition de 
rectangles sur les zones de silence qui seront 
supprimées de la sélection (voir figure 22, 
page 561).

Strip Threshold : définit le seuil d'amplitude (de 
–48 dB à 0 dB) pris en compte pour la 
suppression du silence. Les données audio dont 
le niveau se situe au-dessous de ce seuil sont 
considérées comme du silence et sont 
supprimées. Les données audio se situant 
au-dessus de ce seuil sont conservées et définies 
comme de nouvelles régions.

Minimum Strip Duration : définit la durée 
minimale (de 0 à 10 000 ms) pendant laquelle le 
niveau des données doit rester au-dessous du 
seuil pour qu'elles soient considérées comme du 
silence. Utilisez ce paramètre pour éviter de créer 
une multitude de petites régions dans une 
même sélection.

Pour plus d'informations sur la gestion des 
fichiers, reportez-vous au chapitre 13, 
Gestion des fichiers et des sessions et 
compatibilité.

Fenêtre Strip Silence
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Region Start Pad : indique une valeur de temps 
devant être ajoutée au début de chaque nouvelle 
région créée avec la commande Strip Silence. 
Cela permet de conserver des données musicales 
se situant au-dessous du seuil, telles qu'une 
inspiration avant une phrase vocale ou le 
glissement des doigts sur les cordes avant un 
accord de guitare.

Region End Pad : indique une valeur de temps 
devant être ajoutée à la fin de chaque nouvelle 
région créée avec la commande Strip Silence, 
afin de respecter la résonance des sons.

Strip : supprime les silences détectés en 
conservant uniquement les régions contenant 
des données audio sur la piste.

Extract : supprime les données audio et 
conserve les parties silencieuses de la piste (cela 
correspond en quelque sorte à une fonction de 
suppression inverse du silence idéale pour 
générer une ambiance acoustique de la pièce 
que vous utiliserez ailleurs).

Rename : affiche la boîte de dialogue Rename 
Selected Regions (voir Désignation automatique 
des régions après suppression du silence, 
page 560).

Separate : divise les régions en fonction des 
limites détectées par Strip Silence. 

Désignation automatique des régions 
après suppression du silence

Le bouton Rename de la fenêtre Strip Silence 
ouvre la boîte de dialogue Rename Selected 
Regions, qui détermine la désignation des 
régions avec la commande Strip Silence. La boîte 
de dialogue mémorise vos paramètres 
précédents. Vous pouvez par ailleurs les effacer 
en cliquant sur le bouton Clear.

Name : spécifie le nom de base des régions créées 
avec la commande Strip Silence.

Number : spécifie le nombre de départ de la 
numérotation automatique séquentielle. 

Zeros : spécifie le nombre de zéros apparaissant 
avant le numéro attribué automatiquement.

Suffix : spécifie le texte ajouté à la fin du nom, 
après la numérotation automatique.

Par exemple, si vous définissez ces options 
d'attribution des noms sur :

• Name = SFX

• Number = 23

• Zeros = 1

• Suffix = .Reel1

Boîte de dialogue Rename Regions Selected
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Les noms des régions successivement créées avec 
la commande Strip Silence seront :

• SFX023.Reel1

• SFX024.Reel1

• SFX025.Reel1

• SFX026.Reel1

• SFX027.Reel1

• SFX028.Reel1

Utilisation de la suppression du 
silence

Pour supprimer le silence d'une sélection audio :

1  Sélectionnez une ou plusieurs régions audio. 

2  Choisissez Edit > Strip Silence.

3  Pour définir la méthode de désignation des 
régions crées avec la commande Strip Silence, 
cliquez sur Rename pour ouvrir la boîte de 
dialogue correspondante. Pour en savoir plus, 
reportez-vous à la section Désignation 
automatique des régions après suppression du 
silence, page 560.

4  Dans la fenêtre Strip Silence, réglez les 
curseurs Strip Threshold et Min Strip Duration 
jusqu'à ce que des rectangles apparaissent dans 
la sélection.

Pour affiner la résolution de ces curseurs, 
appuyez sur la touche Pomme (Mac) ou Ctrl 
(Windows) pendant que vous les réglez.

5  Pour conserver des données avant et après les 
nouvelles régions, réglez les curseurs Region 
Start Pad et Region End Pad.

6  Lorsque les rectangles de suppression du 
silence délimitent les données audio que vous 
voulez conserver, appuyez sur le bouton Strip.

Les données définies comme du silence sont 
supprimées de la sélection et de nouvelles 
régions sont créées : elles apparaissent 
également dans la liste des régions.

La commande Strip Silence est non destructive 
et ne supprime pas les données audio des 
fichiers audio parents. Outre la commande 
Undo, la commande Heal Separation vous 
permet de restaurer les données supprimées.

Figure 22.  Rectangles de suppression du silence

Suppression du silence, temps devant être ajouté au 
début et à la fin de la région

La suppression du silence fonctionne avec 
les pistes stéréo et multicanaux et conserve 
la cohérence de phase de leurs régions audio.

Attaque à 
ajouter

Déclin à 
ajouter
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Pour extraire des données audio d'une sélection 
audio à l'aide de la commande Strip Silence :

1  Effectuez une sélection d'édition.

2  Choisissez Edit > Strip Silence.

3  Pour définir la méthode de désignation des 
régions crées avec la commande Strip Silence, 
cliquez sur Rename pour ouvrir la boîte de 
dialogue Region List Auto Namer (voir 
Désignation automatique des régions après 
suppression du silence, page 560).

4  Dans la fenêtre Strip Silence, réglez les 
curseurs Strip Threshold et Min Strip Duration 
jusqu'à ce que des rectangles apparaissent dans 
la sélection.

5  Cliquez sur le bouton Extract.

Toutes les données audio au-delà du seuil 
indiqué sont supprimées et les portions de 
silence de la piste sont conservées.

Pour séparer des régions à l'aide de la commande 
Strip Silence :

1  Effectuez une sélection de temps ou d'édition.

2  Choisissez Edit > Strip Silence.

3  Pour définir la méthode de désignation des 
régions crées avec la commande Strip Silence, 
cliquez sur Rename pour ouvrir la boîte de 
dialogue Region List Auto Namer (voir 
Désignation automatique des régions après 
suppression du silence, page 560).

4  Dans la fenêtre Strip Silence, réglez les 
curseurs Strip Threshold et Min Strip Duration 
jusqu'à ce que des rectangles apparaissent dans 
la sélection.

5  Cliquez sur le bouton Separate.

De nouvelles régions sont générées en fonction 
des limites détectées par la commande Strip 
Silence. 

Insertion de silence
La commande Insert Silence constitue une 
méthode simple et pratique pour insérer des 
zones de silence dans les pistes audio, MIDI et 
d'instrument. Cette commande permet 
d'effectuer une sélection sur une piste (ou 
plusieurs) et d'insérer précisément cette durée de 
silence. 

En mode Shuffle, toutes les données de la piste 
sont décalées plus loin sur la piste d'une durée 
égale à la sélection.

En mode Grid, la commande Insert Silence 
fonctionne comme la commande Clear.

En mode Shuffle, les conditions suivantes 
s'appliquent lorsque vous insérez du silence sur 
plusieurs pistes :

! Si des pistes sont affichées sous forme de 
données audio ou MIDI, la durée de silence 
sélectionnée est insérée dans les données audio 
ou MIDI et dans toutes les données 
d'automation sous-jacentes de toutes les pistes 
sélectionnées. Toutes les régions situées après 
sont déplacées de la quantité de silence insérée. 
Sur les pistes MIDI, seules les notes sélectionnées 
à partir de leur début sont concernées, ce qui 
signifie que si vous avez sélectionné la fin d'une 
note et que vous insérez du silence, cette note 
restera inchangée.

! Si toutes les pistes sélectionnées apparaissent 
sous forme de données d'automation, la plage 
sélectionnée n'est nettoyée que du type de 
données d'automation affiché dans chaque 
piste. Les régions ne sont pas déplacées. A la 
place, un espace vierge apparaît, d'une durée 
égale à celle de la sélection.
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! Si toutes les pistes sélectionnées s'affichent 
sous forme de données d'automation, appuyez 
sur la touche Ctrl (Mac) ou sur Démarrer 
(Windows) tout en choisissant la commande 
Insert Silence pour insérer du silence sur toutes 
les playlists d'automation de toutes les pistes 
sélectionnées. Les régions ne sont pas déplacées.

En mode Slip, les conditions suivantes 
s'appliquent lorsque vous insérez du silence sur 
plusieurs pistes :

! Si des pistes sont affichées sous forme de 
données audio ou MIDI, la plage sélectionnée 
est supprimée des données audio ou MIDI et de 
toutes les données d'automation sous-jacentes 
de toutes les pistes sélectionnées.

! Si toutes les pistes sélectionnées s'affichent 
sous forme de données d'automation, le silence 
n'est inséré que dans le type de données 
d'automation affiché dans chaque piste.

! Si toutes les pistes sélectionnées s'affichent 
sous forme de données d'automation, appuyez 
sur la touche Ctrl (Mac) ou sur Démarrer 
(Windows) tout en choisissant la commande 
Insert Silence pour insérer du silence sur toutes 
les playlists d'automation de toutes les pistes 
sélectionnées.

Pour insérer du silence dans une piste :

1  Effectuez une sélection sur une ou plusieurs 
pistes. La longueur de la sélection détermine la 
durée du silence inséré.

2  Choisissez Edit > Insert Silence.

En mode Shuffle, Pro Tools insère la durée de 
silence sélectionnée. En même temps, il divise 
les régions au début du point d'insertion et 
décale plus loin les nouvelles régions, d'une 
durée égale à celle de la sélection.

Commande de consolidation
Au fil d'une succession normale d'opérations 
d'édition, une piste peut accumuler de 
nombreuses régions. Cependant, lorsqu'une 
piste ou une de ses régions (un couplet ou un 
refrain) a atteint un état satisfaisant, il peut 
s'avérer souhaitable de regrouper ses multiples 
régions en une seule.

Lorsque vous consolidez (entièrement ou 
partiellement) une piste audio, un nouveau 
fichier audio est écrit. Ce fichier correspond à la 
sélection entière avec tous les espaces vierges 
qu'elle contient. 

Lors de la consolidation, les régions dont le son 
est coupé sont traitées comme des zones de 
silence. En revanche, l'activation ou la 
désactivation du son (ou la définition d'une 
automation de coupure) sur une piste n'a pas 
d'incidence sur la commande Consolidate.

Pour consolider des régions d'une piste :

1  Effectuez l'une des opérations suivantes :

• A l'aide de l'outil d'accrochage de temps ou 
du sélecteur, sélectionnez les régions que 
vous voulez consolider. 

– ou –

• Pour sélectionner toutes les régions d'une 
piste, cliquez trois fois dans sa playlist avec 
le sélecteur.

2  Choisissez Edit > Consolidate.

La consolidation d'une piste audio ne 
consolide pas les données d'automation 
sous-jacentes. Pour créer un seul fichier avec 
des données d'automation appliquées aux 
données audio, utilisez la commande 
Bounce to Disk (voir Bounce to Disk :, 
page 858).
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Compactage d'un fichier 
audio
La commande Compact Selected supprime les 
parties inutilisées des fichiers audio, afin 
d'économiser l'espace sur le disque et de 
préparer des sauvegardes plus propres sur le 
disque dur. La commande Compact Selected 
supprime également les fichiers audio qui ne 
sont référencés par aucune région et aucune 
piste.

Du fait qu'elle supprime définitivement les 
données audio, la commande Compact Selected 
ne doit être utilisée que lorsque vous avez 
terminé vos opérations d'édition et lorsque vous 
êtes certain de ne plus avoir besoin des données 
audio inutilisées.

La commande Compact Selected peut encadrer 
les régions du fichier compacté d'une durée 
définie par l'utilisateur. Si les régions de la 
session utilisent des crossfades ou si vous 
souhaitez encadrer les régions en prévision d'un 
futur rognage, entrez la durée correspondante 
(en millisecondes).

Pour compacter un fichier audio :

1  Dans le menu déroulant de la liste des régions, 
choisissez Select > Unused. Toutes les régions 
qui n'ont pas été placées dans une piste de la 
session actuelle sont mises en surbrillance dans 
la liste des régions. 

2  Pour supprimer toutes les régions audio 
inutiles, choisissez Clear Selected dans le menu 
déroulant de la liste des régions. Lorsque la boîte 
de dialogue s'ouvre, choisissez Remove.

3  Dans la liste des régions, sélectionnez la ou les 
régions que vous voulez compacter.

4  Dans le menu déroulant de la liste des régions, 
choisissez Compact Selected.

5  Entrez la durée en millisecondes que vous 
souhaitez définir pour chaque région du fichier.

6  Cliquez sur Compact pour compacter le 
fichier ou sur Cancel pour annuler la 
commande. 

Lorsque l'opération de compactage est terminée, 
la session est automatiquement enregistrée.

Attribution de noms et 
affichage des régions
Une session classique peut rapidement 
accumuler des dizaines de pistes et des centaines 
de régions. Cependant, pour parvenir à gérer des 
régions d'une session et à en assurer le suivi, 
vous pouvez effectuer les opérations suivantes :

• Renommer des régions existantes

• Préciser la méthode de désignation 
automatique des régions

• Masquer les régions créées 
automatiquement

• Supprimer les régions inutilisées

La commande Compact Selected est 
destructive et ne peut être annulée. 
Elle modifie définitivement les fichiers 
audio d'origine. Il n'existe aucun moyen de 
restaurer les données supprimées par cette 
commande.
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Changement de nom des régions

Au cours d'une session, vous pouvez renommer 
des régions pour leur donner des noms plus 
descriptifs, les raccourcir ou les simplifier. 
Lorsque vous renommez une région créée 
automatiquement lors d'une opération 
d'édition, elle devient une région définie par 
l'utilisateur et apparaît dans la liste des régions, 
alors que les régions créées automatiquement 
sont masquées.

La façon la plus simple de renommer une 
région, si elle réside sur une piste, consiste à 
cliquer deux fois dessus avec un des outils 
d'accrochage. Si la région ne réside pas sur une 
piste ou si vous souhaitez renommer plusieurs 
régions, utilisez la commande Rename dans la 
liste des régions.

Vous pouvez également renommer une région 
dans une piste à l'aide de la commande Rename 
du menu déroulant de la liste des régions.

Pour renommer une ou plusieurs régions :

1  Si vous voulez renommer une région créée 
automatiquement, sélectionnez Show > 
Auto-Created dans la liste des régions.

2  Sélectionnez une ou plusieurs régions à 
renommer dans la liste des régions.

3  Dans le menu déroulant de la liste des régions, 
choisissez Rename.

4  Dans la boîte de dialogue Rename Selected, 
entrez le nouveau nom de la région. Si la région 
audio sélectionnée correspond à un fichier 
complet, précisez si vous souhaitez renommer 
uniquement la région ou la région et le fichier 
sur le disque.

5  Cliquez sur OK pour renommer la région. 
Si vous renommez plusieurs régions vous êtes 
invité à les renommer l'une après l'autre.

Options de désignation 
automatique

Vous pouvez indiquer les paramètres de 
désignation automatique d'une région lorsque 
des régions sont créées automatiquement à 
partir de la première en cours d'édition. 

La désignation automatique d'une région n'a pas 
d'incidence sur les noms des fichiers audio 
parents. En revanche, elle mémorise des 
pointeurs vers les régions au sein du fichier 
source parent.Si l'option Region List Selection Follows Edit 

Selection est activée dans les préférences 
d'édition, vous pouvez sélectionner une 
région dans la liste des régions en la 
sélectionnant directement dans une piste.

Boîte de dialogue Rename Selected
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Pour définir les options de désignation 
automatique d'une région :

1  Sélectionnez une région dans la liste des 
régions.

2  Choisissez Auto Rename dans le menu 
déroulant de la liste des régions.

3  Dans la boîte de dialogue Rename Regions, 
entrez le texte qui sera utilisé pour nommer les 
régions créées à partir de la région sélectionnée.

Name : détermine le nom racine des régions 
créées automatiquement.

Number : définit le nombre de départ de la 
numérotation automatique séquentielle.

Zeros : spécifie le nombre de zéros apparaissant 
avant le numéro attribué automatiquement.

Suffix : spécifie le texte ajouté à la fin du nom, 
après la numérotation automatique.

4  Cliquez sur OK.

Masquage et suppression des 
régions inutiles

Au fil des éditions d'une session, la liste des 
régions peut accumuler rapidement de 
nombreuses régions : celles que vous avez créées 
intentionnellement et celles qui ont été créées 
automatiquement en coupant, collant et 
séparant d'autres régions ou en important des 
fichiers REX, ACID ou des fichiers de groupes de 

régions. Pro Tools permet de masquer et de 
supprimer des régions de votre session, de 
manière à minimiser le nombre d'entrées de la 
liste des régions.

Masquage des régions créées 
automatiquement

Vous pouvez masquer les régions créées 
automatiquement en cours d'édition.

Pour masquer les régions créées 
automatiquement :

" Dans la liste des régions, désélectionnez 
Show > Auto-Created. Lorsque cette option n'est 
pas sélectionnée, seules les régions définies par 
l'utilisateur apparaissent dans la liste des 
régions.

Les régions définies par l'utilisateur incluent :

• Les régions correspondant à un fichier 
complet

• Les régions créées pendant l'enregistrement

• Les régions importées

• Les régions renommées

• Les régions créées suite à un traitement 
AudioSuite

• Les nouvelles régions créées à l'aide de la 
commande Region > Capture ou des 
commandes Edit > Separate Region

• Les régions créées en rognant des régions 
audio de fichiers complets

Lorsque les régions créées automatiquement 
sont masquées, Pro Tools vous avertit dès que 
leur nombre excède un certain seuil et permet de 
les supprimer. Si vous choisissez de les suppri-
mer, toutes les régions créées automatiquement 
sont supprimées en même temps. 

Pour que les régions créées automatiquement 
soient conservées, veillez à les renommer (voir 
Changement de nom des régions, page 565).

Boîte de dialogue Rename Regions Selected
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Suppression des régions inutiles

Dans la liste des régions, vous pouvez 
sélectionner les régions superflues, puis les 
supprimer de la session à l'aide de la commande 
Clear. Il est également possible de supprimer de 
façon permanente du disque dur des régions 
correspondant à un fichier complet.

Pour rechercher et supprimer les régions inutiles 
d'une session :

1  Effectuez l'une des opérations suivantes :

• Pour les régions MIDI, choisissez Select > 
Unused dans le menu déroulant de la liste 
des régions.

– ou –

• Pour les régions audio, dans le menu 
déroulant Region List, choisissez Select, 
puis Unused, Unused Except Whole Files 
ou Offline (suivant le cas).

2  Après avoir sélectionné toutes les régions 
inutiles, choisissez Clear dans le menu 
déroulant de la liste des régions.

3  Dans la boîte de dialogue Clear Audio, 
effectuez l'une des opérations suivantes :

• Cliquez sur Remove pour supprimer les 
pistes inutiles de la session.

– ou –

• Si vous supprimez une région audio 
correspondant à un fichier complet, et que 
vous voulez supprimer définitivement le 
fichier audio de votre disque dur, cliquez 
sur Delete.

Lorsque vous supprimez des fichiers audio pour 
plusieurs régions, Pro Tools ouvre une boîte de 
dialogue d'avertissement pour chaque fichier 
audio. 

Pour ne plus afficher ces boîtes de dialogue 
d'avertissement :

" Cliquez sur le bouton Delete de la boîte de 
dialogue Clear en maintenant enfoncée la 
touche Option (Mac) ou Alt (Windows). Cette 
opération supprime définitivement chaque 
fichier audio de votre disque dur (pour chacune 
des régions inutiles), sans avertissement 
préalable. 

La commande Clear ne peut pas être 
annulée.

Boîte de dialogue Clear Selected (régions audio)

Le mode de suppression doit être utilisé avec 
précaution. En effet, la suppression des 
fichiers est définitive.
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Chapitre 23 : Pistes du chef 
d'orchestre et emplacements mémoire

Dans Pro Tools, les modifications apportées aux 
données de tempo, de mesure et de tonalité se 
trouvent dans les pistes du chef d'orchestre. Les 
événements de mesure et de tempo ont une 
incidence sur la résolution temporelle (les tics) 
des pistes et fournissent également la table de 
mesures et de tempos de la grille Bar|Beat et du 
métronome. Les modifications apportées aux 
données de tonalité peuvent se répercuter sur les 
notes MIDI lors de l'application d'une 
transposition. 

Vous pouvez modifier les événements de tempo 
dans la règle Tempo ou dans l'éditeur prévu à cet 
effet. Pour modifier les événements de mesure et 
les données de tonalité, utilisez respectivement 
la règle de métrique et la règle de signature de 
tonalité. 

Les emplacements mémoire constituent une 
méthode de navigation dans votre session 
particulièrement utile lors de l'édition et 
l'organisation des pistes. Ces emplacements 
peuvent représenter des marqueurs de timeline, 
des sélections d'édition ou encore un ensemble 
de paramètres d'affichage de piste susceptible 
d'être rappelé.

Marqueur de début de 
morceau
Le marqueur de début de morceau définit le 
tempo initial du matériel exprimé en 
mesures/temps (Bar|Beat). Les nouvelles sessions 
s'ouvrent avec un tempo par défaut de 120 BPM.

Lorsqu'une session est créée, le marqueur de 
début de morceau n'est associé à aucun 
événement de métrique. Un événement de 
métrique est ajouté automatiquement au début 
du morceau si vous insérez un événement de 
métrique à un autre emplacement de la règle de 
métrique.

Le marqueur de début de morceau peut être 
déplacé, mais pas supprimé.

Marqueur Song Start

L'emplacement du marqueur de début de 
morceau peut également être modifié dans 
la fenêtre Time Operations (voir 
Déplacement du début d'un morceau, 
page 600).
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Pour déplacer le marqueur de début de morceau en 
le faisant glisser :

" Dans la règle de tempo, faites glisser le 
marqueur vers la gauche ou la droite.

Si le mode d'édition est défini sur Grid, le 
marqueur de début de morceau se déplace par 
incréments du pas de grille actuel. 

Pour éditer le tempo initial dans le marqueur de 
début de morceau :

1  Dans la règle de tempo, cliquez deux fois sur le 
marqueur de début de morceau.

2  Dans la boîte de dialogue Change Tempo, 
entrez une nouvelle valeur BPM.

3  Cliquez sur OK.

Tempo
La règle de tempo permet de modifier les 
événements de tempo, un par un. Vous pouvez 
modifier le tempo visuellement dans l'éditeur ou 
apporter des modifications précises dans la 
fenêtre Tempo Operations. 

Evénements de tempo

Les événements de tempo peuvent être attribués 
au marqueur de début de morceau pour 
remplacer le tempo par défaut (120 BPM) et 
permettent de modifier le tempo à 
l'emplacement de session où ils sont insérés. 

Pour afficher la règle de tempo :

" Sélectionnez View > Rulers > Tempo.

Déplacement du marqueur

Pour ne déplacer que le marqueur de début 
de morceau, sans déplacer aucune donnée 
basée sur les tics, maintenez les touches 
Démarrer+Maj (Windows) ou Ctrl+Maj 
(Mac) enfoncées pendant que vous le faites 
glisser. Au cours de cette opération, le 
déplacement est limité à l'incrément de 
mesure uniquement. 

Pour définir le tempo par défaut d'une 
session, reportez-vous à la section Réglage 
du tempo et de la métrique par défaut, 
page 321.

Il est possible d'utiliser Beat Detective pour 
générer les marqueurs Bar|Beat (table de 
tempos). Pour plus d'informations, 
reportez-vous à la section Création de 
marqueurs Bar|Beat avec le Beat Detective, 
page 629.

En mode de tempo manuel, la piste de 
tempo est ignorée et la session est lue au 
tempo défini dans la fenêtre Transport 
(voir Utilisation du mode tempo manuel, 
page 322).
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Tempo actuel

Conforme aux événements de tempo survenant 
en cours de lecture, le tempo actuel de la session 
s'affiche dans la fenêtre Transport.

Insertion d'événements de tempo

Pour insérer un événement de tempo :

1  Cliquez sur la règle de tempo à l'endroit où 
vous voulez insérer l'événement de tempo.

2  Cliquez sur le bouton Add Tempo Change 
situé à gauche de la règle de tempo.

3  Dans la fenêtre Tempo Change, entrez 
l'emplacement (Location) et la valeur BPM de 
changement du tempo. 

Cochez l'option Snap To Bar pour placer 
l'événement de tempo inséré précisément sur le 
premier temps de la mesure la plus proche.

4  Pour baser la valeur BPM sur un élément autre 
que la noire par défaut, sélectionnez une autre 
valeur.

5  Cliquez sur OK. Le nouvel événement de 
tempo est inséré et apparaît dans la règle de 
tempo.

A chaque événement de tempo est associé un 
petit triangle vert qui indique son emplacement. 
Vous pouvez faire glisser ce triangle pour 
déplacer l'événement de tempo ou cliquer deux 
fois dessus pour l'éditer.

Edition et déplacement des 
événements de tempo

Les événements de tempo existants peuvent être 
déplacés, édités, copiés et collés.

Pour déplacer un événement de tempo en le 
faisant glisser :

" Dans la règle de tempo, faites glisser le triangle 
de l'événement de tempo vers la gauche ou la 
droite.

Lorsque le mode d'édition est réglé sur Grid, 
l'événement déplacé s'aligne sur le pas de grille 
courante. 

Tempo actuel affiché dans la fenêtre Transport

Bouton d'ajout de changement de tempo

Boîte de dialogue Change Tempo

Indicateur du tempo actuel

Evénement de tempo inséré

Déplacement d'un événement de tempo
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Pour éditer un événement de tempo :

1  Dans la règle de tempo, cliquez deux fois sur 
l'événement de tempo.

2  Dans la boîte de dialogue Tempo Change, 
entrez un nouvel emplacement (Location) ou 
une nouvelle valeur BPM pour l'événement de 
tempo.

3  Cliquez sur OK.

Pour supprimer un événement de tempo :

" Tout en appuyant sur Option (Mac) ou sur Alt 
(Windows), déplacez le curseur sur l'événement 
de tempo (le curseur devient un outil 
d'accrochage associé au signe « – ») et cliquez 
dessus pour le supprimer.

Pour copier et coller plusieurs événements de 
tempo :

1  A l'aide du sélecteur, cliquez sur la règle de 
tempo et faites glisser le curseur pour 
sélectionner la plage de mesures qui contient les 
événements de tempo.

2  Choisissez Edit > Copy.

3  Cliquez dans la règle de tempo à l'endroit où 
vous souhaitez coller les événements de tempo.

4  Choisissez Edit > Paste. Le contenu du 
presse-papiers est collé à partir du point 
d'insertion et remplace les événements de 
tempo existants.

Pour étendre une sélection d'édition d'une piste à 
la règle de tempo :

1  A l'aide du sélecteur ou de l'outil d'accrochage 
de temps, sélectionnez une plage de temps.

2  Cliquez sur la règle de tempo tout en 
appuyant sur Maj. 

Pour sélectionner tous les événements de tempo :

" Cliquez deux fois avec le sélecteur dans la 
règle de tempo.

Pour supprimer une plage sélectionnée 
d'événements de tempo :

1  Pour restreindre la sélection en fonction du 
pas de grille actuel, réglez le mode d'édition 
sur Grid. 

2  Déplacez le sélecteur dans la règle de tempo 
pour sélectionner les événements de tempo que 
vous voulez supprimer.

3  Choisissez Edit > Clear pour supprimer les 
événements de tempo sélectionnés.

Battement du tempo

Vous pouvez définir manuellement le tempo 
dans une session Pro Tools à l'aide des touches 
de votre clavier. Vous pouvez également utiliser 
un clavier MIDI, relié à l'ordinateur, pour battre 
le tempo.

Pour régler le tempo manuel à l'aide du clavier :

1  Pour faire apparaître les commandes MIDI 
dans la fenêtre Transport, sélectionnez View > 
Transport > MIDI Controls.

2  Dans la fenêtre Transport, cliquez sur le 
bouton Tempo Ruler Enable (chef d'orchestre) 
pour qu'il n'apparaisse plus en surbrillance. 
Pro Tools passe en mode Manual Tempo. 
Dans ce mode, tous les événements de tempo 
enregistrés sur la piste de tempo sont ignorés.

Evénements de tempo sélectionnés

Appuyez sur Option (Mac) ou sur Alt 
(Windows) et déplacez le curseur pour 
effectuer la sélection dans toutes les pistes 
du chef d'orchestre.
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3  Cliquez dans le champ du tempo pour le faire 
apparaître en surbrillance et appuyez sur la 
touche T de votre clavier de façon répétée au 
rythme du nouveau tempo.

Pour régler le tempo manuel en le battant en 
rythme sur un clavier MIDI externe :

1  Pour faire apparaître les commandes MIDI 
dans la fenêtre Transport, sélectionnez View > 
Transport > MIDI Controls.

2  Choisissez Setup > Preferences et cliquez sur 
l'onglet MIDI.

3  Sélectionnez Use MIDI To Tap Tempo.

4  Dans la fenêtre Transport, cliquez sur le 
bouton Tempo Ruler Enable (chef d'orchestre) 
pour qu'il n'apparaisse plus en surbrillance. 
Pro Tools passe en mode Manual Tempo. Dans 
ce mode, tous les événements de tempo 
enregistrés sur la piste de tempo sont ignorés.

5  Cliquez dans le champ Tempo pour le faire 
apparaître en surbrillance et battez le tempo en 
jouant une note de façon répétée sur le clavier 
de votre contrôleur MIDI.

Pour calculer le nouveau tempo, Pro Tools fait la 
moyenne des huit derniers battements (ou 
moins) afin de déterminer le tempo. La 
valeur BPM calculée apparaît dans le champ 
Tempo de la fenêtre Transport.

Changements du tempo et 
décalage d'automation

Lorsqu'une piste est basée sur les échantillons, la 
playlist d'automation de la piste n'est pas 
concernée par les modifications apportées au 
tempo. Dès lors, l'automation s'aligne 
systématiquement sur les données audio de la 
piste en respectant les échantillons.

En revanche, lorsqu'une piste est basée sur les 
tics, les points d'inflexion des courbes 
d'automation sont modifiés pour refléter les 
modifications du tempo.

Lorsque vous changez le tempo, la durée de 
chaque région audio d'une piste ne subit aucune 
modification. Aussi, les données d'automation 
des pistes basées sur les tics ne sont plus 
synchronisées avec les données audio. 

Mode de tempo manuel activé

Pour appliquer le nouveau tempo à 
l'intégralité de la session, il suffit de 
modifier le tempo par défaut associé au 
marqueur de début de morceau. Pour plus 
d'informations, reportez-vous à la section 
Marqueur de début de morceau, page 569.

Bouton d'activation 
de la règle de 
tempo

Champ du tempo

Changements de tempo appliqués à des régions plus 
grandes

Lorsque le tempo d'une piste basée sur 

...l'automation n'est plus synchronisée.

les tics change...
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Limitation du décalage de l'automation

En général, plus les régions audio sont grandes, 
plus le décalage de l'automation est marqué. 
En créant, de nombreuses régions de petite 
taille, il est possible de minimiser les effets du 
décalage de l'automation, car le point de départ 
de chaque région suivante est lié au changement 
du tempo. Lorsque le tempo diminue, 
l'automation augmente ; lorsque le tempo 
augmente, l'automation se réduit.

Editeur de tempo graphique
L'éditeur de tempo, représenté par une fenêtre 
redimensionnable située sous la règle de tempo 
dans la fenêtre Edit, permet de visualiser et de 
modifier graphiquement les informations.

Editeur de tempo

L'éditeur de tempo est une extension de la règle 
de tempo et s'ouvre à partir de la zone des règles 
de la fenêtre Edit. 

Pour afficher l'éditeur de tempo, effectuez l'une 
des opérations suivantes :

" Sélectionnez View > Rulers > Tempo, puis 
View > Rulers > Tempo > Tempo Editor.

– ou –

" Cliquez sur le triangle Développer/réduire de 
l'éditeur de tempo.

Changements de tempo appliqués à de petites régions

Pour diviser une région audio en régions plus 
petites, utilisez Beat Detective. Pour plus 
d'informations, consultez la section 
chapitre 24, Beat Detective.

Vous pouvez également séparer les régions 
au niveau des transitoires ou en fonction de 
la résolution actuelle de la grille. Pour plus 
d'informations, consultez la section 
Commandes Separate Region, page 486.

L'utilisation d'un grand nombre de petites régions...

...permet de conserver la synchronisation 
audio en cas de changement de l'automation.

Editeur de tempo

Triangle Développer/Réduire de l'éditeur de tempo

Evénements 

Résolution du tempo

Densité d'édition du tempo
de tempo
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Edition des événements de tempo 
dans l'éditeur de tempo

Pour modifier les événements de tempo 
contenus dans l'éditeur de tempo, effectuez 
l'une des opérations suivantes :

! Vous pouvez déplacer des événements de 
tempo individuels à l'aide d'un outil 
d'accrochage afin d'ajuster leur emplacement ou 
leur valeur.

! Vous pouvez décaler vers le haut ou vers le bas 
un groupe de tempos sélectionné avec l'outil de 
trimming.

! Vous pouvez dessiner de nouveaux 
événements de tempo avec le crayon pour 
remplacer des événements.

! Vous pouvez copier et coller, déplacer et 
décaler des événements de tempo.

Dessin d'événements de tempo

Les événements de tempo peuvent être dessinés 
dans l'éditeur de tempo à l'aide du crayon.

Freehand : permet de dessiner librement en 
faisant glisser la souris. La forme est reproduite 
sous forme d'une série d'étapes, conformément 
au paramètre Tempo Edit Density. (pour en 
savoir plus, reportez-vous à la section Sélection 
de la densité d'édition du tempo, page 576).

Line : le crayon en forme de ligne trace une ligne 
droite lorsque vous cliquez puis relâchez la 
souris. Les valeurs de tempo se transforment en 
une série d'étapes selon les paramètres Tempo 
Edit Density et Resolution. (pour en savoir plus, 
reportez-vous à la section Sélection de la densité 
d'édition du tempo, page 576).

Parabolic : la forme parabolique dessine la 
meilleure courbe possible afin de s'ajuster à 
votre dessin à main levée. La forme est 
reproduite sous forme d'une série d'étapes, 
conformément au paramètre Tempo Edit 
Density.

S Curve : le crayon en forme de courbe en S trace 
la meilleure courbe en S possible afin de s'ajuster 
à votre dessin à main levée. La forme est 
reproduite sous forme d'une série d'étapes, 
conformément au paramètre Tempo Edit 
Density.

Menu déroulant de formes de l'outil Crayon

Ces formes
ne sont pas
opérationnelles
dans l'éditeur
de tempo.

Les autres formes du crayon (triangle, carré 
et forme aléatoire) ne concernent pas les 
événements de tempo.
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Sélection de la résolution du tempo 
(rapport BPM)

L'éditeur de tempo vous permet de spécifier la 
valeur de la note sur laquelle se base le rapport 
BPM pour tous les événements de tempo créés 
lorsque vous dessinez une courbe de tempo avec 
le crayon. La valeur de la note s'appelle la 
résolution du tempo (paramètre Tempo 
Resolution).

Pour sélectionner la résolution du tempo (rate 
BPM) pour l'édition au crayon, effectuez l'une des 
opérations suivantes :

" Cliquez sur le sélecteur de résolution de 
tempo et sélectionnez une valeur de note dans le 
menu déroulant. Cette valeur de note s'applique 
à la fréquence BPM des événements de tempo 
créés à l'aide du crayon.

– ou –

" Sélectionnez l'option Follow Metronome 
Click. La valeur BPM des événements de tempo 
créés à l'aide du crayon est telle qu'elle reflète les 
valeurs du métronome définies par les 
événements de métrique dans la règle métrique. 

Une courbe de tempo peut inclure des valeurs 
BPM différentes en cas de modification du 
métronome dans la plage sélectionnée.

Sélection de la densité d'édition du tempo

L'éditeur de tempo permet de spécifier la densité 
des événements de tempo créés dans la règle de 
tempo lorsque vous dessinez une courbe de 
tempo à l'aide du crayon.

Sélecteur de résolution du tempo et menu déroulant

Digidesign recommande de choisir l'option 
Follow Metronome Click dans la majorité 
des cas. Il est en effet inutile et complexe de 
définir des événements de métrique 
différents pour chaque événement de tempo.

Courbe de tempo avec différentes valeurs du 
métronome

Sélecteur de densité d'édition du tempo et menu 
déroulant

Choix de la noire Choix de la noire pointée
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Pour sélectionner la densité d'édition du tempo 
pour l'édition au crayon :

" Cliquez sur le sélecteur de densité d'édition du 
tempo et sélectionnez une valeur de temps dans 
le menu déroulant. Les événements de tempo 
créés à l'aide du crayon sont placés sur la règle de 
tempo en fonction du paramètre de densité 
spécifié.

Mode d'ajustement de la courbe

Immédiatement après avoir tracé de nouveaux 
tempos à l'aide du crayon, une courbe s'affiche 
en bleu correspondant à la nouvelle 
représentation graphique du tempo. 
Des poignées d'ajustement de couleur bleue sur 
la courbe permettent de régler la forme et la 
taille du graphique.

Les poignées d'ajustement restent actives tant 
que vous n'avez pas sélectionné un nouvel outil 
ou exécuté une autre commande. 

Accrochage des événements de tempo

Les outils d'accrochage permettent de créer des 
paramètres de tempo en faisant glisser les 
événements de tempo dans l'éditeur de tempo. 
Pour supprimer un événement de tempo, 
cliquez sur l'événement à l'aide d'un outil 
d'accrochage tout en maintenant la touche Alt 
(Windows) ou Option (Mac) enfoncée.

Faites glisser un événement de tempo vers la 
gauche ou la droite pour ajuster l'emplacement 
du changement de tempo.

Appuyez sur la touche Démarrer (Windows) 
ou Ctrl (Mac) avant de dessiner une ligne 
pour appliquer les événements de tempo déjà 
créés à cette ligne au lieu d'en créer de 
nouveaux. 

Ajustement de la courbe de tempo

Poignées d'ajustement de la courbe de tempo

Tous les événements de tempo au-dessous 
de la courbe sont affectés par le déplacement 
des poignées d'ajustement de la courbe de 
tempo. Pour ajuster la forme de la courbe 
sans modifier immédiatement les données 
de piste, appuyez sur la touche de démarrage 
(Windows) ou Ctrl (Mac) pendant 
l'ajustement. Les événements de tempo sont 
modifiés pour correspondre à la nouvelle 
courbe lorsque vous relâchez le bouton de la 
souris.

Utilisation d'un outil d'accrochage pour modifier un 
événement de tempo
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Sélection des événements de tempo

Vous pouvez facilement sélectionner un 
événement de tempo ou la totalité de la courbe 
de tempo dans l'éditeur de tempo.

Pour sélectionner un événement de tempo dans 
l'éditeur de tempo :

A l'aide du sélecteur ou de l'outil d'accrochage, 
cliquez deux fois sur la ligne horizontale de 
tempo.

Pour sélectionner la courbe de tempo dans 
l'éditeur de tempo :

" A l'aide du sélecteur ou de l'outil d'accrochage, 
cliquez trois fois sur la ligne horizontale de 
tempo dans la courbe à sélectionner.

Extension de sélections du tempo

Il est possible d'étendre la sélection à 
l'événement de tempo suivant ou précédent.

Pour étendre une sélection de tempo :

1  Sélectionnez une partie d'une région ou 
cliquez n'importe où dans la région.

2  Effectuez l'une des opérations suivantes :

• Appuyez sur Maj+Tab pour étendre la 
sélection à l'événement de tempo suivant.

– ou –

• Pour étendre la sélection et inclure 
l'événement de tempo précédent, appuyez 
sur Maj+Option+Tab (Mac) ou sur 
Maj+Ctrl+Tab (Windows).

Utilisation de l'outil de trimming

L'outil de trimming permet de mettre à l'échelle 
l'ensemble des événements de tempo d'une 
session ou d'une sélection temporelle. Il permet 
également d'étirer (ou de contracter) une région 
d'événements de tempo pour couvrir une plus 
grande ou une plus petite zone de la timeline. 

Pour mettre à l'échelle l'ensemble des 
événements de tempo de la session à l'aide de 
l'outil de trimming :

1  Ouvrez l'éditeur de tempo.

2  Sélectionnez l'outil de trimming.

3  Cliquez au-dessus des événements de tempo et 
faites glisser le curseur vers le haut ou le bas. 
Les valeurs de tempo augmentent lorsque vous 
faites glisser l'outil de trimming vers le haut, 
elles diminuent lorsque vous le faites glisser vers 
le bas.

Sélection d'un événement de tempo

Sélection d'une courbe de tempo

Modification du tempo à l'aide de l'outil de trimming



Chapitre 23 : Pistes du chef d'orchestre et emplacements mémoire 579

Pour mettre à l'échelle des événements de tempo 
sélectionnés à l'aide de l'outil de trimming :

1  Ouvrez l'éditeur de tempo.

2  A l'aide du sélecteur, sélectionnez la zone à 
éditer.

3  Sélectionnez l'outil de trimming.

4  Cliquez dans la zone sélectionnée et faites 
glisser le curseur vers le haut ou le bas. 
Les valeurs de tempo augmentent lorsque vous 
faites glisser l'outil de trimming vers le haut, 
elles diminuent lorsque vous le faites glisser vers 
le bas.

Pour modifier le degré de changement du tempo à 
l'aide de l'outil de trimming :

1  Ouvrez l'éditeur de tempo.

2  A l'aide du sélecteur, sélectionnez la zone à 
éditer.

3  Sélectionnez l'outil de trimming.

4  Cliquez sur la poignée de début ou de fin de la 
plage sélectionnée et faites-la glisser vers le haut 
ou vers le bas.

Pour allonger ou raccourcir la plage du 
changement de tempo à l'aide de l'outil de 
trimming :

1  Ouvrez l'éditeur de tempo.

2  A l'aide du sélecteur, sélectionnez la zone à 
éditer.

3  Sélectionnez l'outil de trimming.

4  Cliquez au début ou à la fin de la sélection et 
faites glisser le curseur horizontalement. 
Les événements de tempo conservent la 
distance relative qui les séparent mais sont 
répartis sur une zone plus grande ou plus petite.

Déplacement, opération de couper-coller et 
déplacement par incrément dans l'éditeur de 
tempo

Pour déplacer un groupe sélectionné 
d'événements de tempo dans l'éditeur de tempo :

1  Ouvrez l'éditeur de tempo.

2  A l'aide du sélecteur, sélectionnez la zone à 
déplacer.

3  Cliquez sur un événement de tempo à l'aide 
d'un outil d'accrochage et faites-le glisser 
horizontalement pour déplacer les événements 
vers leur nouvel emplacement. 

Modification des tempos sélectionnés à l'aide de l'outil 
de trimming

Modification du degré de changement du tempo à 
l'aide de l'outil de trimming

Modification de la plage de changement du tempo à 
l'aide de l'outil de trimming

Appuyez sur Alt (Windows) ou Option 
(Mac) pendant que vous déplacez une copie 
des événements de tempo.
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Pour copier et coller des événements dans 
l'éditeur de tempo :

1  Ouvrez l'éditeur de tempo.

2  A l'aide du sélecteur, sélectionnez la zone à 
copier.

3  Choisissez Edit > Copy.

4  Cliquez dans l'éditeur de tempo à l'endroit où 
vous souhaitez coller les événements de tempo.

5  Choisissez Edit > Paste. Les éléments copiés 
sont collés à partir du point d'insertion et 
remplacent les événements de tempo existants.

Pour déplacer une sélection par incrément dans 
l'éditeur de tempo :

1  Ouvrez l'éditeur de tempo.

2  A l'aide du sélecteur, sélectionnez la zone à 
déplacer par incrément.

3  Effectuez l'une des opérations suivantes :

• Appuyez sur la touche plus (+) du pavé 
numérique pour déplacer les événements 
de tempo sélectionnés vers l'avant de la 
valeur de déplacement par incrément.

– ou –

• Appuyez sur la touche moins (–) du pavé 
numérique pour reculer la sélection de la 
valeur de déplacement par incrément.

Modification du mode 
d'affichage linéaire
Vous avez la possibilité d'afficher la fenêtre Edit 
à l'échelle temporelle au format linéaire Tick 
(Bars|Beats) ou Sample (absolu). Les pistes MIDI 
et d'instrument, les pistes audio et les courbes de 
tempo peuvent s'afficher et fonctionner très 
différemment selon les paramètres d'affichage 
temporels.

Le menu déroulant du mode d'affichage linéaire 
détermine si l'éditeur de tempo affiche les 
événements selon le format temporel absolu ou 
selon le format temporel Bars|Beats.

Lorsque l'option Linear Sample Display est 
définie, l'affichage des événements de tempo est 
exprimé en échantillons ; autrement dit, leur 
emplacement exprimé en mesures/temps 
change une fois la courbe de tempo tracée.

Lorsque l'option Linear Tick Display est définie, 
l'affichage des événements de tempo est 
exprimé en tics ; autrement dit, leur 
emplacement exprimé en mesures/temps n'est 
pas altéré une fois la courbe de tempo tracée.

Sélecteur du mode d'affichage de la linéarité et menu 
déroulant

L'opération consistant à dessiner des 
événements de tempo à l'aide de l'option 
Linear Sample Display peut entraîner le 
déplacement non intuitif de matériel 
exprimé en mesures/temps. Digidesign 
recommande d'utiliser l'option Linear Tick 
Display lorsque vous dessinez des 
changements de tempo.
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Pour modifier l'affichage du format temporel :

" Cliquez sur le sélecteur du mode d'affichage 
linéaire et sélectionnez un format dans le menu 
déroulant.

Densité d'édition du tempo et mode d'affichage 
linéaire

Si les deux paramètres Tempo Edit Density (dans 
l'éditeur de tempo) et Linearity Display Mode 
sont définis selon un format temporel Bars|Beats 
ou selon un format temporel absolu, les 
modifications du tempo sont réparties à 
intervalles réguliers. Lorsque les deux 
paramètres sont définis de telle manière que l'un 
est régi par une échelle temporelle absolue et 
l'autre par une échelle temporelle Bars|Beats, le 
nombre de modifications du tempo augmente 
ou diminue au fil du temps.

Fenêtre Tempo Operations
La fenêtre Tempo Operations permet de définir 
les événements de tempo sur une plage de temps 
(ou de mesures) donnée. Cette période est 
exprimée dans le format de l'échelle temporelle 
principale. De plus, la fenêtre Tempo Operations 
vous permet d'effectuer les opérations 
suivantes :

• Insertion d'un nombre spécifique 
Bars|Beats à une plage de temps précise.

• Création de tempos pour accélérer ou 
ralentir, de manière linéaire et sur 
différentes courbes.

• Mise à l'échelle et extension des tempos 
existants.

La fenêtre Tempo Operations comporte six 
pages d'onglets, chacun d'elles correspondant à 
un type d'opération liée au tempo.

Constant : permet de créer un tempo constant 
sur une plage de temps sélectionnée.

Linear : permet de créer des tempos qui 
changent à intervalle régulier sur une plage de 
temps sélectionnée.

Parabolic : permet de créer des tempos qui vont 
en accélérant ou en décélérant selon une courbe 
de tempo visant à changer le tempo plus 
rapidement ou plus lentement sur une période 
donnée.

S Curve : permet de créer des tempos qui vont 
en accélérant ou en décélérant selon une courbe 
de tempo doté d'un point d'inflexion 
définissable déterminant les valeurs du temps et 
de la mesure à mi-parcours.

Scale : permet de mettre à l'échelle des tempos 
dans une sélection par un pourcentage. 

Stretch : permet de sélectionner des événements 
de tempo et de les appliquer à une zone plus 
grande ou plus petite de la sélection.

Pour ouvrir une page donnée de la fenêtre Tempo 
Operations :

" Choisissez Event > Tempo, puis la commande 
correspondant à la page Tempo Operations 
souhaitée (Constant, par exemple).

La fenêtre Tempo Operations n'est pas 
disponible en mode Manual Tempo.

Si la fenêtre Tempo Operations est toujours 
ouverte, vous pouvez sélectionner une des 
pages à partir du menu déroulant situé en 
haut de la fenêtre.
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Pour ouvrir la dernière page activée de la fenêtre 
Operations :

" Choisissez Event > Tempo > Operations 
Window.

Pour définir les événements de tempo sur une 
plage de temps donnée :

1  Faites une sélection dans la règle temporelle 
ou dans une piste.

2  Choisissez Event > Tempo > Operations 
Window.

3  Sélectionnez une page dans le menu déroulant 
situé en haut de la fenêtre Tempo Operation.

4  Modifiez les paramètres de la page choisie, si 
nécessaire.

5  Effectuez l'une des opérations suivantes :

• Cliquez sur Apply.

– ou –

• Appuyez sur Entrée (Windows) ou Retour 
(Mac) pour appliquer automatiquement les 
valeurs et fermez la fenêtre.

Page Constant

La page Constant permet de créer un tempo 
constant sur une plage de temps sélectionnée.

Advanced : lorsque la case Advanced est cochée, 
la plage de la sélection adopte le format défini 
par l'échelle temporelle principale ; des options 
supplémentaires et modifiées sont disponibles.

Calculate (option avancée) : permet de calculer 
la valeur de fin du tempo ou de la sélection.

Selection Start and End : spécifie la valeur de 
début ou de fin du changement de tempo selon 
le format temporel Bars|Beats. Lorsqu'une 
sélection d'édition est effectuée, les champs Start 
et End affichent les limites de la sélection.

End Time (option avancée) : affiche la valeur de 
fin de la sélection. Si la valeur de l'échelle 
temporelle principale est Bars|Beats, la valeur de 
fin s'affiche dans l'échelle temporelle 
secondaire. Si l'échelle temporelle principale est 
au format temporel absolu, la valeur de fin est 
calculée et exprimée selon un format Bars|Beats. 
La modification de la valeur de fin entraîne un 
changement du tempo.

Appuyez sur les touches Alt+2 
(Windows) ou Option+2 (Mac) du pavé 
numérique pour ouvrir la fenêtre Tempo 
Operations et afficher la dernière page 
active de Tempo Operations.

Page Constant (option avancée)
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Tempo : indique le tempo, exprimé en temps par 
minute (BPM) à appliquer à la plage 
sélectionnée.

Resolution (option avancée) : permet de 
sélectionner la valeur de note BPM pour votre 
paramètre de tempo.

Density (option avancée) : permet de spécifier le 
nombre d'événements de changement du 
tempo dans la règle de tempo.

Preserve Tempo after Selection : si cette option 
est sélectionnée, le paramètre de tempo 
précédent appliqué au point de fin de sélection 
est préservé après la sélection. Lorsque l'option 
n'est pas sélectionnée, le dernier paramètre de 
tempo créé par l'opération liée au tempo reste en 
vigueur à la fin de la session, ou jusqu'à 
l'événement de tempo suivant au-delà de la 
plage sélectionnée.

Page Linear

La page Linear permet de créer des tempos qui 
changent à intervalle régulier sur une plage de 
temps sélectionnée.

Advanced : lorsque la case Advanced est cochée, 
la plage de la sélection adopte le format défini 
par l'échelle temporelle principale ; des options 
supplémentaires et modifiées sont disponibles.

Calculate (option avancée) : permet de calculer 
la valeur de fin de la sélection, le tempo de début 
ou celui de fin.

Selection Start and End : affiche les points de 
début et de fin du changement du tempo dans la 
référence temporelle principale actuellement 
sélectionnée. Lorsqu'une sélection d'édition est 
effectuée, les champs Start et End affichent les 
limites de la sélection. Le fait de modifier les 
valeurs de début et de fin a pour effet de 
modifier la plage de la sélection.

Le fait de sélectionner l'option Follow 
Metronome Click indique à la valeur de note 
BPM du tempo de reproduire la valeur du 
métronome définie dans les marqueurs de 
temps.

Page Linear (option avancée)
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End Time (option avancée) : affiche la valeur 
absolue de la fin de la sélection. Si la valeur de 
l'échelle temporelle principale est Bars|Beats, la 
valeur de fin s'affiche dans l'échelle temporelle 
secondaire. Si l'échelle temporelle principale est 
au format temporel absolu, la valeur de fin est 
calculée et exprimée selon un format Bars|Beats. 
La modification de la valeur de fin entraîne un 
changement du tempo.

Tempo Start and End : affiche le tempo, en 
temps par minute (BPM), pour les points de 
début et de fin de la plage sélectionnée. 
Le changement de tempo entraîne la 
modification de la valeur de fin.

Resolution (option avancée) : permet de 
sélectionner la valeur de note BPM pour votre 
paramètre de tempo.

Density (option avancée) : permet de spécifier le 
nombre d'événements de changement du tempo 
dans la règle de tempo. 

Preserve Tempo after Selection : si cette option 
est sélectionnée, le paramètre de tempo 
précédent appliqué au point de fin de sélection 
est préservé après la sélection. Lorsque l'option 
n'est pas sélectionnée, le dernier paramètre de 
tempo créé par l'opération liée au tempo reste en 
vigueur à la fin de la session, ou jusqu'à 
l'événement de tempo suivant au-delà de la 
plage sélectionnée.

Page Parabolic

La page Parabolic permet de créer des tempos 
qui vont en accélérant ou en décélérant selon 
une courbe de tempo visant à changer le tempo 
plus rapidement ou plus lentement sur une 
période donnée.

Advanced : lorsque la case Advanced est cochée, 
la plage de la sélection adopte le format défini 
par l'échelle temporelle principale ; des options 
supplémentaires et modifiées sont disponibles.

Calculate (option avancée) : permet de calculer 
la valeur de fin de la sélection, le tempo de 
début, le tempo de fin ou la courbe du 
changement de tempo. 

Selection Start and End : affiche les points de 
début et de fin du changement du tempo dans la 
référence temporelle principale actuellement 
sélectionnée. Lorsqu'une sélection d'édition est 
effectuée, les champs Start et End affichent les 
limites de la sélection. Le fait de modifier les 
valeurs de début et de fin a pour effet de 
modifier la plage de la sélection.

Le fait de sélectionner l'option Follow 
Metronome Click indique à la valeur de note 
BPM du tempo de reproduire la valeur du 
métronome définie dans les marqueurs de 
temps.

Page Parabolic (option avancée)
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End Time (option avancée) : affiche la valeur 
absolue de la fin de la sélection. Si la valeur de 
l'échelle temporelle principale est Bars|Beats, la 
valeur de fin s'affiche dans l'échelle temporelle 
secondaire. Si l'échelle temporelle principale est 
au format temporel absolu, la valeur de fin est 
calculée et exprimée selon un format Bars|Beats. 
La modification de la valeur de fin entraîne un 
changement du tempo.

Tempo Start and End : affiche le tempo, en 
temps par minute (BPM), pour les points de 
début et de fin de la plage sélectionnée. Le 
changement de tempo entraîne la modification 
de la valeur de fin.

Curvature : spécifie et affiche une représentation 
graphique et numérique de la courbe de tempo. 
Les nombres négatifs indiquent un changement 
de tempo plus rapide au début de la plage de 
temps et les nombres positifs indiquent un 
changement de tempo plus rapide à la fin de la 
plage. Vous définissez cette valeur au moyen de 
la glissière.

Resolution (option avancée) : permet de 
sélectionner la valeur de note BPM pour votre 
paramètre de tempo.

Density (option avancée) : permet de spécifier le 
nombre d'événements de changement du tempo 
dans la règle de tempo. 

Preserve Tempo after Selection : si cette option 
est sélectionnée, le paramètre de tempo 
précédent appliqué au point de fin de sélection 
est préservé après la sélection. Lorsque l'option 
n'est pas sélectionnée, le dernier paramètre de 

tempo créé par l'opération liée au tempo reste en 
vigueur à la fin de la session, ou jusqu'à 
l'événement de tempo suivant au-delà de la 
plage sélectionnée.

Page S-Curve

La page S-Curve permet de créer des tempos qui 
vont en accélérant ou en décélérant selon une 
courbe de tempo doté d'un point d'inflexion 
définissable déterminant les valeurs du temps et 
de la mesure à mi-parcours.

Advanced : lorsque la case Advanced est cochée, 
la plage de la sélection adopte le format défini 
par l'échelle temporelle principale ; des options 
supplémentaires et modifiées sont disponibles. 

Calculate (option avancée) : permet de calculer 
la valeur de fin de la sélection, le tempo de 
début, le tempo de fin ou la courbe du 
changement de tempo. 

Le fait de sélectionner l'option Follow 
Metronome Click indique à la valeur de note 
BPM du tempo de reproduire la valeur du 
métronome définie dans les marqueurs 
de temps. Page S-Curve (option avancée)



Guide de référence Pro Tools586

Selection Start and End : affiche les points de 
début et de fin du changement du tempo dans la 
référence temporelle principale actuellement 
sélectionnée. Lorsqu'une sélection d'édition est 
effectuée, les champs Start et End affichent les 
limites de la sélection. Le fait de modifier les 
valeurs de début et de fin a pour effet de 
modifier la plage de la sélection.

Start and End Time (option avancée) : affiche la 
valeur absolue de la fin de la sélection. Si la 
valeur de l'échelle temporelle principale est 
Bars|Beats, la valeur de fin s'affiche dans l'échelle 
temporelle secondaire. Si l'échelle temporelle 
principale est au format temporel absolu, la 
valeur de fin est calculée et exprimée selon un 
format Bars|Beats.

Tempo Start and End : affiche le tempo, en 
temps par minute (BPM), pour les points de 
début et de fin de la plage sélectionnée. 
Le changement de tempo entraîne la 
modification de la valeur de fin.

Curvature : spécifie et affiche une représentation 
graphique et numérique de la courbe de tempo. 
Les nombres négatifs indiquent un changement 
du tempo plus rapide au début et à la fin de la 
plage de temps alors que cette valeur est la plus 
faible à mi-parcours. Les nombres positifs 
indiquent une valeur de changement faible vers 
le début et la fin de la plage sélectionnée, la 
valeur la plus élevée se trouvant à mi-parcours. 
Vous définissez cette valeur au moyen de la 
glissière.

Mid Point : indique l'emplacement sur l'échelle 
temporelle principale du point central de la 
courbe. Vous définissez cette valeur au moyen 
de la glissière.

Mid Tempo : spécifie le tempo à mi-parcours. 
Vous définissez cette valeur au moyen de la 
glissière.

Resolution (option avancée) : permet de 
sélectionner la valeur de note BPM pour votre 
paramètre de tempo.

Density (option avancée) : permet de spécifier le 
nombre d'événements de changement du tempo 
dans la règle de tempo. 

Preserve Tempo after Selection : si cette option 
est sélectionnée, le paramètre de tempo 
précédent appliqué au point de fin de sélection 
est préservé après la sélection. Lorsque l'option 
n'est pas sélectionnée, le dernier paramètre de 
tempo créé par l'opération liée au tempo reste en 
vigueur à la fin de la session, ou jusqu'à 
l'événement de tempo suivant au-delà de la 
plage sélectionnée.

Page Scale

La page Scale permet de mettre à l'échelle des 
tempos dans une sélection par un pourcentage.

Le fait de sélectionner l'option Follow 
Metronome Click indique à la valeur de note 
BPM du tempo de reproduire la valeur du 
métronome définie dans les marqueurs de 
temps.

Page Scale



Chapitre 23 : Pistes du chef d'orchestre et emplacements mémoire 587

Advanced : lorsque la case Advanced est cochée, 
la plage de la sélection adopte le format défini 
par l'échelle temporelle principale ; des options 
supplémentaires et modifiées sont disponibles.

Calculate (option avancée) : associé aux 
paramètres sélectionnés dans la liste déroulante 
Scale, le menu Calculate permet de calculer 
l'heure de fin de sélection, le tempo moyen, le 
tempo de début ou le tempo de fin. 

Scale (option avancée) : associé aux paramètres 
sélectionnés dans la liste déroulante Calculate, 
le menu Scale permet de mettre à l'échelle tous 
les tempos, le tempo de début ou le tempo 
de fin.

La mise à l'échelle de l'ensemble des tempos a 
pour effet d'attribuer le même coefficient à 
chaque tempo de la plage sélectionnée. 
En revanche, avec la mise à l'échelle du tempo 
de début, les tempos sont traités de manière 
différente : la mise à l'échelle du premier 
événement de tempo est plus importante alors 
que la mise à l'échelle des événements qui 
suivent diminue au fur et à mesure jusqu'au 
tempo de fin qui n'est pas mis à l'échelle. Avec la 
mise à l'échelle du tempo de fin, les tempos sont 

traités de manière différente : la mise à l'échelle 
du dernier événement de tempo est plus 
importante alors que la mise à l'échelle des 
événements qui précèdent diminue au fur et à 
mesure jusqu'au tempo de début qui n'est pas 
mis à l'échelle.

Selection Start and End : affiche les points de 
début et de fin de l'opération liée au tempo dans 
la référence temporelle principale actuellement 
sélectionnée. Lorsqu'une sélection d'édition est 
effectuée, les champs Start et End affichent les 
limites de la sélection. Le fait de modifier les 
valeurs de début et de fin a pour effet de 
modifier la plage de la sélection.

Start and End Time : affiche la référence 
temporelle absolue des points de début et de fin 
de la sélection. Si la valeur de l'échelle 
temporelle principale est Bars|Beats, les temps 
s'affichent dans l'échelle temporelle secondaire. 
Si l'échelle temporelle principale est au format 
temporel absolu, les temps sont calculés et 
exprimés selon un format Bars|Beats.

Average Tempo : affiche le tempo moyen, en 
temps par minute (BPM) sur la plage 
sélectionnée. Le fait de modifier le tempo 
moyen affecte le pourcentage de mise à l'échelle.

Scale : affiche le pourcentage de mise à l'échelle 
du tempo, en temps par minute (BPM) sur la 
plage sélectionnée. La modification de la mise à 
l'échelle affecte le tempo moyen.

Preserve Tempo after Selection : si cette option 
est sélectionnée, le paramètre de tempo 
précédent appliqué au point de fin de sélection 
est préservé après la sélection. Lorsque l'option 
n'est pas sélectionnée, le dernier paramètre de 
tempo créé par l'opération liée au tempo reste en 
vigueur à la fin de la session, ou jusqu'à 
l'événement de tempo suivant au-delà de la 
plage sélectionnée.

Page Scale (option avancée)
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Stretch :

La page Stretch permet de sélectionner des 
événements de tempo et de les appliquer à une 
zone plus grande ou plus petite de la sélection.

Advanced : lorsque la case Advanced est cochée, 
la plage de la sélection adopte le format défini 
par l'échelle temporelle principale ; des options 
supplémentaires et modifiées sont disponibles.

Selection Start and End : indique la plage des 
événements de tempo que vous voulez modifier. 
Lorsqu'une sélection d'édition est effectuée, les 
champs Start et End affichent les limites de la 
sélection. 

Stretch To End : spécifie un nouveau point de 
fin pour la région à laquelle vous voulez 
appliquer les événements de tempo 
sélectionnés. La modification du point de début 
a un impact sur le pourcentage Stretch.

Stretch To Start (option avancée) : spécifie un 
nouveau point de début pour la région à laquelle 
vous voulez appliquer les événements de tempo 
sélectionnés. La modification du point de début 
a un impact sur le pourcentage Stretch.

Stretch : détermine le pourcentage de temps 
couvert par les événements de tempo 
sélectionnés.

Preserve Tempo after Selection : si cette option 
est sélectionnée, le paramètre de tempo 
précédent appliqué au point de fin de sélection 
est préservé après la sélection. Lorsque l'option 
est désactivée, le dernier paramètre de tempo 
créé par l'opération liée au tempo reste en 
vigueur à la fin de la session, ou jusqu'à 
l'événement de tempo suivant au-delà de la 
plage sélectionnée.

Commande Identify Beat
La commande Identify Beat vous permet 
d'établir une table de tempo/mesure pour des 
données audio enregistrées sans référence à un 
métronome ou pour des données audio 
importées dont les tempos sont inconnus.

La commande Identify Beat analyse une plage 
de sélection (généralement avec un nombre 
précis de temps ou de mesures) et calcule son 
tempo d'après la métrique spécifiée. Au cours du 
processus, les marqueurs Bar|Beat correspondant 
au tempo calculé sont insérés et apparaissent 
dans la règle de tempo au début et à la fin de la 
sélection ; de plus, les événements de métrique 
sont insérés dans la règle de métrique.

Page Stretch

Utilisez Beat Detective pour générer des 
marqueurs Bar|Beat dans une sélection 
comportant des changements rythmiques 
sur chaque temps et subdivision de temps. 
Pour plus d'informations, consultez la 
section chapitre 24, Beat Detective.
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Marqueurs Bar|Beat

Les marqueurs Bar|Beat ressemblent aux 
événements de tempo, mais leur emplacement 
est indiqué par de petits triangles bleus.

Choix entre les marqueurs Bar|Beat et 
les événements de tempo

Les événements de tempo faisant référence aux 
tics et les marqueurs Bar|Beat aux échantillons, 
ils ne peuvent pas être mélangés. Si une session 
contient des événements de tempo et que vous 
tentez d'insérer des marqueurs Bar|Beat, les 
événements de tempo existants sont convertis 
en marqueurs Bar|Beat (et réciproquement).

Les événements de tempo peuvent également 
être convertis en marqueurs Bar|Beat (et 
réciproquement). Lors de la conversion 
d'événements de tempo en marqueurs Bar|Beat 
et inversement, il peut se produire un léger 
arrondi des échantillons.

Pour utiliser des événements de tempo et des 
marqueurs Bar|Beat :

1  Appuyez sur Pomme (Mac) ou sur Ctrl 
(Windows) et cliquez sur le bouton Add Tempo 
Change.

2  Sélectionnez Tempo Events ou Bar|Beat 
Markers dans le menu déroulant. 

Identification des temps

Détermination du tempo d'une boucle de batterie 
d'une mesure et création des marqueurs Bar|Beat 
correspondants :

1  Placez une boucle de batterie d'une mesure au 
début d'une piste audio.

2  Sélectionnez View > Rulers > Samples. 
Ceci garantit que la sélection des données audio 
s'effectuera à l'échantillon près.

3  Sélectionnez la région audio avec l'outil 
d'accrochage de temps, puis choisissez Event > 
Identify Beat.

4  Dans la boîte de dialogue Bar|Beat Markers, 
indiquez les points de début et de fin 
correspondant aux marqueurs Bar|Beat insérés. 
Cet exemple utilisant une boucle d'une mesure, 
entrez 1|1|000 et 2|1|000.

5  Le cas échéant, indiquez la mesure (Time 
signature) correspondant aux plages de début et 
de fin.

Marqueur Bar|Beat

Menu déroulant de la règle de tempo

Boîte de dialogue Identify Beat
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6  Cliquez sur OK pour calculer 
automatiquement le nouveau tempo et insérer 
les marqueurs Bar|Beat et événements de 
métrique nécessaires. Tout événement de tempo 
et de métrique se trouvant dans la sélection est 
supprimé.

Après avoir déterminé le tempo des données 
audio, vous pouvez dupliquer la région audio 
d'origine à l'aide de la commande Repeat.

Lorsque vous travaillez avec une sélection, la 
commande Identify Beat ne calcule qu'un seul 
tempo pour la plage sélectionnée. Si le tempo 
varie d'une mesure à l'autre ou d'un temps à 
l'autre, vous devrez utiliser la commande 
Identify Beat pour chaque variation de tempo 
(en vous assurant que vous définissez une plage 
de sélection ou un emplacement de temps 
correspondant précisément au changement de 
tempo).

Pour définir avec précision les tempos 
correspondant à une plage de données audio au 
moyen de la commande Identify Beat, vous 
devez veiller à ce que la sélection initiale 
représente un nombre précis de temps ou de 
mesures. Une astuce utile consiste à lire la 
sélection en boucle (voir Lecture en boucle, 
page 475) pour vérifier qu'elle ne « saute » pas 
rythmiquement. Pour éviter tout décalage et 
garantir une précision à l'échantillon près, 
sélectionnez les données audio en ayant 
préalablement défini l'échelle temporelle sur 
Samples plutôt que sur Bars|Beats.

Déplacement des marqueurs Bar|Beat

Vous pouvez faire glisser les marqueurs Bar|Beat 
vers de nouveaux emplacements pour les aligner 
sur des régions audio qui ont été déplacées ou 
sur un point légèrement différent d'une région 
audio. Ceci a pour résultat d'aligner les données 
MIDI sur la nouvelle table de tempos.

Les marqueurs Bar|Beat font référence aux 
échantillons et les événements de tempo aux 
tics, c'est pourquoi ils se comportent de façon 
différente lorsque vous les faites glisser dans la 
règle de tempo.

Lorsque vous faites glisser un événement de 
tempo :

• L'événement de tempo est placé à un nouvel 
emplacement en mesure/temps. 
Les expressions en échantillons et en adresse 
SMPTE des positions de l'événement sont 
également mises à jour.

Marqueurs Bar|Beat insérés

Lors de l'identification des temps, 
sélectionnez une zone aussi large que 
possible. Si, par exemple vous voulez 
identifier un fichier audio s'étendant sur 
quatre mesures, sélectionnez les quatre 
mesures au lieu d'une seule pour réduire les 
erreurs d'arrondi.

Déplacement d'un marqueur Bar|Beat
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• La valeur BPM correspondant à l'événement 
de tempo déplacé demeure constante, de 
même que les autres événements de tempo de 
la session.

• Les événements MIDI voisins et les régions 
audio des pistes basées sur les règles 
temporelles, de même que la règle, 
raccourcissent ou s'allongent pour s'ajuster au 
nouvel emplacement de tempo.

Lorsque vous faites glisser un marqueur Bar|Beat :

• Sa valeur BPM est recalculée d'après le 
marqueur Bar|Beat qui se trouve 
immédiatement à sa gauche. Les marqueurs 
Bar|Beat situés à la droite du marqueur 
déplacé demeurent en place.

• Son emplacement, en mesure/temps, est 
déplacé avec le marqueur Bar|Beat. Si le 
marqueur Bar|Beat a été placé au départ à 
3|1|000, il y reste (sauf si vous l'éditez).

• Les expressions de son emplacement en 
échantillons et en adresse SMPTE changent en 
fonction du calcul du nouveau tempo pour le 
marqueur Bar|Beat.

• Les événements MIDI voisins, ainsi que la 
règle, raccourcissent ou s'allongent pour 
s'ajuster au nouveau tempo.

Edition des marqueurs Bar|Beat

Un marqueur Bar|Beat Marker peut être édité 
pour redéfinir son emplacement exprimé en 
mesure/temps, ce qui redéfinit également le 
point de début et de fin de la plage analysée 
pour le tempo. Ceci est différent du 
déplacement d'un marqueur Bar|Beat en le 
faisant glisser. 

Pour éditer un marqueur Bar|Beat :

1  Dans la règle de tempo, cliquez deux fois sur le 
marqueur Bar|Beat.

2  Dans la boîte de dialogue Edit Bar|Beat, entrez 
le nouvel emplacement du marqueur Bar|Beat.

3  Le cas échéant, entrez une nouvelle mesure 
(Time Signature). 

4  Cliquez sur OK.

Pour supprimer un marqueur Bar|Beat :

Tout en appuyant sur Option (Mac) ou sur Alt 
(Windows), déplacez le curseur sur le marqueur 
Bar|Beat (le curseur devient un outil 
d'accrochage associé au signe moins (–) et 
cliquez dessus pour le supprimer.

Boîte de dialogue Edit Bar|Beat
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Insertion de marqueurs Bar|Beat 
individuels
Matériel exprimé en échantillons avec des 
tempos variables

Vous pouvez insérer les marqueurs Bar|Beat un 
par un, en définissant un point d'insertion 
d'édition (au lieu d'effectuer une sélection) 
avant d'utiliser la commande Identify Beat. 
La possibilité d'identifier chaque temps, l'un 
après l'autre, est particulièrement utile avec du 
matériel dont les tempos varient.

Par exemple, si une mesure accélère légèrement, 
vous pouvez insérer un marqueur Bar|Beat sur 
chaque temps (voir la figure 23) afin de refléter 
précisément les variations du tempo.

Même après avoir inséré des marqueurs Bar|Beat, 
d'autres ajustements de la table de tempos 
restent possibles, en faisant glisser chaque 
marqueur, pour les aligner avec le temps associé 
dans les données audio.

Evénements de métrique
Vous pouvez modifier la métrique dans la règle 
de métrique ou apportez des modifications 
précises dans la fenêtre Time Operations.

Les événements de métrique peuvent être 
insérés au début d'une session pour remplacer la 
métrique par défaut (de 4/4), et n'importe où 
dans la session pour d'autres modifications de la 
métrique.

Pour afficher la règle de métrique :

" Sélectionnez View > Rulers > Meter.

Métrique actuel

Conforme aux événements de métrique 
survenant en cours de lecture, la métrique en 
cours de la session apparaît dans la fenêtre 
Transport.

Figure 23.  Marqueurs Bar|Beat sur chaque temps

Métrique en cours affichée dans la fenêtre Transport

Métrique
actuelle
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Insertion d'événements de 
métrique

Pour insérer un événement de métrique :

1  Effectuez l'une des opérations suivantes :

• Choisissez Event > Time > Change Meter.

• Cliquez sur le bouton Add Meter Change 
situé à droite de la règle de métrique.

• Tout en appuyant sur Ctrl (Mac) ou sur 
Démarrer (Windows), déplacez le curseur 
dans la règle de métrique (le curseur 
devient un outil d'accrochage associé au 
signe plus (+) et cliquez à l'emplacement où 
vous souhaitez insérer l'événement.

• Cliquez deux fois sur le vumètre dans la 
fenêtre Transport.

2  Dans la boîte de dialogue Meter Change, 
procédez comme suit :

• Renseignez les champs Location and Meter 
de la fenêtre Meter Change.

– et –

• Pour placer l'événement de métrique inséré 
précisément sur le premier temps de la 
mesure la plus proche, cochez l'option 
Snap To Bar.

3  Choisissez une valeur de note (ronde, blanche, 
noire, etc.) pour le nombre de clics entendus 
dans chaque mesure. Sélectionnez l'option 
point (.) si vous voulez une valeur pointée.

Bouton d'ajout de mesure

Insertion manuelle d'un événement de métrique

Vumètre actuel dans la fenêtre Transport

Fenêtre Meter Change

Avec certaines métriques, il peut être 
souhaitable d'utiliser une valeur pointée. 
Par exemple, dans le cas d'une métrique de 
6/8, le choix d'une noire pointée (donnant 
deux clics par mesure) est généralement 
mieux adapté qu'une croche simple (six clics 
par mesure).
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4  Cliquez sur Apply pour insérer le nouvel 
événement de métrique. Le nouvel événement 
de métrique est inséré et apparaît dans la règle 
de métrique.

A chaque événement de métrique est associé un 
petit triangle jaune qui indique son 
emplacement. Vous pouvez sélectionner ce 
triangle pour le copier et le coller ou cliquer 
deux fois dessus pour éditer l'événement de 
métrique.

Edition des événements de métrique

Les événements de métrique existants peuvent 
être édités, supprimés, copiés et collés.

Pour éditer un événement de métrique :

1  Dans la règle de métrique, cliquez deux fois 
sur l'événement de métrique.

2  Dans la boîte de dialogue Meter Change, 
entrez un nouvel emplacement (Location) ou 
une nouvelle valeur (Meter) pour l'événement.

3  Cliquez sur OK.

Pour supprimer un événement de métrique :

" Tout en appuyant sur Option (Mac) ou sur Alt 
(Windows), déplacez le curseur sur l'événement 
de métrique (le curseur devient un outil 
d'accrochage associé au signe moins (-) et 
cliquez dessus pour le supprimer.

Pour copier et coller plusieurs événements de 
métrique :

1  Pour restreindre la sélection en fonction du 
pas de grille actuel, réglez le mode d'édition sur 
Grid. 

2  Déplacez-vous dans la règle de métrique pour 
sélectionner la région qui inclut les événements 
de métrique.

Si le début de la sélection inclut un événement 
de métrique, appuyez sur Pomme (Mac) ou sur 
Ctrl (Windows) pour faire apparaître le 
sélecteur.

3  Choisissez Edit > Copy.

4  Cliquez dans la règle de métrique à l'endroit 
où vous souhaitez coller les événements de 
métrique.

5  Choisissez Edit > Paste. Le contenu du 
presse-papiers est collé à partir du point 
d'insertion et remplace les événements de 
métrique existants.

Pour étendre une sélection d'édition d'une piste à 
la règle de métrique :

1  A l'aide du sélecteur ou d'un outil 
d'accrochage, sélectionnez une plage de la piste.

2  Cliquez sur la règle de métrique tout en 
appuyant sur Maj.

Cliquez de nouveau sur la règle de métrique tout 
en appuyant sur Maj pour la retirer de la 
sélection.

Evénement de métrique inséré

Evénements de métrique sélectionnés

Appuyez sur Option (Mac) ou sur Alt 
(Windows) tout en déplaçant le curseur 
pour effectuer la sélection dans toutes les 
pistes du chef d'orchestre.
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Pour sélectionner tous les événements de 
métrique :

" Cliquez deux fois avec le sélecteur dans la 
règle de métrique.

Pour supprimer une plage sélectionnée 
d'événements de métrique :

1  Pour restreindre la sélection en fonction du 
pas de grille actuel, réglez le mode d'édition sur 
Grid. 

2  Déplacez le sélecteur dans la règle de métrique 
pour sélectionner les événements de métrique 
que vous voulez supprimer.

3  Choisissez Edit > Clear pour supprimer les 
événements de métrique sélectionnés.

Mesures partielles

Le cas échéant, Pro Tools créera une mesure 
partielle pour s'adapter à l'événement de 
métrique inséré. Lorsqu'un événement de 
métrique est précédé d'une mesure partielle, il 
apparaît en italiques dans la règle de métrique.

Les mesures partielles peuvent également 
apparaître lorsque vous collez des événements 
de mesure à d'autres emplacements que le 
premier temps d'une mesure.

Fenêtre Time Operations
La fenêtre Time Operations permet d'effectuer 
les opérations suivantes :

• Changement de métrique

• Insertion d'un temps

• Suppression de temps

• déplacer le début du morceau.

Pour ouvrir une fenêtre Time Operations 
spécifique :

" Choisissez Event > Time, suivi de l'une des 
commandes Time Operations (Change Meter, 
par exemple).

Pour ouvrir la dernière fenêtre Time Operations 
active :

" Choisissez Event > Time > Operations 
Window.

Changement de métrique

Change Meter permet de spécifier des 
changements de métrique complexes pour le 
matériel exprimé en mesures/temps (Bar|Beat). 
Vous pouvez entrer des modifications de 
métrique dans une mesure donnée, modifier la 
métrique sur une période de temps sélectionnée 
ou ajouter des modifications de métrique de 
manière séquentielle, mesure après mesure.

Mesure partielle 4/4

Pour insérer des événements de métrique en 
évitant les mesures partielles, utilisez la 
commande Change Meter de la fenêtre Time 
Operations. Pour plus d'informations, 
reportez-vous à la section « Changement de 
métrique », page 595.

Si la fenêtre Time Operations est toujours 
ouverte, vous pouvez sélectionner Time 
Operation à partir du menu déroulant situé 
en haut de la fenêtre.

Appuyez sur les touches Alt+1 
(Windows) ou Option+1 (Mac) du pavé 
numérique pour ouvrir la fenêtre Time 
Operations et afficher la dernière fenêtre 
Time Operations active.
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Les options de la commande Change Meter sont 
les suivantes :

New Meter : permet de spécifier une nouvelle 
mesure. Le premier champ permet de saisir le 
nombre de temps (jusqu'à 99) compris dans une 
mesure et le deuxième champ la durée de la note 
correspondant à un temps.

Click : permet de spécifier la valeur de la note 
qui déclenche le clic du métronome. Si, par 
exemple, vous choisissez la croche, un clic se 
produit pour toutes les croches, et ce 
indépendamment du tempo.

Starting at Bar : définit la mesure où intervient 
le changement de métrique. Les changements 
de métrique indiqués à la page Change Meter 
peuvent seulement être réalisés au début d'une 
mesure.

Apply Change To : permet d'appliquer le 
changement de métrique à la plage 
sélectionnée, à la fin de la session ou jusqu'à la 
mesure suivante. 

Change : les champs Change permettent 
d'indiquer le nombre de mesures de la nouvelle 
métrique que vous voulez remplacer par la plage 
sélectionnée.

Pro Tools calcule automatiquement le nombre 
entier de mesures le plus proche ; vous pouvez 
également spécifier le nombre de mesures qui 
seront concernées. Du temps est inséré ou 
supprimé, sous forme d'incréments de mesures 
complets, à la fin de la sélection, sur toutes les 
pistes affectées lorsque vous remplacez la plage 
calculée.

Option Realign

Les commandes associées au paramètre Realign 
permettent de choisir les éléments à réaligner 
après les changements de métrique. Vous 
pouvez choisir de réaligner les événements de 
métrique ou les événements de métrique et de 
tempo, les marqueurs et les pistes faisant 
référence aux tics ou toutes les pistes (ou aucune 
des pistes) faisant référence aux échantillons.

Meter Ruler Only : applique les changements de 
métrique exclusivement à la règle de métrique. 
Les autres règles et pistes ne subissent aucune 
modification.

Meter and Tempo Rulers, All Tick-Based Markers 
and Tracks, and Sample-Based Markers and 
Tracks : applique les changements de métrique 
à l'ensemble des règles, aux pistes basées sur les 
tics et à votre choix de pistes basées sur des 
échantillons. Du temps est inséré ou supprimé, 
le cas échéant, à la fin de la sélection pour 
préserver l'alignement du matériel qui suit la 
sélection. 

Fenêtre de changement de métrique
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Exemples de changements de métrique

Pour modifier la métrique sur une plage de 
mesures :

1  Effectuez l'une des opérations suivantes :

• Faites glisser le sélecteur pour sélectionner 
une plage de mesures à modifier.

– ou –

• Pour que le changement de métrique soit 
appliqué jusqu'à l'événement de métrique 
suivant, cliquez à l'aide du sélecteur sur 
l'endroit où vous souhaitez que commence 
le changement. Le changement métrique 
se produit au début de la mesure la plus 
proche.

2  Choisissez Event > Time > Change Meter.

3  Spécifiez une nouvelle métrique et cliquez sur 
Setting. Pro Tools définit automatiquement les 
options de sélection de manière à ce que la 
nouvelle métrique concorde le mieux possible 
avec la plage sélectionnée, en ajoutant ou 
soustrayant éventuellement des temps.

4  Sélectionnez Selected Range dans le menu 
déroulant Apply Change To.

5  Sélectionnez les règles et pistes que vous 
souhaitez réaligner après l'application des 
changements de métrique.

6  Cliquez sur Apply.

Pour ajouter une série de changements de 
métrique, une mesure après l'autre :

1  Effectuez l'une des opérations suivantes :

• A l'aide du sélecteur, cliquez à l'endroit où 
vous souhaitez que commence le 
changement. Le changement métrique se 
produit au début de la mesure la plus 
proche.

– ou –

• Entrez le numéro de la première mesure 
dans le champ Starting At Bar. 

2  Choisissez Event > Time > Change Meter.

3  Spécifiez une nouvelle métrique et cliquez sur 
Setting. 

4  Choisissez Until the Next Bar dans le menu 
déroulant Apply Change To.

5  Cliquez sur Apply pour valider la nouvelle 
métrique et placer le point d'insertion à la fin de 
la nouvelle mesure.

6  Spécifiez une nouvelle métrique et un 
paramètre Setting pour la mesure suivante.

7  Répétez les étapes 5 à 6 pour tout changement 
de métrique supplémentaire à insérer.

Insertion d'un temps

Le menu déroulant Insert Time permet d'insérer 
un silence dans les règles de chef d'orchestre, les 
pistes MIDI et audio.

Les options de la commande Insert Time sont les 
suivantes :

Start, End et Length : définit les points de début 
et de fin de la sélection ainsi que la durée de 
celle-ci. 

Fenêtre d'insertion de temps
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Set Meter : si la valeur de l'échelle temporelle 
principale est Bars|Beats, Set Meter permet 
d'indiquer une nouvelle métrique pour le temps 
inséré. La sélection est quantifiée au nombre de 
mesures le plus proche ; la métrique précédente 
est insérée après la sélection. Si l'échelle 
temporelle principale fait référence aux 
échantillons, cette option n'est pas disponible.

Option Realign

Les commandes associées à l'option Realign 
permettent de choisir les éléments qui seront 
décalés (ultérieurement) lorsque le temps est 
inséré, de la manière suivante :

• Si l'échelle temporelle principale est au format 
temporel Bars|Beats, vous pouvez choisir de 
réaligner seulement les événements de 
métrique ou de réaligner une combinaison de 
règles de métrique et de tempo, les marqueurs 
et les pistes faisant référence aux tics et un 
choix de pistes basées sur des échantillons.

• Si l'échelle temporelle principale est au format 
temporel absolu (Min:Sec par exemple), vous 
pouvez décider d'aligner indépendamment les 
événements du chef d'orchestre, les 
marqueurs et les pistes faisant référence aux 
tics et un choix de pistes basées sur des 
échantillons. 

Meter Ruler Only : si l'échelle temporelle 
principale est au format temporel Bars|Beats, 
vous pouvez seulement insérer des temps dans 
la règle de métrique. Les événements de 
métrique postérieurs au point de début de la 
sélection sont décalés après le point de la fin de 
la durée de la sélection. 

Si l'échelle temporelle principale fait référence 
aux échantillons, l'option n'est pas disponible.

Meter and Tempo Rulers : permet d'insérer des 
temps dans les règles de métrique et de tempo. 
Les événements de métrique et de tempo 
postérieurs au point de début de la sélection 
sont décalés après le point de la fin de la durée 
insérée.

Tick-Based Markers and Tracks : permet de 
décaler les marqueurs de type Bar|Beat et 
d'insérer du temps dans les pistes basées sur des 
tics. Les événements associés aux marqueurs 
ainsi que les pistes basées sur des tics postérieurs 
au point de début de la sélection sont décalés, 
après le point de la fin, de la durée insérée.

Si la sélection de temps inclut des régions audio 
sur des pistes basées sur les tics, les régions audio 
sont séparées au point de début ; la nouvelle 
région contenant la sélection précédente est 
décalée vers le point de fin.

Sample-Based Markers and Tracks : permet de 
décaler les marqueurs de format temporel absolu 
et d'insérer du temps dans les pistes basées sur 
les échantillons. Les événements associés aux 
marqueurs ainsi que les pistes faisant référence 
aux échantillons postérieurs au point de début 
de la sélection sont décalés après le point de la 
fin de la durée insérée.

Si la sélection inclut des régions audio sur des 
pistes faisant référence aux échantillons, les 
parties sélectionnées des régions audio sont 
séparées au point de début ; la nouvelle région 
contenant la sélection précédente est décalée 
vers le point de fin.
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Exemple d'insertion de temps

Pour insérer quatre mesures vides 4/4 temps 
vides une session :

1  Définissez le format Bars|Beats pour l'échelle 
temporelle principale.

2  Choisissez Event > Time > Insert Time.

3  Spécifiez la mesure où vous voulez insérer les 
mesures dans le champ Start. 

4  Entrez quatre mesures dans le champ Length.

5  Sélectionnez Meter and Tempo Rulers, All 
Tick-Based Markers & Tracks et All Sample-Based 
Markers and Tracks pour l'option Realign.

6  Cliquez sur Apply.

Suppression de temps

Le paramètre Cut Time permet de supprimer un 
intervalle de temps défini (données de règles 
temporelles et de piste) des règles de chef 
d'orchestre, des pistes MIDI et audio.

Les options de la commande Cut Time sont les 
suivantes :

Start, End et Length : définit les points de début 
et de fin de la sélection ainsi que la durée de 
celle-ci. 

Option Realign

Les commandes associées à l'option Realign 
permettent de choisir les éléments qui seront 
décalés à l'issue de la suppression du temps, de la 
manière suivante :

• Si l'échelle temporelle principale est au format 
temporel Bars|Beats, vous pouvez choisir de 
réaligner seulement les événements de 
métrique ou de réaligner une combinaison de 
règles de métrique et de tempo, les marqueurs 
et les pistes faisant référence aux tics et un 
choix de pistes basées sur des échantillons.

• Si l'échelle temporelle principale est au format 
temporel absolu (Min:Sec par exemple), vous 
pouvez décider d'aligner indépendamment les 
événements du chef d'orchestre, les 
marqueurs et les pistes faisant référence aux 
tics et un choix de pistes basées sur des 
échantillons. 

Meter Ruler Only : si l'échelle temporelle 
principale est au format temporel Bars|Beats, 
vous pouvez seulement supprimer des temps 
dans la règle de métrique. Les événements de 
métrique dans la sélection sont supprimés et 
ceux qui se produisent après le point de fin de la 
sélection sont décalés vers le point de début de 
la sélection. 

Si l'échelle temporelle principale fait référence 
aux échantillons, l'option n'est pas disponible.

Meter and Tempo Rulers : permet de supprimer 
du temps dans les règles de métrique et de 
tempo. Les événements de métrique et de tempo 
dans la sélection sont supprimés et ceux qui se 
produisent après le point de fin de la sélection 
sont décalés vers le point de début de la 
sélection.

Fenêtre de suppression de temps
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Tick-Based Markers and Tracks : permet de 
décaler les marqueurs de type Bar|Beat et de 
supprimer le temps des pistes basées sur les tics. 
Les événements associés aux marqueurs ainsi 
que les pistes basées sur les tics dans la sélection 
sont supprimés et ceux postérieurs au point de 
fin de la sélection sont décalés vers l'avant.

Si la sélection de temps inclut des régions audio 
basées sur les tics, la zone sélectionnée de la 
région audio est supprimée ; la région qui suit la 
sélection est décalée vers l'avant.

Sample-Based Markers and Tracks : permet de 
décaler les marqueurs de format temporel absolu 
et de supprimer du temps des pistes basées sur 
les échantillons. Les événements associés aux 
marqueurs ainsi que les pistes basées sur les 
échantillons dans la sélection sont supprimés et 
ceux postérieurs au point de fin de la sélection 
sont décalés vers l'avant.

Si la sélection de temps inclut des régions audio 
faisant référence aux échantillons, la zone 
sélectionnée de la région audio est supprimée ; 
la région qui suit la sélection est décalée vers 
l'avant.

Exemple de suppression de temps

Pour couper trente secondes d'une session :

1  Définissez le format Minutes:Seconds pour 
l'échelle temporelle principale.

2  Choisissez Event > Time > Cut Time.

3  A l'aide du sélecteur, cliquez au début de la 
zone à couper. 

4  Entrez trente secondes (0:30.000) dans le 
champ Length.

5  Sélectionnez Meter and Tempo Rulers, All 
Tick-Based Markers & Tracks et All Sample-Based 
Markers and Tracks pour l'option Realign.

6  Cliquez sur Apply.

Déplacement du début d'un 
morceau

Le paramètre Move Song Start permet de 
redéfinir l'emplacement du début d'un morceau.

Les options de la commande Move Song Start 
sont les suivantes :

Timebase : permet de redéfinir avec précision la 
position du marqueur de début de morceau 
mesuré par une règle temporelle compatible.

Move Start To : définit l'emplacement du 
marqueur de début de morceau dans la règle 
temporelle choisie. 

Renumber Song Start To : lorsque cette option 
est activée, elle permet de définir le marqueur de 
début de morceau à n'importe quel numéro de 
mesure.

Fenêtre de déplacement du début d'un morceau
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Move

Les commandes associées à l'option Move 
permettent de déterminer les éléments à décaler 
lorsque le début du morceau est déplacé, de la 
manière suivante :

Song Start Only : déplace le marqueur de début 
de morceau uniquement.

Meter and Tempo Rulers, Tick-Based Markers and 
Tracks, and Sample-based Markers and
Tracks : déplace le marqueur de début de 
morceau, règles de métrique et de tempo, les 
marqueurs et les pistes basées sur les tics et votre 
sélection de pistes faisant référence aux 
échantillons. 

Exemple de déplacement de début d'un 
morceau

Pour déplacer le marqueur de début d'un morceau 
de 15 secondes sur la timeline :

1  Choisissez Event > Time > Move Song Start.

2  Sélectionnez Minutes:Seconds dans le menu 
déroulant Timebase. 

3  Dans le champ Move Song Start To, entrez 
0:15:000 pour déplacer le début du morceau de 
15 secondes vers l'avant.

4  Si vous voulez renuméroter les mesures de 
manière à ce que le marqueur de début de 
morceau se trouve dans une autre mesure, 
sélectionnez l'option Renumber Song Start et 
entrez le numéro de la mesure dans le champ 
Renumber 1st Bar to.

5  Indiquez si vous voulez déplacer les pistes et 
les marqueurs basés sur des échantillons ou 
aucun d'eux en sélectionnant la case 
correspondante. 

6  Cliquez sur Apply.

Renumérotation des mesures
La commande Renumber Bars permet de 
renuméroter toutes les mesures d'une session, en 
changeant effectivement l'expression, en 
mesures/temps, des emplacements de toutes les 
régions, événements de métrique et de tempo, 
tout en laissant intacte leur position. A l'issue de 
cette manipulation, les expressions, en 
échantillons et en SMPTE, des emplacements 
des données audio de la session ne sont pas 
modifiées.

Pour renuméroter les mesures :

1  Choisissez Event > Renumber Bars.

2  Indiquez la mesure à renuméroter (bar) ainsi 
que le nouveau numéro de la mesure (becomes 
bar), puis cliquez sur Renumber.

Signatures de tonalité
La règle Key Signature permet d'ajouter des 
signatures de tonalité aux sessions Pro Tools. 
Ces signatures peuvent être importées et 
exportées avec les données MIDI. Cette 
fonctionnalité s'utilise notamment lors de 
l'exportation de séquences MIDI vers des 
programmes de notation du type Sibelius. La 
signature de tonalité par défaut est Do majeur.

Boîte de dialogue Renumber Bars

Pour plus d'informations l'exportation de 
données MIDI vers Sibelius, reportez vous à 
la section Envoi vers Sibelius, page 278.
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Règle Key Signature

La règle Key Signature permet d'ajouter, de 
modifier et de supprimer des signatures de 
tonalité. Les signatures de tonalité permettent 
d'indiquer les tonalités et les changements de 
tonalité utilisés dans une session Pro Tools. Elles 
s'utilisent également pour certaines fonctions 
diatoniques (par exemple, pour la transposition 
de tonalité ou la modification de la hauteur de la 
tonalité spécifiée).

Pour afficher la règle Key Signature, effectuez 
l'une des opérations suivantes :

" Sélectionnez View > Rulers > Key Signature.

– ou –

" Dans le sélecteur de vue de la fenêtre Edit, 
sélectionnez Key Signatures.

Vous pouvez également afficher ou masquer la 
portée de la règle Key Signature.

Pour afficher la portée de la règle Key Signature :

1  Affichez la règle Key Signature.

2  Effectuez l'une des opérations suivantes :

• Sélectionnez View > Rulers > Key Signature 
Staff.

– ou –

• Cliquez sur le triangle d'affichage/de 
masquage de la règle Key Signature.

Modification des signatures de tonalité

Vous pouvez ajouter, modifier et supprimer des 
signatures de tonalité.

Pour ajouter une signature de tonalité :

1  Positionnez le curseur à l'emplacement de la 
timeline auquel vous souhaitez ajouter une 
signature de tonalité.

2  Effectuez l'une des opérations suivantes :

• Choisissez Event > Add Key Change.

– ou –

• Cliquez sur le bouton plus (+) de la règle 
Key Signature.

3  Dans la boîte de dialogue Key Change, 
sélectionnez le mode (majeur ou mineur), la 
tonalité, l'emplacement et la durée, puis 
indiquez le type de modification apportée à la 
hauteur.

4  Cliquez sur OK.

Pour modifier une signature de tonalité :

1  Cliquez deux fois sur le marqueur de signature 
de tonalité dans la règle Key Signature.

2  Dans la boîte de dialogue Key Change, 
effectuez les modifications souhaitées.

3  Cliquez sur OK.

Pour supprimer une signature de tonalité, 
effectuez l'une des opérations suivantes :

" Cliquez sur le marqueur de signature de 
tonalité en maintenant enfoncée la touche 
Option (Mac) ou Alt (Windows).

– ou –

" Dans la règle Key Signature, créez une 
sélection contenant la signature de tonalité à 
supprimer, puis choisissez Edit > Clear ou 
appuyez sur la touche Suppr.

Règle Key Signature
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Boîte de dialogue Key Change

La boîte de dialogue Key Change permet de 
spécifier le mode (majeur ou mineur), la tonalité 
(entre sept dièses et sept bémols), la durée 
affectée (par exemple, de la première mesure au 
prochain changement de tonalité) et l'effet du 
changement de tonalité (transposition ou 
limitation des notes MIDI des pistes par rapport 
à la tonalité). Pour plus d'informations sur la 
modification de la hauteur des pistes, 
reportez-vous à la section Modification des 
hauteurs de piste, page 604. La boîte de dialogue 
Key Change s'affiche chaque fois que vous 
ajoutez ou modifiez un marqueur de signature 
de tonalité.

Major Keys : affiche les tonalités majeures (de 
sept bémols à sept dièses).

Minor Keys : affiche les tonalités mineures (de 
sept bémols à sept dièses). Pro Tools applique 
uniquement le mode mineur naturel.

Sharps : permet de sélectionner une tonalité en 
dièse entre les sept dièses et le do majeur (ou le la 
mineur).

Flats : permet de sélectionner une tonalité en 
bémol entre les sept bémols et le do majeur (ou 
le la mineur).

From : permet d'indiquer l'emplacement du 
marqueur de signature de tonalité dans la zone 
Bars|Beats.

To : permet d'indiquer la durée du changement 
de tonalité jusqu'au prochain marqueur de 
signature de tonalité, jusqu'à une sélection ou 
jusqu'à la fin de la session.

Snap To Bar : permet d'accrocher le marqueur 
de signature de tonalité à la barre de mesure.

Edit Pitched Tracks : permet de transposer les 
notes MIDI existantes des pistes sur un ton 
supérieur ou inférieur, de manière diatonique 
ou chromatique (suivant le type de changement 
de tonalité) ou limiter la hauteur des pistes à la 
nouvelle tonalité. Pour plus d'informations sur 
la modification de la hauteur des pistes, 
consultez la section Modification des hauteurs 
de piste, page 604.

Transpose-: si l'option Edit Pitched Tracks est 
activée, cette case permet de transposer les notes 
MIDI existantes des pistes sur un autre ton 
(supérieur ou inférieur, de manière diatonique 
ou chromatique). Par exemple, si la session est 
en do majeur et si vous ajoutez un changement 
de tonalité vers le ré mineur, sélectionnez Edit 
Pitched Tracks, Transpose, Up et Diatonically 
pour transposer les notes de la piste vers le ton 
supérieur et abaisser d'un demi-ton la tierce, la 
sixte et la septième. La séquence do, ré, mi est 
transposée vers ré, mi, fa (naturelle, et non dièse, 
comme c'est le cas avec la transposition 
chromatique). 

Lors de la transposition diatonique, les notes 
chromatiques sont conservées lors du 
changement de tonalité. Par exemple, lors d'un 
changement de tonalité de do majeur en mi 
majeur, la note si bémol devient un ré naturel. 
Vous pouvez dès lors conserver les « blue notes » 
lors d'un changement de tonalité impliquant 
une transposition diatonique.

Boîte de dialogue Key Change
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Constrain Pitches To Key : si l'option Edit 
Pitched Tracks est activée, permet de limiter les 
hauteurs aux notes de la nouvelle tonalité. Si les 
hauteurs diatoniques de l'ancienne tonalité ne 
se trouvent pas dans la nouvelle tonalité, elles 
sont transposées individuellement vers la 
hauteur diatonique la plus proche. Par exemple, 
si vous remplacez la tonalité do majeur par un ré 
majeur, la séquence do, ré, mi, fa, sol devient 
une séquence en do dièse, ré, mi, fa dièse et sol.

La limitation des hauteurs à la tonalité entraîne 
également la limitation des hauteurs 
chromatiques à la nouvelle échelle diatonique. 
Par exemple, si vous changez la tonalité do 
majeur en ré majeur, la séquence do, ré, ré dièse, 
mi sdevient une séquence en do dièse, ré, ré 
et mi.

Modification des hauteurs 
de piste

La hauteur des pistes peut être modifiée sur les 
pistes MIDI ou d'instrument suite à une 
transposition résultant d'un changement de 
tonalité (notamment les limitations à la 
tonalité). Ce type d'opération est autorisé par 
défaut sur toutes les pistes MIDI et d'instrument. 
Toutefois, si certaines pistes MIDI ou 
d'instrument sont assignées à des boîtes à 
rythmes ou à des échantillonneurs, elles ne 
doivent pas être affectées par les changements 
de tonalité en raison des affectations de tonalité. 
Pour verrouiller ces pistes lors de l'application 
d'un changement de tonalité, désactivez 
l'option Pitched correspondante.

Pour désactiver l'option Pitched d'une piste :

" Cliquez sur le sélecteur de playlist de la piste et 
désélectionnez l'option Pitched dans le menu 
contextuel.

Importation de signatures de 
tonalité

Lors de l'importation de données MIDI (ou de 
données de session comportant des données 
MIDI), vous pouvez choisir d'importer ou non 
les signatures de tonalité contenues dans les 
fichiers MIDI.

Import MIDI

La boîte de dialogue Import MIDI contient 
l'option Import Key Signature from MIDI File. 
Si cette option est sélectionnée, les signatures de 
tonalité sont importées dans Pro Tools en même 
temps que les autres données MIDI.

Option Pitched activée dans le sélecteur de playlist
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Import Session Data

La boîte de dialogue Import Session Data 
contient l'option Import Key Signature Map. Si 
cette option est sélectionnée, les signatures de 
tonalité sont importées dans Pro Tools en même 
temps que les données de session.

Emplacements mémoire et 
marqueurs
Chaque session peut mémoriser jusqu'à 
999 emplacements mémoire, qui peuvent servir 
à rappeler :

• des marqueurs des emplacements 
importants de la session ;

• des sélections d'édition sur une ou 
plusieurs pistes ;

• des plages d'enregistrement et de lecture, 
avec les valeurs de pré et de post-roll ;

• des paramètres des pistes, y compris le 
statut Masquer/Afficher, la hauteur de piste 
et les valeurs de zoom ;

• l'activation de groupes d'édition et de 
mixage.

Les emplacements mémoire sont affichés et triés 
dans la fenêtre Memory Locations, dans laquelle 
vous pouvez les rappeler en cliquant dessus.

Propriétés des emplacements 
mémoire

Lorsque vous créez un emplacement mémoire 
(voir Création d'emplacements mémoire, 
page 607) vous êtes invité à définir ses propriétés 
temporelles (Time Properties) et ses propriétés 
générales (General Properties).

Boîte de dialogue Import MIDI

Import Session Data

Fenêtre Memory Locations
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Propriétés temporelles

Sous Time Properties, vous pouvez régler un 
emplacement mémoire sur Marker, Selection ou 
None. Ce choix détermine le type 
d'emplacement mémoire créé. Chacun de ces 
trois types d'emplacement mémoire peut 
également enregistrer n'importe quelle 
combinaison de propriétés générales.

Marker : rappelle un emplacement de timeline, 
exprimée en mesures/temps (Bar|Beat, référence 
basée sur le métronome) ou en nombre 
d'échantillons (Absolute). Lorsque vous rappelez 
un emplacement mémoire de type Marker, le 
curseur de lecture va se placer sur l'emplacement 
du marqueur, et les temps de début et de fin de 
la fenêtre Transport sont également mis à jour. 
Si les sélections d'édition et de timeline sont 
reliées, le curseur d'édition se déplace également 
sur l'emplacement du marqueur.

Les marqueurs apparaissent dans la règle des 
marqueurs avec une fine ligne jaune qui traverse 
toutes les pistes de la fenêtre Edit (pour vous 
aider à réorganiser et à aligner les données des 
pistes). Cliquer sur un marqueur dans la règle 
des marqueurs rappelle son emplacement et ses 
propriétés générales.

Selection : rappelle un emplacement de 
sélection d'édition ou de curseur d'édition, dont 
la référence peut être de type Bar|Beat 
(mesures/temps, basée sur les références 
temporelles) ou absolue (basée sur 
l'échantillon). Un emplacement mémoire de 
type Selection permet de sauvegarder des 
sélections d'édition, pour une ou plusieurs 

pistes, auxquelles vous revenez souvent pendant 
une session. Si les sélections d'édition et de 
timeline sont liées, un emplacement mémoire 
de sélection peut aussi rappeler des plages 
d'enregistrement et de lecture.

None : ne rappelle aucune propriété temporelle 
et est donc appelé emplacement mémoire des 
propriétés générales.

Références Bar|Beat et absolue

Le menu déroulant Reference détermine si 
l'emplacement mémoire Marker ou Selection est 
de type Bar|Beat ou absolu. Si vous choisissez 
l'option Bar|Beat, l'emplacement mémoire est 
basé sur le métronome ; autrement dit, 
l'expression de son emplacement en 
mesures/temps demeure constante, même si 
vous modifiez le tempo. En revanche, sa 
position relative aux données audio, dont la 
position est exprimée en échantillons, change.

Si vous choisissez l'option Absolute, 
l'emplacement mémoire est exprimé en 
échantillons ; autrement dit, son emplacement 
exprimé en mesures/temps change dès qu'on 
modifie le tempo. En revanche, la relation aux 
données audio, elles aussi basées sur les 
échantillons, n'est pas altérée.

Marqueurs dans la règle des marqueurs

Seules des sélections contiguës peuvent être 
sauvegardées avec des emplacements 
mémoire. Les sélections non contiguës, 
effectuées avec l'outil de saisie d'objet, 
seront rappelées comme si la sélection avait 
été faite avec l'outil d'accrochage de temps.

Marqueur Bar|Beat (à gauche) et marqueur Absolu 
(à droite)
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Dans la règle des marqueurs, les marqueurs de 
type Bar|Beat apparaissent comme des écussons 
jaunes, tandis que les marqueurs absolus 
apparaissent sous forme de diamants jaunes.

Propriétés générales

Les trois types d'emplacements mémoire 
(Marker, Selection et None) peuvent stocker et 
rappeler n'importe quelle combinaison des 
propriétés générales suivantes :

Number : la modification du numéro permet 
d'écraser un emplacement mémoire ou de 
modifier l'ordre des emplacements mémoire 
dans la fenêtre Memory Locations.

Zoom Settings : rappelle les valeurs de zoom 
horizontal, audio et MIDI pour les pistes audio, 
MIDI et d'instrument.

Pre- and Post-Roll Times : rappelle les valeurs de 
pré et de post-roll (mais pas l'éventuelle 
activation des fonctions correspondantes). 
Cette propriété peut être stockée avec un 
emplacement mémoire de sélection pour 
rappeler des plages d'enregistrement et de 
lecture avec des valeurs de pré/post-roll.

Track Show/Hide : rappelle quelles pistes sont 
masquées. Cette propriété vous permet 
d'afficher des groupes de pistes pour l'édition et 
le mixage.

Track Heights : rappelle toutes les hauteurs de 
pistes. Utilisez cette option avec l'option Zoom 
Settings pour rappeler des environnements 
d'édition adaptés à des tâches particulières, 
comme l'édition jusqu'au niveau de 
l'échantillon ou le rognage de notes MIDI.

Group Enables : rappelle quels groupes d'édition 
et de mixage sont actifs. Cette option est utile 
pour rappeler des groupes pour des tâches 
particulières d'édition et de mixage, telles que la 
coupure de toutes les pistes de batterie ou 
l'atténuation d'une paire stéréo.

Window Configuration : permet de rappeler une 
configuration de fenêtre spécifique. 
Cette option s'utilise pour rappeler une 
configuration de fenêtre adaptée aux tâches 
d'édition ou de mixage.

Commentaires

Les trois types d'emplacements mémoire 
(Marker, Selection et None) peuvent stocker et 
rappeler les commentaires. Vous pouvez entrer 
un maximum de 255 caractères pour décrire un 
emplacement mémoire. Vous avez également la 
possibilité d'éditer les commentaires 
précédemment saisis.

Création d'emplacements 
mémoire

Il est possible de créer des emplacements 
mémoire de différentes manières, suivant 
leur type.

Lorsque vous créez un emplacement mémoire, 
le numéro disponible suivant lui est attribué 
(1–999). Ce numéro sert à rappeler 
l'emplacement mémoire depuis le pavé 
numérique.

Pour en savoir plus, reportez-vous aux 
sections Création d'emplacements 
mémoire, page 607 et Edition des 
emplacements mémoire, page 610.
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Pour créer un emplacement mémoire de type 
marqueur :

1  Configurez les paramètres de la session que 
vous sauvegarderez avec l'emplacement 
mémoire de type marqueur, tels que les 
paramètres de zoom, le statut 
d'affichage/masquage des pistes, les hauteurs de 
pistes et l'activation des groupes d'édition et de 
mixage.

2  Sélectionnez Options > Link Timeline and 
Edit Selection.

3  Si la règle des marqueurs n'est pas affichée, 
sélectionnez View > Rulers > Markers.

4  Effectuez l'une des opérations suivantes :

• Avec le sélecteur, cliquez sur une piste ou 
une règle à l'emplacement où vous 
souhaitez placer le marqueur. Pour placer 
un marqueur au début d'une région, 
sélectionnez-la à l'aide de l'outil 
d'accrochage de temps. Cliquez sur le 
bouton Add Marker/Memory Location (ou 
appuyez sur la touche Entr du pavé 
numérique).

– ou –

• Tout en appuyant sur Ctrl (Mac) ou sur la 
touche de démarrage (Windows), déplacez 
le curseur dans la règle des marqueurs (le 
curseur devient un outil d'accrochage 
associé au signe plus (+) et cliquez à 
l'emplacement où vous souhaitez placer le 
marqueur.

5  Dans la boîte de dialogue New Memory 
Location, sélectionnez l'option Marker et 
indiquez sa référence, Bar|Beat ou Absolute.

6  Entrez le nom du nouveau marqueur et 
sélectionnez les propriétés générales que vous 
voulez sauvegarder avec le marqueur.

7  Cliquez sur OK. Le marqueur est créé et 
apparaît dans la règle des marqueurs, ainsi que 
dans la fenêtre Memory Locations.

Pour créer un emplacement mémoire de 
sélection :

1  Configurez les paramètres de la session que 
vous sauvegarderez avec l'emplacement 
mémoire de type Selection, tels que les 
paramètres de zoom, le statut 
d'affichage/masquage des pistes, les hauteurs de 
pistes et l'activation des groupes d'édition et de 
mixage.

2  Sélectionnez une plage de données sur une ou 
plusieurs pistes. 

3  Effectuez l'une des opérations suivantes :

• Appuyez sur la touche Entr du pavé 
numérique.

– ou –

• Dans le menu déroulant de la fenêtre 
Memory Locations (cliquez sur le bouton 
Name), choisissez Add Memory Location.

4  Dans la boîte de dialogue New Memory 
Location, sélectionnez l'option Selection et 
indiquez la référence, Bar|Beat ou Absolute.

5  Entrez le nom du nouvel emplacement 
mémoire et sélectionnez les propriétés générales 
que vous voulez sauvegarder.

6  Cliquez sur OK. L'emplacement mémoire de 
sélection est créé et apparaît dans la fenêtre 
Memory Locations.

Bouton d'ajout d'emplacement mémoire/de marqueur

Insertion manuelle d'un marqueur
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Pour créer un emplacement mémoire des 
propriétés générales :

1  Configurez les paramètres de la session que 
vous sauvegarderez avec l'emplacement 
mémoire de type Selection, tels que les 
paramètres de zoom, le statut 
d'affichage/masquage des pistes, les hauteurs de 
pistes et l'activation des groupes d'édition et de 
mixage.

2  Appuyez sur la touche Entr du pavé 
numérique.

3  Dans la boîte de dialogue Memory Location, 
sélectionnez l'option None.

4  Entrez le nom du nouvel emplacement 
mémoire et sélectionnez les propriétés générales 
que vous voulez sauvegarder.

5  Cliquez sur OK. L'emplacement mémoire des 
propriétés générales est créé et apparaît dans la 
fenêtre Memory Locations.

Création d'emplacements mémoire à 
la volée

Lorsque l'option Auto-Name Memory Locations 
When Playing des préférences d'édition est 
activée, vous pouvez créer des emplacements 
mémoire en cours de lecture sans ouvrir la boîte 
de dialogue New Memory Location. Vous 
pouvez également sélectionner cette option 
dans le menu déroulant de la fenêtre Memory 
Locations.

Cette fonction est utile lorsque vous voulez 
marquer certains emplacements tout en 
écoutant une passe d'enregistrement, ou 
marquer certaines images lors du visionnage 
d'une scène vidéo.

Pour créer un marqueur en cours de lecture :

1  Dans le menu déroulant de la fenêtre Memory 
Locations, sélectionnez Default To Marker. 
Ceci garantit que les nouveaux emplacements 
mémoire seront, par défaut, des marqueurs.

2  Dans le menu déroulant de la fenêtre Memory 
Locations, sélectionnez Auto-Name Memory 
Locations.

3  Pour les marqueurs insérés ayant une 
référence Bar|Beat, veillez à définir l'échelle de 
temps principale sur Bars:Beats.

4  Dans la fenêtre Transport, cliquez sur le 
bouton Play.

5  Lorsque l'emplacement est atteint, appuyez 
sur la touche Entr du pavé numérique. Un 
marqueur est créé automatiquement et apparaît 
dans la règle des marqueurs.

Les marqueurs créés automatiquement sont 
nommés et numérotés sous la forme 
« Marker 1 », « Marker 2 », « Marker 3 », etc.

Lorsque l'option Default To Marker est 
désélectionnée, les nouveaux emplacements 
mémoire seront par défaut identiques au dernier 
type créé. Cela signifie que si le dernier 
emplacement mémoire créé était une sélection, 
c'est ce type qui sera créé à la volée. Dans ce cas, 
le nom de l'emplacement mémoire créé est basé 
sur le début de la sélection d'édition, en 
reprenant le format de l'échelle temporelle 
principale (tel que « 2|2|305 » ou « 0:02.658 »).

Dans la boîte de dialogue New Memory 
Location, vous pouvez activer ou désactiver 
toutes les propriétés en cliquant sur 
n'importe quelle propriété générale tout en 
maintenant enfoncée la touche Option 
(Mac) ou Alt (Windows). Vous pouvez aussi 
cliquer sur n'importe quelle propriété en 
appuyant sur Pomme (Mac) ou sur Ctrl 
(Windows) pour changer son état et celui de 
toutes les autres propriétés générales.
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Rappel d'emplacements mémoire

Vous pouvez rappeler des emplacements 
mémoire à partir de la fenêtre Memory 
Locations et à partir du pavé numérique. 
De plus, vous pouvez rappeler des 
emplacements mémoire de type Marker en 
cliquant dessus dans la règle des marqueurs.

Pour rappeler un emplacement mémoire :

1  Si la fenêtre Memory Locations n'est pas 
ouverte, choisissez Window > Memory 
Locations pour l'ouvrir.

2  Si vous rappelez un emplacement mémoire de 
sélection qui définit une plage d'enregistrement 
ou de lecture, sélectionnez Options > Link 
Timeline and Edit Selection.

3  Effectuez l'une des opérations suivantes :

• Cliquez sur l'emplacement mémoire désiré 
dans la fenêtre Memory Locations pour le 
rappeler.

• Lorsque le mode du pavé numérique est 
réglé sur Classic, appuyez sur le numéro de 
l'emplacement mémoire suivi de la touche 
point. 

• Lorsque le mode du pavé numérique est 
réglé sur Transport ou Shuttle, appuyez sur 
la touche Point (.), sur le numéro de 
l'emplacement mémoire, suivi à nouveau 
de la touche Point (.).

Pour rappeler un marqueur depuis la règle des 
marqueurs :

1  Si la règle des marqueurs n'est pas affichée, 
sélectionnez View > Rulers > Markers.

2  Cliquez sur le marqueur. Le curseur de lecture 
se positionne sur le marqueur et les propriétés 
générales stockées avec le marqueur sont 
rappelées.

Edition des emplacements 
mémoire

Les emplacements mémoire peuvent être 
renommés, édités, supprimés, copiés et collés.

Pour renommer un emplacement mémoire :

1  Effectuez l'une des opérations suivantes :

• Dans la fenêtre Memory Locations, cliquez 
deux fois sur l'emplacement mémoire que 
vous voulez renommer.

– ou –

• Si vous renommez un emplacement 
mémoire de type marqueur, cliquez deux 
fois sur le marqueur dans la règle des 
marqueurs.

2  Entrez le nouveau nom de l'emplacement 
mémoire puis cliquez sur OK.

Lorsque l'option Use Separate Play and Stop 
Keys est sélectionnée dans la page 
Operation Preferences, la touche Entrée ne 
permet plus d'ajouter des marqueurs 
d'emplacements mémoire. Pour effectuer 
cette opération, vous devez d'abord appuyer 
sur le point (.), puis sur la touche Entrée du 
pavé numérique. Le nouveau marqueur 
apparaît lorsque vous appuyez sur la touche 
Entrée.

Si vous rappelez un emplacement mémoire à 
partir du pavé numérique, il n'est pas 
nécessaire que la fenêtre Memory Locations 
soit ouverte.

Même si la règle des marques n'est pas 
affichée, vous pouvez rappeler des marqueurs 
à partir de la fenêtre Memory Locations et à 
partir du pavé numérique.



Chapitre 23 : Pistes du chef d'orchestre et emplacements mémoire 611

Pour redéfinir les propriétés générales d'un 
emplacement mémoire :

1  Configurez les paramètres de la session tels 
que les paramètres de zoom, les valeurs de pré et 
de post-roll, le statut d'affichage/masquage des 
pistes, les hauteurs de pistes et l'activation des 
groupes.

2  Effectuez l'une des opérations suivantes :

• Dans la fenêtre Memory Locations, cliquez 
sur l'emplacement mémoire que vous 
voulez redéfinir en maintenant enfoncée la 
touche Ctrl (Mac) ou cliquez avec le bouton 
droit de la souris (Windows).

– ou –

• Si vous modifiez un emplacement mémoire 
de type marqueur, cliquez sur le marqueur 
dans la règle des marqueurs en maintenant 
enfoncée la touche Ctrlle (Mac) ou cliquez 
avec le bouton droit de la souris 
(Windows).

3  Dans la boîte de dialogue Memory Locations, 
sélectionnez les propriétés générales que vous 
voulez sauvegarder avec l'emplacement 
mémoire.

4  Entrez le nom de l'emplacement mémoire et 
cliquez sur OK. 

Pour changer le type d'un emplacement mémoire :

1  Effectuez l'une des opérations suivantes :

• Dans la fenêtre Memory Locations, cliquez 
deux fois sur l'emplacement mémoire que 
vous voulez modifier.

– ou –

• Si vous modifiez un emplacement mémoire 
de type marqueur, cliquez deux fois sur le 
marqueur dans la règle des marqueurs.

2  Dans la boîte de dialogue Memory Location, 
sélectionnez l'option Marker, Selection, ou 
None comme type d'emplacement mémoire. 

3  Entrez le nom de l'emplacement mémoire et 
cliquez sur OK.

Pour modifier la sélection stockée avec un 
emplacement mémoire :

1  Si la fenêtre Memory Locations n'est pas 
ouverte, choisissez Window > Memory 
Locations pour l'ouvrir.

2  Sélectionnez une plage de données sur une ou 
plusieurs pistes. 

3  Dans la fenêtre Memory Locations, cliquez sur 
l'emplacement mémoire que vous voulez 
redéfinir en maintenant la touche Control 
(Mac) ou cliquez avec le bouton droit de la 
souris (Windows).

4  Entrez le nom de l'emplacement mémoire et 
cliquez sur OK.

Pour déplacer un marqueur en le faisant glisser :

" Dans la règle des marqueurs, faites glisser le 
marqueur vers la gauche ou la droite.

Lorsque le mode d'édition est réglé sur Grid, 
l'événement déplacé s'aligne sur le pas de grille 
courante. En mode Spot, la boîte de dialogue 
Spot s'ouvre.

Pour aligner un marqueur sur un autre 
emplacement :

1  Sélectionnez Options > Link Timeline and 
Edit Selection.

2  Effectuez l'une des opérations suivantes :

• Dans n'importe quelle règle de base de 
temps, cliquez avec le sélecteur sur le 
nouvel emplacement.

Déplacement d'un marqueur
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– ou –

• Cliquez dans la liste de diffusion de 
n'importe quelle piste. Pour aligner le 
marqueur sur le début d'une région, 
sélectionnez-la à l'aide de l'outil 
d'accrochage de temps.

3  Dans la fenêtre Memory Locations ou la règle 
des marqueurs, cliquez sur l'emplacement 
mémoire de type marqueur que vous voulez 
redéfinir en maintenant enfoncée la touche Ctrl 
(Mac) ou la touche Démarrer (Windows).

4  Entrez le nom du marqueur et cliquez sur OK.

Suppression des emplacements 
mémoire

Pour supprimer un emplacement mémoire, 
effectuez l'une des opérations suivantes :

" Dans la fenêtre Memory Locations, 
sélectionnez l'emplacement mémoire et 
choisissez Delete Memory Location dans le 
menu déroulant.

– ou –

" Dans la fenêtre Memory Locations, cliquez sur 
l'emplacement mémoire en maintenant 
enfoncée la touche Option (Mac) ou Alt 
(Windows).

Pour supprimer tous les emplacements mémoire, 
effectuez l'une des opérations suivantes :

" Dans la fenêtre Memory Locations, choisissez 
Delete All dans le menu déroulant.

– ou –

" Cliquez sur n'importe quel emplacement 
mémoire de la fenêtre Memory Locations en 
maintenant enfoncées les touches Option+Maj 
(Mac) ou Alt+Maj (Windows).

Pour supprimer un marqueur de la règle des 
marqueurs :

" Tout en appuyant sur Option (Mac) ou sur Alt 
(Windows), déplacez le curseur sur le marqueur 
(le curseur se transforme alors en outil 
d'accrochage associé au signe moins (-) et 
cliquez dessus pour le supprimer.

Copie d'emplacements mémoire de 
type marqueur

Pour copier et coller plusieurs marqueurs :

1  Pour restreindre la sélection en fonction du 
pas de grille actuel, réglez le mode d'édition sur 
Grid. 

2  Déplacez-vous dans la règle de tempo pour 
sélectionner les mesures de façon à inclure les 
marqueurs.

Si le début de la sélection inclut un marqueur, 
appuyez sur Pomme (Mac) ou sur Ctrl 
(Windows) pour faire apparaître le sélecteur.

3  Choisissez Edit > Copy.

4  Cliquez dans la règle des marqueurs à l'endroit 
où vous souhaitez coller les événements de 
tempo.

5  Choisissez Edit > Paste. Le contenu du 
presse-papiers est collé à partir du point 
d'insertion et remplace les marqueurs existants.

Appuyez sur Option (Mac) ou sur Alt 
(Windows) tout en déplaçant le curseur 
pour effectuer la sélection dans toutes les 
pistes du chef d'orchestre.
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Pour étendre une sélection d'édition d'une piste à 
la règle des marqueurs :

1  A l'aide du sélecteur ou de l'outil d'accrochage 
de temps, sélectionnez une plage de piste.

2  Cliquez sur la règle des marqueurs tout en 
appuyant sur Maj. 

Cliquez de nouveau sur la règle de tempo tout 
en appuyant sur Maj pour la retirer de la 
sélection.

Pour sélectionner tous les marqueurs de la règle 
des marqueurs :

" Cliquez deux fois avec le sélecteur dans la 
règle de tempo.

Fenêtre Memory Locations
La fenêtre Memory Locations répertorie les 
emplacements mémoire en indiquant leur 
numéro, leur nom ainsi que les icônes des filtres 
d'affichage. Cette fenêtre permet de rappeler et 
de modifier les emplacements.

Pour rappeler un emplacement mémoire à partir de 
la fenêtre Memory Locations.

" Cliquez sur l'emplacement mémoire.

Commandes et options des 
emplacements mémoire

Vous pouvez sélectionner les options d'affichage 
et de tri, ainsi que les commandes permettant de 
créer et de supprimer des emplacements 
mémoire, à partir du menu déroulant de la 
fenêtre Memory Locations.

Sous menu View : regroupe les commandes 
permettant d'afficher ou de masquer les 
différentes propriétés d'emplacement mémoire :

• Show Icons

• Markers

• Selections

• Zoom 

• Pre/Post Roll 

• Track Show/Hide 

• Track Height

Fenêtre Memory Locations avec les icônes des filtres 
d'affichage

Lorsque le mode du pavé numérique est 
réglé sur Classic, appuyez sur le numéro de 
l'emplacement mémoire suivi de la touche 
point. Lorsque le mode du pavé numérique 
est réglé sur Transport ou Shuttle, appuyez 
sur la touche Point (.), sur le numéro de 
l'emplacement mémoire, suivi à nouveau de 
la touche Point (.).

Menu déroulant de la fenêtre Memory Locations
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• Group Enables

• Window Configuration

• Show Markers Only

• All

Show Main Counter : lorsque vous sélectionnez 
cette option, une colonne apparaît dans la 
fenêtre Memory Locations afin d'afficher les 
emplacements par rapport à l'échelle temporelle 
principale (marqueurs) et les temps de début des 
emplacements mémoire de sélection. Les 
emplacements mémoire des propriétés générales 
n'affichent rien dans cette colonne.

Pour accéder au menu déroulant permettant de 
modifier l'échelle temporelle principale, cliquez 
sur la partie supérieure de la colonne Main Time 
Scale.

Show Sub Counter : lorsque vous sélectionnez 
cette option, une colonne apparaît dans la 
fenêtre Memory Locations afin d'afficher les 
emplacements par rapport à l'échelle temporelle 
secondaire (marqueurs) et les points de début 
des emplacements mémoire de sélection. Les 
emplacements mémoire des propriétés générales 
n'affichent rien dans cette colonne.

Pour accéder au menu déroulant permettant de 
modifier l'échelle temporelle secondaire, cliquez 
sur la partie supérieure de la colonne Sub 
Timescale.

Show Comments : lorsque vous sélectionnez 
cette option, une colonne apparaît dans la 
fenêtre Memory Locations afin d'afficher les 
commentaires de chacun des marqueurs.

Sort by Time : lorsque cette option est 
sélectionnée, les marqueurs sont triés par ordre 
d'apparition dans la timeline, suivis des 
emplacements mémoire de sélection et des 
propriétés générales, classés par ordre de 
création.

Lorsque l'option Sort by Time est 
désélectionnée, tous les emplacements mémoire 
sont classés par numéro.

New Memory Location : cette commande permet 
de créer un emplacement mémoire.

Edit <Nom> : permet d'accéder à la boîte de 
dialogue Edit Memory Location correspondant à 
l'emplacement mémoire sélectionné. Pour 
modifier un emplacement mémoire, vous 
pouvez également cliquer deux fois dessus dans 
la fenêtre Memory Locations.

Clear <Nom> : efface l'emplacement mémoire 
sélectionné, sans le supprimer définitivement. 
Le numéro attribué aux emplacements mémoire 
suivants n'est pas modifié.

Compteurs principaux et secondaires dans la fenêtre 
Memory Locations

Echelle temporelle secondaireEchelle temporelle principale

Commentaires dans la fenêtre Memory Locations

Pour supprimer un emplacement, cliquez 
dessus dans la fenêtre Memory Locations en 
maintenant enfoncée la touche Option 
(Mac) ou Alt (Windows).
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Delete All : supprime tous les emplacements 
mémoire. L'emplacement mémoire suivant est 
associé au numéro d'emplacement 1.

Insert Slot Before <Nom> : ajoute un 
emplacement mémoire vide au-dessus de 
l'emplacement sélectionné ; le numéro des 
emplacements suivants est mis à jour.

Delete <Nom> Slot : supprime l'emplacement 
mémoire sélectionné et met à jour le numéro 
des emplacements suivants.

Default To Marker : lorsque cette option est 
sélectionnée, les nouveaux emplacements 
mémoire créés sont des marqueurs par défaut, 
même si vous pouvez définir un autre type dans 
la boîte de dialogue New Memory Location.

Auto-Name Memory Location : lorsque cette 
option est sélectionnée, les emplacements 
mémoire sont créés automatiquement sans que 
la boîte de dialogue New Memory Location ne 
s'ouvre. Si l'option Default To Marker est 
sélectionnée, un emplacement mémoire de type 
marqueur est créé automatiquement. Sinon, le 
type d'emplacement mémoire est déterminé par 
le dernier type créé (Marker, Selection, ou 
None).

Icônes des filtres d'affichage

Lorsque vous sélectionnez l'option Show Icons 
dans le menu déroulant Memory Locations, la 
fenêtre Memory Locations propose un filtre basé 
sur les icônes qui permet d'afficher ou de 
masquer les emplacements mémoire en 
fonction de leurs propriétés. Pour 
afficher/masquer les emplacements mémoire en 
fonction de leurs propriétés, cliquez sur l'icône 
appropriée.

Si une icône est désactivée (grisée), tous les 
emplacements mémoire associés à cette 
propriété sont masqués. Cependant, un 
emplacement mémoire qui contient d'autres 
propriétés correspondant à une icône encore 
active restera affiché. Lorsqu'une icône 
d'affichage est active, elle apparaît en couleurs. 
Lorsqu'elle est désactivée, elle apparaît en grisé.

De plus, le filtre d'affichage est pratique pour 
indiquer les propriétés stockées dans chaque 
emplacement mémoire (indiquées par une 
rangée d'icônes avec chaque emplacement 
mémoire).

Icônes des filtres d'affichage des emplacements 
mémoire

Marqueur

Emplacement mémoire de sélection

Zoom

Pré-roll et post-roll

Afficher/Masquer
Hauteur de piste

Groupes actifs

Configuration de fenêtre
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Chapitre 24 : Beat Detective

Beat Detective est un puissant outil d'analyse, 
d'édition et de manipulation de données audio 
ou de pistes MIDI avec des données rythmiques 
inhérentes.

Beat Detective analyse une sélection audio ou 
MIDI, détecte ses crêtes des transitoires ou notes 
accentuées et crée des beat triggers basés sur les 
crêtes des transitoires ou les notes MIDI 
détectées. A partir de ces beat triggers, Beat 
Detective peut : 

• Extraire les informations de tempo et repérer 
les temps pour créer des marqueurs Bar|Beat 
utilisables pour définir la table de tempos de la 
session. Pour plus d'informations, 
reportez-vous à la section Création de 
marqueurs Bar|Beat avec le Beat Detective, 
page 629.

• Extraire les informations de tempo et de 
groove sous forme de modèles groove, appelés 
DigiGrooves. Ces modèles peuvent être 
appliqués aux données audio ou MIDI à l'aide 
de Beat Detective ou de Groove Quantize (voir 
Modèles DigiGroove, page 630.

• Divisez la sélection audio en régions à part 
entière, puis conformez (ou « quantifiez ») les 
régions divisées à la table de tempos de la 
session ou aux modèles groove. Voir 
Séparation des régions avec le Beat Detective, 
page 633 et Conformation de régions avec le 
Beat Detective, page 635.

Beat Detective et les données source

Le Beat Detective est extrêmement efficace avec 
les données audio ou MIDI aux transitoires 
d'attaque ou aux accents marqués (c'est-à-dire 
avec la plupart des instruments utilisés dans la 
musique populaire, tels que la batterie, la guitare 
ou la basse). Le Beat Detective fonctionnera 
moins bien avec les données audio aux attaques 
moins franches ou au phrasé legato (telles que 
les cordes et les voix).

Applications du Beat Detective

Le Beat Detective peut servir dans de 
nombreuses situations :

Extraction du tempo à partir des données audio : 

Beat Detective peut générer des marqueurs 
Bar|Beat pour l'extraction du tempo, même si les 
données contiennent des tempos variés ou des 
éléments interprétés avec un certain swing. 
De plus, une fois les marqueurs Bar|Beat créés, ils 
peuvent être utilisés pour quantifier d'autres 
régions audio et pistes MIDI. 

Création de DigiGrooves : Le Beat Detective peut 
extraire des modèles groove, appelés 
DigiGrooves, à partir d'une sélection audio. 
Les DigiGrooves peuvent être utilisés pour 
appliquer le groove ou le feeling d'un passage 
capturé vers d'autres sélections audio (utilisant 
Groove Conform) ou vers des données MIDI 
(utilisant Groove Quantize). 
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Conformation des régions audio : Beat Detective 
peut conformer (« quantifier ») les données 
audio ayant un tempo différent ou des tempos 
variés, à la table de tempos actuelle de la session 
ou à un modèle groove. 

« Resserrer » les performances : Beat Detective 
peut améliorer le « timing » de certaines 
données audio en calculant et en extrayant son 
tempo moyen, puis en conformant ses 
composantes rythmiques (les régions séparées 
par le Beat Detective) à la table de tempos de la 
session.

Correspondance de boucles : comme Beat 
Detective peut extraire les informations de 
tempo et repérer les temps dans les données 
audio, puis conformer ces dernières à une table 
de tempos ou à un modèle groove existants, il 
peut servir à aligner des boucles sur différents 
tempos ou ambiances. Si une boucle présente un 
tempo différent de la session courante, le Beat 
Detective vous permet de séparer rapidement 
chaque temps de la boucle et de les conformer à 
la table de tempos (comme alternative à la 
compression ou à l'extension temporelle de la 
boucle, qui peut modifier la hauteur et 
l'ambiance des données audio). 

Remixes : Beat Detective peut servir pour les 
remixes ou pour créer de nouveaux rythmes. 
Il peut extraire le tempo des pistes de batterie 
d'origine et même, dans certains cas, du mix 
stéréo d'origine. Les nouvelles pistes, audio ou 
MIDI, peuvent être conformées aux données 
d'origine ou, à l'inverse, celles-ci peuvent être 
conformées à de nouvelles pistes de batterie, ce 
qui confère au remix un feeling rythmique 
radicalement nouveau.

Utilisation de la fonction Edit Smoothing en 
post-production uniquement) La fonction Edit 
Smoothing du Beat Detective permet de 
nettoyer automatiquement des pistes de 
bruitages contenant de nombreuses régions 
devant subir rognage et crossfades : elle 
supprime efficacement les silences ainsi créés 
entre les régions (ce qui conserve l'ambiance 
acoustique de la pièce sur toute la piste).

Configuration d'utilisation du 
Beat Detective
Le Beat Detective est disponible sur tous les 
systèmes Pro Tools.

Lorsque vous travaillez avec des données 
audio basées sur des tics, servez-vous de la 
commande Region Separation de Beat 
Detective pour séparer rapidement des 
régions audio en sons (ou sections). Il est 
également possible de regrouper les régions 
séparées pour faciliter l'édition et 
l'organisation.

Pro Tools LE ne permet pas d'appliquer 
Beat Detective à plusieurs pistes. Lorsque 
cela est le cas, seule la piste du haut est 
éditée.
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Besoins en RAM du Beat Detective

Les opérations du Beat Detective peuvent 
demander une grande quantité de RAM, en 
particulier si vous travaillez avec plusieurs pistes 
et des sélections de longue durée.

Pour éviter les situations de mémoire 
insuffisante avec Beat Detective, procédez de la 
façon suivante :

• Si vous remarquez un ralentissement du 
fonctionnement du Beat Detective, ajoutez 
plus de RAM à votre ordinateur 

• Si votre ordinateur ne possède pas 
suffisamment de RAM, travaillez avec des 
sélections plus courtes ou sur des pistes 
individuelles.

• Réduisez le nombre de niveaux d'annulation 
dans les préférences d'édition (voir Niveaux 
d'annulation et RAM, page 418). Les 
opérations demandant beaucoup de mémoire, 
telles que l'Edit Smoothing (données audio 
uniquement) avec Beat Detective, peuvent 
immobiliser une grande quantité de RAM 
lorsqu'elles se trouvent dans la file 
d'annulation.
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Fenêtre Beat Detective
La fenêtre Beat Detective s'affiche, identique à celle illustrée à la figure 24, ci-dessous. 

Pour ouvrir la fenêtre Beat Detective, effectuez 
l'une des opérations suivantes :

" Choisissez Event > Beat Detective.

– ou –

" Appuyez sur Ctrl+8 (Windows) ou sur 
Pomme+8 (Mac) sur le clavier numérique.

Le Beat Detective est une fenêtre flottante que 
vous pouvez laisser ouverte lorsque vous 
travaillez. Vous pouvez donc régler les 
paramètres en temps réel en cours de lecture, 
tout en regardant les beat triggers de votre 
sélection apparaître dans la fenêtre Edit.

Modes du Beat Detective
La fenêtre du Beat Detective se compose de trois 
zones : Operation, Selection et Detection. 
Les commandes proposées dans la zone Action 
varient en fonction du mode de 
fonctionnement (Operation) choisi. Les options 
de sélection (Selection) de Beat Detective restent 
disponibles dans tous les modes de 
fonctionnement.

Les modes du Beat Detective sont les suivants :

Operation : permet d'analyser, au choix, des 
données MIDI ou des données audio.

Bar|Beat Marker Generation : crée des 
marqueurs Bar|Beat (mesures/temps) 
correspondant aux transitoires détectés dans la 
sélection audio.

Groove Template Extraction : extrait les 
informations rythmiques et dynamiques des 
données audio, et enregistre ces informations 
dans le Presse-Papiers de Groove, ou sous forme 
de modèle DigiGroove.

Figure 24.  Beat Detective (Pro Tools HD illustré)
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Region Separation (données audio uniquement) : 
sépare et crée de nouvelles régions en fonction 
des transitoires détectés dans la sélection audio.

Region Conform (données audio uniquement) : 
conforme toutes les régions séparées de la 
sélection à la table de tempos en cours. Beat 
Detective peut conformer des régions audio à 
des modèles groove (tels que des modèles 
DigiGrooves) en plus de la quantification 
standard.

Edit Smoothing (données audio uniquement) : 
remplit les espaces entre les régions conformées 
en rognant automatiquement ces dernières, puis 
insère des crossfades si vous le souhaitez.

Définition d'une sélection 
pour le Beat Detective
Que vous procédiez à la génération des 
marqueurs Bar|Beat (mesures/temps), à 
l'extraction d'un modèle DigiGroove ou à la 
séparation des régions pour les conformer, vous 
devez toujours définir la sélection des données 
audio ou MIDI que vous voulez analyser. 
La fenêtre du Beat Detective offre des outils vous 
permettant de définir et de capturer la plage de 
sélection, la mesure (time signature) et le feeling 
« swing » (subdivision) des données audio 
sélectionnées.

Pour que le Beat Detective puisse créer des beat 
triggers précisément en mesure, la durée et la 
métrique de la sélection doivent être 
correctement définies. De plus, la sélection ne 
peut contenir aucun changement de métrique 
ou de tempo.

Pour définir une sélection de Beat Detective :

1  Dans la fenêtre Edit, sélectionnez une plage de 
données audio ou MIDI sur une ou plusieurs 
pistes.

Vérifiez que les points de début et de fin de la 
sélection tombent précisément sur le temps. 
Pour atteindre les points de début et de fin d'une 
région audio, faites un zoom au niveau de 
l'échantillon et utilisez l'option de tabulation 
vers transitoires (voir Tabulation vers 
transitoires, page 473).

Pour obtenir les meilleurs résultats possibles 
avec le Beat Detective, assurez-vous que le 
passage sélectionné démarre exactement sur 
l'attaque du premier temps. 

Utilisez la lecture en boucle pour vérifier la 
précision de votre sélection.

Pro Tools LE ne permet pas d'appliquer 
Beat Detective à plusieurs pistes. Lorsque 
cela est le cas, seule la piste du haut est 
éditée.

Pour conserver intacte la sélection d'édition 
lors de la lecture ou du bouclage à partir de 
n'importe quel emplacement, désélectionnez 
Options > Link Timeline et Edit Selection.

Sélection audio pour le Beat Detective
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2  Choisissez Event > Beat Detective.

3  Vous devez définir ou capture la sélection 
chaque fois que vous effectuez une nouvelle 
sélection ou changez la table de tempos. Pour 
définir la plage de sélection, effectuez l'une des 
opérations suivantes :

• Si le tempo et la métrique de la sélection 
audio ne correspondent pas à ceux par 
défaut de la session, entrez la mesure (Time 
Signature), ainsi que les emplacements 
Bar|Beat de début (Start) et de fin (End). 
Pour une sélection s'étendant sur quatre 
mesures et commençant sur le premier 
temps, entrez 1|1 et 5|1.

• Si le tempo et la métrique de la sélection 
audio ne correspondent pas à ceux par 
défaut de la session et si vous n'êtes pas 
certain de la durée des données 
enregistrées, entrez la mesure (time 
signature), ainsi que les emplacements de 
Start Bar|Beat et de End Bar|Beat, puis 
commencez la lecture et cliquez sur le 
bouton Tap plusieurs fois pour calculer 
automatiquement l'emplacement de End 
Bar|Beat. Lorsque vous utilisez le bouton 
Tap sur de longues sélections, continuez de 
battre la mesure jusqu'à stabilisation de la 
valeur de l'emplacement de End Bar|Beat. 
Une fois cette valeur stabilisée, vous 
pourrez si nécessaire ajuster manuellement 
le nombre sur la limite de la mesure la plus 
proche.

• Si le tempo et la métrique de la sélection 
correspondent à ceux de la session (voir 
Calcul du tempo avec Beat Detective, 
page 623), et si la sélection s'aligne 
correctement sur les mesures et les temps 
de la session, cliquez sur le bouton Capture 
Selection. Les valeurs correctes de mesure 
(time signature), ainsi que de Start Bar|Beat 
et de End Bar|Beat se remplissent 
automatiquement.

4  Pour améliorer la précision du Beat Detective 
dans l'analyse des notes « swinguées », 
sélectionnez l'option Contains qui indique la 
plus petite subdivision du temps contenue dans 
la sélection. L'option Contains peut inclure une 
noire, un huitième de note, un seizième de note 
(par défaut), une triple croche ou un triplet. 
L'option Contains sélectionnée détermine 
l'emplacement de la grille du modèle groove 
pour les modèles DigiGroove.

Pour éviter de perdre une sélection existante, 
sauvegardez et rappelez une sélection 
d'édition en l'enregistrant dans un 
emplacement mémoire. Pour plus 
d'informations, reportez-vous à la section 
Emplacements mémoire et marqueurs, 
page 605.

Beat Detective, options de sélection

Tant que les données audio sont 
correctement alignées sur la table de tempos 
de la session, utilisez l'option Capture 
Selection chaque fois que vous effectuez une 
nouvelle sélection ou effectuez les 
changements nécessaires à la table de 
tempos (par exemple, changement de tempo 
ou de métrique).

La définition de la sélection n'est pas 
conservée lorsqu'une session est fermée, 
puis réouverte.
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Calcul du tempo avec Beat 
Detective
Si vous connaissez la métrique, les points de 
début et de fin d'une sélection audio, vous 
pouvez utiliser le Beat Detective pour calculer 
son tempo.

Pour calculer le tempo d'une sélection avec le 
Beat Detective :

1  Effectuez une sélection dans la fenêtre Edit et 
définissez la sélection dans la fenêtre Beat 
Detective comme indiqué dans la section 
Définition d'une sélection pour le Beat 
Detective, page 621.

2  Sélectionnez le mode Bar|Beat Marker 
Generation.

3  Dans la zone Detection (mode Normal), 
cliquez sur le bouton Analyze.

4  Réglez le curseur Sensitivity sur 0%.

5  Cliquez sur Generate.

Des marqueurs Bar|Beat (mesures/temps) sont 
créés automatiquement au début et à la fin de la 
sélection, représentant le tempo et la métrique 
des données.

Création de beat triggers
Une fois la plage de sélection définie avec 
précision, le Beat Detective peut créer les beat 
triggers d'après les crêtes des transitoires ou les 
notes MIDI détectées. L'étendue et le type de 
transitoires ainsi trouvés peuvent être réglés 
avec les paramètres de détection, ce qui permet 
de cibler les données des mesures, des temps et 
des subdivisions des temps, tout en évitant les 
données non rythmiques.

Pour créer des beat triggers à partir d'une 
sélection audio :

1  Dans la fenêtre Edit, effectuez une sélection 
audio.

2  Sélectionnez Audio dans le menu déroulant 
Operation.

3  Dans la fenêtre Beat Detective, sélectionnez 
l'un des modes suivants :

• Bar|Beat Marker Generation

• Groove Template Extraction

• Region Separation (données audio 
uniquement)

4  Définissez ou capturez la sélection comme 
indiqué dans Définition d'une sélection pour le 
Beat Detective, page 621.

Beat Detective, Mode Detection

Création de marqueurs Bar|Beat avec le Beat 
Detective pour identifier le tempo et la métrique
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5  Dans le menu déroulant Analysis, choisissez 
l'un des algorithmes de détection suivants :

• High Emphasis donne de bons résultats 
avec les sons riches en aigus, tels que les 
cymbales et les charleys, et ne prend pas en 
compte les sons graves.

• Low Emphasis donne de bons résultats avec 
les sons graves, tels que la guitare basse et la 
grosse caisse, ainsi qu'avec la plupart des 
données tonales, telles que le piano ou la 
guitare rythmique.

6  Cliquez sur le bouton Analyze. 

7  En fonction du contenu rythmique de la 
sélection, définissez la résolution sur Bars 
(mesures), Beats (temps), ou Sub-Beats 
(subdivisions de temps).

8  Réglez le curseur Sensitivity jusqu'à ce que des 
beat triggers apparaissent sur les temps et 
subdivisions de temps de la sélection.

Les beat triggers correspondant au premier 
temps d'une mesure sont indiqués par des lignes 
épaisses, les beat triggers correspondant aux 
autres temps par des lignes d'épaisseur 
moyenne, et les beat triggers de subdivisions de 
temps par des lignes fines. 

9  Vous pouvez zoomer au niveau échantillon et 
cliquer sur le bouton Scroll Next pour trouver le 
trigger suivant de la sélection. Pour revenir au 
trigger précédent, maintenez la touche Option 
(Mac) ou Alt (Windows) enfoncée et cliquez sur 
le bouton Scroll Next (voir Navigation dans les 
beat triggers consécutifs, page 629). Ceci permet 
de vérifier que les beat triggers apparaissent aux 
emplacements corrects. Si de « faux triggers » 
apparaissent entre les battements ou les 
sous-battements (représentant des données non 
rythmiques), supprimez-les (voir Suppression de 
beat triggers, page 627), ou réduisez la valeur de 
sensibilité (curseur Sensitivity).

10  Pour afficher les emplacements métriques 
des beat triggers, sélectionnez l'option Show 
Trigger Time.

11  Si les beat triggers n'apparaissent pas aux 
emplacements corrects, répétez les étapes 5–10 
et essayez l'autre algorithme d'analyse (High 
Emphasis ou Low Emphasis).

Pour créer des beat triggers à partir d'une 
sélection MIDI :

1  Dans la fenêtre Edit, réglez la piste MIDI que 
vous avez l'intention d'utiliser sur la vue Notes.

2  Effectuez une sélection à partir d'une plage de 
données MIDI. Assurez-vous que les points de 
début et de fin de la sélection correspondent à 
des emplacements musicaux pertinents (barres 
de mesure, par exemple).

3  Choisissez Event > Beat Detective.

4  Sélectionnez MIDI dans le menu déroulant 
Operation.

5  Dans la fenêtre Beat Detective, sélectionnez 
l'un des modes suivants :

• Bar|Beat Marker Generation

• Groove Template Extraction

Beat triggers détectés

MesureBattement Sous-battement
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6  Définissez la plage de sélection. Si le tempo et 
la métrique de la sélection audio ne 
correspondent pas à ceux par défaut de la 
session, entrez la mesure (Time Signature), ainsi 
que les emplacements Bar|Beat de début (Start) 
et de fin (End). Pour une sélection s'étendant sur 
quatre mesures et commençant sur le premier 
temps, entrez 1|1 et 5|1.

7  Si votre piste MIDI contient des accords, 
sélectionnez l'un des algorithmes de 
reconnaissance des accords MIDI suivants à 
partir du menu déroulant Analysis :

• Last Note

• First Note

• Loudest Note

• Average Location

• Highest Note

• Lowest Note

8  Cliquez sur le bouton Analyze. 

Reconnaissance des accords MIDI

Etant donné que les notes MIDI d'un accord 
peuvent être jouées avec un léger intervalle, Beat 
Detective considère que les notes jouées à 
intervalle rapproché (équivalent à la moitié au 
moins de la valeur de temps définie dans le 
champ Selection Contains) constituent un 
accord. 

Beat Detective utilise les critères définis dans le 
menu déroulant Analysis pour interpréter la 
position du temps par rapport à l'accord.

Last Note : définit le beat trigger par rapport au 
début de la dernière note jouée dans l'accord.

First Note : définit le beat trigger par rapport au 
début de la première note jouée dans l'accord.

Loudest Note : définit le beat trigger par rapport 
au début de la note de l'accord jouée à la plus 
grande vélocité.

Average Location : définit le beat trigger par 
rapport à un point se trouvant à distance 
moyenne entre le début de la première note 
jouée dans l'accord et la dernière note jouée 
dans l'accord.

Highest Note : définit le beat trigger par rapport 
au début de la note la plus haute jouée dans 
l'accord.

Lowest Note : définit le beat trigger par rapport 
au début de la note la plus basse jouée dans 
l'accord.

Realignement de session

La fonction de réalignement de session de Beat 
Detective permet de créer des marqueurs 
Bar|Beat sans décalage des données basées sur 
des tics. Cela est pratique pour extrapoler les 
marqueurs Bar|Beat à partir de données basées 
sur des tics afin d'aligner la table de tempos et la 
grille Bar|Beat aux données en question. 

Analyse des accords MIDI

First
Note Last

Note

Highest Note

Lowest Note

Rien ne vous empêche également de passer 
de données basées sur des tics (telles que les 
performances MIDI) à des données basées 
sur des échantillons, puis d'insérer 
manuellement des marqueurs Bar|Beat.
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La création de marqueurs Bar|Beat dans des 
sessions constituées de données basées sur des 
tics (pistes MIDI et pistes audio basées sur des 
tics, par exemple), risque de provoquer un 
décalage de ces données en valeur absolue. Cela 
peut être utile pour aligner les données basées 
sur des tics avec des marqueurs Bar|Beat générés 
à partir de données basées sur des échantillons.

Lorsque vous créez des marqueurs Bar|Beat 
Markers dans une session composée de données 
audio ou MIDI basées sur des tics, Beat Detective 
vous donne la possibilité de préserver la position 
des données en question ou d'autoriser un 
décalage.

Pour créer des marqueurs Bar|Beat Markers avec 
Beat Detective dans une session composée de 
pistes basées sur des tics :

1  Dans la fenêtre Edit, effectuez une sélection 
audio ou MIDI

2  Dans la fenêtre Beat Detective, sélectionnez le 
mode Bar|Beat Marker Generation.

3  Définissez ou capturez la sélection comme 
indiqué dans Définition d'une sélection pour le 
Beat Detective, page 621.

4  Définissez la résolution de détection sur Bars 
ou Beats.

5  Cliquez sur le bouton Generate. 

6  Effectuez l'une des opérations suivantes :

• Dans la boîte de dialogue Realign Session, 
choisissez Preserve Tick Position si vous 
avez l'intention d'autoriser le décalage 
absolu des données basées sur des tics. 
Cette option permet de préserver la 
fonctionnalité avant l'application de Beat 
Detective.

– ou –

• Choisissez Preserve Sample Position si vous 
préférez maintenir la position absolue des 
données basées sur des tics. Cette option 
peut être pratique lors de l'ajout d'une table 
de mesures et de tempos à une performance 
jouée librement.

7  Cliquez sur OK.

Conseils pour obtenir des beat triggers 
utilisables

Les conseils suivants vous permettent de vérifier 
les beat triggers :

! Pour vous concentrer sur une zone 
particulière de la sélection, séparez les sélections 
d'édition et de timeline, puis définissez la plage 
de lecture en cliquant ou en vous déplaçant dans 
la règle temporelle.

! Vérifiez l'épaisseur des beat triggers vous 
vérifier s'ils s'alignent correctement avec les 
données audio. Les lignes épaisses tombent sur 
les barres de mesure, les lignes moyennes sur les 
temps et les lignes fines sur les subdivisions de 
temps. 

! Sélectionnez l'option Show Trigger Time et 
vérifiez si les emplacements métriques 
(supposés) des beat triggers s'alignent avec les 
données. Un « faux » beat trigger doit être 
déplacé ou supprimé car il peut provoquer le 
mauvais placement ultérieur des beat triggers 
(voir Edition des beat triggers, page 627).

Boîte de dialogue Realign Session
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! Evaluez si les sélections longues doivent être 
divisées en sélections plus petites, ce qui facilite 
leur gestion. Par exemple, l'utilisation de 
sections de 8 ou 4 mesures peut s'avérer plus 
rapide et produire de meilleurs résultats. 

! Les beat triggers sont préservé lorsque vous 
permutez les modes audio et MIDI. Cela permet 
d'utiliser les triggers MIDI pour éditer des 
données audio ou de collecter des triggers à 
partir de combinaisons de pistes MIDI et de 
pistes audio (Pro Tools HD uniquement).

! Pour les sélections englobant plusieurs pistes, 
déterminez s'il est plus simple de travailler 
séparément sur chacune d'elles ou s'il vaut 
mieux utiliser le mode Collection (Pro Tools HD 
et Pro Tools LE avec Music Production Toolkit 
uniquement). Pour plus d'informations, 
reportez-vous à la section Mode Detection 
(Normal) et Collection, page 639.

Edition des beat triggers

Bien que le Beat Detective offre une grande 
souplesse au niveau de la détection des 
transitoires, vous devrez à l'occasion supprimer, 
déplacer ou insérer manuellement des beat 
triggers. Vous pouvez également promouvoir 
des beat triggers afin de les conserver à des 
réglages de sensibilité moins élevés. 

Suppression de beat triggers

De « faux » beat triggers, ne représentant pas un 
vrai temps ou subdivision de temps dans les 
données source, peuvent apparaître lorsque 
vous élevez la valeur du curseur Sensitivity afin 
de détecter des données de faible niveau. Dans 
ce cas, vous pouvez repérer et supprimer 
manuellement les faux beat triggers.

Pour supprimer un beat trigger :

1  La fenêtre Beat Detective étant ouverte, 
choisissez un outil d'accrochage dans la fenêtre 
Edit.

2  Recherchez le faux beat trigger que vous 
voulez supprimer. Les transitoires 
correspondant à de faux beat triggers présentent 
généralement des crêtes plus petites que les 
autres beat triggers, et tombent souvent entre les 
subdivisions de temps.

3  Cliquez sur le beat trigger en maintenant 
enfoncée la touche Option (Mac) ou Alt 
(Windows) pour le supprimer.

Déplacement des beat triggers

Vous pouvez ajuster le positionnement des beat 
triggers, par exemple pour mieux respecter une 
attaque ou pour compenser une crête 
individuelle se trouvant légèrement devant ou 
derrière le temps.

Pour déplacer un beat trigger :

1  La fenêtre Beat Detective étant ouverte, 
choisissez un outil d'accrochage dans la fenêtre 
Edit.

2  Repérez le beat trigger que vous voulez 
déplacer puis faites-le glisser vers la gauche ou la 
droite.

Beat Detective LE ne peut pas être appliqué 
à plusieurs pistes. Lorsque cela est le cas, 
seule la piste du haut est éditée.

Suppression d'un beat trigger



Guide de référence Pro Tools628

Insertion de beat triggers

Si un temps (ou une subdivision de temps) 
important n'est pas détecté du fait d'un niveau 
trop faible, vous pouvez insérer un beat trigger 
manuellement.

Pour insérer un beat trigger :

1  La fenêtre Beat Detective étant ouverte, 
choisissez un outil d'accrochage dans la fenêtre 
Edit.

2  Cliquez dans la sélection à l'endroit où vous 
souhaitez insérer le nouveau beat trigger. Après 
avoir inséré un beat trigger, vous pouvez le faire 
glisser vers la gauche ou la droite pour ajuster sa 
position (voir Déplacement des beat triggers, 
page 627).

Si vous cliquez trop près d'un beat trigger 
existant, ce dernier sera déplacé vers le nouvel 
emplacement.

Promotion des beat triggers

Pour être sûr que des beat triggers importants ne 
disparaissent pas lorsque vous réduisez la 
sensibilité, vous pouvez les promouvoir. Ceci est 
utile si, au niveau de sensibilité limite 
d'apparition de beat triggers absolument 
nécessaires, une sélection contient de nombreux 
faux beat triggers (en nombre trop élevé pour se 
lancer dans leur suppression). Pour éviter que la 
réduction de sensibilité ne provoque la 
disparition des beat triggers nécessaires, il suffit 
de les promouvoir.

Pour promouvoir un beat trigger :

1  Augmentez la sensibilité via le curseur jusqu'à 
ce que le transitoire désiré soit détecté et qu'un 
beat trigger apparaisse.

2  Pour promouvoir ce beat trigger, cliquez 
dessus en maintenant enfoncée la touche 
Pomme (Mac) ou Ctrl (Windows). 

3  Si nécessaire, vous pouvez promouvoir 
d'autres beat triggers en répétant les étapes 1–2.

4  Abaissez la sensibilité via le curseur jusqu'à 
une valeur où les faux beat triggers 
disparaissent.

Une fois que vous avez promu des beat triggers, 
ils ne disparaissent que si vous réglez la 
sensibilité à 0%. Pour rétrograder tous les beat 
triggers de la sélection et rétablir leur état 
d'origine, vous pouvez cliquer sur le bouton 
Analyze.

Déplacement d'un beat trigger
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Redéfinition de l'emplacement 
métrique d'un beat trigger

Il est indispensable que les beat triggers soient 
affectés précisément à l'emplacement métrique 
correct. Si un transitoire détecté se trouve 
légèrement décalées par rapport au temps, le 
Beat Detective risque de leur affecter, ainsi qu'à 
d'autres transitoires de la sélection, un mauvais 
emplacement métrique.

Par exemple, si vous avez une piste de basse dans 
laquelle une note normalement placée un temps 
fort a été jouée un peu trop tôt, le Beat Detective 
risque de définir son emplacement comme 
survenant un peu avant le temps fort. Si vous 
effectuez ensuite une séparation puis conformez 
la région contenant cette note, elle sera déplacée 
sur une position erronée. Les régions qui suivent 
peuvent elles aussi se retrouver à un 
emplacement erroné.

Si vous vous apercevez qu'un beat trigger n'est 
pas affecté à l'emplacement métrique correct, 
vous pouvez le redéfinir avec l'option Identify 
Trigger.

Pour modifier l'emplacement métrique d'un beat 
trigger :

1  Cliquez deux fois sur le beat trigger que vous 
voulez repositionner. La boîte de dialogue 
Identify Trigger s'ouvre.

2  Dans la boîte de dialogue Identify Trigger, 
entrez l'emplacement correct du beat trigger 
puis cliquez sur OK. 

Navigation dans les beat triggers 
consécutifs

Utilisez le bouton Scroll Next pour vous 
déplacer du beat trigger sélectionné au suivant. 
Pour revenir au beat trigger précédent, 
maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée et cliquez sur le bouton 
Scroll Next. Ceci est particulièrement utile pour 
l'édition de beat triggers consécutifs lors d'un 
zoom au niveau de l'échantillon.

Création de marqueurs 
Bar|Beat avec le Beat 
Detective
Une fois que le Beat Detective a détecté avec 
précision les crêtes des transitoires dans la 
sélection audio et a créé des beat triggers précis, 
vous pouvez convertir ces derniers en 
marqueurs Bar|Beat. Des marqueurs Bar|Beat 
créés par Beat Detective créent une table de 
tempos et peuvent être utilisés dans toute la 
session.

Une fois une table de tempos établie, d'autres 
régions audio et notes MIDI peuvent être 
conformées aux marqueurs Bar|Beat créés par 
Beat Detective.

Si vous voulez faire correspondre des données 
audio à la table des tempos existante de la 
session ou à modèle de groove, il est 
recommandé de ne pas créer de marqueurs 
Bar|Beat à partir des données. Il est préférable 
d'utiliser Beat Detective pour séparer et 
conformer les données (voir Séparation des 
régions avec le Beat Detective, page 633).

Boîte de dialogue Identify Trigger

Si vous souhaitez simplement aligner une 
partie grossière à d'autres pistes, il est 
probable que vous n'ayez pas besoin de créer 
des marqueurs Bar|Beat.
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Pour créer des marqueurs Bar|Beat avec le Beat 
Detective :

1  Dans la fenêtre Edit, effectuez une sélection 
audio.

2  Dans la fenêtre Beat Detective, sélectionnez le 
mode Bar|Beat Marker Generation.

3  Définissez ou capturez la sélection comme 
indiqué dans Définition d'une sélection pour le 
Beat Detective, page 621.

4  Définissez la résolution de détection sur Bars 
ou Beats et configurez les options de détection 
de manière à détecter avec précision les pics des 
transitoires de la sélection (voir Création de beat 
triggers, page 623).

5  Cliquez sur le bouton Generate. 

Des marqueurs Bar|Beat sont alors créés, d'après 
les beat triggers, et apparaissent dans la règle 
temporelle.

Utilisation de subdivisions de 
temps

Le tempo est dérivé des marqueurs Bar|Beat. 
Le groove, ou feeling, est dérivé des subdivisions 
de temps ; la déviation des subdivisions du 
temps par rapport à la grille stricte de tempo 
détermine le groove ou feeling. 

Pour extraire le groove d'une sélection, réglez la 
résolution de la détection sur Sub-Beats. Ceci 
garantit que les rythmes internes à chaque 
mesure (s'il en existe) sont pris en compte lors de 
la création des marqueurs Bar|Beat. Ces 
marqueurs Bar|Beat peuvent ensuite servir pour 
quantifier d'autres régions audio ou pistes MIDI, 
se conformant ainsi aux marqueurs Bar|Beat 
créés par Beat Detective.

Modèles DigiGroove
Le Beat Detective permet d'extraire des nuances 
très précises de synchronisation d'une 
performance rythmique et de les enregistrer 
sous forme de modèle Groove appelé modèle 
DigiGroove. Les DigiGrooves peuvent être 
enregistrés localement dans le Presse-Papiers de 
Groove ou sur le disque en tant que 
DigiGrooves. 

Marqueurs Bar|Beat créés avec la résolution Bar

Marqueurs Bar|Beat créés avec la résolution Beat

Lorsque vous quantifiez des régions ou des 
notes MIDI en insérant des marqueurs 
Bar|Beat sur les subdivisions des temps, qui 
définissent le swing de l'interprétation, 
veillez à utiliser une valeur réduite de 
quantification (en désactivant l'option 
Swing de la fonction Quantize).
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Les modèles Groove peuvent être utilisés pour 
transférer le feeling d'une performance 
particulière vers les données suivantes :

• Régions audio sélectionnées en utilisant 
Groove Conform (voir Groove Conform, 
page 636).

• Données MIDI sélectionnées à l'aide de 
Groove Quantize (voir Groove Quantize, 
page 681).

Les modèles Groove sont des « tables de 
quantification » dérivées de performances 
musicales réelles. L'aspect rythmique de chaque 
interprétation est analysé et sauvegardé sous 
forme de modèle de groove. Beat Detective 
analyse une sélection audio à la recherche de 
pics de transitoire, en fonction d'un seuil défini 
et affecte les relations rythmiques à un modèle 
de 960 parties par quart de note (ppq).

Lors de la création de modèles DigiGroove, Beat 
Detective analyse également les dynamiques 
d'une performance. Les données de vélocité 
MIDI sont sauvegardées à partir des pistes MIDI 
et les accents et les niveaux de crête sont inclus 
dans le modèle « groove » comme données de 
vélocité, lesquelles peuvent être appliquées pour 
changer les dynamiques des pistes MIDI. 

Beat Detective convertit l'amplitude des signaux 
dans les pistes en vélocité MIDI en respectant 
une échelle linéaire. Par exemple :

• Un signal de 0 dBFS équivaut à une vélocité 
MIDI de 127.

• Un signal de –6 dBFS équivaut à une 
vélocité MIDI de 64.

• Un signal de –12 dBFS équivaut à une 
vélocité MIDI de 32.

• Un signal de –48 dBFS équivaut à une 
vélocité MIDI de 1.

Il est très important de capturer ces 
informations afin de préserver le feeling d'une 
performance, et de pouvoir ajouter de la vie à 
des pistes MIDI manquant de dynamique. 

Pour extraire un modèle de Groove :

1  Dans la fenêtre Edit, effectuez une sélection 
audio ou MIDI La sélection doit être constituée 
d'une ou plusieurs mesures complètes, en 
commençant et en finissant sur des temps forts.

2  Dans la fenêtre Beat Detective, sélectionnez le 
mode Groove Template Extraction

3  Définissez ou capturez la sélection comme 
indiqué dans Définition d'une sélection pour le 
Beat Detective, page 621.

4  Configurez les options de détection de 
manière à détecter avec précision les pics des 
transitoires de la sélection (voir Création de beat 
triggers, page 623).

5  Cliquez sur le bouton Extract. 

6  Dans la boîte de dialogue Extract Groove 
Template, entrez les commentaires concernant 
le groove. Vous pouvez entrer un maximum de 
255 caractères pour décrire le groove. Vous 
pouvez consulter les commentaires en cliquant 
sur le bouton Show Info dans la fenêtre Beat 
Detective.

Beat Detective capture les données de durée 
uniquement à partir de pistes MIDI, et pas 
de pistes audio.

Lors de l'extraction de modèles Groove, la 
sélection capturée ne doit pas inclure de 
marqueurs Bar|Beat. La précision du 
modèle de groove s'en ressentirait.
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7  Effectuez l'une des opérations suivantes :

• Pour enregistrer le modèle extrait et 
l'utiliser dans la session en cours sans écrire 
le fichier de modèle sur le disque, cliquez 
sur Save To Groove Clipboard. (Ce modèle 
sera perdu lorsque vous fermerez la session 
courante.)

• Pour enregistrer le modèle extrait sur le 
disque afin de l'utiliser dans d'autres 
sessions ou de le partager avec d'autres 
utilisateurs de Pro Tools, cliquez sur Save 
To Disk. Donnez un nom au modèle et 
cliquez sur Save. (Ne changez pas 
l'emplacement des fichiers de modèles 
DigiGroove ni des dossiers ; ils ne seraient 
plus disponibles dans vos sessions.) 

• Cliquez sur Cancel pour annuler sans 
enregistrer le modèle. 

Contenu swing pour la création de modèles 
Groove

Lorsque vous définissez le contenu swing de la 
sélection, sélectionnez l'option Contains 
eighth-note si la sélection audio possède un fort 
groove swingué à la croche. Si la sélection audio 
possède des croches relativement régulières, 
utilisez l'option Contains sixteenth-note. Ceci 
permettra d'appliquer plus facilement ailleurs le 
modèle DigiGroove résultant. Bien qu'un groove 
puisse être basé sur des données de croches non 
swinguées, vous pouvez choisir d'appliquer le 
modèle aux données contenant des doubles 
croches. Si le modèle n'a qu'une résolution à la 
croche, mais que les données conformées 
contiennent des doubles croches, les doubles 
croches adjacentes auront le même 
emplacement de croche.

Extrapolation de groove

La capacité de Beat Detective à extraire des 
données de tempo d'un vaste ensemble de 
données est améliorée par sa puissante logique 
d'« extrapolation de groove ». L'extrapolation de 
groove crée automatiquement l'inclusion de 
beat triggers dans les modèles de groove même si 
aucune crête de transitoire n'est détectée. 
Par exemple, une boucle de batterie peut ne pas 
avoir de coup sur le temps 3, et de ce fait, aucune 
crête de transitoire n'est détectée et aucun beat 
trigger n'est créé. Le Beat Detective effectuera 
une extrapolation à partir des autres beat 
triggers de la sélection et créera un trigger pour 
le temps 3 dans le modèle de groove.

De plus, les triggers extrapolés conservent le 
feeling des triggers créés à partir des crêtes de 
transitoires. Par exemple, si une mesure de 
grosse caisse a détecté trois beat triggers qui se 
trouvent tous 20 tics avant le temps, tout beat 
trigger extrapolé sera également placé 20 tics 
avant le temps.

Boîte de dialogue Extract Groove Template

Utilisez des dossiers et des sous-répertoires 
pour organiser les modèles DigiGroove. 
Assurez-vous toutefois qu'ils se trouvent 
toujours dans C:\Program Files\ 
Digidesign\Pro Tools\Grooves (Windows) 
ou Applications/Digidesign/Pro Tools/ 
Grooves (Mac). Les fichiers de modèles 
Groove situés à d'autres emplacements ne 
seront pas disponibles dans Groove 
Quantize ou Beat Detective. 
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Séparation des régions avec 
le Beat Detective 
(Audio uniquement)

Lorsque des beat triggers apparaissent dans votre 
sélection, ils peuvent être utilisés pour définir les 
points de début et de fin pour de nouvelles 
régions, qui peuvent être séparées 
automatiquement. Les nouvelles régions 
peuvent être conformées à la table de tempos 
existante de la session ou à un modèle de 
groove.

Si vous souhaitez plutôt nettoyer le timing de la 
sélection, sans modifier le tempo existant, 
commencez d'abord par calculer le tempo en 
créant des marqueurs Bar|Beat (voir Calcul du 
tempo avec Beat Detective, page 623).

Pour séparer des régions avec le Beat Detective :

1  Dans la fenêtre Edit, effectuez une sélection 
audio.

2  Dans la fenêtre Beat Detective, Sélectionnez le 
mode Region Separation.

3  Définissez ou capturez la sélection comme 
indiqué dans Définition d'une sélection pour le 
Beat Detective, page 621.

4  Configurez les options de détection de 
manière à détecter avec précision les pics des 
transitoires de la sélection (voir Création de beat 
triggers, page 623).

5  Cliquez sur le bouton Separate. 

Les régions sont séparées d'après les beat triggers 
détectés.

Trigger Pad

Lors de la séparation de régions, la fenêtre 
Beat Detective affiche une option nommée 
Trigger Pad.

Entrez une valeur dans ce champ (entre 0 et 
-50 ms) pour décaler les points de début de 
région lorsque le point de séparation est relié au 
beat trigger (transitoire). Ceci crée un espace 
entre le point de début de la région et le point de 
synchronisation de la région, ce qui assure que 
la portion d'attaque des données demeure 
intacte.

Lors de la conformation de régions séparées, 
l'emplacement de la région est déterminé par le 
point de synchronisation de la région (et non 
par le point de début de la région).

Paramètres de détection, mode Region Separation

Région séparée avec Trigger Pad de 20 ms

Pour plus d'informations sur les points de 
synchronisation des régions, reportez-vous à 
la section Points de synchronisation, 
page 504.

Début de région (point de séparation)
Point de synchronisation (beat trigger)

20 ms
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Séparation sur plusieurs pistes

(Pro Tools HD et Pro Tools LE avec Music 
Production Toolkit uniquement)

Vous pouvez utiliser les beat triggers d'une seule 
piste ou d'un sous-ensemble de pistes, pour 
séparer un groupe de pistes. 

Dans l'exemple qui suit, la sélection définie est 
une boucle de batterie constituée de deux 
mesures de 5/4. La grosse caisse, la caisse claire, 
les toms et les micros d'overhead sont 
enregistrés sur des pistes séparées.

En analysant la piste de grosse caisse de la 
boucle, avec la résolution de détection définie 
sur Beats, Beat Detective place les beat triggers 
aux transitoires sur les temps beats 1 et 4 (voir la 
figure 25).

L'extension de la sélection aux pistes de caisse 
claire, de toms et de micro d'overhead, puis la 
séparation, se traduisent par des régions séparées 
dans chacune des pistes de batterie au même 
emplacement, d'après les beat triggers de la piste 
de grosse caisse (voir la figure 26). 

Les régions séparées peuvent alors être 
conformées en tant que groupe.

Vous pouvez également utiliser le mode 
Collection (Pro Tools HD et Pro Tools LE avec 
Music Production Toolkit uniquement) lorsque 
vous travaillez avec plusieurs pistes. Le mode 
Collection permet d'analyser et de détecter les 
triggers de chaque piste individuellement et, si 
vous le souhaitez, de n'ajouter que les triggers de 
la piste courante à la collection globale. Pour 
plus d'informations, reportez-vous à la section 
Mode Detection (Normal) et Collection, 
page 639. 

Pour utiliser Beat Detective LE sur plusieurs 
pistes, vous devez posséder l'option Music 
Production Toolkit. Si cette option n'est pas 
installée, seule la piste du haut est éditée.

Figure 25.  Piste de grosse caisse

Figure 26.  Pistes de batterie correspondant à la grosse 
caisse, à la caisse claire, aux toms et aux micros 
d'overhead
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Conformation de régions avec 
le Beat Detective
(Audio uniquement)

Après avoir séparé les régions avec le Beat 
Detective, vous pouvez les conformer à l'aide de 
l'un des deux modes suivants : 

Standard Conform : utilise la table (grille) de 
tempos courant de la session

Groove Conform : utilise les modèles de groove.

Le Beat Detective conformera toute région 
sélectionnée, qu'elle ait été ou non séparée avec 
lui. Toutefois, pour pouvoir conformer 
correctement des régions avec le Beat Detective, 
le point de début de la région doit correspondre 
au début des données à aligner sur les 
mesures/temps de la session. Ceci ne devrait 
généralement pas poser de problème si les 
régions ont été séparées avec le Beat Detective 
(et non séparées ou rognées manuellement).

Standard Conform

Ceci revient presque à utiliser la commande 
Region > Quantize to Grid, avec toutefois une 
différence importante : Beat Detective peut 
ajuster la position de toutes les régions en une 
seule opération, que leur feeling soit uniforme 
ou swing.

Pour conformer des régions avec l'option Standard 
Conform :

1  Dans la fenêtre Beat Detective, sélectionnez le 
mode Region Conform.

2  Assurez-vous d'avoir choisi Standard.

3  Dans la fenêtre Edit, sélectionnez les régions 
séparées à conformer, si elles le ne sont pas déjà. 
Vérifiez que les points de début et de fin de la 
sélection tombent précisément sur le temps.

4  Dans la fenêtre Beat Detective, définissez ou 
recapturez la sélection comme indiqué dans la 
section Définition d'une sélection pour le Beat 
Detective, page 621.

5  Pour déterminer le degré de conformation des 
régions à la grille (table de tempos), sélectionnez 
l'option Strength et indiquez une valeur en 
pourcentage, soit à l'aide du curseur, soit en 
saisissant un nombre : 

• Un pourcentage faible préserve le feeling 
rythmique d'origine des régions.

• Un pourcentage élevé aligne les régions 
plus fortement sur la table de tempos, 
100 % correspondant à un alignement 
parfait sur celle-ci.

6  Pour définir quelles régions seront 
conformées, sélectionnez l'option Exclude 
Within et indiquez une valeur en pourcentage, 
soit à l'aide du curseur, soit en saisissant un 
nombre :

• Les pourcentages réduits garantissent que 
les régions plus éloignées des pas de la grille 
sont conformées et que les régions les plus 
proches ne le sont pas.

Beat Detective, options Standard Conform

Pour « resserrer » le feeling initial, tout en le 
préservant, réglez le paramètre Strength 
entre 85 et 88 %.
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• Pour des pourcentages élevés, les régions 
les plus proches du pas de la grille sont 
conformées, ainsi que les régions les plus 
éloignées.

7  Pour obtenir un feeling « swing » sur les 
régions conformées, sélectionnez l'option Swing 
et déterminez si le swing est basé sur les croches 
ou les doubles croches, puis indiquez une valeur 
en pourcentage, soit à l'aide du curseur, soit en 
saisissant un nombre :

• Les pourcentages plus faibles produisent 
moins de swing, la valeur 0 % n'en 
produisant aucun.

• Les pourcentages plus élevés produisent 
davantage de swing, la valeur 100 % 
produisant un feeling de swing ternaire.

• Les valeurs en pourcentage entre 100 et 150 
déplacent les régions au-delà du swing 
ternaire, tendant vers la double croche 
suivante (à condition que la valeur de note 
Swing soit définie sur les croches).

8  Cliquez sur le bouton Conform pour 
conformer automatiquement toutes les régions 
de la sélection.

9  Pour écouter les nouvelles régions 
conformées, cliquez sur Play dans la fenêtre 
Transport. 

10  Effectuez l'une des opérations suivantes :

• Le cas échéant, sélectionnez Edit > Undo et 
répétez les étapes 4 à 8 en essayant un autre 
ensemble de paramètres de conformation.

– ou –

• Le cas échéant, appliquez la fonction Edit 
Smoothing (voir Edit Smoothing, 
page 638).

Groove Conform

Plutôt que d'utiliser une grille basée sur la table 
de tempos de la session, Groove Conform utilise 
une grille basée sur un modèle de groove, ou 
DigiGroove. Les DigiGrooves peuvent être 
utilisés pour appliquer le feeling d'un passage 
capturé aux régions audio sélectionnées. Pour 
plus d'informations sur la création de modèles 
DigiGroove, reportez-vous à Modèles 
DigiGroove, page 630.

Pour « resserrer » le feeling initial, tout en le 
préservant, réglez la valeur Exclude Within 
entre 10 et 15 %.

Si le Beat Detective a capturé suffisamment 
de subdivisions de temps à partir d'une 
sélection avant la séparation, vous pouvez 
effectuer la conformation avec l'option 
Swing pour faire passer le groove d'un 
feeling « régulier » à un feeling « swing ». 
Vous pouvez également importer un modèle 
de groove contenant un feeling swing (voir 
Groove Conform, page 636).

Régions conformées avec Beat Detective
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Pour conformer des régions avec Groove Conform :

1  Dans la fenêtre Beat Detective, sélectionnez le 
mode Region Conform.

2  Sélectionnez Groove.

3  Dans la fenêtre Edit, sélectionnez les régions 
séparées à conformer, si elles le ne sont pas déjà. 
Vérifiez que les points de début et de fin de la 
sélection tombent précisément sur le temps.

4  Dans la fenêtre Beat Detective, définissez ou 
recapturez la sélection comme indiqué dans la 
section Définition d'une sélection pour le Beat 
Detective, page 621.

5  Dans le menu déroulant des modèles Groove, 
sélectionnez le Presse-Papiers de Groove ou 
enregistrez un modèle de groove (pour des 
informations sur la création de modèles Groove, 
reportez-vous à la section Modèles DigiGroove, 
page 630).

6  Pour voir les commentaires concernant le 
modèle sélectionné, cliquez sur Show Info. 

7  Pour déterminer le degré de conformation des 
régions au modèle de groove, sélectionnez 
l'option Timing et indiquez une valeur en 
pourcentage, soit à l'aide du curseur, soit en 
saisissant un nombre : 

• Un pourcentage faible préserve le feeling 
rythmique d'origine des régions.

• Un pourcentage élevé aligne les régions 
plus fortement sur la grille des modèles de 
groove, 100 % correspondant à un 
alignement parfait sur celle-ci.

• Si le curseur est défini sur 200 %, les régions 
se déplacent vers un emplacement ayant 
deux fois la différence entre l'emplacement 
de la région d'origine et celui de 
l'événement du modèle de référence. 

Par exemple, si une note a été jouée à la mesure 
1|1|060 (double croche), et si l'événement du 
modèle correspondant se trouve à 1|1|073, une 
valeur de curseur de 100% se traduit par le 
décalage de la note à 1|1|073 ; une valeur de 
curseur de 200 % décale le note à 1|1|086.

8  Si vous le souhaitez, activez l'option 
Pre-Process using Standard Conform. Lorsque 
cette option est activée, le Beat Detective 
conforme les régions aux paramètres Standard 
Conform courants avant d'appliquer le modèle 
de groove. Avec les données dans lesquelles les 
performances n'étaient pas précises, l'option 
Pre-Process using Standard Conform peut 
produire de meilleurs résultats en vérifiant la 
correspondance précise des performances aux 
mesures, temps et subdivisions de temps 
corrects avant d'appliquer le modèle de groove. 
L'expérimentation est le meilleur moyen de 
déterminer lorsque cette option doit être 
utilisée. 

9  Cliquez sur le bouton Conform pour 
conformer automatiquement toutes les régions 
de la sélection.

Beat Detective, options Groove Conform

Lorsque vous utilisez Groove Conform, la 
sélection capturée ne doit pas inclure de 
marqueurs Bar|Beat. La précision du 
modèle de groove s'en ressentirait.

Lors de la conformation d'un passage audio 
à un modèle de groove fortement 
« swingué », l'utilisation de l'option 
Pre-Process using Standard Conform 
produira souvent de meilleurs résultats.
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10  Pour écouter les nouvelles régions 
conformées, cliquez sur Play dans la fenêtre 
Transport. 

11  Effectuez l'une des opérations suivantes :

• Le cas échéant, sélectionnez Edit > Undo et 
répétez les étapes 4 à 9 en essayant un autre 
ensemble de paramètres de modèle de 
groove ou Groove Conform.

– ou –

• Le cas échéant, appliquez la fonction Edit 
Smoothing (voir Edit Smoothing, 
page 638).

Edit Smoothing
(Audio uniquement)

Après que les régions ont été conformées, des 
espaces peuvent les séparer. Du fait de ces 
« trous de son », la lecture peut donner une 
impression de manque de naturel.

Le Beat Detective peut remplir 
automatiquement les espaces entre les régions et 
même ajouter des crossfades si vous le désirez. 
Cette option, appelée Edit Smoothing, peut être 
utilisée avec des régions qui ont été conformées 
ou avec une piste contenant de nombreuses 
régions (une piste d'effets sonores, par exemple) 
qui doivent être rognées et crossfadées. 
Ce processus automatisé de lissage des 
modifications des régions peut économiser des 
heures et des heures d'édition fastidieuse.

Pour utiliser l'option Edit Smoothing sur les 
régions conformées :

1  Dans la fenêtre Beat Detective, sélectionnez le 
mode Edit Smoothing.

2  Sélectionnez une option de lissage :

Fill Gaps : cette option permet de rogner les 
points de fin des régions pour remplir les espaces 
entre régions.

Fill And Crossfade : cette option permet de 
rogner les points de fin des régions et d'ajouter 
automatiquement un fondu d'entrée (en ms) 
directement avant le point de début de chaque 
région.

3  Dans la fenêtre Edit, sélectionnez la plage des 
régions audio conformer à lisser, si ce n'est déjà 
fait. Vérifiez que les points de début et de fin de 
la sélection tombent précisément sur le temps.

4  Cliquez sur le bouton Smooth pour « lisser » 
les éditions des régions sélectionnées.

5  Ecoutez les résultats en cliquant sur Play dans 
la fenêtre Transport. 

6  Le cas échéant, sélectionnez Edit > Undo et 
répétez les étapes 2–5 en essayant une durée de 
crossfade (Crossfade Length) différente.

Beat Detective, options d'Edit Smoothing

Aspect de régions avant et après Edit Smoothing
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Création de points de synchronisation 
après Edit Smoothing

Après un Edit Smoothing avec Beat Detective, 
des points de synchronisation (correspondant 
au point de début des données) sont créés 
automatiquement pour les régions conformées. 
Ceci vous permet de conformer ultérieurement 
les régions à une table de tempos ou à un modèle 
de groove différents, ou d'utiliser des paramètres 
de conformation différents. En revanche, les 
points de synchronisation ne sont créés que s'ils 
sont nécessaires : Si des espaces sont créés entre 
les régions au cours de Region Conform, Fill 
Gaps en mode Edit Smoothing rognera les 
régions pour les remplir et un point de 
synchronisation sera créé au point de départ 
d'origine de chaque région. S'il n'existe aucun 
espace entre les régions, aucun point de 
synchronisation ne sera créé par Edit 
Smoothing.

Consolidation des régions après Edit 
Smoothing

Le processus de séparation, de conformation et 
de lissage avec Beat Detective peut déboucher 
sur des pistes comportant de nombreuses 
régions et d'innombrables crossfades. Si vous 
travaillez avec plusieurs pistes, la densité de ces 
éditions peut créer des problèmes de 
performances du système.

Une fois que vous êtes satisfait des résultats 
obtenus avec le Beat Detective, il est 
recommandé d'aplanir les pistes avec la 
commande Consolidate. Pour toutes les régions 
sélectionnées, Consolidate crée un seul fichier 
audio contigu afin de réduire la densité d'édition 
de la session. Pour plus d’informations, 
reportez-vous à la section « Commande de 
consolidation », page 563. 

Mode Detection (Normal) et 
Collection
(Pro Tools HD et Pro Tools LE avec Music 
Production Toolkit uniquement)

Dans certains cas, il peut être difficile pour le 
Beat Detective d'analyser correctement plusieurs 
pistes avec les mêmes paramètres de détection. 
Le mode Collection du Beat Detective permet de 
rassembler un ensemble de beat triggers issus de 
différentes pistes, chacune possédant des 
paramètres de détection différents, puis 
d'utiliser cet ensemble de beat triggers pour créer 
des marqueurs Bar|Beat ou des modèles 

Pour plus d'informations sur les points de 
synchronisation des régions, reportez-vous à 
la section Points de synchronisation, 
page 504.

Si les performances ne sont pas essentielles, 
servez-vous de la commande Region Group 
pour faciliter l'édition et la manipulation 
des régions. Cela peut être pratique pour 
organiser les temps sectionnés avec Beat 
Detective, notamment si vous prévoyez de 
changer les tempos avec des pistes audio 
basées sur des tics. Pour plus d'informations 
sur les groupes de régions, voir Groupes de 
régions, page 525.

Avant de consolider une longue sélection sur 
plusieurs pistes, vérifiez que le système 
dispose de suffisamment de RAM. Pour plus 
d’informations, reportez-vous à la section 
« Besoins en RAM du Beat Detective », 
page 619.
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DigiGroove, ou séparer des nouvelles régions. Le 
mode Collection est le seul moyen d'analyser et 
de créer des beat triggers sur une piste et de les 
appliquer sur une autre.

Cette méthode consistant à ajouter des beat 
triggers de façon sélective à partir de plusieurs 
passes d'analyse sur des pistes différentes, 
jusqu'à obtenir uniquement les beat triggers 
dont vous avez besoin, est potentiellement 
beaucoup plus efficace que la suppression, 
l'insertion ou le réglage manuel de beat triggers 
incorrects ou faux.

Pistes de batterie et mode Collection

Supposons que vous ayez des pistes de batterie 
correspondant à la grosse caisse, à la caisse 
claire, aux toms et aux micros d'overhead. Si 
vous analysez une sélection s'étendant sur 
toutes les pistes, régler le curseur Sensitivity à 
une valeur suffisamment élevée pour capturer 
les données de la charley (qui proviennent en 
majorité des pistes des micros d'overhead) risque 
de créer de nombreux faux beat triggers. 

En revanche, si vous n'analysez que la piste des 
micros d'overhead, les beat triggers résultants 
apparaissent légèrement plus tard que les sons 
des autres pistes (car le son a davantage de 
chemin à parcourir pour arriver à ces micros). Si 
vous étendez ensuite la sélection aux autres 

pistes de batterie et que vous les séparez, les 
régions des pistes de la grosse caisse, de la caisse 
claire et des toms seront coupées un peu en 
retard (voir la figure 27 ci-dessous).

Le mode Collection permet d'analyser 
individuellement chaque piste de batterie et 
d'optimiser les paramètres de détection de 
chaque piste jusqu'à obtenir les beat triggers 
désirés. Les beat triggers de chaque piste peuvent 
s'ajouter successivement à la collection, ou vous 
pouvez choisir de ne récupérer que les seuls 
triggers d'une piste. La collection résultante de 
beat triggers peut ensuite servir à créer des 
marqueurs Bar|Beat ou un modèle DigiGroove, 
ou à séparer de nouvelles régions.

Utilisation du mode Collection

Le mode Collection est disponible en mode 
Bar|Beat Marker Generation, Groove Template 
Extraction ou Region Separation (données audio 
uniquement), et il est accessible en cliquant sur 
le bouton Collection Mode dans la zone 
Detection.

Pour utiliser le mode Collection avec Beat 
Detective LE, vous devez posséder l'option 
Music Production Toolkit.

Figure 27.  Les micros d'overhead créent des beat 
triggers en retard

Beat Detective, options du mode Collection
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Pour utiliser le mode Collection :

1  Dans la fenêtre Edit, effectuez une sélection 
audio sur une seule piste. Vérifiez que les points 
de début et de fin de la sélection tombent 
précisément sur le temps.

2  Dans la fenêtre Beat Detective, sélectionnez 
l'un des modes suivants :

• Bar|Beat Marker Generation

• Groove Template Extraction

• Region Separation (données audio 
uniquement)

3  Définissez ou capturez la sélection comme 
indiqué dans Définition d'une sélection pour le 
Beat Detective, page 621.

4  Configurez les options de détection de 
manière à détecter avec précision les pics des 
transitoires de la sélection (voir Création de beat 
triggers, page 623).

5  Cliquez sur le bouton Collection Mode.

6  Dans la zone Detection (mode Collection), 
cliquez sur Add pour ajouter les beat triggers 
courants à la collection. 

7  Cliquez sur le bouton Normal Mode et 
déplacez la sélection vers la piste suivante à 
analyser. Vérifiez que vous maintenez constante 
la plage de sélection pour chaque piste. 

8  Configurez les options de détection de 
manière à détecter avec précision les pics des 
transitoires de la sélection (voir Création de beat 
triggers, page 623).

9  Cliquez de nouveau sur le bouton Collection 
Mode.

10  Effectuez l'une des opérations suivantes :

• Dans la zone Detection (mode Collection), 
cliquez sur Add Unique Triggers pour 
n'ajouter que les beat triggers uniques de la 
piste à la collection. 

• Cliquez sur Add All pour ajouter tous les 
triggers à la collection.

• Cliquez sur Add All pour ajouter tous les 
triggers à la collection.

Chaque nouvel ensemble de beat triggers ajouté 
à la collection apparaît dans une couleur 
différente. Si des beat triggers de la collection se 
suivent de très près (du fait d'une diaphonie de 
micro, par exemple), Beat Detective ne conserve 
que les beat triggers apparus le plus tôt (voir la 
figure 28).

11  Répétez les étapes 7 à 10 pour chaque piste 
supplémentaire que vous analysez.

Pour déplacer la sélection vers le haut, 
appuyez sur Ctrl+P (Mac) ou sur 
Démarrer+P (Windows) ; pour déplacer la 
sélection vers le bas, appuyez sur 
Ctrl+point-virgule (Mac) ou sur 
Démarrer+point-virgule (Windows).

Après avoir activé le focus clavier sur les 
commandes, appuyez sur P sur le clavier de 
votre ordinateur pour déplacer la sélection 
vers le haut, ou sur le point-virgule (;) pour 
la déplacer vers le bas. Appuyez sur la 
touche Maj pour inclure la sélection 
courante au groupe.
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Les beat triggers stockés dans le mode Collection 
sont sauvegardés avec les sessions. Cela signifie 
que lorsque vous rouvrez une session, les 
données de la collection précédente sont à votre 
disposition (jusqu'à ce que vous les supprimiez). 

12  Une fois que les beat triggers désirés ont été 
ajoutés à la collection, vous pouvez les utiliser 
pour créer des marqueurs Bar|Beat ou un modèle 
de groove, ou séparer de nouvelles régions. 
Néanmoins, ceci peut être fait dans le mode 
Collection (lorsque les beat triggers s'affichent 
dans plusieurs couleurs).

Pour séparer des régions sur plusieurs pistes, 
veillez à étendre la sélection à toutes les 
pistes supplémentaires avant d'effectuer la 
séparation.

Figure 28.  La piste de micro d'overhead affichant une collection de beat triggers contenant les triggers uniques 
créés à partir des pistes de grosse caisse, caisse claire et toms

Beat triggers détectés dans 
la piste de grosse caisse 
ajoutés à la collection

Beat triggers uniques 
détectés sur la piste de 
caisse claire ajoutés à la 
collection

Beat triggers uniques 
détectés sur la piste de 
toms ajoutés à la collection

Beat triggers collectés 
appliqués à la piste de 
micro d'overhead
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Chapitre 25 : Édition MIDI

Pro Tools est livré avec des outils d'édition MIDI 
puissants. Vous pouvez créer et éditer dans la 
fenêtre Edit des notes MIDI individuelles et des 
événements de contrôleur à l'aide du crayon et 
des outils de trimming et d'accrochage. Vous 
pouvez transformer de manière destructive des 
groupes de notes MIDI et modifier la hauteur, le 
timing, la dynamique et le phrasé grâce aux 
différentes opérations MIDI (par exemple, 
Quantize, Transpose, Change Velocity et 
Change Duration). Il est possible également 
d'utiliser les propriétés en temps réel pour 
intervenir, de façon non destructive, sur les 
données MIDI lors de la phase de lecture. 
Pro Tools offre, en outre, divers outils de zoom 
et d'affichage optimisés pour l'édition MIDI.

Mirrored MIDI Editing
Cette fonction permet d'éditer des régions MIDI 
et d'appliquer vos modifications à chaque 
région MIDI du même nom. Cela s'avère très 
utile lors de l'édition de régions MIDI en boucle.

Pour activer l'édition MIDI en miroir, procédez 
comme suit :

" Choisissez Options > Mirror MIDI Editing.

– ou –

" Activez le bouton Mirrored MIDI Editing dans 
la fenêtre Edit.

En mode Mirrored MIDI Editing, le bouton 
Mirrored MIDI Editing clignote une fois en 
rouge dès qu'une édition est appliquée à plus 
d'une région.

Pour plus de détails sur l'édition de données 
audio et MIDI au niveau d'une région, 
consultez le chapitre 20, Utilisation des 
régions et des sélections.

Bouton Mirrored MIDI Edit dans la fenêtre Edit

Bouton Mirrored MIDI Edit
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Pour désactiver l'édition MIDI en miroir, procédez 
comme suit :

" Désélectionnez Options > Mirror MIDI 
Editing.

– ou –

" Désactivez le bouton Mirrored MIDI Editing 
dans la fenêtre Edit.

Crayon
Le crayon sert à créer et éditer des données 
MIDI. Les cinq premières formes du crayon 
(à main levée, ligne, triangle, carré et aléatoire) 
permettent d'entrer une série de hauteurs 
identiques avec des durées et des vitesses 
différentes (les vélocités des notes varient en 
fonction de la forme du crayon). Les différentes 
formes du crayon peuvent s'avérer 
particulièrement utiles pour le dessin et l'édition 
de différents types de données de contrôle MIDI. 
Vous pouvez par exemple utiliser la forme ligne 
pour le volume, la forme triangle pour le 
panoramique, la forme carrée et aléatoire pour la 
vélocité et régler le crayon sur main levée pour le 
pitch bend.

Pour sélectionner la forme du crayon :

1  Dans la barre d'outils, cliquez sur l'icône de 
l'outil Crayon pour afficher un menu déroulant.

2  Sélectionnez une forme de crayon.

Free Hand

Lorsque vous êtes en vue Notes, le crayon à main 
levée (Free hand) insère une seule note MIDI 
dont la vélocité est déterminée par la préférence 
Default Note On Velocity MIDI. La hauteur de 
pitch, l'emplacement et la durée de la note 
sont fonction de l'endroit où vous cliquez sur la 
piste MIDI.

Lors de l'édition des valeurs de vélocité ou des 
données du contrôleur MIDI, le tracé du crayon 
réglé sur main levée suit le mouvement de la 
souris. La forme est reproduite sous forme d'une 
série d'étapes, conformément à la préférence 
Pencil Tool Resolution When Drawing 
Controller Data MIDI.

Lorsque le mode Mirrored MIDI Editing est 
désactivé et que vous éditez des notes de 
régions en boucle dans la vue Notes, 
l'édition a pour effet d'aplanir la boucle. De 
la même manière, l'édition de groupes de 
régions a pour effet de séparer les groupes de 
régions.

Les formes de crayon Parabolic et S-Curve 
servent à définir des événements de tempo 
dans l'éditeur de tempo uniquement. Pour 
plus d'informations, reportez-vous à la 
section « Dessin d'événements de tempo », 
page 575.

Menu déroulant de formes du crayon

Formes de 
crayon 
disponibles 
pour MIDI 
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Line

Lorsque vous êtes en vue Notes, le crayon en 
forme de ligne (Line) insère une série de notes 
MIDI ayant toutes la même hauteur et dont la 
vélocité est déterminée par la préférence Default 
Note On Velocity MIDI. La durée de chaque 
note est déterminée par la valeur de la grille 
actuelle.

Lors de l'édition des valeurs de vélocité ou des 
données du contrôleur MIDI, le crayon en forme 
de ligne trace une ligne droite à main levée. Pour 
cela, cliquez à l'endroit où vous souhaitez que la 
ligne commence, puis relâchez la souris pour 
terminer la ligne. Les valeurs du contrôleur 
continu MIDI se transforment en une série 
d'étapes selon la préférence Pencil Tool 
Resolution When Drawing Controller Data 
MIDI.

Triangle

Lorsque vous êtes en vue Notes, le crayon en 
forme de triangle insère une série de notes MIDI 
ayant toutes la même hauteur et dont la vélocité 
varie entre la préférence Default Note On 
Velocity MIDI et la valeur 127 formant ainsi des 
dents de scie. La durée de chaque note est 
déterminée par la valeur de la grille actuelle.

Lors de l'édition des valeurs de vélocité ou des 
données du contrôleur MIDI, le crayon en forme 
de triangle trace une ligne en dents de scie en 
fonction des valeurs de la grille actuelle. Les 
valeurs du contrôleur MIDI se transforment en 
une série de marches selon la résolution définie 
pour l'option Pencil Tool Resolution When 
Drawing Controller Data MIDI (dans la page des 
préférences MIDI).

Square

Lorsque vous êtes en vue Notes, le crayon en 
forme de carré (Square) insère une série de notes 
MIDI ayant toutes la même hauteur et dont la 
vélocité passe de la valeur spécifiée dans Default 
Note On Velocity MIDI à la valeur 127. La durée 
de chaque note est déterminée par la valeur de la 
grille actuelle.

Lors de l'édition des valeurs de vélocité ou des 
données du contrôleur MIDI, le crayon en forme 
de carré trace une ligne constituée d'une série de 
carrés qui se répètent en fonction de la valeur de 
la grille actuelle.

Random

Lorsque vous êtes en vue Notes, le crayon de 
forme aléatoire (Random) insère une série de 
notes MIDI ayant toutes la même hauteur et 
dont la vélocité varie au hasard entre la valeur 
spécifiée dans Default Note On Velocity MIDI et 
la valeur 127. La durée de chaque note est 
déterminée par la valeur de la grille actuelle.

Lors de l'édition des valeurs de vélocité ou des 
données du contrôleur MIDI, le crayon en forme 
aléatoire trace une série de valeurs aléatoires qui 
varient en fonction de la valeur de la grille 
actuelle.
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Personnalisation de la durée 
des notes
La commande Custom Note Duration permet de 
définir la durée par défaut des notes insérées 
manuellement.

Pour sélectionner une durée de note 
personnalisée :

1  Dans la barre d'outils, cliquez sur l'icône de 
l'outil Crayon pour afficher un menu déroulant.

2  Sélectionnez une durée de note personnalisée. 
Une icône en forme de note (bouton Custom 
Note Duration) apparaît sous l'icône du crayon 
dans la barre d'outils.

3  Cliquez sur la note pour afficher le menu 
déroulant Custom Note Duration et 
sélectionnez une durée.

L'icône de note change en fonction de la valeur 
sélectionnée.

Définition de la valeur de 
la grille
Lors de l'insertion de notes MIDI à l'aide du 
crayon, la valeur de la grille détermine entre 
autres la durée de chaque note en fonction de la 
forme du crayon (voir Crayon, page 646).

Pour définir la valeur de la grille pour l'édition 
MIDI :

1  Définissez l'échelle temporelle principale sur 
Bars:Beats (temps/mesures) (voir Définition de 
l'échelle temporelle principale, page 409).

2  Dans le menu déroulant de valeur de la grille, 
sélectionnez une valeur de note (par exemple 
1/4, 1/8 ou 1/16).

3  Vérifiez la mesure et le tempo par défaut de la 
session (voir Réglage de la métrique par défaut, 
page 321 et Réglage du tempo par défaut, 
page 321).

Insertion de notes MIDI
Outre l'enregistrement, l'enregistrement par 
étape et l'importation de données MIDI dans 
Pro Tools, vous pouvez insérer manuellement 
des notes MIDI à l'aide du crayon. 

Outil crayon avec l'icône de note

Menu déroulant Custom Note Duration

Pour plus d'informations sur le mode Grid, 
consultez la section Grid, page 427.

Lors de l'insertion de notes MIDI ou d'autres 
données MIDI à l'aide du crayon, des 
limites de région MIDI sont créées sur les 
barres de mesure les plus proches.
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Pour insérer une note MIDI :

1  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Notes.

2  Sélectionnez le crayon et vérifiez qu'il est réglé 
sur Freehand. Le curseur se transforme en 
crayon lorsque vous le placez sur la playlist 
d'une piste MIDI ou d'une piste d'instrument en 
vue Note.

3  Pour insérer une noire sur le tempo, définissez 
l'échelle temporelle principale sur Bars:Beats et 
réglez le mode d'édition sur Grid et la valeur de 
grille sur une noire (0|1|000). 

4  Déplacez le crayon dans la zone de la playlist 
de la piste MIDI ou d'instrument. Utilisez la 
règle de la fenêtre Edit et le mini-clavier de la 
piste pour repérer la hauteur et l'emplacement 
de temps désirés.

Lorsque vous vous servez du crayon, la position 
et la valeur du curseur sont affichées dans la 
barre des options.

5  Lorsque vous avez atteint la hauteur et le 
temps désirés, cliquez pour insérer la note.

La vélocité des notes insérées est déterminée par 
l'option Default Note On Velocity MIDI (dans la 
page des préférences MIDI). En mode Grid, la 
durée de la note est déterminée par la valeur de 
la grille de la fenêtre Edit. Elle peut également 
être définie par la valeur Custom Note Duration 
(voir Personnalisation de la durée des notes, 
page 648).

Si l'option Play MIDI Notes when Editing est 
activée (dans la page des préférences MIDI), un 
son est émis à chaque insertion d'une note.

Crayon défini sur Free Hand

Position et valeur du curseur

Note MIDI insérée avec le crayon

Après avoir activé l'outil Smart (voir 
Utilisation de l'outil Smart, page 445), 
maintenez la touche Démarrer (Windows) 
ou Pomme (Mac) enfoncée et cliquez pour 
transformer le curseur en crayon et insérer 
des notes MIDI. Pour supprimer des notes, 
maintenez les touches Option+Ctrl (Mac) 
ou Alt+Démarrer (Windows) enfoncées et 
cliquez sur les notes.

Lorsque le mode Grid est activé, le point de 
début de la note MIDI passe par défaut 
directement au pas de grille le plus proche. 
Maintenez la touche Pomme (Mac) ou Ctrl 
(Windows) enfoncée et cliquez avec le 
crayon pour désactiver momentanément 
l'alignement sur la grille.
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Vous pouvez faire glisser le crayon après avoir 
cliqué (ou avant d'avoir relâché le bouton de la 
souris), pour régler la hauteur et la durée de la 
note. Cliquez et faites glisser la souris vers la 
droite pour allonger la note sans en modifier le 
point de début et vers la gauche pour raccourcir 
la note sans en modifier le point de fin.

Les différentes formes du crayon (ligne, triangle, 
carré et aléatoire) permettent d'entrer une série 
de hauteurs identiques avec des vélocités 
différentes. La longueur des notes insérées et 
l'espace entre celles ci sont déterminés par la 
valeur de la grille actuelle ou par la valeur 
Custom Note Duration. Les vélocités des notes 
sont déterminées par la forme du crayon.

Utilisez la forme carrée pour alterner vélocités 
fortes et faibles. Utilisez la forme triangulaire 
pour créer des rampes de vélocités vers le haut et 
vers le bas. La forme ligne entre les notes avec 
des vélocités identiques.

Pour insérer une série de notes avec des vélocités 
aléatoires :

1  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Notes.

2  Sélectionnez le crayon et vérifiez qu'il est réglé 
sur Random.

3  Définissez l'échelle temporelle principale sur 
Bars:Beats (temps/mesures). De plus, réglez le 
mode d'édition sur Grid et la valeur de grille sur 
une noire (0|1|000).

Avec ces paramètres, les notes insérées seront 
espacées d'une noire.

4  Cliquez sur le point où sera insérée la première 
note, puis faites glisser la souris vers la droite 
jusqu'à atteindre le nombre de notes souhaité.

Réglage de la durée d'une note insérée

Lorsque le mode Grid est activé, le point de 
fin de la note MIDI passe par défaut 
directement au pas de grille le plus proche. 
Maintenez la touche Pomme (Mac) ou Ctrl 
(Windows) enfoncée pendant que vous 
faites glisser le crayon pour désactiver 
momentanément l'alignement sur la grille.

Crayon défini sur Random

Insertion d'une série de notes avec le crayon
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Edition manuelle des notes 
MIDI
Vous pouvez éditer tous les aspects d'une note 
MIDI à partir de la fenêtre Edit : ses points de 
début et de fin, sa durée, sa hauteur et sa 
vélocité. Le sélecteur, l'outil d'accrochage et le 
crayon permettent de travailler sur des notes 
individuelles ou des groupes de notes.

Sélection des notes MIDI

Vous devez sélectionner les notes MIDI avant de 
pouvoir les éditer.

Pour sélectionner plusieurs notes MIDI, procédez 
comme suit :

" Avec l'outil d'accrochage ou le crayon, cliquez 
sur chaque note en appuyant sur la touche Maj.

" Avec un outil d'accrochage, positionnez le 
curseur à un emplacement vide (le rectangle de 
sélection apparaît) et dessinez un rectangle 
autour du groupe de notes à modifier.

Lorsque vous utilisez un outil d'accrochage, si 
une partie du rectangle touche une note (que ce 
soit son point de début ou de fin), celle ci est 
incluse à la sélection. Toutefois, les sélections 
effectuées avec un outil d'accrochage n'incluent 
pas les données sous-jacentes de contrôleur et 
d'automation de la piste MIDI.

" Faites glisser le sélecteur sur une plage de 
notes.

Lorsque vous utilisez le sélecteur, une note n'est 
sélectionnée que si son point de début est inclus. 
Lorsqu'une piste MIDI ou d'instrument est en 
vue Notes ou Regions, les sélections effectuées à 
l'aide du sélecteur incluent toutes les données 
sous-jacentes de contrôleur et d'automation.

Pour désélectionner une ou plusieurs notes :

" Avec le crayon ou un outil d'accrochage, 
cliquez sur les notes tout en appuyant sur la 
touche Maj.

Sélection et écoute de notes MIDI à l'aide du 
mini-clavier

Le mini-clavier permet de sélectionner et de 
jouer des notes de piste MIDI et d'instrument. 
Vous pouvez cliquer sur le mini-clavier avec 
n'importe quel outil d'édition.

Sélection de notes à l'aide d'un outil d'accrochage

Sélection de notes avec le sélecteur

Vous pouvez également sélectionner des 
notes dans la fenêtre Select/Split Notes. 
Pour plus d'informations, reportez-vous à la 
section Select/Split Notes, page 694.
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Pour jouer une note sur une piste MIDI ou 
d'instrument et sélectionner toutes les notes de 
même hauteur sur la piste (le cas échéant) :

" Sélectionnez un outil d'édition, puis cliquez 
sur une touche du mini-clavier.

Pour sélectionner et jouer une plage de notes sur 
une piste MIDI ou une piste d'instrument :

" Sélectionnez un outil d'édition, cliquez sur 
une touche, puis déplacez le curseur vers le haut 
ou vers le bas dans le mini-clavier.

Transposition des notes

Vous pouvez transposer les notes MIDI en 
faisant glisser un outil d'accrochage ou le crayon 
vers le haut ou vers le bas. Si plusieurs notes sont 
sélectionnées avant de faire glisser l'outil 
d'accrochage, elles sont toutes transposées.

Pour transposer une note MIDI :

1  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Notes.

2  Sélectionnez le crayon ou un outil 
d'accrochage.

3  Tout en appuyant sur Maj, faites glisser la note 
vers le haut ou vers le bas.

La touche Maj garantit que la note transposée 
conserve son point de début. Vous entendez les 
notes à mesure que vous les faites glisser et 
l'indicateur de valeur d'emplacement du curseur 
(dans la fenêtre Edit) indique le nombre de 
demi-tons et le sens (+/-) de la transposition.

Note jouée sur le mini-clavier avec sélection de toutes 
les notes de même hauteur

Pour jouer une note sans effectuer de 
sélection, maintenez la touche Option 
(Mac) ou Alt (Windows) enfoncée.

Pour sélectionner et désélectionner des notes 
et effectuer des sélection non contiguës, 
cliquez sur les notes souhaitées en 
maintenant la touche Pomme (Mac) ou Ctrl 
(Windows) enfoncée.

Note jouée sur le mini-clavier avec sélection de toutes 
les notes de même hauteur

Vous pouvez également cliquer sur le 
mini-clavier en maintenant la touche Maj 
enfoncée pour développer ou réduire le plage 
de notes.

Transposition à l'aide d'un outil d'accrochage

Pour transposer une copie de la note sans 
modifier la note originale, maintenez la 
touche Option (Mac) ou Alt (Windows) 
enfoncée pendant que vous faites glisser la 
note.

Les notes MIDI peuvent également être 
transposées à l'aide d'une transposition 
MIDI (voir Transpose, page 692) ou des 
propriétés MIDI en temps réel (voir 
Propriétés MIDI en temps réel, page 700). 
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Déplacement des notes

De même que les régions, vous pouvez déplacer 
les notes MIDI vers la gauche ou vers la droite 
avec un outil d'accrochage ou le crayon pour 
changer leur point de début. Si plusieurs notes 
sont sélectionnées avant de faire glisser la main, 
elles sont déplacées ensemble.

Pour déplacer une note MIDI :

1  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Notes.

2  Avec un outil d'accrochage ou le crayon, faites 
glisser la note vers la gauche ou la droite 
(appuyez sur Maj pour conserver la hauteur de la 
note).

Au fur et à mesure que vous faites glisser la note, 
l'indicateur de valeur d'emplacement du curseur 
(dans la fenêtre Edit) affiche le nouveau point de 
début.

Lorsque le mode d'édition est réglé sur Grid, la 
note déplacée s'aligne sur le pas de grille le plus 
proche. Lorsque le mode d'édition est réglé sur 
Spot, la boîte de dialogue Spot s'ouvre.

Rognage des temps de début et de fin 
d'une note

Tout comme les régions, vous pouvez ajuster les 
points de début et de fin des notes MIDI avec 
l'outil de trimming. Si plusieurs notes sont 
sélectionnées lorsque vous utilisez l'outil de 
trimming, elles sont toutes modifiées.

Pour changer les points de début ou de fin d'un 
groupe de notes MIDI :

1  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Notes.

2  Avec un outil d'accrochage ou le crayon, 
cliquez sur chaque note à rogner en appuyant 
sur la touche Maj.

3  Effectuez l'une des opérations suivantes :

• Sélectionnez l'outil de trimming. 

– ou –

• Utilisez le crayon.

4  Déplacez le curseur près du début de n'importe 
quelle note en surbrillance pour faire apparaître 
l'outil de trimming. Faites-le glisser vers la droite 
pour raccourcir les notes ou vers la gauche pour 
les rallonger.

Pour copier les notes sélectionnées sans 
toucher aux notes originales, maintenez la 
touche Option (Mac) ou Alt (Windows) 
enfoncée pendant que vous faites glisser les 
notes.

Le placement des notes MIDI peut 
également être ajusté à l'aide de la 
commande Shift (voir Commande Shift, 
page 508) ou de la commande Nudge 
(voir Déplacement par incrément 
(Nudging), page 505).

Il est possible également d'appliquer l'outil 
de rognage aux régions MIDI. Pour plus 
d'informations, reportez-vous à la section 
Fonction de compression/ extension 
temporelle pour les régions MIDI, page 657.

Outil de trimming
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En mode Grid, les points de début ou de fin 
déplacés s'alignent sur le pas de grille le plus 
proche de la grille. En mode Spot, la boîte de 
dialogue Spot s'ouvre et vous invite à entrer le 
nouvel emplacement des points de début et de 
fin de la note.

Vous pouvez également rogner les notes à l'aide 
de la commande Trim Region to Selection (voir 
Commande Trim Region to Selection, page 489) 
et de la commande Trim To Insertion (voir 
Rognage par incrément, page 491).

Edition manuelle de la vélocité des 
notes

Lorsque le format d'affichage d'une piste MIDI 
ou d'une piste d'instrument est réglé sur 
Velocity, la vélocité d'attaque des notes est 
représentée par une barre verticale. Plus celle-ci 
est haute, plus la valeur de vélocité est élevée 
(0-127).

Pour modifier la vélocité MIDI :

1  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Velocity.

2  Sélectionnez l'outil d'accrochage de temps.

3  Effectuez l'une des opérations suivantes :

• Faites glisser l'extrémité supérieure (le 
diamant) de la barre de vélocité vers le haut 
ou vers le bas.

– ou –

• Si deux notes possèdent le même temps de 
début (avec des barres de vélocité se 
superposant), faites glisser la note vers le 
haut ou le bas en appuyant sur Pomme 
(Mac) ou Ctrl (Windows).

Faites glisser le diamant vers le haut pour 
augmenter la valeur de la vélocité ou vers le bas 
pour la réduire. Lorsque vous le faites glisser, il 
devient bleu et la note associée est sélectionnée. 
Les valeurs de vélocité correspondant au 
diamant déplacé apparaissent dans l'indicateur 
de valeur d'emplacement du curseur (dans la 
fenêtre Edit).

Les vélocités d'une plage de notes peuvent être 
éditées à l'aide du crayon.

Changement de la position de fin des notes avec l'outil 
de trimming

En mode Grid, appuyez sur la touche Ctrl 
(Windows) ou Pomme (Mac) pour 
désactiver momentanément le mode Grid.

Déplacement d'une barre de vélocité

Edition de vélocités simultanées
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Pour dessiner des valeurs de vélocité créant un 
effet crescendo :

1  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Velocity.

2  Sélectionnez le crayon en forme de ligne.

3  Cliquez au début de la plage de notes, vers le 
bas de la plage de vélocité, puis faites glisser le 
crayon vers la droite tout en le faisant remonter, 
jusqu'à ce que la ligne englobe la plage de notes 
que vous souhaitez inclure dans le fondu.

Vous pouvez également utiliser l'outil de 
trimming pour décaler globalement les vélocités 
de toutes les notes sélectionnées. Cette fonction 
est pratique si vous êtes satisfait de la relation de 
vélocité entre les notes, mais que vous souhaitez 
qu'elles soient globalement plus ou moins 
fortes.

Pour décaler les vélocités avec l'outil de 
trimming :

1  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Velocity.

2  A l'aide du sélecteur ou d'un outil 
d'accrochage, sélectionnez la série de notes que 
vous voulez éditer.

3  A l'aide de l'outil de trimming, cliquez à 
proximité de la série de notes sélectionnée, puis 
faites glisser vers le haut ou le bas. La vélocité de 
toutes les notes augmente lorsque vous faites 
glisser l'outil de trimming vers le haut et 
diminue lorsque vous le faites glisser vers le bas.

Saisie des attributs des notes

Lorsque vous sélectionnez une note individuelle 
avec un outil d'accrochage ou le crayon, ses 
attributs s'affichent dans la zone d'édition des 
événements.

La hauteur est indiquée par le nom de la note et 
son numéro d'octave. Les vélocités d'attaque et 
de relâchement apparaissent sous forme de 
valeur MIDI (0-127). Les valeurs de sélection 
d'édition de début (Start), de fin (End) et de 
durée (Length) sont affichées dans l'échelle 
temporelle principale.

Pour changer un attribut sur une note MIDI :

1  Dans la zone de playlist d'une piste MIDI ou 
d'une piste d'instrument, sélectionnez la note 
avec un outil d'accrochage ou le crayon.

2  Cliquez dans la zone de texte Attributes et 
effectuez l'une des opérations ci-dessous.

• Entrez la nouvelle valeur sur le pavé 
numérique.

• Appuyez sur la flèche vers le haut ou vers le 
bas pour faire défiler les chiffres jusqu'à la 
nouvelle valeur.

Modification des vélocités avec la forme Ligne

En vue Velocity, l'outil de trimming peut 
servir à rogner la durée des notes en plus de 
modifier les vélocités.

Modification des vélocités avec l'outil de trimming

Zone d'édition des événements affichant les 
informations concernant la piste MIDI

Pitch

Vélocité 
d'attaque

Vélocité de 
relâchement
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• Appuyez sur la flèche vers le haut ou vers le 
bas pour atteindre la nouvelle valeur. 

• Jouez la nouvelle note choisie sur le 
contrôleur de clavier MIDI.

Appuyez sur la barre oblique (/) pour passer d'un 
champ à l'autre dans la zone d'édition des 
événements.

Notes multiples et zone d'édition des 
événements

Les valeurs que vous entrez dans la zone 
d'édition des événements s'appliquent à toutes 
les notes, lorsque vous en sélectionnez plusieurs. 
Un triangle apparaît à gauche de la note pour 
indiquer que plusieurs notes sont sélectionnées.

Entrer une nouvelle valeur dans le champ Start 
déplace la première note de la sélection jusqu'à 
cet endroit, et toutes les autres notes suivent le 
mouvement.

De même, les valeurs entrées dans les champs de 
hauteur et de vélocité s'ajoutent ou se 
soustraient à celles de toutes les notes 
sélectionnées. Par exemple, pour transposer 
d'une octave vers le bas toutes les notes 
sélectionnées, entrez une valeur de hauteur 
de -12.

Suppression de notes MIDI

Outre la suppression de notes sélectionnées via 
la commande Clear dans le menu Edit, vous 
pouvez supprimer des notes individuelles à 
l'aide du crayon.

Pour supprimer un groupe de notes MIDI à l'aide 
de la commande Clear :

1  A l'aide du sélecteur ou de l'outil main, 
sélectionnez les notes à supprimer (voir 
Sélection des notes MIDI, page 651).

2  Effectuez l'une des opérations suivantes :

• Choisissez Edit > Clear pour supprimer les 
notes sélectionnées. Les données de 
contrôleur sous-jacentes de la piste 
demeurent intactes.

– ou –

• Appuyez sur la touche Retour arrière 
(Windows) ou Supprimer (Mac).

Pour supprimer une seule note MIDI avec le 
crayon :

" Sélectionnez le crayon, puis cliquez sur la note 
tout en appuyant sur la touche Alt (Windows) 
ou Option (Mac). Le crayon se transforme en 
gomme lorsque vous appuyez sur la touche Alt 
(Windows) ou Option (Mac).

Vous pouvez également changer les 
attributs des notes MIDI dans la liste des 
événements MIDI (voir le Chapitre 27, Liste 
des événements MIDI).

Notes multiples dans la zone d'édition des événements

Lorsque vous supprimez des notes MIDI 
dans une sélection de plage temporelle, 
toutes les données de contrôleur et 
d'automation sous-jacentes sont également 
supprimées.

Suppression d'une note avec le crayon



Chapitre 25 : Édition MIDI 657

Fonction de compression/ 
extension temporelle pour les 
régions MIDI
L'outil de compression/extension temporelle est 
pratique pour faire correspondre une région 
MIDI à la longueur d'une autre région, à une 
grille de tempo ou à tout autre point de 
référence.

A l'aide de l'outil de compression/extension 
temporelle, vous pouvez déplacer le point de 
début ou de fin de la région MIDI pour étendre 
ou compresser la région, en adaptant les 
données MIDI en conséquence, quelle que soit 
la base de temps de la piste (tics ou 
échantillons).

Utilisation de l'outil de trimming Time 
Compression/Expansion en mode Grid

Cet outil peut être utilisé en mode Grid pour 
faire correspondre une région au tempo d'une 
session ou d'une section d'une session, ou pour 
créer des performances équivalant au double ou 
à la moitié de la durée.

Pour développer ou réduire les régions MIDI en 
mode Grid :

1  Réglez le mode d'édition sur Grid.

2  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Regions.

3  Sélectionnez l'outil de rognage TCE.

Vous pouvez également supprimer des 
événements de changement de programme 
et des événements Sysex en maintenant la 
touche Option (Mac) ou Alt (Windows) 
enfoncée pendant que vous cliquez dessus 
avec le crayon.

Outil de trimming compression/extension temporelle 
(Time Compression/Expansion)

Mise à l'échelle d'une région MIDI à l'aide de l'outil de 
compression/extension temporelle

Avant rognage

Après rognage
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4  A l'aide de l'outil de rognage TCE, faites glisser 
le point de début ou de fin de la région MIDI 
pour étendre ou compresser la région à la taille 
de la grille (par exemple, par noires). La nouvelle 
région MIDI, créée automatiquement, apparaît 
dans la playlist et dans la liste des régions.

Utilisation de l'outil de trimming Time 
Compression/extension temporelle en 
mode Slip

Pour développer ou réduire les régions MIDI en 
mode Slip :

1  Définissez le mode d'édition sur Slip.

2  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Regions.

3  Sélectionnez l'outil de rognage TCE.

4  Avec l'outil de rognage TCE, faites glisser le 
point de début ou de fin de la région MIDI pour 
étendre ou compresser la région. La nouvelle 
région MIDI, créée automatiquement, apparaît 
dans la playlist et dans la liste des régions.

Utilisation de l'outil de trimming Time 
Compression/Expansion en mode Spot

En mode Spot, lorsque vous cliquez avec l'outil 
de rognage TCE dans une région, la boîte de 
dialogue Spot s'affiche. Vous pouvez préciser 
l'emplacement sur lequel vous voulez que la 
région débute ou se termine, ou la durée de la 
région pour que celle-ci s'ajuste 
automatiquement.

Pour développer ou réduire les régions MIDI en 
mode Spot :

1  Définissez le mode d'édition sur Spot.

2  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Regions.

3  Sélectionnez l'outil de rognage TCE.

4  Cliquez sur la région MIDI à proximité de son 
point de début ou de fin. La boîte de dialogue 
Spot s'ouvre. A l'aide d'une règle temporelle, 
entrez une nouvelle valeur de début ou de fin 
(ou une durée) pour la région, puis cliquez sur 
OK. La nouvelle région MIDI, créée 
automatiquement, apparaît dans la playlist et 
dans la liste des régions.

Utilisation de l'outil de trimming Time 
Compression/extension temporelle en 
mode Shuffle

En mode Shuffle, la région rognée commence 
systématiquement au niveau du point de départ 
de la région d'origine, quel que soit le sens de 
rognage (de l'avant vers l'arrière ou de l'arrière 
vers l'avant).

Pour développer ou réduire les régions MIDI en 
mode Shuffle :

1  Réglez le mode d'édition sur Shuffle.

2  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Regions.

3  Sélectionnez l'outil de rognage TCE.

4  Avec l'outil de rognage TCE (Time 
Compression/Expansion), faites glisser le point 
de début ou de fin de la région MIDI pour 
étendre ou compresser la région. La nouvelle 
région MIDI, créée automatiquement, apparaît 
dans la playlist et dans la liste des régions.
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Evénements de contrôleur 
continu
Les événements de contrôleur continu des pistes 
MIDI et des pistes d'instrument s'affichent sous 
la forme d'un graphique linéaire muni d'une 
série de points d'inflexion que vous pouvez 
éditer. Les événements de contrôleur des pistes 
MIDI et des pistes d'instrument diffèrent 
quelque peu des données d'automation des 
pistes audio dans la mesure où les points 
d'inflexion sont en escalier (et non basés sur des 
vecteurs), chaque point d'inflexion représentant 
un seul événement de contrôleur.

Vous pouvez insérer et éditer dans Pro Tools les 
événements de contrôleur continu suivants :

• Volume

• Panoramique

• Variation de hauteur

• Aftertouch (mono)

• Contrôleurs MIDI, numéros 0 à 127

Les contrôleurs MIDI numéro 7 (volume) et 
numéro 10 (panoramique) sont traités par 
Pro Tools comme des données d'automation. 
Cela signifie que ces événements de contrôleur 
(ainsi que les coupures du son) peuvent être 
enregistrés et automatisés à partir de la fenêtre 
Mix. Par ailleurs, chaque mode d'automation 
d'une piste MIDI ou d'une piste d'instrument a 
une incidence sur la lecture et l'enregistrement 
de ces événements. Il est possible d'interrompre 
les événements de volume, de panoramique et 
de coupure du son d'une piste MIDI, mais la 
lecture de tous les autres événements de 
contrôleur de la piste se poursuit. Les pistes 
d'instrument prennent en charge aussi bien le 
volume, la coupure de son et le panoramique de 
données MIDI que le volume, la coupure de son 
et le panoramique de données audio.

Enregistrez en mode MIDI Merge pour ne pas 
écraser les données d'automation de 
panoramique et de volume MIDI. Lors de 
l'enregistrement en mode MIDI Merge, les 
données de panoramique et de volume ne sont 
pas lues pendant l'enregistrement des nouvelles 
données MIDI. 

Les événements de contrôleur continu (volume 
et panoramique inclus) émis par un contrôleur 
MIDI externe (clavier ou surface de contrôle) 
peuvent être enregistrés, puis insérés dans la 
playlist d'une piste MIDI à l'aide d'un outil 
d'accrochage ou du crayon.

Piste MIDI affichant des événements de volume

L'aftertouch polyphonique ne peut pas être 
visualisé dans la fenêtre Edit. Pour 
visualiser les données d'aftertouch 
polyphonique dans Pro Tools, utilisez la 
liste des événements MIDI (voir le 
Chapitre 27, Liste des événements MIDI).
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Insertion et édition d'événements 
de contrôleur

Les événements de contrôleur continu peuvent 
être édités par l'une des méthodes suivantes :

! Vous pouvez déplacer des points d'inflexion 
individuels à l'aide d'un outil d'accrochage afin 
d'ajuster leur emplacement ou leur valeur.

! Vous pouvez décaler vers le haut ou vers le bas 
un groupe de points d'inflexion sélectionné avec 
les outils de trimming.

! Vous pouvez dessiner de nouveaux 
événements du contrôleur avec le crayon pour 
remplacer des événements. Ceux-ci peuvent être 
dessinés avec le crayon (main levée, ligne, 
triangle, carré ou aléatoire).

! Vous pouvez couper, copier, coller, déplacer et 
décaler des événements du contrôleur.

Résolution des événements de 
contrôleur insérés

Lorsque vous insérez des événements de 
contrôleur avec le crayon, la densité des 
événements est déterminée par l'option Pencil 
Tool Resolution When Drawing Controller Data 
des préférences MIDI.

Pour définir la résolution du crayon :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet MIDI.

2  Indiquez une valeur (de 1 à 100 millisecondes) 
pour l'option Pencil Tool Resolution When 
Drawing Controller Data. 

3  Cliquez sur OK.

Pour modifier un événement de contrôleur 
continu à l'aide du crayon, il convient d'abord 
d'ajouter le contrôleur à la liste des contrôleurs 
MIDI automatisés.

Pour activer manuellement un contrôleur continu 
pour l'automation : 

1  Cliquez sur le sélecteur de vue de la piste MIDI 
ou d'instrument que vous souhaitez éditer et 
choisissez Add/Remove Controller dans le menu 
déroulant des contrôleurs.

Pour copier des événements de contrôleur 
continu MIDI et les coller sur un autre 
contrôleur MIDI, utilisez la fonction de 
collage spécial (Edit > Paste Special > To 
Current Automation Type). En effet, vous 
pouvez souhaiter par exemple utiliser les 
mêmes données de contrôle pour le volume 
ou un filtre de coupure ou bien pour le 
panoramique et la hauteur. Pour plus 
d'informations, reportez-vous à la section 
Fonction de collage spécial pour les données 
d'automation, page 830.

Les modifications apportées aux données de 
volume concernent toutes les pistes d'un 
groupe d'édition actif. Ce n'est toutefois pas 
le cas pour les autres playlists de contrôleur 
(panoramique, notamment). Pour insérer et 
éditer d'autres types de contrôleurs sur 
toutes les pistes d'un groupe d'édition, 
maintenez la touché Ctrl (Mac) ou 
Démarrer (Windows) enfoncée pendant que 
vous effectuez les éditions.

Le contrôleur est ajouté automatiquement à 
la liste des contrôleurs MIDI automatisés 
lorsque vous enregistrez des informations de 
contrôleur à partir d'un périphérique 
externe.
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2  Sélectionnez la plage des contrôleurs MIDI 
contenant le contrôleur à automatiser. 

3  Sélectionnez les contrôleurs continus que 
vous souhaitez automatiser dans la liste de 
gauche, puis cliquez sur Add.

4  Cliquez sur OK pour fermer la boîte de 
dialogue Automated MIDI Controller.

Sélection de patch 
(changements de programme 
et de banque)
Chaque piste MIDI et d'instrument peut 
posséder un changement de programme par 
défaut, qui est envoyé chaque fois que la piste 
est lue. D'autres changements de programme 
peuvent être insérés à n'importe quel point de la 
piste.

A propos des changements de 
programme et de banque

Le protocole MIDI permet de choisir dans un 
ensemble de 128 programmes (0-127). 
Toutefois, la plupart des instruments MIDI 
possèdent plusieurs banques de 
128 programmes. Pour spécifier une banque, 
vous devez envoyer un message de sélection de 
banque. Certains instruments utilisent le 
contrôleur 0 et d'autres le contrôleur 32 (certains 
utilisent une combinaison des deux). La boîte de 
dialogue Patch Select de Pro Tools permet 
d'utiliser l'un ou l'autre de ces messages de 
sélection de banque lorsque vous insérez un 
événement de changement de programme. 
Vérifiez le contrôleur utilisé dans la 
documentation du fabricant de votre 
périphérique.

Menu déroulant des contrôleurs MIDI

Boîte de dialogue Automated MIDI Controllers

Lorsque vous enregistrez des informations 
de contrôleur continu à partir d'un 
périphérique MIDI externe, le contrôleur est 
ajouté automatiquement à la liste des 
contrôleurs MIDI.
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Changement de programme par 
défaut

Vous pouvez spécifier le changement de 
programme par défaut de chaque piste MIDI en 
cliquant sur le bouton Patch Select des fenêtres 
Edit ou Mix. Le message de changement de 
programme est alors envoyé à votre instrument 
lorsque vous lisez la piste.

Pour définir le changement de programme par 
défaut d'une piste MIDI ou d'une piste 
d'instrument :

1  Cliquez sur le bouton Patch Select dans la 
fenêtre Mix ou Edit.

2  Effectuez l'une des opérations suivantes :

• Dans la boîte de dialogue Patch Select, 
sélectionnez un numéro de programme.

– ou –

Si vous ignorez la commande de sélection de 
banque utilisée par votre instrument, vous 
pouvez effectuer un enregistrement MIDI 
dans Pro Tools pendant que vous procédez à 
un changement de banque à partir de 
l'instrument. Il suffit ensuite d'examiner les 
informations de sélection de banque 
enregistrées par votre instrument dans 
Pro Tools dans la liste des événements 
MIDI.

Certains anciens appareils MIDI (le 
Kurzweil K1000 par exemple) utilisent un 
message de changement de programme à la 
place d'un message de sélection de banque 
pour le changement de banque. Pour ces 
périphériques, vous devez donc envoyer deux 
messages de changement de programme 
pour accéder à un programme particulier, le 
premier définissant la banque et le second le 
programme.

Bouton Patch Select

Boîte de dialogue Patch Select

Bouton de sélection des 
patchs (fenêtre Edit)

Bouton de sélection des 
patchs (fenêtre Mix)
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• Si vous utilisez des fichiers de noms de 
patch, sélectionnez une banque dans le 
menu déroulant situé dans la partie 
supérieure gauche de la boîte de dialogue 
Patch Select, puis choisissez un nom de 
patch. Pour plus d'informations, 
reportez-vous à la section Noms de patch, 
page 663.

3  Cliquez sur Done (Terminé).

Une fois sélectionné, le numéro (ou le nom de 
patch) du programme apparaît sur le bouton 
Patch Select de la fenêtre Edit.

Contrairement aux événements de changement 
de programme enregistrés et insérés, le 
changement de programme par défaut 
n'apparaît pas dans la liste de diffusion de la 
piste.

Pour supprimer le changement de programme 
par défaut, sélectionnez None dans la boîte de 
dialogue Patch Select.

Noms de patch

Pro Tools est compatible XML (Extensible 
Markup Language) pour l'archivage et 
l'importation des noms de patch des 
périphériques MIDI externes (tels que des 
instruments MIDI). Pro Tools installe les fichiers 
de noms MIDI (.midnam) pour les noms de 
patch d'usine par défaut de nombreux 
périphériques MIDI standard.

Les fichiers de noms de patch sont triés par 
fabricant et se trouvent à l'emplacement 
suivant :

• Sous Windows, dans Program 
Files\Common Files\Digidesign\MIDI 
Patch Names\Digidesign

• Sur Mac, dans /Library/Audio/MIDI Patch 
Names/Digidesign

Pour importer des noms de patch MIDI dans 
Pro Tools :

1  Choisissez Setup > MIDI > MIDI Studio et 
vérifiez la définition du périphérique MIDI dans 
la fenêtre MIDI Studio Setup (Windows) ou 
Audio MIDI Setup (Mac).

2  Vérifiez si la sortie de la piste MIDI est 
correctement attribuée au périphérique MIDI.

3  Cliquez sur le bouton de sélection des patchs 
de la piste MIDI.

Sélection d'une banque dans la boîte de dialogue Patch 
Select

Bouton Patch Select, fenêtre Edit

Nom de patch

Les fichiers de nom de patch MIDI 
(.midnam) peuvent être modifiés dans un 
éditeur de texte. Vous pouvez en outre 
utiliser des bibliothèques et des logiciels 
d'édition tiers pour créer vos propres patchs.

Pour plus d'informations sur la 
configuration des périphériques MIDI sur 
des systèmes Windows et Mac, 
reportez-vous au Guide de démarrage.
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4  Dans la boîte de dialogue Patch Select, cliquez 
sur Change.

5  Dans la boîte de dialogue Open, accédez à l'un 
des éléments suivants :

• Sous Windows, Program Files\Common 
Files\Digidesign\MIDI Patch 
Names\Digidesign\<nom du fabricant>

– ou –

• Sur Mac, /Library/Audio/MIDI Patch 
Names/Digidesign/<nom du fabricant> 

6  Sélectionnez le fichier .midnam 
correspondant au périphérique MIDI.

7  Cliquez sur Open.

8  La boîte de dialogue Patch Select affiche les 
noms de patch du fichier sélectionné et le menu 
déroulant Patch Name Bank s'affiche dans 
l'angle supérieur gauche de la fenêtre.

Une fois les noms de patch importés dans 
Pro Tools, vous pouvez les utiliser pour ce 
périphérique MIDI dans les sessions suivantes.

Pour effacer des noms de patch :

1  Dans la boîte de dialogue Patch Select, cliquez 
sur Clear.

2  Cliquez sur Done (Terminé).

Boîte de dialogue Patch Select

Bouton Change

Boîte de dialogue Patch Select contenant les noms de 
patchs

Pro Tools ne permet pas d'importer un 
fichier de noms de patch s'il ne correspond 
pas aux informations de modèle et de 
fabricant sélectionnées dans la fenêtre 
MIDI Studio Setup (Windows) ou Audio 
MIDI Setup (Mac).
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Insertion/édition des 
changements de programme

Vous pouvez insérer les changements de 
programme dans la liste de diffusion d'une piste 
à l'aide du crayon, puis les éditer, supprimer, 
copier et coller.

Pour insérer un changement de programme avec le 
crayon :

1  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Program Change.

2  Pour que l'événement inséré s'aligne sur la 
valeur d'une grille, activez le mode Grid. 

3  A l'aide du crayon, cliquez dans la playlist de 
la piste à l'endroit où vous souhaitez insérer les 
changements de programme.

4  Dans la boîte de dialogue Patch Select, 
sélectionnez un numéro (ou un nom) de 
programme et, le cas échéant, spécifiez une 
valeur de changement de banque.

5  Cliquez sur Done pour insérer l'événement de 
changement de programme dans la playlist de la 
piste.

Pour éditer un événement de changement de 
programme :

1  A l'aide d'un outil d'accrochage ou du crayon, 
cliquez deux fois sur le changement de 
programme à éditer.

2  Dans la boîte de dialogue Patch Select, 
sélectionnez le nouveau numéro (ou un nom) 
de programme et, le cas échéant, spécifiez une 
valeur de changement de banque.

3  Cliquez sur Done (Terminé).

Pour déplacer un événement de changement de 
programme :

" A l'aide d'un outil d'accrochage ou du crayon, 
faites glisser le changement de programme vers 
la gauche ou la droite.

Si le mode d'édition est défini sur Grid, 
l'événement déplacé s'aligne sur le pas de grille 
le plus proche. Lorsque le mode d'édition est 
réglé sur Spot, la boîte de dialogue Spot s'ouvre.

Pour supprimer un événement de changement de 
programme :

1  Effectuez l'une des opérations suivantes :

• Lorsque le format d'affichage de la piste est 
réglé sur Program Change, cliquez sur l'évé-
nement de changement de programme à 
l'aide d'un outil d'accrochage pour le sélec-
tionner.

– ou –

• Si la région contient d'autres événements 
que vous souhaitez supprimer, sélectionnez 
la région entière à l'aide d'un outil d'accro-
chage (lorsque la piste affiche des régions).

Sur certains instruments, le changement de 
programmes en cours de lecture peut 
interrompre celle-ci. Pour éviter ce cas de 
figure, placez les événements de 
changement de programme sur la piste à un 
endroit exempt de note.

Evénement de changement de programme

Le placement des changements de 
programme peut également être ajusté à 
l'aide de la commande Shift (voir 
Commande Shift, page 508) ou de la 
commande Nudge (voir Déplacement par 
incrément (Nudging), page 505).
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2  Effectuez l'une des opérations suivantes :

• Choisissez Edit > Clear pour supprimer les 
événements sélectionnés de la piste.

– ou –

• Appuyez sur la touche Retour arrière 
(Windows) ou Supprimer (Mac).

Ecoute des programmes

Lorsque la boîte de dialogue Patch Select est 
ouverte, Pro Tools peut faire défiler 
automatiquement les différents patchs d'un 
périphérique MIDI affecté à une piste.

Pour écouter les patchs :

1  Si vous avez l'intention d'écouter des patchs 
pour une piste MIDI ou une piste d'instrument 
en cours de lecture, cliquez sur le bouton Play 
dans la fenêtre Transport.

2  Ouvrez la boîte de dialogue Patch Select en 
cliquant sur le bouton Patch Select ou en 
insérant ou éditant un changement de 
programme dans une piste MIDI ou une piste 
d'instrument.

3  Cliquez sur un numéro de programme, celui à 
partir duquel vous désirez faire défiler les patchs.

4  Entrez le nombre de secondes désiré entre 
chaque changement de programme.

5  Sélectionnez l'option Increment Patch.

Après le nombre de secondes indiqué, Pro Tools 
sélectionne le nouveau patch et transmet le 
changement de programme à l'appareil MIDI 
affecté à la piste.

6  Lorsque vous avez terminé l'écoute de 
paramètres, cliquez sur Done pour arrêter 
l'incrémentation des patchs et fermer la boîte de 
dialogue Patch Select.

Evénements System 
Exclusive
Vous pouvez enregistrer les événements System 
Exclusive (Sysex) sur des pistes MIDI ou des 
pistes d'instrument dans Pro Tools (voir Option 
MIDI Step Input, page 362). Lorsque des 
événements ont été enregistrés, ils apparaissent 
dans la playlist de la piste sous forme de blocs 
lorsque la vue de la piste est réglée sur Sysex.

Si vous ne pouvez pas éditer le contenu des 
événements System Exclusive enregistrés 
directement dans Pro Tools, vous pouvez 
néanmoins les déplacer, les déplacer par 
incréments, les copier/coller, ou les supprimer.

Pour déplacer un événement Sysex :

1  Réglez le format d'affichage de la piste MIDI 
ou d'instrument sur Sysex.

2  A l'aide d'un outil d'accrochage, faites glisser 
l'événement Sysex vers la gauche ou la droite.

Si le mode d'édition est défini sur Grid, 
l'événement déplacé s'aligne sur le pas de grille 
le plus proche. Lorsque le mode d'édition est 
réglé sur Spot, la boîte de dialogue Spot s'ouvre.

Vous pouvez également supprimer des 
événements de changement de programme 
individuels en cliquant dessus avec le 
crayon tout en maintenant la touche Option 
(Mac) ou Alt (Windows) enfoncée.

Bloc d'événements Sysex
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Pour supprimer un ou plusieurs événements 
Sysex :

1  Effectuez l'une des opérations suivantes :

• Lorsque le format d'affichage de la piste est 
réglé sur Sysex, cliquez sur l'événement 
Sysex à l'aide d'un outil d'accrochage pour 
le sélectionner.

– ou –

• Si la région contient d'autres événements 
Sysex que vous souhaitez supprimer, 
sélectionnez la région entière à l'aide d'un 
outil d'accrochage (lorsque la piste affiche 
des régions).

2  Effectuez l'une des opérations suivantes :

• Choisissez Edit > Clear pour supprimer les 
événements sélectionnés de la piste.

– ou –

• Appuyez sur la touche Retour arrière 
(Windows) ou Supprimer (Mac).

Poursuite de note et de 
contrôleur

Note Chasing

La fonction Note Chasing permet d'entendre des 
notes MIDI longues et soutenues même 
lorsqu'elles sont lues à partir d'un point situé 
après leur début. Par exemple, si une note 
démarre à 1|1|000 et dure 8 mesures (jusqu'à 
9|1|000), la fonction Note Chasing permet, 
même si vous lancez la lecture depuis la mesure 
5, d'entendre la note démarrée à 1|1|000, 
puisqu'elle est soutenue jusqu'à 9|1|000.

La fonction Note Chasing peut être activée et 
désactivée séparément sur chaque piste MIDI ou 
d'instrument. Par défaut, l'option Note Chasing 
est activée sur les nouvelles pistes MIDI et 
d'instrument.

Pour activer la fonction Note Chasing sur une 
piste MIDI :

" Cliquez sur le sélecteur de playlist de la piste et 
sélectionnez l'option Note Chasing.

Le placement des blocs d'événements Sysex 
peut également être ajusté à l'aide de la 
commande Shift (voir Commande Shift, 
page 508) ou de la commande Nudge (voir 
Déplacement par incrément (Nudging), 
page 505).

Vous pouvez également supprimer des blocs 
d'événements Sysex individuels en cliquant 
dessus avec le crayon tout en maintenant 
enfoncée la touche Option (Mac) ou Alt 
(Windows).

Option Note Chasing activée dans le sélecteur 
de playlist
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Veillez à désactiver la fonction Note Chasing 
lorsque vous travaillez avec des 
échantillonneurs qui jouent des boucles. Si une 
piste MIDI, par exemple, déclenche une boucle 
de batterie de 4 mesures et que vous commencez 
à jouer à la mesure 3, la boucle commencera sa 
lecture au mauvais moment et sera décalée par 
rapport aux autres pistes. 

Poursuite de données de contrôleur et 
de programmes

Pro Tools poursuit en permanence les 
événements de contrôleur continu et les 
changements de programme des pistes MIDI. 
Ceci garantit que les valeurs du contrôleur et les 
connexions de périphériques MIDI restent 
correctement configurées.

Supposons qu'une piste MIDI de 32 mesures 
commence à un volume de 127 et effectue un 
fondu de sortie à 0 dans la dernière mesure. 
Si après avoir lu toute la piste, vous tentez de lire 
à partir de la mesure 8, le volume initial de 127 
est « poursuivi », retrouvé et envoyé à l'appareil 
affecté à la piste. En l'absence de « poursuite », la 
piste ne serait pas entendue puisque 
l'événement de volume le plus récent aura été 0.

La poursuite se produit également pour un 
changement de programme par défaut d'une 
piste MIDI, ainsi qu'avec tout événement de 
changement de programme se trouvant sur la 
piste. Par conséquent, si vous avez choisi un 
changement de programme par défaut pour une 
piste, lorsque vous effectuez la lecture depuis 
n'importe quel point de la piste, cet événement 
de changement de programme est envoyé au 
périphérique affecté à la piste.

Valeurs de contrôleur par défaut et 
poursuite

Bien que les nouvelles pistes MIDI semblent 
avoir des valeurs par défaut pour les playlists de 
contrôleur continu, ce n'est en fait pas le cas. 
Par exemple, lorsque vous consultez la playlist 
de la molette de modulation d'une piste MIDI, 
vous observez que la ligne de point d'inflexion 
est définie sur zéro par défaut. Cependant, 
comme la molette de modulation de votre 
synthétiseur a pu être intentionnellement réglée 
sur une valeur différente, la valeur par défaut de 
la piste n'est pas transmise lors de la lecture.

Par exemple, si vous insérez une modification de 
molette de modulation de 0 à 90 vers la fin de la 
piste et si vous lancez ensuite la lecture depuis le 
début de la piste, ou à partir d'un emplacement 
situé avant la modification, la valeur de la 
molette de modulation reste sur 90 jusqu'à ce 
que la valeur 0 soit atteinte, ce que 
probablement vous ne souhaitez pas.

Pour vous assurer que la valeur par défaut du 
contrôleur d'une playlist est envoyée 
(et poursuivie), cliquez sur le point d'inflexion 
initial au début de la piste, déplacez-le 
légèrement puis redéfinissez-le sur la valeur par 
défaut.
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Décalage des pistes MIDI
Pro Tools peut décaler les pistes MIDI 
globalement ou individuellement.

Décalage de lecture MIDI global

Pro Tools offre une préférence de décalage MIDI 
(MIDI Offset) qui permet d'avancer ou retarder 
la lecture des pistes MIDI et d'instrument (par 
rapport aux pistes audio) d'un nombre 
d'échantillons donné. Le décalage ne concerne 
que la lecture et pas l'affichage des données 
MIDI dans la fenêtre Edit.

Cette fonction est offerte en grande partie pour 
compenser la latence de l'écoute audio dans 
Pro Tools LE. Si vous écoutez la sortie de vos 
instruments MIDI externes par l'intermédiaire 
d'une console de mixage ou d'un système de 
sonorisation externe (ou d'un casque), il ne se 
produit aucune latence. En revanche, si vous 
écoutez la sortie de vos périphériques MIDI à 
travers une interface Pro Tools LE (par exemple, 
une interface Mbox 2), la lecture des pistes MIDI 
semble s'effectuer légèrement après celle des 
pistes audio. Plus le paramètre de la taille du 
buffer matériel est élevé (128, 256, 512 ou 1 024 
échantillons), plus la latence l'est également.

Si vous configurez l'option Global MIDI 
Playback Offset, vous pouvez avancer 
légèrement la lecture de vos pistes MIDI (d'un 
nombre spécifié d'échantillons), de manière à 
compenser la latence de l'écoute audio dans 
Pro Tools LE.

Pour configurer le décalage de lecture MIDI 
global :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet MIDI.

2  En face de l'option Global MIDI Playback 
Offset, entrez le nombre d'échantillons (-10 000 
à 10 000) désiré pour le décalage. Une valeur 
négative avance la lecture des pistes MIDI par 
rapport aux pistes audio, tandis qu'une valeur 
positive retarde la lecture des pistes MIDI.

Pour compenser la latence d'écoute dans 
Pro Tools LE, réglez le décalage sur une valeur 
approximativement équivalente à la taille du 
buffer matériel.

3  Cliquez sur OK.

Décalages de pistes MIDI et de pistes 
d'instrument

Vous pouvez décaler des pistes MIDI et 
d'instrument individuelles dans Pro Tools pour 
compenser les temps de réaction de 
périphériques MIDI (le temps nécessaire au 
déclenchement d'événements sur un 
échantillonneur ou un synthétiseur).

Avec Pro Tools HD, lorsque la 
compensation de retard est active, les délais 
des pistes MIDI et d'instrument sont 
automatiquement compensés pour assurer 
une écoute à faible latence. Pour plus 
d'informations, reportez-vous à la section 
Compensation de retard pour un événement 
MIDI, page 760.

Vous pouvez également régler le décalage de 
lecture MIDI global dans la fenêtre MIDI 
Track Offsets. Vous pouvez également 
appliquer le retard des propriétés en temps 
réel MIDI pour décaler les données MIDI 
(voir Propriétés MIDI en temps réel, 
page 700).
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Par exemple, si des grosses caisses sont lues par 
une piste audio dans Pro Tools et que vous 
voulez qu'elles soient parfaitement 
synchronisées avec les sons de grosses caisses 
générés par un périphérique MIDI, vous devrez 
peut-être utiliser un décalage MIDI. Dans cet 
exemple, 5 ms sont généralement nécessaires 
pour déclencher les notes MIDI, éventuellement 
davantage avec certains appareils MIDI.

Pour mesurer la latence d'un appareil MIDI 
affecté à une piste MIDI, il suffit de réenregistrer 
sa sortie audio dans Pro Tools. Comparer ensuite 
les emplacements des échantillons des 
événements audio enregistrés et ceux des notes 
MIDI d'origine pour obtenir la valeur de latence.

Pour configurer le décalage d'une piste MIDI ou 
d'instrument :

1  Choisissez Event > MIDI Track Offsets.

2  Cliquez dans la colonne Sample Offset de la 
piste MIDI et entrez le nombre d'échantillons 
(-10 000 à 10 000) pour le décalage. Une valeur 
négative avance la lecture des pistes MIDI ou 
d'instrument par rapport aux pistes audio, 
tandis qu'une valeur positive retarde la lecture 
des pistes MIDI ou d'instrument.

Le décalage équivalent apparaît en 
millisecondes dans la colonne msec Offset. 
Cette valeur ne peut être éditée mais elle est 
automatiquement mise à jours lorsque vous 
entrez une nouvelle valeur dans la colonne 
SMPTE Offset.

3  Appuyez sur Retour (Mac) ou sur Entrée 
(Windows) pour valider la valeur de décalage.

Pour réinitialiser tous les décalages de toutes les 
pistes MIDI et d'instrument, cliquez sur le 
bouton Reset en haut et à gauche de la fenêtre.

Notes coincées
Si vous rencontrez des notes coincées dans vos 
périphériques MIDI, vous pouvez les faire taire 
par la commande All MIDI Notes Off.

Pour couper toutes les notes coincées :

" Choisissez Event > All MIDI Notes Off. 

Fenêtre MIDI Track Offsets

Appuyez sur Pomme+Maj+point (.) (Mac) 
ou sur Ctrl+Maj+point (.) (Windows) pour 
activer la commande All MIDI Notes Off.
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Remove Duplicate Notes
La commande Remove Duplicate Notes est 
pratique pour supprimer des notes en double 
dans une performance MIDI. Lorsqu'une note 
commence dans les premiers instants (25% de la 
durée) d'une note de même hauteur qui retentit 
déjà (ou dans l'intervalle d'une croche, selon la 
durée la plus courte), elle est considérée comme 
un double et est combinée avec la note 
précédente. Si elle démarre après ce délai, la 
première note est raccourcie de façon à se 
terminer au tic précis où commence la 
nouvelle note.

Pour supprimer des notes en double :

1  Effectuez une sélection d'édition comprenant 
les notes en double à éliminer.

2  Choisissez Event > Remove Duplicate Notes.
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Chapitre 26 : Oopérations MIDI

Fenêtre MIDI Operations
Les commandes proposées dans la fenêtre MIDI 
Operations permettent de transformer des 
groupes de notes MIDI et de modifier la hauteur, 
le timing et le phrasé. 

La fenêtre MIDI Operations se compose de neuf 
pages, une pour chaque commande MIDI 
Operations.

• Grid/Groove Quantize

• Restore Performance

• Flatten Performance

• Change Velocity

• Change Duration

• Transpose

• Select/Split Notes

• Input Quantize

• Step Input

La fenêtre MIDI Operations peut rester ouverte 
si vous souhaitez y revenir pour appliquer une 
commande ou essayer une option différente 
pour une commande donnée.

Il est possible également d'appliquer des 
valeurs de quantification, durée, retard et 
transposition, de façon non destructive, à 
l'aide des propriétés MIDI en temps réel. 
Pour plus d'informations, reportez-vous à la 
section Propriétés MIDI en temps réel, 
page 700.

Pour plus d'informations sur la 
configuration des périphériques MIDI sur 
des systèmes Windows et Mac, 
reportez-vous au Guide de démarrage.
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Pour ouvrir une page MIDI Operations spécifique :

" Choisissez Event > MIDI, puis la commande 
MIDI Operations voulue (Grid/Groove 
Quantize, par exemple).

Pour ouvrir la dernière page MIDI Operations 
active :

" Choisissez Event > MIDI > Operations 
Window.

Pour appliquer la commande dans la fenêtre MIDI 
Operations, effectuez une des opérations 
suivantes :

" Cliquez sur Apply ou appuyez sur Entrée sur le 
pavé numérique. Ceci applique la commande et 
laisse la fenêtre ouverte au premier plan.

– ou –

" Appuyez sur Retour (Mac) ou sur Entrée 
(Windows) sur le clavier alphanumérique. 
Ceci applique la commande et ferme la fenêtre.

Pour annuler la commande dans la fenêtre MIDI 
Operations :

" Choisissez Edit > Undo.

Fenêtre MIDI Operations (page Grid/Groove Quantize 
affichée)

Pour ouvrir la fenêtre MIDI Operations et 
afficher la dernière page MIDI Operations 
active, appuyez sur les touches Alt+3 
(Windows) ou Option+3 (Mac).

Si la fenêtre MIDI Operations est déjà 
ouverte, vous pouvez sélectionner la page qui 
vous intéresse à partir du menu déroulant 
accessible en haut de la fenêtre.

Lorsque vous utilisez en même temps la 
fenêtre MIDI Operations et les propriétés 
MIDI en temps réel, les opérations MIDI 
sont appliquées aux données MIDI réelles. 
L'application des propriétés MIDI 
Real-Time sur les données MIDI continue.
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Utilisation de la fenêtre MIDI 
Operations

Les méthodes qui suivent vous permettent de 
configurer facilement les différentes options, 
variables d'une commande à l'autre, de la fenêtre 
MIDI Operations :

! Pour passer d'un champ au suivant ou revenir 
au champ précédent, utilisez la touche Tab ou 
Maj+Tab.

! Augmentez ou diminuez les valeurs des 
champs sélectionnés à l'aide des touches 
fléchées vers le haut et vers le bas. Appuyez sur 
ces touches et maintenez-les enfoncées pour 
faire défiler rapidement les valeurs.

! Cliquez et tirez sur un champ sélectionné vers 
le haut ou le bas en pour faire défiler une 
nouvelle valeur.

! Appuyez sur Pomme (Mac) ou sur Ctrl 
(Windows) tout en réglant les curseurs pour 
obtenir une résolution plus fine.

! Dans le cas des champs de hauteur et de 
vélocité, jouez une note sur votre contrôleur 
MIDI pour entrer automatiquement les valeurs 
correspondantes.

! Le changement de valeur d'un paramètre 
particulier (par exemple le pourcentage de 
Swing dans la fenêtre Quantize), active 
automatiquement ce paramètre. 

Grid/Groove Quantize
La commande Grid/Groove Quantize ajuste 
l'emplacement et la durée des notes MIDI pour 
améliorer leur temps ou créer une sensation 
rythmique particulière. 

La page Grid/Groove par défaut contient 
diverses options Grid Quantize. L'opération de 
quantification consiste à aligner les notes sur 
une grille de quantification, dont vous 
définissez le pas dans le menu déroulant 
Quantize Grid sous forme d'une durée de note 
standard. Il est possible également d'appliquer 
un modèle groove. La fenêtre Grid/Groove 
Quantize propose des options légèrement 
différentes selon l'opération choisie (Grid 
Quantize ou Groove Quantize).

L'opération Grid/Groove Quantize MIDI n'est 
pas la même que la commande Quantize to Grid 
(Région > Quantize to Grid). Cette dernière 
ajuste en effet le point de début d'une région 
sélectionnée, dont le contenu se trouve déplacé 
(en préservant les relations rythmiques 
internes). 

En revanche, l'opération Grid/Groove Quantize 
MIDI modifie les notes MIDI de façon 
individuelle. Certaines notes peuvent être 
retardées, d'autres avancées, d'autres 
raccourcies, d'autres rallongées et certaines 
notes subiront davantage de modifications que 
d'autres.

Vous pouvez également quantifier les 
entrées MIDI (voir Input Quantize, 
page 696).
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Pour ouvrir la fenêtre Grid/Groove Quantize :

" Choisissez Event > MIDI > Grid/Groove 
Quantize. 

Pour sélectionner Grid Quantize :

" Dans le menu contextuel Quantize Grid, 
sélectionnez une valeur de note.

Pour sélectionner Groove Quantize :

" Dans le menu contextuel Quantize Grid, 
sélectionnez un modèle de groove.

Options Grid Quantize

La fenêtre Grid/Groove Quantize permet 
d'appliquer une valeur de quantification de 
grille lorsqu'une valeur rythmique particulière 
est sélectionnée dans le menu contextuel 
Quantize Grid. Si vous sélectionnez un modèle 
groove dans le menu déroulant Quantize, vous 
pouvez appliquer une quantification de groove. 
Pour plus d'informations à ce sujet, 
reportez-vous à la section Groove Quantize, 
page 681.

Options What to Quantize

Les options de la zone What to Quantize 
déterminent les aspects des notes MIDI 
sélectionnées qui seront quantifiés : les phases 
d'attaque (Attacks), de relâchement (Releases) 
ou les deux.

Attacks : lorsque vous cochez cette option, les 
points de début des notes sont quantifiés.

Releases : lorsque vous cochez cette option, les 
points de fin des notes sont quantifiés.

Preserve Note Duration : lorsque vous cochez 
cette option, la durée des notes est conservée. 

Lorsqu'elle n'est pas cochée, mais que par contre 
l'option Attacks l'est, les points de fin des notes 
ne sont pas déplacés. 

Lorsque cette option n'est pas cochée, mais que 
par contre l'option Releases l'est, les points de 
début des notes ne sont pas déplacés.

Si vous avez coché les deux options Attacks et 
Releases, l'option Don't Change Durations n'est 
pas disponible.

Fenêtre MIDI Operations, Grid/Groove Quantize

Les paramètres de la fenêtre Quantize sont 
sauvegardés avec chaque session. Pour 
enregistrer vos paramètres favoris pour vos 
futures sessions, enregistrez les en tant 
qu'éléments d'un modèle de session (voir 
Création de modèles de session 
personnalisés, page 109). 

Appuyez sur Alt+0 (Windows) ou sur 
Option+0 (Mac) pour accéder à la fenêtre 
Grid/Groove Quantize.
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La figure 29 illustre le réglage des notes par les 
différentes options de la zone What To 
Quantize.

Grille de quantification

Menu déroulant Quantize Grid : détermine le pas 
de la grille sur lequel s'alignent les notes. 
Vous pouvez sélectionner comme pas de grille 
n'importe quelle valeur de note, de la ronde 
(1/1) à la quadruple croche (1/64), valeurs 
pointées ou triolets compris. 

Tuplet : sélectionnez l'option Tuplet pour 
quantifier les groupes de notes « inhabituels », 
tels que les quintolets (5 dans 4 temps). Dans ce 
cas, le pas de grille de quantification est calculé à 
partir de la valeur de note sélectionnée et de la 

valeur de Tuplet. Par exemple, si une double 
croche équivaut à 240 tics, des croches en 
quintolets (5 pour 4) donnent un pas de grille de 
192 tics (240 tics 5)* 4.

Offset Grid By : permet de décaler 
temporellement la grille de quantification vers 
l'avant ou l'arrière, du nombre de tics spécifié. 
Utilisez cette option pour obtenir un effet de jeu 
« en avant » (en utilisant des valeurs positives) 
ou « en arrière » (en utilisant des valeurs 
négatives) du temps.

Randomize : lorsque cette option est cochée, les 
notes sont déplacées de façon aléatoire vers 
l'avant ou l'arrière dans le temps (à l'issue de la 
quantification). Par exemple, lorsque la grille de 
quantification est définie sur la croche et que 
l'option Randomize est définie sur 50 %, les 
notes sont déplacées jusqu'à une triple croche 
avant ou après la limite du tempo. Le paramètre 
Randomize a également une incidence sur la 
durée des notes (si vous avez coché l'option 
Releases).

Figure 29.  Exemples de quantification

Le mode Relative Grid n'affecte pas la grille 
de quantification.

Avant quantification

Pour ne quantifier que les backbeats (temps 
pairs de la mesure), réglez la valeur de grille 
de quantification sur une blanche avec un 
décalage de 960 tics.
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Options

Les autres options de quantification incluent :

Option Swing : lorsque vous sélectionnez cette 
option, tous les pas de grille sont décalés du 
pourcentage spécifié (de 0 à 300) pour obtenir 
une ambiance swing. La valeur 0 % ne produit 
aucun swing, la valeur 100 % produisant une 
ambiance swing ternaire. Les valeurs supérieures 
à 100 % réduisent progressivement le swing 
jusqu'au maximum de 300 %, seuil à partir 
duquel tous les pas de grille sont décalés vers le 
pas suivant de la grille.

Include Within : lorsque cette option est 
sélectionnée, les attaques et les relâchements ne 
sont quantifiés que s'ils se trouvent dans le 
pourcentage spécifié autour de la grille de 
quantification. Cette option permet de nettoyer 
les temps forts sans toucher aux notes swinguées 
ou très fortement décalées par rapport au tempo.

La figure 30 illustre une grille de quantification 
définie sur la noire, l'option Include Within 
étant réglée sur 50 %. Seuls les attaques et les 
relâchements tombant dans la zone ombrée 
(équivalente à une croche de part et d'autre de 
chaque battement) sont quantifiés.

Exclude Within : lorsque cette option est 
sélectionnée, les attaques et les relâchements ne 
sont pas quantifiés s'ils se trouvent dans le 
pourcentage spécifié autour de la grille de 
quantification. Cette option permet de préserver 
le feeling des notes proches du temps, tout en en 
corrigeant d'autres qui sont très éloignées du 
tempo.

La figure 31 illustre une grille de quantification 
définie sur la noire, l'option Exclude Within 
étant réglée sur 25 %. Les attaques et les 
relâchements qui tombent sur la zone ombrée 
(équivalente à une double croche de part et 
d'autre de chaque tempo) ne sont pas quantifiés.

Strength : lorsque cette option est cochée, les 
notes sont déplacées sur la grille de 
quantification, du pourcentage indiqué. 
Les faibles pourcentages préservent le feeling 
d'origine des notes, les pourcentages élevés 
alignent les notes plus rigidement sur la grille.

Grille à la croche, swing à 100 %

Tous les autres points sont
décalés par la fonction Swing

Swing à 0 %
(480 tics)

Swing à 
100 %

Figure 30.  Option Include Within

Figure 31.  Option Exclude Within
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Exemples de quantification 
par grille

Les exemples qui suivent illustrent certaines des 
utilisations les plus courantes de la commande 
Grid Quantize.

Si vous envisagez de lire en boucle pendant la 
quantification, vous pouvez désélectionner 
Options > Link Timeline and Edit Selection. 
Ceci garantit que la région de lecture ne change 
pas lorsque les notes sélectionnées sont 
déplacées en cours de quantification et 
d'annulation.

Quantification stricte

Pour quantifier à la double croche, de façon 
stricte :

1  Sélectionnez la région des notes MIDI à 
quantifier.

2  Choisissez Event > MIDI > Grid/Groove 
Quantize.

3  Dans la zone What to Quantize, cochez 
l'option Attacks. Pour quantifier également les 
durées de notes, cochez l'option Releases.

4  Dans le menu déroulant Quantize Grid, 
sélectionnez des doubles croches (1/16). Vérifiez 
que les autres options : Tuplet, Offset Grid By et 
Swing ne sont pas cochées.

5  Assurez-vous que les options Quantize 
restantes sont bien désélectionnées.

6  Cliquez sur Apply.

Quantification préservant le feeling 
d'origine

Vous pouvez effectuer une quantification moins 
stricte, préservant le feeling d'origine de vos 
pistes MIDI enregistrées :

Pour effectuer la quantification tout en préservant 
le feeling d'origine :

1  Sélectionnez la région des notes MIDI à 
quantifier.

2  Choisissez Event > MIDI > Grid/Groove 
Quantize.

3  Dans la zone What to Quantize, cochez 
l'option Attacks. Pour quantifier également les 
durées de notes, cochez l'option Releases.

4  Dans le menu déroulant Quantize Grid, 
sélectionnez la valeur de note à utiliser. 

5  Assurez-vous que les autres options Tuplet, 
Offset Grid By et Swing ne sont pas 
sélectionnées.

6  Sélectionnez l'option Exclude Within et entrez 
une valeur entre 10 et 15 %.

7  Sélectionnez l'option Strength et entrez une 
valeur entre 70 et 80 %.

8  Assurez-vous que les options Quantize 
restantes sont bien désélectionnées.

9  Cliquez sur Apply.

10  Ecoutez les modifications. Si vous n'êtes pas 
satisfait, annulez-les et essayez d'autres valeurs 
pour les options Exclude Within et Strength.

Après la quantification, vous pouvez utiliser 
l'option Restore Performance pour revenir à 
la version d'origine (voir Restore 
Performance, page 686.)
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Quantification avec Swing

Si vous travaillez avec des charleys ou des lignes 
de basse MIDI, vous pouvez appliquer davantage 
de swing à la piste.

Pour quantifier à la croche avec une ambiance 
swing :

1  Sélectionnez la région des notes MIDI à 
quantifier.

2  Choisissez Event > MIDI > Grid/Groove 
Quantize.

3  Dans la zone What to Quantize, cochez 
l'option Attacks. Pour quantifier également les 
durées de notes, cochez l'option Releases.

4  Dans le menu déroulant Quantize Grid, 
sélectionnez des croches (1/8). 

5  Cochez l'option Swing et entrez le 
pourcentage désiré :

• Pour un swing léger, utilisez 12 %.

• Pour un swing plus prononcé, utilisez 
24 %.

• Pour un swing ternaire, utilisez 50 à 75 %.

6  Assurez-vous que les options Tuplet, Offset 
Grid By et Randomize ne sont pas sélectionnées. 

7  Cliquez sur Apply.

8  Ecoutez les modifications. Si vous n'êtes pas 
satisfait, annulez-les et essayez avec un autre 
pourcentage de swing.

Quantification avec Randomize

Si vous avez l'impression que les notes sonnent 
de façon trop mécanique ou trop sur le tempo, 
utilisez l'option Randomize de la fenêtre 
Quantize pour les rendre plus naturelles.

Pour « humaniser » le feeling rythmique des 
notes :

1  Sélectionnez la région des notes MIDI à 
quantifier.

2  Choisissez Event > MIDI > Grid/Groove 
Quantize.

3  Dans la zone What to Quantize, cochez 
l'option Attacks. Pour quantifier également les 
durées de notes, cochez l'option Releases.

4  Dans le menu déroulant Quantize Grid, 
sélectionnez la valeur de note à utiliser. 

5  Sélectionnez l'option Randomize et entrez une 
valeur de 5 %.

6  Cliquez sur Apply.

7  Ecoutez les modifications. Si vous n'êtes pas 
satisfait, annulez-les et essayez avec un autre 
pourcentage d'événement aléatoire.

Essais de quantification

Lorsque vous utilisez la commande Quantize, il 
se peut que vous deviez essayer différentes 
combinaisons avec les paramètres pour obtenir 
les résultats souhaités. Essayez différentes 
valeurs pour les options Include et Exclude 
Within, ainsi que l'option Strength ; ces 
paramètres déterminent quelles notes sont 
concernées et dans quelle mesure elles sont 
modifiées. Vous pouvez également utiliser le 
paramètre Randomize, qui ajoute un côté 
aléatoire à la quantification, pour rendre le 
feeling des pistes moins mécanique.
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Groove Quantize

La fenêtre Grid/Groove Quantize permet 
d'appliquer une quantification de groove si vous 
sélectionnez un modèle groove dans le menu 
déroulant Quantize Grid. La commande Groove 
Quantize permet de régler les emplacements des 
notes MIDI ainsi que leurs durées selon un 
modèle Groove plutôt qu'une grille de 
quantification stricte. Les modèles Groove 
extraient le feeling rythmique spécifique d'une 
performance enregistrée afin de l'appliquer à 
une séquence MIDI. Il est possible de créer des 
modèles DigiGroove à l'aide de Beat Detective.

Modèles Groove

Les modèles Groove (par exemple les modèles 
DigiGroove) sont des « cartes de 
quantification » dérivées de performances 
musicales réelles. L'aspect rythmique de chaque 
interprétation est analysé et sauvegardé sous 
forme de modèle de groove. Ces modèles 
peuvent être utilisés pour transférer le feeling 
d'une performance particulière vers les données 
MIDI (Timing, Duration et Velocity).

Il est possible de créer des modèles DigiGroove à 
l'aide de Beat Detective. Ce dernier analyse un 
fichier audio ou MIDI à la recherche de pics de 
transitoire, en fonction d'un seuil défini et 
affecte les relations rythmiques à un modèle de 
960 parties par quart de note (ppq). Ce modèle 
peut être utilisé avec Groove Quantize et Beat 
Detective.

De plus, les modèles DigiGroove sont 
disponibles chez Digidesign et d'autres 
fabricants. 

Fenêtre MIDI Operations, Grid/Groove Quantize
(modèle groove sélectionné)

Pour plus d'informations sur Beat Detective 
et la création de modèles Groove, 
reportez-vous au chapitre 24, Beat 
Detective.

Les modèles Feel Injector Templates de 
Numerical Sound (960 ppq) sont pris en 
charge par Pro Tools, mais pas les modèles 
DNA Groove Templates (192 ppq).
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Grille de quantification

Menu déroulant Quantize Grid : détermine le 
modèle groove à utiliser pour la quantification. 
Tous les fichiers de modèles Groove du dossier 
Grooves sont disponibles dans le menu 
déroulant Quantize Grid. 

Le chemin du répertoire Grooves est : 

• Sous Windows : C:\Program Files\ 
Digidesign\Pro Tools\Grooves

• Sous Mac : Applications/Digidesign/ 
Pro Tools/Grooves

Si vous organisez vos modèles Groove en 
sous-dossiers dans le dossier Groove, ceux-ci 
apparaissent sous forme de sous-menus dans le 
menu contextuel. Lorsque vous sélectionnez un 
modèle, des informations spécifiques à celui-ci 
relatives au temps et à la durée (en nombre de 
mesures) s'affichent en dessous du menu 
déroulant.

Show Comments : le champ Comments affiche 
les commentaires enregistrés avec le modèle 
Groove depuis Beat Detective. Vous ne pouvez 
pas modifier ce champ dans la fenêtre 
Grid/Groove Quantize. En revanche, cela est 
possible lorsque vous enregistrez un modèle 
Groove à partir de la page Groove Quantize.

Pre-Quantize : permet d'effectuer une 
quantification de type hard sur les notes MIDI 
sélectionnées en fonction d'une grille de 
doubles croches avant d'appliquer la commande 
Groove Quantize. 

Options

Timing : activez cette option pour appliquer un 
modèle Groove Quantize aux notes MIDI 
sélectionnées. Faites glisser le curseur pour faire 
varier le niveau de quantification appliqué à la 
sélection. S'il est réglé sur 0 %, il n'existe aucun 
effet sur le timing. Par contre, s'il est réglé sur 
100 %, les notes sont déplacées vers la position 
des modèles sous-jacents. Sur 200 %, les notes 
sont déplacées vers la position correspondant au 
tic, soit deux fois la différence entre la position 
de la note d'origine et celle de l'événement du 
modèle référencé. 

Ainsi, si vous lisez une note à la mesure 1|1|060 
(un seizième de note) et que l'événement du 
modèle correspondant a la mesure 1|1|073, un 
timing sur 100  % décale la note vers 1|1|073 
(sur 200 %, la note est décalée vers 1|1|086). 

Par défaut, le curseur Timing est réglé sur 100 %.

Duration : activez cette option pour influencer la 
durée des notes MIDI sélectionnées. Sur 100 %, 
les durées changent pour être en accord avec le 
modèle Groove actuel. Sur 200 %, les durées 
varient en fonction du rapport entre la durée 
d'origine des notes sélectionnées et les durées 
dans le modèle. 

Par défaut, le curseur Duration est réglé sur 
100 %.

Beat Detective ne permet pas l'extraction 
d'informations relatives aux durées 
provenant d'interprétations audio. Les 
modèles DigiGroove créés via Beat Detective 
contiennent une valeur de durée qui 
équivaut à 50 % de la résolution du modèle 
sélectionné (voir Définition d'une sélection 
pour le Beat Detective, page 621).
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Vitesse activez cette option pour influencer la 
vélocité des notes MIDI sélectionnées. Un 
curseur réglé sur 0 % n'affecte aucunement les 
vélocités sélectionnées. En revanche, sur 100 %, 
toutes les vélocités changent pour être en accord 
avec le modèle Groove actuel. Sur 200 %, les 
vélocités sont exagérées avec pour effet de 
monter le volume des notes fortes et de baisser 
celui des notes faibles. 

Ainsi, dans le cas de deux notes adjacentes avec 
des vélocités toutes les deux égales à 80 et pour 
lesquelles les vélocités du modèle sont égales 70 
et 90 respectivement, le réglage du curseur sur 
200 % permet d'obtenir des vélocités de 60 
et 100.

Par défaut, le curseur Velocity est réglé sur 
100 %.

Réglages du curseur

Pour enregistrer le modèle Groove en tenant 
compte des réglages du curseur dans la zone 
Options :

1  Dans la fenêtre Grid/Groove Quantize, 
sélectionnez Recall with Template pour 
restaurer les options Groove Quantize à leur 
valeurs définies dans le modèle actuel.

2  Cliquez sur le bouton Save.

3  Tapez ou modifiez les commentaires que vous 
souhaitez enregistrer avec le modèle.

4  Effectuez l'une des opérations suivantes :

• Pour enregistrer le modèle Groove en 
tenant compte des réglages du curseur dans 
la zone Options, cliquez sur Save.

– ou –

• Pour faire une copie du modèle Groove en 
tenant compte des réglages du curseur dans 
la zone Options, cliquez sur Save as. 
Lorsque la boîte de dialogue Save s'ouvre, 
attribuez un nom à la copie et cliquez 
sur Save.

Vous risquez de perdre les réglages du curseur si 
vous effectuez l'une des opérations suivantes 
sans enregistrer les paramètres au préalable :

• Sélection d'une autre fenêtre MIDI 
Operations

• Fermeture de la fenêtre MIDI Operations

• Sélection d'un autre modèle Groove

Application de modèles Groove

Les modèles Groove peuvent être de toute 
longueur et peuvent être appliqués à un nombre 
illimité de mesures. En général, vous appliquez 
les modèles Groove aux sélections de même 
longueur et de même temps. Cependant, les 
modèles Groove peuvent être appliqués à 
différents temps ; un modèle Groove en 6/8 peut 
par exemple être appliqué à une sélection en 
4/4. De plus, il n'est pas nécessaire de démarrer 
sur le temps fort lors de la sélection afin 
d'appliquer un modèle Groove.

Pour appliquer un modèle Groove Quantize :

1  A l'aide du sélecteur ou d'un outil 
d'accrochage, sélectionnez les notes MIDI 
auxquelles vous souhaitez appliquer un modèle 
Groove Quantize.

2  Choisissez Event > MIDI > Grid/Groove 
Quantize.

Enregistrement des réglages du modèle Groove de 
l'utilisateur
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3  Sélectionnez un modèle Groove dans le menu 
déroulant Grid Quantize.

4  Activez les options Timing, Duration et 
Velocity et réglez leurs valeurs en pourcentage à 
l'aide des curseurs.

5  Si nécessaire, activez l'option Pre-Process 
Using Quantize.

6  Cliquez sur Apply. 

Affectation de modèles Groove

Pro Tools applique des modèles Groove en 
fonction du début du morceau. Ainsi, un 
modèle Groove à deux mesures est répété 
automatiquement lorsqu'il rencontre une 
mesure impaire dans la session (mesure 1, 3, 5, 
7, etc.).

Affectation du modèle pour les temps 
identiques et les mesures impaires

Si un modèle Groove à deux mesures est 
appliqué à une sélection d'une mesure ayant le 
même temps, seule la première mesure du 
modèle est utilisée. Par contre, si la sélection 
exclut les limites de la mesure, par exemple 
1|2|000 à 2|1|000, le modèle Groove ne modifie 
que les notes sélectionnées.

Figure 32.  Modèle DigiGroove (dérivé de l'audio) appliqué à une série de quadruples croches et avec les options 
Timing et Velocity définies toutes les deux sur 100 %

Exemple de répétition du modèle Groove à deux 
mesures

Modèle 
Groove à 

deux 
mesures

Modèle 
Groove à 

deux 
mesures

Modèle 
Groove à 

deux 
mesures

Modèle 
Groove à 

deux 
mesures

Application d'un modèle Groove à deux mesures à une 
seule mesure impaire

Mesure 1 à 4/4 Mesure 2 à 4/4 

(modèle Groove)

1ère mesure 4/4 
sélectionnée

(non utilisée)
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Affectation du modèle pour les temps 
identiques et les mesures paires

Si la sélection démarre sur une mesure paire, sur 
la partie adéquate du modèle Groove sera 
utilisée. Ainsi, si la sélection contient deux 
mesures et que la première est paire, le modèle 
est d'abord appliquée à la deuxième mesure puis 
à la première.

Affectation du modèle à des temps non 
identiques

Lorsque les modèles Groove et les sélections de 
piste se font sur des temps non identiques, le 
modèle est répété ou tronqué pour correspondre 
au nombre de battements de la sélection.

Ainsi, si le modèle Groove contient moins de 
battements que la sélection, le modèle est répété 
pour compenser la différence. C'est le cas, par 
exemple, lorsqu'un modèle à une mesure 6/8 est 
appliquée à une seule mesure 4/4 sélectionnée.

Ainsi, si le modèle Groove contient plus de 
battements que la sélection d'une piste, il 
n'utilise que le nombre nécessaire de 
battements. C'est le cas, par exemple, lorsqu'un 
modèle à une mesure 6/4 est appliquée à une 
mesure 4/4 sélectionnée.

Affectation du modèle dans le cas de temps 
mixtes

Si la sélection contient des temps mixtes, le 
modèle Groove est toujours affecté de façon à 
aligner les temps forts. Ainsi, si le modèle 
Groove est composé d'une mesure 4/4 et qu'elle 
est appliquée à une mesure 4/4 sélectionnée 
suivie d'une mesure 3/8 et d'une mesure 3/4, le 
temps fort du modèle Groove est aligné sur les 
temps forts de la sélection et seul le nombre 
approprié de battements du modèle Groove est 
utilisé.

Application d'un modèle Groove à deux mesures à une 
seule mesure paire

Application d'un modèle Groove à une mesure 6/8 à 
une mesure 4/4 sélectionnée

Mesure 1 à 4/4 Mesure 2 à 4/4
(modèle Groove)

1ère mesure 4/4 

(non utilisée)

sélectionnée

Mesure 1 à 6/8

1ère mesure 4/4 

(modèle Groove)

1ère mesure 6/8 
répétée (battements 
3-6 non utilisés)

sélectionnée

Application d'un modèle Groove à une mesure 6/4 à 
une mesure 4/4 sélectionnée

1ère mesure 6/4 

1ère mesure 4/4 

(modèle Groove)
(battements 5-6 non utilisés)

sélectionnée
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Restore Performance
La commande Restore Performance rétablit l'état 
d'origine de toutes les notes MIDI sélectionnées 
(c'est-à-dire les notes obtenues lors du premier 
enregistrement ou insérées manuellement) 
même après avoir enregistré la session ou 
supprimé la liste des dernières annulations. 

Les attributs des notes MIDI suivants peuvent 
être restaurés :

Timing (Quantization) : restaure les temps de 
début d'origine des notes sélectionnées. 
Cela modifie la durée des notes sélectionnées si 
l'option Duration n'est pas activée. 

Duration : restaure les durées d'origine des notes 
sélectionnées. Si l'option Timing (Quantization) 
n'est pas activée, la position de début des notes 
sélectionnées n'est pas restaurée et leur position 
de fin ne peut pas être modifiée. 

Velocity : restaure les vitesses d'origine des notes 
sélectionnées.

Pitch : restaure les hauteurs d'origine des notes 
sélectionnées.

Pour restaurer le temps, la durée, la vitesse ou la 
hauteur d'origine des notes MIDI sélectionnées :

1  Sélectionnez les notes MIDI à restaurer.

2  Choisissez Event > MIDI > Restore 
Performance.

3  Sélectionnez les attributs des notes à restaurer.

4  Cliquez sur Apply.

Application d'un modèle Groove à une mesure 4/4 à 3 
mesures à des temps différents

Il est possible de réinitialiser la grille du 
modèle Groove en ajoutant un marqueur de 
temps (il peut s'agir du même temps). 
Le modèle Groove redémarre à l'endroit du 
marqueur quel que soit le nombre de 
mesures et sans tenir compte des 
changements de temps.

3 mesures sélectionnées à 

(modèle Groove)
Mesure 1 à 4/4

(modèle Groove)
Mesure 1 à 4/4

(modèle Groove)
Mesure 1 à 4/4

(non utilisé)

des temps différents

Fenêtre MIDI Operations, page Restore Performance

La commande Restore Performance ne peut 
pas être annulée.
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Toute modification apportée aux commandes 
standard Quantize, Groove Quantize, Change 
Duration, Change Velocity ou Change Pitch est 
alors annulée et les réglages d'origine sont 
restaurés. Les notes enregistrées après avoir 
activé l'option Input Quantize sont également 
restaurées (voir Input Quantize, page 696).

Suppression d'Input Quantize

Restore Performance peut servir à supprimer une 
quantification en entrée. Ainsi, si vous effectuez 
un enregistrement avec l'option Input Quantize 
activée, il est possible de le restaurer tel qu'il 
était lors de l'interprétation.

Flatten Performance
La commande Flatten Performance verrouille 
l'interprétation actuelle des notes sélectionnées, 
créant ainsi un état de restauration pour les 
attributs des notes spécifiées lors de l'utilisation 
de l'option Restore Performance.

Pour aplanir des notes :

1  A l'aide d'un outil d'accrochage ou du 
sélecteur, sélectionnez les notes MIDI à aplanir.

2  Choisissez Event > MIDI > Flatten 
Performance pour ouvrir la page Restore 
Performance.

3  Sélectionnez les attributs des notes à aplanir. 
Pour obtenir la description de ces attributs, 
reportez-vous à la section Flatten Performance, 
page 687.

4  Cliquez sur Apply. 

Restore Performance n'annule pas les 
fonctions couper, copier et coller, ni ne 
déplace manuellement les notes MIDI.

Cette commande n'annule pas les 
modifications apportées à la durée lors du 
rognage du début d'une note. Le rognage du 
début d'une note modifie essentiellement 
son temps, ce qui équivaut, dans Pro Tools, 
à la déplacer manuellement.

Pour plus d'informations à propos d'Input 
Quantize, reportez-vous à la section Input 
Quantize, page 696.

Fenêtre MIDI Operations, page Flatten Performance

La commande Flatten Performance ne peut 
pas être annulée.
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Change Velocity
La commande Change Velocity ajuste 
automatiquement les vélocités d'attaque et de 
relâchement des notes MIDI sélectionnées. 
Utilisez cette commande pour rendre des notes 
plus fortes ou moins fortes, ou pour créer des 
crescendos ou des diminuendos.

Vous pouvez également éditer manuellement les 
vélocités à l'aide du crayon et des outils 
d'accrochage (voir Edition manuelle des notes 
MIDI, page 651).

Set All To : règle toutes les vélocités à la valeur 
spécifiée (1-127).

Add : ajoute la quantité spécifiée (1 à 127) aux 
valeurs de vélocité existantes.

Subtract : soustrait la quantité spécifiée (1 à 127) 
aux valeurs de vélocité existantes.

Scale By : multiplie toutes les valeurs de 
vélocités par un certain pourcentage (1 à 
400 %).

Change Smoothly : permet de passer 
progressivement d'une valeur de vélocité à une 
autre.

Fenêtre MIDI Operations, page Change Velocity

Les valeurs de vélocité ont généralement une 
incidence sur le niveau sonore des notes 
MIDI. Selon la manière dont elles sont 
assignées aux instruments MIDI, les 
vélocités peuvent également affecter 
d'autres aspects du son d'un instrument 
(comme par exemple la coupure de filtre, les 
enveloppes et les modulations).

Les paramètres de la fenêtre Change 
Velocity sont sauvegardés avec chaque 
session. Pour enregistrer vos paramètres 
favoris comme paramètres par défaut pour 
vos futures sessions, enregistrez la session 
comme un modèle (voir Création de modèles 
de session personnalisés, page 109).

Vous pouvez également changer la vélocité 
en temps réel, de manière non destructive, à 
l'aide des propriétés MIDI en temps réel. 
Pour plus d'informations, reportez-vous à la 
section Propriétés MIDI en temps réel, 
page 700.

S'il existe des options permettant d'ajuster 
les vélocités d'attaque et de relâchement des 
notes, la plupart des périphériques MIDI 
ignorent les informations de vélocité de 
relâchement. Pour savoir si votre instrument 
prend en charge la vélocité de relâchement, 
veuillez consulter la documentation du 
fabricant.
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Change Smoothly by Percentage : permet de 
faire passer progressivement les valeurs de 
vélocité d'un pourcentage à un autre. 

La courbe régissant cette transformation peut 
être ajustée (+/-99) pour intervenir sur sa 
progressivité.

Limit To : lorsque cette option est cochée, elle 
restreint la commande Change Velocity à une 
valeur minimale et maximale.

Randomize : lorsque cette option est cochée, la 
commande Change Velocity crée des valeurs de 
vélocité aléatoires, en tenant compte du 
pourcentage spécifié. Par exemple, utiliser une 
valeur de 64 pour Set all to, et une valeur 
Randomize de 50 %, produit au hasard des 
valeurs de vélocité comprises entre 48 et 80 
(+/-25 % de la valeur de vélocité).

Plages de vélocité

Pour être valides, les valeurs de vélocité de notes 
MIDI doivent être comprises entre 1 et 127. La 
commande Change Velocity ne crée jamais de 
valeurs hors de cette fourchette ; 1 sera toujours 
la valeur la plus basse et 127, la plus élevée. Cela 
signifie que, dans certains cas, la commande 
Change Velocity peut n'avoir aucun effet sur 
une note donnée.

Par exemple, si une note d'une vélocité de 64 est 
multipliée par 200 %, la nouvelle valeur de 
vélocité sera de 127. Si vous tentez de multiplier 
ou d'augmenter encore la vélocité, vous 
n'obtiendrez aucune modification.

Vélocités de fondu

Pour faire varier les vélocités progressivement 
dans le temps :

1  Sélectionnez la région de notes MIDI à éditer.

2  Choisissez Event > MIDI > Change Velocity.

3  Sélectionnez l'option Change Smoothly, la 
plage étant définie entre 127 et 0.

4  Cliquez sur Apply.

Conservation des relations de vélocité existantes

Pour préserver en partie les valeurs relatives de 
vélocité existantes tout en réalisant des fondus 
de vélocité, utilisez l'option Change Smoothly 
by Percentage. La figure 33 illustre la différence 
entre les deux options Change Smoothly.

Figure 33.  Option Change Smoothly by Percentage

Vélocités d'origine

Après l'option Change Smoothly by Percentage, 

Après l'option Change Smoothly, de 100 à 10

de 100 % à 20 %
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Multiplication des vélocités

Il est fréquent que les valeurs de vélocité 
existantes présentent la relation souhaitée entre 
elles, mais qu'elles soient, dans leur ensemble 
soit trop faibles, soit trop élevées. Dans ce cas, 
vous pouvez utiliser l'option Scale By.

Par exemple, pour augmenter les valeurs de 
vélocité de 20 % :

1  Sélectionnez la région de notes MIDI à éditer.

2  Choisissez Event > MIDI > Change Velocity.

3  Sélectionnez l'option Scale By, en réglant la 
valeur de pourcentage sur 120.

4  Cliquez sur Apply.

Change Duration
La commande Change Duration modifie la 
durée des notes MIDI sélectionnées. Utilisez-la 
pour modifier l'articulation des notes 
sélectionnées en les rendant plus staccato ou 
legato.

Fenêtre MIDI Operations, page Change Duration

Les paramètres de la page Change Duration 
sont sauvegardés avec chaque session. Pour 
enregistrer vos paramètres favoris comme 
paramètres par défaut pour vos futures 
sessions, enregistrez la session comme un 
modèle (voir Création de modèles de session 
personnalisés, page 109).

Vous pouvez également changer la durée 
des notes en temps réel, de manière non 
destructive, à l'aide des propriétés MIDI en 
temps réel. Pour plus d'informations, 
reportez-vous à la section Propriétés MIDI 
en temps réel, page 700.
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Set/Add/Subtract/Scale

Set All To : Attribue une même durée, spécifiée 
en noires et en tics, à toutes les notes.

Add : Ajoute à toutes les durées de notes une 
même valeur, spécifiée en noires et en tics.

Subtract : soustrait à toutes les durées de notes 
une même valeur, spécifiée en noires et en tics.

Scale By : multiplie les durées de notes d'un 
certain pourcentage (1 à 400 %).

Legato

Activez l'option Legato pour ajouter un effet de 
legato à la sélection MIDI. Sélectionnez Gap ou 
Overlap dans le menu déroulant Legato et entrez 
la valeur d'espacement ou de chevauchement 
désirée en temps et tics.

Remove Overlap

Cette option a pour effet de supprimer le 
chevauchement de note pour toutes les notes de 
la même hauteur. Elle diffère de l'option Legato 
dans la mesure où elle préserve les notes qui ne 
se chevauchent pas (qu'elles aient la même 
hauteur ou non). Pour créer un espace entre les 
notes qui se chevauchaient auparavant, entrez 
la valeur d'espacement désirée en temps et tics. 

Transform Sustain Pedal To Duration

Cette option prolonge les notes émises lorsque 
la pédale de tenue (contrôleur 64) est abaissée 
(0 à 63) jusqu'au moment où la pédale de tenue 
remonte (64 à 127). Activez l'option Delete 
Sustain Pedal Events pour convertir les 
événements de pédale de tenue en durées de 
note. Cette opération peut faciliter 
considérablement le travail d'édition tout en 
préservant l'effet de performance voulu. En cas 

de suppression en cours d'édition d'un 
événement d'activation de la pédale de tenue, 
par exemple, la performance MIDI suivante perd 
son effet de legato.

Options Change Continuously

Cette option permet de changer la durée des 
notes de façon continue en tics ou en 
pourcentage. Pour modifier la forme du 
changement, réglez le curseur de la courbe.

Change Continuously in Ticks : permet de faire 
passer progressivement les durées de notes d'une 
valeur à l'autre. Les valeurs de durée sont 
spécifiées en noires et en tics.

Change Continuously by Percentage : permet de 
faire passer progressivement les longueurs de 
notes d'un pourcentage à l'autre. 

La courbe régissant cette transformation peut 
être ajustée (+/-99) pour intervenir sur sa 
progressivité.

Limit Range : lorsque cette option est cochée, 
elle restreint la commande Change Duration à 
une valeur minimale et maximale (exprimée en 
noires et en ticks).

Randomize : lorsque cette option est cochée, la 
commande Change Duration crée des valeurs 
aléatoires, en tenant compte du pourcentage 
spécifié. Par exemple, utiliser la fonction Set all 
to avec une valeur de 480 tics et une valeur 
Randomize de 50 %, produit des durées 
aléatoires, comprises entre 360 et 600 (+/-25 % 
de la valeur de durée).
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Exemples d'application de 
changements de durée

Pour rendre les notes plus staccato :

1  Sélectionnez la région de notes MIDI à éditer.

2  Choisissez Event > MIDI > Change Duration.

3  Sélectionnez l'option Scale By avec la valeur 
en pourcentage de 50.

4  Cliquez sur Apply. La durée des notes 
sélectionnées est réduite de 50 %.

Avec cette option, il se peut que vous deviez 
essayer plusieurs valeurs de pourcentage avant 
d'obtenir l'effet recherché.

Pour donner plus de legato aux notes :

1  Sélectionnez la région de notes MIDI à éditer.

2  Choisissez Event > MIDI > Change Duration.

3  Sélectionnez l'option Legato.

4  Dans le menu déroulant Legato, sélectionnez 
Overlap.

5  Entrez 0|000 comme valeur de 
chevauchement.

6  Cliquez sur Apply. 

Les points de fin des notes sélectionnées sont 
étendus jusqu'au point de début de la note 
suivante, ce qui élimine l'espace entre chaque 
note.

Transpose
Alors que les outils d'accrochage servent à 
transposer manuellement plutôt des notes MIDI 
individuelles ou de petits groupes de notes, la 
commande Transpose peut s'utiliser sur des 
pistes et des régions MIDI entières. L'une des 
utilisations les plus courantes de la commande 
Transpose est le changement de tonalité de vos 
pistes MIDI. Vous pouvez définir un groupe de 
pistes MIDI devant être transposées, en veillant 
à exclure les pistes de batterie du groupe (les 
transposer changerait les sons de batterie). Vous 
pouvez également transposer dans la tonalité.

Appuyez sur Alt+P (Windows) ou sur 
Option+P (Mac) pour accéder à la fenêtre 
Change Duration.

Vous pouvez également transposer des notes 
MIDI en temps réel, de manière non 
destructive, à l'aide des propriétés MIDI en 
temps réel. Pour plus d'informations, 
reportez-vous à la section Propriétés MIDI 
en temps réel, page 700.

Fenêtre MIDI Operations, page Transpose
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Transpose By (Octaves) : transpose les notes 
sélectionnées de +/-10 octaves.

Transpose By (Semitones) : effectue une 
transposition chromatique des notes 
sélectionnées vers le haut ou vers le bas, jusqu'à 
+/-127demi-tons.

Transpose (From et To) : transpose les notes 
sélectionnées par demi-tons, en se basant sur la 
différence entre hauteur d'origine et la hauteur 
désirée. Ainsi, la transposition de C3 à F#3 
transpose les notes vers le haut de six demi-tons 
(ou trois tons).

Transpose All Notes To transpose toutes les 
notes sélectionnées à la même hauteur. 
Servez-vous du curseur ou de la zone de saisie 
des chiffres pour spécifier la hauteur à laquelle 
vous souhaitez transposer toutes les notes 
sélectionnées.

Transpose In Key : transpose les notes 
sélectionnées en montant ou en descendant de 
tonalité par ton (en se basant sur la règle des 
signatures de tonalité).

Pour transposer des notes MIDI :

1  Si vous envisagez de transposer un groupe de 
pistes, activez le groupe d'édition.

2  Sélectionnez les notes à transposer.

3  Choisissez Event > MIDI > Transpose.

4  Sélectionnez l'option pour Transpose (By, 
From and To, All Notes To, ou In Key).

5  Paramétrez les champs de hauteur 
correspondants.

Si le champ de hauteur est sélectionné, jouez 
une note sur votre contrôleur MIDI pour l'entrer 
automatiquement comme valeur de hauteur.

6  Cliquez sur Apply.

Pour transposer toutes les notes d'une piste vers 
le bas d'une octave :

1  A l'aide du sélecteur, cliquez deux fois sur la 
piste pour sélectionner toutes les notes.

2  Choisissez Event > MIDI > Transpose.

3  Sélectionnez l'option Transpose By.

4  Entrez la valeur -1 octave.

5  Cliquez sur Apply.

Pour transposer des notes sélectionnées dans la 
tonalité :

1  Sélectionnez les notes à transposer.

2  Choisissez Event > MIDI > Transpose.

3  Sélectionnez Transpose in Key.

4  Sur l'échelle de tonalité, ajustez le curseur 
(ou saisissez un chiffre) sur la tonalité sur 
laquelle vous souhaitez transposer la sélection. 
Par exemple, pour transposer de trois tons plus 
bas, saisissez « –2 ».

5  Cliquez sur Apply.

Appuyez sur Alt+T (Windows) ou sur 
Option+T (Mac) pour ouvrir la fenêtre 
Transpose.



Guide de référence Pro Tools694

Select/Split Notes
La fenêtre Select/Split Notes offre un ensemble 
complet d'outils pour sélectionner et répartir des 
notes en fonction d'une multitude de critères. 
Vous disposez d'outils supplémentaires pour 
indiquer si les données sélectionnées sont 
copiées dans le Presse-papiers ou sur de 
nouvelles pistes, spécifier si les données sont 
réparties sur plusieurs nouvelles pistes ou sur 
une seule destination, et effectuer divers autres 
choix. 

Critères spécifiques à la hauteur de note

All Notes : sélectionne toutes les notes.

Notes Between : sélectionne les notes comprises 
entre les notes supérieure et inférieure spécifiées. 
Vous pouvez entrer les valeurs des notes sous 
forme de hauteur (C1–G8) ou de numéro de 
note MIDI (0–127).

Top : sélectionne la ou les notes les plus hautes 
de chaque accord.

Bottom : sélectionne la ou les notes les plus 
basses de chaque accord.

Autres critères

Vitesse : activez l'option Velocity pour définir la 
plage de vitesses utilisée pour sélectionner ou 
répartir des notes. Définissez les valeurs de 
vitesse minimale et maximale souhaitées. 

Duration : activez l'option Duration pour définir 
la plage de durées (en temps et tics) utilisée pour 
sélectionner ou répartir des notes. Définissez les 
valeurs de durée minimale et maximale 
souhaitées.

Position : activez l'option Position pour 
sélectionner ou répartir toutes les notes figurant 
dans la plage de positions relatives (en temps et 
tics) au sein de chaque barre. La valeur minimale 
détermine le début de la plage et la valeur 
maximale la fin de la plage.

Action

Select Notes : sélectionne les notes MIDI en 
fonction des critères spécifiés.

Split Notes: The Clipboard : copie les données 
sélectionnées dans le Presse-papiers 
uniquement.

Split Notes A New Track : copie toutes les 
données sélectionnées sur une seule nouvelle 
piste. Si la sélection inclut plusieurs pistes, le 
même nombre de pistes est créé. Les nouvelles 
pistes correspondent au type de la piste d'origine 
(Instrument ou MIDI). 

Fenêtre MIDI Operations, page Select/Split Notes
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Split Notes: A New Track per Pitch : copie toutes 
les données sélectionnées sur plusieurs 
nouvelles pistes (à raison d'une nouvelle piste 
pour chaque hauteur de note). Un zoom est 
appliqué aux nouvelles pistes pour permettre 
l'affichage d'une seule note. Si la sélection inclut 
plusieurs pistes, les données de chaque piste 
sont réparties séparément.

Include MIDI Controller Data : intègre toutes les 
données MIDI continues (y compris celles 
relatives au pitchbend et à l'aftertouch) sur la 
piste entière, sans restriction en matière de 
sélection temporelle.

Sélection et répartition de notes

Pour sélectionner et répartir des notes :

1  Effectuez l'une des opérations suivantes :

• A l'aide du sélecteur ou d'un outil 
d'accrochage, sélectionnez la plage de 
notes MIDI contenant les notes.

– ou –

• Pour affecter toutes les notes MIDI d'une 
piste, cliquez sur celle-ci avec le sélecteur. 
Le curseur d'édition se met alors à 
clignoter.

2  Choisissez Event > MIDI > Select/Split Notes. 

3  Définissez les critères relatifs à la hauteur de 
note.

4  Spécifiez les autres critères désirés (vélocité, 
durée et position).

5  Activez l'option Select ou Split, selon le cas. 

6  Dans le menu déroulant Split Notes, choisissez 
Copy ou Cut. 

7  Si vous répartissez les notes, sélectionnez 
l'option Copy ou Cut to destination.

8  Si vous répartissez les notes, activez l'option 
Include MIDI Controller Data. L'activation de 
cette option permet de prendre en compte 
toutes les données de contrôleur associées aux 
notes réparties sur les nouvelles pistes. 
Désélectionnez cette option si vous souhaitez 
uniquement répartir les données de note sur les 
nouvelles pistes. 

9  Cliquez sur Apply. 

Les propriétés en temps réel associées à la piste 
ou aux régions sont copiées sur les nouvelles 
pistes créées par la commande Select/Split 
Notes. 

Sélection d'une plage de hauteurs de 
notes

L'option Select/Split Notes est couramment 
utilisée pour sélectionner une seule note sur 
toute la longueur d'une région ou d'une piste. 
Ceci est particulièrement pratique si vous 
souhaitez sélectionner une note d'une piste de 
batterie MIDI (une charley, par exemple), et la 
modifier, sur la plage de temps sélectionnée, 
avec les commandes Quantize, Groove 
Quantize, Transpose ou Change Duration.

Pour ne sélectionner que la charley dans une piste 
de batterie Général MIDI :

1  Effectuez l'une des opérations suivantes :

• A l'aide du sélecteur ou d'un outil 
d'accrochage, sélectionnez la plage de 
notes MIDI contenant les notes.

– ou –

• Pour affecter toutes les notes MIDI d'une 
piste, cliquez sur celle-ci avec le sélecteur. 
Le curseur d'édition se met alors à 
clignoter.

2  Choisissez Event > MIDI > Select/Split Notes.
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3  Sélectionnez l'option Notes Between, la plage 
de note étant définie entre F#1 et F#1 (si le 
paramètre MIDI Note Display est réglé sur 
Standard Pitch).

Pour les percussions Général MIDI, la charley 
fermée est affectée au numéro de note MIDI 42 
(F#1 sur Standard Pitch). Si la charley de votre 
kit de batterie est affectée à une autre note, 
veillez à l'indiquer.

4  Cliquez sur Apply.

Sélection de notes dans un accord

L'opération Select/Split Notes sert également à 
ne sélectionner que les notes les plus hautes ou 
les plus basses d'un accord. Le plus souvent, 
seules les notes les plus hautes ou les plus basses 
d'un accord doivent être retouchées 
(augmentation de la vélocité ou transposition de 
la hauteur, par exemple).

Pour ne sélectionner que les notes les plus basses 
d'un accord :

1  Effectuez l'une des opérations suivantes :

• A l'aide du sélecteur ou d'un outil 
d'accrochage, sélectionnez la plage de 
notes MIDI contenant les notes.

– ou –

• Pour affecter toutes les notes MIDI d'une 
piste, cliquez sur celle-ci avec le sélecteur. 
Le curseur d'édition se met alors à 
clignoter.

2  Choisissez Event > MIDI > Select/Split Notes.

3  Sélectionnez l'option Bottom et laissez le 
nombre de notes défini sur 1.

4  Cliquez sur Apply.

Input Quantize
Lorsque l'option Input Quantize est activée, 
toutes les notes MIDI enregistrées sont 
automatiquement quantifiées.Vous pouvez également sélectionner toutes 

les notes ayant une hauteur spécifique sur 
une piste en utilisant le mini-clavier. Pour 
plus d'informations, reportez-vous à la 
section Sélection des notes MIDI, page 651.

Pour que des notes soient considérées 
comme un accord, leurs temps de début 
doivent se trouver au maximum à 
trente-deux tics les uns des autres.

Fenêtre MIDI Operations (page Input Quantize)

Utilisez Input Quantize for drum machine 
pour l'enregistrement de style boucle (voir 
Enregistrement en boucle et mode de fusion 
MIDI, page 359).
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Pour activer la quantification en entrée :

1  Choisissez Event > MIDI > Input Quantize.

2  Dans la page Input Quantize, sélectionnez 
Enable Input Quantize.

3  Configurez comme désiré les autres options de 
la page Input Quantize. Pour plus 
d'informations sur les options de quantification, 
consultez la section Grid/Groove Quantize, 
page 675. 

4  Lorsque vous avez terminé, fermez la fenêtre 
MIDI Operations.

Step Input
L'option Step Input permet d'utiliser un 
contrôleur MIDI pour entrer séparément des 
notes, étape par étape. Vous bénéficiez ainsi du 
contrôle précis de la position, de la durée et de la 
vélocité de la note. Avec MIDI Step Input, vous 
pouvez également créer des passages musicaux 
qui s'avéreraient difficiles à jouer avec 
exactitude ou encore à un tempo rapide. 

Pour entrer des notes MIDI avec Step Input 
(à l'aide d'un périphérique MIDI externe) :

1  Assurez-vous que votre périphérique MIDI 
externe est correctement branché et fonctionne 
avec Pro Tools.

2  Choisissez Event > MIDI > Step Input.

3  Sélectionnez l'option Enable.

4  Sélectionnez la piste MIDI ou la piste 
d'instrument voulue dans la menu déroulant 
Destination.

5  Choisissez la valeur de la note à entrer dans la 
zone Step Increment.

Fenêtre Step Input

Lorsque l'option Step Input est activée, 
chaque piste MIDI précédemment préparée 
à l'enregistrement quitte le mode de 
préparation à l'enregistrement et si la 
préférence Default Thru Instrument est 
définie, elle est désactivée.
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6  Jouez une note ou un accord sur votre 
instrument MIDI. Ceci a pour effet d'entrer la 
note et de passer au point d'insertion suivant.

Pour augmenter la longueur d'une note pendant 
l'utilisation de Step Input :

1  Jouez une note en continu sur votre 
instrument MIDI.

2  Choisissez la valeur de la note que vous voulez 
ajouter et appuyez sur le bouton Increment.

Relâchez la note sur votre clavier MIDI pour 
passer au point d'insertion suivant.

Commandes Step Input

La page Step Input propose les paramètres 
suivants :

Enable : la sélection de cette option ajoute des 
événements MIDI de destination lorsque vous 
jouez sur votre clavier MIDI externe. De plus, la 
piste MIDI précédemment préparée à 
l'enregistrement est désactivée. 

Si un instrument Thru par défaut est défini dans 
la page MIDI Preferences, il est désactivé si 
l'option Step Input est sélectionnée et réactivé si 
Step Input n'est plus désactivée.

Destination : permet de sélectionner la piste de 
destination de la phase Step Input à partir d'une 
liste déroulante de toutes les pistes MIDI dans 
votre session. 

Step Increment :

les options de la zone Step Increment 
permettent de définir l'espacement et la durée 
des événements MIDI entrés à l'aide de 
l'opération Step Input. Vous pouvez 
sélectionner n'importe quelle valeur de note, de 
la ronde à la quadruple croche (valeurs pointées 
comprises). 

Tuplet : permet d'entrer des groupes de notes 
« inhabituels », tels que les triolets ou 
quintolets. La longueur du tuplet est calculée à 
partir de la sélection de l'espacement de note et 
de la valeur Tuplet. Si, par exemple, une croche 
équivaut à 480 tics, des croches en triolet (3 pour 
2) donnent un espace de note de 320 tics 
(480 tics / 3 * 2).

Note Length : cette option permet de 
sélectionner la longueur de la note sous forme 
d'un pourcentage de la valeur d'espacement. Si, 
par exemple, une croche équivaut à 480 tics, une 
croche dont la durée atteint 80% correspond à 
une longueur de 384 tics.

Options

Use Input Velocity : lorsque cette option est 
sélectionnée, les notes MIDI sont enregistrées à 
la vitesse où vous les jouez sur votre clavier 
MIDI.

Set Velocity To : les notes MIDI sont enregistrées 
à la vitesse indiquée dans le champ Velocity. 
Vous définissez cette valeur au moyen du 
curseur.

Lorsqu'une note est ainsi jouée sur le clavier 
MIDI, l'option Next Step affiche Increment. 

Pourcentages de longueur de note

100% 80% 120%
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Enable Numeric Keypad Shortcuts : cette option 
permet de sélectionner les options Step Input à 
partir du pavé numérique. Pour plus 
d'informations, reportez-vous à la section « 
Raccourcis du pavé numérique », page 700.

Undo Step, Next Step et Redo Step

Servez-vous des boutons Undo Step et Next Step 
pour procéder aux opérations suivantes :

• Déplacer le point d'insertion suivant, soit 
en supprimant la note précédente, soit en 
avançant le point d'insertion à la valeur 
Step Increment.

• Allonger et raccourcir les notes qui sont 
jouées sur le contrôleur MIDI en ajoutant 
ou en supprimant des valeurs Step 
Increment. La valeur Step Increment peut 
être modifiée à mi-note pour créer une note 
avec une longueur de note hybride.

Utilisez le bouton Redo Step pour recommencer 
la séquence des opérations précédemment 
annulées. 

Undo Step : lorsque vous avez relâché la note 
précédente sur le clavier MIDI et que le point 
d'insertion a été décalé vers la note suivante, la 
fonction Undo Step supprime entièrement la 
dernière note.

Lorsqu'une note est jouée, Undo Step affiche 
alors Decrement et supprime la dernière valeur 
Step Increment ajoutée à la note actuellement 
jouée.

Next Step (ou Increment) : si aucune note n'est 
jouée au clavier MIDI, Next Step passe au point 
d'insertion correspondant à la valeur Step 
Increment et insère une pause musicale.

Lorsqu'une note est jouée au clavier MIDI, Next 
Step affiche alors Increment et ajoute la valeur 
Step Increment à la note jouée, ce qui l'allonge 
d'autant. 

Tandis que la note est jouée, la valeur Step 
Increment peut être modifiée, vous permettant 
de créer des notes de toute longueur.

Redo Step : réinsère la dernière note supprimée 
à l'aide de l'opération Undo Step. 

Déclenchement des boutons Undo Step, Next 
Step, ou Redo Step

Les boutons Undo Step, Next Step et Redo Step 
peuvent être définis de manière à être 
déclenchés par un synthétiseur MIDI externe, 
une boîte à rythme ou tout autre contrôleur. 

Pour définir les événements déclencheurs MIDI 
Undo Step, Next Step et Redo Step :

1  Placez l'insertion d'édition sur la piste de votre 
choix, à l'emplacement où vous souhaitez entrer 
la première note MIDI.

2  Choisissez Event > MIDI > Step Input.

3  Recherchez le bouton que vous voulez affecter 
à un événement MIDI et cliquez dans le champ 
situé sous ce bouton.

Sélection du champ Next Step
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4  Jouez l'événement MIDI à utiliser comme 
signal de déclenchement. 

5  Appuyez sur Entrée pour confirmer 
l'affectation du déclencheur MIDI.

Raccourcis du pavé numérique

Si vous avez activé l'option Enable Numeric 
Keypad Shortcuts, vous pouvez appliquer de 
nombreuses commandes dans la page Step 
Input, ainsi que plusieurs commandes de 
sélection depuis le pavé numérique de votre 
ordinateur. 
:

Propriétés MIDI en temps réel
Les propriétés MIDI en temps réel permettent de 
changer certaines propriétés MIDI dans les pistes 
MIDI et d'instrument (ou les régions MIDI) au 
cours de la lecture. Il existe cinq types de 
propriétés MIDI en temps réel : Quantize 
(quantification), Duration (durée), Delay 
(retard), Velocity (vélocité) et Transpose 
(transposition). 

Il est possible d'ajuster les propriétés MIDI en 
temps réel en cours de lecture, ce qui vous 
permet d'écouter pour vérifier si vous obtenez le 
résultat escompté. Une fois les paramètres 
désirés identifiés, vous pouvez les enregistrer sur 
les pistes ou régions sélectionnées. Cela a pour 
effet de remplacer les propriétés MIDI 
correspondantes sur les pistes ou régions 
sélectionnées et de rétablir l'affichage des 
propriétés en temps réel avec ses paramètres par 
défaut.

Les propriétés en temps réel peuvent être 
redéfinies à partir de la vue des propriétés en 
temps réel dans la fenêtre Edit ou à partir de la 
fenêtre Real-Time Properties.

Si vous utilisez un contrôleur continu (tel 
que Pitch Bend) comme déclencheur, 
assurez-vous d'utiliser une valeur de 
contrôleur externe afin d'éviter toute entrée 
de données erronées.

Champ Next Step déclenché par une variation de 
hauteur

Raccourcis Step Input Touche

Ronde 1

1/2 note 2

1/4 note 4

1/8 note 5

1/16 note 6

1/32 note 7

1/64 note 8

Note pointée . (point décimal)

Activer/désactiver les tuplets 3

Etape suivante Enter

Annuler l'étape 0

Avancer la sélection par 
incrément

+

Reculer par incrément la 
sélection

–

Sélectionner le compteur 
principal

=

Modifier les indicateurs de 
sélection

/

Raccourcis Step Input Touche
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Vue des propriétés en temps réel

La vue des propriétés en temps réel de la fenêtre 
Edit concerne uniquement les pistes. Pour 
appliquer les propriétés en temps réel aux 
régions, utilisez la fenêtre Real-Time Properties 
(voir Fenêtre Real-Time Properties, page 701).

Pour activer la vue des propriétés en temps réel 
dans la fenêtre Edit :

" Choisissez View > Edit Window > Real-Time 
Properties. 

Pour les hauteurs des micro-pistes, des 
mini-pistes ou des petites pistes, la colonne des 
propriétés en temps réel contient une ou deux 
propriétés selon le cas. La ou les deux premières 
propriétés activées sont affichées 
automatiquement.

Pour sélectionner une autre propriété en temps 
réel dans la vue de la hauteur d'une mini-piste ou 
d'une petite piste :

" Maintenez enfoncée la touche Ctrl (Windows) 
ou Pomme (Mac) et cliquez sur une propriété en 
temps réel pour choisir un autre élément dans le 
menu déroulant.

Fenêtre Real-Time Properties

Cette fenêtre permet d'appliquer des propriétés 
en temps réel aux pistes ou régions 
sélectionnées.

Pour ouvrir la fenêtre Real-Time Properties :

" Choisissez Event > MIDI Real-Time Properties. 

La fenêtre Real-Time Properties peut servir à 
appliquer des propriétés en temps réel basées sur 
les pistes ou sur les régions. Il suffit, pour cela, 
d'effectuer une sélection d'édition et de choisir 
les pistes ou les régions qui vous intéressent à 
partir du menu contextuel Apply To.

Colonne des propriétés en temps réel dans la 
fenêtre Edit

Fenêtre Real-Time Properties avec les propriétés 
activées
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Fenêtre Real-Time Properties avec une vue 
développée

Dans la fenêtre Real-Time Properties, les 
boutons Quantize, Duration et Velocity sont 
tous associés à un triangle Développer/Réduire 
prévu pour afficher ou masquer des paramètres 
supplémentaires. 

Activation des propriétés en temps réel

Pour activer les propriétés en temps réel :

1  Sélectionnez une piste ou effectuez une 
sélection d'édition.

2  Dans la vue des propriétés en temps réel de la 
fenêtre Edit ou dans la fenêtre Real-Time 
Properties, sélectionnez les propriétés en temps 
réel voulues en cliquant sur le nom de la 
propriété (Quantize, Duration, Delay, Velocity 
ou Transpose). Les propriétés en temps réel 
activées sont mises en surbrillance et affichent 
leurs paramètres.

3  Si vous travaillez en mode Link Track and Edit 
Selection à partir de la fenêtre Real-Time 
Properties, sélectionnez la piste ou la région 
voulue dans le menu déroulant Apply To.

4  Définissez les paramètres de la fenêtre 
Real-Time Properties (voir Paramètres des 
propriétés en temps réel, page 703).

Les propriétés en temps réel activées sont 
audibles lors de la lecture et sont appliquées aux 
pistes et régions sélectionnées.

Fenêtre Real-Time Properties, vue développée

Triangles de 
développement/
réduction

Lorsque vous utilisez les propriétés en temps 
réel, activez le mode Link Track and Edit 
Selection pour sélectionner une piste à partir 
d'une sélection d'édition (voir Activation ou 
désactivation de la liaison des sélections 
d'édition et de piste, page 463).
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Paramètres des propriétés en 
temps réel

Quantize

L'option de quantification peut être basée sur 
une grille ou un modèle groove. Dans le premier 
cas, vous disposez de paramètres 
supplémentaires de triolet et de décalage de 
grille, en plus des propriétés de quantification 
MIDI standard. Dans le deuxième cas, des 
commandes supplémentaires sont prévues pour 
définir les limites d'application de la durée et des 
vélocités du groove. Pour l'un comme pour 
l'autre, il est possible de définir trois valeurs 
importantes (Strength, Include et Randomize).

Menu déroulant Quantize : sélectionnez la valeur 
de quantification désirée. Toutes les valeurs 
rythmiques de note standard de la ronde à la 
quadruple croche, valeurs pointées ou triolets 
compris, sont autorisées. Ce menu contextuel 
donne également accès à tous les modèles de 
groove standard et personnalisés.

Swing : entrez le niveau de swing souhaité sous 
forme d'une valeur en pourcentage comprise 
entre 0 et 300%. 

Tuplet : activez l'option Tuplet et entrez le 
rapport voulu pour le triolet (1 à 99) : 3 pour 2 
ou 5 pour 4, par exemple. Cette option est 
accessible uniquement dans la vue développée 
de la fenêtre Real-Time Properties.

Offset : activez l'option Offset et entrez la valeur 
de décalage voulue en tics (de -2000 à 2000). 
Cette option est accessible uniquement dans la 
vue développée de la fenêtre Real-Time 
Properties.

Strength : activez l'option Strength et indiquez 
la quantité souhaitée sous forme d'une valeur en 
pourcentage comprise entre 0 et 100%. Cette 
option est accessible uniquement dans la vue 
développée de la fenêtre Real-Time Properties.

Include : activez l'option Include et définissez 
une plage de valeurs comprise entre 0 et 100%. 
Cette option est accessible uniquement dans la 
vue développée de la fenêtre Real-Time 
Properties.

Random : activez l'option Random et entrez une 
valeur en pourcentage comprise entre 0 
et 100%. Cette option est accessible 
uniquement dans la vue développée de la 
fenêtre Real-Time Properties.

Sélection d'une valeur de quantification par grille ou 
d'un modèle groove
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Duration :

Cette option peut servir à augmenter ou réduire 
la durée des notes MIDI en fonction d'une valeur 
fixe ou d'un pourcentage. Elle s'avère très utile 
pour la création d'effets de legato ou de staccato.

Menu déroulant du mode Duration

Sélectionnez l'une des options suivantes à partir 
du menu déroulant du mode Duration : Set, 
Add, Subtract, Scale, Legato/Gap ou 
Legato/Overlap.

Set : sélectionnez cette option pour définir des 
notes de la durée spécifiée.

Add : sélectionnez cette option pour ajouter la 
durée spécifiée à la durée actuelle de chaque 
note.

Subtract : sélectionnez cette option pour 
soustraire la durée spécifiée de la durée actuelle 
de chaque note.

Scale : sélectionnez cette option pour multiplier 
la durée actuelle de chaque note par une valeur 
en pourcentage comprise entre 1 et 400%.

Legato/Gap : sélectionnez cette option pour 
prolonger chaque note jusqu'à la note suivante. 
La durée spécifiée est soustraite pour produire 
un espace cohérent entre les notes.

Legato/Overlap : sélectionnez cette option pour 
prolonger chaque note jusqu'à la note suivante. 
La durée spécifiée est ensuite ajoutée pour 
obtenir une valeur de chevauchement 
cohérente.

Duration Amount

Si l'option choisie pour le menu déroulant Ticks 
ou Notes est exprimée en tics, entrez une durée 
sous la forme d'une noire et d'un nombre de tics 
(4|000, par exemple). Si l'option choisie pour le 
menu déroulant Ticks ou Notes est exprimée 
sous forme d'une valeur de note, entrez le 
multiplicateur approprié (7/16 de notes, par 
exemple).

Menus déroulants Ticks ou Notes

Le menu contextuel Ticks ou Notes vous permet 
de sélectionner soit un nombre de tics, soit une 
taille de note pour la durée de notes. Vous 
disposez également d'un menu déroulant Ticks 
ou Notes pour les valeurs maximale et minimale 
de durée (Duration).

Valeurs Min et Max de durée

Activez au choix l'une ou les deux valeurs (durée 
minimale et durée maximale) et entrez une 
valeur sous la forme d'une noire et d'un nombre 
de tics ou d'un multiple d'une valeur de note. 
Ces options sont disponibles uniquement dans 
la vue développée de la fenêtre Real-Time 
Properties.

Delay

Cette option permet de retarder ou d'avancer 
toutes les données MIDI dans la région ou la 
piste sélectionnée. Choisissez « + » dans le menu 
déroulant Delay pour retarder les données MIDI 
ou « - » pour les avancer. Indiquez l'unité voulue 

Sélection d'un mode Duration
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(Ticks ou Milliseconds) dans le menu déroulant 
correspondant. Spécifiez la valeur du retard en 
tics ou en millisecondes. Cette valeur ne doit pas 
dépasser 2000 ms ou 999 tics.

Velocity

Cette option permet de changer la vélocité MIDI 
selon un pourcentage ou une valeur constante. 
Entrez une valeur en pourcentage dans le champ 
Dynamics pour multiplier la vélocité aux 
alentours de 64. Vous pouvez également 
spécifier un décalage en ajoutant (+) ou 
retranchant (-) des valeurs comprises entre 1 
et 127. Il est possible, en outre, de fixer des 
limites minimum et maximum de vélocité. Ces 
options sont disponibles uniquement dans la 
vue développée de la fenêtre Real-Time 
Properties.

Velocity peut être appliquée en tant que 
propriété en temps réel à MIDI Input et MIDI 
Thru.

Transpose

Cette option vous permet de transposer des 
notes MIDI vers le haut ou le bas selon un 
nombre d'octave et de demi-tons spécifiés, ou 
dans la tonalité voulue sur une échelle de tons 
(en se basant sur la règle des signatures de 
tonalité). Il est possible également d'effectuer 
une transposition en fonction d'une hauteur de 
note donnée. Sélectionnez By, To, ou In dans le 
menu contextuel Transpose pour effectuer une 
transposition par intervalle, vers une hauteur 
spécifique ou dans la tonalité voulue sur 
l'échelle de tons. 

Dans le premier cas, entrez le nombre d'octaves 
et de demi-tons désiré sous forme de valeurs 
positives ou négatives. 

Dans le deuxième cas, entrez la note MIDI 
voulue.

Pour transposer dans la tonalité par degré de 
l'échelle de tons, entrez le nombre de degrés 
souhaités sous forme de nombres positifs ou 
négatifs. Par exemple, entrez +2 pour une 
transposition de trois tons plus haut.

La transposition peut être appliquée en tant que 
propriété en temps réel à MIDI Input et MIDI 
Thru.

Propriétés en temps réel sur les 
pistes et les régions

Les propriétés en temps réel peuvent être 
configurées en vue d'être appliquées à une piste 
entière (c'est-à-dire à toutes les régions de cette 
piste), ou région par région. Les propriétés au 
niveau des pistes permettent, en outre, un 
traitement des entrées MIDI en temps réel de la 
vélocité et de la transposition.

La présence de propriétés en temps réel basées 
sur des pistes est signalée par un T affiché dans le 
coin supérieur droit des pistes MIDI. Les 
propriétés en temps réel basées sur des régions 
sont désignées par un R affiché dans le coin 
supérieur droit de la région. Les limites d'une 
région sont indiquées dans la vue Notes.

Indicateurs des propriétés en temps réel basées sur 
des régions et sur des pistes

Propriétés en 
temps réel basées 

sur des pistes

Propriétés en 
temps réel basées 

sur des régions
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Propriétés en temps réel basées sur 
des régions

Les propriétés en temps réel basées sur des 
régions peuvent être définies uniquement 
au moyen de la fenêtre Real-Time Properties 
(Event > MIDI Real-Time Properties). Il est 
possible de les appliquer à plusieurs régions. 
Après avoir attribué des propriétés en temps réel 
à une région, rien ne vous empêche de déplacer 
ou copier et coller la région. Celle-ci conservera 
ses propriétés.

Propriétés en temps réel basées sur 
des pistes

Ces propriétés s'appliquent aux séquences MIDI 
de la piste entière. Toutefois, les régions 
possédant leurs propres propriétés en temps réel 
ont priorité sur les propriétés en temps réel 
basées sur des pistes. Vous pouvez réinitialiser 
les propriétés en temps réel basées sur des 
régions en sélectionnant la région et en cliquant 
sur le bouton Clear Region Properties dans la 
fenêtre Real-Time Properties (voir Ecriture des 
propriétés en temps réel sur les pistes ou les 
régions, page 706).

Pour plus de souplesse, chaque fois que des 
propriétés en temps réel sont attribuées par 
piste, elles sont regroupées dans une playlist de 
piste. Vous pouvez ainsi établir plusieurs 
playlists composées de différents paramètres de 
propriétés en temps réel.

Ecriture des propriétés en temps 
réel sur les pistes ou les régions

Lorsque vous êtes satisfait de vos paramètres, 
vous pouvez écrire les propriétés en temps réel 
sur les pistes ou régions sélectionnées au moyen 
de la fenêtre Real-Time Properties. Les propriétés 
en temps réel sont appliquées aux données MIDI 
actuelles de la piste ou d'une région.

Pour écrire des propriétés en temps réel sur des 
pistes :

1  Sélectionnez la ou les pistes auxquelles vous 
souhaitez appliquer des propriétés en 
temps réel.

2  Ouvrez la fenêtre Real-Time Properties 
(Event > MIDI Real-Time Properties).

3  Si le mode Link Track and Edit Selection est 
activé, sélectionnez Tracks dans le menu 
déroulant Real-Time Properties Apply To.

4  Définissez les paramètres qui conviennent.

5  Effectuez l'une des opérations suivantes :

• Cliquez sur le bouton Write to Track dans 
la fenêtre Real-Time Properties.

– ou –

• Choisissez Track > Write MIDI Real-Time 
Properties.

Pour écrire des propriétés en temps réel sur des 
régions :

1  Sélectionnez la ou les régions auxquelles vous 
souhaitez appliquer des propriétés en temps 
réel.

2  Ouvrez la fenêtre Real-Time Properties 
(Event > MIDI Real-Time Properties).

3  Si le mode Link Track and Edit Selection est 
activé, sélectionnez Regions dans le menu 
déroulant Real-Time Properties Apply To.

4  Définissez les paramètres qui conviennent.

5  Cliquez sur le bouton Write to Region.
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Pour réinitialiser les propriétés en temps réel 
d'une région :

1  Sélectionnez la région pour laquelle vous 
souhaitez réinitialiser les propriétés en temps 
réel.

2  Ouvrez la fenêtre Real-Time Properties 
(Event > MIDI Real-Time Properties).

3  Choisissez Regions dans le menu déroulant 
Real-Time Properties Apply To.

4  Cliquez sur le bouton Clear Region Properties.

Propriétés en temps réel dans la 
liste des événements MIDI

Dans la liste des événements MIDI, la présence 
de propriétés en temps réel basées sur des pistes 
est signalée par un T affiché à droite de chaque 
événement. Les propriétés en temps réel basées 
sur des régions sont signalées par un R.

Affichage des effets des 
propriétés en temps réel

L'option Display Events as Modified by 
Real-Time Properties détermine si Pro Tools 
affiche les effets des propriétés en temps réel à la 
fois dans la fenêtre Edit et dans la liste des 
événements MIDI. Pour ce faire, vous devez 
activer cette option. Lorsque cette option est 
désactivée, les effets des propriétés en temps réel 
sont audibles, mais pas visibles. Vous ne pouvez 
pas voir les notes et les autres événements MIDI 
en fonction de leur emplacement, de leur 
hauteur, de leur durée ou de leur vélocité 
d'origine, mais vous avez la possibilité 
d'entendre le résultat obtenu après application 
des paramètres des propriétés en temps réel. 

Pour activer ou désactiver l'option Display Events 
as Modified by Real-Time Properties :

1  Sélectionnez Setup > Preferences.

2  Cliquez sur l'onglet MIDI.

3  Activez ou désactivez l'option Display Events 
as Modified by Real-Time Properties.

4  Cliquez sur OK.

Propriétés en temps réel basées sur des pistes et des 
régions signalées dans la liste des événements MIDI

Pour plus d'informations sur la liste des 
événements MIDI, reportez-vous au 
chapitre 27, Liste des événements MIDI.

Colonne piste/région

Option Display Events as Modified by Real-Time 
Properties, page MIDI Preferences
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Effets des propriétés en temps réel 
affichés dans la liste des événements 
MIDI

La liste des événements MIDI prend en compte 
les effets des propriétés en temps réel à 
condition d'avoir activé l'option Display Events 
as Modified by Real-Time Properties. Lorsque 
vous modifiez ou insérez un événement dans 
une piste ou une région possédant des propriétés 
en temps réel actives, Pro Tools tient compte des 
propriétés et modifie ou insère l'événement à un 
autre endroit, si nécessaire, pour refléter les 
effets des propriétés en temps réel.

Effets des propriétés en temps réel 
affichés dans la fenêtre Edit

Si l'option Display Events as Modified by 
Real-Time Properties est activée dans la fenêtre 
Edit, les événements MIDI apparaissent à 
l'endroit où ils sont émis. Ils ne seront, 
cependant, enregistrés aux nouveaux endroits 
choisis que lorsque vous écrirez les propriétés en 
temps réel sur la piste ou la région.

Lorsque vous faites glisser des événements MIDI, 
les emplacements réels (hauteur ou temps) sont 
décalés en fonction de la longueur du 
déplacement des événements, mais l'effet des 
propriétés en temps réel est affiché.

Lorsque vous insérez un événement dans une 
piste ou une région possédant des propriétés en 
temps réel actives, Pro Tools tient compte des 
propriétés et modifie ou insère l'événement à un 
autre endroit, si nécessaire, pour refléter les 
effets des propriétés en temps réel.
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Chapitre 27 : Liste des événements 
MIDI

Liste des événements MIDI
La liste des événements MIDI répertorie de façon 
détaillée tous les événements d'une piste MIDI 
ou d'une piste d'instrument. Ceux-ci 
apparaissent sous forme de texte et de nombres, 
ce qui permet d'éditer précisément leur 
emplacement, leur longueur et leurs valeurs.

Les événements de la liste des événements MIDI 
peuvent être copiés et collés, sélectionnés ou 
supprimés. Tout événement MIDI (exception 
faite des données Sysex) peut être inséré et édité 
dans la liste. Certains types d'événements MIDI 
peuvent être masqués à l'aide du filtre 
d'affichage.

Ouverture de la liste des 
événements MIDI

Pour ouvrir la liste des événements MIDI, 
effectuez l'une des opérations suivantes :

" Choisissez Event > MIDI Event List.

" Maintenez la touche Ctrl (Mac) ou Démarrer 
(Windows) enfoncée et cliquez deux fois sur le 
nom d'une piste MIDI ou d'instrument dans la 
fenêtre Edit ou Mix.

" Appuyez sur Option+signe égal (Mac) ou sur 
Alt+signe égal (Windows).

Liste des événements MIDI

Sélecteur de piste

Menu Options

Menu Insert

Contrairement aux playlists de la fenêtre 
Edit, vous pouvez insérer et afficher les 
données d'aftertouch polyphonique dans la 
liste des événements MIDI.

Les données de coupure du son des pistes 
MIDI et des pistes d'instrument 
n'apparaissent pas dans la liste des 
événements MIDI.
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Menus de la liste des événements MIDI

Trois menus contextuels apparaissent en haut 
de la liste des événements MIDI :

Sélecteur de piste : indique la piste MIDI ou 
d'instrument affichée et permet d'en choisir une 
autre.

Menu Options : contient les commandes et 
options de la liste des événements MIDI (voir 
Options de la liste des événements MIDI, 
page 717).

Menu Insert : contient la liste des types 
d'événements que vous pouvez insérer.

A droite de ces menus déroulants se trouve le 
nombre des événements affichés.

Colonnes de la liste des 
événements MIDI

Les informations relatives aux événements de la 
liste des événements MIDI sont affichées dans 
les trois colonnes suivantes :

Colonne Start : affiche l'emplacement de début, 
selon l'échelle temporelle principale, de chaque 
événement. Les emplacements peuvent aussi 
être affichés dans l'échelle temporelle 
secondaire si l'option Show Sub Counter est 
sélectionnée dans le menu déroulant Options.

Le curseur de lecture apparaît sous forme de 
flèche bleue (rouge lorsque les pistes sont 
activées en enregistrement) dans la colonne 
Start.

Lorsque plusieurs événements se trouvent au 
même emplacement, celui-ci n'est indiqué que 
pour l'événement du haut, les autres étant 
estompés. Vous pouvez éditer ces derniers en 
cliquant deux fois dessus.

Colonne Event : affiche le type d'événement, 
indiqué par une icône, ainsi que les valeurs qui y 
sont associées.

Colonne Length/Info : affiche le point de fin ou 
la durée des notes en fonction de l'option 
sélectionnée dans le menu déroulant Options. 
Sont également affichés les noms des 
événements de contrôleur continu et les 
changements de programme.

Filtre d'affichage pour la liste des 
événements MIDI

Vous pouvez utiliser le filtre d'affichage pour 
spécifier les types d'événements à faire 
apparaître dans la liste des événements MIDI. 
Ceci vous aide à n'atteindre que les événements 
sur lesquels vous voulez intervenir et protège les 
autres événements MIDI des opérations 
d'édition et de suppression. Les événements 
n'apparaissant pas dans la liste des événements 
MIDI sont néanmoins lus.

La combinaison de touches Option+signe 
égal (Mac) ou Alt+signe égal (Windows) 
permet de passer de la liste des événements 
MIDI à la fenêtre Edit et réciproquement.

Colonnes de la liste des événements MIDI

Curseur de 

Cliquez deux 
fois pour 

Evénements 
MIDI 
simultanés

lecture
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Le filtre d'affichage peut être réglé pour afficher 
tous les messages (All), seulement les messages 
spécifiés (Only), ou tous les messages sauf 
ceux-ci (All except).

Exemple : pour filtrer les messages Aftertouch et 
System Exclusive dans la liste des événements 
MIDI :

1  Dans la liste des événements MIDI, allez dans 
le menu déroulant Options et sélectionnez View 
Filter.

2  Dans la boîte de dialogue MIDI Event List 
View Filter, sélectionnez l'option All Except.

3  Sélectionnez les options Mono Aftertouch, 
Polyphonic Aftertouch et System Exclusive. Ne 
cochez pas les autres cases d'option.

Lorsque vous utilisez l'option All Except, les 
événements sélectionnés ne sont pas affichés. 
Inversement, lorsque vous utilisez l'option 
Only, seuls les événements sélectionnés sont 
affichés.

4  Cliquez sur OK.

Navigation dans la liste des 
événements MIDI

La touche de tabulation et les touches fléchées 
permettent de naviguer dans la liste des 
événements MIDI. Vous pouvez également 
repérer le point de début de l'édition ou tout 
autre emplacement spécifié.

Pour explorer le contenu de la liste des 
événements MIDI, effectuez l'une des opérations 
suivantes :

• Cliquez deux fois pour passer en mode 
édition.

• Appuyez sur la touche de tabulation ou la 
flèche vers le bas pour vous placer sur 
l'événement suivant (après avoir sélectionné 
ou non le champ d'édition).

• Maintenez la touche Option (Mac) ou 
Ctrl(Windows) pendant que vous appuyez sur 
la touche de tabulation pour déplacer le 
curseur vers l'événement précédent (après 
avoir sélectionné ou non le champ d'édition) :

• Si vous avez sélectionné un champ d'édition, 
appuyez sur la flèche vers le droite pour vous 
placer sur le champ d'édition situé à droite.

• Appuyez sur la flèche vers le gauche pour vous 
placer sur le champ d'édition situé à gauche.

Pour conserver le dernier événement 
sélectionné, maintenez la touche Maj enfoncée 
pendant que vous vous placez sur l'événement 
suivant ou précédent.

Pour vous placer sur le point de début de l'édition :

" Dans la liste des événements MIDI, choisissez 
Scroll To Edit Selection dans le menu déroulant 
Options.

Lorsque vous insérez un type d'événement 
qui a été filtré à partir de la liste des 
événements MIDI, il ne peut plus être filtré.

Boîte de dialogue MIDI Event List View Filter
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Pour vous placer sur un emplacement spécifique 
de la liste des événements MIDI :

1  Dans la liste des événements MIDI, choisissez 
Go To dans le menu déroulant Options.

2  Dans la boîte de dialogue Go To, choisissez le 
format dans le menu déroulant Time Scale.

3  Si vous utilisez le timecode (Pro Tools HD et 
Pro Tools LE avec DV Toolkit 2 uniquement), 
vous pouvez sélectionner l'option Use 
Subframes.

4  Entrez l'emplacement où vous voulez vous 
placer et cliquez sur OK.

Les éléments suivants du menu Options ont une 
incidence sur la navigation dans la liste des 
événements MIDI :

• Lorsque l'option Page Scroll During 
Playback est sélectionnée, la liste des 
événements MIDI défile pendant la lecture.

• Lorsque l'option Scroll During Edit 
Selection est sélectionnée, la liste des 
événements MIDI défile automatiquement 
lorsque la sélection d'édition change dans 
la fenêtre Edit.

Insertion d'événements dans 
la liste des événements MIDI

Vous pouvez insérer des événements dans la 
liste des événements MIDI en choisissant un 
type d'événement dans le menu Insert. 
Vous trouverez ci-après plusieurs exemples 
d'insertion d'événements dans la liste des 
événements MIDI.

Pour insérer une note dans la liste des 
événements MIDI :

1  Effectuez l'une des opérations suivantes :

• Cliquez sur le bouton Insert et choisissez 
Note dans le menu déroulant.

– ou –

• Appuyez sur Pomme+N (Mac) ou sur 
Ctrl+N (Windows).

2  Entrez l'emplacement, la hauteur, les vélocités 
d'attaque et de relâchement, ainsi que la durée 
de la nouvelle note. Pour naviguer d'un champ à 
l'autre, utilisez les flèches vers la gauche et vers 
la droite. 

Boîte de dialogue Go To

Menu Insert de la liste des événements MIDI

Champs de saisie des événements pour une note

Pitch

Vélocité d'attaque

Vélocité de relâchement
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Lorsqu'un champ est sélectionné, entrez une 
valeur en effectuant l'une des opérations 
suivantes :

• Entrez la valeur sur le pavé numérique.

• Appuyez sur la flèche vers le haut ou vers le 
bas pour faire défiler la valeur.

• Jouez la note sur votre contrôleur MIDI 
puis appuyez sur la touche Retour (Mac) ou 
Entrée (Windows) du clavier 
alphanumérique pour valider la valeur.

3  Effectuez l'une des opérations suivantes :

• Pour insérer la note et rester en mode de 
saisie d'événement, appuyez sur la touche 
Entrée du clavier numérique.

• Pour insérer la note et quitter le mode de 
saisie d'événement, appuyez sur la touche 
Retour (Mac) ou Entrée (Windows) du 
clavier alphanumérique.

• Pour quitter le mode de saisie d'événement 
sans insérer l'événement de note, appuyez 
sur la touche Echap du clavier 
alphanumérique.

Pour insérer un événement de contrôleur dans la 
liste des événements MIDI :

1  Effectuez l'une des opérations suivantes :

• Cliquez sur le bouton Insert et choisissez 
Controller dans le menu déroulant.

– ou –

• Appuyez sur Pomme+L (Mac) ou sur Ctrl+L 
(Windows).

2  Tapez l'emplacement, le numéro du type de 
contrôleur et la valeur de contrôleur du nouvel 
événement. Le nom du contrôleur est affiché 
dans la colonne length/info, à droite de la valeur 
du contrôleur. Pour naviguer d'un champ à 
l'autre, utilisez les flèches vers la gauche et vers 
la droite.

Lorsqu'un champ est sélectionné, entrez une 
valeur en effectuant l'une des opérations 
suivantes :

• Entrez la valeur sur le pavé numérique.

• Appuyez sur la flèche vers le haut ou vers le 
bas pour faire défiler la valeur.

• Maintenez la touche Pomme (Mac) ou Ctrl 
(Windows) enfoncée pendant que vous 
vous déplacez vers le haut ou le bas pour 
faire défiler la valeur.

• Jouez l'événement de contrôleur sur votre 
contrôleur MIDI et appuyez sur la touche 
Retour (Mac) ou Entrée (Windows) du 
clavier alphanumérique pour valider la 
valeur.

Une fois le champ Start sélectionné, vous 
pouvez entrer automatiquement 
l'emplacement d'un autre événement 
présent sur la piste en cliquant dessus. Champs de saisie des événements pour un événement 

de contrôleur

Une fois le champ Start sélectionné, vous 
pouvez entrer automatiquement 
l'emplacement d'un autre événement 
présent sur la piste en cliquant dessus.

Numéro du contrôleur Nom du contrôleur

Valeur du contrôleur
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3  Effectuez l'une des opérations suivantes :

• Pour insérer l'événement de contrôleur et 
rester en mode de saisie d'événement, 
appuyez sur la touche Entrée du clavier 
numérique.

• Pour insérer l'événement de contrôleur et 
quitter le mode de saisie d'événement, 
appuyez sur la touche Retour du clavier 
alphanumérique.

• Pour quitter le mode de saisie d'événement 
sans insérer d'événement de contrôleur, 
appuyez sur la touche Echap du clavier 
alphanumérique.

Pour insérer un changement de programme dans la 
liste des événements MIDI :

1  Effectuez l'une des opérations suivantes :

• Cliquez sur le bouton Insert et choisissez 
Program Change dans le menu déroulant.

– ou –

• Appuyez sur Pomme+P (Mac) ou sur Ctrl+P 
(Windows).

2  Entrez l'emplacement du nouvel événement.

3  Entrez un numéro de changement de 
programme et une valeur de sélection de banque 
(le cas échéant). Le nom du changement de 
programme apparaît dans la colonne 
length/info.

Vous pouvez cliquer dans la colonne Info pour 
ouvrir la fenêtre Program Change (pour plus de 
détails, consultez Sélection de patch 
(changements de programme et de banque), 
page 661). 

4  Effectuez l'une des opérations suivantes :

• Pour insérer le changement de programme 
et rester en mode de saisie d'événement, 
appuyez sur la touche Entrée du clavier 
numérique.

• Pour insérer le changement de programme 
et quitter le mode de saisie d'événement, 
appuyez sur la touche Retour du clavier 
alphanumérique.

• Pour quitter le mode de saisie d'événement 
sans insérer de changement de programme, 
appuyez sur la touche Echap du clavier 
alphanumérique.

Insertion d'un autre événement

Après avoir inséré un événement, vous pouvez 
facilement en insérer un autre du même type. 
Le type d'événement à insérer est indiqué en bas 
du menu Insert.

Exemple : pour insérer une deuxième note après 
avoir inséré la première, effectuez l'une des 
opérations suivantes :

" Cliquez sur le bouton Insert et choisissez 
Another Note dans le menu déroulant.

– ou –

" Appuyez sur Pomme+M (Mac) ou sur Ctrl+M 
(Windows).

Champs de saisie des événements pour un 
changement de programme

Numéro du programme Nom du programme

Valeur du contrôleur 0

Valeur du contrôleur 32

Une fois le champ Start sélectionné, vous 
pouvez entrer automatiquement 
l'emplacement d'un autre événement 
présent sur la piste en cliquant dessus.
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Evénement d'édition dans la 
liste des événements MIDI
Les événements de la liste des événements MIDI 
peuvent être édités, sélectionnés, supprimés ou 
copiés et collés.

Pour éditer un événement dans la liste des 
événements MIDI :

1  Effectuez l’une des opérations suivantes :

• Cliquez deux fois sur le champ de 
l'événement à éditer.

– ou –

• appuyez sur Pomme+Enter (Mac) ou sur 
Ctrl+Entrée (Windows) pour éditer un 
événement sélectionné.

2  Pour entrer une nouvelle valeur, effectuez 
l'une des opérations suivantes :

• Entrez la nouvelle valeur sur le pavé 
numérique.

• Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée pendant que vous 
appuyez sur la flèche vers le haut ou vers le 
bas pour faire défiler l'affichage jusqu'à la 
nouvelle valeur désirée.

• Maintenez la touche Pomme (Mac) ou Ctrl 
(Windows) enfoncée tout en vous 
déplaçant vers le haut ou le bas pour faire 
défiler l'affichage jusqu'à la nouvelle valeur 
désirée.

• Jouez la nouvelle note (ou valeur de 
contrôleur) sur votre contrôleur MIDI puis 
appuyez sur la touche Retour (Mac) ou 
Entrée (Windows) du clavier 
alphanumérique pour valider la valeur.

3  Effectuez l'une des opérations suivantes :

• Pour entrer la nouvelle valeur d'événement 
et vous déplacer vers un autre champ ou un 
autre événement, utilisez les touches 
fléchées.

• Pour entrer la nouvelle valeur et rester en 
mode édition, appuyez sur la touche Entrée 
du clavier numérique.

• Pour entrer la nouvelle valeur et quitter le 
mode édition, appuyez sur la touche Retour 
(Mac) ou sur Entrée (Windows) du clavier 
alphanumérique.

• Pour quitter le mode de saisie d'édition sans 
valider la nouvelle valeur, appuyez sur la 
touche Echap du clavier alphanumérique.

Sélection d'événements dans la 
liste des événements MIDI

Pour sélectionner une plage d'événements dans la 
liste des événements MIDI, effectuez l'une des 
opérations suivantes :

" Cliquez sur l'événement au début de la 
sélection et faites glisser le curseur jusqu'à 
l'événement de fin.

– ou –

" Tout en appuyant sur Maj, cliquez sur 
l'événement au début de la sélection puis sur 
l'événement de fin.

Pour sélectionner des événements non contigus 
dans la liste des événements MIDI :

" Maintenez la touche Pomme (Mac) ou Ctrl 
(Windows) enfoncée pendant que vous cliquez 
sur chaque événement.

Lorsque l'option Insert At Playback 
Location est active (voir Options de la liste 
des événements MIDI, page 717), vous 
pouvez utiliser les raccourcis clavier afin 
d'insérer d'autres événements à la volée.
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Pour désélectionner un événement MIDI de 
la liste :

" Maintenez la touche Pomme (Mac) ou Ctrl 
(Windows) enfoncée pendant que vous cliquez 
sur l'événement sélectionné.

Suppression d'événements dans 
la liste des événements MIDI

Pour supprimer un événement MIDI de la liste :

" Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée pendant que vous cliquez 
sur l'événement à supprimer.

Pour supprimer une sélection d'événements MIDI 
dans la liste :

1  Sélectionnez les événements que vous voulez 
supprimer en vous déplaçant dans la colonne 
Start ou en cliquant sur chaque événement tout 
en appuyant sur Maj.

2  Pour n'afficher que les événements que vous 
voulez supprimer, utilisez le filtre d'affichage 
(voir Filtre d'affichage pour la liste des 
événements MIDI, page 710). Les événements 
qui ne sont pas affichés ne peuvent être 
supprimés.

3  Effectuez l'une des opérations suivantes :

• Choisissez Edit > Clear pour supprimer les 
événements sélectionnés.

– ou –

• Appuyez sur la touche Supprimer (Mac) ou 
Retour arrière (Windows) du clavier 
alphanumérique.

Copier/coller d'événements dans 
la liste des événements MIDI

Pour copier et coller dans la liste des événements 
MIDI :

1  Sélectionnez les événements à copier dans la 
liste des événements MIDI.

2  Choisissez Edit > Copy.

3  Effectuez l'une des opérations suivantes :

• Pour coller les données à l'emplacement 
d'un événement, cliquez dessus dans la liste 
des événements MIDI.

– ou –

• Pour coller les données à un emplacement, 
choisissez Go To dans le menu Options de 
la liste des événements MIDI, entrez 
l'emplacement auquel vous voulez 
effectuer le collage et cliquez sur OK.

4  Choisissez Edit > Paste. Les événements du 
Presse-papiers sont collés et remplacent les 
événements existants.

Les notes sélectionnées dans la liste des 
événements MIDI peuvent être modifiées à 
l'aide de n'importe quelle commande de la 
fenêtre MIDI Operations (voir chapitre 26, 
Oopérations MIDI).

Sélection dans la liste des événements MIDI

Pour coller des événements sans effacer les 
anciens, utilisez la commande Merge Paste 
Special.
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Options de la liste des 
événements MIDI

La liste des événéments MIDI propose les 
options suivantes :

Show Sub Counter : affiche le temps des 
événements dans l'échelle de temps secondaire.

Go To : ouvre la boîte de dialogue Go To, dans 
laquelle vous pouvez préciser un emplacement, 
exprimé dans n'importe quelle échelle 
temporelle, sur lequel le point d'insertion de 
l'édition se déplace.

Scroll To Edit Selection : fait défiler la liste des 
événements MIDI sur le point de début de 
l'édition ou le point d'insertion de l'édition.

Page Scroll During Playback : fait défiler la liste 
des événements MIDI lors de la lecture.

Scroll During Edit Selection : fait défiler la liste 
des événements MIDI automatiquement lorsque 
la sélection d'édition change dans la fenêtre 
Edit.

Show Note Length : affiche la durée au lieu des 
temps de fin des notes dans la colonne 
length/info de la liste des événements MIDI.

Show Note End Time : affiche les temps de fin 
des notes au lieu de la durée dans la colonne 
length/info de la liste des événements MIDI.

Insert At Edit Location : insère par défaut le 
point de début de l'édition ou le point 
d'insertion de l'édition comme emplacement 
des événements.

Insert At Playback Location : permet d'insérer 
des événements dans la liste des événements 
MIDI en temps réel, tout en écoutant la session. 

Insert At Playback Location With Grid : aligne 
l'emplacement des événements insérés en temps 
réel sur la grille.

View Filter : ouvre la boîte de dialogue View 
Filter dans laquelle vous pouvez spécifier les 
types d'événements devant s'afficher dans la 
liste des événements MIDI. Les événements qui 
ne sont pas affichés ne sont pas concernés par 
les opérations Couper, Copier et Coller dans la 
liste des événements MIDI, mais ils sont 
néanmoins lus. Pour plus d'informations, 
reportez-vous à la section Filtre d'affichage pour 
la liste des événements MIDI, page 710.

Options de la liste des événements MIDI
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Chapitre 28 : Mixage : Principes de 
base

En plus du mixage final, les tâches de mixage 
peuvent être réalisées à tout moment lors d'une 
session d'enregistrement. Ce chapitre explique 
les aspects du mixage sur un système Pro Tools, 
notamment les flux de signaux audio, les voies 
de sortie et de bus, les départs et l'assignation des 
signaux pour le prémixage et le mixage.

Lors du mixage, des plug-in en temps réel et des 
points d'inserts matériels assurent les effets et le 
traitement des signaux (voir chapitre 29, Inserts 
de plug-in et inserts matériels). 

Notions de mixage
Le mixage consiste à modifier certains éléments, 
tels que les niveaux de son, le panoramique et 
les effets. Les modifications apportées sont 
basées sur les données entendues en studio. Bien 
que vous puissiez contrôler de nombreuses 
variables en studio (par exemple les 
haut-parleurs et l'acoustique de la salle), vous ne 
pouvez pas contrôler l'environnement d'écoute 
du mixage final. Les conseils suivants proposent 
plusieurs méthodes permettant de garantir la 
meilleure qualité de mixage possible au plus 
grand nombre d'auditeurs :

Alternez les enceintes et l'écoute. Ecoutez vos 
mixages sur différents types d'enceintes afin 
d'en évaluer la qualité. Cette opération permet 
d'anticiper ce qu'entendra effectivement le 
public visé.

Mixage de référence L'enregistrement de 
cassettes ou de CD d'un état provisoire du mix 
permet de l'écouter hors studio, dans des 
environnements d'écoute différents.

Ecoute pour la compatibilité de formats : 
les mixages stéréo doivent généralement être 
compatibles avec le format mono. Lorsque vous 
effectuez un mixage en mode Surround 
multicanal, les mixages devront peut-être 
également être compatibles avec les systèmes 
d'écoute stéréo ou mono (consultez le manuel 
Pro Tools Sync & Surround Concepts Guide).

Mesures et étalonnage
Les vumètres indiquent visuellement le niveau 
des signaux. Ils spécifient l'arrivée du signal sur 
un canal et sa valeur par rapport au repère "0 dB" 
(supérieure ou inférieure). 

L'étalonnage de tous vos équipements avec des 
niveaux de référence standard permet de garder 
(et de mesurer) un niveau constant lors du 
passage d'un appareil d'enregistrement à un 
autre dans un studio, à l'échelle d'une structure 
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de post-production ou tout au long de la chaîne 
de production d'un film long métrage. Par 
exemple, un signal de niveau -18  dBFS sortant 
d'une machine DAT doit être lu et mesuré à 
-18 dBFS dans Pro Tools.

Types de pistes
Pro Tools propose quatre types de pistes 
capables d'acheminer des données audio : 

• Audio

• Entrée auxiliaire

• Fader principal

• Instrument

Les systèmes Pro Tools sont équipés de pistes 
audio mono et stéréo. 

Les pistes audio multicanaux et formats de 
mixage Surround sont pris en charge par 
Pro Tools HD uniquement.

Pro Tools propose deux types de pistes incluant 
des données MIDI :

• MIDI

• Instrument

Pro Tools HD fournit des pistes de VCA 
principal. Ces pistes ne transfèrent pas de 
données audio et ne contrôlent pas de données 
MIDI, mais affectent les commandes des autres 
pistes. Pour plus d'informations, reportez-vous à 
la section Pistes de VCA principal, page 727. 

Dans la fenêtre Mix, les pistes sont identifiées 
par leur icône de type.

Utilisez l'option Calibration Reference Level 
de la page Operations Preferences pour 
définir le niveau de calibrage de référence 
par défaut en dB, lorsque Pro Tools 
fonctionne en mode Calibration.

Pour les interfaces audio possédant des 
fonctions de rognage (telles que l'interface 
I/O 192), reportez-vous au guide de 
l'interface pour obtenir des instructions de 
calibrage.

Les pistes d'instruments sont répertoriées à 
la fois sous les pistes audio et sous les pistes 
MIDI parce qu'elles sont formées de pistes 
d'entrée auxiliaire et de pistes MIDI. 

Pistes audio, d'entrée auxiliaire, de fader principal, de 
VCA principal, MIDI et d'instrument

Pour plus d'informations sur la création de 
pistes, consultez la section Création de 
pistes, page 146.

Icônes de type de piste
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Pistes audio :

Les pistes audio lisent et enregistrent les 
données audio sur des disques ou permettent, 
lorsqu'elles sont préparées en enregistrement ou 
en mode d'écoute TrackInput, d'écouter les 
signaux d'entrée. Les inserts sur les pistes audio 
sont des inserts pré-fader. Les départs peuvent 
être pré-fader ou post-fader.

Pistes d'entrée auxiliaire :

les entrées auxiliaires offrent les mêmes options 
d'assignation des signaux que les pistes audio, à 
ceci près que leurs entrées doivent provenir d'un 
bus interne ou d'une entrée matérielle. Les 
inserts sur les entrées auxiliaires sont des inserts 
pré-fader.

Les entrées auxiliaires servent à accueillir des 
sorties d'instruments MIDI externes et autres 
sources sonores, ainsi qu'à prémixer des bus 
internes et des sorties. Elles peuvent être 
entièrement automatisées. Lorsque vous utilisez Chemin de signaux audio, pistes audio

Inserts

Départs,

Volume

Sortie principale

pré-fader

Solo/Mute

Panora-

Sorties 

Départs,post-fader

Sortie

+

 

 

Record

Source : tout fichier mono, 
stéréo ou audio multicanal, en 
cours de lecture 

Entrée : lors de l'écoute en 
enregistrement ou en mode 
d'écoute TrackInput(plug-in ou 

inserts 
matériels)

Source 
ou 
entrée

supplémentaires

mique

Flux de signaux audio, pistes d'entrée audio

Inserts

Départs,

Volume

Sortie principale

pré-fader

Solo/Mute

Panora-

Sorties 

Départs,post-fader

Sortie

+

Entrée

(plug-in ou 
inserts 
matériels)

Source : chemin de bus 
ou d'entrée matérielle

mique

supplémentaires
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des entrées auxiliaires pour accueillir des sources 
externes, c'est sur ces sources elles-mêmes qu'il 
convient de régler le volume de sortie afin 
d'obtenir un niveau d'enregistrement correct. 

Utilisations courantes des entrées auxiliaires

L'envoi de pistes vers l'entrée auxiliaire, par 
l'intermédiaire de bus, permet :

• l'application de plug-in en temps réel ou d'un 
processeur externe à un prémixage en 
utilisant l'entrée auxiliaire comme retour 
d'effets (par exemple la réverbération ou la 
compression de ligne de bus) ;

• l'incorporation de sons à partir d'instruments 
MIDI externes et d'autres sources audio dans 
le mixage, pour l'écoute ou l'assignation de 
pistes audio à enregistrer sur disque (par 
exemple, à partir de sorties audio d'un 
synthétiseur MIDI) ;

• le regroupement du contrôle du volume du 
niveau d'un prémixage sur un seul fader ;

• la lecture audio à partir d'un plug-in 
d'instrument, bien que les pistes 
d'instruments soient la méthode 
recommandée d'intégration de plug-in 
d'instruments, par exemple Xpand de 
Digidesign.

Pour acheminer une entrée auxiliaire :

1  Pour choisir un chemin de bus ou d'entrée, 
cliquez sur le sélecteur de chemin d'entrée de 
l'entrée auxiliaire.

2  Pour choisir un chemin de bus ou de sortie, 
cliquez sur le sélecteur de chemin de sortie de 
l'entrée auxiliaire. 

3  Pour définir le volume de retour (par défaut : 
–∞ dB), réglez le fader de l'entrée auxiliaire. 

Pistes de fader principal

Les pistes de fader principal contrôlent les 
niveaux généraux des voies de sortie et des bus. 
Lorsqu'elles sont affectées à un chemin de sortie 
ou de bus actif, elles permettent de contrôler les 
traitements par effets post-fader et le niveau 
général d'un mixage principal, les mixages pour 
casque, des retours, des stems (prémixages), les 
départs d'effets et d'autres applications 
d'assignation de signaux. Les pistes de fader 
principal prennent en charge tous les formats de 
pistes reconnus par votre système Pro Tools.

Vous trouverez des exemples de prémixage 
dans la section Acheminement de signal 
pour l'écoute et le prémixage, page 750.

Flux de signaux audio, pistes de fader principal

Volume

Sortie

Sortie principale
Sorties +

(plug-in ou 
matériel)

Inserts 
post-fader 
(après 
fader)

Entrée (source) déterminée 
par affectation de sortie (ou 
autres pistes)

supplémentaires



Chapitre 28 : Mixage : principes de base 725

Contrairement aux inserts des pistes audio et 
des entrées auxiliaires, les inserts de fader 
principal sont placés après le fader. Il est ainsi 
possible d'insérer un plug-in de dithering ou un 
équivalent sur le mixage Master. Pour en savoir 
plus sur le dithering, reportez-vous à la section 
Dithering, page 761.

Les faders principaux fournissent jusqu'à cinq 
inserts post-fader, mais aucun départ. Les pistes 
de fader principal ne disposent pas non plus de 
curseurs de panoramique, ni de boutons Mute 
ou Solo.

Utilisations courantes des pistes de fader 
principal

Vous pouvez utiliser des pistes de fader principal 
pour :

• Contrôler le niveau et traiter des mixages 
de sortie.

• Ecouter et visualiser une sortie sur un 
vumètre (par exemple une sortie de bus ou 
une sortie matérielle) pour éviter l'écrêtage.

• Contrôler des niveaux de prémixage.

• Contrôler des niveaux de départs d'effets.

• Contrôler des niveaux de pistes submaster 
(envoyées sur un bus).

• Appliquer un traitement de dithering ou 
autres traitements d'insert à tout un 
mixage.

Utilisez les faders principaux pour contrôler les 
niveaux de prémixage, de généraux de départs 
d'effets et autres sorties. Les faders principaux 
peuvent contrôler des sorties d'interface audio 

ou des bus internes. Un fader principal stéréo 
contrôle le niveau d'une paire de sorties. Les 
faders principaux ne consomment aucune 
ressource de traitement audio de votre système.

Pour utiliser un fader principal comme commande 
de volume stéréo principal :

1  Créez une piste de fader principal stéréo.

2  Configurez les sorties de toutes les pistes audio 
de la session sur le chemin de sortie principal 
(par exemple sorties 1-2 de votre interface audio 
primaire), puis réglez le panoramique de chaque 
piste.

3  Configurez la sortie de la piste du fader 
principal sur le chemin de sortie principal. 

Vumètres de fader principal

Les niveaux visualisés par les vumètres associés 
aux pistes de fader principal sont toujours 
mesurés après fader, quel que soit le réglage de 
Pre-Fader Metering dans le menu Options. 

Pistes de fader principal et voies

Vous pouvez attribuer des pistes de fader 
principal à des chemins principaux ou à des 
sous-chemins, comme défini dans la boîte de 
dialogue I/O Setup. Il est impossible d'assigner 
plusieurs pistes de fader principal au même 
chemin.

Faders principaux actifs et inactifs

Lorsqu'une piste de fader principal est inactive, 
les plug-in associés, les assignations d'I/O et 
leurs ressources sont désactivés. 

Lorsqu'une affectation de sortie de piste de fader 
principal (assignation à un chemin) est 
désactivée, la piste de fader principal ne contrôle 
plus le gain principal du chemin concerné.

Si vous devez absolument avoir un insert 
pré-fader sur votre signal de fader principal, 
configurez une entrée auxiliaire avant le 
fader principal.
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La duplication d'une piste Master Fader 
désactive son assignation.

Pistes d'instrument

Les pistes d'instruments offrent les mêmes 
options d'assignation des signaux audio que les 
pistes d'entrée auxiliaire, à ceci près que leurs 
entrées doivent provenir du plug-in d'un 
instrument inséré sur la piste d'instrument ou, 
d'un bus ou d'une entrée matérielle. Les pistes 
d'instruments fournissent jusqu'à dix inserts 
placés avant le fader.

Les pistes d'instruments sont utilisées en tant 
qu'entrées de plug-in d'instruments, et d'autres 
sources (y compris, de bus internes). 
Elles peuvent être entièrement automatisées. 
Lorsque vous utilisez des pistes d'instruments 
pour accueillir des sources externes, c'est sur ces 
sources elles-mêmes qu'il convient de régler le 
volume de sortie afin d'obtenir un niveau 
d'enregistrement correct. 

Utilisations courantes des pistes d'instruments

La lecture MIDI à partir ou via une piste 
d'instrument vous permet de contrôler l'audio :

• de plug-in d'instrument, tels que des 
synthétiseurs logiciels ou des 
échantillonneurs ;

• d'instruments MIDI externes, tels que des 
synthétiseurs logiciels ou des 
échantillonneurs.

Pour transférer les données audio d'un instrument 
MIDI externe vers une piste d'instrument :

1  Cliquez sur le sélecteur de chemin d'entrée de 
la piste d'instrument et sélectionnez l'entrée 
matérielle correspondant à votre instrument 
MIDI externe.

2  Pour choisir un chemin de bus ou de sortie, 
cliquez sur le sélecteur de chemin de sortie de la 
piste d'instrument. 

3  Dans la vue Instruments, cliquez sur le 
sélecteur d'entrée MIDI et affectez un 
périphérique et un canal à partir du menu 
contextuel pour enregistrer et contrôler 
l'instrument MIDI externe.

4  Dans la vue Instruments, cliquez sur le 
sélecteur de sortie MIDI et affectez un port et un 
canal à l'instrument MIDI externe à partir du 
menu contextuel.

5  Pour définir le volume, réglez le curseur de 
l'instrument (par défaut –∞ dB).

Flux de signaux audio, pistes d'instruments

Inserts

Départs,

Volume 

Sortie principale

pré-fader

Solo/Mute

Panora-

Sorties 

Départs,post-fader 

Sortie

+

Entrée

Record
(MIDI 

Plug-in d'instrument, 
bus interne ou 

instrument matériel

(plug-in ou 
inserts 
matériels)

unique-
ment)

(après fader)

mique

supplémentaires
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Pistes de VCA principal
(Pro Tools HD uniquement)

Les pistes de VCA principal reproduisent le 
fonctionnement des canaux amplificateurs 
contrôlés par voltage des consoles analogues, où 
un fader de canal VCA est utilisé pour contrôler, 
regrouper, ou décaler les niveaux de signal 
d'autres canaux de la console.

Les pistes de VCA principal ne transmettent pas 
de données audio. Elles n'ont par conséquent 
pas d'entrées, de sorties, d'inserts ou d'envois. 
Les pistes de VCA principal sont associées à un 
groupe de mixage, qui apparaît dans le sélecteur 
d'assignation de groupe. Les commandes des 
pistes de ce groupe de mixage (appelées pistes 
esclaves ) sont modifiées par celles de la piste de 
VCA principal. 

Comportement de groupe et commandes de 
pistes esclaves VCA

Lorsqu'un groupe est attribué à une piste de VCA 
principal, par défaut, les commandes de ses 
pistes esclaves ne suivent pas les comportements 
de groupe paramétrés dans la page Attributes de 
la boîte de dialogue des groupes. Cela constitue 
le comportement standard des opérations VCA. 
Cependant, vous pouvez paramétrer les pistes 
esclaves de façon à ce qu'elles suivent un 
comportement de groupe. Pour plus 
d'informations, reportez-vous à la section 
Autorisation de comportement de groupe pour 
les commandes des pistes esclaves, page 729.

Pour plus d'informations sur l'affectation 
d'une entrée et d'une sortie MIDI à des 
pistes d'instrument, reportez-vous à la 
rubrique Affectation d'entrée et de sortie 
MIDI aux pistes d'instrument, page 165.

Pour plus d'informations sur l'insertion de 
plug-in d'instrument sur des pistes 
d'instrument, reportez-vous à la rubrique 
Insertion de plug-in d'instrument sur les 
pistes d'instrument, page 165.

Piste de VCA principal

Sélecteur d'assignation 

Identification de groupe VCA

Indicateur de type de 

TrackInput 

Mute

Record

Volume

Mise 

Enable

Vumètre de niveau

de groupe

en solo

piste VCA
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Commandes de pistes de VCA principal

Les commandes d'une piste de VCA principal 
affectent les commandes correspondantes des 
pistes esclaves du groupe de mixage assigné. 
Les commandes suivantes sont disponibles :

Volume

Le fader de volume VCA contrôle le fader de 
volume des pistes audio, d'entrée auxiliaire, 
d'instrument, de fader principal et des autres 
pistes de VCA principal dans un groupe contrôlé 
par VCA (les faders de volume des pistes MIDI ne 
sont pas affectés). Les faders de volume des 
pistes esclaves se déplacent pour montrer le 
niveau composite (niveau de chaque piste 
résultant de la contribution du fader de volume 
de la piste de VCA principal). 

Mute

Le bouton Mute des pistes de VCA contrôle la 
mise en sourdine des pistes audio, d'entrées 
auxiliaires, d'instrument, MIDI et des autres 
pistes de VCA principal dans un groupe contrôlé 
par VCA. La mise en sourdine d'un groupe 
contrôlé par VCA ne modifie pas l'état d'origine 
des pistes esclaves (les boutons Mute des pistes 
esclaves dont le son a été activé affichent une 
mise en sourdine implicite). 

Mise en solo

Le bouton Solo des pistes de VCA contrôle la 
mise en solo des pistes audio, d'entrées 
auxiliaires, d'instrument, MIDI et des autres 
pistes de VCA principal dans un groupe contrôlé 
par VCA.

• La mise en solo d'une piste de VCA 
principal coupe implicitement le son de 
toutes les pistes à l'exception de ses pistes 
esclaves. Celles-ci sont donc indirectement 
mises en solo.

• Cette opération entraîne la désactivation 
de tous les solos explicites sur les pistes 
esclaves. Celles-ci sont mises en solo 
indirectement et toutes les autres pistes 
sont implicitement mises en sourdine.

• La mise en solo explicite d'une piste esclave 
alors que la piste de VCA principal 
correspondante est également mise en solo 
écrase le solo de la piste principale.

Bouton d'enregistrement

Le bouton d'activation en enregistrement de la 
piste VCA permet de changer le mode Record 
Enable des pistes audio, d'instrument et des 
autres pistes VCA ayant déjà été activées 
individuellement pour l'enregistrement. 
Une fois les pistes définies individuellement, 
vous pouvez activer ou désactiver 
l'enregistrement à l'aide de ce bouton. 

Pour forcer temporairement les pistes esclaves à 
basculer leur statut d'enregistrement :

" Cliquez sur le bouton d'activation en 
enregistrement de la piste de VCA principal tout 
en maintenant la touche Alt (Windows) ou 
Option (Mac) enfoncée.
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TrackInput 

Le bouton TrackInput des pistes VCA permet 
d'activer ou de désactiver l'écoute des signaux 
d'entrée des pistes audio activées pour 
l'enregistrement d'un groupe contrôlé par VCA. 
Une fois les pistes activées pour 
l'enregistrement, bouton TrackInput permet 
d'alterner le statut d'écoute des signaux d'entrée 
pour ces pistes. 

Pour forcer temporairement les pistes esclaves à 
basculer leur statut d'écoute des signaux 
d'entrée :

" Cliquez sur le bouton TrackInput de la piste 
de VCA principal tout en maintenant la touche 
Alt (Windows) ou Option (Mac) enfoncée. 

Afficheur de niveau

Sur les pistes de VCA principal, les vumètres 
indiquent le niveau le plus élevé observé sur 
l'une des pistes esclaves, et non la somme des 
niveaux de toutes les pistes esclaves. 

Le format de canal des vumètres de la piste de 
VCA principal est défini selon les formats de 
canal des pistes esclaves, comme suit :

• Si toutes les pistes esclaves ont le même 
format de canal (mono, stéréo ou 
multicanaux), la piste de VCA principal 
contient autant de vumètres que les pistes 
esclaves.

• Si les pistes esclaves ont des formats 
différents, la piste de VCA principal 
contient un seul vumètre.

Activation en enregistrement, 
TrackInput et pistes esclaves

Lorsqu'une piste esclave est activée pour 
l'enregistrement (bouton Record Enable allumé) 
ou sur le mode Input Only (bouton TrackInput 
allumé), son automation est temporairement 
désactivée et son curseur de volume n'est plus 
affecté par la piste de VCA principal.

Autorisation de comportement de 
groupe pour les commandes des pistes 
esclaves

Lorsqu'une piste est une piste esclave VCA, ses 
commandes Volume, Mute, Solo, Record Enable 
et Input Monitoring suivent les fonctions VCA 
et ne suivent normalement pas le 
comportement du groupe de mixage. 

Cependant, vous pouvez paramétrer ces 
commandes de pistes esclaves pour autoriser le 
comportement de groupe de mixage en plus des 
fonctions VCA.

Pour autoriser le comportement de groupe des 
commandes VCA sur les pistes esclaves :

1  Choisissez Setup > Preferences et cliquez sur 
Mixing. 

2  Dans la section Automation, désélectionnez 
l'option Standard VCA Logic for Group 
Attributes. 

Les commandes Volume, Mute, Solo, Record 
Enable et Input Monitoring sont alors 
disponibles en tant qu'attributs de groupe de 
mixage dans la boîte de dialogue Group. 
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Attribution de groupes aux pistes de 
VCA principal

Vous pouvez assigner un groupe de mixage 
existant à une piste de VCA principal. Vous 
pouvez également assigner un nouveau groupe 
de mixage lors de sa création. Vous ne pouvez 
assigner qu'un groupe à la fois à une piste de 
VCA principal. Une piste de VCA principal ne 
peut pas contrôler un groupe qui s'inclut 
lui-même.

Pour assigner un groupe existant à une piste de 
VCA principal :

" Cliquez sur le sélecteur d'assignation de 
groupe sur la piste de VCA principal et 
sélectionnez un groupe disponible dans le menu 
contextuel.

Pour assigner un nouveau groupe à une piste de 
VCA principal :

1  Lors de la création d'un nouveau groupe, 
sélectionnez Mix ou Mix/Edit en tant que type 
de groupe.

2  Dans la boîte de dialogue des groupes, 
sélectionnez une piste de VCA principal à partir 
du menu déroulant VCA. 

Appartenance de pistes à plusieurs 
groupes VCA

Une piste esclave peut être membre de plusieurs 
groupes contrôlés par VCA. Dans ce cas, les 
contributions de tous les faders de volume de 
pistes de VCA principal sont additionnées sur la 
piste esclave. Les commandes Mute, Solo, 
Record Enable et TrackInput suivent les même 
règles pour l'activation ou la désactivation des 
pistes esclaves. 

Inserts
Pro Tools permet d'introduire jusqu'à cinq 
inserts sur chaque piste audio, entrée auxiliaire, 
fader principal ou piste d'instrument. Chaque 
insert peut être un insert de plug-in logiciel, un 
insert matériel ou un plug-in d'instrument.

Les inserts offrent les fonctionnalités suivantes : 

• Les plug-in et les inserts matériels acheminent 
les signaux à partir de la piste à travers l'effet 
de votre choix, puis les renvoient 
automatiquement vers la même piste. 

• Les inserts matériels envoient et revoient le 
signal vers les canaux d'entrée et de sortie 
correspondants d'une interface audio, laquelle 
peut être assignée à des effets externes.

• Certains plug-in d'instrument (notamment 
Virus Indigo) acceptent de l'audio à partir de 
l'entrée de piste, vous permettant ainsi de 
vous en servir comme des plug-in de 
traitement.

• Les inserts des pistes audio, des entrées 
auxiliaires et des pistes d'instrument sont 
disposés avant le fader. 

• Les inserts des pistes de fader principal sont 
placés après fader.

• Les inserts peuvent être désactivés.

Assignation d'un groupe existant à une piste VCA 
principal

Assignation d'un nouveau groupe à une piste de VCA 
principal
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• La plupart des commandes de plug-in sont 
entièrement automatisables.

Format des sorties de piste et plug-ins

Pro Tools prend en charge les plug-in mono, 
multimono, stéréo et multicanaux (Pro Tools 
HD avec Surround Mixer uniquement). 

Les inserts fonctionnant en série, la 
modification du format d'un plug-in risque 
d'altérer le format du canal. L'insertion d'un 
plug-in mono-stéréo sur une entrée auxiliaire 
mono, par exemple, modifie le chemin du signal 
à partir de ce plug-in et sur tout le reste de la 
piste. Ce phénomène impose que les inserts 
matériels ou les plug-in insérés après un plug-in 
stéréo soient des plug-in stéréo en entrée comme 
en sortie (ou d'un format multicanal pris en 
charge). 

Formats de plug-in

Pro Tools prend en charge les plug-in mono et 
stéréo, notamment les chemins de plug-in des 
trois types suivants : 

• Entrée mono/sortie mono

• Entrée mono/sortie stéréo

• Entrée stéréo/sortie stéréo

Les sessions Pro Tools HD exécutées avec la 
console Surround prennent aussi en charge les 
plug-in de 3 à 8 canaux, multimono et 
multicanaux.

Vues dans les fenêtres Mix 
et Edit
Vous pouvez configurer les fenêtres Mix et Edit 
pour afficher ou masquer un certain nombre de 
commandes de mixage à l'aide des commandes 
de menu ou des sélecteurs de vue. 

La plupart de ces vues sont disponibles dans les 
deux fenêtres, sauf indication contraire.

Sélecteurs de vue de fenêtre

La fenêtre Edit et la fenêtre Mix offrent 
disposent de sélecteurs de vue de fenêtre 
permettant de configurer leurs vues.

Pour en savoir plus sur l'utilisation des 
plug-in et des inserts, reportez-vous au 
chapitre 29, Inserts de plug-in et inserts 
matériels.

Sélecteur de vue de la fenêtre Edit

Sélecteur de vue de la fenêtre Mix

Cliquez sur le sélecteur de vue de la fenêtre Edit

Cliquez sur le sélecteur de vue 
de la fenêtre Mix
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Affichage des vues

Pour afficher toutes les vues dans la fenêtre Mix 
ou Edit, effectuez l'une des opérations suivantes :

" Sélectionnez View > Mix Window (ou Edit 
Window) > All.

– ou –

" Cliquez sur le sélecteur de vue de la fenêtre 
Mix (ou le sélecteur de vue de la fenêtre Edit), 
puis sélectionnez All.

Pour n'afficher aucune vue dans la fenêtre Mix ou 
Edit, effectuez l'une des actions suivantes :

" Sélectionnez View > Mix Window (ou Edit 
Window) > None.

– ou –

" Cliquez sur le sélecteur de vue de la fenêtre 
Mix (ou le sélecteur de vue de la fenêtre Edit), 
puis sélectionnez None.

Pour afficher (ou masquer) les vues disponibles 
dans les fenêtres Mix et Edit, effectuez une des 
opérations suivantes :

" Sélectionnez View > Mix Window (ou Edit 
Window), puis un des types de vue (par 
exemple, Comments).

– ou –

" Cliquez sur le sélecteur de vue de la fenêtre 
Mix (ou le sélecteur de vue de la fenêtre Edit), 
puis sélectionnez un des types de vue (par 
exemple, Comments).

Vue Comments Affiche tout texte de 
commentaire saisi dans la boîte de dialogue 
Track Name/Comments. Pour plus 
d'informations, reportez-vous à la section 
Attribution de noms aux pistes, page 147.

Mic Preamps View (Pro Tools HD uniquement) : 

Affiche les commandes de chaque piste pour 
Digidesign PRE. Pour masquer ces éléments, 
désélectionnez l'option. Pour des informations 
détaillées, consultez le Guide PRE.

Vue Instruments Affiche les commandes MIDI 
des pistes d'instrument (sélecteur d'entrée MIDI, 
sélecteur de sortie MIDI, volume MIDI, 
panoramique MIDI et coupure de son MIDI).

Vue Comments dans les fenêtres Mix et Edit

Vue Mic Preamps

Vue Instruments

Vue Comments
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Vue Inserts Affiche les inserts (plug-in logiciels 
et inserts d'I/O matériels) pour chaque piste. 
Pour masquer ces éléments, désélectionnez 
l'option.

Vue Sends (Sends A–E et Sends F–J) Affiche les 
affectations de départs pour chaque piste. Pour 
masquer ces éléments, désélectionnez l'option. 
Pour plus d'informations, reportez-vous à la 
section Configuration de la vue Sends dans les 
fenêtres Mix et Edit, page 739.

Vue I/O (fenêtre Edit uniquement) Affiche les 
sélecteurs d'entrée et de sortie, ainsi que les 
indicateurs de volume et de panoramique pour 
chaque piste. Pour masquer ces éléments, 
désélectionnez l'option.

Tout en maintenant la touche Maj (Windows) 
ou la touche Ctrl (Mac) enfoncée, cliquez sur les 
champs de volume ou de panoramique de la vue 
I/O dans la fenêtre Edit pour régler le volume ou 
les commandes de panoramique à l'aide d'un 
curseur contextuel.

Vue Real-Time Properties (fenêtre Edit 
uniquement) Affiche les commandes des 
propriétés en temps réel des pistes MIDI et 
d'instrument. Pour plus d'informations sur les 
propriétés en temps réel, voir Propriétés MIDI en 
temps réel, page 700.

Vues dans la fenêtre Mix

Vue I/O (fenêtre Edit)

Vue Inserts

Vue Sends (A-E)

Vue des I/O

Vue Sends (F-J)

Curseur contextuel du volume de la vue I/O (fenêtre 
Edit)

Curseur contextuel du panoramique de la vue 
I/O (fenêtre Edit)

Vue Real-Time Properties (fenêtre Edit)
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Vue Delay Compensation (fenêtre Mix sur 
Pro Tools HD uniquement) La vue de 
compensation de retard indique la quantité 
totale de retard sur chaque piste. Elle permet 
d'appliquer un décalage défini par l'utilisateur 
pour le retard de piste et elle affiche la quantité 
totale de retard appliquée par Pro Tools à 
chaque piste. La vue de compensation de retard 
est affichée dans la fenêtre Mix. 

Les valeurs de retard peuvent être exprimées en 
échantillons ou en millisecondes, comme 
sélectionné sur la page Display Preferences. Pour 
en savoir plus sur la compensation de retard, 
reportez-vous à la section Compensation de 
retard, page 757.

Vue des couleurs de piste Affiche la couleur de 
piste de chaque piste. Pour masquer ces 
éléments, désélectionnez l'option. Pour plus 
d'informations, reportez-vous à la rubrique 
Codage couleur des pistes, des régions, des 
marqueurs et des groupes, page 171.

Vue Transport (fenêtre Edit uniquement) Affiche 
les commandes de transport fonctionnelles dans 
la partie supérieure de la fenêtre Edit. 
Ces commandes sont identiques à celles de la 
fenêtre Transport. Pour plus d'informations, 
reportez-vous à la section Fenêtre Transport :, 
page 119.

Masquage de vues dans la fenêtre Edit

Vous pouvez rapidement masquer des colonnes 
dans la fenêtre Edit à l'aide d'un simple raccourci 
clavier. 

Pour masquer une colonne dans la fenêtre Edit :

" Tout en maintenant la touche Alt (Windows) 
ou la touche Option (Mac) enfoncée, cliquez en 
haut de la colonne à masquer (Mic Pre, 
Comments, Instrument, Inserts, Sends A-E, 
Sends F-J, I/O, Real-Time Properties ou Track 
Color).

Chemins d'entrée et de sortie 
audio
Pro Tools vous permet de configurer les entrées 
et sorties physiques de vos interfaces audio, ainsi 
que les chemins et sous-chemins de bus internes 
dans la boîte de dialogue I/O Setup et la boîte de 
dialogue Hardware Setup. Ces entrées et sorties 
matérielles, ainsi que ces chemins de bus 
internes peuvent être affectés en tant qu'entrées 
et sorties de pistes audio, de pistes d'entrée 
auxiliaire, de pistes d'instrument et de faders 
principaux.

Chemin d'entrée audio

Les sélecteurs de chemin d'entrée déterminent 
l'entrée source des pistes audio, des pistes 
d'entrée auxiliaire et, de manière facultative, des 
pistes d'instrument. Les entrées de piste peuvent 
être configurées à partir de chemins ou 
sous-chemins d'entrée matérielle ou de bus 
interne. Pour plus d'informations sur 
l'affectation d'entrées de piste, reportez-vous à la 
rubrique Assignation des entrées vers les pistes 
audio, page 156.

Affichage de la compensation de retard

Commandes de transport (fenêtre Edit)

Indicateur de retard

Décalage défini par

Indicateur de 
compensation de 
piste 

de plug-in

l'utilisateur
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Les chemins d'entrée matérielle et de bus 
peuvent être configurés dans la boîte de 
dialogue I/O Setup. Pour plus d'informations, 
consultez la section chapitre 6, Configuration 
des E/S.

Vous pouvez également définir les ports 
physiques à acheminer vers les ports d'entrée de 
Pro Tools dans la page Main de la boîte de 
dialogue Hardware Setup. Pour plus 
d'informations, reportez-vous à la section 
Configuration des paramètres du système 
Pro Tools (dans le moteur de lecture), page 40.

Chemin de sortie audio

Les sélecteurs de chemin de sortie de piste 
envoient les signaux après fader aux sorties ou 
aux chemins de bus assignés. Le sélecteur de 
chemin de sortie envoie la sortie de piste 
principale au chemin principal ou secondaire 
choisi. Les pistes peuvent être envoyées 
directement vers des chemins et sous-chemins 
de sorties matérielles ou de bus internes en vue 
du prémixage (des chemins principal et 
secondaire). 

Le format de piste (mono, stéréo ou multicanal) 
détermine les choix de chemin principal et de 
sous-chemins disponibles pour la sortie de piste. 
Pour plus d'informations sur l'affectation de 
sorties de piste, reportez-vous à la rubrique 
Assignation des sorties des pistes audio, 
page 157.

Le format mono, stéréo ou multicanal stéréo ou 
supérieur des pistes audio, des pistes d'entrée 
auxiliaire, des pistes de fader principal et des 
pistes d'instrument, est défini lors de la création 
des pistes :

• Les pistes mono peuvent être affectées à tout 
chemin principal ou à tout sous-chemin 
mono, stéréo ou multicanal disponible.

• Les pistes stéréo peuvent être affectées à tout 
chemin principal ou à tout sous-chemin 
mono, stéréo ou multicanal disponible.

• Les pistes multicanaux (Pro Tools HD 
uniquement) peuvent être affectées à tout 
chemin mono ou tout chemin offrant un 
même nombre de canaux (par exemple, la 
piste LCRS peut être affectée à un chemin 
LCRS ou mono). 

Fenêtres Output

Les fenêtres Output contiennent les principales 
commandes de mixage de piste (telles que le 
panoramique de piste et le volume), comme 
alternative aux vues des fenêtres Mix et Edit. Les 
fenêtres Multichannel Output et Send 
fournissent également des vues panoramiques 
étendues et d'autres commandes spécifiques à 
l'effet Surround Voir chapitre 34, Panoramique 
et mixage en mode Surround (Pro Tools HD 
uniquement).

Au cours des grandes sessions, les fenêtres 
Output permettent de conserver les pistes 
importantes ancrées à un emplacement que les 
déplacements des fenêtres Mix et Edit (ou de la 
table de mixage) ne peuvent pas modifier. Pour 
plus d'informations, reportez-vous à la section 
Fenêtres Output pour les pistes et les départs, 
page 744.

Assignations de sorties multiples

Les pistes audio, les pistes d'entrée auxiliaire et 
les pistes d'instrument Pro Tools peuvent être 
assignées à plusieurs chemins de sortie. 
L'assignation d'un même mixage à plusieurs 
chemins constitue un moyen efficace de 
l'envoyer simultanément vers des sorties 
différentes, par exemple pour alimenter des 
moniteurs, fournir un mixage casque, ou toute 
autre situation où un mixage en parallèle est 
nécessaire.
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Pour affecter une piste à plusieurs sorties :

1  Affectez un chemin de sortie principal en le 
choisissant dans le sélecteur de chemin de sortie 
de la piste. 

2  Cliquez en appuyant sur la touche de 
démarrage (Windows) ou Ctrl (Mac) pour 
sélectionner un autre chemin de sortie dans le 
sélecteur de chemin de sortie de la piste. La 
nouvelle destination de sortie est ajoutée en tant 
que sortie supplémentaire. 

Affichage des assignations de sorties multiples

Lorsqu'une piste est assignée à plusieurs 
chemins de sortie, le sélecteur de chemin de 
sortie signale son état (assignations, 
actif/inactif) à l'aide des indicateurs suivants :

• Le signe plus (+) indique que plusieurs sorties 
sont assignées à cette piste. 

• Dans le menu du sélecteur de chemin de 
sortie, toutes les sorties actuellement affectées 
à la piste sont cochées afin d'indiquer qu'elles 
sont actives. 

• Un astérisque (*) indique qu'une ou plusieurs 
sorties affectées sont inactives. 

Sorties inactives

Vous pouvez désactiver un chemin de sortie en 
totalité dans la boîte de dialogue I/O Setup 
(ce qui affectera toutes les pistes assignées à ce 
chemin) ou par assignation (ce qui concernera 
uniquement une sortie spécifique de la piste 
audio ou de l'entrée auxiliaire). 

A l'ouverture d'une session, si le périphérique 
nécessaire ou les autres ressources ne sont pas 
disponibles, les sorties sont automatiquement 
désactivées. 

Les sorties inactives conservent toutes les 
playlists d'automation associées. Les 
modifications réalisées au cours de la session 
affectent également les playlists d'automation 
de sortie des pistes inactives.

Sorties inactives et ressources DSP

La désactivation d'une sortie de piste la coupe, 
tout en conservant toutes les données de playlist 
et d'automation. Les sorties inactives n'utilisent 
pas de ressources pour les connexions à la 
console TDM, toutefois les plug-in assignés à la 
piste continuent d'exploiter les ressources DSP 
requises. Les plug-in RTAS utilisent les 
ressources de l'unité centrale tandis que les 
plug-in TDM utilisent les ressources DSP 
disponibles sur les cartes Pro Tools|HD. 

Pour libérer les ressources DSP des plug-in 
inutilisés, vous pouvez désactiver la piste 
associée ou désactiver uniquement le plug-in. 

Appuyez sur les touches Démarrer+Alt 
(Windows) ou Option+Ctrl (Mac) tout en 
cliquant pour ajouter l'assignation à toutes 
les pistes ou appuyez sur les touches 
Alt+Démarrer+Maj (Windows) ou 
Option+Maj+Ctrl (Mac) pour ajouter 
l'assignation à toutes les pistes 
sélectionnées.

Indication de l'assignation à plusieurs sorties

Pour plus d'informations, reportez-vous à la 
section Inactivation des pistes, page 170.

Pour en savoir plus, reportez-vous aux 
sections Eléments actifs et inactifs, page 14 
et Désactivation des inserts, page 769.
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A propos de l'option No Output

Les sorties de piste peuvent être réglées sur No 
Output. Le choix de cette option entraîne la 
perte de toute automation de panoramique 
associée à la piste.

Les pistes ainsi configurées ne sont pas audibles, 
mais ne libèrent pas pour autant les ressources 
DSP associées. 

Envois
Pro Tools permet d'introduire jusqu'à dix 
départs (A–E et F–J) sur chaque piste audio, piste 
d'entrée auxiliaire ou piste d'instrument.

Les départs offrent les fonctionnalités 
suivantes : 

• Les signaux de départ peuvent être prélevés 
avant ou après fader.

• Les commandes de niveau de départ, de 
panoramique, de mise en sourdine et LFE 
peuvent être configurées pour suivre ou non 
les groupes.

• Le niveau, la coupure (Mute) et le 
panoramique du départ (dans le cas de départs 
stéréo ou multicanaux) peuvent être 
entièrement automatisés. Pour plus 
d'informations, reportez-vous à la section 
Automation des envois, page 808.

• Les commandes des départs peuvent être 
affichées et modifiées dans les fenêtres Mix ou 
Edit ou dans leurs propres fenêtres Output.

• Les départs peuvent être assignés à tout 
chemin de sortie et de bus disponible 
(chemins principaux ou sous-chemins), au 
format mono, stéréo ou dans tout format 
multicanal pris en charge pour le mixage 
Surround. 

• Chaque départ peut avoir plusieurs 
affectations (vers des chemins de sortie et de 
bus disponibles, par exemple).

Les signaux des départs peuvent être réinjectés 
dans le mixage via une entrée auxiliaire, une 
piste audio ou une piste d'instrument pour être 
audible dans Pro Tools. Ils peuvent être écoutés 
et traités à travers une entrée auxiliaire (ou une 
piste d'instrument), enregistrés sur des pistes 
audio et prémixés sur disque. Les notions de 
prémixage et de mixage final sont exposées au 
chapitre 31, Mixage final.

Affectation de départs à des 
pistes

Pour ajouter un départ à une piste :

1  Assurez-vous que la vue Sends est activée dans 
la fenêtre Mix ou Edit (pour en savoir plus, 
reportez-vous à la section Vues dans les fenêtres 
Mix et Edit, page 731). 

2  Cliquez sur le sélecteur Send de la piste, puis 
choisissez un chemin dans le menu déroulant.

Affectation d'un départ à un chemin de bus stéréo
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Le départ peut être assigné à un chemin de sortie 
mono ou stéréo (ou dans tout format multicanal 
pris en charge pour le mixage Surround) ou de 
bus.

3  Définissez le niveau de sortie de l'envoi dans la 
fenêtre Send en effectuant l'une des opérations 
suivantes :

• Réglez le fader du niveau de départ.

– ou –

• Pour régler le niveau d'un départ sur le gain 
unitaire (0 dB), maintenez enfoncée la 
touche Option (Mac) ou Alt (Windows) 
tout en cliquant sur le fader du niveau de 
départ.

Lors de la création d'un nouvel envoi, son 
niveau de sortie initial dépend des paramètres 
de la préférence Sends Default to -INF.

Pour modifier la configuration par défaut des 
départs :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Operation.

2  Effectuez l'une des opérations suivantes :

• Sélectionnez Sends Default to « -INF ».

– ou –

• Désélectionnez Sends Default to « -INF ». 
Les nouveaux départs seront configurés par 
défaut sur le gain unitaire (0 dB).

Pour supprimer un départ d'une piste :

" Cliquez sur le bouton Sends de la piste, puis 
choisissez No Send dans le menu déroulant. 

Formats de départs

Départs mono et stéréo Si vous cliquez sur le 
bouton Sends d'une piste, la liste des sorties ou 
des chemins de bus mono ou stéréo s'affiche à 
l'écran. 

Départs multicanaux (Pro Tools HD uniquement) 

Si vous cliquez sur le bouton Sends d'une piste, 
la liste des sorties ou des chemins de bus 
multicanaux s'affiche à l'écran. 

Fenêtre Send (mono)
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Choix des chemins de départ

Les sélecteurs de départs permettent de choisir 
les chemins de bus et de sortie.

Bus de mixage internes Les systèmes Pro Tools 
HD offrent 128 bus pour le routage interne des 
signaux et les systèmes Pro Tools LE, 32. Ces 
chemins de bus internes facilitent les 
prémixages et les traitements avec des plug-in. 
Les chemins de bus sont définis dans la boîte de 
dialogue I/O Setup et sont disponibles dans tous 
les formats de canaux pris en charge (mono, 
stéréo ou multicanaux, selon le système).

Sorties matérielles les départs matériels sont 
souvent réservés aux mixages casques ou à 
l'envoi de signaux vers des processeurs d'effets 
externes. Contrairement aux inserts matériels, 
les départs ne renvoient pas automatiquement 
le son. 

Configuration de la vue Sends 
dans les fenêtres Mix et Edit

Les pistes audio, les entrées auxiliaires et les 
pistes d'instrument incluent deux groupes de 
vues Sends : Sends A-E (départs 1 à 5) et Sends F-J 
(départs 6 à 10). Le menu View offre des options 
distinctes pour l'affichage de ces départs dans les 
fenêtres Mix et Edit.

Pour afficher les départs dans la fenêtre Mix :

" Sélectionnez l'une des options suivantes :

• View > Mix Window > Sends A-E.

• View > Mix Window > Sends F-J.

Pour afficher les départs dans la fenêtre Edit :

" Effectuez l'une des opérations suivantes :

• View > Edit Window > Sends A-E.

• View > Edit Window > Sends F-J.

Options de la vue Sends

Les départs apparaissent dans les fenêtres Mix et 
Edit conformément aux options des vues Sends 
A à E et des vues Sends F à J. Chacune de ces vues 
offre six options d'affichage : La vue Assignment 
et cinq vues Send individuelles (A–E ou F–J).

Vue Assignments

Il s'agit de la vue de départs par défaut, qui 
affiche les cinq départs (A à E ou F à J) sur toutes 
les pistes affichées dans les fenêtres Mix et Edit.

Dans la vue Assignment, les commandes de 
départ sont réglées à partir des fenêtres Send. 
Pour plus d'informations, reportez-vous à la 
section Pour faire apparaître une autre fenêtre 
Output ou la fenêtre Send :, page 745.

Vous pouvez personnaliser les noms, le 
format et la correspondance de chemins de 
bus et de sorties dans la boîte de dialogue 
I/O Setup. Pour plus d'informations, 
reportez-vous à la section Création et 
modification de chemins, page 60.

Vue des assignations, sans départ (à gauche) et avec un 
départ assigné (à droite)

Sélecteurs des départs

Vue de l'assignation du départ A
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Pour faire apparaître toutes les assignations des 
départs :

1  Si les départs ne sont pas visibles actuellement 
sur vos pistes, sélectionnez View > Mix Window 
(ou Edit Window) > Sends A-E (ou Sends F-J).

2  Effectuez l'une des opérations suivantes :

• Sélectionnez View > Sends A-E > 
Assignments ou View > Sends F-J > 
Assignments. 

– ou –

• Lorsque vous affichez des départs dans une 
vue Send individuelle (notamment une vue 
Send A), tout en maintenant la touche Ctrl 
(Windows) ou la touche Pomme (Mac) 
enfoncée, cliquez sur le sélecteur Send et 
sélectionnez Assignments.

Vues Send individuelles (A-J)

Les vues Send individuelles (notamment Send 
A) offrent des commandes de niveau de départ, 
de panoramique et de coupure de son pour un 
seul départ vers toutes les pistes. 

Vous pouvez régler les commandes de départs 
directement depuis ces vues Send. Les départs 
peuvent également être ouverts pour édition ou 
visualisation des niveaux dans les fenêtres Send. 
Pour plus d'informations, reportez-vous à la 
section Fenêtres Output pour les pistes et les 
départs, page 744.

Pour afficher les commandes associées à un 
départ spécifique sur toutes les pistes :

1  Si les départs ne sont pas visibles actuellement 
sur vos pistes, sélectionnez View > Mix Window 
(ou Edit Window) > Sends A-E (ou Sends F-J).

2  Effectuez l'une des opérations suivantes :

• Sélectionnez View > Sends A-E (ou Sends 
F-J) et sélectionnez une des vues 
individuelles Send (par exemple Send A).

– ou –

• Dans la vue Assignment, tout en 
maintenant la touche Ctrl (Windows) ou la 
touche Pomme (Mac) enfoncée, cliquez sur 
le sélecteur Send Assignment.

Vue du départ A, avec différents types d'assignation

Sans assignationPré-fader 
multicanal 

Post-fader 
stéréo 

Vues des départs

Sélecteur Send Assignment
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Modification des départs dans les 
fenêtres Mix et Edit (vues Send 
individuelles)

Les vues Send individuelles (par exemple Send 
A) font apparaître, départ par départ, tous les 
paramètres disponibles dans la zone consacrée 
aux départs dans les fenêtres Mix et Edit. Ces 
vues permettent d'accéder à toutes les 
commandes associées au départ concerné, sur 
toutes les pistes. 

Le niveau et la coupure du départ peuvent suivre 
les groupes Mix, ce qui permet d'ajuster les 
différentes commandes de départ depuis un seul 
jeu de commandes

Vues Send individuelles et vumètres de 
niveau de départ

Lors de l'affichage des commandes 
correspondant à un départ particulier, vous 
pouvez afficher les vumètres de niveau du 
départ.

Ces vumètres indiquent les valeurs crêtes ainsi 
que les écrêtages survenant lorsque ces vumètres 
sont affichés (si un départ est écrêté alors que 
son vumètre n'est pas affiché, cet écrêtage 
n'apparaît pas). Si vous utilisez un ordinateur 
plutôt lent, le masquage des vumètres des 
départs peut améliorer le rafraîchissement 
d'écran.

Pour afficher les vumètres lors de la visualisation 
de départs individuels :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Display.

2  Sélectionnez Show Meters in Sends View, puis 
cliquez sur OK.

Pour remettre à zéro l'indicateur d'écrêtage d'un 
vumètre de départ :

" Cliquez sur l'indicateur d'écrêtage. 

Pour réinitialiser tous les vumètres, effectuez 
l'une des opérations suivantes :

" Appuyez sur la touche Option et cliquez sur 
l'indicateur Clip.

" Sélectionnez Track > Clear All Clip Indicators.

" Appuyez sur les touches Alt+C (Windows) ou 
Option+C (Mac).

Affichage de l'état des départs

Lorsque vous affichez toutes les commandes 
d'une vue Send individuelle, l'indicateur d'état 
des départs est visible directement dans les 
fenêtres Mix et Edit.

Dans la vue Assignment, l'état des départs est 
affiché comme suit :

• Par défaut, le bouton Send est grisé, pour 
indiquer la non-coupure.

• Le texte du bouton Send est rouge lorsque le 
départ est écrêté.

• Le bouton Send est bleu lorsque le départ est 
coupé. 

Vue du départ A, départ stéréo

Bouton Send Mute
Curseurs Send Pan

Vumètre de niveau de départ

Bouton Pre/Post Fader

Sélecteur de départ

Bouton Send Assignment
Fader de 
niveau de 
départ

Dans la vue Assignment, vous pouvez 
modifier les départs en ouvrant la fenêtre 
Output correspondante. Pour plus 
d'informations, reportez-vous à la section 
Fenêtres Output pour les pistes et les 
départs, page 744.



Guide de référence Pro Tools742

• Le bouton Send est illuminé dès qu'une 
fenêtre de départ est ouverte. 

Si vous utilisez une surface de commande (telle 
que D-Control ou Digi 002) avec Pro Tools, le 
contrôleur actif est repéré par des contours 
colorés sur les départs, les inserts et les sorties.

Départs inactifs

Il est possible de désactiver les départs. Les 
départs inactifs libèrent leurs ressources de 
console et ressources DSP, mais conservent leur 
position dans la vue Sends de la piste. Les 
départs inactifs ne transmettent pas de données 
audio. Les départs inactifs conservent toutes les 
playlists d'automation associées. En outre, toute 
modification apportée à des régions de pistes 
comportant des départs inactifs peut encore 
affecter les playlists d'automation de départs.

A l'ouverture d'une session, les départs sont 
automatiquement désactivés en cas 
d'indisponibilité du matériel ou des autres 
ressources. 

Pour désactiver un départ :

" Maintenez enfoncées les touches 
Ctrl+Démarrer (Windows) ou Pomme+Ctrl 
pendant que vous cliquez sur l'assignation du 
départ.

– ou –

" Désactivez la piste. Pour plus d'informations, 
reportez-vous à la section Inactivation des 
pistes, page 170.

Pour activer ou désactiver les départs dans la 
même position (A-E) attribués au même chemin 
sur toutes les pistes :

" Maintenant enfoncées les touches 
Ctrl+Démarrer (Windows) ou Pomme+Ctrl 
(Mac) pendant que vous cliquez sur un bouton 
Send pour l'activer ou le désactiver.

Pour activer ou désactiver les départs dans la 
même position (A-E) attribués au même chemin 
sur toutes les pistes sélectionnées :

" Maintenant enfoncées les touches 
Ctrl+Démarrer+Alt+Maj (Windows) ou 
Pomme+Ctrl+Option+Maj (Mac) pendant que 
vous cliquez sur un bouton Send pour l'activer 
ou le désactiver.

Indication de coupure de départ, d'écrêtage et de l'état 
de la fenêtre

Non coupé Fenêtre ouverte
 (bouton Send illuminé)

Coupé 
(bleu) 

Écrêté
(texte rouge) 

Affichage de départs inactifs

 

Départ inactif 
(en italique et 

grisé)

Départ actif (en 
texte brut)

Piste inactive (la 
piste entière 

apparaît en italique 
et grisée)
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Déplacement ou copie de départs 

Les départs peuvent être déplacés ou copiés sur 
d'autres pistes ou à d'autres emplacements d'une 
même piste par la méthode conventionnelle du 
glisser-déposer. Les départs peuvent être déposés 
de façon à créer de nouveaux départs au niveau 
de la destination, ou déposés sur des 
assignations de départs existantes afin de les 
remplacer. 

Les départs peuvent être déplacés ou copiés sur 
des pistes comportant des formats de départs 
compatibles (mono, stéréo ou autre). Pro Tools 
vous avertit lorsque vous tentez de déplacer ou 
de copier un départ vers une destination non 
compatible. Pour en savoir plus, reportez-vous à 
la section Format des départs et compatibilité 
des pistes, page 743. 

Pour déplacer un départ :

" Cliquez sur le nom du départ et faites-le glisser 
à son nouvel emplacement sur la piste d'origine 
ou une autre piste. 

Pour copier un départ :

" Maintenez la touche Alt (Windows) ou la 
touche Option (Mac) enfoncée pendant que 
vous le faites glisser et le déposez à son nouvel 
emplacement. 

Le déplacement ou la copie d'un départ conserve 
toutes les affectations d'acheminement, 
l'automation (le cas échéant), les paramètres de 
niveau/panoramique/coupure de son, ainsi que 
le format de sortie. 

Format des départs et compatibilité des pistes

Les départs ne peuvent être copiés que sur des 
pistes comportant un format de sortie pour 
départs compatible (mono, stéréo ou autre). 
En outre, les conditions suivantes sont 
applicables lors du déplacement ou de la copie 
de départs d'une piste vers une autre :

• Lorsque vous copiez un départ stéréo d'une 
piste mono vers une piste stéréo, l'automation 
de panoramique du départ (le cas échéant) est 
déposée sans avertissement. 

• Lorsque vous copiez un départ stéréo d'une 
piste stéréo vers une piste mono, les données 
de gauche de l'automation de panoramique 
du départ sont conservées et celles de droite 
sont déposées. Une boîte de dialogue 
d'avertissement s'affiche pour vous permettre 
de confirmer ou d'annuler cette opération 
destructive. 

• Lorsque vous déplacez ou copiez un départ 
pour remplacer un départ existant, toute 
automation du départ existant est remplacé. 
Une boîte de dialogue d'avertissement 
s'affiche pour vous permettre de confirmer ou 
d'annuler cette opération destructive. 

Copie des paramètres des pistes 
sur les départs
(Pro Tools HD uniquement)

Il est parfois nécessaire que les paramètres de 
départ soient identiques à ceux de la piste 
elle-même ; par exemple, pour générer un 
mixage casque basé sur le mixage principal. 
Vous pouvez copier les valeurs actuelles ou la 
totalité de la playlist d'automation à partir de 
pistes sélectionnées à partir de n'importe lequel 
de leurs départs. 
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Liaison des commandes Send Pan 
et Main Pan

Vous pouvez lier des commandes de 
panoramique de départs individuels aux 
commandes de panoramique principales des 
pistes correspondantes. Cette fonctionnalité 
permet d'accélérer la définition des mixages de 
retour ou du traitement des effets. 

Les commandes de panoramique de départ liées 
apparaissent en gris clair.

Pour lier les commandes de panoramique de 
départ aux commandes de panoramique 
principales d'une piste :

1  Cliquez sur le bouton Send Assignment pour 
le départ que vous souhaitez lier pour ouvrir la 
fenêtre Send. 

2  Dans la fenêtre Send, cliquez sur le bouton 
FMP (Follow Main Pan). 

Pour modifier les paramètres par défaut FMP 
(Follows Main Pan) pour les départs récemment 
crées :

1  Choisissez Setup > Preferences et cliquez sur 
Mixing.

2  Dans Setup, sélectionnez ou désélectionnez 
l'option Send Pans Default to Follow Main Pan. 

Fenêtres Output pour les 
pistes et les départs
Les sorties de piste et les départs peuvent être 
ouverts pour affichage et édition dans des 
fenêtres prévues à cet effet. 

• Les fenêtres Output de pistes contiennent les 
commandes de fader de piste, de 
panoramique, d'automation, de Solo et de 
coupure (Mute). 

• Les fenêtres Send contiennent les réglages de 
niveau de départ, de coupure (Mute), de 
panoramique et d'automation. 

• Les commandes des fenêtres Standard Output 
et Send offrent des paramètres 
supplémentaires d'affectation, d'assignation 
et d'affichage.

Pour plus d'informations, reportez-vous à la 
section Copie des données d'automation de 
piste sur les envois, page 808.

Liaison de Send Pan à Main Pan
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Pour ouvrir la fenêtre Output d'une piste :

" Cliquez sur le bouton de la fenêtre Output 
dans la voie de console. 

Pour ouvrir une fenêtre Send :

" Cliquez sur le bouton Send Assignment dans 
la fenêtre Mix ou Edit. 

Pour faire apparaître une autre fenêtre Output ou 
la fenêtre Send :

" Cliquez sur un bouton de la fenêtre Output ou 
sur le bouton Send Assignment de la fenêtre Mix 
ou Edit. 

Si une fenêtre Output similaire, déjà ouverte, est 
signalée par l'illumination d'une icône Target 
(rouge, allumée), le nouveau départ sélectionné 
s'ouvre à sa place. 

Ouverture de plusieurs fenêtres Output

Il est possible de faire apparaître simultanément 
plusieurs fenêtres de piste et de départ à l'aide de 
l'une des méthodes ci-après : 

Pour ouvrir d'autres fenêtres Output :

" Tout en maintenant la touche Maj enfoncée, 
cliquez sur le bouton d'une fenêtre Output ou 
sur le bouton Send Assignment.

Ouverture d'une fenêtre Output de piste

Ouverture d'une fenêtre Send

Cliquez ici ou ici
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Pour maintenir une fenêtre ouverte lors de 
l'ouverture d'autres fenêtres Ouptut :

" Vérifiez que la cible est désactivée. 

Pour plus d'informations, voir Fenêtres 
« ciblées », page 749.

Liaison de panoramique

Les sorties stéréo offrent deux commandes de 
panoramique, une pour chaque côté de la paire 
gauche/droite. Les sorties multicanaux offrent 
un panoramique multicanal.

Les commandes de la fenêtre Output permettent 
de découpler (ou de coupler) des canaux pour 
générer un panoramique précis des pistes stéréo 
et multicanaux.

En mode couplé (mode par défaut), chaque 
modification apportée au panoramique sur un 
côté est immédiatement répercutée à l'identique 
de l'autre côté. Il s'agit d'un mode de liaison 
absolu. Pour refléter les modifications du 
panoramique, reportez-vous à Couplage de 
panoramiques en mode inversé, page 746.

Une fois le couplage supprimé, les commandes 
de panoramique redeviennent entièrement 
indépendantes.

Pour activer le couplage :

" Activez l'icône de couplage.

Pour découpler une sortie afin de récupérer des 
panoramiques indépendants :

" Désélectionnez l'icône de couplage. 

Couplage de panoramiques en mode 
inversé

Dans le cas de canaux couplés et réglés en mode 
inversé, les déplacements de panoramiques sont 
inversés d'un canal à un autre. 

Le mode de panoramique inversé répercute à 
l'inverse, dans une direction donnée, le 
mouvement d'un son d'un canal à l'autre. S'il est 
activé pour une inversion avant, par exemple, et 
si vous déplacez de droite à gauche le son d'un 
des canaux d'une sortie de piste stéréo, le son de 
l'autre canal subira le déplacement équivalent 
de gauche à droite. 

Fenêtres Send multiples

Cible activée Cible désactivée

Fenêtres Output avec couplage (gauche), sans 
couplage (milieu), avec couplage inversé à l'avant 
(droite)
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Le mode de couplage inversé à l'avant est 
disponible sur tous les systèmes. Les couplages 
inversés arrière et inversés avant/arrière sont 
disponibles sur les systèmes Pro Tools|HD. Ils ne 
s'affichent que sous forme d'options dans les 
fenêtres de plug-in multicanaux et de 
panoramiques/sortie.

Pour activer le mode de couplage inversé :

1  Activez l'icône de couplage.

2  Sélectionnez un mode d'inversion de 
panoramique. 

Commandes de sélecteur 
standard dans les fenêtres Output

Toutes les fenêtres Output contiennent des 
sélecteurs standard de chemins, d'automation et 
d'autres commandes, situés dans la zone 
supérieure (zone Output Editor).

Fermeture : ferme la fenêtre.

Sélecteur de piste : permet d'accéder à toutes les 
pistes audio, les entrées auxiliaires et les pistes 
Master Fader au cours de la session.

Sélecteur de vue de sortie : permet d'accéder 
aux autres sorties (de piste et de départ) sur la 
piste, le cas échéant, et fait apparaître la sortie 
sélectionnée dans la fenêtre active.

Sélecteur de vue de départ (fenêtre Send 
uniquement) : permet d'accéder aux autres 
départs de la piste.

Sélecteur de chemin de sortie : permet d'affecter 
le chemin de sortie désiré à la piste ou au départ 
actuel. 

Bouton Pre/Post Fader (fenêtre Send 
uniquement) : détermine si le départ est 
pré-fader ou post-fader.

Sélecteurs de couplage et de mode inversé (piste 
multicanal)

Link 

Inversion avant/arrière

Inversion avant

Inversion arrière

Commandes standard de la fenêtre Output

Commandes standard de la fenêtre Send

Bouton Automation Safe

Cible

Vue du vumètre

Sélecteur de chemin
Sélecteur de vue de sortie

Sélecteur de piste

Fermeture

Couplage

Link

du chemin

inversé

Bouton Automation Safe

Bouton Pre/Post Fader

Cible

Vue du vumètre 

Sélecteur de chemin
Sélecteur de départ

Sélecteur de piste
Fermeture

Couplage 

Link
inversé

du chemin
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Bouton Safe : le mode d'isolation d'automation 
(Safe) protège le niveau de piste et de départ, les 
panoramiques et autres commandes contre tout 
risque d'effacement. Pour plus d'informations, 
reportez-vous à la section chapitre 30, 
Automation. 

Couplage inversé : répercute à l'inverse, dans 
une direction donnée, le mouvement d'un son 
d'un canal à l'autre (par exemple commandes du 
panoramique des canaux gauche et droit). 

Couplage et suppression du couplage : permet 
de coupler/découpler les sorties gauche et droite 
(ou d'autres sorties) en stéréo (ou multicanaux). 
Le mode non couplé permet de régler 
indépendamment les côtés ou canaux séparés. 
Lorsqu'ils sont liés, les modifications se reflètent 
sur tous les canaux. Pour plus d'informations, 
reportez-vous à la section Liaison de 
panoramique, page 746. 

Cible : identifie la « cible » des commandes de 
configuration de plug-in. Sélectionne également 
la fenêtre active dans l'affichage des fenêtres 
Output. Pour plus d'informations, reportez-vous 
à la section « Fenêtres « ciblées » », page 749. 

Vue du vumètre du chemin : ouvre la vue du 
vumètre du chemin. Ce type de vumètre 
indique les niveaux du chemin sélectionné 
(et non les niveaux de la piste ou du départ). 

Fader de piste, commandes de 
panoramique, Solo, Mute et 
d'automation

Les fenêtres Output contiennent le fader de 
volume de la piste, les commandes de 
panoramique, les touches Solo et Mute et le 
sélecteur de mode d'automation. Ils permettent 
de régler ou d'automatiser les commandes de la 
fenêtre Output. 

Vue du vumètre du chemin dans une fenêtre Send

Vumètres

Sélecteur 

Vumètre 

Vumètre 

Bouton View

de chemin

de niveau 
de départ

de chemin

de vumètre
de chemin
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Fenêtres « ciblées »

Lorsque la cible est allumée en rouge, cela 
signifie que sa fenêtre est « ciblée » et que la 
fenêtre de même type suivante remplace 
l'affichage actuel (à moins qu'elle n'ait été 
ouverte sous forme de fenêtre supplémentaire, 
en appuyant sur la touche Maj). Lorsque la cible 
n'est pas allumée, elle s'affiche en gris et la 
fenêtre active est ancrée à son contenu et à son 
emplacement à l'écran. L'ouverture de nouvelles 
fenêtres n'a aucun effet sur les fenêtres ancrées.

Pour définir une fenêtre Send ouverte en tant que 
fenêtre Target :

" Cliquez sur le bouton Target afin qu'il 
s'allume en rouge. 

Utilisation des fenêtres Output

Les fenêtres Output contiennent les commandes 
Pro Tools standard de piste, de départ, de cible, 
etc. 

Pour passer à une autre piste :

" Cliquez sur le sélecteur de piste, puis 
choisissez une piste dans le menu déroulant.

Pour réassigner une sortie :

" Cliquez sur le sélecteur de chemin de sortie, 
puis sélectionnez un chemin dans le menu 
contextuel. 

Pour afficher les commandes correspondant à un 
autre départ sur la même piste :

" Cliquez sur le sélecteur de vue Send, puis 
sélectionnez le départ souhaité.

Pour attribuer un autre départ à une piste :

" Cliquez sur le sélecteur de départ, puis 
sélectionnez un chemin de sortie ou de bus dans 
le menu contextuel.

Pour ajouter une assignation de sortie au départ 
actif :

" Cliquez sur un nouveau chemin de sortie en 
appuyant sur la touche Ctrl (Mac) ou Démarrer 
(Windows) dans le sélecteur de départ (ou le 
sélecteur de chemin de sortie).

Les fenêtres Plug-in sont dotées de fonctions 
supplémentaires relatives à la cible (telles 
que le focus sur les commandes de 
configuration). Pour plus d'informations, 
reportez-vous à la section Fenêtre Plug-In, 
page 775.

Sélection d'une piste dans la fenêtre Output

Sélection d'un chemin dans la fenêtre Output

Accès à un autre départ dans la fenêtre Output
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Acheminement de signal pour 
l'écoute et le prémixage
Les fonctionnalités de bus et de mixage de 
Pro Tools prennent en charge bon nombre de 
configurations de prémixage et d'écoute et 
offrent notamment les possibilités suivantes :

• écoute et mixage de la lecture des pistes audio 
avec entrées audio ou instruments MIDI ;

• prémixages de bus pour le traitement des 
effets ou l'écoute ;

• prémixages avec faders principaux.

Ecoute et mixage de données 
audio avec des pistes d'entrée 
auxiliaire

Utilisez des pistes d'entrée auxiliaire pour 
écouter et mixer des données audio externes, 
tels que l'entrée d'instruments MIDI, de bandes 
ou de micros dans un mixage Pro Tools.

Pour écouter et mixer une piste de signal audio 
externe à l'aide de pistes d'entrées auxiliaires :

1  Reliez les sorties audio de votre source audio 
(telle qu'un synthétiseur MIDI ou une sortie de 
bande) aux entrées disponibles sur l'interface 
audio de votre système Pro Tools. 

2  Si nécessaire, configurez les chemins d'entrée 
que vous prévoyez d'utiliser dans la boîte de 
dialogue I/O Setup (consultez le chapitre 6, 
Configuration des E/S).

3  Utilisez une piste d'entrée auxiliaire (nouvelle 
ou existante) disposant du même format de 
canaux que votre source audio (mono, stéréo ou 
multicanaux).

4  Réglez l'entrée de la piste d'entrée auxiliaire 
sur le chemin d'entrée correspondant.

5  Affectez la sortie de piste au(x) chemin(s) 
approprié(s) pour l'écoute.

6  Réglez le fader d'entrée auxiliaire pour mixer 
l'entrée audio. 

Ecoute et mixage de données 
audio avec des pistes 
d'instrument

Utilisez les pistes d'instrument pour écouter et 
mixer de l'audio à partir de plug-in d'instrument 
ou d'instruments MIDI externes dans un mixage 
Pro Tools.

Pour utiliser une piste d'instrument pour l'écoute 
et le mixage de la sortie d'un plug-in 
d'instrument :

1  Utilisez une piste d'instrument existante ou 
créez-en une nouvelle.

2  Sélectionnez View > Mix Window > 
Instruments pour afficher les commandes MIDI 
de la piste d'instrument. 

3  Sélectionnez un plug-in d'instrument dans le 
premier sélecteur d'insert ou dans la piste 
d'instrument (par exemple, Xpand! de 
Digidesign).
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4  Le nœud MIDI virtuel (port) du plug-in 
d'instrument doit être automatiquement 
sélectionné pour la sortie MIDI de la piste 
d'instrument. Si ce n'est pas le cas, sélectionnez 
le canal MIDI souhaité ainsi que le port 
correspondant du plug-in d'instrument.

5  Affectez la sortie de piste au(x) chemin(s) 
approprié(s) pour l'écoute.

6  Réglez le fader de piste d'instrument pour 
mixer l'entrée audio. 

7  Si vous contrôlez le plug-in d'instrument à 
partir de la piste d'instrument, vous pouvez 
également réaliser un mixage à l'aide les 
commandes de volume MIDI et de panoramique 
de la vue Instrument.

Pour utiliser une piste d'instrument afin d'écouter 
et de mixer des données audio à partir d'un 
instrument MIDI externe :

1  Reliez les sorties audio de votre instrument 
MIDI externe (par exemple, un synthétiseur 
MIDI) aux entrées disponibles sur l'interface 
audio de votre système Pro Tools. 

2  Si nécessaire, configurez les chemins d'entrée 
que vous prévoyez d'utiliser dans la boîte de 
dialogue I/O Setup (consultez le chapitre 6, 
Configuration des E/S).

3  Connectez l'entrée et la sortie MIDI de votre 
instrument MIDI externe aux ports d'entrée et 
de sortie disponibles de votre interface MIDI.

4  Le cas échéant, configurez les paramètres 
MIDI Studio Setup (Setup > MIDI > MIDI 
Studio). 

5  Utilisez une piste d'instrument (nouvelle ou 
existante) disposant du même format de canaux 
que votre source audio (mono, stéréo ou 
multicanaux).

6  Sélectionnez View > Mix Window > 
Instruments pour afficher les commandes MIDI 
de la piste d'instrument. 

7  Réglez l'entrée audio de la piste d'instrument 
sur le chemin d'entrée correspondant.

8  Dans la vue Instrument de la piste 
d'instrument, réglez la sortie MIDI sur le port 
MIDI correspondant connecté à l'entrée MIDI de 
votre instrument MIDI externe.

9  Affectez la sortie de piste au(x) chemin(s) 
approprié(s) pour l'écoute.

Piste d'instrument configurée pour contrôler et 
écouter le plug-in d'un instrument 
(Digidesign Synchronic)

Sélecteur de sortie MIDI

Commande de volume MIDI

Sélecteur d'entrée audio, réglé sur 

Sélecteur de sortie audio

Commande de panoramique MIDI

Plug-in d'instrument

aucune entrée
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10  Réglez le fader de piste d'instrument pour 
mixer l'entrée audio. 

11  Si vous contrôlez l'instrument MIDI externe à 
partir de la piste d'instrument, vous pouvez 
également réaliser un mixage à l'aide les 
commandes de volume MIDI et de panoramique 
de la vue Instrument.

Pour écouter et mixer des données audio 
provenant d'un plug-in d'instrument avec plusieurs 
sorties audio :

1  Utilisez une piste d'instrument existante ou 
créez-en une nouvelle.

2  Sélectionnez View > Mix Window > 
Instruments pour afficher les commandes MIDI 
de la piste d'instrument. 

3  Sélectionnez un plug-in d'instrument à 
plusieurs sorties dans le premier sélecteur 
d'insert ou dans la piste d'instrument (par 
exemple, Strike de Digidesign).

4  Le nœud MIDI virtuel (port) du plug-in 
d'instrument doit être automatiquement 
sélectionné pour la sortie MIDI de la piste 
d'instrument. Si ce n'est pas le cas, sélectionnez 
le canal MIDI souhaité ainsi que le port 
correspondant du plug-in d'instrument.

5  Dans la fenêtre de plug-in, assignez les sorties 
audio individuelles du plug-in (dans le plug-in 
Strike, les sorties de canaux sont assignées à 
partir de la page Mix).

6  Créez une piste d'entrée auxiliaire pour 
chaque sortie du plug-in. Assurez-vous que le 
format de canaux des entrées auxiliaires 
correspond bien à celui des sorties de plug-in 
(mono, stéréo ou multicanaux).

7  Paramétrez les entrées des pistes d'entrées 
auxiliaires pour qu'elles puissent recevoir les 
sorties individuelles du plug-in.

8  Affectez les sorties des pistes d'entrée 
auxiliaires au(x) chemin(s) approprié(s) pour 
l'écoute.

Piste d'instrument configurée pour contrôler et 
écouter un instrument MIDI externe (K2600XS)

Sélecteur de sortie MIDI

Commande de volume MIDI

Sélecteur d'entrée audio

Sélecteur de sortie audio

Commande de panoramique MIDI
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9  Ajustez les faders d'entrée auxiliaire pour le 
mixage des sorties individuelles du plug-in.

Création d'un prémixage

Un prémixage est créé en acheminant plusieurs 
sources audio vers un même chemin de bus ou 
de sortie. Ceci « prémixe » les sources vers un 
seul chemin qui peut être renvoyé à une entrée 
auxiliaire, où le prémixage peut être traité à 
l'aide de plug-in ou de processeurs d'effets 
externes.

Pour créer un prémixage audio, il suffit 
d'assigner une combinaison de départs et de 
sorties de pistes vers des bus ou des chemins de 
sortie disponibles.

Prémixage via sorties de piste ou départs

Selon le type de prémixage souhaité, discret ou 
départ/retour, il convient de choisir entre 
l'utilisation de sorties de pistes ou celle de 
départs. 

Sortie de prémixage discret

Pro Tools permet de diriger discrètement la 
source audio vers un prémixage. Cette méthode 
est préférable pour le dithering ou autres 
traitements de mastering, lorsque l'on ne désire 
pas entendre de signaux audio non traités en 
plus des signaux traités. Pour un prémixage 
discret, on utilise les sorties de piste (et non les 
départs) pour assigner des pistes à un chemin de 
bus. Dans ce cas, l'équilibre entre les signaux 
traités et non traités est contrôlé par les 
paramètres Wet/Dry du plug-in.

Pour créer un prémixage discret, procédez 
comme suit :

1  Réglez la sortie des pistes à inclure dans le 
prémixage sur un chemin de bus stéréo. 

2  Effectuez la panoramisation de chaque piste.

3  Sélectionnez Track > New.

4  Indiquez le type de piste (entrée auxiliaire) et 
le format (stéréo), puis cliquez sur Create.

5  Réglez l'entrée de l'entrée auxiliaire sur le 
même chemin de bus que celui auquel sont 
affectées toutes les pistes à prémixer.

6  Réglez la sortie de la piste d'entrée auxiliaire 
sur les sorties de mixage stéréo principales (en 
général, les sorties 1-2). 

7  Définissez le niveau de la piste d'entrée 
auxiliaire.

8  Pour traiter le prémixage, affectez un plug-in 
ou un insert matériel à l'entrée auxiliaire. 

9  Réglez les commandes du plug-in. 
Les commandes Bypass et Wet/Dry du plug-in 
(lorsqu'elles sont disponibles) déterminent la 
quantité d'effet entendue.

Plug-in d'instrument avec plusieurs sorties acheminées 
vers des pistes d'entrée auxiliaires

Plug-in 

Entrées de sorties 
de plug-in

d'instrument
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Les niveaux relatifs du prémixage sont contrôlés 
par les faders de piste. La piste d'entrée auxiliaire 
contrôle les niveaux de sortie de toutes les pistes 
qui lui parviennent. 

Vous pouvez automatiser les niveaux, 
panoramiques, coupures (Mute) ainsi que les 
niveaux, panoramiques et coupures des départs 
de l'entrée auxiliaire.

Il est également possible d'enregistrer un 
prémixage sur disque, afin de libérer pour 
d'autres pistes les voix des pistes qui le 
composent. Pour plus d'informations, 
reportez-vous à la section chapitre 31, Mixage 
final.

Prémixage de type départ/retour en 
vue d'un traitement par effets

Lors d'un prémixage pour utilisation d'une 
réverbération, d'un retard ou de tout traitement 
d'effet similaire, utilisez les départs pour recréer 
le dispositif de routage de départ/retour 
classique. Vous pouvez alors partager un plug-in 
en temps réel ou un insert matériel entre toutes 
les pistes incluses dans le prémixage. La quantité 
d'effet (Wet/Dry) dans le mixage peut être 
modifiée à l'aide des faders de piste (niveau de 
son direct, Dry) et du fader d'entrée auxiliaire 
(niveau de signal d'effet, Wet).

Départ et retour avec un insert de 
plug-in ou un insert matériel

Pour créer un prémixage de retour d'effets avec un 
plug-in ou un insert matériel :

1  Affectez la sortie principale de chaque piste 
aux sorties du mixage principal.

2  Sur les pistes sources, assignez un départ 
(mono ou stéréo) et sélectionnez un chemin de 
bus mono ou stéréo dans le sélecteur de départ. 
Configurez les départs avant ou après fader, 
selon vos besoins.

3  Sélectionnez Track > New.

4  Indiquez le type de piste (entrée auxiliaire) et 
le format (stéréo), puis cliquez sur Create.

5  Dans le sélecteur de chemin d'entrée de la 
piste d'entrée auxiliaire, sélectionnez le chemin 
de bus de départ.

6  Assignez un plug-in ou un insert matériel dans 
l'entrée auxiliaire.

7  Sélectionnez l'effet « 100% wet » et réglez les 
commandes nécessaires.

8  Dans le sélecteur de chemin de sortie de la 
piste d'entrée auxiliaire, sélectionnez un chemin 
de sortie (sorties principales).

Réglez chaque fader de piste pour équilibrer les 
pistes Dry (non traitées). Lorsque le départ est 
disposé avant le fader, la quantité d'effet est 
contrôlée par le niveau du fader de niveau de 
départ ou du fader du volume d'entrée 
auxiliaire. Si le départ est disposé après le fader, 
le fader du niveau de départ suit le niveau du 
volume.

Pour plus d'informations, reportez-vous à la 
section chapitre 29, Inserts de plug-in et 
inserts matériels.
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Prémixages de départs et de retours 
avec des périphériques externes

Pour créer un prémixage du retour d'effets avec un 
périphérique externe :

1  Affectez la sortie principale de chaque piste 
aux sorties du mixage principal.

2  Assignez un départ (mono ou stéréo) et 
définissez les destinations des départs sur les 
pistes source vers le chemin de sortie relié au 
périphérique externe. Configurez les départs 
avant ou après fader, selon vos besoins.

3  Sélectionnez Track > New.

4  Indiquez le type de piste (sortie auxiliaire) et le 
format (stéréo ou mono), puis cliquez sur 
Create.

5  Cliquez sur le sélecteur de chemin d'entrée de 
la piste d'entrée auxiliaire pour choisir un 
chemin d'entrée relié au périphérique externe.

6  Dans le sélecteur de chemin de sortie de la 
piste d'entrée auxiliaire, sélectionnez un chemin 
de sortie (sorties principales).

7  Réglez chaque fader de piste pour équilibrer 
les pistes Dry (non traitées). 

La quantité d'effet est contrôlée par le niveau du 
fader de niveau de départ ou du fader du volume 
d'entrée auxiliaire.

Configuration de départ/retour pour un plug-in ou un 
insert matériel

Départ vers le bus d'effets

Configuration d'entrée vers le 

Sortie réglée sur les sorties de 

Contrôle le niveau des signaux 

Contrôle le niveau du retour

Effet (plug-in ou hardware)
Insert

Contrôle le niveau de départ vers les
 bus d'effets

chemin du bus de départs

mixage principales

d'origine (Dry)

d'effets

Configuration de départ/retour pour un périphérique 
externe

Départ vers un périphérique 

Entrée réglée pour assurer

Sortie réglée sur les sorties 

Contrôle le niveau des signaux

Contrôle le niveau d'effet

 

externe

le retour du périphérique

de mixage principales

d'origine (Dry)
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Création de prémixages d'écoute

La piste d'acheminement effectue un envoi vers 
une ou plusieurs pistes d'entrée auxiliaire pour 
écouter les prémixages dans un environnement 
de studio. Vous pouvez par exemple fournir à un 
bassiste un prémixage de batterie afin qu'il suive 
une nouvelle partie relative à la batterie.

Pour créer un prémixage d'écoute, procédez 
comme suit :

1  Affectez la sortie principale de chaque piste 
aux sorties du mixage principal.

2  Assignez un départ (mono ou stéréo) et 
définissez les destinations des départs sur les 
pistes source vers le chemin de sortie relié au 
périphérique externe. Configurez les départs 
avant ou après fader, selon vos besoins.

3  Sélectionnez Track > New.

4  Indiquez le type de piste (sortie auxiliaire) et le 
format (stéréo ou mono), puis cliquez sur 
Create.

5  Dans le sélecteur de chemin de sortie de la 
piste d'entrée auxiliaire, sélectionnez le chemin 
de sortie (et non pas les sorties principales) pour 
écouter le mixage. 

Réglez le fader de la piste d'entrée auxiliaire pour 
contrôler le volume du mixage d'écoute.

Création d'un commande maître de 
niveau de départ

Les pistes de fader principal contrôlent le niveau 
global de sortie des chemins de bus et de sortie. 

Pour créer un contrôle de volume maître de niveau 
de départ :

1  Sélectionnez Track > New.

2  Indiquez le type de pistes (fader principal) et 
les formats mono, stéréo ou tout autre format 
multicanal pris en charge pour le mixage 
Surround.

3  Cliquez sur Create.

4  Effectuez l'une des opérations suivantes :

• Réglez la sortie de la piste de fader principal 
sur le même chemin que celui utilisé pour 
les départs vers une piste d'entrée 
auxiliaire.

Prémixage de batterie à écouter
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• Réglez la sortie de la piste de fader principal 
de façon à la faire correspondre au chemin 
choisi pour votre départ effets.

Dès lors, les niveaux de départs agissent sur 
l'équilibre des pistes source et les pistes de fader 
principal sur le niveau général de l'ensemble du 
prémixage.

Ecoute de pistes en Solo au sein d'un 
prémixage

Écoute de pistes en solo coupe implicitement le 
son de toutes les autres pistes, y compris des 
entrées auxiliaires. La protection contre la mise 
en solo d'une entrée auxiliaire évite cette 
coupure de son implicite et permet à l'entrée 
auxiliaire de continuer à transmettre les 
données audio lorsque ses pistes source sont en 
mode Solo.

Pour isoler du solo une entrée auxiliaire :

" Cliquez sur le bouton Solo de la piste d'entrée 
auxiliaire tout en appuyant sur la touche 
Pomme (Mac) ou Ctrl (Windows).

Pour mettre en solo une piste particulière 
appartenant à un groupe :

" Maintenez enfoncée la touche Ctrl (Mac) ou 
Démarrer (Windows) et cliquez sur le 
bouton Solo. 

Génération d'une sortie stéréo à partir 
d'un départ/retour mono

Pour générer une sortie stéréo à partir d'un 
départ mono, vous pouvez recourir à une entrée 
auxiliaire. Réglez la destination du départ vers 
une piste d'entrée auxiliaire sur laquelle vous 
placez un plug-in mono vers stéréo. La sortie de 
l'entrée auxiliaire devient dès lors une sortie 
stéréo. 

Pour créer un effet « stéréo » à partir d'une 
source mono, vous devez utiliser l'effet de 
réverbération, l'effet de retardement ou tout 
autre effet de découpage temporel.

Compensation de retard
(Pro Tools HD uniquement)

Pro Tools dispose d'une fonction de 
compensation de retard permettant de gérer les 
retards DSP qui se produisent sur les pistes 
audio, d'entrée auxiliaire, de fader principal ou 
d'instrument, en raison de l'utilisation des 
plug-in et des acheminements vers la console. 
Lorsque cette fonction est activée, Pro Tools 
permet de préserver l'alignement temporel entre 
les pistes dont les plug-in présentent des 
différences au niveau du retard inhérent au DSP, 
les pistes comportant des chemins de mixage 
différents, les pistes interrompues et 
recombinées par l'intermédiaire de la console et 
les pistes comportant des inserts matériels. 

Pour conserver l'alignement temporel, Pro Tools 
rétablit le retard de chaque piste de façon à ce 
qu'il soit égal à celui de la piste possédant le 
retard le plus long.

La fonction de compensation de retard doit être 
activée pendant le mixage et la lecture pour que 
le son avec compensation de retard soit optimal. 
Lors de l'enregistrement, la compensation de 
retard doit en général être désactivée.

Pour activer cette fonction, procédez comme 
suit :

" Choisissez Options > Delay Compensation.
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Paramètres de compensation de 
retard

Il existe trois paramètres dans la boîte de 
dialogue Playback Engine permettant d'attribuer 
des ressources DSP à la fonction de 
compensation de retard :

None : n'attribue aucune ressource DSP en vue 
de la compensation de retard.

Short : attribue un nombre réduit de 
ressources DSP pour la compensation de retard 
de chaque canal. Il s'agit du paramètre le plus 
efficace pour les systèmes Pro Tools|HD Accel.

Long : attribue un nombre maximal de 
ressources DSP pour la compensation de retard 
de chaque canal de console. Ce paramètre utilise 
les mêmes ressources DSP que celles des plug-in 
DSP haut-débit.

Pour configurer le moteur de compensation de 
retard, procédez comme suit :

1  Sélectionnez Setup > Playback Engine.

2  Dans le menu déroulant Delay Compensation 
Engine, sélectionnez un paramètre de 
compensation de retard.

3  Cliquez sur OK.

L'état de la compensation de retard est enregistré 
en tant que préférence de session et préférence 
système.

Affichage de la compensation de 
retard

La vue de compensation de retard indique la 
quantité totale de retard sur chaque piste. Elle 
permet d'appliquer un décalage défini par 
l'utilisateur pour le retard de piste et elle affiche 
la quantité totale de retard appliquée par 
Pro Tools à chaque piste. La vue de 
compensation de retard est affichée dans la 
fenêtre Mix. 

Pour afficher les informations de compensation de 
retard : 

" Sélectionnez View > Mix Window > Delay 
Compensation.

Delay Compensation Time Mode

Les valeurs de retard peuvent être exprimées en 
échantillons ou en millisecondes, comme 
sélectionné avec l'option Delay Compensation 
Time Mode dans la page des préférences 
d'affichage. Elle est disponible à condition 
d'avoir activé la compensation de retard 
(Options > Delay Compensation).

Affichage de la compensation de retard

Décalage défini par

Indicateur de 
retard de plug-in

Indicateur de 
compensation de 

l'utilisateur
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Indicateur de retard de plug-in (dly)

L'indicateur de retard de plug-in (dly) affiche le 
retard total au niveau des inserts de plug-in et 
des inserts matériels sur la piste. La valeur 
correspondant au retard total permet à Pro Tools 
de calculer le retard appliqué aux autres pistes 
pour qu'elles restent synchronisées. Les 
informations de retard correspondant à la piste 
dont le retard est le plus important sont 
affichées en orange. 

Les informations concernant le retard d'une 
piste s'affichent en rouge si le retard de la piste 
dépasse la limite de compensation. Pour plus 
d'informations, reportez-vous à la section Retard 
dépassant la limite de compensation, page 759.

Champ du décalage défini par l'utilisateur (+/-)

Ce champ permet d'ajuster les retards de piste 
manuellement lorsque la compensation de 
retard est activée. Cela peut s'avérer utile dans 
les cas suivants :

• pour synchroniser une piste dans le cas où 
un plug-in renvoie un retard incorrect ;

• pour modifier le « feeling » de la 
synchronisation d'une piste.

Pour modifier le retard de piste à l'aide 
du champ +/- :

1  Dans la vue de compensation de retard, 
cliquez dans le champ du décalage défini par 
l'utilisateur (+/-).

2  Pour définir la valeur de retard (en 
échantillons ou en millisecondes selon vos 
préférences actuelles), procédez de l'une des 
manières suivantes :

• Entrez une valeur positive (avec ou sans le 
modificateur +) pour un retard positif, ou 
négative (avec le modificateur -) pour un 
retard négatif. 

• Glissez dans le champ sélectionné en 
maintenant enfoncée la touche Pomme 
(Mac) ou Ctrl (Windows) dans le champ 
+/- pour faire défiler une nouvelle valeur.

• Utilisez les flèches Haut et Bas pour 
augmenter ou réduire les valeurs 
numériques. 

3  Appuyez sur Entrée.

Pour désactiver le retard défini par l'utilisateur :

" Cliquez dans le champ +/- tout en maintenant 
enfoncées les touches Pomme+Ctrl (Mac) ou 
Ctrl+Démarrer (Windows). Le champ apparaît 
alors grisé et la valeur qui lui correspond n'est 
plus appliquée à la piste.

Indicateur de compensation de retard (cmp)

Cet indicateur affiche la valeur de compensation 
que Pro Tools applique à chaque piste. 

Retard dépassant la limite de 
compensation

Si le retard total d'une piste entraîne un 
dépassement de la quantité de retard système 
(affiché dans la fenêtre Session Setup) par 
rapport à la quantité autorisée pour le moteur de 
retardement sélectionné (dans la boîte de 
dialogue Playback Engine), l'alignement 
temporel des données sur cette piste ne sera plus 
correct.

L'indicateur de compensation de retard de 
plug-in et l'indicateur de compensation de piste 
s'affichent en rouge pour indiquer que le retard 
de piste dépasse la limite de compensation de 
retard.
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Pour compenser un retard dépassant la limite de 
compensation :

1  Désactivez le « rapport » pour la piste en 
cliquant sur l'indicateur de retard de plug-in 
tout en maintenant enfoncées les touches 
Démarrer+Ctrlle (Windows) ou Pomme+Ctrl 
(Mac). 

L'information concernant la piste s'affiche en 
grisé une fois qu'elle est désactivée.

2  Insérez manuellement les données audio sur 
cette piste à un moment antérieur en vous 
basant sur le nombre d'échantillons affichés 
dans le champ Plug-in Delay.

Ecoute à latence réduite lors de 
l'enregistrement

Pour l'enregistrement, Pro Tools interrompt 
automatiquement la compensation de retard 
pour fournir un chemin d'écoute à latence 
réduite via les sorties principales des pistes 
prêtes pour l'enregistrement. Lorsqu'une piste 
audio est prête à l'enregistrement (à l'arrêt), avec 
TrackInput et DestructivePunch activé, ou 
possède un point d'entrée en enregistrement, la 
compensation de retard de la piste est 
automatiquement interrompue et l'indicateur 
de compensation de piste affiche la valeur 0. 

Vous pouvez interrompre cette suppression 
automatique de compensation de retard à tout 
moment de la manière suivante :

Pour appliquer la compensation de retard aux 
pistes sur lesquelles elle a été interrompue :

" Tout en maintenant enfoncées les touches 
Démarrer+Ctrl (Windows) ou Pomme+Ctrl 
(Mac), cliquez sur l'indicateur de compensation 
de piste. Le retard de piste sera appliqué à la piste 
et l'indicateur de compensation de piste apparaît 
en bleu. 

Compensation de piste au niveau des 
entrées auxiliaires

La compensation de retard au niveau des entrées 
auxiliaires peut être ignorée pour vous permettre 
d'écouter les sources externes (comme les pistes 
audio d'un appareil vidéo asservi) à latence 
réduite, tout en relevant le retard de la piste.

Pour désactiver la compensation de retard d'une 
entrée auxiliaire :

Tout en maintenant enfoncées les touches 
Démarrer+Ctrl (Windows) ou Pomme+Ctrl 
(Mac), cliquez sur l'indicateur de compensation 
de piste. Le retard de piste porte la valeur 0 et 
apparaît grisé.

Compensation de retard pour un 
événement MIDI

Lorsque la compensation de retard est active, un 
événement MIDI enregistré de façon à sembler 
synchronisé avec des données à compensation 
de retard est en fait enregistré avec un décalage 
du retard total en vigueur. 

Pour compenser, les événements MIDI sont 
reculés dans le temps d'un retard total de session 
suivant chaque passage d'enregistrement MIDI. 

Enregistrement à latence réduite avec 
des instruments MIDI virtuels

Lorsqu'une piste MIDI ou d'instrument qui 
achemine des données MIDI vers un plug-in 
d'instrument est activée pour l'enregistrement, 
Pro Tools interrompt automatiquement la 
compensation de retard via les sorties 
principales de la piste audio ou de l'entrée 
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auxiliaire dans lequel le plug-in d'instrument 
plug-in est inséré. Cela permet d'effectuer une 
écoute sans latence du plug-in d'instrument lors 
de l'enregistrement.

Plug-ins de traitement MIDI et audio

Certains plug-in de traitement audio (tels que 
Bruno et Reso) et de nombreux plug-in 
d'instrument vous laissent traiter des données 
audio tout en permettant aux données MIDI de 
contrôler les paramètres de traitement. Lorsque 
vous activez pour l'enregistrement une piste 
MIDI ou d'instrument qui contrôle un plug-in 
de traitement audio, la piste sur laquelle le 
plug-in est inséré passe en mode à latence 
réduite, entraînant la lecture anticipée des 
données audio traitées. 

Pour que l'audio reste synchronisé durant 
l'enregistrement avec un plug-in commandé via 
MIDI sur une piste audio :

" Tout en maintenant enfoncées les touches 
Démarrer+Ctrl (Windows) ou Pomme+Ctrl 
(Mac), cliquez sur l'indicateur de compensation 
de piste de la piste audio pour appliquer la 
compensation de retard. 

Pour que l'audio reste synchronisé durant 
l'enregistrement avec un plug-in commandé via 
MIDI sur une entrée auxiliaire :

1  Tout en maintenant enfoncées les touches 
Démarrer+Ctrl (Windows) ou Pomme+Ctrl 
(Mac), cliquez sur l'indicateur de compensation 
de piste de l'entrée auxiliaire pour désactiver la 
compensation de retard.

2  Entrez le retard système total dans le champ 
User Offset.

Dithering
Le dithering est une forme spécifique de bruit 
aléatoire, utilisé pour masquer le bruit de 
quantification dans les systèmes 
audionumériques. Lors des passages de très bas 
niveau, à l'extrémité inférieure de la plage 
dynamique d'un système audionumérique, 
d'importantes distorsions de quantification se 
produisent, ce qui se traduit par des 
performances très médiocres dans ce domaine. 
Le processus de dithering réduit les erreurs de 
quantification en introduisant un bruit aléatoire 
de très faible niveau, limitant les artefacts de 
distorsion lorsque le niveau du signal audio est 
faible. Le dithering est donc un compromis 
entre les performances en termes de rapport 
signal/bruit et de taux de distorsion. Une 
utilisation appropriée du dithering permet de 
tirer des performance subjectives maximales 
d'un format de données 16 bits (par exemple les 
CD à la norme Red Book). 

Les systèmes Pro Tools|HD traitent tous les sons 
en interne en 24 bits ; Pro Tools LE traite le son 
en interne en 32 bits virgule flottante. Si le 
passage de données 24 bits au format 16 bits 
n'est pas assuré via un dithering, les 8 bits 
excédentaires sont tronqués (complètement 
supprimés) lors de l'enregistrement sur un 
support ou une machine au format 16 bits (par 

La compensation de retard des instruments 
MIDI virtuels ne fonctionne que lorsque 
toutes les connexions MIDI et audio sont 
réalisées dans Pro Tools. Par exemple, 
Pro Tools n'interrompt pas la compensation 
de retard lorsque vous utilisez ReWire pour 
connecter des synthétiseurs et des 
échantillonneurs dans d'autres applications 
client ReWire (telles que Live et Reason). 
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exemple un graveur de CD, la plupart des 
machines DAT, etc.). Par ailleurs, le dithering 
garantit une fidélité spectaculaire aux bas 
niveaux, en ajoutant une petite quantité de 
bruit aux signaux. 

Dithering dans Pro Tools

Pro Tools offre plusieurs options de dithering. 
Chacune est destinée à une application 
spécifique au sein des différentes opérations 
susceptibles de bénéficier du dithering. 

Outre les plug-in de dithering, disponibles en 
version TDM, RTAS et AudioSuite, Pro Tools 
offre une fonction de dithering intégrée.

Plug-ins Dither Mixer (Pro Tools HD uniquement) 

Deux plug-in de consoles incorporent la 
fonction de dithering avec mise en forme du 
bruit : Stéréo avec dithering et Surround avec 
dithering. Pour plus d'informations, 
reportez-vous au Guide de démarrage 
Pro Tools|HD. Les consoles de mixage Stereo et 
Surround standard n'intègrent pas de fonction 
de dithering et nécessitent l'utilisation de 
plug-in de dithering.

Dithering sur la sortie finale pour le mixage 
terminal Vous pouvez insérer un plug-in de 
dithering en temps réel sur une piste Master 
Fader pour contrôler le mixage de sortie, en vue 
d'un traitement du mixage final sur CD ou autre 
support 16 bits. Les inserts des pistes de fader 
principal assurent un traitement après fader. 
Cette forme de dithering permet d'utiliser des 
plug-in de dithering de Digidesign ou d'autres 
fabricants. Avant d'utiliser la commande Bounce 
to Disk, consultez la rubrique Dithering et 
prémixage sur disque (Bounce), page 856.

Dither AudioSuite Pour le traitement de plug-in 
AudioSuite, le dithering est basé sur le plug-in 
Dither.

Pour la plupart des plug-in AudioSuite, le 
dithering peut être appliqué automatiquement 
dans la boîte de dialogue Processing Preferences. 
La case Use AudioSuite Dither permet d'activer 
un dithering prédéfini avec noise shaping.

Les plug-in AudioSuite suivants peuvent 
appliquer automatiquement un dithering au 
cours du traitement : 

• EQ III

• Compressor II

• Limiter II

• Gate II

• Expander/Gate II

• Normalize

• Gain

• DC Offset Removal

• Time Compression/Expansion

• Pitch Shift

Paramètres de fonctionnement par défaut, pour le 
dithering AudioSuite

Pour plus d'informations sur le dithering 
AudioSuite, consultez le Guide Digi-Rack.
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Fondus et Crossfades Dans la boîte de dialogue 
Fades (Edit > Fades > Create Fades), l'option Use 
Dither active une présélection de dithering 
utilisant le noise shaping. 

Noise Shaping

Le bruit fait partie intégrante du processus de 
dithering. La mise en forme du bruit peut encore 
améliorer les performances audio et réduire le 
bruit perceptible inhérent au dithering. 
La fonction de mise en forme du bruit (noise 
shaping) décale par filtrage numérique les 
fréquences du bruit d'environ 4 kHz à proximité 
de la fréquence Nyquist. Ainsi mis en forme, le 
bruit se trouve déplacé dans des régions du 
spectre où notre oreille le perçoit beaucoup 
moins que sous sa forme d'origine.

La fonction de noise shaping (mise en forme du 
bruit) est disponible dans le plug-in Dither.

Utilisation d'une surface de 
contrôle avec Pro Tools
Les surfaces de contrôle ajoutent un contrôle 
concret aux fonctions de Pro Tools. L'utilisation 
d'une surface de contrôle permet de régler des 
faders et des boutons à l'écran, d'activer des 
contrôles de transport ou d'utiliser des fonctions 
scrub et shuttle dans Pro Tools.

Il existe plusieurs surfaces de contrôle 
(optionnelles) de Digidesign pouvant être 
utilisées pour le mixage avec Pro Tools : 

D-Control et D-Command de Digidesign (Pro Tools 
HD uniquement) Surfaces de travail novatrices et 
tactiles qui se présentent sous la forme d'une 
console familière et intuitive dont la partie 
centrale regroupe les voies.

Control|24 de Digidesign (Pro Tools HD et LE 
uniquement) Contrôleur dédié permettant 
d'accéder à la plupart des fonctions 
d'enregistrement, de mixage, d'édition, 
d'assignation des signaux, de contrôle des 
plug-in et d'automation de Pro Tools. 

Command|8 de Digidesign Surface de contrôle 
pour Pro Tools, compatible USB et d'un prix 
abordable. Command|8 est une surface de 
contrôle compacte, pratique et souple d'emploi 
destinée aux systèmes Pro Tools approuvé par 
Digidesign.

Boîte de dialogue Create Fades

Pour en savoir plus sur le dithering en cours 
du mixage final, reportez-vous au 
chapitre 31, Mixage final.
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Chapitre 29 : Inserts de plug-in et 
inserts matériels

Pro Tools permet de disposer de cinq inserts de 
gain unitaire sur chaque piste audio, d'entrée 
auxiliaire, de fader principal et d'instrument. 
Les inserts de pistes audio, d'entrée auxiliaire et 
d'instrument sont placés avant le fader et, les 
inserts de faders principaux sont placés après le 
fader.

Il peut s'agir de plug-in DSP logiciels ou d'inserts 
matériels. Les inserts Pro Tools envoient les 
signaux de la piste vers le plug-in ou le 
périphérique externe de votre choix, puis les 
renvoient automatiquement vers la même piste. 
Les inserts ne modifient pas les fichiers source 
audio originaux, mais traitent les sons en temps 
réel au cours de la lecture. Il est possible de 
« figer » à tout moment des effets en temps réel 
appliqués aux pistes, en les enregistrant ou en 
les prémixant sur disque (pour en savoir plus, 
reportez-vous au chapitre 31, Mixage final).

Inserts plug-in : Les inserts plug-in sont des 
inserts logiciels qui traitent les données audio 
d'une piste en temps réel. Par exemple, DigiRack 
EQ, le compresseur et les plug-in Delay fournis 
avec votre système Pro Tools peuvent être 
utilisés en tant qu'inserts de plug-in en temps 
réel.

Vous pouvez vous procurer d'autres plug-in 
temps réel auprès de Digidesign et de nombreux 
autres développeurs. 

Inserts d'I/O matériels Les inserts d'I/O 
matériels font passer les sons à travers un 
périphérique externe connecté aux entrées et 
aux sorties parallèles de votre interface audio. 
Le traitement des sons sur une piste peut être 
effectué à l'aide d'un insert matériel en temps 
réel.
 

Les chemins d'insertion nécessitent des entrées 
et des sorties de l'interface audio : ils sont 
déterminés lors de la configuration des I/O sur 
votre système.

Pour plus d'informations sur les plug-in 
livrés avec Pro Tools, consultez le Guide des 
plug-in DigiRack.

Pour plus d'informations sur les plug-in 
optionnels Digidesign, consultez le Guide 
des plug-in Digidesign. Pour en savoir plus 
sur les plug-in tiers, visitez le site Web 
Digidesign à l'adresse www.digidesign.com.

Insert d'I/O matériels
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Généralités

Lorsqu'une piste comporte plusieurs inserts, 
ceux-ci sont traités en série. Chaque effet vient 
donc s'ajouter à celui du plug-in ou de l'insert 
précédent (de haut en bas dans la vue Inserts de 
la fenêtre Mix et de gauche à droite dans la vue 
Inserts de la fenêtre Edit).

Les inserts des pistes audio, d'entrées auxiliaire 
et d'instrument sont disposés avant le fader. Si 
vous réglez les paramètres du plug-in sur des 
valeurs extrêmes, de gain notamment, vous 
risquez de provoquer un écrêtage, plus 
particulièrement sur les pistes enregistrées avec 
une amplitude élevée. Les vumètres 
apparaissant à l'écran permettent de surveiller 
l'écrêtage. (Les inserts des pistes De fader 
principal sont disposés après le fader.)

Utilisation des inserts pour le 
traitement d'effets

Les inserts peuvent être utilisés de deux façons : 

Sur pistes uniques : Vous pouvez appliquer un 
insert à une piste audio, d'entrée auxiliaire, de 
fader principal ou d'instrument individuelle.

Dans le cas des inserts en ligne, vous pouvez 
contrôler la quantité d'effet désirée à l'aide du 
potentiomètre Balance (ou le mix wet/dry) du 
plug-in ou du périphérique externe.

En tant que ressources partagées pour utiliser 
un insert en tant que ressource partagée, dans 
une disposition départ-retour, assignez les 
signaux de plusieurs pistes sur un même bus 
envoyé vers une entrée auxiliaire, puis appliquez 
l'insert à la piste d'entrée auxiliaire. Vous pouvez 
alors contrôler le niveau de départ sur chaque 
piste, et le niveau global de l'effet depuis la piste 

d'entrée auxiliaire. L'utilisation de départs et 
d'autres fonctions d'assignation des signaux 
permet l'optimisation de la puissance de 
traitement d'un système. 

Formats d'inserts

Inserts Mono : s'utilisent sur des pistes mono. 
Les inserts ajoutés à une piste après un insert 
stéréo sont automatiquement utilisés en stéréo.

Inserts stéréo : s'utilisent sur des pistes stéréo. 
Il est également possible de créer un insert d'I/O 
matériel stéréo sur une piste stéréo.

Insert de plug-in d'entrée mono/sortie stéréo : 

conçus pour renvoyer un effet stéréo à partir 
d'une source mono. Certains plug-in (par 
exemple D-Verb) permettent de générer une 
sortie stéréo à partir d'une voie mono. Une piste 
ainsi convertie au format stéréo dispose de 
commandes de panoramique pour chaque canal 
du signal stéréo. Tout insert placé sur une piste 
après un insert stéréo est automatiquement 
utilisé en stéréo.

Inserts de plug-in multimono : s'utilisent sur les 
pistes stéréo ou sur les pistes multicanal de 
format supérieur au format stéréo, uniquement 
lorsque aucune version multicanal du plug-in 
n'est disponible. Les commandes de tous les 
canaux sont liées par défaut afin de permettre 
un réglage par paire. Pour régler les commandes 
indépendamment, dissociez-les à l'aide du 
bouton Master Link. Pour plus d’informations, 
reportez-vous à la section « Liaison et 
dissociation des commandes sur les Plug-in 
multimono », page 785.

Vous trouverez des exemples de bus de type 
départ/retour ainsi que d'autres 
configurations de prémixage à la section 
Acheminement de signal pour l'écoute et le 
prémixage, page 750. 
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Inserts de plug-in multicanaux : s'utilisent pour 
des pistes multicanaux au format stéréo ou 
supérieur. Sur les pistes multicanal de format 
supérieur au format stéréo, les commandes de 
tous les canaux sont généralement liées.

Plug-in TDM et RTAS

Pro Tools prend en charge trois formats de 
plug-in : TDM, RTAS et AudioSuite. Deux d'entre 
eux peuvent être utilisés comme inserts temps 
réel :

Plug-in TDM Utilisés avec les systèmes Pro Tools 
HD, ces plug-in s'appuient sur la capacité de 
traitement des cartes DSP installées sur les 
systèmes Pro Tools|HD.

Plug-in RTAS Les plug-in RTAS sont similaires à 
leurs équivalents TDM, mais contrairement à ces 
derniers, ils s'appuient sur, et sont limités par, la 
puissance de traitement hôte de votre 
ordinateur.

Plug-in AudioSuite Plug-in de traitement de 
fichiers ne fonctionnant pas en temps réel, 
conçus pour Pro Tools (reportez-vous au Guide 
DigiRack).

Les plug-in peuvent être utilisés des manières 
suivantes, selon le logiciel Pro Tools dont vous 
vous servez :

Pro Tools HD

• Vous pouvez appliquer des plug-in TDM et 
RTAS sur des pistes audio, d'entrée auxiliaire, 
de fader principal et d'instrument.

Pro Tools LE

• Vous pouvez appliquer des plug-in RTAS sur 
des pistes audio, d'entrée auxiliaire, de fader 
principal et d'instrument. 

Utilisation des voix et latence 
totale pour les plug-in RTAS
(Pro Tools HD uniquement)

Dans Pro Tools HD, et dans certaines conditions 
énoncées ci-après, l'insertion initiale d'un 
plug-in RTAS peut provoquer une latence 
supplémentaire et requérir l'ajout de deux voix 
par canal (une voix pour l'entrée et une voix 
pour la sortie).

• insertion sur une piste d'entrée auxiliaire 
ou de fader principal ;

Une nouvelle liaison peut provoquer la perte 
de l'automation. Voir Liaison et 
dissociation des commandes sur les Plug-in 
multimono, page 785. Avec Pro Tools HD, les plug-in RTAS placés 

sur des pistes d'entrée auxiliaire, de fader 
principal et d'instrument utilisent des voix 
supplémentaires et peuvent introduire une 
latence plus longue basée sur la taille du 
buffer matériel. Pour plus d'informations, 
reportez-vous à la section Utilisation des 
voix et latence totale pour les plug-in RTAS, 
page 767. 

Le Guide des plug-in DigiRack contient des 
conseils d'optimisation des performances 
RTAS.
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• insertion sur une piste d'instrument sans 
plug-in d'instrument ;

• insertion à la suite d'un plug-in TDM sur 
toute autre piste.

Ainsi, l'insertion initiale d'un plug-in RTAS sur 
une piste mono d'entrée auxiliaire requiert deux 
voix (pour un seul canal). En revanche, sur une 
piste d'entrée auxiliaire stéréo l'insertion de ce 
même plug-in requiert quatre voix (deux voix 
pour chaque canal).

Pour les plug-in RTAS suivants insérés sur la 
même piste, aucune autre voix ne sera requise, à 
moins qu'un plug-in TDM ne soit inséré entre 
deux plug-in RTAS. 

En outre, il faut ajouter une voix supplémentaire 
pour chacun des cas suivants en cas d'insertion 
de plug-in RTAS sur une piste :

• utilisation de la clé de déclenchement 
externe d'un plug-in RTAS sur cette piste ;

• sélection de plusieurs sorties de piste pour 
cette piste (une voix par sortie) ;

• sélection d'une sortie AFL/PFL dans l'onglet 
Output de la boîte de dialogue I/O Setup 
(une voix par canal).

Affichage des inserts

Vous pouvez configurer les fenêtres Mix et Edit 
pour afficher ou masquer les inserts. Les fenêtres 
Plug-In permettent de modifier les commandes 
des plug-in. 

Pour afficher ou masquer des inserts, procédez 
comme suit :

" Dans la fenêtre Mix (ou la fenêtre Edit), 
sélectionnez View > Mix Window (ou Edit 
Window) > Inserts.

– ou –

" Sélectionnez Inserts View à partir du sélecteur 
de vue de la fenêtre Edit ou de la fenêtre Mix.

En règle générale, pour éviter le recours 
inutile à des voix supplémentaires ou 
davantage de latence, n'insérez pas de 
plug-in TDM entre deux plug-in RTAS.

Lorsque vous utilisez Pro Tools 6.9.x ou une 
version plus antérieure, l'ouverture d'une 
session créée avec Pro Tools 7 provoque la 
désactivation des plug-in RTAS insérés sur 
des pistes d'entrée auxiliaire ou de fader 
principal, ou insérés à la suite de plug-in 
TDM sur un autre type de piste.

Affichage des inserts dans la fenêtre Mix

Affichage des inserts à l'aide du sélecteur de vue

Inserts

Sends (A-F)

Sélecteur de vue
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Affichage du statut de la fenêtre des 
plug-in

Dans les fenêtres Mix et Edit, le bouton Plug-In 
et le sélecteur permettent d'afficher le statut de 
désactivation du plug-in actuellement inséré 
(voir Désactivation de plug-in, page 784), le 
statut de la cible et celui de la fenêtre.

Indication de la cible du contrôleur

Si vous utilisez une surface de contrôle avec 
Pro Tools, un seul plug-in peut être « ciblé » à un 
moment donné. La cible de contrôleur actuelle, 
le cas échéant, est signalée par un contour 
coloré :

Désactivation des inserts

Il est possible de désactiver les plug-in et les 
inserts matériels pour libérer leurs ressources et 
les affecter à un autre usage. Lorsqu'il est 
désactivé, l'insert de plug-in conserve les 
informations relatives à son affectation, sa 
position et aux playlists d'automation qui lui 
sont associées. Toutefois, il ne laisse plus passer 
les données audio, et n'utilise pas de ressources 
DSP ou TDM.

A l'ouverture d'une session, les plug-in sont 
automatiquement désactivés dans les cas 
suivants :

• Les ressources DSP du système sont 
insuffisantes.

• Aucun plug-in n'est installé.

• Le type du plug-in n'est pas disponible (RTAS 
ou TDM). 

• L'ouverture de la session entraîne des 
substitutions de type de plug-in. C'est le cas 
par exemple lorsque le type de plug-in est 
disponible mais sa substitution entraîne une 
condition non prise en charge, telle que 
l'ouverture d'une session contenant un 
plug-in TDM pour lequel une version RTAS 
n'est pas disponible.

Pour désactiver un insert, procédez comme suit :

" Cliquez sur le bouton Insert en maintenant 
enfoncées les touches Pomme+Ctrl (Mac) ou 
Ctrl+Démarrer (Windows).

– ou –

" Désactivez la piste. Pour plus d'informations, 
reportez-vous à la section Inactivation des 
pistes, page 170.

Indication de fenêtre de plug-in ouverte

Cible du contrôleur

Le nom du plug-in est illuminé

Contour indiquant le statut de cible
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Pour activer ou désactiver les inserts dans la 
même position sur toutes les pistes :

" Cliquez sur un bouton Insert pour l'activer ou 
le désactiver, en maintenant enfoncées les 
touches Pomme+Ctrl (Mac) ou Ctrl+Démarrer 
(Windows).

Pour activer ou désactiver les inserts dans la 
même position sur toutes les pistes 
sélectionnées :

" Cliquez sur un bouton Insert pour l'activer ou 
le désactiver en maintenant enfoncées les 
touches Pomme+Ctrl+Option+Maj (Mac) ou 
Ctrl+Démarrer+Alt+Maj (Windows).

Inserts de plug-in inactifs

Les inserts de plug-in inactifs conservent toutes 
les playlists d'automation qui leur sont 
associées. De plus, toutes les modifications 
apportées au cours de la session se répercutent 
sur les playlists d'automation des plug-in. Vous 
ne pouvez pas enregistrer d'automation ni 
ajuster de commandes pour un plug-in inactif. 

Inserts matériels inactifs

Un insert matériel inactif conserve son 
affectation, mais ne laisse passer aucune donnée 
audio ni n'utilise de ressource DSP.

Insertion de plug-in sur les 
pistes
Pour utiliser un plug-in temps réel, vous devez 
l'insérer sur une piste. 

Pour insérer un plug-in sur une piste :

1  Dans la fenêtre Mix ou Edit, assurez-vous que 
l'affichage des inserts est visible.

2  Cliquez sur le sélecteur d'insert sur la piste, 
puis sélectionnez le plug-in à utiliser. Pour en 
savoir plus, reportez-vous à Plug-in TDM et 
RTAS, page 767.

Affichage de plug-in inactifs

Affichage de fenêtre de plug-in inactifs

(en italique)
Actif
(texte simple) 

Est inactif

Les inserts matériels n'offrent pas de 
commande de désactivation. Vous pouvez 
utiliser la fonction de désactivation pour 
couper le volume (Mute) d'un insert matériel 
ou le désactiver. 

Vous ne pouvez ni insérer ni supprimer de 
plug-in au cours de l'enregistrement.

Insertion d'un plug-in TDM

Sélecteur d'insert
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Pour supprimer un insert d'une piste :

" Cliquez sur le sélecteur d'insert, puis 
choisissez No Insert.

Ordre d'insertion des plug-in RTAS 
et TDM sur les pistes audio
(Pro Tools HD uniquement)

Dans Pro Tools HD, il existe plusieurs manières 
d'ordonner les plug-in RTAS et TDM sur une 
piste audio, d'entrée auxiliaire ou de fader 
principal :

Insertion des plug-in RTAS groupés avant les 
plug-in TDM Dans cet ordre, aucune voix 
supplémentaire n'est nécessaire et aucun 
phénomène de latence ne se fait sentir. Les 
plug-in RTAS sont ignorés lorsque la fonction 
d'activation de l'enregistrement ou d'écoute 
TrackInput est activée pour cette piste. 

Insertion des plug-in TDM groupés avant les 
plug-in RTAS Dans cet ordre, chaque insertion de 
plug-in RTAS provoque une latence du processus 
et requiert l'utilisation de voix supplémentaires, 
comme indiqué à la section Utilisation des voix 
et latence totale pour les plug-in RTAS, 
page 767. Les plug-in RTAS restent actifs lorsque 
la fonction d'activation de l'enregistrement ou 
d'écoute TrackInput est activée pour cette piste. 

Recommandations relatives à l'ordre 
d'insertion

Pour insérer des plug-in RTAS et TDM sur une 
piste audio, appliquez l'une des stratégies 
suivantes, en fonction de vos besoins :

• Pour vous assurer que les plug-in RTAS restent 
actifs lorsque la fonction d'enregistrement ou 
d'écoute TrackInput est activée, regroupez 
tous les plug-in TDM avant les plug-in RTAS.

– ou –

• Pour éviter des voix supplémentaires et 
minimiser l'effet de latence, regroupez tous les 
plug-in RTAS avant les plug-in TDM.

Vous pouvez insérer un plug-in dans une 
piste en glissant un des fichiers de 
paramètres de plug-in (.txf) à partir d'un 
navigateur DigiBase et en le déposant dans 
une position d'insert disponible de la piste 
dans la fenêtre Mix. Pour plus 
d'informations, reportez-vous à la section 
Glisser-déposer de fichiers de paramètres de 
plug-in, page 784. 

Suppression d'un plug-in

En règle générale, pour l'insertion de plug-in 
sur une piste, regroupez toujours les plug-in 
du même type, en particulier si vous insérez 
des plug-in RTAS à la suite de 
plug-in TDM. Cette précaution vous permet 
d'éviter le recours inutile à des voix 
supplémentaires.
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 Organisation du menu Plug-In
Vous pouvez personnaliser le classement des 
listes (ou menus) de plug-in dans le sélecteur 
d'insert et le sélecteur de plug-in. 

Utilisez le menu déroulant Organize Plug-In 
Menus By de la page Display Preferences de 
Pro Tools pour organiser les menus de plug-in 
en liste simple (Flat List, plug-in affichés par 
ordre alphabétique), par catégorie (Category), 
fabricant (Manufacturer) ou, catégorie et 
fabricant (Category and Manufacturer). 

Menu contextuel Organize Plug-In Menus By

Flat List Permet de présenter les plug-in dans 
une liste simple triée par ordre alphabétique.

Category Affiche les plug-in par catégorie de 
processus (par exemple, EQ, Dynamics, Delay), 
chaque plug-in étant répertorié dans les 
sous-menus de catégorie. Les plug-in ne 
correspondant pas à une catégorie standard 
(par exemple, DigiRack Signal Generator) ou les 
plug-in tiers n'appartenant pas à une catégorie 
définie par leurs développeurs, figurent dans la 
catégorie Other. Certains plug-in peuvent 
figurer dans plusieurs catégories. 

Les catégories de plug-in comprennent :

• EQ

• Dynamics

• Pitch Shift

• Reverb

• Delay

• Modulation

• Harmonic

• Noise Reduction

• Dither

• Sound Field

• Hardware

• Instrument

• Other

• Effects

Le sous-dossier Effects regroupe les effets 
spéciaux, les processeurs d'effets multiples et 
autres plug-in. Tout plug-in dont la catégorie 
fait référence à un type d'effet s'affiche dans le 
sous-dossier Effects.

Plug-in organisés par catégorie (à partir du sélecteur 
d'insert)

Plug-in organisés par fabricant (à partir du sélecteur de 
plug-in)

Sélecteur d'insert

Si aucun plug-in d'une catégorie donnée 
n'est installé sur votre système, le nom 
correspondant à cette catégorie ne s'affiche 
pas dans le menu.
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Manufacturer Permet de classer les plug-in par 
fabricant (tel que Digidesign, Eventide, Line 6 et 
McDSP), chaque plug-in étant répertorié dans 
les sous-menus de fabricant. Les plug-in dont le 
fabricant n'a pas été défini figurent dans le 
dossier fabricant Other. 

La plupart des plug-in tiers distribués par 
Digidesign sont regroupés sous le nom 
Digidesign lorsque cette option est activée.

Category and Manufacturer permet de classer les 
plug-in selon deux menus. Les menus de la 
partie supérieure de la fenêtre affichent les 
plug-in par catégorie de processus (par exemple, 
EQ, Dynamics, Delay), chaque plug-in étant 
répertorié dans les sous-menus de catégorie. 
Les menus de la partie inférieure de la fenêtre 
affichent les plug-in par fabricant (par exemple, 
Digidesign, Eventide, Line 6 et McDSP), chaque 
plug-in étant répertorié dans les sous-menus de 
fabricant.

Pour choisir le type de classement des plug-in :

1  Ouvrez une session ou créez-en. 

2  Choisissez Setup > Preferences, puis cliquez 
sur Display.

3  Cliquez sur le menu contextuel Organize 
Plug-In Menus By et sélectionnez une des 
options d'affichage.

4  Cliquez sur OK.

Le paramètre Organize Plug-In Menus By est 
enregistré avec les préférences Pro Tools (et non 
avec le fichier de session Pro Tools).

Prise en charge des surfaces de 
contrôle

Les surfaces de contrôle Digidesign équipées de 
témoins lumineux de diverses couleurs (tels que 
D-Control) indiquent les plug-in comme suit :

• Les catégories de plug-in (par exemple, EQ) 
et les fabricants de plug-in (par exemple, 
Digidesign) sont indiqués en vert.

• Les plug-in spécifiques placés dans les 
sous-dossiers (par exemple, le plug-in EQ III 
contenu dans le sous-dossier EQ) sont 
indiqués en jaune (ambre).

Les surfaces de contrôle ne disposant que d'un 
affichage unicolore (tels que ProControl et 
Command|8) ne distinguent pas les divers types 
de plug-in. Elles affichent le contenu d'un 
dossier de plug-in sous forme de liste simple.

Plug-in Default EQ et Dynamics 

Vous pouvez définir un plug-in Default EQ et un 
plug-in Dynamics, ce qui les place en haut du 
menu déroulant de sélection d'insert, et en 
première position dans la liste de choix de menu 
lors de l'assignation d'inserts sur des surfaces de 
travail ICON.

Si aucun plug-in d'un fabricant donné n'est 
installé sur votre système, le nom 
correspondant à ce fabricant ne s'affiche 
pas dans le menu.

Affichage de plug-in par défaut dans le menu de 
sélection d'insert
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Pour paramétrer un plug-in par défaut :

1  Choisissez Setup > Preferences et cliquez sur 
Mixing. 

2  Dans Setup, choisissez un plug-in à partir du 
menu déroulant Default EQ ou Default 
Dynamics.

3  Cliquez sur OK pour refermer la fenêtre 
Preferences.

Plug-in favoris

Désignez un plug-in en tant que favori pour y 
accéder plus rapidement. Les plug-in favoris 
s'affichent en tête du menu des plug-in. 

Le nom du plug-in favori s'affiche en gras dans 
les sous-menus de plug-in classés par catégorie.

Pour désigner un plug-in en tant que favori :

" Cliquez sur le sélecteur d'insert en maintenant 
la touche Ctrl (Windows) ou Pomme (Mac) 
enfoncée et sélectionnez un plug-in pour le 
désigner en tant que favori.

Pour modifier le statut d'un plug-in favori :

" Cliquez sur le sélecteur d'insert en maintenant 
la touche Ctrl (Windows) ou Pomme (Mac) 
enfoncée et sélectionnez un plug-in que vous ne 
souhaitez plus désigner en tant que favori. 

Vous pouvez sélectionner ce plug-in favori dans 
la liste des favoris au-dessus du menu des plug-in 
ou dans le sous-menu des plug-in classés par 
catégorie. Dans ce dernier, le plug-in concerné 
apparaît en gras.

Déplacement et duplication 
d'inserts plug-in et d'inserts 
matériels
Pour déplacer ou dupliquer un insert, faites-le 
glisser vers un autre emplacement de la piste ou 
vers une autre piste. Les inserts déplacés ou 
dupliqués conservent leurs paramètres et 
données d'automation d'origine.

Pour déplacer un insert-:

" Faites glisser l'insert jusqu'à l'emplacement 
choisi.

Affichage de menu des plug-in favoris

Plug-in favoris

Catégories de 
plug-in

Vous ne pouvez ni déplacer ni dupliquer les 
plug-in au cours de l'enregistrement.

Déplacement d'un plug-in

Pour remplacer un insert, ainsi que 
l'automation, faites glisser un autre insert 
sur celui-ci.
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Pour dupliquer un insert-:

" Faites-le glisser vers l'emplacement choisi en 
appuyant sur la touche Option (Mac) ou Alt 
(Windows). Les inserts de plug-in dupliqués 
conservent leurs paramètres d'origine et leur 
automation.

Fenêtre Plug-In
La fenêtre Plug-In s'affiche lorsque vous cliquez 
sur le bouton Insert du plug-in d'une piste. Cette 
fenêtre flottante permet de modifier et de définir 
les commandes de tout insert de plug-in en 
temps réel utilisé sur une piste.

Sélecteur de piste : cette fonction permet 
d'accéder à une piste non MIDI au cours d'une 
session.

Sélecteur d'emplacement de l'insert : Cette 
fonction permet d'accéder à n'importe quel 
insert de la piste en cours.

Sélecteur de plug-in : Permet de sélectionner 
l'un des plug-in en temps réel installés dans le 
dossier Plug-Ins créé à l'installation de Pro Tools.

Bouton Bypass : Ce bouton désactive le plug-in 
affiché. Vous pouvez ainsi comparer le son de la 
piste avec et sans effet.

Sélecteur de conversion de plug-in : Ce menu 
permet de convertir l'insert d'un plug-in TDM en 
insert de plug-in RTAS de type identique (et 
inversement). Cette fonction ne peut être 
utilisée qu'avec des plug-in disponibles dans les 
deux formats.

Voyant d'écrêtage : s'allume en rouge pour 
indiquer l'écrêtage d'un vumètre dans un 
plug-in (non disponible sur tous les plug-in). 
Le témoin d'écrêtage du plug-in suit les 
paramètres d'indication d'écrêtage de Pro Tools. 

Menu ΩSettings Ce menu permet de copier, de 
coller, d'enregistrer et d'importer les paramètres 
des plug-in.

Menu Librarian : restaure les fichiers de 
paramètres enregistrés à la racine du dossier du 
plug-in ou dans le dossier Settings de la session 
en cours. Pour plus d’informations, reportez-
vous à la section « Utilisation du menu 
Librarian », page 778.

Boutons Paramètre précédent (–) et Paramètre 
suivant (+) permet de sélectionner le paramètre 
de plug-in précédent ou suivant dans le menu 
Librarian.

Vous pouvez également dupliquer les 
départs. Voir Déplacement ou copie de 
départs, page 743.

Bouton d'insertion et sélecteur sur piste

Fenêtre Plug-In (Mono Trim)

Bouton d'insertion

Sélecteur d'insert

Menu Settings

Sélecteur de piste

Menu Librarian

Sélecteur 
du point 
d'insertion

Sélecteur de plug-in Compare

Bouton
Target

Paramètre
précédent

Paramètre
suivant

Sélecteur du 
menu des 
paramètres

Effet
Bypass

Bouton Safe

Bouton Auto

Conversion
du plug-in

Voyant
d'écrêtage
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Bouton de sélection des paramètres de plug-in 

permet d'accéder à la boîte de dialogue Plug-In 
Settings, qui contient la liste des fichiers de 
paramètres du plug-in actuel, dans laquelle vous 
pouvez sélectionner de nouveaux paramètres ou 
écouter les paramètres définis.

Compare : permet de basculer entre les 
paramètres d'origine du plug-in et leurs valeurs 
après modification, afin de les comparer.

Auto, bouton active en enregistrement 
d'automation les commandes individuelles des 
plug-in. Pour plus d’informations, reportez-vous 
à la section « Automation des plug-ins », 
page 809.

Automation Safe Interdit l'effacement des 
playlists d'automation du plug-in existantes.

Bouton de cible : Lorsque plusieurs fenêtres 
Plug-In sont ouvertes, cliquez sur ce bouton 
pour définir le plug-in cible de toutes les 
commandes clavier. Pour plus d'informations, 
reportez-vous à la section Fenêtres « ciblées », 
page 749.

Sélecteur de déclencheur : permet de 
sélectionner les données audio d'une entrée ou 
d'un bus spécifique et de les acheminer afin de 
déclencher le plug-in. Ce menu n'apparaît que 

sur les plug-in qui prennent en charge le 
traitement par déclenchement externe. 
Les entrées de déclenchement (Trigger) sont 
monophoniques.

MIDI Node Display : affiche les informations 
relatives au nœud MIDI des plug-in compatibles 
MIDI. Les nœuds MIDI sont des connexions 
virtuelles qui relient Pro Tools à des instruments 
logiciels et à d'autres plug-in compatibles MIDI. 
Ils sont particulièrement utiles pour 
l'acheminement de pistes MIDI vers plusieurs 
canaux appartenant à un même périphérique 
MIDI virtuel. Les numéros des nœuds MIDI 
s'affichent également dans le sélecteur de sortie 
MIDI d'une piste.

Bouton Master Link : lie les commandes de tous 
les canaux d'un plug-in multimono, afin de 
pouvoir les régler par paire.

Cette opération supprime le paramétrage 
actuel si celui-ci n'a pas été sauvegardé. 
Enregistrez toujours votre configuration 
dans le menu Librarian.

Affichage du nœud Midi dans l'en-tête d'un plug-in 
(Bruno)

Fenêtre Plug-In (EQ à 1 bande multimono)

Nœud MIDI

Sélecteur de déclencheur

Sélecteur de canal

Boutons Link Enable

Bouton Master Link

Inversion 
de 
phase
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Boutons Link Enable : assure une activation ou 
désactivation de la liaison sélective des 
commandes sur des canaux spécifiques d'un 
plug-in multimono. Chaque carré représente un 
canal d'enceinte. Désactivez le bouton Master 
Link avant d'utiliser les boutons Link Enable. 
Pour plus d’informations, reportez-vous à la 
section « Liaison et dissociation des commandes 
sur les Plug-in multimono », page 785.

Channel selector : permet d'accéder au canal 
spécifique d'une piste multicanal afin de 
modifier les commandes du plug-in. Ce menu 
apparaît uniquement sur les plug-in multimono 
insérés sur des pistes dotées de plusieurs canaux. 
Cliquez dessus en appuyant sur la touche 
Majuscule pour ouvrir une fenêtre Plug-In 
distincte pour chaque canal de la piste 
multicanal sur laquelle le plug-in est inséré.

Bouton d'inversion de phase : Inverse la phase 
(polarité) du signal d'entrée sur certains plug-in.

LFE Enable Ce bouton active le traitement par 
plug-in d'un canal LFE (low frequency effects ou 
subwoofer) sur une piste multicanaux au format 
Surround 5.1, 6.1 ou 7.1 sur certains plug-in. 
Pour désactiver le traitement du LFE, 
désélectionnez ce bouton.

Tempo Sync Active les plug-in compatibles pour 
une synchronisation automatique au tempo de 
la session, pour des retards rythmiques, des 
échos et des effets similaires.

Ouverture des fenêtres Plug-In

Pour ouvrir une fenêtre Plug-In :

" Dans la bande de canal de la fenêtre Mix ou 
Edit, cliquez sur le bouton Plug-In.

Par défaut, chaque plug-in ouvert apparaît à 
l'emplacement d'un plug-in déjà ouvert et le 
remplace dans la fenêtre, au même 
emplacement. 

Ouverture de plusieurs fenêtres 
Plug-In

Pro Tools affiche généralement une seule 
fenêtre Plug-In permettant de régler les 
commandes de n'importe quel plug-in d'une 
session. Vous pouvez également ouvrir d'autres 
fenêtres Plug-In de plug-in spécifiques. Lorsque 
vous travaillez avec plusieurs fenêtres Plug-In, 
cliquez sur le bouton de cible correspondant au 
plug-in dont vous souhaitez modifier les 
commandes à l'aide de celles du clavier.

Pour ouvrir des fenêtres Plug-In supplémentaires :

" Dans la fenêtre Mix, appuyez sur la touche 
Maj, puis cliquez sur le bouton Insert d'un 
plug-in.

Pour ouvrir une fenêtre Plug-In pour chaque canal 
d'un plug-in multimono :

" Dans la fenêtre Plug-In d'un insert de plug-in, 
appuyez sur la touche Option (Mac) ou Alt 
(Windows) et cliquez sur le sélecteur de canal. 

Fenêtre Plug-In (compresseur multicanal)

Bouton LFE

Boutons d'inversion de phase
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Pour fermer toutes les fenêtres Plug-In ouvertes :

" Appuyez sur la touche Option (Mac) ou Alt 
(Windows) et cliquez sur la case de fermeture de 
toutes les fenêtres Plug-In. 

Commandes de la fenêtre Plug-In

Outre les paramètres d'égaliseurs, de processeurs 
de dynamique et autres paramètres spécifiques 
au processeur d'effet, tous les plug-in utilisent 
les commandes Pro Tools standard pour la 
sélection des pistes et des inserts, la 
désactivation, etc. 

Pour sélectionner un autre plug-in sur la même 
piste :

" Cliquez sur le sélecteur d'insert, puis 
sélectionnez un plug-in dans le menu déroulant.

Pour choisir une autre piste :

" Cliquez sur le sélecteur de piste, puis 
choisissez une piste dans le menu déroulant.

Fenêtre Target et raccourcis de paramètres

Lorsque plusieurs fenêtres Plug-In sont ouvertes, 
la fenêtre cible (Target) est indiquée par une 
cible en surbrillance. Pro Tools conserve une 
seule fenêtre Plug-In cible. L'ouverture d'un 
nouveau plug-in entraîne celle d'une nouvelle 
fenêtre cible, au même emplacement que la 
précédente. De plus, la fenêtre Plug-In cible 
constitue également la cible des raccourcis 
clavier de configuration du plug-in. 

Utilisation du menu Librarian
Les paramètres du menu Librarian permettent 
de créer facilement une bibliothèque de 
paramètres de plug-in. AA partir des menus 
Librarian et Settings, vous pouvez copier, coller, 
enregistrer et importer ces paramètres d'un 
plug-in à l'autre ou d'une session à l'autre.

Une fois vos fichiers de paramètres créés et 
enregistrés sur le disque (et après avoir indiqué à 
Pro Tools l'emplacement de leur dossier racine), 
ils apparaissent dans le menu Librarian et dans 
la boîte de dialogue des paramètres de plug-in. 
Ils apparaissent également en tant que fichiers 
de paramète de plug-in (.txf) dans les 
navigateurs DigiBase.

Sélection d'un plug-in dans la fenêtre Plug-In

Sélection d'une piste dans la fenêtre Plug-In

Menu Librarian



Chapitre 29 : Inserts de plug-in et inserts matériels 779

Menu Settings

Utilisez les commandes du menu Settings pour 
enregistrer, copier, coller et gérer les fichiers de 
paramètres des plug-in.

Les commandes du menu des paramètres 
comprennent :

Save Settings : enregistre les paramètres actuels. 
Cette commande remplace toute version 
précédente des paramètres. Ces derniers 
apparaissent ensuite dans le menu Librarian.

Save Settings As : enregistre les paramètres 
actuels sous un nouveau nom.

Copy Settings : copie les paramètres actuels. 
Vous pouvez ensuite appliquer ces paramètres 
au même type de plug-in sur une autre piste en 
choisissant la piste dans la fenêtre Plug-In et en 
collant les paramètres à l'aide de la commande 
Paste Settings.

Paste Settings : colle les paramètres copiés à 
l'aide de la commande Copy Settings.

Import Settings : importe un fichier de 
paramètres non contenu dans les dossiers Root 
Settings ou Session. 

Delete Current Settings File : supprime de façon 
permanente le fichier de paramètres actuel du 
disque.

Lock Settings File : interdit le remplacement des 
paramètres actuels via la commande Save. 
Si vous tentez d'enregistrer des paramètres 
modifiés, vous devrez utiliser un nom ou un 
emplacement différent.

Set As User Default : définit les paramètres 
actuels comme les paramètres utilisateur par 
défaut pour un plug-in spécifique.

Settings Preferences

Les sous-menus de Settings Preferences 
permettent de définir des préférences 
d'enregistrement et d'importation des 
paramètres de plug-in et incluent :

Set Plug-In Default To : applique aux paramètres 
par défaut la configuration Factory Default 
(paramètres d'usine standard pour ce plug-in) ou 
User Default (vos paramètres).

Save Plug-In Settings To : sélectionne le dossier 
dans lequel les paramètres des plug-in sont 
enregistrés. Si vous choisissez Session Folder, les 
paramètres sont enregistrés dans un dossier 
nommé Plug-In Settings, dans le dossier Session 
actif. Si vous choisissez Root Settings Folder, les 
paramètres sont enregistrés dans le dossier 
spécifié à l'aide de la commande Set Root 
Settings Folder.

Vous pouvez également utiliser la boîte de 
dialogue Plug-In Settings pour sélectionner 
des paramètres de plug-in ou les écouter. 
Pour plus d'informations, reportez-vous à la 
section Boîte de dialogue Plug-In Settings, 
page 782.

Menu Settings
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Set Root Settings Folder : sélectionne un dossier 
source ou racine pour enregistrer et importer des 
paramètres. Le dossier des paramètres racine 
doit être nommé Plug-In Settings. N'utilisez 
cette commande que si vous souhaitez choisir 
un emplacement autre que le dossier Plug-In 
Settings.

L'emplacement par défaut du dossier Root 
Plug-In Settings est le suivant :

Windows : Program Files\Common Files\
Digidesign\DAE\Plug-In Settings

Mac : Library/Application Support/Digidesign/
Plug-In Settings 

Choix d'une destination pour les 
paramètres

Avant d'enregistrer des paramètres de plug-in, 
choisissez leur dossier de destination.

Pour sélectionner un dossier de destination : 

" Dans le menu contextuel Settings, 
sélectionnez Settings Preferences > Save Plug-In 
Settings To, puis Session Folder ou Root Settings 
Folder.

Si vous choisissez Root Settings Folder, Pro Tools 
enregistre les données dans le dossier Plug-In 
Settings, à moins que vous n'ayez spécifié un 
emplacement différent pour le dossier Root 
Settings.

Pour sélectionner un autre dossier Root Settings :

1  Dans le menu contextuel Settings, choisissez 
Settings Preferences > Set Root Settings Folder.

2  Choisissez le dossier racine à utiliser et cliquez 
sur Select. 

Création de sous-dossiers de 
paramètres

Pour faciliter la recherche de paramètres 
spécifiques, vous pouvez diviser les fichiers de 
paramètres en créant des sous-dossiers.

Pour créer un sous-dossier de paramètres :

3  Dans le menu déroulant Settings, sélectionnez 
Save Settings.

4  Cliquez sur le bouton New Folder et attribuez 
un nom au sous-dossier.

5  Attribuez un nom à votre paramètre, puis 
cliquez sur Save. Le fichier est enregistré dans le 
sous-dossier. 

Gestion des paramètres

Le menu déroulant Settings permet de gérer vos 
paramètres.

Pour enregistrer les paramètres de plug-in 
dans un emplacement autre que le dossier 
Plug-In Settings, créez d'abord un dossier 
appelé Plug-In Settings dans son nouvel 
emplacement, puis enregistrez vos données 
dans ce dossier.

Menu Librarian

Le paramétrage des plug-in multimono non 
liés répond à des règles spécifiques. Pour 
plus d’informations, reportez-vous à la 
section « Liaison et dissociation des 
commandes sur les Plug-in multimono », 
page 785.
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Pour enregistrer un paramètre : 

1  Dans le menu contextuel Settings, 
sélectionnez Save Settings.

2  Saisissez un nom et cliquez sur OK. Ce fichier 
apparaît dans le menu Librarian.

Pour charger un fichier de paramètres 
préalablement enregistré :

" Dans le menu contextuel Librarian, choisissez 
le paramètre.

Pour importer un paramètre : 

1  Dans le menu contextuel Settings, choisissez 
Import Settings.

2  Recherchez le fichier de paramètres que vous 
souhaitez importer, puis cliquez sur Open. 
Pro Tools charge le paramètre et le copie dans le 
fichier de destination racine.

Pour copier un paramètre : 

" Dans le menu contextuel Settings, 
sélectionnez Copy Settings.

Pour coller un paramètre : 

1  Ouvrez le plug-in de destination.

2  Sélectionnez Paste Settings dans le menu 
déroulant Settings.

Pour créer un ensemble de paramètres utilisateur 
par défaut : 

1  Créez un paramètre et enregistrez-le.

2  Sélectionnez Set As User Default dans le menu 
déroulant Settings. 

Pour qu'un plug-in adopte vos paramètres 
personnalisés par défaut : 

" Dans le menu contextuel Settings, choisissez 
Settings Preferences > Set Plug-In Default To > 
User Setting.

Modification des paramètres à l'aide 
des boutons Paramètre précédent (–) et 
Paramètre suivant (+)

Ces boutons permettent de sélectionner le 
paramètre de plug-in précédent ou suivant dans 
le menu Librarian.

Pour modifier des paramètres d'un plug-in à l'aide 
des bouton +/– :

" Cliquez sur le bouton (–) ou (+) pour 
sélectionner respectivement le fichier de 
paramètres du plug-in précédent ou suivant. 
Une fois le fichier de paramètres précédent ou 
suivant activé, le menu Librarian est mis à jour 
avec les changements.

Modification des paramètres de plug-in 
multimono non liés

Lorsqu'un plug-in multimono n'est pas lié, les 
paramètres importés, copiés, collés ou désactivés 
ne concernent que le canal sélectionné.

Pour enregistrer les paramètres de plug-in, 
appuyez sur Ctrl+Maj+S (Windows) ou sur 
Pomme+Maj+S (Mac).

Pour copier les paramètres de plug-in, 
appuyez sur Ctrl+Maj+C (Windows) ou sur 
Pomme+Maj+C (Mac).

Appuyez sur Ctrl+Maj+V (Windows) ou sur 
Pomme+Maj+V (Mac) pour coller les 
paramètres de plug-in.

Cette opération supprime le paramétrage 
actuel si celui-ci n'a pas été sauvegardé. 
Enregistrez toujours votre configuration 
dans le menu Librarian.
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Pour appliquer des changements à tous les 
canaux d'un plug-in non lié :

" Appuyez sur la touche Alt (Windows) ou 
Option (Mac) tout en sélectionnant la 
commande.

Boîte de dialogue Plug-In Settings

La boîte de dialogue Plug-In Settings affiche la 
liste des fichiers de paramètres pour le type de 
plug-in actuel. Dans cette liste, vous pouvez 
sélectionner de nouveaux paramètres ou écouter 
les paramètres définis. L'écoute des paramètres 
de plug-in sert particulièrement à la sélection de 
noms de patch pour les plug-in d'instruments 
MIDI virtuels ou aux essais d'effets appliqués à 
vos données audio. 

Utilisez le menu déroulant Folder situé en haut 
de la boîte de dialogue Settings pour passer d'un 
sous-dossier de paramètres de plug-in à un autre, 
ou d'un dossier racine à un dossier de paramètres 
de session.

La boîte de dialogue Plug-In Settings inclut les 
éléments suivants :

Folder : ce menu déroulant permet de passer 
d'un paramètre à un autre, dans les dossiers 
racine et de session (et sous-dossier éventuels).

Patch Field : ce champ indique le nom du 
paramètre actuel, en surbrillance dans la liste.

Increment Patch Every X Sec cette option 
permet d'écouter les paramètres de plug-in à la 
volée par défilement de la liste pendant une 
durée déterminée (exprimée en secondes).

Pour modifier les paramètres de plug-in à l'aide de 
la boîte de dialogue Plug-In Settings :

1  Cliquez sur le bouton de sélection de 
paramètres.

2  Effectuez l'une des opérations suivantes :

• Sélectionnez un paramètre de plug-in à 
partir de la liste de la boîte de dialogue.

– ou –

• A l'aide des touches fléchées, parcourez la 
liste jusqu'au paramètre de votre choix. 

3  Cliquez sur Done (Terminé).

Boîte de dialogue Plug-in Settings

Pour basculer entre les sous-dossiers de 
paramètres, appuyez sur la touche Ctrl 
(Windows) ou Pomme (Mac) et utilisez les 
touches fléchées Haut/Bas.
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Ecoute de paramètres de plug-in

Lorsque la boîte Plug-in Settings est ouverte, 
Pro Tools peut parcourir automatiquement la 
liste des paramètres et lancer l'écoute des fichiers 
de paramètres enregistrés dans le dossier racine 
des paramètres de plug-in ou dans le dossier des 
paramètres de la session en cours.

Pour écouter des paramètres de plug-in :

1  Cliquez sur le bouton de sélection de 
paramètres.

2  Dans la liste de la boîte de dialogue, cliquez 
sur le paramètre qui définira le début du 
défilement.

3  Entrez le nombre de secondes désiré entre 
chaque changement de programme.

4  Sélectionnez l'option Increment Patch.

Une fois la durée spécifiée écoulée, Pro Tools 
sélectionne le paramètre suivant. 

5  Après avoir écouté les paramètres souhaités, 
effectuez l'une des opérations suivantes :

• Cliquez sur Done pour arrêter 
l'incrémentation des patchs et fermer la 
boîte de dialogue Plug-in Settings.

– ou –

• Cliquez sur Increment Patch pour arrêter 
l'incrémentation des patchs et laisser la 
boîte de dialogue Plug-In Settings ouverte.

Fichiers DigiBase et de 
paramètres de plug-in

Recherche de fichiers de paramètres de plug-in

Pour rechercher des fichiers de paramètres de 
plug-in :

1  Cliquez sur l'icône de recherche dans le 
navigateur de l'espace de travail.

2  Sélectionnez Plug-in Settings File dans le 
menu contextuel Type.

3  Pour restreindre votre recherche, saisissez le 
nom entier ou une partie du nom du fichier de 
paramètres de plug-in que vous recherchez.

4  Cliquez sur Search.

5  Pour trier votre recherche par nom de plug-in 
ou de fabricant, cliquez sur le titre de colonne 
correspondant.

Recherche de fichiers de paramètres de plug-in

Fichiers de paramètres de plug-in trouvés dans les 
navigateurs de l'espace de travail et triés par nom de 
plug-in

Avec DigiBase Pro (Pro Tools HD et 
Pro Tools LE avec DV Toolkit 2 
uniquement), vous pouvez créer des 
catalogues de paramètres de plug-in 
spécifiques avec lesquels vous travaillez 
fréquemment pour simplifier votre travail. 
Pour plus d'informations à propos de 
DigiBase Pro et des catalogues, consultez le 
Guide de référence Pro Tools.
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Glisser-déposer de fichiers de paramètres de 
plug-in

Vous pouvez insérer un plug-in avec un fichier 
de paramètres de plug-in spécifique, et modifier 
les paramètres des plug-in insérés en glissant les 
fichiers de paramètres de plug-in à partir d'un 
navigateur DigiBase.

Pour insérer un plug-in en effectuant un 
glisser-déposer :

" Glissez-déposez un fichier de paramètres de 
plug-in à partir d'un
navigateur DigiBase dans un Insert dans la 
fenêtre Mix (ou Edit).

Pour modifier des paramètres de plug-in en 
effectuant un glisser-déposer :

" Glissez-déposez un fichier de paramètres de 
plug-in à partir d'un navigateur DigiBase dans la 
fenêtre plug-in. Le fichier de paramètres de 
plug-in doit être destiné au même nom de 
plug-in. Par exemple, vous ne pouvez pas 
remplacer un 1-Band EQ 3 avec un paramètre de 
plug-in pour 4-Band EQ 3.

Désactivation de plug-in

Il est possible de désactiver (contourner) les 
plug-in depuis la fenêtre Plug-In correspondante 
ou depuis la vue Inserts des fenêtres Mix et Edit. 

Glisser-déposer d'un fichier de paramètres de plug-in 
dans un Insert

Glisser-déposer d'un fichier de paramètres de plug-in 
dans un plug-in

Lorsqu'un insert de plug-in est ignoré, le 
sélecteur d'insert de la fenêtre Mix devient 
bleu pour faciliter le repérage visuel. Si 
certains canaux d'un plug-in multimono 
non lié sont ignorés, le sélecteur d'insert 
apparaît en violet.
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Pour désactiver un plug-in, effectuez l'une des 
opérations suivantes :

" Cliquez sur le bouton Effect Bypass de la 
fenêtre Plug-in.

– ou –

" Cliquez sur le bouton Insert du plug-in dans la 
fenêtre Mix ou Edit tout en appuyant sur la 
touche Pomme (Mac) ou Ctrl (Windows). 

Liaison et dissociation des 
commandes sur les Plug-in 
multimono

Lorsqu'un plug-in multimono est appliqué sur 
une piste stéréo ou une piste multicanal de 
format supérieur au format stéréo (Pro Tools HD 
uniquement), les commandes sont couplées par 
défaut. Le réglage de la commande Gain sur un 
canal, par exemple, est étendu à tous les autres 
canaux.

Vous pouvez dissocier les commandes de 
plug-in sur des canaux spécifiques d'une piste et 
les modifier indépendamment. Vous pouvez 
également lier les commandes de manière 
sélective sur certains canaux seulement.

Pour dissocier les commandes d'un plug-in 
multimono :

" Désélectionnez le bouton Master Link.

Pour accéder aux commandes d'un canal 
particulier :

" Sélectionnez le canal dans le sélecteur 
correspondant.

Pour lier les commandes de canaux spécifiques :

1  Désélectionnez le bouton Master Link, si ce 
n'est déjà fait.

2  Cliquez sur les boutons Link Enable 
correspondant aux canaux dont vous souhaitez 
lier les commandes. Par exemple, sur les plug-in 
offrant des commandes LFE distinctes du 
bouton LFE Enable, vous pouvez lier tous les 
canaux à l'exception de celui de LFE en mettant 
en surbrillance les icônes représentant les cinq 
enceintes dans un plug-in multimono.

Edition des commandes de 
plug-in
Pour régler une commande de plug-in, déplacez 
le curseur correspondant ou saisissez une valeur 
dans la zone de texte associée. Pour obtenir des 
informations à propos de l'édition de plug-in 
spécifiques, consultez la documentation du 
plug-in.

Indication de l'état du plug-in désactivé

Sélecteur de canal et commandes de liaison (liaison 
désactivée)

désactivé (bleu)
canaux d'entrée 
désactivé (violet) non désactivé

Sélecteur de canal

Boutons Link Enable

Bouton Master Link

Tous les canaux sont liés, à l'exception du LFE.

Les plug-in DigiRack (installés avec 
Pro Tools) sont décrits dans le Guide des 
Plug-in DigiRack.
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Pour régler une commande de plug-in :

1  Lancez la lecture audio afin d'entendre en 
temps réel les réglages apportés à la commande.

2  Réglez les commandes du plug-in pour obtenir 
l'effet souhaité.

3  Refermez la fenêtre Plug-In pour enregistrer 
les modifications les plus récentes.

Modification des paramètres à l'aide de 
la souris

Vous pouvez régler les potentiomètres rotatifs 
en faisant glisser la souris horizontalement ou 
verticalement. Les valeurs de paramètre 
augmentent lorsque vous faites la souris glisser 
vers le haut ou vers la droite, et diminuent 
lorsque vous la faites glisser vers le bas ou vers la 
gauche.

Raccourcis clavier

! Pour affiner les réglages, appuyez sur la touche 
Commande (Mac) ou Ctrl (Windows) et faites 
glisser la commande.

! Pour restaurer la valeur par défaut d'une 
commande, appuyez sur la touche Option (Mac) 
ou Alt (Windows) et cliquez sur la commande. 

Modification de paramètres à l'aide du 
clavier de l'ordinateur

Vous pouvez modifier les commandes d'un 
plug-in à partir de votre clavier.

Si plusieurs fenêtres Plug-In sont ouvertes, la 
saisie au moyen de la touche Tab et du clavier 
concerne le plug-in ouvert dans la fenêtre cible.

Pour modifier la valeur d'une commande à l'aide du 
clavier :

1  Pour activer le champ, cliquez ou naviguez 
dans la zone de texte de la commande à régler. 

2  Modifiez la valeur en effectuant l'une des 
opérations suivantes :

• Pour augmenter une valeur, appuyez sur la 
touche fléchée Haut du clavier ; 

• pour la diminuer, appuyez sur la touche 
fléchée Bas du clavier.

• Saisissez la valeur.

3  Pour confirmer la valeur, effectuez l'une des 
actions suivantes :

• Appuyez sur la touche Entrée du pavé 
alphanumérique pour saisir la valeur et 
rester en mode d'édition au clavier.

– ou –

• Pour valider la saisie et quitter le mode 
d'édition au clavier, appuyez sur la touche 
Retour (Mac) ou Entrée sur le clavier 
alphanumérique (Windows).

La fenêtre Plug-In cible constitue également 
la cible des raccourcis clavier de 
configuration du plug-in. Pour définir un 
plug-in comme cible de n'importe quelle 
commande clavier (y compris des 
raccourcis), cliquez sur le bouton Target 
requis dans la fenêtre Plug-In.

Pour vous déplacer d'un champ de 
commande au suivant, appuyez sur la 
touche de tabulation. Pour reculer, appuyez 
sur Maj+Tab.

Dans les champs qui acceptent les valeurs 
exprimées en kilohertz, ajoutez la lettre k à 
la suite d'un nombre pour le multiplier par 
1 000. Pour indiquer 8 000, par exemple, 
saisissez 8k.
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Pour supprimer des indications d'écrêtage :

" Appuyez sur les touches Alt+C (Windows) ou 
Option+C (Mac).

Automation de plug-in et fonction 
Safe

Tous les plug-in en temps réel peuvent être 
entièrement automatisés, et prennent en charge 
tous les modes d'automation de Pro Tools 
(Write, Touch, Latch et Trim). 

Le bouton Auto ouvre la boîte de dialogue 
Plug-in Automation qui permet d'activer des 
paramètres individuels de plug-in pour 
l'enregistrement d'automation. Pour en savoir 
plus, reportez-vous à la section Automation des 
plug-ins, page 809.

Le bouton Safe active le mode Automation Safe. 
Son activation interdit l'effacement des playlists 
d'automation du plug-in existant. 
Reportez-vous à la section Protection de 
l'enregistrement de l'automation d'un plug-in, 
page 811.)

Utilisation d'un déclenchement 
externe

Le déclenchement externe se fonde sur un signal 
utilisé par le détecteur d'un plug-in pour 
déclencher le traitement dynamique. Ce signal 
est généralement lancé en interne, à partir du 
signal d'entrée. Néanmoins, certains plug-in 
offrent la possibilité de basculer entre le 
traitement par déclenchement interne et celui 
par déclenchement externe.

Dans le cas du traitement par déclenchement 
externe, le détecteur d'un plug-in est déclenché 
par un signal externe (une source audio ou une 
piste de référence distincte, par exemple) aussi 
appelé déclencheur.

Le traitement par déclenchement externe sert 
généralement à contrôler la dynamique d'un 
signal audio (celui qui entre dans le plug-in) à 
l'aide d'un autre signal (le déclencheur). Une 
piste de grosse caisse, par exemple, peut servir à 
déclencher un noise gate sur une piste de basse 
pour préserver l'impact rythmique et une piste 
de guitare rythmique peut servir à filtrer un 
clavier.

Filtres de déclenchement externe

Certains plug-in comportent des filtres 
passe-haut et passe-bas sur la clé de 
déclenchement externe. Ces commandes 
permettent de définir une gamme de fréquences 
du signal qui servira au déclenchement de l'effet 
du plug-in. Une astuce de production assez 
courante consiste à se servir de ces filtres pour, à 
partir d'une piste de batterie, activer le 
déclenchement uniquement à partir des sons 
riches en aigus (charley, par exemple) ou en 
graves (tom ou grosse caisse par exemple). 

Utilisation d'un déclencheur pour le 
traitement par déclenchement externe

Pour utiliser un déclencheur en vue du traitement 
par déclenchement externe :

1  Cliquez sur le sélecteur de déclencheur et 
choisissez l'entrée ou le bus audio à utiliser pour 
déclencher le plug-in.

2  Pour activer le traitement par déclenchement 
externe, cliquez sur External Key.

Sélection d'un déclencheur
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3  Appuyez sur la barre d'espace pour lancer la 
lecture. Le plug-in utilise l'entrée ou le bus que 
vous avez choisi(e) comme déclencheur d'effet.

4  Pendant la lecture, réglez le déclencheur d'une 
des manières suivantes :

• Pour entendre la source audio sélectionnée 
afin de contrôler le déclencheur, cliquez 
sur le bouton Side-Chain Listen ou Key 
Listen (selon le plug-in). Une fois le réglage 
effectué, désactivez les boutons Side-Chain 
Listen ou Key Listen pour revenir au 
contrôle normal de plug-in.

• Pour filtrer le déclencheur de sorte à ne 
déclencher le plug-in qu'à certaines 
fréquences, définissez la gamme de 
fréquences souhaitée à l'aide des 
commandes de filtrage, si elles existent.

5  Au besoin, réglez également le seuil de 
déclenchement à l'aide de la commande 
Threshold (seuil) du plug-in (si disponible) et 
d'autres commandes.

Plug-in d'instrument
Les plug-in d'instrument sont des instruments 
logiciels (par exemple, synthétiseurs ou 
samplers) qui génèrent des données audio et que 
l'on peut contrôler avec MIDI. Vous pouvez 
insérer des plug-in d'instrument sur des pistes 
audio, d'entrée auxiliaire et d'instrument. 

Les plug-in d'instrument sont insérés sur des 
pistes tout comme les autres plug-in. Vous 
pouvez déplacer et dupliquer les plug-in 
d'instrument, leurs contrôles peuvent être 
désactivés, protégés et automatisés, et vous 
pouvez sauvegarder leurs paramètres en utilisant 
la même méthode que pour les autres plug-in. 

En insérant un plug-in d'instrument sur une 
piste d'instrument, vous pouvez contrôler 
l'entrée MIDI vers le plug-in et la sortie 
audio du plug-in à partir d'une seule piste. 
Pour plus d'informations, reportez-vous à la 
section Ecoute et mixage de données audio 
avec des pistes d'instrument, page 750.

Plug-in d'instrument inséré dans une piste d'instrument

Sortie MIDI acheminée vers un plug-in

Sélecteur de sortie audio

Insert de plug-in d'instrument

Vumètre de vitesse MIDI indiquant 

Vumètres affichant la sortie audio

l'entrée MIDI
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Utilisation d'inserts matériels
Vous pouvez connecter des périphériques 
externes, tels que des processeurs de 
réverbération ou d'effets, à votre système 
Pro Tools, puis les utiliser en tant qu'inserts 
matériels sur des pistes individuelles ou sur des 
prémixages.

Les inserts Pro Tools envoient et récupèrent les 
sons par l'intermédiaire de canaux d'entrée et de 
sortie matériels correspondants. La boîte de 
dialogue I/O Setup permet de définir les inserts 
et de faire correspondre leurs canaux à ceux de 
l'interface audio. 

Pour utiliser un périphérique en insertion, 
connectez-le aux entrées et sorties 
correspondantes de votre système. Par exemple, 
un insert matériel fourni par les sorties 7-8 doit 
être renvoyé à des entrées matérielles 7-8. 

Pour définir des inserts matériels :

1  Choisissez Setup > I/O, puis cliquez sur 
l'onglet Inserts. 

2  Sélectionnez un chemin d'insertion ou cliquez 
sur New Path pour en créer un.

3  Cliquez deux fois sur le nom du chemin pour 
attribuer un nom de chemin personnalisé à 
l'insert.

4  Assurez-vous que le chemin de l'insert est 
correct (mono, stéréo ou autre).

5  Placez à votre convenance les inserts dans la 
grille de la voie. Les chemins d'inserts et de 
sortie sont régis par des règles particulières en ce 
qui concerne la correspondance aux voies (voir 
Canaux superposés et chemins valides :, 
page 66).

Assignation d'inserts matériels

Pour affecter un insert matériel externe à une 
piste :

" Choisissez un insert dans le sélecteur d'insert 
de la piste. 

Désactivation d'inserts matériels

Les inserts matériels n'offrent pas de commande 
de désactivation. Pour écouter en lecture sans 
passer par l'insert matériel, vous pouvez soit 
désactiver l'insert, soit le supprimer en le 
réassignant sur No Insert, ou encore utiliser le 
commutateur Bypass situé sur le périphérique 
matériel lui-même. Pour en savoir plus, 
reportez-vous à la section Désactivation des 
inserts, page 769.

La compensation de retard peut être 
appliquée aux inserts matériels. Pour plus 
d'informations, reportez-vous à la section 
Compensation H/W Insert Delay, page 75.

Sélection d'un insert d'I/O matériel
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Connexion et intégration de 
périphériques externes
Pro Tools peut créer des connexions dédiées vers 
des périphériques externes analogiques ou 
numériques. Le nombre et le type des 
connexions dépend du type de système utilisé.

Pour relier un périphérique externe à un système 
Pro Tools : 

1  Reliez une sortie inutilisée (ou une paire de 
sorties dans le cas d'un périphérique stéréo) du 
système Pro Tools à une entrée du processeur 
externe de signaux.

2  Reliez la sortie du processeur externe de 
signaux à une entrée inutilisée (ou une paire 
d'entrées dans le cas d'un périphérique stéréo) 
du système Pro Tools.

3  Dans les boîtes de dialogue Hardware Setup ou 
I/O Setup, définissez les ports physiques à 
acheminer vers les ports d'entrée et de sortie Pro 
Tools.

4  Définissez les chemins de sortie, d'entrée ou 
d'insertion appropriés dans la boîte de dialogue 
I/O Setup. 

Pour utiliser un périphérique en insertion, 
connectez-le aux entrées et sorties 
correspondantes de votre système. Pour utiliser 
les sorties 7-8, par exemple, l'insert doit utiliser 
également les entrées 7-8. 

Connexion numérique d'unités 
d'effets

Pour utiliser les entrées et les sorties numériques 
du système Pro Tools en tant que départs et 
retours d'effets vers un périphérique d'effets 
numérique, c'est Pro Tools qui fournit le signal 
d'horloge de référence dans la plupart des cas. 
Configurez l'effet numérique pour lui faire 
accepter une horloge numérique externe afin de 
le synchroniser avec Pro Tools.

Pour configurer un départ numérique vers un 
périphérique externe à partir d'un système 
Pro Tools|HD :

1  Effectuez l'une des opérations suivantes :

• Sur les canaux 192 I/O, 192 Digital I/O, 
96 I/O, 96i I/O ou 888|24 I/O, choisissez 
Setup > Hardware, sélectionnez le 
périphérique, le format et le format 
d'horloge, puis définissez la paire de 
canaux sur l'entrée numérique (Digital).

• Dans une interface d'E/S 882|20 ou 1622, 
choisissez Setup > Hardware, choisissez le 
périphérique, puis réglez l'entrée de 
canal 1-2 sur l'entrée numérique.

2  Sélectionnez Internal dans le menu déroulant 
de la source d'horloge.

3  Cliquez sur OK. 

Pour configurer un départ numérique vers un 
périphérique externe à partir d'un système 
Digi 002 ou Digi 002 Rack :

1  Choisissez Setup > Playback Engine et 
sélectionnez le périphérique.

Pour en savoir plus sur la connexion des 
périphériques externes, reportez-vous au 
Guide de démarrage Pro Tools.
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2  Effectuez l'une des opérations suivantes :

• Si le périphérique externe est connecté aux 
prises cinch S/PDIF, désélectionnez 
l'option S/PDIF Mirroring. (Lorsque 
l'option S/PDIF Mirroring est activée, la 
sortie numérique des prises cinch S/PDIF 
reflète exactement la sortie des canaux 
analogiques 1-2.)

• Si le périphérique externe est relié aux ports 
optiques, choisissez un format 
(généralement S/PDIF pour un 
périphérique d'effets) dans le menu 
déroulant Optical Format.

3  Sélectionnez Internal dans le menu déroulant 
de la source d'horloge.

4  Cliquez sur OK.

5  Vous pouvez également entrer de nouveaux 
noms de voie dans la boîte de dialogue I/O 
Setup, correspondant à l'assignation des effets. 

Utilisation de sources d'horloge 
externes (pour l'enregistrement 
et l'écoute)

Lors de l'enregistrement ou de l'écoute, 
Pro Tools peut être synchronisé à une source 
d'horloge externe. Les options de la source 
d'horloge externe varient en fonction du type de 
système Pro Tools utilisé.

Systèmes Pro Tools|HD

Les systèmes Pro Tools|HD peut recevoir une 
horloge externe via n'importe quelle entrée 
numérique de n'importe quelle interface d'I/O 
Pro Tools|HD (dont AES/EBU, S/PDIF et 
Optical).

Si un système étendu Pro Tools|HD comprend 
des interfaces Legacy (telles que l'interface 
888|24 I/O), effectuez la connexion à l'entrée 
numérique des canaux 1-2 de l'interface audio 
Legacy, afin de les utiliser comme source 
d'horloge. Les interfaces de Legacy I/O prennent 
en charge les fréquences d'échantillonnage 
44,1 kHz et 48 kHz.

Pour sélectionner une source d'horloge externe 
pour un système Pro Tools|HD :

1  Sélectionnez Setup > Hardware.

2  Sélectionnez l'I/O Pro Tools|HD appropriée 
pour l'affichage des paramètres dans la page 
principale.

3  Si nécessaire, activez le format numérique 
approprié (si ce n'est déjà fait), en suivant les 
instructions du Guide de démarrage ou du Guide 
d'I/O.

4  Sélectionnez la source d'horloge 
correspondant au type d'entrée.

5  Configurez l'acheminement d'entrée de la 
source numérique à l'aide des menus 
contextuels Input et Output, le cas échéant.

6  Cliquez sur OK pour refermer la boîte de 
dialogue Hardware Setup.

Si vous réglez le format optique sur S/PDIF, 
Pro Tools surveillera le port optique, en 
attente de signaux audio et ignorera toute 
entrée audio arrivant sur les prises cinch 
S/PDIF.

Reportez-vous au Guide de démarrage de 
Pro Tools|HD pour déterminer l'ordre 
correct des cartes et connexions à l'interface 
audio.
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Systèmes Digi 002 ou Digi 002 Rack

Pro Tools peut recevoir un signal d'horloge 
externe provenant de l'entrée optique ou de 
l'entrée S/PDIF.

Pour sélectionner une source d'horloge externe 
pour un système Digi 002 ou Digi 002 Rack :

1  Sélectionnez Setup > Hardware.

2  Sélectionnez la source d'horloge 
correspondant au type d'entrée.

3  Si vous choisissez Optical, assurez-vous que ce 
format correspond au type d'entrée optique 
envoyé au système Pro Tools. 

Systèmes Mbox 2, Mbox 2 Pro et Mbox 

Pro Tools peut recevoir un signal d'horloge 
externe provenant de l'entrée S/PDIF sur ces 
interfaces.

Pour sélectionner une source d'horloge externe 
pour un système Mbox 2, Mbox 2 Pro ou Mbox :

1  Sélectionnez Setup > Hardware.

2  Dans le menu contextuel Clock Source, 
sélectionnez SPDIF (Windows) or SPDIF/RCA 
(Mac). 

3  Cliquez sur OK.

Si vous réglez le format optique sur S/PDIF, 
Pro Tools surveillera le port optique pour 
repérer l'horloge externe et ignorer toute les 
entrées d'horloge sur les jacks RCA S/PDIF.

Votre périphérique d'entrée numérique doit 
être connecté et sous tension pour que la 
synchronisation de Pro Tools avec ce 
périphérique se réalise avec succès. S'il n'est 
pas sous tension, laissez la source d'horloge 
définie sur Internal.
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Chapitre 30 : Automation

Pro Tools permet l'automation dynamique des 
commandes de mixage sur chacun des types de 
piste. Vous pouvez écrire et afficher des actions 
d'automation en temps réel au cours de la 
lecture d'une session. Vous pouvez également 
modifier des données d'automation au moyen 
de la technique utilisée pour modifier les 
données audio et MIDI.

Précision de l'automation sur les tables 
de mixage

Surfaces de contrôle Digidesign Les surfaces de 
contrôle D-Control, D-Command, ProControl, 
Control|24 et Command|8 de Digidesign 
prennent en charge les fonctionnalités 
d'automation de Pro Tools. Les surfaces de 
contrôle Digidesign offrent une résolution de 10 
bits ou 1 024 pas de résolution de fader. 
Pro Tools intercale en cours de lecture ces 
données à une résolution de 24 bits : il en résulte 
une précision et une progressivité accrues de 
l'automation du fader.

Surfaces de contrôle MIDI : la majorité des 
surfaces de contrôle MIDI disposent d'une 
résolution de 7 bits ou 128 pas. Pro Tools 
intercale en cours de lecture ces données à une 
résolution de 24 bits : il en résulte une précision 
et une progressivité de l'automation du fader.

Démarrage rapide de 
l'automation
Pro Tools propose de nombreuses options pour 
l'enregistrement, le remplacement et l'édition 
des données d'automation. 

Etapes élémentaires de l'enregistrement 
d'automation :

• Activez le type d'automation à enregistrer 
(volume, panoramique, coupure du son, 
niveau d'envoi, panoramique d'envoi, 
coupure du son d'envoi ou plug-in). 

• Configurez le mode d'écriture d'automation 
désiré (Write, Touch, Latch ou Trim) sur les 
pistes de votre choix. 

• Si vous désirez automatiser un plug-in, 
autorisez l'automation de ses commandes.

• Protégez l'automation des plug-in, sorties ou 
envois pour éviter l'effacement de leurs 
données d'automation existantes. 

Pour plus d'informations sur l'utilisation 
des surfaces de contrôle Digidesign pour 
créer des automations de mixage, consultez 
le Guide des surfaces de contrôle Digidesign.
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• Lancez la lecture pour démarrer 
l'enregistrement de l'automation et réglez les 
commandes en conséquence. Pro Tools 
enregistre toutes les modifications apportées 
aux commandes activées. 

Pour modifier une automation enregistrée :

• Répétez les étapes précédentes pour écrire les 
données précédentes avec les nouvelles 
données d'automation.

• Modifiez graphiquement les données 
d'automation dans la fenêtre Edit.

• Coupez, copiez, collez ou supprimez les 
données d'automation (avec certaines 
restrictions).

Playlists d'automation
Chaque piste de Pro Tools contient une liste 
d'automation unique par commande 
susceptible d'être automatisée.

Sur les pistes audio, ces paramètres sont les 
suivants :

• Volume

• Rognage du volume (Pro Tools|HD 
uniquement)

• Panoramique

• Mute

• Niveau d'envoi

• Rognage du niveau d'envoi (Pro Tools|HD 
uniquement)

• Panoramique d'envoi

• Coupure du son d'envoi

• Commandes de plug-in

Sur les pistes d'entrée auxiliaire, ces paramètres 
sont les suivants :

• Volume

• Rognage du volume (Pro Tools|HD 
uniquement)

• Mute

• Panoramique

Sur les faders principaux, ces paramètres sont les 
suivants :

• Volume

• Rognage du volume (Pro Tools|HD 
uniquement)

Sur les pistes MIDI, ces paramètres sont les 
suivants :

• Volume (MIDI)

• Panoramique (MIDI)

• Mute

Sur les pistes d'instrument, ces paramètres sont 
les suivants :

• Volume (audio)

• Rognage du volume (audio) (Pro Tools|HD 
uniquement)

• Coupure du son (audio)

• Panoramique (audio)

Sur les pistes de VCA principal (Pro Tools HD 
uniquement), ces paramètres sont les suivants :

• Volume

• Rognage du volume

• Mute

Vous pouvez afficher et modifier tous ces 
paramètres pouvant être automatisés 
individuellement dans Pro Tools, même durant 
la lecture.

De plus, vous pouvez afficher et modifier 
d'autres données de contrôleur continu MIDI 
sur des pistes MIDI ou d'instrument (par 
exemple, la molette de modulation, un breath 
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controller, un contrôleur au pied ou une pédale 
de sustain) de manière similaire. Pour en savoir 
plus sur l'édition de données MIDI, 
reportez–vous à la section Evénements de 
contrôleur continu, page 659.

Playlists d'automation avec 
régions audio et MIDI

Pro Tools gère les régions et les playlists 
d'automation audio différemment des régions et 
des playlists d'automation MIDI.

Pistes audio :

Sur les pistes audio, les données d'automation 
résident dans une autre playlist que les données 
et les régions audio. Toutes les playlists d'édition 
d'une piste audio partagent les mêmes données 
d'automation. 

Pistes MIDI et d'instrument

Sur les pistes MIDI et d'instrument, toutes les 
données d'automation de contrôleur, à 
l'exception des données de coupure de son MIDI 
ou de coupure audio, sont enregistrées dans la 
région MIDI à laquelle elles appartiennent. Sur 
les pistes, les playlists d'édition sont séparées et 
représentent une version spécifique, avec son 
automation de contrôleur. 

Playlists d'automation du rognage

Des playlists d'automation du rognage distinctes 
sont disponibles pour le rognage du volume et le 
rognage du niveau d'envoi. Le rognage du 
volume est disponible sur tous les types de pistes 
à l'exception des pistes MIDI. Le rognage du 
niveau d'envoi n'est disponible que les pistes 
audio. 

Chaque playlist d'automation de rognage 
indique la position du fader de rognage, avec des 
points d'inflexion jaunes pouvant être modifiés. 
Pour plus d'informations sur les playlists de 
rognage, consultez les sections Mode Trim, 
page 799 et Visualisation des données 
d'automation, page 803. 

Playlists d'édition multiples et 
automation de pistes audio 

Toutes les playlists d'édition d'une même piste 
audio partagent les mêmes données 
d'automation. Lorsque vous enregistrez ou 
modifiez des données d'automation sur une 
piste audio, ces données d'automation sont 
enregistrées dans la playlist d'automation 
correspondante de la piste, ce qui permet de les 
modifier avec ou indépendamment des régions 
audio associées. 

Dans une région MIDI, les données de 
coupure de sons MIDI sont indépendantes 
des données MIDI. Vous pouvez ainsi 
couper la lecture de pistes MIDI ou 
d'instrument individuelles dans Pro Tools 
sans altérer les données de contrôleur. 

Les données de contrôleur continu MIDI 
reflètent toujours les modifications de la 
région, à l'exception de la coupure du son. 
Pour plus d'informations, reportez-vous à la 
section Pistes MIDI et d'instrument, 
page 795.
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! Lorsque vous copiez ou coupez des données 
audio sur une piste dans une vue Waveform, les 
données d'automation sous–jacentes sont 
également coupées ou copiées. 

! Si vous collez des données audio dans une 
playlist d'édition depuis d'autres emplacements 
ou pistes, il est possible de modifier les données 
d'automation sous–jacentes sur la piste. 

! En revanche, si vous recourez à la commande 
Trim du menu Edit, les données d'automation 
sous–jacentes restent inchangées. 

Duplication de pistes pour l'édition de playlists

La commande Duplicate Track permet de copier 
facilement une piste en vue d'expériences sur 
l'assignation, les plug-in et l'automation. La 
piste originale et ses données d'automation ne 
risquent donc pas d'être modifiées ni effacées. 

Modes d'automation
Les modes d'automation contrôlent la méthode 
d'écriture et de lecture des données 
d'automation sur une piste. Chaque piste est 
dotée d'un sélecteur de mode d'automation 
permettant de sélectionner le mode 
d'automation de la piste.

Mode Off

Le mode Off désactive l'automation pour tous 
les paramètres concernés :

• Volume

• Panoramique :

• Mute

• Volume, panoramique et coupure du son 
des envois

• Commandes de plug-in

• Volume, panoramique et Mute sur pistes 
MIDI

En mode Off, les données d'automation liées à 
ces paramètres sont ignorées lors de la lecture. 
Toutes les autres données de contrôleur MIDI 
sont envoyées. 

L'automation peut être basculée du mode Off 
vers un autre mode d'automation pendant la 
lecture ou l'enregistrement.

Mode Read

Le mode Read lit les données d'automation 
précédemment écrites pour une piste.

Mode Write

Le mode Write écrit les données d'automation 
entre le démarrage et l'arrêt de la lecture, en 
effaçant sur la durée de cette passe toutes les 
données d'automation antérieures. 

Le paramètre AutoMatch peut être appliqué à 
une passe d'automation en mode Write. Pour 
plus d'informations, consultez la section 
AutoMatch Time :, page 802.

Pour plus d'informations, reportez-vous à la 
section Modification de l'automation, 
page 822.

Pour plus d'informations sur la commande 
de duplication de pistes, reportez–vous à la 
section Duplication de pistes, page 150.
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Option After Write Pass, Switch To

Vous pouvez configurer Pro Tools afin qu'il 
bascule automatiquement vers le mode Touch 
ou le mode Latch, ou qu'il reste inchangé à 
l'issue d'une passe d'automation en mode Write.

Pour activer le mode d'automation à l'issue d'une 
passe en mode Write :

1  Choisissez Setup > Preferences et cliquez sur 
Mixing.

2  Sous Automation, sélectionnez une des 
options After Write Pass, Switch To (Touch, 
Latch ou No Change).

3  Cliquez sur OK pour refermer la fenêtre 
Preferences.

Mode Touch

Le mode Touch écrit les données d'automation 
uniquement lorsque vous touchez un fader ou 
appuyez sur une touche ou que vous cliquez 
dessus avec la souris. Au relâchement du fader, 
l'écriture des données d'automation s'arrête et le 
fader retrouve sa position d'automation 
précédente, à une vitesse définie par les 
paramètres AutoMatch et Touch Timeout. 
Pour plus d'informations, consultez la section 
Préférences d'automation, page 801.

En mode Touch, certaines surfaces de contrôle 
lancent l'écriture des données d'automation au 
moindre contact. Ceux-ci incluent des 
contrôleurs pourvus de faders tactiles, tels que 
D-Control, D-Command, ProControl, 
Control|24, Digi 002, Command|8 de 
Digidesign ou encore Mackie HUI.

Sur d'autres surfaces de contrôle en mode Auto 
Touch, l'écriture des données d'automation en 
mode Touch commence lorsque le fader atteint 
le point de passage, correspondant à sa position 
d'automation antérieure. L'écriture des données 

d'automation débute lorsque le fader atteint le 
point de passage ou une commande rotative 
non tactile et se poursuit jusqu'à l'arrêt de son 
déplacement.

Mode Latch

Le mode Latch fonctionne de manière analogue 
au mode Touch, c'est–à–dire qu'il écrit les 
données d'automation uniquement lorsque 
vous touchez ou déplacez une commande. 
Cependant, à la différence de Touch, l'écriture 
des données d'automation se poursuit jusqu'à ce 
que vous arrêtiez la lecture ou que vous mettiez 
fin à la passe d'automation en changeant le 
mode d'automation en Read (lire) ou Touch 
(toucher).

Le paramètre AutoMatch peut être appliqué à 
une passe d'automation en mode Latch. 
Pour plus d'informations, consultez la section 
AutoMatch Time :, page 802.

Le mode Latch est particulièrement utile pour 
l'automation des commandes de panoramique 
et des plug-in sur des commandes rotatives non 
tactiles puisqu'il n'est pas soumis à un retard 
d'exécution et ne revient pas à sa position 
précédente lorsque vous relâchez la commande. 

Voir aussi Ecriture de données 
d'automation au début, à la fin ou sur 
l'ensemble d'une sélection ou d'une piste, 
page 834.
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AutoJoin en mode Latch

(Pro Tools HD uniquement)

Pro Tools offre deux méthodes différentes de 
reprise de l'automation de l'écriture sur les 
commandes qui étaient actives au moment de 
l'interruption du transport :

AutoJoin Vous permet de reprendre 
automatiquement l'automation de l'écriture en 
mode Latch.

Join Vous permet de reprendre manuellement 
l'automation de l'écriture en mode Latch. 
La fonction Join n'est disponible qu'avec les 
surfaces de contrôle prises en charge par 
Digidesign.

Pour activer AutoJoin à partir de Pro Tools :

1  Sélectionnez Window > Automation.

2  Cliquez sur le bouton AutoJoin.

Indicateur AutoJoin

Après une passe d'automation Latch avec la 
fonction AutoJoin activée, l'indicateur AutoJoin 
apparaît dans la fenêtre Edit de Pro Tools.

Le voyant AutoJoin est une ligne verticale qui 
indique le point d'arrêt de la dernière passe 
d'automation et le point de départ automatique 
de « raccordement » de toutes les pistes en cours 
d'écriture lors de la passe précédente. Lorsque 
l'écriture d'automation reprend à partir de ce 
point, la ligne disparaît.

Mode Touch/Latch
(Pro Tools HD uniquement)

Le mode d'automation Touch/Latch met la 
commande Volume d'une piste en mode Touch 
et toutes les autres commandes pouvant être 
automatisées en mode Latch. 

Bouton AutoJoin Enable de la fenêtre Automation

Reportez–vous au guide de votre surface de 
contrôle pour plus d'informations sur 
l'utilisation des fonctions Join et AutoJoin 
avec une surface de contrôle.

Bouton AutoJoin

Indicateur AutoJoin de la fenêtre Edit

Pour utiliser Join ou AutoJoin afin de 
reprendre l'écriture sur des commandes en 
cours d'écriture lors de l'interruption du 
transport, redémarrez le transport avant 
l'indicateur AutoJoin.

Indicateur AutoJoin
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En mode Touch/Latch, la commande Volume se 
comporte en mode Touch, écrivant 
l'automation lorsque vous la touchez et 
repassant aux niveaux d'écriture précédents 
lorsque vous la relâchez. 

Toutes les autres commandes se comportent en 
mode Latch, écrivant l'automation lorsque vous 
les touchez et ne s'arrêtant pas tant que la 
lecture n'est pas interrompue ou que vous 
n'insérez pas un point de sortie pour l'écriture de 
l'automation.

Mode Trim
(Pro Tools HD uniquement)

Les systèmes Tools HD permettent d'ajuster (ou 
rogner) en temps réel les données d'automation 
du niveau de piste et d'envoi. En revanche, il 
n'est pas possible de rogner de cette manière les 
données d'automation de panoramique, de 
coupure du son et de plug-in. Le mode Trim 
fonctionne en association avec les autres modes 
d'automation (Read, Touch, Latch, Touch/Latch 
et Write). Il permet de conserver l'ensemble des 
modifications apportées aux données 
d'automation du volume tout en augmentant 
ou réduisant légèrement les niveaux afin 
d'équilibrer les mixages. 

Lorsque vous enregistrez des données 
d'automation en mode Trim, les déplacements 
du fader écrivent des valeurs relatives au lieu de 
valeurs absolues. Les données d'automation 
existantes varient de la valeur d'augmentation 
ou de diminution (ou valeur delta) indiquée par 
les faders. 

En mode Trim, les commandes pour lesquelles le 
rognage est impossible se comportent comme 
dans les modes d'automation standard, à 
l'exception du mode Write/Trim dans lequel ils 
fonctionnent comme en mode Touch.

Modes d'automation de rognage

Lorsqu'une piste est dans un des modes 
d'automation de rognage (à l'exception de Trim 
Off), ses faders principaux de volume et de 
niveau d'envoi sont affichés en jaune. Lors du 
rognage, un indicateur de volume de piste ou de 
niveau d'envoi affiche la valeur delta en cours 
d'écriture plutôt que la valeur absolue.

Le comportement des modes d'automation du 
rognage dépend du paramètre de préférence 
Coalesce Trim Automation. Pour plus 
d'informations, consultez la section Fonte de 
l'automation de rognage, page 832. 

Trim Off

Le paramètre Trim Off désactive la lecture et 
l'écriture de toutes les données d'automation 
(principales et rognées) d'une piste. Tous les 
mouvements d'automation sont ignorés durant 
la lecture. Les faders de rognage sont 
temporairement réglés sur zéro lorsqu'une piste 
passe en mode Trim Off.

Sélection du mode Touch/Latch
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En fonction du paramètre de préférence 
Coalesce Trim Automation, le passage d'une 
piste en mode Trim Off peut fondre 
l'automation du rognage sur la piste en 
question. Pour plus d'informations, consultez la 
section Fonte de l'automation de rognage, 
page 832. 

L'automation peut être basculée du mode Trim 
Off vers un autre mode d'automation pendant la 
lecture ou l'enregistrement.

Read Trim

En mode Read Trim, les faders de volume et de 
rognage du niveau d'envoi ne suivent plus la 
playlist d'automation principale et suivent toute 
automation de rognage existante. Vous pouvez 
déplacer un fader de rognage pendant la lecture 
afin d'écouter des nouvelles valeurs de rognage 
mais aucune donnée d'automation n'est écrite. 
Lorsque vous relâchez le fader de rognage, il 
retourne aux valeurs d'automation de rognage 
écrites précédemment.

Si une piste ne contient aucune donnée 
d'automation de rognage, vous pouvez déplacer 
un fader de rognage pendant la lecture afin 
d'écouter des nouvelles valeurs de rognage mais 
aucune donnée d'automation n'est écrite. Le 
fader de rognage reste dans la même position 
tant que la piste reste en mode Trim, ou si vous 
fondez manuellement le niveau de rognage.

Lorsque ce mode est activé, les commandes 
impossibles à rogner (toutes les commandes 
autres que le volume de piste et le niveau 
d'envoi) se comportent comme en mode Read 
standard : aucune donnée d'automation n'est 
écrite.

Touch Trim

En mode Touch Trim, les faders de volume et de 
rognage du niveau d'envoi ne suivent plus la 
playlist d'automation principale et suivent toute 
automation de rognage existante. Lorsque vous 
touchez un fader de rognage, l'écriture des 
données d'automation de rognage commence. 
Lorsque vous relâchez le fader, l'écriture 
s'interrompt et le fader retourne aux valeurs 
d'automation de rognage écrites précédemment.

La vitesse de retour du fader à des valeurs 
précédentes dépend du paramètre AutoMatch 
Time défini dans la page des préférences de 
l'automation. Pour plus d'informations, 
reportez-vous à la section AutoMatch Time :, 
page 802.

Lorsque ce mode est activé, les commandes 
impossibles à rogner (toutes les commandes 
autres que le niveau de piste et d'envoi) se 
comportent comme en mode Touch standard : 
elles suivent les données d'automation 
précédemment enregistrées jusqu'à ce qu'elles 
soient touchées. Lorsqu'ils sont touchés, leur 
position absolue est écrite jusqu'à relâchement 
ou arrêt de la lecture. 

Latch Trim

En mode Latch Trim, les faders de volume et de 
rognage du niveau d'envoi ne suivent plus la 
playlist d'automation principale et suivent toute 
automation de rognage existante. Lorsque vous 
touchez un fader de rognage, l'écriture des 
données d'automation de rognage commence. 
L'écriture de données d'automation de rognage 
continue tant que la lecture n'est pas arrêtée ou 
que vous n'arrêtez pas l'opération. 

Lorsque ce mode est activé, les commandes 
impossibles à rogner (toutes les commandes 
autres que le niveau de piste et d'envoi) se 
comportent comme en mode Latch normal : 
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elles suivent les données d'automation 
précédemment enregistrées jusqu'à ce qu'elles 
soient touchées. Dès qu'ils sont touchés, leur 
position absolue est écrite jusqu'à l'arrêt de la 
lecture.

Touch/Latch Trim

En mode Touch/Latch Trim, les faders de 
volume et de rognage du niveau d'envoi ne 
suivent plus la playlist d'automation principale 
et suivent toute automation de rognage 
existante. Le fader du rognage du volume 
principal se comporte en mode Touch Trim et 
les faders de rognage du niveau d'envoi se 
comportent en mode Latch Trim. 

Write Trim

En mode Write Trim, dès que la lecture 
commence, l'écriture des données d'automation 
du rognage commence pour le volume et les 
niveaux d'envoi, puis se poursuit tant que la 
lecture ou l'opération d'écriture des données de 
rognage n'est pas arrêtée.

Lorsque le mode Write/Trim est activé, les 
commandes impossibles à rogner (toutes les 
commandes autres que le niveau de piste et 
d'envoi) ne sont pas en mode Write mais se 
comportent comme en mode Touch normal : 
aucune donnée d'automation n'est écrite jusqu'à 
ce qu'une commande soit touchée. Ainsi, les 
commandes ne risquent pas d'effacer leurs 
données d'automation à chaque passage en 
mode Write Trim.

Préférences d'automation
Pro Tools offre plusieurs options de contrôle de 
l'écriture et de la lecture des données 
d'automation.

Pour afficher les préférences d'automation :

" Sélectionnez Setup > Preferences, puis cliquez 
sur Mixing.

Niveaux d'envoi et mode Trim
(Pro Tools HD uniquement)

Vous pouvez configurer Pro Tools de façon à 
exclure les niveaux d'envoi du mode Trim afin 
que seul le volume principal soit rogné 
lorsqu'une piste passe en mode Trim. 
Cette fonctionnalité vous donne davantage de 
flexibilité pour configurer les niveaux d'envoi en 
mode Trim.

Le paramètre « After Write Pass, Switch 
To » affecte le mode Write Trim. Après une 
passe d'automation en mode Write/Trim, 
les pistes basculent automatiquement en 
mode Trim du paramètre spécifié par cette 
préférence.

Page de préférences de mixage

Reportez–vous à la section Préférences de 
mixage, page 88 pour obtenir des 
informations détaillées sur les préférences 
d'automation de Pro Tools.
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Pour exclure les niveaux d'envoi du mode Trim :

1  Choisissez Setup > Preferences et cliquez sur 
Mixing.

2  Sous Automation, désélectionnez Include 
Sends in Trim Mode.

3  Cliquez sur OK.

Lissage

Lorsque vous exécutez des mouvements 
d'automation (y compris les mouvements de 
rognage) avec un contrôle continu, Pro Tools 
enregistre chaque action en une série d'étapes 
très courtes, ce qui génère une courbe en 
« escalier » comportant de nombreux points 
d'inflexion. La fonction de lissage lisse 
intelligemment cet escalier en une rampe 
unique, reliant les points d'inflexion entre eux. 
(Le lissage ne s'applique pas aux commandes 
commutées, telles que Mute ou Bypass des plug-
in). Lorsque l'option de lissage est activée, les 
données d'automation qui en résultent 
représentent généralement les mouvements 
réels avec une précision accrue. 

Affinage

L'affinage réduit automatiquement le nombre 
total de points d'inflexion dans une playlist 
d'automation (y compris les playlists de 
rognage) en vue d'améliorer les performances du 
système. Le degré d'affinage appliqué est 
déterminé par le paramètre Degree of Thinning, 
dans la page des préférences de l'automation. Un 
affichage important entraîne une automation 
sensiblement différente des actions 

d'automation réelles. L'affinage s'applique 
uniquement aux pistes audio et ne modifie pas 
les pistes MIDI. Pour les instructions, consultez 
la section Affinage de l'automation, page 819.

AutoMatch Time :

AutoMatch Time est le temps nécessaire à un 
fader pour revenir (en créant une rampe de 
niveau dirigée vers le haut ou vers le bas) au 
niveau d'automation se trouvant sur la piste, à la 
fin de la passe d'automation. Cette valeur est 
définie dans la page des préférences de 
l'automation (voir Préférences d'automation, 
page 801).

L'option AutoMatch est automatiquement 
appliquée à tous les passages en mode Touch, et 
peut être appliquée aux passages en mode Latch 
ou Write.

La valeur AutoMatch Time détermine également 
le taux auquel les valeurs delta écrites en mode 
Trim renvoient à 0 dB (valeur delta de zéro).

La fonctionnalité AutoMatch agit sur des 
commandes continues (telles que le volume ou 
le panoramique), dont elle ramène la valeur à 
des niveaux automatisés antérieurs. La plage de 
fonctionnement de certaines commandes 
discontinues (par exemple, l'égaliseur dans le 
plug-in EQ à 1 bande) s'étend sur plus de deux 
pas. La fonction AutoMatch n'exerce aucune 
influence sur ces commandes.

Option Automation Follows Edit

Lorsque cette commande est désactivée, les 
événements d'automation ne sont pas affectés 
par les modifications apportées aux notes audio 
ou MIDI. Lorsque cette commande est activée, 
les événements d'automation sont affectés par 
les modifications apportées aux notes audio 
ou MIDI.

Toute donnée d'automation non fondue sur 
un envoi fond lorsque les autres données 
d'automation de cette piste sont fondues, 
même si l'option Include Sends in Trim 
Mode n'est pas sélectionnée.
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Pour désactiver la commande Automation 
Follows Edit :

" Sélectionnez Options > Automation 
Follows Edit.

Automation Safe 

Il est possible de configurer les sorties, les envois 
et les plug-in en mode Automation Safe. 
En mode Automation Safe, les données 
d'automation associées à une fenêtre Output 
(niveau de piste ou d'envoi, de panoramique, de 
coupure de son, etc.) ou à un plug-in de cette 
piste sont protégées contre l'effacement, tout en 
enregistrant des données d'automation pour les 
autres éléments de la piste. 

Le mode Automation Safe suspend 
l'enregistrement des données d'automation de 
l'élément (sortie, envoi ou plug-in) de la piste 
sélectionnée pour lequel il est activé. Vous 
pouvez également suspendre l'enregistrement et 
la lecture des données d'automation pour toute 
la durée d'une session, dans la fenêtre 
Automation. Pour plus d'informations, 
consultez la section Activation et interruption 
de l'automation, page 815. 

Visualisation des données 
d'automation
Pro Tools crée une playlist distincte dans la 
fenêtre Edit pour chaque type d'automation 
d'une piste, y compris une playlist pour chaque 
type d'automation de rognage. Ces données 
peuvent être affichées et modifiées comme des 
données audio ou MIDI.

Pour afficher une playlist d'automation :

" Cliquez sur le sélecteur de vue de piste et 
choisissez le type d'automation à afficher dans le 
menu déroulant.

Fonction Automation Safe activée pour l'envoi

Automation Safe activé

Vous pouvez facilement basculer d'une vue 
de piste vers une autre. Pour plus 
d'informations, consultez la section 
Changement de vue de piste, page 395.

Affichage d'une playlist d'automation standard
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Affichage des données 
d'automation de rognage avec la 
playlist principale
(Pro Tools HD uniquement)

L'apparence des données d'automation de 
rognage dépend de la façon dont elles sont 
fondues. Pour plus d'informations, consultez la 
section Fonte de l'automation de rognage, 
page 832. 

Si les données d'automation ne sont pas 
configurées de façon à être fondues après 
chaque passe d'automation, vous pouvez 
afficher les données d'automation de rognage 
ainsi que les données principales d'automation 
du volume ou de niveau d'envoi dans la même 
vue d'automation. Cet affichage des données 
d'automation de rognage ne peut pas être édité.

Pour afficher la playlist d'automation de rognage 
avec la playlist d'automation principale sur les 
pistes :

" Sélectionnez View > Automation > Trim 
Playlist.

Affichage de la playlist 
d'automation composite
(Pro Tools HD uniquement)

Si les données d'automation ne sont pas 
configurées de façon à être fondues après 
chaque passe d'automation, vous pouvez 
afficher une playlist d'automation composite 
indiquant la contribution des données 
d'automation de rognage dans les données 
principales d'automation du volume ou de 
niveau d'envoi. Cet affichage de playlist 
composite ne peut pas être édité.

La playlist composite s'affiche dans la playlist 
d'automation principale ainsi que dans la 
playlist d'automation de rognage.

Affichage d'une playlist d'automation de rognage

Playlist d'automation de rognage

 

Données 
de 
rognage 
du 
volume

Affichage des données d'automation de rognage dans 
une playlist principale de volume 

Données 
de rognage 
du volume

Données 
de volume
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Pour afficher la playlist composite : 

" Sélectionnez View > Automation > Composite 
Playlist. 

Indicateurs AutoMatch

Des indicateurs AutoMatch triangulaires sont 
placés dans l'angle inférieur gauche de chaque 
voie de console de la fenêtre Mix. Lorsqu'ils sont 
allumés, ils indiquent la direction dans laquelle 
le fader se déplace automatiquement pendant 
l'utilisation de la fonction AutoMatch. 

Ecriture de données 
d'automation
Pour écrire des données d'automation pour 
toutes les commandes qu'il est possible 
d'automatiser, déplacez–les au cours de la 
lecture. 

Pour écrire des données d'automation sur des 
pistes :

1  Sélectionnez Window > Automation. 

2  Assurez–vous que l'écriture est autorisée pour 
ce type d'automation.

3  Dans la fenêtre Mix ou Edit, cliquez sur le 
sélecteur de mode d'automation de chaque piste 
à automatiser, puis définissez le mode 
d'automation. Pour une première passe 
d'automation, optez pour le mode Write.

4  Cliquez sur Play pour lancer l'écriture des 
données d'automation.

5  Déplacez les commandes à automatiser.

6  Une fois l'opération terminée, cliquez sur 
Stop.

Affichage de la playlist d'automation de rognage et de 
la playlist composite dans une playlist principale de 
volume 

Indicateurs AutoMatch triangulaires sur une voie de 
console

Données 
de rognage 
du volume

Données 
de volume

Playlist 
composite

Indicateur AutoMatch

Fenêtre Automation

Définition du mode d'automation d'une piste
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Après la première passe d'automation, vous 
pouvez écrire d'autres données d'automation sur 
la piste sans effacer complètement le passage 
précédent, grâce au mode Touch ou Latch. 
Ces modes ajoutent des données d'automation 
uniquement lorsque vous déplacez une 
commande. Voir Modes d'automation, 
page 796.

Pour ajouter des données d'automation à une 
passe antérieure :

1  Activez Options > Link Timeline and Edit 
Selection.

2  Dans la fenêtre Edit, effectuez une sélection ou 
placez le curseur au point où vous souhaitez 
écrire les données d'automation.

3  Dans la fenêtre Mix ou Edit, cliquez sur le 
sélecteur de mode d'automation de chacune des 
pistes à automatiser, puis sélectionnez le mode 
Touch ou Latch comme mode d'automation.

4  Cliquez sur Play pour lancer l'écriture des 
données d'automation. 

5  Déplacez les commandes à automatiser.

6  Une fois l'opération terminée, cliquez sur 
Stop.

Enregistrement de la position initiale 
d'un contrôle

Lors de la création d'une piste audio, d'une piste 
d'entrée auxiliaire, d'une piste de VCA principal, 
d'une piste MIDI ou d'une piste d'instrument, le 
mode Read est automatiquement activé. 
Bien que la piste soit configurée en mode Read, 
vous pouvez définir la position initiale des 
commandes qu'il est possible d'automatiser. 
Cette position sera enregistrée avec la session.

Dans cet état initial, un seul point d'inflexion 
d'automation apparaît au début de chaque liste 
d'automation. Si vous déplacez la commande 
sans écrire de données d'automation, le point 
d'inflexion se déplace jusqu'à la nouvelle valeur.

Pour enregistrer de manière permanente la 
position initiale d'une commande pouvant être 
automatisée, procédez comme suit :

• Configurez la piste en mode Write, puis 
appuyez sur Play pour écrire quelques 
secondes de données d'automation sur la 
piste.

• Insérez manuellement un point d'inflexion 
sur la playlist d'automation après le point 
d'inflexion initial. Pour en savoir plus, 
reportez-vous à la section Modification 
graphique de données d'automation, 
page 822.

Si vous écrivez les données d'automation en 
mode Touch avec l'option Loop Playback 
activée, l'écriture s'arrête automatiquement 
à la fin de la sélection en boucle. Au début 
de chaque nouvelle boucle, vous pouvez 
alors toucher ou déplacer à nouveau la 
commande pour écrire de nouvelles données.



Chapitre 30 : Automation 807

Automation des commandes 
commutées

Lors de l'automation de commandes commutées 
(telles que les commandes de coupure de son, les 
commandes de désactivation de plug-ins ou les 
commandes commutés de plug-ins), Pro Tools 
traite ces commandes comme des commandes 
tactiles. Les données d'automation sont écrites 
tant que la touche ou le bouton associés à la 
commande sont touchés.

Par exemple, si vous venez d'écrire plusieurs 
Mute on/off se succédant rapidement sur une 
piste, vous pouvez effacer ces données 
d'automation manuellement dans la fenêtre 
Edit, en choisissant la playlist d'automation de 
Mute, en sélectionnant les données 
d'automation correspondantes, puis en les 
supprimant. Dans Pro Tools, cette opération 
peut être effectuée automatiquement.

Pour automatiser un contrôle commuté (tel que le 
bouton Mute) :

1  Effectuez une autre passe d'automation sur la 
piste.

2  Lorsque vous atteignez l'emplacement de 
l'état Mute à supprimer, appuyez sur la 
commande commutée (bouton Mute, par 
exemple) et maintenez-la enfoncée. 

3  Tant que vous ne relâchez pas le bouton, 
Pro Tools remplace les données sous–jacentes 
sur la piste par l'état actuel de la touche (activée 
ou désactivée) jusqu'à l'arrêt de la lecture. 

Commandes commutées automatisées 
en mode Touch

Lors de l'automation de commandes commutées 
(y compris de la commande de coupure de son, 
de désactivation de plug-in et toute commande 
commutée de plug-in) en mode Touch, ces 
commandes restent dans leur état actuel tant 
qu'elles ne sont pas touchées.

Toutefois, afin de conserver toute donnée 
d'automation d'une commande commutée à un 
moment ultérieur de la timeline, ce 
comportement « verrouillé » prend fin dans les 
cas suivants :

• En présence d'un point d'inflexion 
d'automation, Pro Tools interrompt 
l'écriture des données d'automation en ce 
point.

• Si vous arrêtez la lecture ou arrêter 
l'opération d'écriture de données 
d'automation avant d'atteindre un point 
d'inflexion d'automation existant, 
Pro Tools applique la fonction AutoMatch 
sur l'état d'automation sous–jacent.

Configuration d'un comportement 
temporaire des commandes 
commutées

Dans certaines situations, notamment lors du 
remplacement ou de l'extension de l'automation 
de la commande Mute, vous pouvez écrire 
temporairement les données d'automation 
d'une commande en la maintenant enfoncée, ce 
qui évite d'utiliser le verrouillage de la 
commande.

Lorsque la lecture parvient à la première 
section dont le son est coupé, le bouton Mute 
s'allume. 
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Pour configurer un comportement temporaire des 
commandes commutées : 

1  Sélectionnez Options > Preferences, puis 
cliquez sur Mixing.

2  Désélectionnez l'option Latching Behavior for 
Switch Controls in Touch.

3  Cliquez sur OK pour refermer la fenêtre 
Preferences.

Automation des envois 

Pro Tools permet d'automatiser 
dynamiquement le niveau, la coupure du son et 
le panoramique des envois (aux formats stéréo 
et multicanal uniquement pour ce dernier 
paramètre). Le niveau et le placement des effets 
sont ainsi plus faciles à contrôler avec précision 
lors du mixage final.

Il est également possible de configurer le niveau 
d'envoi et la coupure du son des envois pour 
qu'ils suivent les groupes. 

Pour automatiser le niveau, la coupure du son ou le 
panoramique d'un envoi :

1  Dans la fenêtre Automation, assurez–vous que 
l'écriture est autorisée pour ce type 
d'automation (niveau, coupure de son et 
panoramique d'envoi).

2  Dans la fenêtre Mix ou Edit, définissez le mode 
d'automation de chaque piste contenant des 
envois à automatiser. Pour chaque piste, cliquez 
sur le sélecteur de mode d'automation, puis 
définissez le mode d'automation. Pour une 
première passe d'automation, optez pour le 
mode Write.

3  Si les départs ne sont pas visibles actuellement 
sur vos pistes, sélectionnez View > Mix Window 
(ou Edit Window) > Sends A-E (ou Sends F-J).

4  Pour afficher les commandes d'envoi, 
exécutez l'une des actions suivantes :

• Cliquez sur l'envoi à automatiser pour 
ouvrir la fenêtre Output correspondante.

– ou –

• Sélectionnez View > Sends A–E (ou Sends 
F–J) et sélectionnez une des vues 
individuelles (par exemple Send A).

5  Cliquez sur Play pour lancer l'écriture des 
données d'automation. 

6  Déplacez les commandes à automatiser.

7  Une fois l'opération terminée, cliquez sur 
Stop. 

Copie des données d'automation de 
piste sur les envois

(Pro Tools HD uniquement)

Les paramètres d'envoi ou les données 
d'automation d'une piste doivent parfois refléter 
ceux ou celles de la piste elle-même, par exemple 
lors de la création d'un mixage casque basé sur le 
mixage principal ou lorsque le niveau d'un effet 
doit impérativement suivre les niveaux d'un 
mixage principal. Vous pouvez copier les 
paramètres actuels ou l'intégralité de la playlist 
d'automation des commandes sélectionnées 
dans la playlist correspondante pour l'envoi.

Il est également possible de configurer la 
coupure de son, le niveau d'envoi et le 
panoramique de façon à suivre les groupes 
de mixage. Pour en savoir plus, 
reportez–vous au Préférences d'automation, 
page 801.
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Pour copier les paramètres ou les données 
d'automation d'une piste dans l'un de ses envois :

1  Sélectionnez les pistes à modifier en cliquant 
sur leur nom pour les mettre en surbrillance.

2  Choisissez Edit > Automation > Copy to Send.

3  Dans la boîte de dialogue Copy To Send, 
effectuez l'une des opérations suivantes : 

• Sélectionnez Current Value pour copier les 
paramètres actuels des commandes 
correspondantes. 

• Sélectionnez Automation pour copier 
l'intégralité de la playlist d'automation des 
commandes correspondantes.

4  Choisissez les commandes à copier. 

5  Sélectionnez les envois dans lesquels vous 
souhaitez copier les données d'automation, puis 
cliquez sur OK.

Vous pouvez annuler les effets de la commande 
Copy To Send.

Automation des plug-ins 

Vous pouvez automatiser les réglages de la 
plupart des commandes de plug-in. 
L'automation d'un plug-in diffère légèrement 
d'autres procédures d'automation : il est en effet 
nécessaire d'activer l'automation de chaque 
commande du plug-in. 

Pour activer l'automation des commandes d'un 
plug-in : 

1  Ouvrez la fenêtre Plug-In du plug-in à 
automatiser.

2  Effectuez l'une des opérations suivantes :

• Cliquez sur le bouton d'activation de 
l'automation de la fenêtre Plug-In.

– ou –

• Maintenez enfoncées les touches 
Ctrl+Alt+Démarrer (Windows) ou 
Pomme+Option+Ctrl (Mac) et cliquez sur 
le sélecteur de vue de piste dans la fenêtre 
Edit.

3  Dans la boîte de dialogue Plug-In Automation, 
sélectionnez les commandes à automatiser, puis 
cliquez sur Add. Si une piste comporte plusieurs 
plug-ins, vous pouvez en sélectionner certains 
en cliquant sur le bouton correspondant dans la 
zone Inserts de la boîte de dialogue. 

 Boîte de dialogue Copy To Send

Lors du remplacement des données 
d'automation, Pro Tools affiche une boîte 
de dialogue de confirmation. Pour empêcher 
qu'elle ne s'affiche, appuyez sur Alt 
(Windows) ou sur Option (Mac), tout en 
cliquant sur OK.

Ouverture de la boîte de dialogue Plug-In Automation

Bouton d'activation de l'automation
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4  Cliquez sur OK pour fermer la boîte de 
dialogue Plug-In Automation.

Pour automatiser un plug-in :

1  Dans la fenêtre Plug-In Automation Enable, 
assurez-vous que l'écriture de l'automation du 
plug-in est activée.

2  Dans la fenêtre Mix ou Edit, pour chaque piste 
contenant des plug-in à automatiser, cliquez sur 
le sélecteur de mode d'automation, puis 
définissez le mode d'automation. Pour une 
première passe d'automation, optez pour le 
mode Write.

3  Cliquez sur Play pour commencer l'écriture de 
l'automation, et déplacez les commandes à 
automatiser.

4  Une fois l'opération terminée, cliquez sur 
Stop.

Activation de l'automation pour des 
paramètres de plug-in individuels

Vous pouvez activer des commandes de plug-in 
individuelles directement depuis la fenêtre du 
plug-in.

Pour activer un paramètre de plug-in depuis la 
fenêtre du plug-in :

1  Assurez-vous que la fenêtre du plug-in à 
automatiser est ouverte. 

2  Cliquez sur la commande du paramètre tout 
en maintenant les touches Ctrl+Alt+Démarrer 
(Windows) ou les touches Pomme+Option+Ctrl 
(Mac) enfoncées.

Activation de l'automation pour tous 
les paramètres de plug-in

Pour activer tous les paramètres de plug-in :

1  Assurez-vous que la fenêtre du plug-in à 
automatiser est ouverte. 

2  Tout en maintenant les touches 
Ctrl+Alt+Démarrer (Windows) ou les touches 
Pomme+Option+Ctrl (Mac) enfoncées, cliquez 
sur le bouton Auto situé au sommet de la fenêtre 
du plug-in. 

Activation automatique de 
l'automation des plug-ins

Vous pouvez configurer Pro Tools de façon à ce 
qu'il active automatiquement l'automation pour 
toutes les commandes d'un plug-in lorsque 
celui-ci est ajouté à votre session. 

Boîte de dialogue Plug-In Automation

Activation de l'automation de plug-in pour des 
paramètres individuels
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Pour activer automatiquement l'automation de 
toutes les commandes d'un plug-in :

1  Choisissez Setup > Preferences et cliquez sur 
Mixing.

2  Sélectionnez Plug-In Controls Default to 
Auto-Enabled.

3  Cliquez sur OK pour refermer la fenêtre 
Preferences.

Protection de l'enregistrement de 
l'automation d'un plug-in

Le mode Automation Safe protège les données 
d'automation d'un plug-in

Pour activer le mode de protection d'un plug-in :

1  Ouvrez un plug-in. 

2  Cliquez sur le bouton Safe pour le mettre en 
surbrillance.

Commandes AutoMatch
(Pro Tools HD uniquement)

Application de la fonction AutoMatch 
sur toutes les commandes

Vous pouvez appliquer automatiquement les 
niveaux d'automation actuels des commandes 
aux commandes d'écriture actuelles.

Pour appliquer la fonction AutoMatch à toutes les 
commandes d'écriture actuelles :

1  Sélectionnez Window > Automation.

2  Assurez–vous que l'écriture est autorisée pour 
les types d'automation auxquels appliquer la 
fonction AutoMatch.

3  Démarrez la lecture. 

4  Lorsque vous atteignez un point de la piste 
auquel vous souhaitez rétablir les valeurs 
d'écriture de commandes précédentes, cliquez 
sur le bouton « auto match » de la fenêtre 
Automation.

Toutes les commandes d'écriture actuelles 
cessent d'écrire des données d'automation et 
reprennent leurs valeurs d'écriture précédentes 
définies par le paramètre AutoMatch Time dans 
les préférences de mixage.

Utilisation de la fonction AutoMatch sur 
des pistes individuelles

Vous pouvez appeler la fonction AutoMatch sur 
des pistes individuelles. Toutes les commandes 
écrivant des données d'automation sur la piste 
s'arrêtent et reprennent leurs niveaux 
d'automation existants.

Pour appliquer la fonction AutoMatch à toutes les 
commandes d'une piste :

" Cliquez sur le sélecteur de mode d'automation 
de la piste tout en maintenant la touche Ctrl 
(Windows) ou la touche Pomme (Mac) 
enfoncée.

Mode Automation Safe activé sur un plug-in

Bouton « auto match » de la fenêtre Automation

Protection activée

Bouton « auto match »
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Utilisation de la fonction AutoMatch 
avec des types d'automation 
individuels

Vous pouvez appeler la fonction AutoMatch sur 
des types d'automation individuels tout au long 
d'une session. 

Pour appliquer la fonction AutoMatch à toutes les 
commandes d'un type d'automation donné :

" Dans la fenêtre Automation, cliquez sur le 
bouton du type d'automation (volume, 
panoramique, coupure du son, plug-in, niveau 
d'envoi, panoramique d'envoi, ou coupure du 
son d'envoi), tout en maintenant la touche Ctrl 
(Windows) ou la touche Pomme (Mac) 
enfoncée. 

Application de la fonction AutoMatch 
sur des commandes individuelles

(D-Control et D-Command uniquement)

Sur des surfaces de travail ICON, vous pouvez 
appeler la fonction AutoMatch sur des 
commandes ou types de commandes de canaux 
uniques.

Pour appliquer la fonction AutoMatch à toutes les 
commandes d'un type donné sur un seul canal :

" Maintenez la touche Ctrl (Windows) ou la 
touche Pomme (Mac) enfoncée tout en cliquant 
sur l'une des commandes suivantes parmi les 
commandes Channel Strip Mode de la piste 
dont les commandes doivent se voir appliquer la 
fonction AutoMatch :

• Inserts

• Départs

• Pan

• Dyn (D-Control uniquement)

• EQ (D-Control uniquement)

Pour appliquer la fonction AutoMatch à une 
commande de panoramique ou aux commandes 
d'un insert ou d'un envoi individuel :

1  Appuyez sur la touche située dans la section 
des commandes Channel Strip Mode pour 
afficher les commandes de panoramique ou le 
niveau supérieur des inserts ou des envois du 
canal. 

2  Tout en maintenant la touche Ctrl (Windows) 
ou la touche Pomme (Mac) enfoncée, appuyez 
sur la touche de sélection du codeur rotatif 
correspondant à la commande à laquelle 
appliquer la fonction AutoMatch :

• Pour les envois, la fonction AutoMatch est 
appliquée au niveau d'envoi, au 
panoramique et à la coupure du son. 

• Pour les inserts, la fonction AutoMatch est 
appliquée à toutes les commandes 
automatisées. 

• Pour le panoramique, la fonction 
AutoMatch est appliquée à tous les curseurs 
de panoramique du canal. 

Pour appliquer la fonction AutoMatch à toutes les 
commandes d'un plug-in affiché dans la section 
Dynamics ou EQ :

" Tout en maintenant la touche Ctrl (Windows) 
ou la touche Pomme (Mac) enfoncée, appuyez 
sur la touche Auto de la section Dyn ou EQ de la 
console. 
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Préparation des commandes pour 
l'écriture de données 
d'automation en mode Latch
(Pro Tools HD uniquement)

Lorsqu'une piste est en mode d'automation 
Latch ou Touch/Latch, vous pouvez préparer des 
commandes individuelles pour l'écriture de 
données d'automation pendant l'arrêt du 
transport. La fonction Latch Prime vous permet 
d'effectuer les préparatifs en vue d'une passe 
d'automation avant le début de la lecture.

Pour préparer les commandes à une automation 
d'écriture en mode Latch pendant l'arrêt du 
transport :

1  Choisissez Setup > Preferences et cliquez sur 
Mixing.

2  Sélectionnez Allow Latch Prime in Stop dans 
la zone Automation.

3  Cliquez sur OK pour refermer la fenêtre 
Preferences.

4  Dans la fenêtre Automation, assurez vous que 
l'écriture est autorisée pour les commandes à 
automatiser.

5  Cliquez sur le sélecteur de mode d'automation 
de la piste sur laquelle écrire les données 
d'automation, puis effectuez l'une des 
opérations suivantes :

• Sélectionnez le mode Latch pour autoriser 
la préparation de toutes les commandes de 
la piste pour lesquelles l'automation est 
activée.

– ou –

• Sélectionnez le mode Touch/Latch pour 
laisser le fader principal du volume en 
mode Touch et autoriser la préparation de 
toutes les autres commandes pour 
lesquelles l'automation est activée.

6  Pendant que le transport est arrêté, touchez ou 
déplacez les commandes devant démarrer 
l'écriture au début de la passe d'automation. 
Lorsqu'une ou plusieurs commandes d'une piste 
sont préparées, le sélecteur de mode 
d'automation s'affiche en gras.

7  Démarrez la lecture. Toutes les commandes 
préparées démarrent l'écriture des données 
d'automation à leurs valeurs préparées.

8  Arrêtez la lecture pour mettre fin à la passe 
d'automation. Toutes les pistes sont sorties de 
leur état Latch Prime.

Indicateur du mode d'automation avant (gauche) et 
après la préparation des commandes verrouillées 
(droite)

Vous pouvez utiliser la commande Write to 
Punch à la fin de la passe d'automation 
pour réécrire la valeur actuelle au début de 
la passe. 

 
Sélecteur de 

mode 
d'automation
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Sortie des pistes et commandes de 
l'état Latch Prime

Vous pouvez sortir une piste ou un type 
d'automation de son état Latch Prime avant ou 
pendant une passe d'automation. 

! Lorsque vous sortez une piste ou un type 
d'automation de son état Latch Prime avant de 
démarrer la lecture, ils restent en mode Latch 
mais leurs commandes ne sont pas préparées 
pour l'écriture lorsque la lecture démarre.

! Lorsque vous sortez une piste ou un type 
d'automation de son état Latch Prime pendant 
une passe d'automation, les commandes 
correspondantes sont automatiquement 
assorties à leurs valeurs écrites actuelles.

! Si vous assortissez automatiquement une 
commande qui est en mode Latch Prime, la 
commande n'est alors plus préparée. 

Pour sortir une piste de son état Latch Prime :

" Cliquez sur le sélecteur de mode d'automation 
de la piste tout en maintenant la touche Ctrl 
(Windows) ou la touche Pomme (Mac) 
enfoncée. 

Le bouton du sélecteur ne s'affiche plus en gras 
pour signaler que la piste n'est plus préparée.

Pour sortir toutes les pistes de leur état Latch 
Prime, effectuez l'une des opérations suivantes :

" Cliquez sur le sélecteur de mode d'automation 
d'une piste tout en maintenant les touches 
Alt+Ctrl (Windows) ou les touches 
Option+Pomme (Mac) enfoncées. 

– ou –

" Dans la fenêtre Automation, cliquez sur le 
bouton « auto match ». 

Pour sortir toutes les pistes sélectionnées de leur 
état Latch Prime, effectuez l'une des opérations 
suivantes :

" Cliquez sur le sélecteur de mode d'automation 
d'une piste tout en maintenant les touches 
Alt+Ctrl+Maj (Windows) ou les touches 
Option+Pomme+Maj (Mac) enfoncées. 

– ou –

" Maintenez les touches Option+Maj (Mac) ou 
les touches Alt+Maj (Windows) enfoncées tout 
en cliquant sur le bouton « auto match » de la 
fenêtre Automation. 

Bouton « auto match » de la fenêtre Automation

Bouton « auto match »
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Pour sortir un type d'automation de son état Latch 
Prime sur toutes les pistes, effectuez l'une des 
opérations suivantes :

" Dans la fenêtre Automation, cliquez sur le 
bouton du type d'automation (volume, 
panoramique, coupure du son, plug-in, niveau 
d'envoi, panoramique d'envoi, ou coupure du 
son d'envoi), tout en maintenant la touche Ctrl 
(Windows) ou la touche Pomme (Mac) 
enfoncée. 

Parcours des points d'entrée 
d'automation en mode Latch Prime

Après avoir préparé les commandes pour 
l'écriture des données d'automation pendant 
l'arrêt du transport, vous pouvez configurer 
Pro Tools de façon à ce qu'il insère 
automatiquement un point d'entrée après 
l'envoi d'une commande Back and Play, ou après 
un retour et verrouillage du timecode.

Pour configurer Pro Tools de façon à ce qu'il insère 
automatiquement l'écriture de données 
d'automation sur une piste :

1  Recherchez le curseur à l'endroit duquel 
insérer les données d'automation. 

2  Préparez les commandes pour l'écriture 
pendant l'arrêt du transport. Voir Préparation 
des commandes pour l'écriture de données 
d'automation en mode Latch, page 813.

3  Dans la fenêtre Automation, cliquez sur le 
bouton « auto join ».

4  Dans la fenêtre Automation, cliquez sur le 
bouton « capture », puis sur le bouton « punch 
capture ». Le marqueur de raccordement 
automatique (ligne rouge verticale) s'affiche à 
l'écran au point d'insertion.

5  Envoyez une commande Back and Play, 
replacez la machine externe à un point 
précédent le point d'insertion ou activez le 
paramètre de pré-roll.

6  Démarrez la lecture. Lorsque le transport 
atteint le point d'insertion, l'écriture des 
données d'automation démarre.

Activation et interruption de 
l'automation
Dans la fenêtre Automation, vous pouvez 
activer ou suspendre l'écriture des types 
d'automation suivants sur toutes les pistes :

• Volume

• Rognage du volume

• Panoramique

• Mute

• Plug-in

• Niveau d'envoi

• Rognage du niveau d'envoi

• Panoramique d'envoi

• Coupure du son d'envoi

L'automation peut être interrompue ou activée 
pendant la lecture (sans avoir à arrêter le 
transport).

Types d'automation de la fenêtre Automation

Boutons de type 
d'automation
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Interruption de l'automation sur toutes 
les pistes

Pour interrompre l'automation sur toutes les 
pistes :

1  Sélectionnez Window > Automation. 

2  Effectuez l'une des opérations suivantes :

• Pour suspendre l'écriture de toutes les 
données d'automation sur toutes les pistes, 
cliquez sur le bouton Auto Suspend.

– ou –

• Pour suspendre l'écriture d'un type de 
données d'automation particulier sur 
toutes les pistes, cliquez sur le bouton de ce 
type (volume, coupure du son, 
panoramique, plug-in, niveau d'envoi, 
coupure du son d'envoi ou panoramique 
d'envoi).

Pour interrompre l'automation du rognage sur 
toutes les pistes (Pro Tools HD uniquement) :

" Dans la fenêtre Automation, cliquez sur le 
bouton Suspend tout en maintenant la touche 
Pomme (Mac) ou la touche Ctrl (Windows) 
enfoncée. 

Le bouton Suspend s'allume en jaune pour 
indiquer que l'automation du rognage est 
interrompue. 

Interruption de l'automation de 
commandes individuelles

Vous pouvez interrompre l'automation d'une ou 
plusieurs commandes. Lorsqu'une commande 
est interrompue, son nom s'affiche en italique 
dans le sélecteur de vue de piste.

Pour interrompre l'automation de commandes 
individuelles sur une piste :

1  Dans la fenêtre Edit, configurez le sélecteur de 
vue de piste pour qu'il affiche la playlist 
d'automation de la commande à suspendre.

2  Effectuez l'une des opérations suivantes :

• Pour interrompre l'écriture et la lecture des 
données d'automation de la commande 
affichée uniquement, cliquez sur son nom 
dans le sélecteur de vue de piste tout en 
appuyant sur la touche Ctrl (Windows) ou 
la touche Pomme (Mac). 

Fenêtre Automation

Interruption de l'automation du rognage

L'interruption de l'automation à partir de la 
fenêtre Edit respecte les groupes d'édition. 
Pour supprimer le comportement de groupe, 
maintenez la touche Démarrer (Windows) 
ou la touche Control (Mac) enfoncée 
pendant la suppression d'une commande.
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• Pour interrompre l'écriture et la lecture des 
données d'automation de toutes les 
commandes, maintenez enfoncées les 
touches Ctrl+Maj (Windows) ou les 
touches Pomme+Maj (Mac) pendant que 
vous cliquez sur leur nom dans le sélecteur 
de vue de piste.

• Pour interrompre l'écriture et la lecture des 
données d'automation d'une commande 
spécifique sur toutes les pistes, maintenez 
enfoncées les touches Ctrl+Alt (Windows) 
ou les touches Pomme+Option (Mac) 
pendant que vous cliquez sur son nom 
dans le sélecteur de vue de piste.

Pour interrompre l'automation du rognage de 
toutes les commandes individuelles d'une piste 
(Pro Tools HD uniquement) :

1  Dans la fenêtre Edit, configurez le sélecteur de 
vue de piste pour qu'il affiche la playlist 
d'automation de la commande de rognage à 
suspendre (rognage du volume ou rognage du 
niveau d'envoi). 

2  Effectuez l'une des opérations suivantes :

• Pour n'interrompre que la commande de 
rognage affichée sur une seule piste, cliquez 
sur son nom dans le sélecteur de vue de 
piste tout en appuyant sur la touche Ctrl 
(Windows) ou la touche Pomme (Mac).

– ou –

• Pour interrompre la commande de rognage 
affichée sur toutes les pistes, cliquez sur son 
nom dans le sélecteur de vue de piste tout 
en appuyant sur la touche Ctrl+Alt 
(Windows) ou la touche Pomme+Option 
(Mac).

Affichage de l'état de l'activation 
de l'automation

Sélecteurs de mode d'automation de piste

! Lorsque l'automation est activée pour une 
piste mais que l'automation d'écriture ne l'est 
pas, le sélecteur de mode affiche le nom du 
mode en texte rouge normal. 

! Lorsque l'automation d'écriture est activée 
pour une piste, le sélecteur de mode 
d'automation affiche le nom du mode en texte 
rouge gras.

Boutons de la fenêtre Automation

! Lorsque le type d'automation est l'écriture de 
l'automation sur toute piste de la session, le 
bouton correspondant s'affiche en texte rouge 
gras dans la fenêtre Automation. 

! Lorsque le type d'automation est activé mais 
n'effectue aucun enregistrement dans la session, 
le bouton correspondant s'affiche en texte rouge 
normal dans la fenêtre Automation. 

Sélecteur de mode d'automation indiquant l'état activé 
(à gauche) et l'état écriture (à droite)

Fenêtre Automation contenant divers états 
d'automation

Ecriture

Activé

Non activé
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Instructions d'activation de 
l'automation

Les règles ci–après déterminent si l'automation 
est activée sur une piste :

! Bien que Pro Tools n'affiche qu'un seul mode 
d'automation pour chaque piste, toutes les 
commandes associées à cette piste ne sont pas 
forcément configurées dans ce mode.

! Si l'automation est interrompue globalement 
dans la fenêtre Automation, toutes les 
commandes pouvant être automatisées se 
comportent comme si elles étaient désactivées et 
ce, quel que soit le mode d'automation de la 
piste.

! Lorsque vous interrompez une commande 
d'automation en cliquant dessus tout en 
appuyant sur la touche Ctrl (Windows) ou 
Pomme (Mac) dans le sélecteur de vue de piste, 
elle se comporte comme si elle était désactivée et 
ce, quel que soit le mode d'automation de la 
piste.

! Si une commande d'automation est 
interrompue dans la fenêtre Automation, elle se 
comporte comme si elle était en mode de lecture 
lorsque la piste est configurée dans un mode 
d'automation enregistrable (mode Touch, Latch 
ou Write).

Suppression des données 
d'automation
Les données d'automation prennent la forme 
d'une ligne graphique comportant des points 
d'inflexion modifiables. Le moyen le plus facile 
de supprimer l'automation d'une piste ou d'une 
sélection consiste à supprimer manuellement les 
points d'inflexion de la liste d'automation.

Cette méthode de suppression des données 
diffère de la commande Cut qui crée des points 
d'inflexion ancrés à la périphérie des données 
restantes. Pour en savoir plus, reportez-vous à la 
section Couper/Copier/Coller de données 
d'automation, page 826. 

Pour supprimer les données d'automation, 
affichez la playlist d'automation à modifier en le 
sélectionnant dans le sélecteur de vue de piste, 
puis exécutez l'une des actions suivantes :

Pour supprimer un seul point d'inflexion :

" A l'aide du crayon ou de la main, cliquez sur le 
point d'inflexion tout en appuyant sur la touche 
Alt (Windows) ou Option (Mac).

Pour supprimer plusieurs points d'inflexion en une 
seule opération :

" Sélectionnez une plage contenant des points 
d'inflexion à l'aide du sélecteur, puis appuyez 
sur la touche de suppression (Windows) ou sur 
la touche d'effacement arrière (Mac).

Pour supprimer toutes les données d'automation 
du type affiché :

" Cliquez sur la piste avec le sélecteur et 
choisissez Edit > Select All, puis appuyez sur la 
touche de suppression (Windows) ou sur la 
touche d'effacement arrière (Mac).

Pour supprimer toutes les données d'automation 
de toutes les listes d'automation d'une piste :

1  Sélectionnez une plage de données à 
supprimer à l'aide du sélecteur.

2  Appuyez sur Démarrer+Ret. Arr. (Windows) 
ou sur Ctrl+Arrière (Mac).



Chapitre 30 : Automation 819

Toutes les données d'automation se trouvant 
dans la sélection sont supprimées de toutes les 
playlists d'automation de cette piste, que 
l'écriture d'automation soit autorisée ou non 
pour ces commandes.

Suppression de l'automation de 
rognage
(Pro Tools HD uniquement)

Si l'automation de rognage n'a pas été fondue 
sur une piste, vous pouvez la supprimer. Lorsque 
vous supprimez l'automation de rognage, les 
points d'inflexion d'automation de toutes les 
playlists de rognage sont supprimés et tous les 
faders de rognage sont remis à zéro.

Pour supprimer l'automation de rognage :

1  Sélectionnez la piste sur laquelle supprimer 
l'automation de rognage.

2  Effectuez l'une des opérations suivantes :

• Sélectionnez Track > Clear Trim 
Automation.

– ou –

• Cliquez avec le bouton droit de la souris sur 
le nom de la piste, puis sélectionnez Clear 
Trim Automation dans le menu contextuel.

Affinage de l'automation
Lors d'une passe d'automation, Pro Tools écrit 
des données d'automation avec une densité 
maximale, sous la forme de points d'inflexion. 
Pro Tools créant des rampes entre les points 
d'inflexion, tous les points acquis ne sont pas 
forcément indispensables à la création d'une 
représentation sonore précise des mouvements 
d'automation exécutés. Chaque point 

d'inflexion occupe de l'espace dans la mémoire 
affectée à l'automation ; l'affinage des données 
peut donc optimiser l'efficacité et les 
performances du système.

Pro Tools offre deux méthodes différentes pour 
réduire le volume les données d'automation en 
supprimant les points d'inflexion inutiles: 
l'option Smooth and Thin Data After Pass et la 
commande Thin Automation.

Utilisation de l'option Smooth and Thin 
Data After Pass

Lorsque cette option est sélectionnée dans la 
page des préférences de mixage, Pro Tools réduit 
automatiquement les données de point 
d'inflexion après chaque passe d'automation.

A la création d'une nouvelle session, l'option 
Smooth and Thin Data After Pass est 
sélectionnée par défaut et le paramètre Some est 
sélectionné. Dans la plupart des cas, ce 
paramètre génère des performances optimales et 
reproduit précisément les mouvements 
d'automation.

Si vous choisissez None, Pro Tools écrit le plus 
grand nombre possible de points d'inflexion. 
Vous pouvez exécuter l'affinage à tout moment, 
via la commande Thin. Pour en savoir plus sur 
l'affinage de données d'automation, 
reportez–vous à la section Lissage, page 802.

Option Smooth and Thin Data After Pass
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Utilisation de la commande Thin 
Automation

La commande Thin Automation permet de 
réduire des zones sélectionnées d'une piste, sur 
lesquelles les données d'automation sont trop 
denses. Vous pouvez utiliser la commande Undo 
pour visualiser les résultats de l'affinage 
(comparaison avec et sans affinage) avant de les 
appliquer définitivement.

Pour utiliser la commande Thin Automation :

1  Dans la fenêtre Edit, cliquez sur le sélecteur de 
vue de piste pour afficher le type d'automation à 
réduire.

2  A l'aide du sélecteur, mettez en surbrillance les 
données d'automation à affiner. Pour réduire 
toutes les données d'automation du type 
sélectionné sur la piste, cliquez sur la piste à 
l'aide du sélecteur et choisissez la commande 
Select All.

3  Sélectionnez Edit > Automation > Thin 
(Pro Tools HD) ou Edit > Thin Automation 
(Pro Tools LE) pour réduire le nombre de 
données d'automation au niveau sélectionné 
dans la page des préférences de mixage.

Dessin d'automation
Vous pouvez utiliser le crayon pour créer des 
événements d'automation pour des pistes audio 
et MIDI, en les dessinant dans une liste 
d'automation ou de contrôleur MIDI 
quelconque, y compris l'automation de rognage 
si elle n'a pas été fondue.

Le crayon peut être configuré pour dessiner une 
série d'événements d'automation utilisant les 
formes suivantes :

Free Hand : permet de dessiner librement en 
faisant glisser la souris. Sur les pistes audio, la 
forme contient le nombre de points d'inflexion 
requis pour intercaler et reproduire sans 
accident la forme d'automation. Sur les pistes 
MIDI, la forme est reproduite sous forme d'une 
série de pas, conformément au paramètre de 
résolution défini dans la page MIDI Preferences.

Line : cet outil dessine une ligne droite. Sur les 
pistes audio, la ligne comporte un point 
d'inflexion à chaque extrémité. Sur les pistes 
MIDI, la valeur du contrôleur change par étapes 
selon la résolution définie dans la page MIDI 
Preferences.

Choix de la forme crayon

 

 

Formes de 
crayon 
disponibles 
pour 
l'automation
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Triangle : cet outil dessine un motif en dents de 
scie répété à une fréquence définie par la valeur 
de grille. Sur les pistes audio, le motif comporte 
un point d'inflexion à chaque extrémité. Sur les 
pistes MIDI, la valeur du contrôleur change par 
étapes selon la résolution définie dans la page 
MIDI Preferences. L'amplitude est contrôlée par 
le mouvement vertical du crayon. 

Square : cet outil dessine un motif carré répété à 
une fréquence définie par la valeur de grille. 
L'amplitude est contrôlée par le mouvement 
vertical du crayon. 

Random : cet outil dessine un motif aléatoire 
dont le niveau évolue à une fréquence définie 
par la valeur de grille fixée. L'amplitude est 
contrôlée par le mouvement vertical du crayon.

Utilisation des formes du crayon

Vous pouvez dessiner une automation pour des 
pistes audio ou MIDI. Par exemple, utilisez le 
motif Triangle pour contrôler des fonctions 
continues ou le motif Square pour contrôler une 
fonction commutée, telle que Mute ou Bypass.

Le crayon dessinant ces formes à partir de la 
valeur de grille, vous pouvez l'utiliser pour 
générer un panoramique cadencé au tempo d'un 
morceau de musique, ou pour caler des effets de 
changement de plan à l'image près en post-
production.

Résolution des données de 
contrôleur MIDI

Si vous utilisez le crayon pour dessiner des 
données d'automation MIDI, elles prennent 
l'aspect de pas discontinus. Vous pouvez 
contrôler la résolution (ou densité) de ces pas 
afin de faciliter la gestion de la quantité de 
données MIDI envoyées pour un déplacement 
de contrôleur MIDI donné.

Pour configurer la résolution du crayon :

1  Sélectionnez Setup > Preferences, puis cliquez 
sur MIDI.

2  Indiquez une valeur pour l'option Pencil Tool 
Resolution When Drawing Controller Data. 
Cette valeur peut aller de 1 à 100 millisecondes.

3  Cliquez sur OK pour refermer la fenêtre 
Preferences.

Les illustrations ci–après présentent les mêmes 
données d'automation de contrôleur MIDI 
dessinées avec différentes valeurs du paramètre 
de résolution du crayon.

Pour en savoir plus sur les données de 
contrôleur continu MIDI, reportez–vous à la 
section Evénements de contrôleur continu, 
page 659.

Données MIDI dessinées avec une résolution de 10 ms 

Données MIDI dessinées avec une résolution de 
100 ms 
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Pour optimiser les performances, il est possible 
de définir une valeur inférieure pour les 
commandes MIDI nécessitant une résolution 
plus élevée (par exemple, le volume MIDI) et 
une valeur supérieure pour ceux qui ne 
nécessitent pas une résolution importante (par 
exemple, le panoramique).

Modification de l'automation
Pro Tools offre plusieurs méthodes pour 
modifier les données d'automation d'une piste 
quelconque de votre session, y compris les 
données d'automation de rognage si elles n'ont 
pas été fondues. Vous pouvez modifier les 
données d'automation graphiquement, en 
ajustant les points d'inflexion de toute playlist 
d'automation. Vous pouvez également couper, 
copier et coller les données d'automation 
comme s'il s'agissait de données audio ou MIDI.

Modification graphique de 
données d'automation

Les données d'automation prennent la forme 
d'une ligne graphique comportant des points 
d'inflexion modifiables. Faites glisser ces points 
d'inflexion pour modifier les données 
d'automation directement dans la fenêtre Edit. 
Lorsque vous déplacez un point d'inflexion 
d'automation vers le haut ou vers le bas, le 
changement de valeur s'affiche en chiffres ou en 
lettres. Le déplacement d'un point d'inflexion 
d'automation vers la gauche ou vers la droite 
permet de régler la durée de l'événement 
d'automation.

Utilisation de l'outil Main

La main permet de créer de nouveaux points 
d'inflexion en cliquant sur la ligne graphique ou 
d'ajuster des points d'inflexion existants en les 
déplaçant. Cliquez sur les points d'inflexion 
avec la main tout en appuyant sur la touche Alt 
(Windows) ou Option (Mac) pour les supprimer.

Utilisation du crayon

Le crayon vous permet de créer des points 
d'inflexion en cliquant une fois sur la ligne 
graphique. Cliquez sur les points d'inflexion 
avec le crayon tout en appuyant sur la touche 
Alt (Windows) ou la touche Option (Mac) pour 
les supprimer.

Utilisation des outils de trimming

Les outils de trimming vous permettent d'ajuster 
les points d'inflexion sélectionnés vers le haut 
ou vers le bas en les faisant glisser vers un point 
quelconque de la sélection.

Création d'un point d'inflexion à l'aide de la main

Suppression d'un point d'inflexion à l'aide du crayon

Déplacement de points d'inflexion à l'aide de l'outil de 
trimming
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Modification de types 
d'automation

Chaque commande qu'il est possible 
d'automatiser dispose d'une playlist 
d'automation particulière. Pour l'afficher, 
sélectionnez–la dans le sélecteur de vue de piste. 
Visualisation des données d'automation, 
page 803.

Modification de l'automation du volume

Faites glisser un point d'inflexion vers le haut ou 
vers le bas pour modifier le volume (valeur en 
dB). Déplacez un point d'inflexion vers la 
gauche ou vers la droite pour régler la durée du 
changement de volume.

Modification de l'automation du 
panoramique

Faites glisser un point d'inflexion vers le bas 
pour obtenir un panoramique droit, vers le haut 
pour un panoramique gauche. Déplacez un 
point d'inflexion vers la gauche ou vers la droite 
pour fixer la durée des mouvements de 
panoramique.

Modification de l'automation de Mute

Faites glisser le point d'inflexion vers le bas pour 
couper le son d'une section. Faites glisser un 
point d'inflexion vers le haut pour rétablir le son 
de la section. Déplacez un point d'inflexion vers 
la gauche ou vers la droite pour définir la durée 
de la coupure du son.

Modification de l'automation d'une 
commande discontinue

L'automation de certaines commandes, 
notamment les valeurs des contrôleurs MIDI ou 
les paramètres des plug-in, apparaît sous forme 
d'une succession de paliers sur la ligne de point 
d'inflexion. Faites glisser un point d'inflexion 
vers le haut ou vers le bas pour changer de palier 
et modifier la valeur de la commande. Déplacez 
un point d'inflexion vers la gauche ou vers la 
droite pour définir la durée du changement de 
commandes discontinues.

Automation du volume de piste

Automation de panoramique de piste

Automation de coupure (Mute) de piste

Automation de commande discontinue
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Modification de points d'inflexion 
d'automation

Pour modifier les points d'inflexion 
d'automation, affichez le paramètre 
d'automation à modifier en le sélectionnant 
dans le sélecteur de vue de piste, puis exécutez 
l'une des actions suivantes :

Pour créer un point d'inflexion :

" Cliquez sur la ligne graphique avec l'outil 
Crayon ou Main.

Pour modifier un point d'inflexion :

" Cliquez sur un point existant de la ligne 
graphique avec l'outil Main, puis déplacez–le.

Pour supprimer un point d'inflexion :

" Cliquez sur un point d'inflexion avec la main 
tout en appuyant sur la touche Alt (Windows) 
ou la touche Option (Mac).

Pour modifier plusieurs points d'inflexion en une 
seule opération :

" A l'aide du sélecteur, sélectionnez une plage 
de la liste d'automation contenant les points 
d'inflexion, puis exécutez l'une des actions 
suivantes :

• Appuyez sur la touche plus (+) pour placer 
les points d'inflexion plus tard sur la piste 
(vers la droite) ou sur la touche moins (-) 
pour les placer plus tôt (vers la gauche). Les 
points d'inflexion se déplacent de la valeur 
d'incrément fixée.

• Pour régler la valeur des points d'inflexion, 
cliquez avec les outils de trimming sur la 
sélection, puis faites glisser les points 
d'inflexion vers le haut ou vers le bas.

Pour modifier toutes les valeurs de point 
d'inflexion dans une région :

" Cliquez dans la région avec un des outils de 
trimming, puis faites glisser les points 
d'inflexion vers le haut ou vers le bas.

Restreindre les nouveaux points 
d'inflexion à la valeur d'automation 
suivante ou précédente

Les nouveaux points d'inflexion d'automation 
peuvent être restreints et écrits à la même valeur 
que le point d'inflexion suivant ou précédent.

Lorsque vous modifiez une sélection 
contenant des points d'inflexion à l'aide de 
l'outil de trimming, de nouveaux points 
d'inflexion ancrés sont créés avant et après 
la zone sélectionnée. Pour éviter la création 
de ces points d'inflexion ancrés, appuyez sur 
Alt (Windows) ou Option (Mac) tout en 
appliquant l'outil de trimming.

Restriction et écriture de nouveaux points d'inflexion 
(au marqueur 1)

Automation d'origine

Après l'écriture au point d'inflexion précédent

Après l'écriture au point
d'inflexion suivant
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Pour écrire un nouveau point d'inflexion à la valeur 
d'automation suivante :

" Tout en maintenant les touches Alt+Maj 
(Windows) ou les touches Option+Maj (Mac) 
enfoncées, écrivez un point d'inflexion (en 
cliquant à l'aide d'un des outils Main dans la 
playlist d'automation de la piste).

Pour écrire un nouveau point d'inflexion à la valeur 
d'automation précédente :

" Tout en maintenant les touches Ctrl+Alt 
(Windows) ou Pomme+Option (Mac) 
enfoncées, écrivez un point d'inflexion (en 
cliquant à l'aide d'un des outils Main dans la 
playlist d'automation de la piste).

Modification de l'automation sur 
les pistes stéréo et multicanaux

Les pistes stéréo et multicanaux affichent une 
seule playlist d'automation par piste. Une seule 
playlist de volume et de coupure est disponible 
pour la piste stéréo ou multicanal.

En ce qui concerne les plug-in multimono, il est 
possible d'afficher et de modifier les playlists 
d'automation par canal lorsque les plug-in sont 
désolidarisés et que la piste est affichée en mode 
développé. 

Vue de piste développée

Par défaut, une playlist unique s'affiche sur les 
pistes stéréo et multicanaux. La playlist occupe 
la hauteur totale de la piste (à l'instar des 
playlists d'automation en mono).

Si vous le souhaitez, vous pouvez afficher une 
vue développée de la piste présentant la playlist 
d'automation de chacun des canaux. 

Playlists d'automation de plug-in sur pistes 
stéréo et multicanaux

Certains plug-in multicanaux offrent un seul jeu 
de commandes, qu'il est possible d'automatiser 
pour tous les canaux d'une piste. Certains plug-
in multicanaux et tous les plug-in multimono 
fournissent également un jeu de commandes 
pour tous les canaux lorsqu'ils sont liés et des 
commandes séparées lorsqu'ils sont 
désolidarisés. Pour en savoir plus, reportez–vous 
au guide de votre plug-in.

Pour afficher et modifier les playlists individuelles 
d'un plug-in multimono :

1  Désolidarisez le plug-in. 

2  Sélectionnez la playlist choisie dans le 
sélecteur de vue de piste.

L'écriture d'un nouveau point d'inflexion à 
la valeur d'automation suivante ou 
précédente est réalisée à l'aide d'un des 
outils Main mais n'est pas prise en charge 
par l'outil Smart.

Sélectionner une liste d'automation pour un plug-in 
multimono non lié

Multimono 
désolidarisée
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Modification de l'automation sur 
des pistes groupées

Lorsque vous modifiez les données 
d'automation sur une piste audio appartenant à 
un groupe d'édition actif, ce type d'automation 
est modifié sur toutes les pistes du groupe. Ce 
phénomène se produit même lorsque le 
paramètre n'est pas affiché sur les autres pistes 
groupées.

Exemples

! Si vous créez des points d'inflexion 
d'automation sur une piste appartenant à un 
groupe (à l'aide de l'outil Crayon ou de l'outil 
Main), les points d'inflexion des autres membres 
du groupe sont placés en fonction de cette piste.

! Si vous déplacez une automation sur une piste 
appartenant à un groupe (à l'aide de l'un des 
outils de trimming), les points d'inflexion des 
autres membres du groupe sont rognés en 
fonction de cette piste. Vous pouvez ainsi rogner 
des sections complètes d'un mixage.

Pour éditer individuellement l'automation d'un 
membre de groupe sans affecter les autres 
membres, effectuez une des opérations 
suivantes :

" Appuyez sur la touche Démarrer (Windows) 
ou la touche Ctrl (Mac) pendant l'édition.

Couper/Copier/Coller de données 
d'automation

Couper des données d'automation n'équivaut 
pas à les supprimer : les résultats obtenus sont 
différents (bien que dans les deux cas, les 
données d'automation existantes soient 
modifiées). La copie laisse intactes les données 
d'automation originales.

Pour supprimer des données d'automation, 
sélectionnez une plage de points d'inflexion, 
puis appuyez sur la touche d'effacement arrière 
(Windows) ou sur la touche de suppression 
(Mac). Pour plus d'informations, consultez la 
section Suppression des données d'automation, 
page 818.

Pour couper des données d'automation, 
sélectionnez une plage de points d'inflexion 
dans une liste d'automation et choisissez la 
commande Cut.

Lorsque vous coupez des données d'automation, 
puis les collez à un nouvel emplacement, des 
points d'inflexion ancrés s'ajoutent aux points 
d'extrémité des données. Ce phénomène 
préserve la pente d'atténuation réelle (pour les 
commandes continues telles que les faders de 
volume ou les panoramiques) ou l'état (pour les 
commandes commutées ou discontinues telles 
que les Mutes) des données d'automation, tant à 
l'intérieur qu'à l'extérieur de la sélection.

Rognage d'automation sur une piste active d'un groupe
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Les figures ci–après illustrent les différences 
entre couper et supprimer des données 
d'automation. Dans la figure 34, une piste est 
configurée pour afficher l'automation du 
volume et une plage de données d'automation 
est sélectionnée.

Si vous choisissez la commande Cut, des points 
d'inflexion ancrés sont créés à chaque extrémité 
de la sélection et la pente d'atténuation de 
l'automation de chaque côté des données 
coupées est préservée, comme illustré dans la 
figure 35. 

Si vous supprimez les données en appuyant sur 
la touche d'effacement arrière (Windows) ou sur 
la touche de suppression (Mac), les valeurs 
d'automation s'étendent entre les points 
d'inflexion pré–existants, comme l'illustre la 
figure 36. 

De plus, si les données coupées ou copiées sont 
collées à un autre emplacement de la piste, des 
points d'inflexion sont créés aux extrémités des 
données collées afin d'en préserver la valeur et la 
pente, comme l'illustre la figure 37.

Modification et vues de piste

Les pistes audio et MIDI possèdent chacune une 
vue Track constituant le format principal pour 
tout ce qui est édition. Lorsque le format 
principal est affiché, toutes les modifications 
effectuées sur la piste s'appliquent à la totalité 
des données de cette piste.

Les formats de vue principaux sont les suivants :

• Pistes audio : Blocks et Waveform

• Pistes MIDI : Blocks, Regions et Notes

Par exemple, lorsqu'une piste audio est 
configurée au format Waveform (formes 
d'ondes) ou Blocks (blocs), les 
couper/copier/coller s'appliquent aux données 
audio et à tous les types de données 
d'automation de la piste. Si la piste est 
configurée pour afficher les données 
d'automation de panoramique, seules les 
données de panoramique sont modifiées.

Lorsqu'une sélection comprend plusieurs pistes 
dont l'une est configurée au format de vue 
principale, toutes les données des pistes 
sélectionnées sont modifiées.

Pour modifier tous les types d'automation sur une 
piste d'entrée auxiliaire ou de fader principal, 
effectuez l'une des actions suivantes :

" Définissez une sélection de modification 
comprenant au moins une piste audio ou MIDI 
affichée au format principal.

– ou –

Figure 34.  Sélection de données d'automation

Figure 35.  Après "Cut" des données d'automation

Figure 36.  Après suppression des données 
d'automation

Figure 37.  Après collage de données d'automation à un 
autre emplacement
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" Appuyez sur la touche Ctrl en coupant ou en 
collant les données d'automation. 

Conseils pour couper, copier et coller

! Sur les pistes audio, si vous coupez ou copiez 
une section de forme d'ondes dans une vue 
Waveform, toutes les données d'automation 
associées à cette forme d'ondes sont également 
coupées ou copiées.

! Sur les pistes audio, si vous coupez dans une 
vue Waveform des données audio sur une piste 
contenant également des données 
d'automation, des points d'inflexion sont 
automatiquement créés aux limites des données 
d'automation restantes.

! Sur les pistes audio, le collage de données de 
formes d'ondes colle également toutes les 
données d'automation associées. 

! Sur les pistes d'entrée auxiliaire, de fader 
principal ou d'instrument, seules les données 
d'automation affichées sont coupées ou copiées. 
Pour couper ou copier toutes les données 
d'automation sur ces types de piste, appuyez sur 
la touche Ctrl tout en procédant au 
couper/copier.

! Sur les pistes contenant une playlist 
d'automation exempte de données (par 
exemple, s'il n'existe qu'un seul point 
d'inflexion au début de la piste), couper les 
données n'entraîne pas la création de nouveaux 
points d'inflexion.

! En cas de chevauchement de régions (par 
exemple, lors de déplacements de régions en 
mode Slip), la suppression d'une région ainsi 
superposée entraîne la perte de tous les points 
d'inflexion d'automation situés en dessous.

! Si des données coupées ou copiées 
contiennent un type d'automation non présent 
sur la piste cible, Pro Tools vous avertit avant de 
permettre le collage des données. 

! Les données d'automation coupées ou copiées 
concernant des plug-in ou des envois non 
présents sur la piste cible sont ignorées 
lorsqu'elles sont collées.

Commandes Cut Special, Copy Special, 
Clear Special et Paste Special

Les quatre commandes « spéciales » (Cut 
Special, Copy Special, Paste Special et Clear 
Special) simplifient les tâches de déplacement 
ou de suppression de différents types de 
données d'automation et de données de 
contrôleur MIDI entre des pistes, des envois et 
des plug-in. Ces commandes vous permettent :

• de modifier les données d'automation et de 
contrôleur MIDI uniquement (auxquelles 
aucune note audio ou MIDI n'est associée).

• de modifier les données d'automation et de 
contrôleur MIDI sans avoir à changer de 
vue de piste.

En outre, la commande Paste Special vous 
permet de copier un type de données sur un 
autre (par exemple, des données du 
panoramique gauche dans la playlist du 
panoramique de droite)
T

Pour plus de souplesse, vous pouvez utiliser 
des playlists ou la commande Duplicate 
Track pour travailler en toute sécurité sur 
une copie des données modifiées. 

Vous ne pouvez pas coller des données du 
contrôleur MIDI sur des données 
d'automation, et inversement.
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Cut Special

Les commandes Cut Special vous permettent de 
couper uniquement les données d'automation 
de la sélection actuelle (sans les notes audio ou 
MIDI associées) et de les placer en mémoire pour 
les coller à un autre emplacement de la manière 
suivante. Vous avez le choix entre les options 
suivantes :

All Automation : coupe toutes les données 
d'automation ou du contrôleur MIDI, affichées 
ou non. 

Pan Automation : coupe uniquement les 
données de panoramique MIDI ou 
d'automation de panoramique, affichées ou 
non.

Plug-In Automation : Ne coupe que les données 
d'automation de plug-in qui sont affichées.

Copy Special

Les commandes Copy Special vous permettent 
de copier uniquement les données d'automation 
de la sélection actuelle (sans les notes audio ou 
MIDI associées) et d'en placer une copie en 
mémoire pour les coller à un autre emplacement 
de la manière suivante.

All Automation : copie toutes les données 
d'automation ou du contrôleur MIDI, affichées 
ou non. 

Pan Automation : copie uniquement les données 
de panoramique MIDI ou d'automation de 
panoramique, affichées ou non.

Plug-In Automation : copie uniquement les 
données d'automation de plug-in affichées.

Paste Special

Les commandes Paste Special vous permettent 
de coller des données d'automation dans une 
autre région (sans que cela affecte les notes 
audio ou MIDI) d'une des manières suivantes : 

Merge Vous permet d'ajouter les données collées 
à des données d'automation existantes du même 
type dans la sélection de la destination. Cette 
fonction permet de regrouper dans une piste 
MIDI unique des données MIDI provenant de 
plusieurs pistes. Par exemple, vous aimez la 
variation de hauteur des trombones du 
synthétiseur et souhaitez l'appliquer à la guitare 
du synthétiseur.

Repeat to Fill Selection : Colle plusieurs 
instances des données d'automation sur toute la 
plage de sélections. Si vous sélectionnez une 
zone dont la taille n'est pas un multiple exact de 
celle de la région copiée, la partie restante de la 
sélection est remplie par une version rognée de 
la sélection d'origine. Cette fonction permet de 
créer facilement des boucles de batterie et autres 
effets répétitifs. Avant de coller les données, 
Pro Tools vous invite à spécifier un crossfade 
pour lisser les transitions entre les régions. 

To Current Automation Type : Colle les données 
d'automation ou de contrôleur MIDI contenues 
dans le Presse-papiers sur la sélection, en tant 
que type d'automation actuel ou contrôleur 
MIDI. Ceci vous permet de copier des données 
d'automation de toute type sur tout autre type. 
Par exemple, vous pouvez copier des données 
d'automation du panoramique gauche sur des 
données d'automation de plug-in. Ou vous 
pouvez copier des données de volume MIDI 
pour les coller sur un panoramique MIDI.
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Clear Special

Les commandes Clear Special vous permettent 
d'effacer uniquement les données d'automation 
de la région actuelle, de la manière suivante :

All Automation : supprime toutes les données 
d'automation ou du contrôleur MIDI, affichées 
ou non. 

Pan Automation : N'efface que les données 
d'automation de panoramique ou les données 
de panoramique MIDI qu'elles soient ou non 
affichées.

Plug-In Automation : N'efface que les données 
d'automation de plug-in qui sont affichées.

Fonction de collage spécial pour les 
données d'automation

En général, les données d'automation copiées se 
collent dans une playlist d'automation de type 
exactement identique (par exemple, les données 
de panoramique gauche sont collées dans la liste 
de panoramique gauche). 

Toutefois, il peut arriver de vouloir coller un 
type de données sur un autre (par exemple, des 
données du panoramique gauche dans la 
playlist du panoramique de droite)

La fonction Special Paste vous permet de copier 
un type de données sur un autre. 

Pour ne coller que des données d'automation ou 
de contrôleur MIDI (sans les notes audio ou 
MIDI associées), utilisez la commande Paste 
Special (voir Paste Special, page 829).

Pour que ce mode de « Coller » spécial (Special 
Paste) fonctionne, les conditions suivantes 
doivent être respectées :

• Chaque piste à coller doit être affichée en tant 
que données d'automation.

– et –

• Le Presse-papiers de chaque piste cible ne doit 
contenir qu'une seule liste d'automation. 
La fonction de collage spécial ne peut pas 
copier plusieurs listes d'automation par piste.

Pour coller des données dans une liste 
d'automation différente :

" Maintenez enfoncée la touche Démarrer 
(Windows) ou Ctrl (Mac), pendant que vous 
sélectionnez Edit > Paste.

Glide Automation
(Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement)

Les commandes Glide Automation vous 
permettent de créer manuellement une 
transition d'automation (ou glisse) d'une valeur 
d'automation existante vers une nouvelle 
valeur, sur une zone sélectionnée.

Il est impossible d'échanger des données 
d'automation entre des pistes audio et MIDI 
ou entre des commandes continues (faders 
ou panoramiques) et des commandes 
commutées ou discontinues (Mute ou 
contrôleurs MIDI).

Lorsque vous faites glisser plusieurs 
paramètres simultanément, par exemple 
avec le panoramique Surround ou les plug-
in, utilisez Edit > Automation > option 
Glide to All Enabled.
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Pour appliquer une commande Glide Automation 
au type de paramètre d'automation actuel :

1  Dans la fenêtre Automation, assurez–vous que 
l'écriture est autorisée pour ce type 
d'automation.

2  Cliquez sur le sélecteur de vue de piste pour 
sélectionner le type d'automation à automatiser. 

3  Faites glisser le sélecteur sur la piste pour 
sélectionner la zone sur laquelle écrire le 
paramètre Glide.

4  En fin de sélection, donnez au paramètre 
d'automation la valeur souhaitée. Par exemple, 
pour faire glisser le volume d'automation vers – 
l'infini, déplacez le curseur du volume vers – 
l'infini.

5  Choisissez Edit > Automation > Glide to 
Current.

Pour appliquer une commande Glide Automation à 
tous les paramètre activés :

1  Dans la fenêtre Automation, assurez–vous que 
l'écriture est autorisée pour ces types 
d'automation.

2  Dans chaque piste à automatiser, cliquez sur le 
sélecteur de vue de piste et choisissez le type 
d'automation à automatiser dans le menu 
contextuel.

3  A l'aide du sélecteur, cliquez et faites glisser 
horizontalement pour inclure toutes les pistes 
d'une sélection à automatiser (faites glisser 
verticalement pour définir la plage temporelle).

4  Dans chaque piste à automatiser, donnez au 
paramètre d'automation la valeur souhaitée en 
fin de sélection.

5  Choisissez Edit > Automation > Glide to All 
Enabled.

Considérations à propos des commandes Glide 
Automation

Le comportement de la fonction Glide 
Automation appliquée à des données 
d'automation est le suivant :

• Lorsque vous effectuez une sélection, les 
points d'inflexion d'automation sont écrits 
aux point de début et de fin de l'automation 
de transition. La valeur d'automation au 
début de la sélection correspond au point de 
départ de l'automation de transition et la fin 
de la sélection, à son point de fin. 
L'automation de transition qui est créée entre 
les deux points est basée sur la longueur de la 
sélection ainsi que sur la valeur finale 
sélectionnée.

• Si les points d'inflexion de l'automation 
correspondent à la sélection, ils ne sont pas 
modifiés ; toutefois, la valeur sélectionnée 
pour la fin de la sélection est écrite à partir du 
point final, jusqu'au point d'inflexion suivant.

• Si aucun point d'inflexion de l'automation ne 
correspond à la sélection, la valeur 
sélectionnée pour la fin de la sélection est 
écrite à la fin de la piste.

• Si aucune sélection n'est effectuée, un point 
d'inflexion est écrit à l'emplacement actuel et 
la valeur sélectionnée pour l'automation de 
glisse est écrite au point d'inflexion suivant.

Vous pouvez également appuyer sur les 
touches Alt+Barre oblique (/) (Windows) ou 
les touches Option+Barre oblique (/) (Mac).

Vous pouvez également appuyer sur les 
touches Alt+Maj+Barre oblique (/) 
(Windows) ou les touches 
Option+Maj+Barre oblique (/) (Mac).
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Rognage de l'automation
(Pro Tools HD uniquement)

Si vous avez déjà écrit des données 
d'automation, vous pouvez modifier celles qui 
se rapportent au volume de piste et aux niveaux 
d'envoi en temps réel, en mode Trim. Lorsque le 
rognage est autorisé sur une piste, vous 
n'enregistrez plus des positions de fader absolues 
mais des modifications relatives aux données 
d'automation existantes. Pour plus 
d'informations, reportez-vous à la section Mode 
Trim, page 799.

Pour activer le mode Trim :

" Dans la fenêtre Mix ou Edit, cliquez sur le 
sélecteur de mode d'automation de la piste dont 
l'automation doit être rognée, puis sélectionnez 
Trim.

Lorsque le mode Trim d'une piste est activé, ses 
faders de volume et de niveau d'envoi 
deviennent jaunes ; le contour du sélecteur de 
mode d'automation correspondant passe 
également au jaune. Ce contour reste allumé 
pour indiquer que le rognage est autorisé sur la 
piste ; il clignote au cours de l'opération de 
rognage du volume ou des niveaux d'envoi de la 
piste. 

Ecriture de données d'automation 
de rognage

L'écriture des données d'automation de rognage 
dépend de la façon dont elles sont fondues. 
Pour plus d'informations, consultez la section 
Fonte de l'automation de rognage, page 832. 
Si l'automation n'a pas été configurée de façon à 
se fondre à chaque passe d'automation, les 
mouvements d'automation de rognage sont 
écrits dans une playlist de rognage distincte. 

Pour rogner le volume ou les niveaux d'envoi 
d'une piste :

1  Dans la fenêtre Automation, assurez–vous que 
l'écriture est autorisée pour ce type 
d'automation (volume ou niveau d'envoi).

2  Cliquez sur le sélecteur de mode d'automation 
de la piste sur laquelle vous souhaitez écrire les 
données d'automation, puis sélectionnez un 
mode d'automation (Touch, Latch, Touch/Latch 
ou Write). 

3  Cliquez à nouveau sur le sélecteur de mode 
d'automation, puis sélectionnez Trim :

4  Démarrez la lecture, puis réglez le volume ou 
les niveaux d'envoi.

5  Arrêtez la lecture pour mettre fin à la passe de 
rognage. 

Fonte de l'automation de rognage

Vous pouvez configurer Pro Tools de façon à ce 
qu'il confirme, ou fonde, l'automation de 
rognage dans la playlist d'automation principale 
par l'une des méthodes suivantes :

After Every Pass : Les mouvements de rognage 
sont automatiquement appliqués lorsque le 
transport est arrêté à la fin d'une passe 
d'automation. Les playlists d'automation sont 
supprimées et les faders de rognage sont remis à 
zéro.

Activation du mode Trim
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On Exiting Trim Mode : Les mouvements de 
rognage sont enregistrés séparément dans la 
playlist d'automation de rognage en attendant 
d'être fondus. L'automation du rognage est 
automatiquement fondue sur une piste à 
condition que celle-ci ne soit pas en mode Trim. 
Vous pouvez répéter une passe d'automation, 
modifier manuellement l'automation de 
rognage de toute playlist de rognage ou 
supprimer l'automation de rognage avant de la 
fondre par cette méthode.

Manually : Les mouvements de rognage sont 
enregistrés séparément dans la playlist 
d'automation de rognage en attendant d'être 
fondus. Avec ce paramètre, la seule façon de 
fondre les mouvements de rognage est avec la 
commande Coalesce Trim Automation. Vous 
pouvez répéter une passe d'automation, 
modifier manuellement l'automation de 
rognage de toute playlist de rognage ou 
supprimer l'automation de rognage avant de la 
fondre par cette méthode. 

Pour définir la méthode de fonte de l'automation 
de rognage :

1  Choisissez Setup > Preferences et cliquez sur 
Mixing.

2  Sous Coalesce Trim Automation, sélectionnez 
une des options suivantes :

• After Every Pass :

• On Exiting Trim Mode :

• Manually :

Pour fondre l'automation de rognage sur une piste 
à la sortie du mode Trim :

1  Choisissez Setup > Preferences et cliquez sur 
Mixing.

2  Sous Coalesce Trim Automation, sélectionnez 
On Exiting Trim Mode.

3  Cliquez sur OK pour refermer la fenêtre 
Preferences.

4  Vérifiez que le transport est arrêté dans 
Pro Tools.

5  Sur la piste sur laquelle fondre l'automation de 
rognage, cliquez sur le sélecteur de mode 
d'automation, puis désélectionnez Trim.

L'automation de rognage est appliquée à la 
playlist d'automation principale ; les playlists 
d'automation de rognage sont supprimées et les 
faders de rognage sont remis à zéro. 

Pour fondre manuellement des données 
d'automation de rognage sur une piste :

1  Sélectionnez la piste sur laquelle fondre 
l'automation de rognage.

2  Effectuez l'une des opérations suivantes :

• Sélectionnez Track > Coalesce Trim 
Automation.

– ou –

Même lorsque l'automation a été configurée 
de façon à se fondre à la sortie du mode 
Trim, vous pouvez vous servir de la 
commande Coalesce Trim Automation pour 
confirmer les mouvements de rognage à tout 
moment.

Si le transport n'est pas arrêté alors que vous 
procédez à l'écriture des données 
d'automation, vous ne pouvez ni entrer ni 
quitter directement le mode Trim. Vous 
devez appliquer la fonction AutoMatch 
avant de quitter le mode Trim. Cette 
opération évite que les valeurs 
d'automation ne fassent des bonds 
soudains. 
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• Cliquez avec le bouton droit de la souris sur 
le nom de la piste, puis sélectionnez 
Coalesce Trim Automation dans le menu 
contextuel.

L'automation de rognage est appliquée à la 
playlist d'automation principale ; les playlists 
d'automation de rognage sont supprimées et les 
faders de rognage sont remis à zéro.

Ecriture de données 
d'automation au début, à la 
fin ou sur l'ensemble d'une 
sélection ou d'une piste
(Pro Tools HD uniquement)

Pro Tools permet d'écrire les valeurs 
d'automation en cours à partir de n'importe quel 
point d'insertion en avançant (ou en reculant) 
vers la fin (ou le début) d'une piste ou d'une 
sélection d'édition sur une piste, ou sur la 
totalité d'une piste ou de la sélection d'édition, 
au cours d'une passe d'automation. 

Les commandes standard Write Automation to 
Start, All ou End ne fonctionnent pas lorsque le 
transport Pro Tools est arrêté. Elles influent 
uniquement sur les paramètres d'automation 
pour lesquels l'écriture est autorisée et 
actuellement en cours d'écriture. 

Il est possible de configurer les boutons Write 
Automation to Start, End et All de telle sorte 
qu'ils s'appliquent toujours automatiquement. 
Pour plus d'informations, consultez la section 
Ecriture de données d'automation au début, à la 
fin ou sur l'ensemble d'une sélection ou d'une 
piste à l'arrêt, page 835. 

Conditions d'utilisation des 
commandes Write Automation standard

Pour que des données d'automation soient 
écrites pour un paramètre spécifique, la piste 
associée doit être configurée dans l'un des 
modes d'automation suivants et respecter les 
conditions ci-après.

Mode Latch : la commande d'automation doit 
être modifiée (touchée) au cours de la passe 
d'automation. 

Mode Touch : le paramètre d'automation doit 
être modifié (touché). 

Mode Write : tous les paramètres d'automation 
de la piste doivent être configurés en mode 
Write. 

Cette commande peut être annulée.

Pour écrire les valeurs actuelles d'automation au 
début, à la fin ou sur l'ensemble d'une piste ou 
d'une sélection d'édition :

1  Sélectionnez Window > Automation.

2  Assurez–vous que l'écriture est autorisée pour 
ce type d'automation.

3  Effectuez l'une des opérations suivantes :

• Cliquez sur une piste au niveau d'un point 
d'insertion.

– ou –

• Faites glisser avec le sélecteur pour 
sélectionner une partie de la piste.

Boutons Write Automation to Start, End et All de la 
fenêtre Automation

Boutons Automation Write to Start/End/All
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4  Cliquez sur Play pour lancer la lecture.

5  Si vous êtes en mode Latch ou Touch, assurez-
vous que la lecture s'effectue sur la piste correcte.

6  Lorsque vous atteignez un point de la piste ou 
de la sélection contenant des données 
d'automation que vous souhaitez appliquer, 
cliquez sur le bouton Write Automation to Start, 
All ou End dans la fenêtre Automation. 

7  Arrêtez la lecture.

Les valeurs actuelles de toutes les données 
d'automation pour lesquelles l'écriture est 
autorisée sur ce point sont écrites dans la zone 
correspondante de la piste ou de la sélection.

Write to Start, End ou All et le 
mode Trim

En mode Trim, il est également possible d'écrire 
des valeurs delta de rognage pour le volume de 
la piste et les niveaux d'envoi, vers le début, la 
fin ou l'ensemble de la piste ou de la sélection 
d'édition. 

Pour écrire les valeurs delta de rognage en cours 
au début, à la fin ou sur l'ensemble d'une piste ou 
d'une sélection :

1  Sélectionnez Window > Automation.

2  Assurez–vous que l'écriture est autorisée pour 
ce type d'automation (volume de piste ou 
niveau d'envoi).

3  Dans la fenêtre Mix ou Edit, cliquez sur le 
sélecteur de mode d'automation de la piste dont 
l'automation doit être rognée, puis sélectionnez 
Trim. Les faders de volume de piste et de niveau 
d'envoi deviennent jaunes.

4  Effectuez l'une des opérations suivantes :

• Cliquez sur une piste au niveau d'un point 
d'insertion.

– ou –

• Faites glisser avec le sélecteur pour 
sélectionner une partie de la piste.

5  Cliquez sur Play pour lancer la lecture. 

6  Lorsque vous atteignez un point de la piste ou 
de la sélection contenant le paramètre de 
rognage (valeur delta) que vous souhaitez 
appliquer, cliquez sur le bouton Write 
Automation to Start, All ou End dans la fenêtre 
Automation.

7  Arrêtez la lecture. 

Les modifications relatives apportées au volume 
de piste et aux niveaux d'envoi en ce point sont 
écrits dans la zone correspondante de la piste ou 
de la sélection.

Ecriture de données d'automation 
au début, à la fin ou sur 
l'ensemble d'une sélection ou 
d'une piste à l'arrêt

La fenêtre Automation contient des options 
permettant d'écrire des données d'automation 
sur toute playlist d'automation (y compris les 
playlists de rognage) après la réalisation d'une 
passe d'automation correcte. 

Il est possible de configurer les commandes 
Write Automation to Start, End ou All de telle 
sorte qu'elles se désactivent ou restent actives 
après la réalisation d'une passe d'automation 
correcte.
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Pour plus d'informations, consultez la section 
Conditions d'utilisation des commandes Write 
Automation standard, page 834. 

Pour configurer les modes d'écriture à l'arrêt de 
façon à ce qu'ils se désactivent après une passe 
d'automation :

1  Sélectionnez Window > Automation.

2  Cliquez sur l'un des modes d'écriture à l'arrêt 
(Start, All, End) pour l'activer.

La flèche du mode d'écriture à l'arrêt activé 
s'affiche en bleu.

Pour configurer les modes d'écriture à l'arrêt de 
façon à ce qu'ils restent activés après une passe 
d'automation :

1  Sélectionnez Window > Automation.

2  Tout en maintenant la touche Alt (Windows) 
ou la touche Option (Mac) enfoncée, cliquez sur 
l'un des boutons Write On Stop (Start, All ou 
End) pour l'activer.

La flèche du mode d'écriture à l'arrêt activé 
s'affiche en rouge.

Ecriture des données 
d'automation jusqu'au point 
d'inflexion ou point 
d'insertion suivant
(Pro Tools HD uniquement)

Lorsque vous effectuez une passe d'automation, 
Pro Tools vous permet d'écrire les valeurs 
d'automation actuelles, du point d'insertion 
actuel au point d'inflexion suivant (point de la 
piste à partir duquel l'écriture des données 
d'automation a débuté). 

! Write Automation to Next Breakpoint vous 
permet de mettre à jour les données 
d'automation d'une piste sans écraser les 
données précédentes ou suivantes de la 
timeline, et sans avoir à définir de sélection 
avant la modification des données 
d'automation.

! Write Automation to Punch Point vous 
permet de remplir une valeur d'automation 
manquante d'une piste après avoir trouvé le 
niveau ou paramètre approprié au cours d'une 
passe d'automation, sans avoir à ré–effectuer la 
passe.

Tout comme les commandes Write Automation 
to Start, End et All standard, les commandes 
Write Automation to Next Breakpoint et Write 
Automation to Punch Point ne fonctionnent 
pas lorsque le transport Pro Tools est arrêté. 
Elles influent uniquement sur les paramètres 
d'automation pour lesquels l'écriture est 
autorisée et actuellement en cours d'écriture. 

Optionnellement, les commandes Write 
Automation to Next Breakpoint et Write 
Automation to Punch Point peuvent être 
configurées de façon à être appliquées 
automatiquement après une passe d'automation 

Commandes Write On Stop de la fenêtre Automation

Boutons Automation Write On Stop
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correct. Pour plus d'informations, consultez la 
section Ecriture des données d'automation 
jusqu'au point d'inflexion suivant à l'arrêt ou 
jusqu'au point d'insertion à l'arrêt, page 839.

Pour écrire les valeurs d'automation actuelles au 
point d'inflexion suivant :

1  Sélectionnez Window > Automation.

2  Assurez–vous que l'écriture est autorisée pour 
ce type d'automation.

3  Cliquez sur une piste pour définir un point 
d'insertion.

4  Cliquez sur Play pour lancer la lecture.

5  Si vous êtes en mode Touch, Latch ou 
Touch/Latch, assurez-vous que la lecture 
s'effectue sur la piste appropriée.

6  Lorsque vous avez atteint le point de la piste à 
partir duquel vous souhaitez appliquer les 
paramètres actuels, cliquez sur le bouton Write 
Automation to Next Breakpoint.

7  Arrêtez la lecture. 

Les valeurs actuelles de toutes les commandes 
écrites à ce stade sont écrites jusqu'au point 
d'inflexion suivant.

Pour écrire les valeurs d'automation actuelles 
jusqu'au point d'inflexion d'automation 
précédent :

1  Sélectionnez Window > Automation.

2  Assurez–vous que l'écriture est autorisée pour 
ce type d'automation. 

3  Cliquez sur une piste pour définir un point 
d'insertion.

4  Cliquez sur Play pour lancer la lecture.

5  Si vous êtes en mode Touch, Latch ou 
Touch/Latch, assurez-vous que la lecture 
s'effectue sur la piste appropriée.

Les commandes Write Automation to Next 
Breakpoint et Write Automation to Punch 
Point fonctionnent dans les mêmes 
conditions que les commandes Write 
Automation to Start, End et All. Pour plus 
d'informations, consultez la section 
Ecriture de données d'automation au début, 
à la fin ou sur l'ensemble d'une sélection ou 
d'une piste, page 834.

Boutons Write To Next Breakpoint de la fenêtre 
Automation

La commande Write Automation to Next 
Breakpoint reste activée après une passe 
d'automation correcte. A l'inverse des 
commandes Write Automation standard, 
elle ne peut pas être configurée de façon à se 
désactiver après une passe d'automation.

Bouton Write to Next 
Breakpoint

Bouton Write to Next 
Breakpoint on Stop
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6  Lorsque vous avez atteint le point de la piste à 
partir duquel vous souhaitez appliquer les 
paramètres actuels, cliquez sur le bouton Write 
Automation to Punch Point.

Les valeurs actuelles de tous les paramètres pour 
lesquels l'écriture est autorisée sont écrites 
jusqu'au point où la première commande a 
commencé à écrire les données d'automation.

Write To Next Breakpoint ou Punch 
Point et mode Trim

En mode Trim, il est également possible d'écrire 
des valeurs de rognage pour le volume de la piste 
et les niveaux d'envoi jusqu'au point d'inflexion 
écrit suivant ou jusqu'au point d'insertion 
d'automation précédent. 

Pour écrire les valeurs de rognage actuelles 
jusqu'au point d'inflexion suivant ou jusqu'au 
point d'insertion :

1  Sélectionnez Window > Automation.

2  Assurez–vous que l'écriture est autorisée pour 
ce type d'automation (volume de piste ou 
niveau d'envoi).

3  Dans la fenêtre Mix ou Edit, cliquez sur le 
sélecteur de mode d'automation, puis 
sélectionnez Trim. Les faders de volume de piste 
et de niveau d'envoi deviennent jaunes.

4  Cliquez sur une piste pour définir un point 
d'insertion.

5  Cliquez sur Play pour lancer la lecture. 

6  Lorsque vous avez atteint le point de la piste à 
partir duquel vous souhaitez appliquer les 
valeurs de rognage actuelles, cliquez sur le 
bouton Write Automation to Next Breakpoint 
de la fenêtre Automation.

Pour écrire les valeurs de rognage actuelles 
jusqu'au point d'insertion :

1  Sélectionnez Window > Automation.

2  Assurez–vous que l'écriture est autorisée pour 
ce type d'automation (volume de piste ou 
niveau d'envoi).

3  Dans la fenêtre Mix ou Edit, cliquez sur le 
sélecteur de mode d'automation, puis 
sélectionnez Trim. Les faders de volume de piste 
et de niveau d'envoi deviennent jaunes.

4  Cliquez sur une piste pour définir un point 
d'insertion.

5  Cliquez sur Play pour lancer la lecture. 

6  Lorsque vous avez atteint le point de la piste à 
partir duquel vous souhaitez appliquer les 
valeurs de rognage actuelles, cliquez sur le 
bouton Write Automation to Punch Point de la 
fenêtre Automation.

Boutons Write To Punch Point de la fenêtre Automation

Bouton Write to Punch
Point

Bouton Write to Punch
Point on Stop
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Ecriture des données 
d'automation jusqu'au point 
d'inflexion suivant à l'arrêt ou 
jusqu'au point d'insertion à l'arrêt

La fenêtre Automation contient une option 
permettant l'écriture automatique des données 
d'automation jusqu'au point d'inflexion suivant 
à l'arrêt ou jusqu'au point d'insertion à l'arrêt.

Pour configurer l'option Write Automation to Next 
Breakpoint on Stop :

1  Sélectionnez Window > Automation.

2  Cliquez sur le bouton Write Automation to 
Next Breakpoint on Stop ou sur le bouton Write 
Automation to Punch Point. 

Lorsque cette option est activée, l'écriture des 
données d'automation s'effectue 
automatiquement jusqu'au point d'inflexion 
suivant après une passe d'automation correcte.

Pour configurer l'option Write Automation to 
Punch Point on Stop :

1  Sélectionnez Window > Automation.

2  Cliquez sur le bouton Write Automation to 
Punch Point on Stop. 

Lorsque cette option est activée, l'écriture des 
données d'automation s'effectue 
automatiquement jusqu'au point d'insertion 
d'automation après une passe d'automation 
correcte.

Instructions d'utilisation des 
commandes Write To
(Pro Tools HD uniquement)

Utilisation des commandes Write 
To pendant la lecture

Vous pouvez exécuter toute commande Write 
Automation To sans arrêter le transport 
Pro Tools. Sur les surfaces de contrôle prises en 
charge, le bouton Write To correspondant 
clignote tant que le transport n'est pas arrêté.

Lorsque le transport Pro Tools se déplace, l'appel 
d'une commande Write Automation To affecte 
l'écriture des données d'automation des 
manières suivantes :

• Write to Start/Selection Start : 
Les commandes en cours d'exécution 
continuent à écrire les données 
d'automation.

• Write to All/Selection : Les commandes en 
cours d'exécution (à l'exception des 
commandes en mode Write) arrêtent 
d'écrire les données d'automation.

• Write to End/Selection End : Les 
commandes en cours d'exécution (à 
l'exception des commandes en mode 
Write) arrêtent d'écrire les données 
d'automation.

• Write to Next Breakpoint : Les commandes 
en cours d'exécution (à l'exception des 
commandes en mode Write) arrêtent 
d'écrire les données d'automation.

• Write to Punch point : Les commandes en 
cours d'exécution continuent à écrire les 
données d'automation.

La commande Write Automation to Next 
Breakpoint reste activée après une passe 
d'automation correcte. A l'inverse des 
commandes Write Automation standard, 
elle ne peut pas être configurée de façon à se 
désactiver après une passe d'automation.
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Application de commandes Write 
To à des pistes sélectionnées

Les commandes Write Automation To 
s'appliquent en général à l'ensemble des pistes 
sur lesquelles l'écriture de données 
d'automation est en cours. Il est possible 
d'appliquer ces commandes uniquement à des 
pistes sélectionnées. 

Pour appliquer une ou plusieurs commandes Write 
Automation To à des pistes sélectionnées :

1  Sélectionnez les pistes sur lesquelles appliquer 
les commandes Write To.

2  Cliquez sur le bouton Write Automation 
requis tout en maintenant les touches Alt+Maj 
(Windows) ou Option+Maj enfoncées.

Suppression des avertissements 
lors de l'utilisation des 
commandes Write To

Lorsque vous exécutez une ou plusieurs 
commandes Write Automation To (à l'exception 
de Write to Next Breakpoint), Pro Tools affiche 
un message d'avertissement signalant que les 
valeurs d'automation vont être modifiées au 
cours de la session. Vous pouvez supprimer ces 
avertissements. 

Pour supprimer les messages d'avertissement des 
commandes Write To :

1  Choisissez Setup > Preferences et cliquez sur 
Mixing.

2  Sous Automation, sélectionnez Suppress 
Automation ‘Write To' Warnings. 

Remplacement ou extension 
des données d'automation de 
coupure de son 
(Pro Tools HD uniquement)

Pro Tools vous permet de remplacer ou 
d'étendre un événement de coupure de son en 
temps réel sans pour autant modifier l'état de 
coupure actuel.

Un événement de coupure de son peut être 
écrasé lorsque la passe d'automation démarre 
avant le premier événement de coupure de son 
et se termine après le deuxième événement. 
Dans ce cas, l'état actuel activé/désactivé de la 
coupure de son est conservé.

Un événement de coupure de son peut être 
rallongé lorsque la passe d'automation démarre 
avant un événement activé ou désactivé et se 
termine avant la fin du deuxième événement.

Ecrasement d'un événement d'automation de coupure 
de son

Coupure de son d'un événement écrasée

Automation de la coupure de son d'origine (coupure de son 
désactivée, coupure de son activée, coupure de son désactivée)
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La commande Mute Overwrite/Extend est prise 
en charge par le mode Touch et le mode Latch, 
comme suit :

Mode Touch : Ecrit l'état actuel tant que le 
bouton Mute est maintenu enfoncé.

Mode Latch : Ecrit l'état actuel jusqu'à ce que 
vous arrêtiez l'opération ou la fonction 
AutoMatch.

Pour écraser un état de coupure de son de une ou 
plusieurs pistes :

1  Sélectionnez Window > Automation. 

2  Vérifiez que la coupure de son est autorisée.

3  Dans la fenêtre Mix ou Edit, cliquez sur le 
sélecteur de mode d'automation de la piste dont 
l'état Mute doit être écrasé, puis sélectionnez le 
mode Touch ou Latch comme mode 
d'automation.

4  Dans chaque piste à automatiser, cliquez sur le 
sélecteur de vue de piste et sélectionnez Mute.

5  Placez le curseur avant le début de 
l'événement de coupure de son à écraser.

6  Lancez la lecture.

7  Maintenez la touche Ctrl (Windows) ou la 
touche Pomme (Mac) enfoncée et cliquez sur le 
bouton Mute de la piste en amont de 
l'événement de coupure de son à écraser.

Rallongement d'un événement d'automation de 
coupure de son

Bouton « mute » de la fenêtre Automation activé

Evénement de coupure de son désactivée rallongé 

Automation de la coupure de son d'origine (coupure de son 
désactivée, coupure de son activée, coupure de son désactivée)

(jusqu'à la fin de la passe d'automation)

Automation de la 
coupure de son 
activée

Pour écraser des états Mute sur plusieurs 
pistes, activez le même mode d'automation 
pour toutes ces pistes.

Placement du curseur avant le début de l'événement 
de coupure de son

Pour écraser l'état de coupure de son de 
plusieurs pistes, maintenez les touches 
Alt+Ctrl (Windows) ou Option+Pomme 
(Mac) enfoncées et cliquez sur le bouton 
Mute sur une des pistes à automatiser.

Exemple : Placez le curseur ici, avant le début de 
l'événement de coupure de son
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8  Après la fin du deuxième événement de 
coupure de son, relâchez les touches et le 
bouton Mute.

9  A la fin de la passe d'automation, cliquez sur 
Stop.

Pour rallonger un état Mute sur une piste :

1  Sélectionnez Window > Automation. 

2  Vérifiez que la coupure de son est autorisée.

3  Dans la fenêtre Mix ou Edit, cliquez sur le 
sélecteur de mode d'automation de la piste à 
automatiser, puis sélectionnez le mode Touch 
ou le mode Latch.

4  Dans chaque piste à automatiser, cliquez sur le 
sélecteur de vue de piste et sélectionnez Mute.

5  Placez le curseur avant le début de 
l'événement de coupure de son à rallonger.

6  Lancez la lecture.

7  Maintenez la touche Ctrl (Windows) ou la 
touche Pomme (Mac) enfoncée et cliquez sur le 
bouton Mute de la piste en amont de 
l'événement de coupure de son à étendre.

8  Avant la fin du deuxième événement de 
coupure de son, relâchez les touches et le 
bouton Mute.

En mode Touch, vous devez maintenir le 
bouton Mute enfoncé tout au long de 
l'écriture.

Arrêt de l'automation après la fin d'un événement de 
coupure de son

Exemple d'un état Mute écrasé

Pour rallonger des états Mute sur plusieurs 
pistes, activez le même mode d'automation 
pour toutes ces pistes.

Exemple : Arrêtez la passe d'automation ici, après la fin de 
l'événement de coupure de son

Etat Mute écrasé

Placement du curseur avant le début de l'événement 
de coupure de son

Pour étendre l'état de coupure de son de 
plusieurs pistes, maintenez les touches 
Alt+Ctrl (Windows) ou Option+Pomme 
(Mac) enfoncées et cliquez sur le bouton 
Mute sur une des pistes.

Si vous rallongez un événement au-delà de 
l'événement activé ou désactivé suivant, 
l'intégralité de l'événement est modifié.

Arrêt de l'automation avant la fin d'un événement de 
coupure de son

Exemple : Placez le curseur ici, avant le début de 
l'événement de coupure de son

Exemple : Arrêtez la passe d'automation ici, avant la fin de 
l'événement de coupure de son
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9  A la fin de la passe d'automation, cliquez sur 
Stop.

Création d'automation par 
cliché
(Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement)

Pro Tools permet d'écrire des valeurs de données 
d'automation pour plusieurs paramètres en une 
seule opération. Il existe deux méthodes 
d'écriture d'automation par cliché :

Vers une sélection : les données d'automation 
sont écrites vers la sélection de Timeline (et vers 
la sélection Edit si elle est liée). Des points 
d'inflexion ancrés se placent immédiatement 
avant et après la sélection afin que les données 
qu'elle contient ne soient pas modifiées.

Vers l'emplacement du curseur : les données 
d'automation sont écrites au point d'insertion 
du curseur. Après le point d'insertion, les 
données d'automation s'étendent jusqu'à la 
valeur de point d'inflexion suivante ou, en 
l'absence de point d'inflexion, elles restent à 
l'emplacement de la nouvelle valeur écrite 
jusqu'à la fin de la session.

Pour en savoir plus sur les opérations de couper, 
copier, coller de données d'automation au cours 
d'une session, reportez–vous à la section Ecriture 
de données d'automation au début, à la fin ou 
sur l'ensemble d'une sélection ou d'une piste, 
page 834.

Pour écrire une automation par cliché :

1  Dans la fenêtre Automation, assurez–vous que 
l'écriture est autorisée sur les paramètres à 
modifier. Désélectionnez tous les paramètres 
d'automation que vous souhaitez conserver.

2  Dans la fenêtre Edit, cliquez sur le sélecteur de 
vue de piste pour afficher les données 
d'automation à modifier.

3  Ecrivez un point d'inflexion dans la playlist si 
elle n'en contient aucun, de la manière 
suivante :

• Placez le curseur dans la playlist (ou 
effectuez une sélection d'édition), puis 
sélectionnez les touches Ctrl+Barre oblique 
(/) (Windows) ou les touches Pomme+Barre 
oblique (/) (Mac).

– ou –

• Sélectionnez la main puis cliquez à tout 
endroit dans la playlist.

4  Effectuez l'une des opérations suivantes :

• Sélectionnez une zone sur la playlist de la 
piste (ou sur plusieurs pistes) à laquelle 
vous souhaitez appliquer l'automation. 

– ou –

• Placez le curseur en un point d'insertion de 
l'option Edit.

5  Réglez les commandes à automatiser. 
Vous pouvez également modifier une 
présélection de plug-in.

6  Choisissez Edit > Automation, puis effectuez 
l'une des opérations suivantes :

• Pour écrire la valeur actuelle uniquement 
vers le paramètre d'automation affiché, 
choisissez Write to Current.

– ou –

• Pour écrire les valeurs actuelles de tous les 
paramètres d'automation activés dans la 
fenêtre Automation, choisissez Write to All 
Enabled.

Exemple d'un état Mute rallongé

état Mute désactivé rallongé 
(jusqu'à la fin de la passe d'automation)
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Ajout de données d'automation par 
cliché à des listes d'automation vides

Si vous exécutez une commande Write 
Automation sur une playlist d'automation ne 
contenant pas de données d'automation 
antérieures, la valeur choisie s'écrit dans la 
playlist entière et non uniquement dans la zone 
sélectionnée.

En effet, une liste vide de données d'automation 
ne contient qu'un seul point d'inflexion 
d'automation, correspondant à la position 
actuelle de la commande pour les paramètres. La 
position du point d'inflexion est mise à jour à 
chaque modification de la valeur du paramètre. 

Pour que la commande Write Automation 
n'écrive pas la valeur d'automation sélectionnée 
sur l'ensemble de la liste, vous pouvez :

• ancrer les données d'automation en plaçant le 
curseur à la fin de la session (ou sur tout autre 
point de terminaison) et en sélectionnant 
l'option Write to Current ;

– ou –

• cliquer avec un outil Main de chaque côté de 
la sélection.

Ainsi, la commande Write Automation n'écrit 
les données que dans la zone sélectionnée.

Ecriture d'automation par cliché sur 
des données d'automation

Lorsque vous déplacez le curseur de lecture, les 
commandes automatisées de Pro Tools sont 
mises à jour, de façon à refléter les données 
d'automation présentes sur la piste. Pour 
conserver les paramètres définis pour un cliché, 
vous pouvez suspendre les paramètres 
d'automation afin d'éviter la mise à jour de leurs 
valeurs.

Pour écrire une automation par cliché sur les 
données existantes :

1  Dans la fenêtre Automation, assurez–vous que 
l'écriture est autorisée sur les paramètres 
d'automation à modifier. Désélectionnez tous 
les paramètres d'automation que vous souhaitez 
conserver.

2  Réglez les commandes des paramètres à 
automatiser.

3  Cliquez sur le sélecteur de mode d'automation 
puis sélectionnez le mode Off pour les pistes 
auxquelles vous souhaitez appliquer 
l'automation.

4  A l'aide du sélecteur, sélectionnez la plage sur 
laquelle vous souhaitez appliquer l'automation.

5  Choisissez Edit > Automation, puis 
sélectionnez l'une des options suivantes dans le 
sous–menu :

• Pour écrire la valeur actuelle uniquement 
vers le paramètre d'automation affiché 
dans la fenêtre Edit, choisissez Write to 
Current.

– ou –

• Pour écrire les valeurs actuelles de tous les 
paramètres d'automation activés dans la 
fenêtre Automation, choisissez Write to All 
Enabled.

6  Cliquez sur le sélecteur de mode d'automation 
puis sélectionnez le mode Read pour les pistes 
que vous souhaitez lire avec l'automation.
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Capture de données d'automation et 
application en un autre point

Les commandes Write Automation peuvent 
également permettre de capturer des états 
d'automation en des points spécifiques d'une 
piste et de les appliquer à d'autres emplacements 
de la piste.

Pour capturer et appliquer des données 
d'automation :

1  Dans la fenêtre Automation, assurez–vous que 
l'écriture est autorisée sur les paramètres 
d'automation à modifier. Désélectionnez tous 
les paramètres d'automation que vous souhaitez 
conserver.

2  Cliquez sur le sélecteur de mode d'automation 
puis sélectionnez le mode Read pour les pistes 
dont vous souhaitez capturer l'automation.

3  Sélectionnez Options > Link Timeline and 
Edit Selection.

4  A l'aide du sélecteur, sélectionnez 
l'emplacement où vous souhaitez capturer 
l'automation. Toutes les commandes 
automatisées sont mises à jour pour refléter les 
données d'automation à cet emplacement. Si 
vous définissez une sélection, les commandes 
sont mises à jour pour refléter les données 
d'automation du début de la sélection.

5  Cliquez sur le sélecteur de mode d'automation 
de chaque piste à laquelle vous souhaitez 
appliquer l'automation capturée, puis 
sélectionnez Off comme mode d'automation.

6  A l'aide du sélecteur, sélectionnez 
l'emplacement où vous souhaitez appliquer 
l'automation.

7  Activez les paramètres d'automation 
précédemment suspendus.

8  Choisissez Edit > Automation, puis 
sélectionnez l'une des options suivantes dans le 
sous–menu :

• Pour écrire la valeur actuelle uniquement 
vers le paramètre d'automation affiché 
dans la fenêtre Edit, choisissez Write To 
Current.

– ou –

• Pour écrire les valeurs actuelles de tous les 
paramètres d'automation activés dans la 
fenêtre Automation Enable, choisissez 
Write To All Enabled.

9  Cliquez sur le sélecteur de mode d'automation 
puis sélectionnez le mode Read pour les pistes 
que vous souhaitez lire avec l'automation.

Automation par cliché et rognage 
de données d'automation

Pro Tools permet de rogner des valeurs telles que 
les clichés et d'appliquer les changements relatifs 
(valeurs delta) aux données d'automation 
sélectionnées à l'aide de la commande Trim 
Automation. Cette procédure est comparable à 
l'action de la commande Write Automation 
mais elle écrit les valeurs delta (différentielles) et 
non les valeurs absolues des données 
d'automation. 

Vous pouvez utiliser des valeurs de rognage pour 
écrire une automation instantanée vers tout 
paramètre qu'il est possible d'automatiser.
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Pour créer un cliché des changements relatifs 
apportés aux données d'automation :

1  Dans la fenêtre Automation, assurez–vous que 
l'écriture est autorisée sur les paramètres 
d'automation à modifier. Désélectionnez tous 
les paramètres d'automation que vous souhaitez 
conserver.

2  Sélectionnez la zone de piste à modifier. 
Toutes les commandes automatisées sont mises 
à jour pour refléter les données d'automation au 
début de la sélection.

3  Déplacez les commandes du paramètre vers le 
haut ou vers le bas, de la valeur de modification 
que vous souhaitez appliquer aux données. 

4  Choisissez Edit > Automation, puis effectuez 
l'une des opérations suivantes :

• Pour écrire la valeur delta actuelle 
uniquement vers le paramètre 
d'automation affiché, choisissez Trim to 
Current.

– ou –

• Pour écrire la valeur delta actuelle pour 
tous les paramètres d'automation activés 
dans la fenêtre Automation, choisissez 
Trim to All Enabled.

Aperçu de l'automation
(Pro Tools HD uniquement)

Le mode Automation Preview vous permet 
d'écouter les modifications apportées à un 
mixage et de les comparer à des valeurs 
d'automation existantes sans confirmer leur 
entrée dans la playlist d'automation.

Lorsque vous mettez Pro Tools en mode 
Automation Preview, vous pouvez obtenir un 
aperçu des valeurs des commandes pour 
lesquelles l'automation est activée sur toute 
piste en mode d'automation enregistrable. 

Lorsque vous touchez ou déplacez une 
commande en mode Automation Preview, celle-
ci est isolée et désactivée dans la playlist 
d'automation. La commande s'arrête de lire ou 
d'écrire les données d'automation, vous 
permettant d'écouter librement les 
modifications apportées.

Une fois que vous avez trouvé le niveau ou l'état 
souhaité, vous pouvez confirmer ou insérer la 
valeur prévisualisée dans la playlist 
d'automation pour les commandes isolées. 

! Si vous effectuez une insertion pendant la 
lecture, le mode d'automation Latch est 
sélectionné et l'écriture débute à la valeur 
prévisualisée. 

! Si vous effectuez une insertion pendant l'arrêt 
du transport, le mode d'automation Latch est 
sélectionné et la commande est préparée à partir 
de la valeur prévisualisée.

La préférence Allow Latch Prime in Stop ne 
doit pas nécessairement être activée pour 
que l'aperçu puisse mettre une commande 
en mode Latch Prime.
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Aperçu de nouvelles valeurs 
d'automation

Pour prévisualiser une nouvelle valeur 
d'automation d'une commande :

1  Vérifiez que l'automation est activée pour la 
piste dont vous souhaitez prévisualiser la valeur 
(modes Touch, Latch, Touch/Latch ou modes de 
rognage correspondants). 

2  Vérifiez que le type d'automation à 
prévisualiser est activé dans la fenêtre 
Automation (volume, panoramique, coupure du 
son, niveau d'envoi, panoramique d'envoi, 
coupure du son d'envoi ou plug-in). 

3  Dans la fenêtre Automation, cliquez sur le 
bouton « preview ». Le bouton s'allume en vert 
pour signaler que le mode Preview est actif.

4  Pour isoler une commande, touchez ou 
déplacer une commande pour laquelle 
l'automation est activée.Vous pouvez isoler des 
commandes pendant la lecture ou pendant 
l'arrêt du transport. 

L'indicateur du mode d'automation de la piste 
s'allume en vert pour indiquer qu'au moins une 
de ses commandes est isolée et le bouton 
d'insertion de l'aperçu de la fenêtre Automation 
s'allume pour indiquer qu'une valeur d'aperçu 
est prête à être insérée.

5  Démarrer la lecture et réglez la commande 
isolée afin d'écouter les modifications.

Sortie des commandes de l'état 
Isolated

Vous pouvez sortir les commandes de leur état 
d'isolement sans avoir à quitter le mode Preview.

Pour sortir toutes les commandes d'une piste de 
leur état d'isolement, effectuez l'une des 
opérations suivantes :

" Cliquez sur le sélecteur de mode d'automation 
de la piste tout en maintenant la touche Ctrl 
(Windows) ou la touche Pomme (Mac) 
enfoncée.

– ou –

" Remplacez le mode d'automation de la piste 
par le mode Read ou le mode Off. 

Pour sortir toutes les commandes d'un certain 
type d'automation de leur état d'isolement :

" Dans la fenêtre Automation, désactivez le type 
d'automation

Isolation de plusieurs commandes

Dans certains cas, notamment lors du 
démarrage d'un nouveau mixage, vous pouvez 
isoler plusieurs commandes simultanément.

Pour isoler toutes les commandes activées pour 
l'écriture :

" Maintenez la touche Alt (Windows) ou la 
touche Option (Mac) enfoncée tout en cliquant 
sur le bouton Preview.

Pour isoler toutes les commandes activées pour 
l'écriture sur toutes les pistes sélectionnées :

" Maintenez les touches Alt+Maj (Windows) ou 
les touches Option+Maj (Mac) enfoncées tout en 
cliquant sur le bouton Preview.

Commande d'aperçu de la fenêtre Automation

Bouton Bouton 
d'insertion d'aperçu
de l'aperçu
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Interruption du mode Preview

Vous pouvez arrêter temporairement le mode 
Preview afin de basculer entre les valeurs 
d'aperçu et les données d'automation existantes. 

Pour interrompre le mode Preview :

" Maintenez la touche Ctrl (Windows) ou la 
touche Pomme (Mac) enfoncée tout en cliquant 
sur le bouton Preview.

Insertion des valeurs d'aperçu

Une fois que vous avez isolé une commande et 
écouté une nouvelle valeur, vous pouvez insérer 
(écrire) la valeur dans la playlist d'automation. 

Pour insérer une valeur d'aperçu dans la playlist 
d'automation :

" Cliquez sur le bouton d'insertion de l'aperçu 
(allumé).

Mode Preview et commandes 
Write To

Les commandes Write Automation To 
fonctionnent comme suit avec le mode 
Preview :

Avant d'insérer des valeurs d'aperçu Les 
commandes Write Automation To (à l'exception 
de Write to Next Breakpoint) peuvent être 
utilisées pour étendre les valeurs d'aperçu. 
La commande Write Automation To ne 
s'applique qu'aux commandes isolées. Pro Tools 
reste en mode Preview.

Après avoir inséré des valeurs d'aperçu 
Les commandes Write Automation To (à 
l'exception de Write to Next Breakpoint) 
peuvent être utilisées pour étendre la valeur 
insérée de la même manière que les autres 
données d'automation. 

Capture des données 
d'automation
(Pro Tools HD uniquement)

Vous pouvez capturer les valeurs d'automation 
actuelles à un emplacement d'une session et les 
appliquer rapidement à un autre emplacement à 
l'aide des commandes Capture et Punch 
Capture. La commande Capture enregistre 
temporairement la valeur de toutes les 
commandes actuellement en cours d'écriture de 
données d'automation, et les commandes 
Punch Capture écrivent ces valeurs enregistrées 
sur tous les types d'automation activés.

! Les systèmes ICON permettent de capture 
jusqu'à 48 valeurs différentes (ou clichés). 

! Tous les autres systèmes ne permettent de 
capturer qu'une seule valeur.

Capture de valeurs d'automation

Vous pouvez capturer les valeurs d'automation 
actuelles des commandes en cours d'écriture. 

Pour capturer des valeurs d'automation :

1  Vérifiez que toutes les pistes dont vous 
souhaitez capturer les valeurs d'automation sont 
dans un mode activé pour l'écriture (Write, 
Touch, Latch, Touch/Latch ou Latch).

Commande de capture de la fenêtre Automation

Capture Punch 
Capture
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2  Vérifiez que les types d'automation à 
prévisualiser sont activés dans la fenêtre 
Automation (volume, panoramique, coupure du 
son, niveau d'envoi, panoramique d'envoi, 
coupure du son d'envoi ou plug-in).

3  Démarrez la lecture. Lorsque vous atteignez 
un point auquel vous souhaitez capturer les 
états d'automation actuels, cliquez sur le bouton 
« capture » de la fenêtre Automation.

Le bouton d'insertion de la capture de la fenêtre 
Automation s'allume pour indiquer qu'une 
valeur capturée peut être insérée.

Insertion de valeurs d'automation 
capturées

Une fois que des valeurs d'automation sont 
capturées, elles peuvent être insérées (écrites) à 
un autre emplacement de la piste. Les pistes en 
mode Read ou Off ne sont pas affectées.

! Si vous effectuez une insertion pendant la 
lecture, le mode d'automation de toute piste en 
mode Touch est remplacé par le mode Latch et 
l'écriture débute à la valeur capturée.

! Si vous effectuez une insertion pendant l'arrêt 
du transport, le mode d'automation de toute 
piste en mode Touch est remplacé par le mode 
Latch et la commande est préparée à partir de la 
valeur capturée.

Pour insérer des valeurs d'automation capturées :

1  Placez-vous à l'endroit où vous souhaitez 
appliquer les états d'automation capturés. Cette 
opération peut être effectuée pendant la lecture 
ou pendant l'arrêt du transport.

2  Cliquez sur le bouton d'insertion de la capture 
de la fenêtre Automation pour appliquer les 
états d'automation capturés. Les états capturés 
sont appliqués à tous les types d'automation 
actuellement activés dans la fenêtre 
Automation.

Capture des valeurs d'automation 
de toutes les commandes

Vous pouvez capturer, au cours d'une session, 
l'état de toutes les commandes pouvant être 
automatisées (à l'exception de celles des pistes 
dont le mode d'automation est Off), qu'elles 
soient en cours d'écriture de données 
d'automation ou non.

Pour capturer les valeurs d'automation de toutes 
les commandes :

" Lorsque vous atteignez un point auquel vous 
souhaitez capturer les états d'automation 
actuels, cliquez sur le bouton « capture » tout en 
maintenant la touche Alt (Windows) ou la 
touche Option (Mac) enfoncée.

Pour capturer les valeurs d'automation de toutes 
les commandes sur des pistes sélectionnées 
uniquement :

" Lorsque vous atteignez un point auquel vous 
souhaitez capturer les états d'automation 
actuels, cliquez sur le bouton « capture » tout en 
maintenant les touches Alt+Maj (Windows) ou 
les touches Option+Maj (Mac) enfoncées.

Insertion des valeurs 
d'automation de toutes les 
commandes

Vous pouvez insérer toutes les valeurs 
d'automation capturées à un autre emplacement 
de leur piste respective (à l'exception des pistes 
dont le mode d'automation est Off). 
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Pour insérer les valeurs d'automation de toutes 
les commandes :

" Lorsque vous atteignez un point auquel vous 
souhaitez appliquer les états d'automation 
capturés, cliquez sur le bouton d'insertion de la 
capture tout en maintenant la touche Alt 
(Windows) ou la touche Option (Mac) enfoncée. 
Toute piste en mode Read ou Touch est mise en 
mode Latch. Les pistes en mode Off ne sont pas 
affectées. 

Pour insérer les valeurs d'automation de toutes 
les commandes sur des pistes sélectionnées 
uniquement :

" Lorsque vous atteignez un point auquel vous 
souhaitez appliquer les états d'automation 
capturés, cliquez sur le bouton d'insertion de la 
capture tout en maintenant les touches Alt+Maj 
(Windows) ou les touches Option+Maj (Mac) 
enfoncées. Toute piste en mode Read ou Touch 
est mise en mode Latch. Tout piste sélectionnée 
dont le mode est Off n'est pas affectée. 

Capture et mode Trim

Les commandes Capture et Punch Capture 
fonctionnent avec l'automation du rognage de 
la même façon qu'avec l'automation standard. 
Pro Tools enregistre l'état de rognage lors de la 
capture ; si vous tentez de ce fait d'insérer des 
valeurs de rognage capturées, tout en affichant 
une playlist d'automation autre que de rognage, 
Pro Tools applique automatiquement les valeurs 
à la playlist de rognage correspondante. 

Punch Capture et commandes 
Write To

Après l'envoi d'une commande Punch Capture, 
les commandes affectées écrivent les données 
d'automation (en mode Latch) et toute 
commande Write Automation To peut alors être 
utilisée pour étendre la valeur insérée de la 
même manière que toute autre donnée 
d'automation. 

Capture et mode Preview

Chargement de valeurs capturées pour 
un aperçu

Vous pouvez prévisualiser et modifier les valeurs 
d'automation capturées en mode Preview avant 
d'insérer les valeurs dans la playlist 
d'automation. 

Pour capturer une valeur d'automation et l'utiliser 
dans un aperçu :

1  Vérifiez que l'automation est activée pour la 
piste dont vous souhaitez prévisualiser la valeur 
(modes Touch, Latch, Touch/Latch ou modes de 
rognage correspondants)).

2  Vérifiez que le type d'automation à 
prévisualiser est activé dans la fenêtre 
Automation (volume, panoramique, coupure du 
son, niveau d'envoi, panoramique d'envoi, 
coupure du son d'envoi ou plug-in). 

3  Capturez une valeur d'automation à 
prévisualiser à un autre emplacement d'une 
piste. Voir Capture de valeurs d'automation, 
page 848.

4  Placez–vous en un point où vous souhaitez 
prévisualiser les états d'automation capturés, 
puis cliquez sur le bouton « preview » de la 
fenêtre Automation. 
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5  Cliquez sur le bouton d'insertion de la 
capture.

Les commandes affectées sont isolées et mises à 
jour avec les valeurs capturées. Le bouton 
d'aperçu de l'insertion de la fenêtre Automation 
s'allume pour indiquer que la valeur d'aperçu 
peut être insérée.

6  Démarrer la lecture et réglez la commande 
isolée afin d'écouter les modifications.

7  Lorsque vous êtes prêt à insérer la valeur 
d'aperçu dans la playlist d'automation, cliquez 
sur le bouton d'aperçu de l'insertion qui 
s'allume.

Capture de valeurs en mode Preview

Lorsque vous êtes en mode Preview, vous 
pouvez capturer les valeurs de commandes 
isolées pour les appliquer en un autre point 
d'une piste. En capturant des valeurs d'aperçu, 
vous pouvez conserver les données 
d'automation sous-jacentes au point de capture.

Sur les systèmes ICON, vous pouvez vous servir 
du mode Preview pour capturer plusieurs clichés 
sans modifier les données d'automation. 

Pour capturer une valeur d'aperçu :

1  Activez le mode Preview et isolez une 
commande. (Voir Aperçu de nouvelles valeurs 
d'automation, page 847). 

2  Démarrer la lecture et réglez la commande 
isolée afin d'écouter les modifications.

3  Lorsque vous êtes prêt à capturer une valeur 
d'aperçu, cliquez sur le bouton « capture » de la 
fenêtre Automation.

Le bouton d'insertion de la capture de la fenêtre 
Automation s'allume pour indiquer qu'une 
valeur capturée peut être insérée.

Automation des pistes de VCA 
principal
(Pro Tools HD uniquement)

Affichage des données 
d'automation sur des pistes de 
VCA principal

Les commandes suivantes des pistes de VCA 
principal peuvent être automatisées et disposer 
de playlists d'automation distinctes :

• Volume

• Rognage du volume

• Mute

Ces playlists d'automation se comportent de la 
même façon que les playlists d'automation 
d'autres types de pistes. Pour plus 
d'informations sur l'automation du rognage du 
volume, reportez–vous à la section Rognage de 
l'automation, page 832. 

Affichage de la playlist 
d'automation composite sur des 
pistes esclaves

Lorsqu'une piste est un esclave VCA, vous 
pouvez afficher une playlist d'automation 
composite indiquant la contribution de la piste 
de VCA principal parmi les données 
d'automation du volume ou de la coupure du 
son sur la piste esclave. Cette playlist composite 
reflète la position actuelle du fader du volume 
sur la piste esclave. L'affichage de la playlist 
composite ne peut pas être modifié directement.
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Pour afficher la playlist composite sur des pistes 
esclaves VCA :

" Sélectionnez View > Automation > Composite 
Playlist. 

Fonte de l'automation VCA

Il existe plusieurs façons de confirmer (ou 
fondre) la contribution des données 
d'automation de volume et de coupure du son 
d'une piste de VCA principal aux playlists 
d'automation de ses pistes esclaves.

Suppression de la piste de VCA 
principal

Vous pouvez utiliser une piste de VCA principal 
pour écrire des données d'automation groupées, 
fondre les données d'automation VCA sur toutes 
les pistes esclaves, puis supprimer les données 
d'automation sur la piste de VCA principal. La 
lecture des pistes fondues se fait de manière 
identique que lorsqu'elles appartenaient au 
groupe VCA.

Pour fondre des données d'automation d'une piste 
de VCA principal sur toutes ses pistes esclaves 
tout en conservant la piste de VCA principal :

1  Sélectionnez la piste de VCA principal dont 
vous souhaitez fondre les données 
d'automation. 

2  Effectuez l'une des opérations suivantes :

• Sélectionnez Track > Coalesce VCA Master 
Automation. 

– ou –

• Cliquez avec le bouton droit de la souris sur 
le nom de la piste de VCA principal, puis 
sélectionnez Coalesce VCA Master 
Automation dans le menu contextuel.

L'état composite du niveau du volume et de la 
coupure du son est fondu sur chacune des pistes 
esclaves. Le fader du volume de la piste de VCA 
principal est remis à zéro, le paramètre de 
coupure du son VCA est désactivé et toute 
donnée d'automation de la piste de VCA 
principal est supprimée.

Suppression de la piste de VCA 
principal

Vous pouvez utiliser une piste de VCA principal 
de manière temporaire pour écrire des données 
d'automation groupées, puis fondre les données 
d'automation VCA sur toutes les pistes esclaves 
en supprimant la piste de VCA principal. 
La lecture des pistes fondues se fait de manière 
identique que lorsqu'elles appartenaient au 
groupe VCA.

Pour fondre des données d'automation d'une piste 
de VCA principal sur toutes ses pistes esclaves et 
supprimer la piste de VCA principal :

1  Sélectionnez la piste de VCA principal dont 
vous souhaitez fondre les données 
d'automation.

2  Sélectionnez Track > Delete.

L'état composite du niveau du volume et de la 
coupure du son est confirmé sur chacune des 
pistes esclaves.

Affichage des données d'automation composite sur 
une piste esclave VCA

Playlist 
d'automation 
du volume

Playlist 
composite

Cette action ne peut pas être annulée.



Chapitre 30 : Automation 853

Suppression d'une piste esclave d'un 
groupe VCA

Vous pouvez supprimer une piste esclave 
individuelle d'un groupe VCA, qui confirme les 
données d'automation VCA sur cette piste, sans 
affecter la piste de VCA principal ni les autres 
pistes esclaves. La lecture des pistes esclaves 
fondues se fait de manière identique que 
lorsqu'elles appartenaient au groupe VCA.

Pour fondre les données d'automation d'une piste 
de VCA principal sur une piste esclave 
individuelle :

1  Effectuez l'une des opérations suivantes :

• Sélectionnez Modify Groups dans le menu 
contextuel Group List. 

• Cliquez sur l'indicateur d'ID de groupe de la 
piste, puis sélectionnez Modify dans le 
menu contextuel. 

• Cliquez avec le bouton droit sur le nom du 
groupe dans la liste des groupes, puis 
sélectionnez Modify dans le menu 
contextuel.

2  Dans la boîte de dialogue Groups, 
sélectionnez le groupe contrôlé par VCA 
contenant la piste esclave.

3  Dans la boîte de dialogue Groups, cliquez sur 
Tracks puis supprimez la piste esclave du groupe.

4  Cliquez sur OK.

La piste esclave est supprimée du groupe VCA et 
l'état composite du niveau du volume et de la 
coupure du son est fondu sur la piste. 

Duplication d'une piste esclave

Lorsque vous dupliquez une piste esclave sans 
dupliquer ses affectations de groupes, les 
données d'automation VCA sont fondues sur la 
piste dupliquée. La piste dupliquée fondue est 
lue de manière identique que si elle appartenait 
au groupe VCA. 

Pour fondre les données d'automation d'une piste 
de VCA principal sur une piste esclave individuelle 
en dupliquant la piste :

1  Sélectionnez la piste esclave dont vous 
souhaitez fondre les données d'automation. 

2  Choisissez Track > Duplicate

3  Dans la boîte de dialogue Duplicate Track, 
désélectionnez Group Assignments.

4  Cliquez sur OK. 

L'état composite du niveau du volume et de la 
coupure du son est fondu sur la piste dupliquée. 
La piste esclave d'origine est conservée et le 
groupe VCA reste inchangé.
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Fonte de données d'automation sur une 
sélection d'édition

Vous pouvez confirmer des données 
d'automation VCA sur une sélection 
d'automation d'une piste de VCA principal sans 
confirmer les données d'automation sur 
l'intégralité de la piste.

Pour fondre les données d'automation d'une 
sélection d'édition sur une piste de VCA principal :

1  Sélectionnez la piste de VCA principal dont 
vous souhaitez fondre les données 
d'automation.

2  Effectuez une sélection d'édition sur une piste 
de VCA principal qui englobe la plage de 
données d'automation que vous souhaitez 
fondre.

3  Effectuez l'une des opérations suivantes :

• Tout en maintenant la touche Démarrer 
(Windows) ou Ctrl (Mac) enfoncée, cliquez 
sur Track > Coalesce VCA Master 
Automation. 

– ou –

• Tout en maintenant la touche Démarrer 
(Windows) ou Ctrl (Mac) enfoncée, cliquez 
avec le bouton droit de la souris sur le nom 
de la piste de VCA principal, puis 
sélectionnez Coalesce VCA Master 
Automation dans le menu contextuel. 

L'état composite du niveau du volume et de la 
coupure du son est confirmé sur chacune des 
pistes esclaves de la sélection d'édition. 
Le volume de la piste de VCA principal est remis 
à zéro, le paramètre de coupure du son VCA est 
désactivé et toute donnée d'automation de la 
piste de VCA principal est supprimée, dans la 
zone sélectionnée uniquement. 
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Chapitre 31 : Mixage final

Pro Tools vous permet d'enregistrer et de prémixer 
des pistes sur un disque. La commande Bounce 
to Disk permet d'enregistrer un mixage final sur 
un disque, de créer un nouvel enregistrement en 
boucle, de figer des effets ou de consolider tout 
type prémixage. Vous pouvez également 
prémixer, envoyer vers de nouvelles pistes audio 
et enregistrer des bus et des entrées. 

Bounce to Disk : cette commande écrit la session 
en cours (en l'absence de sélection) ou la 
sélection d'édition (Edit) ou de timeline 
(Timeline) sur le disque, sous forme de 
nouveaux fichiers audio. Toute sortie ou chemin 
de bus disponible peut faire office de source de 
prémixage. La commande Bounce to Disk sert 
aussi à écrire ou masteriser n'importe quelle 
sortie ou chemin de bus directement sur un 
disque. La fréquence d'échantillonnage, la 
résolution et les autres processus de conversion 
peuvent être appliqués en cours de prémixage 
(bounce) ou après. La commande Bounce to 
Disk permet de prémixer toutes les voix 
disponibles sur disque, sans devoir en garder 
une seule en réserve. Bien qu'il soit possible 
d'écouter en temps réel le prémixage en cours de 
création, vous ne pourrez pas agir sur la console 
ou autres commandes au cours de la procédure 
de Bounce to Disk. 

Enregistrement sur des pistes : ce processus de 
prémixage et d'enregistrement sur de nouvelles 
pistes audio est comparable au mixage et à 
l'enregistrement de n'importe quels signaux 

d'entrée. Cette méthode utilise des pistes, des 
voix et des chemins de bus disponibles, en 
nombre suffisant pour gérer le prémixage et les 
nouvelles pistes. Lors de l'enregistrement sur 
pistes, vous pouvez régler la console de mixage 
ou d'autres commandes.

Sélection de sons pour des boucles, 
des prémixages et des effets

Le prémixage sur disque (Bounce to Disk) et 
l'enregistrement sur pistes s'appliquent à la 
sélection Timeline ou Edit le cas échéant. Il est 
ainsi plus facile de convertir des sélections 
réalisées à partir de plusieurs pistes en boucles 
mono, stéréo ou multicanaux. Les prémixages, 
les stems et les autres types de mixage spécialisé 
peuvent également être enregistrés sur disque au 
moyen de l'une de ces méthodes, soit sur une 
machine DAT ou MDM, soit sur tout autre 
support d'enregistrement, de transfert ou 
d'archivage. 

Enregistrer des effets sur un disque permet de les 
"figer", c'est-à-dire d'ajouter de façon définitive 
des effets en temps réel (par exemple une 
égalisation ou une réverbération) à une piste 
audio. Il suffit de la transférer et de l'enregistrer 
sur d'autres pistes en ajoutant les effets désirés. 
Les données audio originales sont préservées, ce 
qui permet de revenir à tout moment à la piste 
source. « Figer » ainsi les effets se révèlent utiles 
notamment si vous disposez d'un nombre limité 
de pistes ou d'effets externes. 
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Utilisez la commande Bounce to Disk si vous 
devez convertir les fichiers de prémixage ou si 
vous désirez éviter toute action accidentelle sur 
les commandes de la console au cours du 
prémixage. 

Procédez à l'enregistrement sur de nouvelles 
pistes si vous souhaitez être en mesure de régler 
les commandes en cours d'écriture des fichiers. 

Dithering et prémixage sur disque 
(Bounce)

Le processus de dithering peut améliorer 
considérablement la qualité du son. En général, 
cette procédure est nécessaire en cas de 
réduction de résolution des données 
audionumériques. 

Si vous utilisez la commande Bounce to Disk, 
sachez que ce processus ne permet pas 
d'appliquer de dithering. 

Pour appliquer du dithering à un fichier de 
prémixage, il faut insérer l'un des plug-in Dither 
de Digidesign ou tout autre plug-in de dithering, 
sur la piste du fader principal affectée au chemin 
source du prémixage. Les pistes de fader 
principal sont souvent préférables aux entrées 
auxiliaires, car les inserts de fader principal 
s'installent après le fader (ce qui convient 
davantage au dithering).

En l'absence de plug-in de dithering sur le 
chemin source du prémixage, si vous décidez 
d'opter pour une résolution inférieure en cours 
de prémixage sur disque ou après, le fichier 
résultant est converti par troncature. 

Dans quel cas utiliser un plug-in de dithering

Utilisez un plug-in de dithering dès lors que 
vous désirez réduire la résolution comme, par 
exemple, lors d'un mastering en 16 bits avec la 
commande Bounce to Disk, ou lors d'un 
mastering vers une machine externe 
enregistrant en 16 bits. 

Il est également nécessaire dans les sessions en 
16 bits. Bien que celles-ci utilisent des fichiers 
16 bits, elles sont traitées à une résolution 
numérique supérieure :

• Des chemins de signaux audio d'entrée et de 
sortie de 24 bits avec fonctions de mixage et 
de traitement interne de 48 bits pour les 
systèmes Pro Tools|HD.

• Des chemins de signaux audio d'entrée et de 
sortie de 24 bits avec traitement des virgules 
flottantes de 32 bits pour les systèmes 
Pro Tools LE.

Ainsi, que vous travailliez dans une session 
16 bits ou 24 bits, il est conseillé d'utiliser un 
plug-in Dither lorsque vous masterisez dans un 
format 16 bits.

Masteriser dans un format 24 bits, en revanche, 
ne nécessite pas d'utiliser de plug-in Dither.

Utilisation du plug-in Dither sur un mixage de 
sortie

Pro Tools est fourni avec des plug-in de 
dithering en temps réel qui améliorent les 
performances en 16, 18 et 20 bits et réduisent le 
bruit de quantification lors du mixage de 
signaux de faible niveau, ou lors de fondus.

Les seules commandes des plug-in de dithering 
que l'utilisateur peut choisir sont les 
commandes Bit Resolution et Noise Shaping.

Les plug-ins AudioSuite offrent une autre 
option d'enregistrement des plug-in d'effets 
sur disque. Pour en savoir plus, 
reportez-vous au Guide des plug-ins 
DigiRack.
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Pour utiliser un plug-in de dithering dans un 
prémixage :

1  Choisissez Track > New, puis sélectionnez 
Master Fader (stereo) dans le menu contextuel.

2  Réglez la sortie de la piste Master Fader sur la 
sortie ou le chemin de bus emprunté par le 
prémixage.

3  Affectez les sorties de toutes les pistes audio de 
la session au même chemin que celui choisi à 
l'étape 2. La piste de fader principal contrôle 
désormais les niveaux de sortie de toutes les 
pistes qui y parviennent.

4  Sur la piste du fader principal, cliquez sur un 
bouton Insert, puis sélectionnez l'un des plug-in 
de dithering de Digidesign.

5  Dans la fenêtre du plug-in de dithering, réglez 
les paramètres Bit Resolution et Noise Shaping.

Lors du prémixage sur disque, il est possible de 
convertir le fichier à une résolution plus 
adaptée. Avant d'être converti par la commande 
Bounce to Disk, le signal subit un dithering, 
conformément aux valeurs spécifiées pour les 
paramètres Bit Resolution et Noise Shaping du 
plug in de dithering.

Enregistrement sur des pistes
Vous pouvez créer un prémixage dans une 
session Pro Tools et l'enregistrer vers des pistes 
disponibles dans cette même session. Cette 
technique permet d'ajouter au mixage des 
entrées « en direct » et de modifier les niveaux, 
les panoramiques, les Mute (coupures), etc. en 
cours d'enregistrement. Cette méthode peut 
également être utilisée à la place de la méthode 
Bounce to Disk, pour créer des pistes de mixage 
directement dans votre session Pro Tools.

Nombre de voix nécessaires

L'enregistrement d'un prémixage vers de 
nouvelles pistes impose de disposer d'une voix 
disponible pour chaque piste à enregistrer. 
Assurez-vous que vous disposez de 
suffisamment de voix disponibles pour lire 
toutes les pistes à enregistrer et pour enregistrer 
les pistes de destination. 

À l'inverse, la commande Bounce to Disk permet 
de prémixer toutes les voix disponibles sur un 
disque sans devoir en garder de réserve ; il est 
toutefois impossible d'intervenir manuellement 
sur les diverses commandes au cours du 
prémixage. Pour plus d'informations, 
reportez-vous à la section Bounce to Disk :, 
page 858.

Pour en savoir plus sur le dithering, 
reportez-vous à la section Dithering, 
page 761. 

 Pour en savoir plus sur les plug-in de 
dithering de Digidesign, reportez-vous au 
Guide des plug-in DigiRack.

Pour en savoir plus sur la gestion des voix, 
reportez-vous à Priorité des pistes et 
assignation de voix, page 159.
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Pour enregistrer un prémixage sur une piste :

1  Appliquez les plug-in ou les processeurs 
externes à ajouter aux pistes audio et aux entrées 
auxiliaires avant l'enregistrement.

2  Réglez sur un chemin de bus la sortie 
principale de canal des pistes que vous désirez 
inclure dans le prémixage. Réglez le 
panoramique de chaque piste si vous utilisez des 
pistes stéréo ou multicanaux.

3  Choisissez Track > New, puis créez une ou 
plusieurs pistes audio mono, stéréo ou 
multicanaux. 

4  Si l'enregistrement est réalisé en stéréo, réglez 
le panoramique de la nouvelle piste stéréo (ou 
de deux pistes mono) à fond à gauche et à fond 
à droite.

5  Réglez l'entrée de chaque piste de destination 
de telle sorte qu'elle corresponde au chemin de 
bus depuis lequel l'enregistrement s'effectue.

6  Réglez la sortie des nouvelles pistes sur la voie 
de sortie principale.

7  Sélectionnez Options > Link Timeline and 
Edit Selection.

8  Sélectionnez les données audio à enregistrer. 
Le début, la fin et la durée de l'enregistrement 
peuvent être définis par l'emplacement du 
curseur ou par les sélections Timeline et Edit. 

• Lorsque l'enregistrement est basé sur une 
sélection, l'entrée et la sortie de 
l'enregistrement s'effectuent 
automatiquement au début et à la fin de la 
sélection. N'oubliez pas d'ajouter du temps 
à la fin d'une sélection pour inclure les 
queues de réverbérations, les dernières 
répétitions des délais, etc.

• En l'absence de sélection définie, 
l'enregistrement débute au point 
d'insertion du curseur de lecture. Il se 
poursuit jusqu'à ce que vous appuyiez sur 
Stop. 

9  Préparez les nouvelles pistes en 
enregistrement, puis cliquez sur Record dans la 
fenêtre Transport. 

10  Cliquez sur Play dans la fenêtre Transport 
pour lancer l'enregistrement du prémixage.

11  Si vous enregistrez une sélection audio, 
l'enregistrement s'arrêtera automatiquement. 
Si vous procédez à un enregistrement « ouvert », 
cliquez sur Stop ou sortez d'enregistrement. 
Vérifiez que la lecture en boucle n'est pas 
activée.

Bounce to Disk :
La commande Bounce to Disk permet de 
procéder à un mixage en utilisant toutes les voix 
disponibles sur votre système. L'enregistrement 
s'effectue dans des fichiers audio distincts, aussi 
n'est-il pas nécessaire de réserver des pistes pour 
le prémixage (bounce). 

Les prémixages (bounces) Pro Tools s'effectuent 
en temps réel, ce qui permet d'écouter la lecture 
audio du mixage au cours de l'opération (bien 
que vous ne puissiez pas intervenir dessus !). 

Avec Pro Tools HD, les plug-in RTAS placés 
sur des pistes d'entrée auxiliaire, de fader 
principal et d'instrument utilisent des voix 
supplémentaires et peuvent introduire une 
latence plus longue basée sur la taille du 
buffer matériel. Pour plus d'informations, 
reportez-vous à la section Utilisation des 
voix et latence totale pour les plug-in RTAS, 
page 767. 
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Vous pouvez utiliser la commande Bounce to 
Disk pour créer et importer automatiquement 
des boucles, des prémixages ou toutes autres 
données audio dans une session. Elle permet 
également de créer un master final mono, stéréo 
ou multicanal dans l'un des différents formats 
de fichier audio existants. Bounce to Disk offre 
des options de conversion de fréquence 
d'échantillonnage, de résolution et de format. 

Le prémixage d’une piste sur un disque contient 
les éléments suivants :

Pistes audibles : Toutes les pistes audibles qui 
parviennent à la sortie sélectionnée en tant que 
source de prémixage sont inclues dans le 
prémixage. Les pistes coupées (Mute) 
n'apparaissent pas dans le prémixage. En cas 
d'écoute en mode Solo d'une piste ou de 
plusieurs pistes, seuls les éléments écoutés en 
Solo apparaissent dans le prémixage.

Automation : toutes les données d'automation 
pour lesquelles la lecture est autorisée sont lues 
et prises en compte pour le prémixage. 

Inserts et départs : tous les inserts actifs, 
notamment les plug-in temps réel et les inserts 
matériels, sont pris en compte pour le 
prémixage.

Durée de sélection ou de piste : si vous 
sélectionnez une partie d'une piste, la durée du 
prémixage correspond à celle de la sélection. 
En l'absence de sélection, la durée du prémixage 
correspond à celle de la piste audible la plus 
longue de la session.

Informations de marquage temporel 
Les éléments prémixés par Bounce subissent 
automatiquement un marquage temporel 
(« horodatage »), ce qui permet de les faire 
glisser dans une piste et de les disposer au même 

emplacement que les éléments originaux. 
Pour en savoir plus sur le marquage temporel, 
reportez-vous à la section Marquage temporel, 
page 938.

Les fichiers prémixés subissent une 
compensation de retard

Pro Tools compense tous les retards de bus et de 
plug-in dus à un prémixage. Ainsi, lorsqu'un 
fichier de prémixage est réimporté dans une 
session et placé directement en regard du 
mixage de la source, il est aligné avec le mixage 
original de la source.

Les pistes préparées en enregistrement ou 
dotées de la permutation d'écoute TrackInput 
ne peuvent être prémixées.

Les pistes préparées en enregistrement ou en 
mode d'écoute Input Only ne peuvent être 
prémixées à l'aide Pro Tools.

Pour exécuter la commande Bounce to Disk : 

1  Créez une sélection de timeline pour définir la 
plage à prémixer.

2  Sélectionnez File > Bounce to > Disk.

3  Configurez les options de prémixage (voir 
Options de prémixage, page 860). 

4  Cliquez sur Bounce.

Prémixage avec l'option Mute Frees 
Assigned Voice (Pro Tools HD 
uniquement)

Lorsque vous prémixez des sessions qui incluent 
des pistes Mute, l'activation de l'option Mute 
Frees Assigned Voice peut parfois augmenter le 
nombre de pistes pouvant être prémixées. Pour 
plus d'informations, reportez-vous à la section 
Option Mute Frees Assigned Voice, page 170.
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Options de prémixage
La commande Bounce to Disk donne accès à un 
certain nombre d'options de fichier 
configurables.

Source de prémixage

Sélectionnez un chemin de sortie ou de bus 
mono, stéréo ou multicanal en tant que source 
de prémixage. Tous les chemins de sortie ou de 
bus actifs définis dans la boîte de dialogue 
I/O Setup sont disponibles comme source de 
prémixage (Bounce Source). 

Pour régler la source de prémixage :

" Sélectionnez une sortie ou un chemin de bus à 
l'aide du sélecteur de source de prémixage.

Enforce Avid Compatibility

Cette option crée des montages d'une précision 
à l'image près, exporte les fichiers au format 
OMFI (sauf si vous choisissez le format de fichier 
MXF) et limite les options de fréquence 
d'échantillonnage à 44,1 ou 48 kHz. Le 
dithering sans mise en forme du bruit s'applique 
aux fichiers 24 bits exportés vers le format 
16 bits.

File Type

Cette option permet de sélectionner le type 
(créateur) des fichiers prémixés. 

Boîte de dialogue Bounce to Disk (conversion et options 
activées)

Sélectionnez une source de prémixage

Sélection d'un type de fichier
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Sound Designer II

(Mac uniquement)

Il s'agit du format de fichier natif des anciens 
systèmes Pro Tools fonctionnant sous Mac. 
Sélectionnez-le pour utiliser les sons prémixés 
avec une application Digidesign pour Mac.

BWF (Broadcast .WAV Format)

WAV désigne le format de fichier natif des 
anciens systèmes Pro Tools reposant sur 
Windows ; ce format est désormais compatible 
avec Windows et Mac. Pour utiliser un fichier 
BWF (.WAV) dans Pro Tools, vous pouvez le 
faire glisser depuis le navigateur DigiBase, 
l'Explorateur Windows, le Finder Mac ou un 
dossier, ou utiliser la commande de menu 
Import Audio to Track ou Import Audio to 
Region List. Les fichiers de ce type de format 
n'ont pas besoin d'être convertis pour être 
utilisés dans Pro Tools.

AIFF(Audio Interchange File Format) :

Pour utiliser un fichier AIFF dans Pro Tools, vous 
pouvez le faire glisser depuis le navigateur 
DigiBase, l'Explorateur Windows le Finder Mac 
ou utiliser la commande Import Audio. 
Les fichiers de ce type de format n'ont pas 
besoin d'être convertis pour être utilisés dans 
Pro Tools.

QuickTime

QuickTime est le format de fichiers audio 
multimedia d'Apple. Ce type de fichier n'est pas 
pris en charge directement dans les sessions 
Pro Tools. Pour utiliser un fichier QuickTime 
audio sur un système Pro Tools, exécutez la 
commande Import Audio. Le format QuickTime 
est largement utilisé pour joindre des fichiers 
aux messages électroniques en vue de simplifier 

l'analyse et l'approbation des projets à longue 
distance. De nombreuses applications 
multimédia répandues reconnaissent également 
le format QuickTime.

Sound Resource 

(Mac uniquement)

Ce type de fichier est reconnu par certaines 
applications Mac. Ce type de fichier n'est pas 
pris en charge directement dans les sessions 
Pro Tools. Pour utiliser un fichier SND sur un 
système Pro Tools, exécutez la commande 
Import Audio. Le format SND permet 
notamment d'utiliser vos propres données audio 
dans d'autres applications Mac ne prenant pas 
en charge les formats Sound Designer II et AIFF. 

Windows Media

(Windows uniquement)

Les fichiers formatés Windows Media peuvent 
contenir des données audio, vidéo ou de script, 
stockées au format Windows Media. Les fichiers 
au format Windows Media peuvent porter 
l'extension .asf, .wma ou .wmv.

MXF (Material Exchange Format)

(Pro Tools avec DigiTranslator uniquement)

MXF est un format de fichier média qui inclut 
des fichiers vidéo et des fichiers audio, et qui est 
conçu pour l'échange de matériel audiovisuel et 
des données et métadonnées qui lui sont 
associées. Il a été conçu dans le but d'améliorer 
l'interopérabilité des fichiers entre les serveurs, 
stations de travail et autres périphériques de 
création de contenu.
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Les fichiers de format de séquence AAF et OMF 
peuvent référer aux fichiers médias MXF ou 
intégrer des fichiers médias MXF. Pro Tools avec 
DigiTranslator prend en charge les séquences 
intégrées AAF.

MPEG-1 Layer 3 (MP3)

Le format de réduction de débit numérique de 
données MPEG-1 Layer 3 (MP3) permet de 
diffuser et de télécharger des données audio sur 
Internet, puis de les lire sur des périphériques 
portables. L'option MP3 est requise pour utiliser 
ce type de fichier. 

Le codeur MP3 installé avec Pro Tools est une 
version de démonstration de 30 jours 
entièrement fonctionnelle. Vous pouvez acheter 
la version complète de ce codeur MP3 sur le site 
de Digidesign (www.digidesign.com).

Lorsque ce format est sélectionné, le menu 
déroulant Resolution de la boîte de dialogue 
Pro Tools Output Options n’est pas disponible. 
La résolution est définie par le codeur.

La fréquence d'échantillonnage choisie est 
donnée au codec comme fréquence 
d'échantillonnage de base pour les opérations. 
La fréquence d'échantillonnage réelle du fichier 
obtenu est définie dans la boîte de dialogue MP3 
Encoder Options. Si vous choisissez, par 
exemple, une fréquence d'échantillonnage de 
base de 48 000 Hz, la boîte de dialogue MP3 
Encoder Options autorisera des données de 
sorties en 48, 24 ou 12 kHz, suivant la qualité du 
codage.

Pour exporter ou prémixer des données vers le 
format MP3, vous pouvez définir les options 
suivantes :

Paramètres de codeur

Vitesse de codeur cette option détermine la 
qualité audio du fichier prémixé. Deux options 
sont disponibles : Highest Quality et Fastest 
Encoding Time. 

Le traitement du son peut durer cinq fois plus 
longtemps avec l'option Highest Quality qu'avec 
Fastest Encoding ; aussi, est-il préférable de 
réserver la première option aux situations dans 
lesquelles une qualité optimale est 
indispensable et pour lesquelles vous disposez 
de suffisamment de temps à consacrer à ce 
traitement. 

Débit constant (CBR, Constant Bit rate) Code les 
fichiers avec un débit unique sélectionné dans le 
menu local CBR. Ce débit étant fixe, la qualité 
du son codé varie selon la nature des éléments 
compressés. Cette option est préconisée pour la 
diffusion sur Internet, car la bande passante 
requise est prévisible. 

Pour plus d'informations, reportez-vous au 
Guide DigiTranslator.

Vous pouvez vous procurer l'option MP3 
Export à partir de la boutique en ligne 
DigiStore sur le site Web de Digidesign 
(www.digidesign.com).

Option MP3 Export 
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Paramètres ID3 Tag Info

ID3 Tag Type : l'étiquette ID3 stocke les données 
concernant le fichier audio codé que les lecteurs 
MP3 utilisent pour afficher des informations le 
concernant. Pro Tools prend en charge trois 
versions de cet identificateur afin d'assurer une 
compatibilité descendante avec des lecteurs 
MP3 moins récents : 

• ID3 v1.0 : apparaît à la fin d'un fichier MP3 
diffusé en continu ; aussi les informations 
d'identité s'affichent-elles uniquement après 
la diffusion logicielle.

• ID3 v1.1 : analogue à la version 1.0, cet 
identificateur affiche en outre un numéro de 
plage.

• ID3 v2.3 : apparaît dans l'en-tête d'un fichier 
MP3 pour streaming ; aussi les informations 
d'identité s'affichent-elles au début du 
streaming.

Title/Artist/Album/Comment : Saisissez le titre, 
le nom de l'artiste et toute autre information 
concernant le fichier MP3. Un grand nombre de 
lecteurs MP3 affichent ces informations.

Genre : choisissez un genre décrivant le contenu 
du fichier. Cette information est lue par de 
nombreux lecteurs MP3 et peut apparaître dans 
des catalogues et des bases de données de 
recherche.

Track Number : avec l'identificateur ID3 v1.1 ou 
v2.3, vous pouvez indiquer un numéro de la 
plage du CD pour le fichier. Un grand nombre 
de lecteurs MP3 affichent ces informations.

Year : indiquez une année. Un grand nombre de 
lecteurs MP3 affichent ces informations.

Paramètres de fichier Mac

Options Type et Creator : si votre fichier est 
destiné à un ordinateur Mac, vous pouvez 
indiquer le type de fichier Mac et le nom du 
créateur. Il suffira ainsi de cliquer deux fois sur le 
fichier pour ouvrir le lecteur MP3.

Bouton Defaults

Pour restaurer tous les paramètres de cette zone 
de dialogue, cliquez sur Defaults.

Format

Il s'agit du format du fichier de prémixage. Vous 
pouvez choisir le format Mono (summed), 
Multiple mono ou Stereo Interleaved. 

Pour configurer le format du fichier prémixé :

" Choisissez un format de fichier dans le 
sélecteur de format.

Mono (summed) : un seul fichier de disque est 
créé, sommation mono des sources écoutées. 

Avant de procéder à un prémixage sur disque, 
vérifiez que vos niveaux sont inférieurs à -3 dB 
afin d'éviter l'écrêtage qui se produit lorsque les 
signaux droit et gauche dépassent -3 dB 
au-dessous du maximum, repère « pleine 
échelle » (0 dB FS).

Bien que ID3 v2.3 s'impose en tant que 
format MP3 standard, il n'est pas encore 
reconnu par tous les lecteurs MP3. 
Contactez le développeur du logiciel de votre 
lecteur pour en savoir plus sur sa 
compatibilité.

Boîte de dialogue Bounce (type de format de fichier)
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Multiple mono : Plusieurs fichiers mono sont 
créés, leur nombre étant identique à celui des 
canaux du chemin source. 

• Si la sortie ou le chemin de bus source est 
stéréo, deux fichiers mono sont créés, dont les 
noms reçoivent le suffixe « .L » ou « .R » à 
l'issue du prémixage. 

• En cas d'utilisation d'un format multicanal 
(par exemple, six canaux, 5.1), des fichiers 
mono séparés sont créés pour chaque membre 
du chemin. Les fichiers reçoivent des suffixes 
de chemin conformément à la définition de 
chemin entrée dans la zone de dialogue I/O 
Setup.

• Si la sortie source ou le chemin de bus est 
mono, le menu déroulant passe de multiple 
mono à mono, et un fichier mono est créé 
(pas de sommation de sources multiples).

Stereo Interleaved : cette option crée un fichier 
entrelacé unique, contenant tous les flux 
prémixés depuis le chemin de sortie choisi. Dans 
un prémixage stéréo entrelacé, les pistes 
affectées à des sorties impaires sont envoyées au 
canal gauche tandis que les pistes affectées à des 
sorties paires sont envoyées au canal droit.

Pro Tools permet également de prémixer des 
fichiers multicanaux entrelacés dans chaque 
type de fichier reconnu. Cette option simplifie 
la gestion des fichiers de mixages et de projets 
dans le cadre de sauvegardes ou d'archivages. 

Pro Tools ne prend pas en charge en natif le 
format de fichier entrelacé. Ces fichiers doivent 
donc être divisés en fichiers multimono lors de 
l'importation (ce qui nécessite un espace disque 
supplémentaire). 

Resolution :

Cette option permet de choisir parmi trois 
résolutions différentes pour la conversion de 
prémixage.

Le prémixage sur disque (Bounce to Disk) 
n'applique pas de dithering lors de la conversion 
à une résolution moins élevée, au cours d'un 
prémixage ou après (y compris en cas de 
prémixage sur 16 bits). Pour créer un fichier 
prémixé de résolution inférieure, insérez un 
plug in Dither ou un équivalent sur une piste de 
fader principal affectée au chemin source du 
prémixage. Cette opération applique un 
dithering au fichier de prémixage avant que la 
conversion, dans le cadre du Bounce to Disk, ne 
tronque les données pour l'obtention de la 
résolution définitive du fichier. Reportez-vous à 
la section Dithering et prémixage sur disque 
(Bounce), page 856.)

En matière de résolution, plusieurs options sont 
possibles :

8 bits : cette résolution est souvent utilisée pour 
les applications multimédia. Si les données 
audio sur lesquelles vous travaillez sont 
relativement simples, vous pouvez utiliser la 
fonction Squeezer de Pro Tools pour optimiser 
les résultats. Pour plus d'informations, consultez 
la section Qualité de conversion de la fréquence 
d'échantillonnage, page 866.

16 bits : il s'agit de la résolution standard des 
CD.

24 bits : Ce paramètre fournit la plus haute 
résolution. Il est utile pour la création d'un 
mixage final sans perte de résolution (par 
exemple, lorsque vous produisez un mixage 
final prêt à être masterisé).
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Si votre session est de 16 bits, vous devez 
appliquer un dithering car toutes les sessions 
Pro Tools effectuent des traitements internes à 
24 bits.

Pour définir la résolution du fichier prémixé :

" Choisissez une valeur de résolution dans le 
sélecteur de résolution.

Fréquence d'échantillonnage

Cette option permet de choisir, pour 
l'enregistrement, une fréquence 
d'échantillonnage quelconque parmi plusieurs. 
Les choix possibles dépendent du système 
Pro Tools et des interfaces audio Digidesign 
utilisées.

Qualité de conversion de fréquence 
d'échantillonnage

Si vous optez pour une valeur de fréquence 
d'échantillonnage différente de la fréquence 
d'échantillonnage originale de la session, les 
options de conversion deviennent accessibles. 
Vous pouvez configurer la qualité de la 
conversion et planifier son exécution au cours 
du prémixage ou après. Pour plus 
d'informations, reportez-vous à la section 
Qualité de conversion de la fréquence 
d'échantillonnage, page 866.

Vous trouverez ci-après les fréquences 
d'échantillonnage les plus courantes et leurs 
applications. Des fréquences d'échantillonnage 
plus élevées fourniront une meilleure fidélité 
sonore pour l'enregistrement et la lecture, mais 
également pour le traitement avec les plug-in de 
dynamique, de dithering (avec mise en forme du 
bruit) et d'émulation analogique.

192000 Cette fréquence d'échantillonnage est 
prise en charge pour certains DVD audio et 
permet d'obtenir la meilleure fidélité sonore 
possible sur les interfaces audio compatibles 
(interface 192 I/O, par exemple).

176400 Il est possible que vous souhaitiez 
travailler avec une fréquence d'échantillonnage 
de 176.4 kHz pour une fréquence du résultat 
final de 44,1 kHz (disques compacts, par 
exemple). Ceci permettra d'obtenir une 
conversion de fréquence d'échantillonnage de 
44,1 kHz un peu plus rapide qu'à partir de 
192 kHz.

96000 Cette fréquence d'échantillonnage est 
prise en charge pour les DVD audio et permet 
d'obtenir une fidélité sonore de haute qualité sur 
les interfaces audio compatibles (interfaces 
192 I/O, 96 I/O, 96i I/O et Digi 002 par 
exemple). 

88200 Il est possible que vous souhaitiez 
travailler avec une fréquence d'échantillonnage 
de 88,2 kHz pour une fréquence du résultat final 
de 44,1 kHz (disques compacts, par exemple). 
Ceci permettra d'obtenir une conversion de 
fréquence d'échantillonnage de 44,1 kHz un 
peu plus rapide qu'à partir de 96 kHz.

48000 C'est une fréquence d'échantillonnage 
standard pour la vidéo professionnelle et les 
DVD, ainsi que pour certains archivages 
d'étiquettes d'enregistrement et de diffusion. 
Elle est prise en charge par les appareils 
DA-88/98, DAT et ADAT.

44100 Cette fréquence d'échantillonnage 
standard pour les disques compacts (CD) est 
prise en charge par les machines DA-88/98, DAT 
et ADAT.
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Custom : pour obtenir une fréquence 
d'échantillonnage personnalisée, cliquez dans la 
fenêtre de la fréquence d'échantillonnage et 
entrez une valeur manuellement.

Fréquences Pull Up et Pull Down : toutes les 
fréquences d'échantillonnage disponibles 
prennent en charge les modes Pull-up et 
Pull-down, ou d'autres valeurs spécifiques. 

Qualité de conversion de la 
fréquence d'échantillonnage

Dès que vous modifiez la fréquence 
d'échantillonnage d'un fichier prémixé (par 
exemple, lors du mixage en 44,1 kHz d'une 
session enregistrée en 96 kHz, en vue d'une 
sortie sur CD audio), Pro Tools utilise l'option 
Conversion Quality pour déterminer la qualité 
de la conversion de fréquence d'échantillonnage 
utilisée. 

Il existe cinq paramètres, classés par ordre 
croissant (de Low à Tweak-Head). Plus cette 
qualité est élevée, plus la conversion du fichier 
prémixé est longue.

Use Squeezer :
(Résolution 8 bits uniquement)

L'option Use Squeezer repose sur un algorithme 
DSP exclusif spécialement conçu pour effectuer 
la conversion en 8 bits de fichiers source simples 
tels que des voix off de narrateurs. Elle optimise 
la dynamique sonore en retraitant les sons par 
compression, limitation et gating avant la 
conversion vers une résolution 8 bits. Il en 
résulte un signal apparemment plus fort, d'une 
intelligibilité améliorée. Si vous devez convertir 
un fichier audio 16 bits complexe vers une 
résolution 8 bits, commencez par tester cette 
option.

Conversion pendant ou après le 
prémixage

La zone de dialogue Bounce to Disk applique 
toutes les options de conversion, notamment la 
conversion de fréquence d'échantillonnage et de 
résolution, au cours du prémixage ou à la suite 
de l'opération. 

Les options suivantes sont disponibles 
uniquement lors de prémixages utilisant des 
résolutions, fréquences d'échantillonnage, types 
et formats de fichiers différents.

Convert During Bounce La rapidité de cette 
option par rapport à la conversion après le 
prémixage est acquise au détriment de la 
précision de lecture de l'automation des plug-in.

Convert After Bounce L'option Convert After 
Bounce, bien que plus lente, garantit un niveau 
inégalé de précision de l'automation des plug-in. 

Import Into Session After Bounce

L'option Import After Bounce importe 
automatiquement les nouveaux fichiers 
prémixés dans la liste des régions. Vous pouvez 
alors les placer dans des pistes. Si vos nouveaux 
fichiers prémixés sont des fichiers stéréos (mono 
multiples) divisés, ils apparaissent ensemble 
dans la liste des régions.

 L'option Import After Bounce n'est 
disponible que si le type de fichier cible et la 
fréquence d'échantillonnage du prémixage 
sont identiques au type de fichier et à la 
fréquence d'échantillonnage de la session en 
cours, et si la résolution cible (débit) est 
inférieure ou égale à la résolution de la 
session. En outre, les pistes prémixées en un 
fichier stéréo entrelacé (Stereo Interleaved) 
ne peuvent pas être automatiquement 
importées après un prémixage.
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Help

Le bouton Help ouvre une boîte de dialogue non 
modifiable décrivant les fonctions Bounce to 
Disk.

Enregistrement d'un 
prémixage (avec la 
commande Bounce to Disk)
Vous pouvez créer un prémixage à l'aide de la 
commande Bounce to Disk, en coupant le son 
des pistes ou en désactivant les inserts 
n'appartenant pas au prémixage, puis en 
sélectionnant la partie de la session à prémixer. 
Vous ne pouvez mettre en solo que les données 
audio que vous souhaitez prémixer.

Il est également possible de créer un prémixage 
en réalisant un enregistrement vers de nouvelles 
pistes. Pour en savoir plus, reportez-vous à 
Enregistrement sur des pistes, page 857.

Pour procéder à un prémixage sur disque et en 
intégrer le résultat dans la session :

1  Configurez votre prémixage à l'aide de 
départs, d'entrées auxiliaires et de pistes de fader 
principal. Reportez-vous à la section 
Acheminement de signal pour l'écoute et le 
prémixage, page 750.)

2  Effectuez l'une des opérations suivantes :

• Pour prémixer la session tout entière, 
cliquez sur Return to Zero dans la fenêtre 
Transport pour atteindre le début de la 
session. 

– ou –

• Pour prémixer une partie de la session, 
activez l'option > Link Timeline and Edit 
Selection, puis sélectionnez un élément 
dans la fenêtre Edit.

3  Sélectionnez File > Bounce to > Disk.

4  Configurez les options et les paramètres de 
prémixage. 

5  Assurez-vous que la résolution du fichier 
prémixé correspond à celle de la session.

6  Vérifiez que la fréquence d'échantillonnage du 
fichier prémixé est prise en charge par la session 
et par l'interface audio.

7  Si nécessaire, vérifiez que le type et le format 
de fichier pour le fichier prémixé correspondent 
au type et au format de fichier de la session.

8  Sélectionnez l'option Import After Bounce.

9  Cliquez sur Bounce.

10  Choisissez une destination pour le nouveau 
fichier audio, indiquez un nom, puis cliquez sur 
Save.

Les prémixages Pro Tools s'effectuent en temps 
réel, ce qui permet d'entendre la lecture audio 
du mixage au cours de l'opération. Il est 
impossible d'agir sur les commandes au cours 
d'une opération Bounce to Disk. 

Pour ramener les fichiers prémixés dans des 
pistes :

1  Effectuez l'une des opérations suivantes :

• Si les données audio qui viennent d'être 
prémixées ont été importées 
automatiquement dans la session, faites 
glisser les nouveaux fichiers de la liste des 
régions vers des pistes existantes de votre 
session.

Si vous prémixez depuis un point de 
sélection, vous pouvez aligner le fichier sur 
le point de prémixage : Faites glisser la 
région de la liste des régions vers la piste de 
destination en maintenant enfoncée la 
touche Ctrl (Mac) ou Démarrer (Windows).
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• Si les fichiers prémixés ne sont pas 
disponibles dans la liste des régions, 
importez-les dans la session en 
sélectionnant la commande Import Audio, 
ou en faisant glisser les fichiers prémixés et 
en les déposant depuis un navigateur 
DigiBase. 

• Si vous placez plusieurs fichiers, veillez à ce 
qu'ils soient alignés les uns sur les autres ; 
maintenez enfoncée la touche Maj pendant 
que vous les sélectionnez dans la liste des 
régions, puis faites-les glisser 
simultanément vers les pistes existantes du 
format qui convient. 

2  Si vous travaillez sur des pistes stéréo, réglez 
les panoramiques à l'extrême gauche et à 
l'extrême droite.

3  Mettez la piste contenant le prémixage en 
solo.

4  Cliquez sur Play dans la fenêtre Transport 
pour écouter le résultat du prémixage.

Mixage final
Au cours d'un mixage final, vous créez un 
mixage prenant en compte toutes les éditions, 
toutes les automations et tous les traitements 
d'effets spéciaux.

Pour enregistrer un mixage final sur un disque :

1  Réglez les volumes de sortie de piste, finalisez 
les automations de mixage éventuelles de 
chaque piste de la session.

2  Réglez tous les paramètres de plug-in en temps 
réel et d'effets ainsi que les données 
d'automation sur chacune des pistes de la 
session.

3  Assurez-vous que toutes les pistes à inclure 
dans le prémixage sont audibles (et non coupées 
(Mute) ou inactives).

4  Assignez la sortie de chaque piste à inclure 
dans le prémixage à un même chemin de sortie 
ou de bus.

5  Ajoutez du dithering. Pour plus 
d'informations, reportez-vous à la section 
Dithering et prémixage sur disque (Bounce), 
page 856.

6  Effectuez l'une des opérations suivantes :

• Pour prémixer la session tout entière, 
cliquez sur Return to Zero dans la fenêtre 
Transport pour atteindre le début de la 
session. 

– ou –

• Pour prémixer une partie de la session, 
activez l'option > Link Timeline and Edit 
Selection, puis sélectionnez un élément 
dans la fenêtre Edit.

7  Sélectionnez File > Bounce to > Disk.

8  Choisissez le chemin source à prémixer.

9  Configurez les autres paramètres de la boîte de 
dialogue Bounce to Disk. Pour plus 
d'informations, reportez-vous à la section 
Options de prémixage, page 860.

10  Cliquez sur Bounce.

11  Choisissez une destination pour le nouveau 
fichier audio, indiquez un nom, puis cliquez sur 
Save.

Par défaut, le prémixage s'arrête à la 
dernière forme d'onde audio ou à la dernière 
note MIDI. Pour arrêter le prémixage plus 
tôt, effectuez une sélection d'édition ou de 
temps pour définir la fin (et le début) du 
prémixage.
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Mastering
Le processus de mastering final consiste à 
enregistrer les données directement sur le 
disque, sur un enregistreur de DAT, de DVD ou 
de CD, une machine de mastering stéréo ou 
directement sur un enregistreur multipiste (dans 
le cas d'un mixage Surround).

Une fois le Master de votre session créé, vous 
pouvez le transférer sur un support portable en 
vue de le dupliquer. Il est également possible de 
transférer le fichier Master sur un CD ou une 
cassette DAT en vue de presser des CD.

Mastering vers un enregistreur 
numérique

Bien qu'il soit généralement préférable de 
« masteriser » les sessions directement sur le 
disque dur, Pro Tools permet de réaliser un 
mastering numérique vers tout enregistreur 
numérique équipé d'entrées AES/EBU ou S/PDIF, 
machine DAT par exemple.

entrées et sorties 24 bits

Les systèmes Pro Tools|HD prennent en charge 
les chemins d'entrée et de sortie audio 24 bits, 
avec traitement et mixage interne 48 bits, 
offrant 16 bits supplémentaires de marge de 
sécurité à l'extrémité supérieure de la plage 
dynamique d'un canal, et 8 bits à l'extrémité 
inférieure. Vous pouvez échanger des fichiers 
avec d'autre systèmes d'enregistrement à 24 bits 
sans avoir à convertir leur résolution tant qu'ils 
sont de format compatibles.

Les systèmes Pro Tools LE prennent en charge 
les entrées et sorties audio à 24 bits et utilisent 
les fonctions internes de mixage et de 
traitement des virgules flottantes à 32 bits. Vous 

pouvez échanger des fichiers avec d'autre 
systèmes d'enregistrement à 24 bits sans avoir à 
convertir leur résolution tant qu'ils sont de 
format compatibles.

Mastering et compression audio

Bien que la compression audio soit souvent un 
outil indispensable en enregistrement 
analogique, elle est parfois source de problèmes 
dans le domaine numérique. La compression 
d'un signal d'entrée à un taux très élevé résulte 
en un signal contenant une puissance totale 
extrêmement importante par rapport au niveau 
des transitoires. En enregistrant un certain 
nombre de ces signaux au niveau le plus élevé 
possible sur plusieurs pistes, vous vous trouvez 
dans une situation plus susceptible de 
provoquer des écrêtages dans le signal du 
mixage de sortie.

Le mixage de signaux très puissants après 
compression génère un niveau de sortie 
extrêmement élevé. Il est possible que ce signal 
de sortie s'élève au-dessus du niveau limite Full 
Scale, ce qui produit un écrêtage. 

Pour éviter ce problème, surveillez le niveau 
global de votre matériel : placez un vumètre sur 
une piste Master Fader ou utilisez le vumètre de 
l'enregistreur Master externe pour identifier 
l'écrêtage. Si le mastering s'effectue sur le disque 
dur, il est préférable de ne pas mixer ensemble, à 
gain unitaire (amplification de 0 dB) des signaux 
audio allant jusqu'au repère Full Scale, ce qui 
provoquerait systématiquement un écrêtage.
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Mastering et correction d'erreurs du 
support

Les supports à accès aléatoire (tels que les 
disques durs, les cartouches optiques, les 
cartouches de Bernoulli ou les lecteurs WORM) 
peuvent générer une copie numérique parfaite 
de vos données, car réalisée bit à bit, en 
respectant la valeur de chaque bit. Les supports 
séquentiels (par exemple, les bandes DAT) 
utilisent des algorithmes de correction d'erreurs 
afin de compenser les données erronées 
éventuellement reçues lors de transferts 
numériques. Ces corrections dévient légèrement 
par rapport aux données réelles ; aussi les 
générations successives de copie entraînent-elles 
une dégradation progressive.

Pour éviter ces dégradations, créez et conservez 
vos Masters sur des supports numériques à accès 
aléatoire (par exemple, un disque dur), et ne les 
transférez vers un support numérique séquentiel 
(cassette DAT par exemple) qu'en cas de besoin.

Pour configurer Pro Tools en vue d'un mastering 
numérique stéréo direct :

1  Connectez l'enregistreur numérique aux 
sorties numériques du système. Si votre système 
dispose de plusieurs sorties numériques, utilisez 
les canaux 1 et 2 de l'interface audio.

2  Dans Pro Tools, configurez le format et les 
sorties numériques appropriés depuis la boîte de 
dialogue Hardware Setup ou I/O Setup 
Reportez-vous à la section Configuration des 
paramètres matériels Pro Tools, page 47.)

3  Définissez l'horloge du périphérique principal 
en tant qu'esclave de l'horloge numérique de 
Pro Tools, ou pour fournir une horloge 
principale à Pro Tools. Reportez-vous à la 
section Configuration des paramètres matériels 
Pro Tools, page 47.)

4  Sur l'enregistreur numérique, sélectionnez le 
format numérique correspondant aux 
connexions.

5  Dans Pro Tools, affectez toutes les pistes audio 
souhaitées au chemin de sorties Master 1-2.

6  Cliquez sur Return to Zero dans la fenêtre 
Transport pour retourner au début de la session.

7  Appuyez sur Record sur votre enregistreur 
numérique.

8  Lancez la lecture de la session.

9  À la fin de la lecture, arrêtez l'enregistreur.
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Partie VIII : Vidéo, synchronisation et Surround



872



Chapitre 32 : Configuration de Pro Tools pour le mixage en mode Surround (Pro Tools HD uniquement) 873

Chapitre 32 : Configuration de 
Pro Tools pour le mixage en mode 
Surround (Pro Tools HD uniquement)

Ce chapitre explique comment configurer des 
sessions Pro Tools pour le mixage multicanal. 

Le mixage multicanal n'est pris en charge que 
dans Pro Tools|HD. Dans ce chapitre, toute 
référence à Pro Tools désigne les systèmes 
Pro Tools|HD. 

Connexions audio de 
Pro Tools pour le mixage au 
format 5.1
Même si tous les formats de mixage 5.1 
prévoient une disposition des haut-parleurs 
identique, trois standards principaux régissent 
la disposition des différents canaux constituant 
le mixage multicanal au format 5.1 sur les pistes. 

Dans le tableau suivant, nous partons du 
principe que les canaux Surround sont affectés 
aux sorties 1 à 6 d'une interface audio Pro Tools. 
Utilisez les canaux 7 et 8 pour l'écoute des 
mixages stéréo destinés à une version stéréo ou 
pour les mixages de retours ou casques. 

Pour connecter vos interfaces audio en vue d'un 
mixage et d'une écoute au format 5.1 :

1  Déterminez le format 5.1 et la disposition des 
pistes à appliquer. 

2  Connectez les canaux de sortie de votre 
interface audio aux canaux d'entrée 
correspondants de votre système d'écoute, 
conformément aux affectations du tableau 33, 
page 873.

Pour obtenir des informations à propos des 
concepts fondamentaux du surround, 
consultez le guide Pro Tools Sync & 
Surround Concepts.

Tableau 33. Disposition des pistes pour les formats 5.1

Formats Disposition des pistes

1 2 3 4 5 6

Film (Pro Tools 
par défaut)

G C D Ls Rs LFE

SMPTE/ITU 
pour Dolby 

Digital (AC3) et 
Control|24

G D C LFE Ls Rs

DTS avec 
ProControl

G D Ls Rs C LFE

Si vous utilisez une surface de contrôle 
Digidesign, consultez le guide qui 
l'accompagne pour plus d'informations.
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Configuration de Pro Tools 
pour les sessions 
multicanaux
Il existe plusieurs méthodes permettant de 
configurer Pro Tools et les sessions pour le 
mixage multicanal :

Nouvelles sessions

Vous pouvez créer une session et choisir un 
fichier de paramètres d'E/S de mixage Surround 
comme configuration d'E/S par défaut. Pour plus 
d'informations, reportez-vous à la section 
Nouvelles sessions et nouveaux paramètres 
d'E/S, page 874. 

Remixage de sessions en Surround 
(Importation de paramètres d'E/S 
multicanaux)

En créant ou important un fichier de paramètres 
d'E/S de mixage Surround dans la boîte de 
dialogue I/O Setup, il est possible de disposer de 
chemins multicanaux dans n'importe quelle 
session stéréo (ou d'un autre format). Vous 
pouvez ensuite réassigner les pistes des chemins 
stéréo originaux à ces chemins multicanaux. Les 
chemins actifs et inactifs simplifient la 
réassignation Pour plus d'informations, 
reportez-vous à la section Importation de 
configurations d'E/S multicanaux, page 876.

Chemins multicanaux personnalisés

Vous pouvez personnaliser et redéfinir des 
chemins existants dans la boîte de dialogue 
I/O Setup. Pour plus d'informations, 
reportez-vous à la section Chemins multicanaux 
personnalisés, page 877. 

Importation de données de session

La commande Import Session Data (File > 
Import > Session Data) permet d'importer non 
seulement les pistes et les médias, mais 
également les chemins et les affectations de 
piste associés. Après avoir importé les données 
de session, utilisez la boîte de dialogue I/O Setup 
pour configurer les chemins et les sous-chemins 
requis par la session. Pour plus d'informations, 
consultez la section chapitre 6, Configuration 
des E/S.

Nouvelles sessions et nouveaux 
paramètres d'E/S

Lors de la création d'une nouvelle session, vous 
pouvez choisir le format surround à utiliser 
comme configuration d'E/S par défaut. Des 
configurations de chemin par défaut sont 
fournies sous forme de fichiers de configuration 
d'E/S, pour des mixage stéréo et surround. 

Une fois que vous avez créé une session, vous 
pouvez créer et importer des pistes, des données 
audio, et gérer les assignations du signal afin de 
construire votre mixage. 

Le plug-in Surround Mixer doit être installé 
dans le dossier Plug-ins pour que les options 
multicanaux soient visibles dans Pro Tools. 
Vous pouvez installer ce plug-in avec 
Pro Tools (reportez-vous au Guide de 
démarrage). S'il n'est pas installé, vous 
pouvez le déplacer du dossier Plug-ins 
(Unused) au dossier Plug-ins.
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Pour créer une session pour un mixage 
multicanal :

1  Sélectionnez File > New Session.

2  Sélectionnez un des paramètres 5.1 
disponibles à partir du menu I/O Settings (Film, 
SMPTE/ITU ou DTS/ProControl Monitoring).

3  Si besoin est, modifiez d'autres paramètres 
dans la section Session Parameters.

4  Nommez la session.

5  Cliquez sur Save.

Les présélections surround préconfigurent la 
boîte de dialogue I/O Setup pour la nouvelle 
session avec un chemin et des sous-chemins au 
format 5.1 par défaut pour les sorties et les bus.

Fichiers de paramètres de mixage 
surround

Les paramètres d'E/S fournissent les chemins de 
sortie et de bus pour trois standards de 
dispositions de pistes spécifiques dans la 
nouvelle session. Pour obtenir des informations 
sur les entrées et les chemins d'insertion, 
reportez-vous à la section Chemins d'entrée et 
d'insert par défaut avec les paramètres de mixage 
5.1, page 876. 

Les trois paramètres 5.1 de format d'E/S (Film, 
SMPTE/ITU et DTS/ProControl Monitoring) 
fournissent par défaut la sortie et les chemins de 
bus suivants pour la nouvelle session :

Configuration d'une nouvelle session pour un mix 5.1

Chemins de sortie au format 5.1 (film) standard

Fichiers de paramètres et disposition des pistes

Paramètres 5.1
Disposition des 
pistes

Film (standard Pro Tools) L C R Ls Rs LFE

SMPTE/ITU (Monitoring de 
Control|24)

L R C LFE Ls Rs

DTS (Ecoute ProControl) L R Ls Rs C LFE
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Chemins de sortie 5.1 par défaut

• Un chemin de sortie 5.1 principal et des 
sous-chemins 5.0 (pas de LFR), 
gauche/droit (stéréo), LCR et central 
(mono). 

– et –

• Un chemin stéréo principal et deux 
sous-chemins mono.

Chemins de bus 5.1 par défaut

• Un chemin de bus 5.1 principal et des 
.sous-chemins 5.0 (pas de LFE) pour les bus 
central, gauche/droit (stéréo), LCR et 
central (mono) 

– et –

• Un chemin stéréo principal et deux 
sous-chemins mono.

Chemins d'entrée et d'insert par défaut avec 
les paramètres de mixage 5.1

Les fichiers de paramètres de mixage 5.1 
proposent par défaut des chemins d'entrée 
principaux et des sous-chemins mono pour les 
entrées et les inserts. Le cas échéant, vous 
pouvez créer des chemins multicanaux d'entrée 
ou d'insert dans la boîte de dialogue I/O Setup 
(voir Chemins multicanaux personnalisés, 
page 877) 

Importation de 
configurations d'E/S multicanaux

La boîte de dialogue I/O Setup permet d'impor-
ter et d'exporter des fichiers de paramètres. L'im-
portation des fichiers de paramètres d'E/S sert 
notamment au remixage d'une session stéréo en 
mode surround. Vous pouvez également recou-
rir à cette fonctionnalité pour préparer une ses-
sion à un transfert sur un autre système 
Pro Tools, ou simplement pour sauvegarder et 
échanger les paramètres d'E/S. 

Pour importer un fichier de paramètres d'E/S 
multicanaux :

1  Choisissez Setup > I/O.

2  Cliquez sur Import Settings.

3  Sélectionnez le fichier de paramètres à 
importer et cliquez sur Open.

4  Si des chemins ont déjà été définis pour la 
session en cours et qu'ils ne correspondent pas à 
ceux du fichier de paramètres importé, Pro Tools 
vous demande si vous souhaitez supprimer les 
chemins existants ou les conserver et ajouter les 
paramètres importés à votre session. 

• Cliquez sur No pour ajouter les nouveaux 
chemins à votre configuration actuelle des 
E/S.

• Cliquez sur Yes pour remplacer la 
configuration d'E/S actuelle par les paramètres 
importés. 

5  Cliquez sur OK pour fermer I/O Setup.

Exportation de paramètres d'E/S

L'exportation de fichiers de paramètres d'E/S 
permet de constituer une bibliothèque de 
configurations multicanaux pour différents 
projets. 

Pour exporter un fichier de paramètres d'E/S 
multicanaux :

1  Choisissez Setup > I/O.

2  Cliquez sur Export Settings.

3  Attribuez un nom au fichier de paramètres 
d'E/S actuel et enregistrez-le.
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Chemins multicanaux 
personnalisés

La boîte de dialogue I/O Setup permet de créer et 
de personnaliser des chemins de signaux pour 
tout format de mixage multicanal pris en 
charge. 

Les chemins et les sous-chemins multicanaux 
sont affectés à des entrées, des sorties ou des bus 
internes par l'intermédiaire de la grille des 
canaux. Lorsque vous sélectionnez un fichier de 
paramètres d'E/S 5.1 prédéfini, la répartition par 
défaut des chemins multicanaux ainsi créés 
correspond à celle des pistes du format 
sélectionné. 

La boîte de dialogue I/O Setup, comme l'onglet 
Main de la boîte de dialogue Hardware Setup, 
contient des commandes de routage des ports 
d'entrée et de sortie physiques du périphérique 
d'E/S vers les ports d'entrée et de sortie 
Pro Tools.

Réaffectation de canaux

La boîte de dialogue I/O Setup et sa grille de 
canaux permettent de réaffecter les canaux. 
Cette fonctionnalité est particulièrement utile 
pour modifier l'assignation des canaux à 
l'intérieur d'un chemin multicanal sans avoir à 
modifier les connexions au niveau des interfaces 
audio.

Vous pouvez réaffecter les chemins à n'importe 
quelle configuration selon les besoins. Les seules 
limites sont celles des ressources de votre 
système, ainsi que les conditions requises par la 
boîte de dialogue I/O Setup pour le 
chevauchement des canaux et l'attribution de 
noms (voir Chemins valides et conditions, 
page 66pour plus de détails).

Exemple de configuration LCRS

L'exemple ci-après montre une des méthodes de 
configuration de la boîte de dialogue I/O Setup 
pour un mixage au format LCRS 4 canaux, avec 
une interface 96 I/O.

Pour définir un chemin LCRS :

1  Sélectionnez Setup > I/O et cliquez sur l'onglet 
Output. 

2  Cliquez sur New Path.

3  Choisissez LCRS dans le sélecteur de format de 
chemin.

4  Nommez le chemin LCRS.

Lorsque vous créez des chemins au format 
5.1, vous pouvez spécifier la disposition par 
défaut des pistes. Pour plus d'informations, 
reportez-vous à la section Ordre 
d'acheminement par défaut des pistes au 
format 5.1, page 879. 

Voir également Exemples de chemins et 
d'assignations du signal pour un mixage 
Surround, page 891. 

Exemple de chemins principal et de sous-chemins LCRS

Pour en savoir plus sur la configuration des 
E/S, reportez-vous à la section Création et 
modification de chemins, page 60. 



Guide de référence Pro Tools878

5  Dans la grille des canaux, cochez la case située 
en dessous du premier canal d'interface audio (à 
l'extrêmité gauche) du chemin. Pro Tools 
remplit automatiquement les cases adjacentes 
sur la droite. Si vous cliquez sur la ligne LCRS 
sous le canal 1, le chemin LCRS sera réparti sur 
les canaux 1 à 4.

6  Sélectionnez le nouveau chemin LCRS et 
cliquez sur New Sub-Path.

7  Nommez le nouveau sous-chemin LCR et 
sélectionnez LCR comme format de chemin. 
Cliquez sur le canal 1, sur la ligne LCR, pour 
affecter le chemin.

8  Sélectionnez le chemin LCRS, cliquez sur New 
Sub-Path et créez un sous-chemin stéréo (un 
pour l'avant gauche et un pour l'avant droite).

9  Sélectionnez le chemin LCRS, cliquez sur New 
Sub-Path et créez un sous-chemin mono (pour le 
canal du milieu). 

10  Sélectionnez le chemin LCRS, cliquez sur 
New Sub-Path et créez un sous-chemin mono 
(pour le canal du milieu).

11  Cliquez sur OK pour fermer I/O Setup.

Pistes, format, affectation et mesures 
du format 5.1

Les définitions de chemin de la boîte de 
dialogue I/O Setup déterminent comment les 
données audio sont routées vers les interfaces 
audio, et leur niveau mesuré sur celles-ci.

Les fonctions internes de visualisation à l'écran 
des niveaux des chemins en format 5.1 dans 
Pro Tools adoptent toujours la disposition des 
pistes Film :

L C R Ls Rs LFE

La disposition des pistes audio au format 5.1 
dans la fenêtre Edit de Pro Tools adopte 
également la disposition Film (de haut en bas). 
Examinez l'illustration Disposition des pistes, 
acheminement et mesures au format 5.1, 
page 880.

Dans la boîte de dialogue I/O Setup, vous 
pouvez récupérer ces signaux en sortie des 
interfaces audio, en adoptant n'importe quelle 
disposition de pistes (DTS, SMPTE/ITU ou 
autre). 

Pour réaffecter des canaux dans un chemin :

" Faites glisser un canal vers un nouvel 
emplacement valide de la grille. Les autres 
affectations de canaux se décalent en 
conséquence.

Sélecteurs par défaut dans la 
boîte de dialogue I/O Setup
L'onglet Output de la boîte de dialogue 
I/O Setup contient des sélecteurs permettant de 
définir les paramètres par défaut d'E/S pour les 
sessions multicanaux.

Sélecteurs par défaut de la boîte de dialogue I/O Setup

Ordre des chemins par défaut Options de configuration d'E/S
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Default Path Order : sélectionne la disposition 
(ou l'ordre d'acheminement) par défaut pour les 
nouveaux chemins (six voies) au format 5.1.

Controller Meter Path : sélectionne le chemin 
dont le niveau sera affiché dans les vumètres de 
sortie de la surface de contrôle Digidesign. Pour 
plus d'informations, reportez-vous à la section 
Pistes, format, affectation et mesures du format 
5.1, page 878.

Audition Paths : sélectionne le chemin d'écoute 
pour la pré-écoute audio dans les boîtes de 
dialogue Regions List, Import Audio et dans 
Digibase. Seules les sorties de l'interface 
principale peuvent être utilisées comme chemin 
d'écoute.

New Track Default Output : sélectionne le 
chemin de sortie par défaut pour toutes les 
nouvelles pistes, pour chaque format pris en 
charge. 

AFL/PFL Path : sélectionne l'emplacement 
auquel les pistes sont assignées lorsqu'elles sont 
écoutées en mode Solo AFL (After Fader Listen) 
ou PFL (Pre Fader Listen).

AFL/PFL Mutes (Output Path) : sélectionne la 
sortie coupée en cas d'activation du mode Solo 
AFL (After Fader Listen) ou PFL (Pre Fader Listen) 
et de l'écoute d'une piste en solo.

Ordre d'acheminement par défaut 
des pistes au format 5.1

Il est possible de spécifier la disposition par 
défaut des pistes pour tous les nouveaux 
chemins de format 5.1 que vous créez. 

Pour choisir un nouvel ordre d'acheminement 
5.1(disposition des pistes) :

1  Choisissez Setup > I/O.

2  Cliquez sur l'onglet Output.

3  Choisissez la disposition des pistes dans les 
sous-menus du menu Default Path Order. 

Le paramètre New Track Default Output 
peut être défini aussi bien pour des chemins 
de bus que pour des chemins de sortie.

Sélecteur d'ordre d'acheminement par défaut dans la 
boîte de dialogue I/O Setup
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Disposition des pistes, acheminement et mesures au 
format 5.1

Figure 38.  Disposition des pistes dans les différents formats 5.1

Affectation des canaux dans I/O SetupFormat 5.1

 

 

L C R Ls Rs LFE

Compteurs de pistesPistes

idem
L C R Ls Rs LFE

L C R Ls Rs LFE

L R C LFE Ls Rs

L R Ls Rs C LFE

Film
(standard Pro Tools) 
L C R Ls Rs LFE

SMPTE/ITU
(Ecoute Control|24)
L R C LFE Ls Rs

DTS
(Monitoring ProControl)
L R Ls Rs C LFE

idem
L C R Ls Rs LFE

idem
L C R Ls Rs LFE
(haut en bas)

idem
L C R Ls Rs LFE
(gauche à droite)
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Chapitre 33 : Pistes multicanaux et 
assignation des signaux (Pro Tools HD 
uniquement)

Les sessions Surround combinent généralement 
des pistes audio mono, stéréo et multicanaux, 
des entrées auxiliaires, des faders principaux, des 
pistes d'instrument, des bus et des inserts.

Une fois la configuration d'E/S adéquate 
importée ou définie, il est possible de mixer les 
pistes audio, d'entrée auxiliaire, de master 
principal et d'instrument en multicanal 
Surround grâce aux fonctions de mixage de 
Pro Tools. 

La configuration des E/S et l'affectation des 
signaux multicanaux sont déterminées par les 
chemins définis dans la boîte de dialogue 
I/O Setup.

Le mixage multicanal n'est pris en charge que 
par les systèmes Pro Tools|HD, et uniquement si 
le plug-in Surround Mixer est installé dans votre 
dossier Plug-ins. Dans ce chapitre, toute 
référence à Pro Tools désigne les systèmes 
Pro Tools|HD. 

Démarrage rapide de pistes 
multicanaux
La section suivante est une introduction au 
mixage multicanal Surround dans Pro Tools. 

Pour effectuer un mixage en multicanal :

1  Ouvrez une session Pro Tools stéréo pour la 
remixer en mode Surround. (Vous pouvez 
également créer des sessions vides en mode 
Surround. voir Nouvelles sessions et nouveaux 
paramètres d'E/S, page 874.)

2  Configurez les entrées, les sorties, les bus et les 
inserts multicanaux dans la boîte de dialogue 
I/O Setup, selon vos besoins en suivant la 
procédure indiquée à la section Configuration 
de Pro Tools pour les sessions multicanaux, 
page 874.
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3  Effectuez l'une des opérations suivantes :

• Créez des pistes et affectez des sorties de 
piste et des départs aux chemins 
multicanaux. Configurez l'assignation des 
signaux pour le prémixage, l'envoi sur les 
bus, le traitement et l'écoute. Si certaines 
pistes ne doivent pas être soumises à un 
panoramique sur 360°, placez-les dans le 
mixage en utilisant des sous-chemins et les 
assignations de signaux. Voir Assignation 
du signal multicanal, page 885. 

• Utilisez la commande Import Audio (File > 
Import > Audio) pour importer des fichiers 
audio multicanaux.

• Utilisez la commande Import Session Data 
(File > Import > Session Data) pour 
importer des pistes 5.1, des bus et autres 
données existantes. Voir Importation de 
pistes et de leurs attributs, page 255.

• Glissez et déposez des fichier audio 
multicanaux à partir des navigateurs 
DigiBase, de l'Explorateur Windows ou du 
Finder Mac.

4  Ajustez le panoramique Surround depuis les 
fenêtres des sorties de pistes et de départs 
multicanaux. Reportez-vous au chapitre 34, 
Panoramique et mixage en mode Surround 
(Pro Tools HD uniquement) pour obtenir des 
informations sur le mixage et l'application d'un 
panoramique pour le son Surround.

Pistes audio multicanaux
Les pistes audio multicanaux contiennent 
plusieurs signaux pour chaque canal de la piste ; 
ainsi, une piste au format 5.1 doit avoir six 
signaux : un pour la gauche, un pour le centre, 
un pour la droite, un pour la gauche surround, 
un pour la droite surround et un pour le LFE. 

Les pistes audio multicanaux peuvent être :

• enregistrées directement dans Pro Tools, les 
signaux provenant de plusieurs microphones 
ou de dispositifs microphoniques étant 
acheminés vers les chemins d'entrée 
multicanaux appropriés de Pro Tools ;

• importés d'autres sessions Pro Tools ;

• édités, traités et mixés en combinaison avec 
des pistes mono et stéréo.

Les fichiers audio et les pistes au format 5.1 
adoptent la disposition Film standard. Quelle 
que soit l'affectation des chemins dans la boîte 
de dialogue I/O Setup, toutes les pistes audio et 
tous les vumètres au format 5.1 se conforment à 
la disposition de pistes du standard Film :

L C R Ls Rs LFE

Les pistes audio multicanaux ne doivent pas 
nécessairement être mixées dans les formats 
multicanaux. Ces pistes peuvent être mono, 
stéréo ou de tout autre format reconnu et leur 
mixage s'effectue en utilisant les sorties de pistes 
et les départs de Pro Tools. Pour plus 
d'informations, reportez-vous à la section 
Assignation du signal multicanal, page 885.

Piste audio multicanal au format 5.1
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Placement des données audio sur 
les pistes multicanaux

Pour placer des fichiers audio et des régions sur 
des pistes audio multicanaux, il suffit de les faire 
glisser depuis des navigateurs DigiBase, la liste 
des régions, l'Explorateur Windows, le Finder 
Mac ou d'autres pistes.

Pour ce faire, le nombre de canaux déplacés doit 
correspondre au format de la piste de 
destination. Vous ne pouvez faire glisser qu'une 
paire stéréo ou deux régions mono sur une piste 
audio stéréo, par exemple. De même, vous ne 
pouvez placer de données audio sur une piste 
LCR que lorsque vous avez sélectionné trois 
régions. Dans le cas de pistes au format 5.1, vous 
devez sélectionner six fichiers ou régions mono. 

Solo, Mute et Gain sur les pistes et les 
chemins multicanaux

Les pistes stéréo et multicanaux sont composées 
de plusieurs signaux audio reliés. Par défaut, ces 
pistes multicanaux peuvent être entièrement 
contrôlées par un seul fader de voie et par les 
touches Solo et Mute. 

Si vous souhaitez contrôler séparément les 
signaux d'une piste multicanal, convertissez-la 
en pistes mono séparées (« discrètes »). 
Pour pouvoir régler séparément le niveau et la 
phase, il faut insérer, puis désolidariser, un 
plug-in Trim multimono. Ces deux étapes sont 
expliquées ci-après.

Pour convertir une piste multicanal en pistes mono 
séparées :

1  Sélectionnez la piste multicanal.

2  Choisissez Track > Split Into Mono. 

Pour contrôler séparément le gain sur les canaux 
distincts d'une piste multicanal : 

1  Insérez un plug-in Trim multimono dans la 
piste multicanal.

2  Désolidarisez le plug-in Trim en cliquant sur 
l'icône Link, qui doit alors s'éteindre. 

3  Utilisez le sélecteur de voie pour afficher les 
contrôles pour un canal et pour régler le gain. 

Quand vous faites glisser des fichiers audio 
vers une piste multicanal, ils sont placés de 
haut en bas, selon l'ordre précis où ils 
apparaissent dans la liste de régions ou la 
playlist dont ils proviennent. Aussi, vous 
devez veiller à ce qu'ils soient agencés dans 
l'ordre voulu au sein de la liste des régions 
avant de les faire glisser. Renommez ces 
fichiers afin qu'ils soient triés dans l'ordre 
voulu lors d'un tri par nom de région dans 
la liste des régions. Pour une piste au format 
5.1 par exemple, arrangez les pistes de sorte 
qu'elles correspondent à L, C, R, Ls, Rs et 
LFE.

Une fois les pistes multicanaux converties 
en mono, leur format multicanal d'origine 
ne peut plus être rétabli. Cependant, vous 
pouvez « réassembler » une piste 
multicanal en faisant glisser le nombre de 
fichiers mono possédant le suffixe approprié 
sur une piste multicanal ; des données 
d'automation risquent toutefois d'être 
perdues au cours de cette opération. 
Vous pouvez également enregistrer le 
prémixage des pistes mono sur une piste 
multicanal du disque.

Pour plus d'informations, reportez-vous à la 
section Liaison et dissociation des 
commandes sur les plug-in multimono, 
page 887. 
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Formats de piste et de sortie

Lorsque vous créez des pistes, spécifiez le format 
mono, stéréo ou tout autre format multicanal 
pris en charge. 

Dans les fenêtres Mix et Edit, le format d'une 
piste transparaît toujours, d'après le nombre de 
vumètres de pistes apparaissant dans sa voie de 
console (un seul pour les pistes mono, une paire 
pour les pistes stéréo, et six pour les pistes 5.1).

L'affectation de la sortie d'une piste détermine le 
format de cette sortie. Une piste mono, par 
exemple, comporte toujours un seul vumètre de 
piste, même lorsqu'elle est affectée à un chemin 
de sortie stéréo. Si cette même piste mono est 
affectée à un chemin de sortie au format 5.1, sa 
sortie sera répartie sur ces six canaux de sortie, 
en fonction de la position du panoramique. 

Changement de format

Changer de format de sortie pour une piste 
donnée a plusieurs effets :

• Le panoramique qui apparaît sur la piste 
s'adapte au nouveau format de sortie.

• Il peut être nécessaire de créer ou de 
supprimer une ou plusieurs playlists 
d'automation associées.

En raison des effets d'un changement de format 
de sortie, une boîte de dialogue d'avertissement 
apparaît à chaque fois que vous passez à un 
format de sortie comportant un moins grand 
nombre de canaux. Plus précisément, c'est ce qui 
se produit à chaque fois que des playlists 
d'automation doivent être supprimées.

Affectations de sorties multiples et format des 
pistes

Lorsqu'une piste est affectée à plus d'un chemin, 
avec des formats différents, sa sortie principale 
correspond au format du chemin affecté qui 
comporte le plus grand nombre de canaux.

Sorties multiples et playlists d'automation

Lorsqu'une piste comporte plusieurs affectations 
de sortie, Pro Tools trie les données de 
panoramique en fonction de chaque chemin 
affecté. Si vous affectez une piste mono 
simultanément à un chemin stéréo et à un 
chemin au format 5.1, par exemple, cette piste 
disposera d'un panoramique 5.1 dans la fenêtre 
Mix ou Edit. Lorsque vous effectuez un 
panoramique sur la piste, Pro Tools interprète 
les déplacements panoramiques 5.1 comme des 
déplacements panoramiques stéréo. 

Cela permet de disposer d'une forme de mixage 
en parallèle. Vous pouvez ainsi créer 
simultanément plusieurs mixages de formats 
différents en envoyant vos éléments vers 
plusieurs chemins. 

Maintenez les touches Ctrl+Démarrer 
(Windows) ou Pomme+Ctrl (Mac) 
enfoncées pendant que vous cliquez sur une 
commande d'une fenêtre Output pour 
afficher sa playlist d'automation et 
visualiser toute automation de 
panoramique. 
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Assignation du signal 
multicanal
Pour effectuer un mixage dans un format 
multicanal, les pistes sont affectées à des 
chemins multicanaux. 

Pour mixer les pistes en Surround, les deux 
méthodes suivantes sont applicables :

• affectation d'une sortie principale de piste à 
un chemin multicanal ; 

• affectation d'un départ multicanal pour 
acheminer les données audio vers un chemin 
multicanal. 

Sorties de pistes multicanaux

Les pistes peuvent être acheminées vers des 
chemins de bus ou de sortie multicanaux via le 
sélecteur de chemin de sortie. Vous disposez 
ainsi d'un panoramique et d'un vumètre 
multicanaux dans la vue I/O des fenêtres Mix et 
Edit. 

Il est possible d'ajouter d'autres affectations de 
sortie en maintenant la touche Démarrer 
(Windows) ou Ctrl (Mac) enfoncée pendant que 
vous cliquez sur le sélecteur pour affecter un 
autre chemin. 

Départs multicanaux

Tous les formats, qu'ils soient mono ou stéréo, 
permettent d'affecter un ou plusieurs départs 
multicanaux. Vous disposez ainsi d'un 
panoramique multicanal dans la vue Sends. Les 
départs sont également utiles pour rassembler 
des signaux de pistes en vue du traitement par 
un plug-in multicanal. 

La figure 39 ci-dessous représente une piste 
audio mono avec un départ 5.1 (6 canaux) 
(Sends View Shows > Send A View).

Il existe deux méthodes de configuration des pistes 
pour le mixage multicanal.

Ce chemin de sortie du 
canal est multicanal. La 
piste est donc dotée d'un 
panoramique multicanal. 

Le chemin de sortie 
principal de ce canal est 
mono (« Centermusic »). 
Il comporte un départ 
multicanal offrant un 
panoramique multicanal
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Les fonctions de routage par bus et de prémixage 
de Pro Tools sont disponibles pour tous les 
formats de voies, de mono/stéréo jusqu'au 
format 8 canaux. Des exemples d'écoute 
multicanal, de traitement par effets et de 
routage par bus sont donnés dans la section 
Mixage par l'intermédiaire de chemins et 
sous-chemins, page 888. Des exemples de 
mixages mono et stéréo sont donnés au 
chapitre 28, Mixage : principes de base.

Entrées auxiliaires multicanaux et 
faders principaux

Le bus multicanal revient dans la console sur 
une entrée auxiliaire multicanal ou un fader 
principal.Les départs sont utiles lorsque vous 
devez créer simultanément un autre mixage 
indépendant (par exemple, dans un format 
distinct), ce qui nécessite des contrôles de fader, 
de Mute, de Solo et d'automation dédiés.

Vous pouvez attribuer des faders principaux aux 
chemins principaux et aux sous-chemins. Les 
chemins principaux doivent correspondre au 
format du fader principal, et un seul fader 
principal peut être actif et affecté à un chemin 
principal (actif) ou sous-chemin à la fois. Il n'est 
pas possible d'affecter un fader principal à un 
sous-chemin si son chemin principal associé est 
déjà assigné à un autre fader principal. Pour plus 
d'informations, reportez-vous à la section Pistes 
de fader principal, page 724. 

Pistes d'instrument multicanaux

Vous pouvez utiliser les pistes multicanaux pour 
l'écoute et l'assignation des plug-in d'instrument 
multicanaux ou des instruments MIDI externes 
multicanaux.

Figure 39.  Piste mono de format de sortie mono avec 
départ multicanal

Panoramique de départ multicanal

Vumètre mono

Format de sortie 
mono
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Plug-in mono, multimono et 
multicanaux

Vous pouvez utiliser les plug-in dans les formats 
mono, multimono ou multicanaux.

Pour en savoir plus sur les plug-in mono, stéréo, 
et entrée mono/sortie stéréo, reportez-vous au 
chapitre 29, Inserts de plug-in et inserts 
matériels

Plug-in multimono : ils sont conçus pour des 
pistes multicanaux au format stéréo ou 
supérieur. Les plug-in multimono sont utiles, 
voire obligatoires, dans les situations suivantes : 

• lorsque le plug-in ne nécessite pas de 
corrélation des canaux (égalisation des 
canaux d'un signal multicanal, par exemple) ;

• lorsque vous devez intervenir séparément sur 
chaque signal formant une piste multicanal ;

• lorsqu'un plug-in ne prend pas en charge les 
formats multicanaux.

Lors de la première insertion d'un plug-in 
multimono dans une piste multicanal, ses 
commande sont couplées. Vous pouvez les 
désolidariser pour les régler individuellement. 
Pour plus d'informations, reportez-vous à la 
section Liaison et dissociation des commandes 
sur les plug-in multimono, page 887.

Les plug-in multimono peuvent également être 
insérés dans les pistes stéréo, afin d'appliquer 
des plug-in indépendants aux canaux droit et 
gauche.

Plug-in multicanaux : ils sont conçus pour être 
utilisés sur les pistes stéréo et multicanaux 
nécessitant un traitement corrélé, tel que la 
limitation stéréo et multicanal, la compression 
et autres effets similaires. 

Liaison et dissociation des commandes 
sur les plug-in multimono

Lorsqu'un plug-in multimono est appliqué à 
une piste multicanal comportant plus de deux 
canaux, les commandes sont généralement 
couplées. Le réglage de la commande Gain sur 
un canal, par exemple, est étendu à tous les 
autres canaux.

Si nécessaire, vous pouvez dissocier les 
commandes de plug-in sur des canaux 
spécifiques d'une piste et les modifier 
indépendamment. Vous pouvez également lier 
les commandes de manière sélective sur certains 
canaux seulement. 

Par exemple, pour appliquer des fréquences de 
coupure identiques sur les canaux (surround) Ls 
et Rs d'un mixage au format 5.1, vous pouvez 
activer l'option Link Enable uniquement pour 
les canaux d'un plug-in EQ multimono 
désolidarisé. Le réglage des contrôles de la 
fenêtre Plug-In sur l'un des canaux (Ls ou Rs) 
s'applique simultanément à l'autre canal couplé. 

Formats de plug-in

Sélecteur de canal et commandes de liaison

Sélecteur de canal

Boutons Link Enable

Bouton Master Link
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Sélecteur de canal : permet d'accéder au canal 
spécifique d'une piste multicanal afin de 
modifier les paramètres du plug-in. Ce menu 
apparaît uniquement sur les plug-in multimono 
insérés sur des pistes comportant plus de deux 
canaux. 

Bouton Master Link : lie les commandes de tous 
les canaux d'un plug-in multimono, afin de 
pouvoir les régler par paire.

Boutons Link Enable : assure une liaison 
sélective des commandes sur des canaux 
spécifiques d'un plug-in multimono. Chaque 
carré représente un canal de haut-parleur. 
Désactivez le bouton Master Link avant d'utiliser 
les boutons Link Enable. 

Pour dissocier les commandes d'un plug-in 
multimono :

" Désélectionnez le bouton Master Link. Il est 
allumé lorsque le couplage est activé, éteint dans 
le cas contraire.

Pour accéder aux commandes d'un canal 
particulier :

" Sélectionnez le canal dans le sélecteur 
correspondant.

Pour ouvrir une fenêtre de plug-In pour tous les 
canaux d'un plug-in multimono :

" Maintenez la touche Option (Mac) ou Alt 
(Windows) enfoncée pendant que vous cliquez 
sur un sélecteur de canal. 

Pour lier les commandes de canaux spécifiques :

1  Désélectionnez le bouton Master Link, si ce 
n'est déjà fait.

2  Cliquez sur les boutons Link Enable 
correspondant aux canaux dont vous souhaitez 
lier les commandes.

Chemins dans les mixages 
Surround
Pro Tools fournit un environnement de routage 
et de prémixage flexible. Vous pouvez ainsi tirer 
le meilleur parti des ressources de votre système 
en commençant par identifier les éléments sur 
lesquels vous souhaitez appliquer un 
panoramique dynamique et ceux qui peuvent 
être placés statiquement sur certains canaux 
(voir Mixage par l'intermédiaire de chemins et 
sous-chemins, page 888).

Une fois les éléments de votre session identifiés, 
vous pouvez combiner des affectations de 
chemins principaux et de sous-chemins au 
panoramique multicanal.

Mixage par l'intermédiaire de chemins 
et sous-chemins

Il est rare que toutes les pistes fassent l'objet d'un 
« panoramique étendu », c'est-à-dire sur 
plusieurs haut-parleurs et pas seulement deux. 
Dans la plupart des cas, certains éléments sont 
placés sur certains haut-parleurs et y restent, 
constituant ainsi la base du mixage.

La figure 40, page 890 est un exemple de 
combinaison du panoramique et de 
l'assignation du signal dans un mixage 
multicanal. Les sections suivantes indiquent 
comment organiser la session et l'assignation 
des signaux afin de tirer le meilleur parti des 
ressources disponibles. 

Pour plus d'informations sur les plug-in de 
retouche, consultez le Guide des plug-in 
DigiRack.
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Quand faut-il affecter des sorties multicanaux ?

" Affectez des chemins 5.1 uniquement aux 
pistes sur lesquelles le panoramique doit être 
appliqué sur les six canaux. 

Par exemple, une piste d'effets spéciaux 
comportant le survol d'un avion à réaction se 
verra affecter un chemin 5.1 pour pouvoir « faire 
voler » le son de l'avant vers l'arrière. Dans un 
mixage musical, vous pouvez appliquer cet effet 
à un instrument en solo ou faire tourner une 
nappe de synthé, comme effet spécial. 

Les éléments devant être entendus 
simultanément sur tous les haut-parleurs 
peuvent également être affectés à la sortie 
multicanal, qu'ils nécessitent ou non un 
panoramique actif dans le champ audio. 

Quand faut-il utiliser les sous-chemins ?

" Pour simplifier les sessions d'une certaine 
importance, vous pouvez utiliser les 
sous chemins pour envoyer des éléments 
statiques (ou stationnaires) directement vers le 
ou les canaux de sortie désirés. 

Par exemple, les dialogues d'un film sont 
souvent mixés sur le haut-parleur central 
uniquement, afin de « fixer à l'écran » cet 
élément sonore essentiel à l'image. Au lieu 
d'affecter un panoramique six canaux aux pistes 
de dialogue pour leur appliquer un 
panoramique uniquement vers le haut-parleur 
central, vous pouvez envoyer directement la 
sortie principale de la piste de dialogue vers un 
sous-chemin mono (centre).

Pour plus d'informations, reportez-vous à la 
section Extension des conventions de 
mixage stéréo au mixage Surround, 
page 890. 
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Extension des conventions de mixage stéréo au 
mixage Surround

Le mixage en stéréo a inauguré les 
panoramiques actifs et statiques, et le mixage en 
mode Surround peut bénéficier des mêmes 
principes de base. 

Panoramiser un son de l'enceinte gauche à 
l'enceinte droite est à considérer comme un effet 
spécial. Dans un mixage musical typique, les 
pistes de base sont placées une fois pour toutes 
dans l'image stéréo, et elles y restent. 

Figure 40.  Utilisation de l'assignation des signaux et des sous-chemins pour le mixage en mode Surround

Pistes envoyées vers des
sous-chemins

Pistes avec 
panoramiques en 3D

Affecta-
tion à
des
bus

Sortie 
principale
vers 
les sous-
chemins

Sorties principales vers les chemins 5.1 pour panoramique en Surround

Entrée auxiliaire 
envoyée vers les 

chemins 
principaux
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Les mixages Surround multicanaux risquent de 
devenir complètement incohérents si trop 
d'éléments se déplacent en permanence. 
Pour créer des effets spéciaux, certaines pistes 
peuvent être panoramiquées de façon 
dynamique, rebondissant ou passant 
progressivement d'une enceinte à l'autre.

Exemples de chemins et 
d'assignations du signal pour 
un mixage Surround
Ces exemples montrent comment les entrées 
auxiliaires, les faders principaux et les autres 
fonctions d'acheminement du signal de 
Pro Tools peuvent être appliqués aux 
prémixages (stems), aux mixages secondaires et 
à des traitements similaires dans le cadre d'un 
projet. 

Dans ces exemples, la musique et les effets 
spéciaux sont mixés dans le cadre d'une 
bande-annonce au format Surround 5.1. 
Les prémixages musicaux et effets doivent être 
enregistrés sur un magnétophone numérique 
8 pistes.

Exemple de chemins multicanaux

L'assignation des signaux est essentielle à toute 
session Surround Pro Tools. Elle se configure et 
se définit dans la boîte de dialogue I/O Setup.

Exemple de chemins de sortie

La figure 41 illustre les chemins de sorties 
définis dans la boîte de dialogue I/O Setup d'un 
exemple de session créée sur un système 
Pro Tools|HD avec une interface audio 96 I/O.

Les sous chemins ont été définis pour les 
chemins de sortie principaux Mix, Music et FX. 

D'autres chemins de sortie stéréo, comportant 
des sous chemins mono, ont également été 
définis pour les canaux restants. 

Figure 41.  Paramètres d'E/S, exemple de chemins de 
sortie
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Exemple de chemins de bus

La figure 42 affiche des exemples de chemins de 
bus.

Deux chemins principaux au format 5.1 ont été 
définis (Music et FX), chacun d'eux comportant 
plusieurs sous-chemins.

Exemple de sous-chemins

Les sous chemins permettent d'effectuer 
l'assignation vers les canaux de votre choix dans 
la sortie Surround multicanal. Dans la figure 43, 
le bus Mix 5.1 est doté de plusieurs 
sous chemins illustrant cette propriété. 

Sous-chemins au format 5.0 : Le bus FX 5.0 est 
un sous-chemin à 5 canaux. Vous pouvez 
utiliser ce type d'assignation vers des 
sous-chemins pour économiser les ressources de 
mixage avec les pistes que vous êtes certain de 
vouloir laisser hors du canal LFE. 

Chemin LFE : un sous-chemin LFE personnalisé a 
été ajouté pour fournir un chemin mono séparé 
au canal LFE. 

Exemples d'acheminement du 
signal

L'illustration ci-dessous montre plusieurs 
possibilités d'utilisation du chemin principal et 
des sous-chemins dans un exemple de session 
composée d'un mixage principal au format 5.1 
et de prémixages de la musique et des effets. 

Exemples de prémixages

La figure 44 représente une configuration 
d'acheminement pour un prémixage d'effets. 
Certaines pistes sont envoyées vers des 
sous-chemins stéréo, tandis que d'autres sont 
affectées à des sous-chemins mono, LCR ou 
autres. Deux pistes (une stéréo, une mono) sont 
assignées à des bus multicanaux, pour bénéficier 
du panoramique Surround. Une entrée 
auxiliaire 5.1, affectée au chemin de bus FX 
principal, sert de prémixeur. 

Figure 42.  Paramètres d'E/S, exemple de chemins de 
sortie

Figure 43.  Paramètres d'E/S, exemple de 
sous-chemins
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Figure 44.  Prémixage d'effets (FX)
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La figure 45 présente une configuration d'acheminement pour les pistes musicales.

Dans cet exemple, la plupart des pistes musicales sont envoyées vers les canaux avant gauche/droit au 
moyen d'un sous-chemin stéréo. Une entrée auxiliaire 5.1 contrôle la sortie du bus et celle du 
prémixage. 

Figure 45.  Prémixage musical



Chapitre 33 : Pistes multicanaux et assignation des signaux (Pro Tools HD uniquement) 895

Exemple de prémixages principaux

Dans la figure46, les deux canaux d'entrée auxiliaires peuvent faire l'objet d'affectations multiples vers 
d'autres chemins au format 5.1 pour un mixage principal. 

Les affectations de sorties multiples permettent 
de configurer un certain nombre de mixages 
multiformat. Par exemple, vous pouvez affecter 
une sortie stéréo supplémentaire aux pistes et 
créer un mixage stéréo en même temps qu'un 
mixage au format 5.1. Pour plus d'informations, 
reportez-vous à la section Assignations de sorties 
multiples, page 735.

Exemples LFE

Les pistes LFE et d'autres données audio peuvent 
être collectées à la sortie LFE de deux manières :

• Au moyen du curseur LFE dans les fenêtres de 
sortie. Ce signal LFE est prélevé après fader. 

– ou –

• Au moyen d'un sous-chemin personnalisé 
pour acheminer séparément les signaux des 
voies.

La figure 47 suivante montre une fenêtre de 
sortie de canal, qui gère les départs et affiche le 
niveau sur le canal LFE. 

Figure 46.  Prémixages principaux

Figure 47.  Départ vers le canal LFE depuis une sortie 
stéréo

Fader LFE Vumètre LFE auxiliaire
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Le fader LFE permet d'ajouter à la sortie LFE 
globale, à tout niveau, les signaux présents sur 
n'importe quel chemin multicanal. Dans 
l'exemple ci-dessus, le pourcentage alloué au 
centre de la piste a été désactivé, et le fader LFE a 
été levé pour acheminer le signal vers le canal 
LFE. 

La figure 48 montre comment acheminer une 
piste LFE « dédiée » uniquement vers le 
canal LFE. Cet exemple fait appel à un 
sous-chemin LFE personnalisé pour 
l'acheminement vers le chemin du bus FX 
principal. 

LFE et filtrage

Pro Tools n'applique aucun filtrage aux signaux 
LFE. Dans certaines cas, le format requiert un 
filtrage sur le piste LFE. Pour obtenir des 
informations supplémentaires, reportez-vous au 
manuel Pro Tools Sync & Surround Concepts Guide. 

Figure 48.  Acheminement LFE séparé

Les faders LFE peuvent « suivre » les 
groupes de mixage et d'édition. Pour plus 
d’informations, consultez la section 
Sélection des attributs de groupes, page 187.

Pour obtenir des instructions sur la création 
d'un sous-chemin, reportez-vous à la 
section Chemins multicanaux 
personnalisés, page 877. 
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Chapitre 34 : Panoramique et mixage 
en mode Surround (Pro Tools HD 
uniquement)

Ce chapitre explique comment effectuer des 
panoramiques et des mixages en mode Surround 
dans Pro  Tools. 

Le mixage multicanal n'est pris en charge que 
dans Pro Tools|HD. Dans ce chapitre, toute 
référence à Pro Tools désigne les systèmes 
Pro Tools|HD. 

Avant de pouvoir régler un panoramique en 
Surround, vous devez affecter la piste en 
question à une sortie multicanal ou à un chemin 
de sortie adéquat. 

La boîte de dialogue I/O  Setup définit 
l'architecture de routage et de sortie de la 
console Surround multicanaux de Pro Tools. 
Si vous ne l'avez pas encore fait, nous vous 
conseillons de vous familiariser avec les chemins 
principaux et les sous-chemins, ainsi qu'avec la 
boîte de dialogue I/O Setup avant de lancer des 
projets multicanaux dans Pro Tools. 

Pour plus d'informations sur les 
configurations multicanaux et les options 
de la boîte de dialogue I/O Setup, consultez 
le chapitre 32, Configuration de Pro Tools 
pour le mixage en mode Surround 
(Pro Tools HD uniquement). En ce qui 
concerne l'assignation des signaux en mode 
multicanal, consultez le chapitre 33, Pistes 
multicanaux et assignation des signaux 
(Pro Tools HD uniquement).
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Introduction au panoramique 
Surround dans Pro  Tools
Quatre méthodes différentes de panoramique 
sont disponibles : 

• dans la fenêtre Edit, à l'aide de la grille de 
panoramique de taille réduite, dans la 
vue I/O ;

• dans la fenêtre Mix, à l'aide de la grille de 
panoramique de taille réduite ;

• dans la fenêtre Output, au moyen de la grille 
de panoramique plein écran ;

• par édition de l'automation de panoramique.

Les surfaces de contrôle offrent d'autres options 
de panoramique. Pour plus d'informations sur 
les surfaces de contrôle, consultez la 
documentation de la vôtre. 

Grilles de panoramique des 
fenêtres Mix et Edit

Dans les fenêtres Mix et Edit, les grilles de 
panoramique multicanaux apparaissent sur les 
pistes comportant des affectations de sorties 
multicanaux pour les pistes ou les départs. 

Pour effectuer un panoramique depuis la fenêtre 
Mix ou Edit :

1  Depuis la fenêtre Edit, assurez-vous que la vue 
I/O est affichée (View > Edit Window > I/O). Les 
grilles de panoramique sont systématiquement 
affichées dans les pistes de la fenêtre Mix 
prenant en charge le panoramique.

2  Lancez la lecture. 

3  Cliquez sur la grille de panoramique de la piste 
multicanal appropriée dans la fenêtre Mix ou 
Edit, puis faites la glisser. 

Le curseur de position du panoramique suit vos 
mouvements tant que vous maintenez le 
bouton de la souris enfoncé. La gestion des 
mouvements est telle qu'une fois que vous avez 
cliqué pour « saisir » le curseur de position du 
panoramique, les mouvements ne sont pas 
limités à la zone réduite allouée à la grille dans la 
piste. 

Couleur du curseur de position du panoramique 
lors de l'automation

Le curseur de position du panoramique est vert 
en mode Automation Read (lecture) rouge en 
mode Automation Write, Touch, Latch ou 
Touch/Latch (modes enregistrables) et jaune en 
mode Automation Off (désactivation de 
l'automation) ou Automation Suspend 
(interruption de l'automation). 

En mode Trim, le fader de volume et le fader LFE 
sont en jaune.

Panoramique dans la grille des pistes

Cliquez et faites glisser
pour faire un panoramique.
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Les fenêtres de sortie offrent d'autres fonctions 
et commandes (ainsi qu'une grille beaucoup 
plus grande). Pour en savoir plus, reportez-vous 
à la section Fenêtres Output, page 899. 

Fenêtres Output
Les fenêtres Output offrent des commandes de 
panoramique (appelées panoramiques), ainsi 
que les commandes Pro Tools standard, dans 
tous les formats de mixage (du format 
LCR 3 canaux jusqu'au format 7.1 8 canaux). 

Reportez-vous à la section Commandes 
standard, page 900 pour obtenir davantage 
d'informations sur les commandes standard de 
la fenêtre Output. Reportez-vous à la section 
Commandes de panoramique Surround, 
page 901 pour obtenir davantage 
d'informations sur les commandes de 
panoramique de la fenêtre Output.

Les fenêtres Output fournissent notamment les 
fonctionnalités suivantes :

• Panoramique X/Y (mode joystick)

• Panoramique à trois boutons

• Contrôle de divergence intégrale et de 
pourcentage de centrage

• AutoGlide

• Envoi au LFE

• Vumètres multicanaux

• Prise en charge de la fenêtre cible de 
Pro Tools

Il est possible d'ouvrir simultanément plusieurs 
panoramiques ou d'afficher le panoramique en 
cours dans une seule fenêtre.

Pour ouvrir une fenêtre Output :

" Cliquez sur le bouton Output Window de la 
piste dans la fenêtre Mix ou Edit (vue I/O).

Ouverture d'une fenêtre Output multicanaux

Pour obtenir des instructions sur la gestion 
de fenêtres Output multiples, reportez-vous 
à la section Fenêtres Output pour les pistes 
et les départs, page 744.
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Commandes standard
Toutes les fenêtres Output offrent des 
commandes standard Pro Tools pour 
l'acheminement, l'affectation des chemins et 
d'autres fonctions applicables aux pistes. Ces 
commandes se trouvent au-dessus de toutes les 
fenêtres Ouput, Send, Insert et Plug-in. 
Certaines commandes sont propres à certains 
types de fenêtre.

Fader de piste, Solo, Mute et Auto

Toutes les fenêtres Output sont dotées de 
commandes de volume et de coupure (Mute). 
Vous pouvez ainsi régler, automatiser ou couper 
directement le volume des pistes. Le grand fader 
et le bouton Mute sont équivalents à ceux de la 
fenêtre Mix de Pro Tools. 

Zone de contrôle du panoramique

Pour plus de détails ces fonctions standard, 
consultez la section Commandes de 
sélecteur standard dans les fenêtres Output, 
page 747

Sélecteur de 
piste

Sélecteur de 
sortie

Sélecteur de 
chemin Icône Target

Affichage des vumètres

Bouton Safe
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Commandes de panoramique Surround
Quand elle est affectée à des pistes ou à des chemins, la fenêtre Output offre une grille X/Y pour les 
panoramiques surround. Les haut-parleurs associés au format multicanal du panoramique sont 
représentés, dans leur position respective, à l'extérieur de la grille de panoramique. Ces haut-parleurs 
font également office de commandes Snap Pan to Speaker.

Cette section décrit toutes les commandes et fonctions des panoramiques multicanaux de Pro Tools. 

Figure 49.  Fenêtre Output avec un panoramique multicanal au format 5.1

Grille X/Y

Fader LFE

Fader et vumètre de la 
piste

de position 
(boutons de 
panoramique)

Divergence

Curseur de 
position du 
panoramique

Bouton du mode de 
panoramique

Automation des pistes 
Solo et Mute

Pourcentage de centrage

Cliquez ici pour activer 
les vumètres

Icônes Snap Pan to Speaker
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Grille X/Y et curseur de position 
du panoramique

La grille X/Y permet de saisir et d'afficher les 
informations de panoramique multicanal. Vous 
pouvez également entrer des informations de 
panoramique en utilisant le mode X/Y, le mode 
trois boutons ou en saisissant des valeurs 
numériques dans les champs de données 
Position, comme décrit plus bas. Vous pouvez 
aussi modifier graphiquement l'automation de 
panoramique dans la fenêtre Edit.

Par défaut, les panoramiques multicanaux 
s'effectuent en mode X/Y. Dans ce mode, la 
position actuelle du panoramique de la piste est 
représentée par un point de couleur verte. 
Ce point est le curseur de position du 
panoramique ; il indique l'état de l'automation 
des pistes par les couleurs Pro Tools standard : 

Vert-: la piste est en mode Automation Read.

Rouge : la piste fonctionne en mode 
Automation Write, Touch ou Latch.

Jaune : la piste est en mode Automation Off 
(ou Automation Suspend).

Bouton du mode panoramique

Ce bouton, situé sous la grille X/Y, permet 
d'accéder aux modes de panoramique Surround 
(voir Modes de panoramique, page 904). 
 

Commandes Position

Les commandes Position permettent de définir 
les positions des panoramiques.

Front : affiche et contrôle le panoramique sur 
l'axe horizontal avant (X) (gauche/droite). 

Rear : affiche et contrôle le panoramique sur 
l'axe horizontal arrière (X) (gauche/droite). 
En mode de panoramique X/Y par défaut, les 
positions avant et arrière sont solidaires et ne 
peuvent être contrôlées indépendamment. 

F/R (Front/Rear) : affiche et contrôle le 
panoramique sur l'axe Y. 

Commande Center %

Cette commande permet de contrôler le 
pourcentage du signal envoyé au haut-parleur 
central. Vous pouvez ainsi panoramiser une 
piste vers l'avant avec un centre fantôme (valeur 
Center de 0 %) ou en l'envoyant sur les trois 
canaux frontaux (LCR) lorsque vous êtes en 
mode panoramique. 

Grille X/Y et curseur de position du panoramique

Grille X/Y

Curseur de 
position du 
panoramique

Bouton du mode de panoramique configuré en mode 
X/Y

Commandes Position et Center %

Icône du mode X/Y
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Commandes de divergence

La divergence détermine la largeur du signal 
panoramique au niveau des haut-parleurs 
adjacents. Consultez le manuel Pro Tools Sync & 
Surround Concepts Guide pour obtenir des 
informations supplémentaires. Il existe trois 
commandes de divergence.

Divergence avant, arrière et AV/AR : permettent 
de contrôler la divergence séparément, 
automatiquement pour les haut-parleurs avant, 
arrière et entre l'avant et l'arrière, 
respectivement.

Icônes Snap Pan to Speaker

Ces icônes permettent de faire correspondre le 
panoramique à l'emplacement d'un 
haut-parleur. Le fait de cliquer, par exemple, sur 
le haut-parleur supérieur gauche déplace le 
curseur de position du panoramique dans le 
coin supérieur gauche de la grille X/Y.

Fader LFE

Le fader LFE n'est disponible que dans les 
formats surround « .1 », à savoir 5.1, 6,1 et 7,1. 

Le fader LFE détermine, pour la piste active, le 
niveau de signal envoyé vers le canal LFE. Les 
faders LFE des fenêtres Track et Send peuvent 
suivre des groupes. Le canal LFE de Pro Tools 
fonctionne toujours à pleine bande passante. 
Pour plus d'informations sur l'utilisation du 
fader LFE, reportez-vous à la section Faders LFE 
dans les panoramiques multicanaux, page 911.

Commandes de divergence

Pour voir des exemples des répercussions des 
réglages de divergence sur les panoramiques 
en sortie, reportez-vous à la section 
Divergence et Center Percentage, page 908.

Fader LFE
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Modes de panoramique
Le bouton Panning Mode donne accès à quatre 
modes de panoramique : X/Y, édition de 
divergence, panoramique à trois boutons et 
glissement automatique. Les commandes de 
panoramique peuvent être automatisées dans 
les quatre modes.

Modes de panoramique

Mode X/Y : pour effectuer un panoramique de 
style joystick, faites glisser le curseur de position 
du panoramique dans la grille de haut-parleur 
X/Y. Pour plus d'informations, reportez-vous à 
la section Panoramique X/Y, page 904.

Panoramique à trois boutons : panoramique de 
point à point, entre paires de haut-parleurs. 
Pour plus d'informations, reportez-vous à la 
section Panoramique à trois boutons, page 905. 

Edition de divergence : faites glisser les bords de 
la divergence dans la grille X/Y de divergence 
pour les redimensionner. 

Mode de glissement automatique : panoramique 
de point à point entre le curseur de position du 
panoramique et la nouvelle destination en 
fonction de la durée de glissement automatique 
spécifiée. Pour plus d'informations, 
reportez-vous à la section Mode de glissement 
automatique, page 907.

Pour activer un mode de panoramique :

" Cliquez sur le bouton du mode de 
panoramique dans le panoramique Surround 
autant de fois que nécessaire pour afficher 
l'icône du mode désiré.

Panoramique X/Y

Pour effectuer un panoramique en mode X/Y :

1  Cliquez sur le bouton du mode de 
panoramique afin d'afficher l'icône du 
mode X/Y.

2  Faites glisser le curseur de position du 
panoramique ou cliquez n'importe où dans la 
grille, puis faites glisser le curseur pour 
panoramiser le signal de la piste. L'emplacement 
du curseur de position du panoramique 
détermine la position du signal. Pour envoyer, 
par exemple, un son vers le haut-parleur arrière 
gauche, déplacez le curseur de position du 
panoramique vers l'angle inférieur gauche. 

Bouton du mode de panoramique (mode X/Y affiché)

Bouton du mode de panoramique

Bouton du mode de panoramique configuré en 
mode X/Y

Icône du mode X/Y
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Pour positionner le curseur de position du 
panoramique à un emplacement particulier de la 
grille :

" Maintenez la touche Ctrl enfoncée pendant 
que vous cliquez sur un point quelconque de la 
grille X/Y. 

Options et raccourcis de la grille

Mode de réglage précis : Maintenez la touche 
Ctrl (Windows) ou Pomme (Mac) enfoncée pour 
effectuer un réglage précis de toutes les 
commandes de panoramique. 

Restriction du déplacement à l'axe X ou Y : 

faites glisser le curseur de position du 
panoramique en maintenant enfoncée la touche 
Maj pour restreindre son mouvement sur l'axe X 
ou Y.

Restauration des paramètres par défaut 

Maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée pendant que vous cliquez dans 
la grille de panoramique pour initialiser tous les 
paramètres à leur valeur par défaut. 

Snap Pan to Speaker : cliquez sur une des icônes 
Snap Pan to Speaker pour faire correspondre le 
panoramique à l'emplacement de cet 
haut-parleur. 

Affichage des données d'automation dans la 
fenêtre Edit : maintenez les touches Démarrer 
(Windows) ou Pomme+ Ctrl (Mac) enfoncées 
pendant que vous cliquez sur une commande 
pour afficher la playlist lui correspondant dans 
la fenêtre Edit.

Panoramique à trois boutons

Pro Tools offre aussi un mode trois boutons 
pour entrer des déplacements de panoramique. 

Le mode trois boutons permet d'effectuer :

• des panoramiques en ligne droite, en 
déplaçant le curseur de position du 
panoramique au moyen des boutons rotatifs 
Front, Rear et Front/Rear ; 

– et –

• des panoramiques séparés entre des paires de 
haut-parleurs.

Il n'est pas nécessaire de cliquer exactement 
sur le curseur de position du panoramique. 
Si vous cliquez à un endroit quelconque de 
la grille, le curseur se déplace par rapport à 
cet emplacement ou un panoramique 
matériel est activé. Le panoramique ne vient 
pas se placer au niveau du point où vous 
avez cliqué. 

Panoramique X/Y

Il est possible d'automatiser tous les 
paramètres de panoramique, y compris la 
position et la divergence. Pour plus 
d'informations, consultez la section 
chapitre 30, Automation. 
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Par exemple, lorsque vous effectuez un 
panoramique de l'avant gauche vers l'arrière 
droite en mode trois boutons, le son ne sera 
audible que sur ces deux haut-parleurs (en 
partant du principe que la divergence intégrale 
est activée). 

En comparaison, si vous effectuez un 
panoramique en mode X/Y, le son peut être 
audible sur certains canaux ou sur tous pendant 
le déplacement du son. 

Le mode trois boutons effectue un panoramique 
« discret » et « ponctuel » entre les positions 
avant et arrière de la trajectoire, tandis que le 
panoramique en mode X/Y s'effectue en 
couvrant les 360° de la grille de panoramique. 
Les options Divergence et Center Percentage 
(Center %) sont variables dans les deux modes. 

Pour activer le mode panoramique trois boutons :

" Cliquez sur le bouton du mode de 
panoramique à trois boutons afin d'afficher 
l'icône du mode correspondant.

La ligne de la trajectoire s'affiche dans la grille, 
de l'avant (axe X) vers l'arrière (axe Y).

Pour effectuer un panoramique en mode trois 
boutons :

1  Réglez les boutons de position avant (Front) et 
arrière (Rear) pour définir la trajectoire. 

2  Faites tourner le bouton de position 
avant/arrière (Front/Rear) pour effectuer le 
panoramique le long de la trajectoire. Le curseur 
de position du panoramique est contraint à 
suivre la trajectoire correspondant à la ligne 
blanche. 

Pour changer la durée d'une sélection, effectuez 
l'une des opérations suivantes :

" Faites glisser l'un des points d'extrémité (avant 
ou arrière) de la trajectoire. 

– ou –

" Réglez les commandes de position avant 
(Front) ou arrière (Rear). 

Panoramique et vumètres en mode trois boutons

Panoramique et vumètre en mode X/Y

Trajectoire en 
mode trois 
boutons

Mode trois

Vumètres

Position du panoramique
X/Y

Vumètres

Mode X/Y

Bouton du mode de panoramique configuré en mode à 
trois boutons

Icône du mode de panoramique à trois boutons
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Pour modifier la trajectoire actuelle (de gauche à 
droite) en conservant les angles actuels :

" Faites glisser la ligne de trajectoire (pas ses 
extrémités) sur une nouvelle position. 

Mode de glissement automatique

Le mode de glissement automatique permet 
d'écrire rapidement des données d'automation 
de panoramique Surround en cliquant aux 
emplacements voulus dans la fenêtre Surround 
Panner, au lieu de déplacer manuellement les 
commandes de panoramique Surround.

Le délai nécessaire pour passer d'un point à 
l'autre (du curseur de position du panoramique à 
la nouvelle destination) est appelé la durée de 
glissement automatique. Cette durée est définie 
dans la page Mixing Preferences et peut être 
comprise entre 10 msec et 10 000 msec 
(10 secondes).

Pour définir la durée de glissement automatique :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Mixing.

2  Réglez la durée de glissement automatique 
dans la section Automation.

Pour effectuer un passe d'automation AutoGlide :

1  Cliquez sur le bouton du mode de 
panoramique afin d'afficher l'icône du mode de 
glissement automatique.

Le bouton du mode de panoramique présente 
une ligne inclinée en pointillés se terminant par 
un point uni (représentant un curseur) dans 
l'angle supérieur droit.

2  Dans la fenêtre Mix ou Edit, cliquez sur le 
sélecteur du mode d'automation et sélectionnez 
un mode d'automation pour la piste que vous 
souhaitez automatiser.

3  Appuyez sur Play pour commencer la lecture.

4  Définissez une nouvelle destination pour le 
curseur en procédant de l'une des façons 
suivantes :

• Cliquez sur une icône Snap Pan to Speaker 
pour effectuer un glissement vers 
l'emplacement de son haut-parleur.

– ou –

• Cliquez à l'intérieur de la fenêtre de 
panoramique pour effectuer un glissement 
vers un emplacement spécifique dans la 
grille X/Y.

Lorsque vous écrivez des données 
d'automation en mode de glissement 
automatique, il n'est pas possible de faire 
glisser le curseur de position du 
panoramique.

Bouton du mode de panoramique configuré en mode 
de glissement automatique

Icône du mode de glissement automatique
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La durée du déplacement du curseur sur le 
panoramique vers la nouvelle destination 
correspond à la durée AutoGlide. Dès que le 
nouveau point de destination est atteint, le 
programme génère un nouveau point 
d'inflexion au nouvel emplacement.

5  Pour définir des déplacements panoramiques 
supplémentaires, recommencez l'étape 
précédente.

6  Arrêtez le transport lorsque vous avez terminé.

Divergence et Center 
Percentage
La valeur des paramètres Divergence et Center 
Percentage (Center %), qu'il est possible 
d'automatiser, peut varier de 0 à 100. 
Ces commandes sont particulièrement utiles 
pour assurer une couverture sonore homogène, 
notamment dans les salles de grande taille et 
pour améliorer la clarté des voix. 

Divergence frontale : contrôle la divergence 
entre les haut-parleurs avant (axe X 
uniquement). 

Divergence arrière : contrôle la divergence entre 
les haut-parleurs arrière (axe X uniquement).

 Divergence avant/arrière : contrôle la 
divergence entre l'avant et l'arrière (axe Y).

% de centrage (pourcentage) détermine s'il 
existe une image centrale séparée, une image 
centrale entièrement fantôme ou une valeur 
variable comprise entre les deux. 

Divergence

Dans la grille de panoramique, les valeurs de 
divergence actuelles sont représentées par un 
contour violet. 

Bouton du mode panoramique (mode de glissement 
automatique affiché)

Mode de glissement automatique

Icônes Snap 
Pan to 
Speaker

Curseur de 
position du 
panoramique

Affichage et contrôles de divergence

Affichage de la 
divergence

Commandes de divergence
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Par défaut, les panoramiques Surround de Pro  
Tools sont divergents à 100 % ; autrement dit, 
un signal en panoramique sur un seul 
haut-parleur ne sera audible que sur celui-ci. 

Une divergence inférieure se traduit par un 
signal source qui s'élargit progressivement. 
Lorsque la divergence est inférieure à 100 %, les 
pistes sont envoyées vers les haut-parleurs 
adjacents dans une certaine mesure, même 
lorsque le curseur de position du panoramique 
se trouve près d'une seule icône de haut-parleur. 

Pour régler la divergence :

" Réglez les contrôles de divergence frontale, 
arrière et avant-arrière conformément à vos 
besoins. 

Pour régler la divergence en mode graphique :

1  Cliquez sur le bouton du mode de 
panoramique afin d'afficher l'icône du mode 
d'édition de divergence.

2  Faites glisser les bords de la divergence dans la 
grille pour les redimensionner. 

Divergence complète pour un panoramique discret vers 
l'avant gauche (les vumètres n'indiquent la présence 
d'un signal que sur le canal avant gauche).

La divergence frontale à 0 % offre le panoramique le 
plus large (notez les vumètres indiquant la présence 
d'un signal sur les trois haut-parleurs frontaux).

Vumètres

Curseur de 
position du 
panoramique

Vumètres

Divergence
frontale

Curseur de 
position du 
panoramique

Bouton du mode de panoramique configuré en mode 
d'édition de divergence

Icône du mode d'édition de divergence
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Pourcentage de centrage

Les commandes Center Percentage déterminent 
s'il existe un canal central séparé pour la piste, 
ou bien s'il s'agit d'un canal central fantôme. 

Exemple de pourcentage de centrage

En production film et vidéo, le canal central 
contient souvent les dialogues. Pour améliorer la 
clarté et l'intelligibilité de la boîte de dialogue, il 
est souvent bénéfique de laisser les autres 
éléments (tels que la musique) hors du 
haut-parleur central. En réduisant le 
pourcentage de centrage sur les pistes musicales 
(dans cet exemple), la musique sur laquelle est 
réglée un panoramique vers l'avant du champ 
peut être envoyée uniquement vers les 
haut-parleurs gauche et droit, créant ainsi une 
image centrale fantôme.

Pour régler le pourcentage de centrage :

" Réglez le potentiomètre Center Percentage sur 
la position adéquate. 

Plus vous réduisez la valeur du bouton Center 
Percentage, plus l'icône centrale de haut-parleur 
située en haut de la grille s'estompe. Pour une 
valeur de 0, elle est complètement invisible, 
reflétant ainsi le réglage du centre entièrement 
fantôme.

Centre discret (Center % de valeur 100)

Curseur de position
du panoramique

Vumètres

Pourcentage de
centrage

Centre fantôme (Center % de valeur 0)

Haut-parleur central moins visible

Vumètres

Pourcentage de
centrage

Curseur de position
du panoramique
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Faders LFE dans les 
panoramiques multicanaux
Les commandes de fader LFE gèrent le niveau du 
signal prélevé sur la piste pour être envoyé au 
canal LFE. Les faders LFE ne sont disponibles que 
lorsqu'une piste est affectée à un chemin dont le 
format implique l'existence d'un LFE (5.1, 6.1 ou 
7.1). 

Pour envoyer le signal sur le canal LFE :

" Ajustez le fader LFE dans une fenêtre Output 
au format surround « .1 ». 

Groupes et faders LFE

Pour suivre les groupes Mix et Edit, les faders LFE 
de piste et de départ doivent être activés dans la 
page d'attributs de groupes de la boîte de 
dialogue Creat Groupe ou Modify Groups. 
Leur assignation permet de suivre les groupes en 
tant qu'attribut global ou sur une base « groupe 
par groupe ». Pour plus d'informations, 
reportez-vous à la section Sélection des attributs 
de groupes, page 187.

LFE Enable

Certains plug-in multicanaux, notamment le 
compresseur multicanaux DigiRack Dynamics 
III Compressor/Limiter, intègrent une fonction 
d'activation de fader LFE. Ceci permet d'activer 
ou de désactiver le traitement du canal LFE le cas 
échéant. 

Pour traiter le canal LFE dans un plug in 
multicanal :

" Activez la fonction LFE Enable, si le plug in 
multicanal la prend en charge. LFE Enable 
apparaît en surbrillance lorsque vous l'activez, et 
en mode normal lorsque vous désactivez le LFE 
lors du traitement.

Playlists
Les panoramiques multicanaux comportent un 
playlist d'automation pour chaque commande 
de position et de divergence. 

Pour obtenir des informations générales à 
propos des LFE, des sous-canaux et sujets 
connexes, consultez le manuel Pro Tools 
Sync & Surround Concepts Guide.

LFE Enable dans le compresseur multicanaux DigiRack 
Dynamics III Compressor/Limiter

Si la fonction d'activation de fader LFE n'est 
pas disponible, essayez d'utiliser la version 
multimono du plug-in.

L'automation de panoramique peut être 
représentée, modifiée, coupée, copiée et 
collée à partir de la fenêtre Edit. Pour plus 
d'informations, consultez la section 
chapitre 30, Automation.
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Surround Scope Plug-in
Le plug-in Surround Scope fournit un vumètre 
sur 360° pour l'affichage des chemins 
multicanaux au cours du mixage.

Disposition des pistes du format 5.1

Tous les vumètres au format 5.1 affichés (y 
compris ceux du vumètre Surround Scope, sur 
les pistes et dans les fenêtres Output et leurs vues 
du vumètre du chemin) apparaissent toujours 
dans l'ordre suivant :

L C R Ls Rs LFE

Pour utiliser le plug-in Surround Scope :

" Sur un Master Fader multicanaux, cliquer sur 
un bouton Insert et sélectionnez Multi-channel 
TDM plug-in > Sound Field > Surround Scope. 

Surround Scope affiche les niveaux de sortie sur 
une grille couvrant 360° ainsi qu'à l'aide de 
points lumineux (voyants) classiques. 

Pour plus d'informations sur la 
visualisation dans Pro Tools, reportez-vous 
à la section Pistes, format, affectation et 
mesures du format 5.1, page 878. 

Plug-in Surround Scope 

Pour plus d'informations sur Surround 
Scope, consultez le guide des plug-in 
Digidesign.
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Chapitre 35 : Utilisation de la 
synchronisation

La synchronisation permet à un système de 
générer un timecode en sortie et à un autre 
système de le suivre. Pro Tools peut être 
synchronisé avec d'autres appareils via un 
timecode SMPTE/EBU ou un signal de MIDI 
Time Code (MTC).

Options de synchronisation de 
Pro Tools
Il existe plusieurs options pour la 
synchronisation de Pro Tools avec une source 
externe et son utilisation en tant qu'appareil 
maître. Certaines options ne sont pas 
disponibles sur tous les systèmes Pro Tools, 
comme expliqué ci-après. 

SMPTE Trigger Only

Cette solution est très utile pour les projets 
courts si la vitesse des deux systèmes est proche. 
Toutefois, même les meilleurs systèmes restent 
rarement parfaitement synchronisés plus de 
quelques minutes.

Déclenchement SMPTE référencé avec 
un périphérique SYNC

(Pro Tools HD uniquement)

Vous pouvez utiliser un périphérique Digidesign 
SYNC optionnel pour référencer les vitesses 
d'enregistrement et de lecture de Pro Tools à 
l'une des sources de référence d'horloge ci-après, 
tout en asservissant Pro Tools à un timecode :

• LTC

• Source vidéo

• Référence vidéo house

• VITC

• Word Clock 1x

• Horloge AES/EBU « null »,

• Pilot Tone

• Biphase

En référençant tous les transports du système à 
un signal de synchronisation commun ou à un 
signal tenant compte d'éventuelles fluctuations 
du timecode maître entrant, on obtient une 
synchronisation très précise à long terme.

Pour en savoir plus sur les différents 
formats SMPTE/EBU et sur les autres 
concepts relatifs au timecode, consultez le 
manuel Pro Tools Sync & Surround Concepts 
Guide.
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Déclenchement SMPTE Trigger lors du blocage 
d'une source référencée

L'option SMPTE Trigger peut être utilisée avec 
un périphérique optionnel SYNC ou tout 
périphérique équivalent pour référencer la 
vitesse d'enregistrement et de lecture d'un 
système Pro Tools asservi à un timecode LTC. 
En référençant le système à un signal tenant 
compte des fluctuations du timecode entrant, 
on obtient une synchronisation très précise, 
même à long terme. Les périphériques SYNC 
prennent également en charge le références de 
position VITC et Bi-phase/Tach.

Option de synchronisation du 
prériphérique SYNC

L'ajout d'un périphérique Digidesign SYNC à un 
système Pro Tools|HD permet d'utiliser 
Pro Tools en tant qu'appareil maître dans la 
configuration. Tous les autres périphériques 
sont alors asservis à Pro Tools. 

Vous pouvez associer Pro Tools à un 
périphérique SYNC pour générer des 
commandes LTC, MIDI Time Code ou de MMC 
(MIDI Machine Control). Lorsque le 
périphérique SYNC reçoit un timecode SMPTE 
sur son connecteur d'entrée SMPTE, il le 
régénère puis le renvoie sur le connecteur de 
sortie LTC ou MTC. Ce signal peut ensuite être 
transmis à d'autres périphériques esclaves.

MachineControl™

Les périphériques Digidesign SYNC prennent 
également en charge le logiciel MachineControl 
qui propose de nombreuses fonctions 
spécialisées pour les tâches de post-production, 
notamment l'activation de pistes à distance, 
l'émulation VTR, le timecode série, etc. 
Reportez-vous à MachineControl Guide pour plus 
d'informations ou contactez votre revendeur 
Digidesign.

Sortie d'horloge externe

Pro Tools peut jouer le rôle du dispositif maître 
(sortie Word Clock) de la configuration de 
synchronisation. Dans ce cas, tous les autres 
dispositifs lui sont asservis. 

Avec les systèmes Pro Tools|HD, la sortie 
d'horloge peut être configurée sur 1x word clock 
ou 256x Slave Clock pour les interfaces Legacy 
I/O de Digidesign (telles que 888|24 I/O). 
Reportez-vous au Guide de démarrage 
Pro Tools|HD si vous souhaitez davantage 
d'informations sur la sortie d'horloge et les 
interfaces Legacy I/O. 

Pour régler la sortie d'horloge externe

1  Dans Pro Tools, sélectionnez Setup > 
Hardware.

2  Cliquez sur le menu déroulant Ext. Clock 
Output et sélectionnez un signal disponible. 

3  Lorsque vous avez terminé, cliquez sur OK 
pour refermer la boîte de dialogue Hardware 
Setup.

Pour en savoir plus sur la connexion d'un 
périphérique de synchronisation externe au 
système Pro Tools, reportez-vous au Guide 
de démarrage. Si vous utilisez un 
périphérique SYNC, consultez sa 
documentation technique.
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Fenêtre Session Setup
La fenêtre Session Setup permet de configurer 
sur votre système un certain nombre de 
paramètres relatifs au timecode. Cette fenêtre 
inclut également des zones d'affichage de la 
fréquence d'échantillonnage, du format de 
fichier et de la résolution de la session. 

Fenêtre Session Setup

La fenêtre Session Setup est organisée en trois 
sections d'affichage. La session ainsi que les 
paramètres lui correspondant s'affichent dans la 
partie supérieure de la fenêtre. Les icônes 
Développer/Réduire en forme de triangles 
permettent de masquer ou d'afficher les zones 
SYNC Setup & Session Offsets et Time Code 
Settings. Pour plus d'informations, 
reportez-vous à la section figure 50, page 916.

Pour afficher la fenêtre Session Setup :

" Dans une session Pro Tools, choisissez Setup > 
Session.

Pour développer la zone SYNC Setup & Session 
Offsets :

" Cliquez sur le triangle Développer/Réduire de 
la zone SYNC Setup & Time Code Offsets.

Les commandes de cette section permettent de 
configurer les paramètres des périphériques 
SYNC Digidesign. Les paramètres sont fournis 
pour les options Clock Reference et Positional 
Reference, Video Format et Variable Speed 
Override. 

Pour afficher la zone Time Code Settings :

" Cliquez sur le triangle Développer/Réduire 
dans la zone Time Code Settings.

Les commandes de cette zone permettent de 
générer le timecode et fournissent des options 
d'inertie ainsi que des sélecteurs distincts pour 
les fréquences audio et vidéo.

Si le port Legacy est activé (et non le port 
Expansion), la sortie d'horloge externe passe 
automatiquement en mode Slave 256x. 
Pour réinitialiser la sortie d'horloge externe, 
le bouton Port Settings doit être réglé sur 
Expansion et l'interface Legacy I/O doit être 
réglée sur No Interface. Pour régler une 
interface Legacy I/O sur No Interface, 
sélectionnez son nom dans la liste des 
périphériques, puis cliquez sur No Interface 
dans le menu déroulant.

Les systèmes Pro Tools LE dotés de DV 
Toolkit 2 prennent en charge plusieurs 
paramètres liés au timecode (tels que les 
règles temporelles Time Code et 
Pieds+Images). Pour obtenir la liste 
complète, consultez le DV Toolkit 2 Guide.
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Paramètres et affichage de la 
session

Sample Rate

Ce paramètre indique la fréquence 
d'échantillonnage de la session actuelle. 

Bit Depth

Ce paramètre indique la résolution de la session 
actuelle.

Audio Format

Ce paramètre indique le format de fichier pour 
les fichiers enregistrés dans la session.

Clock Source

Ce menu permet de configurer l'horloge source 
du système. Vous avez le choix entre un 
périphérique SYNC, une source d'horloge 
interne à partir d'un périphérique Digidesign et 
une source d'horloge externe connectée à une 
interface audio Pro Tools|HD.

Options de source d'horloge

SYNC : lors de l'utilisation d'un périphérique 
SYNC, Pro Tools reçoit sa source d'horloge du 
périphérique SYNC. Le périphérique SYNC peut 
en retour référencer une source d'horloge 
externe sélectionnée dans la section SYNC Setup 
dans la fenêtre Session Setup. 

Figure 50.  Fenêtre Session Setup avec un périphérique SYNC

Paramètres SYNC 

Décalage du lecteur de timecodeParamètres d'inertie

Source d'horloge

Paramètres et 
affichages de la 
session

Paramètres de 
décalage de 
timecode externe

Paramètres Pull 
Up/Pull Down

Paramètres de 
générateur

Section Time Code 
Settings

Section SYNC & 
Time Code Offsets

Setup

Les modifications apportées au paramètre 
Clock Source dans la boîte de dialogue 
Hardware Setup se répercutent dans la 
fenêtre Session Setup, et vice versa.
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Internal : en mode Internal, votre système 
référence l'horloge interne de votre périphérique 
Digidesign et lit les données audio à la fréquence 
d'échantillonnage de la session.

External Clock Sources : selon votre interface 
audio Pro Tools|HD, les options de source 
d'horloge externe peuvent inclure AES/EBU, 
S/PDIF, Optical, ADAT Optical, TDIF et Word 
Clock (des fréquences de signal Word Clock 
optionnelles sont disponibles aux fréquences 
plus élevées). Les sources externes peuvent être 
tout multiple de la fréquence « de base ». La 
fréquence de base est de 44,1 kHz pour les 
sources 88,2 et 176,4 kHz. La fréquence de base 
est de 48 kHz pour les sources 96 et 192 kHz. Si 
une source externe est sélectionnée et qu'aucune 
horloge de synchronisation valide n'est détectée 
au niveau de l'horloge externe d'entrée, le 
périphérique I/O repasse en mode Internal.

System Delay

Lorsque la compensation de retard est activée, 
cet écran indique la quantité totale de retard (en 
échantillons) appliquée par le système pour la 
compensation de retards de plug-ins et 
d'acheminement vers la console. 

Session Start

Ce champ permet de spécifier une valeur SMPTE 
pour l'emplacement de l'image de départ de la 
session. Pour plus d'informations, reportez-vous 
à la section « Définition de l'image de départ 
d'une session SMPTE », page 921.

Incoming Time (heure actuelle)

Ce champ indique la valeur de timecode 
entrant. 

Time Code Rate

Ce menu déroulant permet de régler la 
fréquence de timecode SMPTE applicable à la 
session en cours. 

Feet+Frame Rate 

Vous pouvez définir les fréquences Pieds+Image 
des sessions à l'aide du sélecteur correspondant. 
Les fréquences d'échantillonnage prises en 
charge sont 23,976, 24 et 25 i/s.

Réglez cette fréquence en fonction de celle du 
projecteur cinématographique ou de la vidéo si 
la vitesse du projecteur est prise en compte. 
Ainsi, pour procéder au transfert de télécinéma 
depuis un projecteur cinématographique à 
24 i/s en vidéo NTSC, le projecteur devrait 
fonctionner à 23,976 i/s qu'un facteur de 
ralentissement soit ou non appliqué à la session.

Time Code 2 Rate 

Ce menu contextuel vous permet de paramétrer 
une fréquence d'images secondaire qui peut être 
affichée dans la règle à côté de la règle principale 
de Timecode. Cela vous permet de référencer 
dans la Timeline des fréquences d'images qui 
sont différentes de la fréquence du time code de 
la session.

Si un périphérique SYNC est sélectionné 
dans la boîte de dialogue Peripherals et 
qu'il est correctement connecté dans la 
chaîne Loop Sync, ce périphérique peut 
être utilisé comme Loop Master, et toutes 
les autres interfaces audio Pro Tools|HD 
comme Loop Sync esclaves.

Pour plus d'informations sur les sources 
d'horloge externe, consultez la 
documentation de votre périphérique 
SYNC.
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Section SYNC Setup and Time 
Code Offsets
(Pro Tools HD uniquement)

Sync Setup

Les commandes de la section SYNC Setup 
permettent de configurer les paramètres de 
périphériques SYNC tels que la référence 
d'horloge, la référence de position, le format 
vidéo et la fonction VSO.

Clock Reference Ce menu permet de définir la 
référence d'horloge de Pro Tools.

! Lorsque vous utilisez un périphérique SYNC 
Digidesign, le sélecteur Clock Reference 
répertorie tous les types d'horloge pris en charge 
pour ce périphérique.

! Lorsque vous utilisez des systèmes 
Pro Tools|HD sans périphérique SYNC, vous 
pouvez faire votre choix parmi tous les formats 
ou sources numériques activés depuis votre 
interface Pro Tools|HD I/O (tel que AES, S/PDIF 
ou 1x Word vers le port d'entrée Word Clock de 
l'interface Pro Tools|HD).

Positional Reference Ce menu permet de définir 
la source de timecode que Pro Tools utilise en 
tant que référence de position. 

Video Format Ce menu permet de définir la 
session pour le format NTSC ou PAL. 

\Variable Speed Override (VSO) La fonction 
Variable Speed Override (VSO) nécessite un 
périphérique SYNC Digidesign. 

Si vous connectez un périphérique SYNC au 
système Pro Tools|HD, les commandes VSO se 
trouvent dans la section SYNC Settings de la 
fenêtre Session Setup. 

Indicateur Locked L'indicateur Locked reste 
allumé lorsque le périphérique SYNC est 
verrouillé sur la référence d'horloge 
sélectionnée. L'indicateur Locked clignote si la 
source de référence d'horloge sélectionnée est 
absente ou si sa valeur se trouve hors de la 
fourchette de fréquences dans laquelle l'appareil 
peut se verrouiller.

Indicateur Speed Cal Cet indicateur définit la 
précision de la référence d'horloge entrante. 
L'indicateur Speed Cal s'allume lorsque la 
fréquence de sortie est comprise dans les 
200 ppm (0,02%) de la fréquence 
d'échantillonnage sélectionnée. L'indicateur 
Speed Cal s'éteint lorsque la fréquence 
d'échantillonnage de sortie diffère de la 
fréquence attendue (fréquence cible). 

Commandes VSO dans la fenêtre Session Setup

Pour en savoir plus sur l'utilisation de la 
fonction VSO pour modifier la vitesse de 
lecture de Pro Tools, consultez la 
documentation de votre périphérique SYNC.
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External Time Code Offsets

Dans la zone External Time Code Offsets, 
Pro Tools vous permet de compenser les 
périphériques qui enregistrent constamment un 
décalage fixe d'un nombre d'images (comme 
certains masters vidéo à émission corrigée) ou le 
matériel qui démarre à un autre moment que la 
session elle-même. 

Pro Tools fournit trois types de décalages de 
timecode de début de session. Il s'agit de :

• MMC (Machine à port MIDI)

• 9-Pin (Machine à port série)

• Périphériques de synchronisation (tels que 
les périphériques SYNC Digidesign ou une 
interface MIDI qui fournit le timecode 
MIDI) 

Des valeurs de décalage positives et négatives 
peuvent être saisies pour décaler l'affichage du 
timecode Pro Tools en le retardant ou en 
l'avançant, respectivement. 

Il est possible de définir des valeurs uniques 
pour chacun de ces trois types de décalages ou 
de les lier pour les ajuster les uns par rapport aux 
autres. 

Si vous utilisez l'option MachineControl de 
Digidesign, des options supplémentaires de 
décalages de timecode externe sont disponibles. 
Pour en savoir plus, reportez vous au Guide 
MachineControl.

Section Time Code Settings

Generator

Ce générateur vous permet d'activer la 
génération Pro Tools et la sortie de LTC et de 
MTC. Pour plus d'informations, reportez-vous à 
la section Génération de timecode, page 928.

Using Peripheral : cette option génère un 
timecode en sortie à partir du périphérique 
sélectionné dans la page Synchronization de la 
boîte de dialogue Peripherals.

Using MTC : cette option génère un timecode à 
la destination sélectionnée dans la page 
Synchronization de la boîte de dialogue 
Peripherals.

Freewheel

Les options disponibles dans la section 
Freewheel vous permettent de configurer la 
façon dont Pro Tools passera en mode inertie ou 
poursuivra la lecture si le timecode est 
interrompu ou corrompu. Ces options 
permettent notamment d'éviter les erreurs dues 
à la présence de « trous » (drop-outs) dans le 
timecode source SMPTE mais également les 
pertes temporaires de signal.

None : le mode inertie n'est pas activé. 

Frames : définit un nombre d'images en inertie 
(entre 1 et 120 images). La valeur par défaut est 
8 images, paramètre conseillé pour la plupart 
des applications.

Jam Sync : cette option permet à Pro Tools de se 
synchroniser avec un timecode entrant, puis de 
poursuivre la lecture même si ce timecode 
entrant disparaît complètement. Elle peut 
s'avérer utile si le timecode est altéré ou s'il a été 
effacé accidentellement de la bande source.
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Pull Up/Down

Lorsque Pro Tools est associé à un périphérique 
SYNC ou un autre périphérique d'une autre 
marque compatible avec les fréquences 
d'échantillonnage majorées, cette option 
permet d'accélérer (pull up) ou de ralentir (pull 
down) la fréquence d'échantillonnage actuelle.

Consultez le manuel Guide Pro Tools Sync & 
Surround Concepts pour obtenir des informations 
générales. Pour plus d'informations sur 
l'application des facteurs de majoration dans 
Pro Tools, reportez-vous à Pull Up et Pull Down, 
page 923. 

Time Code Reader Offset (Sync Offset)

Il permet de définir un décalage s'appliquant au 
MIDI Time Code entrant (d'une valeur comprise 
entre –100 000 et +100 000 échantillons). Le 
décalage permanent ainsi créé permet d'affiner 
le point à partir duquel Pro Tools se synchronise 
avec le timecode entrant. Par exemple, pour une 
valeur de -50, un événement dans Pro Tools se 
produit 50 échantillons avant son équivalent 
dans le MIDI Time Code entrant. Vous pourrez 
utiliser cette fonction pour compenser 
d'éventuelles latences lors d'une conversion 
SMPTE-Midi Time Code ou 
analogique/numérique - 
numérique/analogique. 

Préparatifs pour travailler 
avec un code SMPTE
Pour travailler avec un code SMPTE, la première 
étape consiste à choisir la fréquence d'images 
appropriée. Pro Tools prend en charge toutes les 
fréquences d'images SMPTE standard. Si vous 
travaillez avec une bande couchée SMPTE, il est 
important de connaître la fréquence 
d'échantillonnage. Pour ce faire, vous pouvez, 
dans certains cas, utiliser un périphérique SYNC.

Configuration de Pro Tools 
pour travailler avec un code 
SMPTE
Les paramètres système Synchronization et 
MachineControl sont définis dans la boîte de 
dialogue Peripherals de Pro Tools. Ces 
paramètres s'appliquent au système et sont 
conservés quel que soit le type de session sur 
lequel vous travaillez. Configurez ces paramètres 
avant d'ouvrir une session.

D'autres paramètres tels que la fréquence de 
timecode de la session, la fréquence pieds et 
images, l'image de départ et le format d'affichage 
de l'heure de la session peuvent être configurés 
dans la fenêtre Session Setup. Ces paramètres 
sont spécifiques à la session et ne peuvent être 
modifiés que lorsqu'une session est ouverte.

N'oubliez pas, l'application des 
accélérations et ralentissements varie selon 
les différentes procédures. Il est donc 
important d'effectuer une vérification de la 
procédure spécifique employée pour chaque 
projet avant de commencer votre travail.

Pour obtenir des explications complètes sur 
les fréquences SMPTE, consultez le manuel 
Pro Tools Sync & Surround Concepts Guide.

L'option MachineControl n'est prise en 
charge que sur les systèmes Pro Tools|HD.
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Sélection d'un format SMPTE

Pour choisir un format SMPTE :

1  Dans Pro Tools, sélectionnez Setup > Session.

2  Sélectionnez une fréquence d'images (format 
SMPTE) à partir du sélecteur de fréquence 
d'images. 

3  Entrez le nombre d'images désiré pour le mode 
Time Code Freewheel (le cas échéant) dans la 
zone correspondante (voir Freewheel, 
page 919).

Définition de l'image de départ 
d'une session SMPTE

Dans la fenêtre Session Setup, vous pouvez 
définir une image de départ SMPTE pour la 
session. Les bandes de travail vidéo 
commencent rarement à un timecode SMPTE de 
00:00:00:00. Vous pouvez indiquer rapidement 
le timecode de début de votre session en 
fonction de celui de la bande de travail du 
projet. Les fonctions de Pro Tools liées au 
timecode SMPTE (par exemple, le mode Spot) 
utiliseront dès lors cette nouvelle valeur comme 
point de départ de la session.

Timecode de début lors du couchage 
sur une bande

Si vous générez un timecode, il est conseillé de le 
coucher à partir de la valeur 01:00:00:00 (en 
réservant du temps pour les blancs d'amorce, les 
logos, la mesure, etc.). Ceci permet d'éviter les 
problèmes survenant sur certains 
synchroniseurs lors du passage de 23:59:59:29 à 
00:00:00:00 (communément appelé passage à 
zéro).

Pour définir une image de départ SMPTE pour 
votre session :

1  Choisissez Setup > Session. 

2  Entrez une valeur de code SMPTE dans le 
champ Session Start.

Pour saisir une adresse SMPTE entrante en tant 
qu'heure de départ de la session :

1  Cliquez dans le champ Session Start

2  Commencez la lecture de la source de 
timecode. 

3  Une fois positionné sur l'emplacement de 
capture de la valeur entrante, appuyez sur la 
touche égal (=) du pavé numérique. 

4  Appuyez sur Enter pour valider la valeur. Vous 
pouvez modifier par la suite une adresse ainsi 
saisie. Lorsqu'elle se déroule en ligne, la session 
considère l'adresse SMPTE ainsi entrée comme 
son image de début SMPTE.

Si les pistes contiennent des régions et si vous 
retardez l'image de début SMPTE originale (par 
exemple, de 00:00:00:00 à 01:00:00:00), toutes 
les régions existant sur les pistes conservent leur 
position relative, mais commencent plus tard, 
de la valeur du retard ajouté à l'image de début.

5  Si vous modifiez l'heure de début d'une 
session ouverte dans laquelle des pistes existent 
déjà, une boîte de dialogue s'affiche après la 
fenêtre Session Setup. Choisissez l'une des deux 
options suivantes :

Maintain Time Code : place le temps de session 
supplémentaire au début de la session en 
maintenant les régions existantes à leur 
timecode original.
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Maintain Relative Position : place le temps 
supplémentaire de la session au début de la 
session tout en préservant la position relative 
des régions existantes par rapport à la nouvelle 
image de départ. Si vous modifiez par exemple 
l'image de début de la session de 01:00:00:00 à 
00:59:00:00, Pro Tools rallonge la session d'une 
minute afin de prendre en compte la nouvelle 
image de départ, puis avance toutes les régions 
existantes pour préserver leur position relative 
par rapport à cette image de départ. 

Redéfinition de la position du 
timecode
(Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement)

Utilisez cette commande pour redéfinir la 
position de timecode actuelle ainsi que l'heure 
de début de la session. Lorsque vous créez un 
point d'insertion (ou une sélection) et que vous 
entrez la nouvelle position de timecode pour cet 
emplacement, l'heure de début de la session est 
recalculée en fonction de ce nouvel 
emplacement de timecode relatif.

Pour redéfinir la position d'un timecode :

1  A l'aide du sélecteur, cliquez sur une piste (ou 
effectuez une sélection) à l'endroit ou vous 
souhaitez redéfinir la position.

2  Choisissez Setup > Current Time Code 
Position.

3  Entrez un nouveau numéro d'image SMPTE 
qui corresponde au timecode indiqué dans la 
boîte de dialogue.

4  Cliquez sur OK.

Redéfinition d'un emplacement 
Feet+Frames
(Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement)

Utilisez cette commande pour redéfinir la 
position Feet+Frames actuelle. Lorsque vous 
créez un point d'insertion (ou une sélection) et 
que vous entrez la nouvelle position 
Feet+Frames pour cet emplacement, l'heure de 
début de la session est recalculée en fonction de 
ce nouvel emplacement Feet+Frames relatif.

Habituellement, cette commande est utilisée 
pour intégrer à des sessions Pro Tools les signaux 
de tests, pré-roll, amorces normalisées et autres 
données pré-programmées.

Pour définir une position d'image relative pour une 
session (Feet+Frames) :

1  A l'aide du sélecteur, cliquez sur une piste (ou 
effectuez une sélection) à l'endroit ou vous 
souhaitez redéfinir la position.

2  Choisissez Setup > Current Feet+Frames 
Position

3  Entrez un emplacement pieds et images 
(Feet+Frames) qui corresponde au timecode 
indiqué dans la boîte de dialogue.

4  Cliquez sur OK.

Si votre point d'insertion ou votre sélection 
ne fait pas partie des limites d'une grille, 
l'alignement se fait par rapport au pas le 
plus proche de la grille.

Si votre point d'insertion ou votre sélection 
ne fait pas partie des limites d'une grille, 
l'alignement se fait par rapport au pas le 
plus proche de la grille.
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Affichage de l'heure dans les 
images SMPTE
(Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement)

Dans Pro Tools, vous pouvez faire correspondre 
au timecode la valeur affichée dans l'indicateur 
Main Time Scale (SMPTE). Cette valeur sera 
reflétée dans le compteur principal. Pro Tools se 
synchronisera toujours sur le timecode SMPTE 
entrant, mais si l'échelle temporelle est en 
mesures:temps, minutes:secondes ou 
feet.frames, il est généralement préférable 
d'utiliser le timecode SMPTE comme référence.

Pour régler l'indicateur Main Time Scale sur Time 
Code SMPTE, effectuez l'une des opérations 
suivantes :

" Choisissez View > Rulers > Time Code.

– ou –

" Cliquez sur le sélecteur du compteur principal 
dans la fenêtre Edit, puis sélectionnez Time 
Code.

Pro Tools affiche les valeurs de timecode selon la 
fréquence d'images SMPTE sélectionnée.

Affichage du compteur secondaire et 
de l'échelle temporelle secondaire

Vous pouvez afficher une échelle temporelle 
secondaire dans le compteur secondaire. Par 
exemple, si la valeur de l'échelle temporelle 
principale est réglée sur Time Code et que vous 
souhaitez, en utilisant la fréquence d'images 
29.97 Non-Drop, comparer l'heure SMPTE à 
l'heure d'horloge murale, cliquez sur le sélecteur 
du compteur secondaire et sélectionnez l'option 
Min:Secs dans la zone Sub Time Scale.

Pull Up et Pull Down
Pro Tools prend en charge jusqu'à 4 % 
d'accélération (pull up) et de ralentissement 
(pull down), avec une prise en charge 
supplémentaire de 0,1 %. Il est possible de 
définir des fréquences distinctes pour les 
sessions audio et vidéo (lorsque la vidéo a été 
importée ou saisie dans une session). 

Lorsque vous référencez des valeurs 
d'accélération et de ralentissement de 4 %, le 
pourcentage appliqué est exactement de 
4,167 %. Pour plus d'informations, 
reportez-vous à la section tableau 36, page 926.

Même s'il n'est pas requis pour utiliser les 
options étendues d'accélération et de 
ralentissement fournies dans Pro Tools, seul un 
périphérique SYNC peut être contrôlé depuis 
Pro Tools, et rappeler, et restaurer 
automatiquement les facteurs de majoration 
lorsqu'une session est ouverte. Les autres 
périphériques de synchronisation doivent être 
configurés manuellement. 

Sélection de l'échelle temporelle principale à l'aide du 
sélecteur du compteur principal

Les paramètres d'accélération et de 
ralentissement n'affectent pas le timecode 
généré par un périphérique SYNC.
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Configuration des paramètres Pull Up 
et Pull Down

Pour accélérer ou ralentir des données audio ou 
vidéo :

1  Choisissez Setup > Session.

2  Sélectionnez une valeur de Pull Up/Down 
dans la zone Time Code Settings de la fenêtre 
Session Setup.

Accélération et ralentissement audio : contrôle 
la fréquence d'échantillonnage de l'audio. Pour 
plus d'informations, reportez-vous à la section 
Accélération et ralentissement de la fréquence 
d'échantillonnage audio, page 925.

Accélération et ralentissement vidéo : contrôle 
le débit vidéo. Pour plus d'informations, 
reportez-vous à la section Video Frame Rate Pull 
Up and Down, page 927. 

Les options disponibles dans ces menus 
dépendent de la fréquence d'images de la 
session. Il est possible d'appliquer des 
combinaisons en sélectionnant des valeurs dans 
les deux menus. 

Les options disponibles dans ces menus 
dépendent également des paramètres par défaut 
et des paramètres Auto Match Pull Factors 
définis dans le menu Time Code Rate. Voir Pull 
Up et Pull Down étendus, page 924 et Auto 
Match Pull Factors, page 924.

Pull Up et Pull Down étendus

Préférences et commandes de la boîte de dialogue 
Session Setup : Le menu Audio Rate Pull 
Up/Down propose toutes les combinaisons 
possibles de Pull Up et Pull Down pour la 
fréquence d'échantillonnage en question, quelle 
que soit la fréquence d'images de la session. 

De plus, si la timeline comporte une séquence 
QuickTime, la fréquence vidéo peut être 
accélérée ou ralentie de 0,1 %, quelle que soit la 
fréquence d'images de la session. Les versions 
antérieures de Pro Tools activent également le 
mode de ralentissement de la fréquence 
d'images des clips vidéo QuickTime lorsque 
l'audio a été ralenti, de sorte que cette option est 
incluse dans Pro Tools version 5.3.1 ou 
ultérieure pour conserver la compatibilité avec 
des sessions antérieures. 

Auto Match Pull Factors

L'option Auto Match Pull Factors est située dans 
le menu Time Code Rate de la session dans la 
fenêtre Session Setup. Lorsqu'elle est activée, 
Pro Tools règle les cadences de lecture audio et 
vidéo pour qu'elles reflètent tous les 
changements de la fréquence du timecode de la 
session actuelle. 

L'option Auto Match Pull est appliquée en 
fonction du paramètre de majoration actuel. 
Lorsque cette option est activée, si la fréquence 
d'images de la session est modifiée de sorte que 
la vidéo doit être décalée d'une valeur non prise 
en charge, la vidéo reste inchangée. 

Ce paramètre peut être verrouillé, n'est pas 
disponible par défaut et son état est stocké avec 
la session.

Fenêtre Session Setup

Les facteurs de majoration de 4 % ne sont 
disponibles que dans les sessions à 176,4 et 
192 kHz.

Accélération 
et ralentissement vidéo

Accélération 
et ralentissement audio
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Utilisation du paramètre Auto Match Pull 
Factors : exemple

Auto Match Pull Factors associe les facteurs de 
majoration audio et vidéo lorsque la fréquence 
d'images de la session est modifiée. 

Par exemple, si la fréquence d'images d'une 
session Pro Tools est définie sur 25 i/s, les 
données audio et vidéo sont joués sans 
accélération, et l'option Auto Match Pull Factors 
est activée. 

Lorsque vous définissez la fréquence d'images de 
la session sur 24 i/s, les valeurs des paramètres 
d'accélération audio et vidéo sont réduits de 
-4.0% (paramètre de majoration approprié 
requis par la modification apportée à la 
fréquence d'images). 

La mise en correspondance automatique des 
facteurs de majoration est appliquée à tout 
paramètre Audio Rate Pull Up/Down ou Video 
Rate Pull Up/Down défini. Par exemple, si les 
données audio ont été majorées de -0,1 % lors de 
la modification de la fréquence d'images de 
29,97 à 24 i/s, le paramètre Audio Rate Pull 
Up/Down est modifié et est défini sur None. 

Accélération et ralentissement de 
la fréquence d'échantillonnage 
audio

Le menu Audio Rate Pull Up/Down applique des 
facteurs d'accélération et de ralentissement lors 
de lecture ou de l'enregistrement de données 
audio de la session. Toutes les valeurs de 
majoration sont disponibles, quelle que soit la 
fréquence d'images. 

Menu Audio Rate Pull Up/Down de la fenêtre 
Session Setup

Voir également Auto Match Pull Factors, 
page 924.
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Débits audio et options de Pull 
Up/Down

Le tableau 36 répertorie les fréquences 
d'échantillonnage actuelles de chaque option et 
de chaque combinaison d'accélération (pull up) 
et de ralentissement (pull down) (arrondi à 
l'entier le plus proche en Hz) :

Tableau 36. Fréquences d'échantillonnage en fonction des paramètres d'accélération et de ralentissement

Pull Up/Down
Sample Rate (Fréquence d'échantillonnage)

44100 48000 88200 96000 176400 192000

+4,1667 % et 
+0,1 %

45983 50050 91967 100100 n/d n/d

+4.1667% 45938 50000 91875 100000 n/d n/d

+4,1667 % et 
-0,1 %

45892 49950 91783 99900 n/d n/d

+0.1% 44144 48048 88288 96096 176576 192192

–0.1% 44056 47952 88112 95904 176224 191808

-4,0 % et 
+0,1 %

42378 46126 84757 92252 n/d n/d

–4.0% 42336 46080 84672 92160 n/d n/d

-4,0 % et 
-0,1 %

42294 46034 84587 92068 n/d n/d
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Video Frame Rate Pull Up 
and Down

Le sélecteur du menu Video Pull Up/Down vous 
permet de modifier la fréquence 
d'échantillonnage de la lecture de la séquence 
QuickTime indépendamment des valeurs 
d'accélération ou de ralentissement audio. Le 
sélecteur se situe en dessous du menu Audio 
Rate Pull Up/Down dans la fenêtre Session 
Setup. 

Les choix disponibles dans le menu Video Rate 
Pull Up/Down dépendent du format de fichier et 
de la fréquence d'échantillonnage de la 
séquence QuickTime. Les valeurs de majoration 
vidéo sont enregistrées avec la session. 

Effets de l'utilisation du Pull Up ou du 
Pull Down

Les sections suivantes décrivent quelles 
fonctions de Pro Tools sont affectées par les 
valeurs de pull up et de pull down. 

Règle de Time Code 

Les valeurs d'accélération et de ralentissement 
vidéo n'affectent pas la règle de Time Code. 
Assurez-vous que la fréquence 
d'échantillonnage de session est correctement 
définie pour votre projet. Si par exemple vous 
travaillez avec des données vidéo 24 i/s et que 
vous appliquez une valeur d'accélération de 4 %, 
vous devez définir la fréquence 

d'échantillonnage de la session sur 25 i/s pour 
que la règle de Time Code reste alignée. 
De même, si vous travaillez avec de la vidéo 
24 i/s à laquelle est appliquée une valeur 
d'accélération de 0,1 %, définissez la fréquence 
d'échantillonnage sur 29,97.

Lorsque vous travaillez avec un support Avid 
25i/s et qu'une valeur d'accélération de 4 % est 
appliquée à la vidéo, définissez la fréquence 
d'échantillonnage de la session sur 24 i/s.

Plug-in

Pour assurer le bon fonctionnement de sessions 
auxquelles des valeurs d'accélération de l'ordre 
de 4 % sont appliquées, les plug-in doivent 
utiliser l'horloge d'échantillonnage plutôt 
qu'une horloge temporelle absolue. Tous les 
plug-in Digidesign sont basés sur une horloge 
d'échantillonnage. 

Fréquences d'échantillonnage élevées 
et facteurs de majoration

Des facteurs de majoration audio de 4 % ne sont 
pas disponibles avec des sessions ayant des 
fréquences d'échantillonnage de 176,4 et 
192 kHz. 

Pas d'enregistrement vidéo avec le 
mode Pull Up

(périphérique Avid Video requis)

Il est possible que des données vidéo ne puissent 
pas être enregistrées si le mode d'accélération 
vidéo est sélectionné. Si la piste vidéo est activée 
en enregistrement et que des valeurs 
d'accélération du débit vidéo sont définies, ou si 
vous essayez de définir une valeur d'accélération 
vidéo alors que la piste vidéo est activée en 

Menu Video Rate Pull Up/Down de la fenêtre Session 
Setup

Voir également Auto Match Pull Factors, 
page 924.
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enregistrement, Pro Tools affiche une boîte de 
dialogue et désactive l'enregistrement vidéo. 
Pour poursuivre la numérisation, définissez à 
nouveau le menu Video Rate Pull Up sur None. 

Mode Online (en ligne) de 
Pro Tools
Pour déclencher la lecture ou l'enregistrement 
depuis une source externe, le Transport 
Pro Tools doit être mis en ligne. Pro Tools sait 
alors qu'il doit repérer le timecode entrant. 

Pour mettre le Transport Pro Tools en ligne, 
effectuez l'une des opérations suivantes :

" Choisissez Options > Transport Online. 

" Cliquez sur le bouton Online, à l'extrême 
gauche de la fenêtre Transport. 

" Appuyez sur Ctrl+P (Windows) ou sur 
Pomme+P (Mac). 

Le bouton Online clignote et Pro Tools attend 
une adresse SMPTE pour lancer la lecture. Dès 
réception d'un timecode, la lecture débute et le 
bouton Online s'illumine. Les indicateurs de 
sélection d'édition de la fenêtre Edit ainsi que le 
champ Incoming Time de la fenêtre Session 
Setup affichent le timecode entrant. 

Pour mettre Pro Tools hors ligne, procédez comme 
suit :

" Désélectionnez Options > Transport Online.

– ou –

" Désactivez le bouton Online dans la fenêtre 
Transport.

Enregistrement Online

La page Operation Preferences contient deux 
options déterminant comment Pro Tools lance 
l'enregistrement en mode Online.

Record Online at Time Code (or ADAT)
Lock : L'enregistrement en ligne débute dès que 
Pro Tools reçoit un timecode ou un signal de 
synchronisation ADAT et se synchronise sur 
celui-ci. Dans ce cas, il n'est pas nécessaire de 
placer un point d'insertion, ni d'effectuer une 
sélection dans une piste pour définir le point 
d'entrée en enregistrement.

Record Online At Insertion/Selection : avec cette 
option, l'enregistrement en ligne commence là 
où vous avez placé le point d'insertion dans une 
piste. Il se poursuit alors jusqu'à ce que Pro Tools 
ne reçoive plus de timecode. Si vous effectuez 
une sélection dans une piste, Pro Tools 
enregistre en ligne uniquement sur la durée de la 
sélection. 

Génération de timecode
A l'aide d'un périphérique SYNC, Pro Tools peut 
générer un timecode MIDI (MTC) et SMPTE. Il 
est possible de convertir Pro Tools en source de 
synchronisation maître, à laquelle asservir 
d'autres appareils.

Génération de timecode à 30 i/s, 24 i/s ou 
23.976 i/s impossible lorsque le périphérique 
SYNC est verrouillé sur une entrée ou une 
référence vidéo

Un périphérique SYNC ne peut pas générer de 
timecode à 30 i/s, 24 i/s ou 23,976 i/s lorsqu'il 
est verrouillé sur un signal d'horloge vidéo. Si 
vous configurez Pro Tools pour générer un 
timecode de 30 i/s alors que le périphérique 
SYNC est verrouillé sur un signal d'horloge 
vidéo, ce dernier génère en réalité des images à la 
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fréquence standard NTSC de 29,97 i/s. Pro Tools 
peut générer un timecode à des fréquences 
d'image non NTSC si vous utilisez l'horloge 
interne du périphérique SYNC comme source de 
synchronisation.

Pour générer un timecode à l'aide d'un 
périphérique SYNC :

1  Reliez le connecteur LTC Out du périphérique 
SYNC au connecteur SMPTE in des appareils à 
asservir. Si l'appareil asservi reconnaît le code 
MTC, reliez le connecteur MTC OUT du 
périphérique SYNC au connecteur MIDI IN de 
l'appareil asservi. 

2  Assurez-vous que le périphérique SYNC est 
sous tension.

3  Dans Pro Tools, choisissez Setup > Peripherals 
et cliquez sur Synchronization.

4  Dans la section Digidesign Synchronization 
Device, sélectionnez Enable SYNC Peripheral.

5  Cliquez sur OK pour refermer la boîte de 
dialogue Peripherals.

6  Choisissez Setup > Session et sélectionnez la 
fréquence d'images appropriée à partir du menu 
contextuel Time Code Rate.

7  Dans la partie SYNC Setup de la fenêtre 
Session Setup, choisissez une référence d'horloge 
dans le sélecteur Clock Reference. Notez que la 
disponibilité des références d'horloge dépend 
des fréquences d'échantillonnage. Voir External 
Clock Sources :, page 917.)

8  Cliquez sur le bouton Online dans la fenêtre 
Transport, puis cliquez sur Play. Pro Tools 
génère et émet en sortie un timecode depuis le 
périphérique SYNC.

Utilisation de la fonction MIDI 
Machine Control
Pro Tools permet de transmettre des 
informations de position à des machines 
externes et de contrôler leurs transports à l'aide 
de messages MMC (MIDI Machine Control). 

Contrôle d'appareils externes via 
MMC

Vous pouvez contrôler tout périphérique 
prenant le MMC en charge directement à partir 
de Pro Tools, avec soit le périphérique, soit 
Pro Tools en tant que maître de l'horloge du 
système.

Les machines externes prises en charge par 
Pro Tools mettent en œuvre uniquement des 
communications en « boucle ouverte » De ce 
fait, bien que Pro Tools joue le rôle de transport 
maître, toute manipulation éventuelle des 
transports réalisée directement sur l'appareil 
externe lui-même n'est pas répercutée à 
Pro Tools. En revanche, vous pouvez 
sélectionner le périphérique externe (MMC) 
dans le menu local Transport et agir sur les 
commandes de transport apparaissant à l'écran 
de Pro Tools pour commander le périphérique. 

Pro Tools ne prend pas en charge la préparation 
en enregistrement des pistes des machines 
externes commandées via MMC. Pour procéder 
à un enregistrement sur la machine externe, 
vous devrez préparer les pistes manuellement. 

Si vous modifiez les fréquences d'images de 
timecode en cours de session, bon nombre 
de convertisseurs SMPTE-MIDI Time Code 
devront être éteints puis rallumés afin de 
reconnaître la nouvelle fréquence d'images.
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Activation de MIDI Machine 
Control dans Pro Tools

Pro Tools maître de MMC

Lorsque Pro Tools est le maître, il envoie des 
commandes MMC au périphérique esclave et 
reçoit des informations MTC de ce même 
périphérique.

Pour asservir un périphérique externe à Pro Tools 
avec le MMC (MIDI Machine Control) :

1  Connectez un port de sortie MIDI à votre 
interface MIDI Pro Tools sur le port approprié du 
périphérique esclave.

2  Connectez la sortie MTC du périphérique 
esclave à un port MIDI IN de votre interface 
MIDI Pro Tools.

3  Dans Pro Tools, choisissez Setup > Peripherals 
et cliquez l'onglet Synchronization.

4  Désélectionnez l'option Enable SYNC 
Peripheral. 

5  A partir du menu contextuel MTC Reader Port, 
sélectionnez le port MIDI IN auquel le 
périphérique esclave est connecté (la source 
d'informations MTC du périphérique esclave). 

6  Cliquez sur l'onglet Machine Control dans la 
fenêtre Peripherals.

7  Dans la zone MIDI Machine Control (Master), 
sélectionnez Enable.

8  Dans la section MIDI Machine Control 
(Master), sélectionnez à partir du menu 
contextuel le port MIDI OUT auquel le 
périphérique esclave est connecté.

9  Paramétrez le numéro ID MMC pour lequel 
cette information sera envoyée dans le champ 
« ID ». 

Les commandes MMC intègrent le numéro 
d'identification de la machine visée par ces 
commandes. Il existe 128 numéros ID MMC 
classés de 0 à 127. L'ID par défaut 127 est un 
paramètre spécial qui transmet les données vers 
les 128 ID MMC. Avec un paramètre de 127, 
Pro Tools transmettra les commandes MMC à 
tous les ID MMC. 

10  Définissez une durée de pré-roll pour le 
périphérique esclave MMC. La fonction de 
pré-roll permet au périphérique de disposer de 
suffisamment de temps pour se synchroniser au 
timecode transmis par Pro Tools. Cette durée est 
variable selon l'appareil externe. Si la durée de 
pré-roll est insuffisante, le périphérique n'aura 
peut-être pas le temps de se synchroniser avant 
d'arriver à la position temporelle désirée.

L'option MachineControl de Digidesign 
prend en charge la préparation à distance 
des pistes en enregistrement sur les 
machines compatibles avec les protocoles 
Sony 9 broches et V-LAN. Pour plus 
d'informations, reportez-vous à la section « 
Activation de pistes à distance », page 934.

Onglet Machine Control de la boîte de dialogue 
Peripherals
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11  Cliquez sur OK pour refermer la boîte de 
dialogue Peripherals.

12  Dans la fenêtre Transport de Pro Tools, 
choisissez Transport = MMC.

Pro Tools peut désormais contrôler le transport 
sur la machine sélectionnée et agir en tant que 
maître d'horloge.

13  Pour que le transport Pro Tools suive 
l'emplacement du périphérique esclave, cliquez 
sur le bouton Online dans la fenêtre Transport.

Pro Tools esclave MMC

Lorsque ProTools est asservi, il reçoit des 
commandes MMC du périphérique maître et 
renvoie les informations MTC au périphérique 
esclave.

Pour asservir Pro Tools à un périphérique externe 
en utilisant MIDI Machine Control :

1  Connectez un port MIDI IN de votre interface 
MIDI Pro Tools sur le port approprié du 
périphérique maître.

2  Connectez un port MIDI OUT de votre 
interface MIDI Pro Tools au port d'entrée MTC 
du périphérique maître.

3  Dans Pro Tools, sélectionnez Setup > Session.

4  Dans la partie Time Code Settings de la fenêtre 
Session Setup, sélectionnez Using MTC. 

5  Choisissez Setup > Peripherals, puis cliquez sur 
l'onglet Synchronization. 

6  Désélectionnez l'option Enable SYNC 
Peripheral si elle est sélectionnée.

7  A partir du menu contextuel MTC Generator 
Port, sélectionnez le port MIDI OUT auquel le 
périphérique maître est connecté (la destination 
d'informations MTC à partir de Pro Tools). 

8  Cliquez sur l'onglet Machine Control dans la 
fenêtre Peripherals.

9  Dans la section MIDI Machine Control 
(Slave), sélectionnez Enable.

10  Paramétrez le numéro identifiant MMC 
(canal) pour lequel cette information sera reçue 
dans le champ « ID ». 

11  Cliquez sur OK pour refermer la boîte de 
dialogue Peripherals.

Pro Tools répond alors aux commandes MMC 
du périphérique externe.

Pour que Pro Tools puisse recevoir des 
commandes MMC (MIDI Machine 
Control), la source MMC doit être activée 
dans la boîte de dialogue Input Devices. 
Pour plus d'informations, consultez la 
section Activation des périphériques 
d'entrée, page 348.

Onglet Machine Control de la boîte de dialogue 
Peripherals
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Commande des périphériques 
MMC avec la fenêtre Transport de 
Pro Tools 

Vous pouvez utiliser la fenêtre Transport de 
Pro Tools pour contrôler à distance tous les 
dispositifs activés (comme par exemple un 
appareil vidéo non linéaire). Il suffit que vous 
activiez les dispositifs pour écouter l'adresse que 
vous avez entrée pour le MMC. La fenêtre 
Transport contrôle alors le transport de 
Pro Tools et tous les périphériques asservis. 

Pour contrôler des périphériques externes à partir 
de la fenêtre de Transport de Pro Tools :

" Sélectionnez Pro Tools ou MMC dans le menu 
local Transport de la fenêtre Pro Tools 
Transport. L'élément sélectionné jouera le rôle 
de transport maître.

• Une fois le transport maître réglé sur 
Pro Tools, la position de lecture est régie 
par le curseur qui apparaît à l'écran de 
Pro Tools. 

• Lorsque le transport maître est réglé sur 
MMC, la position de lecture est régie par 
celle de la machine externe. 

Paramètres de transport MMC

Si vous avez choisi MMC, les options suivantes 
permettent de définir le comportement du 
transport machine dans la page 
Synchronization Preferences.

Machine Chases Memory Location : lorsque cette 
option est sélectionnée, le déplacement vers un 
emplacement donné dans une session à l'aide 
d'un emplacement mémoire fait « suivre » le 
transport connecté, qui se rend aussi à cet 
emplacement. 

Machine Follows Edit Insertion/Scrub : lorsque 
cette option est sélectionnée, la recherche d'un 
emplacement spécifique dans une session par 
déplacement du point de sélection ou scrubbing 
d'une piste fait « suivre » le transport connecté, 
qui se rend aussi à cet emplacement.

Mise hors ligne d'un périphérique

Utilisez le menu contextuel Online à partir du 
sélecteur de transport maître pour mettre un 
périphérique MIDI (ou Machine) hors ligne.

Pour mettre un périphérique hors ligne :

1  Cliquez sur le sélecteur de transport maître.

2  Cliquez sur le menu contextuel Online et 
cliquez sur le périphérique (Machine ou MIDI) 
pour le désélectionner. Les choix proposés 
varient en fonction du transport maître actuel et 
des périphériques configurés dans Pro Tools.

Sélection d'un transport maître

Désélection d'un périphérique pour le mettre hors ligne

Menu contextuel Online
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Pour remettre un périphérique en ligne, il suffit 
de le resélectionner dans le menu contextuel 
Online.

Configuration d'un temps de 
synchronisation minimal
Le temps de synchronisation correspond à la 
durée nécessaire pour que les différentes 
machines composant votre système se 
synchronisent entre elles. Cette durée est 
différente pour chaque machine. Pour régler le 
temps de synchronisation dans Pro Tools, 
entrez la valeur dans le champ Minimum Sync 
Delay de la fenêtre Synchronization, dans la 
boîte de dialogue Peripherals. La valeur 
minimale disponible est 15 images. Déterminez 
la valeur minimale de temps de synchronisation 
pour votre système, puis entrez cette valeur dans 
la zone Minimum Sync Delay. Sur les systèmes 
utilisant MachineControl de Digidesign, activer 
le paramètre de timecode Use Serial accélérera 
considérablement la synchronisation. Pour que 
le timecode série soit utilisable, il faut que les 
périphériques SYNC et externes soient 
synchronisés au signal vidéo interne.

Pour définir un temps de synchronisation minimal :

1  Choisissez Setup > Preferences, puis cliquez 
sur Synchronization. 

2  Saisissez un nombre d'images dans le champ 
Minimum Sync Delay. 

3  Cliquez sur OK pour refermer la boîte de 
dialogue Preferences. 

Configuration de l'option Minimum Sync Delay 
pour les machines MMC externes référencées 
sur un signal de house sync

Si vous contrôlez via MMC, depuis Pro Tools, 
une machine référencée sur un signal de house 
sync, cette dernière commence par se rendre à 
l'emplacement MMC, puis se référence au signal 
d'image couleur. Dans le cas d'un signal de 
house sync, il faut 4 images pour se verrouiller 
sur la séquence d'images couleur. Si le temps de 
synchro minimal que vous avez entré est 
inférieur à la durée requise par la machine MMC 
pour se rendre à l'emplacement requis puis se 
verrouiller sur la séquence couleur, la lecture 
débutera avant que la machine ne soit 
synchronisée. Dans ce scénario, la valeur de 
l'option Minimum Sync Delay doit être 
supérieure à la durée requise pour le verrouillage 
sur la séquence d'images couleur. Le problème 
ne se pose pas avec le périphérique SYNC, qui 
refuse de se synchroniser tant qu'il n'est pas calé 
sur la séquence d'images couleur. 

Paramétrage de la source LTC 
Pro Tools
Lors du verrouillage de Pro Tools à une source de 
timecode stable, activez la préférence Stable LTC 
Source. La sélection de cette option supprime le 
délai d'attente d'une seconde avant la tentative 
de synchronisation de Pro Tools sur un 
timecode LTC entrant.

Le menu contextuel Online affiche 
uniquement les périphériques qui ont été 
configurés correctement dans Pro Tools.

Pour savoir comment configurer des 
périphériques MIDI, reportez-vous à la 
section Activation de MIDI Machine 
Control dans Pro Tools, page 930.

Pour savoir comment configurer des 
périphériques Machine, reportez-vous au 
Guide MachineControl.
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Pour paramétrer l'option Pro Tools LTC Source :

1  Choisissez Setup > Preferences, puis cliquez 
sur Synchronization. 

2  Effectuez l'une des opérations suivantes :

• Pour des sources de timecode stables 
(comme par exemple un générateur LTC), 
sélectionnez l'option Stable LTC Source.

• Pour les sources de timecode comme les 
magnétophones, désélectionnez cette 
option.

3  Cliquez sur OK. 

Activation de pistes à 
distance
L'option MachineControl™ de Digidesign pour 
Pro Tools permet de préparer à distance des 
pistes en enregistrement sur les machines 
compatibles avec le protocole 9 broches (ou 
V-LAN pour le transport uniquement). Sans 
cette option, Pro Tools ne prend pas en charge la 
préparation à distance des pistes en 
enregistrement sur les machines externes. 
MachineControl, outre autoriser la préparation 
à distance des pistes en enregistrement, permet à 
Pro Tools de se comporter en tant que maître ou 
esclave vis-à-vis de machines externes 
compatibles avec le protocole Sony 9 broches 
(ou V-LAN pour le transport uniquement).

MIDI Beat Clock
Certains périphériques MIDI tels que les 
batteries, les séquenceurs matériels et les 
arpégiateurs ne peuvent se synchroniser qu'avec 
un signal d'horloge de type MIDI Beat Clock. 
Pour les synchroniser avec Pro Tools, il faut 
donc leur transmettre un signal d'horloge MIDI 
Beat Clock. De nombreux plug-in prennent 
également en charge les signaux d'horloge MIDI 
Beat Clock.

Pour transmettre l'horloge MIDI Beat Clock :

1  Choisissez Setup > MIDI > MIDI Beat Clock.

2  Dans la zone de dialogue MIDI Beat Clock, 
sélectionnez l'option Enable MIDI Beat Clock.

3  Sélectionnez les périphériques chargés de la 
réception de l'horloge MIDI Beat Clock. Si votre 
interface MIDI ne prend pas en charge la 
transmission de MIDI Beat Clock vers des ports 
séparés, seule l'interface apparaît en tant que 
destination.

4  Cliquez sur OK.

Choisissez Setup > Machine Track Arming 
Profiles pour configurer votre système, puis 
sélectionnez Window > Machine Track 
Arming pour afficher la fenêtre Machine 
Track Arming.

Pour plus d'informations sur l'activation de 
pistes avec MachineControl, remportez-
vous au manuel MachineControl Guide.

Boîte de dialogue MIDI Beat Clock
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Placement de régions à des 
adresses SMPTE
(Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement)

Le processus de spotting (placement) consiste à 
assigner des musiques ou des sons à des 
emplacements déterminés par une adresse 
SMPTE spécifiques, dans un film ou une vidéo. 
Cette fonction permet notamment de placer :

! Des régions entières sélectionnées avec l'outil 
d'accrochage de temps. Plusieurs régions, dans 
quel cas Pro Tools place la première région dans 
votre sélection.

! Un point spécifique à l'intérieur d'une région, 
en cliquant avec le sélecteur sur ce point, puis en 
sélectionnant Region > Identify Sync Point. 

! Des session ou des pistes, en les faisant glisser 
à partir d'un navigateur jusqu'à l'option 
Timeline (timeline) ou la liste des régions. 

mode Spot

En mode Spot, pour placer rapidement une 
région sur une piste, il suffit de cliquer dessus 
avec l'outil d'accrochage de temps. 

Le mode Spot permet également de faire glisser 
une région de la liste des régions vers une piste 
depuis un navigateur Digibase. 

Boîte de dialogue Spot

La boîte de dialogue Spot s'affiche lorsque vous 
déplacez une région vers une piste ou cliquez sur 
une région avec l'outil d'accrochage de temps en 
mode Spot. Les champs numériques jouent un 
rôle d'affichage de données et de contrôle 
d'édition pour les régions sélectionnées. 

Selon le format d'échelle de synchronisation 
choisi, les informations de ces champs sont 
exprimées sous forme d'un timecode SMPTE, en 
minutes:secondes, en pieds:images, en 
échantillons ou en mesures/temps.

Le champ actif pour la saisie de données 
numériques apparaît en surbrillance. Entrer une 
valeur dans un champ déplace un élément 
sélectionné vers l'emplacement temporel choisi. 
Les champs Start, Sync Point et End sont 
accessibles lorsque l'outil d'accrochage de temps 
est activé. Seuls les champs Start ou End (selon le 
point d'insertion de la souris) et Duration sont 
accessibles lorsque l'un des outils de trimming 
est activé (voir Utilisation des outils de 
trimming en mode Spot, page 937).

Boîte de dialogue Spot

Pour augmenter ou réduire les valeurs 
SMPTE d'un nombre d'images spécifique 
dans la boîte de dialogue Spot, appuyez sur 
la touche plus (+) ou moins (–) du pavé 
numérique, saisissez un nombre, puis 
appuyez sur Entrée.
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Option Use Subframes

Une sous-image (Subframe) représente 1/100e 
d'image. L'option Use Subframes permet 
d'utiliser ces unités plus petites pour obtenir une 
plus grande précision. Cette commande ajoute 
un champ temporel supplémentaire dans la case 
SMPTE en heures:minutes:secondes:images, qui 
s'affiche à l'extrême droite lorsque cette option 
est activée. Utilisez un point (.) comme 
séparateur entre les valeurs d'image et de 
sous-image.

Capture d'un timecode

Pro Tools permet également de capturer 
facilement des valeurs de timecodes « à la 
volée » dans la boîte de dialogue Spot en 
appuyant sur la touche égal (=) ou en cliquant 
sur le bouton Current Time tandis que Pro Tools 
reçoit un timecode valide. L'option VITC permet 
de capturer avec précision un emplacement 
SMPTE sur un magnétoscope en mode pause ou 
défilant au « ralenti ».

Lorsque Time Code est sélectionné dans la zone 
Time Scale, appuyez sur la touche égal (=) pour 
capturer le timecode entrant. Lorsque Bars:Beats 
est sélectionné dans la zone Time Scale, appuyez 
sur la touche égal (=) pour capturer la mesure la 
plus proche.

Bien que le bouton Capture Time Code 
fonctionne avec des timecodes LTC ou VITC 
« tournant » librement, seule la fonction VITC 
permet de capturer le timecode d'une image 
arrêtée. 

Les périphériques SYNC peuvent lire le VITC. 
Avec 
MachineControl et un périphérique SYNC, vous 
pouvez également lire le timecode série.

Pour placer une région sur une valeur SMPTE 
spécifique :

1  Choisissez Window > Edit.

2  Définissez l'échelle temporelle principale sur 
le time code. Reportez-vous à la section 
Définition de l'image de départ d'une session 
SMPTE, page 921.)

3  Cliquez sur le bouton Spot dans l'angle 
supérieur gauche de la fenêtre Edit pour 
configurer Pro Tools en mode Spot.

4  Identifiez l'adresse SMPTE à partir de laquelle 
vous souhaitez déclencher la lecture de votre 
région en arrêtant la vidéo sur cette image. 

5  A l'aide de l'outil d'accrochage de temps, 
cliquez sur une région dans une piste ou dans la 
liste des régions et faites-la glisser vers une piste. 
La boîte de dialogue Spot apparaît.

6  Entrez l'emplacement SMPTE en utilisant une 
des méthodes suivantes : 

Champ horaire supplémentaire avec option Use 
Subframes activée

Les sous-images ne sont pas disponibles 
dans le champ Current Time.

Pour utiliser le mode Remote avec 
MachineControl, vous devez disposer d'un 
port série approuvé. Consultez le site Web 
www.digidesign.com pour obtenir la liste 
complète des ports actuellement approuvés.

Mode Spot activé
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• Si vous utilisez le VITC, appuyez sur la 
touche égal (=) du pavé numérique ou 
cliquez sur Current Time Code pour saisir 
la valeur de timecode SMPTE d'un 
magnétoscope en mode pause.

– ou –

• Si vous utilisez un LTC, une fois l'option 
Time Code sélectionnée dans la zone Time 
Scale, appuyez sur la touche égal (=) du 
pavé numérique pour capturer la valeur de 
timecode entrant. Lorsque Bars:Beats est 
sélectionné dans la zone Time Scale, 
appuyez sur la touche égal (=) pour 
capturer la mesure la plus proche.

7  Si la région a été enregistrée alors que 
Pro Tools était « en ligne », vous pouvez utiliser 
le bouton Original Time Stamp pour rappeler et 
saisir la position d'image SMPTE à laquelle la 
région a été enregistrée à l'origine. Cette 
méthode permet également d'accéder à un 
marquage temporel défini par l'utilisateur. Pour 
plus d'informations, reportez-vous à la section 
Marquage temporel, page 938.

8  Cliquez sur OK pour refermer la boîte de 
dialogue. La région se déplace à l'adresse SMPTE 
choisie. Lorsque la session se déroule en ligne, 
lorsque le timecode arrive à cette adresse, la 
lecture de la région est déclenchée.

Placement automatique de 
régions

L'option Auto-Spot Regions de Pro Tools 
simplifie encore le placement des régions. Si 
vous utilisez le VITC avec cette option activée, 
ou le logiciel MachineControl, vous pouvez 
mettre en pause la bande vidéo à l'emplacement 
SMPTE de votre choix, puis cliquer sur une 
région avec l'outil d'accrochage de temps : la 
région se place alors automatiquement à cette 
adresse de timecode. 

Vous pouvez également utiliser la fonction de 
timecode série de MachineControl pour le 
placement automatique en activant 
MachineControl et le timecode série du 
périphérique. 

Pour placer une région automatiquement :

1  Choisissez Options > Auto-Spot Regions.

2  Si vous utilisez le VITC, repérez l'adresse 
SMPTE à laquelle vous souhaitez déclencher la 
lecture de votre région en arrêtant la vidéo sur 
l'image correspondante. 

3  Cliquez sur la région à l'aide de l'outil 
d'accrochage de temps. La région va alors se 
placer automatiquement à l'adresse de timecode 
désirée (celle où la vidéo est arrêtée).

Utilisation des outils de trimming 
en mode Spot

Vous pouvez utiliser la zone de dialogue Spot 
pour « rogner » des régions, et notamment les 
heures de début/fin/durée et les adresses de 
timecode entrant de référence. Si vous cliquez 
sur une région en mode Spot avec un des outils 
de trimming, la boîte de dialogue Spot apparaît. 
Vous pouvez alors saisir une valeur dans les 
champs Start, End et Duration afin de spécifier 
le point exact de rognage du début ou de la fin 

Cliquer sur une région avec un outil de 
trimming permet de la « rogner » jusqu'à 
l'emplacement du timecode en cours.

Les régions sont placées automatiquement 
en fonction de leur temps de début, à moins 
que vous n'ayez défini préalablement un 
point de synchronisation (voir Identification 
d'un point de synchronisation, page 939). 
Si la région contient un point de 
synchronisation, son placement s'effectue 
par celui-ci. 
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de la région. Cette option permet également de 
modifier la durée d'une région, afin de la faire 
correspondre à un point de repère visuel 
particulier. 

Rogner une région contenant un point de 
synchronisation (voir Identification d'un point 
de synchronisation, page 939) ne modifie pas 
l'adresse SMPTE de ce point, à moins que le 
rognage ne s'effectue au-delà de ce point.

Marquage temporel
Pro Tools affecte un marquage temporel à 
chaque région enregistrée en ligne, utilisant le 
timecode SMPTE original d'enregistrement du 
son. Pour rappeler ce timecode SMPTE d'origine 
pour une région, cliquez sur le bouton Original 
Time Stamp dans la zone de dialogue Spot.

Vous pouvez également placer une région en 
fonction d'un marquage temporel SMPTE 
utilisateur indépendant, en utilisant la 
commande Time Stamp du menu déroulant de 
la liste des régions. Une fois la région marquée 
temporellement au moyen de cette commande, 
cliquez sur le bouton User Time Stamp pour la 
replacer conformément à son emplacement 
SMPTE défini par l'utilisateur.

Show Original Time Code in 
Regions

Cette commande affiche le marquage temporel 
SMPTE original de toutes les régions 
appartenant à des pistes. Cette valeur SMPTE 
représente l'heure de l'enregistrement « en 
ligne » original de la région sur Pro Tools, et ne 
reflète pas nécessairement l'emplacement 
SMPTE actuel de la région sur une piste.

Pour afficher le marquage temporel original sur les 
régions :

" Choisissez View > Region > Original Time 
Stamp.

Pour masquer le marquage temporel original :

" Choisissez View > Region > No Time.

Création d'un marquage temporel 
utilisateur

Pour créer un marquage temporel utilisateur 
SMPTE indépendant, exécutez la commande 
Time Stamp du menu déroulant de la liste des 
régions. Cette commande permet de 
sélectionner une ou plusieurs régions pour 
redéfinir leur marquage temporel. Le marquage 
temporel original et le marquage temporel 
utilisateur sont alors enregistrés avec la session.

Lors du premier enregistrement des données 
audio, le marquage temporel utilisateur 
correspond au marquage temporel original. 
Vous pouvez toutefois modifier le premier à tout 
moment à l'aide de la commande Time Stamp. 
Cette fonctionnalité est particulièrement utile 
en post-production, lorsque le timecode SMPTE 
des bandes vidéo de travail subit de nombreuses 
modifications d'une version de montage à 
l'autre.
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Pour marquer temporellement une ou plusieurs 
régions avec une nouvelle valeur SMPTE :

1  Sur une piste, sélectionnez la région à 
marquer.

2  Dans le menu déroulant de la liste des régions, 
choisissez la commande Time Stamp.

3  Entrez une nouvelle valeur SMPTE en 
effectuant l'une des opérations suivantes : 

• Entrez les valeurs manuellement (via les 
flèches de direction). 

• Cliquez sur le bouton Current Time Code 
(ou appuyez sur la touche égal (=)), si vous 
souhaitez saisir l'adresse du timecode 
entrant

• Cliquez sur le bouton Current Selection, si 
vous souhaitez entrer l'heure de début de la 
sélection actuelle à l'écran.

4  Cliquez sur OK pour refermer la boîte de 
dialogue.

Cette commande peut être utilisée en mode de 
traitement « par lots » pour configurer de 
nouveaux marquages temporels pour plusieurs 
régions simultanément. Pour ce faire, il suffit de 
sélectionner plusieurs régions et d'exécuter la 
commande Time Stamp Selected. Des zones de 
dialogue correspondant à chaque région 
s'ouvrent successivement. Utilisez-les pour saisir 
les nouvelles valeurs.

Une fois saisis, les marquages temporels 
utilisateur peuvent être affichés dans toutes les 
régions appartenant à des pistes. 

Pour afficher le marquage temporel utilisateur sur 
les régions :

" Choisissez View > Region > User Time Stamp.

Pour masquer le marquage temporel utilisateur :

" Choisissez View > Region > No Time.

Identification d'un point de 
synchronisation
La commande Identify Sync Point de Pro Tools 
permet d'identifier un point particulier d'une 
région en vue de son placement audio (en 
mode Spot). 

Scénario de placement d'effets sonores : 
Votre effet sonore (d'un seul tenant) consiste en 
un grincement de porte, suivi du claquement de 
sa fermeture, qui résonne quelques secondes 
dans la réverbération de la pièce. La partie 
« claquement » de l'effet, qui doit être 
synchronisée exactement avec l'image, ne se 
produit pas au tout début du fichier audio, ni à 
la fin. Elle se trouve vers le centre du fichier, ce 
qui complique son positionnement. Dans ce 
scénario, utilisez la commande Identify Sync 
Point pour créer un point dans la région, puis 
synchroniser ce point avec un timecode SMPTE. 

Boîte de dialogue Time Stamp

Pour plus d'informations sur les points de 
synchronisation, consultez la section Points 
de synchronisation, page 504.
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Pour créer un point de synchronisation dans une 
région :

1  Effectuez l'une des opérations suivantes :

• Cliquez avec le sélecteur sur le point de la 
région à synchroniser à un emplacement 
SMPTE précis. 

– ou –

• Appuyez sur la touche fléchée vers le bas au 
cours de la lecture. 

2  Choisissez Region > Identify Sync Point. 
L'heure SMPTE actuelle est automatiquement 
entrée en tant qu'emplacement SMPTE pour le 
point de synchronisation. Une petite flèche 
orientée vers le bas s'affiche en bas de la région, 
avec une fine ligne grise verticale, pour indiquer 
l'emplacement du point de synchronisation.

Résolution des problèmes de 
synchronisation
Si vous ne parvenez par à faire fonctionner la 
synchronisation SMPTE correctement, les 
suggestions suivantes vous aideront à résoudre 
les problèmes les plus courants. 

Utilisez le champ Incoming/Current Time de la 
fenêtre Session Setup en tant que référence.

L'indicateur Incoming Time de la fenêtre Session 
Setup indique si Pro Tools reçoit du timecode. Si 
ce champ semble inactif lorsque du timecode 
entre dans votre périphérique de lecture de 

timecode, vérifiez les paramètres du 
périphérique matériel, sa connexion à 
l'ordinateur et votre configuration Multimedia 
Setup (Windows) et AMS (Mac).

Couchez le code SMPTE avant 
l'enregistrement.

Toutes les bandes (audio et vidéo) utilisées dans 
votre configuration doivent être couchées avec 
un timecode SMPTE avant d'y enregistrer des 
données audio, ou dans Pro Tools. Si les bandes 
ne sont pas couchées avec un timecode, votre 
système peut sembler fonctionner mais la 
synchronisation ne s'effectue pas correctement. 
Au contraire, les machines et Pro Tools 
dériveront de plus en plus l'une par rapport à 
l'autre au fil du temps.

Ce problème se manifeste également lorsque des 
données audio sont enregistrées dans Pro Tools 
sans synchronisation SMPTE (si elles ont été 
enregistrées avant la session en cours, par 
exemple). Il sera alors impossible de 
synchroniser précisément les données audio 
avec un magnétophone analogique ou un 
magnétoscope, puisque les données audio de 
Pro Tools n'ont pas été enregistrées 
synchronisées au timecode SMPTE issu du 
magnétophone analogique ou du 
magnétoscope.

Points de synchronisation

Points de synchronisation

Lorsque vous utilisez MachineControl, 
l'indicateur Incoming Time affiche le code 
9-pin, même si le périphérique LTC n'est 
pas connecté.
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Synchronisez tous les composants de votre 
système.

Lors du couchage du timecode, assurez-vous que 
le générateur de timecode et le magnétoscope 
sont référencés à un même signal de référence, 
issu d'un quartz. Par exemple, lors du couchage 
d'un timecode à 29,97 i/s Drop Frame sur un 
magnétoscope, le générateur SMPTE et le 
magnétoscope doivent être référencés à un 
même générateur de « black burst » ou de house 
sync. Au cours de la lecture, la platine maîtresse 
doit aussi être référencés à ce signal de « black 
burst » ou house sync. 

Cette convention assure la compatibilité de 
votre bande entre les phases d'enregistrement et 
de lecture et lors de la lecture sur des appareils 
différents, dans d'autres studios. Ainsi, lors de la 
lecture d'une bande couchée avec un timecode, 
la machine lectrice doit être référencée à la 
même fréquence d'images que la machine 
d'enregistrement lors du couchage du timecode. 
Lorsque vous couchez un timecode sur une 
machine audio, celle-ci peut être en « roue 
libre » et non référencée ; en revanche, lors de la 
lecture, elle doit être contrôlée par un 
synchroniseur référencé à un signal de house 
sync.

Quelle est la valeur réelle de fréquence 
d'images de votre support ?

Si vous recevez vos données d'une société de 
production au lieu de les enregistrer 
vous-même, vérifiez impérativement que la 
fréquence d'images SMPTE utilisée est 
correctement spécifiée sur la bande. Plusieurs 
formats de timecode utilisent la même 
résolution (telles que 23.976 i/s et 24 i/s) bien 
qu'ils fonctionnent à des fréquences d'images 
par seconde légèrement différentes.

Vous pouvez utiliser un périphérique SYNC 
Digidesign (et certains produits d'autres 
marques) pour déterminer la fréquence 
d'images.

29.97Fréquence 29,97 i/s Non-Drop non 
reconnue

29,7 i/s Non-Drop désigne une version 
légèrement plus lente du timecode 30 i/s 
Non-Drop. Lorsque la fréquence de 29,97 i/s 
Non-Drop est utilisée en vidéo couleur, chaque 
image vidéo correspond à une image SMPTE, 
sans devoir utiliser de format de timecode Drop. 
Aucune image n'étant omise, les calculs horaires 
et de position se trouvent grandement 
simplifiés.

Certains périphériques matériels et logiciels ne 
reconnaissent pas la fréquence d'images 
29,97 Non-Drop en tant que telle. Par exemple, 
tout convertisseur standard SMPTE-MTC ne la 
reconnaît pas explicitement. Vous devrez alors 
indiquer au convertisseur d'attendre une 
fréquence de 30 i/s Non-Drop. En réalité, un 
grand nombre de périphériques reconnaissant le 
format SMPTE lisent correctement la fréquence 
29,97 Non-Drop s'ils sont configurés pour lire la 
fréquence 30 i/s Non-Drop.

Tout lecteur SMPTE utilisant des valeurs de 
timecode pour effectuer des calculs en temps 
réel (à l'instar de Pro Tools en cas de 
déclenchement et de synchronisation à un code 
SMPTE) doit également être informé que la 
fréquence d'images est de 29,97 et non 30 i/s. 
Pro Tools permettant de choisir cette fréquence 
d'images, cela ne pose pas de problème 
particulier. En revanche, le problème réside dans 
l'incapacité de nombreux utilisateurs à 
distinguer ces deux fréquences.
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Certaines sociétés de production fournissent des 
bandes de travail vidéo couchées avec un 
timecode à 29,97 i/s mais écrivent sur la boîte 
« 30 i/s NTSC », ce qui signifie en réalité 
29,97 i/s Non-Drop.

Ainsi, lorsque la bande arrive en votre 
possession, vous ne connaissez pas sa fréquence 
d'images réelle. Si vous envoyez un timecode 
29,97 Non-Drop à un système Pro Tools 
configuré pour recevoir un timecode à 30 i/s 
Non-Drop, il en résultera une dérive temporelle 
d'environ 1,8 image par minute, ce qui 
désynchronisera la lecture audio.

Utilisez une source d'horloge constante.

Les fichiers média doivent si possible être joués 
en utilisant le même signal de référence que 
celui avec lequel ils ont été enregistrés. Cette 
précaution garantit une étroite correspondance 
entre les fréquences d'échantillonnage 
d'enregistrement et de lecture. 
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Chapitre 36 : Traitement vidéo dans 
Pro Tools

Ce chapitre décrit les fonctions vidéo de 
Pro Tools. Les différences existant entre la prise 
en charge QuickTime et Avid sont indiquées 
tout au long du chapitre.

Introduction
Pro Tools permet d'effectuer les opérations 
vidéo suivantes :

• Créer des pistes vidéo et importer une vidéo 
dans la timeline

• Verrouiller les pistes vidéo

• Importer une vidéo dans Pro Tools à l'aide 
des commandes de menu ou de la souris

• Extraire des données audio des séquences 
QuickTime

• Effectuer un scrubbing audio et vidéo

• Afficher une vidéo dans la fenêtre Video ou 
la transférer vers un moniteur externe via 
un port FireWire

• Effectuer un prémixage de la piste vidéo au 
format QuickTime

Pro Tools LE avec DV Toolkit 2 et Pro Tools HD 
permettent d'effectuer les opérations vidéo 
suivantes :

• Importer plusieurs fichiers vidéo dans la 
timeline

• Créer plusieurs pistes vidéo avec des 
séquences QuickTime et des vidéos Avid 
dans la timeline

• Effectuer une sélection dans plusieurs 
playlists de pistes vidéo

• Mixer plusieurs codecs sur les pistes vidéo

• Organiser, regrouper et éditer des régions 
vidéo dans la timeline comme des régions 
audio

• Organiser, regrouper et éditer des régions 
vidéo avec des régions audio

• Gérer les régions vidéo

• Annuler plusieurs opérations vidéo

Pour obtenir des informations détaillées sur 
les fonctions de Pro Tools qui concernent 
spécifiquement les données vidéo Avid, 
consultez le guide Périphériques vidéo Avid.
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A propos de QuickTime

Utilisation de séquences 
QuickTime dans Pro Tools

Pro Tools prend en charge l'importation, la 
lecture et l'édition des séquences QuickTime. 

Configuration QuickTime requise

Procédez à l'installation de QuickTime si vous 
prévoyez d'inclure des fichiers vidéo ou 
d'importer des fichiers MP3 ou MP4 (AAC) dans 
vos sessions Pro Tools. Vous pouvez télécharger 
gratuitement QuickTime pour Windows XP sur 
le site Web d'Apple, à l'adresse www.apple.com.

Options de lecture des séquences 
QuickTime

La page Operation Preferences contient trois 
options déterminant la priorité de lecture 
QuickTime :

Normal : ce paramètre n'attribue aucune priorité 
particulière à la lecture de la séquence par 
rapport à d'autres tâches de mise à jour d'écran 
telles que les vumètres, les déplacements de 
faders, etc. Dans la plupart des cas, vous devez 
utiliser ce paramètre.

Medium : ce paramètre attribue une priorité 
supérieure à la lecture d'une séquence 
QuickTime par rapport aux autres tâches de 
mise à jour d'écran de Pro Tools. Appliquez ce 
paramètre si le paramètre Normal ne permet pas 
une lecture cohérente de la séquence 
QuickTime.

Highest : ce paramètre accorde une priorité 
maximale à la lecture des séquences QuickTime. 
Dans ce mode, Pro Tools désactive les tâches à 
l'écran et exige que vous appuyiez sur la barre 
d'espace pour arrêter la lecture. Faites appel à ce 
paramètre si vous désirez une lecture 
ininterrompue de la séquence QuickTime.

Conseils pour optimiser les 
performances du disque dur

Pour obtenir les meilleurs résultats, pensez à 
utiliser des disques vidéo et audio dédiés. 

Pour obtenir des informations complètes sur la 
configuration de votre disque dur, visitez le site 
Web de Digidesign
(www.digidesign.com).

Application de valeurs 
d'accélération aux séquences 
QuickTime

L'application d'une valeur d'accélération à des 
séquences QuickTime au cours d'une session 
peut avoir des effets imprévisibles sur la lecture 
d'une vidéo Avid au cours de cette session. 
Veillez à n'utiliser les valeurs d'accélération 
vidéo que pour les sessions ne contenant pas de 
vidéos Avid.

Pour obtenir plus d'informations sur la 
version QuickTime compatible avec votre 
version de Pro Tools, reportez-vous aux 
pages relatives à la compatibilité sur le site 
Web de Digidesign :
(www.digidesign.com).

Voir aussi Lecture Firewire de séquences 
QuickTime DV, page 965. 
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Avant de commencer votre 
projet
Avant de démarrer un projet nécessitant 
l'utilisation d'une vidéo, prenez en compte les 
points suivants :

Fréquence d'images : avant de recevoir des 
données vidéo, recherchez la fréquence 
d'images. Servez-vous de cette valeur lorsque 
vous définissez la fréquence d'images de vos 
sessions Pro Tools et au moment de l'acquisition 
vidéo.

Application et codec d'origine : avant de recevoir 
des données vidéo en tant que fichiers médias, 
recherchez l'application et le codec ayant servis 
à la création de ces fichiers. Assurez-vous ensuite 
que vous pouvez lire ces fichiers dans Pro Tools. 
Il est préférable d'obtenir un échantillon au 
préalable.

Incrustation du timecode de la séquence 
QuickTime : avant de recevoir des séquences 
QuickTime, demandez le timecode à 
« incruster » (par superimpression) si possible. 
Cela permet de s'assurer que Pro Tools place le 
fichier à l'emplacement de timecode qui 
convient dans la timeline.

Espace suffisant sur les disques vidéo : assurez-
vous de disposer d'un espace suffisant sur les 
disques vidéo dédiés. Les fichiers vidéo occupent 
beaucoup plus d'espace que les fichiers audio et 
doivent être stockés sur des disques distincts 
afin d'éviter tout problème de performance.

Pistes vidéo
Les pistes vidéo vous permettent d'ajouter ou 
d'importer les données vidéo vers la timeline de 
la manière suivante :

• Pro Tools LE permet d'ajouter ou d'importer 
une piste vidéo par session dans la limite 
d'une playlist vidéo et d'une séquence 
QuickTime par piste.

• Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 permettent d'ajouter plusieurs 
pistes vidéo à la timeline, à raison de plusieurs 
playlists vidéo et plusieurs séquences 
QuickTime par piste.

• Pro Tools HD, associé à un périphérique vidéo 
Avid, offre la possibilité de mixer des données 
vidéo QuickTime et Avid dans la timeline 
(mais pas au sein d'une même piste vidéo). 

Pour créer une piste vidéo :

1  Choisissez Track > New.

2  Dans la boîte de dialogue New Tracks, 
procédez comme suit :

• Choisissez Video Track dans le menu 
contextuel Track Type.

– et –

• Entrez le nombre de nouvelles pistes vidéo.

3  Cliquez sur Create.

Une nouvelle piste vidéo s'affiche. Les pistes 
vidéo peuvent s'afficher de manière légèrement 
différente selon la configuration du système ou 
le type de vidéo ajouté à la piste vidéo.

Boîte de dialogue New Tracks
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Piste vidéo principale

La piste vidéo principale est la piste vidéo 
actuellement en ligne. Elle sera lue avec des 
données audio au cours de la session. 

Lorsque la piste vidéo principale est hors ligne, 
vous pouvez lire les données audio dans votre 
session sans les données vidéo. Lorsque la vidéo 
est hors ligne, le bouton Video Online devient 
grisé. Ainsi, vous pouvez savoir d'un coup d'œil 
si votre vidéo est hors ligne ou simplement vide 
à l'endroit lu.

Si aucune piste vidéo est actuellement en ligne, 
la piste vidéo principale est la dernière piste 
vidéo à être lue.

Pour sélectionner la piste vidéo principale :

" Cliquez sur le bouton Video Online d'une 
piste hors ligne (grisé) pour la mettre en ligne 
(bleu) et en faire la piste vidéo principale. 

Présence de plusieurs pistes 
vidéo dans la timeline
(Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement)

Vous pouvez ajouter plusieurs pistes vidéo à la 
timeline, mais elles ne peuvent pas être lues 
simultanément. La piste lue est considérée 
comme la piste vidéo principale.

Présence de plusieurs playlists 
vidéo
(Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement)

Les playlists donnent la possibilité de basculer 
simplement d'une version d'une piste vidéo à 
l'autre.

Vous pouvez réaliser les mêmes opérations avec 
les playlists vidéo qu'avec les playlists audio :

• Duplication d'une playlist

• Création d'une playlist

• Affectation d'une playlist à une autre piste 
vidéo

• Changement du nom d'une playlist

• Suppression d'une playlist

Piste vidéo vide

Bouton Video Online (hors ligne et en ligne)

Piste vidéo 
principale

Sélecteur de playlist

Pour plus d'informations, reportez-vous à la 
section Playlists, page 413.
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Présence de plusieurs codecs sur 
une même piste vidéo
(Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement)

Une piste vidéo peut contenir des régions vidéo 
compressées à l'aide de différents codecs vidéo. 
Cependant, après avoir ajouté le premier fichier 
vidéo à une session, tout fichier vidéo 
supplémentaire ajouté à la timeline devra 
posséder le même débit vidéo que ce fichier. 

Commandes et indicateurs 
des pistes vidéo

Vue de la piste vidéo

La piste vidéo peut être visionnée en mode 
Frames ou Blocks ; ces deux modes d'affichage 
présentent les limites des régions vidéo et les 
métadonnées correspondantes. Seule la vue 
Frames permet d'afficher les images vidéo.

Pour définir la vue de la piste vidéo :

" Sur la piste vidéo, sélectionnez Frames ou 
Blocks dans le menu contextuel des options de 
la vue.

Affichage en mode Frames

En mode d'affichage Frames, les données vidéo 
s'affichent sous forme d'images dans la piste 
vidéo. Ces images sont calculées en fonction de 
l'image vidéo et de l'échelle conformément aux 
paramètres de zoom et à la hauteur de la piste. 
Elles sont très pratiques pour repérer facilement 
une scène ou une séquence dans la piste vidéo.

Si vous modifiez les paramètres de zoom en 
cours de lecture, les images ne s'affichent pas 
correctement. Des cadres noirs apparaissent 
pendant la lecture. Pour voir les images, il est 
donc conseillé d'arrêter la lecture avant de 
redéfinir les paramètres de zoom.

Si la fonction Pull Up ou Pull Down est activée, 
les images restent à leur emplacement.

Performances du mode d'affichage Frames

Lorsque vous visualisez le contenu d'une piste 
vidéo en mode Frames, les performances de 
l'ordinateur peuvent être réduites ou médiocres. 
Dans ce cas, masquez la piste vidéo ou passez à 
l'affichage en mode Blocks.

Affichage en mode Blocks

En mode Blocks, les images sont remplacées par 
des blocs de couleur. 

Si vous passez de la vue Blocks à la vue 
Frames au cours de la lecture, la piste vidéo 
n'affiche les images qu'après interruption 
de la lecture.

Piste vidéo affichée en mode Frames

Piste vidéo affichée en mode Blocks
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Icônes des types de pistes vidéo

Une piste vidéo affiche une icône QuickTime ou 
une icône Avid en fonction du type de fichier 
vidéo ajouté. Aucune icône ne s'affiche si la piste 
vidéo est vide.

Vous pouvez insérer tout fichier vidéo pris en 
charge dans une piste vidéo vide ; l'icône sera 
alors mise à jour et la piste vidéo lira 
exclusivement ce type de fichier vidéo.

Différences entre les pistes vidéo 
comportant des séquences QuickTime 
ou des vidéos Avid

(Pro Tools HD uniquement)

Lorsqu'un périphérique vidéo Avid (tel que 
Avid Mojo SDI) est relié à votre système et mis 
sous tension, les conditions suivantes 
s'appliquent :

• Le sélecteur de sortie vidéo s'affiche pour 
toutes les pistes vidéo, mais le sélecteur 
d'entrée vidéo apparaît uniquement sur les 
pistes contenant une vidéo Avid.

• Vous pouvez ajouter la vidéo Avid sur une 
piste vidéo vide. 

• Seules les pistes vidéo Avid sont associées à 
un bouton Record Enable.

Bouton Video Online

Le bouton Video Online permet de sélectionner 
la piste vidéo principale, de mettre cette piste en 
ligne ou hors ligne et de savoir d'un coup d'œil si 
la vidéo est en ligne ou hors ligne d'après la 
couleur du bouton (grisé = hors ligne, bleu = en 
ligne).

Pistes vidéo affichant les icônes QuickTime et Avid

Icône 
Avid

Icône 
QuickTime

Pour obtenir des informations détaillées sur 
l'utilisation du bouton Record Enable et des 
commandes dans la vue des E/S, consultez 
le guide Périphériques vidéo Avid.

Bouton Video Online (hors ligne et en ligne)

Piste vidéo 
hors ligne

Piste vidéo 
en ligne
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Pour passer d'une piste vidéo en ligne à une piste 
hors ligne et vice-versa :

" Cliquez sur le bouton Video Online d'une 
piste hors ligne (grisé) pour la mettre en ligne 
(bleu) et en faire la piste vidéo principale. 

" Cliquez sur le bouton Video Online de la piste 
vidéo principale pour la mettre hors ligne, 
Pro Tools ne diffuse alors plus de données vidéo.

Verrouillage des pistes vidéo
Vous pouvez verrouiller une ou plusieurs pistes 
vidéo pour empêcher l'édition de toute région 
vidéo appartenant à ces pistes.

Lorsqu'une piste vidéo est verrouillée, Pro Tools 
restreint toutes les opérations d'édition 
impliquant la piste (sauf celles relatives au 
verrouillage et au déverrouillage des régions 
vidéo).

Lorsqu'une piste vidéo est verrouillée, un petit 
cadenas s'affiche pour indiquer l'état de la piste 
et signifier qu'elle n'est pas modifiable (le 
cadenas ne s'affiche pas si le sélecteur de hauteur 
de piste est défini sur Mini).

Le verrouillage ou le déverrouillage d'une piste 
vidéo n'a pas d'effet sur l'état 
verrouillé/déverrouillé des régions. Si une région 
a été verrouillée avant la piste, la région reste 
dans cet état lorsque vous déverrouillez la piste. 
Cependant, le fait de déverrouiller une région 

dans une piste verrouillée n'offre pas la 
possibilité d'éditer cette région. Tant que la piste 
est verrouillée, la région se comporte comme si 
elle était verrouillée.

Pour verrouiller une piste vidéo :

1  Sélectionnez la ou les pistes vidéo à 
verrouiller.

2  Effectuez l'une des opérations suivantes :

• Cliquez sur le nom d'une piste vidéo 
sélectionnée en maintenant enfoncée la 
touche Ctrl (Mac) ou Démarrer (Windows) 
et choisissez Locked.

– ou –

• Cliquez avec le bouton droit de la souris sur 
une piste vidéo sélectionnée et choisissez 
Locked.

Définition du débit vidéo
Le débit vidéo représente le nombre d'images 
vidéo émis par Pro Tools en une seconde et est 
calculé automatiquement d'après la fréquence 
d'images du premier fichier vidéo ajouté à une 
session. Les fichiers vidéo insérés par la suite à la 
session doivent posséder la même fréquence 
d'images que celle du débit vidéo.

La fréquence d'images est indiquée pour chaque 
fichier vidéo figurant dans les navigateurs 
DigiBase ; le débit vidéo en cours s'affiche dans 
la vue des E/S de la piste vidéo principale.

Piste vidéo verrouillée

Icône de 
verrouillage 

Piste vidéo verrouillée

Icône de 
verrouillage 
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Le débit vidéo n'est pas lié à la fréquence de 
timecode de la session. Celle-ci détermine le 
nombre d'images affichées par seconde dans les 
grilles, les règles et les compteurs. Vous pouvez 
définir manuellement la fréquence de timecode 
de la session à l'aide du menu contextuel 
correspondant de la fenêtre Session Setup. 
Pour aligner les grilles et les règles par rapport 
aux images en cours des fichiers vidéo de la 
timeline, le paramétrage de la fréquence de 
timecode de la session doit être défini de 
manière à correspondre au débit vidéo 
(c'est-à-dire à la fréquence d'images du premier 
clip vidéo ajouté).

Indicateur du débit vidéo

L'indicateur du débit vidéo s'affiche 
uniquement dans la piste vidéo principale 
(en ligne ou hors ligne) et désigne le débit vidéo 
correspondant au nombre d'images vidéo émis 
par Pro Tools. 

L'indicateur du débit vidéo est habituellement 
de couleur noire, mais il vire au rouge dans les 
conditions suivantes :

• Le débit vidéo ne concorde pas avec le 
paramétrage actuel de la fréquence de 
timecode de la session.

– ou –

• Une valeur d'accélération a été appliquée 
au fichier vidéo, ce qui a pour effet de 
désynchroniser le débit vidéo par rapport à 
la fréquence de timecode de la session.

Importation de données vidéo 
dans Pro Tools
Pro Tools propose les méthodes suivantes en 
vue d'importer des fichiers vidéo dans la 
timeline, la liste des régions et toute piste vidéo 
nouvelle ou existante :

• Utilisation de la commande Import Video

• Déplacement par glisser-déposer depuis la 
liste des régions vers la timeline 
(Pro Tools HD ou Pro Tools LE avec DV 
Toolkit 2 seulement)

• Déplacement par glisser-déposerdepuis un 
navigateur DigiBase , l'Explorateur 
Windows ou le Finder Mac

• Utilisation de la commande Import Session 
Data

Reportez-vous à la section Indicateur du 
débit vidéo, page 950 pour plus 
d'informations sur l'indicateur figurant 
dans la vue des E/S.

Fréquence d'images

Débit 
vidéo

Le paramétrage de la fréquence de timecode 
s'effectue dans la fenêtre Session Setup. 
Pour plus d'informations, reportez-vous à la 
section Fenêtre Session Setup, page 915.

La fréquence d'images du premier fichier 
vidéo ajouté à une session détermine le débit 
vidéo de la session. Les fichiers vidéo insérés 
par la suite à la session doivent posséder la 
même fréquence d'images que celle du débit 
vidéo.
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Importation de données vidéo dans 
Pro Tools à l'aide de la commande 
Import Video

La commande Import Video permet de choisir 
un ou plusieurs fichiers vidéo à importer dans 
Pro Tools. 

Lorsque vous utilisez cette méthode pour 
importer des fichiers vidéo dans Pro Tools, la 
boîte de dialogue Video Import Options 
s'affiche. Cette boîte de dialogue contient 
plusieurs options visant à personnaliser le mode 
d'importation des fichiers.

Pour importer des données vidéo dans Pro Tools à 
l'aide de la commande Import Video :

1  Effectuez l'une des opérations suivantes :

• Choisissez File > Import > Video.

– ou –

• Appuyez sur les touches Alt+Ctrl+Maj+I 
(Windows) ou Pomme+Ctrl+Maj+I (Mac).

2  Dans la boîte de dialogue Select Video File to 
Import, sélectionnez un ou plusieurs fichiers 
vidéo.

3  Cliquez sur Open.

4  Configurez la boîte de dialogue Video Import 
Options selon vos préférences et cliquez sur OK 
pour importer les données vidéo dans Pro Tools.

Importation de données vidéo dans 
Pro Tools par glisser-déposer 

Vous pouvez faire glisser les fichiers vidéo à 
partir d'un navigateur DigiBase ou depuis 
l'Explorateur Windows ou le Finder Mac et les 
déposer dans la timeline, sur une piste, dans la 
liste des pistes ou dans la liste des régions.

Lorsque vous utilisez cette méthode pour 
importer des fichiers vidéo dans Pro Tools, la 
boîte de dialogue Video Import Options 
s'affiche. Cette boîte de dialogue contient 
plusieurs options visant à personnaliser le mode 
d'importation des fichiers. 

En général, les médias audio et vidéo 
doivent être stockés sur des disques dédiés 
distincts. Lors de l'importation simultanée 
de données audio et de données vidéo, 
Pro Tools peut cependant les copier sur le 
même disque. Pour éviter une dégradation 
des performances, veillez à déplacer le 
fichier vidéo vers le disque sur lequel les 
données vidéo seront lues avant d'importer 
les données audio et vidéo dans votre 
session. 

Lorsque vous importez le fichier vidéo au 
format MPEG-2 dans Pro Tools, seule la 
partie vidéo du fichier est importée ; les 
régions vidéo qui en résultent ne peuvent 
pas être éditées.

Dans un navigateur DigiBase, vous pouvez 
désigner vos disques audio pour lire ou 
enregistrer les fichiers audio, mais n'y 
transférer que les fichiers vidéo et 
réciproquement. Pour des instructions 
détaillées, reportez-vous à la section 
Indicateurs de volumes audio et vidéo, 
page 229.

Pour des instructions détaillées, 
reportez-vous à la section Configuration des 
options d'importation vidéo, page 952.
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Pour importer des données vidéo dans Pro Tools 
par glisser-déposer :

1  Faites glisser un ou plusieurs fichiers vidéo à 
partir d'un navigateur DigiBase, ou depuis 
l'Explorateur Windows ou le Finder Mac, et 
déposez-les dans la timeline, dans la liste des 
pistes ou sur une piste vidéo existante.

2  Configurez la boîte de dialogue Video Import 
Options selon vos préférences et cliquez sur OK 
pour importer les données vidéo dans Pro Tools.

Importation de données vidéo dans 
Pro Tools à l'aide de la commande 
Import Session Data

Servez-vous de la commande Import Session 
Data pour importer des données vidéo d'autres 
sessions Pro Tools ou d'une autre séquence AAF 
ou OMF (avec DigiTranslator 2.0). Tout fichier 
vidéo que vous importez doit posséder la même 
fréquence d'images que les fichiers vidéo de la 
session.

Déplacement à l'aide de la souris 
de fichiers vidéo depuis la liste 
des régions vers la timeline
(Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement)

Vous pouvez ajouter des séquences QuickTime à 
la timeline en les faisant glisser directement de 
la liste des régions et en les déposant sur une 
piste vidéo.

Pour ajouter des fichiers vidéo à une piste vidéo en 
les faisant glisser depuis la liste des régions :

1  Sélectionnez un ou plusieurs fichiers vidéo 
dans la liste des régions.

2  En mode d'édition, faites glisser les fichiers 
vidéo sélectionnés vers une zone vide de la 
timeline (pour créer une piste vidéo) ou sur une 
piste vidéo existante (pour les placer au sein de 
cette piste).

Configuration des options 
d'importation vidéo

La boîte de dialogue Video Import Options 
s'affiche lorsque vous importez des données 
vidéo dans Pro Tools à l'aide de la commande 
Import Video ou que vous faites glisser les 
fichiers vidéo depuis un navigateur DigiBase, 
l'Explorateur Windows ou le Finder Mac.

Pour des instructions détaillées, 
reportez-vous à la section Configuration des 
options d'importation vidéo, page 952.

Pour plus d'informations sur l'importation 
des données d'une session, reportez-vous à 
la section Importation de pistes et de leurs 
attributs, page 255. Pour obtenir des 
informations détaillées sur l'importation de 
séquences AAF ou OMF dans Pro Tools, 
reportez-vous au guide DigiTranslator.
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Section Destination

La section Destination de la boîte de dialogue 
Video Import Options permet de choisir la 
destination générale des fichiers vidéo importés 
dans Pro Tools.

Main Video Track : le fichier vidéo est importé 
directement dans la piste actuellement en ligne 
(considérée comme la piste vidéo principale) et 
dans la liste des régions. Si aucune piste n'est en 
ligne, le fichier vidéo est importé sur la dernière 
piste vidéo qui était en ligne.

New Track : chaque fichier vidéo est importé 
dans sa propre piste et dans la liste des régions.

Region List (Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement) : chaque fichier vidéo 
est importé directement dans la liste des régions 
à partir de laquelle vous pourrez le faire glisser 
vers la timeline.

Menu contextuel relatif à 
l'emplacement

Si vous ne sélectionnez pas la liste des régions 
comme destination dans la section Destination, 
le menu contextuel relatif à l'emplacement 
permet de choisir précisément à quel endroit 
dans la timeline Pro Tools place les données 
vidéo importées.

Session Start : place le fichier vidéo au début de 
la session.

Song Start : place le fichier vidéo au niveau du 
marqueur Song Start.

Selection : place le fichier vidéo au niveau du 
curseur d'édition ou dans la sélection (le cas 
échéant).

Spot : affiche la boîte de dialogue Spot dans 
laquelle vous pouvez placer le fichier vidéo à des 
endroits précis en vous basant sur une échelle 
temporelle.

Original Time Stamp (vidéo Avid uniquement) : 

place le fichier vidéo Avid dans la timeline à 
l'emplacement du timecode correspondant aux 
marquages temporels de la bande source 
d'origine. Dans le cas de plusieurs fichiers vidéo, 
cette option permet de placer tous les fichiers 
vidéo dans la timeline à leurs marquages 
temporels respectifs.

Options d'importation vidéo 
supplémentaires

Gaps Between Regions (Pro Tools(Pro Tools HD 
et Pro Tools LE avec DV Toolkit 2 uniquement) : 

lorsque vous importez plusieurs séquences 
QuickTime ou fichiers vidéo Avid dans une 
piste, elles sont déplacées ensemble par défaut. 
Cette option permet d'indiquer le nombre de 
secondes séparant chaque clip vidéo importé 
dans la piste vidéo.

Boîte de dialogue Video Import Options

Pour plus d'informations sur la 
désactivation de la boîte de dialogue Video 
Import Options lors de l'opération 
glisser-déposer des fichiers vidéo, 
reportez-vous à la section Contournement 
de la boîte de dialogue Video Import 
Options, page 954.
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Import Audio from File (séquences QuickTime 
uniquement) : 
lorsque cette option est sélectionnée, les 
données audio de la séquence QuickTime que 
vous importez sont extraites et placées sur les 
nouvelles pistes audio mono ou stéréo de la 
timeline (les données audio mono ou stéréo 
d'une fréquence d'échantillonnage inférieure ou 
égale à 48 kHz sont prises en charge). Si l'option 
n'est pas sélectionnée, seule la partie vidéo de la 
séquence QuickTime sera importée dans 
Pro Tools.

Remove Existing Video Tracks : lorsque cette 
option est sélectionnée, toutes les pistes vidéo 
sont supprimées avant que Pro Tools n'importe 
la vidéo dans la session.

Remove Existing Video Regions : lorsque cette 
option est sélectionnée, toutes les régions vidéo 
sont supprimées de la timeline et de la liste des 
régions avant que Pro Tools n'importe les 
données vidéo dans la session (mais elles sont 
conservées sur le disque). Cette option s'avère 
utile si vous voulez importer un fichier vidéo 
dont la fréquence d'images ne correspond pas au 
débit vidéo actuel. 

Clear Main Video Track Playlist : lorsque cette 
option est activée, toutes les régions vidéo de la 
playlist actuellement sélectionnée sur la piste 
vidéo principale sont supprimées de la piste 
avant que Pro Tools n'importe la vidéo dans la 
session. Aucune autre playlist, piste vidéo ou 
région vidéo ne sera affectée. Cette option est 
disponible seulement si la piste vidéo principale 
est choisie comme destination.

Contournement de la boîte de dialogue Video 
Import Options

Vous pouvez contourner la boîte de dialogue 
Video Import Options lorsque vous faites glisser 
des fichiers vidéo dans Pro Tools. Les fichiers 
vidéo sont ajoutés à l'endroit précis de la 
timeline où vous les déposez en fonction du 
mode d'édition actuel de Pro Tools.

Pour contourner la la boîte de dialogue Video 
Import Options lors de l'importation des données 
vidéo dans Pro Tools :

" Tout en maintenant la touche Alt (Windows) 
ou la touche Option (Mac) enfoncée, faites 
glisser un ou plusieurs fichiers vidéo à partir 
d'un navigateur DigiBase, de l'Explorateur 
Windows ou du Finder Mac dans la liste des 
régions ou dans la timeline.

Extraction des données audio 
de la séquence compatible 
QuickTime
(séquence compatible QuickTime uniquement)

Vous pouvez extraire les fichiers audio des 
formats suivants depuis les séquences 
compatibles QuickTime sans importer les 
données vidéo :

• Qualcomm

• AAC (MPEG-4)

• Flux audio vidéo numériques

• MP3

• QDesign

• uLaw 2:1

• aLaw 2:1

• Intel ADPCM

• Microsoft ADPCM

• IMA 4:1

• 32 bits virgule flottante

Pour plus d'informations, reportez-vous à la 
section Définition du débit vidéo, page 949.
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• 64 bits virgule flottante

• 16 bits Big Endian

• 16 bits Little Endian

• MACE 6:1

• MACE 3:1

Les données audio sont converties à la fréquence 
d'échantillonnage et à la résolution de la 
session ; une nouvelle région s'affiche dans la 
liste des régions pour chaque fichier importé. La 
liste des régions affiche le nom de la région, le 
nombre de pistes initiales et le numéro de la 
région sur la piste.

Pour importer des données audio depuis une 
séquence QuickTime sans importer les données 
vidéo, effectuez les opérations suivantes :

1  Choisissez File > Import > Audio.

2  Dans la boîte de dialogue Import Audio, 
recherchez la séquence QuickTime à partir de 
laquelle vous voulez importer les données 
audio, puis sélectionnez-la.

3  Sous la section relative aux régions, cliquez sur 
le nom de la région audio à extraire de la 
séquence QuickTime et cliquez sur Convert ou 
sur Add.

4  Sélectionnez les autre fichiers audio qui vous 
intéressent, puis cliquez sur Done pour importer 
les données audio.

5  Dans la boîte de dialogue Audio Import 
Options, indiquez si vous voulez importer les 
données audio dans une nouvelle piste ainsi que 
dans la liste des régions ou seulement dans la 
liste des régions. 

Qualité de conversion de la 
fréquence d'échantillonnage

Si vous importez des données audio QuickTime 
qui n'ont pas été enregistrées à la fréquence 
d'échantillonnage de la session, la fréquence 
d'échantillonnage est convertie afin de 
correspondre à celle des données audio de la 
session. Pro Tools permet de choisir la qualité de 
la conversion de la fréquence d'échantillonnage 
à l'aide du paramètre Conversion Quality de la 
page des préférences d'édition. 

Il existe cinq paramètres, classés par ordre 
croissant (de Low à Tweak-Head). Plus la qualité 
de la conversion de la fréquence 
d'échantillonnage est élevée, plus la conversion 
du fichier prémixé est longue.

Pour définir la qualité de conversion de la 
fréquence d'échantillonnage :

1  Choisissez Setup > Preferences et cliquez sur 
l'onglet Processing.

2  Cliquez sur le menu contextuel de la qualité 
de conversion et sélectionnez un paramètre de 
conversion.
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Régions vidéo
Vous pouvez créer des régions vidéo 
fonctionnant de façon similaire aux régions 
audio. 

Une région vidéo est un segment de données 
vidéo et peut correspondre à une portion de 
vidéo ou à un fichier vidéo entier. Dans 
Pro Tools, les régions vidéo sont créées à partir 
de fichiers QuickTime ou Avid et peuvent être 
organisées en playlists de pistes vidéo 
correspondantes. Il est possible de regrouper des 
régions vidéo, de les traiter en boucle et de leur 
appliquer un code couleur.

Lorsque vous utilisez Pro Tools HD ou 
Pro Tools LE avec DV Toolkit 2, vous pouvez 
procéder à des ajouts, des éditions ou des 
changements d'options d'affichage pour les 
régions vidéo comme vous le feriez pour les 
régions audio. Toutes les modifications 
apportées aux régions vidéo sont non 
destructives. Pour en savoir plus, reportez-vous à 
la section Edition vidéo générale, page 957.

Comme pour les régions audio, Pro Tools affiche 
les régions vidéo dans la liste des régions ou 
dans la timeline.

Dans Pro Tools LE, les régions vidéo sont 
soumises aux limitations suivantes :

• Vous pouvez ajouter une seule région vidéo 
par session. Il est possible de la lire, mais pas 
de l'éditer. Elle ne figure pas non plus dans la 
liste des régions.

• Lorsque vous importez de la vidéo ou ouvrez 
une session créée par Pro Tools HD ou 
Pro Tools LE avec DV Toolkit 2, seule la piste 
vidéo principale ou la première piste vidéo 
disponible contenant des régions QuickTime 
est prise en compte. Il est possible de lire et 
d'afficher plusieurs régions et de passer en 
revue les limites des régions à l'aide de la 
touche de tabulation. En revanche, vous ne 
pouvez pas les modifier. Pour en savoir plus, 
reportez-vous à la section Utilisation de 
Pro Tools LE pour importer une vidéo depuis 
d'autres versions de Pro Tools, page 968.

Les régions vidéo sont présentées en mode d'affichage 
Frames dans la timeline
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Régions vidéo dans la liste des 
régions
(Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement)

Dans la liste des régions, chaque région vidéo est 
caractérisée par une petite icône vidéo en regard 
de son nom.

Affichage ou masquage des régions 
vidéo dans la liste des régions

Le menu contextuel de la liste des régions 
contient des commandes permettant d'afficher 
ou de masquer les régions vidéo dans la liste des 
régions.

Pour afficher ou masquer des régions vidéo dans la 
liste des régions :

1  Dans la fenêtre Edit, cliquez sur le menu 
contextuel de la liste des régions et choisissez 
Show.

2  Sélectionnez l'option Video pour afficher ou 
masquer les régions vidéo.

Edition vidéo générale
(Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement)

La plupart des opérations d'édition valables pour 
les régions audio sont applicables aux régions 
vidéo. Cette section présente toutes les 
opérations d'édition vidéo disponibles. Sauf 
indication contraire, la procédure à suivre pour 
chaque tâche d'édition vidéo est la même que 
pour la tâche d'édition audio correspondante.

Fonctions d'édition vidéo de base

• Edition non destructive

• Affichage dans les playlists des noms et 
positions temporelles des régions et 
d'autres données

• Plusieurs playlists vidéo

• Multiples niveaux d'annulation

• Régions vidéo et groupes de régions vidéo 
dans la liste des régions

• Tous les modes d'édition

• Tous les outils d'édition (à l'exception des 
outils de compression/extension 
temporelle et du crayon)

Lecture et sélection des données des pistes 
vidéo

• Sélection à l'intérieur des limites d'image 
vidéo (voir Sélection à l'intérieur des limites 
d'image vidéo, page 959)

• Sélection et édition dans plusieurs pistes 
audio et vidéo (voir Sélection et édition dans 
plusieurs pistes audio et vidéo, page 959)

• Liaison ou annulation de la liaison des 
sélections de piste et d'édition

Région vidéo telle qu'elle est présentée dans la liste 
des régions

Pour plus d'informations sur la gestion des 
régions dans la liste des régions, 
reportez-vous à la section Liste des régions, 
page 419.

Icône
de

région
vidéo

Pour plus d'informations sur les opérations 
d'édition, reportez-vous à la section 
appropriée dans ce manuel.
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• Défilement automatique des pistes vidéo

• Lecture en boucle

• Fenêtre Universe (voir Défilement d'une vidéo 
dans la fenêtre Video Universe, page 962)

Utilisation des régions et des sélections

• Commande de capture de région

• Commande de séparation de régions et outil 
de séparation

• Chevauchements supérieur et inférieur de 
régions

• Toutes les commandes de rognage sauf 
pour TCE

• Réunion de régions séparées

• Placement, alignement, glissement, 
permutation et repérage de régions

• Points de synchronisation

• Déplacement par incrément (Nudging)

• Commande de décalage (Shift)

• Quantification des régions sur la grille 
(arrondies à l'image vidéo la plus proche)

• Commande de remplacement des régions

• Commandes permettant de couper, copier, 
coller et supprimer des régions

• Commandes spéciales couper, copier, coller et 
supprimer

• Répétition du collage pour remplir la 
sélection

• Edition sur plusieurs pistes

• Commande de duplication

• Commande de répétition

• Groupes de régions (voir Groupes de régions 
vidéo, page 960)

• Mise en boucle de régions

Gestion des régions

• Insertion de silence (voir Création d'un 
espace sur les pistes vidéo à l'aide de la 
commande d'insertion de silence, 
page 959)

• Commande de compression de la sélection 
(sans effet sur la vidéo, avec au moins une 
piste audio sélectionnée)

• Toutes les commandes d'attribution de 
nom et d'affichage des régions

Avertissements au sujet de l'édition

Les avertissements suivants concernent l'édition 
vidéo dans Pro Tools :

• Il n'est pas possible d'éditer de la vidéo 
MPEG-2 dans la timeline.

• Si vous créez et activez un groupe de pistes 
composé de pistes audio et vidéo (et si les 
limites de région d'une piste audio ne sont 
pas alignées par rapport aux limites d'une 
image vidéo), il est impossible de passer 
d'une limite de région à une autre à l'aide 
de la touche de tabulation.

Opérations d'édition générales 
non applicables aux régions vidéo

Les opérations d'édition suivantes concernent 
les régions audio, mais pas les régions vidéo :

• Fondus

• Activation/désactivation de la coupure du 
son d'une région

• Plug-in AudioSuite

• Réparation de la forme d'onde avec le 
crayon

• Suppression du silence

• Consolidation des régions
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Sélection et édition dans 
plusieurs pistes audio et vidéo

Vous pouvez créer une sélection dans plusieurs 
pistes audio et vidéo et couper, copier ou coller 
simultanément des données audio et vidéo.

Les données audio et vidéo sélectionnées et 
coupées, copiées ou collées dépendent du mode 
d'édition actuel.

Sélection à l'intérieur des limites 
d'image vidéo

Pro Tools ne permet pas de sélectionner, de lire 
ou d'éditer une image vidéo partielle. Les règles 
suivantes s'appliquent à la sélection ou à 
l'édition de données vidéo :

• Lorsque vous faites une sélection sur une piste 
vidéo, les limites de la sélection respectent le 
paramètre de grille actuel, mais sont arrondies 
à la limite d'image vidéo la plus proche, 
comme suit :

• Si la sélection inclut plus de la moitié d'une 
image vidéo, celle-ci est prise en compte 
dans la sélection vidéo.

• Si la sélection inclut moins de la moitié 
d'une image vidéo, celle-ci est exclue de la 
sélection vidéo.

• Lorsque vous collez une sélection contenant 
des données vidéo sur une piste vidéo, le 
point d'insertion s'aligne automatiquement 
par rapport à la limite d'image vidéo la plus 
proche.

Création d'un espace sur les 
pistes vidéo à l'aide de la 
commande d'insertion de silence

La commande Insert Silence a pour effet 
d'insérer un espace sur une piste vidéo.

Cette commande permet d'effectuer une 
sélection sur une piste (ou plusieurs pistes) et 
d'insérer précisément la quantité d'espace 
correspondante. Votre sélection peut s'appliquer 
à plusieurs pistes vidéo et audio. Il suffit alors 
d'exécuter la commande Insert Silence pour 
insérer à la fois un silence audio et un espace.

En mode Shuffle, toutes les données vidéo de la 
piste sont décalées plus loin sur la piste d'une 
durée égale à la sélection. En mode Slip, Grid ou 
Spot, la commande Insert Silence fonctionne 
comme la commande Edit > Clear.

Pour insérer un espace dans une piste vidéo :

1  Effectuez une sélection sur une ou plusieurs 
pistes. La longueur de la sélection détermine la 
durée de l'espace inséré.

2  Choisissez Edit > Insert Silence.

Sélection et édition dans plusieurs pistes (mode Slip 
illustré)

Avant Après

Lorsque vous collez simultanément des 
données audio et vidéo, il est probable que 
l'audio ne soit plus positionné à l'endroit 
exact que vous aviez choisi en raison du 
réalignement de l'image vidéo. Si tel est le 
cas, une boîte de dialogue d'avertissement 
s'affiche.
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Changement du nom des 
fichiers vidéo sur disque
Lorsque vous renommez des régions audio dans 
la timeline ou dans la liste des régions, vous 
pouvez en profiter pour changer le nom des 
fichiers audio sur disque. Cela ne concerne pas 
les fichiers vidéo sur disque.

Pour renommer les fichiers vidéo sur disque, 
vous devez le faire à partir d'un navigateur 
DigiBase, de l'Explorateur Windows ou du 
Finder Mac.

Groupes de régions vidéo
(Pro Tools HD et Pro Tools LE avec 
DV Toolkit 2 uniquement)

Vous pouvez inclure des régions vidéo dans des 
groupes de régions dans le cadre des opérations 
suivantes :

• Création de groupes de régions

• Création de groupes de régions multipistes 
(pistes audio comprises)

• Edition des groupes de régions

• Création de fondus et de fondus enchaînés 
pour les fichiers audio dans les groupes de 
régions

• Importation et exportation de fichiers de 
groupes de régions

Utilisation de la fenêtre Video
Pro Tools offre une fenêtre Video prévue 
spécialement pour visionner ou afficher une 
vidéo ou effectuer un scrubbing vidéo.

Pour afficher la fenêtre Video, effectuez l'une des 
opérations suivantes :

" Choisissez Window > Video.

– ou –

" Appuyez sur Pomme+9 (Mac) ou sur Ctrl+9 
(Windows).

Modification des options de la 
fenêtre Video

Le menu contextuel de la fenêtre Video permet 
d'effectuer les opérations suivantes :

• Activer/désactiver l'état en ligne de la piste 
vidéo principale

• Basculer la sortie des séquences QuickTime 
entre la fenêtre Video et un moniteur externe 
via le port FireWire

• Redimensionner la fenêtre Video

Pour plus d'informations sur la gestion des 
groupes de régions, reportez-vous à la 
section Groupes de régions, page 525.

Seuls les modes Scrub et Shuttle permettent 
d'accéder aux vidéos Avid dans la fenêtre 
Video.

Fenêtre Video (avec le menu contextuel correspondant)
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Pour activer/désactiver l'état en ligne de la piste 
vidéo principale :

" Cliquez avec le bouton droit de la souris 
(Windows ou Mac) ou maintenez la touche Ctrl 
enfoncée et cliquez sur la fenêtre Video (Mac), 
puis choisissez Online.

Pour basculer la sortie des séquences QuickTime 
entre la fenêtre Video et le port FireWire, procédez 
de l'une des manières suivantes :

" Choisissez Options > Video Out FireWire.

– ou –

" Cliquez avec le bouton droit de la souris 
(Windows ou Mac) ou maintenez la touche Ctrl 
enfoncée et cliquez sur la fenêtre Video (Mac), 
puis choisissez Video Out FireWire.

Redimensionnement de la fenêtre 
Video

Il est possible de redimensionner la fenêtre 
Video à l'aide de la souris ou du menu 
contextuel.

Pour redimensionner la fenêtre Video à l'aide de la 
souris :

" Positionnez le curseur dans l'angle inférieur 
gauche ou droit de la fenêtre Video, puis faites 
glisser la fenêtre jusqu'à ce que vous obteniez la 
taille voulue.

Pour redimensionner la fenêtre Video à l'aide du 
menu contextuel :

" Cliquez avec le bouton droit de la souris 
(Windows ou Mac) ou maintenez la touche Ctrl 
enfoncée et cliquez sur la fenêtre Video (Mac), 
puis choisissez l'une des options de taille 
suivantes :

• Half Size

• Actual Size

• Double Size

• Fit Screen

Scrubbing de la piste vidéo

En raison du phénomène de latence introduit 
par tous les périphériques vidéo de type 
FireWire, la lecture d'une vidéo sur un moniteur 
externe n'est pas synchronisée avec l'outil de 
scrubbing. Pour effectuer un scrubbing vidéo 
sans latence, vous pouvez opérer depuis la 
fenêtre Video.

Si vous appliquez un scrubbing directement sur 
la piste vidéo, seule la piste vidéo sera lue en 
mode Scrub (les données audio ne seront pas 
lues). Si vous appliquez le scrubbing à une piste 
audio, les données audio et vidéo associées 
seront lues simultanément en mode Scrub.

Pour appliquer le scrubbing à une piste vidéo :

1  Assurez-vous d'activer le scrubbing dans la 
fenêtre Video en choisissant Options > Scrub in 
Video Window.

2  Sélectionnez l'outil de scrubbing.

3  Cliquez sur la piste vidéo et faites glisser l'outil 
de scrubbing.

Outil de scrubbing

Pour affiner la précision du scrubbing, 
appuyez sur la touche Pomme pendant 
l'opération.

Outil de scrubbing 
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Lecture d'une piste vidéo en mode 
Shuttle

Le mode Shuttle Lock permet d'utiliser le clavier 
numérique pour effectuer, à la vitesse que vous 
désirez, un shuttle avant ou arrière allant jusqu'à 
deux pistes : 5 correspond à la vitesse normale, 
les touches de 6 à 9 permettent d'avancer à des 
vitesses progressivement plus accélérées et les 
touches de 4 à 1 permettent de reculer de plus 
en plus vite (4 correspond à la vitesse de Shuttle 
Lock la plus lente et 1 à la plus rapide). Si 
plusieurs pistes sont sélectionnées, seules les 
deux premières passent en mode Shuttle Lock. 

Pour lire la piste vidéo en mode Shuttle Lock : 

1  Dans Pro Tools HD, assurez-vous que l'option 
Numeric Keypad Mode des préférences de 
fonctionnement n'est pas réglée sur Shuttle (voir 
Préférences de fonctionnement, page 80).

2  A l'aide du sélecteur, cliquez dans la piste à 
l'endroit où vous souhaitez que commence la 
lecture. Pour que le shuttle s'effectue sur deux 
pistes, cliquez sur une seconde piste en 
appuyant sur Maj. 

3  Appuyez sur Ctrl (Mac) ou sur Démarrer 
(Windows) et sur un chiffre du clavier 
numérique : 0–9 (9 est le plus rapide, 5 est la 
vitesse normale, 0 arrête le shuttle). 

Dès que le mode Shuttle Lock est actif, les 
boutons Avance rapide et Retour rapide sont mis 
en surbrillance dans la fenêtre Transport. 

4  Appuyez sur d'autres touches pour changer la 
vitesse de lecture ou appuyez sur plus (+) ou 
moins (-) pour changer la direction de lecture 
(plus pour aller en avant, moins pour aller en 
arrière). 

5  Pour arrêter la lecture, appuyez sur Ctrl+0 
(Mac) ou sur Démarrer+0 (Windows). 

Pour quitter le mode Shuttle Lock, effectuez l'une 
des opérations suivantes : 

" Cliquez sur le bouton d'arrêt dans la fenêtre 
Transport. 

– ou –

" Appuyez sur la barre d'espace. 

Défilement d'une vidéo dans 
la fenêtre Video Universe
(Pro Tools HD uniquement)

La fenêtre Video Universe, accessible à partir de 
la fenêtre Universe, permet de visualiser, de 
parcourir, d'effectuer un zoom et de sélectionner 
des régions vidéo sur la piste vidéo principale.

La fenêtre Video Universe affiche l'image vidéo 
centrale de chaque région vidéo dans la piste 
vidéo principale. Les images vidéo sont classées 
de façon séquentielle en fonction de l'ordre dans 
la timeline. La bande de couleur sous chaque 
image représente le code couleur de la région.

Pour afficher la fenêtre Video Universe :

1  Assurez-vous que le bouton Video Online de la 
piste vidéo principale est en ligne (bleu).

2  Choisissez Window > Universe afin d'afficher 
la fenêtre Universe.

3  Cliquez avec le bouton droit de la souris 
(Windows ou Mac) ou maintenez la touche Ctrl 
enfoncée et cliquez à dans la fenêtre Universe 
(Mac), puis choisissez Video Universe.
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Augmentation ou réduction de la taille 
des images vidéo

Pour changer la taille des images vidéo dans la 
fenêtre Video Universe :

" Cliquez avec le bouton droit de la souris 
(Windows ou Mac) ou maintenez la touche Ctrl 
enfoncée et cliquez dans la fenêtre Universe 
(Mac), puis choisissez Increase ou Decrease.

Sélection des facteurs de zoom dans la 
fenêtre Video Universe

Lorsque vous déplacez le curseur sur la partie 
supérieure d'une image vidéo dans la fenêtre 
Video Universe, il change de forme pour se 
comporter comme un outil Zoom. Vous pouvez 
alors effectuer un grossissement sur une ou 
plusieurs régions vidéo de façon à occuper 
l'intégralité de la fenêtre Edit.

Pour utiliser la fenêtre Video Universe afin 
d'effectuer un zoom sur les régions vidéo dans la 
fenêtre Edit :

1  Déplacez le curseur sur la partie supérieure 
d'une image vidéo jusqu'à ce qu'il prenne la 
forme d'un outil Zoom.

2  Effectuez l'une des opérations suivantes :

• Pour déplacer le début d'une région vidéo 
vers l'extrême gauche de la timeline tout en 
conservant le facteur de zoom actuel dans 
la fenêtre Edit, cliquez une fois sur l'image 
vidéo représentant la région.

• Pour effectuer un zoom avant sur une 
région vidéo de façon à ce qu'elle occupe 
toute la fenêtre Edit, cliquez deux fois sur 
l'image vidéo représentant la région.

• Pour appliquer le zoom à une plage de 
régions sélectionnées de façon à ce qu'elles 
occupent toute la fenêtre Edit, cliquez sur 
les images vidéo représentant les régions et 
faites-les glisser.

Sélection de plages dans la fenêtre 
Video Universe

Lorsque vous déplacez le curseur sur la partie 
inférieure d'une image vidéo dans la fenêtre 
Video Universe, il change de forme pour se 
comporter comme un sélecteur. Cet outil 
permet alors de sélectionner des plages dans une 
ou plusieurs régions vidéo de la fenêtre Edit.

Fenêtre Video Universe avec les images vidéo 
représentant les régions vidéo de la piste vidéo 
principale

Image vidéo avec l'outil Zoom
Image vidéo avec le sélecteur
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Pour utiliser la fenêtre Video Universe afin de 
sélectionner des plages dans les régions vidéo de 
la fenêtre Edit :

1  Déplacez le curseur sur la partie inférieure 
d'une image vidéo jusqu'à ce qu'il prenne la 
forme d'un sélecteur.

2  Effectuez l'une des opérations suivantes :

• Pour placer le curseur au début d'une 
région vidéo, cliquez sur l'image vidéo 
représentant la région vidéo.

• Pour sélectionner une région vidéo entière 
du début à la fin, cliquez deux fois sur 
l'image vidéo représentant la région en 
question.

• Pour sélectionner une ou plusieurs régions 
entières du début à la fin, faites glisser les 
images vidéo représentant les régions en 
question.

Sélection simultanée des facteurs de 
zoom et des plages dans la fenêtre 
Video Universe

Lorsque vous déplacez le curseur sur une image 
vidéo dans la fenêtre Video Universe tout en 
maintenant la touche Alt (Windows) ou Option 
(Mac) enfoncée, le curseur se transforme en 
sélecteur. Cet outil permet à la fois de 
sélectionner des plages et de leur appliquer un 
zoom.

Pour utiliser la fenêtre Video Universe dans le but 
d'effectuer simultanément une sélection et un 
zoom sur les régions vidéo dans la fenêtre Edit :

1  Déplacez le curseur sur une partie quelconque 
d'une image vidéo dans la fenêtre Video 
Universe jusqu'à ce qu'il prenne la forme de 
l'outil Zoom ou du sélecteur.

2  Pour sélectionner une plage de régions vidéo 
tout en leur appliquant un zoom de façon à 
occuper l'intégralité de la fenêtre Edit, 
maintenez la touche Alt (Windows) ou Option 
(Mac) enfoncée pendant que vous faites glisser 
les images vidéo correspondantes.

Lecture de séquences 
QuickTime HD
Pro Tools permet d'importer et de lire des 
fichiers vidéo QuickTime haute définition.

Définition de la fréquence de 
timecode de la session pour 
l'importation de séquences 
QuickTime HD

Pour lire des séquences QuickTime à une 
cadence supérieure à 30 i/s, la synchronisation 
des images dans Pro Tools s'effectue 
correctement à condition que la fréquence de 
timecode dans la fenêtre Session Setup 
corresponde à la moitié de la fréquence d'images 
des fichiers vidéo.

Pour lire correctement, par exemple, une 
séquence QuickTime HD à 59,94 i/s, choisissez 
29,97 images par seconde comme fréquence de 
timecode de la session.

Si la fenêtre Edit n'affiche pas les régions 
vidéo sélectionnées, l'affichage défile 
automatiquement de façon à montrer le 
début de la sélection.

Lors de la lecture d'une vidéo HD à partir 
d'un périphérique vidéo Avid ou d'un autre 
dispositif verrouillé sur une référence vidéo 
de définition standard (tel qu'un générateur 
de black burst vidéo), la vitesse de 
rafraîchissement de l'affichage est 
déterminée par la fréquence d'images de la 
référence vidéo.
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Pour paramétrer la fréquence de timecode d'une 
session :

1  Choisissez Setup > Session.

2  Dans la fenêtre Session Setup, sélectionnez la 
fréquence de timecode appropriée à partir du 
menu contextuel correspondant.

Lecture Firewire de 
séquences QuickTime DV
Grâce à l'ajout d'un transcodeur (décodeur) DV 
externe, vous pouvez lire les séquences 
QuickTime DV25 via le port Firewire de 
l'ordinateur. Il peut s'agir de séquences 
QuickTime exportées au format QuickTime DV 
à partir d'Avid.

Pour obtenir les dernières informations sur la 
compatibilité des transcodeurs Firewire, visitez 
le site Web de Digidesign 
(www.digidesign.com).

Les performances de QuickTime DV25 peuvent 
varier selon les besoins de votre système et de 
vos projets. 

Prise en charge des séquences 
QuickTime

« Referenced » et « Consolidated » : les séquences 
QuickTime DV sont soit des fichiers Quicktime 
complets (contenant toutes les données), soit 
des fichiers de référence Quicktime (contenant 
simplement des renvois aux fichiers DV 
d'origine). 

Conditions requises par le codec : lorsque vous 
exportez un fichier depuis Avid, utilisez toujours 
le codec DV d'Apple. N'activez pas l'option 
« Use Avid Codec » de la boîte de dialogue 
Export. Les fichiers DV exportés avec le codec 
d'Avid ne pourront pas être lus avec Pro Tools. 

Films DV Stream : Pro Tools ne prend pas en 
charge les données audio des fichiers DV Stream. 
Les fichiers DV Stream contiennent tout le flux 
de données transmis ou enregistré par une 
caméra via le câble FireWire. Ce type de fichier 
sauvegarde l'image et le son en commun 
(procédé « Interleave »), tandis que les fichiers 
QuickTime mémorisent séparément les données 
audio et vidéo. 

Lecture de séquences QuickTime DV via 
le port FireWire

Pour lire les séquences QuickTime DV via le port 
FireWire : 

1  Importez une séquence QuickTime DV dans 
une session Pro Tools. Reportez-vous à la section 
Importation de données vidéo dans Pro Tools, 
page 950 pour plus d'informations.

2  Choisissez Options > Video Out FireWire. 

Pour obtenir de meilleures performances lors 
de la lecture de films DV via le port 
FireWire sur Mac, utilisez un disque dur 
dédié uniquement à la vidéo.

Les périphériques vidéo Avid prennent en 
charge la plupart des formats QuickTime.

Voir aussi Exportation de séquences 
QuickTime DV depuis Avid, page 966. 
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Quand cette option est active, Pro Tools 
transmet les films DV (NTSC ou PAL) via le port 
FireWire à un décodeur DV externe. Cela permet 
d'améliorer les performances du système, car il 
n'est plus nécessaire que les données du film 
soient décompressées par le processeur de 
l'ordinateur, ni affichées à l'écran. 

Si la fenêtre Video est ouverte pendant la lecture 
vidéo via le port FireWire, elle affichera un 
message à cet effet.

Compensation des retards vidéo

Il est possible de compenser les retards de la 
sortie vidéo liés aux décodeurs externes et à 
certains types d'écran.

Pour compenser les retards provoqués par des 
dispositifs de contrôle vidéo :

1  Choisissez Setup > Video Sync Offset.

2  Dans la boîte de dialogue Set Video Sync 
Offset, entrez une valeur dans le champ 
QuickTime Video Offset permettant de 
compenser le retard causé par vos appareils de 
contrôle vidéo. La valeur de retard introduite 
varie en fonction de votre système et du type de 
périphérique vidéo utilisé. Lorsque vous utilisez 
un périphérique Avid avec QuickTime, le mieux 
est de commencer par 18 quarts d'image. Il est 
conseillé, cependant, de vérifier si cette valeur 
est suffisamment précise pour votre système. 
Il existe des périphériques tiers prévus 
spécialement pour mesurer ce retard.

Une fois cette valeur fixée, il n'est plus nécessaire 
en principe d'en changer sauf si vous changez 
des éléments dans votre système de contrôle 
vidéo (tels que des projecteurs ou des écrans 
plasma).

Exportation de séquences QuickTime 
DV depuis Avid

Vous trouverez ci-dessous les paramètres requis 
pour exporter des séquences à l'aide 
d'Avid XPress Pro. Ces paramètres permettent 
de créer des séquences QuickTime DV que 
Pro Tools peut lire via le port Firewire. 

Pour exporter une séquence de référence 
QuickTime DV devant être lue par Pro Tools via le 
port Firewire : 

1  Activez les options d'exportation suivantes :

• Flatten video tracks

• Fill in spaces with black

• Render all video effects

• Use Apple DV Codec

• Enable the Apple DV codec

2  Assurez-vous que l'option Use Avid Codec 
n'est pas activée.

Boîte de dialogue Video Sync Offset

Vous pouvez sauvegarder ces paramètres 
d'exportation dans Avid XPress Pro comme 
valeurs par défaut, afin de simplifier les 
échanges ultérieurs de médias. Pour plus 
d'informations sur les paramètres 
d'exportation et les paramètres par défaut, 
reportez-vous à la documentation d'Avid 
Xpress.
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Conseils pour optimiser la lecture 
d'un film

Lorsque vous utilisez Pro Tools pour lire des 
séquences QuickTime (sans périphérique vidéo 
Avid), la qualité de lecture dépend de la vitesse 
du processeur, des performances du disque dur, 
des dimensions d'image (en pixels) de la 
séquence et de la qualité du dispositif vidéo 
utilisé pour l'acquisition et la lecture des 
données vidéo numérisées. 

Pour une lecture vidéo plus cohérente, consultez 
les suggestions ci-après :

! Utilisez un périphérique vidéo Avid 
compatible.

! Choisissez un ordinateur équipé d'un 
processeur extrêmement rapide.

! Désactivez la préférence d'automation Faders 
Move During Playback.

! Réglez l'option de défilement sur None 
(Options > Scrolling > None).

! Réduisez autant que possible la taille de la 
fenêtre Edit.

! Fermez les fenêtres inutiles.

! Réduisez la longueur totale de la chaîne SCSI 
de votre système pour en optimiser le débit.

! Réduisez la résolution en pixels de la séquence 
(par exemple, passez de 640 x 480 pixels à 
320 x 240 pixels).

! Masquez la piste vidéo quand vous n'en avez 
pas besoin. 

Prémixage de la piste vidéo 
vers une séquence QuickTime
Une fois le mixage final achevé et les 
événements audio synchronisés à la séquence 
vidéo, vous pouvez effectuez le prémixage de la 
piste vidéo principale (QuickTime ou Avid) et le 
mixage mono ou stéréo de votre session vers une 
nouvelle séquence QuickTime. 

Vous pouvez faire votre choix parmi une 
multitude de codecs QuickTime standard, 
entièrement compatibles avec les autres 
applications QuickTime.

Pour effectuer un prémixage audio ou vidéo de la 
piste vidéo au format QuickTime :

1  Finalisez votre mixage.

2  Vérifiez si la piste vidéo à prémixer est bien la 
piste vidéo principale. Le bouton Video Online 
de la piste doit être en surbrillance (bleu).

3  Assurez-vous que toutes les pistes audio à 
inclure dans le prémixage sont audibles (et non 
coupées ou inactives). 

4  Assignez la sortie de chaque piste à inclure 
dans le prémixage à un même chemin de sortie 
stéréo ou de bus.

Etant donné que les formats et les codecs 
n'ont pas tous été testés, assurez-vous que le 
prémixage au format QuickTime a réussi.

Pro Tools ne peut pas effectuer un 
prémixage audio ou vidéo vers un fichier 
vidéo MPEG-2.
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5  Effectuez l'une des opérations suivantes :

• Pour prémixer la session tout entière, 
cliquez sur Return to Zero dans la fenêtre 
Transport pour atteindre le début de la 
session. 

– ou –

• Pour prémixer une partie de la session, 
activez la commande Options > Link 
Timeline and Edit Selection, puis 
sélectionnez un élément dans la fenêtre 
Edit. 

6  Choisissez File > Bounce to > QuickTime 
Movie.

Le programme affiche la boîte de dialogue 
Bounce (en cas de prémixage de séquences 
QuickTime) ou Bounce to QuickTime (si vous 
effectuez un prémixage vidéo Avid vers des 
séquences QuickTime).

7  Sélectionnez la sortie ou le chemin de bus de 
votre mixage à l'aide du sélecteur de source de 
prémixage.

8  Si vous effectuez un prémixage Avid vers 
QuickTime et souhaitez configurer les 
paramètres vidéo QuickTime, cliquez sur 
Options.

9  Définissez les autres paramètres qui 
conviennent.

10  Cliquez sur Bounce.

11  Choisissez une destination pour la nouvelle 
séquence QuickTime, donnez-lui un nom, puis 
cliquez sur Save.

Le prémixage vidéo risque de prendre du temps. 
Cela dépend du format de la vidéo source, du 
format de la vidéo prémixée et de la vitesse de 
traitement.

Utilisation de Pro Tools LE 
pour importer une vidéo 
depuis d'autres versions de 
Pro Tools
Lorsque vous vous servez de Pro Tools LE pour 
importer de la vidéo ou ouvrir une session créée 
sous Pro Tools HD ou Pro Tools LE avec 
DV Toolkit 2, il est possible que certains 
composants de la session se présentent 
différemment ou soient absents :

• Seule la piste vidéo principale est affichée. Si 
aucune piste vidéo n'a été sélectionnée 
comme piste vidéo principale lors de 
l'enregistrement de la session, c'est la première 
piste vidéo contenant des séquences 
QuickTime dans cette session qui s'affiche.

• Seule la playlist choisie lors de 
l'enregistrement de la session est affichée.

• Toutes les séquences QuickTime de la piste 
vidéo principale sont affichées, mais la piste 
vidéo est verrouillée et ne peut pas être éditée.

• Toutes les autres pistes vidéo, playlists et 
régions vidéo sont masquées. Elles 
continueront, cependant, d'être enregistrées 
avec la session et seront disponibles si la 
session est ouverte sur un système compatible.

Pour traiter de la vidéo avec Pro Tools LE dans 
une telle session, les opérations suivantes sont 
possibles :

Pro Tools est prévu pour effectuer des 
prémixages vers QuickTime DV25. 
Le prémixage sous d'autres formats n'a pas 
été testé.

Pour plus d'informations sur la 
configuration des paramètres QuickTime, 
reportez-vous à la documentation Apple.
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• Déplacer le curseur de positionnement vers les 
limites des régions vidéo à l'aide de la touche 
de tabulation.

• Ajouter et éditer des pistes audio.

• Effectuer un prémixage de la piste vidéo sur 
disque au format QuickTime.

• Exporter la session, y compris la piste vidéo 
entière.

Pour plus d'informations, consultez la 
section Prémixage de la piste vidéo vers une 
séquence QuickTime, page 967.
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Index

Symboles
+ et –, voir Plus (+) et Moins (–)

Entrées numériques
16 bits

prémixage sur disque 864
1622 I/O 30
176,4 kHz

valeur de majoration 927
192 I/O 30

configuration du matériel 49
Soft Limit 49

192 kHz
valeur de majoration 927

192, interface d'I/O numérique 30
24 bits

prémixage sur disque 864
traitement TDM 761

29,97 i/s Non-Drop 941
32 bits, virgule flottante 761
3-Second Clip Hold, option 79, 145
3-Second Peak Hold, option 79, 145
5.1, formats dans Pro Tools 878
8 bits 864
882|20 I/O 30
888|24 I/O 30
96 I/O 30

configuration du matériel 49
96i I/O 30

configuration du matériel 49

A
AAF, format de fichier 265, 270
Actif

insert 769
Activation

automation 815
automation de plug-in 787
dispositifs d'entrée MIDI 348
groupe 188
option Auto Backup 83

Activation (panoramique Surround) 905
Activation à l'enregistrement de piste, indicateur 121

Activation de pistes à distance 934
Active, mode

activation d'éléments 14
piste 170
plug-in 16

Actuel, tempo 571
ADAT Bridge I/O 24 bits, interface d'E/S 30
Add Key Change, commande 602
Add Marker/Memory Location, bouton 608
Add Meter Change, bouton 593
Add Tempo Change, bouton 571, 589
Add Unique Triggers 641
AES/EBU

configuration du matériel 48
Affectation de canaux

édition 65
ordre des chemins par défaut 74
réaffectation 65

Affectation de chemins dans I/O Setup 65
Affichage 947

informations du fichier pour les régions audio 420
marquage temporel original 938
marquage temporel utilisateur 939
nom de région 399
position temporelle d'une région 399
règle de métrique 592
règle de tempo 570
toutes les règles 407

Affichage dans les navigateurs 205
Affichage des blocs dans la piste vidéo 947
Affichage étendu de la piste 398, 825
Affichage linéaire, mode 580
Affichage Start, End et Length 117
Affinage d'automation 802, 819
AFL (After Fader Listen) 167
AFL/PFL Mutes (chemin de sortie), sélecteur 74
AFL/PFL, chemin

définition d'un niveau 74
sélection 73

AFL/PFL, sélecteur de chemin 73
After Fader Listen, mode 167
After Playback, option de défilement 460
After Write Pass, Switch To, option 91, 797
Aide

info-bulle 78, 136
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prémixage sur disque 867
AIFF, format de fichier 861
Ajout

départ 737
nouvelle playlist 415

Alignement sur la région suivante ou précédente 498
All MIDI Notes Off, commande 670
Allow Latch Prime in Stop, option 90
Allow Track Arm Commands in Local Mode, option 95
Always Display Market Colors, option 79
Always Fill Channel Strips When Banking, option 89
Analogique, entrée 49
Analogique, sortie 49
Annulation d'un enregistrement audio 328
Annulation des prises d'enregistrement 328, 356
Appellation

chemin 61
insert et départ 789

Application multilingue, prise en charge 297
Apply Real-Time Properties, option 276
Archivage

préparation avec Compact Selected 564
Arrêt, bouton 120
Arrière, divergence 908
Assignation du signal

bases du Surround 885
exemple 12
exemple de Surround 892
ordre des chemins par défaut 74

Assignation dynamique des voix 160
Assignment, affichage (option d'affichage des départs) 739
Attribut pour les groupes 186
Attributes Group, commande 178
Aucun défilement pendant la lecture 460
Aucune sortie

par suppression des chemins 64
Audio During Fast Forward/Rewind, option 80, 455
Audio Files, dossier 100
Audio Media, options 258
Audio Track RecordLock, option 83, 374
Audio, accélération et ralentissement 924
Audio, bouton de zoom arrière 430
Audio, bouton de zoom avant 430
Audio, fichier

compactage 564
concepts 10
format 860
format mélangé 248
importation 247
types de fichiers mélangés 107

Audio, fichiers
nom par défaut 310

Audio, indicateur 229
Audio, piste 9

création d'une table des tempos 588
enregistrement en boucle 333
enregistrement fractionné 332
enregistrement multiple 328
flux de signaux 723
format 5.1 873
format de sortie 884
placement de données audio dans les pistes 

multicanaux 883
prémixage sur disque 858
session Surround 882

voie 139
vue Waveform 400

Audio, région
automation 402

Audio,région
adaptation à la sélection d'édition 478
suppression du silence 559

AudioSuite
dithering 762
plug-in 762
traitement 524

AudioSuite Buffer Size, préférence 92
AudioSuite, menu 134
Audition Paths, sélecteur 72
Auto Backup, option 83
Auto Input, mode d'écoute 305, 306
Auto Match Pull Factors 924
Auto Region Fade In/Out Length, préférence 85
Auto Regions Fade In/Out Length, préférence 551
Auto Rename Region List, commande 566
Auto, bouton 776
AutoGlide Time, préférence 91, 907
AutoGlide, mode 907
AutoJoin

commande 798
indicateur 798

AutoMatch
bouton 811
commandes individuelles 811
commandes individuelles avec ICON 812
indicateur 805
toutes les commandes 811
types d'automation individuels 812

AutoMatch Time, préférence 91, 802
Automatically Copy Files on Import, option 92, 267
Automatically Create Click Track in New Sessions, option 93
Automatically Create Fades for Imported REX and ACID files, 

option 87
Automation 793

affichage des limites et des formes de fondu 557
affinage 802, 819
au point d'inflexion suivant 836
bouton Safe 776
capture et application 845, 848
capture et application à d'autres emplacements 845
cliché 843
commandes commutées 807
couper, copier et coller 519, 826
création 810
delta 799
départ 808
dessin avec le crayon 820
discontinu 823
écriture 805
écriture à l'ensemble, au début ou à la fin de la sélection 

834
édition 822
édition avec l'outil Smart 447
et assignation de sorties multiples 884
fonte de l'automation de rognage 832
fonte de l'automation VCA 852
interruption 816
interruption de l'activation 815
lissage 802
mode Special Paste 830
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mode Trim 799
On Stop 835
panoramique multicanal 911
piste 805
piste de VCA principal 851
pistes masquées 154
pistes multicanaux 825
pistes regroupées 826
playlist 414, 794, 803
plug-in 809, 810
point d'inflexion 824
point de passage 797
précision du plug-in lors du prémixage 866
protection 803
région audio 402
rognage 832
suppression 818
valeurs relatives et absolues 799
vue Track 515

Automation de contrôle discontinu 823
Automation de coupure 823
Automation de panoramique 823
Automation du volume 823
Automation Enable, fenêtre 805
Automation Follows Edit, option 803
Automation par cliché 843

ajout à des playlists d'automation vides 844
écriture sur une automation existante 844
valeurs de rognage 845

Automation Preview, mode 846
bouton d'insertion de l'aperçu 848
commandes Write Automation To 848
interruption 848

Automation, modes
Latch 797
Latch Trim 800
Off 796
Read 796
Read Trim 800
Touch 797
Touch Trim 800
Touch/Latch Trim 801
Trim Off 799
Write 796
Write Trim 801

Automation, préférences
option Smooth and Thin Data After Pass 819
préférence AutoMatch Time 802

Auto-Name Memory Locations While Playing, option 86, 609
Auto-Name Separated Regions, option 86, 487
Auto-Spot Regions, commande 937
Avance rapide

par incrément 455
recherche 455

Avance rapide, bouton 120
Avant/Arrière, divergence 908
Avid

lecture dans Pro Tools 965
Avid Video Errors Stop Playback, option 82
Avid Video NTSC Has Setup, option 83
Avid Xpress DV

conditions requises par le codec pour l'exportation 965

B
Back and Play, commande 455
Back, commande 455
Back/Forward Amount 455
Back/Forward Amount, préférence 81
Back/Forward, commandes 455

extension de sélections 456
répétition 456

Bande passante de traitement 51
Bar|Beat, marqueur

à partir de la commande Identify Beat 589
déplacement 590
données audio avec tempos variables 592
édition 591
événement de tempo 590

Bars:Beats, échelle temporelle 408
Basculement

hauteur de piste 397
niveaux de zoom 437
vue Track 396

Base de données
partage de fichiers 197

Batch Fades, boîte de dialogue 552
Battement du tempo 323
Beat Detective 617, 619

avec plusieurs pistes 634
beat trigger

déplacement 627
génération 623
insertion 628
promotion 628
suppression 627

configuration requise 618
conformation de régions 635
création des marqueurs Bar|Beat 629
définition de la sélection 621
détection des transitoires 623
Edit Smoothing 638
extrapolation 632
fenêtre 620
mode Collection 639
modèle 630
modèle DigiGroove 630
modèle Groove

extraction 631
Scroll Next 629
séparation de régions 633
Trigger Pad 633

Beat Detective, commande 620
Big Counter, fenêtre 454
Black burst 941
Blocks, vue 394

piste vidéo 947
Boucle et réverbération, retard 858
Bounce to Disk, commande 855, 858

Aide 867
chemin source 860
Convert After Bounce 866
Convert During Bounce 866
dithering 856
enregistrement d'un prémixage 867
File Type 860
Format 863
fréquence d'échantillonnage, qualité de la conversion 

866
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marquage temporel 859
option Use Squeezer 866
options Bounce 860
options de conversion de fréquence d'échantillonnage 

865
résolution 864

Bounce to QuickTime Movie, commande 967
Bouton de tabulation vers transitoires 473
Bring to Front, commande 489
Bus de mixage 291, 739

redéfinition 64
BWF (.WAV), format de fichier 861
Bypass, bouton

plug-in en temps réel 775

C
Calibration Mode, commande 302
Calibration Reference Level, préférence 85
Canal 11
Canal d'entrée, sélecteur 48
Canal de remplacement

développement sur de nouvelles pistes 514
remplacement d'une région 513

Canal de sortie, sélecteur 48
Capacité de traitement du disque 51
Capacité de traitement du processeur 51
Capture de valeurs d'automation 848
Capture du timecode 936
Capture Region, commande 485
Caractère interdit 103, 285
catalog.ddb 196
Catalogue

création de dossiers 201
nom de clip 234
suppression de dossiers 215

Center % (pourcentage de centrage) 908
Center Playhead Scrolling, option 461
Center % dans la fenêtre Output 910
Champ du décalage défini par l'utilisateur (+/–) 759
Change Duration, commande 690
Change Duration, option 673
Change Edit to Match Timeline, commande 478
Change Meter, commande 593, 595
Change Tempo, commande 571
Change Timeline to Match Edit, commande 478
Change Velocity, commande 688
Change Velocity, option 673
Changement de nom

emplacements mémoire 610
playlist 415
région 565
région créée automatiquement 565

Changement de programme 17, 661
défaut, piste MIDI 662
déplacement 665
écoute 666
édition 665
insertion 665
recherche 668
sélection de banque 661
suppression 665

Changement de vue de piste 396
Chef d'orchestre, bouton 124
Chemin

actif et inactif 66
affectation 65
application 66
attribution d'un nom 61
création de chemins multicanaux 877
création et modification 60
dernière utilisation 70
écoute 72
exemple de sous-chemins Surround 892
exemple multicanal 65
mono ou stéréo 61
ordre par défaut 74
organisation 63
par défaut mono et stéréo 61
présélection pour le mixage stéréo 71
principal 55
réinitialisation par défaut 63
sélection 63
sortie par défaut 73
superposition 66
suppression 64
Surround 888

Chemin au format 5.0 dans les mixages 5.1 892
Chemin d'entrée, sélecteur 143, 157
Chemin de sortie, sélecteur 143, 158
Chemin du vumètre, sélecteur 72
Chemin source 860
Chemins superposés 66
Classic, mode du pavé numérique 24, 81
Clear All Clip Indicators, commande 145, 741
Clear Special, commandes 519, 830

All Automation 519, 830
Pan Automation 519, 830
Plug-In Automation 519, 830

Clear Trim Automation Track, commande 155, 819
Clear, commande (menu Edit) 518
Clear, commande (Region List) 425, 567
Clic 345
Clic, suppression 402
Click, plug-in 318
Clip Hold, options

3 secondes 145
Clip Indication, options 79

infini 145
None 145

Clip MIDI et liste des régions 420
Clock Source, menu déroulant 48
Close Session, commande 111
Coalesce Trim Automation Track, commande 155
Coalesce Trim Automation, options 91
Coalesce VCA Master Automation Track, commande 155
Coalesce when Removing Slaves from VCA Group, option 90
Codage couleur des pistes par défaut, options 79
Codage couleur des régions par défaut, options 80
Codage couleur, options 79, 171
Collage

automation 830
avec la commande Repeat to Fill Selection 520
pistes multiples 521
plug-in, paramètres 781
plusieurs types de données 521
sélections et régions 517

Color Palette, fenêtre 173
Command|8 763
Commandes d'édition 515
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coller 517
copier 516
couper 516
mode d'édition 516

Commandes de sélection
Play Edit Selection 474
Play Timeline 474

Commandes, focus clavier 22
Commentaires 148
Commentaires, champs (DigiBase) 210
Comments, vue 148, 732
Compact Selected, commande 425, 564
Compare, bouton 776
Compatibilité

informations 5
Compensation de retard

affichage 146
H/W Insert 75
MIDI Beat Clock 94
moteur 45
option Time Mode 85
ressources DSP 45
timecode MIDI 94

Compressé, format de fichier audio QuickTime 954
Compteur principal 409
Compteurs principaux 409
Configuration

MMC 930, 931
options du métronome 319
piste audio pour enregistrement 325
Pro Tools 40
SMPTE 920

Configuration de fenêtre 127
importation 262

Configuration de fenêtre, liste 128
Connexion

appareil audio externe 790
unité d'effet 790

Connexion d'entrée 11, 301
Consolidate, commande 563
Constant, commande (Tempo Operations) 582
Continuous Scroll During Playback, option 460

demi-écran 461
Continuous Scroll with Playhead, option

demi-écran 461
Contrôle local 17, 349
Contrôle séparé des signaux 883
Controller Meter Path, sélecteur 72
Conversion de session

format de fichier audio 105
fréquence d'échantillonnage 105
résolution 105

Conversion Quality, option 250, 866, 955
paramètre Tweak-head 955
paramètre Tweak-head 866

Convert Plug-In, sélecteur 775
Convert WAV files to AES31/BroadcastWave, option 92, 286
Copie

automation de pistes sur les envois 808
note MIDI avec la commande Split 694
paramètre de plug-in 781
paramètres de contrôle de piste vers les départs 743
sélections et régions 516
toutes les playlists d'automation d'une piste 519

Copy Settings, commande 779

Copy Special, commandes 519, 829
All Automation 519, 829
Pan Automation 519, 829
Plug-In Automation 519, 829

Copy to Send, commande 809
Copy, commande 516
Couplage

contrôles de plug-in 785
panoramique inversé 746
panoramique stéréo 746
plug-in multimono 887

Coupure
automation 826
note MIDI avec la commande Split 694
piste 169
région 510
sélections et régions 516

Coupure de départ 737
Coupure du son, bouton 169
CPU Usage Limit, paramètre 41, 42
Crayon, outil 429, 524, 646

dessin de l'automation 820
édition des points d'inflexion 822
formes 646, 820
Free Hand 646
gomme 656
insertion de notes MIDI 649
ligne

édition du tempo 575
Line 647
Random 647
réparation des formes d'onde 524
résolution des événements de contrôleurs insérés 660
sélectionner la forme du crayon 646
Square 647
Triangle 647

Create Click Track, commande 318
Create Fades, commande 548, 550
Création

crossfade 548
fondus d'entrée et de sortie 547
groupe de régions 525
marqueur et emplacement mémoire 607
région 485
session compatible Mac et PC 289
sessions 99
sous-dossiers de paramètres 780

Création automatique, région 393
attribution d'un nouveau nom 565

Crête, indicateur 143
Crossfade 539

avec dithering 544
boîte de dialogue Fades 541
création avec l'outil Smart 446
dithering 763
en groupe 551
gain égal 543
linéaire 545
pré/post 549
puissance constante 543, 546
recouvrement 546
rognage 549
suppression 549
types 539

Crossfade centré 540
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Crossfade Preference for Pre/Post-Roll, option 87, 546
Current Feet+Frames Position, commande 922
Current Meter, bouton 321
Current Meter, indicateur 124
Current Time Code Position, commande 922
Curseur

emplacement 117
valeur 117

Curseur d'édition 454
déplacement vers les limites d'une région 472
scrubbing 447

Curseur de lecture 453
Curseur de tempo 124
Custom Shuttle Lock Speed, préférence 81
Cut Special, commandes 518, 829

All Automation 518, 829
Pan Automation 518, 829
Plug-In Automation 518, 829

Cut Time, commande 595, 599
Cut, commande 516

D
DAE 7
D-Command 763
D-Control 763
Déclenchement externe

définition 787
filtres 787
traitement 776

Déclencheur 787
déclencheur, sélecteur 776

Décompte 320
Décompte, bouton 123
Découplage des contrôles de plug-in 785, 887
Default Dynamics préférence 89
Default Dynamics, préférence 773
Default EQ, préférence 89, 773
Default Note On Velocity, préférence 93, 649
Default Path Order, sélecteur 74
Default Thru, instrument 349

préférence 93
Défaut

changement de programme 662
chemin 61
chemin d'écoute 72
chemin de sortie 73
chemin du vumètre 72
fréquence d'échantillonnage 45
I/O Setup 69
métrique 321
ordre des chemins 74
tempo 321

Défilement
affichage d'une piste 150
dans la règle 458
de Mix et Edit aux pistes 459
vertical ou horizontal dans la fenêtre Pro Tools 458
vue Notes vers le haut ou vers le bas 404, 437

Défilement de la page 454, 460
Défileur

préférence d'émulation 83, 374
Définition des points d'enregistrement fractionné et de boucle 

338
Définition par l'utilisateur, région 392, 565

Degree of Thinning, préférence 89
Delay After Play Command, préférence 95
Delay Before Locking to Time Code, option 95
Delay Compensation 757

activation 757
affichage 734
application aux pistes automatiquement désactivées 

760
champ du décalage défini par l'utilisateur (+/-) 759
configuration du moteur de compensation de retard 758
dépassement de la limite de compensation 759
désactivation 759
indicateur de retard de plug-in (dly) 759
informations 758
mode 758
modification du retard de piste 759
paramètres 758
pendant l'enregistrement 309

Delay Compensation for External Devices, options 94
Delay Compensation Time Mode, option 85, 758
Delay Compensation, option 757
Delay Compensation, option (menu View) 758
Delay Compensation, vue 146, 734
Delay, plug-in 765
Delete Active Groups (liste de groupes), commandes 178
Delete Active Groups, commande 185
Delete Current Settings File, commande 779
Delete Fades, commande 549
Delete Group, commande 178, 185
Delete Track, commande 150, 156
Delta

rognage des données d'automation 799
Demi-écran 461
Demi-vitesse, enregistrement 345
Demi-vitesse, lecture 346
Départ 737

affichage des commandes 741
ajout 737
automation 808
bus de mixage 739
copie des automations de pistes 808
étiquetage 789
I/O matériel 739
mixage multicanal 885
modification des paramètres par défaut 738
mono ou stéréo 738
multicanal 885
niveau par défaut 738
suppression 738
vue Assignment 739

Départ, commandes 737
Déplacement

changement de programme 665
événement Sysex 666
fondu 552
insert 774
marqueur 611
marqueur Bar|Beat 590
note MIDI 653
région contenant des fondus 553

Déplacement des régions 496
Déplacement par incrément 505

contenu de région 508
définition de la valeur de déplacement par incrément 

506
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fondu 552
plage de sélection 468
points de début/de fin d'une sélection 468
région contenant des fondus 553
régions multiples 507
sélections et régions 506
valeur d'incrément suivante 507

Dernière utilisation 70
Désignation automatique

fichiers audio et régions 310
playlist 414
prise 310
région QuickPunch 371
régions séparées 487
Strip Silence 560

Désignation de volumes 229
Destructif, enregistrement 330
Destructive Record, mode 316, 330
DestructivePunch 381

enregistrement 386
préference de longueur de fichier 386
préparation 385
Prepare DPE Tracks 386

DestructivePunch File Length, préference 386
DestructivePunch File Length, préférence 85
Développement sur de nouvelles pistes 514
Digi 002 33

enregistrement avec la pédale 367
Digi 002 Rack 33
DigiBase

A (volumes audio) 207
affichage dans le Finder 204
affichage dans le navigateur 204
affichage de forme d'ondes

calcul 211
bande 209
bande son 209
basculement de l'affichage de l'aperçu des fichiers avec 

la barre d'espace 204
bit utilisateur 209
boutons plus (+) et moins (–) 218
calcul de forme d'onde 204, 211
candidat au rétablissement de lien 224
capacité 208
chemin 209
chemin d'accès 209
Circled 209
colonne d'état 207
commentaire de base de données 208
commentaire de fichier 208
commentaires

base de données 210
fichier 210

compression vidéo 209
copie d'éléments 213
copie de la sélection 204
copie et rétablissement de lien 204, 221
création de catalogue à partir de la sélection 204
critère de recherche

AND 218
OR 218

date d'indexation 208
date de création 208
date de modification 208
date de tournage 209

démontage 204
déplacement d'éléments 213
déverrouillage de la sélection 204
durée 208

groupe de régions 208
écoute 211
espace de travail

recherche 231
exemple pratique 242
fenêtre de navigateur 197
fenêtre de tâches 195, 238
fenêtre Relink 195, 224
fichier de transfert 220, 221
fichier manquant 220, 222
Find Links 226
format 208
forme d'onde 208
forme d'onde (dans les navigateurs) 210
fréquence d'échantillonnage 208
fréquence d'images 209
fréquence d'images du timecode de la bande son 209
fréquence TC 209
gestion des tâches 242
identifiant de bande 209
identifiant unique 209
indexation 202
inversion de la sélection 204
libre 208
lien 220
marquage temporel d'origine 208
marquage temporel utilisateur 208
menu de navigation 203
mise à jour de la base de données pour les éléments 

sélectionnés 203
mode Auto Preview 205, 212
mode d'écoute en boucle 212
mode de recherche 218
mode de recherche avancée 218
mode de recherche rapide 218
mode Loop Preview 205
modificateur (recherche dans les navigateurs) 217
modificateur de recherche 217
Name (nom de fichier) 207
navigateur 192
navigateur de l'espace de travail 193, 228
navigateur de projet 194, 231
navigateur de volume 194
nom de canal 209
nom de clip 210
nom de fichier 207
nom de plug in 209
nom de plug-in fabricant 209
nombre de canaux 208
nouveau catalogue 204
nouveau dossier 203
options d'affichage du navigateur 205
options de rétablissement de lien 227
outils du navigateur 197
partage des fichiers de base de données 197
prise 209
projet 209
recherche 215

caractère générique 217
recherche et rétablissement du lien automatiquement 

222
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recherche et rétablissement du lien manuellement 222
recherche rapide 215
régénération de fondus manquants 223
résolution 208
rétablissement de lien 220
rétablissement des liens des fichiers hors ligne 204
rétablissement des liens des fichiers sélectionnés 204
scène 209
sélection de fichiers en ligne 204
sélection de fichiers hors ligne 204
sélection de fichiers Transfer 204
Skip All 222
suppression d'éléments 213
suppression de dossiers dans les catalogues 215
suppression de la sélection 204
tâche active 240
tâche échouée 241
tâche interrompue 240
taille 208
tempo 208
timecode de la bande son 209
tri de colonnes 207
type 208
V (volumes vidéo) 207
verrouillage de la sélection 204
volume approprié (voir Fichier de transfert) 221
volume de lecture/écriture 196
volume du fichier de base de données 196
volume en lecture seule 196
volume Performance 195
volume Transfer 195
volumes partagés sur le réseau 196
WaveCache 196

DigiBase et DigiBase Pro
préférences 242

DigiBase Pro
catalogue 194, 233

consolidation 236
création 235
ouverture 235

copie de commentaires de fichiers dans les noms de 
clips 205

copie des commentaires de base de données dans les 
noms de clips 205

fichier de base de données de catalogue 196
fonctions de recherche 216
nom de clip 234
partage des catalogues de base de données 197
sauvegarde de résultats de recherche sous forme de 

catalogue 219
DigiDelivery 273
Digidesign Audio Engine 7
DigiGroove, modèles 630
DigiTranslator Integrated, option 270
Direct Outputs, mode 71
Disable “Input” When Disarming Track (In “Stop”), option 84
Disk Allocation 311

et sessions multiplateformes 312
et volume système 313
fenêtre 311
redimensionnement de la fenêtre 311

Disk Space, fenêtre 314
options 314

Display (liste de groupes), commande 178

Display Events as Modified by Real-Time Properties, option 93, 
707

Disposition de piste
ordre des chemins par défaut 74

Disque dur
compactage de données audio 564
enregistrement sur le volume système 313
Round Robin Allocation 312

Dither Plug-In, préférence 92
Dithering

AudioSuite 762
commande Bounce to Disk 856
fondu 544, 763
piste de fader principal 857
préférences 762
résolution et commande Bounce to Disk 864

Divergence
graphique 909
utilisation 908

Division de pistes stéréo ou multicanaux 523
Données de session

importation 255
Dossier

création et ouverture 201
suppression dans les catalogues 215

Dossier de destination pour paramètres de plug-in 780
Draw Grids in Edit Window, option 77, 428
Draw Waveforms Rectified, option 77, 401
DSP

aucune sortie 737
départ inactif 742
éléments actifs et inactifs 14
entrée et sortie inactive 158
ressources globales 14
sortie inactive 736
vumètre de départ 741

Duplicate Group, commande 178
Duplicate Track, commande 150, 155, 796
Duplicate, commande 521
Duplication

départ 743
insert 775
playlist 414
sélection de notes MIDI 522
sélections et régions 521

Durée
propriétés en temps réel 704

Durée, note MIDI
aléatoire 691
édition à l'aide de la commande Change Duration 690
plus de legato 692
plus de staccato 692

Durée, pour les sélections 467
DV

Video Sync Offset 966
DV Stream 965
DV Toolkit 2 35
DV25, film

lecture via le port Firewire 965
Dynamic Transport, mode 480
Dynamics, plug-in 765
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E
E/S non disponible

présentation 69
E/S, paramètres d'usine 71
Echelle temporelle 408

Bars:Beats 408
Feet.Frames 409
Minutes:Seconds 409
principale 409, 923
Samples 409
secondaire 410, 923
timecode 409

Echelle temporelle principale 408, 409, 923
Echelle temporelle secondaire 410, 923
Ecoute

dans les navigateurs 211
enregistrement MIDI avec MIDI Thru 349
fondu 541
indicateur 121
note MIDI 651
pendant l'enregistrement fractionné 333
points de début/de fin d'une sélection 474
pré/post-roll 474
prise 335
programme 666
région de la liste des régions, d'une 424

Ecoute avec latence faible
pendant l'enregistrement 309
prémixage sur disque 309

Ecoute in-place 73
Ecrêtage 302, 775
Ecriture

automation 805
automation à l'arrêt 835
automation à l'ensemble, au début ou à la fin de la 

sélection 834
automation par cliché 843
données d'automation au point d'inflexion suivant 836

Edit Insertion Follows Scrub/Shuttle, option 80, 447
Edit Selection Follows Region List Selection, option 86, 465
Edit Smoothing avec Beat Detective 638
Edit Window Default Length, préférence 78
Edit Window Follows Bank Selection, option 89
Edit Window, option 114
Edit, fenêtre 114, 116

défilement à partir de la règle 458
demi-écran 461
option de vue All 732
option de vue None 732
options de vue 114

Edit, menu 134
Clear Special, commandes 519, 830
commande Change Edit to Match Timeline 478
commande Change Timeline to Match Edit 478
commande Clear 518
commande Consolidate 563
commande Copy 516
commande Create Fades 548, 550
commande Cut 516
commande Delete Fades 549
commande Duplicate 521
commande Fade To End 548
commande Fade To Start 548
commande Fades 541
commande Heal Separation 491

commande Identify Sync Point 504
commande Insert Silence 562
commande Paste 517
commande Play Edit Selection 479
commande Play Timeline Selection 479
commande Redo 417
commande Repeat 522
commande Repeat to Fill Selection 520
commande Select All 464
commande Shift 508
commande Strip Silence 559, 561
commande TCE Edit to Timeline Selection 478
commande Thin Automation 820
commande Trim Automation to All Enabled 846
commande Trim Automation to Current 846
commande Trim Region End to Fill Selection 490
commande Trim Region End to Insertion 490
commande Trim Region Start to Fill Selection 490
commande Trim Region Start to Insertion 490
commande Trim Region to Selection 489
commande Undo 417
commandes Paste Special 519
commandes Separate Region 486
Copy Special, commandes 519, 829
Copy to Send, commande 809
Cut Special, commandes 518, 829
Trim Region to Fill Selection, commande 491
Write Automation, commandes 843, 845

Edit, modes 425
commandes d'édition 516
Grid 427
Grid relatif 427
placement des régions 492
Shuffle 426
Shuffle verrouillé 426
Slip 426
Spot 427, 935

Edit, options de vue de la fenêtre 732
Edition

attribut de la note 655
automation 822
changement de programme 665
dans la liste des événements MIDI 715
durée de note 690
emplacement mémoire 611
événement de contrôleur 660
événement de métrique 594
événement de tempo 571
forme d'onde 401
marqueur 611
marqueur Bar|Beat 591
mode Grid 427
mode Shuffle 426
mode Shuffle verrouillé 426
mode Slip 426
mode Spot 427
modes d'édition 425
modes Grid 503
non destructif 391
non destructive pour l'audio 402
non destructive pour MIDI 406
note MIDI 651
pendant la lecture 391
piste masquée 154
point d'inflexion 824
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région MIDI 405
régions en tant que grille 428
sur plusieurs pistes 520
vélocité d'une note 654
vélocité de note 688
vue d'une piste 515

Edition destructive
compactage des fichiers audio 564

Edition MIDI en miroir 645
Edition, outils 117, 429

crayon 429
main 429
outil de scrubbing 447
outil de zoom 429
scrubbing 429
sélecteur 429
Smart 429
trimming 429, 438
zoom 429

Effect Bypass, bouton 775
Effets, enregistrement sur disque 855
Elément

sélection 213
Elément à copier 108
Emplacement d'une note MIDI

déplacement 653
Emplacement mémoire 605, 606

attribution d'un nouveau nom 610
création 607
création à la volée 609
édition 611
emplacement mémoire de sélection 606
extension de sélections 469
marqueur 606
rappel 610
rappel de sélections d'édition 341
stockage de sélections d'édition 340
suppression 612
suppression totale 612

Emplacement mémoire de sélection 606
déplacement de la sélection stockée 611

Emplacement, note MIDI
aléatoire 680
quantification 679

Emplacements, notes MIDI
rendre aléatoire 677

En ligne, bouton 119
Enable Session File Auto Backup, option 83
End To Insertion, commande 490
Enforce Mac/PC Compatibility, option 107, 289
Enregistrement 302, 325

à partir d'une source numérique 343
annulation d'une prise 328
annulation des prises 328
avec le métronome 318
avec Round Robin Allocation 312
avec un décompte 320
configuration de pistes audio 325
configuration de pistes d'instrument 352
configuration de pistes MIDI 352
demi-vitesse 345
destructif 330
données System Exclusive 362
en ligne 928
en mode Record Pause 329

enregistrement en boucle 334
indicateur 121
latence d'écoute 308
mode DestructivePunch 386
mode QuickPunch 367
mode TrackPunch 371
non destructif 7, 330
non linéaire 7
piste audio 327
piste audio mono 325
piste audio stéréo 325
piste multicanal 325
plusieurs pistes audio 328
prémixage sur disque 857, 858
prise supplémentaire 330
raccourci clavier 329
régions MIDI 355
sur le volume système 313
vers une nouvelle playlist 331
voyant de statut 376

Enregistrement à la volée
pistes MIDI 357
QuickPunch 316, 367

Enregistrement d'une copie d'une session 105
Enregistrement d'une session 104
Enregistrement des paramètres du plug-in 781

commande Save Plug-In Settings To 779
commande Save Settings As 779
Save Settings, commande 779

Enregistrement du fichier de session sous un nouveau nom 
104

Enregistrement en boucle
audio 333
et pré/post-roll 334
MIDI 359

prises multiples 360
Enregistrement en ligne 928
Enregistrement fractionné

audio 332
et écoute 333
et pré/post-roll 332
MIDI 356
MIDI à la volée 357

Enregistrement MIDI 347
activation des dispositifs d'entrée 348
annulation d'une prise 356
annulation des prises 356
données System Exclusive 362
écoute avec MIDI Thru 349
filtre d'entrée 350
mode Merge/Replace 351
quantification en entrée 350, 696
Wait for Note 351

Enregistrement non destructif
avec QuickPunch 368

Enregistrement non destructif, mode 315
Enregistrement portable (appareil)

canal de remplacement 513
développement de canaux de remplacement sur de 

nouvelles pistes 514
importation de fichiers audio monophoniques 255
importation de fichiers audio polyphoniques 255

Enregistrement, bouton 121
Enregistreur DAT, enregistrement à partir de 344
Entrée auxiliaire 13, 137
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écoute et mixage 750
flux de signaux 723
voie 139

Entrée MIDI, sélecteur 143, 163
piste d'instrument 165

Entrée mono/sortie stéréo 766
Entrée numérique

raccourci 469
EQ, plug-in 765
Erreur DAE 345
Etendue, vue Transport 129, 339
Etiquette d'E/S (voir I/O Setup)
Evénement de contrôleur 18, 659

édition 660
édition avec l'outil Smart 447
insertion 660
recherche 668
région MIDI 406

Evénement de contrôleur continu 18
Evénement, zone d'édition 118

attribut de la note 655
Evénements MIDI, liste 709

édition d'événements 715
insertion d'événements 712
menu Options 717
navigation 711
sélection d'événements 715
suppression d'événements 716
View Filter 710

Event, menu 134
commande All MIDI Notes Off 670
commande Beat Detective 620
commande Change Meter 593
commande Identify Beat 588
commande MIDI Track Offsets 669
commande Remove Duplicate Notes 671
commande Renumber Bars 601
commande Time 595
commandes de tempo 581
commandes MIDI 673
liste des événements MIDI 709

Exit, commande (Windows) 111
Expand to New Tracks, commande 156
Export MIDI Settings, boîte de dialogue

menu contextuel MIDI File Format 276
option Apply Real-Time Properties 276

Export MIDI, commande 276
Export Region Definitions, commande 270, 425
Export Regions as Files, commande 267, 425
Export Selected Tracks as OMF/AAF, commande 270
Export Selected, boîte de dialogue 268
Export Session Info as Text, commande 270
Export Settings, bouton (I/O Setup) 70
Exportation

audio 267
définition de région 269
données audio des régions 267
fichier AAF 270
fichier OMFI 270
fichier stéréo entrelacé 269
groupe de régions 281
marqueur 277
piste MIDI 276
session sous forme de texte 270

Extension de sélections 468, 578

inclusion de régions adjacentes 468
limite de région 468, 578
marqueur et emplacement mémoire 469
pistes adjacentes 470, 471

External Time Code Offsets 919
Extrapolation 632

F
Fade Files, dossier 100
Fade To End, commande 548
Fade To Start, commande 548
Fader de volume 144
Fader de volume MIDI 144
Fader principal

commande maître de niveau de départ 756
flux de signaux 724
inactif 725
inserts 766
inserts post-fader 724
multicanal 886
voie 140
vumètre avant/après fader 725

Fades, boîte de dialogue 541
forme d'entrée 544
forme de sortie 542
option Link 543
option Use Dither 544

Fades, commande 541
Feet+Frames, position

redéfinition 922
Feet.Frames, échelle temporelle 409
Fermeture de plusieurs fenêtres Plug-In 778
Fichier

fondu manquant 222
nom de clip 234

Fichier complet, région audio 392
Fichier de transfert 284
fichier des paramètres d'E/S

importation et exportation 69
Fichier manquant 284

fondu et recréation 222
ignorer 222

File 860
File d'annulation 418
File, menu 134

commande Bounce To Disk 858
commande Close Session 111
commande Exit (Windows) 111
commande Export MIDI 276
commande Export Selected Tracks as OMF/AAF 270
commande Export Session Info as Text 270
commande Import Audio to Track 251
commande Import region groups 280
commande New Session 99
commande Open Session 101
commande Revert to Saved 104
commande Save 104
commande Save As 104
commande Save Copy In 106, 290
option Send via DigiDelivery 273

Fin, bouton 120
Find All Candidates, option 226
Find Matching Tracks, option 260
Find Region List, commande 421
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FireWire
lecture QuickTime DV25 965

First Selected MIDI Track, préférence 93
Flatten Performance, commande 687
Flatten Performance, option 673
Flux de signaux

entrée auxiliaire 723
fader principal 724
piste audio 723
piste d'instrument 726

Focus clavier sur la liste des régions 424
Focus sur le clavier 21

commandes 22
liste des groupes 23
liste des régions 22, 424

Fonctionnement, préférences 80
Auto Regions Fade In/Out Length, préférence 551
option Audio During Fast Forward/Rewind 455
option Edit Insertion Follows Scrub/Shuttle 447
option Link Record and Play Faders 307
option Machine Chases Memory Location 932
option Machine Follows Insertion/Scrub 932
option Record Online 928
option Use F11 for Wait for Note 351
préférence Open Ended Record Allocation 313

Fondu 546
avec dithering 544
création 547
création avec l'outil Smart 446
déplacement 552
déplacement par incrément 552
en groupe 551
fondu automatique 550
options de dithering 763
régénération 223, 285

Fondu automatique 550
Fondu d'entrée, forme 544
Fondu de sortie, forme 542
Fondu par défaut, Réglages 87
Fonte

automation de rognage 832
automation VCA 852

Format audio, session 916
Format de fichier (audio) 860

AIFF 861
BWF (.WAV) 861
MP3 862
MXF 861
QuickTime 861
ressource SND 861
Sound Designer II 861

Format de fichier de groupe de régions (.rgrp) 279, 532
Forme d'onde 400

affichage rectifié 401
instructions pour l'édition 401
passage à zéro 402
réparation avec le crayon 524
suppression des clics 402
WaveCache 213

Forward and Play, commande 455
Forward, commande 455
Frames, vue

piste vidéo 947
Fréquence d'échantillonnage 45, 865
Fréquence d'échantillonnage, options de conversion 259

Fréquence d'échantillonnage, qualité de la conversion 250, 
865, 955

Fréquence d'images
pull up et pull down 924

Frontale, divergence 908

G
Gain égal, crossfade 543
Génération du timecode 919
Gestion des régions 564
Gestionnaire de tâches 254
Get Info, commande 110
Glide Automation, commandes 830
Glisser-déposer

de la liste des régions vers les pistes 493
importation 263
importation de fichiers audio 253
importation de fichiers MIDI 275
importation de groupes de régions 533

Global MIDI Playback Offset, préférence 93, 669
Grid absolu, mode 427, 503
Grid relatif, mode 427, 503
Grid, mode 427, 503

absolu 427, 503
configuration 427
définition de la valeur de la grille 502
interruption 503
option Draw Grids in Edit Window 428
option Regions/Markers 428
relatif 427, 503

Grid/Groove Quantize, commande 675
Grid/Groove Quantize, option 673
Grille

paramètres pour l'édition MIDI 648
Grille de panoramique des fenêtres Mix et Edit 898
Grille, sélecteur de valeur 427, 428
Grille, valeur 648
Groove Quantize 681
Groove, modèles 630, 631, 681

affectation 684
application 683

Group Track, commande 180, 182
Group, boîte de dialogue 179
Groupe

activation 188
attribution d'un nouveau nom 183
attributs 186
création 180
décalage des commandes 190
dissociation des groupes d'édition et de mixage 176
duplication 185
édition d'automation 826
groupe d'édition 180
groupe de mixage 180
liaison des groupes d'édition et de mixage 176
modification 183
piste masquée 154
sélection au clavier 189
suppression 185

Groupe d'édition 180
sélection 464

Groupe de mixage 180
Groupe de régions 393, 525

annulation du groupement 527
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création 525
division 529
édition 530
exportation vers d'autres disques durs 282
fondus et crossfades 532
format temporel 526
importation 280
importation et exportation 279
mixte 527
modification du format temporel 530
multipiste 527
reconstitution de groupe 527
référence temporelle 529
rognage 531

Groupe de régions, fichiers
exportation 533
importation 533

Groupes, liste 176
focus clavier 23
masquage 177
menu contextuel 178
présentation 177

H
H/W Buffer Size 40, 308
H/W Insert Delay 75
Hardware Setup

taille du buffer 308
Hauteur d'une note MIDI

transposition 652
Hauteur de piste 397

changement de zoom 436
redimensionnement 399

Hauteur, note MIDI
transposition à l'aide de la commande Transpose 692

HD Accel 30
HD Core, carte 30
HD Process, carte 30
Heal Separation, commande 491
Help, menu 21, 134
Heure actuelle, affichage 917
HFS+ Disk Support, option 287
HFS+, disque

système Windows 287
Hide All Floating Windows, commande 134
Hide and Make Inactive Track, commande 155
Hide/Show Track, commande 155
High Quality QuickTime Image, option 82
Highest QuickTime Playback Priority, paramètre 82, 944
Historique de recherche 422
Historique, recherche de régions 422
Horloge externe, sortie 48, 914
Hors ligne

rétablissement de liens de fichiers 204
sélection de fichiers dans DigiBase 204

I
I/O matériel, départ 739
I/O Setup, boîte de dialogue 53, 57

affichage d'E/S non disponible 69
dernière utilisation 70
exemple de mixage Surround 891
fichier des paramètres 69

fichier des paramètres pour le mixage Surround 71
fichier des paramètres usine 71
importation pour le Surround 876
initialisation 66
paramètres d'importation et d'exportation 69
paramètres par défaut 69
présélection pour le mixage stéréo 71
redimensionnement de la fenêtre 53
réinitialisation des chemins 63
session Surround 874

I/O SYNC
génération de timecode 929
options de synchronisation 914
référence 913
VSO

I/O, vue 143, 733
ID de groupe, indicateur

menu contextuel 178
Identify Beat, commande 588, 589
Identify Sync Point, commande 504, 939
Ignore Errors During Playback/Record, option 43
Ignore Track Arming, option 95
Image de départ pour les sessions 917
Import Audio to Track, commande 251
Import Audio, boîte de dialogue 251
Import Key Signature Map, option 262
Import Marker/Memory Locations, option 262
Import Region Groups, commande 280, 281
Import Session Data, boîte de dialogue 257
Import Session Data, commande 256
Import Settings, bouton (I/O Setup) 70
Import Settings, commande (plug-in) 779
Import Video, commande 951
Import Window Configurations, option 262
Importation

audio 247
audio et qualité de la conversion 250
configuration de fenêtre 262
conversion de fichier 266
conversion des données audio 248
copie 267
données audio QuickTime 954
élément hors ligne du catalogue 238
fichier audio multicanal d'un appareil d'enregistrement 

portable 254
groupe de régions 280
marqueur 275
marqueurs/emplacements mémoire 262
par glisser-déposer 263
paramètres d'E/S multicanaux 876
paramètres PRE 263
piste MIDI 274
piste pour d'autres sessions 255
plug-in, paramètres 781
référence ou copie 267
table des signatures de tonalité 262
table des tempos et mesures 262

Importation MIDI 274
Inactif

affectation des chemins d'une piste 66
chemin 66
chemin, globalement 67
départ 742
entrée 158
insert 769
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piste 170
piste de fader principal et affectation 725
sortie 158

Inactive, mode
désactivation d'éléments 14
plug-in 16

Include Control Changes in Undo Queue, option 91
Include Sends in Trim Mode, option 91
Includes Take Region Lengths That Match, option 86, 337
Includes Take Region Names That Match Track Names, option 

86, 337
Incoming Time, affichage 917
Indicateur d'emplacement 457
Indicateur d’emplacement

recherche 457
Indicateur de compensation de retard (cmp) 759
Indicateur de retard de plug-in (dly) 759
Indicateur de sélection d'édition 469
Infinite Clip Hold, option 79, 145
Infinite Peak Hold, option 79, 145
Info-bulle 78, 136
Input Devices, commande 348
Input Filter, commande 350

boîte de dialogue MIDI Event List View Filter 711
boîte de dialogue MIDI Input Filter 350

Input Only, mode d'écoute 306
Input Quantize, commande 697
Input Quantize, option 673
Insert 730, 765

après fader sur pistes de faders principaux 724, 766
déplacement 774
désactivation (et activation) 769
duplication 775
en tant que bus partagé 766
étiquetage 789
I/O matériels 765
mono 766
partagé dans un prémixage 754
plug-in 765
stéréo 766
sur pistes uniques 766

Insert avant/après fader 766
Insert d'I/O matériel 765
Insert Silence, commande 562

mode Shuffle 562
mode Slip 563

Insert Time, commande 595, 597
Insertion

changement de programme 665
dans la liste des événements MIDI 712
événement de contrôleur 660
événement de métrique 593
événement de tempo 571
note MIDI 648
plug-in sur les pistes 770

Insertion de l'aperçu, bouton 848
Insertion de la capture, bouton 849
Inserts, vue 733
Instrument, piste 138

configuration pour l'enregistrement 352
écoute et mixage 750
flux de signaux 726
mixage Surround 886
sélecteur d'entrée MIDI 165
sélecteur de sortie MIDI 165

voie 142
vue Notes 394
vue Regions 394

Instrument, plug-in
enregistrement audio 364

Instrument, vue 732
Interface audio 32

canaux d'entrée 11
Internal, mode (option Clock Source) 917
Internet, site 5
Interruption

automation 815, 816
écriture de l'automation 815

J
Jam Sync 919
Join, commande 798

L
Largeur des pistes 146
Latch Record Enable Buttons, option 83
Latch, mode

AutoJoin 798
Join 798

Latch, option 168
Latching Behavior for Switch Controls in “Touch”, option 90
Latence d'écoute 308
Latence pour enregistrement et écoute 308
LCRS, exemple de chemin 877
LE, système 33

fonctionnalités 34
QuickPunch 369

Lecture
à partir d'un point de la piste 454
aucun défilement 460
demi-vitesse 346
piste 328, 453
sélection 474
sélection à la volée 465
sélection d'édition avec la tête de lecture 479
sélection de timeline avec la tête de lecture 479

Lecture en solo
piste 166
piste dans un prémixage 757

Lecture, bouton 120
Legacy I/O 49
Levels of Undo, préférence 88, 418
LFE

activation dans les plug-in 911
exemple de canal séparé ou de collecte des signaux 895
exemple de sous-chemin 892
fader 911

LFE Enable, bouton 777
Librarian, menu 775
Limit To, préférence 85
Limite de région

déplacement de la tête de lecture 479
déplacement du curseur d'édition 472
extension de sélections 468, 578

Linéaire, crossfade 545
Linear Sample Display, commande 580
Linear Tick Display, commande 580
Linear, commande (Tempo Operations) 583
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Link Enable, boutons 777
plug-in multimono 888

Link Mix and Edit Group Enables, option 88
Link Record and Play Faders, option 83, 307
Link Selection, bouton 462, 463
Link Timeline and Edit Selection, option 462
Link Track and Edit Selection, option 149, 463
Lissage d'automation 802
Liste des pistes 152

masquage 152
menu contextuel 152
présentation 152

Localisateur de curseur de lecture 458
Lock Region, commande 509
Lock Settings File, commande 779
Locked Track, commande 155
Locked, indicateur 918
Loop Playback, option 475

et mode Touch 806
Loop Record, mode 316, 334
Low Latency Monitoring, option 308

M
Mac, session

compatibilité Windows 289
Machine Chases Memory Location, option 94, 932
Machine Cues Intelligently, option 94
Machine Follows Insertion/Scrub, option 94, 932
Machine Track Arming, fenêtre 934
Main, outil 429, 466

édition des points d'inflexion 577, 822
outil de saisie d'objet 466
outil de séparation 488
sélection de notes MIDI 651

Maître de transports 932
Make Active, commande 171
Make Active/Inactive Track, commande 155
Make Inactive, commande 171
Manual Tempo, mode 124, 322
Marquage temporel 938

commande Bounce to Disk 859
Marquage temporel original 938
Marquage temporel utilisateur 939
Marqueur 606

création 607
création à la volée 609
déplacement 611
édition 611
exportation 277
extension de sélections 469
importation 275
options d'affichage 613
références au métronome et aux échantillons 606
suppression 612
tri 614

Marqueur Bar|Beat
créé avec Beat Detective 629

Marqueur d'édition 462
durée de la sélection 467

Marqueur de début de morceau 569
déplacement 570
modification du tempo 570

Marqueur de sélection de timeline 339, 462
durée de la sélection 467

sélection d'édition 463
sélection de timeline 477

Marqueur, règle 407, 606
Marqueur/Emplacement mémoire

importation 262
Masquage

piste 153
région créée automatiquement 566
toutes les pistes 153

Master Link, bouton 776
plug-in multimono 888

Mastering
numériquement 869
sur disque 868

Mastering numérique 869
Matches, menu déroulant 335
Matching Start Time Takes List, préférences 86
Matériel

affectation à Pro Tools 59
décalage de retard 75
mise à jour des paramètres d'E/S après modification 63

Matériel, configuration 48
entrée analogique 49
format numérique 48
initialisation d'une interface Legacy I/O 49
menu déroulant Meters pour l'interface 96 I/O 48
sélecteur de canal d'entrée 48
sélecteur de canal de sortie 48
sélection de plusieurs sorties 50
sortie analogique 49
sortie d'horloge externe 48
source d'horloge 48

Mbox 33
Mbox 2 33
Medium (QuickTime Playback Priority), paramètre 82
Medium QuickTime Playback Priority, paramètre 944
Memory Locations, fenêtre 605, 610

options d'affichage des marqueurs 613
View Filter 615

Menu Track
commande Scroll to Track 459
commande Split Into Mono 523

Menus 178
Merge, mode (voir Mode de fusion MIDI)
Mesure

renumérotation 601
Métrique

affichage 124
défaut 321
en cours 592

Métrique, événement 592
édition 594
insertion 593

Métrique, règle
affichage 592
extension d'une sélection d'édition 594

Métronome 318
activation 320
configuration 319

Métronome, bouton 123, 320
Mic Preamps, vue 732
MIDI 16

affectation de canaux 164
appareil 17
canaux 17
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chemins des signaux 18
contrôle local 17
décalage 669
définition de la valeur de la grille pour l'édition 648
enregistrement en boucle 359
erreurs courantes 18
événement de contrôleur 659
fichier de nom de patch (.midnam) 663
générateur de signaux 17
importation 274
importation par glisser-déposer 275
instrument Thru par défaut 349
interface 17
nom de patch 663
périphérique de contrôle 17
sélection et répartition des notes 694
source sonore 17
surface de contrôle 17

MIDI externe, instrument
enregistrement audio 365

MIDI File Format, menu contextuel 276
MIDI Machine Control 929
MIDI Machine Control (MMC) 929

activation de pistes à distance 934
configuration dans Pro Tools 930, 931
contrôle des périphériques externes 929

MIDI Merge 123, 317, 351
MIDI Merge, mode 317
MIDI Note Display, options 94
MIDI Operations, commandes 673

commande Change Duration 690
commande Change Velocity 688
commande Flatten Performance 687
commande Grid/Groove Quantize 675
commande Input Quantize 697
commande Restore Performance 686
commande Select/Split Notes 695
commande Step Input 697
commande Transpose 692

MIDI Operations, fenêtre 673, 675
MIDI Replace, mode 123, 317, 351
MIDI standard, fichier 274

exportation 276
importation 274
type 0 274
type 1 274

MIDI Studio Setup, fenêtre 663
MIDI Thru, commande 349
MIDI Track Offsets, commande 669
MIDI, bouton de zoom arrière 430
MIDI, bouton de zoom avant 430
MIDI, commandes du menu Setup

commande Input Devices 348
commande Input Filter 350
commande MIDI Beat Clock 934

MIDI, fichier (voir MIDI standard)
MIDI, note

attribut 655
défilement 404
déplacement 653
division 694
durée en tics 411
écoute à l'aide du mini-clavier 651
édition 651

durée 690

hauteur 652
vélocité 654, 688

insertion 648
quantification 681
recherche 667
rognage des points de début et de fin 653
sélection 651
sélection à l'aide du mini-clavier 651
suppression 656
transposition 652, 692

MIDI, notes
duplication des notes sélectionnées 522

MIDI, périphérique de contrôle 347
Local Control 349

MIDI, piste
affectation à plusieurs canaux 353
changement de programme par défaut 662
configuration pour l'enregistrement 352
décalage MIDI 669
enregistrement 347
enregistrement à la volée 357
enregistrement en boucle 359
enregistrement fractionné 356
entrée 163
Note Chasing 667
sélection d'une plage de hauteurs 695
sortie 164
voie 141
vue Notes 394, 403
vue Regions 394, 404
vue Sysex 666
vue Velocity 654

MIDI, préférences 93
option Pencil Tool Resolution When Drawing Controller 

Data 660
préférence Default Note On Velocity 649
préférence Global MIDI Playback Offset 669
préférence Pencil Tool Resolution When Drawing 

Controller Data 93, 821
MIDI, propriétés en temps réel 700

paramètres 703
pistes et régions 705

MIDI, région 403
création sur barres de mesure 355
et enregistrement fractionné 358
événement de contrôleur 406
instructions pour l'édition 405

Mini-clavier 651
Minimize Additional I/O Latency, option 43
Minimum Sync Delay, option 95
Minimum Sync Delay, préférence 95, 933
Minutes:Seconds, échelle temporelle 409
Mise en boucle

lecture 475
région 534
sélection 475

Mix Window Follows Bank Selection, option 89
Mix Window, option 113
Mix, fenêtre 113, 115

commande de piste 113
largeur des pistes 146
None, option de vue 732
option All Views 113
option de vue All 732

Mix, options de vue de la fenêtre 732
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Mixage final 868
Mixage final vers un format stéréo 868
Mixage stéréo

présélection usine des paramètres d'E/S 71
Mixage, préférences 88

préférence AutoMatch Time 91
Mixing Preferences, page

option Touch Timeout 89
MMC (voir MIDI Machine Control)
Mode calculateur pour la saisie numérique 470
Mode Collection, Beat Detective 639
Mode d'écoute 305

Auto Input 305
Input Only 306

Mode d'édition, boutons 425
Mode d'enregistrement 314

et MIDI 317
mode d'enregistrement non destructif 315
mode Destructive Record 316
mode Loop Record 316
QuickPunch 316

Modèle
Beat Detective 630
DigiGroove 630
session Pro Tools 109

Modèle de session personnalisé 109
Modify Group, commande 178
Modify Groups (liste de groupes), commande 178
Molette de défilement

affichage des notes d'une piste MIDI 404, 437
défilement d'une fenêtre Pro Tools 458
zoom avant dans la fenêtre Edit 437

Momentary, option Solo Latch 168
Mono

chemin 61
insert 766
prémixage sur disque 863

Moteur de compensation de retard
configuration 758

Move Song Start, commande 595, 600
MP3, format de fichier 862

MP3, option 248, 862
MPEG-1 Layer 3 862
MTC (MIDI Time Code)

émission 919
Multicanal, piste 325

acheminement du signal 881
automation 825
déplacement de régions 523
division 523
remplacement des régions 512

Multicanal, plug-in 887
Multicanal, région 393
Multicanaux, plug-in 767
Multimono

plug-in 766, 887
sélecteur de canal de plug-in 888

Multiple mono 864
Multiplication de la vélocité des notes 655, 690
Multitimbral 17
Music Production Toolkit 35
Mute Audio Inputs in Auto Input, option 380
Mute Frees Assigned Voice, option 169, 170
Mute Overwrite/Extend 840
Mute Record-Armed Tracks While Stopped, option 380

Mute Record-Armed Tracks While Stopped, option 84
Mute/Unmute Region, commande 510
MXF, format 248, 861

N
Narrow Mix, option d'affichage 146
Navigateur

affichage des options 205
informations générales 124, 192, 197
ouverture 199
premier plan 199
tri 207
utilisation 199

Navigateur de l'espace de travail 312, 313
Navigateur de projet 233, 284
Navigation 199
New Group (liste de groupes), commande 178
New Memory Location, boîte de dialogue 340
New Session, commande 99

dernière utilisation 70
New Track Default Output Path, sélecteur 73
New Track, commande 147
New Tracks Default To Tick Timebase, option 86
New Tracks, boîte de dialogue 147
Niveau d'entrée 301
Niveau, fader

départ 737
No Clip Hold, option 79
No Clip Indication, option 145
No Output, option 737
No Peak Hold, option 79, 145
Nom de groupe

menu contextuel 178
Nom de la piste

menu contextuel 155
Nombre de voix 44
Non destructif, enregistrement 330

enregistrement vers une nouvelle playlist 331
Non destructive, édition 391

audio 402
MIDI 406

Non linéaire 7
Non-Linear Transport Error Suppression, option 95
Normal (QuickTime Playback Priority), paramètre 82
Normal QuickTime Playback Priority, paramètre 944
Normal Zoom, mode 431
Note (voir MIDI, note)
Note Chasing, option 667
Note coincée 670
Notes, rapport 102
Notes, vue 394, 403

défilement vers le haut ou vers le bas 404
mini-clavier 403
pistes MIDI et pistes d'instrument 403

Numeric Keypad, mode 81
Numeric Keypad, modes

Classic 81
option Use Separate Play and Stop Keys 82
Shuttle 81, 450
Transport 81

Numérique, format 48
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O
Object Select in Edit Window, commande 425
Offline, région 393
OMF, format de fichier 265
OMFI, format de fichier 270
On Stop 835
Online, options 84
Open Ended Record Allocation, préférence 85, 313
Open Session, commande 101
Operation/Destination Track, menus contextuels 260
Operations, menu

commande Calibration Mode 302
Link Track and Edit Selection 149, 463
option Link Timeline and Edit Selection 462
option Low Latency Monitoring 308

Optical
I/O ADAT 48

Optical (S/PDIF)
configuration du matériel 48

options d'affichage des règles 407
Options de défilement 460

après la lecture 460
Center Playhead 461
Continuous Scroll During Playback, option 460
None 460
page 454, 460

Options, menu 134
commande Auto-Spot Regions 937
commande MIDI Thru 349
commande Mirror MIDI Editing 645
commande Transport Online 928
commande Video Out FireWire Port

 965
Delay Compensation, option 757
mode Destructive Record 330
mode Loop Record 334
option Link Track and Edit Selection 149, 463
option Loop Playback 475
option Mute Frees Assigned Voice 169, 170
option Pre/Post-Roll 342
option Pre-Fader Metering 145
options de défilement 460
options Solo Latch 168

OR
modificateur de recherche 218

Organize Plug-In Menus By, option 78, 772
Original Time Stamp 502
Other Playlists, menu 415
Outil d'accrochage de temps 466
Outil de saisie d'objet 466

et groupe d'édition 466
Outils d'édition

crayon 524
Grabber 466
sélecteur 453

Output Window, bouton 899
Output, fenêtres 735
Output, options

fréquence d'échantillonnage 865
option Conversion Quality 866

Ouverture de plusieurs fenêtres Plug-In 777

P
P (navigateurs) 229
Panoramique couplé en mode inversé 746
Panoramique de départ 737
Panoramique, curseur 144
Panoramique, indicateur 144
Panoramisation

activation dans la grille 905
automation et groupes 826
conventions 890
couplage stéréo 746
grille 898
mode de réglage précis 905
mode X/Y 904
option Use Absolute Pan Linking 88
playlist d'automation multicanal 911
trajectoire 907
trois boutons 905

Parabolic, commande (Tempo Operations) 584
Parallèle, mixage 884
Paramètre de session 107
Paramètre précédent, bouton 775
Paramètre suivant, bouton 775
Paramètres

collage 781
commande Settings Preferences 779
copie 781
création de sous-dossiers 780
création du défaut de l'utilisateur 781
enregistrement 781
importation 781
sélection d'une destination 780

Paramètres d'E/S 71
paramètres de plug-in, bibliothèque 778
Paramètres par défaut pour plug-in TC/E 92
Paramètres utilisateur par défaut, création 781
Parasite 345
Passage à zéro 402
Paste Settings, commande 779
Paste Special, commandes

Merge 519, 829
Overwrite 829
Repeat to Fill 829
Repeat to Fill Selection 519
To Current Automation Type 519, 829

Paste, commande 517
Patch Select, boîte de dialogue 662
Patch Select, bouton 662
Pavé numérique, modes 23

Classic 24
Shuttle 25
Transport 24

Peak Hold, options 79
3 secondes 145
infini 145
None 145

PEC/Direct Style Input Monitoring, option 84
Pencil Tool Resolution When Drawing Controller Data, option 

660
Pencil Tool Resolution When Drawing Controller Data, 

préférence 93, 821
Performance, volume

définition 195
enregistrement 195
lecture 195
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PFL (Pre Fader Listen) 167
Phase Invert, bouton 777
Piste

ajout à une sélection 470, 471
ajout de commentaires 148
ajout de nouvelles données à la fin des pistes 331
concepts 9
configuration MIDI pour l'enregistrement 352
configuration pour l'enregistrement 325
conversion de pistes multicanaux en pistes mono 883
coupure 169
création d'une piste de métronome 318
déplacement des sélections 471
désactivation (et activation) 170
disposition de piste au format 5.1 882
duplication 150, 796
enregistrement 327
format 138
hauteur de piste 397
lecture 328, 453
lecture en solo 166
masquage 153
nom 146, 310
options de codage couleur 171
placement des régions 492
préparation en enregistrement 302
priorité de lecture 160
raccourci de défilement 459
recherche avec Avance rapide/Retour rapide 455
regroupement 174
rognage des données indésirables 489
sélection de toutes les régions 464
sélection des données 463
sélection sur plusieurs pistes 470
suppression 150
suppression d'une sélection 472
Surround 881
transposition 692
types 137
vue principale 397, 827
vue Track 393, 395
vumètre 145

Piste de métronome 318
Piste masquée

édition de groupes 154
groupe 154
sélection 464

piste multicanal
nom 310

Piste stéréo
nom 310

Piste, commandes
fenêtre Edit 117
fenêtre Mix 117

Piste, données 392
Piste, sélecteur de vue 395
Piste, vumètre 144
Pistes multiples

adaptation des régions audio à la sélection d'édition 
479

Beat Detective 634
collage 521
déplacement de régions par incrément 507
déplacement en mode Shuffle 497
écoute des prises 336

édition 520
extension de sélections 470, 471
sélection 470
séparation des régions 487

Placement
placement automatique 937
région 500, 935, 936

Play Edit Selection, commande 474, 479
Play MIDI Notes When Editing, option 93
Play Start Follows Timeline Selection, option 81
Play Start Marker Follows Timeline Selection, option 481
Play Timeline Selection, commande 474, 479
Playback Engine 914

paramètre RTAS Processors 40
Playlist 10, 413

affectation 415
ajout d'une nouvelle playlist 415
attribution d'un nouveau nom 415
désignation automatique 414
duplication 414
édition MIDI non destructive 406
enregistrement vers de nouvelles playlists 331
groupe 416
modification de règle temporelle 413
piste multicanal 825
playlist d'automation 414, 794, 803
playlist d'édition 413
rappel 415
réglage du pré/post-roll 342
sélecteur de playlist 414
suppression 416

Playlist d'édition 413
Plug-in

désactivation (et activation) 16
Plug-in

activation de l'automation 787, 810
automation 809
bouton Paramètre précédent 775
bouton Paramètre suivant 775
bouton Plug-ins Settings Select 776
Category 772
Category and Manufacturer 773
couplage 887
couplage et découplage 785
création de paramètres par défaut 781
désactivation depuis une fenêtre 784
favorites 774
Flat List 772
insertion sur les pistes 770
Manufacturer 773
mixage Surround 887
mono à stéréo 766
multicanaux 767
multimono 766, 887
Organize Plug-in Menus By 772
paramètre RTAS Processors 40
précision de l'automation lors du prémixage 866
processeurs multiples 41
sélecteur de canal pour le multimono 888
suppression des pistes 771
Surround 887
valeur de majoration 927

Plug-in Controls Default to Auto-Enabled, option 90
Plug-in RTAS 767

latence supplémentaire 767
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utilisation des voix 767
Plug-In Settings, menu 775
Plug-in TDM 767
Plug-in temps réel 765
Plug-in, commandes

couplage 785
réglage 785, 786

Plug-In, fenêtre
fermeture de plusieurs fenêtres 778
ouverture de plusieurs fenêtres 777

Plug-in, insert 765
Plug-ins Settings Select , bouton 776
Point d'enregistrement de boucle 338

marqueur de sélection de timeline 339
Point d'enregistrement fractionné 338

marqueur de sélection de timeline 339
Point d'inflexion 824

incrustation Avid 822
Point d'insertion d'édition

placement des régions 494
rognage de régions 489

Point de passage 797
Point de synchronisation 939

Beat Detective 639
identification 504, 939
région 504

Post crossfade 540, 549
Post-roll, bouton 122
Pré crossfade 540, 549
Pre Fader Listen, mode 167
PRE, paramètres

importation 263
Pre/Post Fader, bouton 747
Pré/post-roll

écoute 474
et enregistrement en boucle 334
et enregistrement fractionné 332
sélection 341

Pré/post-roll, drapeau 342, 462
Pre/Post-Roll, option 342
Pre-Fader Metering, option 145
Préférence d'affichage

option Show Meters in Sends View 741
Préférences

affichage des info-bulles 136
DestructivePunch File Length 386
Mute Audio Inputs in Auto Input 380
option Automatically Copy Files on Import 267
option Mute Record-Armed Tracks While Stopped 380
suspension pendant la lecture 242
TrackInput 307
TrackPunch 373
Zoom Toggle 87

Préférences d'affichage 77
option Draw Grids in Edit Window 428
option Draw Waveforms Rectified 401
options Clip Indication 79
options Peak Hold 79

Préférences d'édition 85
option Auto-Name Memory Locations While Playing 609
option Auto-Name Separated Regions 487
option Conversion Quality 250
option Crossfade Preference for Pre/Post-Roll 87, 546
option Edit Selection Follows Region List Selection 465
option Includes Take Region Lengths That Match 337

option Includes Take Region Names That Match Track 
Names 337

option Separate Region Operates On All Related Takes 
337

préference QuickPunch Crossfade Length 368, 374
Region List Selection Follows Edit Selection, option 419, 

465
Separate Region Operates On All Related Takes, option 

487
Preferences, boîte de dialogue 77

ouverture 77
Premier plan 199
Prémixage 56

application d'un insert 754
exemple de Surround 895
lecture en solo de pistes 757
prémixage sur disque 857
report son 867

Préparation des pistes à l'enregistrement 302
Prepare DPE Tracks, option 386
Pre-Process using Standard Conform 637
Pré-roll, bouton 121
Preserve Fades when Editing, option 87
Preserve Folder Hierarchy, commande

éléments à copier
commande Preserve Folder Hierarchy 109

Principal, chemin 55
Priorité de lecture QuickTime, options

paramètre Highest 944
paramètre Medium 944
paramètre Normal 944

Prise
écoute 335
écoute à partir de la liste des pistes identiques 335
enregistrement d'autres prises 330
nom par défaut 310
numérotation de QuickPunch 371

Prise associée 335
et commande Separate Region 337
préférences 337

Pro Tools
guides 3
icône de fichier de session 8
menus principaux 134

Pro Tools LE
gestion de fichiers 283
système 33

Pro Tools LE, système 34
Pro Tools M-Powered 35
Pro Tools|HD Accel, système 30
Pro Tools|HD, système 30

fonctionnalités audio 31
fonctionnalités d'E/S 32
fonctionnalités MIDI 31
gestion de fichiers 283
interface audio 32
QuickPunch 368, 369
TrackPunch 371

Pro Tools
piste vidéo

vue Frames 947
Pro Tools, menu

commande Quit (Mac) 111
Procédure 378
Program Change, boîte de dialogue 662, 664
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Protection de l'automation 803
Puissance constante, crossfade 543, 546
Pull up et pull down

audio 924
plug-in 927
règle 927
vidéo 924

Punch In Frame Offset, préférence 95
Punch Out Frame Offset, préférence 95

Q
Quantification

données MIDI en entrée 350, 696
note MIDI 681

attaque et relâchement 677
quantification

propriétés en temps réel 703
Quantize Regions, commande

valeur de la grille 502
Quantize to Grid, commande 509
Quantize, commande

essai 680
Quantize, fenêtre 678
QuickPunch 316, 367

crossfade 368, 374
numérotation des prises/régions 371
système LE 369
système Pro Tools|HD 368

QuickPunch Crossfade Length, préference 368, 374
QuickPunch Crossfade Length, préférence 87
QuickTime

Avid 965
QuickTime Playback Priority, options

paramètre Highest 82
paramètre Medium 82
paramètre Normal 82

QuickTime, format de fichier audio 954
QuickTime, format de fichiers 861
QuickTime, séquence

configuration requise 944
optimisation de la lecture 967
qualité de lecture 944
sync 966

Quit, commande (Mac) 111

R
R (navigateurs) 229
Raccourci clavier

commandes de touches générales 21
enregistrement 329
entrée numérique 469

Raccourcis clavier 786
Raccourcis de saisie clavier 786
Randomize, option

durée de note 691
emplacements des notes 677

Real-Time Properties, fenêtre 701
Real-Time Properties, vue 701, 733
Recalculate Waveform Overviews, commande 425
Recall Memory Location Selection at Original Track, option 86
Recherche

avec Avance rapide/Retour rapide 455
changement de programme 668

curseur de lecture 458
événement de contrôleur 668
indicateur d'emplacement 457
note MIDI 667

Recherche de régions
par nom 421
selon dernières entrées ajoutées 421

Recherche des régions 421
historique de recherche 422

Recherche et rétablissement du lien automatiquement 285
Recherche et rétablissement du lien manuellement 285
Recompute Invalid Overviews, option 78
Record Enable, bouton 302, 376
Record Online at Insertion/Selection, option 84
Record Online at Time Code (or ADAT) Lock, option 84
Record Online, option 928
Record Pause, mode 329
Record Safe, mode 305
Recouvrement, crossfade 546
Redéfinition

position de timecode 922
position Feet+Frames 922

Redo, commande 417
Référence ou copie lors de l'importation 267
Régénération de fondus manquants 285
Région 10

affichage des noms 399
affichage des positions temporelles 399
alignement 499
alignement sur la région suivante 499
alignement sur les points de début de la région 495
attribution d'un nouveau nom 565
boucle 534
capture 485
collage 517
conformation avec Beat Detective 635
consolidation 563
copie 516
coupure 510, 516
création 485
créée automatiquement 393
crossfade 548
décalage 508
définie par l'utilisateur 392, 565, 566
déplacement 496
déplacement à partir de la liste des régions 492
déplacement de régions contenant des fondus 553
déplacement en mode Grid 503
déplacement en mode Shuffle 496

pistes multiples 497
déplacement en mode Slip 500
déplacement par incrément 506
déplacement par incrément de régions contenant des 

fondus 553
déplacement vers des pistes multicanaux 523
désignation automatique 566
déverrouillage 509
duplication 521
exportation sous forme de fichiers audio 267
extension des sélections à inclure 468
gestion 564
insertion de silence 562
marquage temporel 938
masquer les régions créées automatiquement 566
MIDI 355
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multicanal 393
nom par défaut 310
offline 393
Original Time Stamp 502
placement 500, 936
placement au point d'insertion d'édition 494
placement automatique 937
placement dans les pistes 492
placement en arrière-plan 489
placement en premier plan 489
point de synchronisation 504, 939
quantification 509
recherche 421
région audio de fichiers complets 392
réinitialisation 518
réinitialisation des propriétés en temps réel 707
remplacement 510
répétition 522
rétablissement des séparations 492
rognage des données indésirables 489
rognage des points de début et de fin 438
rognage jusqu'au point d'insertion d'édition 489
rognage par la valeur de déplacement par incrément 491
sélection 464
sélection de toutes les régions d'une piste 464
séparation 486
séparation avec Beat Detective 633
séparation avec l'outil Separation Grabber 488
suppression des régions inutilisées 567
suppression des silences 561
tri 420, 421
User Time Stamp 502
verrouillage 509

Région audio 400
fichier complet 392

Région créée automatiquement
masquage 566

Région définie par l'utilisateur 566
Region Groups, dossier 100
Region List Selection Follows Edit Selection, option 86, 419, 

465
Region List, menu 938

commande Auto Rename 566
commande Clear 567
commande Compact Selected 564
commande Export Region Definitions 270
commande Find 421
commande Rename 565
commande Selected Unused 567
commande Time Stamp Selected 502
commande Timeline Drop Order 493
option Show Auto-Created 566
Sort By, option 421

Région mise en boucle 534
annulation de la mise en boucle 536
attribution d'un nouveau nom 536
copier-coller des données d'automation 538
création 535
édition 537
rognage à l'aide de l'outil de trimming de boucle 443
sélection 537

Region Time, option d'affichage 399
Région, définition 269
Region, menu 134

Capture, commande 485

commande Bring to Front 489
commande Identify Sync Point 939
commande Lock 509
commande Mute/Unmute 510
commande Quantize to Grid 509
commande Remove Sync Point 504
commande Send to Back 489
commande Ungroup All Regions 527
commande Ungroup Region 527
commande Unlock 509
commande Unloop Regions 536

Région, nom
menu contextuel 135, 425
options d'affichage 399

Régions, liste 419
affichage des informations du fichier pour les régions 

audio 420
clip MIDI 420
commande Export Regions as Files 267
écoute de régions 424
faire glisser à partir 492
focus clavier 22
historique de recherche 422
menu contextuel 419
recherche des régions 421
renouvellement d'une recherche 422
sélection de régions 423
tri 420

Regions, vue 394, 404
Règle

affichage de toutes les règles 407
défilement 458
modification de l'ordre d'affichage 407
pull up et pull down 927
règle temporelle 406
règles du chef d'orchestre 407
zoom avant 432

Règle du chef d'orchestre 407
dans les sélections 471

Règle temporelle 406
déplacement des sélections d'édition 472
déplacement des sélections de graduation 477
drapeaux de pré/post-roll 462
marqueur d'édition 462
marqueur de sélection de timeline 462
sélection de timeline 476
sélection sur toutes les pistes 471
timecode 2 408

Règle temporelle principale 408
Règle, options d'affichage

échelle temporelle Bars:Beats 408
échelle temporelle de timecode 409
échelle temporelle Feet.Frames 409
échelle temporelle Minutes:Seconds 409
échelle temporelle Samples 409

Règle, sélecteur de vue 407
Regroupement de médias 236
Réinitialisation des chemins 63
Remote Mode, options 95
Remove Duplicate Notes, commande 671
Remove Sync Point, commande 504
Rename Track, commande 155
Rename, commande (Region List) 425, 565
Renamed Audio Files, dossier

commande save copy in 286
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Render Sources 232, 238
Renumber Bars, commande 601
Répartition (MIDI) 694
Repeat to Fill Selection, commande 520
Repeat, commande 522
Répétition des sélections et des régions 522
Replace Region, commande 425, 510

boîte de dialogue Replace Region 510
piste multicanal 512

Replace, mode
Report son

vers un mixage stéréo 868
vers un prémixage 867

Résolution pour la session 100, 916
Ressource non disponible 102
Ressource SND, format de fichier 861
Ressources système 14
Restore Performance, commande 686
Restore Performance, option 673
Rétablissement de lien

Find Links 226
options de rétablissement de lien 227

Retard
décalage d'une piste MIDI 669
indicateur de retard du canal 143
propriétés en temps réel 704

Retard du canal, indicateur 143
Retour à zéro, bouton 119
Retour rapide

par incrément 455
recherche 455

Retour rapide, bouton 119
Revert to Saved, commande 104
Rognage

crossfade 549
données de pistes et de régions indésirables 489
point d'inflexion d'automation 578, 822, 832
points de début et de fin d'une région 438
points de début et de fin des notes 653
région avec l'outil Scrub Trim 441
région jusqu'au point d'insertion d'édition 489
régions par la valeur de déplacement par incrément 491

Rognage, automation
fonte 832

Root Settings, dossier 779
spécification 780

Round Robin Allocation 312
Routage par bus

chemin de signal 53
départ 737
départ multicanal 886
exemple de Surround 892
prémixage et traitement des effets 750

RTAS Engine, options 42
RTAS Processors, paramètre 40, 41

S
S/PDIF

configuration du matériel 48
Sample Rate Conversion Quality, préférence 92
Samples, échelle temporelle 409
Saturation numérique 302
Sauvegarde automatique des sessions 83, 101
Save As, commande 104

Save Copy In, commande 105, 106, 290
Save, commande 104
Scale, commande (Tempo Operations) 586, 588
Scroll Into View Track, commande 155
Scroll into View, commande 150
Scroll to Track Banks Controllers, option 89
Scroll To Track, commande 148, 459
Scrub in Video Window, commande 961
Scrub Trim, outil 441
Scrubbing 447

avec l'outil Scrub Trim 441
avec le sélecteur 448
curseur d'édition 447
deux pistes audio 448
piste audio unique 448
piste vidéo 961
résolution 448
vitesse et sens de la lecture 448

Scrubbing, outil 429, 447
mode Shuttle 449
sélection 472

S-Curve, commande (Tempo Operations) 585
Section 618
Select All, commande 464
Select Parent in Project browser, option 232
Select Parent in Workspace, commande 425
Select Tracks in Group, commande 178
Select Unused Regions, commande 567
Select/Split Notes, commande 694, 695

action Split Notes 694
Select/Split Notes, option 673
Sélecteur 429, 453

scrubbing 448
sélection de notes MIDI 651

Sélecteur d'assignation de groupe 727
Sélecteur d'entrée 157
Sélecteur de canal 777

plug in multimono 888
Sélecteur de compteurs principaux 409
Sélecteur de compteurs secondaires 410
Sélecteur de mode d'automation 796
Sélecteur de piste 775
Sélecteur de playlist 10, 414
Sélecteur de plug-in

plug-in en temps réel 775
Sélecteur de sortie 158
Sélecteur de voix 161
Sélecteur de vue de la fenêtre Edit 731
Sélecteur de vue de la fenêtre Mix 731
Sélecteur du point d'insertion 775
Sélection

à la volée 465
avec l'outil de scrubbing 472
avec les règles du chef d'orchestre 471
boucle 475
collage 517
commande Bounce to Disk 859
consolidation 563
copie 516
coupure 516
dans la liste des événements MIDI 715
décalage 508
déplacement par incrément 468, 506
déplacement par incrément des points de début et de fin 

468
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déplacement vers la région suivante/précédente 472
déplacement vers les pistes adjacentes 471
données des pistes 463
duplication 521
écoute des points de début et de fin 474
et groupe d'édition 464
extension 468, 578
extension à la règle de métrique 594
extension à la règle de tempo 572, 613
indicateur de sélection d'édition 469
lecture 474
marqueur de sélection de timeline 463
modification de longueur 467
non contiguë 466
note dans un accord 696
note MIDI 651
objet 466
pendant la lecture 465
piste masquée 464
plage de hauteur de notes 695
région 464
régions non contiguës 466
réinitialisation 518
répétition 522
stockage avec des emplacements mémoire 606
suppression d'une piste 472
sur plusieurs pistes 464, 470
sur toutes les pistes 471
toutes les régions d'une piste 464
toutes les régions de toutes les pistes 464

Selection Changes Alternate Playlists, option 413
Sélection d'édition

copiée à partir d'une sélection de timeline 478
copiée vers une sélection de timeline 478
déplacement dans la règle 472
écoute avec la tête de lecture 479

Sélection d'édition et de timeline séparées 461
Sélection d'édition, indicateur 117
Sélection d'objets 466
Sélection de banque 17, 661
Sélection de timeline 476

champs de début, de fin et de durée 122
copiée à partir d'une sélection d'édition 478
copiée vers une sélection d'édition 478
déplacement dans la règle 477
écoute avec la tête de lecture 479
marqueur de sélection de timeline 477
règle temporelle 476

Sélection non contiguë 466
Send 278
Send Pans Default to Follow Main Pan, option 88
Send to Back, commande (menu Region) 489
Send To Sibelius 278
Send via DigiDelivery, commande 273
Sends A-E, options d'affichage 739
Sends Default to -INF, option 88
Sends F-J, options d'affichage 739
Sends, vue 733
Separate Region Operates On All Related Takes, option 337, 

487
Separate Region Operates On All Related Takes, préférence 

86
Separate Region, commandes 486

At Selection 486
At Transients 486

et prises associées 337
On Grid 486
pistes multiples 487

Séparation des sélections d'édition et de timeline 461
Separation Grabber, outil 488
Session 8

création 99
création pour le mixage Surround 874
enregistrement 104
fermeture 111
fichier

concepts 8
format audio 916
formats audio mélangés 107
fréquence d'échantillonnage 45, 100, 916
fréquence d'images 917
image de départ 917
modèle 109
ouverture 101
ouverture à partir d'un volume de transfert 102
résolution 100, 916
sauvegarde 83, 101

Session Data to Import, menu 260
Session File Backups, dossier 101
Session Setup, fenêtre 915

timecode entrant 940
Set As User Default, commande 779
Set Plug-In Default To, commande 779
Set Record Tracks to Auto Input, commande 307
Set Record Tracks to Input Only, commande 307
Set Root Settings Folder, commande 780
Set Servo Lock Bit at Play (Tamura Support), option 95
Setup, menu 134

boîte de dialogue Click/Countoff Options 319
commande Preferences 77
commande Video Sync Offset 966
configuration de session 915
Disk Allocation 311
fenêtre MIDI 663
I/O Setup 57

Shift, boîte de dialogue 508
Shift, commande 508
Show All Tracks Group, commande 178
Show Auto-Created, option 566
Show Meters in Sends View, option 79, 741
Show Only Tracks in Group, commande 178
Show Original Setup, bouton 69
Show/Hide Region List, bouton 419
Show/Hide Track List/Group List View, bouton 152, 177
Show/Hide Tracks in Group, commande 178
Shuffle, mode 426

déplacement de régions 496
région verrouillée 509

Shuffle, mode verrouillé 426
Shuttle

option de mode fixe 450
Shuttle, mode du clavier numérique 25, 81, 450
Single Zoom, mode 432
SIP (Solo In Place) 167
Skip All 284
Slip, mode 426

déplacement de régions 500
Smart, outil 429, 445

création de crossfades 446
création de fondus 446



Index 995

édition d'événements de contrôleur 447
édition de l'automation 447
piste audio 446
piste MIDI 446
piste multicanal 447

Smooth and Thin Data After Pass, option 89, 819
SMPTE

configuration 920
image de départ pour la session 917

Snap Pan to Speaker, icônes 903
Snap To Bar, option 593
Snap To, commandes 498
Soft Limit 49
Solo in Place, mode 167
Solo Latch, options 168
Solo Safe, mode 169
Solo, bouton 166
Solo, mode 166

sélection 167
Sort By, option 421
Sortie

chemin multicanal 885
chemins et sous-chemins 5.1 par défaut 876
format et piste 884

Sortie MIDI, sélecteur 143, 164
piste d'instrument 165

Sorties multiples
configuration du matériel 50

Sound Designer II, format de fichier 861
Source d'horloge 791
Source d'horloge externe 791
Sous-chemin 55

exemple pour le Surround 889
Sous-dossiers, création pour paramètres 780
Sous-images 936
Speed Cal, indicateur 918
Split Into Mono, commande 156, 523, 883
Split Notes, action 694
Spot, boîte de dialogue 501, 935

bouton User Time Stamp 938
option Use Subframes 936

Spot, mode 427, 935
déplacement de régions 500
rognage de régions 937

SRC, options 259
Stable LTC Source, option 96, 933
Standard VCA Logic for Group Attributes, option 90
Start To Insertion, commande 490
Start, End et Length, affichage 339
Step Input, commande 697
Step Input, option 673
Stereo 864
Stéréo entrelacé, exportation de fichier 269
Stéréo, insert 766
Stéréo, piste

déplacement de régions 523
division 523
remplacement des régions 512

Stop at Shuttle Speed Zero, option 94
Strip Silence, commande 559, 561

désignation des régions 560
Strip Silence, fenêtre 559
Suppress Automation “Write To” Warnings, option 90
Suppression

automation 818, 826

changement de programme 665
chemin d'E/S existant 64
crossfade 549
dans la liste des événements MIDI 716
départ 738
emplacement mémoire 612
événement Sysex 667
groupe 185
note MIDI 656
piste 150
playlist 416
plug-in des pistes 771
région inutilisée 567

Suppression d'éléments
dossier du catalogue 215

Suppression d'erreurs RTAS 43
Suppression de chemin 64
Surface de contrôle

Command|8 763
Control|24 763
D-Command 763
D-Control 763

Surround
assignation du signal élémentaire 885
Center % (pourcentage de centrage) 910
configuration de Pro Tools et des sessions 874
départ 885
exemple d'utilisation de sous-chemins 889
exemple de chemins au format 5.1 878
fichier de paramètres 874
grille de panoramique 898
importation des paramètres d'E/S 876
niveau séparé, Solo, Mute 883
playlist et automation de panoramique 911
utilisation des chemins 888

Surround Scope, plug-in 912
Suspend All Groups (liste de groupes), commande 178
Swing 678, 680
Sync Offset 920
Sync Point View, option 505
Synchronisation

black burst 941
dépannage 940
MIDI Beat Clock 934
MMC 929
options 913
résolution 941

Synchronisation, champ du mode 916
Synchronisation, préférences 94
Sysex, vue 666
System Exclusive, données 18, 666

déplacement 666
enregistrement 362
suppression 667

System Usage, fenêtre 51, 52
options de vue 52

Système
arrêt 39
démarrage 39
paramètres 40

Système, affectation de mémoire 47

T
T (navigateurs) 229
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Table des mesures
importation 262

Table des signatures de tonalité
importation 262

Table des tempos
à partir de la commande Identify Beat 588
importation 262

Tâche
active 240
échec 241
en attente 241
groupée 242
interrompue 240
suspension pendant la lecture 242

Tâche en attente 241
Taille du buffer

matériel 308
Taille du buffer de lecture DAE 46
Taille du buffer matériel 40
Takes List, menu déroulant

pistes multiples 336
Target, bouton 776
Tascam DA30 48
TC/E Plug-In, préférence 92
TCE Edit to Timeline, commande 478
Témoin 775
Tempo

actuel 571
affichage 124
battement 323
défaut 321
effet sur les marqueurs et les emplacements mémoire 

606
mode Manual Tempo 322

Tempo actuel 124
Tempo Edit Density, menu déroulant 577
Tempo Operations, commandes

commande Constant 582
commande Linear 583
commande Parabolic 584
commande Scale 586
commande S-Curve 585
commande Stretch 588

Tempo Operations, fenêtre 581
Tempo Ruler Enable, bouton 124
Tempo Sync 777
Tempo, événement 570

édition 571
insertion 571
marqueur Bar|Beat 590

Tempo, règle
affichage 570
extension d'une sélection d'édition 572, 613

Tempo, sélecteur de résolution 576
Temporisation sur les échantillons 410, 606
Temporisation sur les références temporelles 410
Temporisation sur les tics 606
Temps réel, édition 391
Temps réel, propriétés

activation 702
affichage 700
affichage dans la fenêtre Edit 708
affichage dans la liste des événements MIDI 707
basées sur des pistes 706
basées sur des régions 706

durée 704
écriture sur les pistes 706
écriture sur les régions 706
option Display Events as Modified by Real-Time 

Properties 93
paramètres 703
pistes et régions 705
quantification 703
réinitialisation 707
retard 704
transposition 705
vélocité 705
vue 700

tester 866
Tête de lecture 461

déplacement vers les limites d'une région 479
sélection d'édition 479
sélection de timeline 479

Thin Automation, commande 820
Time Code Mapping, options 258
Time Code Rate, menu contextuel 917
Time Compression/Expansion, outil de trimming 92, 439, 657
Time Compression/Expansion, plug-in 478
Time Operations, commandes 595

commande Change Meter 595
commande Cut Time 599
commande Insert Time 597
commande Move Song Start 600

Time Operations, fenêtre 592, 595
Time Slot TDM, utilisation 51
Time Stamp Selected, commande 502
Time Stamp, commande 336, 425, 938
Timecode

capture 936
génération 919, 928
Jam Sync 919
roue libre 919

Timecode 2, règle 408
Timecode en roue libre 919
Timecode secondaire, règle 408
Timecode, échelle temporelle 409
Timecode, génération 928
Timecode, position

redéfinition 922
Timeline Drop Order, commande 493
Timeline Insertion/Play Start Marker Follows Playback, option 

80, 482
Touch Timeout, option 89
Toutes les pistes

masquage 153
présentation 153
sélection dans les règles temporelles 471
sélection de toutes les régions 464

Track Name/Comments, boîte de dialogue 147
Track Number, commande 148, 459
Track Offset, options 259
Track Position Numbers Stay with Hidden Tracks, option 78
Track, menu 134

commande Clear All Clip Indicators 145, 741
commande Delete 150
commande Duplicate 150, 796
commande Group 180, 182
commande Make Active 171
commande Make Inactive 171
commande New Track 147
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commande Scroll to Track 148
commande Split Into Mono 883
commande Write MIDI Real-Time Properties 706
mode d'écoute Auto Input 306
mode d'écoute Input Only 306
Set Record Tracks to Auto Input 307
Set Record Tracks to Input Only 307

Track, vue 393
affichage étendu de la piste 398, 825
basculement 396
bloc 394
contenu d'édition 515
forme d'onde 400
modification 395
Notes 403
notes 394
région 394, 404
Sysex 666
vélocité 654
vue principale 827

TrackInput, bouton d'écoute 306
TrackInput, indicateur d'écoute 121
TrackPunch 371
TrackPunch, mode 372
TrackPunch, préférences 373
Tracks Group, commande 178
Trafic du bus PCI 51
Traitement par déclenchement externe 787
Traitement par déclenchement interne 787
Traitement, préférences 92
Trajectoire, panoramique 907
Transfert

sélection de fichiers dans DigiBase 204
Transfert, volume

définition 195
Transitoire

détection avec Beat Detective 623
tabulation vers 473

Transport
écoute TrackInput 121
indicateur d'activation à l'enregistrement de piste 121

Transport maître, bouton 122
Transport Online, option 928
Transport RecordLock, option 83, 374, 379
Transport, fenêtre 119

affichage du statut de l'enregistrement 376
champs de début, de fin et de durée 122, 339
commandes de transport 119
commandes MIDI 123
pré/post-roll 121
pré/post-roll 341

Transport, mode du clavier numérique 24, 81
Transport, options de vue 123, 340, 341, 453
Transpose, commande 692
Transpose, option 673
Transposition 692

note MIDI 652
par octave 693
piste 692
propriétés en temps réel 705
touche 693

Tri
données dans les navigateurs 207
marqueur 614
région 420, 421

tri secondaire 207
Trim Automation, commandes 846

Trim to All Enabled 846
Trim to Current 846

Trim Region, commandes
End to Fill Selection 490
End to Insertion 490
Start to Fill Selection 490
Start to Insertion 490
To Fill Selection 491
To Selection 489

Trim to All Enabled Automation, commande 846
Trim to Current Automation, commande 846
Trimming, outil 429
Trimming, outils 438, 578, 822

outil de trimming Time Compression/Expansion 92, 439
outil Scrub Trim 441
outil Time Compression/Expansion Trim 657

Trois boutons, panoramique 905
Tweak-head, paramètre 955
Tweak-head, paramètre 866
Types de fichiers mélangés 107, 248

U
Undo History, fenêtre 417
Undo, commande 417
Ungroup All Regions, commande 527
Ungroup Region, commande 527
Universe, fenêtre 451
Unloop Region, commande 509
Unloop Regions, commande 536
Use Absolute Pan Linking, option 88
Use All Available Space, préférence 85
Use AudioSuite Dither, option 92, 762
Use F11 for Wait for Note, option 93, 351
Use MIDI to Tap Tempo, option 93
Use Separate Play and Stop Keys, option 82
Use Squeezer, option 866
Use Subframes, option 936
User Time Stamp 502

V
Valeur de déplacement par incrément 506

rognage de régions 491
Valeur de la grille 502
Variable Speed Override 918
VCA principal

affichage des données d'automation 851
attribution de groupes 730
commandes 728
mixage 727
réinitialisation 852
suppression 852
type de piste 138, 727
voie 140

Vélocité
propriétés en temps réel 705

Vélocité d'une note MIDI
décalage avec l'outil de trimming 655
dessin avec le crayon 655
édition 654
édition de la vélocité 654
paramètres par défaut pour notes insérées 649
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Vélocité, note MIDI
atténuation 689
édition 688
multiplication 690

Velocity, vue 654
Verrouillage de régions 509
Vidéo

limites d'enregistrement avec une majoration 927
Video Media, options 258
Video Online, bouton 946, 948
Video Out FireWire Port, commande 965
Video Sync Offset, commande 966
Video Universe, fenêtre 452
Video Window, commande 960
Vidéo, accélération et ralentissement 924
Vidéo, indicateur 229
Vidéo, piste

affichage sous forme de blocs 947
scrubbing 961

View Filter, commande 710
fenêtre Memory Locations 615

View, menu 134
commande Track Number 148, 459
option d'affichage Narrow Mix 146
option Mix Window 113
option Region Sync Point View 505
options d'affichage des noms des régions 399
options d'affichage des positions temporelles des 

régions 399
options de la vue Transport 123, 340, 341, 453
options de vue de la fenêtre Edit 114, 732
options de vue de la fenêtre Mix 732
options de vue de la fenêtre System Usage 52

Vitesse de Shuttle Lock personnalisée 450
Voie 11

entrée auxiliaire 139
piste audio 139
piste d'instrument 142
piste de fader principal 140
piste de VCA principal 140
piste MIDI 141

Voix
assignation automatique par ordre croissant 162
et RTAS 767
priorité des pistes 160
TrackPunch 372

Volume
navigateur de volume 124, 192, 197
performance 195
transfert 195

Volume, fader 144
Volume, indicateur 143
Volume.ddb 196
VSO (voir Variable Speed Override)
Vue

compensation de retard 146
I/O 143
vue Inserts 733
vue large des vumètres 145
vue Sends 733

Vue principale des pistes 397, 827
Vumètre

niveaux pré/post-fader 145
piste audio 144

piste d'entrée auxiliaire, de fader principal et 
d'instrument 144

piste MIDI 144
plug-in Surround Scope 912
surface de contrôle 72
vue Sends 741

Vumètre actuel 124, 592
Vumètre, options 79
Vumètre, vue large 145

W
Wait for Note 123, 351
WAV file, format 286

conformité AES31/Broadcast 286
WAV, format de fichier 861
WaveCache 213
WaveCache.wfm, fichier 100, 196
Waveform, vue 400
Window, menu 134

Color Palette 173
commande Automation Enable 805
commande Big Counter 454
commande Disk Space 314
commande Edit 114
commande Machine Track Arming 934
commande Memory Locations 610
commande Mix 113
commande Project 284
commande Task Manager 254
commande Transport 119
commande Undo History 417
commande Universe 451
commande Workspace 312
System Usage, commande 52

Windows, session
compatibilité Mac 289

Word Clock 48
Write 845
Write Automation to Next Breakpoint on Stop, commande 839
Write Automation to Next Breakpoint, commande 836
Write Automation to Selection/Selection Start/Selection End, 

boutons 834
Write Automation To, commandes

mode Automation Preview 848
Write Automation, commandes 843, 845
Write MIDI Real-Time Properties, commande 706

X
XML (Extensible Markup Language) 663
X–OR (annulation des solos précédents), option Solo Latch 

168

Z
Zoom 429

arrière complet 431
autour d'un point de piste 431
avec une molette de défilement 437
changement de zoom 436
continu 430
dans la règle 432
dans une sélection 431
enregistrement des niveaux de zoom 433
horizontalement pour toutes les pistes 430
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rappel des niveaux de zoom 434
rendre visible toutes les régions 431
retour au niveau de zoom précédent 431
sur une zone de piste 432
verticalement pour toutes les pistes audio 430
verticalement pour toutes les pistes MIDI 430

Zoom arrière horizontal, bouton 429
Zoom avant horizontal, bouton 429
Zoom continu 430
Zoom sans modification des playlists 437
Zoom Toggle, commande 436, 437
Zoom Toggle, préférences 87
Zoom, boutons 429
Zoom, outil 429, 431
Zoom, présélection 433
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